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About this Manual
PowerWorld Simulator includes comprehensive, context-sensitive on-line help. Any page of this manual
can be printed for your own off-line reference. Occasionally updates to the on-line help are posted in
patches on the PowerWorld website.

1
©2011 PowerWorld Corporation

Introduction to PowerWorld Simulator
PowerWorld Simulator (Simulator) is a power system simulation package designed from the ground
up to be user-friendly and highly interactive. Simulator has the power for serious engineering analysis,
but it is also so interactive and graphical that it can be used to explain power system operations to
non-technical audiences. With Version 16 we’ve made Simulator more powerful, more visual, and
easier to use.
Simulator consists of a number of integrated products. At its core is a comprehensive, robust Power
Flow Solution engine capable of efficiently solving systems of up to 100,000 buses. This makes
Simulator quite useful as a stand-alone power flow analysis package. Unlike other commercially
available power flow packages, however, Simulator allows the user to visualize the system through the
use of full-color animated oneline diagrams complete with zooming and panning capability. System
models can be either modified on the fly or built from scratch using Simulator’s full-featured graphical
case editor. Transmission lines can be switched in (or out) of service, new transmission or generation
can be added, and new transactions can be established, all with a few mouse clicks. Simulator’s
extensive use of graphics and animation greatly increases the user’s understanding of system
characteristics, problems, and constraints, as well as of how to remedy them.
The base package of Simulator is capable of solving power systems comprised of up to 100,000 buses.
The base package also contains all the tools necessary to perform integrated economic dispatch, area
transaction economic analysis, power transfer distribution factor (PTDF) computation, short circuit
analysis, and contingency analysis. All of the above features and tools are easily accessible through a
consistent and colorful visual interface. These features are so well integrated that you will be up and
running within minutes of installation.
In addition to the features of the base Simulator package, various add-on tools are available, including
the new transient stability feature. Please see Introduction to Simulator Add-On Tools for more
information.
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Introduction to Simulator Add-On Tools
In addition to the features of the base Simulator package, various add-on tools are available. A brief
introduction to each follows:
Voltage Adequacy and Stability Tool (PVQV)
The purpose of the PVQV add-on is to allow the user to analyze the voltage stability characteristics of
a system. After the PVQV simulation is complete, the user can graph various system parameters. For
more information, see the PVQV Overview.
Optimal Power Flow Tool (OPF)
The purpose of an OPF is to minimize an objective (or cost) function . In Simulator OPF the Linear
Programming OPF algorithm (LP OPF) determines the optimal solution by iterating between solving a
standard power flow and solving a linear program to change the system controls thereby removing any
limit violations. For more information, see the OPF Overview.
Security Constrained Optimal Power Flow Tool (SCOPF)
The OPF tool minimizes an objective function (usually total operation cost) by changing different
system controls while meeting power balance constraints and enforcing base case operating limits.
The SCOPF tool takes it one step further by considering contingencies that may arise during system
operation and ensuring that in addition to minimizing the objective function, no unmanageable
contingency violations occur. For more information, see the SCOPF Overview.
Optimal Power Flow Reserves (OPFR)
Simulator OPF Reserves is the tool used to simulate Ancillary Services Reserve Markets. For more
information, see the Optimal Power Flow Reserves Overview.
Available Transfer Capability Analysis Tool (ATC)
ATC analysis determines the maximum MW transfer possible between two parts of a power system
without violating any limits. For more information, see the ATC Analysis Overview.
PowerWorld Simulator Automation Server (SimAuto)
SimAuto provides PowerWorld customers the ability to access PowerWorld Simulator functionality
within a program written externally by the user. The Simulator Automation Server acts as a COM
object, which can be accessed from various programming languages that have COM compatibility.
Examples of programming tools with COM compatibility are Borland Delphi, Microsoft Visual C++,
Microsoft Visual Basic, and Matlab (among others). For more information on SimAuto, see the
SimAuto Overview.
Integrated Topology Processing
Integrated Topology Processing allows you to solve EMS-type, full-topology models in a numerically
robust and transparent manner. Integrated Topology Processing extends Simulator applications
traditionally used by planners so they can operate in an operations real-time environment. For more
information, see the Integrated Topology Processing Overview.
Transient Stability (TS)
Transient Stability analysis allows the analysis of system dynamic response to a fault on the system.
For more information, see the Transient Stability Overview.
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Distributed Computing
Distributed computing allows the use of multiple computers to speed up analysis by splitting the work
among a user-specified list of computers. For more information, see the Distributed Computing AddOns topic.
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What's New
Web links to previous version information: Version 15 Version 14 Version 13 Version 12 Version 11
Version 10 Version 9 Version 8 Version 7 Version 6
Simulator Version 16 contains a number of major new features and several smaller enhancements
designed to improve the performance and convenience of the package.




New Add-Ons
 Distributed Transient Stability
Auxiliary Files and Display Auxiliary Files
 The Selected field can now be used with oneline display objects in Display Auxiliary Files.
Auxiliary File SCRIPT and SimAuto Changes
 All Submodes such as Contingency, PowerFlow, ATC, etc. have been made obsolete in the
scripting language. The Run mode and Edit modes still exist, but otherwise moving between
submodes is no longer necessary.
 New and modified script commands
 Added new script command AutoInsertTieLineTransactions;
 Added new script command InjectionGroupsAutoInsert;
 Added new script command SendToExcel(ObjectType, [FieldList], Filter,
UseColumnHeaders, "WorkBookName", "WorkSheetName");
 Added new script command DetermineBranchesThatCreateIslands(BranchesToProcess,
StoreBuses, "FileName", SetSelectedOnLines);
 Added new script command StopAuxFile;
 Added new script command SetGenPMaxFromReactiveCapabilityCurve("filtername");
 Added new script command SetScheduledVoltageForABus([bus identifier], voltage);
 Added Transient Stability script commands
 Modified the editing of data in a case information display (or through an AUX file) so that
the string "&ModelExpressionName:8:4" can be entered. A string which starts with the
character & will be treated as though the value of the named model expression is being
entered in the field. The format of the string will be determine by the last two integer
values representing the total number of digits and decimal places.
 Added a new file type to the SaveData() script command called "CSVColHeader". When
using this file type, the file will be written with the first row showing column headers you
would see in a case information display. The file type "CSV" will always show variable
names. Similar feature was added for SaveDataWithExtra() script command.
 Modified the Move() script command to permit you to move a MULTISECTIONLINE. The
format is the same as for moving a regular branch except that the object name should
be MULTISECTIONLINE.
 Added optional parameter to SaveCase script command for use when saving an EPC file.
New format is SaveCase("filename",SaveFileType,[PostCTGAGC, UseAreaZone]);
PostCTGAGC by default is set to NO. Set to YES to set the base load flag in the EPC file
based on the Post-Contingency Prevent AGC Response setting. If preventing postcontingency AGC, the base load flag is set to 1. If not preventing post-contingency AGC
or this option is set to NO, the base load flag is set to 0. UseAreaZone by default is set
to NO. Set to YES to limit the entries in the EPC file based on the area/zone/owner filter.
 Added support for Display Auxiliary File (AXD) script commands to allow manipulation of
oneline diagram objects
 The following general commands can be used: ExitProgram, LoadScript, LoadData,
SelectAll, UnSelectAll, SaveData, SaveDataWithExtra, Delete, WriteToTextFile, SetData,
CreateData, DeleteFile, RenameFile, CopyFile, SetCurrentDirectory, SaveObjectFields,
SendToExcel, and StopAuxFile.
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 The following are new oneline diagram specific script commands
 AutoInsertBorders
 AutoInsertBuses(LocationSource, MapProjection, AutoInsertBranches,
InsertIfNotAlreadyShown, "FileName", FileCoordinates);
 AutoInsertLoads(MinkV, InsertTextFields, InsertEquivObjects);
 AutoInsertGens(MinkV, InsertTextFields);
 AutoInsertSwitchedShunts(MinkV, InsertTextFields);
 AutoInsertLines(MinkV, InsertTextFields, InsertEquivObjects, InsertZBRPieCharts,
InsertMSLines, ZBRImpedance, NoStubsZBRs, SingleCBZBRs);
 AutoInsertLineFlowObjects(MinkV, InsertOnlyIfNotAlreadyShown, LineLocation, Size,
FieldDigits, FieldDecimals, TextPosition, ShowMW, ShowMvar, ShowMVA, ShowUnits,
ShowComplex);
 AutoInsertSubstations(Location Source,Map Projection, AutoInsertBranches,
InsertIfNotAlreadyShown, “FileName”, FileCoordinates);
 AutoInsertLineFlowPieCharts(MinkV, InsertOnlyIfNotAlreadyShown, InsertMSLines,
Size);
 AutoInsertInterfaces(InsertPieCharts, PieChartSize);
 ResetStubLocations(ZBRImpedance,NoStubsZBRs);
 Labels now supported in SimAuto functions ChangeParametersSingleElement,
GetParametersSingleElement, and GetParametersMultipleElement.
Available Transfer Capability (ATC) Enhancements
 Optimized the speed of the ATC calculations. Overall speed increase from the initial release
of Simulator 15 is now between 2 and 6 times for the iterated solution methods and
between 4 and 10 times for the Single Linear Step solution methods.
 Added a new option to linearize the calculation of contingency makeup power. This will
precalculate the impact of makeup power on line flows at the start of the analysis and then
the total effect of makeup power will be determined by multiplying the effect on a line by
the Total amount of Makeup power needed. This calculation will be slightly faster than
previous calculation of makeup power, but it will not take into account the fact larger
amounts of makeup power may cause particular generators to hit min or max limits.
 Removed the option Apply PTDF Cutoff for Limiting Elements with Contingencies.
 Added a new option for the ATC calculation when performing the calculation on multiple
scenarios. The option will allow you to specify that monitoring be done only on branches
that are defined as part of the scenarios.
 Added option to select the Field to Show on the multiple scenarios results summary table.
 Modified the highlighting used and Iteratively Found string for better understanding of the
results when using iterated methods.
 Removed the Max Iterations option when using the iterated methods. This is no longer
necessary as oscillation prevention is handled internally.
Bus View and Substation View
 Now storing option settings for displaying MW branch, Mvar branch, and MW interface flows
in absolute value in the registry. The values stored in the registry will be used as the
defaults for these settings when oneline options don’t exist for the Bus View or Substation
View with the power flow case (PWB).
 Default drawing values for generator rotor shape and fill will be used with the Bus View as
the default shape. If a fuel type for a generator is specified, the rotor shape will depend on
that, but the default drawing values will be used if no fuel type is specified.
Case Information Displays
 Added ability to define a Quick Filter on a case information display. This gives the ability to
define an advanced filter for temporary use on a case information display and does not
require you to name the filter.
 Added ability to use other object type filters with the GenVarLim object.
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Add ability to define Custom String Expressions which represent the concatenation of
strings from the columns of an object. Included in this is a new function available in the
expression string with format "Str(x1, minlength, decimals)" where x1 represents a numeric
variable, minlength represents the minimum number of characters for the result, and
decimals represents the number of characters to the right of the decimal point.
 When choosing Send to Excel, Simulator will now programmatically set Excel to NOT "treat
consecutive limiters as one". It also ensures that some "Other" character is not being used
as a delimiter so that only TAB characters are used.
 Modified the editing of data in a case information displays (or through an AUX file) so that
the string "&ModelExpressionName:8:4" can be entered. A string which starts with the
character & will be treated as though the value of the named model expression is being
entered in the field. The format of the string will be determine by the last two integer
values representing the total number of digits and decimal places.
 The Transformer Configuration Field is now enterable and toggleable on a case information
display.
 Modified case information displays show that when showing a value such as -0.01 which is
truncated to fewer decimal places, the resulting string will still include the negative sign and
show "-0.0" for example instead of "0.0".
 In a Custom String Expression, when using the Str(Value, Digits, Decimals) function, if the
Decimals parameter is specified as negative, then it will truncate all trailing zeros beyond
the decimal.
 Added fields for Owner records showing the Number of Branches by Type (Transformer,
Line, SeriesCap, Breaker, Disconnect), and the number of switched shunts.
 Added fields for injection groups that list Area/Zone/Owner of all of the devices in the
injection group. Fields are available for listing either the number or name of the associated
Area/Zone/Owner.
 When sending Custom Case Information to Excel, only fields that are text will be marked as
text. Previously, the formatting was based on columns being identified as text based fields
instead of identifying each individual cell as to whether or not it is text.
 Added the ability with case information displays to show the Super Area in which a
generators, loads, switched shunts, and branches are contained.
 Amps field is now available with loads.
 With buses and substation records, added the ability to specify latitude/longitude
information using the four parameters of UTM longitude zone, UTM Easting, UTM Northing
and specification of either north or south hemisphere.
Contingency Analysis Enhancements
 Two different types of fields are now available with contingencies to list the
Areas/Zones/Owners associated with the elements of the contingency. Fields exist for listing
either the number or name of the associated Areas/Zones/Owners. Fields that are labeled
with “recurse” will look inside injection groups, interfaces, and contingency blocks for
identifying the associated Areas/Zones/Owners. Fields without “recurse” will not look inside
injection groups, interfaces, or contingency blocks.
 Added option to use labels in contingency action descriptions. This includes actions shown
in the Contingency Definition list and What Actually Occurred. This can be useful when used
with a full-topology EMS model.
 When listing contingency results by element (bus, branch, interface, nomogram interface,
or custom monitor), only those elements which actually have a violation are now listed
 Specific generators, loads, and switched shunts can now be specified in addition to buses
when using Move, Set To, and Change By actions.
 Added an optional "inclusion filter" with each Contingency Global Actions Elements. The
global action will only be used with a particular contingency only if the contingency meets
the inclusion filter.
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Added new Custom Monitoring to the contingency analysis tool. This allows you to setup
monitoring of a field of a specific object (or all objects of a specific type) and report these
fields values as limit violations in the contingency analysis. Appropriate advanced filters can
also be specified so that violations are only reported if specified pre-contingency or postcontingency conditions are met.
 "Close with Breakers" action is now available. This will attempt to identify breakers that can
be closed in order to energize a device rather than changing the status of the device itself.
Fault Analysis
 Added total fault impedance field to Bus, to store the Thevenin R and X needed to calculate
the total fault X/R ratio.
 Added ability to define a list of Fault Definitions (similar to a list of contingency definitions).
These faults can then be processed as a batch and the results of Fault Current Magnitude
and Angle, and Thevenin impedance at the fault can be automatically saved for each fault.
File Formats
 When using the Present Topological Differences from Base Case tool, added the ability to
save the removed elements in the EPC file format using status values of -4.
 Modified the writing of GE EPC file so that Multi-Terminal DC converters will write out the
"aloss" parameter in a manner consistent with how the EPCL file mtTAP.p expects to ensure
the EPCL operates appropriate for WECC data files.
 When reading from an EPC file, added the reading of the area and zone designation of a GE
branch and transformer.
 Added a log warning message when appending an EPC file which causes a transformer
branch to be converted to a normal branch.
 When loading in EPC files and the latitude and longitude values are both zero, both entries
will be ignored as invalid.
 When appending an EPC file with a scheduled voltage for a bus, the voltage setpoints for
switched shunts and generators that are regulating this bus are now properly updated.
 Modified how appending an existing three-winding transformer is handled if a new threewinding transformer is entered which uses a bus number which is already used as a star
bus by another transformer. This is not allowed and a new bus number will automatically be
chosen.
 When appending to an existing case using an EPC file, any new branches that are created
are now flagged as having just been added. This flag is then used as part of the preprocessing feature in the power flow solution to automatically estimate appropriate voltage
magnitudes and angles for any existing or new buses that become newly energized.
 Modified the writing of PTI RAW files so that switched shunt records always write out at
least one block. If none exists, a single block with 1 step and size equal to the present MVar
output is written.
 When appending using the RAW file format, we now populate a field to say whether an
object is new or modified while reading.
 Added an option when saving a RAW file to append object labels as comments to the end of
data records.
 When appending to an existing case using a RAW file, any new branches that are created
are now flagged as having just been added. This flag is then used as part of the preprocessing feature in the power flow solution to automatically estimate appropriate voltage
magnitudes and angles for any existing or new buses that become newly energized.
 When loading the hdbexport file, modified to automatically add two labels to each
transmission line. One label starts with the "from" substation name and the other label
starts with the "to" substation name.
 Modified to add additional bus labels when reading the MEAS records in the Areva CSV file.
 At the end of reading in an hdbexport CSV file, if any CBTyp values were encountered that
were not recognized a dialog box will appear prompting the user to designate a Branch
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Device Type for each CBTyp. In addition options can be specified in the Simulator Options
dialog under File Management that specifies a mapping from CBTyp to Branch Device Type.
 Added options when saving a case in a PWB file to force saving the case with comments.
 Added file menu choices to open a oneline using particular linking (by Number, by
Name_kV, or by Label) and then allow storing the default choice so that onelines can
always default to be opened by Label or Name_kV if desired. Done to work better with fulltopology cases where labels are consistent.
 Added support for EPC version 18.
General
 Modified how Simulator handles setting its Windows Operating System Priority so that the
user can change this. The only exception is that while animating, Simulator always sets its
Priority to Low to ensure that the animation does not interfere with other programs.
 Various dialog messages now distinguish between the various branch device types, i.e.
breaker, disconnect, etc., instead of just identifying as a branch.
 Added a graphical display to visualize the logic diagram for a Model Filter. This shows the
logic diagram including AND and OR gates with the associated Model Filters and Model
Conditions which are combined to give the Model Filter.
 Added a graphical display to visualize the logic diagram for an Advanced Filter. This shows
the logic diagram including AND and OR gates with the associated advanced filters and
conditions which are combined to give the Advanced Filter.
 Geography Tab in Bus Dialog now converts from Lat/Lon to UTM and vice versa.
 Added Voltage Source Converter (VSC) DC Lines.
 When defining Model Filters, a NOT operator is available that can be applied to each Model
Condition or Model Filter that is part of the filter.
Integrated Topology Processing
 Added a new field for object types Branch, Gen, Load, Shunt, and DCLine which shows the
Derived Status. For full topology power system models, this field will show whether the
breakers adjacent to a device are OPEN or CLOSED. If the device is energized, the field will
always show CLOSED. If the device's actual Status is OPEN, the field will alway show OPEN.
If the device's actual status is CLOSED, but the device is not energized, the software will
determine if any adjacent Breaker objects are CLOSED in which case the derived status will
show CLOSED - otherwise it will show OPEN.
 Branches that are part of an interface will never be consolidated. In order to improve
consolidation, if an interface contains a branch that can be consolidated, i.e. breaker,
disconnect, etc., but it is in series with a device that cannot be consolidated, i.e. branch,
load, gen, etc., the interface will be automatically modified to monitor the device in series
instead.
 Added optional parameter, AddCommentsForObjectLabels, to the SaveConsolidatedCase
script command. This parameter is set to NO by default. If set to YES and saving to a RAW
file, object labels will be added to the end of data records. The new format of the script
command is SaveConsolidatedCase(filename,filetype,[BusFormat, TruncateCTGLabels,
AddCommentsForObjectLabels]).
 On several dialogs which show results of calculations for all buses in the system, an option
was added to the Buses tab saying "Only show the primary bus for each superbus". This is
done to reduce the number of duplicate results shown when using a full-topology model.
Dialogs effected by this changed include the Limit Monitoring dialog, TLR/GSF Sensitivities
dialog, Loss Sensitivities, and Flows and Voltages Sensitivities.
 Added new Branch Device Types for Fuse, Ground Disconnect, and Load Break Disconnect.
The load break disconnect is treated as a special switching device similar to the Breaker, so
special actions such as "Open with Breakers" will automatically open load break
disconnects.
 Added option to Close Breakers to Energize Switched Shunts. When using this option,
breakers will be closed automatically if a switched shunt is on either Discrete or Continuous
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control and is required to meet the regulated voltage. This option is applied any time that
the power flow is solved.
 When using the Economic Merit Order Dispatch method with the PV tool and a generator is
needed in the dispatch, breakers will be closed automatically to energize the generator if
necessary.
 Added script command CloseWithBreakers.
Oneline Diagrams
 When using a contour with a dynamic interpretation, if all the values being contoured had
the same value the contour image could appear random. This was remedied by enforcing a
minimum tolerance on the separation between minimum, nominal, and maximum values of
the color map.
 Added a Simulator Oneline option that alter how Simulator responds when click on a circuit
breaker symbol for a generator display object. Normally the generator's status is set to
closed and the MW value is reset to its previous value. The new option allows the value to
be set to its minimum MW output instead.
 When changing to a Saved View which specifies that a contour be shown, we now
automatically refresh the contour image
 Added ability to export a oneline diagram as a GIF image.
 Added ability to export a oneline diagram as an animated GIF image (animated the arrows
and generator rotors).
 When opening a oneline diagram using the AXD format, if no Saved View named
THIS_VIEW_IS_APPLIED_TO_THE_CURRENT_DISPLAY is specified, then a Show Full will
automatically occur for the oneline.
 When clicking on a oneline diagram, substation oneline objects have been modified to give
preference for clicking on the substation. If another object overlaps the substation,
Simulator will still register the click on the substation now.
 For dynamic formatting purposes, Model Fields will behave like the type of field that they
are showing. Thus, a model field showing Area information will behave as though it is an
Area Field.
 Modified Line Flow Arrow objects so that the text better aligns with the arrow.
 Added a new Interface Flow Arrow Object which behaves very similar to the Line Flow
Object show an arrow to represent the MW flow direction and then shown text for MW
value and Mvar value with a sign relative to the MW flow direction.
 Previously an option existed in Simulator which allowed you to specify whether to show
transformer symbols using either Coil or Circles. We now also have a oneline-specific option
which allows this option to be different for different onelines.
 Added options to automatically load a Display Auxiliary File (AXD) with each oneline that is
opened. One option stores the settings in the windows registry so this applies to all onelines
opened on the computer. Another option stores the settings in the case (PWB) so that it
only applies to onelines opened with the specific case.
 Added an option stored with the case to specify the maximum number of onelines that can
be open simultaneously (this option defaults to 10). If this maximum threshold is exceeded,
Simulator will automatically close the oneline whose most recent access is oldest. By default
a oneline can be closed in this manner, but an additional oneline-specific option has been
added that can be changed to prevent this closure. This feature has been added for users
who make extensive use of oneline links or substations display object links which can make
opening dozens of onelines very easy. Opening dozens of onelines can slow down the
program substantially. If you have a main oneline from which other onelines are
automatically opened, you may want to prevent the main oneline from closing.
 Added transparency with contouring. Transparency can be defined with either the No Data
Color or with a custom color map.
Power Flow Solution
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Modified slightly when generator limits are checked. Previously they would be checked
"immediately" (i.e. inside the inner power flow loop) if the mismatch fell below 0.02 per unit
(2 MW or 2 Mvar normally). This could lead to some inconsistent results if in one situation
the mismatch when from 2.001 to near zero, and in another it went from 1.999 to near
zero. Simulator will now only check generator limits inside the inner power flow loop if the
user chooses the "check immediately" solution option.
 Modified the algorithm which automatically chooses a slack bus when a new island is
created. Previously, if possible, it would always choose a bus which had generation that
regulated its own terminal bus. Now it is biased to do this, but if another bus with
generation that does not regulate its terminal bus is available and this other bus has a
maximum MW output that is 5 times higher, it will be chosen.
 When pre-processing the voltage profile of a solution before solving, Simulator will now look
at groupings of buses connected by very low impedances lines. If a bus in a grouping of
energized buses has a zero voltage while other buses in the group do not, the zero voltage
will be changed to the first non-zero voltage found in the grouping. This provides a much
more reliable solution.
 Added a new field, Enforce Current Limit, with multi-terminal DC line converters. When set
to NO, the current limits for the converters will not be enforced. The default setting for this
field is YES. When loading multi-terminal DC lines from an EPC file, this option will be set to
NO.
 Multiple switched shunts can now be on control at the same bus. Coordination of control for
shunts that regulate the same bus (or same bus due to ZBR grouping) is handled through a
Var Sharing Parameter that can be specified with each shunt.
PV and QV Curve Enhancements
 When choosing to report limit violations in the PV Curve Tool, if no limit violations are found
then the minimum voltage is reported instead.
 In the PV curve tool, added the ability to estimate at what transfer level a voltage becomes
inadequate. Estimation is done by linearly interpolating between the two transfer levels
where it goes from adequate to inadequate.
 When exporting QV results to a CSV file, all results are now sorted by the voltage setpoint.
 Added the ability to plot multiple QV curves on the same plot.
 The more flexible plotting environment available in Transient Stability has been integrated
into the PV Curve tool. This is available under "New Plots" on the PV Curve dialog. Note that
this is available in addition to the previous plotting tool.
 PV Curve Tool state archiving is now available when using Integrated Topology Processing.
 Nominal Shift field is now included in the PV output file. Previously, only the Export and
Import fields were included sometimes making it difficult to match up results between a
scenario and the base case.
 Optimized the solution speed of the PV and QV curves tools. The QV curve especially should
run much more quickly, especially on cases smaller than a few thousand buses.
 Added a new YES/NO optional parameter to PVWriteResultsAndOptions("filename",
AppendFile). Specifying NO will cause it to overwrite the existing file. Specifying YES will
cause it to append to the file. If not specified, then YES is assumed.
 Attempt to speed up the process of determining how much additional var support is
necessary for the power flow solution to converge when a contingency will not solve in the
base case. Now look for the solvable point by tracing the QV curve from the present base
case voltage up to the maximum voltage instead of tracing from the present base case
voltage down to the minimum voltage.
 Added Economic Merit Order Dispatch option for use when dispatching generators. This
option allows specifying how source or sink generators are dispatched at various transfer
levels. Ideally, generators will maintain their output within an economic range. Generators
will be turned on or off as needed to maintain all online generators within their specified
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economic range. Generators that are not needed to provide MW output will also not provide
Mvar output.
Security Constrained OPF (SCOPF)
 When using the DC-Approximation, modified the SCOPF dialog so that less messaging is sent to
the SCOPF dialog regarding the progress of the SCOPF solution. All the messaging to status
edit boxes on dialog was greatly slowing down the solution process.
Sensitivity Calculations
 Greatly increased the speed of calculating multiple element TLR sensitivities.
 Modified internal numerical routines to make all sensitivity calculations faster.
 Added interface fields for showing the LODF and the Post-CTG MW flow (after Line outage)
values similar to those presently available for a branch.
 Previously it was only possible to open one instance of the LODF dialog at a time. This was
because only one LODF result was stored so performing the calculation on one dialog changed
the results on other open dialogs even if the chosen branch did not change on the other
dialogs. This caused confusion and thus resulted in us restricting to one LODF dialog. This has
now been modified to allow two LODF dialogs to be open simultaneously, but when doing this
Simulator forces one dialog to show a "Single LODF" calculation, while the second dialog shows
the "LODF Matrix". This is less confusing because the "LODF matrix" results are stored
separately and thus can be displayed separately.
 Same modification done for PTDF dialog by restricting the first dialog to "Single" Directions, while
the second dialog shows "Multiple" directions.
 Same modification done for TLR/GSF dialog by restricting the first dialog to the "Line/XFMR or
Interface" device type, while the second dialog shows "Multiple Elements" device type.
 Added two new Device Type/ Flow Type combinations on the Flows and Voltages Dialog, under
Single Meter, Multiplier Transfers. Bus / Mvar allows you to see the sensitivity of the total
generator Mvar injection at a bus due to additional injections of MW or Mvar at all buses in the
system. Gen / Mvar allows you to see the sensitivity of the Mvar output of a single generator
to additional injections of MW or Mvar at all buses in the system.
 Added a new tab on the Flows and Voltages tab called Multiple Meters, Single Control Change.
This allows the calculation of the sensitivity of various quantities to a change in a control
setpoint. Control setpoints include generator voltage setpoint, transformer tap ratio, phase
shifter phase shift, and switched shunt nominal Mvar. Various quantities include bus voltage
magnitude and angle, bus total generator Mvar injection, generator Mvar injection, branch MW
and Mvar flow, and interface MW and Mvar flow.
Time Step Simulation Enhancements
 Added the storage of the Custom Inputs to the TSB file format.
 Added the storage of the Custom Results for Loads to the TSB file format.
 When using the column plotting option to plot time points, time scale will now be in seconds if no
difference between time points is greater than one minute.
 Modified the Time Step processing when using the SCOPF algorithm at each time step so that
less messaging is sent to the Time Step dialog regarding the progress of the SCOPF solution.
All the messaging to status edit boxes on the Time Step dialog was greatly slowing down the
solution process.
Transient Stability
 Transient Model Modification
 Added ability to specify whether to use the Runga-Kutta Order 2 (RK2) or Euler's method
for the integration time step.
 Added a new option to specify the type of Exciter Saturation Model function. Choices are
Quadratic, Scaled Quadratic, or Exponential.
 Transient Limit Monitoring
 Modified the ability of Action To Take option to allow an option "Trip (Open) Device". The
option will trip/open a device" if a monitoring violation occurs (this works for Buses, AC
Lines, Generators, Loads, and DC Lines).
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 Transient Plots
 Added the ability to add to a Plot a Title Block including an image logo, text, and a date.
 Added the ability to specify special strings such as "@CTGName" which will automatically
determine an appropriate string to place in the Plot Title Block Memos, Axis Title captions,
Chart Title, or Chart Footer. @CTGNAME will display the appropriate contingency name;
@CASENAME will show the name of the case presently open; @BUILDDATE will show the
Simulator patch build date; @DATETIME will show the present date and time; @DATE will
show the present date; @TIME will show the present time.
 Added the ability to automatically save plot images during a transient stability run. The
images will be saved in the same directory as the defined hard-drive storage directory.
 Transient Stability File Format Support
 Modified the loading of GE DYD files to also accept a file extension of "DYC". When loading
a DYC file no prompt will appear asking about deleting existing stability models. The
assumption is that it will append to existing models.
 Added the ability to read a "DYR file with options". When choosing this, you may specify a
MCRE *.rwm file to split up generators, a MTRLD *.dat file to split up motors, a GNET *.idv
file to disable generator models, and a BASEGEN *.dat to specify the Governor Response
Limits flag for generators.
 Added the ability to load the MCRE, MTRLD, GNET, and BASEGEN files each separately if
desired.
 When writing out a DYR file, we now automatically write out a GNET *.idv and a BASEGEN
*.dat file. The filename and path used will be the same as for the DYR file, except "_GNET"
and "_BASEGEN" are appended to the filenames.
 Transient Stability Contingency Definitions
 Added a new transient contingency event for "OPEN BUS" which opens all AC lines
connected to a bus.
 Added ability to open only one end of a transmission branch in the transient contingency
event.
 Added the ability to assign a model criteria to a transient contingency action. The action will
then only be applied if the initial conditions meet the model criteria.
 Added ability to define transient contingency definitions based on an injection group. The
only action allowed is Open and the user must specify whether to open generation, load or
shunts. In addition they must specify the amount to open. When the contingency action is
implemented the amount to open will be based on the initial condition of the device (not
the transient condition), and devices will be opened in order of highest participation factor
to lowest participation until at least the amount specified has been exceeded.
 Transient Stability Script Actions
 TSSolveAll - Solves all specified transient contingencies.
 TSSolve("ContingencyName", [StartTime, StopTime, StepSize]) - Solves only the specified
transient contingency. StartTime, StopTime, and Stepsize are specified in seconds.
 TSWriteOptions("FileName", [opt1, opt2, ... opt5], KeyField) - Save the transient stability
option settings to an auxiliary file specified by FileName. Opt1 through Opt5 should be set
to YES or NO according to the specific option categories to save. These parameters are
optional and the default is YES for any parameter not specified. opt1 - Save Dynamic
Models; opt2 - Save Stability Options; opt3 - Save Stability Events; opt4 - Save Results
Settings; opt5 - Save Plot Definitions; KeyField – Optional parameter. Primary, Secondary,
or Label. If not specified set to Primary by default.
 TSCalculateSMIBEigenValues - Calculate single machine infinite bus eigenvalues.
Initialization to the start time is always done before calculating eigenvalues.
 TSSaveTwoBusEquivalent("PWBFileName",[BUS busnum]) - Save the two bus equivalent
model of a specified bus to a PWB file. Initialization to the start time is always done before
saving the two bus equivalent. “PWBFileName” – name of the PWB file to which to save.
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Bus can be specified by number [BUS busnum], name/nominal kV combination [BUS
"busname_nominalKV"], or label [BUS "buslabel"].
 TSLoadGE("FileName",GENCCYN) - Loads transient stability data stored in the GE DYD
format. “FileName” – name of the DYD file to load. GENCCYN - YES or NO. Set to YES to
split combined cycle units. Set to NO to leave them alone.
 TSLoadBPA("FileName") - Loads transient stability data stored in the BPA format.
“FIleName” – name of the BPA file to load
 TSLoadPTI("FileName", "MCREfilename", "MTRLOfilename", "GNETfilename",
"BASEGENfilename") - Loads transient stability data in the PTI format. “FileName” – name
of the DYR file to load. This is NOT an optional field. All of the files listed after are optional.
If not loading these particular files, specify an empty string, " ".
 Transient Stability Storage
 Added support for storing interface MW, Mvar, and MVA flows as part of the transient
stability results.
 Added ability to store switched shunt, to store injection group MW and Mvar outputs, and to
store multi-terminal DC record results in transient stability
 When choosing to store results to the Hard Drive, previously if no directory was specified to
which results should be saved then results would not be saved to hard drive at all. Now if
the directory is blank, Simulator will default to save data in the same directory as the case
was loaded from. Note that if an invalid directory is specified it will offer the opportunity to
create the directory or abort the run.
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Help
On-line help is available in PowerWorld Simulator via the Help ribbon group on the Window ribbon
tab, or by pressing the F1 key on many dialogs and displays. Context-sensitive help is available on the
oneline diagrams. To obtain object specific help, position the mouse over the object in question on the
oneline and press the F1 key.
Sample power flow cases and other information are available at the PowerWorld web site:
http://www.powerworld.com
Contact technical support at support@powerworld.com for answers to your questions regarding any
PowerWorld product. Or call us at (217) 384-6330.
PowerWorld Corporation
2001 S. First Street
Suite 203
Champaign, IL 61820
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Contact Information
PowerWorld Corporation
2001 South First Street
Champaign, IL 61820
Phone: (217) 384-6330
Fax: (217) 384-6329
Toll Free: (877) 748-7840 - U.S. and Canada only
General Information: info@powerworld.com
Technical Support: support@powerworld.com
Sales: sales@powerworld.com
www.powerworld.com
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Windows Basics
Operating System
Simulator runs under all Windows XP and later Microsoft Windows Operating Systems.
Mouse Conventions
Since much of the interaction between Simulator and the user is accomplished by using the mouse,
we have designed the interface to obey consistent conventions for mouse usage. In general, the
left-mouse button is used to affect some sort of immediate change or control over a power system
element, while the right mouse button is used to gain more information about a power system
element or to view a list of available options. More details on are provided throughout this manual.
Dialog Window Position, Size Tracking
As various dialogs are opened, PowerWorld will keep track of the Free-Floating/Contained style as
well as the position and size of each dialog. When that dialog is then opened again it will open to the
same style, size, and position as it was previously. These settings are stored in the Windows registry
so that they are remembered when the program is opened again. You can always reset all these
settings to their factory defaults by clicking the Reset to Default button on the Window Ribbon
Group in the Windows Ribbon Tab.
Dialog Window Styles (Free-Floating, Free-Floating On Top, and In Container)
By default, most dialogs or windows when opened are contained inside the main program window.
(The only general exception to this are dialogs that are opened as "modal" windows which you must
close before continuing to use the software.) You can change this default globally by choosing
Switch to Free-Floating Windows on the Window Ribbon Group in the Windows Ribbon Tab.
Alternatively, you can leave most windows in the container and individually choose to make specific
windows Free-Floating. This is done by left clicking on the icon in the upper left of the dialog to open
the windows system menu. This is allowed for all windows except for oneline diagrams. (Oneline
diagrams always appear inside the main container window.) For windows that we allow this for,
three choices will appear as shown below.
In Container Window
In Container Window is the same as the default behavior
for most windows. The dialog will be contained inside
the main program shell and can not be moved outside of
it.
Free-Floating on Top
Setting a window or dialog to Free-Floating on Top will
make the window float independent of the main program
shell. The dialog will also always remain on top of the
main program shell and thus can not get lost behind the
main program shell. The message log window is one of a
small number of windows that defaults to this behavior.
Free Floating
This style is the same as Free-Floating on Top, however
the dialog will become hidden behind the main program
window when the main program window becomes
active.
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Example Windows Styles
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PowerWorld Simulator: Getting Started
The key to using Simulator is to recognize that it has two distinct modes Edit Mode and Run Mode.
The Edit Mode is used to construct new simulation cases or to modify existing cases, while the Run
Mode is used to perform the actual power system simulation. You can easily switch between the
modes using the Edit Mode and Run Mode buttons in the Mode ribbon group.
If you are new to Simulator and seek a quick means of familiarizing yourself with it, we recommend
starting with the tutorials; see Creating a New Case or Starting with an Existing Case
Sample cases are provided with the software in the "Sample Cases" directory. If you’re interested in
learning by doing, you may wish to just open one of the sample cases and try the different Simulator
features.
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Edit Mode Introduction
The Edit Mode is used to create a new case or to modify existing cases. To switch to Edit Mode, click
on the Edit Mode button in the Mode ribbon group on any of the ribbon tabs.
Here is a sampling of things you can do in Edit Mode:








Create a new case; see New Case for details.
Create a new oneline diagram; see New Oneline for details.
Add new components graphically to an existing case; see Draw ribbon tab.
Modify the appearance of the oneline objects; see Formatting ribbon group for details.
View and modify a case using non-graphical lists displays; see Case Information Displays for
details.
Equivalence a case; see Equivalencing for details.
Append a subsystem to an existing case; see Appending a Case for details.

For more details on the Edit Mode please see Edit Mode Overview.
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Run Mode Introduction
The Run Mode is used to solve a single Power Flow Solution, run one of the available load flow tools,
or run a time-domain simulation of the power system. To access the Run Mode, click on the Run
Mode button in the Mode group of the Simulator Ribbon.
The key menu associated with the Run Mode is the Simulation menu. This menu allows you to perform
a single Power Flow Solution (however, it is quicker to use the Quick Access toolbar).
Other key components of the Run Mode include:











The oneline diagrams, which allow you to view the case graphically. See Oneline Diagram
Overview for details.
The Case Information Displays, which allow you to view the entire power system case using list
displays. See Case Information Displays for details.
Dialogs to change the simulation options and the Power Flow Solution. See Simulation Options for
details.
Scaling to allow easy variation in the load, shunts, and generation at any number of buses. See
Scaling for details.
Contouring, which shows a color contour representing the variation in any power system
parameter across a system. See Contouringfor details.
Transfer distribution factor calculations. See Power Transfer Distribution Factors for details.
Perform a fault analysis. See Fault Analysis for details.
Run Transfer Capability studies.
Perform an Optimal Power Flow (OPF) or Security Constrained Optimal Power Flow (SCOPF)
analysis.
Generate PV and QV curves.
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Script Mode Introduction
The Script Mode is used to access the Script Command window. Simulator scripting allows a method of
grouping multiple commands for sequential processing by Simulator. From the Script Command
Execution window, the user can manually enter script commands for processing, or load an auxiliary
file containing multiple script commands and data modification commands.
Some features in Simulator are available exclusively in either RUN mode or EDIT mode. This
functionality is preserved in the script language. If the Script Command Execution Dialog is opened
from Edit Mode, Simulator defaults to EDIT mode. If the Script Command Execution Dialog is opened
from Run Mode (or when a script is initially started), Simulator defaults to the RUNmode.
To switch modes, use the EnterMode (mode) script command.
There are also a number of general script actions that can be executed in either mode. See Script
General Actions for more details.
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Message Log
The Message Log displays detailed results of each Power Flow Solution, chronicling the solution
process iteration by iteration. It also reports messages raised by Simulator in performing various
operations, such as opening or validating a case. The Message Log can be helpful when you run into
problems solving a particular simulation case. The Message Log is not used with Viewer.
To display the Message Log, go to the Tools ribbon tab, and click the button
group. This button is also available on the Add Ons ribbon tab.

Log on the Log ribbon

The Message Log is one the few windows that is set by default to be Free-Floating On Top. This
means that the dialog floats independently of the main program window and always remains on top of
the main container window. If you would like to change this style to make the message log contained
inside the container window, see the Window Basics help for more information.
Message Log Local Menu
Right-clicking on the Message Log displays its local menu. To change the font characteristics of the
log, select Change Font.
To suppress or change color of certain messages associated with the power flow case select either
Suppress Messages or Color Messages and then the desired message whose characteristics
want to change. For more information about the colors and messages see the Message Log Options.
You can find certain text by clicking on Find, and then entering the text in the dialog displayed.
Also, you can highlight all the text in the log, or inversely unselect all the highlighted text by clicking
on Select All, or Unselect All, respectively. To print or copy the contents to the Windows clipboard
of a highlighted section of the message log, select Print Selection or Copy Selection to
Clipboard. You can also clear the contents of the log by selecting Clear Window. Lastly, you will
find some log options available, such as Change Maximum Lines, Disable Logging, Disable
Time Stamp, and Save Log to File options which allow automatically saving the log to a file
during load flow analysis.
Message Log Color Outlines and Color Background
When solving the power flow, there are several loops which occur that are discussed the Solving the
Power Flow Topic. These loops will generate Red, Purple, Green, and Blue outlines on the
message log to visually indicate which loop the message text is generated by. This helps in
determining which part of a the power flow solution may be having difficulty solving.
Additionally, when the various tools and add-ons send message text to the log the background of
the text will be colored to indicate this. For instance, contingency analysis actions will be highlighted
with a light blue background, while PV, QV, ATC, and OPF add-on message text will be highlighted
with a light yellow background.
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Custom and Memo Display
The Custom tab is now available on many dialogs and displays in Simulator. The purpose of the
custom tab is to allow the user to add their own custom information and comments to data and
objects in the load flow case. Simply switch to the Memo or Custom page on a display and start typing
in the memo box, or add values or text in the custom fields. The information added to these memo
pages is stored with the objects in the load flow case and saved to PWB files.
The custom fields section allows access to setting and changing the values for custom fields that have
been defined for the object. Defining custom fields is detailed in Custom Field Descriptions.
The custom section also contains a Selected? check box. This is a special field that is associated with
most objects in Simulator. In many of the places where filtering is allowed, filtering can be done based
on the Selected? field. Additional information about this field can be found under the Set Selected
Field topic.
The memo section of the dialog is simply a location to log information about the object. Any
information entered in the memo box will be stored with the case when the case is saved to a PWB
file.
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Status Bar
The Status Bar is displayed across the bottom of the PowerWorld Simulator window. The left-most
field of the status bar displays the current Simulator mode (Edit or Run). The remaining fields vary
depending on which mode of operation Simulator is currently in. The status bar displays Tool Tips
when the cursor is positioned over a toolbar button or menu item. The tool tip is also shown next to
the cursor after a short time delay.
Edit Mode
The Edit Mode status bar displays the Screen Coordinates of the cursor when positioned over a oneline
diagram.

Edit Mode Status Bar
Run Mode
The left side of the Run Mode status bar displays simulation status ("Solution Animation Stopped" or
"Solution Animation Running"), AC or DC depending on solution options and the Difference Flows
status ("Current Case", "Base Case", or "Difference Case").

Run Mode Status Bar (Left Side)
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Ribbons User Interface
PowerWorld's user interface consists of a ribbon across the top of the program. Important terminology
regarding the ribbon is depicted in the images below.

Ribbon
Ribbon
Tab

The entire strip across the top is called the ribbon
The ribbon consists of several ribbon tabs which group together features of the software
that are used together. Their are seven ribbons which have their own purposes and own
help topics listed as follows.
 Case Information Ribbon Tab: primarily used to navigate and look through all the
data in your model.
 Draw Ribbon Tab: primarily used to draw new oneline diagrams or edit existing
onelines by adding, moving, formatting, or resizing existing oneline objects. Most of
the options on the Draw ribbon tab are only available in Edit Mode.
 Onelines Ribbon Tab: primarily used after you have already created a oneline
diagram. This ribbon provides features for customizing the appearance of your
oneline diagram.
 Options Ribbon Tab: all of the buttons on this ribbon are also available on one of the
other ribbons, however this ribbon brings all the options in the software into one
place.
 Tools Ribbon Tab: this ribbon provides access to all of the analysis tools that are
available in the base package of PowerWorld Simulator. You will use this ribbon
when you are performing power flow analysis, contingency analysis, or using the
sensitivities tools for instance.
 Add Ons Ribbon Tab: this ribbon provides access to all the add-on tools available for
Simulator including the OPF, SCOPF, ATC, and PVQV tools. If you have not
purchased these tools then the options will be grayed out.
 Windows Ribbon Tab: this ribbon provides access to customizing the Windows in the
User Interface. It also has some information reading help topics .
The goal in designing these ribbons was to create several task specific ribbons which
represent the various ways that the software is used. Our hope is that you will not spend
a lot of time flipping back and forth between ribbons. If you find yourself doing this
please contact PowerWorld Corporation to help us make the software better for the
future.

Ribbon
Group

Inside a particular ribbon tab, there are around 4 to 7 groupings called ribbon groups.
The following image shows three ribbon groups (Individual Insert, Select, and
Formatting) with various buttons and menus available.
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ribbon groups join sets of buttons and menus that are related to one another. The large
buttons and icons are used to draw attention to the most commonly used features of the
software. All features are still available through drop-down menus in the same manner
as was available previously. Our design goal in creating and laying out the ribbons was
to provide the new user with insight about using the software, while at the same time
giving the experienced user quick access to common features.
Large Button

Large Button
Menu
Small Button
With Caption
Small Button
Menu
Small Button
without
Caption
Menu
Only Caption

Help
Button
Quick
Access
Toolbar

Clicking the help button on the right edge of the ribbon brings up this online help
The quick access toolbar at the top left of the ribbon (near the Application Button)
contains small buttons with no caption that are always visible. For more information
about how to use and customize this see the Quick Access Toolbar help.

Applicati
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on Title
Bar
Applicati
on
Button

Click on this to bring up the Application File Menu shown below. For more information
about using the Application File Menu see the Application File Menu help.
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Quick Access Toolbar
The Ribbon Quick Access Toolbar provides you with quick access to the most frequently used buttons.
These buttons are found in the top left portion of the Ribbon just to the right of the Application
Button. The default buttons that appear in the Quick Access Toolbar are shown in the figure below.

The eight default buttons are as follows from left to right.









Save Case
Open Auxiliary File
Model Explorer
Display Bus View
Message Log
Simulator Options
Single Solution
Abort

The Quick Access Toolbar can also be customized very simply. If you find a button that you would like
quicker access to, simply right-click on the button and then choose Add to Quick Access Toolbar. The
small icon version of the button will then immediately appear up in the Quick Access Toolbar. This is
depicted in the image below.

The Quick Access Toolbar can also be modified to show the Toolbar Below the Ribbon providing more
space for specifying buttons.
Also experiment with Showing the Quick Access Toolbar below the Ribbon or Minimizing the Ribbon.
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Add Ons Ribbon Tab
The Add Ons ribbon consists of buttons and menus that access to the various Simulator Add On Tools.
The ribbon is shown below when configured for the OPF, SCOPF, PVQV, ATC, Transient Stability, and
Topology Processing add on tools.

The Tools ribbon is broken into seven ribbon groups
Mode Ribbon Group
Edit Mode
Switches the program to Edit Mode, which can be used to build a new case or to modify an
existing one.
Run Mode
Switches the program to Run Mode, which can be used to perform a single Power Flow
Solution or a timed simulation with animation.
Log Ribbon Group
Abort
Terminates the current Power Flow Solution. If the application is performing a timed
simulation, pressing the abort button will pause the simulation. See PowerWorld Simulation
Control for more details.
Log
Toggles the display of the message log window. The log window shows what is going on with
the Power Flow Solution process and may prove useful when you are trying to track down a
problem with a non-converging model.
Script
Opens the Script dialog, which can be used to call script commands or open auxiliary files
containing script commands and data modifications. Note that the drop-down next to the
Script button give convenient access to the Quick Auxiliary Files.
Optimal Power Flow (OPF) Ribbon Group
Primal LP
Click this button to solve the OPF. A more detailed description of what this does is found in
the topic OPF LP Primal.
Security Constrained OPF
Click this button to open the Security Constrained OPF Dialog.
OPF Options and Results
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Click this button to open the OPF Options and Results Dialog.
OPF Case Info Menu
The OPF Case Info Menu provides direct access to several case information displays that
show default columns related to input and ouptut of the Optimal Power Flow. Instead of using
this menu, PowerWorld encourages you leave the Model Explorer open and navigate using
the Explore Pane on the Model Explorer. All of these options are available under the Optimal
Power Flow folder on the Model Explorer.

PV and QV Curve (PVQV) Ribbon Group
PV Curves
Click this button to open the PV Curves dialog.
QV Curves
Click this button to open the QV Curves dialog.
Refine Model
Click this button to open the Refine Model Dialog.
Transient Stability (TS) Ribbon Group
Transient Stability
Click this button to open the Transient Stability Analysis dialog.
Stability Case Info Menu
The Stability Case Info Menu provides direct access to several case information displays that
show default columns related to input and output of the transient stability tool.
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Topology Processing Ribbon Group
Topology Processing
Click this button to open the Topology Processing Dialog.
Available Transfer Capability Ribbon Group
Available Transfer Capability
Click this button to open the Available Transfer Capability Dialog.
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Case Information Ribbon Tab
The Case Information ribbon consists of buttons and menus that provide access to the information
about the power system model. The ribbon is shown below

The Case Information ribbon is broken into four ribbon groups
Mode Ribbon Group
Edit Mode
Switches the program to Edit Mode, which can be used to build a new case or to modify an
existing one.
Run Mode
Switches the program to Run Mode, which can be used to perform a single Power Flow
Solution or a timed simulation with animation.
Case Information Ribbon Group
Model Explorer
Opens the Model Explorer giving access to all the case information displays for the
model.
Area/Zone Filters
Opens the Area/Zone/Owner Filters display which allows filtering of the case information
displays by Area, Zone, and Owner.
Limit Monitoring
Opens the Limit Monitoring Settings and Limit Violations Dialog which allows you to specify
what to monitor in the various analysis tools.
Menus for Network, Aggregation, and Filters, Expression, Etc
These three menus all perform the same action as opening the Model Explorer, except that
they automatically set the Explore Pane of the Model Explorer to show the respective case
information display. Instead of using these menus, PowerWorld encourages you leave the
Model Explorer open and navigate using the Explore Pane on the Model Explorer.

33
©2011 PowerWorld Corporation

Case Data Ribbon Group
Difference Flows Menu
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Difference Flows: Opens the Difference Flows Dialog
Present Topological Differences From Base Case: Opens the Present Topological Differences
From Base Case Dialog.
The remaining options in this menu all replicate the same behavior available on the
Difference Flows Dialog. For more details so that dialog.
Simulator Options
Opens the Simulator Options Dialog.
Case Description
Opens the Case Description Dialog.
Case Summary
Opens the Case Summary Dialog.
Custom Case Info
Opens the Custom Case Information Display
Power Flow List
Opens the Power Flow List
Quick Power Flow List
Opens the Quick Power Flow List
AUX Export Format Desc
Opens the Auxiliary File Export Format Description Dialog for Power System Objects.
Views Ribbon Group
Bus View
Opens the Bus View Oneline which provides a graphical display which allows you to quickly
browse information about a bus and everything connect to that bus.
Substation View
Opens the Substation View Oneline which provides a graphical display which allows you to
quickly browse information about a bus and everything connect to that substation.
Open Windows Menu
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The Open Windows Menu provides a convenient method of switching between open windows.
This includes User Interface Dialogs, Case Information Displays, and Oneline diagrams.
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Draw Ribbon Tab
The Draw ribbon tab is primarily used to draw new oneline diagrams or edit existing onelines by
adding, moving, formatting, or resizing existing oneline objects. Most of the options on the Draw
ribbon tab are only available in Edit Mode. The Draw ribbon tab is shown below.

The Draw ribbon consists of seven ribbon groups described as follows
Mode Ribbon Group
Edit Mode
Switches the program to Edit Mode, which can be used to build a new case or to modify an
existing one.
Run Mode
Switches the program to Run Mode, which can be used to perform a single Power Flow
Solution or a timed simulation with animation.
Quick Insert Ribbon Group
The Quick Insert ribbon group contains buttons for creating a oneline diagram for a system
model you have already read into Simulator. If you are building out your network (or even
substation, area, or zone diagram), then using the Insert Palettes along with the Auto Insert
routines is most efficient. For detailed help see the Quick Insert ribbon group. If you would
instead like help on inserting a single object on your oneline diagram see the see the Individual
Insert ribbon group topic.
Individual Insert Ribbon Group
The Individual Insert ribbon group contains menus which provide access to buttons for inserting
individual oneline objects to the oneline diagram. If you are building out your network (or even
substation, area, or zone diagram), then it is much more efficient to use the Quick Insert ribbon
group. However, for complete access to all objects including those that can not be "quick inserted", see the help under the Individual Insert ribbon group topic.
Select Ribbon Group
The Select ribbon group contains options to help select multiple oneline objects simultaneously.
For more detailed help see the Selection ribbon group topic for more detailed help.
Formatting Ribbon Group
The Format ribbon group contains options for formatting the selected objects on your active
oneline. For more detailed help see the Formatting ribbon group topic for more detailed help.
Clipboard Ribbon Group
The Clipboard ribbon group contains options for copying and pasting oneline display objects.
For more detailed help see the Clipboard ribbon group topic for more detailed help.
Zoom Ribbon Group
The Zoom ribbon group contains buttons for navigating a oneline diagram. For more detailed
help see the Zoom ribbon group topic
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Clipboard Ribbon Group
The Clipboard ribbon group contains options for copying and pasting oneline objects while your are in
Edit Mode. It also provides access to the Undo drawing feature. This ribbon group is on the Draw
ribbon tab. The Group is shown below.

Undo
The Undo command is used in the edit mode to undo the last change made on the oneline
diagram. The Undo command will only undo graphical changes, and will not undo any data
changes in the power system model. See Relationship Between Display Objects and the
Power System Model for information on the display/model relationships.
Paste
The paste command copies the contents of the paste buffer (if any) onto the display at the
current cursor location. Use the Paste command from the Edit Menu. Note that the paste
buffer may contain both display objects and the underlying power system records. When
pasting, the display objects are pasted regardless of whether an identical display object
already exists on the oneline. In contrast, duplicate power system records are never pasted.
This is because, for example, it is acceptable to have two display objects referring to the
same generator, but the generator exists only as a single entity in the power system model.
See Relationship Between Display Objects and the Power System Model for further details.
Paste Special
Paste Special works the same as Paste, however it will also show a dialog asking the you to
choose between
Absolute Coordinates : objects will be pasted using the exact same x/y coordinate as the
copied objects had. This is useful when copying objects between two different oneline
diagrams which contain the same geographic background.
Coordinates Relative to Cursor : objects will be pasted relative to cursor instead of using
the exact x/y coordinates as the copied objects.
Copy
The Copy Command copies the currently selected object(s) into the paste buffer without
deleting them. For power system objects, such as buses, generators or transmission lines,
you are given an option of whether to copy just the display object(s), or copy both the display
object(s) and their underlying power system records. See Relationship Between Display
Objects and the Power System Model for further explanation of these choices. To copy only
the display object(s) and never the power system records from now on, select the Always
Copy Object(s) Only option. You will not be prompted again. You can disable this selection
on the Default Drawing Options Dialog.
Cut
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The Cut Command is used in the Edit Mode to delete the currently selected object(s). To
delete a set of objects, first select the objects. Then select the Cut command from the Edit
Menu. For power system objects, such as buses, generators or transmission lines, you are
given an option of whether to delete just the display object(s), or delete both the display
object(s) and their underlying power system records. See Relationship Between Display
Objects and the Power System Model for further explanation of these choices. To delete only
the display object(s) and never the power system records from now on, select the Always
Delete Object(s) Only option. You will not be prompted again. You can disable this
selection on the Default Drawing Options Dialog.
Unlike Delete, Cut also copies the selection into the paste buffer.
Delete
The Delete Command is used in the Edit Mode to delete the currently selected object(s). To
delete a set of objects, first select the objects. Then select the Delete command from the
Edit menu. For power system objects, such as buses, generators or transmission lines, you
are given an option of whether to delete just the display object(s), or delete both the display
object(s) and their underlying power system records. See Relationship Between Display
Objects and the Power System Model for further explanation of these choices. To delete only
the display object(s) and never the power system records from now on, select the Always
Delete Object(s) Only option. You will not be prompted again. You can disable this
selection on the Default Drawing Options Dialog.
Unlike Cut, Delete does not copy the selection into the paste buffer.
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Formatting Ribbon Group
The Formatting ribbon group contains options for formatting the selected objects on your active
oneline. This group is on the Draw ribbon tab and its options are available only in Edit mode. The
options allow you to control such display object attributes as font, color, line styles, zoom-dependent
vissibility, and display layer level. The group is shown below.

A description of the actions on this group are as follows.

Format Buttons
Clicking this button will open the Format Dialog. The dialog which opens will have five tabs as
follows.
Font
Select this option to change the font with which the selected objects are displayed. The Font
Tab of the Format Selection Dialog is displayed.
Line/Fill
Select this option to change the line thickness and style with which a display object is drawn,
or the fill color for closed shapes. The Line/Fill Tab of the Format Selection Dialog is
displayed.
Levels/Layers
Select this option to change the stack level of an object, the layer the object is contained in,
and optional settings for when an object should resize. The Levels/Layers Tab of the Format
Selection Dialog is displayed.
Display/Size
Simulator can change the attributes of the way multiple objects are displayed using this
option, which opens the Display/Size page of the Format Selection Dialog. The size of the
objects can be adjusted, as well as the orientation of the object(s) from their terminal buses.
Objects can also be Anchored to their terminal buses or devices, or marked as Immobile,
meaning the object(s) cannot be moved on the oneline diagram.
Field
Select this option to change the attributes related to object text fields which are selected. The
Field Tab of the Format Selection Dialog is displayed.
Anchors
Invokes a command to refresh anchors on all oneline objects.
Copy Format and Paste Format Buttons
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The button on the left is the Copy Format button. After selecting an object this will copy all the
format properties of that object into an internal buffer. When you then subsequently select other
objects, you can click on the button on the right which is the Paste Format button. Clicking the
Paste Format button will bring up the Paste Format Dialog.
Send to Back, Bring to Front Buttons
After selecting a group of oneline objects using any of the methods described on the Select ribbon
group, you may then click the Send to Back button to cause all the objects selected to move to
underneath other objects. Click the Bring to Front button to bring objects to the top.
The Send to Back and Bring to Front menu options govern the visibility of display objects that
occupy the same screen stack level. All objects have an associated screen stack level, which may be
one of Base, Background, Middle, or Top. Objects having a screen stack level of Top obscure all
objects having stack levels of Middle, Background, or Base that occupy the same region of the
screen. They may or may not obscure objects having the same stack level of Top depending on the
order in which the objects having the same stack level are drawn. Selecting Send to Back for a
selected object will cause it to be obscured by all other same-level objects that occupy its location.
Selecting Bring to Front for a selected object will cause it to be drawn above all other same-level
objects that occupy the same region of the screen. The Send to Back and Bring to Front menu
options govern relative placement of objects only within stack levels. The Send to Back and Bring to
Front options do not affect the relative placement of objects having different stack levels.
Alignment Menu
The alignment menu provides access to the Alignment Dialog and direct access to options to align
the selected objects as specified in the menu items.
Grouping Menu
Grouping is only available for background oneline objects (background lines, ellipses, text, etc...).
This menu provides button to Group and Un-Group objects.
Layers Menu
The Layers Menus provide access for opening the Define Layers Dialog for the presently active
oneline diagram.
Underneath the button for defining layers is a list of the presently defined layers. You may check or
uncheck the various layers to hide or show the objects in those layers.
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Individual Insert Ribbon Group
The Individual Insert ribbon group contains menus which provide access to buttons for inserting
individual oneline objects to the oneline diagram. If you are building out your network (or even
substation, area, or zone diagram), then it is much more efficient to use the Quick Insert Group. The
Individual Insert group is shown below.

The six menus available on the group categorize the objects that can be placed on the oneline
diagrams. A summary of what is in each menu is described blow along with a picture of each of the six
menus.
Network Menu
The objects in this menu represent network model objects. Generally these represent actual physical
devices such as a generator or transmission line. They are similar to the model objects found in the
Network Folder on the Explore Pane of the Model Explorer.
Aggregation Menu
The objects in this menu represent model objects that represent an aggregation of other model
objects such as interfaces or injection groups. They are similar to the data objects found in the
Aggregation Folder on the Explore Pane of the Model Explorer.
Background Menu
The objects in this menu represent objects that are only background text and do not link to any of
the objects you would look at in the Model Explorer. Some of the objects link to external objects
such as documents, but not to elements of the model.
Pies/Gauges Menu
The objects in this menu represent pie charts or gauges which link to the model data found in the
Model Explorer
Field Menu
The objects in this menu represent fields which link to the model data found in the Model Explorer
Indication Menu
The objects in this menu represent indications of status or flow for objects that are found in the
model data found in the Model Explorer

42
©2011 PowerWorld Corporation

43
©2011 PowerWorld Corporation

Quick Insert Ribbon Group
The Quick Insert ribbon group contains buttons for creating a oneline diagram for a system model you
have already read into Simulator. If you are building out your network (or even substation, area, or
zone diagram), then using the Insert Palettes along with the Auto Insert routines is most efficient. If
you would instead like help on inserting a single object on your oneline diagram see the Individual
Insert ribbon group topic. Both of the ribbon groups are on the Draw ribbon tab. The Quick Insert
ribbon group is shown as follows.

Show Insert Palette for Menu
Choosing any of the items in the Show Insert Palette for
Menu will open up its respective Insert Palette. This Insert
palettes show a list of all objects that are already shown on
the oneline diagram as well as a list of objects which are
not. For more information see the Using the Insert Palettes
help topic.

Show Insert Palette for Menu
The first six options are used to automatically insert network
display objects that are connected to bus objects that have
already been drawn on the oneline.
Lines : Shows the Automatically Insert Lines Dialog
Interfaces : Shows the Automatically Insert Interfaces
Dialog
Generators : Shows the Automatically Insert Generators
Dialog
Loads : Shows the Automatically Insert Loads Dialog
Switched Shunts : Shows the Automatically Insert
Switched Shunts Dialog
Lines, Gens, Loads, Shunts : Shows a dialog for autoinserting lines, generators, loads, and shunts
simultaneously.
Reset Stub Locations : Will completely redo the
positioning of objects anchored to buses and substations in
the manner done when auto-inserting lines, gens, load, and
switched shunts.
The next four options provide methods for adding pie
charts, fields, circuit breakers and line flow objects around
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objects that have already been drawn on the oneline
diagram.
Line Flow Pie Charts : Select this to automatically insert
line flow pie charts on the transmission lines or transformers
objects that are selected.
Circuit Breakers : Select this to automatically insert circuit
breakers on the transmission lines or transformers objects
that are selected.
Line Flow Objects : Select this option to automatically
insert line flow objects on the transmission lines or
transformers objects that are selected.
Interface Flow Objects : Select this option to
automatically insert Interface flow objects on the interface
objects. The Interface Flow Arrow Object which behaves
very similar to the Line Flow Object show an arrow to
represent the MW flow direction and then shown text for
MW value and Mvar value with a sign relative to the MW
flow direction.
Add Fields Around : Select this option to insert fields
around the presently selected objects. It will then bring up
the Inserting and Placing Multiple Display Objects Dialog
The follow two options provide a mechanism for autoinserting bus or substation oneline objects. You must have
geographic longitude/latitude information in order to use
these options.
Buses : Shows the Automatically Insert Buses Dialog
Substations : Shows the Automatically Insert Substations
Dialog
The last two options provide a mechanism for inserting
background lines that represent geographic borders or from
a Shapefile.
Borders : Shows the Automatically Insert Borders Dialog
Insert GIS Data From Shapefile : Shows the Shapefile
Import Dialog
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Select Ribbon Group
The Select ribbon group contains options to help select multiple oneline objects simulateously. The
features in this topic are only available when you are in Edit Mode. This ribbon group is on the Draw
ribbon tab. The Group is shown below.

The features available on this ribbon group are described below.
Select by Criteria
Click on the Select by Criteria button to open the Select by Criteria Dialog. On oneline diagrams of
even a modest size, this is an extremely useful feature and PowerWorld highly encourages you to
use this feature.
Select Region
Use to select all objects in a particular region of the oneline. When the Region Type is Rectangle
or Ellipse, then after clicking the button, click and hold the left mouse button on the oneline at the
point where you would like to begin the selection. Then, drag the mouse to size the selection shape.
Finally, let go of the mouse button once every object you need to select has been selected by the
selection rectangle. When the Region Type is Polygon, then after clicking this button single click on
your oneline diagram for each vertex of the polygon. Finally, finish the selection by double-clicking
the mouse after which all objects inside your polygon will be selected.
Depending on the Select Mode below, every object located entirely Inside the region, or if you
have chosen Touching, then every object inside or partially touched will be selected. Selected
objects will have handles appear indicating that they have been selected.
Region Type
Specify a Rectangle, Polygon, or Ellipse. This controls the shape used to select objects on the
oneline diagram when using the Select Region button above.
Select Mode
This combo box specifies how the Select Region button above works. Choose Inside in order to
select only the objects completely inside the selection rectangle. Choose Touching in order to select
every object either partially touched by or completely inside the selection rectangle.
There are also other ways to select multiple objects



You can also select multiple objects manually by holding down the SHIFT key which clicking on
objects in Edit Mode. This will also add to your selection.
If you hold down the SHIFT and CTRL keys simultaneously and then click on your oneline diagram
and select a region it has the same affect as click on the Select Region button and selecting a
region on your oneline
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Onelines Ribbon Tab
The Onelines ribbon tab generally consists of buttons and menus that provide access to modifying the
appearance of a oneline diagram you have already created. For access to features regarding adding,
moving, resizing, and formatting objects, see the Draw ribbon tab. The Oneline ribbon is shown below.

The Options ribbon consists of buttons and menus that provide access to customizing the software
options. The ribbon is shown below.
Mode Ribbon Group
Edit Mode
Switches the program to Edit Mode, which can be used to build a new case or to modify an
existing one.
Run Mode
Switches the program to Run Mode, which can be used to perform a single Power Flow
Solution or a timed simulation with animation.
Active Ribbon Group
The Active ribbon group contains basic methods for customizing the appearance of basic
analysis tools for customizing an existing oneline diagram. For more detailed help see the Active
ribbon group topic
Zoom Ribbon Group
The Zoom ribbon group contains buttons for navigating a oneline diagram. For more detailed
help see the Zoom ribbon group topic
General Options Ribbon Group
Dynamic Formatting Menu
This menu provides access to setting the Dynamic Formatting Options that apply to the active
oneline, as well as formatting that applies to all onelines and Case Information Displays.

Custom Hint Values
Provides access to setting the Custom Hint Values that apply to all oneline objects..
Default Drawing Values
Provides access to the Default Drawing Values.
Toggle Full Screen
Click this button to cause the presently active oneline to be toggled to full screen.
Keyboard Shortcuts
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Click on this button to open the dialog for defining Keyboard Shortcuts which allow you to
open a oneline or auxiliary file directly from a function key.
Views Ribbon Group
Bus View
Opens the Bus View Oneline which provides a graphical display which allows you to quickly
browse information about a bus and everything connect to that bus.
Substation View
Opens the Substation View Oneline which provides a graphical display which allows you to
quickly browse information about a bus and everything connect to that substation.
Open Windows Menu
The Open Windows Menu provides a convenient method of switching between open windows.
This includes User Interface Dialogs, Case Information Displays, and Oneline diagrams.

48
©2011 PowerWorld Corporation

Active Ribbon Group
The Active ribbon group contains basic methods for customizing the appearance of basic analysis tools
for customizing an existing oneline diagram.

Oneline Display Options
Opens the Oneline Display Options Dialog.
Contouring and Menu
Click the top part of the button to open the Contouring Dialog.
Otherwise, click the drop-down to provide direct access to many of the Contouring Options.
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GIS Tools Menu
Provides access to many Geographic Information System related tools that have been built into the
software.

Insert GIS Data From Shapefile : Opens the Shapefile Import dialog.
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Export Oneline as Shapefile : Choose this to Export the Oneline as a Shapefile.
Populate Lon,Lat with Display X,Y : Choose this to populate the Bus records latitude and
longitude information based on the locations on the present oneline diagram. For more information
see the Populate help topic.
Closest Facilities to Point : Choose this to bring up the Closest Facility to Point feature.
Great Circle Distance : Choose this to calculate the Great Circle Distance between two points.
Insert Measure Line : Provides access to the Insert Measure Line Feature.
Delete All Measure Lines : Provides access to the Delete All Measure Lines feature.
List Displays Menu
Contains access to several ways of viewing the oneline objects inside of "case information displays".
Of course instead of seeing case information, you instead see information about the oneline objects.

All Display Objects: Opens the Display Explorer providing access to all objects on the active
oneline.
Unlinked Display Objects : Opens the Unlinked Display Objects Dialog.
Ony Selected Display Opbjects : Opens the Display Explorer providing access to objects on the
active oneline, but defaults that explorer to only show the presently selected objects.
Browse Open Onelines: Brings up the Browse Open Onelines dialog.
Display Objects Export Format Description : Opens a Display Objects Export Format
Description dialog.
Layers Menu
The Layers Menus provide access for opening the Define Layers Dialog for the presently active
oneline diagram.
Underneath the button for defining layers is a list of the presently defined layers. You may check or
uncheck the various layers to hide or show the objects in those layers.
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Save View
Choose this option to open the Save Views Dialog.
2D View / 3D View
Toggle between 2D and 3D to change the presently active oneline between the 2D and 3D modes.
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Zoom Ribbon Group
The Zoom Ribbon Group is on both the Onelines ribbon tab and the Draw ribbon tab. To display large
detailed power systems, Simulator’s onelines possess zooming and panning capabilities. The Zoom
Ribbon Group enables you to prescribe a zoom level either by directly specifying a zoom value or by
selecting a rectangular region of the diagram on which to focus. There is also a button to open a
dialog box from which you can select a bus on which to center the display. See Zooming and Panning
for more information.

This toolbar contains the following several buttons for zooming the presently active oneline.






Zoom Area In /Out : The top two buttons can be clicked to zoom or out on a particular area of
the oneline. When you click these buttons, the cursor will change to a cross-hair waiting for you to
choose the region to zoom into (or out of)
Zoom In / Out : The middle two buttons can be clicked to change your mouse into a zooming
tool. After choosing the button with a plus sign, each time you click on the oneline you will zoom
in on that location. When choosing the button with a negative sign you will zoom out instead.
Present Zoom Level: the number represents the present zoom level and can be manually
changed to modify the zoom level.
Show Full : Automatically zooms and pans the presently active oneline diagram so that all objects
on the oneline diagram can be seen.
Find: Provide access to the Find Object on Oneline Dialog
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Options Ribbon Tab
The Options ribbon consists of buttons and menus that provide access to customizing the software
options. All of the buttons on this ribbon are also available on one of the other ribbons, however this
ribbon brings all the options in the software into one place. The ribbon is shown below.

The Options ribbon is broken into four ribbon groups
Mode Ribbon Group
Edit Mode
Switches the program to Edit Mode, which can be used to build a new case or to modify an
existing one.
Run Mode
Switches the program to Run Mode, which can be used to perform a single Power Flow
Solution or a timed simulation with animation.
Case Options Ribbon Group
Simulator Options
Opens the Simulator Options Dialog.
Misc. Power Flow Menu
Provides more direct access to some miscellaneous options that are also found on the Opens
the Simulator Options Dialog.
Solution Menu
Provides more direct access to some options related to the power flow solution algorithm.
These options are all also available on the Simulator Options Dialog.
Case Info Options Menu
Provides more direct access to some options related to the appearance of case information
displays. These options are all also available on the Case Information Display Options on the
Simulator Options Dialog.
Oneline Options Ribbon Group
Oneline Display Options
Opens the Oneline Display Options Dialog.
Pie Chart Menu
Provides more direct access to options related to Pie Charts. These options are all also
available on the Oneline Display Options Dialogon the Pie Charts/Gauges page.
Animation Menu
Provides more direct access to options related to Animated Arrows. These options are all also
available on the Oneline Display Options Dialog on the Animated Flows page.
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Thumb Nail Menu
Provides more direct access to options related to Thumb Nail View. These options are all also
available on the Oneline Display Options Dialog on the ThumbNail View page.
Draw Grid Menu
Provides more direct access to options related to the Draw Grid. These options are all also
available on the Oneline Display Options Dialog.
Misc. Options Menu
Provides more direct access to miscellaneous options related to oneline diagrams. These
options are all also available on the Oneline Display Options Dialog.
Saved Options Menu
This menu provides direct access to the for toggling between different sets of options. These
different sets of options are defined on the Oneline Display Options Dialog by clicking on the
Save Options to Case button on that dialog..
General Options Ribbon Group
Dynamic Formatting Menu
This menu provides access to setting the Dynamic Formatting Options that apply to the active
oneline, as well as formatting that applies to all onelines and Case Information Displays.
Custom Hint Values
Provides access to setting the Custom Hint Values that apply to all oneline objects..
Default Drawing Values
Provides access to the Default Drawing Values.
Toggle Full Screen
Click this button to cause the presently active oneline to be toggled to full screen.
Keyboard Shortcuts
Click on this button to open the dialog for defining Keyboard Shortcuts which allow you to
open a oneline or auxiliary file directly from a function key.
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Solution Options Quick Menu
The Solution Options Quick Menu provides access to most of the solution options contained in the
Solution Options dialog in an individual manner through menu commands.

This quick menu contains the following default options:

















Solution Convergence Tolerance (MVA)
Maximum Solution Iterations
Maximum Outer Control Loop Iterations
Enable/Disable Only One Iteration
Enable/Disable Optimal Multiplier
Enable/Disable Enforcing Generator MW Limits
Enable/Disable Automatic Generation Control (ACE)
Enable/Disable Generator MVAR Checking
Enable/Disable Checking Generator MVAR Immediately
Enable/Disable Switched Shunt Control
Enable/Disable Transformer LTC Control
Enable/Disable Phase Shifter Control
Enable/Disable Modeling Phase Shifters as Discrete Controls
Enable/Disable Preventing Controller Oscillations
Set Island-Based AGC Control Type
Set Island-Based AGC Tolerance (MW)
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Tools Ribbon Tab
The Tools ribbon consists of buttons and menus that provide access to the analysis tools that come
with all versions of PowerWorld Simulator. Note: Features related to the various add-on tools including
OPF, SCOPF, PVQV Curve, and ATC are found on the Add Ons ribbon tab. The tools ribbon is shown
below

The Tools ribbon is broken into six ribbon groups
Mode Ribbon Group
Edit Mode
Switches the program to Edit Mode, which can be used to build a new case or to modify an
existing one.
Run Mode
Switches the program to Run Mode, which can be used to perform a single Power Flow
Solution or a timed simulation with animation.
Log Ribbon Group
Abort
Terminates the current Power Flow Solution. If the application is performing a timed
simulation, pressing the abort button will pause the simulation. See PowerWorld Simulation
Control for more details.
Log
Toggles the display of the message log window. The log window shows what is going on with
the Power Flow Solution process and may prove useful when you are trying to track down a
problem with a non-converging model.
Script
Opens the Script dialog, which can be used to call script commands or open auxiliary files
containing script commands and data modifications. Note that the drop-down next to the
Script button give convenient access to the Quick Auxiliary Files.
Power Flow Tools Ribbon Group
This group represents the basic solution actions for solving the power flow.
For more detailed help see the Power Flow Tools ribbon group topic.
Run Mode Ribbon Group
The Run Mode Ribbon Group contains basic analysis tools that are only available in Run Mode.
For more detailed help see the Run Mode Ribbon Group topic.
Other Tools Ribbon Group
The Other Tools Ribbon Group contains basic analysis tools that are normally available in both
Run Mode, and Edit Mode.
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For more detailed help see the Other Tools Ribbon Group topic.
Edit Mode Ribbon Group
The Edit Mode ribbon group contains basic analysis tools that are only available in Edit Mode.
For more detailed help see the Edit Mode Ribbon Group topic.
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Edit Mode Ribbon Group
The Edit Mode ribbon group contains basic analysis tools that are only available in Edit Mode. The
Group is shown below.

Equivalencing
Click this button to open the Equivalencing Dialog.
Modify Case Menu
The Modify Case Menu contains actions related to modifying the network model.
Tap Transmission Line: Opens the Tap Transmission Line Dialog.
Move Bus Equipment: Opens the Move Bus Equipment Dialog.
Split Bus: Open the Split Bus Dialog.
Merge Buses: Opens the Merge Buses Dialog.
List of Unused Bus Numbers: Clicking this button to get a list of unused bus numbers in the
model.
Append Case: Provides access to opening a case while appending.
Renumber Menu
The Renumber Menu contains actions related to renumbering data in the model.
Renumber Areas/Zones/Substations: Opens the Renumber Areas, Zones and Substations
Dialog.
Renumber Buses: Opens the Renumber Buses Dialog.
Renumber Multi-Section Line Dummy Buses: Allows user-specification of dummy bus numbers for
multi-section lines. See the section Multi-Section Line records > Renumber Dummy Buses
with the Multi-Section Lines Display topic for more information.
Renumber Three-Winding Transformer Star Buses: Allows user-specification of three-winding
transformer star bus numbers. See the section 3W Transformers records > Renumber Star
Buses with the Three Winding Transformer Display topic for more information.
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Other Tools Ribbon Group
The Other Tools ribbon group contains basic analysis tools that are normally available in both Run
Mode and Edit Mode. The group is shown below.

Limit Monitoring Settings
Opens the Limit Monitoring Settings Dialog.
Difference Flows Menu

Difference Flows: Opens the Difference Flows Dialog
Present Topological Differences From Base Case: Opens the Present Topological Differences From
Base Case Dialog.
The remaining options in this menu all replicate the same behavior available on the Difference Flows
Dialog. For more details so that dialog.
Scale Case
Opens the System Scaling Dialog.
Model Explorer
Opens the Model Explorer giving access to all the case information displays for the model.
Connections Menu
The Connection Menus contains actions related to analyzing the interconnectedness of the network
model. These may be considered Graph Theory routines.
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Determine Path Distances to Buses: Opens the Determine Patch Distances from Buses or Group
Dialog.
Determine Shortest Path Between: Opens the Determine Shortest Path Between Dialog.
Find Circulating MW or Mvar Flows: Opens the Mvar and MW Flow Cycle Dialog.
Facility Analysis: Open the Facility Analysis Dialog.
Branches that Create Islands: Opens the Branches that Create Islands Dialog.
Other Menu
The Other Menu contains other miscellaneous features.

Governor Power Flow: Opens the Governor Power Flow Dialog.
Set Generator Part. Factors: Opens the Set Generator Participation Factors Dialog
Set Selected Field for Network Cut: Opens the Set Selected Field for Network Cut Dialog
Set Selected From Selection: When a selection is chosen in Edit Mode, click this to set the
Selected? field to YES for that selection.
Create new Areas from Islands: When selected, Simulator will replace existing Area designations
of the buses in the case with new areas defined by the electrical islands existing in the case.
Charts Menu: The Charts menu is only available in Run Mode. It provides access to various charts
including the Area ACE Chart, Area Load and Generation Chart, Area Losses Chart, Area MW
Transactions Chart, and Area Average Cost Chart.
Browse PWB Header Files: When selected, Simulator will prompt you to specify a directory
containing PWB files for which you wish to preview the header (case description) text. Once the
directory has been specified, Simulator will obtain the case description for each PWB file in the
directory, and write them all into the Simulator message log.
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Run Mode Ribbon Group
The Run Mode ribbon group contains basic analysis tools that are only available in Run Mode. The
group is shown below.

Contingency Analysis
Click this button open the Contingency Analysis Dialog providing access to the automated processing
of a list of contingencies.
Sensitivities Menu
The Sensitivities Menu contains a list that provides access to all the sensitivity calculations available.

Power Transfer Distribution Factors (PTDFs) opens its associated dialog.
TLR Sensitivities / Generation Shift Factors opens its associated dialog.
Flow and Voltage Sensitivities opens its associated dialog.
Loss Sensitivities opens its associated dialog.
Fault Analysis
Click this button to open the Fault Analysis Dialog.
Time Step Simulation
Click this button to open the Time Step Simulation Dialog.
Line Loading Replicator
Click this button to open the Line Loading Replicator Dialog.
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Power Flow Tools Ribbon Group
The main function of the PowerWorld Simulator is to simulate the operation of an interconnected
power system. The simulation is accomplished by selecting Single Solution – Full Newton from
either the Quick Access Toolbar or the Power Flow Tools ribbon group on the Tools ribbon tab. This
activity performs a single Power Flow Solution. See Solving the Power Flow for more information.
The following tasks are also available from the Power Flow Tools ribbon group on the Tools ribbon
tab.

Single Solution – Full Newton
The main function of the PowerWorld Simulator is to simulate the operation of an interconnected
power system. The simulation is accomplished by selecting Single Solution – Full Newton from
the Power Flow Tools ribbon group on the Tools ribbon tab. This activity performs a single Power
Flow Solution. See Solving the Power Flow for more information. Also note that if presently in Edit
Mode, you wil be automatically taken to Run Mode when choosing this.
Simulator Options
When choosing any of the solution methods, the options as specified in the Simulator Options will
affect what calculation is performed. solves the power flow using the either the Full Newton AC load
flow or the DC Approximation load flow, as specified in the Simulator Options.
Play Button
Click this button to cause repeated solutions of the system and to cause the animation of oneline
diagrams
Pause/Stop Button
Click this button to stop the action of the Play button.
Restore Menu
The Restore menu offers option to either Restoring a Previous Solution or a Restore a Previous State

Sometimes a power flow attempt won't converge to a solution. When this occurs, the voltages
and angles calculated by the solution engine will not satisfy the real and reactive power balance
constraints at each bus. Then, the state currently stored in memory will not be an actual system
operating point. It is often very difficult to coax the system to solve once it has failed to
converge.
To help you recover from a solution attempt that has failed to converge (both timed simulations
and single solutions), Simulator offers you two options.
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After Simulator solves a system successfully, it will store the voltages and angles it found in
memory. If the changes that you then make to the system result in a system that can't be
solved, you can select Restore > Last Successful Solution from the Power Flow Tools
ribbon group on the Tools ribbon tab to reload the results of the last converged solution. After
reloading this information, Simulator will re-solve the system and refresh all displays.
In addition to restoring the last converged solution, Simulator also gives you the ability to restore
the state of the system as it was just prior to the unsuccessful solution attempt. This can be
thought of as "un-doing" the effect of the solution attempt. Before attempting a solution,
Simulator stores the state of the system in memory. If it solves the power flow successful,
Simulator will discard this pre-solution state. However, it the power flow fails to converge,
Simulator will keep the state in memory. To recover it, select Restore > State Before
Solution Attempt from the Power Flow Tools ribbon group on the Tools ribbon tab.
Simulator will replace the non-converged post-solution state with the pre-solution state and
refresh the displays. You can then play with the system to try to make it easier to solve.
If you are working with large systems, you should be aware that saving these system states can
consume a lot of memory. Therefore, Simulator offers you the option to disable one of both of
these features. To do this, select Simulator Options from the Case Options ribbon group on
the Options ribbon tab to open the Simulator Options Dialog, and then go to the Storage sub-tab
of the Solution tab. You will see two checkboxes there that can be modified to control whether or
not these extra system states are saved.
Solve Menu

Single Solution – Full Newton
The main function of the PowerWorld Simulator is to simulate the operation of an
interconnected power system. The simulation is accomplished by selecting Single Solution –
Full Newton from the Power Flow Tools ribbon group on the Tools ribbon tab, or from the
Quick Access Toolbar. This activity performs a single Power Flow Solution. See Solving the
Power Flow for more information. Also note that if presently in Edit Mode, you wil be
automatically taken to Run Mode when choosing this.
Polar NR Power Flow
This perform a Newton Rhapson power flow solution using polar coordinates instead of
rectangular coordinates as is normally done in Simulator.
DC Power Flow
This automatically change the Simulator Options to use the DC Approximation and then
immediately performs the DC power flow solution.
Reset to Flat Start
Select Solve > Reset to Flat Start from the Power Flow Tools ribbon group on the Tools
ribbon tab to initialize the Power Flow Solution to a "flat start." A flat start sets all the voltage
magnitudes and generator setpoint voltages to 1.0 per unit and all the voltage angles to zero.
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Usually, a flat start should be used only if the power flow is having problems converging. You
can also use the flat start option on the Simulator Options Dialog to initialize every solution
from a flat start.
Robust Solution Process
The Robust Solution Process provides a method to attempt to reach a solution when the
standard load flow (Newton-Raphson) solution fails. The robust process performs a solution in
a series of steps.
First, the robust solution will turn off all controls in the case. Then the load flow will be solved
using a fast decoupled power flow. If the fast decoupled power flow reaches a solution,
Simulator then immediately solves the load flow using the Newton-Raphson load flow, still
keeping the controls turned off. If the Newton-Raphson solution is also successful, Simulator
will begin adding controls back into the solution process, one type of control at a time. Thus
the generator MVAR controls are added back in, and the load flow is resolved. Then the
switched shunt controls are restored, and the load flow is again resolved. Simulator will
continue in this manner by reintroducing next the LTC control, followed by the area
interchange control, and lastly the phase shifter control. Furthermore, when reintroducing the
phase shifter control, the controls are added one at a time for each phase shifter, with a load
flow solution occurring after each.
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Window Ribbon Tab
The Window ribbon consists of buttons and menus that provide access to customizing the windows in
the user interface. It also provides access to help topics and topics regarding the Auxiliary File Format.
The ribbon is shown below.

The Case Information ribbon is broken into four ribbon groups
Mode Ribbon Group
Edit Mode
Switches the program to Edit Mode, which can be used to build a new case or to modify an
existing one.
Run Mode
Switches the program to Run Mode, which can be used to perform a single Power Flow
Solution or a timed simulation with animation.
Window Ribbon Group
Open Windows Menu
The Open Windows Menu provides a convenient method of switching between open windows.
This includes User Interface Dialogs, Case Information Displays, and Oneline diagrams.

Switch to Free-Floating Windows (Switch to Standard Container Window)
Choosing this option toggles the program from between two different window environment
1. All diagrams and dialogs are contained within the Simulator program shell
2. All diagrams and dialogs are free-floating on your monitor.
For more information see the Window Basics.
Reset to Defaults
The program keeps track of dialog Free-Floating/Contained Style, Size, and Position. Clicking
this button will reset all these to the factory default settings. Nearly all dialogs in will then be
reset back to Contained with a default size and position as well. For more information on
Style, Size and Position, see Window Basics.
Refresh Displays
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Redraws (refreshes) each of the open windows. Simulator usually automatically refreshes the
open windows as necessary. However, this action allows you to trigger the refresh when you
want it.
Ribbon Settings Menu
This menu contains options for customizing your ribbon.

Ribbon Colors : You can change the color scheme to either Blue, Silver or Black
Legacy Menus : Choose to Hide or Show a special Menus ribbon tab. The Menus ribbon tab
mimics the menu and toolbar structure that existed in older versions of Simulator.
Arrange Windows
The options under Arrange Windows are Tile Horizontally, Tile Vertically, and Cascade. Tile
rearranges the open oneline diagrams such that the total window area is divided equally
among all of them and each is completely visible. Cascade Rearrange all open windows such
that all they appear on top of each other while leaving the title bars visible.
Toggle Full Screen
Toggle full screen makes the currently selected diagram window switch to full screen mode.
Full screen mode will dedicate the screen to the window, with all other windows, including the
Simulator menus and toolbars, to be hidden. To get back to normal mode, right-click on the
diagram in full screen mode and select Toggle Full Screen from the popup menu.
Help Ribbon Group
Contents
Opens the Simulator Options Dialog.
Set Help File
Opens the Case Description Dialog.
About
Click this to open the About dialog. The About dialog contains information about the software
as well as showing you the Build Date of your version of Simulator. PowerWorld release patch
version of Simulator on our website. These patch versions are named by date and is shown
on the About dialog.
There is also an option on the About dialog to Change License Key. This allows selection of a
new license key file. Add ons are controlled through the license key. If you are using different
versions of Simulator with different add ons, this option provides the mechanism for switching
between the different versions of Simulator. You will need a different license key file if you
are using different licenses for Simulator that have different add ons.
PowerWorld Website
Click this to open your default web browser to the PowerWorld Corporation Website.
Check for Updates
This button will open the PowerWorld website to the patch download page. You will be
required to enter your Account Username and Product ID (password) to check for and
download patches for your version of Simulator.
Auxiliary File Ribbon Group
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Load Auxiliary
Choose this option to load an Auxiliary File.
Load Display Auxiliary File
Choose this option to load a Display Auxiliary File to append to the active oneline.
Auxiliary File Format
Opens the Bus View Oneline which provides a graphical display which allows you to quickly
browse information about a bus and everything connect to that bus.
Export Display Object Fields Menu
Export Case Object Fields Menu
Choose these options to export a list of fields for each type of object in a case (or a Oneline
Display). The list also indicates which fields are key fields and required fields for each object.
You can output this list of fields as either a text file or into Excel.
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Application File Menu
The Application File menu is used to open and save either full cases or oneline diagrams, to create
new cases, to open and load auxiliary files, to print and to exit Simulator. To access this menu you
must click on the Application button in the upper-left corner of the program.
Application Button:
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Case Formats
Simulator supports a number of case formats. You can both open and save cases using most of the
following formats:
PowerWorld Binary (*.pwb) (Preferred Format)
For most users, the best choice of power flow case formats is the PowerWorld Binary format. This
format stores the most complete set of case information but requires the smallest file sizes.
Information stored in this format includes power flow data, economic parameters, case time
variation/options values, and screen customizations. The only potential disadvantage of this format
is that it is stored in binary form, which means that it cannot be viewed using a standard text editor.
All the other formats are ASCII and thus readable in text editors such as Notepad.
One additional benefit of using the Powerworld Binary format is that with this format the case can
be password-protected. This setting is available under Misc. Power Flow > Set Case Username
and Password in the Case Options ribbon group on the Options ribbon tab.
PowerWorld Auxiliary File (*.aux)
Simulator can now save and load cases using the PowerWorld defined auxiliary file format. When the
aux file format is chosen as the save file type in Simulator, the data describing the entire case is
written to a text file described by Simulator’s auxiliary file format. These files can be considerably
larger than PowerWorld Binary files, and generally should not be used unless otherwise necessary.
Note that not all auxiliary files represent an entire case, and in fact in most cases do not. Only when
an auxiliary file is created using the Save Case As option in the Application Button in Simulator
does the auxiliary file contain all necessary information for loading the complete case in Simulator as
an auxiliary file.
PowerWorld Auxiliary File - Secondary Keys (*.aux)
This option is the same as choosing PowerWorld Auxiliary File except for the key identifiers for each
record. Instead of using the primary keys (i.e. bus numbers) to identify devices in the data, the
secondary keys (i.e. combination of bus name and nominal voltage) will be used as the identifiers in
the saved file.
PowerWorld Auxiliary File - Labels (*.aux)
This option is the same as choosing PowerWorld Auxiliary File except for the key identifiers for each
record. Instead of using the primary keys (i.e. bus numbers) to identify devices in the data, the
device primary labels will be used as the identifiers in the saved file.
PTI Raw Data Format (*.raw)
This format is included primarily for interchange of power flow data with other packages. The PTI
Raw Data format only contains power flow data. When using this format, the generator participation
factors are automatically set to be proportional to the MVA rating of each generator.
When reading a RAW file that has comments on a given line, the comments will be loaded into the
Memo field of the corresponding data record. However, the Memo field will not be written back out
when saving a RAW file.
PTI Raw Data Format (*.raw) (with options)
This format is the same as the PTI Raw Format except that the PTI RAW File Load Options dialog
will be opened to allow user input for various options.
GE PSLF Format (*.epc)
This format is included primarily for importing load flow data saved from GE's PSLF program. The
EPC format is a text file format. This format does contain excess information that Simulator does not
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use, however Simulator does store this information for editing and writing back out to EPC format
files.
GE PSLF Format (*.epc) (with options)
This format is the same as the GE PSLF Format except that the GE EPC File Load Options dialog will
be opened to allow user input for various options.
Areva HDBExport Format (*.csv)
Customers who use the Areva EMS system are able to use a command in the Areva EMS called
HDBExport to save a comma-delimited file containing a complete description of the network model
in the EMS system. The CSV file must be exported using appropriate flags and a specific pattern file
in order to generate the format required by PowerWorld. The resulting file will be a full-topology
representation of the network model appropriate for use with the Integrated Topology Processing
add-on. For more information, please contact PowerWorld Corporation offices.
BPA IPF Format (*.net)
The BPA IPF Format is another format which can be read from our customers in China.
IEEE Common Format (*.cf)
The IEEE Common Format is used to specify only power flow information. CAUTION: IEEE common
format does not support many of the formats used in the PowerWorld packages, such as multiple
loads and generators at a bus. Usually, IEEE Common Format is used only for inputting cases.
PowerWorld Simulator Project Files (*.pwp)
Project files are described in Overview of PowerWorld Simulator Project Files.
Advanced settings for opening cases are available under the File Management settings.
Special Data Handling
Some special handling of data may occur when loading, appending, or saving data in the various
formats. The following details what occurs in these situations.
PowerWorld Binary (*.pwb)
Appending



Appended data completely overwrites an existing record corresponding to the same bus
number(s).
Branch elements are appended to a case only if both of their terminal buses exist.

PTI RAW Data Format (*.raw)
Appending




Appended data completely overwrites an existing record corresponding to the same bus
number(s).
Branch elements are appended to a case only if both of their terminal buses exist.
Any new buses or branches that are created are now flagged as having just been added.
This flag is then used as part of the pre-processing feature in the power flow solution to
automatically estimate appropriate voltage magnitudes and angles for any existing or new
branches and buses that become newly energized.
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A field, EPC File\EPC Modification Status, is populated to indicate whether an object is
new or modified while reading. Even though this is a field that is normally associated with
loading in an EPC file, the meaning is the same so the same field is used.

Saving


When saving a case as a PTI RAW files the switched shunt records will always write out at
least one block. If none exists, a single block with 1 step and size equal to the present MVar
output is written.

GE PSLF Format (*.epc)
Reading






If the latitude and longitude values are both zero when loading an EPC file, both entries will
be ignored as invalid..
A designation of the area and zone of a GE branch and transformer will be stored when
loading from an EPC file.
When loading multi-terminal dc lines from an EPC file, current limits for dc converters will
not be enforced. This is set via a field, Enforce Current Limit, available with dc
converters.
When reading in a GE EPC file, the "aloss" parameter is usually rounded to one bus or the
other to be expressed in terms of the "From End Metered" field (except in the case of MultiTerminal DC converters).
Simulator does not consider load IDs to be case sensitive. If multiple loads are found with
the same ID that vary only by the case of the characters, Simulator will attempt to create a
unique ID for each load. An appropriate message will appear in the message log.

Appending









Appended data completely overwrites an existing record corresponding to the same bus
number(s).
Branch elements are appended to a case only if both of their terminal buses exist.
Any new buses or branches that are created are now flagged as having just been added.
This flag is then used as part of the pre-processing feature in the power flow solution to
automatically estimate appropriate voltage magnitudes and angles for any existing or new
branches and buses that become newly energized.
A field, EPC File\EPC Modification Status, is populated to indicate whether an object is
new or modified while reading.
If a new three-winding transformer is entered which uses a bus number which is already
used as a star bus by another three-winding transformer this will not be allowed and a new
bus number will automatically be chosen.
If appending an EPC file causes a transformer branch to be converted to a normal branch, a
log warning message will show this.
If the scheduled voltage for a bus is specified, the voltage setpoints for switched shunts and
generators that are regulating this bus are also properly updated.

Saving


When saving a case as a GE EPC file the Multi-Terminal DC converters will write out the
"aloss" parameter in a manner consistent with the EPCL file mtTAP.p
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When using the Present Topological Differences from Base Case tool and the removed
elements are saved in the GE EPC file format the elements are saved with a status value of
-4.

Areva HDBExport Format (*.csv)
Reading





When loading the hdbexport file, modified to automatically add two labels to each
transmission line. One label starts with the "from" substation name and the other label
starts with the "to" substation name.
At the end of reading in an hdbexport CSV file, if any CBTyp values were encountered that
were not recognized a dialog box will appear prompting the user to designate a Branch
Device Type for each CBTyp (See the hdbexport Files section in File Management for
more explanation on this).
Additional bus labels are added when reading the MEAS records.
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Auxiliary File Format (*.aux)
Simulator Auxiliary Files have now been greatly enhanced to include both Script sections for running
Simulator commands in a "batch" process, and Data sections for changing mass amounts of load flow
information. Many auxilliary file formats used in early versions of Simulator can not be saved in current
versions. The older formats can still be read into Simulator.
Auxiliary file format and use now has its own help chapter titled Auxiliary Script/Data Files.
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GE EPC File Load Options
The GE EPC File Load Options dialog will open when choosing to open or save a GE EPC case "with
options".

EPC File Version
Set this to determine what version of the EPC file is being read or saved.
What To Do With Multi-Section Lines
Assumed Generator Var Limit Deadband
GE Base Load Flag Setting
When opening a file, the GE Base Load Flag setting will be used to set the Post-CTG Prevent AGC
Response field in Simulator. The caption will be the following: if GE Base Load Flag > 0, then
Post-CTG Prevent Response = YES, else Post-CTG Prevent Response = NO
When saving a file, the Post-CTG Prevent AGC Response field in Simulator will be used to set the
Base Load Flag setting in the EPC file. The caption will be the following: if Post-CTG Prevent
Response = YES, then set GE Base Load Flag = 1, else set GE Base Load Flag = 0
Filter By
If desired, only data in with specific areas, zones or owners can be loaded from the EPC file by using
this option. Checking the Area/Zone/Owner Filters box will display the edit boxes for entering the
Area, Zone, and Owner numbers. You can also check the Include Tie Lines box to read in branches
for which only one of the two terminal buses is designated with the specified area, zone or owner.
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Leaving this box unchecked will force the requirement that BOTH branch terminal buses meet the
specified areas, zones or owners for it to be read from the EPC file.
See the Case Formats topic for information on special handling of data that occurs when loading a
case using the GE EPC file format.
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PTI RAW File Load Options
This dialog contains options related how Simulator reads (or writes) the PTI RAW file. There are only
three options on the dialog.
RAW File Version
This option is available for both reading and writing the RAW file. Simply choose the appropriate
version number from the drop-down menu.
Add comments for object labels at the end of RAW file records
This option is available for both reading and writing the RAW file. Simply check to append object
labels as comments to the end of data records.
Creation of transactions for loads in a different area than their terminal bus
This is only relevant when loading a RAW file. The option allows the user to select if transactions
should be created for loads that are in different areas than their terminal buses.
Loads may be assigned to a different area than the load’s terminal bus. PTI offers an option that
allows the user to ignore this assignment when calculating the tie-line flow for an area.
(AREA INT CODE = 1 FOR LINES ONLY)
(AREA INT CODE = 2 FOR LINES AND LOADS)
Simulator does not allow you to define a load this way and then choose to ignore it. Most RAW files
that PowerWorld has seen seem to be solved ignoring the loads that are in different areas than their
terminal bus by using the "lines only" option. To overcome this, when PowerWorld reads a RAW file,
MW Transactions can be automatically created with the ID "RAW_LOAD". These transactions are
between the load’s area and its terminal bus and are created so that the export from each area
correctly matches a case solved using "lines only". If you know that your case was solved using
"lines and loads", then you would not want to add the transactions. There are three options for how
to deal with these possible interchange differences. The default is to let Simulator determine what is
best based on the input data. If it is known what option was used in PTI, then the user can choose
to either create the MW transactions or not create them. See the topic Add and Remove
transactions due to tie-line loads with File Management Options for more information about
adding or removing these transactions after the case has been loaded.
If not loading the RAW file with options, Simulator will determine based on the input data whether
or not the transactions representing loads that are in different areas than their terminal buses need
to be created.
When loading the RAW file with options, the user can select how to number the star buses of threewinding transformers. The options are to use a number that is near the primary bus number, start
numbering above the maximum bus number, or specify a number at which to start the numbering.
When reading a RAW file that has comments on a given line, the comments will be loaded into the
Memo field of the corresponding data record. However, the Memo field will not be written back out
when saving a RAW file.
Three-Winding Transformer Star Bus Numbering.
The PTI RAW format does not include separate buses which represent the internal star buses of a
three-winding transformer. When loading a RAW file, Simulator will automatically create buses for
these star buses. This option provides the user a choice of how these star buses are numbered.
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Opening a Simulation Case
The most common first step in using Simulator is to open a case. When a case is opened, any
associated oneline files are also opened. To open a case, either select it from the list of recently
opened cases in the file menu or






Select Open Case from the Application Button to display the Open Dialog.
In the Type of Files box, select the desired file type. By default, the PowerWorld Binary type is
selected (*.PWB). The PowerWorld Binary is the preferred file type, providing the most
comprehensive power system information along with the smallest size and quickest load time.
Other file types include the PowerWorld Case type, PowerWorld Auxiliary file, PTI Raw Data
formats, GE EPC text format, and IEEE Common Format. Please see Case Formats for more
details.
In the list of cases, click on the desired case.
Click OK.

When opening an existing Simulator case, you may see one or more oneline diagrams pop up. When
opening a power flow case created with another program, a oneline may not be available. However,
you can easily create a oneline for such a case using the Edit Mode.
If you are in the Edit Mode, you can modify the case. See Edit Mode Overview for details.
If you are in the Run Mode, the Clock Window may be displayed. This window shows the simulation
start time, end time and current time. You may choose to close or open the clock at any time.
If the case has validation errors, the mode is immediately switched to Edit Mode. You must correct the
validation errors shown in the message log before you can use the Run Mode to solve the case.

79
©2011 PowerWorld Corporation

Opening a Oneline Diagram
Simulator supports oneline diagrams that have been developed using its Edit Mode tools. PowerWorld
can also import PTI Draw Files (*.drw).
When a case is opened, any associated onelines are usually opened, as well. Additionally, oneline
diagrams can be opened directly from any existing onelines using oneline links. However, you may also
directly open a oneline diagram using the following procedure:






Select Open Oneline from the Application Button.
Choose the file type you would like to open by using the drop-down in the bottom right-hand
corner of the Open dialog. The Available File Type Options for Opening a Oneline section
details how the different file types work.
 Alternately, you can use the file menu choices to open a oneline using a particular linking. The
file menu choices are available on the submenu when selecting Open Oneline from the
Application Button. The linking choices listed in the Available File Type Options for
Opening a Oneline section found below are available with this option (except for the PTI
Draw File format). When you select a particular linking option, you will be prompted if you
want to save this as your default type. You can override the default by selecting a different
linking option the next time that you open a oneline.
In the list of available oneline files, click on the desired oneline.
Click OK.

Available File Type Options for Opening A Oneline








Oneline Display File (*.pwd) - This is the standard binary file used to store oneline diagrams.
When this option is selected, oneline display objects involving buses will be linked to their
corresponding case data objects through bus numbers.
Oneline Display File (Name_kV linking) (*.pwd) - This is the standard binary file used to
store oneline diagrams, but a special table stored with the file is used to link the oneline display
objects involving buses to their corresponding case data objects using bus name and nominal kV
combinations instead of bus numbers and renumber the bus numbers of the display objects to
match the current case. This option is useful when opening a oneline that was created with a
different case than the one currently in memory and the current case has undergone some bus
renumbering, but the bus names and nominal kV levels remain the same as in the original case.
Oneline Display File (Label linking) (*.pwd) - This is the standard binary file to store oneline
diagrams, but a special table stored with the file is used to link the oneline display objects by label
to their corresponding case data objects. Only objects that allow the use of labels will be linked in
this manner. If a linking via label cannot be found, the oneline object will be unlinked. This option
is useful when opening a oneline that was created with a different case than the one currently in
memory and the current case has undergone bus renumbering, but the labels remain the same as
in the original case.
PTI Draw File (*.drw) - File format supported by PSS/E. All functionality of that file format may
not be fully supported in Simulator.
Display Auxiliary File (*.axd) - This is a text file used to store the oneline display objects.

You may open as many onelines as you like, and even multiple copies of the same oneline.
The following topics may be helpful when opening onelines created with a different case:
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Refresh Anchors
Bus Renumbering Dialog
Three-Winding Transformer Star Bus Automatic Renumbering
When opening a oneline diagram by using one of the PWD options, the star buses of three-winding
transformers will automatically be renumbered to match the current power flow case. This is done
without any input from the user. This is done because some power flow case file formats do not
require that star bus numbers remain constant, therefore, if opening a oneline diagram with a power
flow case other than the one with which is was created, there is a good possibility that the star bus
numbers will be different. The renumbering is accomplished using a table saved with the PWD file
that contains the three-winding transformers. If using the name_kV linking to open a oneline, the
three-winding transformers in the internal table are identified by name_kV when doing the star bus
updates. If the transformer cannot be found when using either the number or name_kV linking, its
star bus will not be renumbered.
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Recently Opened Cases
A numbered list of the most recently opened cases appears in the Recent Files list when you click on
the Application Button. Simply choose a case from the list to open the case.
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Building a New Case
To create a new case in Simulator, select New Case from the application file menu. After asking you
whether or not to save the current working case (if one exists), Simulator will automatically switch to
Edit Mode. The screen will turn to the default background color, indicating that you can begin to build
the new case.
New users may wish to view the tutorial Creating a New Case from Scratch for further guidance.

83
©2011 PowerWorld Corporation

Building a New Oneline
This option enables you to create a new oneline diagram. It is accessible from either the Edit or Run
modes by choosing New Oneline from the application file menu. When you select it, the application
will automatically switch to Edit Mode, from which you can construct the new oneline.
New users may wish to view the tutorial Creating a New Case from Scratch for further guidance.
Additionally, the following topics may be of some assistance:
Using the Insert Palettes
Oneline Conditional Display of Objects
Using the Oneline Alignment Grid
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Saving Cases
Simulator allows users to save case information in several different formats. To call up the Save As
dialog, select Save As from the Application Button. The format in which the file will be saved
depends upon the value of the Save as Type field of the dialog. Simulator can save cases in
PowerWorld binary format (the default), PowerWorld Auxiliary file format, PTI raw data, GE PSLF
format, and the IEEE common format. Please see Case Formats for more details on the various case
formats available.
To force saving a case with comments, a submenu exists for the Save As and Save As Type menu
items. Select the ... with Comment... to open the comment dialog. More information about Case
Comments can be found in the Case Description topic.
To convert a case to a different format, follow this procedure:






Select Open Case from the Application Button.
In the Files of Type box, select the desired file type. By default, the PowerWorld Binary type is
selected (*.PWB).
Select the name of the desired case and click OK.
Select Save Case As from the Application Button.
Change the Save as Type setting to match the desired file type, designate the name with which
to save the file, and click OK.

To simply save the case with its current name and format, select either Save from the Application
Button or the Save Case button on the Quick Access toolbar.
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Saving a Oneline
Select Save Oneline from the Application Button to save the currently selected oneline file.
Select Save Oneline As from the Application Button to save the currently selected oneline file with a
different name or format. You may overwrite existing files.
For both the Save Oneline and Save Oneline As options, only the oneline diagram is saved; the case
(i.e. the power flow model) is not written to disk.
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Close Oneline
To close a oneline diagram, select to Close Oneline from the Application Button, or right-click on the
background of the oneline diagram and select Form Control > Close from the local menu. This will
prompt you to save the oneline if changes have been made since the last save. Note that this does not
close the current case, just the oneline diagram. The power system data is still loaded, and case
simulations can be run with the oneline closed.
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Generator Capability Curves Format (*.gcp)
These files are outdated for Simulator version 8.0 and later. Their descriptions are still maintained here
as they can still be read into Simulator. However, they can no longer be saved. These records are now
stored in Auxiliary Script/Data Files.
The generator capability curves are used to model the dependence of the generator reactive power
limits and the generator’s real power output. The generator reactive capability curves files have the
following format, with one generator per line:
num or name, ID, P1, Q1,max,Q1,min, P2, Q2,max, Q2,min ... Pn, Qn,max, Qn,min
where
num/name the generator’s bus number or the bus’ name in single quotes,
ID the generator’s single character id,
Pi a generator MW output value,
Qi,max and Qi,min the associated maximum and minimum reactive power limits.
Version 11 and later of Simulator allow for an unlimited number of capability curve points to be read
from the gcp file. Up to 10 different P/Q max/Qmin values may be specified in older versions of Simulator.
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Generator Cost Data Format (*.gcd)
These files are outdated for Simulator version 8.0 and later. Their descriptions are still maintained here
as they can still be read into Simulator. However, they can no longer be saved. These records are now
stored in Auxiliary Script/Data Files.
The generator cost data file contains the parameters used to model the generator operating costs.
Each record in the generator cost data file specifies the operating cost model for a single generator.
The cost model may be either a cubic polynomial or a piecewise linear curve. When reading a file of
generator cost data records, Simulator will open the Cost Curve Data Options Dialog below. This
dialog gives you additional control over the input and process of generator cost information.
Each generator cost data record begins with the fields
num or name, ID,
where
num/name the generator’s bus number or the bus’ name in single quotes,
ID the generator’s single character id,
Following the ID field is an optional single-character field CostModel that specifies the type of cost
model. If CostModel is ‘CUBIC’ or is not specified, the record describes a cubic cost model and thus
concludes with the following fields:
ai, bi, ci, di, FuelCost ParFac
where
ai, bi, ci, di input-output curve coefficients; see Generator Cost Information for details,
fuelcost fuel cost, expressed in price per Mbtu,
ParFac generator participation factor.
If, on the other hand, CostModel is ‘PLIN’, the record describes a piecewise linear cost model. The
remainder of the record specifies pairs of generator output and corresponding generator cost:
FixedCost MW1 IncCost1 MW2 IncCost2 … MWn IncCostn MWneg ParFac
where
FixedCost Operation cost independent of the generator’s MW output; expressed in $/Hr,
MWi, IncCosti Output/incremental cost data point pairs that define the incremental cost model
for the generator (note IncCosti has the units $/MWhr),
MWneg An arbitrary negative value used to terminate the record,
ParFac generator participation factor.
Cost Curve Data Options Dialog
The Cost Curve Data Options Dialog gives you additional control over the input and processing
of generator cost information. It appears when you try to read generator cost information from an
auxiliary data file (either .aux or .gcd).
To command Simulator to turn all units onto automatic generation control (AGC) for which it reads a
cost data record, check the first checkbox. This box has the rather lengthy label "If a unit for which
a cost curve is read is not on AGC, Simulator should set it on AGC." In other words, if a cost curve is
read for a particular generator, that generator will be set on AGC if this box is checked.
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Cross-compound is a generator architecture sporting a single boiler and two turbines, one operating
at high pressure and the other operating at low pressure. The existence of cross-compound units
may complicate the modeling of generator cost characteristics, because sources for this information
tend to describe the cost associated with the tandem, whereas Simulator’s economic dispatch will try
to dispatch the two parts of the cross-compound unit as two separate units. To address this
problem, Simulator gives you the option to lump the properties of the high- and low-pressure
turbines into a single unit. It consolidates the two components by adding together their maximum
MW outputs, minimum MW outputs, and present output levels, assigning these quantities to one of
the units, and setting the other unit off AGC and at 0 MW of output. To have Simulator perform this
function for you, check the box in the Cross Compound Units panel.
To tell Simulator how to identify units that belong to the same cross-compound generator, click the
box labeled "How To Identify…". This will open the How to Identify Cross-Compound Dialog
described next.
How to Identify Cross-Compound Dialog
Simulator regards cross-compound units as those that are connected to the same bus and that have
generator id’s that match any of a number of specified pairs. You must define for Simulator the pairs
of generator id’s that should be used to identify cross-compound units. Use the "How to identify
cross-compound units" dialog to do this.
Specify the pair of generator id’s in the small text boxes below the text labeled "Specify a new pair
of id’s that identify two units that belong to the same cross-compound set." Then, click the Add
button to include the pair of id’s you just entered in Simulator’s cross-compound identification
procedure. The box on the right lists all the pairs of identifiers Simulator will use to identify parts of
a cross-compound set. To remove a pair of identifiers from this list, select it from the box and click
the Delete key.
The list of cross-compound identifier pairs is stored in the pwrworld.ini file, so there is no need to
specify these pairs each time you load in a new case.
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Injection Groups Format (*.inj)
These files are outdated for Simulator version 8.0 and later. Their descriptions are still maintained here
as they can still be read into Simulator. However, they can no longer be saved. These records are now
stored in Auxiliary Script/Data Files.
The injection group files store the information for defined injection groups (also referred to as
participation groups). The files have the following format:
GROUP groupname
POINTS
Devtype busnum id participation pointtype
.
.
.
END
where
groupname the name of the injection group, in single quotes,
devtype either GEN or LOAD,
busnum bus number of the device,
id the device’s single character ID,
participation relative amount each device will contribute during a transfer,
pointtype either FIXED or DYNAMIC.
Multiple GROUP sections can be put in the file, each marked with END to signify the end of that
group’s data.
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Interface Data Format (*.inf)
These files are outdated for Simulator version 8 and later. Their descriptions are still maintained here
as they can still be read into Simulator. However, they can no longer be saved. These records are now
stored in Auxiliary Script/Data Files.
The interface data files store the interface data. The files have the following format:
INTERFACE intname lima limb limc
Elemtype from to id checktoend fromto
.
.
.
where
intname the interface name, in single quotes,
lima, limb, limc the three limits for the interface, in MW,
elemtype one of three valid element types: AREA, LINE, or ZONE
from for AREA and ZONE, the first area or zone number; for LINE, the from bus number,
to for AREA and ZONE, the second area or zone number; for LINE, the to bus number,
id only included for LINE, the two character circuit identifier; otherwise left blank,
checktoend only included for LINE, if this field equals 1, the flow is checked at the to bus,
otherwise the flow is checked at the from bus; otherwise left blank,
fromto only included for LINE, if this field equals 1, the positive flow is assumed to be from the
from bus to the to bus, otherwise the flow is assumed to be in the opposite direction; otherwise
left blank.
Multiple interface records can be listed in the file, and multiple interface elements can be listed in each
interface record.
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Sequence Data Format
The sequence data files store the sequence data needed to run a fault analysis. The sequence data
format has the following five different types of records:






Generator
Load
Branch
Switched Shunt
Mutual Impedance

Each of these four types of sequence data records has a different format, since they each store
different information for the sequence data. The format of each record is given below:
Generator
GEN busnum ID Rpos Xpos Rneg Xneg Rzer Xzer RN XN
where
busnum generator terminal bus,
id generator identifier,
Rpos, Xpos positive sequence resistance and reactance,
Rneg, Xneg negative sequence resistance and reactance,
Rzer, Xzer zero sequence resistance and reactance,
RN, XN neutral-to-ground resistance and reactance.
Load
LOAD busnum Gneg Bneg Gzer Bzer
where
busnum load terminal bus,
Gneg, Bneg negative sequence total conductance and susceptance for all loads at bus,
Gzer, Bzer zero sequence total conductance and susceptance for all loads at bus.
Branch
BRANCH fbusnum tbusnum ckt Rzer Xzer Czer fGzer fBzer tGzer tBzer Xftype
where
fbusnum, tbusnum from and to bus numbers for the branch,
ckt branch circuit identifier,
Rzer, Xzer zero sequence branch resistance and reactance,
Czer total zero sequence line charging,
fGzer, fBzer zero sequence line shunt conductance and susceptance at the from bus end of the
branch,
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tGzer, tBzer zero sequence line shunt conductance and susceptance at the to bus end of the
branch,
Xftype Transformer configuration, entered as an integer based on the following table. Note that
the default for a transmission line is 3, since a grounded wye - grounded wye transformer
connection has the same equivalent model as a transmission line.
0 Wye - Wye
1 Grounded Wye - Wye
2 Wye - Grounded Wye
3 Grounded Wye - Grounded Wye
4 Wye - Delta
5 Delta - Wye
6 Grounded Wye - Delta
7 Delta - Grounded Wye
8 Delta - Delta
Switched Shunt
SSHUNT busnum numblocks Bzer1 Bzer2 …
where
busnum terminal bus number,
numblocks number of different zero sequence admittance blocks,
Bzer# zero sequence susceptance for each admittance block, maximum of 8.
Mutual Impedance
MUTIMP from1 to1 ckt1 from2 to2 ckt2 RM XM start1 end1 start2 end2
where
from1, to1 from and to bus numbers of the first mutually coupled branch,
ckt1 circuit identifier of the first mutually coupled branch,
from2, to2 from and to bus numbers of the second mutually coupled branch,
ckt2 circuit identifier of the second mutually coupled branch,
RM, XM zero sequence mutual resistance and reactance,
start1, end1 start and end locations of the section of the first line affected by the mutual
coupling, with each point represented as a percentage of the total line length (between 0 and 1),
start2, end2 start and end locations of the section of the second line affected by the mutual
coupling, with each point represented as a percentage of the total line length (between 0 and 1).
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Exporting Onelines in Different Graphic Formats
Simulator can export oneline diagrams and other graphical displays as bitmaps, metafiles, jpegs, or
gifs. Select Export Oneline from the Application Button. A save file dialog appears where the
dropdown menu for files type offers four choices: JPEG, BITMAP, METAFILE, GIF. Select the file type
and choose he name before clicking the save button.
Exporting an image as a jpeg also requires you to set the compression ratio for the picture. See Saving
Images as Jpegs for more information.
Exporting an image as a gif provides the option to save an animated image. Upon saving, you are
given the option to specify the number of frames to save and the time delay between frame changes
during playback. You are also given the ability to scale the image before saving.
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Saving Images as Jpegs
Simulator can save oneline diagrams, bus view displays, and strip charts as jpeg images. To save a
oneline diagram or bus view display as a jpeg, select Export Oneline from the Application Button.
This brings up the save file dialog. Choose jpeg as the file type, type the file name, and press save.
This brings up the Jpeg Options Dialog where you decide the picture's resolution. Adjust the resolution
control to specify the compression ratio at which to save the diagram as a jpeg. The greater the
resolution you specify, the larger the resulting file will be. Click Save to save the image or click
Cancel to terminate the process without saving the image as a jpeg.
To save a strip chart as a jpeg image, right-click on the background of the strip chart and select
Export Image from the resulting local menu. This brings up the save file dialog. Choose jpeg as the
file type, type the file name, and press save. Specify the compression/resolution in the Jpeg Options
Dialog. Click Cancel to terminate the process, or click Save to save the jpeg.
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Saving Admittance Matrix and Jacobian Information
The Save Ybus or Power Flow Jacobian Dialog is used to store the power system bus admittance
matrix (Ybus) and/or the power flow Jacobian in a text format that can be easily read into other
programs such as MATLAB. This dialog is primarily designed for users doing power system analysis
research. The dialog has the following fields.
Ybus in MATLAB Format
Filename for Saving Ybus
Enter the name of the file in which to store the Ybus data. The Ybus data is stored using the
MATLAB sparse matrix format in the matrix Ybus. If the Include Bus Voltages field is checked,
then the bus voltages are also stored, but in the vector V.
Save Ybus in MATLAB Format
Click this button to save the Ybus.
Power Flow Jacobian in MATLAB Format
Jacobian Save File
Enter the name of the file in which to store Jacobian data. The Jacobian is stored using the MATLAB
sparse matrix format in the matrix Jac.
Jacobian ID Save File
Enter the filename to store the text identifier information. This information is used to translate the
bus numbering convention used in the Jacobian and Ybus files with the actual bus number and
name in the case.
File Type
Choose the type of MATLAB file you wish to save as. The MATLAB .M Format is the more common
text format used for directly loading MATLAB information. The Text for MATLAB Ascii is for use
with MATLAB’s ability to read Ascii files. The Ascii file type can be read into MATLAB much faster
than the traditional .M files.
Jacobian Form
Select Rectangular to store the rectangular form of the Jacobian, or Polar to store the polar form
of the Jacobian.
Save Jacobian
Click this button to save the Jacobian and object identifier information.
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Working With GE EPC Files
PowerWorld Simulator can open and export to GE EPC files, but as with any format conversion there
are some quirks to keep in mind. Many of these are described in a number of pages throughout these
help files.










Differences in File Formats
Appending a Case
Case Formats
File Management Options
GE EPC File Load Options
Present Topological Differences from Base Case
Script General Actions
Transient Stability Data from External Files
Transient Stability Overview: Generator Models
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Differences In File Formats
PowerWorld Simulator supports loading from and saving to a number of different external formats,
including EPC and PSS/E files. There are a number of points where Simulator's handling of a power
system is not precisely represented in other formats, so some care must be taken when working with
these other files.
GE EPC Files
Buses
Bus names are limited to 12 characters. When writing out to PSLF files, Simulator will truncate
names in a way that ensures unique names remain unique.
PSLF specifies the specific voltage setpoint with a Bus record, and then specifies a range with the
device (Vband for a shunt, Vmin/Vmax for a transformer)
Generators
GE Baseload Flag is an extra flag used by PSLF in transient simulation only (user-written EPCL
code might also use this). Simulator allows you to interpret this field as a Post-Contingency
AGC status (Simulator has a separate field for Transient Simulation use).
PSLF supports up to 8 owners per generator, while Simulator only supports 4. If an EPC file
specifying more than 4 owners is loaded, Simulator will keep track of them with EPC specific
fields.
Simulator has an AVR flag which is set to YES or NO. PSLF uses (Qmax-Qmin) to determine AVR.
By default ranges at 2.0 Mvar or less are considered AVR=NO.
Shunts
PSLF supports up to 4 owners per shunt, but Simulator assumes ownership is inherited from the
terminal bus. Simulator will keep track of any owners specified in a loaded EPC file with
EPC specific fields.

Branches
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PSLF supports up to 8 owners per branch, while Simulator only supports 4. If an EPC file
specifying more than 4 owners is loaded, Simulator will keep track of them with EPC specific
fields.
Transformers
PSLF allows a tertiary bus number of zero (0). Simulator supports this exclusion of the tertiary
bus, but will write it as two 2-winding transformers when exporting to a RAW file.
Multi-Section Lines
In PSLF, intermediate buses are not defined and thus loads, generators, and shunts at these
points are not allowed. When writing out to an EPC file, the multi-section line record is ignored if
intermediate buses have objects.
Area/Zones for Shunt Objects
PSLF allows area and zone designations for specific branches and transformers. Simulator reads
this into EPC specific fields, but does not use them for anything.
Area MW Transactions
PSLF includes tables showing Transactions. The actual scheduled values are informational only.
PSLF does not use these MW Transactions in the power flow solution; instead, it includes a field
with an area specifying the net MW export. When loading an EPC file, Simulator's area field
"Unspecified MW Interchange" is assigned as the "leftover" which isn't included in the
transactions table.
DC Lines
In Simulator, there are distinct container objects for both a two-terminal DC line and a multiterminal DC line (MTDC). In PSLF, there are only definitions of the DC Buses, AC/DC converter,
and DC line objects. The groupings are then determined by the topology of the DC line links.
PSLF requires that all DC buses throughout the entire model have a unique DC bus number,
which Simulator supports.
Interfaces
PSLF supports the definition of an interface as a group of AC lines (or Multi-Sections lines).
Simulator supports several more types of interface elements, such as Area-To-Area, Zone-ToZone, DC Line, Injection group, Generator, Load, or another interface.
Injection Groups
Simulator supports the definition of an injection group which represents a group of generators,
loads, or switched shunts (and can contain other injection groups). This can bus used for
summary calculations, sensitivity-based calculations, or as a source and sink for a transfer. A
user-written EPCL would be required to support this in PSLF.
Substations
In Simulator, each bus can be optionally assigned to a substation. This is useful in oneline
diagram creation and is necessary to support EMS-based full-topology models. PSLF does not
support substations.
Super Areas
In Simulator, Super Area objects can be created and each area can be assigned to one super
area. This is useful in studying groups of areas which are dispatched together (Electricity
Markets). PSLF does not support Super Areas.
Nomograms
In Simulator, Nomogram objects can be created which specify two interfaces and then a twodimensional limit region. Nomogram limit violation can then be monitored or enforced in
Contingency Analysis, ATC, OPF and SCOPF studies. PSLF does not support Nomograms.
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PSS/E Files
Buses
PSS/E bus names are limited to 12 characters. When writing out to PSS/E files, Simulator will
truncate names in a way that ensures unique names remain unique.
Generators
While Simulator specifies the capability curve explicitly, PSS/E has a separate input file called
"GCAP" which specifies the capability (Simulator can read this file).
PSS/E specifies a "bus type" to signify the generator is not on AVR control, while Simulator uses
an AVR flag set to YES or NO.
Shunts
See shunt format comparison table above.
Transformers
PSS/E does not support a fixed tap definition on the same side as the variable tap (FROM), thus
Fixed tap is always assumed as 1.00.
PSS/E does not specify the intermediate Star Bus of a 3-winding transformer explicitly. The
voltage and angle at this point are part of the transformer record.
PSS/E does not allow the tertiary of a 3-winding transformer to be excluded. Simulator allows
this, though we do not consider it good practice.
Area/Zones for Shunt Objects
Simulator allows Generators, Loads and Switched Shunts to have a different area or zone than
the terminal bus. PSS/E only allows this for Loads. These objects are then treated as tie-lines in
area and zone interchange calculations. PSS/E has a specoal solition option to specify whether to
include the interchnge as "LINES ONLY" or "LINES AND LOADS". Simulator always uses Lines and
Loads.
Area MW Transactions
PSS/E includes tables showing Transactions. The actual scheduled values are informational only.
PSS/E does not use these MW Transactions in the power flow solution; instead, it includes a field
with an area specifying the net MW export. When loading an EPC file, Simulator's area field
"Unspecified MW Interchange" is assigned as the "leftover" which isn't included in the
transactions table.
DC Lines
PSS/E requires that all DC buses of a particular MTDC grouping be numbered from 1 to the
number of DC buses. Simulator supports this when exporting to PSS/E.
Interfaces
PSS/E has a monitor functionality (MON file) which allows definition of an interface which
includes AC branches and Line Open of Close contingent elements.
Injection Groups
Simulator supports the definition of an injection group which represents a group of generators,
loads, or switched shunts (and can contain other injection groups). This can bus used for
summary calculations, sensitivity-based calculations, or as a source and sink for a transfer. PSS/E
has a similar concept called a "subsystem", which you may find in a SUB file.
Substations
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In Simulator, each bus can be optionally assigned to a substation. This is useful in oneline
diagram creation and is necessary to support EMS-based full-topology models. PSS/E does not
support substations.
Super Areas
In Simulator, Super Area objects can be created and each area can be assigned to one super
area. This is useful in studying groups of areas which are dispatched together (Electricity
Markets). PSS/E does not support Super Areas.
Nomograms
In Simulator, Nomogram objects can be created which specify two interfaces and then a twodimensional limit region. Nomogram limit violation can then be monitored or enforced in
Contingency Analysis, ATC, OPF and SCOPF studies. PSS/E does not support Nomograms.
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Overview of PowerWorld Simulator Project Files
Performing a simulation using PowerWorld Simulator sometimes requires using a number of different
files. In addition to the case file that stores the model of the system, there may be one or more
oneline diagrams depicting various regions of the system. These oneline diagrams might feature
document links that connect to files that were created using other applications, as well as oneline
links, which open other oneline diagrams when they are clicked. For these links to function properly,
the documents and oneline displays to which they connect must be available. A simulation might also
employ a template file that is used to load in a predefined set of solution, environment, and display
options. Furthermore, the simulation might make use of data stored in auxiliary data files to
supplement the data stored in the case file. Finally, a simulation might utilize a script file to perform
some automated sequence of tasks, or even to display a movie of system conditions. Having to deal
with so many files may make it difficult to transfer the case to another computer, or to share the
model with a colleague. PowerWorld Simulator Project files provide a solution.
PowerWorld Simulator Projects have the extension *.pwp. A project serves as a container for all the
files that might comprise a simulation, including the case file, one or more oneline diagrams, a script
file, one or more auxiliary data files, and a case template, as well as any other support files you may
wish to include. A project is actually a compressed file archive that is compatible with the widely
available PKZip and WinZip file compression utilities. It is strongly recommended, however, that you
work with project files strictly within the PowerWorld Simulator environment, as Simulator can
automatically perform the file compression and extraction functions and process the contents of the
included files in a single step. (Note: Simulator performs file compression and extraction using
software components available from http://www.cdrom.com/pub/infozip/ and
http://www.geocities.com/SiliconValley/Orchard/8607/ main.html).
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PowerWorld Project Initialization Script
Included in every project file is an initialization script file called OPENPWB.SCP. This is a special type of
PowerWorld script file that is used to unload the contents of the project that are used in the
simulation. This file must begin with the keyword "INITIALIZATION" and terminate with the keyword
"END". Between these two lines, OPENPWB.SCP identifies the name of the case, any oneline diagrams
that should be opened immediately, a template file (if any), a script file (if any), and one or more
auxiliary data files (if any) to open and read into memory after extracting the files. The file might also
contain the keyword "AUTOSTART", indicating that the simulation of the system described by the
project file should commence immediately after it is read into memory. The OPENPWB.SCP is
generated for you automatically when you save a new project file. Here is an example that loads the
case B7FLAT.PWB (in PowerWorld binary format) along with oneline diagram B7FLAT.PWD, the
template B7FLAT.PWT, the script B7FLAT.SCP, and the auxiliary file B7FLAT.AUX, and then starts the
simulation immediately after all contents are extracted and read:
INITIALIZATION
CASE PWB B7FLAT.PWB
ONELINE B7FLAT.PWD
TEMPLATE B7FLAT.PWT
SCRIPT B7FLAT.SCP
DATAFILE B7FLAT.AUX
AUTOSTART
END
Again, all projects must contain the file OPENPWB.SCP. If a project does not contain this file, an error
message will be shown. Simulator automatically includes an OPENPWB.SCP file with every project it
creates. Therefore, unless you try to create a project file outside of Simulator, you will not have to
worry about this requirement.
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Associating Project Files with Simulator
PowerWorld Simulator can automatically open and load the contents of a project if the proper file
associations have been made. When Simulator is installed on a computer, it registers the file extension
*.pwp in the Windows registry. Then, whenever you double-click on an icon for a project file or
download a project file from a web site, Simulator will start, extract the contents of the project file,
and read them into memory. The power system will then be displayed exactly as the author of the
project file intended it to be displayed.
If the file association is somehow destroyed (i.e. Windows no longer recognizes that *.pwp files should
be associated with and opened by Simulator), you can re-establish the association manually using the
following procedure:






Windows 95/98/NT
o Open Windows Explorer.
o Select View > Folder Options from Windows Explorer’s main menu.
o Switch to the tab labeled "File Types."
o Click the button labeled "New Type."
o For "Description of Type," specify "PowerWorld Project."
o For "Associated Extension," specify "PWP".
o For "ContentType (MIME)," specify "application/powerworld_project."
o For "Default Extension," specify ".PWP".
o Under "Actions," click the button labeled "New."
o Specify the "Action" as "open."
o Specify the "Application used to perform action" as the path to the Simulator executable
file, followed by a space and the string "%1" (including the quotation marks). For example,
if the path of the PowerWorld Simulator executable is "c:\program
files\PowerWorld\pwrworld.exe," then you should specify the following string:
c:\program files\PowerWorld\pwrworld.exe "%1"
o Click OK to close the Action dialog.
o Click OK to complete the definition of the file association.
Windows XP
o Open Windows Explorer
o Select Tools > Folder Options from Windows Explorer’s main menu.
o Switch to the tab labeled "File Types"
o Click the button labeled New
o For "File Extension", enter "PWP", then click OK.
o Find the PWP entry in the Registered file types list, then click on it.
o Next, with the PWP entry selected, click on Advanced.
o In the box to the left of the "Change Icon…" button, type in "PowerWorld Project"
o Click on the "New…" button on the right-hand side of this dialog, which will pop up a "New
Action" dialog
o In the New Action dialog, click "Browse…"
o Navigate to and select the PowerWorld program binary (pwrworld.exe); the default location
is c:\Program Files\PowerWorld\pwrworld.exe
o In the New Action dialog, enter "Open the project" in the field labeled "Action"
o Click OK in the New Action dialog and in the Edit File Type dialog
o Click Close when you are back to the main File Types dialog.
For future Windows versions, refer to the Windows help on changing file type associations.
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The *.pwp file type will now be recognized on your system as being associated with PowerWorld
Simulator. Again, you will need to perform this procedure only if the association somehow gets
removed.
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Creating a New Project File
Creating a new project file in Simulator is fairly simple. First, make sure that the case for which you
want to create the project is open in Simulator, as well as any oneline diagrams that you wish to open
automatically whenever the user opens the project. Then select Save As Project from the Application
Button. This opens the Create Project Dialog, which you can use to specify the contents of the project
file. When you click OK on the Create Project Dialog, the files you identified will be compressed into a
single file, along with the project initialization script that tells Simulator how it should import the
contents of the project.
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Create Project Dialog
The Create Project Dialog enables you to create a new PowerWorld Simulator Project by specifying the
files that should be included in the project. To open the Create Project Dialog, select Save As Project
from the Application Button. When it opens, the dialog will automatically include the case file, all open
oneline diagrams, all documents and onelines linked to the display by document links and oneline
links, the current case template file, and the current script in its list of files to add to the project. You
can then use this dialog to add files to or delete files from the list of project contents.
The Create Project Dialog features the following controls:
Case
Identifies the name of the case file that is currently open in Simulator. The case file may be in
PowerWorld binary format, in PTI Version 23 - 29 .raw format, or in GE PSLF .epc format. You
cannot change this field, because it must be set to whatever case is currently open.
Open these oneline diagrams automatically
Lists the names of the oneline diagrams that will automatically open whenever a user opens the
project file. This is also a read-only control and lists the names of all oneline diagrams that are
currently open in Simulator. Therefore, before you start to create a project using the Create Project
dialog, make sure that only those oneline diagrams you wish to open automatically with the project
are currently open in Simulator.
Use this script file
Identifies a script file that should be opened automatically when the project is open. Scripts are text
files that contain commands in PowerWorld's scripting language that Simulator interprets to perform
a predefined set of tasks during the simulation. If a script file is in use when you try to create the
project, its name will automatically appear in this text box. To specify a different script file, either
type its full path in the text box, or press the adjacent Browse button to search for it on your
machine.
Load data from auxiliary files
Lists the auxiliary data files that should be automatically read when the project is open. Auxiliary
data files are text files that contain data that supplement or supersede the information in the case
file. You may include as many automatically loading auxiliary data files in the project as you like. To
add an auxiliary file to the project contents, click the adjacent Add button and locate the file on your
machine. To remove an auxiliary file from the list, select it and click the adjacent Remove button.
Also include these files
Lists any other files you may wish to include in the project. Use this control to include supplementary
documents, pictures, or even other PowerWorld project files, in the project. To add a file to the
contents, click Add a File. To remove a file from the list, select it and press the adjacent Remove
button.
Automatically start the simulation after opening the project
Check this button to cause Simulator to start the simulation immediately after opening the project.
This saves the user who opens the project the step of switching to run mode and clicking the play
button in the Power Flow Tools ribbon group on the Tools ribbon tab. This option is particularly
effective, for example, if you want to display a "movie" of system conditions when the project is
open. By including a script file in the project that tells Simulator how to modify the system and view
over time, you create a project that, when opened or downloaded, animates the scenario you are
trying to model.
Save this project as
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Identifies the name of the project that should be saved. By default, the project name is the same as
that of the case except that it has the extension "pwp". To specify a different name, either type it
directly in the text box, or click the adjacent Browse button and specify the full path.
When you have finished specifying the contents of the project file, click the OK,save the
project button. If you wish to cancel the operation without creating the project, click Cancel.
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Opening an Existing Project
To open an existing PowerWorld Simulator Project file, select Open Project from the Application
Button, and select the name of the project you wish to open. Alternatively, you may select Open Case
from the Application Button, change the Files of Type setting to "PowerWorld Project (*.pwp)," and
select the project you wish to open. Simulator will extract the contents of the project file into the
project file’s folder and input the information it needs to display the case, oneline diagrams, and other
associated files.
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Model Explorer

Most Case Information Displays are enclosed inside the Model Explorer. To open the Model Explorer,
click on the Model Explorer button shown above. The Model Explorer button is available on both the
Case Information Ribbon Tab and Tools Ribbon Tab by default. It is also placed on the Quick Access
Toolbar by default.
Note: normally only one Model Explorer window will be open at a time. If you choose to open a case
information display from various places in the Ribbon, the open Model Explorer will be moved to this
case information display. If you want multiple Model Explorers to be open, then click on the Open
New Explorer button below the Explore Pane.
When you open the Model Explorer you will see a case information display. In addition to this the
model explorer has 5 additional regions to help you navigate the model as well as modify the model.
Explore Pane
The Explore Pane contains a hierarchical list of most of the objects contained in the power system
model. Entries in the Explore Pane that are grayed out represent objects that presently are not
defined in the model. The Explore Pane is separated into eight primary folders, with only the
Network and Aggregations folder expanded by default. The primary folders are as follows:











Recent - contains a list of case information displays that have been recently opened. This same
list of case information displays are depicted by the Tabs displayed across the top of the Model
Explorer which indicate the currently open data tables.
Network - contains a list of the network model objects. Generally these represent actual physical
devices such as a generator or transmission line.
Aggregations - contains a list of model objects that represent an aggregation of other model
objects. Some examples of data found here are interfaces and injection groups.
Solution Details - provides access to case information displays that provide details regarding the
power flow solution. It includes displays such as the Y-Bus, Jacobian, and summaries of remotely
regulated buses
Case Information and Auxiliary - contains generic objects that operate on the other objects in
the model. This includes filters, expressions, and model criteria.
Contingency Analysis - contains a convenient place to access case information displays showing
options related to contingency analysis.
Fault Analysis - contains a convenient place to access case information displays showing options
related to fault analysis.
Optimal Power Flow - contains a convenient place to access case information displays showing
options related to the OPF or SCOPF.
Transient Stability - contains a convenient place to access case information displays showing
options related to Transient Stability
User-Defined - contains a list of User-Defined Case Information Displays available. These
displays are created by right-clicking on the Explore Pane and choosing to Insert User-Defined
Case Info. For more information see the User-Defined Case Information Displays help.
Explore Pane Options
There are a few options regarding the Explore Pane which can be accessed by right-clicking
on the Explore Pane, Searchbar, Filterbar, or Case Information Toolbar. When right-clicking a
local menu will appear that allows you to specify the following options.
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Fields Pane Location : Allows
you to specify the location of the
Fields Pane. See the Model
Explorer: Fields Pane for more
details.
Save Recent (Number) : Choose
this option to change the number of
recently viewed case information
tables that are kept open and
shown as tabs in the Recent Tabs.
Show Number of Objects :
Check this option to show a number
next to each entry in the Explore
Pane.
Insert User-Defined Case Info,
Remove User-Defined Case
Info : These options allow you to
insert and remove user-defined
Case Information Displays. For
more detailed information see the
User-Defined Case Information
Display help.
Fields Pane
The Fields Pane provides direct access to modifying the columns that appear on the case information
displays. This replicates the features that can also be accessed by choosing
Display/Column
Options on the case information toolbar to open the dialog for Configuring the Case Information
Displays. See the Model Explorer: Fields Pane for more details.
Recent Tabs
The Recent Tabs represent a list of the most recently viewed case information displays on the Model
Explorer. You can click on the X to the left of each tab to clear that from the recent list.
Case Information Toolbar
The Case Information Toolbar contains a graphical representation of all the options and actions
which can be applied to the case information display. The toolbar is described in detail in the case
information toolbar topic. Also note that all the options displayed on the toolbar are also available by
right-clicking on the toolbar and showing the case information local menu.
Case Information Filterbar
The Filterbar provides convenient access to apply an Advanced Filter or a Device Filter to the case
information display. The toolbar is described in detail in the Case Information Filterbar topic.
Case Information Searchbar
The Searchbar contains a toolbar that allows you to search the active case information display for
particular text. This toolbar behaves in the same manner as the Search For Text Dialog.
A picture of the Model Explorer as it appears when showing the generator records is shown below.
Besides showing case information display,
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Model Explorer: Fields Pane
The Fields Pane on the Model Explorer provides direct access to all the fields available for the case
information display shown. The same features can also be accessed by choosing
Display/Column
Options on the case information toolbar to open the dialog for Configuring the Case Information
Displays. A picture of the Fields Pane is shown at the bottom of this topic.
Dragging to Add Fields
After selecting fields from the Fields Pane, left-click and drag to add fields to the case information
display. Fields will be added to the left of the column on which they are dropped. You will see red
highlighting in the column headings indicating the position to which the fields will be added.
Dragging to Remove Fields
If you hold the CTRL key down and then left-click and drag a column heading from the case
information display, you can then drop into the list of fields on the Fields Pane to remove the
column.
Dragging to Move Fields
If you hold the CTRL key down and then left-click and drag a column heading on the case
information display, you can move the columns around relative to one another. You will see red
highlighting in the column headings to indicate the position to which the field is being moved.
Find Field
Click this button to search through the list of fields using a wild card search.
Add ->
Click this button and all selected fields in the Fields Pane will be added to the left of the presently
selected columns in the case information display.
<-Remove
Click this button and all columns that have any cell presently selected will be removed from the case
information display.
Expand and Collapse
Click this button to expand or collapse the folder view showing all the available fields.
Frozen Columns
The number of columns that are fixed and do not scroll when you scroll left or right in the display.
Frozen columns will have a background color of gray instead of white. The number of frozen
columns is 1 by default.
Reset to Factory Defaults
Click this button to reset all case information display properties to their default settings, including
column and data field associations.
Fields Pane Location
By right-clicking on the Fields Pane or Explore Pane you can bring up the Explore Pane Options. On
this drop-down you can specify the Fields Pane Location to be either Tab with Explore, Left Side,
or Right Side. The behavior for the various pane locations are shown as follows.
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Case Information Displays
Simulator offers numerous that provide a convenient, spreadsheet-like view of the power system and
its components and are available regardless of whether the case has an associated oneline diagram or
not. Many case information displays are available by using the Model Explorer button found on the
Case Information ribbon tab, although these spread-sheet like views appear throughout the software
as stand-alone displays and embedded inside other dialogs. Case information displays are available for
buses, bus mismatches, generators, generator costs, ac lines, transformers, transformer impedance
correction tables, dc lines, interfaces, areas, zones, schedules, and all other types of objects.
It is also possible to create User-Defined Case Information Display on the Model Explorer.
Other screens, such as the Area/Zone/Owner Filters display, also fall into the category of case
information displays. There are many different characteristics associated with the Case Information
Displays, as discussed in the following topics:
Colors and Cell Styles
Using Cell Handles
Case Information Toolbar
Case Information Filterbar
Sorting Records
Configuring the Case Information Displays
Finding Records
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Configuring the Case Information Displays
The content and format of all case information displays can be controlled through the Display / Column
Options dialog. This dialog can be viewed by choosing
Display/Column Options on the case
information toolbar or from the case information display’s local menu. The features on this display can
also be accessed on the Model Explorer: Fields Pane.
To reset all case information display properties to their default settings, including column and data
field associations, click the Reset All to Default Values button.
To save your changes and close the dialog box, click OK. To save your changes without closing the
dialog box, click Save. To undo the changes you have specified and close the dialog box, click
Cancel. Finally, click Help to view the corresponding help screen.
While it is normally sufficient to customize the case information displays that comes with the program,
it is also possible to create User-Defined Case Information Displays on the Model Explore. This then
provides the ability to switch between different sets of columns, filters, sorting etc... without requiring
repeated customizations.
Column Options
The Column Options Tab is shown in the figure below.
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Available Fields
This folder view contains all the fields available for addition to the respective case information
display. You may select several entries from this list by holding down the Shift and Control keys.
Hold down the control key to select several individual fields. Hold down the Shift key to select all
fields between two successive mouse clicks. You may then add multiple fields to the Shown fields
(see Add-> below). Fields are generally organized into folder, so make use of the Find Field
button if you have trouble finding the field you're looking for.
Note: when the mouse hovers over a field, a hint appears giving a longer description of the field.
Find Field
Click this button to search through the list of fields using wild card search.
Expand and Collapse
Click these button to expand or collapse the folder view showing all the available fields.
Show Variable Names
When this box is checked, the variable name corresponding to each column heading will be
displayed in the list of available fields alongside the appropriate column heading.
Green, Red, and Blue dots
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Also note that fields that the Green, Red, and Blue dots next to each string represents what type of
value it is. Also, fields that are shown with gray text in the available field list represent fields that are
already shown and in the list on the right.
Show these fields in this order
This list contains the fields which are presently shown on the respective case information display.
Not that the field name is representing using backslash \ characters to signify the folders. You may
select several entries from this list by holding down the Shift and Control keys. Hold down the
control key to select several individual fields. Hold down the Shift key to select all fields between two
successive mouse clicks. You may then remove multiple fields (see Remove below) or move the
order of fields (see Move below).
Note: when the mouse hovers over a field, a hint appears giving a longer description of the field.
Column Width
Enter a new value to adjust the physical width of the column. This will affect all fields selected in the
Show these fields list.
Total Digits
The number of digits to use when displaying values in the column (including the decimal point.) This
will affect all fields selected in the Show these fields list.
Decimal Places
Number of total digits to the right of the decimal point. This will affect all fields selected in the Show
these fields list.
Add > (Inserting Columns)
Click the Add > button to add all selected available fields to the end of the Show these fields list.
You may also click on the selected Available fields and drag and drop the field on the Show these
fields list. When drag/dropping the fields, all selected fields will be inserted just before the field that
the mouse is over when you drop the fields. Once you have added fields you may then utilize the
< Remove (Removing Columns)
Click the < Remove button to remove the fields that are currently selected in the Show these fields
list. You may also click on the selected fields in the Show these fields list and drag and drop the
fields on the Available fields.
Move Up, Move Down (Moving Columns)
If you selected a block of fields in the Show these fields list, you may change the order of the list by
clicking on the Move Up or Move Down button. You can also move the selection by left-clicking
and dragging to move the columns around.
Also note that if you hold the CTRL key down and then left-click and drag a column heading on the
case information display, you can move the columns around relative to one another. You will see red
highlighting in the column headings to indicate the position to which the field is being moved.
Highlight Key Fields
Checking this option will highlight the key fields for the type of object displayed in the case
information display presently being modified. The fields highlighted in Yellow in the two lists are
either the Primary key fields (numbered) or the Secondary key fields (lettered). Note that some key
fields, usually the Circuit ID, are both numbered and lettered, meaning they are used as both
Primary or Secondary key fields. Either ALL numbered key fields OR all lettered key fields must be
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included in the list of shown columns if you intend to export the data to either Excel or a text file,
modify it, and paste it back into Simulator.
The fields highlighted in Green are the fields that would be necessary in Excel or an auxiliary file in
order to create NEW objects of the type displayed when pasting from Excel or reading in an auxiliary
file. If all of the green highlighted fields are not present in the external source, Simulator will not be
able to create new objects that may be defined in that source, and will only paste information for
objects that already exist in the present case.
Frozen Columns
The number of columns that are fixed and do not scroll when you scroll left or right in the display.
Frozen columns will have a background color of gray instead of white. The number of frozen
columns is 1 by default.

Display Options
Use Area / Zone Filters
Check this box to restrict the case information display’s record set to cover only those areas and
zones specified by the area/zone/owner filters. If this box is unchecked, all records, regardless of
zone or area, will be displayed. (The area/zone filters option obviously does not apply to the
Area/Zone Filters information display.)
Advanced Filter
Clicking this button will open the Advanced Filters Dialog, which will allow more detailed filtering on
the display.
Zoom
You can zoom in and out on a case information display by using the keyboard short cut Ctrl+Up and
Ctrl+Down. Alternatively you can zoom in out by setting a percentage on this dialog. This can also
by modified under the Options Menu of the Case Information Toolbar.
Use Custom Font / Row Height
If checked, then the Row Height and Custom Font specifications will be used. Changing either the
Row Height or Custom Font properties will cause this box to become checked automatically. If you
wish not to apply your custom specifications to the active case information display, uncheck this
box; the default font and row height settings, as defined under the Case Information Displays tab of
the Simulator Options dialog box or under the Options Menu of the Case Information Toolbar, will be
reapplied.
Row Height
Defines the height of the rows of the case information display.
Change Custom Font
Defines the font with which to display the records.
Set as Default
Sets the current Font and Row Height as the defaults.
Auto Size all Column Widths
Constrains all field widths to contain the widest data elements in each column.
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Custom Field Descriptions
Custom Field Descriptions allow specification of custom floating point, integer, and string fields with
user-defined column headers and field names. These fields can be added to case information displays
for all power system case data and many supporting data types. Custom fields are currently not
available for use with case information displays listing display objects. By default, there are two
custom fields of each type available, but any number of each type of field can be defined for each type
of data.
To view the Custom Field Descriptions, open Custom Field Descriptions found under the Case
Information and Auxiliary folder on the Model Explorer. The table lists the object types for which
custom fields have been defined, how many of each type of field has been defined, and any custom
field captions and headers for the fields. By default, there will be three entries; there are two fields
each for floating point, integer, and string fields for all data types. These defaults will be used unless
specific custom fields are defined for a particular data type.
To insert a new description, select Records > Insert from the case information toolbar. To modify an
existing description, choose Show Dialog from the case information toolbar. Performing either of
these actions will open the Custom Field Description dialog. To remove and existing description,
choose Records > Delete. Default descriptions cannot be removed.
The following fields are used for defining the custom field descriptions:
Object Type
Type of object for which the field is available. The Default type will be used for any data type that
does not have its own definition. This field can only be set using the Custom Field Description dialog
and cannot be changed once a description has been created.
Field Type
The three options for this field are Floating Point, Integer, and String. This is the type of value that
will be used in the custom field. This field can only be set on the Custom Field Description dialog
when inserting a new custom field description.
Number of Type
This value determines how many fields of the particular Field Type will be available.
Captions for Field (comma-separated)
Specify the caption to use for each field. These captions will appear in lists of fields for objects such
as the list of available fields used with Display/Column options. Enter the captions as a commaseparated list. Leave an empty entry to not assign a particular caption. If a caption is not defined for
a particular field, the default will be used. For example, if the Field Type is Integer and there are two
fields defined, the Field Captions will be Integer 1 and Integer 2.
If captions are not defined for the fields and Captions for Headers are defined, the header captions
will be used instead of the defaults.
Captions for Header (comma-separated)
Specify the caption to use for each field column header. These headers appear in the case
information displays for the particular object type. Enter the captions as a comma-separated list.
Leave an empty entry to not assign a particular caption. If a header caption is not defined for a
particular field, the default will be used. For example, if the Field Type is Integer and there are two
fields defined, the Header Captions will be Cust Int 1 and Cust Int 2.
If captions are not defined for the headers and Captions for Field are defined, the field captions will
be used instead of the defaults.
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Custom Field Description Dialog
The Custom Field Description Dialog is used to create and modify custom field descriptions for a
selected object type. This dialog can be accessed from the Custom Field Descriptions display when
inserting a new description by selecting Records > Insert or modifying an existing description by
selecting Show Dialog.

Object Name
Type of object for which the field is available. Select the type from the drop-down list or use the
Find button to search through a list of available types. This field can only be set when creating a
new description and cannot be changed once a description has been created.
Field Type
The three options for this field are Floating Point, Integer, and String. This is the type of value that
will be used in the custom field. This field can only be set when inserting a new custom field
description and cannot be changed once a description has been created.
Number of Type
This value determines how many fields of the particular Field Type will be available.
Clear Captions
Click this button to clear out any previously defined captions.
Field Captions
Specify the caption to use for each field. These captions will appear in lists of fields for objects such
as the list of available fields used with Display/Column options. If a caption is not defined for a
particular field, the default will be used. For example, if the Field Type is Integer and there are two
fields defined, the Field Captions will be Integer 1 and Integer 2.
If captions are not defined for the fields and Header Captions are defined, the header captions will
be used instead of the defaults.
Header Captions
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Specify the caption to use for each field column header. These headers appear in the case
information displays for the particular object type. If a header caption is not defined for a particular
field, the default will be used. For example, if the Field Type is Integer and there are two fields
defined, the Header Captions will be Cust Int 1 and Cust Int 2.
If captions are not defined for the headers and Captions for Field are defined, the field captions will
be used instead of the defaults.
OK, Cancel
Click OK to accept the changes and close the dialog or Cancel to ignore the changes and close the
dialog.
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Calculated Fields
Calculated fields provide a means of performing an arithmetic operation (minimum, maximum, sum,
average, median, variance, standard deviation, count) on a group of objects based on a selected field.
Based on the object type of the group, a calculated field can be added to a case information display
for a given object. The calculated field value that is displayed is then based on the calculated field
parameters and how the object type in the calculated field relates to the given object.
For example, suppose that you want to find the largest line flow for all lines connected to a bus. A
calculated field can be set up using the branch object type with a selected field of MVA (maximum)
and the maximum operation can be performed on this field. This calculated field can then be
associated with buses by adding this field to the bus case information display. The resulting values for
this field will show the maximum MVA flow for all lines connected to a given bus. When determining
the value, only the branches that have a terminal bus the same as the given bus will be considered,
and the maximum MVA value for all of those branches will be reported.
Optionally, filters can be associated with calculated fields to further specify what objects should be
considered in the calculation.
The calculated fields case information display can be accessed from the Model Explorer under Case
Information and Auxiliary > Calculated Fields. Existing calculated fields can be modified by
selecting Show Dialog from the case information toolbar, and new calculated fields can be added by
selecting Records > Insert from the case information toolbar. Both actions will open the Calculated
Field dialog shown below.
Calculated Field Dialog
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Calculated Field Name
This is the name of the calculated field as it will appear when added to a case information display.
Use the Save, Save As, Rename, and Delete buttons to create new calculated fields without
exiting the dialog. Switch between existing calculated fields by choosing a name from the drop-down
box.
Object Type
Type of object that will be included in the calculation. The type of object determines which objects
this field can be used with. This information is displayed to the right of the Object Type option.
Field
Select the field to use in the calculation by selecting a field name from the drop-down box or by
clicking the Find button to use advanced search options to locate the field. Check the Use Absolute
Value box to use the absolute value of the field in the operation.
Operation
Select the type of operation to perform on the object fields.
Treat Blank Entries
Depending on the field selected, some objects may not have entries. Select to either treat these
blank entries As zeros or to Ignore them in the calculation.
Objects to be included in the operation
This option determines if All objects of the selected type will be included in the calculation or if they
will be filtered by Only objects that meet the filter below.
If choosing to apply a filter, the filter can be defined by using the same options available when
defining an advanced filter. The Set Filter Same As button can be used to select an existing
advanced filter whose actions should be applied to this filter.
Keep in mind that objects included in the calculation will first be determined by the object type. If for
example branch is selected, then all branches will be considered. Setting a filter will limit the branches
to only those branches that meet the filter. If the calculated field is used with buses, then the
branches considered for a given bus will be only those branches that have a terminal bus the same as
the given bus. If the calculated field is used with generators, then the branches considered for a given
generator will be only those branches that have a terminal bus the same as the terminal bus of the
given generator.
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Case Information Customizations Display
To open the Case Information Customizations display, select Case Information and Auxiliary >
Case Info Customizations from the Model Explorer. If you have customized any of the case
information displays for your case, you can see a list of the customized displays and their settings from
this display.
Case Information Customization settings cannot be inserted manually or modified on this display.
Those modifications must be done on the actual case information display. The primary use of this list
display is to provide you a location to save and load case information customizations to an auxiliary
file. Customizations can be loaded from an auxiliary file by right-clicking on the grid and choosing to
load data from an auxiliary file. To save the customizations, right-click on this display and select Save
As > Auxiliary Data.
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Case Information Displays: Local Menu Options
All case information displays have a set of local menu options. The local menu can be brought up at
any time by right clicking on case information display. Most of the actions and options available in the
local menu are identical to the options available in the Case Information Toolbar. This is depicted in
the figure below.

For help on most of the actions and options available in the local menu, please see the Case
Information Toolbar help. The other options that are also sometimes available on the right-click menu
however are listed below.
Why is this field or line disabled?
This option will display a message showing the reason why the field is disabled. This option will be
enabled only if the field is actually disabled.
Help
Display context-sensitive help for the case-information display.
Form Control
This menu option allows to control the case information display.
Print
You can print the contents of most of the case information displays by selecting Print from the
local menu.
Close
Closes the case information display.
Make Top Left of Form Visible
Makes the top or the left of the case information display visible, if either the top or the left are
not visible.
Shift Form Up
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Moves the case information display up so the bottom of the case information display can be
visible.
Maximize
Maximizes the size of the case information display.
Unmaximize (Restore)
Restores the size of the case information display.
Minimize
Minimizes the size of the case information display.
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Case Information Displays: Colors and Cell Styles
The case information displays distinguish data field types by text color and cell style. Most of the
entries on the case information display are colored using the following color convention. These colors
can be customized using the Case Information Displays tab on theSimulation Options Display, which
can be invoked by selecting Simulator Options from the Case Options ribbon group on the
Options ribbon tab. Simulator Options is also available on the Tools and Case Information ribbon
tabs.
There are three types of data fields:
Standard Fields Fields that cannot be modified directly from the case information display are
colored black by default.
Enterable Fields Fields that can be modified are colored navy blue by default. When selected, a
cell containing an enterable field will display a tiny filled square in its bottom right corner. This box is
called a cell.
Toggleable Fields Fields whose values can be toggled are colored green by default. The values
contained in toggleable fields are modified by double left-clicking on them or selecting the possible
entries from the drop-down or dialog that becomes available when single left-clicking on the field.
Like cells in enterable fields, cells in toggleable fields display a cell handle when selected.
Besides indicating field type, color coding is also used to highlight violations of branch flow, generator
MW or MVR output, and bus voltage constraints. Fields that are either at a limit or violating a limit are
colored red by default. This, too, is configurable from the Case Information Displays tab on Simulation
Options Display.
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Case Information Displays: Using Cell Handles
When selected, cells corresponding to enterable and toggleable fields exhibit a small filled square in
their bottom right corner called a cell handle. The cell handle may be used to propagate the value of
the selected cell to other cells in the same field.
Suppose we have selected a toggleable or enterable cell and that we wish to copy its value to other
records. Call this cell the source cell and its value the source value. To copy the source value to
another record or records, perform the following steps:






Drag the mouse onto the cell handle until the pointer becomes a crosshair.
With the mouse pointer showing as a crosshair, click and hold the left mouse button.
With the left mouse button depressed, drag the mouse up or down from the source cell to select a
group of records to which to copy the source value. These destination cells will display a yellow
background when selected in this manner.
When you have finished selecting the destination cells, release the left mouse button.
A message box will appear asking whether you want to change the values of the destination cells
to the source value. Answer Yes to complete the copy.
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Case Information Displays: Sorting Records
You can sort the entries on the case information displays by just about any field. To sort the records
by a particular column, left-click on the column’s heading. Left-click the column’s heading again to
reverse the sort order.
To sort the records by the absolute value of a field, hold down the shift key as you left-click on the
field’s heading.
Simulator also has a more advanced sorting tool, which can be accessed by selecting Advanced Sort
from the local menu. Advanced sort allows you to sort information based on values in more than one
column of data. Advanced sort also allows you to sort based on the absolute value of numerical fields
and by case sensitivity for string fields.
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Case Information Displays: Finding Records
The Find Dialog is used to find the device of the specified type on the different Case Information
displays. The Find Dialog is available on most case information displays from the local menu, which
can be invoked by right-clicking in the grid.
Different Find dialogs exist for Areas, Buses, Interfaces, Lines and Zones. Note that the Bus Dialog is
used to locate all bus objects, such as generators, loads, switched shunts and the bus itself. In
general, the format of each dialog is similar, allowing you to find the desired object using either its
number or name. The only exception is interfaces, for which no name is defined. The basics of the
Find dialog are explained in the Find Dialog Basics help topic.
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Saving Case Information Display Contents as HTML Tables
Simulator's Case Information Displays allow you to save their contents as HTML tables for display on
the world-wide web. To do this, right-click on any row of the table and select Save As HTML from the
resulting local menu. This brings up the Table Format Dialog. Set the various table formatting options
and click OK. Then, select the name of the file to which to save the HTML code. Finally, if a region of
the table was selected, you will be asked if you want to save just the selected region as HTML.
Indicate Yes to convert just the selected portion of the table, or click No to write the entire table as
HTML.
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HTML Table Format Dialog
The Table Format Dialog allows you to set various formatting options for HTML tables. This form is
invoked when you try to save a Case Information Displays as HTML.
The Table Format Dialog is divided into two tabs, Table Properties and Table Elements.
Table Properties
This tab allows you to specify values for options that govern the appearance of the table as a whole.
Here you can specify the following properties:
Border Weight
The thickness of the border to draw around each cell. Specify 0 to suppress the drawing of a cell
border.
Horizontal Cell Spacing
The spacing to employ between cells that neighbor each other horizontally.
Vertical Cell Spacing
The spacing to employ between cells that neighbor each other vertically.
Table Width
The width of the table. If the Percent checkbox is checked, the width specifies the horizontal
dimension of the table relative to the object that contains it on the screen.
Caption
The table title that will be printed directly above it on the web page.
Table Elements
These options control how the data will be centered in each cell. Choices include:
Horizontal Alignment
Controls how the text in each cell should be positioned horizontally. The default value is Left, but
you may also choose to center or right-justify the data in each cell.
Vertical Alignment
Controls how the text in each cell should be positioned vertically. The default value is Middle, but
you may also choose to align the text with the top or bottom edges of the cell.
If any of the numeric entries (Border Weight, Horizontal Cell Spacing, Vertical Cell Spacing, Table
Width) are left blank or zero, your browser will employ its default settings for these values in rendering
the table on the screen.
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Case Information Toolbar

Directly above most case information displays , the Case Information Toolbar provides easy access to
many Case Information Display options for formatting and customizing a list display. Note that all of
the options are also available from the right-click local menu on the case information display as well.

Show Dialog
Selecting the Show Dialog option will invoke a dialog box containing more detailed information and
settings regarding the corresponding system object. For example, clicking Show Dialog while a Bus
Case Information Display is the active window opens the Bus Information Dialog.
Display/Column Options
The contents and format of the information display can be controlled using the Case Information
Display Dialog. See Configuring the Case Information Displays for more details.
Auto Size all Column Widths
Constrains all field widths to contain the widest data elements in each column.
Increase/Decrease Decimals
Adjusts the number of displayed decimal places for all cells in the selected column in a case
information display.
Find
Use the Find local menu option to retrieve a record pertaining to a particular element. Choosing Find
from toolbar opens the Find Dialog Box, which is used to find records pertaining to an element
identified by either number or name.
Search
Invokes the Search for Text dialog; allows you to search for specific text in a case information
display.
Bus View Oneline
On many case information displays click this button to open the Bus View Oneline to the bus related
to the presently active cell of the case information display.
Records Menu
The Records Menu contains actions that apply to the specific kinds of records displayed in the active
case information display. Custom Expressions, Bus View Oneline, Substation View Oneline, Quick
Power Flow List and are always shown in this drop-down. For more details see the Case Information
Toolbar: Records Menu Help.
Geo Data View Menu
The Geo Menu is only available on case information displays that show records related to the
network model. For more details see the Case Information Toolbar: Geo Data Menu Help.
Set and Columns Menu
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Set contains actions for setting data or toggling data.
Columns contains actions that act on the column such as Get Column Metrics. For more details see
the Case Information Toolbar: Set, Toggle, and Column Menu Help.
Copy, Paste and Send Menu
The Copy, Paste and Send Menu contains actions that copy and paste data through the Windows
Clipboard. In addition it contains actions that send data directly to spreadsheet software such as
Microsoft Excel or Open Office Calc. For more details see the Case Information Toolbar: Copy, Paste,
and Send Menu Help.
Save Auxiliary Menu
The Save Auxiliary Drop-Down contains actions that save data in the case information display to
various formats. The Auxiliary File Format and Comma-Separate-Variable (CSV) formats are always
available, but some records show other more specific formats. For more details see the Case
Information Toolbar Save Auxiliary Files Menu Help.
Load Auxiliary Menu
The Load Auxiliary Drop-Down contains actions that load data records related to the active case
information display. The Auxiliary File Format is always a choice, but some records show other more
record-specific formats. For more details see the Case Information Toolbar: Load Auxiliary Files
Menu Help.
Area/Zone/Owner Filters
Opens the Area/Zone/Owner Filters display which allows filtering of the case information displays by
Area, Zone, and Owner.
Filtering Menu
The Filtering Drop contains actions related to filtering the records shown in the active case
information display. For more details see the Case Information Toolbar: Filtering Menu Help.
Advanced Sort
Allows the user to custom sort the information in the display based on desired criteria. See Case
Information Display: Sorting Records for more information.
Refresh Display
Select this option to update the currently displayed data to match the present state of the system.
Options Menu
Invokes a drop down menu similar to the Case Information Display options dialog. See Case
Information Display Options for more details.
Highlight Key and Required Field Column Headings
If this option is checked, the key fields needed for identifying objects will be highlighted in the
case information display. These fields are important if you are planning on pasting data back
into Simulator from Excel or reading data in from an auxiliary file. If the necessary key fields
are not present in the Excel paste of auxiliary file, the data in those formats cannot be
processed by Simulator.
Similarly, the Required Field Column Headings can also be highlighted in the case information
display. In order for Simulator to create new objects by reading them from an auxiliary file or
and Excel paste, the required fields must be present in the pasted data or the object cannot
be created.
Headings
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This option allows you to choose whether the column headings of the case information
displays are the normal column headings or are the variable names of the type of data stored
in each column. Variable names are the strings used when writing data out to an Auxiliary
File. Change the headings to variable names can be helpful when looking at or creating
auxiliary files.
Show Grid Lines
Grid lines are shown by default in case information displays. Unchecking this box will remove
the grid lines from the displays.
Show Header Hints
This option allows the hints for the current field to be displayed when moving the cursor over
the column heading.
Word Wrap Headings
Check this box to wrap the heading column text, breaking it in several rows to fit the current
column width. If unchecked, the column heading text will be displayed in only one row.
Highlight Objects if Selected? Field = YES
Check this option to automatically highlight all case information rows that represent a model
object that has its "Selected" field set to YES. The row will then be highlighted using the color
specified on this dialog. This option will apply to all case information displays representing all
types of objects.
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Case Information Toolbar: Copy, Paste and Send Menu
The Case Information Toolbar Copy, Paste and Send Menu displays the identical options as shown in
the Copy/Paste/Send menu of the case information display local menu. This is depicted in the figure
below. The options are described below the figure.

Paste
Select Paste from the local menu to copy a record set from the Windows clipboard into the case
information display. See Copying Simulator Data to and from Other Applications for more details.
Copy Selection
The Copy Selection menu option copies the records selected in the case information display to the
Windows clipboard, from which the selection can be copied into other programs such as Microsoft
Excel for further analysis. See Copying Simulator Data to and from Other Applications for more
details.
Copy All
The Copy All menu option copies the entire record set contained in the case information display to
the Windows clipboard, from which it can be copied into other programs such as Excel for further
analysis. See Copying Simulator Data to and from Other Applications for more details.
Copy / Send Special
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The Copy / Send Special menu option will open the a dialog that allows the user to set a few custom
options before completing the data copy. The user can choose to copy all or a selection, and to copy
the data either to the Windows clipboard or send it directly to Excel. Also, you can choose to copy or
send the transpose. In addition, the user can choose whether to use the normal column headings or
variable names (see the list of fields in Data Argument List for Auxiliary Files) as column identifiers.
Lastly, the user can specify whether or not to include a row containing the type of object the data
represents (Object Name) and a row containing the column headers for each column of data. Note
that for pasting the information back into Simulator, the Object Name and Column Heading rows
must be contained with the data to be pasted. If you have changed the settings on this dialog and
wish to make them the case default settings, click on the Make Default for all Copy Actions button.
Send All to Excel (or to Open Office Calc)
The Send All to Excel menu option copies the entire record set contained in the case information
display and automatically sends it to Excel. The first time this option is selected, Simulator will start
a new instance of Excel on your machine and paste the data on the first sheet. Subsequent calls to
Send to Excel will continue to add sheets and paste data to this instance of Excel, until the Excel
instance is closed manually by the user. This functionality works identically for the Open Office Calc
spreadsheet as well.
Send Selection to Excel (or to Open Office Calc)
The Send Selection to Excel menu option copies the selected record set in the case information
display and automatically sends it to Excel. The first time this option is selected, Simulator will start
a new instance of Excel on your machine and paste the data on the first sheet. Subsequent calls to
Send to Excel will continue to add sheets and paste data to this instance of Excel, until the Excel
instance is closed manually by the user.This functionality works identically for the Open Office Calc
spreadsheet as well.
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Case Information Toolbar: Filtering Menu
The Filtering Menu, contained on the Case Information Toolbar, gives access to several options
regarding any Advanced Filters that can be applied to the active case information display. In addition it
provides access to the Area/Zone/Owner Filters. The drop-down menu is shown in the following figure.

The top of the menu has four primary buttons that appear on all case information displays. These four
are as follows
Advanced Filter
Allows the user to custom filter the information in the display based on desired criteria. See
Advanced Filtering for more information.
Use Area/Zone/Owner Filters
Filters displayed records by selections made on the Area/Zone/Owner Filters display.
Area/Zone/Owner Filters
Opens the Area/Zone/Owner Filters display for setting the areas, zones or owners for which
the filter should apply.
Remove Filter
Click this button to remove the Advanced Filter from the present case information display.
This does not delete the Advanced Filter definition, but only removes the reference to it from
the active case information display. The filter can easily to reapplied after removing it. If you
would like to permanently delete an Advanced Filter see Advanced Filtering.
After the top section of the menu are two sections that may or may not be available for a particular
case information display
(List of Filters)
This contains a list of advanced filters for the object type displayed in the active case information
display. These filters would have already been created using either the Advanced Filtering dialog or
by reading them from an Auxiliary File. In the example image above the "50" and "50MW+" entries
represent filters that apply to a generator object. If there are more than 10 advanced filters for the
present object type, then a submenu will be shown for the object type as well. Also if an advanced
filter is presently applied to the case information display, then the active advanced filtered will be
denoted with a check mark.
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(List of Filters for Related Objects)
This contains a list of advanced filters whose object type is related to the type of record displayed in
the active case information display. For example, the case information display shown in the figure
above is showing generator records. Generator records allow you to filter the generator object using
a Bus, Substation, Area, Zone, or Branch Filter. In the example above there are 5 filters defined for
Bus objects (100kV+, 69, exw, jamie, and Loads) which can be used to filter the generator records.
For more information on Related Object Filtering, see the Advanced Filtering dialog. Also if an
advanced filter is presently applied to the case information display, then the active advanced filtered
will be denoted with a check mark and the object type of that filter will be denoted with a grayed
out check mark.
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Case Information Toolbar: Geo Data View Menu
The Geo Menu, found on the Case Information Toolbar, contains options related to opening the
Geographic Data View Displays based on the objects selected in the case information display. For more
information see the help on Geographic Data Views.
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Case Information Toolbar: Load Auxiliary Files Menu
The Case Information Toolbar Load Auxiliary Menu displays the identical options as shown in the Load
menu of the case information display local menu. This is depicted in the figure below. The options are
described below the figure.

This option will load the contents of an external file to the case information display.
Auxiliary File (Any Data)
This option allows loading an auxiliary file containing any data.
Auxiliary File (Only Specific Data)
This option allows loading an auxiliary file containing only data related to the current case
information display.
At the end of the menu, some case information displays show more specific formats that are relevant
only for that type of record. For instance in the figure above you can see support for loading in older
file formats previously supported.
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Case Information Toolbar: Save Auxiliary Files Menu
The Case Information Toolbar Save Auxiliary Menu displays the identical options as shown in the Save
As menu of the case information display local menu. This is depicted in the figure below. The options
are described below the figure.

This option will save the contents of the case information display to an external file.
Auxiliary File
This option allows saving all the contents of the case information display to an auxiliary file.
Auxiliary File (only selected records)
This option allows saving the selected record set in the case information display to an auxiliary
file.
Auxiliary File (only selected records/columns)
This option allows saving the selected record set and the selected columns in the case
information display to an auxiliary file.
CSV (Comma Delimited)
This option allows saving all the contents of the case information display to a comma delimited
file.
CSV (only selected records/columns)
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This option allows saving the selected record set and the selected columns in the case
information display to a comma delimited file.
HTML
You can save the entire table or selected records to an HTML file for viewing from an Internet
browser. For more information, see Saving Case Information Display Contents as HTML Tables.
Bitmap
This option allows saving the case information display into a Bitmap picture file.
JPeg
This option allows saving the case information display into a JPEG picture file.
At the end of the menu, some case information displays show more specific formats that are relevant
only for that type of record. For instance in the figure above you can see a specific Auxiliary File
format options which automatically saves all the data related to the cost information of the generator.
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Case Information Toolbar: Records Menu
The Case Information Toolbar Records Menu displays a combination of the Insert/Delete buttons and
the Records and Plot menus on the case information display local menu. This is depicted in the figure
below. The options are described below the figure.

Insert and Delete
Many records have an Insert and Delete related buttons. These are used for inserting new records
and deleting records. Note that some records can only be inserted or deleted in Edit Mode. In such
cases the Insert and Delete button will be grayed out when not in Edit Mode.Use the Bus View
Oneline local menu option
Records Menu
Quick Power Flow List
Use the Quick Power Flow List local menu option to invoke Simulator’s Quick Power Flow List
tool.
Bus View Oneline
Use the Bus View Oneline local menu option to bring up the Bus View Display, which
illustrates how the selected bus is connected to the rest of the system.
Substation View Oneline
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Use the Bus View Oneline local menu option to bring up the Substation View Display, which
illustrates how the selected substation is connected to the rest of the system.
Define Expression
Allows you to define Custom Expressions that are functions of other fields.
Pan to Object on Open Onelines
Selecting this option will move the view on any open oneline diagrams to focus on the device
clicked in the table, if an object representing the device exists on the diagram.
Record-Specific Actions
At the end of the Record Drop-Down will be a list of options that are special for the particular
kind of record shown in the active case information display. For example, in the image above
for a generator case information display the option "Create Injection Group From Selection..."
allows you to create a new injection group containing all of the presently selected generator
records.
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Case Information Toolbar: Set, Toggle, and Columns Menus
The Case Information Toolbar Set and Columns Menus display the identical options as shown in the
Set/Toggle/Columns menu of the case information display local menu. This is depicted in the figure
below. The options are described below the figure.

Toggle
This option will be available for fields that are toggleable. The number and type of options available
will change depending on the type of field being toggled. Some fields simply allow toggling between
two YES/NO, TRUE/FALSE, or CLOSED/OPEN entries, while others allow a much larger list of
choices. The toggle entries on the toolbar menus are used to toggle the field for all records.
Set All Values To
Click on this menu item to bring up a dialog which allows you to set all the values in a column to the
same value. For instance you might change all the buses to have an angle of zero degrees.
A special trick that can be used in conjunction with this option is entering a string of the form
"@variablename". When entering data into a field, if the string begins with the symbol @, then
Simulator will parse the remaining part of the string to see if it matches one of the variable names
associated with that type of object. Variable name strings are what are used in the Auxiliary File
Format (see the list of fields in Data Argument List for Auxiliary Files). Essentially this trick allows
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you to copy one column to another column. Using this trick, you could change the set-point voltage
of all the generators in the case to be equal to the terminal bus voltage of the generator.
Set All Values To Field
Click on this menu item to bring up a dialog which allows you to select a field of this record type and
then set all the values in a column to the this field. For instance you might change all the generator
setpoint voltage to be equal to their present regulated bus voltage. This represents a user-interface
method of employing the special trick using the "@variablename" string as discussed in the Set All
Value To comments above.
Select Column(s)
Use this option to quickly select entire columns in the grid. First highlight the cells of a single record
for the columns you wish to highlight, and then choose this option to highlight the entire column.
Select Row(s)
Use this option to quickly select entire columns in the grid. First highlight the cells of a single record
for the columns you wish to highlight, and then choose this option to highlight the entire column.
Get Column Metrics
This option allows you to compute the metrics for the selected column. Choosing Get Column Metrics
from the local menu will bring the Grid Metrics Dialog. This option is only available for columns
whose content is numeric.
Contour Column
Use the Contour Column local menu option to contour a column of the list display. Choosing Contour
Column from the local menu will open the Contour Column Dialog.
Plot Column(s)
Select this option to plot the values in any selected columns.
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Case Information Filterbar
On the Model Explorer, directly above the case information display is the Case Information Filterbar.
Although the Filterbar is not shown by default on other case information displays not embedded in the
Model Explorer, the Filterbar can be shown by right-clicking on the Case Information Toolbar and
choosing Filterbar>Top or Filterbar>Bottom. The Filterbar is shown in the following image.

For some object types it is possible to filter based on data for a related object class instead of for the
actual object class. For example, an Advanced Filter for a Bus may exist to only show buses with a
Nominal Voltage larger than 138 kV. You may then want to use this filter on a case information display
which shows generators. For object types which support this feature, the Filter By Dropdown and
the Filter Type Dropdown will be available. For objects which do not support this, these dropdowns
will not be visible.
Filter By Dropdown
This value will be either Advanced or Device. For more information about this setting see the
Advanced Filtering Dialog help.
Filter Type Dropdown
This dropdown allows you to specify which class to base the filter on. For more information about
this setting see the Advanced Filtering Dialog help.
List of Filters or Devices Dropdown
When the Filter By Dropdown is set to Advanced, this dropdown will contain a list of all the
presently defined advanced filters for the object type specified in the Filter Type Dropdown.
When the Filter By Dropdown is set to Device, this dropdown will contain a list of all objects of
the object type specified in the Filter Type Dropdown.
When clicking on this dropdown the appropriate list will be shown and by choosing an entry from
this dropdown the respective advanced or device filter is applied to the case information display.
Also, if the dropdown contains more than 1,000 entries in it, clicking on this dropdown will instead
have the same effect as clicking on the Find... Button.
Find... Button
Click on this button to open the Advanced Filtering Dialog for the case information display.
Remove Button
Click this button to remove the Advanced Filter or Quick Filter from the present case information
display. This does not delete an advanced filter definition, but only removes the reference to it from
the active case information display. The filter can easily to reapplied after removing it. If you would
like to permanently delete an Advanced Filter see Advanced Filtering.
Quick Filter
Click this button to set a Quick Filter using the column in which the cursor is currently set in the
display.
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Area/Zone/Owner Filters
The Area/Zone/Owner Filters Dialog allows you to filter the information shown on the case information
displays and other dialogs by area, zone or owner. There are a several ways to open the
Area/Zone/Owner Filters Dialog.





Go to the Case Information ribbon tab, and choose
Area/Zone Filters from the Case
Information ribbon group
Click on the button
on the Case Information Toolbar
There are also many buttons on user interface dialogs throughout the program that invoke this
dialog as well.

For small cases, you will usually not need to use this filtering capability, but it can be very useful for
large cases. The filters display lists each area, zone and owner in the case, the number of buses in
each, the range of bus numbers contained in each, and whether or not information about that area,
zone or owner should be displayed. In order for a device to be displayed, its area, zone and owner
Shown property must be set to yes. For devices which can belong to more than one area, zone, or
owner (for instance a transmission line that connects two areas, i.e. a tie line), then the device will be
displayed if any end of the device meets the area/zone/owner filter.
You can switch between displaying the filters for the case areas, zones or owners by clicking on the
associated tab.
The area/zone/owners filters list is itself a case information display and therefore shares many of the
same local menu options and characteristics. Using the local menu, you can search for an area, zone
or owner by number or by name, copy records to and from other applications, and send the records to
a printer. You can inspect an area, zone or owner by selecting Show Dialog from the local menu,
which invokes the Area Information , Zone Information or Owner Information Dialogs. You can also
change the format and content of the filters display by selecting the Display Column/Options item from
the local menu. The records can be sorted by any of its component fields simply by clicking the
corresponding column’s heading.
The display’s only enterable field is the one entitled Shown, which may assume only the values Yes
and No. For example, if the Area/Zone/Owner Filters setting for an area is No, then any case
information display configured to enforce area/zone/owner filters will omit the area’s elements from
the resulting record set. You can specify whether a particular case information display enforces filters
using the display’s Display/Column Options Dialog.
Double-click on a cell in the Shown field to toggle its value. Use the cell handle to propagate a
particular value to multiple areas, zones or owners, or use the Toggle All Yes or Toggle All No local
menu options to set the values of all area, zone or owner records.
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Advanced Filtering
Filtering by areas, zones and owners using Area/Zone/Owner Filtering is a quick and simple way to
filter, however Simulator also contains the ability to perform custom filtering on case information
displays as well. Advanced Filtering is accessed by clicking on the Case Information Toolbar Filtering
Menu and choosing Advanced Filter or right-clicking on a Case Information Display and choosing
Advanced Filter from the local menu. This brings up the Advanced Filters Dialog, which allows you to
custom filter the information in the display. Advanced Filters require a filter name, and are stored with
your power system case.
Note that you can also use the Quick Filter option on a case information display to set conditions for a
filter just as you would for an advanced filter, without requiring a filter name. Quick filter conditions
are not saved with the load flow case.
A Case Information Display will have the phrase "Filter: Name of Filter" in its caption if an Advanced
Filter has been applied to it. To remove a filter from a Case Information Display, choose Remove Filter
from the Case Information Toolbar Filtering Menu or bring up the Advanced Filters Dialog and click on
Remove. Note that Remove does NOT delete the filter, but just stops using it to filter the data. You
can always remove the filter temporarily and then come back and reapply the filter. If you want to
Delete a filter, you must bring it up in the Advanced Filters Dialog and click on Delete.
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Advanced Filters Dialog
The first thing to choose on the Advanced Filter dialog is what to Filter By and the Filter Type.

Filter By
Filter By can be set to either Advanced or Device.
Advanced Filtering allows you to define a set of logical comparisons for the various fields which
must be met. For example you may want to only see Buses that meet the conditions "Nominal
Voltage > 100 kV" AND "MW Load > 100 MW". For more help on Advanced Filtering see the topic
Advanced Filtering: Advanced.
Device Filtering allows you to directly use one of the power system model objects as a filter. The
relationship between the object type being listed and the object type of the device filter determines
how filtering is done. For example, if you use an Injection Group as a device filter to filter a list of
Generators, then you will get only the generators which are inside the Injection Group. As another
example, if you are using an Injection Group as a device filter to filter a list of Branches, then you
will get only branches that are connected to the terminal bus of any generator, load, or switched
shunt contained in the injection group. Device filtering can be used instead of more complicated
Advanced Filters. For more help on Device Filtering see the topic Advanced Filter: Device.
Select Filter Type
When defining an Advanced Filter, normally this type is the same as the object type for which your
are defining a filter. When defining a Device Filter, normally this type will be different.
By changing the drop-down next to Select Filter Type, it is possible to filter based on data for a
related object instead of for the actual object. For example, an Advanced Filter for a Bus may exist
to only show buses with a Nominal Voltage larger than 138 kV. You may then want to use this filter
on a case information display which shows generators. This is possible by changing the Filter Type
to be a Bus when showing the Filter Dialog on the Generator case information display. Just click the
drop-down to see which related objects' filters can be used for that particular situation.
View Filter Logic
Select View Filter Logic to show a graphical display to visualize the logic diagram for an Advanced
Filter.
Note Regarding Auxiliary Files: Throughout auxiliary script commands, the ability to specify an
advanced filter by name is available. In this context, if the use of an Advanced Bus filter is desired in a
place where an Advanced Generator filter is needed, then use the string "<BUS> filtername" to
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represent the filter. If the use of a device filter is desired, then use the string "<DEVICE> objecttype
'key1' 'key2' 'key3'" to represent the device filter.
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Advanced Filters View Filter Logic Graphical Display
The Advanced Filter Logic Display feature provides a graphical display which allows you to quickly
browse information about an Advanced Filter and the corresponding conditions The advanced filter
logic displays enable convenient Advanced Filter-by-Advanced Filter navigation through the complete
list of model filters. From the advanced filter logic display, you can find out an advanced filter name
and Logical Comparison object, and conditions names that are part of the particular advanced filter.
Moreover you can find out all information associated with the advanced filter by pressing right click
with the mouse and directly invoking their associated information dialogs. The advantage of the
advanced filter logic displays, is that they are auto-created logic diagrams.
Below this top panel sits the actual advanced filter display. The advanced filter you have chosen to
inspect, is represented as the last advanced filter to the right of the display. When you drag the mouse
over one of the neighboring advanced filters symbols, it turns into a pointing finger, then by clicking
the left mouse button when the mouse cursor is in this shape redefines the target advanced filter to be
the advanced filter whose symbol you just clicked. The advanced filter view display is redrawn to show
the same sort of display for the newly chosen target. Right-clicking on the advanced filter view
display’s background will generate the local menu.
The advanced filter background color can be red or green. Green means that the criteria is satisfied
and the evaluation of the model filter is true. Red means that the evaluations is false. Repeated colors
of the Advanced Filter Names and Conditions represent that the particular Advanced Filter or Condition
is used more than once in the Advanced Filter Display.
The advanced filter view display can be generated using the following method:


Pressing the "View Filter Logic" button in the Advanced Filter Dialog Dialog.
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Advanced Filtering: Advanced
The Advanced Filters Dialog Filter set to Advanced is shown in the following figure.

When you open this dialog, you will only see filters that have been defined for the type of object you
are trying to filter (e.g. Bus, Generator, Interface, etc…). You can choose a filter from the Filter Name
drop-down box showing the list of filters available, or you can create a new filter. To make a new
filter, simply click on Save As to save a copy of the present filter under a new name and then specify
the properties of the filter as discussed below. When you have specified the filter as you wish, click
Filter.
Note that advanced filters are stored with the case file when the case is saved. In addition, the filters
can be exported to a Simulator Auxiliary File for storage and import into other cases. A list of all
advanced filters defined for a case can be viewed in the Advanced Filters case information display.
To create an Advanced Filter you must specify the following things:
Filter Name
A string that describes your filter so that you can call it up from other forms in the future.
Condition 1, Condition2, etc…
Describes the conditions of your filter. To define a condition






Specify the field you are filtering. By default, the fields in the drop-down list are limited to the
fields presently shown as columns in the display. If you wish to choose from a list of all fields for
the object, change the radio button setting to Show All Fields. It is very useful to use the Find…
button to more easily search for the field you are interested in.
Specify the comparison operation such as "between" or "greater than".
Specify the values the field is compared to. Depending on the comparison operation, either one or
two values are needed.
Select ABS to use the absolute value of the field value in the comparison operation. For Fields that
are strings, select Case Sens. to make the comparison case sensitive.
158

©2011 PowerWorld Corporation

Note: The comparison operation "within integer range list" uses the same format as described in
Entering a Range of Numbers.
Note: To add or delete conditions click on the Add>> or Delete… button. You can also delete an
individual condition by clicking on the X button next to the condition.
Note: There is no limit to the number of comparisons you use for the Advanced Filter.
Logical Comparison
The following describes how the Filter uses the Conditions which are specified





AND means that all conditions should be true
Not AND is the opposite of AND (i.e. any one of the conditions can be false)
OR means that any one of the conditions can be true
Not OR is the opposite of OR (i.e. all of the conditions must be false)

For advanced logical comparisons within the same filter, refer to the important note below.
Pre-Filter using Area/Zone Filters
When this box is checked, data is filtered first by the Area/Zone/Owner Filters and then by the
Advanced Filter, therefore the data must meet both the Area/Zone/Owner Filters and the Advanced
Filters in order to be shown. When this box is unchecked, the Area/Zone/Owner Filters are ignored.
Enable Field to Field Comparisons
When this box is checked, it is possible to compare two fields of the device. In order to do so, select
Field and click on Find to select the second field to be compared. The following depicts what a
particular condition looks like when the enable Field to Field comparisons checkbox is checked.

Important Note: Once you choose a condition comparison type, that type is used for all conditions in
the filter. Therefore if you wish to use the AND condition, all conditions you define will be applied
using AND. There is a way to combine different conditions within the same filter. This is accomplished
by allowing nested filters. In other words, one condition of a filter can be that another filter is met. To
refer to one filter from within another, check the box Use Another Filter. Then choose whether the
condition is to meet the filter or Not meet the filter, then choose the filter (which must have been
previously defined) from the drop down list of the third box, or by clicking the Find button. This allows
you to define some conditions using one logical comparison in one filter, and then use that filter to
combine those conditions with other conditions using a different logical comparison.
For example, consider the logical comparison of A and (B or C). To replicate this, you would define
one advanced filter (AF1) that contains the logic B or C. Then you can define an advanced filter (AF2)
that uses AF1 as A and (AF1).
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Advanced Filtering: Device
The Advanced Filters Dialog Filter by set to Device is shown in tshe following figure

Device Filtering allows you to directly use one of the power system model objects as a filter. The
relationship between the object type being listed and the object type of the device filter determines
how filtering is done. For example, the image below shows the use an Injection Group as a device
filter to filter a list of Generators. The result of using this filter will be only the generators which are
inside the Injection Group.
As another example, if you are using an Injection Group as a device filter to filter a list of Branches,
then you will get only branches that are connected to the terminal bus of any generator, load, or
switched shunt contained in the injection group. Device filtering can be used instead of more
complicated Advanced Filters.
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Advanced Filters Display
The Advanced Filters Display is a Case Information Display available under the folder Case Information
and Auxiliary on the Model Explorer. The purpose of this display is to list any advanced filters you have
defined for the current case. Each record will list the name of the filter, the type of object the filter is
for, filter logic, and whether or not a pre-filter was used.
Normally you will create advanced filters directly on a case information display that is showing a
particular object type. However you can also choose Insert from the Case Information Toolbar
Records Menu to create an advanced filter. You will then be prompted to choose the object type on a
dialog before proceeding to the Advanced Filters Dialog.
Normally you will delete advanced filters from the Advanced Filters Dialog, however you can also
choose Delete from the Case Information Toolbar Records Menu to delete an advanced filter. This will
then remove the filter from any case info displays, dynamic formatting definitions, select by criteria
definitions, or any other locations that are presently using this advanced filter.
The most common use of this display is to using the Case Information Toolbar: Load Auxiliary Files
Menu Save As option to save a list of advanced filters to an auxiliary file. feature makes it easy to
transfer defined Advanced Filters from one case to another.
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Custom Expressions
Simulator allows you to define Custom Expressions that are functions of other fields. These Custom
Expressions can then be shown as a column in a Case Information Display. To define custom
expressions, right-click in a Case Information Display table and choose Records > Define
Expression from the local menu or choose Records > Define Expression from the case
information toolbar. This brings up the Define Custom Expressions Dialog. When you bring up the
dialog you will only see expressions that have been defined for the type of object shown on the Case
Information Display (e.g. Bus, Generator, Interface, etc…).
To define a new custom Expression click New.
You can name the expression for easy identification in the list of fields for the object by filling in the
Expression Name field.
To define the Custom Expression, first specify which fields you would like to use in the expression and
assign them to the variables x1, x2, …, x8. Fields can be chosen that apply to the type of object for
which the expression is being defined or a Model Expression can be chosen. Model Expressions allow
using either an expression that applies to model fields or simply a single model field. After fields or
Model Expressions have been assigned to variables, type in the expression as a function of the
variables x1, x2, …, x8. For example
x1 * SIN(x2) + EXP(-x5)
or
TAN(x1) + ABS(x6)*8 - 100
For a complete list of functions and operators that are available to you, see Functions and Operators
Available.
Once the Custom Expression has been defined, you may add the expression to the column of the Case
Information Display from which is was called by clicking on Add Column… For more information on
how to add columns to a display see Configuring the Case Information Displays.
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Custom Expressions Display
To open the Custom Expressions Display, select Case Information and Auxiliary > Custom
Expressions in the Model Explorer. If you have defined any custom expressions for your case, you
can see the list of those expressions in this display. The type of object to which the expression applies,
the name of the expression, and the custom expression itself are given. The display also shows the
values being represented by each of the variables in the custom expression.
Custom expressions cannot be inserted manually in this display, but they can be loaded from an
auxiliary file by right-clicking on the grid and selecting Load > Auxiliary File (any data)… from the
local menu. Conversely, you can save a list of custom expressions in a case to an auxiliary file by rightclicking on the grid and choosing Save As > Auxiliary file.
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Custom String Expressions
Simulator allows you to define Custom String Expressions to generate a string from other fields. These
Custom String Expressions can then be shown as a column in a Case Information Display. To define
custom string expressions, right-click in a Case Information Display table and choose Records >
Define String Expression from the local menu. This brings up the Define Custom String Expressions
Dialog. When you bring up the dialog you will only see expressions that have been defined for the type
of object shown on the Case Information Display (e.g. Bus, Generator, Interface, etc…).
To define a new custom Expression click New.
You can name the expression for easy identification in the list of fields for the object by filling in the
Expression Name field.
To define the Custom Expression, first specify which fields you would like to use in the expression and
assign them to the variables x1, x2, …, x8. Fields can be chosen that apply to the type of object for
which the expression is being defined or a Model Expression can be chosen. Model Expressions allow
using either an expression that applies to model fields or simply a single model field.
The custom string expression is then defined in terms of the variables x1, x2, ..., x8. Different
elements of the expression are concatenated with a + symbol. A number of different types of
elements can be combined.




Static strings can be specified inside of quotation marks
Variables containing string data (such as Bus Name) may be added directly
Variables containing numeric data may be formatted using the function Str( variable, minlength,
decimals). The variable parameter is the value to be formatted, the minlength parameter is the
minimum number of characters for the result, and the decimals parameter specifies the number of
characters to the right of the decimal point. If the decimals parameter is specified as a negative
number, then all trailing zeros beyond the decimal are truncated.

For example
"This custom string expression displays the bus name (" + x1 + ") and per unit voltage (" + Str(x2, 3,
2) + ")"
For a complete list of functions and operators that are available to you for numeric expressions, see
Functions and Operators Available.
Once the Custom String Expression has been defined, you may add it to the column of the Case
Information Display from which is was called by clicking on Add Column… For more information on
how to add columns to a display see Configuring the Case Information Displays.
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Functions and Operators Available
Below is a list of functions and operators that are available for use in Defining Custom Expressions:
Symbol

Equivalent

Description

Example

Prioritizes an
expression

5*(1+1) = 10

Factorial

5! = 120fact(5) =
120

Percentage

35% = 0.35

Raised to the
power of

4 ^ 5 = 1024

*

Multiply by

3 * 6 = 18

/

Divide by

9 / 2 = 4.5

Integer divide
by

9\2=4

MOD

Modulo
(remainder)

7 mod 4 = 3

+

Add

1+1=2

-

Subtract

9-5=4

>

Greater than

9 > 2 = 1 * see
note

<

Less than

7<4=0

()
!

FACT

%
^

\

**

DIV

==

=

Equal test

5 == 4 = 0

>=

=>

Greater or
equal

3 >= 3 = 1

<=

=<

Less or equal

#h3E <= 9 = 0

<>

Not equal

#b10101 <> 20
=1

NOT

Bitwise NOT

NOT(15) = -16

AND

&

Bitwise AND

#b101 AND
#h1E=4

OR

|

Bitwise OR

13 OR 6 = 15

XOR

Bitwise
Exclusive OR

9 XOR 3 = 10

EQV

Bitwise
Equivalence

6 EQV 9 = -16

IMP

Bitwise
Implication

1 IMP 5 = -1

IIF

If condition

IIf(1+1=2,4,5) =
4

MIN

Minimum
value

min(10,3,27,15) =
3
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MAX

Maximum
value

max(1,9)=9 *see
note

SIN

Sine

sin(pi) = 0 *see
note

COS

Cosine

cos(pi) = -1

TAN

Tangent

tan(pi) = 0

ASIN

Arc sine

asin(1) = 1.570

ACOS

Arc cosine

acos(-1) = 3.141

Arc tangent

atan(0) = 0

SEC

Secant

sec(0) = 1

CSC

Cosecant

csc(1) = 1.18

COT

Cotangent

cot(1) = 0.642

SINH

Hyperbolic
sine

sinh(3) = 10.01

COSH

Hyperbolic
cosine

cosh(2) = 3.76

TANH

Hyperbolic
tangent

tanh(1) = 0.76

COTH

Hyperbolic
cotangent

coth(1) = 1.31

SECH

Hyperbolic
secant

sech(0) = 1

CSCH

Hyperbolic
cosecant

csch(1) = 0.85

ASINH

Hyperbolic arc
sine

asinh(2) = 1.44

ACOSH

Hyperbolic arc
cosine

acosh(9) = 2.89

ATANH

Hyperbolic arc
tangent

atanh(.1) = 0.10

ACOTH

Hyperbolic arc
cotangent

acoth(7) = 0.14

ASECH

Hyperbolic arc
secant

asech(.3) = 1.87

ACSCH

Hyperbolic arc
cosecant

acsch(2) = 0.48

ABS

Absolute value

abs(-8) = 8

EXP

e to the power
of

exp(3) = 20.08

EXP2

2 to the power
of

exp2(3) = 8

EXP10

10 to the
power of

exp10(3) = 1000

Natural log

log(16) = 2.77

ATAN

LOG

ATN

LN
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LOG2

Log base 2

log2(8) = 3

LOG10

Log base 10

log10(100) = 2

CEIL

Round up

ceil(6.2) = 7

RND

Random
number

rnd(1) = .969

INT

Truncate to an
integer

int(6.8) = 6

SGN

SIGN

Sign of
expression (-1,
0, or 1)

sgn(-9) = -1

SQR

SQRT

Square root

sqr(64) = 8
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Model Expressions
Model Expressions can be accessed and created by choosing Case Information and Auxiliary
> Custom Model Expressions in the Model Explorer. To open the Define Model Custom Expressions
dialog, right-click and choose Insert, when creating a new expression, or Show Dialog to view an
existing expression.
The Save, Save As, Rename, and Delete buttons and the drop-down list of expressions at the top
of the dialog allow for the additional of new expressions, modification of existing expressions, and
removal of existing expressions. There are two types of Model Expressions: an expression and a
lookup table.
Lookup Tables
The dialog as configured when creating a lookup table appears as follows:

A lookup table may be either one or two-dimensional by specifying the Lookup Type. The Number
of Points must be set for each dimension. This will determine the size of the table. A Model Field
must also be selected for each dimension. Clicking the Define button next to either the x1 or x2
field opens the Model Field Dialog. This dialog allows the selection of an Element Type and a
specific element of this type. The list of elements behaves the same as the Find Dialogs found
throughout Simulator. After selecting the element, choose the field associated with this element that
will be used in the Lookup Table. Click OK to accept the element and field selected and close the
dialog.
Fill in the Lookup Table with the desired values. If selecting a one-dimensional table, there will be
two columns, one containing the values for the x1 Model Field and the other containing the Values
to return from the Lookup Table when the Model Field is at the defined value. There will be one
header row plus as many additional rows as defined in the Number of x1 Points. If selecting a
two-dimensional table, there will be one column for the x1 Model Field and as many other columns
as selected for the Number of x2 Points. There will be one header row for defining the x2 values
plus as many additional rows as defined in the Number of x1 Points. The cells under the first row
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and to the right of the first column are used for defining the Values to return from the Lookup Table
when the Model Fields meet the defined values.
If selecting a one-dimensional table, the returned Value is determined based on the current value of
the x1 Model Field. The returned value is the Value corresponding with the x1 value that is less
than or equal to the current value of the Model Field. If the current value of the Model Field is less
than the smallest value of x1 in the table, then the Value returned corresponds to the smallest x1
value. If selecting a two-dimensional table, the same rules apply except that the Value returned
corresponds to the current value of the x1 AND x2 Model Fields and where these intersect in the
table.
Expressions
The dialog as configured when creating an expression appears below:

To define the Model Expression as an expression, specify the Model Fields that the expression should
be a function of by clicking the Define button next to the appropriate variable. Clicking the Define
button opens the Model Field Dialog. This dialog allows the selection of an Element Type and a
specific element of this type. The list of elements of a particular type can be searched, filtered, and
sorted to make finding an element easier. After selecting the element, choose the field associated
with this element that will be used in the expression. Click OK to accept the element and field
selected and close the dialog. After the Model Fields have been defined, enter the function
description. See Custom Expressions for more information about defining expressions.
After model expressions have been defined, new options will appear on the Contingency Element
Dialog and on the Advanced Filter Dialog.
Normally, you may only enter a constant for the comparison value on the Advanced Filter Dialog.
However, if you select Enable Field to Field Comparisons, the advanced filter dialog will feature a
drop-down from which you can choose Expression. After choosing Expression, you may select the
name of the model expression, or click the Find button to search for the name.
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Similarly, normally you may only enter a Constant or a Field for the Move, Set To, or Change By
Action Types on the Contingency Element Dialog. However, now you will have the option to choose
Model Expression. To change the type of the Amount, choose Model Expression from the second
drop-down box. After doing this, enter or choose the name of the model expression in the first
Amount drop-down box, or click on the Find… button to search for a name.
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Once a Model Expression has been saved, it may be referenced directly in a Case Information Display
or AUX file using special notation.
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Find Dialog Basics
Many times when working with large load flow cases, it can be somewhat difficult to locate devices in
the case information displays regarding a specific device. Simulator has many tools to facilitate filtering
data, such as the Area/Zone/Owner filters and the Advanced Filtering tool. Even with these helpful
tools, finding a device can still be hampered when the bus number or exact spelling of the bus name
are not known.
To facilitate locating devices in Simulator, you can use the Find tool to use Simulator’s advanced
search engine for finding the device(s) you are looking for. The Find tool is available from the popup
menus of almost all case information displays, as well as several of the various information dialogs in
Simulator. Anywhere you see a button or menu option labeled Find… you can open the advanced
search tool.
Once the Find dialog has been opened, the dialog will automatically adjust to suit the type of device
you are searching for. The caption of the dialog should reflect the type of object the dialog is currently
attuned to locate. For most devices, such as buses, generators, loads, etc., there will be one list
displayed at the bottom of the dialog containing numbers and names of the type of device you are
searching for. In some instances, mostly when searching for branch-type devices, the bottom panel is
split with a second list is displayed in the right side panel. This list is used to display the possible
connections of the bus selected in the first list. For example, if bus number one is selected and it has
connections to bus two and bus three, the second list will display the information for bus two and bus
three. Thus you can search for a bus in the first list, then choose from the possible connections in the
second list to get a specific branch from the list.
Despite what type of device you are trying to find, the first few options and buttons on the dialog will
be the same. Sort by Name and Sort by Number allow you to choose how you wish to find a
device in the list. If you know the bus number you are looking for, choose Sort by Number. If you
know the name, or at least part of the name, that you are looking for, then choose Sort by Name.
The list (or first list for branches) will be sorted accordingly.
If you wish to narrow down the list of devices to search through, you have a couple of options for
filtering the list before searching through it. First you can make use of the traditional Area/Zone/Owner
filters by clicking in the associated check box. If you need to set more specific conditions for filtering
the list, you can instead click the Define Filter button to set up an advanced filter. Either one will
reduce the number of devices in the list for the search.
Once you have the list set up for your search, you can type in the number or name you wish to find in
the text box. If you do not know the exact number or name, you can use wildcards to facilitate the
search and find all possible matches for a set of characters or numbers. You can use a question mark
(?) to represent a single character wildcard, or an asterisk (*) to represent a multiple character
wildcard.
For example, if you want to find bus number 10005, but all you know is the first four digits are 1000,
you can type in *1000*, and Simulator will search until it finds the first number that contains those
four digits. You can then use the Search Next button (note that pressing Enter is the same as
clicking Search Next) to find the next number containing the four numbers, and so on. The same
goes for searching by name. If you are looking for bus ACEONE, but all you know is the name contains
the string ACE, then you can type in *ACE* and then keep pressing Enter until you find the bus
named ACEONE. By using the beginning and ending *, we would also find elements such as NEWACE,
because the double * looks for strings that contain ACE anywhere in the string. Note that if you know
the first few letters (or numbers), you can narrow down the number of elements found from the
search by eliminating the first * from the search string. For example, to find bus ACEONE, we could
have instead used ACE*, and this would have gone through all matches that started with ACE, ignoring
other elements such as NEWACE. You can also use wildcards in the middle of a string, such as AC*NE,
and Simulator will find any name that starts with AC and ends with NE.
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Once you have entered a wildcard search, you can also click the Search All button. This will
essentially bring up the same Find dialog again, but with the choices narrowed to those that meet your
wildcard search.
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Search for Text Dialog
This dialog allows you to search for specific text in a case information display. Specify the text you
want to search in Search for edit box. Clicking on Search Next will take you to the next field whose
content matches with the text specified. The search can be made By Rows, in which the text is
searched first in all the fields of a record, before searching in the next record. If the search is made By
Columns then the text is searched first in all the fields of a column, before searching the text in the
next column. If the option Match case is checked, the search for text will be case-sensitive. The
option Find entire cells only will take you only to fields whose entire content matches completely
with the text you are searching for.
When checking the box Search Ignore Filters, Simulator will look through all the records of the type
on your present case information display, but will ignore any Area/Zone/Owner Filtering and any
Advanced Filtering specified with that case information display. If text is found which matches your
wildcard search, but is for a record presently filtered out, then you will be prompted to remove the
filtering so that the record can be displayed.
When checking the box Search All Fields, Simulator will look through every available field which can
be displayed for the type of records presently represented on your case information display. If text is
found which matches your wildcard search, but is for a field that is not presently shown, then you will
be prompted to add the field to the columns that are shown.
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Model Conditions Display and Dialog
Model Conditions are a type of Model Criteria. Model Criteria represent Boolean expressions regarding
the present state of the power system model. They can be used to create a convenient display that
shows whether the power system meets a set of criteria. They can also be used in conjunction with
the definition of a contingency in the Contingency Definition Display to create contingency actions that
are conditional based on the state of the power system. To see a list of Model Conditions, choose
Case Information and Auxiliary > Model Conditions.
A model condition contains two parts: a power system element and an advanced filter. The model
condition will then return true or false depending on the result of applying the advanced filter to the
power system element specified. Model conditions can also be used as part of a Model Filter.
The Model Conditions Display is a type of Case Information display and has the abilities common to
this type of display. To delete a model condition, right-click on the display and choose Delete. To
insert a new model condition, right-click on the display and choose Insert. This brings up the Model
Conditions Dialog that can be used to create, delete, and modify Model Conditions.
Model Conditions Dialog
The Model Conditions Dialog has three sections. The top section provides the ability to Save, Save
As, Rename and Delete model conditions. To choose a different Model Condition, click on the
down arrow next to the Model Condition name.
The middle section provides a location to specify what power system element this Model Condition is
related to. On the left is a list of Element Types that are available. When clicking on one of these
types, the right portion of the dialog will provide you with a list of the elements of this type. This list
is a familiar Find Dialog and provides you the ability to search for the element you are interested in.
The bottom section provides a location to specify an Advanced Filter which you would like to have
applied to the power system element chosen in the middle section. The bottom section of the dialog
behaves identically to the Advanced Filtering Dialog. If an Advanced Filter exists for the type of
element for which you are creating a Model Condition, you can click the Set Filter Same As button
to choose this filter. This will then set the parameters of the Model Condition to be the same as the
Advanced Filter.
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Model Filters Display and Dialog
Model Filters are a type of Model Criteria. Model Criteria represent boolean expressions regarding the
present state of the power system model. They can be used to create a convenient display that shows
whether the power system meets a set of criteria. They can also be used in conjunction with the
definition of a contingency in the Contingency Definition Display to create contingency actions that are
conditional on the state of the power system. To see a list of Model Filters, choose Case Information
and Auxiliary > Model Filters in the Model Explorer.
A model filter contains a list of Model Conditions and/or other Model Filters and a boolean operator to
apply to these conditions. The model filter then returns true or false depending on the result of
applying the boolean operator to the boolean results of the conditions. A NOT operator can be applied
to each condition so that the boolean opposite of the condition result will be used when evaluating the
filter.
The Model Filters Display is a type of Case Information display and has the abilities common to this
type of display. To delete a model filter, right-click on the display and choose Delete. To insert a new
model filter, right-click on the display and choose Insert. This brings up the Model Filters Dialog that
can be used to create, delete, and modify Model Filters.
Model Filters Dialog
The Model Filters dialog behaves in a manner very similar to the Advanced Filtering Dialog. To
choose conditions for the model filter, click the down arrows next to the conditions list. The list will
either contain Model Conditions or Model Filters depending on the option to display either
Condition or Filter. You may also click the Find... button to the left of the list. To insert or delete
conditions from the model filter, click the Add>> or Delete... button. When specifying more than
one condition, choose the Logical Comparison that will be used to compare the conditions.
Individually each condition can have a NOT operator applied to it by checking the NOT checkbox
next to the condition. Finally, the top of the dialog provides the ability to Save, Save As, Rename
and Delete model filters. To choose a different Model Filter, use click on the down arrow next to the
Model Filter name.
To modify the model conditions in the case, click the Modify Model Conditions Dialog. This will
open the Model Conditions Dialog.
Select View Filter Logic to show a graphical display to visualize the logic diagram for a Model Filter.
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Model Filters View Filter Logic Graphical Display
The Model Filter Logic Display feature provides a graphical display which allows you to quickly
browse information about a Model Filter and the corresponding Model Conditions. The model filter
logic displays enable convenient Model Filter-by-Model Filter navigation through the complete list of
model filters. From the model filter logic display, you can find out a model filter name and Logical
Comparison object, and model conditions names that are part of the particular model filter. Moreover
you can find out all information associated with the model filter or the model conditions by pressing
right click with the mouse and directly invoking their associated information dialogs. The advantage of
the model filter logic displays, is that they are auto-created logic diagrams.
Along the top of the model filter view display resides a panel of controls. To move the model filter logic
view to a particular model filter, use the up and down arrow to move to the desired the model filter in
the list. . If you are navigating and want to return to a previously open model filter press History to
bring up a menu list of the previously open model filters. The menu will show a list of the last model
filters which have been visited in a model filter view.
Below this top panel sits the actual model filter display. The model filter you have chosen to inspect, is
represented as the last model filter to the right of the display. Notice that from this model filter there
are also a connection to other model filters that are in a column. They represent the model filters in
which the selected model filter is used as a model condition . When you drag the mouse over one of
the neighboring model filters symbols, it turns into a pointing finger, then by clicking the left mouse
button when the mouse cursor is in this shape redefines the target model filter to be the model filter
whose symbol you just clicked. The model filter view display is redrawn to show the same sort of
display for the newly chosen target. Right-clicking on the model filter view display’s background will
generate the local menu.
The model filter background color can be red or green. Green means that the model criteria is satisfied
and the evaluation of the model filter is true. Red means that the evaluation is false. The model filter
objects also can have a circle entering to the model filter. This means that the connecting model filter
or model condition will be negated. For example, if the model condition or filter entering another
model filter model criteria is true it will evaluated as false in the entering model filter. Repeated colors
of the Model Filter Names and Conditions represent that the particular Model Filter or Condition is used
more than once in the Model Filter Display.
The model filter view display can be generated using any of the following methods:




Right click on the model filter of interest on the Model Explorer on the model filter Case
Information of the contingency analysis folder. This will bring the local menu and the display can
be opened by selecting "Insert Filter Logic..."
From the Contingency Analysis Tool Dialog, Go to the Contingency Definitions inside the Options
ribbon. In the model filters definitions case information repeat the previously explained process.
Pressing the "View Filter Logic" button in the Model Filter Display Dialog.
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Entering a Range of Numbers
On a number of displays it is often convenient to enter a group of numbers, including ranges.
Examples include entering buses or areas to scale on the Scaling Display, or buses on the Quick Power
Flow List. The format for this field is to enter individual numbers separated by commas, and/or ranges
with a dash between the beginning of the range and the end of the range.
For example the entry
1-5,21,23-25
corresponds to numbers 1 through 5, 21 and 23 through 25.
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Referencing Model Expressions
A saved Model Expression may be referenced directly in a Case Information Display or AUX file using
special notation. A string of the format "&ModExpName:digits:decimals" will resolve to the result of the
model expression named by ModExpName, with digits specifying the minimum number of digits to
display, and decimals specifying the number of digits to show to the right of the decimal.
Note that the link to the Model Expression is not maintained after the initial entry. If the Model
Expression is modified, or any of the relevant values change, the value in the Case Information Display
will not update unless the reference is re-entered manually or the AUX file is re-loaded.
Example:
&NetGeneration:5:2

179
©2011 PowerWorld Corporation

Copying Simulator Data to and from Other Applications
You may sometimes find it useful to copy data from Simulator to other applications such as a word
processor or spreadsheet program. Alternatively, you may want to copy data from other applications
into Simulator. Simulator’s case information displays provide a convenient way to accomplish this. In
particular, the Copy All, Copy Selection, and Paste options from the local menu or the Case
Information Toolbar: Copy, Paste and Send Menu allow Simulator to pass data with other applications
through the windows clipboard.
To copy a selection of data from a case information display to another application, first select the
range of cells to copy from the case information display. Then, right-click on the case information
display to display its local menu, and choose Copy Selection. To copy the entire content of a case
information display to another application, follow the same procedure, except choose Copy All from
the local menu instead of Copy Selection. Switch to the application that will serve as destination for
the data and use that application’s Paste command to finish copying the selected Simulator data to
that application. Note that not only is the data copied, but by default so are the data headings. The
data headings are very important to maintain if you are planning on copying data from a spreadsheet
back into a Simulator case information display. Also note that Simulator copies the text to the windows
clipboard with tabs delimiting each cell.
Note: Be aware that most programs have limitations on the amount of information you can paste. For
example, some spreadsheet programs only allow up to 256 columns and 65,000 rows of information.
Some power system information, particularly the Ybus or Jacobian matrices, can easily exceed these
limitations.
To paste data from another application into a case-information display, select the data in the other
application and use that application’s Copy command. In order to paste back into Simulator, you must
have the record type and data headings selected with the columns of data. The record type (or object
name) must match the case information display you are attempting to paste into, and the data
headings (or variable names) tell Simulator which columns of data you are pasting. In order for the
data to be pasted to the correct records, you must include the key field columns in the data to be
pasted into Simulator. Also if you are attempting to create new data records by pasting back into
Simulator then you must include the required field columns as well. If the object type is not valid then
the Paste option will be disabled and the caption will read "object type invalid". If the key fields are
missing, then the Paste option will be disabled and the caption will read "key fields missing".
It is not necessary to copy and paste all columns or rows of data back into Simulator, as long as the
column headings match a valid heading for the case information display. Simulator will skip the data
under any column headings that are unrecognized. If you wish to copy data from a spreadsheet into a
Simulator display, you must make sure they are ordered in such a way that all the information you
wish to paste can be grouped and copied as one block of date from the spreadsheet. Once you have
copied all the information from the spreadsheet you wish to transfer, switch to Simulator, open the
case information display in which to paste the data, and select Paste from its local menu.
Note: You can only paste values into the case information displays if the values are enterable on the
display (shown blue by default). Also, be careful about pasting redundant data. For example, in the
Bus Records display both voltage in per unit and voltage in kV are enterable, but they specify the
same information. Make sure you only copy ONE of these columns into Simulator. Otherwise you may
not get what you expect. Simulator will paste the value in twice, and whatever value was pasted 2 nd
will be used.
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Save Case Information Data
The Save Data Dialog gives you quick access to saving data from certain Case Information Displays in
a PowerWorld Simulator Auxiliary File.
Specify the name of the auxiliary file in which to save the data records in the text box labeled Name
of File to Save. Instead of typing the name of the file by hand, you can press the Browse button to
locate it. Then, indicate whether you want the objects whose data you are writing to the file to be
identified by number or by name. Finally, to ensure that only the records currently listed in the Case
Information Display are written to the auxiliary file, check the Save Only Records Listed in this
Display checkbox. Otherwise, data for all such objects in the entire system will be saved to the file.
When you have finished setting these options, click OK. If you changed your mind and do not want to
save the data to a file, click Cancel.
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Key Fields
Key fields are necessary fields when attempting to paste data into a Case Information display from
another data application. Other fields are also considered required fields for the purpose of creating
new objects in Simulator by pasting or loading information from another source, such as Excel or a
PowerWorld Auxiliary file. The key fields are easily identified from a few different locations.
Column Headings
The column headings of case information displays are colored to indicate fields that are key fields.
Any field that is a key fields will be highlighted yellow. Also note that some fields are highlighted
green. These fields are required fields that are necessary when you are attempting to create a new
object by pasting or loading the data from another application. If the necessary key fields (yellow)
are not included in the data loaded from another source, the information for that object is ignored.
If all of the required fields (green) are not included in an object that is detected as new, Simulator
will skip it. If all the required fields are present, then Simulator can create the new object. Note that
for new objects, the key fields are necessary as well.
Display/Column Options
The Display/Column Options dialog, available by right-clicking on any case information display, also
has the capability to highlight both the key fields and required fields, as described above. The check
box labeled "Highlight Key Fields" will enable highlighting of the field names in the two lists on the
display.
Export Object Fields
This option from the Help menu in Simulator allows you to export a list of most fields for each type
of object in a case. The list also indicates which fields are key fields and required fields for each
object. You can output this list of fields as either a text file or into Excel.
The following table lists some of the more commonly accessed key fields needed when attempting to
Paste data into existing objects in a Case Information Displays from another data application.
Type of Data

Data
Description

Necessary
Key Columns
for Paste

Area

Area Records

Area Num

Bus

Bus Records

Number

DC Line

DC Line
Records

Rectifier
Number

Inv
Number

Gen

Gen Records

Number

ID

Interface

Interface
Records

Name

Line/Transformers

Line Records

From
Number

To
Number

Load

Load Records

Number

ID

Substations

Substation
Records

Sub Num

182
©2011 PowerWorld Corporation

Num

Circuit

Switched Shunt

Switched
Shunt Records

Number

Zone

Zone Records

Zone Num
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ID

Required Fields
Required fields are necessary fields when attempting to create new objects by pasting data into a Case
Information Display or when reading data from an PowerWorld Auxiliary. These fields are in addition to
the key fields which identify the object.
There are two purposes of the required fields. First there are some fields for which an appropriate
default value is not apparent thus by requiring these fields it forces the specification of the value.
Second, when pasting data into Simulator it is possible that the record will not exist in the case.
Simulator will then determine whether to create these records by looking to see if the required fields
are specified. By doing this, it prevents the accidental addition of records. For instance you may have
an Auxiliary File that sets the Monitor field of all branches in your case to Yes or No. If Simulator runs
across a branch between two buses that exist, but whose circuit ID does not exist, then Simulator will
just skip this line from the Auxiliary File. It will not be possible to accidentally create a bunch of new
transmission lines with default impedance parameters because the R and X impedance parameters are
required.
The required and key fields are easily identified from a few different locations.
Column Headings
The column headings of case information displays are colored to indicate fields that are key fields.
Any field that is a key fields will be highlighted yellow. Also note that some fields are highlighted
green. These fields are required fields that are necessary when you are attempting to create a new
object by pasting or loading the data from another application. If the necessary key fields (yellow)
are not included in the data loaded from another source, the information for that object is ignored.
If all of the required fields (green) are not included in an object that is detected as new, Simulator
will skip it. If all the required fields are present, then Simulator can create the new object. Note that
for new objects, the key fields are necessary as well.
Display/Column Options
The Display/Column Options dialog, available by right-clicking on any case information display, also
has the capability to highlight both the key fields and required fields, as described above. The check
box labeled "Highlight Key Fields" will enable highlighting of the field names in the two lists on the
display.
Export Object Fields
This option from the Help menu in Simulator allows you to export a list of most fields for each type
of object in a case. The list also indicates which fields are key fields and required fields for each
object. You can output this list of fields as either a text file or into Excel.
An example of required fields for an object is for a Branch object. For a branch object, the key fields
are the from bus number, to bus number and the circuit ID. Required fields are the Impedance Values
R, X, and B and the first three ratings A, B, and C. Without specifying values for these fields you can
not create a new branch.
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Contour Column Dialog
The Contour Column Dialog allows you to contour case information display columns.
The Contour Column Dialog has two tabs:
Contour Type
Custom Color Map
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Contour Column Type
Color Map
Choose from various predefined color maps using the color map combo-box. A color map, along with
the values specified, defines how values are mapped to a color on the contour image.
If a color map showing both high and low values is desired (such as for bus voltages), use of "Blue
= Low, Red = High" is recommended. If a color map showing only high values is desired (such as
for line flows), use of "Weather Radar, Nominal to High" is recommended.
A user may also define additional color maps by going to the Custom Color Map Tab.
Reverse Color Map Colors
Check this box to reverse the colors of the selected color map, so the low color becomes the high
color, and vice versa.
Brightness
Modify the brightness track bar to change the brightness of the color map.
Use cell values directly
Select this option to use the cell values to do the contouring.
Use the specified field below
Select this option to use a different field value to do the contouring.
Value
Select the quantity to use in the contouring from the Value dropdown box or click the Find
Value button to find the desired field.
Draw Color Key
Checking this box will cause the contour to draw a color key showing which colors are mapped to
which values. You can also give the color key a title, unit label, and specify the number of digits to
display in numerical values.
Title
Title for the color key.
Entry Labels
Units of the contoured value displayed on the color key.
Dec. Pts.
Number of decimal places of the contoured value displayed on the color key.
Scalar
Multiplication factor that can be applied to the values when drawing the color key.
Use Equal Spacing For Discrete Maps
This option will draw the color key with equal spacing for all colors in the map, regardless of how
close or distant the values the colors represent.
Use absolute value
Check this check-box to use the absolute values of the quantity selected at the Value dropdown box
(above).
Values
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These values along with the color map define how to convert your values into a color for the
contour. The values are:
Maximum The largest value allowed in the contour. All values above this will be mapped to the
highest color. This value corresponds to 100% in the color map.
Break High This value is used by some color maps to highlight a lower limit. This value corresponds
to 75% in the color map.
Nominal This value is the nominal value for the contour. Values around this will be mapped to the
middle color. This value corresponds to 50% in the color map.
Break Low This value is used by some color maps to highlight a lower limit. This value corresponds
to 25% in the color map.
Minimum The smallest value allowed in the contour. All values below this will be mapped to the
lowest color. This value corresponds to 0% in the color map.
Note: a representation of the color map is shown to the right of the values.
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Grid Metrics Dialog
The grid metrics dialog allows you to determine the metrics for a set of columns. The metrics
determined include: Sum, Average, Variance, Standard Deviation, Maximum, Minimum, Total Items,
and Total Non-Zero Items.
By default the dialog is set to determine the metrics for the whole column of the case information
display where the option has been selected. However, the selected record set can be modified. The
Start Column and End Column values specify what columns to include in determining the metrics.
The Start Row and End Row values specify what records to include when computing the metrics. If
the option Treat blank cells as zero is checked, then any blank cells will be considered as zero when
computing the metrics. Instead, if the option Ignore blank cells for calculation is checked, any
blank cell will be taken out of the metrics calculation. Check Use Absolute Values to use the
absolute values of field values for the metrics computation. Finally, click Update Metrics to determine
the metrics with the new set of options.
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Auxiliary File Export Format Description (For both Display and Power System)
Definition of an Export Format Description
An export format description consists of the following items:
1.
2.
3.

A set of object types
The fields and subdata to be exported for each object type, including how each field should
be formatted when written (e.g., number of digits, number of decimal places)
The format (comma-delimited, space-delimited, etc.) that should be used when writing the
object data to disk.

For instance, an export format description might have two object types defined—buses and
generators—with indications to export the bus numbers for each of these objects and to write
this information to a space-delimited .AUX file.
Types of Export Format Descriptions
Export format descriptions can be defined for both the Display Objects and the Power System
Objects,




Display objects, e.g., background lines, pie charts, displayed fields, etc. Export format
descriptions for display objects are defined by selecting Display Objects Export Format
Description… on the Onelines ribbon tab, under the List Display Menu on the Active ribbon
group.
Power system objects, e.g., buses, loads, generators, etc. Export format descriptions for
power system objects are defined by selecting Power System Objects Export Format
Description from the Case Information ribbon tab on the Case Data ribbon group.

The dialogs used to define both types of export format description are very similar; any
differences between the two dialogs will be clearly noted below.
Export Format Description Dialog
Clicking on Display Objects Export Format Description or Power System Objects
Export Format Description, opens the Export Format Description Dialog. There are several
buttons at the bottom of the dialog:







Create Format for Complete Case : sets the format for the AUX file to be created to be
all necessary fields to replicate the load flow case. This is essentially the same as choosing
to save the case as an auxiliary file when choosing "Save Case As" from the Application
menu and setting the "Save as type" parameter to "PowerWorld Auxiliary Data".
OK : save the current settings to the selected export format description, and close the
dialog
Create AUX File with Specified Format : writes data to a file using the current settings.
A dialog pops up to select the filename for storing the data. If the file already exists, the
data is appended; otherwise, a new file will be created
Cancel : do not save the current settings and close the dialog
Help : open the help associated with the dialog .

The other parts of this dialog box are discussed in detail below
Format Name Section
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The uppermost part of the dialog box is used to manage the set of export descriptions. Once
one export description has been saved (by clicking Save or Save As, after defining some object
types), a drop-down box will appear which allows selection of an export format description from
the set of export format descriptions saved with the case: The buttons underneath the dropdown box have the following functions:






New : clear the rest of the form in order to define a new export format description
Save : save the information in the rest of the dialog box to the export format description
currently selected in the drop-down box. If no export format description is selected, this is
equivalent to clicking Save As.
Save As : save the information in the rest of the dialog box to a new export format
description; a dialog will pop-up asking for the name of the new export format description.
Rename : rename the currently selected export format description
Delete : delete the currently selected export format description

The list of export format descriptions for display objects and power system objects is kept
separate, so the drop-down box will only contain export format descriptions defined for the
object type selected from the menu (Display Objects Export Format Description Dialog or Power
System Objects Export Format Description Dialog).
File Type and Field Defaults
The next section of the dialog box is used to define the format to save the data, and the default
formatting of any numeric fields that are to be saved. Currently, there are 3 options for the file
type:




AUX (space) : output the data using a space-delimited .aux file format
AUX (,) : output the data using a comma-delimited .aux file format
CSV : output the data to a comma-separated-values (CSV) file. This type of file can be
easily imported into any spreadsheet or database software.

In the Defaults for Exporting Fields section, the up/down arrows can be used to change the
default number of total digits and digits to the right of the decimal place used in exporting
numeric values. These values may be overridden in the Select Fields form for individual fields.
Object Type and Filter Method Section
The two-column section on the left side of the dialog box is used to define object types and a
filter for each object type.
Object Type
The first column is used to specify which object types are to be exported. To insert a
new object type (corresponding to a new row) into the export format description, there
are two options—either click the New button above the Object Type column heading, or
right click on a row and select Insert. Upon doing this, a dialog will pop up to choose an
object type:
Type into the text box to search for a particular object type. The list of object types
depends on the type of export description being defined. When defining display object
export descriptions, only display object types will show up in this list; similarly, when
defining power system export descriptions, only power system objects will show up.
Clicking Choose will insert the object type into the list of object types to be exported.
Double-clicking an existing object type will pop-up this same dialog box, allowing the
object type to be changed. Doing so will empty the exported fields, subdata, and filter
method.
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Filter Method
The second column is used to define an object filter. The default behavior is to export all
objects without any filtering, but this can be changed by double-clicking on the filter
description. Upon double-clicking on the filter description, a dialog will appear allowing
you to choose the filter. The options available for determining which objects are exported
are as follows






All : export all objects, disregarding any filters defined in the current case
Use Area/Zone/Owner Filter : only export those objects that satisfy the currently
defined area/zone/owner filter. Clicking on Select Area/Zone will pop up the dialog
box used to define area/zone/owner filters.
Use Selected : only export those objects that have the Selected field set to Yes.
Clicking on Select pop up the dialog box used to set the Selected flag for each of
the objects in the case. Note that this particular option does not exist for display
objects, because display objects do not currently support the Selected field.
Meets Filter : only export those objects that meet an advanced filter, which can be
either selected from the drop-down box or defined using the Define Filter button.

Fields And Subdata To Be Exported
After specifying an object type (and, optionally, a filter), selecting the row on the left side of the
dialog box will allow you to specify the fields and subdata to be exported.
Fields To Be Exported
By default, no fields are selected for export. To define fields for export, click on the
Modify button to the right of the Fields heading the Select Fields dialog box will
popup. This dialog is used to specify which fields are to be exported, along with any
field-specific formatting of numerical values . Generally the dialog behaves identically to
the Configuring Case Information Displays Dialog, so for more detailed help see that
topic. There are parts of the dialog that behave differently however, and these are
described as follows.


Total Digits / Dec Places : these two boxes are used to set the number of total
digits and the number of decimal places to use when writing the data for the fields
current selected in the Selected Fields section. Leaving these two boxes blank means
that the default number of digits and decimal places should be used. Also, if multiple
fields are selected that have different settings for the number of digits or number of
decimal places, these boxes will be grayed out, but still enterable. Once entering a
value into either box, all selected fields will then have the same setting, and the box
will no longer be greyed out.

Subdata To Be Exported
By default, no subdata is selected to be exported. Also, many objects (e.g., Bus and
Area) do not have subdata associated with them, so the Modify button will be greyed
out. If an object type does have subdata, then the SubData definition section will be
grayed out.
To add subdata that should be exported, click the Modify button to the right of the
SubData heading. This brings up the Select SubData dialog. A description of the
options/settings on this dialog follows.
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Available SubData : lists the SubData that exist for this object type. If Exclude
subdata already selected is checked, then only SubData that is not already in the
Selected SubData section will show up in this list.
Exclude subdata already selected : if checked, then the Available SubData
section will only contain items that are not already in the Selected SubData section
Selected SubData : lists the SubData to be exported for this object type
Add -> : set the currently selected SubData in the Available SubData section to be
exported
<- Remove : set the currently selected SubData in the Selected SubData section to
not be exported
OK : save the settings and close the dialog
Save : save the settings, but leave the dialog open
Cancel : do not save the settings and close the dialog
Help : click on this to open the help associated with the Select Fields dialog
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Geographic Data View
Geographic Data Views allow the quick creation and formatting of graphical representations of buses,
generators, loads, switched shunts, transmission lines, substations, areas, zones, super areas, and
injection groups. Latitude and longitude coordinates specified with buses and substations are used to
place objects geographically on a display. The latitude and longitude coordinates must be specified in
order to use this feature. Object attributes such as color, size, rotation rate, rotation angle, and
visibility can easily be formatted based on the associated data object field values.
To create a Geographic Data View, open a case information display for the desired element type,
select the elements for which to add geographic representations, and either right-click on the object
grid and choose Geographic Data View > Geographic Data View from the local menu or choose
Geo > Geographic Data View from the case information toolbar. Use the Select Column, then
Geographic Data View option to select an entire column of elements. The column in which the
elements are selected determines the initial selection of the field to use for attribute settings. The
Geographic Data View Customization dialog will open.
Geographic Data View Customization Dialog

Oneline for Geographic Data Addition
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When creating a new geographic data view, the oneline to which to add the geographic data view
objects must be set. Choose either to Use Already Open Oneline and then select a oneline from
the dropdown list of available onelines or choose to Open a Oneline and then either type in the
name of a PWD file or click Browse to select a one.
Because geographic data views are dependent on having geographic latitude and longitude
information available, the oneline that is selected must have a valid map projection in use. Only
those open onelines that currently have a map projection in use will be listed in the dropdown box
and any oneline opened from a file will be checked for a valid map projection. If a valid map
projection does not exist, new geographic data view objects will not be added to the oneline.
Create Oneline with Geographic Borders
Click this button to create a new oneline diagram with first being prompted to add geographic
borders. A default name will be assigned to the new oneline and that oneline will be added as the
selected oneline in the Use Already Open Oneline dropdown.
Setting Attributes for Geographic Data View Display Objects
Before adding new geographic data view objects, the attributes associated with the objects should
be set. These attributes are stored in Geographic Data View Styles.
Create Empty Oneline
Click this button to create a new oneline diagram. A default name will be assigned to the new
oneline and that oneline will be added as the selected oneline in the Use Already Open Oneline
dropdown.
Create Geo Data View Display and Close Dialog
Click this button to accept all of the option settings, add new geographic data view objects to the
selected oneline, and then close the dialog.
Cancel
Click this button to close the dialog without adding and new geographic data view objects.
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Geographic Data View Styles: Fields and Attributes
The Field and Attributes options associated with Geographic Data View Styles allow the formatting of
the geographic data view display objects depending on the values of fields of their linked data objects.

Attribute
Most of the attributes can have a Default value or a value that is dependent on the value of a
selected field. When the Use box is checked for a particular attribute, the field selected in the Field
Lookup is used to determine the value of the attribute based on either a Color Map or Value Map
lookup. Otherwise, the default value will be used. Line Thickness, Total Area, Rotation Angle, and
Rotation Rate attributes all use value map lookups. Line Color and Fill Color both use color map
lookups. When determining the Field Lookup, either select the field from the drop-down or use the
Find button to open the Find field dialog for easy searching.
When an attribute is selected, either by clicking on one of the options settings for that attribute or just
clicking the background box for that attribute, the appropriate color map or value map for that
attribute will be displayed in the right-hand panel.
Line Thickness
Thickness of the line making up the outside border of the display object.
Line Color
Color of the line making up the outside border of the display object.
Fill Color
Fill color of the display object. The Fill Color will be used only if the Use Fill box is checked.
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There are two choices of Field Lookup for this attribute. The top choice is enabled regardless of
the choice of object Style. The bottom choice is only enabled when the Kite style is chosen. The
Kite style allows two different fields to be displayed in one object. This is useful for displaying
fields like Mvar Maximum and Mvar Minimum. The top field indicates what field will be used to
format the top half of the Kite, and the bottom field indicates what field will be used to format
the bottom half of the Kite.
When using the Kite style, use of the two different Field Lookups can be selected independently
and each has a separate color map. When not choosing to use one or both of the Field Lookups,
that appropriate half of the Kite shape will use the default Fill Color choice. To switch between
color maps for the two Field Lookup choices, either click on the field drop-down for the
appropriate half of the Kite or click the
the Kite style is selected.

button that will appear next to the field choices when

Total Area
This determines the size of the display object. Check the option to Use Auto Width of Objects
for the width of the objects to be determined automatically. If this option is not checked, the
Width can be set manually. The height or size is always determined as a function of the width
and can be set with the Size to Width Ratio. When using the Field Lookup table the total area
of the object is determined based on the Characteristic Value returned. The dimensions of the
object are then determined based on the total area and the Size to Width Ratio.
There are two choices of Field Lookup for this attribute. The top choice is enabled regardless of
the choice of object Style. The bottom choice is only enabled when the Kite style is chosen. The
Kite style allows two different fields to be displayed in one object. This is useful for displaying
fields like Mvar Maximum and Mvar Minimum. The top field indicates what field will be used to
format the top half of the Kite, and the bottom field indicates what field will be used to format
the bottom half of the Kite. Even though two fields can be chosen when using the Kite style, only
one value map is used for the Field Lookup. When using the Kite style and using the Field Lookup
the total area of the object is based on the sum of the lookup values returned for both fields.
Rotation Angle
Static angle of rotation of a display object in degrees.
Rotation Rate
This value is given in Hz and indicates how many times per second an object should do a full
rotation. This is used in conjunction with the General Option for Animation Control. If animation
control is not enabled, the rotation rate has no effect on how the objects are displayed.
Visibility
This attribute can prevent display objects from being shown if certain conditions are not met.
Choosing the All Visible option will always show all of the display objects associated with this
style. If choosing the option Only visible if field is non-zero, select a field from the dropdown box. Only those objects whose selected field is non-zero will be visible. If choosing the
option Only visible if filter is met, select a filter from the drop-down box or click the Find
button to search for an existing filter or create a new one. Only those objects that meet the
selected filter will be visible. Note that the visibility attribute is only applied while in Run Mode. All
objects will be visible in Edit Mode regardless of how this option is set.
Color Map
Color maps are used with Line Color and Fill Color attributes. The Field Set Metrics section simply
gives some statistics on the values of the selected field for the data objects. These metrics are
provided to aid in the setting of the breakpoint values for the color map.
Color Map
Choose from the predefined color maps using the drop-down.
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Reverse Color Map Colors
This checkbox reverses the mapping of the color map, converting the colors corresponding to the
high values into the colors for the low values, and vice-versa.
Use Discrete Color Map
Check this box to make a discrete color map, that is without having smooth transitions between
colors.
Brightness
Modify the brightness track bar to change the brightness of the color map.
Use Absolute Value
Check this box to use the absolute values of the field values when mapping the field values to
colors.
Breakpoint Values
The breakpoint values determine how the field values will map to colors.
Set Breakpoints from Metrics
As different fields are chosen for attributes, the Field Set Metrics will be updated to reflect the
field values. Click this button to update the breakpoint values based on a new set of Field Set
Metrics.
Value Map
Value maps are used with Line Thickness, Total Area, Rotation Rate, and Rotation Angle attributes.
The Field Set Metrics section simply gives some statistics on the values of the selected field for the
data objects. These metrics are provided to aid in the setting of the Field Values and corresponding
Characteristic Values.
The attribute value for a particular display object is set to the Characteristic Value that corresponds
to the field value of the corresponding data object. Characteristic values will be interpolated if the
field value does not fall exactly on a value that has been defined in the table. To insert entries into
the table, right-click on the table grid and choose Insert from the local menu. Choose Delete from
the local menu to remove entries.

Attributes for All Objects In Style
These attributes apply to all objects independent of any specific field value.
Layer
Type in the name of an existing layer to assign the objects to an existing layer, or type in the
name of a new layer to have that layer created and add the objects to that layer.
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Stack Level
An object's stack level dictates what objects it will appear above and which objects it will appear
below on a oneline display. For example, circuit breaker and pie chart objects have a default
stack level of Top. Therefore, anything with a stack level of Middle, Background, or Base will
appear underneath pie charts and circuit breakers on the oneline display. Objects that are within
the same stack level and are drawn in the same location will result in the last object drawn being
the visible object on the display.
Line Dashed
This determines the appearance of the line making up the outside border of the display object.
This line can be solid or one of the dashed options.
Immobile
Check this box to keep the geographic display objects from being moved on the oneline diagram.
Set Font
Click this button to bring up the Select Font Options dialog. The changes to font are limited to
Font Name, Font Color, and special Font Effects of Bold, Underline, Italic, and Strikeout. There is
no option for setting the font size because this is automatically determined based on the size of
the display object.
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Geographic Data View Styles: General Display Options
The General Display Options associated with Geographic Data View Styles are applied to all geographic
data view objects independent of any field value.

Style
The style determines the shape of the geographic data view display object used to represent the
selected data records.
Object ID
Each geographic data view display object can be identified by name, number, or a combination of
the two. When a choice other than None is selected, the appropriate identification for that object will
be displayed. When Prefix ID with Object Type is selected, the object type will be prefixed along
with the main identifier. This option is useful when trying to distinguish between the different types
of objects shown on a given display.
Selection Options
Geographic data view display objects can be formatted differently when they are selected as
opposed to not selected. Check the option Can Be Selected to allow objects to be formatted based
on the set options when they are selected. Line Thickness determines the thickness of the border
line around the outside of the display object when it is selected. Line Color determines the color of
the border line around the outside of the display object when it is selected.
Animation Control
Geographic data view display objects are capable of being animated if a Rotation Rate other than
zero is specified with the attributes. Check the Enable Animation box to animate the objects using
this style. The Interval determines how often the display is refreshed during animation.
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Geographic Data View Styles
Each geographic data view object has an associated Geographic Data View Style. The style determines
how the object is going to be displayed and contains options for setting various attributes associated
with the object. Each style refers to a particular type of object. Geographic data view objects cannot
be individually formatted; they will always obey the formatting of their associated style.
The Geographic Data View Options dialog is used to create and modify styles that will determine
the appearance of geographic data view objects. This dialog is part of the Geographic Data View
Customization dialog when adding new geographic data view objects to a display, but it becomes a
stand-alone dialog when modifying the styles for existing objects. To open as a stand-alone dialog,
right-click on an existing geographic data view object and choose View Geographic Data View
Options from the local menu.
Usually, groups of objects share the same geographic data view style. Keep in mind that changing the
options in a style will change all of the objects that use this style.
Geographic Data View Options Dialog
The Geographic Data View Options dialog is made up of four main sections and tabs:
Object and Field Display Option Sets

This section allows the saving, renaming, and deleting of Geographic Data View Styles. Only those
styles for a particular Object Type will be displayed in the Style Name dropdown box. Style names
must be unique within an Object Type. Geographic data view styles can be stored in the standard
auxiliary file format. When saving or loading an auxiliary file from this dialog, all geographic data
view styles will be stored or loaded regardless of the current object type. The default is to store the
information in a data auxiliary file, .AUX, but these objects are also supported in display auxiliary
files, .AXD.
General Display Options
Fields and Attributes
Object Records
The object records tab lists the data objects that are linked to the geographic data view style,
through their associated geographic data view display objects, selected when the dialog is opened.
The caption of this tab will be updated to reflect the class type of object that is represented. For
example, if viewing bus objects, the caption will be Bus Records instead of Object Records. These
are either the data objects selected before creating a new geographic data view or data objects
represented by existing geographic data view objects that are using the selected style. The format of
the display objects represented by these data objects will be changed based on any changes made
to the options. To assign a group of geographic data view display objects to a new style, simply
select a different style than the style in place when opening the dialog and click either the OK
button on the Geographic Data View Options dialog (existing data object was selected) or the
Create Geo Data View Display and Close Dialog button on the Geographic Data View
Customizations dialog (new geographic data view objects are being created).
To change the style of a single geographic data view display object and assign it to a new style, use
the Display Explorer. Within the Display Explorer, case information displays for geographic data view
objects are available. The style is given in the field Geographic Data View Style Name (variable
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name GEODATAVIEWSTYLENAME). To change the style, change the name listed in this field to a
style that is available for the type of object being changed.
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Custom Case Information Display
To open the Custom Case Information Displays, go to the Case Information ribbon tab, and choose
Custom Case Info from the Case Data ribbon group
Custom Case Information Displays can be used to create a display very similar in appearance to a
spreadsheet workbook with several worksheets. This display can show any information that can be
shown on a case information display, but also allows you to customize the layout of the information in
any manner.
There are three buttons which allow you to Rename the present sheet, add a New sheet, or Delete
the present sheet.
There are three different kinds of cells allowed on this display




Blank Cell – contains nothing
Plain Text Cell – contains a user-entered string with no link to any data in the model.
Model Field Cell – contains a link to model field similar to inserting a model field on a oneline
diagram

Each cell of the display will behave differently depending on the Custom Case Info Mode. There are
four distinct modes that control the user interaction and operation of the custom case information
display. These four modes and the effect they have on the display are described in topics





Define Fields/Strings
Change Field Data
Show Fields Primary
Show Fields Secondary
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Define Fields/Strings
The "Define Fields/String" mode is the primary mode for use when setting up a new Custom Case
Information Display. The three kinds of cells behave as follows in this mode.
Blank Cell
To convert to a Plain Text Cell, just type in the cell. To convert to a Model Field Cell, double-click on
the cell to open up a dialog for defining the model field.
Plain Text Cell
These cells will appear in the Case Info Display Enterable Color (blue by default). To change them
just type on the cell. When pasting into such a cell or editing it directly it will parse the string
entered trying to create a Model Field as though the string represents the model fields as shown in
the Show Fields modes. If the string does not represent such a field, then it will remain a Plain Text
Cell
Model Field Cell
Model Field cells will not be enterable. In order to edit these fields, you must double-click on the cell
to open a dialog for defining the model field.
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Change Field Data
The "Change Field Data" mode can be used to edit the data referred to by the model fields on a
custom case information display. The three kinds of cells behave as follows in this mode.
Blank Cell
Blank cells may not be edited in any manner.
Plain Text Cell
Plain Text cells may not be edited in any manner. It will appear in a special color defined for the
custom case information display which may be specified from the local menu of the workbook tabs.
By default this color is dark gray.
Model Field Cell
Model Field cells will behave according to the field to which they refer. Enterable fields will be
enterable, toggleable fields will toggleable, etc… When pasting in the sheet in this mode you will be
modifying the model data directly. In the following picture there are three fields in cells C4, C5, and
C6 that refer to read-only, enterable, and toggleable field respectively. The fields are labeled using
the plain text cells in D4, D5, and D6.
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Show Fields Primary
The "Show Fields Primary" mode is used for interacting with an external spreadsheet to create the
model field links in custom case information displays. The three kinds of cells behave as follows in this
mode.
Blank Cell
Blank cells behave the same as for the "Define Fields/Strings " mode.
Plain Text Cell
Plain Text cells behave the same as for the "Define Fields/Strings " mode.
Model Field Cell
Model field cells will display a string which represents information about the model field link. The
format for this string will be
‘model field name’ ‘variable name’ totaldigits decimalpoints IncludeUnits
The model field string will use the primary key fields.
When pasting into such a cell or editing it directly it will parse the string entered trying to create a
Model Field as though the string represents the model fields as shown in the Show Fields modes. If
the string does not represent such a field, then it will remain a Plain Text Cell.
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Show Fields Secondary
This mode is identical to the Show Fields mode, except that it will show model fields string using the
secondary key fields.
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Custom Case Information Display Local Menu
By right-clicking on the tabs representing the various sheets of the custom case information display, a
local menu appears giving you the following options.










Rename Sheet – this is only available if you click directly on a specific tab. Choose it to rename the
sheet.
Delete Sheet – this is only available if you click directly on a specific tab. Choose it to delete the
sheet.
New Sheet – Choose this to add a new sheet
Save All Sheets… – Choose this save all the information on the sheets to an auxiliary file. For the
fields one the display, all information will be saved to the auxiliary file using Primary Key Fields
unless the Custom Case Info Mode is set to Show Fields Secondary. In this case, they will be saved
using the secondary key fields.
Custom Case Info Mode – Choose this to open a submenu that allows you to change the mode.
Tabs Position – Choose this to open a submenu that allows you to change the location of the tabs
relative to the sheets
Plain Text Change Data Color – Choose this to change the color which is used to denote Plain Text
cells when the Custom Case Info Mode is set to Change Field Data. The default color is dark gray.

By right-clicking on one of the Custom Case Information Display sheets, you will open a local menu
that has many options which are the same as other Case Information Displays. There are a few extra
options listed as follows








Insert Row – Choose this to insert a new row at the location of the presently selected cell
Delete Row – Choose this to delete rows that are part of the present selection
Insert Column – Choose this to insert a new column at the location
Delete Column – Choose this to delete columns that are part of the present selection
Delete Cell – Choose this to delete the presently selected cells
Custom Case Info Menu – Choose this to open the same menu available by right clicking on the
tabs representing the various sheets
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User-Defined Case Information Displays
While it is normally sufficient to customize the case information displays that come with the program,
it is sometimes convenient to create different sets of columns, filtering, sorting, etc... for the same
object type. One set of generator fields may be convenient for studying voltage regulation problems,
while another set of generator fields may be convenient for looking at MW-related information. This
ability is provided using the User-Defined Case Information Displays. This provides the ability to switch
between different sets of columns, filters, sorting etc... without requiring repeated customizations.
Note: User-Defined Case Information Displays will not show any of the various Record-Specific Actions
which often appear in the Case Information Toolbar Records Menu. To access these special options,
the normal case information display must be used instead.
The management of User-Defined Case Information Displays is all done from the Model Explorer:
Explore Pane.

Inserting User-Defined Case Information Displays
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To define a User-Defined Case Information Display, right-click on the Model Explorer: Explore Pane.
and choose Insert User-Defined Case Info. On the dialog which appears click Find... to change
the Object Type and then enter a Name for the new display.

Viewing User-Defined Case Information Displays
A list of User-Defined Case Information Displays are shown in the folder User-Defined at the
bottom of the Model Explorer: Explore Pane.
Removing User-Defined Case Information Displays
To remove a User-Defined Case Information Display, right-click on its entry under the UserDefined folder on the Explore Pane. Then choose Remove User-Defined Case Info.
Customizing User-Defined Case Information Displays
The customization of a User-Defined Case Information Display is exactly the same as all other case
information displays. See the Configuring Case Information Displays for more information.
Saving Settings for User-Defined Case Information Displays
Settings for the User-Defined Case Information Displays can be saved in the Auxiliary File Format.
To save these, in the Explore Pane, go to the Case Information and Auxiliary/User-Defined Case Info
Displays. This will open a case information display showing the user-defined case information
displays. Then save to an auxiliary file using the Case Information Toolbar: Save Auxiliary Files
Menu.
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Case Description
The Case Description Dialog is broken into two sub-tabs
Case Description
The Case Description Tab allows you to enter a text description of a case. The portion of the
description that is saved with the case varies with case type:
PowerWorld Binary (*.pwb) an unlimited number of lines are allowed
PTI Raw Data format (*.raw) Two lines of text
GE EPC Data format (*.epc) The case title and all the pre-title comments are read in as the case
description
PowerWorld Case (*.pwc) No case description supported
IEEE Common Format (*.cf) No case description supported
In PowerWorld Viewer, these descriptions are read-only.
Case Comments
The Case Comments Tab allows you to read comments previously added to a particular case. It
shows a Case Information type of table with the Date, Time, User and Comment. This info is useful
to track particular changes to a case or any information that need it to be commented after saving a
case.
Clear Comments will clear all of the comments associated with the respective case.
Checking the Prompt for comment when saving case checkbox will force saving the case with
comments by popping a dialog every time a case is saved. The portion of the description that is
saved with the case varies with case type. The Add a comment dialog is shown below:

Add Comment will add the comment to the particular case.
Skip will skip the adding of the comment for the case at this particular time is saved.
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Always Skip will disable this dialog from appearing in future savings. To re-enable the dialog
prompt, the Allow to prompt for comment when saving case option can be set with
Environment Options.
The Comment can be written in the white box and the Name can be modified also.
The dialog is slightly modified if forcing the saving of comments when saving a case. A Prompt
for comment when saving case checkbox will be available to set this option instead of doing
that with the Environment Options.
To display the Case Description Dialog to the Case Information ribbon tab, and choose Case
Description from the Case Data ribbon group.
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Case Summary
The Case Summary Display provides a summary of the current case. Note that there are no enterable
fields on the display. To display the Case Summary, go to the Case Information ribbon tab, and choose
Case Summary from the Case Data ribbon group. The fields shown on this display include:
Number of Devices in Case shows the number of each of the following device types:
Buses
Total number of buses in the case. Use the Bus Display to see a listing of these buses.
Generators
Total number of generators in the case. Use the Generator Display to see a listing of these
generators.
Loads
Total number of loads in the case. Use the Load Display to see a listing of these loads.
Switched Shunts
Total number of switched shunts in the case. Use the Switched Shunt Display to see a listing of
these switched shunts.
Trans. Lines (AC)
Total number of transmission lines in the case. Use the Line/Transformer Display to see a listing of
these lines.
LTCs (Control Volt)
Total number of Load Tap Changing transformers in the case. Use the Transformer Control Display
to see a listing of these transformer controls.
Phase Shifters
Total number of Phase Shifting transformers in the case. Use the Transformer Control Display to see
a listing of these transformer controls.
Mvar Controlling
Total number of Mvar Controlling transformers in the case. Use the Transformer Control Display to
see a listing of these transformer controls.
Series Capacitors
Total number of Series Capacitors in the case. These devices are treated the same as any other
transmission line, and therefore can be found listed as a transmission element in the
Line/Transformer Display.
2 Term. DC Lines
Total number of two-terminal dc transmission lines in the case. Use the DC Transmission Line
Display to see a listing of these dc lines.
N-Term. DC Lines
Total number of multi-terminal dc transmission lines in the case. Use the DC Transmission Line
Display to see a listing of these dc lines.
Areas
Total number of areas in case. Use the Area Display to see a listing of these areas.
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Zones
Total number of zones in the case. Use the Zone Display to see a listing of these zones.
Islands
Total number of islands in the case. An island is a group of buses that are interconnected through ac
transmission lines or transformers but are isolated from the rest of the system. Each island must
have a slack bus. In Simulator, use the Power Flow Solution tab of the Simulator Options display to
specify whether multiple islands are allowed.
Interfaces
Total number of interfaces in the case. An interface is a grouping of tie line objects between area
objects. In Simulator, use the Interfaces Display to open the Interface Dialog to define and modify
interface objects.
Injection Groups
Total number of injection groups in the case. An injection group is a collection of loads and
generators (objects that inject power into a network). In Simulator, use Injection Groups Display to
open the Injection Groups Dialog to define and modify injection groups.
Case Totals
Summarizes the total load, generation, shunt compensation, and losses for the case. Positive shunt
compensation denotes shunt load, whereas negative shunt compensation indicates a shunt injection
(such as shunt capacitance). The case totals fields are valid only when the current case is solved.
Generator Spinning Reserves
The total difference between the present total generator output versus the total maximum possible
output of all in-service generation.
Slack Buses:
The slack bus or buses are listed showing the bus name, number, and area name and number. One
slack bus is required for each island.
Case Pathname
Full file name of the current case.

215
©2011 PowerWorld Corporation

Power Flow List
The Power Flow List shows detailed information about the system’s power flows in a more traditional
text-based form. This information is intended for users who would like detailed flow information about
the power flow. Including the per unit voltage at the bus, the bus’ load and generation, and flows on
all lines and transformers emanating from the bus. The content of this display (i.e. which buses are
included in the list) is governed by the area/zone/owner filters.
To show this display go to the Case Information ribbon tab, and choose Power Flow List from the
Case Data ribbon group.
To view flows at just a few select buses you may want to use the Quick Power Flow List instead. For
large systems with no area/zone filtering set, it may take Simulator a long time to generate the
complete Power Flow List. Note also that this display can show a maximum of 32,767 lines of text. If
this limit is exceeded, Simulator will generate a resource error. Either use the area/zone/owner filters
to limit the number of devices shown on this display, or use the Quick Power Flow List to focus on a
few selected buses of interest.
The Power Flow List allows you to navigate through the system’s buses rather easily. You can also use
the display to show the flows for a bus’ neighbor by double-clicking on the line that reads "TO
nnnnn…," where nnnnn is the number of the bus you would like to see. The display is then positioned
at this bus. If the bus is in an area and/or zone whose area/zone filter is not set, the area/zone filter is
set automatically. In this way, you can inspect the system bus by bus.
The Power Flow List also has its own local menu, which can be viewed by clicking the right mouse
button on the display. Select Change Font to modify the style and size of the display’s font. Select
Refresh to ensure that the display’s contents concur with the current system state. To skip to
particular bus in the list, click Find Bus, which will open the Find Bus Dialog. To display the
information dialog for the currently selected branch, bus, generator, load, or switched shunt, select
Show Dialog. To print the display, choose the Print local menu option. Choosing Copy enables you
to copy the display into the Windows clipboard, from where the information can be pasted into
another application. Finally, select Close to close the display.
When printing the display you can either send the results directly to the printer or save them to a text
file. To save the results in a text file on the Print Dialog select the Save to File option shown in the
lower left corner of the dialog.
For each bus, the following items are shown:
Bus
Shows the bus’ number, name, and nominal voltage in kV. The next four fields are the MW, MVar,
MVA and percentage headers for subsequent rows. The next fields specify the per unit voltage
magnitude, voltage angle in degrees, the bus’ area number and the bus’ area name.
Generator
For each generator at the bus, the Power Flow List shows the generator’s ID (immediately after the
keyword GENERATOR) and the power output of the generator in MW. Following this is generator’s
reactive power output in Mvar. A single character is shown immediately after the Mvar field. An ‘R’
indicates that the generator is regulating the bus voltage, ‘H’ indicates that the generator is at its
high reactive power limit, ‘L’ indicates that the generator is at its low reactive power limit, and a
blank suggests that the generator is set off of AVR. The last field in the GENERATOR item is the MVA
output of the generator. If no generators are connected to the bus, this item will be absent from the
display.
Load
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Shows the total power consumed by each load at the bus. If no loads are present at the bus, this
item will be absent from the display.
Shunt
Shows the total power for the fixed shunts at the bus. Positive shunt values denote shunt load, while
negative shunt quantities indicate injection. If no shunts are connected to the bus, this item will be
absent from the display.
Switched Shunt
Shows the total power for the switched shunts at the bus. If no switched shunts are located at the
bus, this item will be absent from the display.
Lines and Transformers
For each line or transformer coming into the bus, the Power Flow List shows the line’s flow and
percentage loading. For transformers, the off-nominal tap ratio and phase shift angle in degrees are
also shown. Immediately to the right of the off-nominal tap ratio is a two-character designation
indicating the tapped side of the transformer: ‘TA’ indicates that the bus is on the tapped side, while
‘NT’ identifies the bus as residing on the side without the tap. You can left- click on this field to
immediately reposition the bus to the other end of the line or transformer.
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Quick Power Flow List
The Quick Power Flow List provides a convenient means of viewing a listing of the flows at individual
buses in the system. The format and control of the Quick Power Flow List is generally the same as that
of the Power Flow List, except that the Quick Power Flow List displays results for just the desired bus
or range of buses.
You can access this Quick Power Flow List in a number of different ways:





Go to the Case Information ribbon tab, and choose Quick Power Flow List from the Case Data
ribbon group
From most of the Case Information Displays, right-click to invoke the display’s local menu, and
select Quick Power Flow List.
From the Bus Information Dialog click on the View All Flows at Bus button.
From the oneline diagram, right-click on the bus symbol to display the bus’ local menu, and select
Quick Power Flow List.

This display is automatically created if it is not already shown. Information on subsequent buses
appears at the bottom of the display.
As with the Power Flow List, you can navigate through the system bus-by-bus by double-clicking on
the lines that begin with "TO nnnnn …," where nnnnn is the number of the bus you would like to
investigate. Information for that bus will appear at the bottom of the display.
Like the Power Flow List, the Quick Power Flow List has a local menu that is accessed by right-clicking
on the display. Among the things you can do from the local menu is to display the bus, branch,
generator, load, or shunt corresponding to the currently selected record by selecting Display Object
Dialog. You can also navigate through the system bus-by-bus just as you can do through doubleclicking by choosing Goto Line Bus from the local menu.
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Outages
The outages display, available by choosing Solution Details > Outages in the Model Explorer,
presents a tabular listing of devices that are currently out-of-service in the load flow model. The
display contains pages that resemble case information displays for branches, generators, loads,
switched shunts, buses, and Multi-section lines. All devices listed in the pages on this display are the
out-of-service elements.
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Area Display
The Area Display houses data about each area in the case. The Area Display is a class of Case
Information Display and therefore can be used in a manner consistent with all other case information
displays. It has a case information toolbar from which you can print, copy, or modify its records as well
as view the information dialog of its associated areas. You can also sort the area records by clicking on
the heading of the field by which you want to sort.
To show the area records display, select Aggregations > Areas from the Model Explorer or
Aggregation > Areas from the Case Information ribbon group under the Case Information ribbon tab.
By default, the area records display contains the following fields:
Number, Name
Area’s number, between 1 and 9999, and its alphanumeric identifier. Simulator supports names of
any character length. However, when writing out names to file formats with limitations on name
length, the area names will be truncated at their maximum supported length.
AGC Status
Area’s automatic generation control status. This field indicates whether or not the area’s generation
is changing automatically to control the area interchange. See Area Control for more details. You can
toggle the value of the area’s AGC Status (except in Viewer) by left clicking on the entry. Valid
entries in this field include:
Off AGC Area is off AGC. Generation must be adjusted manually to meet changes in load and
losses. If it is not, the system slack will be forced to pick up the balance.
Part AGC Area is on AGC, with generation dispatch controlled by its units’ participation factors.
ED Area is on economic dispatch control so that generation is dispatched in order of least cost.
OPF Area is on OPF control (only used with Simulator OPF). This option is only used with Simulator
OPF. When the case is solved using the OPF the area controls are changed by the OPF to maintain
area power balance. During non-OPF solutions this option is equivalent to Off AGC.
Area Slack Area is on Area Slack control. This option is only available for an area if you have
already specified an area slack bus number in the area’s information dialog.
Gen MW
Total real power generation in the area in MW.
Load MW
Total real power load in the area in MW.
Tot Sched MW
The net of the base and scheduled transactions between the area and all other areas, with exporting
power indicated as a positive value. The interchange for an area is set on the Area Information
Dialog; the MW transactions for an area can be viewed using the specified MW Transactions display.
Int MW
The actual interchange between this area and all other areas, with exporting power positive. If an
area is on AGC control, its actual interchange should match its scheduled interchange.
ACE MW
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The area control error in MW. This is the amount of MW flow difference between the actual MW
interchange and the desired MW interchange. A positive value means the super area is generating
and exporting excess MW's, and a negative value means the super area is under-generating and
importing too many MW's.
Lambda
The area’s marginal cost. This marginal cost is relevant only when an Economic Dispatch (not OPF)
solution has been run. Theoretically, if losses are ignored, an area operates most economically if all
generators operate at the same incremental cost. This common incremental cost is the area’s
lambda, or marginal cost.
The local menu of the area records display has an additional option labeled All Area Gen IC Curves.
Select this activity to generate a plot showing the incremental cost curves for all units located in a
particular area.
Loss (MW)
Total real power losses for the area.
Losses for tie-lines between areas are assigned to the area in which the terminal bus that is NOT the
metered bus is contained. The Metered End field for a branch determines which of the terminals is
metered.
Auto Shunts
Determines whether switched shunts for the area are available for automatic control. You can use
this field to disable all the switched shunts in an area. Click on this field to toggle its value. Click on
the Toggle All Yes or Toggle All No local menu options to set the auto shunts property for all
switched shunts. Note that a switched shunt is available for automatic control only if it meets three
conditions: 1) its control mode property is set to Automatic (see Switched Shunt Information
Dialog); 2) its associated area’s Auto Shunts property is set to Yes; and 3) the Disable Switched
Shunt Control option on the Power Flow Solution tab of the Simulator Options Dialog must not be
checked.
Auto XF
Determines whether tapped transformers for the area are available for automatic control. You can
use this field to disable all the transformers in an area. Click on this field to toggle its value. Click on
the Toggle All Yes or Toggle All No local menu options to set all entries in this column. Note that
three conditions must be met for a transformer to be used for automatic control: 1) its Auto field
must be set to Yes (see Transformer Modeling for details); 2) its associated area’s Auto XF property
is set to Yes; and 3) the Disable Transformer Control option on the Power Flow Solution tab of the
Simulator Options dialog must not be checked.
Unspec. MW Inter.
Shows the total amount of interchange for the area that is listed as Unspecified. This means that
some of the interchange is known in magnitude and direction (import or export) but not which other
area(s) is involved in the interchange. The sum of all area’s unspecified interchange in the case must
equal 0 for a balanced system.
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Zone Display
The Zone Display provides information about all the zones in the case. Similar to the Area Display, the
Zone Display provides a means of dividing up a power system. System results can then be summarized
by zones using this display. Buses can be assigned to zones independent of their area assignments.
Thus a single area could contain multiple zones, or a single zone could span multiple areas. The zone
number for each bus is shown on the Bus Dialog. In the Edit Mode, groups of buses can be easily
moved from one zone to another using the Zone Dialog.
The Zone Records Display is a class of Case Information Display and therefore can be used in a
manner consistent with all other case information displays. It has a local menu from which you can
print, copy, and modify its records as well as view the information dialog of its associated zones. You
can call up the Quick Power Flow List or Bus View Display to obtain more information about a
representative bus in the zone. You can also sort the zone records by clicking on the heading of the
field by which you want to sort.
To show this display, click on Aggregations > Zones in the model explorer.
The display contains the following fields by default:
Zone Number, Zone Name
Zone’s number, between 1 and 9999, and its alphanumeric identifier. Simulator supports names of
any character length. However, when writing out names to file formats with limitations on name
length, the zone names will be truncated at their maximum supported length.
Load MW, Load MVR
Total real and reactive power load in the zone.
Gen (MW), Gen (Mvar)
Total real and reactive power generation in the zone.
Loss MW, Loss MVR
Total real and reactive power loss in the zone. Losses are computed by summing the losses of the
individual transmission lines and transformers in the zone. Because of shunt charging, these devices
can also generate reactive power. Therefore, reactive power losses may actually be negative.
Losses for tie-lines between zones are assigned to the zone in which the terminal bus that is NOT
the metered bus is contained. The Metered End field for a branch determines which of the
terminals is metered.
Int MW, Int Mvar
Net interchange of real and reactive power with all other zones. Exported power is assumed to be
positive.
Load Mult MW
Shows the current load MW multiplier for the zone. All load in the area is scaled by this multiplier.
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Tie Lines between Areas Display
The Tie Lines between Areas Display identifies all area tie lines in the case. Tie lines are not a separate
data record that can be created in Simulator, but instead provide a look at all the devices that connect
two areas together in the power system model. Tie lines are important because the Area Control
algorithms used by Simulator often enforce a constraint which requires that the sum of the flow on the
tie lines must equal the net export scheduled by the area (This is often called the ACE equation).
There are several types of devices that can represent tie lines. These include the following:







Transmission branch (Branch) : a transmission line or transformer that connects two buses that
belong to two different areas is a tie line.
Two-terminal DC transmission lines (DCLine) : a DC transmission line that connects two buses that
belong to two different areas is a tie line.
Multi-terminal DC transmission line (MTDCRecord) : For every multi-terminal DC transmission line
that has converters connected to more than one area is a tie line.
Load (Load): A load can be assigned to a different area than its terminal bus. This is not typical
but is sometimes done to model loads at lower voltage level where more than one entity has load
that connects to the same power system bus. In such a situation this load represents a tie line.
Generator (Gen): Similarly to the load, a generator can be assigned to a different area than its
terminal bus. Again this is considered a tie line.
Switched Shunt (Shunt): Similarly to the load, a switched shunt can be assigned to a different area
than its terminal bus. Again this is considered a tie line.

Note: The easiest way to see which loads, generators, or switched shunts are assigned in this way is
to use this Tie Lines between Areas Display. You can also, however, add separate columns using the
display/column options on the Load, Generator or Switched Shunt Case Information Display. For
instance, for loads there are columns for Area Num of Bus and Area Num of Load. Normally these are
equal, but they will not be for tie line loads.
Note: Be careful when working with cases opened as RAW files in which there are loads that represent
tielines. See PTI RAW Transactions due to tie-line load in Simulator Options: File Management for
more information.
The Tie Lines between Areas Display is a class of Case Information Display and therefore can be used
in a manner consistent with all other case information displays. It has a local menu from which you
can print, copy, and modify its information as well as view the information dialog of its associated
device type. You can learn more about a particular shunt’s terminal bus by choosing either Quick
Power Flow List or Bus View. You can also sort the tie line information by clicking on the heading of
the field by which you want to sort. Additionally, you can choose to restrict the information shown by
the Tie Lines Display according to the constraints of the area/zone/owner filters.
To call up the Tie Lines between Areas Display, select Aggregation > Tie Lines between Areas
from the Model Explorer.
The Tie Lines between Areas Display contains the following fields by default:
Tie Type
Indicates type of device that the tie line represents: Branch, Load, Gen, Shunt, MTDCRecord, or
DCLine.
Near Area Name, Near Number, Near Name
The Bus Number, Name and Area Name of the bus to which the device is attached. For transmission
lines this is the near end of the device.
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Far Area Name, Far Number, Far Name
The Bus Number, Name and Area Name of the other end of the device.
Ckt
The circuit ID for transmission lines or DC Lines, the device ID for generators, loads, and switched
shunts.
Meter MW and Mvar
The MW and Mvar flow from the point represented by Near Number/Name towards the Far
Number/Name. For transmission lines and DC lines the metered point on the line is determined by
the Metered End which is stored with the device. For instance on a transmission line, there is a
check box for From End Metered which is available on the Branch Options (Edit Mode) dialog.
Changing this setting with the device will affect the Meter values slightly.
Status
This is the Open/Closed status of the tie line device.
Lim MVA
For tie lines that represent transmission lines this is the limit (rating) of the device.
MW and Mvar Loss
For tie lines that represent transmission lines this is the MW and Mvar loss across the device.
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Tie Lines between Zones Display
The Tie Lines between Zones Display is essentially identical to the Tie Lines between Areas Display.
The only difference is that it displays devices that connect two zones together instead of areas. See
the Tie Lines between Areas Display for more details.
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Super Area Display
The Super Area Display identifies any super areas that have been defined for the case. Super areas
are groups of areas whose generators are dispatched as a coordinated group. Super areas can thus be
useful for modeling the operation of independent system operators or power pools.
Super areas cannot be inserted into a case from the Individual Insert ribbon group on the Draw ribbon
tab. Instead, a super area can be defined when modifying or creating an area simply by typing the
name of a new super area in the Super Area dropdown box on the Area Information Dialog.
The Super Area Records Display is a class of Case Information Display and therefore can be used in a
manner consistent with all other case information displays. It has a local menu from which you can
print, copy, and modify its records as well as view the information dialog of its associated super areas.
You can call up the Quick Power Flow List or Bus View Display to obtain more information about
representative bus in the super area. You can also sort the super area records by clicking on the
heading of the field by which you want to sort.
To show this display select Aggregation > Super Areas in the Model Explorer.
The display contains the following fields by default:
Super Area
The name of the super area.
AGC Status
The Super Area may operate without automatic generation control (AGC Status = Off AGC), with
participation factor control (AGC Status = Part. AGC), or according to an economic dispatch (AGC
Status = ED). This is a toggleable field.
Use Area PF
Indicates whether to use the areas participation factors when the super area is to operate with
participation factor control (Part. AGC).
Num Areas
Indicates the number of areas defined as being part of the super area. Areas are added to super
areas using the Super Area dropdown box on the Area Information Dialog.
Gen MW
Total MW injection from all the generators in the super area.
Load MW
Total MW load demanded in the super area.
Tot Sched MW
Total scheduled MW interchange with other areas or super areas.
ACE MW
The area control error in MW. This is the amount of MW flow difference between the actual MW
interchange and the desired MW interchange. A positive value means the super area is generating
and exporting excess MW's, and a negative value means the super area is under-generating and
importing too many MW's.
Lambda
The super area’s marginal cost.
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Loss MW
Indicates the real power losses incurred within the super area.
ED Use PF
Indicates whether the power flow engine will calculate loss penalty factors in computing the
economic dispatch solution for the super area. If loss penalty factors are not calculated, then the
economic dispatch is calculated assuming that the super area is lossless. Otherwise, the economic
dispatch solution incorporates losses. The penalty factors gauge the sensitivity of the area’s losses to
changing injection at specific generators. The option to calculate loss penalty factors is relevant only
when the super area operates according to Economic Dispatch Control. Usually, if the system’s cost
curves are relatively flat, the inclusion of losses in the solution will not have much of an effect on the
dispatch.
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Bus Display
The Bus Display presents data describing each bus in the case. The Bus Display is a class of Case
Information Display and therefore can be used in a manner consistent with all other case information
displays. It has a case information toolbar from which you can print, copy, and modify its records as
well as view the information dialog of its associated bus. You can also sort the bus records by clicking
on the heading of the field by which you want to sort. Additionally, you can choose to restrict the
records shown by the Bus Records Display according to the constraints of the area/zone/owner filters.
Finally, when Simulator is in Edit Mode, the case information toolbar allows you to add new buses to or
remove existing buses from the system.
To show the bus records display, select Network > Buses from the Model Explorer or from the Case
Information ribbon group under the Case Information ribbon tab.
By default, the bus records display contains the following fields:
Number and Name
Bus number between 1 and 2,147,483,647 (equals 2^31 minus 1), and its alphanumeric identifier.
Area Name
Alphanumeric identifier of the bus’ area.
Nom kV
The nominal base voltage of the bus in kV.
PU Volt
Bus’ per unit voltage magnitude.
Volt (kV)
Bus’ actual voltage magnitude in kV. This is the per unit voltage magnitude multiplied by the bus’
nominal voltage.
Angle (Deg)
Bus’ voltage angle in degrees.
Load MW, Load Mvar
Total real and reactive load at the bus. If no loads are located at the bus, these fields are blank.
Gen MW, Gen Mvar
Total real and reactive generation at the bus. If no generators are located at the bus, these fields
are blank.
Switched Shunt Mvar
Total switched shunt device reactive power injection at the bus.
Act G Shunt MW, Act B Shunt Mvar
Total real and reactive fixed bus shunt injections.
Area Num
The area number in which the bus is located.
Zone Num
The zone number in which the bus is located.
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Bus Mismatches Display
The Bus Mismatches Display lists the real and reactive mismatches at each bus. The bus mismatches
are defined as the difference between the power entering the bus and the power leaving the bus. A
power flow case is considered solved when all the bus mismatches are below the convergence
tolerance specified on the Power Flow Solution page of the Simulator Options dialog.
Most of the time you will not need to be concerned about the bus mismatches. If the power flow
solves, the mismatches are guaranteed to be below the desired tolerance. However, advanced users
will find this display useful in determining the cause when a power flow diverges.
The Bus Mismatch Display is a class of Case Information Display and therefore can be used in a
manner consistent with all other case information displays. It has a case information toolbar from
which you can print, copy, and modify its information as well as view the information dialog of its
associated bus. You can find a specific bus mismatch using the name or number of the bus, and you
can learn more about the bus by choosing either Quick Power Flow List or Bus View. You can also sort
the bus mismatch information by clicking on the heading of the field by which you want to sort.
To show this display select Solution Details > Mismatches from the Model Explorer. You can view
bus mismatches only when the application is in Run Mode.
Also note that there is a special feature in the Records menu of the case information toolbar for the
mismatch display. This option is Zero-Out Mismatches. Choosing this options will cause Simulator to
insert fictitious B and G Bus Shunt values to force the mismatch at every bus to zero.
The Bus Mismatch Display contains the following fields by default:
Number, Name, Area Name
The number and name of the bus and the name of the area in which it is located.
MW Mismatch, MVR Mismatch, MVA Mismatch
The real and reactive mismatches at each bus, and the total complex power mismatch.
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Remotely Regulated Bus Display
The Remotely Regulated Bus Display provides information about all buses that are remotely regulated
by one or more generators, transformers, or switched shunts. The bus that a generator regulates is
specified in the Edit Mode using the Generator Dialog. Whenever a generator is regulating a bus that is
not its terminal, it is considered to be remotely regulating that bus. The bus that is remotely regulated,
along with the regulating generators, will appear on this display. The same logic is true for
transformers and switched shunts which may regulate remote buses also.
The Remotely Regulated Bus Display is a class of Case Information Display and therefore can be used
in a manner consistent with all other case information displays. It has a local menu from which you
can print, copy, and modify its information as well as view the information dialog of its associated
buses. You can find a specific remotely regulated bus, and you can learn more information about a
particular remotely regulated bus by choosing either Quick Power Flow List or Bus View. You can also
sort the remotely regulated bus information by clicking on the heading of the field by which you want
to sort. Additionally, you can choose to restrict the information shown by the Load Display according to
the constraints of the area/zone/owner filters.
To call up the Remotely Regulated Bus Display, open the Model Explorer and select Remotely
Regulated Buses under the Solution Details folder.
This Remotely Regulated Bus Display contains the following fields by default:
Number, Name, Area Name
Number, name, and area name for the bus that is being remotely regulated.
PU Volt
Per unit voltage magnitude for the bus.
Set Volt
Setpoint voltage for the bus. When a bus is being remotely regulated by a set of generators, the
generators vary their reactive power output to maintain the voltage at the bus at the setpoint value.
You can enter a new value for this field. Changing the setpoint voltage here changes the setpoint
voltage for all the generators that are remotely regulating this bus.
Volt Diff
Per unit difference between the actual voltage magnitude and the set point voltage magnitude.
AVR
Combined automatic voltage regulation (AVR) status for all the generators remotely regulating this
bus. If AVR is No, no generators regulate voltage; if AVR is Yes, all the available generators are
regulating; if AVR is Mixed, some generators regulate voltage and some do not. Regulation of
individual generators can be specified using the Generator Display . You can toggle this field
between "Yes" and "No" by clicking on it.
Total Mvar
Total of the reactive power being supplied by all the generators remotely regulating the bus.
MVR Min, MVR Max
Total of the minimum and maximum reactive power limits for all the generators remotely regulating
the bus.
Remote Regs (gen)
Provides a comma-separated list of all the generators which regulate this bus.
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Rem Regs (XFMR)
Provides a comma-separated list of all the transformers which regulate this bus.
Rem Regs (SS)
Provides a comma-separated list of all the switched shunts which regulate this bus.
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Substation Records Display
The Substation Records Display presents data describing each substation in the case. The Substation
Display is a class of Case Information Display and therefore can be used in a manner consistent with
all other case information displays. It has a local menu from which you can print, copy, and modify its
records as well as view the information dialog of its associated substation. You can also sort the
substation records by clicking on the heading of the field by which you want to sort. Additionally, you
can choose to restrict the records shown by the Substation Records Display according to the
constraints of the area/zone/owner filters. Finally, when Simulator is in Edit Mode, the local menu
allows you to add new substations to or remove existing substations from the system. Note: a
substation is considered in an area/zone if any single bus in the substation is in the area/zone.
To show the substation records display, select Aggregation > Substations in the Model Explorer.
By default, the substation records display contains the following fields:
Sub Num
An integer identifier for the substation.
Sub Name, Sub ID
Two alphanumeric identifiers for the substation.
Area Name, Zone Name
The names of the area and zone of the buses in the substation. If some of the buses in the
substation are in different areas or zones, then this is the most common area or zone.
# of Buses
The number of buses inside the substation.
Nom kV
Nominal kV of the highest voltage bus(es) in the substation.
Gen MW, Gen MVR
Total real and reactive generation at the substation. If no generators are located at the substation,
these fields are left blank.
Load MW, Load MVR
Total real and reactive load at the substation. If no loads are located at the substation, these fields
are left blank.
Shunt MW, Shunt MVR
Total real and reactive shunt values at the substation. If no shunts are located at the substation,
these fields are left blank.
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Generator Display
The Generator Display presents data describing each generator in the case. The Generator Display is a
class of Case Information Display and therefore can be used in a manner consistent with all other case
information displays. It has a local menu from which you can print, copy, and modify its records as
well as view the information dialog of its associated generators. The Quick Power Flow List and Bus
View Display tools are available for finding more information on the generator’s terminal bus. You can
also sort the generator records by clicking on the heading of the field by which you want to sort.
Additionally, you can choose to restrict the records shown by the Generator Records Display according
to the constraints of the area/zone/owner filters. Finally, you can use the local menu’s Insert and
Delete options when the application is in Edit Mode to insert a new generator into the case or to delete
an existing generator.
To show the generator records display, select Network > Generators from the Model Explorer.
By default, the generator records display contains the following fields:
Number, Name
Number and name of the bus to which the generator is attached. The display’s local menu offers you
the opportunity to view the Quick Power Flow List and the Bus View Display for the bus.
ID
Single character ID used to distinguish multiple generators at the same bus. This default value for
this field is ‘1’.
Status
Displays the Open / Closed status of the generator. This field is a toggleable field.
Gen MW, Gen Mvar
The real and reactive power output of the generator. If the generator is on AVR control, the reactive
power is set automatically.
Set Volt
Per unit setpoint voltage for the generator. When a generator is on AVR control, the reactive power
output of the generator is varied automatically in order to maintain the regulated bus voltage at this
value. The regulated bus is usually, but not always, the generator’s terminal bus. Use the Generator
Dialog to see the regulated bus number.
AGC
Designates whether the generator’s real power output is governed by automatic generation control.
If the AGC field is set to Yes, the generator is on automatic generation control (AGC). When a
generator is on AGC, its real power output can be varied automatically. Usually the purpose for AGC
is to keep the area interchange at a desired value. You can click on this field to toggle its value
(except in Viewer). Please see Area Control for more details.
AVR
Designates whether the generator will vary its reactive power output to maintain a constant terminal
voltage. If the AVR property is set to Yes, the generator is on automatic voltage regulation (AVR)
control. When a generator is on AVR control, its reactive power output is varied automatically to
keep the regulated bus voltage at the Set Volt value. AVR is limited by the generator’s reactive
power limits. You can click on this field to toggle its value (except in Viewer).
Min MW, Max MW
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Minimum and maximum allowable real power output of the generator.
Min Mvar, Max Mvar
Minimum and maximum allowable reactive power output of the generator.
Cost Model
The type of cost model the generator is currently set to use. Cost models are necessary for
performing economic analysis, such as Economic Dispatch or Optimal Power Flow.
Part. Factor
Generator’s participation factor. Participation factors are used to determine how AGC generators
participate in area control when their area is on participation factor control. Please see Area Control
for more details.
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Generator Economic Curves
Four characteristic curves describe the efficiency and resulting costs associated with operating a
particular generating unit. These four curves plot





Fuel Cost
Heat Rate
Input-Output
Incremental Cost

Simulator can display plots of all these curves. To display a particular plot for a generator, right-click
on the generator in Run Mode to display its local menu, and then select the plot you wish to see. The
plot will be presented in its own window. The windows for all plots exhibit identical characteristics. For
example, the current operating point is identified by a red filled circle. Right clicking on an open area
of the window displays the plot’s local menu which allows you to print the plot, save it to a file, or copy
it to the clipboard for use in other programs. To adjust the length and number of intervals shown on
an axis, right-click on the axis (not on the numbers) then specify the min and max display values and
number of intervals. To close a plot window, simply click the X button in its top right corner.
The Run Mode generator local menu also provides access to a fifth type of plot curve - the "All Area
Gen IC Curves" plot. This plot simply shows the incremental cost curves and present operating points
of all generators in the same area as the generator on which you clicked.
Fuel Cost Curve
The fuel cost curve specifies the cost of fuel used per hour by the generating unit as a function of
the unit’s MW output. This is a monotonically increasing convex function.
Heat-rate Curve
The heat rate curve plots the heat energy required per MWH of generated electrical output for the
generator as a function of the generator’s MW output. Thus, the heat rate curve indicates the
efficiency of the unit over its operating range. Generally, units are least efficient at the minimum and
maximum portions of their MW output capability and most efficient somewhere in the middle of their
operating range. The vertical axis is plotted in MBtu/MWH and the horizontal axis is plotted in MW.
You may interpret the heat rate for a generator producing X MW as follows: the heat rate indicates
the amount of heat input energy per MWH of generation required to produce X MW of power. The
lower this number, the less input energy is required to produce each MWH of electricity.
Input-Output Curve
The input-output curve is derived simply from the heat-rate curve by multiplying it by the MW output
of the unit. This yields a curve showing the amount of heat input energy required per hour as a
function of the generator’s output.
Incremental Cost Curve
By multiplying the input-output curve by the cost of the fuel in $/MBTU, one obtains the cost curve
for the unit in $/hr. By taking the derivative of the cost curve, one obtains the incremental cost
curve, which indicates the marginal cost of the unit: the cost of producing one more MW of power at
that unit.
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Generator/Load Cost Models
The Generator/Load Cost Models option from the Case Information menu allows you to choose to view
detailed information on generator cost curves or load benefit curves. This cost information can be very
important when solving an Optimal Power Flow or Security Constrained Optimal Power Flow solution.
The Generator/Load Cost Models option has four submenu options to choose from:
Generator Cubic Cost Models
Generator Piecewise Linear Cost Models
All Generator Cost Models
All Load Benefit Models
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Generator Cost Models Display
The Generator Cost Models Display presents detailed cost information for each generator in the case,
regardless of what type of cost curve has been entered for the generator. The Generator Cost Models
Display is a class of Case Information Display and therefore can be used in a manner consistent with
all other case information displays. It has a local menu from which you can print, copy, and modify its
records as well as view the information dialog of its associated generators. The Quick Power Flow List
and Bus View Display tools are available for finding more information on the generator’s terminal bus.
You can also sort the generator records by clicking on the heading of the field by which you want to
sort. Additionally, you can choose to restrict the records shown by the Generator Cost Models Display
according to the constraints of the area/zone/owner filters. Finally, you can use the local menu’s Insert
and Delete options when the application is in Edit Mode to insert a new generator into the case or to
delete an existing generator.
To show the generator piecewise linear and cubic cost model display, select Network > Generators
> Cost Curves All from the Model Explorer.
By default, the generator records display contains the following fields:
Number, Name
Number and name of bus to which the generator is attached.
Area Name of Gen
Name of the area to which the generator belongs. The generator can be assigned to an area
different than the area to which its terminal bus is assigned.
ID
Single character ID used to distinguish multiple generators at the same bus; ‘1’ by default.
Status
The Open / Closed status of the generator. This is a toggleable field.
AGC
Designates whether the generator’s real power output is governed by automatic generation control.
If the AGC field is set to Yes, the generator is on automatic generation control (AGC). When a
generator is on AGC, its real power output can be varied automatically. Usually the purpose for AGC
is to keep the area interchange at a desired value. You can click on this field to toggle its value
(except in Viewer). Please see Area Control for more details.
Gen MW
Current real power output of the generator.
Min MW
Minimum MW output of the generator.
Max MW
Maximum MW output of the generator.
Cost Model
The type of model this generator is currently using. Can be Cubic, Piecewise Linear or None.
IOA, IOB, IOC, IOD
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Parameters used to model the cost characteristic of the generator. Please see Generator Cost
Information for details. Please note that these values can be saved/loaded using the Generator Cost
Data auxiliary file.
These fields will be disabled unless the Cost Model type is set to Cubic.
Fuel Cost
The fuel cost of the type of fuel for the generator.
Variable O&M
Operations and Maintenance costs for the generator.
This field will be disabled unless the Cost Model type is set to Cubic.
Fuel Type
An informational field that can be set to the type of fuel the generator uses.
Unit Type
An informational field that can be set to reflect the type of unit the generator is, such as combined
cycle, steam, hydro, etc.
Cost Shift $/MWh, Cost Multiplier
The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the purpose
of assessing how variations in bids impact profit. The cost function is affected based on the following
equation:
(Original Cost Function + Cost Shift) * Cost Multiplier
Fixed Cost
The fixed operating cost of the generator.
MWh Break x, MWh Price x
The remainder of the display is populated with MWh Break and MWh Price pairs. These pairs define
the break points of the piecewise linear curve. The MWh Break value is a MW output value of the
generator. The MWh Price value is the corresponding marginal cost of producing an additional MW
of power at that MW output level. Therefore entering the break points of the piecewise linear curve
in this manner defines the slopes of the next section of the curve, starting at the current MW Break
point and up to but not including the next defined break point. The last MWh Break and MWh Price
pair defined will define the marginal price of the unit from that break point location to the maximum
output of the generator.
A requirement of the piecewise linear cost curve is that it must be convex, meaning the next MWh
Price must be higher than the previous MWh Price.
These fields will be disabled unless the Cost Model type is set to Piecewise Linear.
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Generator Cubic Cost Display
The Generator Cubic Cost Display presents detailed cost information for each generator in the case set
to use a cubic cost model. The Generator Cubic Cost Display is a class of Case Information Display and
therefore can be used in a manner consistent with all other case information displays. It has a local
menu from which you can print, copy, and modify its records as well as view the information dialog of
its associated generators. The Quick Power Flow List and Bus View Display tools are available for
finding more information on the generator’s terminal bus. You can also sort the generator records by
clicking on the heading of the field by which you want to sort. Additionally, you can choose to restrict
the records shown by the Generator Cubic Cost Display according to the constraints of the
area/zone/owner filters. Finally, you can use the local menu’s Insert and Delete options when the
application is in Edit Mode to insert a new generator into the case or to delete an existing generator.
To show the generator cubic cost display, select Network > Generators > Cost Curves Cubic
from the Model Explorer.
By default, the generator records display contains the following fields:
Number, Name
Number and name of bus to which the generator is attached.
Area Name of Gen
Name of the area to which the generator belongs. The generator can belong to an area which is
different than the area of which its terminal bus is a member.
ID
Alphanumeric ID used to distinguish multiple generators at the same bus; ‘1’ by default.
Status
The Open / Closed status of the generator. This is a toggleable field.
AGC
Designates whether the generator’s real power output is governed by automatic generation control.
If the AGC field is set to Yes, the generator is on automatic generation control (AGC). When a
generator is on AGC, its real power output can be varied automatically. Usually the purpose for AGC
is to keep the area interchange at a desired value. You can click on this field to toggle its value
(except in Viewer). Please see Area Control for more details.
Gen MW
Current real power output of the generator.
IOA, IOB, IOC, IOD
Parameters used to model the cost characteristic of the generator. Please see Generator Cost
Information for details. Please note that these values can be saved/loaded using the Generator Cost
Data auxiliary file.
Fuel Cost
The fuel cost of the type of fuel for the generator.
Variable O&M
Operations and Maintenance costs for the generator.
Fuel Type
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An informational field that can be set to the type of fuel the generator uses.
Unit Type
An informational field that can be set to reflect the type of unit the generator is, such as combined
cycle, steam, hydro, etc.
Cost Shift $/MWh, Cost Multiplier
The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the purpose
of assessing how variations in bids impact profit. The cost function is affected based on the following
equation:
(Original Cost Function + Cost Shift) * Cost Multiplier
Cost $/Hr
Operating cost for the generator in $/hr.
IC
Incremental cost to produce an additional MWh. This can be expressed as dC(Pgi)/dPgi, where C
denotes the generator’s cost of operation in $/hr and Pgi expresses the current MW output of the
unit. In a lossless system, the incremental dispatch is equal to the generator’s lambda value.
LossSens
Area loss sensitivity - This field is only calculated when the generator’s area is on economic
dispatch control. This field specifies the incremental change in area losses if this generator were
to produce one more MW, with the excess generation absorbed by the system slack. This
may be expressed as Ploss/Pgi. The loss sensitivity is used in calculating the generator’s lambda
value for the economic dispatch activity.
Generator MW Marg. Cost
The marginal cost of the generator supplying an additional MW of power to the system.
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Generator Piecewise Linear Cost Display
The Generator Piecewise Linear Cost Display presents detailed cost information for each generator in
the case set to use a piecewise linear cost model. The Generator Piecewise Linear Cost Display is a
class of Case Information Display and therefore can be used in a manner consistent with all other case
information displays. It has a local menu from which you can print, copy, and modify its records as
well as view the information dialog of its associated generators. The Quick Power Flow List and Bus
View Display tools are available for finding more information on the generator’s terminal bus. You can
also sort the generator records by clicking on the heading of the field by which you want to sort.
Additionally, you can choose to restrict the records shown by the Generator Piecewise Linear Cost
Display according to the constraints of the area/zone/owner filters. Finally, you can use the local
menu’s Insert and Delete options when the application is in Edit Mode to insert a new generator into
the case or to delete an existing generator.
To show the generator piecewise linear cost display, select Network > Generators > Cost Curves
Linear in the Model Explorer.
By default, the generator records display contains the following fields:
Number, Name
Number and name of bus to which the generator is attached.
Area Name of Gen
Name of the area to which the generator belongs. The generator can belong to an area which is
different than the area of which its terminal bus is a member.
ID
Alphanumeric ID used to distinguish multiple generators at the same bus; ‘1’ by default.
Status
The Open / Closed status of the generator. This is a toggleable field.
AGC
Designates whether the generator’s real power output is governed by automatic generation control.
If the AGC field is set to Yes, the generator is on automatic generation control (AGC). When a
generator is on AGC, its real power output can be varied automatically. Usually the purpose for AGC
is to keep the area interchange at a desired value. You can click on this field to toggle its value
(except in Viewer). Please see Area Control for more details.
Gen MW
Current real power output of the generator.
Min MW
Minimum MW output of the generator.
Max MW
Maximum MW output of the generator.
Fuel Cost
The fuel cost of the type of fuel for the generator.
Fuel Type
An informational field that can be set to the type of fuel the generator uses.
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Unit Type
An informational field that can be set to reflect the type of unit the generator is, such as combined
cycle, steam, hydro, etc.
Cost Shift $/MWh, Cost Multiplier
The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the purpose
of assessing how variations in bids impact profit. The cost function is affected based on the following
equation:
(Original Cost Function + Cost Shift) * Cost Multiplier
Fixed Cost
The fixed operating cost of the generator.
MWh Break x, MWh Price x
The remainder of the display is populated with MWh Break and MWh Price pairs. These pairs define
the break points of the piecewise linear curve. The MWh Break value is a MW output value of the
generator. The MWh Price value is the corresponding marginal cost of producing an additional MW
of power at that MW output level. Therefore entering the break points of the piecewise linear curve
in this manner defines the slopes of the next section of the curve, starting at the current MW Break
point and up to but not including the next defined break point. The last MWh Break and MWh Price
pair defined will define the marginal price of the unit from that break point location to the maximum
output of the generator.
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Load Display
The Load Display presents data describing each load in the case. The Load Display is a class of Case
Information Display and therefore can be used in a manner consistent with all other case information
displays. It has a case information toolbar from which you can print, copy, and modify its information
as well as view the information dialog of its associated loads. The toolbar also affords the opportunity
to insert new loads into the model or to delete existing ones. Moreover, it enables you to invoke the
Quick Power Flow List and Bus View Display for the load’s terminal bus. You can also sort the load
information by clicking on the heading of the field by which you want to sort. Additionally, you can
choose to restrict the information shown by the Load Display according to the constraints of the
area/zone/owner filters.
To show the load display, select Network > Loads in the Model Explorer.
The load display contains the following fields by default:
Number, Name
Number and name of bus to which the load is attached.
ID
Two-character ID used to distinguish multiple loads at the same bus; ‘1’ by default.
Status
Either Closed if the load is connect to its bus, or Open if it is not. You can click on this field to toggle
its value. If the load is open, the entire load record is dimmed.
MW, Mvar, MVA
Total real, reactive, and complex power for the load. Loads may be voltage dependent. The total
load is the sum of the constant power, constant current, and constant impedance components. See
Load Information and Load Modeling for more information.
S MW, S MVAR, I MW, I MVR, Z MW, Z MVR
These six fields describe the composition of the load at the bus assuming 1 pu bus voltage. The
SMW and SMVAR fields indicate the constant power portion of the load, the component that does
not vary with bus voltage magnitude. The IMW and IMVR fields express the constant current part of
the load, which varies in proportion to the bus voltage magnitude. Finally, ZMW and ZMVR indicate
the constant impedance portion of the load, which varies with the square of the voltage. The sum of
the SMW, IMW, and ZMW fields yields the base MW load at the bus (assuming 1 pu voltage), and
the sum of the SMVR, IMVR, and ZMVR fields provides the base MVR load at the bus (assuming 1 pu
voltage). Please see Load Modeling for more details on how bus load is modeled.
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Load Benefit Models Display
The Load Benefit Models Display presents detailed cost information for each load in the case set to use
a piecewise linear benefit model. The Load Benefit Models Display is a class of Case Information
Display and therefore can be used in a manner consistent with all other case information displays. It
has a local menu from which you can print, copy, and modify its records as well as view the
information dialog of its associated loads. The Quick Power Flow List and Bus View Display tools are
available for finding more information on the load’s terminal bus. You can also sort the load records by
clicking on the heading of the field by which you want to sort. Additionally, you can choose to restrict
the records shown by the Load Benefit Models Display according to the constraints of the
area/zone/owner filters. Finally, you can use the local menu’s Insert and Delete options when the
application is in Edit Mode to insert a new load into the case or to delete an existing load.
To show the generator piecewise linear cost display, select Network > Loads > Benefit Curves
Linear in the Model Explorer.
By default, the generator records display contains the following fields:
Number, Name
Number and name of bus to which the load is attached.
Area Name of Gen
Name of the area to which the load belongs. The load can belong to an area which is different than
the area of which its terminal bus is a member.
ID
Alphanumeric ID used to distinguish multiple generators at the same bus; ‘1’ by default.
Status
The Open / Closed status of the load. This is a toggleable field.
AGC
Designates whether the generator’s real power output is governed by automatic generation control,
since effectively dispatching a load can be viewed as dispatching negative generation. If the AGC
field is set to Yes, the load is on automatic generation control (AGC). When a load is on AGC, its real
power output can be varied automatically. Usually the purpose for AGC is to keep the area
interchange at a desired value. You can click on this field to toggle its value (except in Viewer).
Please see Area Control for more details.
Gen MW
Current real power demand of the load.
Min MW
Minimum MW demand of the load.
Max MW
Maximum MW demand of the load.
Fixed Benefit
The fixed benefit of the load.
Benefit Model
The type of model this load is currently using. Can be either Piecewise Linear or None.
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MWh Break x, MWh Price x
The remainder of the display is populated with MWh Break and MWh Price pairs. These pairs define
the break points of the piecewise linear curve. The MWh Break value is a MW demand value of the
load. The MWh Price value is the corresponding marginal benefit of extracting an additional MW of
load at that MW output level. Therefore entering the break points of the piecewise linear curve in
this manner defines the slopes of the next section of the curve, starting at the current MW Break
point and up to but not including the next defined break point. The last MWh Break and MWh Price
pair defined will define the marginal benefit of the load from that break point location to the
maximum demand of the load.
A requirement of the piecewise linear benefit curve is that it must be concave, meaning the next
MWh Price must be lower than the previous MWh Price. In other words, as more load is supplied,
the less the benefit it is providing. This is how a load can be dispatched along with generation,
according to marginal costs (and marginal benefits.)
These fields will be disabled unless the Cost Model type is set to Piecewise Linear.
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Line and Transformer Display
The Line/Transformer Display presents data describing each transmission line and transformer in the
case. The Line/Transformer Display is a class of Case Information Display and therefore can be used in
a manner consistent with all other case information displays. It has a local menu from which you can
print, copy, and modify its information as well as view the information dialog of its associated
branches. The local menu also affords the opportunity to insert new lines or transformers into the
model or to delete existing ones. Moreover, it enables you to invoke the Quick Power Flow List and
Bus View Display for each branch’s terminal buses. You can also sort the line and transformer
information by clicking on the heading of the field by which you want to sort. Additionally, you can
choose to restrict the information shown by the Line/Transformer Display according to the constraints
of the area/zone/owner filters.
To show the line/transformer display, select Network > Branches Input or Network > Branches
State from the Model Explorer.
The contents of the display depends upon the application’s operating mode.
The line/transformer display shows the following fields by default:
From Bus Number and Name

From Bus number and name. For transformers, the from bus is the tapped side. Right-clicking on

either of these fields brings up the display’s local menu from which you may select Quick Power Flow
List or Bus View Display to obtain more information about the from bus.
To Bus Number and Name

To Bus number and name. Right-clicking on either of these fields brings up the display’s local menu
from which you may select Quick Power Flow List or Bus View Display to obtain more information
about the to bus.
Circuit
Two-character identifier used to distinguish between multiple lines joining the same two buses.
Default is ‘1’.
Status
The service status of the branch. This field is toggleable.
Branch Device Type
Identifier for the type of branch. Options are: Line, Series Cap, Breaker, Load Break Disconnect,
Disconnector, ZBR, Fuse, and Ground Disconnect. The type of branch can be changed through this
field except that a line cannot be changed from or to a Transformer. To make that change, use the
Branch Options dialog in Edit mode. The type of branch becomes very important when using
Integrated Topology Processing. Breakers and Load Break Disconnects are treated as special
switching devices which can be controlled automatically through special actions, such as "Open with
Breakers" and "Close with Breakers".
Xfrmr
Yes or no field signifying if the branch is a transformer or transmission line. This field cannot be
changed.
MW From, Mvar From, MVA From (State display default)
Real, reactive, and complex power flowing into the line at the from bus.
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In versions of Simulator prior to version 14, these values were always calculated based on the
present voltage at a bus and other branch parameters each time they were displayed. This means
that a user could change the bus voltage, or impedance, and see a corresponding change in the line
flow values. These values are no longer calculated each time that they are displayed. They are
updated following a power flow solution, loading in a case, following an update to the system due to
OPF control changes, and after creating an equivalent. The exception to this is that when loading in
a PowerWorld Binary (*.pwb) file and the flows are stored in the file, the stored flows will be
retained instead of updating them based on the present system state. The MW and Mvar values can
be set to user-specified values using an auxiliary file or pasting from Excel. This will allow the
contouring of flows based on some external source.
Four additional fields have been added that will update each time they are displayed. This means
that they will be updated following a voltage change for a bus or other relevant parameter (i.e.
impedance) change for a branch. These fields take on the functionality of the flow fields prior to
version 14 and are calculated each time that they are displayed. These fields are MW From
(Calculated), MW To (Calculated), Mvar From (Calculated), and Mvar To (Calculated). These fields
cannot be changed by the user.
Lim MVA, % of MVA Limit (Max) (State display default)
The current MVA limit of the branch, and the amount of the actual flow as a percentage of the MVA
limit.
MW Loss, Mvar Loss (State display default)
Real and reactive power losses on the transmission line or transformer. Since reactive power losses
include the effect of line charging, the reactive power losses may be negative.
R, X, B (Input display default)
Indicates the branch’s resistance, reactance, line charging susceptance in per unit on the system
base.
Lim A MVA, Lim B MVA, Lim C MVA (Input display default)
Identifies the first three limit settings. Five additional limits can be set, for which the columns can be
added using the Display/Column options from the local popup menu. All limits are expressed in MVA.
See Transformer Display for viewing transformer specific fields.
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Merge Line Terminals
A transmission line can be removed from a load flow case without losing the electrical connectivity of
the line's two terminal buses by merging the line terminals into a single bus. The command to merge
line terminals can be performed in two ways, and can only be invoked when Simulator is in Edit mode.
First, a MergeLineTerminals script command can be invoked in Script mode or from an auxiliary file.
The only parameter of the script command is a filter parameter, which must be populated with either
the name of an advanced filter (with the name in quotation marks) or with the text SELECTED (no
quotation marks.) If an advanced filter is given, Simulator will find all transmission lines that meet the
advanced filter definition, and will individually merge the line terminals of each line one at a time.
Simulator will retain the From bus information as the new merged bus information for each line, with
one exception. If a line was removed by merging its terminals that was the first or last segment of a
multi-section line, the multi-section line terminal bus information will always be retained as the new
merged bus.
The second way a line or lines can be chosen to have their line terminal buses merged is to select a
set of lines in the branches table of the model explorer, and to then right-click in the table and bring
up the popup menu. The option to Merge Terminals is located under the Branch Records submenu.
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Long Line Voltage Profile
Normally when using a power flow solution tool, you only look at the voltages at the terminal buses of
transmission lines. However, for transmission lines which have large shunt charging susceptance (B)
terms, the voltages at intermediate points of the transmission line can become much higher (or even
lower) than the terminal bus values. To see these voltages directly, Simulator provides a tool for
showing the Long Line Voltage Profile of a transmission line (or multi-section line).
You may show the voltage profile along
the length of a transmission line in two
ways. First on any oneline diagram
(including the Bus View), you may rightclick on a transmission line and choose
Show Long Line Voltage Profile.
Second on the Records menu of any case
information display showing transmission
branches, the will be an option to Show
Long Line Voltage Profile. If you
select multiple transmission lines, then
the dialog will show the voltage profile on
each transmission line.
After you have chosen to show the
voltage profile, a dialog will appear
showing a graph of the voltage profile for
each line selected. There will be a legend
with check boxes that allow you to hide
or show particular curves. The horizontal
axis will represent the percent length of
the transmission line. The vertical axis
will represent the per unit voltage at each
particular point along the transmission
line. A per unit voltage is calculated at
101 points along the transmission line
starting at 0%, 1%, ... up to 100% of the
length of the transmission line. The
voltage shown at 0% represents the
voltage at the FROM bus of the
transmission line. The voltage shown at
100% represents the voltage at the TO
bus of the transmission line. This is
shown in the figure below.
When showing show the voltage profile
across a multi-section line, each line
section is represented separately on the
plot and is shown in one of the "100
ranges" on the x-axis. For instance the
third line section will appear between
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200% and 300%. Also series caps and
transformers are shown as dotted lines
on these plots. This is shown in the
second figure below.
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To get exact details of what the voltage profile can be shown by clicking on the Show Profile Details
button. This will display a dialog as shown next.
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Of particular interest on the dialog that appears is the ability to export this data to Excel or text. This
can be done by going to Export and then choosing the Data tab as shown next. Clicking on the Save
button will then save the data to a CSV file.

You may also play with this dialog to see all the possibilities for customizing your plots as well as
printing them.
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Multi-Section Lines Display
To show this display select Aggregations > Multi-Section Lines in the Model Explorer.
The Multi-Section Line Display lists the multi-section lines that exist in the case. The Multi-Section Line
Display is used to functionally group a number of transmission lines together. They are usually used to
model very long transmission lines that require the use of multiple individual transmission line
information to be modeled accurately. Simulator then treats each multi-section line as a single device
with regard to line status. That is, changing the status of one line in the record changes the status of
the other lines in the record as well.
Each multi-section line record consists of the "from" bus, one or more "dummy" buses and the "to"
bus. Each dummy bus must have only two lines connected to it, each of which are members of the
multi-section line record. See Multi-Section Line Information for details.
The Multi-Section Line Display is a class of Case Information Display and therefore can be used in a
manner consistent with all other case information displays. It has a local menu from which you can
print, copy, and modify its information as well as view the information dialog of its multi-section line
information. The local menu also affords the opportunity to insert new multi-section lines into the
model or to delete existing ones when the application operates in the Edit Mode. Moreover, it enables
you to invoke the Quick Power Flow List and Bus View Display for the line’s terminal buses. You can
also sort the multi-section line information by clicking on the heading of the field by which you want to
sort. Additionally, you can choose to restrict the information shown by the Multi-Section Line Display
according to the constraints of the area/zone/owner filters.
While in Edit mode, the local menu allows three options that are specific to multi-section lines. The
options are found under the Multi-Section Line records menu item.
Show Long Line Voltage Profile
For more information on this see the Long Line Voltage Profile topic.
Merge Sections
Select this option to eliminate the selected multi-section line record and designate the section
lines as single line records.
Renumber Dummy Buses
This option allows renumbering/renaming the dummy buses that are part of a multi-section line
by loading a file that has the new designations. The file containing the renumbering should be a
text file in the following format:
frombus, tobus, circuit // this identifies the multi-section line
// frombus and tobus can either be bus numbers or name_nomkV combinations
dummybusnumber1, dummybusname1
dummybusnumber2, dummybusname2
frombus, tobus, circuit // this identifies another multi-section line
dummybusnumber1, dummybusname1
dummybusnumber2, dummybusname2
dummybusnumber3, dummybusname3
The file can either be space or comma delimited. A double slash can be used for a comment. A
line with three entries is assumed to be a multi-section line and any two entry lines following that
are assumed to be the dummy bus identifiers belonging to that multi-section line. Dummy buses
are read for a multi-section line until another three entry line is found, meaning that a new multisection line has been specified. Dummy buses are identified starting at the from bus of the multi253
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section line going to the to bus and that is the way that they should be entered in the file. If a
multi-section line matching the given identifiers cannot be found, all dummy buses after that
multi-section line record are ignored until a new multi-section line specification is found. If an
incorrect number of dummy buses is entered for a multi-section line, none of the dummy buses
will be updated. If the a dummy bus number is specified that matches an existing bus that is not
another dummy bus, no changes will be made for that dummy bus. If a dummy bus number is
specified that matches an existing bus that is another dummy bus, the other dummy bus will be
assigned to a new bus number and the current dummy bus will be assigned to the number
specified in the file.
The display contains the following fields by default:
NumberFrom, NameFrom
Number and name of the multi-section lines from bus. Right-clicking on one of these fields invokes
the display’s local menu from which you can select either Quick Power Flow List or Bus View Display
to find more information about the from bus.
NumberTo, NameTo
Number and name of the multi-section lines to bus. Right-clicking on one of these fields invokes the
display’s local menu from which you can select either Quick Power Flow List or Bus View Display to
find more information about the to bus.
Circuit
Two-character circuit identifier for the multi-section line.
Sections
Number of individual lines within the multi-section line record.
Allow Mixed Status
This value defaults to NO and means that all branches in the multi-section line must have the same
status. Setting this value to YES essentially means that the multi-section line is disabled so that
opening/closing a branch in the multi-section line will no longer automatically open or close the
other lines in the record.
Status
Current status of the record. Note, the status is Closed only if all the lines in the record are closed,
and is Open only if all the lines in the record are open. Otherwise the status is Mixed.

254
©2011 PowerWorld Corporation

Transformer Display
The Transformer Display identifies all transformers in the case. The data presented in the Transformer
Display supplements the data presented in the Line/Transformer Display by presenting transformerspecific information. Consult the Line/Transformer Display for the transformer flows.
The Transformer Display is a class of Case Information Display and therefore can be used in a manner
consistent with all other case information displays. It has a local menu from which you can print, copy,
and modify its information as well as view the information dialog of its associated transformer. You can
find a specific transformer using the names or numbers of its terminal buses, and you can learn more
about a particular transformer’s terminal buses by choosing either Quick Power Flow List or Bus View.
When in Edit Mode, you can delete an existing transformer from the case. You can also sort the
transformer information by clicking on the heading of the field by which you want to sort.
To show this display select Network > Transformers Controls in the Model Explorer.
The Transformer Display contains the following fields by default:
From Bus Number and Name

From Bus number and name. The From Bus is the tapped side. You may view either the Quick
Power Flow List or the bus view display for the From Bus from the local menu.
To Bus Number and Name

To Bus number and name. You may view either the Quick Power Flow List or the bus view display
for the To Bus from the local menu.
Circuit
Two-character identifier used to distinguish between multiple transformers joining the same two
buses.
Status
The service status of the transformer. This field is toggleable.
Type
Type of transformer. Possible values include
Fixed The tap positions are fixed
LTC The tap ratio changes to regulate bus voltage
Mvar The tap ratio changes to regulate reactive power flow
Phase The phase angle changes to regulate real power flow
Tap/Phase
Indicates the tap ratio for LTC and fixed transformers and the phase shift angle in degrees for
phase-shifting transformers.
XF Auto
If the value of this field is Yes, the transformer will automatically change its tap or phase angle to
keep the regulated value within the specified regulation range, provided that the Auto XF field of its
associated area is set to Yes and transformer tap/phase control has not been disabled for the entire
case. The Auto XF field of individual areas is set from the Area Display, and case-wide transformer
control can be set from the Power Flow Solution tab of the Simulator Options Dialog. Click on this
field to toggle its values.
Reg Bus
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For an LTC transformer, this is the number of the bus whose voltage is controlled by the
transformer. For phase shifting transformers, the real power is always controlled at the tapped bus.
Reg Value
For an LTC transformer, this is the present per unit voltage at the regulation bus. For a phase
shifting transformer, this is the present real power flow through the transformer measured on the
"from" (tapped) side.
Reg Error
The error is the difference between the regulated value and the respective limit of the regulation
range specified by Reg Min and Reg Max. If the regulated value is within the regulation range, then
the error is zero. The error is negative if the regulated value falls below the regulation range, and it
is positive if the regulated value exceeds the regulation range.
Reg Min, Reg Max
Minimum and maximum values for the regulation range. For LTC transformers, these fields represent
per unit voltage at the regulated bus. For phase shifting transformers, these fields represent actual
MW flow through the transformer measured on the "from" (tapped) side. Because transformers use
discrete control, the maximum regulation value must be somewhat greater than the minimum value.
Tap Min, Tap Max
For LTC transformers, these fields specify the minimum and maximum tap ranges for the
transformer. For phase shifting transformers, these fields specify the minimum and maximum phase
shift angle in degrees.
Step Size
The per unit step size for tap changing transformers. This step size is usually determined by dividing
the total range of transformer operation by the number of tap positions available.
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Three Winding Transformer Display
The Three Winding Transformer Display shows information about all the three winding transformer
devices in the case. Three winding transformers are modeled in Simulator as a grouping of two
winding transformers, connected at a common midpoint or "Star" bus. The Three Winding Transformer
Display is a way to view all the terminal connection points for the three winding transformers and the
power delivered at each of the terminals.
Depending on how the three winding transformer was loaded into Simulator, the star bus may be
dynamically created for the three winding transformer, with Simulator choosing the star bus number
and name. If the star bus numbers and names of three winding transformers need to be changed, an
option exists to load the new star bus numbers and names from a file. This option can be selected
from the Three-Winding Transformer display in the Model Explorer by right-clicking on the table and
choosing 3W Transformer Records > Renumber Star Buses while in edit mode. The format for
the text file is one record per row, with six fields for each record. The first four fields are primary bus
number, secondary bus number, tertiary bus number, and circuit ID. These fields identify for which
three winding transformer the star bus is being changed for that record. The last two fields for each
record will be the new star bus number and new star bus name. If the new bus number specified is
already in use in the case, the record will be ignored and the star bus will not be renumbered for that
three winding transformer record. Note that the first three fields can be specified as the "name_kv" of
each of the three winding transformer terminal buses instead of the bus numbers.
The Three Winding Transformer Display is a class of Case Information Display, and therefore can be
used in a manner consistent with all other case information displays. It has a local menu from which
you can print, copy, and modify its information as well as view the information dialog of its associated
three winding transformers. When in Edit Mode, you can define new three winding transformers using
the Insert option, or delete existing three winding transformers using Delete. You can also sort the
three winding transformer information by clicking on the heading of the field by which you want to
sort.
To show this display, open the model explorer and click on Network > Three Winding
Transformers.
This display contains the following fields by default:
Pri Bus Num, Sec Bus Num, Ter Bus Num
These are the primary winding, secondary winding and tertiary winding terminal bus numbers for
the three winding transformer connections.
Circuit
The circuit identifier for the three winding transformer.
Pri, Sec and Ter MW and MVAr
These fields display the real and reactive power delivered at each of the three winding transformer
terminals.
Star Bus Number and Name
These two fields provide the number and name of the internal node star bus used in the three
winding transformer equivalent model.
While in Edit mode, the local menu allows an option that is specific to three-winding transformers. The
option is found on the 3W Transformers records > menu item:
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Renumber Star Buses...
This option allows renumbering the star buses of three-winding transformers to user-specified
values. This is done via a text file that is loaded with the new designations. The format of the
text file is the following:

Primary bus, Secondary bus, Tertiary bus, circuit, new star bus number, new star bus name
Either the bus number or name_nominal kV (secondary key field) combination may be used to
identify the buses. Each bus may be identified using either method even for the same threewinding transformer. Use double slashes (//) to indicate a comment in the file. Any text past the
double slashes will be ignored. The file may be either space or comma delimited. If the tertiary
bus does not exist, this entry should be either a 0 or empty string enclosed in double quotes. If
the new star bus number already exists and is the star bus of another three-winding transformer,
the star bus number of the other three-winding transformer will be reassigned and the current
transformer will take the specified number. If the specified new star bus number already exists
and is not taken by another star bus, the three-winding transformer will not be updated with the
specified new star bus number.
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Line Shunts Display
The Line Shunts Display identifies all line shunt devices in the case. Line shunts are similar to switched
shunts in that they are used in power systems either to inject additional MVR into the system
(capacitive shunts) or to absorb excess reactive power (inductive shunts). However instead of being
connected to a bus directly, they are instead shunt connected to one of the terminals of a transmission
line. As a result they can only be in-service if the actual transmission line is in-service. Also, Simulator
also does not allow the automatic regulation of a bus voltage using Line Shunts as is possible using a
switched shunt. Simulator does however allow line shunts to be individually taken in and out of
service. This must be done manually however using the status field of the line shunt.
The Line Shunts Display is a class of Case Information Display and therefore can be used in a manner
consistent with all other case information displays. It has a local menu from which you can print, copy,
and modify its information as well as view the information dialog of its associated line shunts. You can
find a specific line shunt using its bus name or number, and you can learn more about a particular
shunt’s terminal bus by choosing either Quick Power Flow List or Bus View. When in Edit Mode, you
can insert a new line shunt into the case or delete an existing shunt. You can also sort the line shunt
information by clicking on the heading of the field by which you want to sort. Additionally, you can
choose to restrict the information shown by the Line Shunts Display according to the constraints of the
area/zone/owner filters.
To call up the Line Shunts Display, click Network > Line Shunts in the Model Explorer.
The Line Shunts Display contains the following fields by default:
From Number and To Number
Numbers of from and to bus of the transmission branch to which the line shunt is attached. Use the
right menu options to inspect either the Quick Power Flow List or the Bus View Display for the
terminal buses.
Circuit
Circuit identifier for the transmission branch to which the line shunt is attached.
Bus Number Located At
Either the From or To Bus number. Specified the end of the transmission branch to which the line
shunt is attached.
ID
A circuit identifier for the actual line shunt. This is needed because there can be multiple line shunts
at the same end of the same transmission line.
G, B
Indicates the line shunts nominal conductance and susceptance in per unit on the system base.
Status
Line shunts can be individually taken in and out of service. Do this by changing the status field to
Open or Closed.
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DC Lines Display
The DC Line Display presents data describing each dc line in the case. The DC Line Display is a class of
Case Information Display and therefore can be used in a manner consistent with all other case
information displays. It has a local menu from which you can print, copy, and modify its records as
well as view the information dialog of its associated dc lines. You can also sort the dc line records by
clicking on the heading of the field by which you want to sort. Additionally, you can choose to restrict
the records shown by the DC Line Records Display according to the constraints of the area/zone/owner
filters.
To show the dc line records display, select Network > DC Transmission Lines in the Model
Explorer, and click on the DC Lines tab.
By default, the dc line records display contains the following fields:
Number
Each dc line must be assigned a unique number, typically between 1 and 40.
Rect AC Number, Rect AC Name, Rect MW, Rect Mvar
Number and name of the rectifier bus, and the real and reactive power flow from the rectifier into
the dc line. You may right-click on any of the rectifier-related fields and select Quick Power Flow List
or Bus View from the local menu to view additional information about the rectifier bus.
Inv AC Number, Inv AC Name, Inv MW, Inv Mvar
Number and name of the inverter bus, and the real and reactive power flow from the inverter into
the dc line. You may right-click on any of the inverter-related fields and select Quick Power Flow List
or Bus View from the local menu to view additional information about the inverter bus.
Control Mode
Specifies how flow on the dc line is controlled. If this field is set to Power, then the line’s MW flow is
the control parameter. If the control mode is defined as Current, then the line’s current is the control
parameter.
Setpoint Magnitude, Setpoint Location
Specifies the initial value of the control parameter, which is expressed either in MW or in amps
depending on the dc line’s control mode. The Setpoint Location indicates if the setpoint should be
set at the Inverter or Rectifier end of the DC line.
Set kV
Specifies the voltage of the dc line in kV.
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Multi-Terminal DC Record Display
The Multi-terminal DC Line Display presents data describing each multi-terminal DC line in the case.
The Multi-Terminal DC Line Display is a class of Case Information Display and therefore can be used in
a manner consistent with all other case information displays. It has a local menu from which you can
print, copy, and modify its information as well as view the information dialog of its associated records.
The local menu also affords the opportunity to insert multi-terminal DC line records into the model or
to delete existing ones.
To show the Multi-Terminal DC Line display, select Network > DC Lines in the Model Explorer, and
click on the Multi-terminal DC Lines tab of the transformer case information display.
The Multi-terminal DC Line display shows the following fields by default:
Number
The record number of each multi-terminal DC record.
Num Conv
The total number of converters in each multi-terminal DC network.
Num Buses
The total number of DC buses in each multi-terminal DC network.
Num Lines
The total number of DC lines in each multi-terminal DC network.
Mode
The control mode of the multi-terminal DC network: 0 is Blocked control, 1 is Power control, and 2 is
Current control.
V. Cont. Bus
The number of the AC converter bus at which the DC voltage is controlled.
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Switched Shunt Display
The Switched Shunt Display identifies all switched shunt devices in the case. Switched shunts are used
in power systems either to inject additional Mvar into the system (capacitive shunts) or to absorb
excess reactive power (inductive shunts). They may also be used to regulate bus voltage within some
specified range.
The Switched Shunt Display is a class of Case Information Display and therefore can be used in a
manner consistent with all other case information displays. It has a local menu from which you can
print, copy, and modify its information as well as view the information dialog of its associated switched
shunts. You can find a specific switched shunt using its bus name or number, and you can learn more
about a particular shunt’s terminal bus by looking at the Bus View. When in Edit Mode, you can insert
a new shunt into the case or delete an existing shunt. You can also sort the switched shunt
information by clicking on the heading of the field by which you want to sort. Additionally, you can
choose to restrict the information shown by the Load Display according to the constraints of the
area/zone/owner filters.
To call up the Switched Shunt Display, select Network > Switched Shunts in the Model Explorer.
The Switched Shunt Display contains the following fields by default:
Number, Name
Number and name of terminal bus to which the switched shunt is attached. Not that multiple
switched shunts are allowed at a bus, however only one switched shunt can have a Control Mode
which is not fixed. Use the right menu options to inspect either the Quick Power Flow List or the Bus
View Displayfor the terminal bus.
ID
Circuit identifier for the switched shunt device.
Reg Bus Num.
Number of the bus whose voltage is regulated by the switched shunt. If the regulation bus is the
same as the terminal bus, this field is blank.
Status
The service status of the switched shunt. This field is toggleable.
Control Mode
Control Mode for the switched shunt. A switched shunt may operate either as Fixed if its reactive
value is to be held constant, as Discrete if its reactive output is controlled automatically in discrete
steps to regulate its terminal voltage, or as Continuous if its reactive injection is allowed to vary over
a continuous spectrum of values to regulate its terminal voltage. A shunt will be switched either
discretely or continuously to regulate its terminal bus’ voltage between its high and low voltage
limits provided the Auto Shunt field of its corresponding area is set to Yes and switched shunt
control has not been disabled for the entire case. You may set the value of the Auto Shunt field from
the Area Display, and you can control case-wide enforcement of shunt switching from the Power
Flow Solution tab of the Simulator Options Dialog. This Control Mode field is toggleable.
See Switched Shunt Control for more information on how switched shunt output is automatically
adjusted during power flow solutions.
Regulates
Can be set to regulate bus voltage, generator Mvar, or wind generator Mvar output.
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Actual Mvar
The reactive power currently supplied by the switched shunt.
Volt High
Per unit high-voltage limit for the regulation range. It is important for discrete shunt control that Volt
High exceed Volt Low by a nontrivial amount; otherwise, the output of the shunt may oscillate
during the Power Flow Solution.
Volt Low
Per unit low-voltage limit for the regulation range.
Reg Volt
Actual per unit voltage at the regulated bus. When Control Mode is either Discrete or Continuous,
this voltage should be between Volt Low and Volt High.
Deviation
Deviation of the regulated bus’ actual per unit voltage from the desired regulation voltage. If the
actual voltage is within the regulation range, this field is zero. If the voltage is greater than Volt
High, the deviation is positive. It is negative if the actual voltage is less than Volt Low.
Nominal Mvar
The Nominal Mvar field gives the initial amount of reactive power the device would supply (in Mvars)
if its terminal voltage were 1.0 per unit.
Max Mvar, Min Mvar
The maximum and minimum Mvar range for the switched shunt.
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Interface Display
The Interface Display is used to show the net real power (MW) flow on a group consisting of one or
more of the following devices: 1) transmission lines (AC and DC) and/or transformers, 2) total tie-lines
between two adjacent areas, 3) total tie-lines between two adjacent zones, 4) Generators and Loads,
5) Injection Groups, 6) multi-section lines, 7) other interfaces and 8) Contingency Actions . Interface
information is useful because secure power system operation often requires that the flow on such
groups be less than some limit value. For example, interface information could be used as "proxies" for
other types of security constraints, such as voltage or transient stability limitations. Another major
potential use for interfaces is in the Optimal Power Flow solution to monitor flows on groups of
devices, such as a set of transmission lines, generation leaving a plant, load demanded in a certain
region, etc. Interface information can also be extremely useful for summarizing the flows occurring on
a large network. Interface flows can be monitored using the Limit Monitoring Settings Display.
The Interface Display presents more detailed information for each interface that has been defined for
the case. The Interface Display is a class of Case Information Display and therefore can be used in a
manner consistent with all other case information displays. It has a local menu from which you can
print, copy, and modify its information as well as view the information dialog of its associated
interfaces. The local menu also affords the opportunity to insert new interface definitions either singly
(Insert) or as a group (Automatic Insertion) into the model or to delete existing ones. In addition,
PowerWorld has also added options for reading NERC flowgate files (Load NERC Flowgates) and
writing NERC flowgate files (Save NERC Flowgates) to the local menu.
You can sort the interface information by clicking on the heading of the field by which you want to
sort. Additionally, you can choose to restrict the information shown by the Interface Display according
to the constraints of the area/zone/owner filters.
To show the interface display, select Aggregations > Interfaces in the Model Explorer.
Interface information can be saved in the "*.aux" auxiliary file format. See Auxiliary Files for details.
The interface Display is divided into two tabs: Interface and Interface Elements.
Interface Elements Tab
The Interfaces Elements tab has a list of tabs which lists each types of element that can belong to
an interface. There is a check-box below in the middle of the display which allows you to Only show
elements that belong to at least one interface. As you select an element in the top half of the
display, the bottom half of the display will list each interface which contains the selected element.
Again, these provide a nice way to look through the elements that make up each interface.
Interface Tab
The Interfaces tab has a list of interfaces at the top of the display. When on the Interface tab, in the
bottom half of the tab is a set of subtabs which display all the elements of the presently selected
interface from the top half of the display. This set of sub tabs starts with the Elements tab which lists
all the elements of the interface regardless of the type of element. The remainder of the tabs each
lists the interface elements of a specific type of interface element such as Branches, Branch
Open/Close, DC Lines, Generators, Loads, Injection Groups, Multi-Section Lines and other interfaces.
These subtabs provide a nice way to look through the elements that make up each interface. The top
half of the Interface display contains the following fields:
Number
Numeric identifier for the interface.
Name
Alphanumeric identifier for the interface (24 characters maximum).
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Interface MW
Current MW flow on the interface. This flow is the sum total of the Base MW Flow and the
Contingent MW Flow.
MW Limit
Current rating for the interface in MW.
Percent
The actual MW flow on the interface as a percentage of the MW limit.
Monitor Direction
The current direction in which the MW flow is being monitored. The possibilities are From - To or To
- From.
Monitor Both
Toggle this field to Yes in order to monitor the flow on the interface in both directions, instead of a
single direction as designated by the Monitor Direction field.
Lim MW A, Lim MW B, Lim MW C
These three fields display the values of the three possible limits for the interface.
Has Contingency
This is a Yes or No field that will be set to Yes if any of the elements making up part of the interface
are at a device limit.
Contingent MW Flow
If the interface defined contains a contingency action, the Contingent MW Flow is the approximated
flow amount that would be added to the interface should the contingency occur.
Base MW Flow
The base MW flow is the flow on the interface prior to any considered contingency elements.
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Nomogram Display
The Nomogram Display is used to modify and create Nomogram definitions. Nomograms are
combinations of two interfaces for monitoring combined flows on the interfaces concurrently. These
Nomogram interfaces will have a limit definition that defines a region of allowed flow on the interfaces,
and can be monitored in many tools in Simulator as potential constraints, such as the contingency
analysis reporting of interface violations. Another major potential use for nomograms is in the Optimal
Power Flow solution to monitor the flow on a pair of interfaces. Nomogram information can also be
extremely useful for summarizing the flows on a pair of interfaces whose operation and allowed flow
are closely tied together. Nomogram flows can be monitored using the Limit Monitoring Settings
Display.
The Nomogram Display presents more detailed information for each nomogram that has been defined
for the case. The Nomogram Display is a class of Case Information Display and therefore can be used
in a manner consistent with all other case information displays. It has a local menu from which you
can print, copy, and modify its information as well as view the information dialog of its associated
nomograms.
You can sort the nomogram information by clicking on the heading of the field by which you want to
sort. Additionally, you can choose to restrict the information shown by the Interface Display according
to the constraints of the area/zone/owner filters.
To show the interface display, select Aggregations > Nomograms in the Model Explorer.
Nomogram information can be saved in the "*.aux" auxiliary file format. See Auxiliary Files for details.
The Nomogram display contains the following fields:
Name
Alphanumeric identifier for the nomogram.
Int A Flow
Current MW flow on the first interface of the interface pair forming the nomogram. This flow is the
sum total of the Base MW Flow and the Contingent MW Flow.
Int B Flow
Current MW flow on the second interface of the interface pair forming the nomogram. This flow is
the sum total of the Base MW Flow and the Contingent MW Flow.
% Limit, Max Nomo-interface
The actual MW flow on the nomogram as a percentage of the combined nomogram limit.
Monitor
Indicates whether or not the nomogram should be monitored either for violations or as a constraint
in the Optimal Power Flow.
Limit Group
The name of the limit group the nomogram is a member of for limit monitoring.
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Injection Group Display
The Injection Group Records Display presents data describing each injection group in the case. This
display is available by selecting Aggregations > Injection Groups from the Model Explorer. This
display is organized into two tabs with various sections available under each of the tabs. The tabs and
sections provide options for displaying information about injection groups and their associated
participation points in a manner in which it is most useful to the user. Injection groups can be
displayed with their associated participation points or participation points can be displayed with the
injection group to which they belong.
Injection Groups Tab
This tab is organized into a top and bottom section. The top section contains the Injection Groups
Case Information Display that lists all of the defined injection groups. The local menu is available by
right-clicking on the display and contains options available for most case information displays as well
as the option to Show Dialog to view the Injection Group Dialog.
By default, the Injection Groups Case Information Display contains the following fields:
Name
The name of the injection group. To change the name of an injection group, simply type a new
name in the corresponding cell.
Number of Gens
Identifies the number of generators contained in the injection group.
% MW Gen ParFac
Indicates the degree to which generators will contribute to the MW output of the injection group
relative to loads. An injection group that has a % MW Gen ParFac value of 100% receives all of its
output from generator points; an injection group that has a % MW Gen ParFac of 50% and a %
MW Load ParFac of 50% receives equal MW contributions from its constituent loads and
generators.
Number of Loads
Identifies the number of loads contained in the injection group.
% MW Load ParFac
Indicates the degree to which MW loads will contribute to the MW output of the injection group
relative to generators. An injection group that has a % MW Load ParFac value of 100% receives
all of its output from load points; an injection group that has a % MW Load ParFac of 50% and a
% MW Gen ParFac of 50% receives equal MW contributions from its constituent loads and
generators.
% Mvar Load ParFac
Indicates the degree to which Mvar loads will contribute to the Mvar output of the injection group
relative to switched shunts. An injection group that has a % Mvar Load ParFac value of 100%
receives all of its Mvar output from load points; an injection group that has a % Mvar Load ParFac
of 50% and a % Mvar Shunt ParFac of 50% receives equal Mvar contributions from its constituent
loads and switched shunts.
Number of Shunts
Identifies the number of switched shunts contained in the injection group.
% Mvar Shunt ParFac
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Indicates the degree to which switched shunts will contribute to the Mvar output of the injection
group relative to Mvar loads. An injection group that has a % Mvar Shunt ParFac value of 100%
receives all of its Mvar output from switched shunt points; an injection group that has a % Mvar
Shunt ParFac of 50% and a % Mvar Load ParFac of 50% receives equal Mvar contributions from
its constituent loads and switched shunts.
Total MW Injection
Indicates the current total MW injection of all elements in the injection group.
Total Mvar Injection
Indicates the current total Mvar injection of all elements in the injection group.
The bottom section contains additional tabs: Participation Points (All), Generators, Loads,
Switched Shunts, and Injection Groups. These tabs contain tables, which are variations of the
Participation Point Records Display, that list all of the individual participation points for the selected
injection group by element type. Participation points can be added, deleted, or modified for the
selected injection group from any of the tables on these tabs. The Participation Points (All) table
lists only the fields that are relevant for defining participation points while the specific element tables
also make available the fields that are specific to that element type.
The Generators, Loads, Switched Shunts, and Injection Groups tabs have the option to Show
points that are contained by other injection group points. This option is only relevant if an
injection group contains a participation point that is another injection group. When this option is
checked, the individual participation points that are contained in the injection group point will also be
displayed. The Contained by field will list the name of the injection group that contains a particular
participation point. When this option is not checked, the points displayed will be points that are
contained in the selected injection group only and no additional information will be provided about the
points contained inside any injection group points belonging to the selected injection group. If the
Contained by field is empty, this means that the participation point is explicitly defined with the
selected injection group and does not belong to it through an injection group point.
Participation Points Tab
This tab is organized into a top and bottom section. The top section contains tabs for Generators,
Loads, Switched Shunts, and Injection Groups. Tables on these tabs will list power system
elements of each particular type. If the option to Only show elements that belong to at least one
injection group is not checked, then all elements of each type in the case will be listed on one of
these tabs. If this option is checked, then only those elements that belong to an injection group will be
listed. The tables on these tabs are Case Information Displays for each particular type and have the
full functionality of case information displays.
The bottom section is an Injection Groups Case Information Display. When an element from one of the
tables in the top section of the tab is selected, this table will be populated with the list of injection
groups to which the selected element belongs.
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Injection Group Dialog
The Injection Group Dialog provides information about injection groups and allows their modification.
Specifically, the Injection Group Dialog lists the number of generators, loads, and switched shunts
contained in the group and the percentage contribution of generators, loads, and switched shunts to
the injection group’s output. The Injection Group Dialog also houses the Participation Points Records
display, from which points can be added and deleted from the injection group’s list of participants and
the various attributes of the points can be changed.
To view the Injection Group Dialog for a particular injection group, open the Injection Group Display
by selecting Aggregations > Injection Groups from the Model Explorer. Find the injection group of
interest in the Injection Groups Case Information Display and right-click on it. Then select Show
Dialog from the resulting local menu.
The Injection Group Dialog contains the following fields and controls:
Name
Identifies the injection group whose information is currently displayed. Selecting a different name
from this dropdown box will display information for another injection group.
New, Delete
To insert a new injection group from this dialog, press New, and supply the name for the new
injection group. To delete the injection group that is currently being shown, click Delete.
Save
Changes made to injection groups through the Injection Group Dialog are not immediately saved
with the power system case. This allows the option of canceling any changes without impacting the
case. Click the Save button to store any updates with the case.
# Gens
Displays the number of generators contained in the injection group.
# Loads
Displays the number of loads contained in the injection group.
# Shunts
Displays the number of switched shunts contained in the injection group.
% MW Gen Part., % MW Load Part., % MVR Load Part., % MVR Shunt Part.
Displays the relative contributions of generators, loads, and switched shunts to the output of the
injection group.
OK, Cancel
Changes made to the injection groups through the Injection Group Dialog are not immediately saved
with the power system case. This allows the option of canceling any changes without impacting the
case. Click Cancel to close the dialog without saving the changes. Click OK to close the dialog and
save the changes.
Participation Points
The tab on the bottom of the Injection Group Dialog lists the points that make up the injection group.
This display is called the Participation Point Records Display. By right-clicking on this display, points
can be added and deleted from the injection group. Properties of specific points can be changed by
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entering changes directly in the table. The Insert Points button will open the Add Participation Points
Dialog that can also be used for modifying the points.
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Participation Point Records Display
The Participation Point Records Display shows information about the points that comprise a particular
injection group. This display can be accessed for a particular injection group from the Injection Group
Dialog or the Injection Group Display.
The Participation Point Records Display is a class of Case Information Display and therefore can be
used in a manner consistent with all other case information displays. It has a local menu from which
participation points can be deleted or added to the injection group through the Add Participation Points
Dialog. Selecting Insert from the local menu will open the Add Participation Points Dialog that will
allow the addition, deletion, and modification of participation points in the injection group.
The Participation Point Records Display shows the following fields by default:
Point Type
Every participation point is a generator (GEN), load (LOAD), switched shunt (SHUNT), or injection
group (INJECTIONGROUP).
Number
Identifies the number of the bus to which a generator, load, or switched shunt is connected.
Name
Identifies the name of the bus to which a generator, load, or switched shunt is connected.
ID
Identifies the ID of the generator, load, or switched shunt or the name of the injection group.
AutoCalc?
If the value of AutoCalc is YES, the participation factor of the point is re-calculated with every use
to be consistent with the way the point’s participation factor was initially defined. If the value of
AutoCalc is NO, the participation factor is assumed fixed at its present value.
Initial Value
Indicates how the participation factor of the point was originally computed. For generators, the
possible values of this field are
SPECIFIED The participation factor was specified as a constant.
MAX GEN INC The participation factor was defined as the difference between the generator’s
maximum MW output and its present MW output.
MAX GEN DEC The participation factor was defined as the difference between the generator’s
present MW output and its minimum MW output.
MAX GEN MW The participation factor was defined as the maximum MW output of the generator.
For loads, the Initial Value property can assume only two possible values:
SPECIFIED The participation factor was specified as a constant.
LOAD MW The participation factor was defined as the size of the load in MW.
For switched shunts, the Initial Value property can assume four possible values:
SPECIFIED The participation factor was specified as a constant.
MAX SHUNT INC The participation factor was defined as the difference between the maximum
Mvar output of the switched shunt and its present nominal Mvar
output.
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MAX SHUNT DEC The participation factor was defined as the difference between the present
nominal Mvar output and the minimum Mvar output of the switched
shunt.
MAX SHUNT MVAR The participation factor was defined as the maximum Mvar output of the
switched shunt.
For injection groups, the Initial Value property can assume only one possible value:
SPECIFIED The participation factor was specified as a constant.
The Initial Value field is important if saving the injection groups to an auxiliary file and using them
with another case that might have a different generation dispatch or load profile. If the Initial
Value for a point is specified as GEN MAX INC, for example, and the point is loaded from an
auxiliary file into another case, Simulator will re-calculate the point’s participation factor to match the
generator’s positive MW reserve in that case.
The Initial Value field is also important if the AutoCalc field is set to YES, because AutoCalc uses
the rule defined by the Initial Value field to recalculate the participation factor with every use. For
example, if the Initial Value is MAX GEN INC and AutoCalc is YES, the point’s participation factor
will be updated to match the generator’s MW reserve every time the point is accessed.
When the value of the Initial Value field is toggled, the point’s participation factor, shown in the
ParFac field, will update to match the new definition. The Initial Value field must equal SPECIFIED
to be allowed to change the value of the point’s ParFac field by typing the new value directly into
the field.
If AutoCalc is NO and the injection group is not intended to be used with any other case, then the
Initial Value field should either be ignored or set to SPECIFIED.
ParFac
Indicates the participation factor of the participation point. The participation factor defines the
relative contribution of the point to the total output of the injection group. The load, generation, or
switched shunt change associated with each point is calculated based on the value of the
participation factor, with values for points having the largest participation factors experiencing the
greatest change.
The participation factor for injection group participation points indicates the relative contribution of
the entire injection group to the total output of the injection group to which it belongs. The
participation factors of the individual points in the injection group point further define the relative
contribution of these points to the total output of the injection group. The following two injection
groups provide an example of how injection group points impact the injection group to which they
belong when the points are normalized for use:
Injection Group 1

Injection Group 2

Gen 1, ParFac = 50 Gen 5, ParFac = 40
Gen 2, ParFac = 30 Load 1, ParFac = 20
InjectionGroup 2, ParFac = 20 Load 2, ParFac = 20
Total = 100

Total = 80

When Injection Group 1 is used, the participation factors are normalized so that each element
provides the following contribution:
Gen 1, Normalized ParFac = 50/100 = 0.5
Gen 2, Normalized ParFac = 30/100 = 0.3
Gen 5, Normalized ParFac = 20/100 * 40/80 = 0.1
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Load 1, Normalized ParFac = 20/100 * 20/80 = 0.05
Load 2, Normalized ParFac = 20/100 * 20/80 = 0.05
Total Normalized = 1.0
To add points to the injection group, right-click on the Participation Point Records Display and select
Insert from the local menu. This opens the Add Participation Points Dialog.
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Island Display
The Island Display presents information on the system’s islands. An island consists of a group of buses
that are electrically connected via ac transmission lines and transformers and thus operate in
synchronism with one another. Multiple islands can be connected together via dc transmission lines.
Each island requires a slack bus. All systems have at least one island, which may encompass the entire
system.
The Island Display is a class of Case Information Display and therefore can be used in a manner
consistent with all other case information displays. It has a local menu from which you can print, copy,
and modify its information. You can also sort the islands information by clicking on the heading of the
field by which you want to sort.
To show this display select Aggregations > Islands in the Model Explorer. The display is only
available in run mode.
You cannot modify any fields on this display.
The display has the following fields for each island:
Slack Bus Number, Slack Bus Name, Slack Bus Area
Number, name and area of the slack bus for the island. Each island requires at least one slack bus.
Total Buses
Total number of buses in the island.
Energized
Indicates whether the island is connected to a source of power.
Gen MW, Gen Mvar
Total real and reactive generation for the island.
Load MW, Load Mvar
Total real and reactive load for the island.
Scheduled Exports
The power scheduled to be provided by the island to other regions of the system. Because the island
is isolated from the rest of the system, this export requirement is currently not met.
DC MW Exports
The power provided by the island to other regions of the system across a DC line.
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MW Transactions Display
The MW Transactions Display is a quick way to view the defined base transactions between areas
within the load flow case.
The Matrix of Transactions display is set up as a matrix of transactions, with the areas listed as
both the column and row identifiers. It is important to note that the direction of the transaction is such
that the area represented by the row is assumed the exporting area, and the area represented by the
column is assumed the importing area. For example, if there is a 50 MW transaction from area one to
area two, you will see a +50 in the matrix in row 1, column 2. However, if you look at row 2, column
1, you will see a – 50. This is because the grid is displaying the EXPORT from area two to area one,
but since area two is importing, not exporting, the value is represented as negative.
Each row and column position, with the exception of the diagonal positions (it does not make sense for
an area to export to itself), can be directly modified by the user in this information display. As you type
a value in one of the matrix positions, Simulator automatically fills the symmetric matrix position with
the negative of the value you enter. This makes for a quick and easy location for adding and removing
transactions from the case.
Note that you cannot modify Unspecified transactions in the MW Transactions display. This makes
sense, as the unspecified transactions have only one associated area. To modify unspecified
transaction amounts, you must open the Area Information Dialog for the area you wish to modify, and
change the Unspecified transaction amount.
The List of Transactions is just another way of showing the transactions between areas. The List of
Transactions Display is a class of Case Information Display and therefore can be used in a manner
consistent with all other case information displays. It has a local menu from which you can print, copy,
or modify its records as well as view the information dialog of its associated areas. You can also sort
the area records by clicking on the heading of the field by which you want to sort.
Note that a special feature is available in the right-click local menu called Clear Transactions and
auto-insert tieline transactions. By choosing this option all MW transactions in the case will be
deleted, and all Unspecified MW transactions for each area will be set to zero. Then new MW
transactions will be created between each pair of areas that area directly connect to one another. The
amount of the new MW transactions will be set equal to the actual sum of the flow on the tielines
between the connected areas.
By default, the List of Transactions display contains the following fields:
Export Area Number, Export Area Name
Exporting area number and alphanumeric identifier.
Other Area Number, Other Area Name
Importing area number and alphanumeric identifier.
MW Transfer
Value of the transfer in MW.
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Transaction Dialog
The Transaction Dialog can be used to modify or create Base Interchange Transactions between two
areas. This dialog can be opened by right-clicking in the Base Interchange table of the Area
Information Dialog and choosing Show Dialog to see an existing transaction definition, or Insert to add
a new transaction.
The transaction dialog is divided into two pages of controls:
Information
Transacting Area
This is the "from" area for the transaction. For an export from this area, the transaction value will be
positive. For an import into the Exporting Area, the transaction value specified would be negative.
Flow out (export) of the exporting area is always considered positive.
Transaction To Area
This is the "to" area for the transaction.
Transaction ID
New in Simulator version 10 is the ability to have multiple transactions defined between the same
two areas. Because of this, it is now required that transactions also have a Transaction ID.
Rename Transaction ID
If you wish to change the transaction ID for a particular transaction, enter the new value in the
Transaction ID field, and press this button.
Switch Directions
Press this button if you wish to reverse the defined Exporter and Importer for the transaction.
Transaction MW Amount
The MW amount of the transaction being defined. This value should be positive for an export from
the Exporting area to the Importing area. The value can also be entered as negative to define a
transaction into the Exporting area from the Importing area.
Transaction Minimum MW
The minimum transaction amount between the two areas. This field is only enabled if the check box
labeled Transaction Dispatchable in OPF is checked.
Transaction Maximum MW
The maximum transaction amount between the two areas. This field is only enabled if the check box
labeled Transaction Dispatchable in OPF is checked.
Exports/Imports Transmission Charge
The cost to transfer power, in $/MWh. This adds an economic penalty for making the transfer,
making the transfer less likely to take place. Half the charge is assigned to the buyer and half to the
seller.
Transaction Enabled
Transaction can now be defined and either enabled or disabled. Any disabled transactions will be
ignored in both a standard power flow solution and an OPF solution.
Transaction Dispatchable in OPF
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Checking this box enables the transfer to be dispatched by the OPF algorithm. Dispatching the
transaction makes the two areas of the transaction appear to be one area for the purpose of
economically dispatching the generation in the two areas. The transaction can have a maximum and
minimum transfer amount when dispatchable, and a transmission charge associated with the
transaction.
Determine Price in OPF
Checking this box allows the OPF algorithm to determine the cost associated with the transfer. The
cost is determined by the marginal cost of enforcing the power balance constraint for the combined
areas. This is the typical way to implement a transfer if both areas are on OPF control. If only one of
the two areas are on OPF control, then the area which is off of OPF control needs to specify a price
for the transfer. This is done by explicitly defining a piecewise linear cost curve.
Piecewise Linear Transaction Cost Curve
These two curves are only enabled if the option Transaction is Dispatchable in OPF is checked
and the option Determine Price in OPF is unchecked. These two curves can be defined for the
purpose of assigning a price to the transfer of power between one area on OPF control and another
area which is not on OPF control. Separate curves can be defined for export transactions (from the
Exporter to the Importer) and import transactions. To add points to the curves, simply right-click in
the grid and choose Insert from the local menu. Enter the MW value and corresponding marginal
cost for the inserted breakpoint of the piecewise linear curve you are defining. To delete a point,
right-click on that row in the grid and choose Delete from the local menu.
Custom
The Custom page of the Transaction dialog is simply a location to log information about the
transaction in the Memo box, and to see the values (if any) stored in some of the custom fields for the
transaction. To log information about the transaction, simply switch to the Custom page on the dialog,
and start typing your information or comments about the transaction in the page, or enter custom
values in one of the custom fields.
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Owner Data Information Display
The Owner Data display will display the owners sorted by owner number, and show the total number
of devices, as well as a breakdown of the number of specific devices. The owner display will also
summarize the total device output or demand for the owned devices, such as generator output and
load demand.
You can right click on the owner grid to open the local menu, from which you can perform various
actions and view an informational regarding the owner selected in the grid. Once an owner dialog is
displayed for a particular owner, you can browse through information on all the owners.
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Owner Dialog
The Owner Dialog displays summary information about the devices designated as owned by the
selected owner.
The dialog for an individual owner displays each of the elements for that owner, along with the
percentage of ownership, in the device pages labeled Buses, Loads, Generators, and Lines.
The dialog also contains a memo page for making comments or notes about the selected owner.
General Info
Load and Generation
The information in the Load and Generation section provides a summary of the total injections of
the owned devices. This includes a total of all the load, generation, and shunt injections owned.
Summary of Owner Objects
This information section simply lists a total number of all owned devices. Note that buses and
loads do not currently have fractional ownership. However, generators and transmission lines do
have the capability to be partially owned by more than one owner. Therefore it is possible to see
fractional ownership amounts for the number or generators or lines.
Generator Costs and OPF Results
This information provides a summary of LMP and cost information determined by running an
Optimal Power Flow solution. The information provided is determined only for devices owned by
the selected owner.
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Owned Bus Records Display
The Owned Bus Records display is a Case Information Display that allows you many of the same
options as the Case Information Bus Display. In addition to the information available for viewing from
the Bus Display, the Owned Bus Records Display also shows the owner number and percentage of
ownership. Currently, Simulator only allows one owner per bus, so by default the ownership percent is
always 100%.
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Owned Load Records Display
The Owned Load Records display is a Case Information Display that allows you many of the same
options as the Case Information Load Display. In addition to the information available for viewing from
the Load Display, the Owned Load Records Display also shows the owner number and percentage of
ownership. Currently, Simulator only allows one owner per load, so by default the ownership
percentage is always 100%.
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Owned Generator Records Display
The Owned Generator Records Display is a Case Information Display that allows you many of the same
options as the Case Information Generator Display. In addition to the information available for viewing
from the Generator Display, the Owned Generator Records Display also shows the owner number and
percentage of ownership. Currently, Simulator allows up to four owners for one generator, with a total
percentage ownership between 0 and 100%. To make changes to the owners and ownership
percentages for a generator, right-click on the grid and choose Show Dialog and select the Owners,
Area, Zone tab.
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Owned Line Records Display
The Owned Line Records Display is a Case Information Display that allows you many of the same
options as the Case Information Line and Transformer Display. In addition to the information available
for viewing from the Line and Transformer Display, the Owned Line Records Display also shows the
owner number and percentage of ownership. Currently, Simulator allows up to four owners for one
generator, with a total percentage ownership between 0 and 100%. The make changes to the owners
and ownership percentages for a transmission line, right-click on the grid and choose Show Dialog and
select the Owners tab.
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Jacobian Display
The Jacobian display is a matrix showing the system Jacobian matrix for the currently loaded Simulator
case. This display can be very useful for educational purposes. Keep in mind that for a large case, this
display can contain a very large matrix. It is possible to right-click on this display and save the grid to
a Matlab formatted file, or to export the grid to an Excel spreadsheet. Be aware that a Jacobian matrix
from a large will often exceed the size limitations of an Excel spreadsheet.
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Ybus Display
The Ybus display (bus admittance matrix) is a matrix showing the system Ybus for the currently loaded
Simulator case. This display can be very useful for educational purposes. Keep in mind that for a large
case, this display can contain a very large matrix. It is possible to right-click on this display and save
the grid to a Matlab formatted file, or to export the grid to an Excel spreadsheet. However, Excel does
have limitations on the number of rows and columns that could quickly be exceeded with a Ybus from
a large case.
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Bus Information (Edit Mode)
This dialog is used to view/modify information about each bus in the system during Edit Mode. It is
very similar in content to its Run Mode counterpart.
Bus Number
Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the bus. You
can use the spin button immediately to the right of the number to move to the next bus (click the up
arrow) or the previous bus (click the down arrow).
If adding a new bus to the one-line display, this dialog will open after selecting the location of the
bus display object. This dialog can be used to add a bus to the one-line for buses that already exist
in the power flow case or new buses that should be created. If entering the bus number of a bus
that does not already exist in the case, an informational message will appear above the Bus Number
field indicating that using this bus number will insert a new bus into the power system data model
and not just to the one-line display.
Find By Number
To find a bus by its number, enter the number into the Bus Number field and then click this
button.
Bus Name
Unique alphabetic identifier for the bus.
Find By Name
To find a bus by its name, enter the bus name into the Bus Name field (case insensitive) and then
click this button.
Find…
If you do not know the exact bus number or name you are looking for, you can click this button to
open the advanced search engine.
Nominal Voltage
Nominal voltage of the bus in kV.
Labels
Clicking on this button will open the Label Manager Dialog listing all of the labels assigned for the
selected bus.
Area Number
Number of the bus’ area. Each bus must be associated with an area record. If a bus is specified as
belonging to an area that does not already exist in the model, the new area is created.
Area Name
Alphabetic identifier for the bus’ area. If the area already exists, you do not need to enter this value.
Zone Number
Number of the bus’ zone, between 1 and 2,147,483,647 (equals 2^31 minus 1). Each bus must be
associated with a zone record. If a bus is specified as belonging to a zone that does not already exist
in the model, the new zone is created. Zones provide a useful mechanism for breaking up a large
system. Buses can be assigned to zones independent of their area assignments. Thus, a single area
could contain multiple zones, or a single zone could span multiple areas. You can use the Zone
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Dialog to list the buses in a particular zone and easily move a group of buses from one zone to
another.
Zone Name
Alphabetic identifier for the bus’ zone. If the zone already exists, you do not need to enter this
value.
Owner Number
The number of the bus’ owner.
Owner Name
The name of the bus’ owner.
Substation Number
The number of the substation the bus is contained in. This is typically blank in most power flow
data, unless specifically added to a PowerWorld binary save file.
Substation Name
The name of the substation the bus is contained in. This is typically blank in most power flow data,
unless specifically added to a PowerWorld binary save file.
OK, Save, and Cancel
OK saves your changes and closes the dialog. Save saves your changes but does not close the
dialog; this allows you to use, for example, the Find By Number command to edit additional buses.
Cancel closes the dialog without saving any changes.
Bus Information
Voltage (pu), Angle (degrees)
Current per-unit voltage magnitude and angle for the bus. If you are inserting a new bus into an
existing system, you should not change the initial per unit voltage values. Rather, when you
first switch to Run Mode, Simulator will estimate the voltage magnitude and angle at the new buses
in such a way as to reduce the initial mismatches. This automatic estimation is only available
if you have not modified the voltage in any way. Select Bus Voltage Regulator Devices to
view the individual devices regulating the voltage for the bus. Selecting this button displays the Bus
Voltage Regulating Devices Dialog.
System Slack Bus
Check only if the bus should be modeled as a system slack bus. Each case requires at least one slack
bus. Simulator can also dynamically determine slack buses as described in the Advanced Power Flow
Solution Options.
Display
Orientation
Set the orientation of the bus. The current choices are right, left, up or down. For the current bus
object shapes of Rectangle and Ellipse, right and left are analogous to horizontal, up and down are
analogous to vertical. Additional shapes for buses may be available in the future for which right, left,
up and down may have more specific impact on the appearance of the bus object.
Shape
Sets the shape of the bus object.
Width
Specifies the horizontal axis of an elliptical bus or horizontal side length of a rectangular bus.
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Size
Specifies the vertical axis of an elliptical bus or the vertical side length of a rectangular bus.
Scale Width with Size
When this option is checked, changing the size will cause the width to automatically adjust to keep
the same ratio of width to size. To adjust the width independent of the size, uncheck this option or
adjust the width separately after adjusting the size.
Link to New Bus
If you have right clicked on a bus and opened the bus information dialog, you could change the bus
number in the Bus Number field and press this button to force the bus object on the diagram to
link to the new bus number and information in the load flow data.
Attached Devices
Load Summary Information
Displays the net MW and Mvar load at the bus. You cannot change either of these fields from this
display. Select the Add or Edit Bus Load Records to view the individual load records for the bus via
the Load Dialog.
Shunt Admittance
The real (G) and reactive (B) components of shunt compensation at the bus, expressed in MW and
MVR, respectively.
Geography
The Geography page of the dialog provides information on the geographic location of the bus on the
currently active oneline diagram. Also it provides a conversion tool between Lat/Lon and UTM
Coordinates.
Fault Parameters
This tab is only visible when viewing the bus information for a bus with attached load. The parameters
on this tab are used when running a fault analysis study. The values represent the total load at the
bus for the negative and zero sequence as equivalent admittances. By default, these values are zero.
For load buses, these values can be changed by the user, or they can be specified by loading short
circuit data from within the Fault Analysis Dialog.
Custom
The Custom page of the dialog contains two sections: custom fields and memo.
The custom fields section allows access to setting and changing the values for custom fields that have
been defined for the bus. Defining custom fields is detailed in Custom Field Descriptions.
The Memo section of the dialog is simply a location to log information about the bus. Any information
entered in the memo box will be stored with the case when the case is saved to a PWB file.
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Bus Field Information
Bus field objects are used primarily to indicate various quantities associated with bus devices.
Furthermore, some bus field types, which are distinguished by an integrated spin button, may be used
to change bus device properties.
The Bus Fields Information Dialog can be used to modify the properties of individual bus fields on the
oneline. The dialog displays the following fields:
Find…
If you do not know the exact bus number or name you are looking for, you can click this button to
open the advanced search engine.
Bus Number
Number of the bus associated with the field. Use the drop-down box to view a list of all buses in the
case with valid area/zone/owner filters.
Bus Name
Name of the bus associated with the field. Use the drop-down box to view a list of all buses in the
case with valid area/zone/owner filters.
Total Digits in Field
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Field Value
The current value of the field being displayed.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Delta Per Mouse Click
This option is currently not used for bus fields.
Maintain Constant Load Power Factor
This option is only used for certain fields, such as load fields and generator fields. It is not used
currently for any bus fields.
Include Suffix
If this checkbox is checked, the corresponding field units will be displayed after the current value.
Otherwise, only the value without units will be shown.
Anchored
If this checkbox is checked, the bus field is anchored to its associated bus, which means that it will
move with the bus.
Rotation Angle in Degrees
The angle at which the text will appear on the diagram.
Type of Field
Used to determine the type of bus field to show. The following choices are available:
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Bus Name Name of the bus
Bus Number Bus number (from 1 to 2,147,483,647 (equals 2^31 minus 1))
Bus Voltage Bus voltage magnitude
Bus Angle Bus voltage angle in degrees
MW Marginal Cost Bus MW marginal cost in $/MWhr; available only with OPF
Mvar Marginal Cost Bus Mvar marginal cost in $/Mvarhr; available only with OPF
MW Loss Sensitivity Increase in losses for 1 MW of generation over the nominal
Select a Field Choose from any defined Bus fields
Select OK to save changes and to close the dialog, or click Cancel to close the dialog without saving
your changes.
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Shortest Path Between Elements
To access the Shortest Path Between Elements go to the Tools ribbon tab, and choose Connections
> Determine Shortest Path Between... from the Other Tools ribbon group. The Determine
Shortest Path Between dialog provides a way to find the shortest electrical pathway between two parts
of the power system.
After clicking the Calculate button, the shortest path of AC branches will be determined with the first
bus being inside the Start Element and the last bus being inside the End Element. Options described
below allow the user to choose the Start Element, End Element, Distance Measure for each branch,
and branches that are allowed to be traversed. The results will be displayed in a case information
display at the bottom of the dialog showing the sequence of buses that are traversed between the
start and end elements.
The options on the dialog are described below.
Start Element Type and Element
Choose an element type to be either a Bus, Substation, Area, Zone, Super Area or Injection Group.
Then use the object chooser to choose the particular object to be the starting element. For more
help on the object choose see the Find Dialog Basics.
End Element Type and Element
Choose an element type to be either a Bus, Substation, Area, Zone, Super Area or Injection Group.
Then use the object chooser to choose the particular object to be the ending element. For more help
on the object choose see the Find Dialog Basics.
Distance Measure
Choose the distance measure that will be used to determine distances between nodes. Each branch
will be treated as having a length based on the choice below. Note: negative values are not allowed,
therefore negative values will be treated as extremely small lengths instead.
X - Per unit series reactance.
|Z| - Magnitude of the series impedance (based on the per unit reactance and resistance).
Length - Length field for each branch.
Number of Nodes - Length of 1.0 is used for all branches.
Other - When choosing Other, click the Find.. button to choose any numeric field of a branch.
Lines to Process
Regardless of the Distance Measure above, you can choose which branches are allowed to be
traversed when finding the shortest path.
All - All branches are allowed to be traversed.
Only Closed - Only branches that are presently closed can be traversed.
Filter - Only branches that meet the advanced filter specified can be traversed. Click Define...
to choose or create and advanced filter.
Selected - Only branches whose Selected? field is set to YES can be traversed.
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Bus Voltage Regulating Devices Dialog
The Bus Voltage Regulating Devices Dialog displays summary information about the devices regulating
by the selected bus. The regulating devices can be Generators, Switched Shunts and Transformers.
Also the Bus Voltage Regulating Devices Dialog displays a Case Information Display for the regulating
devices. In addition to the information available about the Generators, Switched Shunts and
Transformers Display, the Bus Voltage Regulating Devices Dialogs Display also shows and allows to
modify the Regulating Max and Min per unit voltage, the Device Voltage Target, the Transformer (if
any) Regulation Target Type and Device Voltage Target High.
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Substation Information (Edit Mode)
The Substation Dialog is used in the Edit Mode to view information about a substation and to move
one or more buses from one substation to another. (See Substation Information (Run Mode) for help
on the corresponding Run Mode version.) To view this dialog, first select Aggregation >
Substations from the Model Explorer to view the Substations Records Display. Then, right-click on
the desired substation record and select Show Dialog to view this dialog.
The dialog has the following fields:
Substation Number
An integer identifier for the substation. You can use the spin button immediately to the right of this
field to move to either the next substation (click the up arrow) or the previous substation (click the
down arrow).
Substation Name and ID
Two alphanumeric identifiers for the substation. You can use these fields to change the substation’s
name or ID, provided you click either Save or OK.
Find By Number
To find a substation by its number, enter the number into the Substation Number field, then click
this button.
Find By Name
To find a substation by its name, enter the name into the Substation Name field, then click this
button.
Find By Sub ID
To find a substation by its substation ID, enter the ID into the Substation ID field, then click this
button.
Find…
If the exact substation number, name and ID are not known, you can use the Find Dialog to search
for and select a substation from a list of substations.
Labels
Clicking this button will open the Subscribed Aliases dialog displaying the list of defined labels for the
substation. New labels can also be added for the substation from the dialog as well.
Buses
This table lists all of the buses in the substation. Number, name, voltage, area number and name, and
zone number and name are shown for each bus. This table can be used to move buses to a different
substation. Select the bus or buses you would like to move with the mouse. Then, enter the
Destination Substation Number, which is the substation to which you want to move the selected
buses. You may enter a substation number that does not already exist, too, so that the buses will be
moved to a brand new substation. In this case, be sure to provide the new substation a name and ID,
as well. Finally, click the Move Selected Bus(s) to Destination Substation button to implement the
move.
Display Options
The Display Options tab of the Substation Information dialog is only visible if an open diagram
contains an object representing the substation. This tab allows you to choose the general appearance
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of the substation object. Use the Width and Height fields to set the width and height of the
substation object. The Shape field allows you to choose what shape the substation object will take.
By clicking on Link to New Object, the Choose Object selector will appear, allowing the user to
select another substation in the load flow data to be linked to this particular graphical object.
The Substation Layout Oneline, URL or Command field allows you to specify the same of the
Simulator oneline diagram (pwd) file that should be automatically opened if you click on the substation
object on the diagram in run mode. If no oneline is specified, Simulator will search for a default name
of the format AreaName_SubstationName. If a diagram cannot be found, then Simulator will not
attempt to open any oneline diagrams when the substation is clicked. Optionally, a HTTP URL can be
entered in the form http://example.com. Also, a line command can be entered, such as Excel.exe
c:\file.xls.
Substation Generators, Loads, and Switched Shunts Tables
These tables list all of the generators, loads, and switched shunts in the substation. Number, name,
ID, status, and additional fields for each type of device are shown.
Custom
Enter any text notes you wish in the Memo page. When the case is saved as a Simulator PWB file, the
memo text will also be saved. Custom fields can also be entered for storage with the selected
substation.
Geography
Displays geographic information about the location of the substation, in Latitude and Longitude. When
showing the dialog by right-clicking on a substation oneline display object from a oneline diagram,
then a button will also appear that states Copy Longitude/Latitude from Oneline Location. This
button will then determine the longitude/latitude of the center of the substation object on the oneline
diagram and copy these values into the Substation Data Record. Also it provides a conversion tool
between Lat/Lon and UTM Coordinates.
OK, Save, Cancel
OK saves any changes to the substation name or ID, and closes the dialog.
Save saves any changes to the substation name or ID, but does not close the dialog.
Cancel closes the dialog ignoring any changes.
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Substation Field Options
Substation field objects are used to show different values associated with substations. This dialog is
used to view and modify the parameters associated with these fields.
Substation Number
Select the number of the substation for which you are inserting or viewing information of a
substation field.
Find…
If you do not know the exact substation you are looking for, you can click this button to open the
advanced search engine.
Substation Name
The name of the currently selected substation.
Substation ID
The substation ID number.
Total Digits in Field
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Rotation Angle in Degrees
The angle at which the text will appear on the diagram.
Field Value
Shows the current output for the super area field. Whenever you change the Type of Field
selection, this field is updated.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Anchored
Toggle the anchoring of the field to the substation object of which it is associated.
Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
Used to determine the type of super area field to show. The following choices are available:
Substation Name, Substation Number
Name or number of the selected substation.
Substation ID
ID string for the selected substation.
Max Nominal Voltage
Displays the nominal voltage of the highest nominal voltage bus in the substation.
Substation Load MW, Substation Load Mvar
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Total Load MW or MVAR in the substation.
Substation Gen MW, Substation Gen MVAR
Total Generator MW or MVAR in the substation.
Select a Field
Select this option and click Find Field… to display the value of any other substation specific field.
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Generator Information (Edit Mode)
This dialog is used to view and modify the parameters associated with each generator in the system. It
can also be used to insert new generators and sometimes to delete existing generators.
The Edit Mode version of the Generator Information Dialog is almost identical to the Run Mode
version.
Bus Number
Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the bus to
which the generator is attached. The dropdown list enumerates all generator buses in the case that
meet the criteria established by area/zone/owner filters. You may select a bus number directly from
the dropdown list, or you may use the spin buttons to cycle through the list of generator buses.
Bus Name
Unique alphabetic identifier for the bus to which the generator is attached, consisting of up to eight
characters. Use this dropdown box to view a list of all generator bus names in the case with valid
area/zone/owner filters.
ID
Two-character alphanumeric ID used to distinguish multiple generators at a bus; ‘1’ by default.
Find By Number
To find a generator by its number and ID, enter the number into the Bus Number field and the ID
into the ID field. Then click this button.
Find By Name
To find a bus by its name and ID, enter the bus name into the Bus Name field (case insensitive)
and the ID into the ID field. Then click this button.
Find…
If you do not know the exact generator bus number or name you are looking for, you can click this
button to open the advanced search engine.
Status
Status of the generator, either Closed (connected to terminal bus) or Open (not connected). You can
use this field to change the status of the generator.
Area Name
Alphabetic identifier for the terminal bus’ area.
Labels
Clicking on this button will open the Subscribed Aliases dialog listing all the labels or aliases assigned
for the selected generator.
Fuel Type
Type of fuel used by the generator this model represents. In most cases, this field is unnecessary for
normal load flow analysis, and hence the default value is Unknown. However, this value can be
useful during the Security Constrained OPF analysis.
Unit Type
The type of unit the generator represents, such as combined cycle, steam, hydro, etc.
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There are six additional areas of information on this dialog for specific aspects of generation:
Display Information
Power and Voltage Control
Costs
Fault Parameters
Owner, Area, Zone, Sub
Custom
Stability
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Generator Field Information
Generator field objects are used primarily to indicate various quantities associated with generation
devices. Furthermore, some generator field types, which are distinguished by an integrated spin
button, may be used to change generation device properties.
The Generator Fields Information Dialog can be used to modify the properties of individual generator
fields on the oneline. The dialog displays the following fields:
Find…
If you do not know the exact bus number or name you are looking for, you can click this button to
open the advanced search engine.
Bus Number
Number of the bus to which the generator associated with the field is connected. Use the dropdown
box to view a list of all buses with generators in the case with valid area/zone/owner filters.
Bus Name
Name of the bus to which the generator associated with the field is connected. Use the dropdown
box to view a list of all buses with generators in the case with valid area/zone/owner filters.
ID
ID of the generator associated with the field. Generator ID are two-character alphanumeric fields.
Total Digits in Field
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Field Value
The current value of the field being displayed.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Delta Per Mouse Click
Generator fields can be used not only to show various fields associated with generation devices, but
they can also be used to change some values. This is accomplished using spin buttons shown to the
right of the generator field. When the up spin button is clicked, the generator field value is increased
by the amount specified in the delta per mouse click field. When the down spin button is clicked, the
generator field value is decreased by the same amount.
This field is only used for fields of the following types: Setpoint Gen MW, Setpoint Gen Mvar, and
Gen Setpoint Voltage. Specifying a nonzero value in this field causes the integrated spin button to
appear as part of the generator field on the oneline.
Rotation Angle in Degrees
The rotation angle at which the text field should be displayed.
Anchored
If the Anchored checkbox is checked, the generator field is anchored to its associated generator,
which means that it will move with the generator.
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Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
Used to determine the type of generator field to show. The following choices are available:
Gen MW Output MW generation
Gen Mvar Output Mvar generation
Gen AGC Status AGC status of generator; status can be toggled in Simulator
Gen AVR Status AVR status of generator; status can be toggled in Simulator
Gen Setpoint Voltage Voltage of generator on bus
Select a Field Choose from any of the different generator fields
Select OK to save changes and to close the dialog, or click Cancel to close the dialog without saving
your changes.
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Generator Options: Display
This information is located on the Display Information tab of the Generator Information Dialog.
Display Size
The size of the generator.
Scale Width with Size
If checked, the Display Width will automatically be scaled to the appropriate setting when the
Display Size is changed. If unchecked, then only the length of the generator object will be affected
by changing the value of the Display Size.
Display Width
The width of the display object. This setting is automatically set if Scale Width with Size is checked
and the value of the Display Size field is changed, or the Display Width value can be set manually to
a new value.
Pixel Thickness
Thickness of the display object in pixels.
Orientation
Specifies the direction in which to draw the object.
Anchored
If checked, the object is anchored to its terminal bus. See Anchored Objects for details.
Link to New Generator
Links the object to a different generator in the data.
Rotor Shape
Several shapes are available for the rotor symbol. The default is the "dog bone" shape, but options
are also available for symbols that represent the fuel type of the unit. There is no link between the
Fuel Type field that can be specified with a generator and the rotor symbol. The rotor shape must
be specified independently of the Fuel Type field.
Fill Rotor Symbol with Color 2, Fill with Color 2
Check the Fill Rotor Symbol with Color 2 box to use the color specified in the Fill with Color 2
field to fill the rotor symbol with a different color than the generator background color.
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Generator Options: Power and Voltage Control
This information is located on the Generator Information Dialog.
Power Control
The Power Control grouping fields are used to show/change the values associated with the real power
output of the generator.
MW Output
Current real power output of the generator.
Minimum and Maximum MW Output
Minimum and maximum real power output limits for the generator. Simulator will not let the MW
output go below its minimum value or above its maximum value if the Enforce MW Limits option is
exercised.
Available for AGC
Determines whether or not the generator is available for automatic generation control (AGC).
Normally this box should be checked. However, there are times when you would like to control the
generator output manually (such as if you are using the generator to remove a line limit violation),
in which case you should leave this box unchecked. A generator is also placed on "manual" control
anytime you manually change its output. You could then place the generator back on AGC control if
you wish it to participate in an area generation dispatch.
Enforce MW Limits
If checked, the minimum and maximum MW limits are enforced for the generator, provided the
Enforce Generator MW Limits field is also checked on the Limits Tab of the Simulator Options
Dialog. If this box is checked and a generator is violating a real power limit, the generator’s MW
output is immediately changed.
Participation Factor
The participation factor is used to determine how the real power output of the generator changes in
response to demand when the generator is available for AGC and the area is on participation factor
control. When you open a case using the PTI Raw Data Format, this field is initialized to the per unit
MVA rating of the generator, since participation factor information is not stored in the PTI format.
Voltage Control
The Voltage Control grouping is used to show/change values associated with controlling the
voltage/reactive power output of the generator.
Mvar Output
Current reactive power output of the generator. You can manually change this value only if
Available for AVR is not checked.
Min and Max Mvar Output
Specify the minimum and maximum allowable reactive power output of the generator.
Available for AVR
Designates whether or not the generator is available for automatic voltage regulation (AVR). When
the AVR field is checked, the generator will automatically change its reactive power output to
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maintain the desired terminal voltage within the specified reactive power range. If a reactive limit is
reached, the generator will no longer be able to maintain its voltage at the setpoint value, and its
reactive power will then be held constant at the limit value.
Use Capability Curve
If checked, then the generator’s reactive power limits are specified using a reactive capability curve
that prescribes the dependence of the generator’s reactive power limits on its real power output.
Otherwise, the fixed values given in the Min Mvar Output and Max Mvar Output fields are used.
The generator reactive capability can be defined using the table that appears at the bottom of the
dialog. Please see Generator Reactive Power Capability Curve for details.
Regulated Bus Number
Number of the bus whose voltage the generator is regulating. This is usually, but not always, the
generator’s terminal bus. Multiple generators can regulate the same remote bus, but the regulated
bus must not be another generator bus. If the generator is at a slack bus, it must regulate its own
terminal voltage. Select Solution Details > Remotely Regulated Buses in the Model Explorer
to view the Remotely Regulated Buses display, which identifies all buses that are being remotely
regulated.
SetPoint Voltage
Specifies the desired per unit setpoint voltage value the generator is to regulate at the regulated
bus. The regulated bus need not be the generator terminal bus.
Remote Reg %
This field is only used when a number of generators at different buses are regulating a remote bus
(i.e., not their terminal buses). This field then specifies the percentage of the total reactive power
required by the remote bus to maintain its voltage that should be supplied by this generator. The
default value is 100. If the total value is different from 100%, then all the regulation factors are
normalized to obtain a percentage of regulation.
Wind Control Mode and Power Factor
The Wind Control Mode effects how generator Mvar limits are treated and can be set to either None,
Boundary Power Factor or Constant Power Factor.
When the mode is None, then the generator behaves using the standard settings of the Min and
Max Mvar Output and Capability Curve described above.
For Follow Min Mvar Capability Curve mode, the Mvar output of the generator is determined by a
lookup from the capability curve's Min Mvar value. Essentially the Max Mvar Output and the Min
Mvar Output are then made equal to this value. This provides the ability to make a generator's
Mvar output any piece-wise linear function of the MW output.
For both the Boundary and Constant modes, the Mvar limit magnitudes are determined from the
actual MW Output and the Wind Control Mode Power Factor value.
Magnitude = MWOutput * tan(arccos(Power Factor))
For Boundary mode, the Max Mvar Output is positive and the Min Mvar Output is negative. This
provides a boundary under which the Mvar must operate.
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For Constant mode, Max Mvar Output and the Min Mvar Output are made the same with a
positive Wind Control Mode Power Factor meaning the limits have the same sign as the actual
MW Output, and a negative Wind Control Mode Power Factor meaning the limits are the
opposite sign as the actual MW Output, thus the Mvar output is a function of MW Output and
Power Factor.
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Generator Options: Costs
The Costs tab of the Generator Information dialog (run mode) is used to show/change values
associated with the cost of operation of the generator. See Generator Cost Information for details.
Cost data can also be saved/loaded using the Generator Cost Data files.
Output Cost Model
Cost Model
Simulator can model generators as not having a cost model, or having either a cubic cost model or a
piecewise linear model. The cost model type you choose determines the content of the remainder of
this dialog
Unit Fuel Cost
The cost of fuel in $/MBtu. This value can be specified only when you have chosen to use a cubic
cost model.
Variable O&M
The Operations and Maintenance costs. Only used for cubic cost models.
Fixed Costs (costs at zero MW Output)
The fixed costs associated with operating the unit. These costs are independent of the generator's
MW output level and is added to the cost prescribed by the cubic or piecewise linear model to obtain
the total cost of operating the generator in $/MWHr. The total fixed cost is the addition of the fuel
cost independent value and the fuel cost dependent value multiplied by unit fuel cost.
Cubic Cost Coefficients A, B, C, D
For cubic cost models of the form C(Pgi) = (d*Pgi^3 + c*Pgi^2 + b*Pgi ) * (fuel cost) + fixed costs
(as described above), specify the cost curve's coefficients. The A coefficient is historically the fuel
cost dependent fixed cost value, which is combined separately now with the fuel cost independent
value. These coefficients can be specified only when you have chosen to use a cubic cost model.
Piecewise Linear Table
If you have chosen to use a piecewise linear cost model, a table appears that allows you to specify
pairs of MW output levels and corresponding generator operating costs. To insert a new point on the
cost curve, right-click on the table and choose Insert New Point from the resulting local menu. To
delete an existing point from the cost curve, right-click on the table and choose Delete Point from
the resulting local menu. To edit an existing point in the table, simply enter your changes to the
appropriate cells.
Convert Cubic Cost to Linear
Use this option to create a piecewise linear cost function from the cubic cost function specified by
the coefficients A, B, C, and D and the fuel cost. Specify the number of break points, and hence the
number of segments, in the Number of Break Points field. Click the Convert to Linear Cost
button to create the piecewise linear function that approximates the cubic cost function. This action
switches Cost Model option to Piecewise Linear and displays the Piecewise Linear Table that
identifies the piecewise linear curve’s breakpoints.
Bid Scale / Shift
Cost Shift, Cost Multiplier
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The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the purpose
of assessing how variations in bids impact profit. The cost function is affected based on the following
equation:
(Original Cost Function + Cost Shift) * Cost Multiplier
Marginal Cost (run mode only)
Shows the marginal cost of producing real power at the generator at its current output level,
dCi(Pgi)/dPgi.
ED/OPF Cost (run mode only)
This is the cost of production for this generator following an economic dispatch or optimal power
flow solution, including the scaling from the cost shift and cost multiplier fields.
Unscaled Cost (run mode only)
The cost of production of the generator, ignoring the cost multiplier and cost shift. This cost is the
result of the original cost function by itself.
OPF Reserve Bids
This tab is only available with the OPF Reserves add-on. Detailed information about this tab can be
found in the Generator and Load OPF Reserves Bids topic.
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Generator Options: Fault Parameters
The parameters on this tab are used when running a fault analysis study.
Generator MVA Base
The assumed MVA base for the generator. This value is used when calculating fault analysis values
for the internal generator parameters.
Neutral Grounded
Check this check-box if the generator has the neutral grounded.
Generator Step Transformer
The resistance, reactance and tap setting for the generator step-up transformer, if one is being
modeled internally with the generator. By default, no internal transformer model is assumed.
Internal Impedance
These fields represent the internal impedance of the generator for all three sequences. By default,
all three values are initially the same as the load flow internal impedance of the generator. All three
sets of values can be modified, either manually or by loading values from an external file using the
Fault Analysis Dialog.
Neutral-to-Ground Impedance
Neutral-to-ground impedance for the generator. These values get implemented with the zero
sequence admittance matrix. Note that the neutral-to-ground impedance will not be used, even if
specified, if the original model for the generator implicitly models the generator step-up transformer.
This is because the implicitly modeled transformer is assumed to have a delta winding on the
generator side of the transformer, which isolates the generator from the rest of the zero sequence
network.
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Generator Options: Owners, Area, Zone, Sub
This information is located on the Generator Information Dialog.
This tab is used to display or change the generator’s owner information, area information, zone
information, and substation information.
Same Owner as Terminal Bus
Read-only check-box that indicates whether the generator’s owner is the same than the terminal
buses’ owner.
Owners
Currently, Simulator supports up to four owners for generators. To add an owner of a generator,
change one of the Owner fields to a new owner number, and update the owner percentages
accordingly. To modify an owner's percentage of ownership, simply modify the value in the
percentage field for that owner. If you set the percentage of an owner to 0, that owner will be
removed from the list of owners for the device. You can also remove an owner from owning part of
a device by changing the owner field for that owner to 0. Note that if you do not set the new owner
percentages of all specified owners such that the total is 100%, Simulator will normalize the
percentages such that the total is 100% when you click Save or OK on the generator dialog.
Area Number, Area Name
The area number and name to which the generator belongs. Note that you can change the area of
the generator to be different than the area of the terminal bus. If you do so, you will be prompted to
confirm that you wish to place the generator within a different area than that of the bus to which it
is electrically connected.
Zone Number, Zone Name
The zone number and name to which the generator belongs. Note that you can change the zone of
the generator to be different than the zone of the terminal bus. If you do so, you will be prompted
to confirm that you wish to place the generator within a different zone than that of the bus to which
it is electrically connected.
Substation Number, Substation Name
The name and number of the substation to which the generator belongs, and it is the same than
that of the terminal bus.
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Generator Cost Description
The cost associated with operating a generator varies according to the output of the generator, with
the general rule that getting more power out of a generator costs more. In Simulator, there are two
options for modeling generator cost. The first employs the common cubic relationship
Ci(Pgi) = IndFixedCost + ( ai + bi Pgi + ci (Pgi)2 + di (Pgi)3 ) * fuel cost $/Hour
where Pgi is the output of the generator at bus i in MW. IndFixedCost is the fuel cost independent
fixed cost, and therefore is not multiplied by the fuel cost. The value ai is the fuel cost dependent fixed
cost, and is therefore multiplied by the fuel cost. The values bi, ci, and di are used to model the
generator's input-output (I/O) curve. The I/O curve specifies the relationship between how much heat
must be input to the generator (expressed in MBtu per hour) and its resulting MW output. Normally,
the cubic coefficients remain constant for a generator. The last term in the equation is the fuel cost,
expressed in $/MBtu. This value varies depending on the fuel used in a generator. Typical values
would be $ 1.25/MBtu for coal and $ 2/Mbtu for natural gas. The resultant equation is known as the
fuel-cost curve. The value of the fixed costs, b i, ci, di, and fuel cost can be viewed and modified using
the Generator Information Dialog.
Simulator can also model generator costs using a piecewise linear model consisting of pairs of MW
output and incremental cost ($/MWhr) of generation, along with a fixed cost. These piecewise linear
curves must be convex curves, meaning the marginal cost of the current MW break point must be
higher than the previous MW break point.
Such curves can be defined using the Generator Information Dialog or by loading data from generator
cost data files.
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Set Generator Participation Factors
Participation factor control is another of Simulator’s mechanisms for distributing an area’s responsibility
to serve its load, losses, and interchange. It is particularly well-suited to implementing automatic
generation control (AGC) when you do not have good economic information for an area’s generators.
With participation factor control, the amount of power that each generator contributes to meeting its
areas load, loss, and interchange responsibilities is controlled by the size of its participation factor. The
unit that has the largest participation factor contributes the most, and the unit that has the smallest
participation factor contributes the least.
The Set Generator Participation Factors Dialog gives you a convenient way to define the
participation factors for multiple generators. You can set the participation factor according to a number
of different formulae and then apply this prescription to all generators in a specific area, all generators
in a specific zone, all generators in the system, or all generators whose display filters are currently set
to true.
To display the Set Generator Participation Factors Dialog, you first need to open the Area
Information Dialog and switch to the Area MW Control Options page. The Area Information Dialog has
a button labeled Set Participation Factors that is enabled only if the Participation Factor Control
option is selected under the Area Control Options heading. Set the area on participation factor control
by selecting the Participation Factors option, and then press the Set Participation Factors option.
The Set Generator Participation Factors Dialog is divided into two parts. The first part, which occupies
the top half of the form, allows you to indicate how the participation factors should be calculated or
set for each generator. Your options include:
Max MW Rating of Generator The participation factor for each generator is set to the generator’s
maximum MW capability.
Difference Between Max and Current Output The participation factor for each generator is set
to the generator’s reserve power, so that each generator participates in proportion to how much it
has left to contribute.
Constant Value of The participation factor for each generator is set to the same hard-coded value.
File The participation factor for each generator is read from a file. The first line of the file should
contain the keyword NUMBERS or NAMES indicating whether generators are identified by bus
number or by bus name in the file. All subsequent lines should be comma-delimited and contain
three fields: the number or name of the generator’s bus, the generator’s id, and the generator’s
participation factor.
If you choose any of the first three options, you then must tell Simulator to what generators you want
to assign the participation factors. To assign the participation factors to all generators in a specific
area, select the All Generators in Area option, and then choose the area from the adjacent
dropdown box. If you want to assign the participation factors to all generators in a specific zone, select
the All Generators in Zone option, and then choose the zone from the adjacent dropdown box. If
you want to assign the participation factor to all generators in the system regardless of their area or
zone affiliation, select the All Generators in System option. Finally, if you want to assign the
participation factor to just those generators whose display filter criteria evaluates to true, choose the
All Generators With Valid Display Filters option.
If you instead chose to read participation factors from a file, only those generators whose factors you
read from the file will have their factors set by this action. However, unless each generator’s
associated area is set to control generator output using participation factor control, this information
will be ignored. To make sure that each generator’s area is set to participation factor control, check
310
©2011 PowerWorld Corporation

the Set Corresponding Areas to Participation Factor Control box. Then, each corresponding
area will be set to participation factor control.
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Generator Reactive Power Capability Curve
The reactive power output of most generators depends on the real power output of the generator.
This dependence is expressed using a reactive capability curve. Simulator models the reactive
capability curve using a piecewise linear approximation. The reactive capability curve is modified on
the generator dialog and can be saved/loaded using the Generator Reactive Capability Curve Auxiliary
files.
Modeling a Reactive Power Capability Curve From the Generator Dialog







Make sure the Use Capability Curve checkbox is checked.
In the table at the bottom of the dialog, prescribe the reactive capability curve using up to 50
points. The points should be ordered by MW, in numerically increasing order. At each point specify
the MW value, the minimum reactive power value in Mvar, and the maximum reactive power value
in Mvar. The first point should correspond to the minimum MW output of the generator while the
last point should correspond to the maximum MW output although there is not a strict requirement
that the generator's minimum and maximum output be specified in the curve. If the MW output of
the generator is less than the MW value of the first point specified for the curve, the first curve
point will be used to determine the minimum and maximum Mvar. If the MW output of the
generator is greater than the MW value of the last point specified for the curve, the last curve
point will be used to determine the minimum and maximum Mvar.
To insert a new point, click on the desired column, and then right-click to display the table's local
menu. Select Insert Point.
To remove a point, click on the desired column, and then right-click to display the table's local
menu. Select Delete Point.
When finished be sure to select Save to save your modifications.

In the Run Mode, you can view the reactive power capability curve graphically by right-clicking on the
generator to display its submenu and then selecting Reactive Capability Curve.
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Load Information (Edit Mode)
This dialog is used to view and modify the parameters associated with each load in the system. It can
also be used to insert new loads and sometimes to delete existing loads. It is nearly identical in
structure to its Run Mode counterpart.
The Load Information Dialog can be used to inspect and modify the model of a bus load. To view the
Load Information Dialog, select the load and choose Show Dialog from the case information toolbar
or right-click on the load of interest and select Load Information Dialog from the resulting local
menu. The dialog has the following fields:
Bus Number
Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the bus to
which the load is attached. The dropdown box provides a list of all load buses with valid
area/zone/owner filters. You can use the spin button to cycle through the list of load buses.
When you insert objects graphically, the Bus Number and Bus Name fields are usually set
automatically to the bus upon which you placed the object.
Bus Name
Unique alphabetic identifier for the bus to which the load is attached, consisting of up to eight
characters. The dropdown box lists the names of all load buses in the case with valid
area/zone/owner filters.
ID
Two-character ID used to distinguish multiple loads at a bus. By default, the load ID is equal to "1 ."
An identifier of ‘99’ is used to indicate an equivalent load.
Find By Number
To find a load by its number and ID, enter the number into the Bus Number field and the ID into the
ID field. Then click this button.
Find By Name
To find a load by its name and ID, enter the bus name into the Bus Name field (case insensitive)
and the ID into the ID field. Then click this button.
Find…
If you do not know the exact load bus number or name you are looking for, you can click this button
to open the advanced search engine.
Status
Status of the load, either Closed (connected to terminal bus) or Open (not connected). You can use
this status field to change the load’s status.
Labels
Clicking on this button will open the Label Manager dialog listing all the labels assigned for the
selected load.
Area Number, Area Name
Number and name of the area the load is a member of.
Zone Number, Zone Name
Number and name of the zone the load is a member of.
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Substation Number, Substation Name
Number and name of the substation the load and the terminal bus are members of.
Owner Number, Owner Name
Number and name of the owner the load is a member of. If the load owner is the same as the
terminal bus owner, the Same Owner as Terminal Bus box will be checked. Loads DO NOT have
to be owned by the same owner as the terminal bus.
OK, Save, Delete, and Cancel
OK saves your changes and closes the dialog. Save saves your changes but does not close the
dialog; this allows you to use, for example, the Find By Number command to edit additional loads.
Delete deletes the current load. Cancel closes the dialog without saving your changes.
Specific load information can be found on the following pages of the Load Options dialog:
Load Information
OPF Load Dispatch
Custom
Stability
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Load Options: Load Information
This page of the Load Options dialog contains information on the load magnitude and display settings.
MW and Mvar Value Fields
The MW and Mvar Value fields are used to represent the amount of base real and reactive load at
the bus. Usually this load is modeled as being "constant power," meaning that the amount of load is
independent of the bus voltage magnitude. However, Simulator also permits modeling "constant
current" load, for which the load varies in proportion to the bus voltage magnitude, and "constant
impedance" load, for which the load varies in proportion to the square of the bus voltage magnitude.
Values in these fields are specified in MW and MVR assuming one per unit voltage. All six fields can
be modified by the user.
Display Size
Size of the load.
Scale Width with Size
If checked, the Display Width will automatically be scaled to the appropriate setting when the
Display Size is changed. If unchecked, then only the length of the generator object will be affected
by changing the value of the Display Size.
Display Width
The width of the display object. This setting is automatically set if Scale Width with Size is checked
and the value of the Display Size field is changed, or the Display Width value can be set manually to
a new value.
Pixel Thickness
Thickness of the display object in pixels.
Orientation
Specifies the direction to draw the object.
Anchored
If checked, the object is anchored to its terminal bus. See Anchored Objects for details.
Link to New Load
Links the object to a different load record in the data.
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Load Options: OPF Load Dispatch
This tab of the Load Options dialog contains settings for allowing the load to be included as an OPF
Control. The load(s) can then be dispatched in the OPF algorithm according to the assigned costs.
Benefit Model
Benefit Model
If this field is set to none, the load will not be dispatchable in the OPF solution. If the option is set to
Piecewise Linear, the load is dispatchable during the OPF, according to the following fields.
Min. and Max. MW Output
Minimum and maximum load MW demand for OPF dispatch.
Available for AGC
If checked, the load will be available for redispatch during the OPF routine.
Fixed Benefit
Value of the load benefit at minimum demand.
Piece-wise Linear Benefit Curve
This table allows you to specify pairs of MW demand levels and corresponding load benefit values,
which in turn define the starting points and slopes of the piece-wise linear benefit curve segments.
To insert a new point on the cost curve, right-click on the table and choose Insert New Point from
the resulting local menu. To delete an existing point from the cost curve, right-click on the table and
choose Delete Point from the resulting local menu. To edit an existing point in the table, simply
enter your changes to the appropriate cells.
OPF Reserve Bids
This tab is only available with the OPF Reserves add-on. Detailed information about this tab can be
found in the Generator and Load OPF Reserves Bids topic.
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Load Field Information
Load field objects are used primarily to indicate various quantities associated with load devices.
Furthermore, some load field types, which are distinguished by an integrated spin button, may be used
to change load device properties.
The Load Fields Information Dialog can be used to modify the properties of individual load fields on
the oneline. The dialog displays the following fields:
Find…
If you do not know the exact bus number or name you are looking for, you can click this button to
open the advanced search engine.
Bus Number
Number of the bus to which the load associated with the field is connected. Use the dropdown box
to view a list of all buses with loads in the case with valid area/zone/owner filters.
Bus Name
Name of the bus to which the load associated with the field is connected. Use the dropdown box to
view a list of all buses with loads in the case with valid area/zone/owner filters.
ID
ID of the load associated with the field. Load ID fields are two characters in length.
Total Digits in Field
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Field Value
The current value of the field being displayed.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Delta Per Mouse Click
Load fields can be used not only to show various fields associated with load devices, but they can
also be used to change some values. This is accomplished using spin buttons shown to the right of
the load field. When the up spin button is clicked, the load field value is increased by the amount
specified in the delta per mouse click field. When the down spin button is clicked, the load field
value is decreased by the same amount.
This field is only used for fields of the following types: Load MW and Load Mvar. Specifying a
nonzero value in this field causes the integrated spin button to appear as part of the load field on
the oneline.
Note that the Maintain Constant Load Power Factor option will allow you to specify a Delta per
Mouse-click for the MW load, and when the MW value is changed in run mode, the MVAR load will
also change in such a way as to keep the power factor of the load constant.
Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
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Anchored
If the Anchored checkbox is checked, the load field is anchored to its associated load, which means
that it will move with the load.
Rotation Angle in Degrees
The angle at which the text is placed on the diagram, in degrees.
Type of Field
Used to determine the type of load field to show. The following choices are available:
Load MW MW load
Load Mvar Mvar load
Select a Field Choose from any of the different load fields
Select OK to save changes and to close the dialog, or click Cancel to close the dialog without saving
your changes.
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Load Modeling
Each load can be modeled as having voltage variation. The voltage variation is modeled using the Base
Load Model fields on the Load Information dialog. Thus the actual real and reactive value of each load
is determined using the following equation:
MW = Load MW Multiplier * (SMW + IMW * V + ZMW * V * V)
Mvar = Load Mvar Multiplier * (SMvar + IMvar * V + ZMvar * V * V)
where
MW current real power load in MW
Mvar current reactive power load in Mvar
SMW constant power MW value
Smvar constant power Mvar value
IMW constant current MW value (assuming 1.0 per unit voltage)
Imvar constant current Mvar value (assuming 1.0 per unit voltage)
ZMW constant impedance MW value (assuming 1.0 per unit voltage)
Zmvar constant impedance Mvar value (assuming 1.0 per unit voltage)
V per unit bus voltage magnitude
Load MW Multiplier = (Area MW Multiplier) * (Zone MW Multiplier)
Load Mvar Multiplier = (Area Mvar Multiplier) * (Zone Mvar Multiplier)
The Area Multipliers scale all of the loads in an area. The Zone Multipliers scale all of the loads in a
zone. These are static values that do not vary over time. If a time varying schedule of loads is
required, the Time Step Simulation tool should be used instead of the static multipliers.
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Branch Options (Edit Mode)
The Branch Options dialog is used to view and modify the parameters associated with each
transmission line and transformer in the system. You can also insert new transmission lines and delete
existing transmission lines from this dialog.
The Edit Mode version of this dialog is very similar in content to its Run Mode counterpart.
The Branch Options dialog has the following fields:
From Bus Number and Name

From Bus number and name. For transformers, the from bus is the tapped side.
To Bus Number and Name

To Bus number and name.
Circuit
Two-character identifier used to distinguish between multiple lines joining the same two buses.
Default is ‘1'.
Find By Numbers
To find a line or transformer by its bus numbers, enter the from and to bus numbers and the circuit
identifier. Then click this button. Use the spin button to cycle through the list of lines and
transformers in the system.
Find By Names
To find a line or transformer by the names of its terminal buses, enter the from and to bus names
and the circuit identifier. Then click this button.
Find…
If you do not know the exact from and to bus numbers or names you are looking for, you can click
this button to open the advanced search engine.
From End Metered
This field is only used for lines and transformers that serve as tie lines, which are lines that join two
areas. If this field is checked for a tie line, then the from end of the device is designated as the
metered end. Otherwise the to end is metered. By default, the from end is metered. The location of
the metered end is important in dealing with energy transactions because it determines which party
must account for transmission losses.
Default Owner (Same as From Bus)
Read-only check-box that indicates whether the line’s owner is the same than the from bus’ owner.
From and To Bus Area Name
Name of control area in which each terminal bus is located.
From and To Bus Nominal kV
Nominal voltage level of each terminal bus, in kV.
Labels
Clicking on this button will open the Label Manager Dialog listing all the labels assigned for the
selected branch.
OK, Save, Delete, Cancel, and Help
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OK saves your changes and closes the dialog. Save saves your changes but does not close the
dialog; this allows you to use, for example, the Find By Number command to edit additional
transmission lines. Delete deletes the current branch. The Delete button is not visible if editing a
branch that was accessed via the oneline diagram. Cancel closes the dialog but does not save any
changes. Help opens this help topic.
Display
See Branch Options: Display.
Parameters
See Branch Options: Parameters.
Transformer Control
This tab is only visible for transformer objects. See Transformer Control for details on modeling either
LTC or phase shifting transformers.
Series Capacitor
This tab is only visible for series capacitor objects. See Series Capacitor for details on modeling series
capacitors.
Fault Info
The parameters on this tab are used when running a fault analysis study. The values represent the
zero sequence impedance and zero sequence line shunt admittances for the analysis. By default, the
positive and negative sequence line impedances and line shunt admittances are the same as the load
flow impedance. The same fields are used for transformers, along with the configuration field. The
configuration field defines the winding type combinations for the transformer (wye, delta, etc.) As a
default, Simulator assumes a grounded wye to grounded wye transformer, which has the same model
as a transmission line. Usually transformers are not of this type, and the proper type would need to be
defined either manually or loaded from an external file in order for the fault analysis to be accurate.
Owner, Area, Zone, Sub
The Default Owner (Same as From Bus) read-only check-box indicates whether the branch’s
owner is the same as the from bus’ owner. Transmission elements can have up to four different
owners, each with a certain owner percentage. To add an owner of a transmission element, change
one of the Owner fields to a new owner number, and update the owner percentages accordingly. Note
that if you do not set the new owner percentages of all specified owners such that the total is 100%,
Simulator will normalize the percentages such that the total is 100% when you click Save or OK on
the branch options dialog.
The area, zone, and substation to which the From and To buses belong, are also shown.
Custom
This page of the dialog contains two sections: custom fields and memo.
The custom fields section allows access to setting and changing the values for custom fields that have
been defined for the branch. Defining custom fields is detailed in Custom Field Descriptions.
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The Memo section of the dialog is simply a location to log information about the branch. Any
information entered in the memo box will be stored with the case when the case is saved to a PWB
file.
Stability
This tab is only visible with the Transient Stability Add-On tool. Any branch-specific transient stability
modeling information is contained on this tab. For more information see the Transient Stability Data:
Object Dialogs.
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Branch Options: Display
The Display tab of the Branch Options dialog is available when opening the dialog by right-clicking on
a display object.
Pixel Thickness
Thickness of the display object in pixels.
Anchored
If checked, the object is anchored to its terminal bus, which means that it will move when you move
the terminal bus. See Anchored Objects for details.
Link to New Line
Use the Link to New Line button to create a new line corresponding to the entries you have made
in the dialog. This button performs the same function as pressing Save. Note that adding a new line
to the case in this way does not add a transmission line to the oneline display; the new line is
present only in the model. You may then add the newly modeled line to the oneline diagram in the
usual way (such as select Network > Transmission Line from the Individual Insert ribbon group
on the Draw ribbon tab).
Symbol Segment
Only visible for transformer and series capacitor objects. This field specifies which "segment" of the
branch contains the transformer or capacitor symbol. A segment constitutes a section of the line
between vertex points of the line object, and are numbered starting at the from bus.
Symbol Size
Only visible for transformer and series capacitor objects. Specifies the size (width) of the transformer
or capacitor symbol on the branch.
Symbol Percent Length
The distance or "length" of the symbol on the segment of the branch which contains it.
Show Detailed Line Vertices
When checking this option, a new group of information appears, showing the x,y coordinates of
every vertex of the line. Additionally to being able to edit those locations, it is possible to shift or
scale all the values with the buttons Shift All Values and Scale All Values, respectively.

323
©2011 PowerWorld Corporation

Branch Options: Parameters
The Parameters tab of the Branch Options dialog displays the common parameters required for
defining a transmission branch.
Status
Current status of the device. Either Openor Closed.
Length
If the length of the line is known, it can be entered here in miles for informational purposes.
Per Unit Impedance Parameters
The series resistance and reactance (R and X), the total charging susceptance (that is, B, not B/2)
and the shunt conductance (G) of the device (in per unit). In the case of transformers, the
magnetizing conductance and susceptance can also be specified.
Line Shunts
Click this button to view the Line Shunt Dialog. This dialog is used to only view or modify the values
of the line shunts. Line shunts are expressed in terms of the per-unit conductance and susceptance
at each end of the line or transformer. If the line has shunts, the check box Has Line Shunts is
checked.
MVA Limits
Ratings for the transmission line or transformer in MVA. Eight different limits are allowed.
Calculate Impedances
This will display a pop-up menu with the following two options:
…From Per Distance Impedances
Clicking this item will open the Line Per Unit Impedance Calculator dialog, which can be used to
convert actual impedance and current limits to per unit impedance and MVA limits, and vice
versa.
…From Conductor Type and Tower Configuration
Clicking this item will open the Transmission Line Parameter Calculator dialog, which can be used
to compute per unit impedance values, based on a conductor type and a tower configuration.
Convert Line to Transformer
Clicking this button turns the currently selected transmission line into a transformer, making the
transformer specific fields available.
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Line Shunts Information
The Line Shunts Information dialog is used to modify the parameters of transmission line shunts. The
modeling of the line shunts is explained below.
Line Shunts
Line shunts are included in the model as admittance-to-ground values at either the From end or the
To end of a transmission line. These values can represent many things, such as shunt-to-ground
capacitors, reactors, zigzag (or grounding) transformers, or equivalenced system values. Line shunt
values are entered in per unit, with a positive B corresponding to capacitors and a negative B
corresponding to reactors. Mathematically, the line shunts are included in the algorithm in the same
manner that line charging capacitance is included using the Pi model.
Line shunt values can be modified from the Branch Options dialog or Branch Information Dialog.
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Line Per Unit Impedance Calculator Dialog
The Line Per Unit Impedance Calculator Dialog allows to convert actual impedance and current limit
values to per unit impedance and MVA limit values, and vice versa.
The dialog has the following elements:
Actual Impedance and Current Limits
This part of the dialog shows all the impedance related values in Ohms/length-unit as well as the
transmission line limits specified in Amps. If any of these values is modified, the corresponding per
unit or MVA value will be changed accordingly, taking into consideration the current line length,
length units, and system base values.
Line Length
This value indicates the length of the line in miles or kilometers, depending on the units selected in
Length Units. The option When changing convert is used to convert the values when the length
value is modified. The option PU/MVA --> indicates that the actual impedance and current limits
will be converted to per unit impedance and MVA limits when the length value is changes. The
option <-- Electrical specifies that the per unit impedance and MVA limits will be converted to
actual impedance and current limits when the length value is modified.
Length Units
This option indicates the length units. Choices are miles and kilometers. When this parameter is
changed, the user will be prompted to confirm to convert the actual impedance and current limits,
as well as the line length values, from the old units to the new units. If the answer is positive, then
the actual impedance and current limits, and the line length will be the same but they will be
expressed in the new units selected. If the answer is negative, the values will not change
numerically but they still will be expressed in the new units selected.
System Base Values
The system base values show the power base, the voltage base, and the impedance base. These
values can not be modified in this dialog.
Per Unit Impedance and MVA Limits
This part of the dialog shows all the impedance related values in per unit as well as the transmission
line limits specified in MVA. If any of these values is modified, the corresponding actual or Amps
value will be changed accordingly, taking into consideration the current line length, length units, and
system base values.
Conductor Type
Shows the conductor type selected to compute the per unit impedances in the Transmission Line
Parameter Calculator dialog. It will be blank if there isn’t any.
Tower Configuration
Shows the tower configuration selected to compute the per unit impedances in the Transmission
Line Parameter Calculator dialog. It will be blank if there isn’t any.
Calculate PU Impedances From Conductor Type and Tower Configuration
Clicking this button will open the Transmission Line Parameter Calculator form.
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Transmission Line Parameter Calculator
The transmission line parameter calculator is a tool designated to compute characteristic line
parameters give the type of the conductor and the configuration of a three-phase overhead
transmission line.
The parameters computed are the resistance R, reactance X, susceptance B, and conductance G.
These values are computed as distributed (per unit of distance), lumped or total (for a specific line
distance), and in per-unit.
Calculations
The following controls are part of the calculations section:
Parameters Calculation
This section is to enter the necessary data to compute the characteristic line parameters that are
shown in the Results panel.
Input Data
Conductor Type: This is the combo box that lists all the conductor types available in the
Conductors table. To add, remove or edit a specific conductor and its characteristics, see
Conductor Type section below.
Tower Configuration: This combo box lists all the tower configurations available in the Tower
Configurations table. To add, remove or edit a specific tower configuration, please go to the
Tower Configuration section below.
Line Length: This is the value of the distance of the transmission line. The units are miles when
using English system, or kilometers when using the Metric (SI) system.
Line Length Units: The line length units specify the measurement system to use when entering
the line length. The options are English system or Metric (SI) system. The final and intermediate
results will also be shown in the system specified here.
Power Base: The system voltampere base in MVA.
Voltage Base: The line-line voltage base in KV.
Impedance Base: The impedance base in Ohms. This value is automatically computed when the
power base and the voltage base are entered or modified.
Admittance Base: The admittance base in Siemens. It is also automatically computed as the
inverse of the impedance base.
Final Results
When all the input data is entered, the results automatically will be displayed. The values for R,
X, B and G are shown in three different sections, each section corresponding to Distributed,
Lumped or Total, and Per Unit values, respectively. The Power Surge Impedance Loading is
calculated only for the lumped section.
Intermediate Results
The intermediate values calculated to compute the R, X, B, and G values are displayed here. The
computed geometric mean radius and geometric mean distance are shown in the Distributed
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values section. The characteristic impedance and propagation factor are displayed in the Lumped
values section.
Note: To see the specific calculations used in this program, see the Calculations section, at the end
of this document.
Ampere to MVA Limit Conversion
This section converts the limits of the transmission line from Amperes to MVAs, given the voltage
base, and vice versa.
Conductor Type
This section is used to add, remove, rename, and edit the information related to the conductor types.
This can be done in two ways: using the form for an individual conductor type, or using the table for
all the conductor types available.
Edit By Form
Conductors are identified by a unique code word. All the available conductors are listed in the
Conductor Code Word combo box. By selecting one conductor, all its properties are displayed in the
form. There, the user is able to modify any of those values. After modification of any value, the user
has to save the changes by clicking on the button Save before changing tabs, otherwise the
changes will be lost.
By clicking on New, a message prompting for a name for a new conductor will be shown. By clicking
on Rename, a new name for the current conductor type is required. In order to save the current
conductor type with a different name is necessary to click on Save As. Finally, to remove the
current conductor the user can do so by clicking on the Delete button.
Edit By Table
In this tab, all the conductor types are shown as records in a table, where every field is a
characteristic of the conductor. In order to edit the records in this table, use the Database button
described in the Database section. While editing the table, the user can not change of tab until
changes are posted or discarded.
Conductor Properties
The available properties of the conductors are the following:
Code Word: Code name for the type of conductor. The names of bird species are typically used.
Code Word has to be unique.
Area: The area of aluminum conductor in circular mils. A circular mil is the cross-sectional area of
a circular conductor having a diameter of 1 mil. One mil is one thousandth of an inch (0.001").
Aluminum strands: Number of aluminum strands.
Steel layers: Number of steel strands.
Aluminum layers: Number of aluminum layers.
External diameter: Outside diameter of the conductor in inches.
GMR: Geometric Mean Radius in feet.
DC Resistance: DC resistance of the conductor at 20°C per 1 mile in Ohms.
AC Resistance 25: AC resistance of the conductor at 60 Hz and 25°C per 1 mile in Ohms.
AC Resistance 50: AC resistance of the conductor at 60 Hz and 50°C per 1 mile in Ohms.
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AC Resistance 75: AC resistance of the conductor at 60 Hz and 75°C per 1 mile in Ohms.
Inductive Reactance: Inductive reactance per conductor at 1 foot spacing at 60 Hz in Ohms/mile.
Capacitive Reactance: Capacitive reactance per conductor at 1 foot spacing at 60 Hz in
MegaOhms/mile.
Tower Configuration
This part is used to add, remove, rename, and edit the information related to the tower configurations.
This can be done in two ways: using the form for an individual tower configuration, or using the table
for all the tower configurations available.
Edit By Form
Tower configurations are identified by a unique name. All the available tower configurations are
listed in the Tower Configuration Name combo box. By selecting one specific tower configuration, all
its characteristics are displayed in the form. There, the user can modify any of those characteristics.
After modification of any value, the user has to save the changes by clicking on the button Save
before changing tabs, otherwise the changes will be lost.
By clicking on New, a message prompting for a name for a new tower configuration will be shown.
By clicking on Rename, a new name for the current tower configuration is required. In order to
save the current tower configuration with a different name is necessary to click on Save As. Finally,
to remove the current tower configuration the user can do so by clicking on the Delete button.
Edit By Table
In this tab, all the tower configurations are shown as records in a table, where every field is a value
of the tower configuration. In order to edit the records in this table, use the Database button
described in the Database section. While editing the table, the user can not change of tab until
changes are posted or discarded.
Tower Configuration Values
The values of the tower configuration are the following:
Name: Name for the tower configuration. Name has to be unique.
Phase spacing: x and y coordinates of phases A, B and C positions. Values are in feet for English
system and meters for Metric (SI) system. When these values are modified, the phase spacing
graph is automatically updated. Draw axis has to be checked for x and y axis to be drawn in the
graph.
Conductors per bundle: This section specifies the number of conductors (either single conductor
or a bundle of conductors) per phase. The maximum number of conductors per bundle allowed is
4.
Use regular spacing: When using a bundle of conductors, checking the Use Regular Spacing of
check box will use the specified value as a regular spacing among the conductors. If the Use
Regular Spacing of check box is not checked, then the custom conductors spacing section has
to be used.
Conductors spacing: x and y coordinates of the conductors in the bundle. Values are in feet for
English system and meters for Metric (SI) system. When these values are modified, the bundle
spacing graph is automatically updated. Draw axis has to be checked for x and y axis to be
drawn in the graph.
Temperature: Assumed temperature in Fahrenheit degrees for English system and Celsius
degrees for Metric (SI) system.
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Frequency: Frequency of the system in Hertz.
System of units: The system of units used to specify the values of the tower configuration. The
options are English system or Metric (SI) system. The units specified here not necessarily have to
math the units specified in the Input Data section.
Database
The conductor type and tower configurations tables are read by default from the file
conductors.mbd, which is a MS Access® database. This database can be read from another *.mdb
file by clicking on the Select Conductors and Configurations Database button.
Note: The conductors.mdb file can also be viewed and edited in MS Access®.
In order to edit a record in the database tables, the user can use the toolbar designed to do that.
Following there is a figure showing this toolbar:

The First, Prior, Next, and Last buttons are used to move among records. The Insert, Delete and
Edit buttons are used to insert, delete or edit the current record, respectively. While editing a record,
the user can not change of tab until modifications are posted through the Post edit button or
canceled with the Cancel edit button. The Refresh data button just refreshed the data of the entire
table.
Calculations
Distributed Parameters
Resistance

Where:
330
©2011 PowerWorld Corporation

Rt AC resistance at temperature t per phase per 1 mile in Ohms
t Assumed temperature in Celsius degrees
R25 AC resistance of the conductor at 60 Hz and 25°C per 1 mile in Ohms
R50 AC resistance of the conductor at 60 Hz and 50°C per 1 mile in Ohms
R75 AC resistance of the conductor at 60 Hz and 75°C per 1 mile in Ohms
N Number of conductors per phase
Inductive Reactance

Where:

XL Inductive reactance in Ohms/meter
f

Frequency of the system in Hertz
Geometric mean distance between phases in meters
Geometric mean radius between conductors of one phase in meters

The geometric mean distance between phases is defined as:

Where:
Distances between phases a-b, b-c, c-a, respectively in meters
The geometric mean radius between conductors of one phase is defined as:

For 1 stranded conductor
For 1 solid cylindrical conductor

For more then 1 conductor bundle
Where:
Geometric mean radius in meters

r External radius of conductor in meters
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GMR Geometric mean radius given in tables for one stranded conductor
Distance between conductors k and m in meters.
Note: If k = m, then

=

for one stranded or solid cylindrical conductor.

Susceptance

Where:

B Susceptance in Siemens/meter
f Frequency of the system in Hertz
 Constant permittivity = 8.85418 10-12
Geometric mean distance between phases, defined as above
Geometric mean radius between conductors of one phase using external radius in meters
The geometric mean radius between conductors of one phase using external radius is defined as:

For 1 conductor

For more then 1 conductor bundle
Where:
Geometric mean radius in meters

r External radius of conductor in meters
Distance between conductors k and m in meters.
Note: If k = m, then

= r.

Conductance
Assumed G = 0
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Where:

G Conductance in Siemens/meter
Lumped (Total) Parameters
Resistance, Inductive Reactance, Conductance and Susceptance, using the equivalent 
circuit (long line)

Where:

Z’ Total series impedance of line in Ohms
Y’ Total series admittance of line in Siemens
R’ Total series resistance of line in Ohms
X’ Total series inductive reactance of line in Ohms
G’ Total series conductance of line in Siemens
B’ Total series susceptance of line in Siemens
Zc Characteristic impedance in Ohms
 Propagation constant in meters-1
Line length in meters
The characteristic impedance and propagation constant are defined as:

Where:

z Distributed series impedance in Ohms/meter
y Distributed series admittance in Siemens/meter
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The distributed series impedance and distributed series admittance are defined as:

Where:

R Distributed series resistance in Ohms/meter
X Distributed series inductive reactance in Ohms/meter
G Distributed series conductance in Siemens/meter
B Distributed series susceptance in Siemens/meter
Surge Impedance Loading
The surge impedance loading is defined as the power delivered by a lossless line to a load resistance
equal to the surge (or characteristic) impedance Zc, and is given by:

Where:

PSIL Total surge impedance loading in a three-phase line in VA
VN Line-line nominal voltage in Volts
Base Values
Impedance Base

Where:
Impedance base in Ohms
Power base in VA
Line-line voltage base in Volts
Admittance Base
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Where:
Admittance base in Siemens
Impedance base in Ohms
Per Unit (PU) Parameters
Resistance, Inductive Reactance, Conductance, Susceptance

Where:

RPU Per unit resistance
R’ Total series resistance in Ohms
XPU Per unit Inductive reactance
X’ Total series inductive reactance in Ohms
XPU Per unit conductance
G’ Total series conductance in Siemens
BPU Per unit susceptance
B’ Total series susceptance in Siemens
ZB Impedance base in Ohms
YB Admittance base in Siemens
MVA To Ampere and Ampere To MVA Limits Conversion
MVA to Ampere Limit Conversion
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Where:

LimAmp Limit in Amperes
LimMVA Limit in MVAs
VN Nominal voltage in Volts
Ampere to MVA Limit Conversion

Where:

LimAmp Limit in Amperes
LimMVA Limit in MVAs
VN Nominal voltage in Volts

336
©2011 PowerWorld Corporation

Branch Options: Transformer Control
Transformers are used to transfer power between different voltage levels or to regulate real or
reactive flow through a particular transmission corridor. Most transformers come equipped with taps
on the windings to adjust either the voltage transformation or the reactive flow through the
transformer. Such transformers are called either load-tap-changing (LTC) transformers or tapchanging-under-load (TCUL) transformers.
Another type of transformer is known as a phase-shifting transformer (phase shifter or phase angle
regulator). Phase-shifting transformers, which are less common than LTC transformers, vary the angle
of the phase shift across the transformer in order to control the MW power flow through the
transformer.
Options for specifying transformer control are found on the Transformer Control tab of the Branch
Options dialog when in Edit mode and the Transformer tab of the Branch Information Dialog when in
Run mode.
Off-nominal Turns Ratio and Phase Shift Degrees
The Off-nominal Turns Ratio field indicates the voltage transformation, while the Phase Shift
Degrees field show the phase shift angle. If the transformer is not on automatic control, these
values can be changed manually. The off-nominal tap ratio determines the additional transformation
relative to the nominal transformation. This value normally ranges from 0.9 to 1.1 (1.0 corresponds
to no additional transformation). For phase-shifting transformers the phase shift value normally
ranges from about -40 to 40. The phase angle field can be non-zero for LTC and fixed
transformers, most notably +/- 30 if the transformer configuration is a delta-wye or wye-delta
configuration. The transformer configuration is very important when performing a fault analysis
study.
Automatic Control Type provides the type of transformer. Valid types are 1) No Automatic Control
(in which the taps are assumed fixed), 2) voltage regulation (AVR), 3) Reactive Power Control, and 4)
Phase Shift Control.
Simulator provides you with a great deal of flexibility in being able to specify which transformers will
actually be used for automatic control in the Power Flow Solution. For a transformer to be used for
voltage or flow control, three criteria must be met:





For an LTC transformer, the transformer's Automatic Control Enabled field must be checked.
This field can also be modified on the Transformer Records display. When the transformer is a
phase shifter, the Automatic Control Enabled field has three options. Select Not Enabled to
completely disable the phase shifter for automatic control. Select Enabled for Power Flow to allow
automatic control actions during the power flow solution. Select Enabled for OPF Only to allow the
phase shifter to be a control as part of the OPF solution but not on automatic control as part of the
power flow solution.
The transformer's area must have automatic transformer control enabled. This is specified on the
Options Tabof the Area Records display.
Transformer control must not be disabled for the entire case. This is specified on the Power Flow
Solution Tab of the Simulator Options Dialog. Automatic control for LTC transformers and phase
shifters can be disabled separately at the case level.

The type of transformer can be changed on the Transformer Control Info dialog opened by clicking
the Change Automatic Control Options... button. This dialog contains different information
depending on the type of transformer control that is selected. The Common Options tab of this
337
©2011 PowerWorld Corporation

dialog allows changing the control type while in Edit mode and displays the type of control while in
Run mode. The type CANNOT be modified while in Run mode. The Time Step Options tab contains
control options specific for the Time Step Simulation tool.
The type-specific information contained on the Common Options tab is described below:
No Automatic Control
On this control setting the transformer will operate at the given off-nominal turns ratio and phase
shift, and will remain fixed at those values during the entire solution process unless manually
changed by the user.
AVR (Automatic Voltage Regulation)
When on automatic voltage control, the transformer taps automatically change to keep the
voltage at the regulated bus (usually one of the terminal buses of the transformer) within a
voltage range between the minimum voltage and maximum voltage values (given in per unit).
The Transformer Control Info dialog is configured as the Transformer AVR Dialog when this
control type is selected. Note that automatic control is possible only if a regulated bus has been
specified.
The tap position for an LTC transformer is indicated on the oneline by the number of tap step
positions from the nominal position (i.e., the position when the off-nominal tap ratio is equal to
1.0). When the off-nominal ratio is greater than 1.0, the transformer's tap is said to be in the
"raise" position, and an 'R' appears after the number. Likewise, when the off-nominal ratio is less
than 1.0, the transformer's tap is said to be in the "lower" position, and an 'L' appears after the
number. For example, with a step size of 0.00625 and an off-nominal ratio of 1.05, the tap would
be in position 8R. The tap position can be changed manually only when the transformer has been
set off automatic voltage control.
Simulator will also detect instances when controlling transformers are in parallel, and will employ
checks during the solution routine to prevent the controllers from fighting each other and
potentially going to opposite tap solutions, which could result in unwanted loop flow through the
transformer objects. This option is enabled by default, but can be turned off in the Power Flow
Solution Advanced Options.
Transformer Reactive Power Control
When on automatic reactive power control, the transformer taps automatically change to keep
the reactive power flow through the transformer (measured at the from bus) within a userspecified range. When this control type is selected, the Transformer Control Info dialog is
configured as the Transformer Mvar Control Dialog.
Phase Shift Control
When a transformer is on phase shift control, the transformer phase shift angle automatically
changes to keep the MW flow through the transformer (measured at the from bus) between the
minimum and maximum flow values (given in MW, with flow into the transformer assumed
positive). The limits on the phase shifting angles are specified in the minimum and maximum
phase fields (in degrees). When this control type is selected, the Transformer Control Info dialog
is configured as the Transformer Phase Shifting Dialog. The phase shift angle changes in discrete
steps, with the step size specified in the Step Size field (in degrees). The MW Per Phase
AngleStep Size provides an estimate of the change in the controlled MW flow value if the phase
angle is increased by the step size value.
Area and Case Control Options
This set of options is available when in Run mode and provides a summary of the area and case
level options for allowing automatic transformer control. These settings are provided for
informational purposes only and cannot be set here.
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Area Transformer Control Enabled has to be checked for any transformer in that area to be
controlled (phase shifter control must be enabled for power flow); Case LTC Transformer Control
Enabled has to be checked for any LTC type (Voltage Regulation (AVR) or Reactive Power Control)
transformer in the entire case to be controlled, and Case Phase Shifter Control Enabled has to
be checked for any phase shifter in the entire case to be controlled.
Specify Transformer Bases and Impedances
Shows the Transformer Bases and Impedances Dialog. This dialog allows the user to specify the
transformer parameters in per unit on the transformer base (taken as its rating). Click OK to convert
all the transformer parameters values to the system base specified in the Power Flow Solution
General Options.
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Transformer AVR Dialog
The Transformer AVR Dialog is used to view the control parameters associated with load-tap-changing
(LTC) transformers when they are used to control bus voltage magnitudes. To view this dialog, click
the Change Automatic Control Options button found with the Transformer Control options,
provided that the Voltage Regulation (AVR) option is chosen from the Automatic Control Type
group.
The Common Options tab of this dialog has the following fields:
Automatic Control Type
This section is only visible on the dialog in edit mode. The control type of the transformer can be
changed between no control, voltage regulation, reactive power control, or phase shifter control.
Changing the control type will update the dialog to reflect the type of control that is selected.
Regulated Bus Number
The number of the bus whose voltage is regulated by the control.
Present Regulated Bus Voltage
The present voltage of the regulated bus.
Voltage Error
If the regulated bus' voltage falls outside the regulating range of the transformer (as defined by
the Regulation Minimum Voltage and Regulation Maximum Voltage fields), the Voltage
Error field indicates by how much the voltage deviates from the control range.
Regulation Minimum Voltage
The minimum acceptable voltage at the regulated bus.
Regulation Maximum Voltage
The maximum acceptable voltage at the regulated bus.
Regulation Target Type
As long as the regulated voltage is inside the regulation minimum and maximum, the transformer
will not change its tap ratio. When the regulated voltage moves outside of this regulation range,
Simulator will calculate a new tap ratio in an attempt to bring the regulated voltage back inside
of its range. The Regulation Target Type determines what value is used as a target when
calculating this change in tap ratio. Middle is the default and means that the target is the
average of the regulation minimum and maximum regardless of whether the voltage is high or
low. Max/Min means that the regulation maximum is used as the target when the regulated
voltage is above the maximum, and regulation minimum is used as the target value when the
regulated voltage is below the minimum.
Present Tap Ratio
The tap ratio of the transformer for the current system state.
Minimum Tap Ratio, Maximum Tap Ratio
Minimum and maximum allowable off-nominal tap ratios for the LTC transformer. Typical values
are 0.9 and 1.1.
Tap Step Size
Transformer off-nominal turns ratio increment. The off-nominal turns ratio is either incremented
or decremented from 1.0 in integer multiples of this value. Default value is 0.00625.
Voltage to Tap Sensitivity
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Shows the sensitivity of the voltage magnitude at the regulated bus to a change in the
transformer's tap ratio. You can use this field to assess whether or not the transformer can
effectively control the regulated bus voltage. In an ideal case, such as when the LTC transformer
is being used to control the voltage at a radial load bus, the sensitivity is close to 1.0 (or -1.0
depending upon whether the tapped side of the transformer is on the load side or opposite side
of the transformer). However, sometimes the transformer is very ineffective in controlling the
voltage. This is indicated by the absolute value of the sensitivity approaching 0. A common
example is a generator step-up transformer trying to control its high-side voltage when the
generator is off-line. Simulator automatically disables transformer control if the transformer
sensitivity is below the value specified on Power Flow Solution Tab of the Simulator Options
dialog.
Line Drop/Reactive Current Compensation
Typical specification of the bus at which the voltage should be controlled by a transformer is an
actual bus in the power system model. However, some control schemes require that the voltage
at some fictitious bus a specified impedance away from the transformer be controlled instead.
This can be accomplished using the line drop and reactive current compensation control method.
This method requires that the regulated bus for a transformer be specified as one of the
transformer's terminal buses. This provides a reference point for specifying the location of the
fictitious bus that is the actual controlled point. An impedance must also be specified that will
determine the location of the fictitious bus in reference to the selected regulated bus.
Check the Use Line Drop/Reactive Current Compensation checkbox to use this control
method. Specify the impedance for the location of the fictitious controlled bus using the Line
Drop/Reactive Current Compensation Resistance (R) and Line Drop/Reactive Current
Compensation Reactance (X) fields. The impedance should be specified in per-unit.
Impedance Correction Table
This field specifies the number of the transformer's corresponding transformer impedance
correction table. Transformer impedance correction tables are used to specify how the
impedance of the transformer should change with the off-nominal turns ratio. If this number is 0,
then no impedance correction table is associated with the transformer, and the impedance of the
transformer will thus remain fixed as the tap ratio changes. Valid impedance correction table
numbers range from 1 to 63. To assign an existing impedance correction table to the
transformer, enter the existing table's number. To view the existing impedance correction tables,
click the Insert/View Impedance Correction Table button, which brings up the Transformer
Impedance Correction Dialog. To define a brand new impedance correction table for the
transformer, enter an unused table number and then click Insert/View Impedance
Correction Table to prescribe the correction table. Note that the association between a
transformer and an impedance correction table is not finalized until you select either OK or Save
on the Branch Information Dialog or Branch Options dialog.
View Transformer Correction Table or Insert Transformer Correction Table
Click on this button either to view or to insert transformer correction tables. Clicking on this
button displays the Transformer Impedance Correction Dialog. Note that a table must contain at
least two points in order to be defined.
The Time Step Options tab contains control options specific for the Time Step Simulation tool.
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Branch Options: Series Capacitor
The Series Capacitor tab of the Branch Options dialog displays information related to a series
capacitor, including its status.
Status
The capacitor itself has two status positions, Bypassed and In Service. When the series capacitor
is in service, the branch is modeled as a reactive branch, using the line parameters from the
Parameters page. If the capacitor is bypassed, a low impedance branch is introduced to bypass the
capacitor. Note that this is not the same as the branch status of Open or Closed. The branch status
is the indicator of whether or not the entire circuit is operating (closed), regardless of Bypassed or
In Service status on the capacitor itself.
Is Series Capacitor
If this box is checked, the branch can be treated as a series capacitor, with the series Status of
Bypassed or In-Service available.
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Multi-Section Line Information
Multi-section line records are used to group a number of series-connected transmission lines together
so that their status is controlled as a single entity. They are usually used to model very long
transmission lines that require multiple individual transmission line records if they are to be modeled
accurately. In terms of line status, Simulator then treats each multi-section line as a single device. In
other words, changing the status of one line in the record changes the status of the other lines in the
record, as well.
Multi-section line records are not directly represented on the oneline diagrams. Rather, to view this
dialog, right-click the record of interest on the Multi-Section Line Records display and select Show
Dialog from the resulting local menu. To define a new multi-section line, switch to Edit Mode and,
from the Multi-Section Line Records display, right-click and select Insert from the resulting local
menu.
Note: If any of the transmission lines comprising a multi-section line record are deleted, the entire
multi-section line record is deleted as well.
The Multi-Section Lines Dialog contains the following fields:
From Bus Number and Name
Number and name of the from bus for the record. If you are defining a new multi-section line, this
must be the first data item you specify.
To Bus Number and Name
Number and name of the "to" bus for the record. You cannot specify this value directly. Instead, use
the table at the bottom of the dialog to define the intermediate buses and to terminal.
Circuit
Two character identifier used to distinguish between multiple records joining the same from/to
buses. The first character of the circuit identifier must be an "&."
You can use the spin button immediately to the right of the circuit field to view other multi-section
line records. However if you have changed the record, you must select Save before moving to
another record. Otherwise, your changes will be lost.
From End Metered
If checked, the from end of the record is the metered end; otherwise the to end is metered.
Multi-Section Line Name
The name for the multi-section line.
Table
The table lists the dummy (or intermediate) buses and the to bus that comprise the record. The first
column should contain the first dummy bus number and the circuit ID of the transmission line
joining the from bus with the first dummy bus. The next column should contain the second dummy
bus number and the circuit id of the transmission line joining this bus to the first dummy bus.
Continue until the last column contains the to bus and the circuit ID of the transmission line joining
the last dummy bus with the "to" bus.
Each transmission line comprising the multi-section line must already exist. If only one transmission
line joins any two buses, you may omit the circuit identifier.
OK
Saves any modifications and closes the dialog.
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Save
Saves any modifications but does not close the dialog.
Cancel
Closes the dialog without saving modifications to the current record.
Delete
Deletes the current multi-section line record.
Note: If any of the transmission lines comprising a multi-section line record are deleted, the entire
multi-section line record is deleted as well. One exception is if a section or sections of a multi-section
line are removed by merging the section terminal buses together into a single bus. If special conditions
are met, the multi-section line record will be maintained.

344
©2011 PowerWorld Corporation

Line Field Options
Line field objects are used to show different values associated with transmission lines, transformers
and DC lines. This dialog is used to view and modify the parameters associated with these fields.
Find…
If you do not know the exact line identifiers you are looking for, you can click this button to open
the advanced search engine.
Near Bus Number
Bus associated with the near end of the object. All fields display values calculated at the near bus
end. When inserting fields graphically, this field is automatically set to the closest bus on the
oneline.
Far Bus Number
Bus associated with the far end of the object.
Circuit
Two-character identifier used to distinguish between multiple lines or transformers joining the same
two buses. Default is ‘1’.
Total Digits in Fields
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Delta Per Mouse Click
Only used with the MVA Limit field type. Specifying a nonzero value for this field equips the MVA
Limit Field with an integrated spin button that can be clicked to increment or decrement the MVA
Limit by the amount of the Delta Per Mouse Click value.
Field Value
The current value of the field being displayed.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Rotation Angle in Degrees
The angle at which the text will appear on the diagram.
Anchored
If checked, the line analog is anchored to its associated line.
Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
Used to determine the type of line field to show. The following choices are available:
AC Line MW Flow MW flow into the line or transformer at the near bus
AC Line Mvar Flow Mvar flow into the line or transformer at the near bus
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AC Line MVA Flow Magnitude of MVA flow into the line or transformer at the near bus
AC Line Amp Flow Magnitude of Amp flow (in amps) into the line at the near bus
AC Line MW Losses Real power losses on the line or transformer in MW
AC Line Mvar Losses Reactive power losses on the line or transformer in Mvar
DC Line MW Flow MW flow into the DC line at the near bus
DC Line Mvar Flow Mvar flow into the DC line at the near bus
MVA Limit MVA limit for the line or transformer
DC Line Set point Set point value for the DC line; see DC Transmission Line dialog
Select a Field Choose from over 80 different fields
Select OK to save changes and close the dialog or Cancel to close the dialog without saving your
changes.
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Series Capacitor Field Options Dialog
Series capacitor field objects are used to show field values specific to series capacitors. Use Line Fields
to show fields generic to transformers, series capacitors and transmission lines, such as the flow of
power through the device. The series capacitor fields dialog is used to view and modify the parameters
associated with series capacitor specific fields.
Near Bus Number
Bus associated with the near end of the series capacitor.
Far Bus Number
Bus associated with the far end of the series capacitor.
Circuit
Two-character identifier used to distinguish between branches joining the same two buses. Default
is '1'.
Anchored
When checked, the text field will move with the series capacitor if the series capacitor is moved on
the oneline diagram.
Total Digits in Field
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Rotation Angle in Degrees
The angle at which the text will be placed.
Field Value
The value of the currently selected field.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
Designates the type of transformer field to show. The following choices are available:
Status Capacitor status
Series Capacitance Capacitance of series capacitor
Select OK to save changes and close the dialog or Cancel to close dialog without saving your changes.
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Transformer Field Options Dialog
Transformer field objects are used to show field values specific to transformers. Use Line Fields to
show fields generic to transformers and transmission lines, such as the flow of power through the
device. The transformer fields dialog is used to view and modify the parameters associated with
transformer-specific fields.
Near Bus Number
Bus associated with the near end of the transformer.
Far Bus Number
Bus associated with the far end of the transformer.
Circuit
Two-character identifier used to distinguish between transformers joining the same two buses.
Default is '1'.
Find…
If you do not know the exact transformer you are looking for, you can click this button to open the
advanced search engine.
Total Digits in Field
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Delta per Mouse Click
This value is used only with the Off-nominal Tap Ratio and Phase Shift Angle field types. When
there is a nonzero entry in this field, and the field type is valid, a spin button is shown to the right of
the zone field. When the up spin button is clicked, the field value is increased by this number; when
the down button is clicked, the field value is decreased by this amount.
Field Value
Shows the current output for the transformer field. Whenever you change the Type of Field
selection, this field is updated.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Rotation Angle in Degrees
The angle at which the text is to appear on the oneline diagram.
Anchored
When checked, the text field will move with the transformer if the transformer is moved on the
oneline diagram.
Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
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Designates the type of transformer field to show. The following choices are available:
Off-nominal Tap Ratio Actual tap ratio
Phase Shift Angle Actual phase shift in degrees
Off-nominal Tap Position Tap position in steps, usually ranging from L16 to R16
Automatic Control Status The status of the control for the transformer
Select OK to save changes and close the dialog or Cancel to close dialog without saving your changes.
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DC Transmission Line Options
This dialog is used to view and modify the parameters associated with each two-terminal DC
transmission line in the system. It can also be used to insert new two-terminal DC transmission lines or
to delete existing ones.
This dialog has separate pages: Line Parameters, Rectifier Parameters, Inverter Parameters, Actual
Flows, OPF, Custom, and Stability. The Actual Flows page is not used in Edit Mode. The separate
pages can be accessed using the tabs shown at the top of the dialog. These pages can be used to
view/change the modeling parameters associated with the DC lines.
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DC Line Options: Line Parameters
This page is used to enter parameters associated with the DC line itself.
Rectifier and Inverter Bus Numbers and Names
These fields indicate the numbers and names of the rectifier and inverter ends of the line. When
graphically inserting a DC line, these fields are automatically determined based upon the starting
and ending buses used in drawing the line. When investigating existing DC line records, you may use
the Find By Numbers button to identify a DC line between a specific rectifier - inverter pair. You may
also use the spin control to cycle through the list of DC line records modeled in the case.
Circuit ID
This field is not currently used, since only one DC transmission line can exist between each inverterrectifier pair. It is hard-coded to be 1.
Find By Numbers
To find a DC line by its bus numbers, enter the Rectifier and Inverter bus numbers and the circuit
identifier. Then click this button. Use the spin button to cycle through the list of DC lines in the
system.
Area Name
Names of the areas in which the rectifier and inverter buses are located.
Labels
Clicking this button will open the Subscribed Aliases dialog displaying the list of defined labels for the
DC line. New labels can also be added for the DC Line from the dialog as well.
Link to New DC Line
Use the Link to New DC Line button to create a new DC line corresponding to the entries you have
made in the dialog. This button performs the same function as pressing Save. Note that adding a
new DC line to the case in this way does not add a DC line to the oneline display; the new DC line is
present only in the model. You may then add the newly modeled DC line to the oneline diagram in
the usual way (such as select Network > DC Transmission Line from the Individual Insert ribbon
group on the Draw ribbon tab).
Line Parameters
Status
Operating status of the DC transmission line. If the status is Open, then no power can flow on the
DC line regardless of the control mode setting. If the status is closed, then the control mode will
dictate how power flows on the line.
Control Mode
The initial control mode for the line. Specify Blocked to disable the DC line, Power to maintain
specified MW power flow through the line, or Current to maintain specified current flow through the
line.
Setpoint
If the line operates in the Power Control Mode, Setpoint should indicate the desired power flow in
MW. To specify power flow at the rectifier end, enter a positive value. Enter a negative value to
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specify power flow at the inverter end. If the DC line operates in Current Control Mode, enter the
desired line flow in amps.
Resistance
Resistance of the DC Line.
Sched. Voltage
Scheduled DC line voltage in kV. The value of Rcomp is used to determine whether this value
specifies the inverter end or the rectifier end.
Switch Voltage
When the line operates in the Power Control Mode, this is the inverter voltage level in kV at which
the line switches from constant power to constant current control.
RComp
Compounding resistance. The compounding resistance dictates whether the inverter voltage is
scheduled (Rcomp = 0), or the rectifier voltage is scheduled (Rcomp = DC line resistance). Simulator
does not currently support scheduling the voltage at a point along the DC line (0 < Rcom < DC line
resistance), but instead will treat any non-zero value of Rcomp as scheduling the voltage at the
rectifier.
Setpoint Specified At
Indicates which end of the DC transmission line the Setpoint value is designated. This will be the
terminal where the setpoint value is maintained. The opposite terminal flow value will be a
calculated quantity.
Metered End of Line
Indicates which end of the DC line is assumed metered for Area interchange calculations.
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DC Line Options: Rectifier Parameters
This page is used to enter parameters associated with the rectifier end of the line.
# of Bridges
Number of valve bridges in series.
Base Voltage
Base AC voltage in kV on primary side of transformer.
XF Ratio
Transformer ratio.
XF Tap
Transformer tap setting.
XF Min/Max Tap, XF Tap Step
Transformer minimum and maximum tap settings, and the tap's step size.
Commuting XF Resistance and Reactance
Commuting resistance and reactance for the transformer, in ohms.
Minimum, Maximum, and Actual Firing Angle
Minimum, maximum, and actual values of the firing angle for the rectifier.
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DC Line Options: Inverter Parameters
This page is used to enter parameters associated with the inverter end of the line. Entries are identical
to the Rectifier Page, except here they are associated with the inverter.
# of Bridges
Number of valve bridges in series.
Base Voltage
Base AC voltage in kV on primary side of transformer.
XF Ratio
Transformer ratio.
XF Tap
Transformer tap setting.
XF Min/Max Tap, XF Tap Step
Transformer minimum and maximum tap settings, and the tap's step size.
Commuting XF Resistance and Reactance
Commuting resistance and reactance for the transformer, in ohms.
Minimum, Maximum, and Actual Firing Angle
Minimum, maximum, and actual values of the firing angle for the rectifier.
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DC Line Options: Actual Flow
Shows the actual real and reactive power flows into the line at the rectifier and the inverter, as well as
the voltage at both ends (in kV) and the line current in amps. The contents of this page are valid only
when Simulator is in Run Mode.
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DC Line Options: OPF
This page is used to enter parameters associated with the OPF.
Rectifier/Inverter Bus MW Marginal Costs
Displays the marginal costs of the branches terminal buses, following the solution of the OPF.
OPF Control
Minimum and Maximum Setpoint Value
The minimum and maximum setpoint allowed for the DC Line. When on OPF Control the DC Line
will be dispatched between these values.
Current Setpoint Value
The current Setpoint as found on the Line Parameters Tab.
Transmission Charge
This is the cost incurred for moving power across the DC transmission line. The cost is zero at a
zero MW flow and increases linearly using this charge.
OPF Control Enabled for this DC line
This check box must be checked if the DC limit is going to be enforced when running an OPF
solution. If this box is not checked, the OPF routine will allow the DC line to violate its limits.
Include Impact of DC Line Marginal Losses
When dispatching the DC Line this determines whether the marginal losses from the DC line are
taken into account.
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VSC DC Line Dialog
Simulator allows the modeling of newer types of Voltage Source Converter DC lines, which use
Insulated Gate Bipolar Transistors (IGBT) and Gate Turn-off Thyristors (GTO) to perform pulse-width
modulation or multi-level switching. They are also referred to as "HVDC Light" (ABB) or "HVDC Plus"
(Siemens).
For power flow purposes, these devices are simple: they completely decouple real and reactive power
controls.
There is currently no way to display VSC DC lines on oneline diagrams. However, they are displayed in
Bus View (in a similar manner to Multi-Terminal DC Lines), Power Flow, and Quick Power Flow lists.
VSC DC Name
Name of the VSC DC Transmission Line. This is the unique identifier for the device. The dialog field
is not editable itself, but the name can be changed with the "Rename" button.
To/From Converter
Gives information about the endpoint buses: the numbers, names, and associated Substations and
Areas. These fields are not editable, the information displayed here can only be changed through the
buses themselves. The connected buses can be changed on the Converter Parameters tab below.
Status
Allows the line to be opened or closed.
Resistance
Set the resistance of the line.
Converter Parameters Tab
This tab gives control over the parameters for the converters on each end of the line.

Terminal Bus
Allows the connected buses to be set.
DC Setpoint
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Specifies the DC control mode for each converter, either Out-Of-Service, Voltage, or Power.

AC Setpoint
Specifies the AC control mode for each converter, either per unit Voltage or Power Factor. If the
AC control mode is set to Voltage and the other converter is out of service, it acts as an SVC.
Regulated Bus, Remote Regulation %
When the AC mode is Voltage, the Regulated Bus does not have to be the converter AC terminal.
If this is blank, it signifies it regulated its own terminal. For more information on Remote
Regulation, refer to the Generator Information Power and Voltage Control page.
A loss, B loss
The converter losses for each end are defined as:
Minimum Loss
If this field is specified, it sets a lower bound on the value calculated from A loss, Bloss and IDC
Maximum AC MVA
Converter MVA rating specified in MVA. If set to 0, there is no limit.
Maximum AC Current
Converter current rating in amps. If set to 0, there is no limit.
Power Weighting Factor
Power weighting factor is a value between 0 and 1. It is used to reduce real and reactive power
when limits are hit.
Maximum Mvar
Maximum Mvar injection into the AC network. This is used only when the AC mode is Voltage.
Minimum Mvar
Minimum Mvar injection into the AC network. This is used only when the AC mode is Voltage.
Flows and Voltages Tab
These fields are not editable.
AC MW Flow
The real power flow on the AC side of the converter.
AC MVar Flow
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The reactive power on the AC side of the converter.
DC MW Flow
The power flow on the DC side of the converter.
DC Voltage
The voltage on the DC side of the converter, in kV.
DC Line Current
The current flowing on the DC line, in amps.
Custom Tab
Tab containing Custom Fields.
Stability Tab
Tab for configuring the VSCDC Line Model for stability analysis
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Multi-Terminal DC Record Information
This dialog is used to view and modify the parameters associated with multi-terminal DC records. It is
also used when inserting new multi-terminal DC records.
The Multi-Terminal DC Record dialog can be used to inspect and modify the model of a multi-terminal
DC network record. To view the Multi-Terminal DC Record, simply right-click on the record of interest
in the Multi-Terminal DC Record Display and select Show Dialog from the resulting popup menu. The
dialog has the following fields:
Record Number
Unique number between 1 and 999 which identifies the current multi-terminal DC record.
Number of Devices
Lists the number of DC buses, converters, and DC Lines that form the multi-terminal DC network.
Control
The control method used when solving the multi-terminal DC network.
Controlling Converter
The AC converter bus number where the DC voltage is being controlled.
MTDC Network Status
Status of the entire Multi-terminal DC network. If this field is set to Closed, the entire DC subnetwork
of the MTDC model is considered disconnected in the load flow case.
DC Buses Tab
This page of the dialog displays the DC bus records for the multi-terminal DC network. The display
on this page exhibits the same features as other case information displays. To view the specific
information for a DC bus, right-click on the record of interest and choose Show Dialog from the
popup menu.
DC Converters Tab
This page of the dialog displays the DC converter records for the multi-terminal DC network. The
display on this page exhibits the same features as other case information displays. To view the
specific information for a DC converter, right-click on the record of interest and choose Show Dialog
from the popup menu.
DC Lines Tab
This page of the dialog displays the DC line records for the multi-terminal DC network. The display
on this page exhibits the same features as other case information displays. To view the specific
information for a DC line, right-click on the record of interest and choose Show Dialog from the
popup menu.
Custom Tab
Enter any text notes you wish in the Memo page. When the case is saved as a Simulator PWB file,
the memo text will also be saved. Custom strings and values can also be entered and saved with the
case file as well.
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Multi-Terminal DC Bus Information
This dialog is used to view and modify the parameters specific to multi-terminal DC network buses.
The dialog is also used to enter values for new multi-terminal DC buses when inserting a MultiTerminal DC Record.
To view the Multi-Terminal DC Bus Record dialog, right-click on a bus record in the DC Buses tab of
the Multi-Terminal DC Record dialog and select Show Dialog from the resulting popup menu. The
dialog has the following fields:
DC Bus Number, DC Bus Name
The number and name identifiers for the selected DC bus.
AC Bus Number
The AC bus number connected to the DC bus through an AC/DC converter. If the selected DC bus is
a bus that is internal to the DC multi-terminal network (not directly connected to an AC bus,) this
field will be 0.
Area Number, Area Name
The number and name identifiers of the control area the DC bus is contained in.
Zone Number, Zone Name
The number and name identifiers of the zone the DC bus is contained in.
Ground Resistance
Resistance to ground of the DC bus, entered in Ohms. This field is currently only for storage of
values supported by other load flow formats, and is currently not used by Simulator.
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Multi-Terminal DC Converter Information
This dialog is used to view and modify the parameters specific to multi-terminal DC network buses.
The dialog is also used to enter values for new multi-terminal DC buses when inserting a MultiTerminal DC Record.
To view the Multi-Terminal DC Bus Record dialog, right-click on a bus record in the DC Buses tab of
the Multi-Terminal DC Record dialog and select Show Dialog from the resulting popup menu. The
dialog has the following fields:
Converter Parameters
Number of Bridges
Number of bridges in series for the selected converter.
Converter Type
R for rectifier or I for inverter.
Commutating Impedance
Commutating impedance per bridge, in Ohms.
Firing Angle Limits
The maximum and minimum firing angle limits, in degrees.
Transformer Parameters
AC Base
The primary AC base voltage, in kV.
DC Base
The DC base voltage, in kV.
Transformer Ratio
Actual transformer ratio.
Tap Settings
Displays the actual tap setting, the tap step, and maximum and minimum tap values for the
converter transformer.
Control Parameters
Setpoint
The setpoint control value at the converter. For the voltage-controlling converter, this field is set to
0. For the remaining converters, this field displays MW when in Power mode, or Amps when in
Current mode.
Margin
Rectifier margin, entered in per-unit of the DC power or current. This field is currently only for
support of other load flow formats, and is not used by Simulator.
DC Participation Factor
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Converter participation factor. This field is currently only for support of other load flow formats, and
is not used by Simulator.
Voltage
The DC Voltage magnitude at the DC side of the converter.
Solved Parameters
Firing Angle
The firing angle of the converter, as determined during the load flow solution.
DC Current
The calculated DC current at the converter DC terminal.
MW, MVAR
The real and reactive power delivered to (or absorbed from) the AC system by the converter.
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Multi-Terminal DC Line Information
This dialog is used to view and modify the parameters specific to multi-terminal DC network buses.
The dialog is also used to enter values for new multi-terminal DC buses when inserting a MultiTerminal DC Record.
To view the Multi-Terminal DC Bus Record dialog, right-click on a bus record in the DC Buses tab of
the Multi-Terminal DC Record dialog and select Show Dialog from the resulting popup menu. The
dialog has the following fields:
From and To DC Bus Number
The DC bus numbers of the From and To buses in the multi-terminal DC network. These fields must
contain valid DC bus numbers of the selected multi-terminal DC record. AC bus numbers from the
load flow case are not acceptable bus numbers for a multi-terminal DC line.
DC Circuit
The circuit identifier for the DC line.
DC Resitance and DC Inductance
The resistance and inductance of the DC line. Resistance is in Ohms, and is used for solving the load
flow of the DC network. The inductance is in milliHenries, and is not used for solving the load flow.
The inductance field is currently only for support of other load flow formats, and is not used by
Simulator.
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Branch Options: Transformer Control
Transformers are used to transfer power between different voltage levels or to regulate real or
reactive flow through a particular transmission corridor. Most transformers come equipped with taps
on the windings to adjust either the voltage transformation or the reactive flow through the
transformer. Such transformers are called either load-tap-changing (LTC) transformers or tapchanging-under-load (TCUL) transformers.
Another type of transformer is known as a phase-shifting transformer (phase shifter or phase angle
regulator). Phase-shifting transformers, which are less common than LTC transformers, vary the angle
of the phase shift across the transformer in order to control the MW power flow through the
transformer.
Options for specifying transformer control are found on the Transformer Control tab of the Branch
Options dialog when in Edit mode and the Transformer tab of the Branch Information Dialog when in
Run mode.
Off-nominal Turns Ratio and Phase Shift Degrees
The Off-nominal Turns Ratio field indicates the voltage transformation, while the Phase Shift
Degrees field show the phase shift angle. If the transformer is not on automatic control, these
values can be changed manually. The off-nominal tap ratio determines the additional transformation
relative to the nominal transformation. This value normally ranges from 0.9 to 1.1 (1.0 corresponds
to no additional transformation). For phase-shifting transformers the phase shift value normally
ranges from about -40 to 40. The phase angle field can be non-zero for LTC and fixed
transformers, most notably +/- 30 if the transformer configuration is a delta-wye or wye-delta
configuration. The transformer configuration is very important when performing a fault analysis
study.
Automatic Control Type provides the type of transformer. Valid types are 1) No Automatic Control
(in which the taps are assumed fixed), 2) voltage regulation (AVR), 3) Reactive Power Control, and 4)
Phase Shift Control.
Simulator provides you with a great deal of flexibility in being able to specify which transformers will
actually be used for automatic control in the Power Flow Solution. For a transformer to be used for
voltage or flow control, three criteria must be met:





For an LTC transformer, the transformer's Automatic Control Enabled field must be checked.
This field can also be modified on the Transformer Records display. When the transformer is a
phase shifter, the Automatic Control Enabled field has three options. Select Not Enabled to
completely disable the phase shifter for automatic control. Select Enabled for Power Flow to allow
automatic control actions during the power flow solution. Select Enabled for OPF Only to allow the
phase shifter to be a control as part of the OPF solution but not on automatic control as part of the
power flow solution.
The transformer's area must have automatic transformer control enabled. This is specified on the
Options Tabof the Area Records display.
Transformer control must not be disabled for the entire case. This is specified on the Power Flow
Solution Tab of the Simulator Options Dialog. Automatic control for LTC transformers and phase
shifters can be disabled separately at the case level.

The type of transformer can be changed on the Transformer Control Info dialog opened by clicking
the Change Automatic Control Options... button. This dialog contains different information
depending on the type of transformer control that is selected. The Common Options tab of this
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dialog allows changing the control type while in Edit mode and displays the type of control while in
Run mode. The type CANNOT be modified while in Run mode. The Time Step Options tab contains
control options specific for the Time Step Simulation tool.
The type-specific information contained on the Common Options tab is described below:
No Automatic Control
On this control setting the transformer will operate at the given off-nominal turns ratio and phase
shift, and will remain fixed at those values during the entire solution process unless manually
changed by the user.
AVR (Automatic Voltage Regulation)
When on automatic voltage control, the transformer taps automatically change to keep the
voltage at the regulated bus (usually one of the terminal buses of the transformer) within a
voltage range between the minimum voltage and maximum voltage values (given in per unit).
The Transformer Control Info dialog is configured as the Transformer AVR Dialog when this
control type is selected. Note that automatic control is possible only if a regulated bus has been
specified.
The tap position for an LTC transformer is indicated on the oneline by the number of tap step
positions from the nominal position (i.e., the position when the off-nominal tap ratio is equal to
1.0). When the off-nominal ratio is greater than 1.0, the transformer's tap is said to be in the
"raise" position, and an 'R' appears after the number. Likewise, when the off-nominal ratio is less
than 1.0, the transformer's tap is said to be in the "lower" position, and an 'L' appears after the
number. For example, with a step size of 0.00625 and an off-nominal ratio of 1.05, the tap would
be in position 8R. The tap position can be changed manually only when the transformer has been
set off automatic voltage control.
Simulator will also detect instances when controlling transformers are in parallel, and will employ
checks during the solution routine to prevent the controllers from fighting each other and
potentially going to opposite tap solutions, which could result in unwanted loop flow through the
transformer objects. This option is enabled by default, but can be turned off in the Power Flow
Solution Advanced Options.
Transformer Reactive Power Control
When on automatic reactive power control, the transformer taps automatically change to keep
the reactive power flow through the transformer (measured at the from bus) within a userspecified range. When this control type is selected, the Transformer Control Info dialog is
configured as the Transformer Mvar Control Dialog.
Phase Shift Control
When a transformer is on phase shift control, the transformer phase shift angle automatically
changes to keep the MW flow through the transformer (measured at the from bus) between the
minimum and maximum flow values (given in MW, with flow into the transformer assumed
positive). The limits on the phase shifting angles are specified in the minimum and maximum
phase fields (in degrees). When this control type is selected, the Transformer Control Info dialog
is configured as the Transformer Phase Shifting Dialog. The phase shift angle changes in discrete
steps, with the step size specified in the Step Size field (in degrees). The MW Per Phase
AngleStep Size provides an estimate of the change in the controlled MW flow value if the phase
angle is increased by the step size value.
Area and Case Control Options
This set of options is available when in Run mode and provides a summary of the area and case
level options for allowing automatic transformer control. These settings are provided for
informational purposes only and cannot be set here.
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Area Transformer Control Enabled has to be checked for any transformer in that area to be
controlled (phase shifter control must be enabled for power flow); Case LTC Transformer Control
Enabled has to be checked for any LTC type (Voltage Regulation (AVR) or Reactive Power Control)
transformer in the entire case to be controlled, and Case Phase Shifter Control Enabled has to
be checked for any phase shifter in the entire case to be controlled.
Specify Transformer Bases and Impedances
Shows the Transformer Bases and Impedances Dialog. This dialog allows the user to specify the
transformer parameters in per unit on the transformer base (taken as its rating). Click OK to convert
all the transformer parameters values to the system base specified in the Power Flow Solution
General Options.
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Transformers Bases and Impedances Dialog
Typically the impedances and tap values of transformers is already assumed to have been converted
to unity tap base and bus nominal voltage base. However, some load flow formats provide the taps
and impedances on specific transformer bases, which are different than the bus voltage and unity tap
base assumptions. In these cases, Simulator will convert parameters from the transformer bases to the
unity tap and bus nominal voltage base. Display of the impedances and tap values normally displayed
in the Branch Options dialog are displayed on the Simulator assumed bases. However, if you wish to
view the original transformer values on the transformer supplied bases, this dialog will display the
original values. You can modify the original values stored here in this dialog. Note that when you do
so, the converted values that Simulator stores on the system bases will also be automatically updated
to reflect the change that has been made to the original values on the transformer bases.
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Transformer Impedance Correction Table Display
The Transformer Impedance Correction Display shows information about all the transformer
impedance correction tables in the case. The Transformer Impedance Correction Display is used to
model the change in the impedance of the transformer as the off-nominal turns ratio or phase shift
angle is varied.
The Correction Display is a class of Case Information Display and therefore can be used in a manner
consistent with all other case information displays. It has a local menu from which you can print, copy,
and modify its information as well as view the information dialog of its associated correction tables.
When in Edit Mode, you can define new tables using the Insert option, or delete existing tables using
Delete. You can also sort the transformer impedance correction information by clicking on the heading
of the field by which you want to sort.
To show this display select Network > Impedance Correction Tables from the Model Explorer.
The display contains the following fields by default:
Table #, Table Name
Shows the table number and name for the record. Table number must be between 1 and 64.
Transformer Impedance Scaling Factors
The rest of the default columns show the actual fields in the table. The first field of each pair shows
the off-nominal turns ratio or phase shift angle, while the second field shows the associated scaling
factor for the transformer’s impedance.
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Transformer AVR Dialog
The Transformer AVR Dialog is used to view the control parameters associated with load-tap-changing
(LTC) transformers when they are used to control bus voltage magnitudes. To view this dialog, click
the Change Automatic Control Options button found with the Transformer Control options,
provided that the Voltage Regulation (AVR) option is chosen from the Automatic Control Type
group.
The Common Options tab of this dialog has the following fields:
Automatic Control Type
This section is only visible on the dialog in edit mode. The control type of the transformer can be
changed between no control, voltage regulation, reactive power control, or phase shifter control.
Changing the control type will update the dialog to reflect the type of control that is selected.
Regulated Bus Number
The number of the bus whose voltage is regulated by the control.
Present Regulated Bus Voltage
The present voltage of the regulated bus.
Voltage Error
If the regulated bus' voltage falls outside the regulating range of the transformer (as defined by
the Regulation Minimum Voltage and Regulation Maximum Voltage fields), the Voltage
Error field indicates by how much the voltage deviates from the control range.
Regulation Minimum Voltage
The minimum acceptable voltage at the regulated bus.
Regulation Maximum Voltage
The maximum acceptable voltage at the regulated bus.
Regulation Target Type
As long as the regulated voltage is inside the regulation minimum and maximum, the transformer
will not change its tap ratio. When the regulated voltage moves outside of this regulation range,
Simulator will calculate a new tap ratio in an attempt to bring the regulated voltage back inside
of its range. The Regulation Target Type determines what value is used as a target when
calculating this change in tap ratio. Middle is the default and means that the target is the
average of the regulation minimum and maximum regardless of whether the voltage is high or
low. Max/Min means that the regulation maximum is used as the target when the regulated
voltage is above the maximum, and regulation minimum is used as the target value when the
regulated voltage is below the minimum.
Present Tap Ratio
The tap ratio of the transformer for the current system state.
Minimum Tap Ratio, Maximum Tap Ratio
Minimum and maximum allowable off-nominal tap ratios for the LTC transformer. Typical values
are 0.9 and 1.1.
Tap Step Size
Transformer off-nominal turns ratio increment. The off-nominal turns ratio is either incremented
or decremented from 1.0 in integer multiples of this value. Default value is 0.00625.
Voltage to Tap Sensitivity
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Shows the sensitivity of the voltage magnitude at the regulated bus to a change in the
transformer's tap ratio. You can use this field to assess whether or not the transformer can
effectively control the regulated bus voltage. In an ideal case, such as when the LTC transformer
is being used to control the voltage at a radial load bus, the sensitivity is close to 1.0 (or -1.0
depending upon whether the tapped side of the transformer is on the load side or opposite side
of the transformer). However, sometimes the transformer is very ineffective in controlling the
voltage. This is indicated by the absolute value of the sensitivity approaching 0. A common
example is a generator step-up transformer trying to control its high-side voltage when the
generator is off-line. Simulator automatically disables transformer control if the transformer
sensitivity is below the value specified on Power Flow Solution Tab of the Simulator Options
dialog.
Line Drop/Reactive Current Compensation
Typical specification of the bus at which the voltage should be controlled by a transformer is an
actual bus in the power system model. However, some control schemes require that the voltage
at some fictitious bus a specified impedance away from the transformer be controlled instead.
This can be accomplished using the line drop and reactive current compensation control method.
This method requires that the regulated bus for a transformer be specified as one of the
transformer's terminal buses. This provides a reference point for specifying the location of the
fictitious bus that is the actual controlled point. An impedance must also be specified that will
determine the location of the fictitious bus in reference to the selected regulated bus.
Check the Use Line Drop/Reactive Current Compensation checkbox to use this control
method. Specify the impedance for the location of the fictitious controlled bus using the Line
Drop/Reactive Current Compensation Resistance (R) and Line Drop/Reactive Current
Compensation Reactance (X) fields. The impedance should be specified in per-unit.
Impedance Correction Table
This field specifies the number of the transformer's corresponding transformer impedance
correction table. Transformer impedance correction tables are used to specify how the
impedance of the transformer should change with the off-nominal turns ratio. If this number is 0,
then no impedance correction table is associated with the transformer, and the impedance of the
transformer will thus remain fixed as the tap ratio changes. Valid impedance correction table
numbers range from 1 to 63. To assign an existing impedance correction table to the
transformer, enter the existing table's number. To view the existing impedance correction tables,
click the Insert/View Impedance Correction Table button, which brings up the Transformer
Impedance Correction Dialog. To define a brand new impedance correction table for the
transformer, enter an unused table number and then click Insert/View Impedance
Correction Table to prescribe the correction table. Note that the association between a
transformer and an impedance correction table is not finalized until you select either OK or Save
on the Branch Information Dialog or Branch Options dialog.
View Transformer Correction Table or Insert Transformer Correction Table
Click on this button either to view or to insert transformer correction tables. Clicking on this
button displays the Transformer Impedance Correction Dialog. Note that a table must contain at
least two points in order to be defined.
The Time Step Options tab contains control options specific for the Time Step Simulation tool.
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Transformer Mvar Control Dialog
The Transformer Mvar Control dialog is used to view the control parameters associated with load-tapchanging (LTC) transformers that are used to control the Mvar flow through the transformer. To view
this dialog, click on the Change Automatic Control Options button found with the Transformer
Control options, provided that the Reactive Power Control option is chosen from the Automatic
Control Type group.
When used to control reactive power, the LTC transformer always controls the reactive power flow at
the from end of the transformer (i.e., the tapped side), with positive flow assumed to be going
through the transformer to the to bus. Therefore the regulated bus field is not used.
The Common Options tab of this dialog has the following fields:
Automatic Control Type
This section is only visible on the dialog in edit mode. The control type of the transformer can be
changed between no control, voltage regulation, reactive power control, or phase shifter control.
Changing the control type will update the dialog to reflect the type of control that is selected.
Mvar Flow at From Bus
The current Mvar flow as measured at the from end of the line. This is the parameter the
transformer tries to control.
Mvar Error
If the Mvar flow at the from end violates the limits defined by the Regulation Minimum Mvar
Flow and Regulation Maximum Mvar Flow fields, the Mvar Error field indicates by how
much the flow falls outside the control range.
Regulation Minimum Mvar Flow, Regulation Maximum Mvar Flow
Minimum and maximum allowable reactive power flow as measured at the from bus. The
transformer attempts to regulate the reactive flow to fall within this range.
Regulation Target Type
As long as the regulated Mvar flow is inside the regulation minimum and maximum, the
transformer will not change its tap ratio. When the regulated Mvar flow moves outside of this
regulation range, Simulator will calculate a new tap ratio in an attempt to bring the regulated
Mvar flow back inside of its range. The Regulation Target Type determines what value is used
as a target when calculating this change in tap ratio. Middle is the default and means that the
target is the average of the regulation minimum and maximum regardless of whether the Mvar
flow is high or low. Max/Min means that the regulation maximum is used as the target when
the regulated Mvar flow is above the maximum, and regulation minimum is used as the target
value when the regulated Mvar flow is below the minimum.
Present Tap Ratio
The transformer's present off-nominal turns ratio.
Minimum Tap Ratio, Maximum Tap Ratio
Minimum and maximum allowable off-nominal tap ratios for the LTC transformer. Typical values
are 0.9 and 1.1.
Tap Step Size
Transformer off-nominal turns ratio increment. The off-nominal turns ratio is either incremented
or decremented from 1.0 in integer multiples of this value. Default value is 0.00625.
Mvar to Tap Sensitivity
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The amount of Mvar shift that would be implemented by switching one tap position from the
current position. This sensitivity indicates the ability of the transformer to control Mvars.
Impedance Correction Table
Specifies the number of the transformer's corresponding transformer impedance correction table.
Transformer impedance correction tables are used to specify how the impedance of the
transformer should change with the off-nominal turns ratio. If this number is 0, no impedance
correction table is associated with the transformer, and the impedance of the transformer will
thus remain fixed as the tap ratio changes. Valid impedance correction table numbers range from
1 to 63. To assign an existing impedance correction table to the transformer, enter the existing
table's number. To view the existing impedance correction tables, click the Insert/View
Impedance Correction Table button, which brings up the Transformer Impedance Correction
Dialog. To define a brand new impedance correction table for the transformer, enter an unused
table number and then click Insert/View Impedance Correction Table to prescribe the
correction table. Note that the association between a transformer and an impedance correction
table is not finalized until you select either OK or Save on the Branch Information Dialog or
Branch Options dialog.
View Transformer Correction Table or Insert Transformer Correction Table
Click on this button either to view or to insert transformer correction tables. Clicking on this
button displays the Transformer Impedance Correction Dialog. Note that a table must contain at
least two points in order to be defined.
The Time Step Options tab contains control options specific for the Time Step Simulation tool.
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Transformer Phase Shifting Dialog
The Transformer Phase Shifting Dialog is used to view the control parameters of phase-shifting
transformers. To view this dialog, click on the Change Automatic Control Options button found
with the Transformer Control options, provided that the Phase Shift Control option is chosen from the
Automatic Control Type group.
The Common Options tab of this dialog has the following fields:
Automatic Control Type
This section is only visible on the dialog in edit mode. The control type of the transformer can be
changed between no control, voltage regulation, reactive power control, or phase shifter control.
Changing the control type will update the dialog to reflect the type of control that is selected.
Regulated Bus Number
Number of the terminal bus of the phase shifter regulated by the phase shifter. When control is
active, the phase shifter will automatically change its phase shift to keep the MW flow at this bus
at the desired value.
Current MW Flow
Current MW flow through the transformer measured at the regulated bus terminal.
MW Error
If the current MW flow falls outside the minimum/maximum MW flow limits, the MW Error field
indicates by how much the flow violates the regulating range.
Regulation Minimum MW Flow, Regulation Maximum MW Flow
Minimum and maximum allowable MW flow through the phase shifter.
Regulation Target Type
As long as the regulated MW flow is inside the regulation minimum and maximum, the
transformer will not change its phase angle. When the regulated MW flow moves outside of this
regulation range, Simulator will calculate a new phase angle in an attempt to bring the regulated
MW flow back inside of its range. The Regulation Target Type determines what value is used
as a target when calculating this change in phase angle. Middle is the default and means that
the target is the average of the regulation minimum and maximum regardless of whether the
MW flow is high or low. Max/Min means that the regulation maximum is used as the target
when the regulated MW flow is above the maximum, and regulation minimum is used as the
target value when the regulated MW flow is below the minimum.
Present Phase Angle (Degrees)
The phase angle of the transformer for the current solved system state.
Minimum Phase Angle, Maximum Phase Angle
Minimum and maximum allowable phase shift in degrees.
Step Size (Degrees)
Phase shift change per step in degrees.
MW Flow to Phase Sensitivity
The sensitivity of the controlled MW flow to changes in the transformer's phase. This sensitivity
indicates the transformer's ability to regulate its MW flow.
Impedance Correction Table
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Specifies the number of the transformer's corresponding transformer impedance correction table.
Transformer impedance correction tables are used to specify how the impedance of the
transformer should change with the phase angle. If this number is 0, no impedance correction
table is associated with the transformer, and the impedance of the transformer will thus remain
fixed as the phase angle changes. Valid impedance correction table numbers range from 1 to 63.
To assign an existing impedance correction table to the transformer, enter the existing table's
number. To view the existing impedance correction tables, click the Insert/View Impedance
Correction Table button, which brings up the Transformer Impedance Correction Dialog. To
define a brand new impedance correction table for the transformer, enter an unused table
number and then click Insert/View Impedance Correction Table to prescribe the correction
table. Note that the association between a transformer and an impedance correction table is not
finalized until you select either OK or Save on the Branch Information Dialog or Branch Options
dialog.
View Transformer Correction Table or Insert Transformer Correction Table
Click on this button either to view or to insert transformer correction tables. Clicking on this
button displays the Transformer Impedance Correction Dialog. Note that a table must contain at
least two points in order to be defined.
The Time Step Options tab contains control options specific for the Time Step Simulation tool.
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Transformer Field Options Dialog
Transformer field objects are used to show field values specific to transformers. Use Line Fields to
show fields generic to transformers and transmission lines, such as the flow of power through the
device. The transformer fields dialog is used to view and modify the parameters associated with
transformer-specific fields.
Near Bus Number
Bus associated with the near end of the transformer.
Far Bus Number
Bus associated with the far end of the transformer.
Circuit
Two-character identifier used to distinguish between transformers joining the same two buses.
Default is '1'.
Find…
If you do not know the exact transformer you are looking for, you can click this button to open the
advanced search engine.
Total Digits in Field
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Delta per Mouse Click
This value is used only with the Off-nominal Tap Ratio and Phase Shift Angle field types. When
there is a nonzero entry in this field, and the field type is valid, a spin button is shown to the right of
the zone field. When the up spin button is clicked, the field value is increased by this number; when
the down button is clicked, the field value is decreased by this amount.
Field Value
Shows the current output for the transformer field. Whenever you change the Type of Field
selection, this field is updated.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Rotation Angle in Degrees
The angle at which the text is to appear on the oneline diagram.
Anchored
When checked, the text field will move with the transformer if the transformer is moved on the
oneline diagram.
Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
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Designates the type of transformer field to show. The following choices are available:
Off-nominal Tap Ratio Actual tap ratio
Phase Shift Angle Actual phase shift in degrees
Off-nominal Tap Position Tap position in steps, usually ranging from L16 to R16
Automatic Control Status The status of the control for the transformer
Select OK to save changes and close the dialog or Cancel to close dialog without saving your changes.
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Three Winding Transformer Information
The Three Winding Transformer Dialog is used to create, modify or delete three winding transformer
records in Edit Mode, or to view information for a specific three winding transformer record in run
mode. Note that all the values displayed on this dialog are on the system MVA base. If the records
were created them from a file, the values are automatically converted to the system base. If a three
winding transformer record is entered manually, the parameters need to be entered into Simulator
computed with the same system MVA base Simulator is using.
This dialog has the following controls:
Primary Winding
This section of the dialog displays the primary winding terminal bus number, nominal kV, and fixed
tap value (in per unit). In addition, the automatic tap changer is assumed to be on the primary
winding of a three winding transformer. Therefore the LTC field displays the tap changer tap value
(in per unit) on the primary winding.
Secondary Winding
This section of the dialog displays the secondary winding terminal bus number, nominal kV, and
fixed tap value (in per unit).
Tertiary Winding
This section of the dialog displays the tertiary winding terminal bus number, nominal kV, and fixed
tap value (in per unit).
Star Bus (Internal Node)
This section of the dialog displays the internal node parameters of the three winding transformer
model. Three winding transformers are modeled as three two winding transformers connected at the
three winding transformer terminal buses to a common or internal node, referred to as the star bus.
The parameters displayed for the star bus are the bus number, voltage (in per unit), and angle.
Primary-Secondary, Secondary-Tertiary, and Tertiary-Primary Impedance
These are the actual three winding transformer winding to winding impedances, in per unit on the
system base. These values are used to compute the equivalent two winding transformer impedances
for the two winding transformers used to model the three winding transformer operation.
Transformer Parameters
The values for the magnetizing conductance (G) and magnetizing susceptance (G), in per unit on the
system base.
Circuit ID
The circuit identifier for the three winding transformer.
Status
The status of the three winding transformer. If checked, the three winding transformer model is in
service, otherwise the equivalent model is treated as out of service.
Mathematically equivalent two-winding transformers
This table displays the three two winding transformers that are mathematically equivalent
representations of the three winding transformer. If you read the three winding transformer record
from a file, the two winding equivalent transformers are created automatically. If you are inserting a
three winding transformer manually, you can set the parameters for the primary, secondary and
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tertiary windings in the fields above, then click the Set Two-Winding Equivalent Transformers
button to have Simulator automatically create the two winding transformer records for you. You can
also right-click in this table and insert, modify or delete two winding transformers manually if you
already have the two winding transformer representations created.
Once you are finished with the dialog, you can click Save or OK to save any changes. If you wish to
abandon any changes you have made, click Cancel.
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Switched Shunt Information (Edit Mode)
The Switched Shunt Options dialog is used to view and modify the parameters associated with each
switched shunt in the system. It can also be used to insert new switched shunts and sometimes to
delete existing shunts. Multiple switched shunts are permitted at each bus, although only one is
allowed to be on automatic control at each bus. Switched shunts usually consist of either capacitors to
supply reactive power (in Mvar) to the system, or reactors to absorb reactive power. The switched
shunts are represented by a number of blocks of admittance that can be switched in a number of
discrete steps.
This dialog can be accessed by right-clicking on a switched shunt display object and choosing
Switched Shunt Information Dialog or right-clicking on a switched shunt record in the Switched
Shunt Display and choosing Show Dialog.
The Edit mode version of this dialog is very similar in content to its Run mode counterpart.
Bus Number
Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the bus to
which the switched shunt is attached. You can use the spin button immediately to the right of the
number to move to the next switched shunt (click the up arrow) or the previous switched shunt
(click the down arrow).
Find By Number
To find a switched shunt by its bus number, enter the number into the Bus Number field. Then click
this button.
Bus Name
Unique alphabetic identifier for the bus to which the switched shunt is attached, consisting of up to
eight characters.
Find By Name
To find a switched shunt by its bus name, enter the bus name into the Bus Name field (case
insensitive). Then click this button.
Shunt ID
Since multiple switched shunts are allowed on a single bus, each switched shunt has a unique Shunt
ID.
Find…
If you do not know the exact switched shunt bus number or name you are looking for, you can click
this button to open the advanced search engine.
Status
Open or closed status of the switched shunt.
Labels
Clicking on this button will open the Label Manager Dialog listing all the labels assigned for the
selected switched shunt.
Area Number, Area Name
The area number and name to which the switched shunt belongs. Note that you can change the
area of the switched shunt to be different than the area of the terminal bus. If you do so, you will be
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prompted to confirm that you wish to place the switched shunt within a different area than that of
the bus to which it is electrically connected.
Zone Number, Zone Name
The zone number and name to which the switched shunt belongs. Note that you can change the
zone of the switched shunt to be different than the zone of the terminal bus. If you do so, you will
be prompted to confirm that you wish to place the switched shunt within a different zone than that
of the bus to which it is electrically connected.
Substation Number, Substation Name
The name and number of the substation to which the switched shunt belongs. This is the same as
that of the terminal bus.
Display
Display Size
Size of the switched shunt.
Scale Width with Size
Automatically scales the width of the symbol when the object is resized.
Display Width
Width of the switched shunt symbol.
Pixel Thickness
Thickness of the display object in pixels.
Orientation
Specifies the direction in which to draw the object.
Anchored
If checked, the object is anchored to its terminal bus. See Anchored Objects for details.
Link to New Shunt
Adds a new record in the data or links the selected shunt display object to a different record.
OK, Save, Delete, and Cancel
OK saves your changes and closes the dialog. Save saves your changes but does not close the
dialog; this allows you to use, for example, the Find By Number command to edit additional switched
shunts. Delete deletes the current switched shunt; this option is not available when inserting
objects graphically or opening the dialog by selecting a display shunt object– use the cut command
instead. Cancel closes the dialog but does not save any changes.
Parameters
Nominal Mvar
The Nominal Mvar field gives the amount of reactive power the device would supply (in Mvars) if its
terminal voltage were 1.0 per unit.
Nominal MW
This field is only visible when a switched shunt object has been read from a file as a Bus Shunt. In
that case, it is possible for the bus shunt to have both a MW and MVAR component. The MW
component will be displayed here. In general, switched shunts of other control types do not have
381
©2011 PowerWorld Corporation

MW components, and this field will not be displayed. If you change a switched shunt read as a bus
shunt to another form of control, the MW component will remain, but has no controllability.
Control Mode
Information about this option can be found in the Switched Shunt Control topic.
Control Regulation Settings
Information about these options can be found in the Switched Shunt Control topic.
Switched Shunt Blocks
Information about these settings can be found in the Switched Shunt Control topic.
Control Parameters: Advanced Options
Information about these options can be found in the Switched Shunt Control topic.
Control Parameters: Time Step Options
The Time Step Options tab contains control options specific for the Time Step Simulation tool.
Fault Parameters
Typically switched shunts are treated as open circuits in the zero sequence data for fault analysis.
However, it is possible to define zero sequence admittance blocks to be used. The blocks work
similarly to the load flow Switched Shunt Blocks discussed above. Usually there will be the same
number of blocks in the zero sequence data as in the load flow data. Simulator will determine how
many blocks were switched in for the power flow solution, and then use the zero sequence block data
to calculate the zero sequence admittance for the same number of blocks.
Custom
This page of the dialog contains two sections: custom fields and memo.
The custom fields section allows access to setting and changing the values for custom fields that have
been defined for the switched shunt. Defining custom fields is detailed in Custom Field Descriptions.
The Memo section of the dialog is simply a location to log information about the switched shunt. Any
information entered in the memo box will be stored with the case when the case is saved to a PWB
file.
Stability
This tab is only visible with the Transient Stability Add-On tool. Any switched shunt-specific transient
stability modeling information is contained on this tab. For more information see the Transient Stability
Data: Object Dialogs.
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Switched Shunt Field Information
Switched shunt field objects are used primarily to indicate various quantities associated with switched
shunt devices. Furthermore, some switched shunt field types, which are distinguished by an integrated
spin button, may be used to change switched shunt device properties.
The Switched Shunt Fields Information Dialog can be used to modify the properties of individual
switched shunt fields on the oneline. The dialog displays the following fields:
Find…
If you do not know the exact bus number or name you are looking for, you can click this button to
open the advanced search engine.
Bus Number
Number of the bus to which the switched shunt associated with the field is connected. Use the
dropdown box to view a list of all buses with switched shunts in the case with valid area/zone/owner
filters.
Bus Name
Name of the bus to which the switched shunt associated with the field is connected. Use the
dropdown box to view a list of all buses with switched shunts in the case with valid area/zone/owner
filters.
ID
ID of the switched shunt associated with the field.
Total Digits in Field
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Field Value
The current value of the field being displayed.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Delta Per Mouse Click
Switched shunt fields can be used not only to show various fields associated with switched shunt
devices, but they can also be used to change some values. This is accomplished using spin buttons
shown to the right of the switched shunt field. When the up spin button is clicked, the switched
shunt field value is increased by the amount specified in the delta per mouse click field. When the
down spin button is clicked, the switched shunt field value is decreased by the same amount.
This field is only used for Switched Shunt Mvar fields. Specifying a nonzero value in this field causes
the integrated spin button to appear as part of the switched shunt field on the oneline.
Rotation Angle in Degrees
The angle at which the text is placed on the diagram, in degrees.
Anchored
If the Anchored checkbox is checked, the switched shunt field is anchored to its associated switched
shunt, which means that it will move with the switched shunt.
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Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
Used to determine the type of switched shunt field to show. The following choices are available:
Switched Shunt Mvar Total Mvar capacitance at the bus
Select a Field Choose from any of the different switched shunt fields
Select OK to save changes and to close the dialog, or click Cancel to close the dialog without saving
your changes.
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Zone Information (Edit Mode)
The Zone Dialog is used in the Edit Mode to view information about a zone and to move one or more
buses from one zone to another. (See Zone Information (Run Mode) for help on the corresponding
Run Mode version.) To view this dialog, open the Zone Records Display by clicking on Aggregations
> Zones in the Model Explorer. Then, right-click on the desired zone record and select Show Dialog
to view this dialog.
The dialog has the following fields:
Zone Number
Zone number between 1 and 999. You can use the spin button immediately to the right of this field
to move to either the next zone (click the up arrow) or the previous zone (click the down arrow).
Zone Name
Alphanumeric identifier for the zone. You can use this field to change the zone's name, provided you
click either Save or OK.
Find By Number
To find a zone by its number, type the number in the Number field and click this button.
Find…
If you do not know the exact zone number you are looking for, you can click this button to open the
advanced search engine.
Labels
To assign alternative identifying labels to the zone, click the Labels button, which will open the Label
Manager Dialog listing all the labels assigned for the selected zone.
OK, Save, Cancel
OK saves any changes to the zone name and closes the dialog. Save saves any changes to the zone
name, but does not close the dialog. Cancel closes the dialog ignoring any changes.
The zone dialog contains three additional pages of information:
Zone Buses Table
This table lists all of the buses in the zone. Number, name, voltage, area number, and area name
are shown for each bus. This table can be used to move buses to a different zone. Select the bus or
buses you would like to move with the mouse. Then, enter the Destination Zone Number, which
is the zone to which you want to move the selected buses. You may enter a zone number that does
not already exist, too, so that the buses will be moved to a brand new zone. In this case, be sure to
provide the Zone Name, as well. Finally, click the Move Selected Bus(es) to Destination Zone
button to implement the move.
OPF
The Reserve Requirement Curves options are only available with the OPF Reserves add-on. More
information about these options can be found in the Area and Zone OPF Reserve Requirement
Curves topic.
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Custom
The Custom Page of the Zone Information dialog displays custom numbers or strings defined with
the viewed zone. The Memo box is simply a location to log information about the zone. To log
information about the zone, simply start typing your information or comments about the zone in the
memo box.
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Bus Information (Run Mode)
This dialog is used to view information about each bus in the system. It can be displayed by rightclicking on any bus on the oneline and choosing Bus Information Dialog or choosing Show Dialog
from the Bus Display. This dialog can only be reached in Run Mode, but has a similar Edit Mode
counterpart. The Bus Information Dialog has the following fields:
Bus Number
Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the bus. You
can use the small arrow immediately to the right of the number to view a list of all buses in the case
with valid display filters. Or you can use the spin button further to the right of the number to move
to the next bus (click the up arrow) or the previous bus (click the down arrow).
Find By Number
To find a bus by its number, enter the number into the Bus Number field and then click this
button.
Bus Name
Unique alphabetic identifier for the bus. You can use the small arrow immediately to the right of the
bus name to view a list of all bus names in the case with valid display filters.
Find By Name
To find a bus by its name, enter the bus name into the Bus Name field (case insensitive) and then
click this button.
Find…
If you do not know the exact bus number or name you are looking for, you can click this button to
open the advanced search engine.
Nom. Voltage
Nominal voltage of the bus.
Labels
Clicking on this button will open the Label Manager dialog listing all of the labels assigned for the
selected bus.
Area Number, Name
Each bus is associated with an Area record. These fields show the number and name of this area.
See Area Records Display for more details about areas.
Zone Number, Name
Each bus is associated with a Zone record. These fields show the number and name of the zone. See
Zone Records Display for more details about zones. You can also use the Zone Dialog to list the
buses in a particular zone and to easily move a group of buses from one zone to another.
Substation Number, Name
Each bus can be associated with a Substation record. By default, buses are not assigned to
substations, and in that case these fields are blank. See the Substation Records Display topic for
more details on adding substations.
Owner Number, Name
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Each bus is associated with an Owner record. These fields show the number and name of the owner.
See Owner Records Display for more information about Owners.
Voltage (per unit)
Bus voltage in per unit notation. You may enter a new per unit voltage magnitude. However, the
only effect this has is changing the initial voltage guess used in the iterative solution. If you would
like to change the reference voltage for a generator, please see Generator Information Dialog.
Voltage (kV)
Bus voltage in actual kilovolts.
Angle (deg) and Angle (rad)
Voltage angle at the bus in degrees and radians. You may enter a new voltage angle. However, the
only effect this has is changing the initial voltage guess used in the iterative solution EXCEPT AT THE
SLACK BUS. Changing the angle for the slack bus will shift the voltage angle for all the buses in the
slack bus' island by a similar amount.
Status
Status of the bus, either connected or disconnected. A disconnected bus is not energized. You can
use this field to change the status of the bus. When the bus is initially connected, selecting
Disconnected opens all of the transmission lines incident to the bus, disconnecting the bus from
the rest of the system. Selecting Connected closes all of the lines incident to the bus unless they
attach to another disconnected bus.
View Substation Dialog
Clicking on this button will open the substation dialog for the substation the bus is contained in.
View Owner Dialog
Clicking on this button will open the bus’ owner dialog.
Slack Bus
Checked only if the bus is a system slack bus. This value can only be changed in the Edit Mode.
View All Flows at Bus
Clicking on this button will open a quick power flow list for the current bus.
Device Info
Generator Information
Displays the total MW and Mvar generation at the bus. You cannot change either of these fields from
this display. Select View/Edit Generator Records to view the individual generator records for the
bus. Selecting this button displays the Generator Dialog for the first generator at the bus.
Load Information
Displays the total MW and Mvar load at the bus. You cannot change either of these fields from this
display. Select View/Edit Bus Load Records to view the individual load records for the bus.
Selecting this button displays the Load Dialog.
Shunt Admittance
Shows the real and reactive components of the shunt admittance to ground. Entered in either MW or
Mvar, assuming one per unit voltage. B is positive for a capacitor and negative for a reactor. If B
corresponds to a switched device, consider using a switched shunt.
Bus Voltage Regulation
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This section lists the devices (if any) that are controlling the voltage at the bus. Select Bus Voltage
Regulator Devices to view the individual devices regulating the voltage for the bus. Selecting this
button displays the Bus Voltage Regulating Devices Dialog.
Desired PU Voltage
If the bus is being regulated by one or more devices, this field will display the desired regulated
voltage (in per unit) the devices are attempting to maintain.
Fault Analysis Load Parameters
This page of the display is only available for buses which have one or more load attached to the bus.
The parameters on this tab are used when running a fault analysis study. The values represent the
total load at the bus for the negative and zero sequence as equivalent admittances. By default, these
values are zero. For load buses, these values can be changed by the user, or they can be specified by
loading short circuit data from within the Fault Analysis Dialog. It is also possible to define these
values as non-zero at a bus where no load exists in the load flow, but it is not usually desirable to do
so.
OPF
This tab is only available if you have the Optimal Power Flow (OPF) add-on tool for PowerWorld
Simulator. This tab displays the MW marginal cost (Locational Marginal Price) for the bus when
performing an OPF solution. The page also breaks down the LMP into its cost components.
Geography
The Geography page of the dialog provides information on the geographic location of the bus on the
currently active oneline diagram. Also it provides a conversion tool between Lat/Lon and UTM
Coordinates.
Custom
The Custom page of the dialog contains two sections: custom fields and memo.
The custom fields section allows access to setting and changing the values for custom fields that have
been defined for the bus. Defining custom fields is detailed in Custom Field Descriptions.
The Memo section of the dialog is simply a location to log information about the bus. Any information
entered in the memo box will be stored with the case when the case is saved to a PWB file.
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Bus Voltage Regulating Devices Dialog
The Bus Voltage Regulating Devices Dialog displays summary information about the devices regulating
by the selected bus. The regulating devices can be Generators, Switched Shunts and Transformers.
Also the Bus Voltage Regulating Devices Dialog displays a Case Information Display for the regulating
devices. In addition to the information available about the Generators, Switched Shunts and
Transformers Display, the Bus Voltage Regulating Devices Dialogs Display also shows and allows to
modify the Regulating Max and Min per unit voltage, the Device Voltage Target, the Transformer (if
any) Regulation Target Type and Device Voltage Target High.
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Substation Information (Run Mode)
This dialog is used in the Run Mode to view and modify information associated with a substation
record. It displays different information from the Edit Mode version of the substation dialog. To display
it from Run Mode, first select Aggregation > Substations in the Model Explorer to bring up the
Substation Records Display. Right-click on the substation of interest and choose Show Dialog. The
Run Mode Substation Dialog has the following fields:
Substation Number
An integer identifier for the substation. You can use the spin button immediately to the right of this
field to move to either the next substation (click the up arrow) or the previous substation (click the
down arrow).
Substation Name and ID
Two alphanumeric identifiers for the substation.
Find By Number
To find a substation by its number, enter the number into the Substation Number field, then click
this button.
Find By Name
To find a substation by its name, enter the name into the Substation Name field, then click this
button.
Find By Sub ID
To find a substation by its substation ID, enter the ID into the Substation ID field, then click this
button.
Find…
If the exact substation number, name and ID are not known, you can use the Find Dialog to search
for and select a substation from a list of substations.
Labels
Clicking this button will open a dialog displaying the list of defined labels for the substation. New
labels can also be added for the substation from the dialog as well.
View All Flows at Substation
Clicking this button will open a quick power flow display listing the buses contained in the
substation.
Information
Load and Generation
Real and reactive load, generation, shunts, losses, and interchange for the substation.
Bus Voltages
Summary information on all buses in the substation, including total number of buses, number of
dead (disconnected) buses, and minimum and maximum bus voltage and angle within the
substation.
Available Gen MW/Mvar Ranges
Total amount of generation increase or decrease available for all generators in the substation.
391
©2011 PowerWorld Corporation

Buses
The Buses table identifies the buses in the substation, and provides summary information on each.
Gens
The Gens table identifies the generators in the substation, and provides summary information on each.
Loads
The Loads table identifies the loads in the substation, and provides summary information on each.
Switched Shunts
The Switched Shunts table identifies the switched shunts in the substation, and provides summary
information on each.
Tie Lines
The Tie Line Table identifies the flows on all of the substation's ties to other substation.
Custom
This page of the dialog can be used to enter notes about the substation. Any information entered in
the memo box will be stored with the case when the case is saved to a PWB file. Custom fields can
also be entered for storage with the substation object viewed.
Geography
Displays geographic information about the location of the substation, in Latitude and Longitude. Also it
provides a conversion tool between Lat/Lon and UTM Coordinates.
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Generator Information (Run Mode)
This dialog is used to view information about each generator in the system. Many fields on this display
can also be changed (except in Viewer). Here we describe the Run Mode version of the Generator
Information Dialog. The Edit Mode version is very similar.
Bus Number
Unique number between 1 and 99,999 used to identify the bus to which the generator is attached.
The dropdown list enumerates all generator buses in the case that meet the criteria established by
display filters. You may select a bus number directly from the dropdown list, or you may use the
spin buttons to cycle through the list of generator buses.
Bus Name
Unique alphabetic identifier for the bus to which the generator is attached, consisting of up to eight
characters. Use this dropdown box to view a list of all generator bus names in the case with valid
display filters.
ID
Two character alphanumeric ID used to distinguish multiple generators at a bus; '1' by default.
Find By Number
To find a generator by its number and ID, enter the number into the Bus Number field and the ID
into the ID field. Then click the Find By Number button.
Find By Name
To find a bus by its name and ID, enter the bus name into the Bus Name field (case insensitive)
and the ID into the ID field. Then click the Find By Name button.
Find…
If you do not know the exact generator bus number or name you are looking for, you can click this
button to open the advanced search engine.
Status
Status of the generator, either Closed (connected to terminal bus) or Open (not connected). You can
use this field to change the status of the generator.
Energized
Indicates if the generator is energized. This is not the same as the Open or Closed status. A
generator may be in-service itself (closed) but not be energized, based on the statuses of other
devices around the generator. For example, in a full topology model, it is not uncommon for a
generator to have a status of Closed, but the generator is not energized if a branch of type Circuit
Breaker connecting the generator to the system has a status of Open.
Area Name
Name of the area in which the generator's terminal bus is located.
Labels
Clicking on this button will open the Subscribed Aliases dialog listing all the labels or aliases assigned
for the selected generator.
Same Owner as Terminal Bus
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Read-only check-box that indicates whether the generator’s owner is the same than the terminal
bus’ owner.
Fuel Type
Type of fuel used by the generator this model represents. In most cases, this field is unnecessary for
normal load flow analysis, and hence the default value is Unknown. However, this value can be
useful during the Security Constrained OPF analysis.
Unit Type
The type of unit the generator represents, such as combined cycle, steam, hydro, etc.
There additional sections of generator information available from the Run Mode generator dialog:
Power and Voltage Control
Generator Cost Information
OPF
Fault Parameters
Owner, Area, Zone, Sub
Custom
Stability
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Generator Information: Power and Voltage Control
The Power Control grouping fields are used to show/change the values associated with the real
power output of the generator.
MW Output
Current real power output of the generator.
Minimum and Maximum MW Output
Minimum and maximum real power output limits for the generator. Simulator will not let the MW
output go below its minimum value or above its maximum value if the Enforce MW Limits option is
exercised.
Available for AGC
Determines whether or not the generator is available for automatic generation control (AGC).
Normally this box should be checked. However, there are times when you would like to control the
generator output manually (such as if you are using the generator to remove a line limit violation),
in which case you should leave this box unchecked. A generator is also placed on "manual" control
any time you manually change its output. You could then place the generator back on AGC control
by using this dialog.
Enforce MW Limits
If checked, the minimum and maximum MW limits are enforced for the generator, provided the
Enforce Generator MW Limits field is also checked on the Limits Tab of the Simulator Options
Dialog . If this box is checked and a generator is violating a real power limit, the generator's MW
output is immediately changed.
Participation Factor
The participation factor is used to determine how the real power output of the generator changes in
response to demand when the generator is available for AGC and the area is on participation factor
control. When you open a case using the PTI Raw Data Format, this field is initialized to the per unit
MVA rating of the generator, since participation factor information is not stored in the PTI format.
Loss Sensitivity
Shows how the losses for an area will change for an incremental increase in the generation at the
bus. This information is useful in determining the economic dispatch for the generation. The implicit
assumption in calculating this field's value is that the incremental change in generation will be
absorbed by the system "slack bus." This field cannot be changed.
The Voltage Control grouping is used to show/change values associated with controlling the
voltage/reactive power output of the generator.
Mvar Output
Current reactive power output of the generator. You can manually change this value only if
Available for AVR is not checked.
Min and Max Mvar Output
Specify the minimum and maximum allowable reactive power output of the generator.
Available for AVR
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Designates whether or not the generator is available for automatic voltage regulation (AVR). When
the AVR field is checked, the generator will automatically change its reactive power output to
maintain the desired terminal voltage within the specified reactive power range. If a reactive limit is
reached, the generator will no longer be able to maintain its voltage at the setpoint value, and its
reactive power will then be held constant at the limit value.
Use Capability Curve
If checked, the generator's reactive power limits are specified using a reactive capability curve that
prescribes the dependence of the generator's reactive power limits on its real power output.
Otherwise, the fixed values given in the Min Mvar Output and Max Mvar Output fields are used.
The generator reactive capability can be defined using the table that appears at the bottom of the
dialog. Please see Generator Reactive Power Capability Curve for details.
Regulated Bus Number
Number of the bus whose voltage the generator is regulating. This is usually, but not always, the
generator's terminal bus. Multiple generators can regulate the same remote bus, but the regulated
bus must not be another generator bus. If the generator is at a slack bus, it must regulate its own
terminal voltage. Select Solution Details > Remotely Regulated Buses from the Model Explorer
to view the Remotely Regulated Bus Records Dialog , which identifies all buses that are being
remotely regulated.
Desired Reg. Bus Voltage
Specifies the desired per unit voltage for the generator at the regulated bus. The regulated bus need
not be the terminal bus of the generator.
Actual Reg. Bus Voltage
Shows the actual per unit voltage at the regulated bus. If the generator is on AVR and has not
reached a reactive power limit, the actual regulated bus voltage should be equal to the desired
regulated bus voltage. This field cannot be changed.
Remote Reg %
This field is only used when a number of generators at different buses are regulating a remote bus
(i.e., not their terminal buses). This field then specifies the percentage of the total reactive power
required by the remote bus to maintain its voltage that should be supplied by this generator. The
default value is 100.
Wind Control Mode and Power Factor
The Wind Control Mode effects how generator Mvar limits are treated and can be set to either None,
Boundary Power Factor , Constant Power Factoror Follow Min Mvar Capability Curve.
When the mode is None, then the generator behaves using the standard settings of the Min and
Max Mvar Output and Capability Curve described above.
For Follow Min Mvar Capability Curve mode, the Mvar output of the generator is determined by a
lookup from the capability curve's Min Mvar value. Essentially the Max Mvar Output and the Min
Mvar Output are then made equal to this value. This provides the ability to make a generator's
Mvar output any piece-wise linear function of the MW output.
For both the Boundary and Constant modes, the Mvar limit magnitudes are determined from the
actual MW Output and the Wind Control Mode Power Factor value.
Magnitude = MWOutput * tan(arccos(Power Factor))
For Boundary mode, the Max Mvar Output is positive and the Min Mvar Output is negative. This
provides a boundary under which the Mvar must operate.
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For Constant mode, Max Mvar Output and the Min Mvar Output are made the same with a
positive Wind Control Mode Power Factor meaning the limits have the same sign as the actual
MW Output, and a negative Wind Control Mode Power Factor meaning the limits are the
opposite sign as the actual MW Output, thus the Mvar output is a function of MW Output and
Power Factor.
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Generator Options: Costs
The Costs tab of the Generator Information dialog (run mode) is used to show/change values
associated with the cost of operation of the generator. See Generator Cost Information for details.
Cost data can also be saved/loaded using the Generator Cost Data files.
Output Cost Model
Cost Model
Simulator can model generators as not having a cost model, or having either a cubic cost model or a
piecewise linear model. The cost model type you choose determines the content of the remainder of
this dialog
Unit Fuel Cost
The cost of fuel in $/MBtu. This value can be specified only when you have chosen to use a cubic
cost model.
Variable O&M
The Operations and Maintenance costs. Only used for cubic cost models.
Fixed Costs (costs at zero MW Output)
The fixed costs associated with operating the unit. These costs are independent of the generator's
MW output level and is added to the cost prescribed by the cubic or piecewise linear model to obtain
the total cost of operating the generator in $/MWHr. The total fixed cost is the addition of the fuel
cost independent value and the fuel cost dependent value multiplied by unit fuel cost.
Cubic Cost Coefficients A, B, C, D
For cubic cost models of the form C(Pgi) = (d*Pgi^3 + c*Pgi^2 + b*Pgi ) * (fuel cost) + fixed costs
(as described above), specify the cost curve's coefficients. The A coefficient is historically the fuel
cost dependent fixed cost value, which is combined separately now with the fuel cost independent
value. These coefficients can be specified only when you have chosen to use a cubic cost model.
Piecewise Linear Table
If you have chosen to use a piecewise linear cost model, a table appears that allows you to specify
pairs of MW output levels and corresponding generator operating costs. To insert a new point on the
cost curve, right-click on the table and choose Insert New Point from the resulting local menu. To
delete an existing point from the cost curve, right-click on the table and choose Delete Point from
the resulting local menu. To edit an existing point in the table, simply enter your changes to the
appropriate cells.
Convert Cubic Cost to Linear
Use this option to create a piecewise linear cost function from the cubic cost function specified by
the coefficients A, B, C, and D and the fuel cost. Specify the number of break points, and hence the
number of segments, in the Number of Break Points field. Click the Convert to Linear Cost
button to create the piecewise linear function that approximates the cubic cost function. This action
switches Cost Model option to Piecewise Linear and displays the Piecewise Linear Table that
identifies the piecewise linear curve’s breakpoints.
Bid Scale / Shift
Cost Shift, Cost Multiplier
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The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the purpose
of assessing how variations in bids impact profit. The cost function is affected based on the following
equation:
(Original Cost Function + Cost Shift) * Cost Multiplier
Marginal Cost (run mode only)
Shows the marginal cost of producing real power at the generator at its current output level,
dCi(Pgi)/dPgi.
ED/OPF Cost (run mode only)
This is the cost of production for this generator following an economic dispatch or optimal power
flow solution, including the scaling from the cost shift and cost multiplier fields.
Unscaled Cost (run mode only)
The cost of production of the generator, ignoring the cost multiplier and cost shift. This cost is the
result of the original cost function by itself.
OPF Reserve Bids
This tab is only available with the OPF Reserves add-on. Detailed information about this tab can be
found in the Generator and Load OPF Reserves Bids topic.
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Generator Information: OPF
The fields on this tab display information regarding the generator’s participation in an OPF load flow
solution.
OPF MW Control
The type of control the generator is allowed during an OPF solution. The generator can be set to No
control during OPF, control only if its AGC property is set to Yes, or to always be controlled by the
OPF regardless of the AGC status of the generator.
Fast Start Generator
The generator is being treated as a fast start generator during the OPF solution.
Generator MW limits
The MW limits of a generator can be altered in this location if you wish for the generator to use
different limits than originally assigned in the load flow case, without actually changing the original
values. Simply change the Current Min MW Limit and Current Max MW Limit to alter the limits
observed by the generator during and OPF solution.
MW Marginal Cost for Generator’s Bus
The OPF solved marginal cost at the generator’s terminal bus.
Initial, Final and Delta MW Output
The MW output information for the generator resulting from the OPF run.
Initial, Final and Delta Hourly Cost
The hourly cost information for the generator resulting from the OPF run.
OPF Results
This section shows the results of OPF for the generator.
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Generator Options: Owners, Area, Zone, Sub
This information is located on the Generator Information Dialog.
This tab is used to display or change the generator’s owner information, area information, zone
information, and substation information.
Same Owner as Terminal Bus
Read-only check-box that indicates whether the generator’s owner is the same than the terminal
buses’ owner.
Owners
Currently, Simulator supports up to four owners for generators. To add an owner of a generator,
change one of the Owner fields to a new owner number, and update the owner percentages
accordingly. To modify an owner's percentage of ownership, simply modify the value in the
percentage field for that owner. If you set the percentage of an owner to 0, that owner will be
removed from the list of owners for the device. You can also remove an owner from owning part of
a device by changing the owner field for that owner to 0. Note that if you do not set the new owner
percentages of all specified owners such that the total is 100%, Simulator will normalize the
percentages such that the total is 100% when you click Save or OK on the generator dialog.
Area Number, Area Name
The area number and name to which the generator belongs. Note that you can change the area of
the generator to be different than the area of the terminal bus. If you do so, you will be prompted to
confirm that you wish to place the generator within a different area than that of the bus to which it
is electrically connected.
Zone Number, Zone Name
The zone number and name to which the generator belongs. Note that you can change the zone of
the generator to be different than the zone of the terminal bus. If you do so, you will be prompted
to confirm that you wish to place the generator within a different zone than that of the bus to which
it is electrically connected.
Substation Number, Substation Name
The name and number of the substation to which the generator belongs, and it is the same than
that of the terminal bus.
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Load Information (Run Mode)
The Load Information Dialog can be used to inspect and modify the model of a bus load. To view the
Load Information Dialog, select the load and choose Show Dialog from the case information toolbar
or right-click on the load of interest and select Load Information Dialog from the resulting local
menu. This is very similar to its Edit Mode counterpart. The dialog has the following fields:
Bus Number
Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the bus to
which the load is attached. The dropdown box provides a list of all load buses with valid display
filters. You can use the spin button to cycle through the list of load buses.
Bus Name
Unique alphabetic identifier for the bus to which the load is attached, consisting of up to eight
characters. The dropdown box lists the names of all load buses in the case with valid display filters.
ID
Two-character ID used to distinguish multiple loads at a bus. By default, the load id is equal to "1 ."
An identifier of '99' is used to indicate an equivalent load.
Find By Number
To find a load by its number and ID, enter the number into the Bus Number field and the ID into the
ID field. Then click this button.
Find By Name
To find a load by its name and ID, enter the bus name into the Bus Name field (case insensitive)
and the ID into the ID field. Then click this button.
Find…
If you do not know the exact load bus number or name you are looking for, you can click this button
to open the advanced search engine.
Status
Status of the load, either Closed (connected to terminal bus) or Open (not connected). You can use
this status field to change the load's status.
Energized
Indicates if the load is energized. This is not the same as the Open or Closed status. A load may be
in-service itself (closed) but not be energized, based on the statuses of other devices around the
load. For example, in a full topology model, it is not uncommon for a load to have a status of Closed,
but the load is not energized if a branch of type Circuit Breaker connecting the load to the system
has a status of Open.
Labels
Clicking on this button will open the Label Manager dialog listing all the labels assigned for the
selected load.
Area Number, Area Name
Number and name of the area the load is a member of.
Zone Number, Zone Name
Number and name of the zone the load is a member of.
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Owner Number, Owner Name
Number and name of the owner the load is a member of. Loads DO NOT have to be owned by the
same owner as the terminal bus.
Substation Number, Substation Name
Number and name of the substation the load is a member of.
Load Information
Base Load Model, Current Load
The Base Load Model fields are used to represent the amount of base real and reactive load at the
bus. Usually this load is modeled as being "constant power," meaning that the amount of load is
independent of the bus voltage magnitude. However, Simulator also permits modeling "constant
current" load, for which the load varies in proportion to the bus voltage magnitude, and "constant
impedance" load, for which the load varies in proportion to the square of the bus voltage magnitude.
Values in these fields are specified in MW and MVR assuming one per unit voltage. All six fields in
the Base Load Model section can be changed.
Load Multiplier
The actual load at the bus is equal to the base value multiplied by the corresponding load multiplier.
The load multiplier is a value specifying how the load is scaled. The load multiplier depends upon the
area load multiplier and the zone load multiplier. See Load Modeling for more details. The load
multiplier value cannot be changed on this dialog.
Bus Voltage Magnitude
Voltage magnitude of the load’s terminal bus.
Information about the remaining tabs on the dialog can be found at the following links:
OPF Load Dispatch
Custom
Stability
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Branch Information Dialog (Run Mode)
The Branch Information Dialog is used to view information about each transmission line and
transformer in the system. You may use this dialog also to change many of the properties of lines and
transformers (except in Viewer).
The Run Mode version of this dialog is very similar in content to its Edit Mode counterpart.
The Branch Information Dialog sports the following fields:
From Bus Number and Name

From Bus number and name. For transformers, the from bus is the tapped side.
To Bus Number and Name

To Bus number and name.
Circuit
Two-character identifier used to distinguish between multiple lines joining the same two buses.
Default is '1'.
Find By Number
To find a line or transformer by its bus numbers, enter the from and to bus numbers and the circuit
identifier. Then click this button. Use the spin button to cycle through the list of lines and
transformers in the system.
Find By Name
To find a line or transformer by the names of its terminal buses, enter the from and to bus names
and the circuit identifier. Then click this button.
Find…
If you do not know the exact from and to bus numbers or names you are looking for, you can click
this button to open the advanced search engine.
From End Metered
This field is only used for lines and transformers that serve as tie lines, which are lines that join two
areas. If this field is checked for a tie line, the from end of the device is designated as the metered
end. Otherwise the to end is metered. By default, the from end is metered. The location of the
metered end is important in dealing with energy transactions because it determines which party
must account for transmission losses.
From and To Bus Area Name
Names of the areas in which the From and To buses are located.
From and To Bus Nominal kV
From and To bus nominal voltage levels.
From and To Bus Voltage (p.u.)
The actual terminal bus voltages of the transmission element, in per unit.
Labels
Clicking on this button will open the Labels dialog listing all the labels for the selected branch.
Parameters
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Status
Current status of the device.
Energized
Indicates if the branch is energized. This is not the same as the Open or Closed status. A branch
may be in-service itself (closed) but not be energized, based on the statuses of other devices around
the branch. For example, in a full topology model, it is not uncommon for a branch of type Line has
a status of Closed, but the branch is not energized if branches of type Circuit Breaker at both ends
of the Line are Open.
Per Unit Impedance Parameters
The resistance, reactance, the total charging susceptance (that is, B, not B/2), and the total shunt
conductance of the device (in per unit). Magnetizing conductance and susceptance is included if the
branch is a transformer.
Line Shunts
Select to view the Line Shunt Dialog. This dialog is used to create or modify line shunts. Line shunts
cannot be created or deleted while in Run Mode. Line shunts are expressed in terms of the per-unit
conductance and susceptance at each end of the line or transformer. If the line has shunts, the
check box Has Line Shunts is checked.
MVA Limits
Ratings for the transmission line or transformer in MVA. Eight different limits are allowed.
Flows
These next fields show the actual real and reactive power flow at both ends of the device (because
of real and reactive losses these numbers may be different), and its percentage MVA loading. The
line losses are summarized as well.
Transformer
The tab is only visible if the branch is a transformer. See the Transformer Control help for more
information on transformer types and controls.
Series Capacitor
This tab is only visible if the selected branch is a series capacitor. If the branch is a series capacitor,
the Is Series Capacitor box will be checked. In addition, the Status field for series capacitors will be
enabled, allowing you to change the Bypassed or In Service status of the series capacitor. The series
capacitor status IS NOT the same as the branch status of Open or Closed.
OPF
The OPF tab is only visible if you have the OPF (Optimal Power Flow) add-on tool for PowerWorld
Simulator.
Enforce Line Flow Limit
This check box must be checked if the branch limit is going to be enforced when running an OPF
solution. If this box is not checked, the OPF routine will allow the branch to violate its branch limits.
Treat Limit as Equality Constraint
If checked, the OPF solution will attempt to solve the load flow while keeping the flow on the branch
at its limit.
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Maximum MVA Flow
The largest MVA flow value measured on the line, either at the From or To bus.
Present MVA Limit
The limit enforced by the OPF for the branch. This is set in the OPF constraint options, and is related
to the original branch limits.
Maximum Percentage
The highest percentage of flow measured on the line, either at the From or To bus.
Limit Marginal Cost
The cost of enforcing the branch MVA limit.
Included in LP
Specifies whether or not the branch flow and limit was included as a constraint in the OPF solution.
In general, branches that are not near their limit and do not appear to be changing flow dramatically
towards their limit will be ignored in the OPF calculation to speed up the solution. No and Yes
indicate whether or not the OPF process determined that the line needed to be included. The user
can initially force the branch to be included or not included with these two fields. By choosing
Always, the branch will be included in the OPF solution constraints regardless of the propensity of
the line to be approaching it's limit.
MVA Flow Constraint Status
The constraint status for the line in the OPF solution will be shown here with the corresponding
boxes checked by Simulator. These check boxes cannot be changed manually by the user.
From/To Bus MW Marginal Costs
Displays the marginal costs of the branches terminal buses, following the solution of the OPF.
Fault Info
The parameters on this tab are used when running a fault analysis study. The values represent the
zero sequence impedance and zero sequence line shunt admittances for the analysis. By default, the
positive and negative sequence line impedances and line shunt admittances are the same as the load
flow impedance. The same fields are used for transformers, along with the configuration field. The
configuration field defines the winding type combinations for the transformer (wye, delta, etc.) As a
default, Simulator assumes an ungrounded wye to ungrounded wye transformer, which has the same
model as an open circuit. Usually transformers are not of this type, and the proper type would need to
be defined either manually or loaded from an external file in order for the fault analysis to be accurate.
Owner, Area, Zone, Sub, PTDF
The Default Owner (Same as From Bus) read-only check-box indicates whether the line’s owner is
the same than the from bus’ owner. Transmission elements can have up to four different owners, each
with a certain owner percentage. To add an owner of a transmission element, change one of the
Owner fields to a new owner number, and update the owner percentages accordingly. Note that if you
do not set the new owner percentages of all specified owners such that the total is 100%, Simulator
will normalize the percentages such that the total is 100% when you click Save or OK on the branch
dialog.
The area, zone and substation to which the From and To buses belong, are also shown. If a PTDF
calculation has been performed, the PTDF values for the viewed line will be displayed as well.
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Custom
This page of the dialog contains two sections: custom fields and memo.
The custom fields section allows access to setting and changing the values for custom fields that have
been defined for the branch. Defining custom fields is detailed in Custom Field Descriptions.
The Memo section of the dialog is simply a location to log information about the branch. Any
information entered in the memo box will be stored with the case when the case is saved to a PWB
file.
Stability
This tab is only visible with the Transient Stability Add-On tool. Any branch-specific transient stability
modeling information is contained on this tab. For more information see the Transient Stability Data:
Object Dialogs.
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Transformer AVR Dialog
The Transformer AVR Dialog is used to view the control parameters associated with load-tap-changing
(LTC) transformers when they are used to control bus voltage magnitudes. To view this dialog, click
the Change Automatic Control Options button found with the Transformer Control options,
provided that the Voltage Regulation (AVR) option is chosen from the Automatic Control Type
group.
The Common Options tab of this dialog has the following fields:
Automatic Control Type
This section is only visible on the dialog in edit mode. The control type of the transformer can be
changed between no control, voltage regulation, reactive power control, or phase shifter control.
Changing the control type will update the dialog to reflect the type of control that is selected.
Regulated Bus Number
The number of the bus whose voltage is regulated by the control.
Present Regulated Bus Voltage
The present voltage of the regulated bus.
Voltage Error
If the regulated bus' voltage falls outside the regulating range of the transformer (as defined by
the Regulation Minimum Voltage and Regulation Maximum Voltage fields), the Voltage
Error field indicates by how much the voltage deviates from the control range.
Regulation Minimum Voltage
The minimum acceptable voltage at the regulated bus.
Regulation Maximum Voltage
The maximum acceptable voltage at the regulated bus.
Regulation Target Type
As long as the regulated voltage is inside the regulation minimum and maximum, the transformer
will not change its tap ratio. When the regulated voltage moves outside of this regulation range,
Simulator will calculate a new tap ratio in an attempt to bring the regulated voltage back inside
of its range. The Regulation Target Type determines what value is used as a target when
calculating this change in tap ratio. Middle is the default and means that the target is the
average of the regulation minimum and maximum regardless of whether the voltage is high or
low. Max/Min means that the regulation maximum is used as the target when the regulated
voltage is above the maximum, and regulation minimum is used as the target value when the
regulated voltage is below the minimum.
Present Tap Ratio
The tap ratio of the transformer for the current system state.
Minimum Tap Ratio, Maximum Tap Ratio
Minimum and maximum allowable off-nominal tap ratios for the LTC transformer. Typical values
are 0.9 and 1.1.
Tap Step Size
Transformer off-nominal turns ratio increment. The off-nominal turns ratio is either incremented
or decremented from 1.0 in integer multiples of this value. Default value is 0.00625.
Voltage to Tap Sensitivity
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Shows the sensitivity of the voltage magnitude at the regulated bus to a change in the
transformer's tap ratio. You can use this field to assess whether or not the transformer can
effectively control the regulated bus voltage. In an ideal case, such as when the LTC transformer
is being used to control the voltage at a radial load bus, the sensitivity is close to 1.0 (or -1.0
depending upon whether the tapped side of the transformer is on the load side or opposite side
of the transformer). However, sometimes the transformer is very ineffective in controlling the
voltage. This is indicated by the absolute value of the sensitivity approaching 0. A common
example is a generator step-up transformer trying to control its high-side voltage when the
generator is off-line. Simulator automatically disables transformer control if the transformer
sensitivity is below the value specified on Power Flow Solution Tab of the Simulator Options
dialog.
Line Drop/Reactive Current Compensation
Typical specification of the bus at which the voltage should be controlled by a transformer is an
actual bus in the power system model. However, some control schemes require that the voltage
at some fictitious bus a specified impedance away from the transformer be controlled instead.
This can be accomplished using the line drop and reactive current compensation control method.
This method requires that the regulated bus for a transformer be specified as one of the
transformer's terminal buses. This provides a reference point for specifying the location of the
fictitious bus that is the actual controlled point. An impedance must also be specified that will
determine the location of the fictitious bus in reference to the selected regulated bus.
Check the Use Line Drop/Reactive Current Compensation checkbox to use this control
method. Specify the impedance for the location of the fictitious controlled bus using the Line
Drop/Reactive Current Compensation Resistance (R) and Line Drop/Reactive Current
Compensation Reactance (X) fields. The impedance should be specified in per-unit.
Impedance Correction Table
This field specifies the number of the transformer's corresponding transformer impedance
correction table. Transformer impedance correction tables are used to specify how the
impedance of the transformer should change with the off-nominal turns ratio. If this number is 0,
then no impedance correction table is associated with the transformer, and the impedance of the
transformer will thus remain fixed as the tap ratio changes. Valid impedance correction table
numbers range from 1 to 63. To assign an existing impedance correction table to the
transformer, enter the existing table's number. To view the existing impedance correction tables,
click the Insert/View Impedance Correction Table button, which brings up the Transformer
Impedance Correction Dialog. To define a brand new impedance correction table for the
transformer, enter an unused table number and then click Insert/View Impedance
Correction Table to prescribe the correction table. Note that the association between a
transformer and an impedance correction table is not finalized until you select either OK or Save
on the Branch Information Dialog or Branch Options dialog.
View Transformer Correction Table or Insert Transformer Correction Table
Click on this button either to view or to insert transformer correction tables. Clicking on this
button displays the Transformer Impedance Correction Dialog. Note that a table must contain at
least two points in order to be defined.
The Time Step Options tab contains control options specific for the Time Step Simulation tool.
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Transformer Mvar Control Dialog
The Transformer Mvar Control dialog is used to view the control parameters associated with load-tapchanging (LTC) transformers that are used to control the Mvar flow through the transformer. To view
this dialog, click on the Change Automatic Control Options button found with the Transformer
Control options, provided that the Reactive Power Control option is chosen from the Automatic
Control Type group.
When used to control reactive power, the LTC transformer always controls the reactive power flow at
the from end of the transformer (i.e., the tapped side), with positive flow assumed to be going
through the transformer to the to bus. Therefore the regulated bus field is not used.
The Common Options tab of this dialog has the following fields:
Automatic Control Type
This section is only visible on the dialog in edit mode. The control type of the transformer can be
changed between no control, voltage regulation, reactive power control, or phase shifter control.
Changing the control type will update the dialog to reflect the type of control that is selected.
Mvar Flow at From Bus
The current Mvar flow as measured at the from end of the line. This is the parameter the
transformer tries to control.
Mvar Error
If the Mvar flow at the from end violates the limits defined by the Regulation Minimum Mvar
Flow and Regulation Maximum Mvar Flow fields, the Mvar Error field indicates by how
much the flow falls outside the control range.
Regulation Minimum Mvar Flow, Regulation Maximum Mvar Flow
Minimum and maximum allowable reactive power flow as measured at the from bus. The
transformer attempts to regulate the reactive flow to fall within this range.
Regulation Target Type
As long as the regulated Mvar flow is inside the regulation minimum and maximum, the
transformer will not change its tap ratio. When the regulated Mvar flow moves outside of this
regulation range, Simulator will calculate a new tap ratio in an attempt to bring the regulated
Mvar flow back inside of its range. The Regulation Target Type determines what value is used
as a target when calculating this change in tap ratio. Middle is the default and means that the
target is the average of the regulation minimum and maximum regardless of whether the Mvar
flow is high or low. Max/Min means that the regulation maximum is used as the target when
the regulated Mvar flow is above the maximum, and regulation minimum is used as the target
value when the regulated Mvar flow is below the minimum.
Present Tap Ratio
The transformer's present off-nominal turns ratio.
Minimum Tap Ratio, Maximum Tap Ratio
Minimum and maximum allowable off-nominal tap ratios for the LTC transformer. Typical values
are 0.9 and 1.1.
Tap Step Size
Transformer off-nominal turns ratio increment. The off-nominal turns ratio is either incremented
or decremented from 1.0 in integer multiples of this value. Default value is 0.00625.
Mvar to Tap Sensitivity
410
©2011 PowerWorld Corporation

The amount of Mvar shift that would be implemented by switching one tap position from the
current position. This sensitivity indicates the ability of the transformer to control Mvars.
Impedance Correction Table
Specifies the number of the transformer's corresponding transformer impedance correction table.
Transformer impedance correction tables are used to specify how the impedance of the
transformer should change with the off-nominal turns ratio. If this number is 0, no impedance
correction table is associated with the transformer, and the impedance of the transformer will
thus remain fixed as the tap ratio changes. Valid impedance correction table numbers range from
1 to 63. To assign an existing impedance correction table to the transformer, enter the existing
table's number. To view the existing impedance correction tables, click the Insert/View
Impedance Correction Table button, which brings up the Transformer Impedance Correction
Dialog. To define a brand new impedance correction table for the transformer, enter an unused
table number and then click Insert/View Impedance Correction Table to prescribe the
correction table. Note that the association between a transformer and an impedance correction
table is not finalized until you select either OK or Save on the Branch Information Dialog or
Branch Options dialog.
View Transformer Correction Table or Insert Transformer Correction Table
Click on this button either to view or to insert transformer correction tables. Clicking on this
button displays the Transformer Impedance Correction Dialog. Note that a table must contain at
least two points in order to be defined.
The Time Step Options tab contains control options specific for the Time Step Simulation tool.
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Transformer Phase Shifting Dialog
The Transformer Phase Shifting Dialog is used to view the control parameters of phase-shifting
transformers. To view this dialog, click on the Change Automatic Control Options button found
with the Transformer Control options, provided that the Phase Shift Control option is chosen from the
Automatic Control Type group.
The Common Options tab of this dialog has the following fields:
Automatic Control Type
This section is only visible on the dialog in edit mode. The control type of the transformer can be
changed between no control, voltage regulation, reactive power control, or phase shifter control.
Changing the control type will update the dialog to reflect the type of control that is selected.
Regulated Bus Number
Number of the terminal bus of the phase shifter regulated by the phase shifter. When control is
active, the phase shifter will automatically change its phase shift to keep the MW flow at this bus
at the desired value.
Current MW Flow
Current MW flow through the transformer measured at the regulated bus terminal.
MW Error
If the current MW flow falls outside the minimum/maximum MW flow limits, the MW Error field
indicates by how much the flow violates the regulating range.
Regulation Minimum MW Flow, Regulation Maximum MW Flow
Minimum and maximum allowable MW flow through the phase shifter.
Regulation Target Type
As long as the regulated MW flow is inside the regulation minimum and maximum, the
transformer will not change its phase angle. When the regulated MW flow moves outside of this
regulation range, Simulator will calculate a new phase angle in an attempt to bring the regulated
MW flow back inside of its range. The Regulation Target Type determines what value is used
as a target when calculating this change in phase angle. Middle is the default and means that
the target is the average of the regulation minimum and maximum regardless of whether the
MW flow is high or low. Max/Min means that the regulation maximum is used as the target
when the regulated MW flow is above the maximum, and regulation minimum is used as the
target value when the regulated MW flow is below the minimum.
Present Phase Angle (Degrees)
The phase angle of the transformer for the current solved system state.
Minimum Phase Angle, Maximum Phase Angle
Minimum and maximum allowable phase shift in degrees.
Step Size (Degrees)
Phase shift change per step in degrees.
MW Flow to Phase Sensitivity
The sensitivity of the controlled MW flow to changes in the transformer's phase. This sensitivity
indicates the transformer's ability to regulate its MW flow.
Impedance Correction Table
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Specifies the number of the transformer's corresponding transformer impedance correction table.
Transformer impedance correction tables are used to specify how the impedance of the
transformer should change with the phase angle. If this number is 0, no impedance correction
table is associated with the transformer, and the impedance of the transformer will thus remain
fixed as the phase angle changes. Valid impedance correction table numbers range from 1 to 63.
To assign an existing impedance correction table to the transformer, enter the existing table's
number. To view the existing impedance correction tables, click the Insert/View Impedance
Correction Table button, which brings up the Transformer Impedance Correction Dialog. To
define a brand new impedance correction table for the transformer, enter an unused table
number and then click Insert/View Impedance Correction Table to prescribe the correction
table. Note that the association between a transformer and an impedance correction table is not
finalized until you select either OK or Save on the Branch Information Dialog or Branch Options
dialog.
View Transformer Correction Table or Insert Transformer Correction Table
Click on this button either to view or to insert transformer correction tables. Clicking on this
button displays the Transformer Impedance Correction Dialog. Note that a table must contain at
least two points in order to be defined.
The Time Step Options tab contains control options specific for the Time Step Simulation tool.
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Transformer Impedance Correction Tables Dialog
The Transformer Correction Tables Dialog is used to view information about the transformer
impedance correction tables. These tables are used on some LTC or phase shifting transformers to
model the impedance of the transformer as a function of the off-nominal turns ratio or phase shift.
The dialog has the following fields:
Transformer Impedance Correction Table Number
Number of the impedance correction table, between 1 and 63. Use the spin button immediately to
the right of this field to step through the list of defined tables. If you have made changes to a
particular table, you must click Save before moving to another correction table; otherwise, your
changes will be lost.
Table Name
The name assigned to the table.
Table Entries
Used to insert/edit/delete the actual entries in the impedance correction table. In the first row, enter
either an off-nominal turns ratio for an LTC transformer, or a phase shift in degrees for a phase
shifting transformer. The entries in the first row must be entered in strictly ascending form. In the
second row, enter the scale factor to apply to the transformer impedance. The transformer's nominal
impedance is multiplied by the scale factor to obtain the actual value. Note that at least two columns
must be used.
Right-click on the table to invoke its local menu, which allows you to delete and to insert columns.
To insert a new column, click on the column before which you want to insert a new column and
select Insert New Point from the local menu. To delete a column, position the cursor on the
column you want to delete and select Delete Point.
Table is Used by the Following Transformers
Lists all the transformers in the case that use this impedance correction table. A single table may be
used by any number of transformers. To associate a table with a transformer, use the Transformer
AVR Dialog for LTC transformers or the Transformer Phase Shifting Dialog for phase shifters.
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Switched Shunt Information (Run Mode)
The Switched Shunt Information dialog can be displayed by placing the cursor on a switched shunt
display object and right-clicking or right-clicking on a switched shunt record in the Switched Shunt
Display and choosing Show Dialog. This is very similar to its Edit mode counterpart. The dialog has
the following fields:
Bus Number
Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the bus to
which the switched shunt is attached. This drop down list identifies the buses in the case with
switched shunts that also have valid display filters. Use the spin button to step through the list of
shunts in the case. Multiple switched shunts are allowed at a bus but only one is allowed to be on
automatic control.
Find By Number
To find a switched shunt by its bus number, enter the number into the Bus Number field. Then click
the Find By Number button.
Bus Name
Unique alphabetic identifier for the bus to which the switched shunt is attached, consisting of up to
eight characters. This dropdown box lists the names of all the switched shunt buses in the case with
valid display filters.
Find By Name
To find a switched shunt by its name, enter the bus name into the Bus Name field (case insensitive).
Then click the Find By Name button.
Shunt ID
Since multiple switched shunts are allowed on a single bus, each shunt is identified by a unique
Shunt ID.
Find…
If you do not know the exact switched shunt bus number or name you are looking for, you can click
this button to open the advanced search engine.
Status
Status of the switched shunt, either Closed (connected to terminal bus) or Open (not connected). On
the oneline, the switched shunt can be opened by placing the cursor on the (red) circuit breaker box
and clicking, and it can be closed by placing the cursor on the (green) box and again clicking. You
can also use this status field to change the switched shunt's status. Note that the switched shunt is
only available for automatic control when its status is closed.
Energized
Indicates if the switched shunt is energized. This is not the same as the Open or Closed status. A
switched shunt may be in-service itself (closed) but not be energized, based on the statuses of other
devices around the switched shunt. For example, in a full topology model, it is not uncommon for a
switched shunt to have a status of Closed, but the switched shunt is not energized if a branch of
type Circuit Breaker connecting the switched shunt to the system has a status of Open.
Labels
Clicking on this button will open the Label Manager Dialog listing all the labels assigned for the
selected switched shunt.
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Parameters
Nominal Mvar
Amount of reactive power that would be supplied by the switched shunt if its terminal voltage were
one per unit (capacitive is positive).
Actual Mvar
Actual reactive power in Mvar being injected into the system by the switched shunt (capacitive is
positive). The Actual Mvar field is equal to the Nominal Mvar field multiplied by the square of the
terminal bus' per unit voltage.
Nominal MW
This field is only visible when a switched shunt object has been read from a file as a Bus Shunt. In
that case, it is possible for the bus shunt to have both a MW and MVAR component. The MW
component will be displayed here. In general, switched shunts of other control types do not have
MW components, and this field will not be displayed. If you change a switched shunt read as a bus
shunt to another form of control, the MW component will remain, but has no controllability.
Actual MW
This field is only visible when a switched shunt object has been read from a file as a Bus Shunt. The
value displayed is the actual real power in MW being injected into the system by the shunt. The
Actual MW field is equal to the Nominal MW field multiplied by the square of the terminal bus' per
unit voltage.
Control Mode
Information about this option can be found in the Switched Shunt Control topic.
Control Regulation Settings
Information about these options can be found in the Switched Shunt Control topic.
Switched Shunt Blocks
Information about these settings can be found in the Switched Shunt Control topic.
Control Options: Advanced Options
Information about these options can be found in the Switched Shunt Control topic.
Control Parameters: Time Step Options
The Time Step Options tab contains control options specific for the Time Step Simulation tool.
Fault Information
Typically switched shunts are treated as open circuits in the zero sequence data for fault analysis.
However, it is possible to define zero sequence admittance blocks to be used. The blocks work
similarly to the load flow Switched Shunt Blocks discussed above. Usually there will be the same
number of blocks in the zero sequence data as in the load flow data. Simulator will determine how
many blocks were switched in for the power flow solution, and then use the zero sequence block data
to calculate the zero sequence admittance for the same number of steps and blocks.
Owner, Area, Zone, Sub
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This tab is used to display or change the generator’s owner information, area information, zone, and
substation information
Area Number, Area Name
The area number and name to which the switched shunt belongs. The area of the switched shunt
can be different than the area of its terminal bus.
Zone Number, Zone Name
The zone number and name to which the switched shunt belongs. The zone of the switched shunt
can be different than the zone of its terminal bus.
Owner Number, Owner Name
The owner number and name to which the switched shunt belongs. A switched shunt will belong to
the same owner to which its terminal bus belongs.
Substation Number, Substation Name
The substation number and name to which the switched shunt belongs. A switched shunt will belong
to the same substation to which its terminal bus belongs.
Custom
This page of the dialog contains two sections: custom fields and memo.
The custom fields section allows access to setting and changing the values for custom fields that have
been defined for the switched shunt. Defining custom fields is detailed in Custom Field Descriptions.
The Memo section of the dialog is simply a location to log information about the switched shunt. Any
information entered in the memo box will be stored with the case when the case is saved to a PWB
file.
Stability
This tab is only visible with the Transient Stability Add-On tool. Any switched shunt-specific transient
stability modeling information is contained on this tab. For more information see the Transient Stability
Data: Object Dialogs.
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Zone Information (Run Mode)
This dialog is used in the Run Mode to view and modify information associated with a zone record. It
displays different information from the Edit Mode version of the zone dialog. To view this dialog, open
the Zone Records Display by clicking on Aggregations > Zones in the Model Explorer. Right-click on
the zone of interest and choose Show Dialog. The Run Mode Zone Dialog has the following fields:
Zone Number, Zone Name
Number and name of the associated zone. Use either the combo box or the spin arrows to view the
different zones.
Find…
If you do not know the exact zone number you are looking for, you can click this button to open the
advanced search engine.
Labels
To assign alternative identifying labels to the zone, click the Labels button, which will open the Label
Manager Dialog listing all the labels or aliases assigned for the selected zone.
The rest of the Run Mode Zone Dialog is divided into multiple pages:
Information
Load and Generation
Real and reactive load, generation, shunts, losses, and interchange for the zone.
Generation AGC Range
These two fields show the total available MW reserve for generators in the zone that are on AGC and
have nonzero participation factors. In other words, these fields show the total MW by which the
generation in the zone can be increased or decreased using only generation that is presently on-line.
The generator status, AGC status, and participation factor can be changed on the Generator Records
Display.
Tie Lines
Zone Tie Lines
The Zone Tie Line Table identifies the flows on all of the zone's ties to other zones.
To determine the total loss for a zone, losses for tie-lines between zones are assigned to the zone in
which the terminal bus that is NOT the metered bus is contained. The Metered End field for a
branch determines which of the terminals is metered.
OPF
Average LMP for Zone
The computed average locational marginal price of all buses contained in the zone.
LMP Standard Deviation
The standard deviation of the locational marginal price for all buses contained in the zone.
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Minimum LMP
The minimum locational marginal price of all the buses in the zone.
Maximum LMP
The maximum locational marginal price of all the buses in the zone.
Reserve Requirement Curves
These options are only available with the OPF Reserves add-on. More information about these
options can be found in the Area and Zone OPF Reserve Requirement Curves topic.
Zone Buses, Zone Gens, Zone Loads, Zone Switched Shunts
These pages show the case information display with the buses, generators, loads and switched shunts
assigned to the zone.
Custom
The Custom Page of the Zone Information dialog displays custom numbers or strings defined with the
viewed zone. The Memo box is simply a location to log information about the zone. To log information
about the zone, simply start typing your information or comments about the zone in the memo box.
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Labels
Using Labels for Identification
Most data objects (such as buses, generators, loads, switched shunts, transmission lines, areas,
zones, and interfaces) may have an alternative names assigned to them. These alternative names
are called labels. Labels allow you to refer to equipment in the model in a way that may be unique
to your organization. Labels may thus help clarify which elements are described by a particular set of
data, especially when the short names employed by the power system model prove cryptic.
Furthermore, since labels are likely to change less frequently than bus numbers, and since a label
must, by definition, identify only one power system component, they may function as an immutable
key for importing data from auxiliary files into different cases, even when bus numbering schemes
change between the cases. Labels must be unique for devices of the same type, but the same label
can be used for a device of a different type.
Information dialogs corresponding to buses, generators, loads, switched shunts, transmission lines,
areas, zones, and interfaces feature a button called Labels. If you press this button, the device’s
Label Manager Dialog will appear. The Label Manager Dialog lists the labels associated with the
device and allows adding, deleting, and modifying labels. The Labels (All) field (variablename =
LabelsAll) in a Case Information Display lists all of the labels that have been associated with a
device. The device's primary label is the one that is listed first in this field. This field lists all labels
assigned to a device as a comma-delimited string. Even though multiple labels may be assigned to a
device, any label can be used to import data from auxiliary data files. The Label Manager Dialog can
be used to assign labels or the string of labels can be entered directly in the Labels (All) field.
Labels can be used to map data from an auxiliary data file to a power system device. Recall that
auxiliary data files require you to include a device’s key fields in each data record so that data may
be mapped to the device. Labels provide an alternative key. Instead of supplying the bus number to
identify a bus, for example, you can supply one of the bus’s labels. The label will enable Simulator to
associate the data with the device associated with that label. This mechanism performs most
efficiently when the primary label is used, but other labels will also provide the mapping mechanism.
The Label (for use in input from AUX or Paste) field (variablename = Label) is used for
importing data using labels and is blank when viewing in a case information display. Keep in mind
that all devices read via an auxiliary file using the label field should have a non-blank label.
Otherwise, information for that device will not be read. Even if the primary or secondary key fields
are provided with the device, as long as the label field is present, that is the only field that will be
used to identify the device. New devices cannot be created by simply identifying them by label.
Either the primary or secondary key fields must be present to create a new device and the label field
should not be present.
Again, it is important to remember this: a single power system device may have multiple labels, but
each label may be associated with only one device of a particular type. This is the key to enabling
data to be imported from an auxiliary file using labels.
Saving Auxiliary Files Using Labels
All devices that can be identified by labels will have the Labels (All) and Label (for use in input
from AUX or Paste) fields available in their case information displays. In order to save auxiliary
files that identify devices by label, the two label fields should be added to the case information
display prior to saving the data in an auxiliary file. Because the Label (for use in input from AUX
or Paste) field will be blank when saved in the auxiliary file, this field must be populated with one
of the labels in the Labels (All) field before loading the auxiliary file back in. Keep in mind that
devices with blank labels cannot be identified when loading in an auxiliary file, so avoid saving
auxiliary files by label if all devices do not have labels.
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Many devices require SUBDATA sections. These sections have custom formats specific to the type of
information that they contain. When saving auxiliary files with devices that require SUBDATA
sections, the user can choose to use primary or secondary key fields or labels to identify devices in
the SUBDATA sections. The user will either be prompted when saving the devices, or there is an
option to change the key field to use when saving subdata sections on the PowerWorld Simulator
Options dialog under the Case Information Displays category. When choosing to use labels, if a
device has a label, it will be used. If it is a device that can be identified by buses and bus labels
exist, bus labels will be used. Finally, if the device does not have a label and the buses do not have
labels, the primary key for the device will be used for identification.
Devices that have SUBDATA sections that contain other devices that can be identified by labels
include: contingencies, interfaces, injection groups, post power flow solution actions, and owners.
The setting to choose which identifier to use for the SUBDATA sections does not just apply to
SUBDATA sections. Often when saving groups of options, this setting will apply to everything being
saved with those options and not just the SUBDATA sections. This includes contingency options,
ATC options, limit monitoring settings, and PVQV options. In these cases, there will be a prompt
asking the user to decide which identifier to use in the auxiliary file.
Loading Auxiliary Files SUBDATA Sections Using Labels
The various SUBDATA sections that represent references to other objects can also be read using
labels. Examples include contingencies, interfaces, injection groups, post power flow solution
actions, and owners. When reading a SUBDATA section such as this, PowerWorld makes no
assumption ahead of time about what identification was used to write this SUBDATA section.
Instead, an order of precedence for the identification is as follows
Identification

Explanation

Example

1

Key Fields

assumes that the strings represent Key Fields

BRANCH 8 9 1

2

Secondary Key
Fields

assumes that the strings represent Secondary Key
Fields

BRANCH
Eight_138
Nine_230 1

3

Labels for
component
objects

the key/secondary key fields for some objects
consist of references to other objects. An example of
this is the BRANCH object that is described by the
From Bus, To Bus, and Circuit ID. This assumes that
labels of the component objects are used.

BRANCH Label8
Label9 1

4

Labels

Assumes that the string represents one of the Labels
of the object

BRANCH
LabelForBranch

Special Use of Labels
There are a few special cases where objects have fields that identify other devices. These devices
can be identified by label but not in the conventional means because the label field applies to the
object that contains the device and a SUBDATA section is not necessary. These special cases
include: (Note all fields given below are by variable name because the use of labels is most relevant
with auxiliary files.)
ATC Scenarios
ATC Scenario change records usually contain primary key fields to identify the devices that
should be adjusted during the scenario. If using labels, these primary key fields will be replaced
with a single Label field. The use of this field is different because the Label field refers to the
device in the change record and not to the change record itself. When labels are used with
ATC scenarios, device labels only can be used. Bus labels cannot be used to identify devices for
which no label exists but a bus label does.
ATC Scenarios are saved in an auxiliary file if choosing to Save Settings on the ATC Dialog.
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ATC Extra Monitors
ATC Extra Monitors identify either branches or interfaces to monitor during the ATC analysis.
These devices are identified in the WhoAmI field of ATC Extra Monitor records. Usually, the
WhoAmI field is a special format that contains key field tags. Optionally, this field can use the
label of the device for the extra monitor. If the device label is not available, the standard format
will be used. There is no option to use bus labels if they exist and the device labels do not.
ATC Extra Monitors area saved in an auxiliary file if choosing to Save Settings on the ATC Dialog.
Model Conditions
Devices in Model Conditions are usually identified by the WhoAmI field which is in a special
format that contains key field tags. Optionally, this field can use the label of the device. If the
device label does not exist, the standard format will be used. There is no option to use bus labels
if they exist and the device labels do not.
Model Expressions
Model Expressions contain Model Fields. Model Fields are identified by the WhoAmI fields in the
Model Expressions. Usually, the WhoAmI fields are in a special format that contains key field
tags. Optionally, these fields can use the label of the device associated with the Model Field. If
the device does not exist, the standard format will be used. There is no option to use bus labels
if they exist and the device labels do not.
Bus Load Throw Over Records
Bus Load Throw Over Records are used with contingency analysis. These records have an option
to identify the bus to which the load will be transferred by either number or name_kV
combination. If choosing to identify objects by label, the BusName_NomVolt:1 field will
contain the label of the bus instead of the name_kV combination.
Bus Load Throw Over Records will be saved in an auxiliary file if choosing to Save settings on the
Contingency Analysis dialog.
Injection Group Participation Points
All participation points and the injection groups to which they belong can be listed on the
Injection Group Display. Load, generator, and shunt devices that can be assigned to a
participation point must be identified by bus and ID. The bus can be identified by either the
number or name. When identifying by name, the BusName_NomVolt field is used to provide
the name_kV combination for the bus. If choosing to identify devices by label, this field instead
will contain the label of the device. If the device does not have a label but the bus does, the bus
label will be used instead in conjunction with the ID of the device. Even if the device does
contain a label, the ID field must be included in any auxiliary file that is going to be loaded
because it is a key field. Injection groups can be included in other injection groups. Injection
groups can be identified by label, even though this is not a normal thing to do. If any injection
groups have labels and these injection groups are included in other injection groups, their labels
will also appear in the BusName_NomVolt field. If they do not have labels, they will be identified
by the injection group name that appears in the PPntID field.
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Label Manager Dialog
The Label Manager Dialog allows the creation and modification of labels to identify power system
devices. Labels can be used for most data objects (such as buses, generators, loads, switched shunts,
transmission lines, areas, zones, and interfaces) as alternate names for these devices. See the Labels
topic for more information on how labels can be used.
The Label Manager Dialog can be accessed by clicking the Labels button on any of the information
displays for objects that allow labels.

List of Labels
Multiple labels can be assigned to a single object. The list on the left of the dialog shows all of the
labels that have been assigned with the primary label listed first and highlighted in yellow.
Add New
Click this button to add a new label after entering the new label in the box to the right of the button.
If this new label should be the primary label, check the Primary box. Labels must be unique for
each type of object. That means that there cannot be two buses labeled One. However, there could
be objects of different types with the same label. There could be a bus and a generator both labeled
One. If attempting to label an object with a label that has already been used by the same object
type, the label will be assigned to the current object and removed from the object to which it was
previously assigned.
Delete
Click this button to delete a label after first selecting the label in the list of labels.
Make Primary
Click this button to make a label the primary label after first selecting the label in the list of labels.
The primary label will be moved to the top of the list. The primary label will always appear at the top
of the list and will be used for sorting when sorting by label.
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Latitude/Longitude and UTM Coordinates Conversion
This tool is used to convert between Latitude/Longitude and UTM Coordinates in a particular Bus. The
Tool is located in the Geography Tab of a Bus or Substation Dialog in the Run or Edit mode.

Latitude (degrees)
Entry for the latitude information that is stored with the chosen bus. The Latitude entry can also be
entered manually.
Longitude (degrees)
Entry for the longitude information that is stored with the chosen bus. The Longitude entry can also
be entered manually.
Datum
Entry for the Datum (model of the shape of the earth) information that is stored with the chosen
bus. The Datum entry can also be entered manually. Example: WGS-84.
Convert Lat/Lon to UTM Coord.
Press Convert Lat/Lon to UTM Coord. to convert from Lat/Lon coordinates to UTM coordinates.
UTM North/South
Entry for the side of the hemisphere: North or South. The UTM North/South entry can also be
entered manually.
UTM Longitude Zone
Entry for the zone information. Also the UTM Longitude Zone entry can also be entered manually.
UTM Northing
Entry for the Northing information. Also the UTM Northing entry can also be entered manually.
UTM Easting
Entry for the Easting information. Also the UTM Easting entry can also be entered manually.
Convert UTM to Lat/Lon Coord.
Press Convert UTM to Lat/Lon Coord. to convert from UTM coordinates to Lat/Lon coordinates.
For more information on the Map Projections or conversion between UTM and Latitude/Longitude
coordinates please go to http://www.uwgb.edu/dutchs/usefuldata/utmformulas.htm or:
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Snyder, John P., Map Projections - A Working Manual, U. Geological Survey Professional Paper 1395,
United States Government Printing Office, Washington, D.C.: 1987.
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Area Information
The Area Information Dialog shows information about each area in the system. It displays an area’s
load, generation and losses; the area’s scheduled interchange with other areas; options for controlling
the area’s generators, transformers, and shunts; the flows on its tie lines; and its operating cost
information. You may view this dialog by doing any of the following:




Select Areas from the Model Explorer. This displays the Area Display. Select the desired area and
click the Show Dialog option on the case information toolbar, or right-click on the record
corresponding to the desired area to bring up the display’s local menu and choose Show Dialog.
Right-click in an empty portion of the oneline near a bus in the area of interest to display the
oneline’s local menu. Select Area Information Dialog.
While in Run Mode, right-click on an Area Display Object that represents an area and choose
Information Dialog. Note: Doing this while in Edit Mode will show the Area Display Options dialog
instead of the Area Information Dialog.

The Area Information Dialog contains the following information:
Number
A drop-down box that specifies the area number. Select an area from the drop-down box, or use the
spin button to cycle through the list.
Find By Number
To find an area by its number, type the number in the Number field and click this button.
Name
A drop-down box that specifies the area’s alphabetic identifier, which may be any length in
Simulator. When saving area names to other load flow formats, the names are truncated at the
maximum character length supported by that format.
Find By Name
To find an area by its name, type the name in the Name field and click this button.
Find…
If you do not know the exact area number or name you are looking for, you can click this button to
open the advanced search engine.
Super Area
To associate an area with a particular super area, either select an existing super area from the dropdown box, or type the name of a new super area.
Area Control Options
Select to change the area’s method of Automatic Generation Control (AGC.)
Labels
To assign alternative identifying labels to the area, click the Labels button.
The rest of the Area Information Dialog is divided into nine pages of controls:





Info/Interchange
Options
Area MW Control Options
OPF
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Tie Lines
Buses
Gens
Loads
Custom
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Area Information: Buses
The Area Buses grid shows a list of all buses that are in the area. The grid displays the bus number,
bus name and other bus information. The Area Buses display is a Case Information Display and has
options available to these types of displays.
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Area Information: Gens
The Area Gens grid shows a list of all generators that are in the area. The grid displays the bus
number, bus name, generator ID and other generator information. The Area Gens display is a Case
Information Display and has options available to these types of displays.
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Area Information: Loads
The Area Loads grid shows a list of all loads that are in the area. The grid displays the bus number,
bus name, load ID and other load information. The Area Loads display is a Case Information Display
and has options available to these types of displays.
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Area Information: Area MW Control Options
Set Participation Factors...
Press this button to open the Generator Participation Factors Dialog, which gives you control over
how the participation factor for each generating unit is defined. If you decide not to prescribe
participation factors using this button, the existing participation factors defined with each generator
will be used. This button will be enabled only if the area has been set to Participation Factor area
control.
Area Slack Bus Number
Identifies which bus to model as the area’s slack bus.
Injection Group Area Slack
An additional area generation control option that can be utilized is the ability for Simulator to use a
defined injection group as the sink for Area Slack control. When an injection group is selected, and
the area is set on Area Slack control, any needed injection changes in the area will be accounted for
by the devices in the injection group.
Some typical injection group options are also available here for handling the injection group
dispatching during the Injection Group Area Slack Control. These options include:
Allow only AGC gen/load to vary:
Only generators and loads in the injection group that are designated as available for AGC control
will be allowed to participate in injection changes.
Enforce generator MW limits (ignore case and area options):
Generators in the injection group can be designated to enforce their MW limits independent of
the global case and area options for generator MW limit enforcement.
Do not allow negative loads:
If loads are decreasing demand as part of an injection group area dispatch, you can specify
whether or not those loads should be allowed to go below 0 demand.
How should reactive power load change as real power load is ramped?
You can choose to keep the ratio of real and reactive power constant for each load that is
included in the injection group, or you can specify a constant power factor that the MVAR value
will be determined from when the MW value is changed.
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Area Information: Info/Interchange
The Info/Interchange Tab serves as an accounting sheet for flows into and out of an area. It houses
the following controls:
Load, Generation, Shunts, Losses, Interchange
These read-only fields express the total real and reactive load, generation, shunt compensation,
losses, and interchange for the area.
Interchange
Interchange in MW between the area and all other areas (exporting power is positive). To prescribe
an interchange with a specific area, simply enter the amount of power in MW to export to that area
in the MW Export column. To specify an import, enter a negative value. If the recipient of the power
is unknown, you may enter the net total in the Unspecified MW Interchange field found above
the list of transactions. The net value of the MW imports and exports is displayed in Transaction
MW.
Check the box Only Show Areas with Nonzero Interchange to display only those areas whose
interchange is different from zero.
By default, one interchange record is initially defined between each area. The total interchange
between two areas can be managed using this single record. However, it is possible to define
multiple interchange records between the same areas. To do so, you can right-click in the
interchange table and select Insert from the local menu. This will open the Transaction Dialog, which
will allow you to insert a new transaction. Transactions between the same two areas must have
unique transaction IDs. Once you have multiple transactions defined between the same two areas,
you can choose which transactions are enabled using the Enabled property in the Base Interchange
table. This field is a toggleable field, meaning you can double-click in the field to toggle its value.
The total interchange defined for an area will be displayed in the summary field labeled
Interchange in the area summary totals on the left side of the page.
AGC Tolerance
The MW tolerance is used in enforcing area interchange. When the absolute value of the ACE is less
than this value, Simulator considers the area interchange constraint to be satisfied.
ACE (Area Control Error)
Current area control error (ACE) for the area in MW. Note that, when the constant frequency model
is used, ACE = area generation - area load - area losses - scheduled area interchange - area shunt
MW.
Area Has Multiple Islands
This is an informational field that cannot be changed. If checked, then Simulator has detected that
the area has devices in separate electrical islands in the system. This is important because it is
sometimes impossible for an area using some form of generation control (AGC) to solve for the
generation dispatch in the entire area (Area Generation = Area Load + Area Losses + Area
Interchange + Area Shunt MW) when the area is not entirely within the same electrical island. If
Simulator is unable to solve for areas that span multiple islands, the AGC status of the area will
automatically be set to "Off AGC" and a warning message will be written to the Simulator message
log.
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Area Information: Options
Report Limit Violations
If checked, limit violations for this area are reported. Limits violations are reported in the Limit
Violations List.
Generation AGC Values
These fields indicate the total available AGC range for all the generators in the area that are
specified as being on AGC and have nonzero participation factors. That is, these fields show
the total amount the generation in the area that can be increased or decreased using the presently
on-line generation. This may be referred to as the spinning reserve. The generator status, AGC
status, and participation factor can be changed on the Generator Records Display.
Load MW Multiplier Value
This value is used for scaling the area MW load. The base load remains unchanged.
Load MVAR Multiplier
This value is used for scaling the area MVAR load. The base load remains unchanged.
Automatic Control Options
The Automatic Control Options section provides a convenient mechanism to enable or disable
automatic control of switched shunts and transformers in the area.
This section also provides a check box for setting if the generators in the area should enforce their
Generator MW Limits or not. Typically this should be checked. Note that even if unchecked, the OPF
routine end Economic Dispatch will ignore this setting and will always enforce generator MW limits
during an OPF solution. Settings for enforcing MW limits at individual generators and globally for the
case will also be ignored if using OPF or Economic Dispatch control.
Include Loss Penalty Factors in ED
If this box is unchecked, then the economic dispatch for the area is calculated assuming that the
area is lossless. Otherwise, the solution will incorporate losses when computing the economic
dispatch. The penalty factors gauge the sensitivity of the area’s losses to changing injection at
specific generators. The option to calculate loss penalty factors is relevant only when the area
operates according to Economic Dispatch Control. Usually, if the system’s cost curves are relatively
flat, the inclusion of losses in the solution will not have much of an effect on the dispatch.
Economic Dispatch Lambda
The lambda value calculated during the economic dispatch computation. This field is valid only when
the area is on economic dispatch control.
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Area Information: Tie Lines
The Tie Lines display shows the flow on all of the tie lines for the selected area. This display is a case
information display and contains many of the options available to these types of displays.
The default fields that are shown in the grid identify each line and show the flow on each line.
Near Area Name, Near Area Number
These fields identify the area name and number of the tie line terminal located in the selected area.
Near Number, Near Name
These fields identify the bus number and name of the tie line terminal located in the selected area.
Far Area Name, Far Area Number
These fields identify the area name and number of the tie line terminal located in the other area.
Far Number, Far Name
These fields identify the bus number and name of the tie line terminal located in the other area.
Ckt
This is the circuit identifier for the tie line.
Meter MW, Meter Mvar
These are the real and reactive power flowing on the tie line from the selected area to the
other area. (Real and reactive power flowing on line from the Near bus to the Far bus.)
Status
This field gives the status of the tie line as Open or Closed.
MW Loss, Mvar Loss
These fields show the real and reactive power losses on the tie line.
To determine the total loss for an area, losses for tie-lines between areas are assigned to the area in
which the terminal bus that is NOT the metered bus is contained. The Metered End field for a
branch determines which of the terminals is metered.
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Area Information: OPF
The OPF Tab contains information regarding the Optimal Power Flow (OPF) solution data for an area.
It houses the following information:
Average LMP for Area
The computed average locational marginal price of all buses contained in the area.
LMP Standard Deviation
The standard deviation of the locational marginal price for all buses contained in the area.
Min/Max LMP
The minimum and maximum locational marginal price of all the buses in the area.
Total Generator Production Cost (Scaled)
The scaled cost includes the Cost Shift and Cost Multiplier. These two values can be defined for each
generator, and allow the user a way to assess changes to the LMP results when a generators cost or
"bid" is modified, without actually changing the original generator cost or bid curve. The scaled cost
function for each generator is equal to:
(original cost function + cost shift) * cost multiplier
Total Generator Unscaled Production Cost
The total unscaled generator production cost, based on the original generator cost or bid curves.
Total Generator LMP Profit
The profit of the generators in the area based on the Locational Marginal Prices (LMPs) determined
by the OPF solution. The profit is determined as:
LMP Price * MW Output – Unscaled Cost Function
Cost of Energy, Loss, and Congestion Reference
Specify a reference for determining the cost of energy, loss and congestion. The choices are Existing
loss sensitivies directly, Area’s Bus’ Loads, Injection Group, or a specific bus.
Reserve Requirement Curves
These options are only available with the OPF Reserves add-on. More information about these
options can be found in the Area and Zone OPF Reserve Requirement Curves topic.
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Area Information: Custom
The Custom page of the Area Information dialog contains two sections: custom fields and memo.
The custom fields section allows access to setting and changing the values for custom fields that have
been defined for areas. Defining custom fields is detailed in Custom Field Descriptions.
The Memo section of the Area Information dialog is simply a location to log information about the
area. To log information about the area, simply switch to the Custom page on the dialog, and start
typing your information or comments about the area in the memo box.
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Area Field Options
Area field objects are used to show different values associated with areas and the system. This dialog
is used to view and modify the parameters associated with these fields.
Area Number
Area number associated with the field. When you insert fields graphically, this field is automatically
set to the area number associated with the closest bus on the oneline. With most types of area
fields, an Area Number of 0 is valid and defines the field as showing values for the entire system.
Find…
If you do not know the exact bus number or name you are looking for, you can click this button to
open the advanced search engine.
Total Digits in Fields
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Rotation Angle in Degrees
The angle at which the text is to appear on the oneline diagram.
Other Area Number
Some of the fields, such as MW Flow to Other Area, require that a second area be specified. If
applicable, enter the second (other) area here.
Other Area Transaction ID
Since it is now possible to have more than one base transaction defined between the same two
areas, base transactions must now also have a unique ID to distinguish between transactions among
the same two areas. If you are displaying a field that pertains to the display of the scheduled flow
between areas, the ID of the transaction in question will also need to be entered here.
Delta MW per Mouse Click
This value is used only with the Sched Flow to Other Area field type. When there is a nonzero
entry in this field, and the field type is Sched Flow to Other Area, a spin button is shown to the
right of the area field. When the up spin button is clicked, the flow to the other area is increased by
this number of MW; when the down button is clicked, the scheduled flow is decreased by this
amount.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Field Value
Shows the current output for the area field. Whenever you change the Type of Field selection, this
field is updated.
For the Sched Flow to Other Area field type only, you can specify a new value in MW. Exports are
assumed to be positive.
Anchored
If checked, the area field will be anchored to a corresponding Area Object. If the area object is
moved on the diagram, the text field will move with it.
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Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
Used to determine the type of bus field to show. The following choices are available:
Name Area name (eight characters maximum). The Area Number field must correspond to a valid
area.
Number Area number (1 - 999). The Area Number field must correspond to a valid area.
MW Load, Mvar Load If the area number is nonzero, then these fields show Total MW or Mvar
load for the area. If the area number is zero, these fields show the
total load in the entire system.
MW Generation, Mvar Generation If the Area Number is nonzero, then these fields show Total
MW or Mvar generation for the area. If the Area Number is zero, these
fields show the total generation in the entire system.
MW Losses, Mvar Losses If the Area Number is nonzero, then these fields show Total MW or
Mvar losses for the area. If the Area Number is zero, these fields show
the total losses in the entire system.
ACE (MW) Area Control Error in MW for the area. The Area Number field must correspond to a
valid area.
Hourly Cost ($/hr) If the Area Number is nonzero, then this field shows the hourly cost for the
area. If the Area Number is zero, these fields show the hourly cost for
the entire system.
Total Cost ($) If the Area Number is nonzero, this field shows the total cost incurred by the area
since the beginning of the simulation. If the Area Number is zero, this
field shows the total cost incurred throughout the system since the
beginning of the simulation.
MW Flow to Other Area,
Mvar Flow to Other Area Total MW or Mvar flow from the area specified in the Area Number field
to the area specified in the Other Area Number field. The Area Number
field must correspond to a valid area. If the Other Area Number field is
zero, this field shows the area’s total MW or Mvar exports.
Sched. Flow to Other Area Scheduled MW transaction from the area specified in the Area Number
field to the area specified in the Other Area Number field, and with the
Transaction ID given in the Other Area Transaction ID field. The Area
Number field must correspond to a valid area. If the Other Area
Number field is zero, this field shows the area’s total scheduled MW
transactions. If the Delta per Mouse Click value is nonzero, you can use
the spin arrows on the oneline to change this value. Also, you may
directly enter a new value in the Field Value field.
Load Schedule Multiplier (MW Only) Indicates the current value of the MW multiplier applied to
the area’s loads.
AGC Status Displays the AGC status of the area.
Select a Field Choose from all possible information fields that can be displayed for areas.
Select OK to save changes and close the dialog or Cancel to close dialog without saving your changes.
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Super Area Information Dialog
The Super Area Information Dialog displays information pertaining to Super Area Display. It
summarizes the super area's real and reactive load and generation, scheduled transactions, and
constituent areas. It also allows you to manage the list of areas to include in the super area and to
designate how its generation should be controlled. To display the Super Area Information Dialog, rightclick on the Super Area Records Display and select Show Dialog from the resulting local menu.
The Super Area Information Dialog has the following fields:
Area in Super Area
Name
The list of all super areas that have been defined in the case are listed in this dropdown box. Select
one of the super areas to display its information, or type a new name in the box and click Add New
to define a new super area.
Rename
Click this button to change the name of the super area specified in the Name field.
Save
Saves the super area of the name specified in the list of super areas.
Delete
Click this button to delete the super area specified in the Name field.
Area in Super Area
Areas in Super Area
Lists the areas contained in the super area. Right-click on a row and select Remove to remove the
area from the super area.
Super Area Control Options
Specify the type of generation control to employ for the super area. The super area may be removed
from area control or employ Participation Factor or Economic Dispatch control. See Area Control for
details on these types of generation control.
An additional type of control available to Super Areas is to Use Area Participation Factors. If the
super area is set to participation factor control, and this option is NOT checked, then the generators
within the super area respond by redispatching to meet the entire super area generation change
based on their own participation factors.
However, if this option IS checked, then an additional level of participation control complexity is
added for the super area. First, the total super area generation change is divided across each area
forming the super area, according to the participation factors of the AREAS, as set in the grid on this
dialog. Once the total generation change has been determined for each area within the super area,
then the generators within each individual area are dispatched using area participation factor control
to meet each specific area's determined generation change.
Use Area Participation Factors
If the super area control is set to Participation Factor control, you can specify participation factors
for each area in the list of areas that indicate how each area should contribute towards changes in
generation for the super area. For example, if you have three areas in the super area and you set
the participation factors to 1, 1 and 2, the three areas will contribute to the total change in
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generation in the super area by ratios of 25%, 25%, and 50%, respectively. The contribution of
each area is then further divided among the generators within each area by the participation factors
of the individual generators.
This option will be applied when calculating TLR, PTDF, voltage, and ATC sensitivities. When
calculating these sensitivities, the assumption is that the super area is on participation factor control
even if the control method is something other than this. If this option is selected, it will be enforced
regardless of the control method when calculating these sensitivities.
New Area Name
Use the dropdown box to select an area to add to the super area. Click the Add New Area by
Name to add the selected area to the super area.
New Area #'s
Enter in a list of area numbers separated with dashes or commas and click Add New Areas by
Number button to add the areas to the Super Area
Summary Information
ACE Total (MW)
The total area control error for the super area. It is calculated by summing the ACE for all areas
comprising the super area.
ACE Tolerance (MW)
The Area Control Error tolerance observed for the super area during a load flow solution.
Total Scheduled Transactions
Lists the total scheduled import or export for the super area. It is computed by summing the
scheduled interchange for all areas comprising the super area. Exports are positive.
Lambda
The marginal cost associated with the super area. Lambda is valid only for super areas that are on
economic dispatch control.
Hourly Cost
Current average hourly cost for the super area in $/hour.
Load, Generation, Shunts, Losses, Interchange
The Load and Generation section of the Super Area Information Dialog accounts for the real and
reactive power flows into, out of, and within the super area. Each quantity is computed by summing
over the areas comprising the super area.
OPF
The OPF Tab contains information regarding the Optimal Power Flow (OPF) solution data for a super
area. It houses the following information:
Average LMP for Area
The computed average locational marginal price of all buses contained in the area.
LMP Standard Deviation
The standard deviation of the locational marginal price for all buses contained in the area.
Min/Max LMP
The minimum and maximum locational marginal price of all the buses in the area.
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Total Generator Production Cost (Scaled)
The scaled cost includes the Cost Shift and Cost Multiplier. These two values can be defined for each
generator, and allow the user a way to assess changes to the LMP results when a generators cost or
"bid" is modified, without actually changing the original generator cost or bid curve. The scaled cost
function for each generator is equal to:
(original cost function + cost shift) * cost multiplier
Total Generator Unscaled Production Cost
The total unscaled generator production cost, based on the original generator cost or bid curves.
Total Generator LMP Profit
The profit of the generators in the area based on the Locational Marginal Prices (LMPs) determined
by the OPF solution. The profit is determined as:
LMP Price * MW Output – Unscaled Cost Function
Cost of Energy, Loss, and Congestion Reference
Specify a reference for determining the cost of energy, loss and congestion. The choices are Existing
loss sensitivies directly, Area’s Bus’ Loads, Injection Group, or a specific bus.
Custom
This page of the dialog can be used to enter notes about the super area. Any information entered in
the memo box will be stored with the case when the case is saved to a PWB file. Custom fields can
also be entered on this page in the form of floating point, integer, and string fields. These custom
fields are stored with the super area and can be used for various tasks in Simulator.
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Super Area Field Information
Super area field objects are used to show different values associated with super areas. This dialog is
used to view and modify the parameters associated with these fields. Note that the super area name
itself cannot be changed on this dialog.
Super Area Name
Select the name of the super area for which you are inserting or viewing information of a super area
field.
Find…
If you do not know the exact super area name you are looking for, you can click this button to open
the advanced search engine.
Total Digits in Field
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Field Value
Shows the current output for the super area field. Whenever you change the Type of Field
selection, this field is updated.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Rotation Angle in Degrees
The angle at which the text will appear on the diagram.
Anchored
Toggles if the field should be anchored to an associated super are object on a diagram.
Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
Used to determine the type of super area field to show. The following choices are available:
Name Super area name (eight characters maximum). The super area name field must
correspond to a valid super area.
MW Load, Mvar Load Total MW or Mvar load for the super area.
MW Generation, Mvar Generation Total MW or Mvar generation for the super area.
MW Losses, Mvar Losses Total MW or Mvar losses for the super area.
ACE (MW) Area Control Error in MW for the super area. The super area name field must
correspond to a valid super area.
MW Exports Total MW exports for the super area.
Hourly Cost ($/hr) The hourly cost for the super area.
AGC Status Displays the AGC status of the super area.
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MW Marginal Cost ($ / MWhr) MW marginal cost for the super area.
Select OK to save changes and to close the dialog, or click Cancel to close the dialog without saving
your changes.
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Interface Information
The Interface Dialog is used to create, modify, or delete interface records in both the Edit and Run
Modes. This dialog has the following controls:
Interface Name
An alphanumeric identifier for the interface of up to 24 characters. Use the dropdown box or the
spin button to navigate through the list of existing interface records.
Interface Number
A numeric identifier for the interface, between 1 and 32,767.
Find Interface…
If you do not know the exact interface name or number you are looking for, you can click this button
to open the advanced search engine.
Add New Interface
Click the Add New Interface button to define a new interface from the Interface Dialog. When you
click this button, the Interface Name field and Interface Elements table are cleared, requiring
you to enter a new name and new elements.
Delete Interface
Select this button to delete the currently displayed interface. Once the interface record has been
deleted, the Interface Name field displays the previous interface record, if any. If there are not
previously defined interface records, Simulator will close the dialog.
Interface Limits
Specify the possible limits for net interface flow. As for transmission lines and transformers, up to
eight distinct limits can be specified for interfaces. Which limit set is used can be controlled from the
Limits Tab of the Simulator Options Dialog or the Line and Transformer Limit Violations Display.
Monitoring Direction
This area allows the user to change the flow monitoring direction. Clicking on the interface in the
Interface Elements area will bring up the Interface Elements Dialog. This is where the default
direction is set. To keep this default direction, choose FROM  TO, to change this direction, choose
TO  FROM, and to monitor both directions, choose Both Directions.
Noncontingent MW Flow Contribution
Indicates the present net flow through the interface elements, not including affects of contingencies,
in MW.
Contingent MW Flow Contribution
The amount of flow that would be added to the interface flow if the contingency defined with the
interface were to occur, in MW.
Total MW Flow
The sum of the non-contingent MW flow and Contingent MW flow, for the total MW flow considered
on the interface, in MW.
PTDF Value (%)
The Power Transfer Distribution Factor for the interface, if calculated.
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Interface Elements
The Interface Elements Table lists each element comprising the interface. If Simulator is in Run Mode,
the table will also show the present flow through each element. To edit or delete an existing element
in the table, click on it to bring up the Interface Element Dialog. Use the Interface Element Dialog to
modify or delete the element.
Insert New Element
Click the Insert New Element Dialog to add a new element to the interface using the Interface
Element Dialog.
Click OK to save any changes you have made and to close the Interface Information Dialog. Click
Save to save your changes but to leave the dialog open so that you can view and modify other
interface records. Click Cancel to close the dialog without saving your latest change.
Element Identifiers
Choose whether to show the interface descriptions using the interface names, the interface
numbers, or a combination of both.
OPF
The OPF page will only be visible if you have the Optimal Power Flow add-on for PowerWorld
Simulator. This page contains interface information relating to performing an OPF solution.
Enforce Interface Flow Limit
If checked, the Interface limit will be checked for enforcement during an OPF solution.
Treat Limit as Equality Constraint
If checked, the OPF routine will try and maintain the flow on the interface at its limit value.
Otherwise the limit will be treated as the maximum for an inequality constraint.
MW Flow on Interface
The actual MW flow on the interface.
Present MW Limit
The currently defined limit for the interface.
Percentage of Limit
The MW flow on the interface as a percentage of the limit.
Limit Marginal Cost
The incremental cost of maintaining the flow on the Interface at its limit value.
MW Flow Constraint
The constraint status of the interface in the OPF solution is shown here with the corresponding
boxes checked by Simulator. These boxes can not be changed by the user.
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Interface Element Information
The Interface Element Dialog is used to redefine or to add the individual elements comprising an
interface. Individual lines or transformers, inter-area ties, inter-zone ties, line contingencies, DC lines,
injection groups, generators, and loads may make up an interface. The Interface Element Dialog
allows you to add all three varieties of interface elements to an interface.
The Interface Element Dialog comes in two very similar forms, depending upon how it was invoked.
The dialog may be called from the Interface Information Dialog by clicking on either the Interface
Elements Table or the Insert New Element button.
The Interface Element Dialog contains the following controls:
Element Type
Specifies the type of interface element being investigated or added. Interface elements can be any
line or transformer or, more specifically, they can be groups of lines and transformers that tie two
areas or two zones together. Interfaces can also contain line contingencies, DC lines, generators,
loads, and injection groups.
When the selection for Element Type changes, the available Element Identifiers change to allow
you to pick the appropriate elements of that type.
Element Identifiers
Depending upon the Element Type selection, different element identifiers are required to designate
the element to add to the interface. You can search through the list of identifiers to find the
particular elements you wish to include. Note that the flow direction on transmission line,
transformer, and DC line elements will be dependent on which end of the line you choose as the
near bus. The flow will always be measured in the direction of near bus to far bus. The flow will be
positive when flowing from near to far, and negative when flow from far to near. In addition, line
elements also have an additional setting labeled Monitor Flow at To End. This determines which
magnitude of flow should be reported. If checked, the flow at the To end of the line will be reported,
otherwise the flow magnitude at the From end is used.
Insert
If you came to the Interface Element Dialog by pressing the Insert New Element button on the
Interface Information Dialog, only the Insert, Cancel, and Help buttons will be available. Click the
Insert button to add the element you have just defined to the list of elements comprising the
interface. After you click Insert, the dialog will disappear, and the Interface Elements table on the
Interface Information Dialog will contain the element you just added.
Replace, Delete
If you arrived at the Interface Element Dialog by clicking on an element in the Interface Elements
Table of the Interface Information Dialog, the Replace, Delete, Cancel, and Help buttons will be
visible. Click Replace to modify the interface element according to your specifications on this dialog.
Click Delete to remove the element from the interface definition.
Cancel
Click Cancel to close the Interface Elements Dialog without saving your changes.
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Interface Field Information Dialog
Interface field objects are used to show the different values associated with interface records. This
dialog is used to view and modify the parameters associated with these fields. The dialog has the
following fields:
Interface Name
Case insensitive name of an existing interface (12 characters maximum).
Find…
If you do not know the exact interface name you are looking for, you can click this button to open
the advanced search engine.
Total Digits in Field
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Rotation Angle in Degrees
The rotation angle at which the text field should be displayed.
Anchored
If checked, the interface field is anchored to its associated interface display object.
Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
Type of field to show for the interface record. Interface fields may show the interface's name, its
MW Limit, MW Flow, percent loading, or any other interface specific field available by clicking the
Select a field option and choosing a field from the drop-down list.
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Interface Pie Chart Information Dialog
Interface Pie Chart objects are used to graphically show the percentage flow associated with interface
records. This dialog is used to view and modify the parameters associated with these fields. The dialog
has the following fields:
Interface Name
Case-insensitive name of an existing interface (12 characters maximum).
Size
Size of the pie chart. Note that the pie chart's size and color can be set to change automatically
when the interface's loading is above a specified limit. Please see Oneline Display Options for details.
Actual Value (read-only)
In Run Mode, this field shows the current MW loading for the interface.
Percent (read-only)
In Run Mode, this field shows the current percentage loading for the interface; if the MVA rating is
zero, the percentage is defined as zero, as well.
Anchored
If checked, the interface pie chart object is anchored to its associated interface.
MW Rating
MW limit for the interface, using the current limit set for the case.
Style
The style of the pie chart. It can be set individually for the particular pie chart, or it can use the style
specified in the Interfaces Pie Chart Options.
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Automatically Inserting Interfaces in Case
The Inserting Interfaces Dialog is used to insert a group of interfaces. Only interfaces between
adjacent areas or adjacent zones can be inserted automatically; single-branch interfaces between
buses must be inserted with line insertion options. Adjacent areas or zones are those that share at
least one tie line. To reach this dialog, first open the Interfaces Display by selecting Aggregations >
Interfaces from the Model Explorer, and then from the case information toolbar select Records >
Auto Insert Interfaces . This dialog is NOT brought up through the menu item Auto Insert >
Interfaces found on the Quick Insert ribbon group of the Draw ribbon tab, which is for inserting
interface objects on an oneline diagram.
The Inserting Interfaces Dialog sports the following fields:
Type of Interfaces to Insert
Select the type of interfaces to insert. Area-to-area interfaces join adjacent areas, while zone-tozone interfaces join adjacent zones. The name of the new interface defaults to "Area1- Area2" or
"Zone1-Zone2" with an Optional Prefix.
Optional Prefix
This field allows you to specify an optional prefix of up to three characters. Use this prefix to avoid
duplicating names, particularly when some of the areas or zones have the same name.
Delete Existing Interfaces
If this option is checked, then all existing interfaces are deleted before inserting the new interfaces.
By default, this option is checked. If this option is not checked, the existing interfaces are not
deleted. However, new interfaces will automatically overwrite any existing interfaces having the
same name.
Only Insert Between Areas/Zones with Area/Zone Filters Set
If this option is checked, the set of potential areas or zones for inserting interfaces is limited to those
for which the area/zone filter setting is Yes.
Limits
Simulator can either calculate an interface rating based on the ratings of the components included in
the interface, or the user can specify a set of ratings to be used for the interface. If neither of these
options is used to set an interface limit, then by default, the interface limits are left as 0, indicating
no limit has been applied.
Insert Interfaces
Click this button to insert the interface records into the case.
Cancel
Closes the dialog without modifying the list of interfaces.
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Nomogram Information Dialog
The Nomogram Dialog is used to create, modify, or delete nomogram records in both the Edit and Run
Modes. Nomograms are used for combining a pair of interface objects for the purpose of monitoring a
combined flow restriction on the two interfaces together.
This dialog has the following controls:
Nomogram Name
An alphanumeric identifier for the nomogram.
Interface A
The first interface forming the interface pair. To add the interface from scratch in the nomogram
dialog, click on the Insert New Element button. In this manner you will be creating the interface
from the individual elements, the same as creating an interface on the interface dialog. If you
already have an interface defined, and wish to clone the elements of that interface for this
nomogram, use the button labeled Clone Elements From to find the interface and copy the
element definition.
Interface B
The second interface forming the interface pair. To add the interface from scratch in the nomogram
dialog, click on the Insert New Element button. In this manner you will be creating the interface
from the individual elements, the same as creating an interface on the interface dialog. If you
already have an interface defined, and wish to clone the elements of that interface for this
nomogram, use the button labeled Clone Elements From to find the interface and copy the
element definition.
Nomogram Breakpoints
This section is used for defining the limit boundaries for the interface. The limit boundaries are
defined by inserting nomogram breakpoints. These breakpoints correspond to a pair of MW flows on
each interface. In other words, you define the amount of flow allowed on Interface B when interface
A is at a certain amount. Typically you will have a flow limit on Interface B that is constant for a
certain range of flow in interface A. However, at some point as the flow on Interface A increases,
the limit of flow on Interface B can start to decrease due to desired flow limit restrictions of the
combined interfaces. At some point, the limit of Interface A would reach a maximum amount and
remain constant, and the range of flow on interface B would be fairly small due to the heavy loading
in Interface A.
To build this Nomogram Limiting Boundary, begin by right-clicking in the Nomogram Breakpoints list
and choose Insert Point. Note that the boundary definition must be a convex piecewise linear curve.
You would typically being by defining the flow limit allowed on Interface B when the flow on
interface A is small or zero. Then define breakpoints where the limit on B decreases as the flow on A
increases. Eventually you will define a point where the flow on A reaches a limit as the flow on B
continues to decrease towards zero. In short, the nomogram limiting boundary is actually a
combination of boundary limits that are scaled combinations of the individual interface limits. See
the image below for an example of a nomogram limiting boundary.
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Injection Group Overview
An injection group is a collection of loads, generators, switched shunts, and/or other injection groups.
In that respect, injection groups are somewhat analogous to areas and zones. However, unlike with
areas and zones, generators, loads, switched shunts, and injection groups can belong to more than
one injection group. Moreover, a single injection group may contain generators, loads, and switched
shunts from several different areas and zones. Thus, injection groups are useful when modeling a
collection of generators, loads, and switched shunts that act together as a unit, regardless of each
individual’s area or zone affiliation. The most common use for injection groups is to model a transfer of
power from one group of generators and loads to another for PTDF calculations and for PV/QV
analysis. They are called injection groups because their components (generators, loads, and
switched shunts) are objects that inject power into the network.
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Creating Injection Groups
Injection groups can be created from the Injection Group Display, Injection Group Dialog, Generator
Display, Load Display, Switched Shunt Display, or by selecting a group of display objects on the
oneline display.
To create an injection group from the Injection Group Display, select Aggregation > Injection
Groups in the Model Explorer to open the Injection Group Display. This display is organized into two
tab pages with additional tabs and displays available under each. The Injection Groups tab lists and
provides a summary of all defined injection groups. Click the right mouse button on this display, and
select Insert from the resulting local menu and the Injection Group Dialog will open with a default
name assigned to the new injection group. The Injection Group Dialog allows the addition of
participation points to the new injection group and allows updating existing injection groups. The
Load option on the local menu of the Injection Group Display can also be used to import injection
groups from an Injection Group Auxiliary Data File and the Auto Insert Injection Groups option can
be used to automatically insert injection groups based on options set in the Auto Insertion of Injection
Groups Dialog.
If the Injection Group Dialog is already open, clicking the button labeled New will create a new
injection group. A prompt will then ask for the name of the injection group to add.
To create an injection group from the Generator Display, Load Display, or Switched Shunt Display,
select the elements to add to the injection group from one of these displays, right-click on the
selection to bring up the local menu, and select Create Injection Group from Selection from the
local menu. The Injection Group Dialog will open with the selected elements added to a new injection
group. Any necessary modifications to the group can be made from the Injection Group Dialog.
To create an injection from a selection of display objects, select the objects to add to the injection
group. Only generators, loads, and switched shunts will be added to an injection group, but if other
objects are selected, the injection group will still be created. The objects that cannot be added to an
injection group will simply be ignored. Once all objects are selected, right-click on the selection to
bring up the local menu. On the local menu select Create Injection Group from Selection. The
Injection Group Dialog will open with the selected objects added to a new injection group. Any
necessary modifications to the group can be made from the Injection Group Dialog. More than one
object must be selected on the display for the create injection group option to be available.
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Auto Insert Injection Groups
Many times injection groups need to be created comprised of generators, loads, or switched shunts
grouped by areas, zones, super areas, owners, or some other criteria. Injection groups can be created
automatically by setting the grouping options by using the Auto Insertion of Injection Groups Dialog.
The Auto Insertion of Injection Groups Dialog can be accessed by selecting Records > Auto Insert
Injection Groups... from the case information toolbar on an Injection Group Display. The following
options are available:
Element Type
This option is used to select the type of element, Generators, Loads, or Switched Shunts, to
add to the new injection groups. Only a single type of element can be added to the new injection
groups.
Group By
This option dictates the common property by which all elements in the injection group will be
grouped. Elements can be grouped by Areas, Zones, Super Areas, Owners, or a selected
Custom Field. If for example the Area option is selected, then injection groups will be created for
each of the defined areas in the case. The same holds true for Zones, Super Areas, and Owners. If
the Custom Field option is selected, then injection groups will be created for all elements whose
Custom Field value is the same. For example, if the Custom Field option is selected and Cust Float 1
is set as the field to use, then all of the elements whose Cust Float 1 field are the same will be
grouped together. If there are elements whose Cust Float 1 field is set to 1 and there are elements
whose Cust Float 1 field is set to 2, then two new injection groups will be created. One will contain
all of the elements whose Cust Float 1 field is 1 and the other will contain all of the elements whose
Cust Float 1 field is 2. Elements whose selected Custom Field is blank will not be included in any of
the new injection groups.
For Areas, Zones, Super Areas, and Owners, the creation of injection groups can be limited by
only creating injection groups for which the Selected field is set to YES for these groups. To use
this option, check the Only Selected checkbox.
Participation Factor
The options for specifying participation factor are the same as those used on the Add Participation
Points Dialog.
Delete Existing Injection Groups
When this option is checked, all existing injection groups will be deleted before inserting the new
injection groups.
How to Name the Injection Groups
The new injection groups will be named based on the options set in this section. The Use Prefix
field determines the prefix that will be used on all injection groups. This field can be blank. The
Start at field determines what integer to start at when counting the new injection groups. The new
injection groups will all be numbered in sequential order starting at the value specified. The Group
By property chosen will also be part of the injection group name. The Group By property can be
identified based on Numbers, Names, or Both. The field at the bottom of this section provides an
example of how the injection groups will be named based on the option settings.
Set Name to Use Prefix
If the options chosen on the injection group dialog are set such that exactly ONE injection group will
be created, you can check this option to name that single injection group using the text entered in
the Use Prefix field. If more than one injection group will be automatically inserted from the
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options set in the dialog, this check box option will be ignored, and the injection groups will be
create as usual, with the Use Prefix text used as a prefix for the naming convention options selected.
Do Insert Injection Groups
Click this button to implement the options selected and create the injection groups.
Save to Aux
This saves the option settings specified on the dialog to an auxiliary file.
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Deleting Injection Groups
To delete an injection group, select Aggregations > Injection Groups from the Model Explorer to
open the Injection Group Display. This display is organized into two tab pages with additional tabs and
displays available under each. The Injection Groups tab lists all defined injection groups. Click the right
mouse button on this display on the injection group to delete, and select Delete from the resulting
local menu.
Alternatively, if the Injection Group Dialog is open, the injection group listed in the Name dropdown
box can be deleted by clicking the Delete button.
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Injection Group Display
The Injection Group Records Display presents data describing each injection group in the case. This
display is available by selecting Aggregations > Injection Groups from the Model Explorer. This
display is organized into two tabs with various sections available under each of the tabs. The tabs and
sections provide options for displaying information about injection groups and their associated
participation points in a manner in which it is most useful to the user. Injection groups can be
displayed with their associated participation points or participation points can be displayed with the
injection group to which they belong.
Injection Groups Tab
This tab is organized into a top and bottom section. The top section contains the Injection Groups
Case Information Display that lists all of the defined injection groups. The local menu is available by
right-clicking on the display and contains options available for most case information displays as well
as the option to Show Dialog to view the Injection Group Dialog.
By default, the Injection Groups Case Information Display contains the following fields:
Name
The name of the injection group. To change the name of an injection group, simply type a new
name in the corresponding cell.
Number of Gens
Identifies the number of generators contained in the injection group.
% MW Gen ParFac
Indicates the degree to which generators will contribute to the MW output of the injection group
relative to loads. An injection group that has a % MW Gen ParFac value of 100% receives all of its
output from generator points; an injection group that has a % MW Gen ParFac of 50% and a %
MW Load ParFac of 50% receives equal MW contributions from its constituent loads and
generators.
Number of Loads
Identifies the number of loads contained in the injection group.
% MW Load ParFac
Indicates the degree to which MW loads will contribute to the MW output of the injection group
relative to generators. An injection group that has a % MW Load ParFac value of 100% receives
all of its output from load points; an injection group that has a % MW Load ParFac of 50% and a
% MW Gen ParFac of 50% receives equal MW contributions from its constituent loads and
generators.
% Mvar Load ParFac
Indicates the degree to which Mvar loads will contribute to the Mvar output of the injection group
relative to switched shunts. An injection group that has a % Mvar Load ParFac value of 100%
receives all of its Mvar output from load points; an injection group that has a % Mvar Load ParFac
of 50% and a % Mvar Shunt ParFac of 50% receives equal Mvar contributions from its constituent
loads and switched shunts.
Number of Shunts
Identifies the number of switched shunts contained in the injection group.
% Mvar Shunt ParFac
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Indicates the degree to which switched shunts will contribute to the Mvar output of the injection
group relative to Mvar loads. An injection group that has a % Mvar Shunt ParFac value of 100%
receives all of its Mvar output from switched shunt points; an injection group that has a % Mvar
Shunt ParFac of 50% and a % Mvar Load ParFac of 50% receives equal Mvar contributions from
its constituent loads and switched shunts.
Total MW Injection
Indicates the current total MW injection of all elements in the injection group.
Total Mvar Injection
Indicates the current total Mvar injection of all elements in the injection group.
The bottom section contains additional tabs: Participation Points (All), Generators, Loads,
Switched Shunts, and Injection Groups. These tabs contain tables, which are variations of the
Participation Point Records Display, that list all of the individual participation points for the selected
injection group by element type. Participation points can be added, deleted, or modified for the
selected injection group from any of the tables on these tabs. The Participation Points (All) table
lists only the fields that are relevant for defining participation points while the specific element tables
also make available the fields that are specific to that element type.
The Generators, Loads, Switched Shunts, and Injection Groups tabs have the option to Show
points that are contained by other injection group points. This option is only relevant if an
injection group contains a participation point that is another injection group. When this option is
checked, the individual participation points that are contained in the injection group point will also be
displayed. The Contained by field will list the name of the injection group that contains a particular
participation point. When this option is not checked, the points displayed will be points that are
contained in the selected injection group only and no additional information will be provided about the
points contained inside any injection group points belonging to the selected injection group. If the
Contained by field is empty, this means that the participation point is explicitly defined with the
selected injection group and does not belong to it through an injection group point.
Participation Points Tab
This tab is organized into a top and bottom section. The top section contains tabs for Generators,
Loads, Switched Shunts, and Injection Groups. Tables on these tabs will list power system
elements of each particular type. If the option to Only show elements that belong to at least one
injection group is not checked, then all elements of each type in the case will be listed on one of
these tabs. If this option is checked, then only those elements that belong to an injection group will be
listed. The tables on these tabs are Case Information Displays for each particular type and have the
full functionality of case information displays.
The bottom section is an Injection Groups Case Information Display. When an element from one of the
tables in the top section of the tab is selected, this table will be populated with the list of injection
groups to which the selected element belongs.
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Injection Group Dialog
The Injection Group Dialog provides information about injection groups and allows their modification.
Specifically, the Injection Group Dialog lists the number of generators, loads, and switched shunts
contained in the group and the percentage contribution of generators, loads, and switched shunts to
the injection group’s output. The Injection Group Dialog also houses the Participation Points Records
display, from which points can be added and deleted from the injection group’s list of participants and
the various attributes of the points can be changed.
To view the Injection Group Dialog for a particular injection group, open the Injection Group Display
by selecting Aggregations > Injection Groups from the Model Explorer. Find the injection group of
interest in the Injection Groups Case Information Display and right-click on it. Then select Show
Dialog from the resulting local menu.
The Injection Group Dialog contains the following fields and controls:
Name
Identifies the injection group whose information is currently displayed. Selecting a different name
from this dropdown box will display information for another injection group.
New, Delete
To insert a new injection group from this dialog, press New, and supply the name for the new
injection group. To delete the injection group that is currently being shown, click Delete.
Save
Changes made to injection groups through the Injection Group Dialog are not immediately saved
with the power system case. This allows the option of canceling any changes without impacting the
case. Click the Save button to store any updates with the case.
# Gens
Displays the number of generators contained in the injection group.
# Loads
Displays the number of loads contained in the injection group.
# Shunts
Displays the number of switched shunts contained in the injection group.
% MW Gen Part., % MW Load Part., % MVR Load Part., % MVR Shunt Part.
Displays the relative contributions of generators, loads, and switched shunts to the output of the
injection group.
OK, Cancel
Changes made to the injection groups through the Injection Group Dialog are not immediately saved
with the power system case. This allows the option of canceling any changes without impacting the
case. Click Cancel to close the dialog without saving the changes. Click OK to close the dialog and
save the changes.
Participation Points
The tab on the bottom of the Injection Group Dialog lists the points that make up the injection group.
This display is called the Participation Point Records Display. By right-clicking on this display, points
can be added and deleted from the injection group. Properties of specific points can be changed by
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entering changes directly in the table. The Insert Points button will open the Add Participation Points
Dialog that can also be used for modifying the points.
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Import PTI Subsystems Dialog
Injection groups can be created from PTI subsystem definition files from the Injection Groups Case
Information Display. Click the right mouse button on this display and select Load > Subsystem from
*.sub file from the resulting local menu. From the Import Injection Groups Dialog, select the file
name for the file to import.
If there is no ambiguity in the import file, new injection groups will be created with the defined
subsystem names without further prompts to the user. No ambiguity means that either participation
points are defined for buses that have either load or generation but not both or that no participation
points are defined and that injection group participation points will be defined based on the maximum
generation for each on-line generator in the defined subsystem. If participation points are defined
without ambiguity, each participation point will be assigned to either the load or generation at the bus
split equally across all loads or generators at the bus.
If there is ambiguity in defined participation points, the Insert PTI Subsystems into Injection Groups
Dialog will be displayed. This dialog prompts the user how participation points should be handled for
buses with both load and generation or buses with no load or generation.
Buses with Load and Generation
This option allows the user to select how a defined participation point will be assigned if the
participation point bus has both load and generation.
Assign Participation Point to Generation
The participation point will be assigned to generation at the bus. The participation point will be
split equally across all generators, either on-line or off-line, at the bus.
Assign Participation Point to Load
The participation point will be assigned to load at the bus. The participation point will be split
equally across all loads, either connected or not, at the bus.
Buses with No Load or Generation
This option allows the user to select how a defined participation point will be assigned if the
participation point bus has no load or generation.
Ignore Participation Point
The participation point will be ignored.
Add Equivalent Load (closed load with ID=’99’ and 0 MW and 0 Mvar) and Assign
Participation Point to this Load
This option adds a connected load at the participation point bus with ID=’99’ and 0 MW and 0
Mvar. The participation point is then assigned to this new load.
For each subsystem that is read that is found to have ambiguity in the defined participation points, the
Insert PTI Subsystems into Injection Groups Dialog will be displayed unless the user selects Same
Options for All Subsystems (Do not prompt again).
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Participation Points Overview
A participation point is a member of an injection group. It is a generator, load, switched shunt, or
another injection group that participates in, or contributes to, the output of an injection group. Each
participation point record identifies the generator, load, switched shunt, or injection group that fills this
role, its participation factor, and how that participation factor is calculated. A participation point’s
participation factor identifies the degree to which the point will contribute to its injection group’s
output relative to the other points making up the group. Participation factors may be defined as having
a fixed value, or they may be re-calculated with every use to stay true to how they were originally
defined. For generators, participation factors may be defined as having a fixed value or being equal to
the generator’s MW reserve in the direction of increasing output (MAX GEN INC), MW reserve in the
direction of decreasing output (MAX GEN DEC), or their maximum output (MAX GEN MW).
Each time that an injection group is used, the participation factors for all participation points in the
group are normalized so that the factors of all participating participation points sum to 100%. The
normalized factors dictate how much a generator, load, or switched shunt contributes to the output of
an injection group. The normalization accounts for the re-calculation of the participation factors with
each use of the injection groups and the exclusion of participation points because of options set with
the various tools that use injection groups. Participation points can be excluded for various reasons
including, but not limited to, the exclusion of generator participation points because the generator is
not on AGC control or because the generator is at a minimum or maximum limit.
Participation points are added to or deleted from an injection group using the Injection Group Dialog.
The Injection Group Dialog houses the Participation Point Records Display, which allows the addition or
deletion of points and opening the Participation Points Dialog to obtain more information about the
points.
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Participation Point Records Display
The Participation Point Records Display shows information about the points that comprise a particular
injection group. This display can be accessed for a particular injection group from the Injection Group
Dialog or the Injection Group Display.
The Participation Point Records Display is a class of Case Information Display and therefore can be
used in a manner consistent with all other case information displays. It has a local menu from which
participation points can be deleted or added to the injection group through the Add Participation Points
Dialog. Selecting Insert from the local menu will open the Add Participation Points Dialog that will
allow the addition, deletion, and modification of participation points in the injection group.
The Participation Point Records Display shows the following fields by default:
Point Type
Every participation point is a generator (GEN), load (LOAD), switched shunt (SHUNT), or injection
group (INJECTIONGROUP).
Number
Identifies the number of the bus to which a generator, load, or switched shunt is connected.
Name
Identifies the name of the bus to which a generator, load, or switched shunt is connected.
ID
Identifies the ID of the generator, load, or switched shunt or the name of the injection group.
AutoCalc?
If the value of AutoCalc is YES, the participation factor of the point is re-calculated with every use
to be consistent with the way the point’s participation factor was initially defined. If the value of
AutoCalc is NO, the participation factor is assumed fixed at its present value.
Initial Value
Indicates how the participation factor of the point was originally computed. For generators, the
possible values of this field are
SPECIFIED The participation factor was specified as a constant.
MAX GEN INC The participation factor was defined as the difference between the generator’s
maximum MW output and its present MW output.
MAX GEN DEC The participation factor was defined as the difference between the generator’s
present MW output and its minimum MW output.
MAX GEN MW The participation factor was defined as the maximum MW output of the generator.
For loads, the Initial Value property can assume only two possible values:
SPECIFIED The participation factor was specified as a constant.
LOAD MW The participation factor was defined as the size of the load in MW.
For switched shunts, the Initial Value property can assume four possible values:
SPECIFIED The participation factor was specified as a constant.
MAX SHUNT INC The participation factor was defined as the difference between the maximum
Mvar output of the switched shunt and its present nominal Mvar
output.
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MAX SHUNT DEC The participation factor was defined as the difference between the present
nominal Mvar output and the minimum Mvar output of the switched
shunt.
MAX SHUNT MVAR The participation factor was defined as the maximum Mvar output of the
switched shunt.
For injection groups, the Initial Value property can assume only one possible value:
SPECIFIED The participation factor was specified as a constant.
The Initial Value field is important if saving the injection groups to an auxiliary file and using them
with another case that might have a different generation dispatch or load profile. If the Initial
Value for a point is specified as GEN MAX INC, for example, and the point is loaded from an
auxiliary file into another case, Simulator will re-calculate the point’s participation factor to match the
generator’s positive MW reserve in that case.
The Initial Value field is also important if the AutoCalc field is set to YES, because AutoCalc uses
the rule defined by the Initial Value field to recalculate the participation factor with every use. For
example, if the Initial Value is MAX GEN INC and AutoCalc is YES, the point’s participation factor
will be updated to match the generator’s MW reserve every time the point is accessed.
When the value of the Initial Value field is toggled, the point’s participation factor, shown in the
ParFac field, will update to match the new definition. The Initial Value field must equal SPECIFIED
to be allowed to change the value of the point’s ParFac field by typing the new value directly into
the field.
If AutoCalc is NO and the injection group is not intended to be used with any other case, then the
Initial Value field should either be ignored or set to SPECIFIED.
ParFac
Indicates the participation factor of the participation point. The participation factor defines the
relative contribution of the point to the total output of the injection group. The load, generation, or
switched shunt change associated with each point is calculated based on the value of the
participation factor, with values for points having the largest participation factors experiencing the
greatest change.
The participation factor for injection group participation points indicates the relative contribution of
the entire injection group to the total output of the injection group to which it belongs. The
participation factors of the individual points in the injection group point further define the relative
contribution of these points to the total output of the injection group. The following two injection
groups provide an example of how injection group points impact the injection group to which they
belong when the points are normalized for use:
Injection Group 1

Injection Group 2

Gen 1, ParFac = 50 Gen 5, ParFac = 40
Gen 2, ParFac = 30 Load 1, ParFac = 20
InjectionGroup 2, ParFac = 20 Load 2, ParFac = 20
Total = 100

Total = 80

When Injection Group 1 is used, the participation factors are normalized so that each element
provides the following contribution:
Gen 1, Normalized ParFac = 50/100 = 0.5
Gen 2, Normalized ParFac = 30/100 = 0.3
Gen 5, Normalized ParFac = 20/100 * 40/80 = 0.1
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Load 1, Normalized ParFac = 20/100 * 20/80 = 0.05
Load 2, Normalized ParFac = 20/100 * 20/80 = 0.05
Total Normalized = 1.0
To add points to the injection group, right-click on the Participation Point Records Display and select
Insert from the local menu. This opens the Add Participation Points Dialog.
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Add Participation Points Dialog
The Add Participation Points Dialog enables the addition of participation points to an injection group as
well as the modification of existing participation points. This dialog is accessed from a Participation
Point Records Display by right-clicking in the participation points list and selecting Insert from the
resulting local menu. Participation Point Records Displays are available from the Injection Group Dialog
or Injection Group Display.

The Add Participation Points Dialog features four tabs, one for adding generator points, one for adding
load points, another for switched shunts, and a fourth for adding points from injection groups that
have already been defined.
The four tabs are almost identical and contain the following controls:
Filtering
If the Use Area/Zone Filters box is checked, the list box beneath it, which lists generators, loads,
switched shunts or previously defined injection groups depending on the tab, will list only those
elements contained in areas or zones or by owners whose area/zone/owner filter setting is YES. If
this box is not checked, all generators, loads, and switched shunts in the case will be listed. Injection
groups will not be filtered using the area/zone/owner filter.
Alternatively, a custom filter can also be defined by clicking on the Define Filter button. This will
open the Advanced Filter dialog, which allows the customization of a filter for determining the
devices to list in the display.
Once the list of devices has been set, with or without filtering, the list can be searched using the
advanced search techniques in Simulator. These techniques allow the list to be sorted by name or by
number and allow the use of wildcard characters. Simply choose Name or Number, and type the
name or number of interest in the box. Simulator will look for and highlight the first matching device
in the list. If the first device is not the one of interest, use Search Next to find the next device that
matches the search criteria. For a comprehensive list of all objects matching the search criteria,
press Search All.
Element List
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The box that occupies the left side of each tab lists the generators, loads, switched shunts, or
injection groups (depending on which tab is active) that can be added to the injection group.
Injection groups will only show up in the element list if they do not cause a circular reference by
being added to the current injection group. This means that any injection group that would cause
the current injection group to link back to itself will be omitted from the list. Multiple elements can
be selected from each of these lists. To select several elements in a row, drag the mouse to
highlight the elements to be added. Alternatively, click the first element to add, press and hold the
shift key, and click the last element to add. To select elements that are not adjacent in the list, click
the first element you to add and hold down the CTRL key while clicking the other elements to add.
Once an element is selected in the Element List, it is ready to be added to the injection group.
Participation Factors
There are several options for defining the participation factors of the selected points.
For generators, a value can be specified, the generator’s present participation factor (which comes
from the case and is displayed in the Generator Display) can be used, the participation factor can be
calculated as the difference between its present output and either the unit maximum or minimum,
its maximum output capability can be used, or the value contained in a selected Custom Field can be
used.
For loads, a value can be specified, the participation factor can be based on the load’s size, or the
value contained in a selected Custom Field can be used.
For switched shunts, a value can be specified, the value contained in a selected Custom Field can be
used, or the factor can be based on positive reserve, negative reserve, or MVAR capability.
For injection groups, a value can be specified to use for every point in the injection group, the
values already defined for the injection group can be used, or the value contained in a selected
Custom Field can be used. These three options are available if the option to Include Individual
Group Points is checked. When this option is checked, copies of the participation points from the
selected injection groups are made and added to the current injection group with the participation
factors based on the selected option. When Include Individual Group Points is not checked,
entire injection groups are included, indicated by the Point Type of INJECTIONGROUP in the
Participation Point Records Display, in the current injection group and the only option for adding the
points is to specify the value for the participation factor. When including an injection group in
another injection group as the entire group, the normalization and use of the participation factors
follows the discussion of ParFac found in the Participation Point Records Display. Including an
injection group in another injection group as the entire group is useful when the injection of the
entire group needs to be changed relative to other individual elements or other injection groups.
Recalculate Factors Dynamically
If this box is checked, the participation factors of the points being added will be automatically
updated every time the points are used. Such points will then have an AutoCalc value of YES. If
this box is not checked, the participation factors of the points being added will be fixed at the values
defined at the time they were created.
To add the points that have been selected, click the Add -> button. The new points will be added to
the list box on the right.
To update existing points, follow the same process for adding points and simply set the participation
factors with the new values. When the Add-> button is clicked, the existing points will be updated
with the new values.
The list box that occupies the right side of each tab lists the points that already comprise the injection
group. To delete specific points from the injection group, select them from this list box and click the
<-Remove button.
To close this dialog, click OK.
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Transaction Dialog
The Transaction Dialog can be used to modify or create Base Interchange Transactions between two
areas. This dialog can be opened by right-clicking in the Base Interchange table of the Area
Information Dialog and choosing Show Dialog to see an existing transaction definition, or Insert to add
a new transaction.
The transaction dialog is divided into two pages of controls:
Information
Transacting Area
This is the "from" area for the transaction. For an export from this area, the transaction value will be
positive. For an import into the Exporting Area, the transaction value specified would be negative.
Flow out (export) of the exporting area is always considered positive.
Transaction To Area
This is the "to" area for the transaction.
Transaction ID
New in Simulator version 10 is the ability to have multiple transactions defined between the same
two areas. Because of this, it is now required that transactions also have a Transaction ID.
Rename Transaction ID
If you wish to change the transaction ID for a particular transaction, enter the new value in the
Transaction ID field, and press this button.
Switch Directions
Press this button if you wish to reverse the defined Exporter and Importer for the transaction.
Transaction MW Amount
The MW amount of the transaction being defined. This value should be positive for an export from
the Exporting area to the Importing area. The value can also be entered as negative to define a
transaction into the Exporting area from the Importing area.
Transaction Minimum MW
The minimum transaction amount between the two areas. This field is only enabled if the check box
labeled Transaction Dispatchable in OPF is checked.
Transaction Maximum MW
The maximum transaction amount between the two areas. This field is only enabled if the check box
labeled Transaction Dispatchable in OPF is checked.
Exports/Imports Transmission Charge
The cost to transfer power, in $/MWh. This adds an economic penalty for making the transfer,
making the transfer less likely to take place. Half the charge is assigned to the buyer and half to the
seller.
Transaction Enabled
Transaction can now be defined and either enabled or disabled. Any disabled transactions will be
ignored in both a standard power flow solution and an OPF solution.
Transaction Dispatchable in OPF
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Checking this box enables the transfer to be dispatched by the OPF algorithm. Dispatching the
transaction makes the two areas of the transaction appear to be one area for the purpose of
economically dispatching the generation in the two areas. The transaction can have a maximum and
minimum transfer amount when dispatchable, and a transmission charge associated with the
transaction.
Determine Price in OPF
Checking this box allows the OPF algorithm to determine the cost associated with the transfer. The
cost is determined by the marginal cost of enforcing the power balance constraint for the combined
areas. This is the typical way to implement a transfer if both areas are on OPF control. If only one of
the two areas are on OPF control, then the area which is off of OPF control needs to specify a price
for the transfer. This is done by explicitly defining a piecewise linear cost curve.
Piecewise Linear Transaction Cost Curve
These two curves are only enabled if the option Transaction is Dispatchable in OPF is checked
and the option Determine Price in OPF is unchecked. These two curves can be defined for the
purpose of assigning a price to the transfer of power between one area on OPF control and another
area which is not on OPF control. Separate curves can be defined for export transactions (from the
Exporter to the Importer) and import transactions. To add points to the curves, simply right-click in
the grid and choose Insert from the local menu. Enter the MW value and corresponding marginal
cost for the inserted breakpoint of the piecewise linear curve you are defining. To delete a point,
right-click on that row in the grid and choose Delete from the local menu.
Custom
The Custom page of the Transaction dialog is simply a location to log information about the
transaction in the Memo box, and to see the values (if any) stored in some of the custom fields for the
transaction. To log information about the transaction, simply switch to the Custom page on the dialog,
and start typing your information or comments about the transaction in the page, or enter custom
values in one of the custom fields.
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Bus View Display
The Bus View Display feature provides a graphical display which allows you to quickly browse
information about a bus and everything connect to that bus. The bus view displays enable convenient
bus-by-bus navigation through the power system. From the bus view, you can find out a bus’ voltage
and angle, the load, shunt compensation, and generation connected to the bus, and the flows on all
lines emanating from the bus. You can also discover the bus’ area and zone affiliations, as well as the
bus’ marginal cost. Moreover you can find out all information about the elements associated with the
bus by directly invoking their associated information dialogs. The advantage of the bus view displays,
is that they are auto-created oneline diagrams.
Along the top of the bus view display resides a panel of controls. The buttons labeled Back and
Ahead allow you to step through the history of buses you have viewed thus far. To move the bus
view to a particular bus, type a number or name into the edit box next to the caption Bus. If a
number is typed the case will be scanned for a bus of that number, otherwise the case will be scanned
for a bus that starts with the string entered. If you’re unsure which bus that you are looking for click
the Find… button to bring up a display that allows you to search using wildcard strings for the bus.
The History menu will show a list of the last 30 buses which have been visited in a bus view. There
are also drop-downs in this top panel for Options and Views . These are discussed below.
Below this top panel sits the actual bus display. The bus you have chosen to inspect, which we shall
refer to as the target bus, is represented by a long, thick horizontal line. Notice that the bus’ voltage in
kV and per unit, its angle, and its marginal cost are specified to the left of the bus. Any loads and
generating loads connected to the target bus are drawn above the bus symbol, along with their
associated annotation. Also any radial connections to a single bus containing load, generator or
switched shunts will be drawn above the bus symbol.
Emanating from the bottom of the bus symbol are all transmission lines and transformers that connect
the target bus to its neighbors. The transmission line and transformer symbols are equipped with pie
charts and annotation identifying flows as measured at the target bus, as well as arrows to identify the
direction of MW flow on the branch. Neighboring buses are represented as filled rectangular regions,
with symbol indicators included if other types of devices, such as loads, generators, etc., are attached.
When you drag the mouse over one of the neighboring bus symbols, it turns into a pointing finger.
Clicking the left mouse button when the mouse cursor is in this shape redefines the target bus to be
the bus whose symbol you just clicked. The bus view display is redrawn to show the same sort of
display for the newly chosen target. You can go back to the previously displayed target bus by clicking
the Back arrow, and then return to this record by clicking the Ahead arrow.
It is useful to think of the bus view displays as nothing more than an additional oneline diagram. In
other words, you interact with the objects drawn on the bus view display in the same way you work
with objects on a more conventional Simulator oneline. Right-clicking on any power system object will
bring up that object’s local menu, which includes a link to the object’s associated information dialog.
As on a conventional oneline diagram, flows on a bus view display can be animated. Right-clicking on
the bus view display’s background will generate the same local menu as other oneline diagrams.
The bus view display can be generated using any of the following methods:




Go to the Case Information ribbon tab, and click on the Bus View from the Views ribbon group
Go to the Onelines ribbon tab, and click on the Bus View from the Views ribbon group.
Right click on the bus of interest on the oneline diagram to display the bus’ local menu, and
choose Bus View. The bus view display will open with the selected bus already displayed.
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From any of the case information displays that convey bus information, right click on a record to
bring up its local menu, and choose Bus View Oneline. The bus view display will open with the
corresponding bus already displayed.
Click the Bus View Button on the Case Information Toolbar.

To switch between the bus view and the main oneline, use the Open Windows Menu available on
the Views ribbon group on the Case Information ribbon tab, Case Information ribbon tab,or Windows
ribbon tab. To close the bus view display, simply close the form using the X button in the top right
corner of the bus view display.
Note that when viewing a consolidated superbus while using consolidation via the topology processing
tool, Simulator will always show circuit breaker symbols on branches, loads, generators, and switched
shunts which are open (out of service.)
Bus View Options
Layout Options
Show Serial Buses
When putting in the branch connections, the Bus View display will look out into the network and
find the next bus which has more than two neighbors. It will then make this the destination bus
for that branch of the Bus View. The intermediate buses will then be shown in order above the
destination branch. This option works especially well in systems with a lot of multi-section lines.
Show Equivalent Lines
This option indicates to the Bus View display whether or not to include branches representing
equivalent circuits as connections in the display.
Represent Multi-Section Line Objects
This option indicates to the Bus View display whether or not to draw multi-section line display
objects when appropriate. If this option is not checked, then the intermediate buses of the multisection lines will be rendered normally. If this option is checked then the intermediate buses of
multi-section lines will not be rendered on the bus view and only the terminals of the multisection line will appear.
Show Field Suffixes
This option specifies whether to display the field values units as suffixes. If this option is not
selected, all the fields will be display as a value without units.
Include Field Labels
Selecting this option will place labels for each displayed field on the bus view diagram.
Default Drawing Values
Choosing this option will open the Default Drawing Values for New Objects dialog. Changing
these options can change some of the drawing aspects of the bus view, including device color
and font size or color.
Dynamic Formatting
Click on this to bring up the Dynamic Formatting for case information displays, and all views and
onelines.
Number of Tiers
The bus view can display one or two "tiers" of buses in the display. Use this selection from the
Options menu to toggle the number of tiers displayed.
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Open Multiple Bus Views
This option indicates whether to open multiple bus views simultaneously. Choices are never, always,
and prompt for confirmation when a new additional bus view is about to open.
Show Hints
When this option is checked, holding the cursor over an object will briefly pop up a hint box
containing information about that object.
Views
Define Custom View
The fields displayed on the bus view can be customized using this option. Clicking on this option will
open a customization settings display, in which you can add and remove field definitions for the
objects on the bus view display. Customized bus view layouts can be saved with the case for recall,
identifiable by a custom bus view layout name. Custom layouts can also be saved to a file for
loading into another load flow case.
Input Data
Switching the bus view to Input Data changes the bus view from displaying system state information
to displaying input data information. For example, switching to Input Data view will display line
impedances and limits, generator minimum and maximum outputs, etc. The default Input Data view
fields can be modified using the Define Custom View customization dialog.
System State
Switching the bus view to System State changes the bus view from displaying Input Data
information to displaying system state information. This will result in line flows being displayed,
voltage and angles displayed, etc., of the current solution state of the system. The default System
State view fields can be modified using the Define Custom View customization dialog.
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Substation View Display
The Substation View Display feature is analogous to the Bus View Display.
Along the top of the substation view display resides a panel of controls. The buttons labeled Back and
Ahead allow you to step through the history of substations you have viewed thus far. Substation View
options are available from the Options menu. To find a substation using search tools, click on the
Search For button. The next two controls following the Substation label allow to specify a substation
name (in the first text box) or a number (in the second text box). If you type a number or name that
does not exist, the substation display will continue displaying the current substation.
Below this top panel sits the actual substation view display.
Just as with the bus view, it is useful to think of the substation view displays as nothing more than a
oneline diagram. In other words, you interact with the objects drawn on the substation view display in
the same way you work with objects on a more conventional Simulator oneline. Right-clicking on any
power system object will bring up that objects local menu, which includes a link to the object’s
associated information dialog. As on a conventional oneline diagram, flows on a substation view
display can be animated. Right-clicking on the substation view display’s background will generate the
same local menu as other oneline diagrams. The substation view can be generated using any of the
following methods:







Go to the Case Information ribbon tab, and click on the Substation View from the Views Ribbon
Group
Go to the Onelines ribbon tab,and click on the Substation View from the Views ribbon group.
Right click on the substation of interest on the oneline diagram to display the substation’s local
menu, and choose Substation View. The substation view display will open with the selected
substation already displayed.
From any of the case information displays that convey substation information, right click on a
record to bring up its local menu, and choose Substation View Oneline from the Substation
Records menu. The substation view display will open with the corresponding substation already
displayed.
Click the Substation View Button under the Records menu on the Case Information Toolbar.

To switch between the substation view and the main oneline, use the Window menu tree on the main
menu. To close the substation view display, simply close the form using the X button in the top right
corner of the substation view display.
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Labels
Using Labels for Identification
Most data objects (such as buses, generators, loads, switched shunts, transmission lines, areas,
zones, and interfaces) may have an alternative names assigned to them. These alternative names
are called labels. Labels allow you to refer to equipment in the model in a way that may be unique
to your organization. Labels may thus help clarify which elements are described by a particular set of
data, especially when the short names employed by the power system model prove cryptic.
Furthermore, since labels are likely to change less frequently than bus numbers, and since a label
must, by definition, identify only one power system component, they may function as an immutable
key for importing data from auxiliary files into different cases, even when bus numbering schemes
change between the cases. Labels must be unique for devices of the same type, but the same label
can be used for a device of a different type.
Information dialogs corresponding to buses, generators, loads, switched shunts, transmission lines,
areas, zones, and interfaces feature a button called Labels. If you press this button, the device’s
Label Manager Dialog will appear. The Label Manager Dialog lists the labels associated with the
device and allows adding, deleting, and modifying labels. The Labels (All) field (variablename =
LabelsAll) in a Case Information Display lists all of the labels that have been associated with a
device. The device's primary label is the one that is listed first in this field. This field lists all labels
assigned to a device as a comma-delimited string. Even though multiple labels may be assigned to a
device, any label can be used to import data from auxiliary data files. The Label Manager Dialog can
be used to assign labels or the string of labels can be entered directly in the Labels (All) field.
Labels can be used to map data from an auxiliary data file to a power system device. Recall that
auxiliary data files require you to include a device’s key fields in each data record so that data may
be mapped to the device. Labels provide an alternative key. Instead of supplying the bus number to
identify a bus, for example, you can supply one of the bus’s labels. The label will enable Simulator to
associate the data with the device associated with that label. This mechanism performs most
efficiently when the primary label is used, but other labels will also provide the mapping mechanism.
The Label (for use in input from AUX or Paste) field (variablename = Label) is used for
importing data using labels and is blank when viewing in a case information display. Keep in mind
that all devices read via an auxiliary file using the label field should have a non-blank label.
Otherwise, information for that device will not be read. Even if the primary or secondary key fields
are provided with the device, as long as the label field is present, that is the only field that will be
used to identify the device. New devices cannot be created by simply identifying them by label.
Either the primary or secondary key fields must be present to create a new device and the label field
should not be present.
Again, it is important to remember this: a single power system device may have multiple labels, but
each label may be associated with only one device of a particular type. This is the key to enabling
data to be imported from an auxiliary file using labels.
Saving Auxiliary Files Using Labels
All devices that can be identified by labels will have the Labels (All) and Label (for use in input
from AUX or Paste) fields available in their case information displays. In order to save auxiliary
files that identify devices by label, the two label fields should be added to the case information
display prior to saving the data in an auxiliary file. Because the Label (for use in input from AUX
or Paste) field will be blank when saved in the auxiliary file, this field must be populated with one
of the labels in the Labels (All) field before loading the auxiliary file back in. Keep in mind that
devices with blank labels cannot be identified when loading in an auxiliary file, so avoid saving
auxiliary files by label if all devices do not have labels.
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Many devices require SUBDATA sections. These sections have custom formats specific to the type of
information that they contain. When saving auxiliary files with devices that require SUBDATA
sections, the user can choose to use primary or secondary key fields or labels to identify devices in
the SUBDATA sections. The user will either be prompted when saving the devices, or there is an
option to change the key field to use when saving subdata sections on the PowerWorld Simulator
Options dialog under the Case Information Displays category. When choosing to use labels, if a
device has a label, it will be used. If it is a device that can be identified by buses and bus labels
exist, bus labels will be used. Finally, if the device does not have a label and the buses do not have
labels, the primary key for the device will be used for identification.
Devices that have SUBDATA sections that contain other devices that can be identified by labels
include: contingencies, interfaces, injection groups, post power flow solution actions, and owners.
The setting to choose which identifier to use for the SUBDATA sections does not just apply to
SUBDATA sections. Often when saving groups of options, this setting will apply to everything being
saved with those options and not just the SUBDATA sections. This includes contingency options,
ATC options, limit monitoring settings, and PVQV options. In these cases, there will be a prompt
asking the user to decide which identifier to use in the auxiliary file.
Loading Auxiliary Files SUBDATA Sections Using Labels
The various SUBDATA sections that represent references to other objects can also be read using
labels. Examples include contingencies, interfaces, injection groups, post power flow solution
actions, and owners. When reading a SUBDATA section such as this, PowerWorld makes no
assumption ahead of time about what identification was used to write this SUBDATA section.
Instead, an order of precedence for the identification is as follows
Identification

Explanation

Example

1

Key Fields

assumes that the strings
represent Key Fields

BRANCH 8 9 1

2

Secondary Key Fields

assumes that the strings
represent Secondary Key
Fields

BRANCH Eight_138
Nine_230 1

3

Labels for component
objects

the key/secondary key
fields for some objects
consist of references to
other objects. An example
of this is the BRANCH
object that is described by
the From Bus, To Bus, and
Circuit ID. This assumes
that labels of the
component objects are
used.

BRANCH Label8 Label9 1

4

Labels

Assumes that the string
represents one of the
Labels of the object

BRANCH LabelForBranch

Special Use of Labels
There are a few special cases where objects have fields that identify other devices. These devices
can be identified by label but not in the conventional means because the label field applies to the
object that contains the device and a SUBDATA section is not necessary. These special cases
include: (Note all fields given below are by variable name because the use of labels is most relevant
with auxiliary files.)
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ATC Scenarios
ATC Scenario change records usually contain primary key fields to identify the devices that
should be adjusted during the scenario. If using labels, these primary key fields will be replaced
with a single Label field. The use of this field is different because the Label field refers to the
device in the change record and not to the change record itself. When labels are used with
ATC scenarios, device labels only can be used. Bus labels cannot be used to identify devices for
which no label exists but a bus label does.
ATC Scenarios are saved in an auxiliary file if choosing to Save Settings on the ATC Dialog.
ATC Extra Monitors
ATC Extra Monitors identify either branches or interfaces to monitor during the ATC analysis.
These devices are identified in the WhoAmI field of ATC Extra Monitor records. Usually, the
WhoAmI field is a special format that contains key field tags. Optionally, this field can use the
label of the device for the extra monitor. If the device label is not available, the standard format
will be used. There is no option to use bus labels if they exist and the device labels do not.
ATC Extra Monitors area saved in an auxiliary file if choosing to Save Settings on the ATC Dialog.
Model Conditions
Devices in Model Conditions are usually identified by the WhoAmI field which is in a special
format that contains key field tags. Optionally, this field can use the label of the device. If the
device label does not exist, the standard format will be used. There is no option to use bus labels
if they exist and the device labels do not.
Model Expressions
Model Expressions contain Model Fields. Model Fields are identified by the WhoAmI fields in the
Model Expressions. Usually, the WhoAmI fields are in a special format that contains key field
tags. Optionally, these fields can use the label of the device associated with the Model Field. If
the device does not exist, the standard format will be used. There is no option to use bus labels
if they exist and the device labels do not.
Bus Load Throw Over Records
Bus Load Throw Over Records are used with contingency analysis. These records have an option
to identify the bus to which the load will be transferred by either number or name_kV
combination. If choosing to identify objects by label, the BusName_NomVolt:1 field will
contain the label of the bus instead of the name_kV combination.
Bus Load Throw Over Records will be saved in an auxiliary file if choosing to Save settings on the
Contingency Analysis dialog.
Injection Group Participation Points
All participation points and the injection groups to which they belong can be listed on the
Injection Group Display. Load, generator, and shunt devices that can be assigned to a
participation point must be identified by bus and ID. The bus can be identified by either the
number or name. When identifying by name, the BusName_NomVolt field is used to provide
the name_kV combination for the bus. If choosing to identify devices by label, this field instead
will contain the label of the device. If the device does not have a label but the bus does, the bus
label will be used instead in conjunction with the ID of the device. Even if the device does
contain a label, the ID field must be included in any auxiliary file that is going to be loaded
because it is a key field. Injection groups can be included in other injection groups. Injection
groups can be identified by label, even though this is not a normal thing to do. If any injection
groups have labels and these injection groups are included in other injection groups, their labels
will also appear in the BusName_NomVolt field. If they do not have labels, they will be identified
by the injection group name that appears in the PPntID field.
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Label Manager Dialog
The Label Manager Dialog allows the creation and modification of labels to identify power system
devices. Labels can be used for most data objects (such as buses, generators, loads, switched shunts,
transmission lines, areas, zones, and interfaces) as alternate names for these devices. See the Labels
topic for more information on how labels can be used.
The Label Manager Dialog can be accessed by clicking the Labels button on any of the information
displays for objects that allow labels.

List of Labels
Multiple labels can be assigned to a single object. The list on the left of the dialog shows all of the
labels that have been assigned with the primary label listed first and highlighted in yellow.
Add New
Click this button to add a new label after entering the new label in the box to the right of the button.
If this new label should be the primary label, check the Primary box. Labels must be unique for
each type of object. That means that there cannot be two buses labeled One. However, there could
be objects of different types with the same label. There could be a bus and a generator both labeled
One. If attempting to label an object with a label that has already been used by the same object
type, the label will be assigned to the current object and removed from the object to which it was
previously assigned.
Delete
Click this button to delete a label after first selecting the label in the list of labels.
Make Primary
Click this button to make a label the primary label after first selecting the label in the list of labels.
The primary label will be moved to the top of the list. The primary label will always appear at the top
of the list and will be used for sorting when sorting by label.
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Difference Flows
The Difference Flows feature provides an easy mechanism for comparing two power system cases.
For example, Difference Flows can be used to show the difference in transmission line flows and bus
voltages resulting from a contingency or a change in power transfer between two areas. Difference
Flow is available in both Run Mode and Edit Mode, however when you switch from Run Mode back to
Edit Mode, Simulator automatically resets you to the Present Case. This is done so that you do not
accidentally try to edit data while in Difference or Base Case mode. Once you are in Edit Mode
however, you can still manually switch back to Difference or Base Case Mode.
For more information about how to use Difference Flows see Using Difference Flows.
The Difference Flows Dialog can be accessed by:




Go to the Tools ribbon tab, and choose Difference Flows > Difference Flows from the Other
Tools Ribbon Group. .
Selecting Difference Flows from the oneline local menu.
All Difference Flows Actions are controlled via the Difference Flows Dialosg or the drop-down list
on the Difference Flows toolbar button.

Case Type to Display
Use of this feature affects all aspects of the Simulator environment. When using the Difference
Flows tool, information shown on oneline diagrams, case information displays, and power flow lists is
governed by which of the three Difference Flow Case Types (base, present or difference) is currently
being displayed.
Key Field to Use
The difference flows feature must make a comparison between the Present Case and the Base Case
to determine which objects between these two case match one another. The Key Fields to Use
specifies whether this matching is done using Primary Keys (bus numbers), Secondary Keys (bus
names/Nom kV pair), or by Label.
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Difference Flows: Case Types
When using the Difference Flows tool, information shown on oneline diagrams, case information
displays, and power flow lists is governed by which of the three case types is currently being
displayed. Difference Flow is available in both Run Mode and Edit Mode, however when you switch
from Run Mode back to Edit Mode, Simulator automatically resets you to the Present Case. This is
done so that you do not accidentally try to edit data while in Difference or Base Case mode. Once you
are in Edit Mode however, you can still manually switch back to Difference or Base Case Mode.
The case types available are:




Base Case – A solved power system that serves as the reference for the difference flows tool. To
establish a base case, set up a solved power system corresponding to the desired operating point.
Open the Difference Flows Dialog and click the button labeled Set Present as Base Case.
Present Case – The operating point used in the Difference Flows comparison. Note: The Present
Case must have the same numbering scheme as the Base Case for proper operation of the
Difference Flows tool. See Topological Differences for more information.
Difference Case – The difference between the Present Case and the Base Case values. The
values displayed in the Difference Case are established using the Base Case as the reference.
When showing status fields for branches, generators, etc... fields will show up as either
OPEN/CLOSED or CLOSED/OPEN if the status changed. The status in the present case will be listed
first. A similar format will be used for fields such as generator AGC Status and other text fields.

To toggle between the different case views, open the Difference Flows Dialog and select the desired
case type. Alternatively, you can click the Difference Flows button in the Other Tools Ribbon Group
on the Tools ribbon tab and select the desired case type.
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Using Difference Flows
To use the Difference Flows tool:








Set up a solved power system corresponding to a desired operating point. This operating point will
be defined as the Base Case.
Select Difference Flows from the Run Mode ribbon group on the Tools ribbon tab, or select
Difference Flows from the oneline local menu in Run Mode.
On the Difference Flows Dialog, click the button labeled Set Present as Base Case. This
stores the current operating point as the Base Case.

Define the operating point (Present Case) for which to perform the difference flows comparison.
The Present Case may be developed either by modifying the Base Case as desired and re-solving,
or by opening a new case selecting Open Case from the Application Button. In the latter
situation, the new case that you open must have the same bus numbering scheme as the Base
Case.
See Difference Flow Case Types for information on toggling between case views. The currently
displayed case type is shown in the PowerWorld Simulator Status Bar. When viewing either the
Base Case or Difference Case, the corresponding status bar display will be highlighted.

Note that the Difference Flows tool can only be used in Run Mode and the status bar will not display a
case type while in Edit Mode.
When showing the Difference Case, most of the fields shown on the onelines and case information
displays show the difference between the present value and its Base Case value. For example, on the
Generator Records Display, an entry of 0.0 in the MW field indicates that the real power output of the
generator did not change. An entry of 10.0 in the MW field indicates that the present real power
output of the generator is 10 MW greater than it was in the Base Case.
At any time during a simulation, you can set the present case as the Base Case by clicking the
corresponding button on the Difference Flows Dialog.
Conversely, if you have made changes to the present case, and you wish to revert to some or all of
the base case values, you can click on the Reset Case… button. When you click this button, the
dialog will expand to show you options for resetting specific types of values to their base case values.
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Expanded Difference Flows Dialog
Once you have indicated which types of values you want to reset (by default, all are selected), you can
click on the Reset Present Case to Base Case Values button to complete the process of reverting
to base case values. Note: once you have finished resetting to the base case values, you can hide the
Reset options by clicking the Hide Reset Button in the upper right hand corner of the Reset options
panel.
The oneline diagrams and case information displays cannot indicate structural differences in the case
very well, such as the addition or removal of a device. To identify such differences, make use of the
Present Topological Differences from Base Case tool to identify topology differences.
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Present Topological Differences from Base Case
The Present Topological Differences from Base Case option provides the users a way to compare the
topological differences between two difference cases in Simulator.
To compare two cases topologically, you must load the first case you wish to use as the reference into
Simulator. Use the Difference Flows tool to set the case as the base case in memory. Once the
reference case has been stored as the base case, open the second or comparison case into Simulator.
Now if you check the Tools ribbon tab, and choose the Difference Flows Menu on the Other Tools
Ribbon Group, you will see the option Present Topological Differences from Base Case. Choosing
this option will open the dialog to display the topological differences.

Topological Differences Dialog
The Topological Differences Dialog contains five tabs. All but the Summary tab are
instances of Case Information Displays and thus exhibit characteristics and controls
similar to other displays.
Summary
A listing of the types of objects in the case. The first column displays the number of NEW devices in
the comparison case that were not in the base case. Alternately, the Removed column displays the
number of devices in the base case that do NOT exist in the comparison case. The third column
simply displays the number of items that were matched between the two cases.
Elements Added
Tabular listings of all objects that exist in the comparison case, but not in the reference case.
Elements Removed
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Tabular listings of all objects that exist in the reference case, but are not present in the comparison
case. A right-click option from the pop-up menu on the Elements Removed tables allows for saving
the removed elements selected to a GE EPC file format.
Elements in Both
Tabular listings of all objects present in both cases.
Create Bus Swap List
Used for setting up a bus renumbering list. It is possible that discrepancies in topology between the
comparison case and the reference case can be due to a difference in bus numbering between the
two cases. Renumbering the buses in the comparison case may take care of most of the topology
discrepancies that are reported in this instance.
Data Objects and Fields
The Save and Send Options on the topological difference dialog makes it possible to save Elements
Added, Elements Removed, and Elements In Both to file. In addition to these options, special objects
and an object field are available to make accessing these objects easier using script actions and will
allow the user to customize the fields stored in the file. When the removed elements are saved in the
GE EPC file format the elements are saved with a status value of -4.
To provide easier access to the objects that have been identified as being removed when viewing the
topological differences, special object types have been created that allow these objects to be accessed
via script commands. These objects provide access to the Elements Removed. All of the object names
start with Removed with the rest of the name just being the usual object name. To identify buses use
the object name RemovedBus. To get generators use RemovedGen, etc. These objects can be
accessed through the SaveData script command and GetParametersMultipleElement through SimAuto.
These object types can only be stored to an auxiliary file. They cannot be read back in, but, the file
headers and object types can be modified to make use of the data or the data can simply be used as
documentation of case differences.
A field is available for all object types that can be used with the difference flows tool. This field is
found under Difference Flow\In Diff. Flows Base Case? and indicated whether or not an object
was in the difference flows base case. This field is useful for filtering only the new elements that are
only in the present case, field value = NO, or all of the elements in both the present and base case,
field value = YES. This will make it possible to use script actions or filters to return only the Elements
Added or Elements In Both.
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Auxiliary Files
PowerWorld has incorporated the ability to import data from data sources other than power flow
models into PowerWorld Simulator. Simulator has always had the ability to import supplemental data
into a power flow model, but this facility was limited to ten or twelve native data formats targeted to
specific applications for which the data had to have a precise format. The extensions described in this
help document provide a more versatile interface to data from non-power-flow sources.
In addition to developing auxiliary data formats, a script language was also developed. The script
language and auxiliary data formats are incorporated together. This format is described in this help
document.
Script/Data files are called data auxiliary files in Simulator and typically have the file extension .AUX.
These files mostly contain information about power system elements and options for running the
various tools within Simulator. They do not contain any information about individual display objects
contained on a one-line diagram. There are separate files called display auxiliary files that are available
for importing/exporting display data from/to Simulator in a text format. These files are distinguished
from the data auxiliary files by using the extension .AXD. The format for these two types of files is
similar, but different object types are supported by each and require that the files be read separately.
Currently, there are no script commands that are available for display auxiliary files.
Both file types will be generically referred to as auxiliary files. An auxiliary file may be comprised of
one or more DATA or SCRIPT sections. A DATA section provides specific data for a specific type of
object. A SCRIPT section provides a list of script actions for Simulator to perform.
These sections have the following format:
SCRIPT ScriptName1
{
script_statement_1
.
script_statement_n
}
DATA DataName1(object_type, [list_of_fields], file_type_specifier,create_if_not_found)
{
data_list_1
.
data_list_n
}
DATA DataName2(object_type, [list_of_fields], file_type_specifier,create_if_not_found)
{
data_list_1
.
data_list_n
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}
SCRIPT ScriptName2
{
script_statement_1
.
script_statement_n
}
Note that the keywords SCRIPT or DATA must occur at the start of a text file line. Auxiliary files may
contain more than one DATA or SCRIPT section. These sections always begin with the keyword DATA
or SCRIPT. DATA sections are followed by an argument list enclosed in ( ). The actual data or script
commands are then contained within curly braces { }.
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Script Command Execution Dialog
The Script Command Execution dialog provides a location for the user to enter script commands
manually, or to load auxiliary files containing Script and/or Data sections previously defined. This
dialog is opened by pressing the Script button in the Log ribbon group on the Tools ribbon tab.
Loading Auxiliary Files
The first feature of the Script Command Execution dialog is that it provides a location to load
previously defined auxiliary files for the currently loaded case. The Auxiliary File menu provides a
location for loading an auxiliary file, or simply validating that the Script and/or Data sections of an
Auxiliary file are correctly formatted in the file.
The Quick Aux option allows you to open the Quick Auxiliary Files dialog for creating a list of
auxiliary files to be opened and processed en masse.
Lastly, you can export the Simulator recognized objects and object fields using the Export Field
Names option. You can export the field names to a text for or to Excel.
Running Script Commands
The second feature of the Script Command Execution dialog is that you can run script commands
manually. To run a script command, type the command into the display, and press the Execute
button. Note that if the Execute on ENTER key option is checked, the command will also be
processed when ENTER is pressed. Note that similar to script command syntax in the Script section
of auxiliary files, script commands must be ended with a semi-colon (;) in the Script Command
Execution dialog as well.
You can enter multiple script commands to be processed in sequence in this display. To do so, you
must uncheck the option Execute on ENTER key. Then you can press enter after each script
command to move to the next line and enter another command. Use the Execute button to process
the sequence of script commands.
If you are running a sequence of script commands and wish to abort the run, use the Abort button.
If you wish to view the message log while script commands are processing, open the log using the
Show Log button.
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Quick Auxiliary Files Dialog
The Quick Auxiliary Files dialog can be accessed from the Quick Aux Files menu option of the Script
Command Execution dialog. This dialog gives you a location for creating a list of auxiliary files to be
processed en masse for the currently loaded case.
Using the Define option of the Quick Aux Files menu, the Quick Auxiliary Files dialog will open. Use
this dialog to Add previously defined auxiliary files to the list of files to be processed. You can
rearrange the order of the files by selecting a file and using the up and down arrows on the right to
move the selected file within the list, or you can sort them alphabetically using the Sort button. To
remove an auxiliary file from the list, use the Delete button.
Once the list of auxiliary files to process is complete, press the Execute button to process the list of
auxiliary files.
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Script Section
The SCRIPT section begins with a left curly brace and ends with a right curly brace.
SCRIPT ScriptName
{
script_statement_1
script_statement_2
.
.
.
script_statement_n
}
Scripts may optionally contain a ScriptName. This enables you to call a particular SCRIPT by using the
LoadScript action. After the optional name, the SCRIPT section begins with a left curly brace and ends
with a right curly brace. Inside of this, script statements can be given.
In general, a script statement has the following format:
Keyword(arg1, arg2, ...);








Statement starts with a keyword.
The keyword is followed by an argument list which is encompassed in parentheses ( ).
The arguments are separated by commas.
If a single argument is a list of things, this list is encompassed by braces [ ]. (eg. SetData)
Statements end with a semicolon.
Statements may take up several lines of the text file.
You may put more than one statement on a single text line.

Some features in Simulator are available exclusively in either RUN mode or EDIT mode. This
functionality is preserved in the script language. Versions of Simulator prior to 16.0 organized certain
functionality with the submode feature. While existing scripts designed to work with submodes will
function as before, moving between submodes is no longer necessary.
If the Script Command Execution Dialog is opened from Edit Mode, Simulator defaults to EDITmode.
If the Script Command Execution Dialog is opened from Run Mode (or when a script is initially
started), Simulator defaults to RUNmode.
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Script General Actions
The following actions are available to you regardless of the Mode:
RenameFile
CopyFile
DeleteFile
LoadAux
LoadScript
LoadData

("oldfilename",
("oldfilename",
("filename");
("filename",
("filename",
("filename",

SelectAll
UnSelectAll
Delete
DeleteInclud
ingContents

"newfilename");
"newfilename");
CreateIfNotFound);
ScriptName,
DataName,

(objecttype,
(objecttype,
(objecttype,
(objecttype,

CreateIfNotFound);
CreateIfNotFound);

filter);
filter);
filter);
filter);

SaveData("filename",filetype,objecttype,[fieldlist],[subdatalist],filter,[SortFieldList]);
SaveDataWithExtra("filename",filetype,objecttype,[fieldlist],[subdatalist],filter,[SortFieldList],[Head
er_List],[Header_Value_List]);
SaveDataUsingExportFormat("filename",filetype,FormatName,ModelToUse;
SetData
CreateData

(objecttype,
(objecttype,

[fieldlist],
[fieldlist],

[valuelist],

filter);

[valuelist]);

ChangeData

(objecttype,

[fieldlist],

[valuelist],

SaveObjectFields

("filename",

objecttype,

[fieldlist]);

WriteTextToFile
SetCurrentDirectory
SendtoExcel

("filename",
("filedirectory",
(objecttype,
UseColumnHeaders,

"text…");
CreateIfNotFound);
[fieldlist],
"workbookname",

filter);

filter,
"worksheetname");

StopAuxFile;
ExitProgram;
NewCase;
OpenCase

("filename
");

OpenCase

("filename
",

OpenCase

("filename
",

// assumes
to open as
PWB
openfiletyp
e);
PWB, GE,
PTI, or CF
openfiletyp
e,

[LoadTransactio
ns,
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(NOT
AVAILABLE
YET)

StarBus]);

PTI
OpenCase

("filename
",

AppendCa
se

("filename
",

AppendCa
se

("filename
",

AppendCa
se

openfiletyp
e,
GE

("filename");

SaveCase

("filename",

EnterMode

[PostCTGAGC,
YES or NO
(mode);
EDIT
RUN

LogAdd

("string…");

LogAddDateTime

("label",

CaseDescriptionClear;
CaseDescriptionSet

PostCTGAGC
]);
YES
NO

NEAR
MAX

number

[MSLine,
MAINTAIN
EQUIVALENCE

VarLimDea
d,
Number

PostCTGAGC
]);
YES
NO

// assumes to
save as PWB
savefiletype,
PWB, PWB5,
PWB6,
PWB7,PWB8,
PWB9, PWB10,
PWB11, PWB12,
PWB13
PTI23, PTI24,
PTI25, PTI26,
PTI27,PTI28,
PTI29, PTI30
GE, GE14, GE15
CF
UseAreaZone]);
YES or NO

AppendFile);
YES or NO
IncludeDate,
YES or NO
("text…",

IncludeTime,
YES or NO

Append
YES or NO
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NEAR
MAX
10000
VarLimDea
d,
Number

[StarBus]);

openfiletyp
e,
GE

SaveCase

("filename",

MAINTAIN
EQUIVALENCE

openfiletyp
e);
PWB, GE,
PTI, or CF
openfiletyp
e,
PTI

("filename
",

LogClear;
LogSave

YES
NO
DEFAULT
[MSLine,

IncludeMilliseconds);
YES or NO

SaveYbusInMatlabFormat
SaveJacobian

("filename",

("Jacfilename",

SetParticipationFactors

DetermineShortestP
ath
ChangeSystemMVA
Base
AutoInsertTieLineTr
ansactions;
InjectionGroupsAut
oInsert;
DetermineBranches
ThatCreateIslands

SetGenPMaxFromRe
activeCapabilityCurv
e
SetScheduledVoltag
eForABus
Scale

ConstantValue,
value

filetype,
M
TXT

JacForm);
R
P

Object);
[Area num]
[Zone num]
SYSTEM
AREAZONE or
DISPLAYFILTERS

(filter);

CalculateRXBGFromLen
gthConfigCondType

DeterminePathDi
stance

"JIDfilename",

(Method,
MAXMWRAT
RESERVE
CONSTANT

GenForceLDC_RCC

DirectionsAutoInsert

IncludeVoltages);
YES or NO

(filter);
(Source,
AREA
ZONE
INJECTIONGROUP

([start],

Sink,
AREA
ZONE
INJECTIONGROUP
SLACK
BranchDistMeas,

DeleteExisting,
YES or NO

BranchFilter,

([start]
,
(NewB
ase);

[end],

BranchDistMe
as,

BranchFilter,

(Branc
hFilter,
ALL
Selecte
d
Closed
"FilterN
ame"
(filter);

StoreBuses,

"filename",

SetSelectedO
nLines);
YES or NO

([bus
identifi
er],

voltage);

(scaletype,

YES or NO

basedon,

[parameters],
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ScaleMarker);

UseDisplayFilters,
YES or NO

BusField);
FileName);

St
va

LOAD
GEN

MW
FACTOR

[P,Q]
[P] (means
constant pf)

INJECTIONGROUP
BUSSHUNT

[P, +Q, -Q]

BUS
AREA
ZONE
OWNER

RenameFile("oldfilename", "newfilename");
Use this action to rename a file from within a script.
"oldfilename": The present file name.
"newfilename": The new file name desired.
CopyFile("oldfilename", "newfilename");
Use this action to copy a file from within a script.
"oldfilename": The present file name.
"newfilename": The new file name desired.
DeleteFile("filename");
Use this action to delete a file from within a script.
"filename": The file name to delete.
LoadAux("filename", CreateIfNotFound);
Use this action to load another auxiliary file from within a script.
"filename": The filename of the auxiliary file being loaded.
CreateIfNotFound: Set to YES or NO. YES means that objects that cannot be found will be
created while reading in DATA sections from filename. If this parameter is not specified, then NO
is assumed.
LoadScript("filename", ScriptName, CreateIfNotFound);
Use this action to load a named Script Section from another auxiliary file. This will open the auxiliary
file denoted by "filename", but will only execute the script section specified.
"filename": The filename of the auxiliary file being loaded.
ScriptName: The specific ScriptName from the auxiliary file which should be loaded.
CreateIfNotFound: Set to YES or NO. YES means that objects which can not be found will be
created while reading in SCRIPT sections from filename. If this parameter is not specified, then
NO is assumed.
LoadData("filename", DataName, CreateIfNotFound);
Use this action to load a named Script Section from another auxiliary file. This will open the auxiliary
file denoted by "filename", but will only execute the script section specified.
"filename": The filename of the auxiliary file being loaded.
DataName: The specific ScriptName from the auxiliary file which should be loaded.
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CreateIfNotFound: Set to YES or NO. YES means that objects which can not be found will be
created while reading in DATA sections from filename. If this parameter is not specified, then NO
is assumed.
SelectAll(objecttype, filter);
Use this to set the selected property of objects of a particular type to true. A filter may optionally be
specified to only set this property for objects which meet a filter.
objecttype: The objecttype being selected.
filter: There are three options for the filter:
SelectAll(objecttype);: No filter specified means to select all objects of this type.
SelectAll(objecttype, "filtername");: "filtername" means select those that meet the
advanced filter. Advanced filters belonging to a different objecttype can also be used. The
"filtername" then takes on the form "<objecttype>objecttype's filtername".
SelectAll(objecttype, AREAZONE);: AREAZONE means select those that meet the
area/zone filters.
UnSelectAll(objecttype, filter);
Same as SelectAll, but this action sets the Selected field to false.
Delete(objecttype, filter);
Use this to delete objects of a particular type. A filter may optionally be specified to only delete
objects that meet a filter.
objecttype: The objecttype being selected.
filter: There are four options for the filter:
Delete(objecttype);: No filter specified means to delete all objects of this type.
Delete(objecttype, "filtername");: "filtername" means delete those that meet the
advanced filter. Advanced filters belonging to a different objecttype can also be used. The
"filtername" then takes on the form "<objecttype>objecttype's filtername".
Delete(objecttype, AREAZONE);: AREAZONE means delete those that meet the
area/zone filters.
Delete(objecttype, SELECTED);: SELECTED means delete those objects whose Selected
field is set to YES.
DeleteIncludingContents(objecttype, filter);
Use this to delete objects of a particular type and other objects that these contain. Currently, only
multi-section lines (objecttype = MultiSectionLine) can be used with this command. The branches
and dummy buses that belong to multi-section lines will also be deleted along with the multi-section
lines. A filter may optionally be specified to only delete objects that meet a filter.
objecttype: The objecttype being selected (presently we only support objecttype =
MultiSectionLine.
filter: There are four options for the filter:
DeleteIncludingContents(objecttype);: No filter specified means to delete all objects of
this type.
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DeleteIncludingContents(objecttype, "filtername");: "filtername" means delete those
that meet the advanced filter. Advanced filters belonging to a different objecttype can also be
used. The "filtername" then takes on the form "<objecttype>objecttype's filtername".
DeleteIncludingContents(objecttype, AREAZONE);: AREAZONE means delete those
thsat meet the area/zone filters.
DeleteIncludingContents(objecttype, SELECTED);: SELECTED means delete those
objects whose selected field is set to YES.
SaveData("filename", filetype, objecttype, [fieldlist], [subdatalist], filter, [SortFieldList]);
Use this action to save data in a custom defined format. A filter may optionally be specified to save
only objects which meet a filter, and a sort order list may also optionally be specified that will allow
saving the objects in a particular order.
"filename": The file to save the data to
filetype:
AUX (or AUXCSV): save as a space-delimited (or comma-delimited) auxiliary data file.
CSV: save as a normal CSV text file, without the AUX file formatting. The first few lines of the
text file will represent the object name and field names.
CSVColHeader: save as a normall CSV file without the AUX file syntax, and with the first row
showing column headers you would see in a case information display.
objecttype: The objecttype being saved.
[fieldlist]: A list of fields to save. For numeric fields, the number of digits and the number of
decimal places (digits to right of decimal) can be specified by using the following format for the
field, variablename:location:digits:rod.
[subdatalist]: A list of the subdata objecttypes to save with each object record.
filter: There are four options for the filter:
SaveData(…);: No filter specified means to save all objects of this type.
SaveData(…, "filtername");: "filtername" means save those that meet the advanced
filter. Advanced filters belonging to a different objecttype can also be used. The "filtername"
then takes on the form "<objecttype>objecttype's filtername".
SaveData(…, AREAZONE);: AREAZONE means save those that meet the area/zone filters.
SaveData(…, SELECTED);: SELECTED means save those objects whose selected field is
set to YES.
[SortFieldList]: This allows the specification of a sort order in which the data will be saved. The
format is:
[variablename1:+:0, variablename2:-:1]
where
variablename is the name of the field to sort by. There is no limit to how many fields can be
specified for sorting. For fields that require a location other than zero , variablename can be
in the format fieldname:location.
+ or - for the second parameter indicates sort ascending for + and sort descending for -.
This parameter must be specified.
0 or 1 for the third parameter indicates: 0 - case insensitive and do not use absolute value, 1
- case sensitive or use absolute value. This parameter is optional.
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SaveDataWithExtra("filename", filetype, objecttype, [fieldlist], [subdatalist], filter,
[SortFieldList], [Header_List], [Header_Value_List]);
Use this action to save data in a custom defined format. User-specified fields and field values can
also be specified in the output. Optional parameters are filter, SortFieldList, Header_List, and
Header_Value_List.
"filename": The file to save the data to
filetype:
CSV: save as a normal CSV text file, without the AUX file formatting. The first few lines of the
text file will represent the object name and field names.
CSVNOHEADER: save as a normal CSV text file, without the AUX file formatting. The object
name and field names are NOT included. This option is useful when appending data of the
same object type and field list into a common file.
CSVColHeader: save as a normall CSV file without the AUX file syntax, and with the first row
showing column headers you would see in a case information display.
Data cannot be saved using the AUX filetype with this command.
objecttype: The objecttype being saved.
[fieldlist]: A list of fields to save. For numeric fields, the number of digits and the number of
decimal places (digits to right of decimal) can be specified by using the following format for the
field, variablename:location:digits:rod.
[subdatalist]: A list of the subdata objecttypes to save with each object record.
filter: There are four options for the filter:
SaveData(…);: No filter specified means to save all objects of this type.
SaveData(…, "filtername");: "filtername" means save those that meet the filter.
SaveData(…, AREAZONE);: AREAZONE means save those that meet the area/zone filters.
SaveData(…, SELECTED);: SELECTED means save those objects whose selected field is
set to YES.
[SortFieldList]: This allows the specification of a sort order in which the data will be saved. The
format is:
[variablename1:+:0, variablename2:-:1]
where
variablename is the name of the field to sort by. There is no limit to how many fields can be
specified for sorting. For fields that require a location other than zero , variablename can be
in the format fieldname:location.
+ or - for the second parameter indicates sort ascending for + and sort descending for -.
This parameter must be specified.
0 or 1 for the third parameter indicates: 0 - case insensitive and do not use absolute value, 1
- case sensitive or use absolute value. This parameter is optional. If it is not specified, the
default is 0.
[Header_List]: This allows the specification of user-defined fields that will appear in the output.
Headers should be specified as a list of comma delimited strings. A string should be enclosed in
double quotes if the string contains a comma. Header strings cannot be blank.
[Header_Value_List]: Allows the specification of the values that should be assigned to the
user-defined fields specified by Header_List. Specifying the values is optional. If specified, there
must be as many values specified as there are headers. If not specified, all values are blank.
Each object will use the same specified value for the specified field. To use different values for
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different objects and save these in the same file, make use of the CSVNOHEADER file format and
filtering.
SaveDataUsingExportFormat("filename", filetype, FormatName, ModelToUse);
Use this action to save data in a user-defined format that has previously been defined.
"filename": The file to save the data to
filetype:
AUX (or AUXCSV): save as a space-delimited (or comma-delimited) auxiliary data file.
CSV: save as a normal CSV text file, without the AUX file formatting. The first few lines of the
text file will represent the object name and field names.
FormatName: The name of the Object Export Format Description to use.
ModelToUse: Optional parameter that indicates the model to use.
FULL: Full-topology model. This is the default if the parameter is omitted.
CONSOLIDATED: Consolidated planning-type model. This option will only work with the
Topology Processing add-on.
SetData(objecttype, [fieldlist], [valuelist], filter);
Use this action to set fields for particular objects. If a filter is specified, then it will set the respective
fields for all objects which meet this filter. Otherwise, if no filter is specified, then the keyfields must
be included in the field list so that the object can be found.
objecttype: The objecttype being set.
[fieldlist]: A list of fields that you want to save.
[valuelist]: A list of values to set the respective fields to.
filter: There are four options for the filter:
SetData(…);: No filter specified: set data only for the object described by the [fieldlist] and
[valuelist] parameters.
SetData(…, "filtername");: "filtername": set data for all objects that meet the advanced
filter. Advanced filters belonging to a different objecttype can also be used. The "filtername"
then takes on the form "<objecttype>objecttype's filtername".
SetData(…, AREAZONE);: AREAZONE: set data for all objects that meet the area/zone
filters.
SetData(…, SELECTED);: SELECTED: set data for all objects whose selected field is set to
YES.
SetData(..., ALL);:ALL: set data for all objects of the specified object type.
CreateData(objecttype, [fieldlist], [valuelist]);
Use this action to create particular objects. Note that the key fields for the objecttype must be
specified.
objecttype: The objecttype being set.
[fieldlist]: A list of fields that you want to save.
[valuelist]: A list of values to set the respective fields to.
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SaveObjectFields("filename", objecttype, [fieldlist]);
Use this action to save a list of fields available for the specified objecttype to a CSV file. Format of
the file is variablename, field, col header, description.
"filename": The file path and name to save.
objecttype: The type of object for which fields should be saved.
[fieldlist]: List of fields for which information will be saved.
WriteTextToFile("filename", "text…");
Use this action to write text to a file. If the specified file already exists, the text will be appended to
the file. Otherwise, it creates the file and writes the text to the file.
"filename": The file path and name to save.
"text…": The text to be written to the file.
SetCurrentDirectory("filedirectory", CreateIfNotFound);
Use this action to set the current working directory.
"filedirectory": The path of the work directory.
CreateIfNotFound: Set to YES or NO. YES means that if the directory path can not be found,
the directory will be created. If this parameter is not specified, then NO is assumed.
SendtoExcel(objecttype, [fieldlist], filter, UseColumnHeaders, “workbookname”,
“worksheetname”);
Use this action to mimic the behavior of Send to Excel option within a case information display.
objecttype : The type of object for which fields should be saved.
[fieldlist] : List of fields for which information will be saved.
filter : There are four options for the filter:
SendToExcel(…); : No filter specified means to save all objects of this type.
SendToExcel (…, “filtername”); : “filtername” means save those meeting the advanced
filter. Advanced filters belonging to a different objecttype can also be used. The “filtername”
then takes on the form “<objecttype>objecttype’s filtername”.
SendToExcel (…, AREAZONE); : AREAZONE means save those that meet the
area/zone/owner filters.
SendToExcel (…, SELECTED); : SELECTED means save those that are selected.
UseColumnHeaders : Set to YES or NO. YES signifies that the first row shows the Column
Header, NO signifies that variable names are used.
“workbookname” : Optional parameter to specify the path and name to save. If blank, a new
workbook will be created, if a value is specified it will overwrite any existing file of that name.
“worksheetname” : Optional parameter to specify the worksheet name to save. If blank, a
new worksheet will be created, if a value is specified it will overwrite the data in any existing
worksheet of that name.
StopAuxFile;
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Use this action to treat the remainder of the file after the command as a big comment. This includes
any script commands inside the present SCRIPT block, as well as all remaining SCRIPT or DATA
blocks.
ExitProgram;
Immediately exits the program with no prompts.
NewCase;
This action clear out the existing case and open a new case from scratch.
OpenCase("filename", OpenFileType);
OpenCase("filename", OpenFileType,[LoadTransactions, StarBus]);
OpenCase("filename", OpenFileType,[MSLine, VarLimDead, PostCTGAGC]);
This action will open a case stored in "filename" of the type OpenFileType;
"filename": The file to be opened.
OpenFileType: An optional parameter indicating the format of the file being opened. If none is
specified, then PWB will be assumed. It may be one of the following strings:
PWB, PTI, GE, CF, AUX.
[LoadTransactions, StarBus]: An optional set of parameters used ONLY when reading in a
PTI raw file.
LoadTransactions:
YES: Creates MW transactions, replicating the option (AREA INT CODE = 1
FOR LINES ONLY)
NO: Do not create, replicating the option (AREA INT CODE = 2 FOR LINES ONLY)
DEFAULT: Let the software estimate which is best
StarBus:
NEAR: Use numbers near the primary bus number for star bus assignment
MAX: Start numbering star buses above the maximum bus number in the case
Number: Start numbering at the number specified
[MSLine, VarLimDead, PostCTGAGC]: An optional set of parameters used ONLY when
reading in a GE epc file.
MSLine:
MAINTAIN: keeps the multi-section lines as defined in the epc file
EQUIVALENCE: removes the multi-section lines by creating a single equivalent line
combining the sections of each line
VarLimDead:
Number: The assumed generator VAR limit deadband
PostCTGAGC:
YES: prevents generators from responding to system changes during a contingency
outage solution
NO: all generators to respond to system changes during a contingency outage solution
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AppendCase("filename", OpenFileType);
AppendCase("filename", OpenFileType, [StarBus]);
AppendCase("filename", OpenFileType, [MSLine, VarLimDead, PostCTGAGC]);
This action will open and append a case stored in "filename" of the type OpenFileType to the load
flow case currently loaded in Simulator.
"filename": The file to be opened and appended.
OpenFileType: An optional parameter indicating the format of the file being opened. If none is
specified, then PWB will be assumed. It may be one of the following strings:
PWB, PTI, GE, CF, AUX.
[StarBus]: An optional set of parameters used ONLY when reading in a PTI raw file.
StarBus:
NEAR: Use numbers near the primary bus number for star bus assignment
MAX: Start numbering star buses above the maximum bus number in the case
Number: Start numbering at the number specified
[MSLine, VarLimDead, PostCTGAGC]: An optional set of parameters used ONLY when
reading in a GE epc file.
MSLine:
MAINTAIN: keeps the multi-section lines as defined in the epc file
EQUIVALENCE: removes the multi-section lines by creating a single equivalent line
combining the sections of each line
VarLimDead:
Number: The assumed generator VAR limit deadband
PostCTGAGC:
YES: prevents generators from responding to system changes during a contingency
outage solution
NO: all generators to respond to system changes during a contingency outage solution
SaveCase("filename", SaveFileType, [PostCTGAGC, UseAreaZone]);
This action will save the case to "filename" in the format SaveFileType.
"filename": The file name to save the information to.
SaveFileType: An optional parameter saying the format of the file to be saved. If none is
specified, then PWB will be assumed. It may be one of the following strings:
PWB, PWB5, PWB6, PWB7, PWB8, PWB9, PWB10, PWB11, PWB12, PWB13
PTI (means PTI30), PTI23, PTI24, PTI25, PTI26, PTI27, PTI28, PTI29, PTI30
GE (means GE15), GE14, GE15
CF
AUX
PostCTGAGC : An optional parameter, only valid for GE EPC format. YES sets the base load flag
in the EPC file based on the Post-Contingency Prevent AGC Response setting If preventing postcontingency AGC, the base load flag is set to 1. If not preventing post-contingency AGC or this
option is set to NO, the base load flag is set to 0.
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UseAreaZone : An optional parameter, only valid for GE EPC format. YES limits the entries in
the EPC file based on the area/zone/owner filter (NO by default)
EnterMode(mode);
This action will tell Simulator what mode to enter before performing the next script command.
Mode: The mode to enter, RUN or EDIT.
LogClear;
Use this action to clear the Message Log.
LogSave("filename", AppendFile);
This action saves the contents of the Message Log to "filename".
"filename": The file name to save the information to.
AppendFile: Set to YES or NO. YES means that the contents of the log will be appended to
"filename". NO means that "filename" will be overwritten.
LogAdd("string…");
Use this action to add a personal message to the MessageLog.
"string…": The string that will appear as a message in the log.
LogAddDateTime("label", IncludeDate, IncludeTime, IncludeMilliseconds);
Use this action to add a personal message to the MessageLog, including the posting date/time.
"label": A string that will appear at the start of the line containing the date/time.
IncludeDate: Set to YES or NO. YES means that the date will be added after the string
specified. If this parameter is not specified, then YES is assumed.
IncludeTime: Set to YES or NO. YES means that the time will be added after the date. If
there’s no date, then it will be added after the string specified. If this parameter is not specified,
then YES is assumed.
IncludeMilliseconds: Set to YES or NO. YES means that the time including milliseconds will be
added after the date or string specified. This is valid only if the IncludeTime is set to YES. If this
parameter is not specified, then YES is assumed.
CaseDescriptionClear;
Use this action to clear the case description of the presently open case.
CaseDescriptionSet("text…", Append);
Use this action to set or append text to the case description
"text…": Specify the text to set/append to the case description
Append: YES will append the text to the exisiting case description. NO will replace the case
description
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SaveYbusInMatlabFormat("filename", IncludeVoltages);
Use this action to store the power system bus admittance matrix (Ybus) in a text format that can be
easily read into other programs such as MATLAB®.
"filename": The file name to save the information to. The Ybus data is stored using the
MATLAB sparse matrix format in the matrix Ybus.
IncludeVoltages: Set to YES or NO. YES means that the bus voltages are also stored but in
the vector V.
SaveJacobian("filename", IncludeVoltages);
Use this action to store the power flow Jacobian in a text format that can be easily read into other
programs such as MATLAB®.
"Jacfilename": The file name to save the Jacobian data to. The Jacobian is stored using the
MATLAB sparse matrix format in the matrix Jac.
"JIDfilename": The file name to save the text identifier information to. This information is
used to translate the bus numbering convention used in the Jacobian and Ybus files with the
actual bus number and name in the case.
filetype: A parameter saying the format of the file to be saved. It may be one of the following
strings:
M: MATLAB .M Format.
TXT: ASCII format.
JacForm: Specifies the form of the Jacobian. It may be one of the following strings:
R: Rectangular form
P: Polar form.
SetParticipationFactors(Method, ConstantValue, Object);
Use this action to define the participation factors for multiple generators.
Method: The formula used to calculate the participation factors for each generator. It may be
one of the following strings:
MAXMWRAT: The participation factor for each generator is set to the generator’s maximum
MW capability.
RESERVE: The participation factor for each generator is set to the generator’s reserve power,
so that each generator participates in proportion to how much it has left to contribute (Max
MW rating - Present MW).
CONSTANT: The participation factor for each generator is set to the same specified value.
ConstantValue: The value used if CONSTANT method is specified. If CONSTANT method is not
specified, enter 0 (zero).
Object: The set of generators to which the participation factors will be assigned. It may be one
of the following settings:
[Area num], [Area "name"] [Area "label"]: For all the generators in area
[Zone num], [Zone "name"] [Zone "label"]: For all the generators in zone
SYSTEM: For all the generators in the system regardless of their area or zone affiliation.
AREAZONE or DISPLAYFILTERS: For just the generators whose area/zone/owner filter criteria
evaluates to true.
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GenForceLDC_RCC(filter);
Use this action to convert the voltage setpoint for Line Drop and Reactive Current Compensation
(LDC/RCC) for multiple generators.
filter: There are four options for the filter:
GenForceLDC_RCC;: No filter specified means to convert voltage setpoint for LDCC/RCC on
all the generators of the system.
GenForceLDC_RCC ("filtername");: "filtername" means to convert voltage setpoint for
LDCC/RCC on those generators that meet the advanced filter. Advanced filters belonging to a
different objecttype can also be used. The "filtername" then takes on the form
"<objecttype>objecttype's filtername".
GenForceLDC_RCC (AREAZONE);: AREAZONE means to convert voltage setpoint for
LDCC/RCC on those generators that meet the area/zone filters.
GenForceLDC_RCC (SELECTED);: SELECTED means to convert voltage setpoint for
LDCC/RCC on those generators whose selected field is set to YES.
CalculateRXBGFromLengthConfigCondType(filter);
Use this action the go through branches in the power system and automatically recalculate the per
unit R, X, G, and B values using the TransLineCalc tool. The branches Conductor Type, Tower
Configuration, and Line Length will be passed to the TransLineCalc tool and new R, X, G and B
values will be calculated. This is only available if you have installed the TransLineCalc tool.
filter: There are four options for the filter which operate identically to the option for the
GenForceLDC_RCC action above.
CalculateRXBGFromLengthConfigCondType;: No filter specified means to perform
calculation on all branches.
CalculateRXBGFromLengthConfigCondType ("filtername");: "filtername" means to
perform calculation on those branches that meet the advanced filter. Advanced filters
belonging to a different objecttype can also be used. The "filtername" then takes on the form
"<objecttype>objecttype's filtername".
CalculateRXBGFromLengthConfigCondType;: AREAZONE means to perform calculation
on those branches that meet the area/zone filters.
CalculateRXBGFromLengthConfigCondType: SELECTED means to perform calculation
on those branches whose selected field is set to YES.
DirectionsAutoInsert(Source, Sink, DeleteExisting, UseDisplayFilters, Start, Increment);
Use this action to automatically insert multiple directions for PTDF studies.
Source, Sink: The type of object used as the source/sink of the directions. Currently, only the
following types of directions can be automatically defined:
AREA SLACK: Directions from areas to slack bus of the system.
ZONE SLACK: Directions from zones to slack bus of the system.
INJECTIONGROUP SLACK: Directions from injection groups to slack bus of the system.
AREA AREA: Directions from areas to other areas of the system.
ZONE ZONE: Directions from zones to other zones of the system.
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INJECTIONGROUP INJECTIONGROUP: Directions from injection groups to other injection
groups of the system.
DeleteExisting: Set to YES or NO. YES means that previously defined directions will be deleted
before the new directions are automatically inserted. NO means automatically inserted directions
will be added to the list of previously defined directions. If this parameter is not specified, then
YES is assumed.
UseDisplayFilters: Set to YES or NO. YES means that only Areas and Zones with their
Area/Zone filters set to YES will be used when automatically inserting directions. NO specifies all
Areas and Zones will be used to automatically insert directions regardless of their Area/Zone
filters. If this parameter is not specified, then NO is assumed.
Start: Integer value that specifies the first number used when automatically numbering the
automatically inserted directions. If this parameter is not specified, then 1 is assumed.
Increment: Integer value that will be used as increment in numbering the subsequent
automatically inserted directions. If this parameter is not specified, then 1 is assumed.
DeterminePathDistance([start], BranchDistMeas, BranchFilter, BusField);
Use this action to calculate a distance measure at each bus in the entire model. The distance
measure will represent how far each bus is from the starting group specified. The distance measure
can be related to impedance, geographical distance, or simply the number of nodes.
[start] : is an the starting place which is enclosed in brackets. The starting place may be either
an Area, Zone, SuperArea, SUbstation, Injection Group, or Bus.
BranchDistMeas : is either X, Z, Length, Nodes, or a variable name for a branch.
X : means use the series reactance,
Z : means use sqrt(X^2 + R^2),
Length : means us the Length field, and
Nodes : means treat each branch as a length of one.
"variablename" : Otherwise use any Branch object variable name.
BranchFilter : is either All, Selected, Closed or the name of a branch Advanced Filter. This
parameter is used to specify which branch can be traversed at all.
All : means all branches can be traversed
Selected : means only branch whose Selected field is YES can be traversed
Closed : means only branches that are CLOSED can be traversed.
"Filtername" : means only branches who meet the Advanced Filter named can be traversed.
Advanced filters belonging to a different objecttype can also be used. The "filtername" then
takes on the form "<objecttype>objecttype's filtername".
BusField : is the variablename of a Bus field. This field is populated with the minimum distance
from the Start Place to that bus. All buses in the start group will have a distance measure of
zero. Buses which can not be reached from the start group will have a distance measure of -1.
DetermineShortestPath([start], [end], BranchDistanceMeasure, BranchFilter, Filename);
Use this action to calculate the shortest path between a starting group and an ending group. The
results will be written to a textfile specified by filename. In the text file, the first bus listed will be in
the end grouping and the last bus listed will be the start grouping. The result text file will have a line
for each bus passed. Each line will contain three entries delimited by a space: “Number
DistanceMeasure Name”.
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[start] : same as the starting place for the DeterminePathDistance script command
[end] : same as the starting place for the DeterminePathDistance script command
BranchDistanceMeasure : same as for DeterminePathDistance script command
BranchFilter : same as for DeterminePathDistance script command
Filename : is a filename (may need to be enclosed in quotes) to which the results will be
written.
ChangeSystemMVABase(NewBase);
Use this action to change the system MVA base to the specified value and update all internal data
structures to store values on the new base.
NewBase: New power system base in MVA.
AutoInsertTieLineTransactions;
Use this action todelete all existing MW transactions and set the unspecified MW interchange for
each area to zero. It then automatically creates a MW transaction between each pair of connected
areas with a MW transaction exactly equal to the sum of the tie-line flows
InjectionGroupsAutoInsert;
Use this action to automatically insert injection groups according to the options specified in the
“IG_AutoInsert_Options” object. The settings available with this object represent what is seen on
the Auto Insert Injection Groups Dialog.
DetermineBranchesThatCreateIslands(BranchFilter, StoreBuses, “filename”,
SetSelectedOnLines);
Use this action to determine the branches whose outage results in island formation. Note that
setting the Selected fuield will overwrite the Selected fields.
BranchFilter : is either All, Selected, Closed or the name of a branch Advanced Filter. This
parameter is used to specify which branch can be traversed at all.
All : means all branches can be traversed
Selected : means only branches whose Selected field = YES can be traversed
Closed : means only branches that are CLOSED can be traversed.
“FilterName” : means only branches who meet the advanced filter named can be traversed.
Advanced filters belonging to a different objecttype can also be used. The “filtername” then takes
on the form “<objecttype>objecttype’s filtername”.
StoreBuses : YES to store the buses in the island to the output file
“filename” : file to which the results will be written.
SetSelectedOnLines : YES to set the SELECTED field to YES for branches that create islands
SetGenPMaxFromReactiveCapabilityCurve(filter);
Use this action to change the Maximum MW output of generators which use a capability curve, equal
to the second-to-last MW point in the capability curve if the last Max Mvar point on the capability
curve is smaller than 0.001 Mvar. If the present MW output is higher than this new Max MW value,
then Max MW is set to the present MW output..
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filter : optional parameter which is either Selected, Closed or the name of a branch Advanced
Filter. This parameter is used to specify which generators are processed. If blank, all generators
are processed.
Selected : means only generators whose Selected field = YES can be processed
AREAZONE : means process those generators that meet the area/zone/owner filters.
“FilterName” : means only generators who meet the advanced filter named can be processed.
Advanced filters belonging to a different objecttype can also be used. The “filtername” then takes
on the form “<objecttype>objecttype’s filtername”.
SetScheduledVoltageForABus([bus identifier], voltage);
Use this action to set the stored scheduled voltage, vsched, for a bus according to how this is
defined in the EPC format. This value is not used by Simulator but is stored for purposes of writing
out to an EPC file. The setpoint voltages for generators and switched shunts regulating the specified
bus are also set to the new voltage. The regulation range for switched shunts is modified for the
new setpoint voltage according to how this is defined in the EPC format: vband = (VHigh-VLow)/2
with newVHigh = voltage+vband and new VLow = voltage-vband.
[bus identifier] : specifies bus
voltage : the new voltage
Scale(scaletype, basedon, [parameters], scalemarker);
Use this action to scale the load and generation in the system.
scaletype: The objecttype begin scaled. Must be either LOAD, GEN, INJECTIONGROUP, or
BUSSHUNT.
basedon: MW: parameters are given in MW, MVAR units.
FACTOR: parameters a factor to multiple the present values by.
[parameters]: These parameters have different meanings depending on ScaleType.
LOAD: [MW, MVAR] or [MW]. If you want to scale load using constant power factor, then do
not specifying a MVAR value.
GEN: [MW].
INJECTIONGROUP: [MW, MVAR] or [MW] . If you want to scale load using constant power
factor, then do not specifying a MVAR value.
BUSSHUNT: [GMW, BCAPMVAR, BREAMVAR]. The first values scales G shunt values, the
second value scales positive (capacitive) B shunt values, and the third value scales negative
(reactive) B shunt values.
scalemarker: This value specifies whether to look at an element’s bus, area, or zone to
determine whether it should be scaled.
BUS: Means that elements will be scaled according to the BusScale property of the element’s
terminal bus.
AREA: Means that elements will be scaled according to the BGScale property of the element’s
Area. Note that it is possible for the area of a load, generator, or switched shunt to be
different than the terminal bus’s area.
ZONE: Means that elements will be scaled according to the BGScale property of the element’s
Zone. Note that it is possible for the zone of a load, generator, or switched shunt to be
different than the terminal bus’s zone.
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OWNER: Means that the elements will be scaled according to the BGScale property of the
element’s Owner.
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Script Oneline Actions
OpenOneLine
CloseOneLine
SaveOneline
ExportOnelineAs
ShapeFile
LoadAXD

("filename
",
("Oneline
Name");
("filename
",
("filename
",

"view",

FullScreen,

"Oneline
Name",
"Oneline
Name",

SaveFileType);

("filename
",

"Oneline
Name",

CreateIfNotFound);

"ShapeFileExportDescri
ptionName",

Show
Full);

UseLo
nLat,

PointLoc
ation);

OpenOneline("filename", "view", FullScreen);
Use this action to open a oneline diagram. This can only be used in SimAuto and cannot be used to
actually view a oneline. This action is most useful when wanting to save a oneline diagram in a
different file format.
"filename": The file name of the oneline diagram to open.
"view": The view name that should be opened. Pass an empty string to denote no specific
view.
FullScreen: Set to YES or NO. YES means that the oneline diagram will be opened in full screen
mode. If this parameter is not specified, then NO is assumed.
ShowFull: Optional parameter. Set to YES to open the oneline and apply the Show Full option.
Set to NO to open the oneline and leave the oneline as is. Default is NO if not specified.
CloseOneline("OnelineName");
Use this action to close an open oneline diagram without saving it. If the name is omitted, the last
focused oneline diagram will be closed.
"OnelineName": The name of the oneline diagram to close.
SaveOneline("filename", "OnelineName", SaveFileType);
Use this action to save an open oneline diagram to a file.
"filename": The path and file name of the file to save.
"OnelineName": Name of the open oneline to save.
SaveFileType: Type of file to save. Valid options are PWB, PWB5, PWB6, PWB7. PWB8, PWB9,
PWB10, PWB11, PWB12, PWB13. If omitted, PWB, which is the most recent version, will be
assumed.
ExportOnelineAsShapeFile("filename", "OnelineName",
"ShapeFileExportDescriptionName", UseLonLat, PointLocation);
Use this action to save an open oneline diagram to a shapefile.
"filename": The file name of the shapefile to save.
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"OnelineName": The name of the oneline diagram to save to a shapefile. The oneline diagram
must be open. Use the OpenOneline script command if necessary to open the appropriate
oneline.
"ShapeFileExportDescriptionName": Name of the ShapeFile Export Description to use when
saving the shapefile.
UseLonLat: Set to YES or NO. YES means that the coordinates of objects on the oneline
diagram will be saved using longitude,latitude. This will only be true if a valid map projection is in
use with the oneline diagram. Otherwise, the coordinates will be saved in x,y. If this parameter is
set to NO, the coordinates will be saved in x,y. If this parameter is not specified, YES is assumed.
PointLocation: Determines where points are specified -- object centers, or the upper left
corner. Specify "center" to define points as the shape centers, or "ul" to define them as the
upper left corner of the shapes. If not specified, upper left is assumed.
LoadAXD("filename", "OnelineName", CreateIfNotFound);
Use this action to apply a display auxiliary file to an open oneline diagram. This action is only
allowed when using SimAuto.
"filename": The file name of the display auxiliary file to load.
"OnelineName": The name of the oneline diagram to which to apply the display auxiliary file.
Use the OpenOneline script command if necessary to open the appropriate oneline. If the
specified oneline is not open, a new one will be created with the given name.
CreateIfNotFound: Set to YES or NO. YES means that objects which cannot be found will be
created while reading in DATA sections from filename.
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Script Edit Mode Actions
The following case related script commands are available in Edit mode:
Equivalence;
DeleteExternalSystem;
SaveExternalSystem
Move

("filename",

([elementA],

[destination
parameter],
[numB idB]

[GEN numA
idA]
[LOAD
numA idA]
[BRANCH
numA1
numA2
cktA]
[SHUNT
numA idA]
Combine

SplitBus

Savefiletype,

withties);

percentage);

[numB idB]
[numB1
numB2
cktB]
[numB idB]

([elementA],
[GEN numA
idA]
[LOAD
numA idA]

[elementB]);
[GEN numB idB]

[BRANCH
numA1
numA2
cktA]

[BRANCH numB1 numB2 cktB]

([element],
[BUS num]

MergeBuses
MergeLineTerminals
TapTransmissio
nLine

[LOAD numB idB]

NewBusNumber,
num

([element],
[BUS num]

// NOT
AVAILABLE
YET
// NOT
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YET

InsertBusTieLine,
YES or NO

LineOpen);
YES or NO

filter);

(filter);
([eleme
nt],
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H
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cktA];

PosAlongThe
Line,
Value in %

NewBusNu
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el,
LINESHUN
TS

CAPACITA
NCE
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TreatAsMSLi
ne);
YES or NO

RenumberMSLineDummyBuses

("filename");

Renumber3WXFormerStarBuses

("filename");

InterfacesAutoInser
t

DeleteExisting
,
YES or NO

(Type
,
AREA

UseDisplayFilters
,
YES or NO

Prefix,

Limits);

"string
"

AUTO

ZONE

ZEROS
[value1
,…
value
8]

Equivalence
This action will equivalence a power system. All options regarding equivalencing are handled by the
Equiv_Options objecttype. Use the SetData() action, or a DATA section to set these options prior to
using the Equivalence() action. Also, remember that the property BusEquiv must be set true for each
bus that you want to equivalence.
DeleteExternalSystem
This action will delete part of the power system. It will delete those buses whose property BusEquiv
must is set true.
SaveExternalSystem("filename", SaveFileType, WithTies)
This action will save part of the power system to a "filename". It will save only those buses whose
property BusEquiv must is set true.
"filename": The file name to save the information to.
SaveFileType: An optional parameter saying the format of the file to be saved. If none is
specified, then PWB will be assumed. May be one of the following strings:
PWB, PWB5, PWB6, PWB7. PWB8, PWB9, PWB10, PWB11, PWB12, PWB13, PWB14
PTI (means PTI30) PTI23, PTI24, PTI25, PTI26, PTI27, PTI28, PTI29, PTI30, PTI31, PTI32
GE (means GE15), GE14, GE15, GE16, GE17
CF
AUX
WithTies: An optional parameter. The user must specify the file type explicitly in order to use
the WithTies parameter. Allows saving transmission lines that tie a bus marked with BusEquiv as
false and one marked true. This must be a string which starts with the letter Y, otherwise NO will
be assumed.
Move([elementA], [destination parameters], percentage);
Use this action to move a generator, load, switched shunt, or transmission line.
[elementA]: the object that should be moved. Must be one of the following formats.
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[GEN busnum id], [GEN "name_nomkv" id], [GEN "buslabel" id], [GEN "label"]
[LOAD busnum id], [LOAD "name_nomkv" id], [LOAD "buslabel" id], [LOAD "label"]
[BRANCH busnum1 busnum2 ckt], [BRANCH "name_kv1" "name_kv2" ckt],
[BRANCH "buslabel1" "buslabel2" ckt], [BRANCH "label"]
[SHUNT busnum id], [SHUNT "name_nomkv" id], [SHUNT "buslabel" id], [SHUNT "label"]
[destination parameters]: These parameters have different meanings depending on object
type of the element. Bus numbers must be used here.
GEN: [busnum id]
LOAD: [busnum id]
BRANCH: [busnum1 busnum2 id]
SHUNT: [busnum id]
percentage: The percentage of the device to move to the new destination. This is only valid for
generators and loads, and allows partial generation or load to be moved to the new location.
Combine([elementA], [elementB]);
NOTE: THIS ACTION IS ONLY AVAILABLE FOR GENERATORS.
Use this action to combine two generators, two loads, or two transmission line. Note that elementA
and elementB must be of the same object type. You can not combine a BRANCH and a LOAD.
[elementA]: The object that should be moved. Must be one of the following formats.
[GEN busnum id]
[LOAD busnum id]
[BRANCH busnum1 busnum2 ckt]
[elementB]: The object that element A should be combined with. Must the same format as for
elementA.
SplitBus([element], NewBusNumber, InsertBusTieLine, LineOpen);
Use this action to transform one bus into two connected buses.
[element]: The bus that should be split. Must be of the following format:
[BUS num]
[BUS "name_nomkv"]
[BUS "buslabel"]
NewBusNumber: The number of the new bus resulting from the split. Must be unique, that is,
it cannot be a number that identifies another number in the case.
InsertBusTieLine Set to YES or NO. YES means to insert a very low-impedance bus tie
between the bus to split and its offspring. The new branch will have an impedance of 0.0000 +
j0.0001 ohms. NO means that no bus tie will be inserted. If this parameter is not specified, then
YES is assumed.
LineOpen Set to YES or NO. YES means that the bus tie should be inserted as an open branch.
NO means that the bus tie will be inserted as a closed branch. This options is valid only if
InsertBusTieLine is set to YES. If this parameter is not specified, then NO is assumed.
MergeBuses([element], filter);
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Use this action to merge a set of buses into a single bus.
[element]: The number of the new bus resulting from the merging. It should be a number of a
bus that is part of the set of buses to be merged, or it should be unique, meaning that it cannot
be a number that identifies another number in the case. Must be of the following format:
[BUS num]
filter: There are four options for the filter:
MergeBuses(…);: No filter specified means to merge all the buses of the system.
MergeBuses(…, "filtername");: "filtername" means to merge those buses that meet the
advanced filter. Advanced filters belonging to a different objecttype can also be used. The
"filtername" then takes on the form "<objecttype>objecttype's filtername".
MergeBuses(…, AREAZONE);: AREAZONE means to merge those buses that meet the
area/zone filters.
MergeBuses(…, SELECTED);: SELECTED means to merge those buses whose selected
field is set to YES.
MergeLineTerminals(filter);
Use this action to remove a line or lines from the model by combining the terminal buses at both
ends of a line into a single bus.
filter: There are two options for the filter:
MergeLineTerminals("filtername");: "filtername" means to individually merge the
terminal buses of each transmission line that meets the advanced filter.
MergeLineTerminals(SELECTED);: SELECTED means to individually merge the
terminals of each transmission line whose selected field is set to YES.
TapTransmissionLine([element], PosAlongTheLine, NewBusNumber, ShuntModel,
TreatAsMSLine);
Use this action to insert a bus at some location along an existing transmission line.
[element]: The transmission line to tap. Must be of the following format:
[BRANCH busnum1 busnum2 ckt]
[BRANCH "name_kv1" "name_kv2" ckt]
[BRANCH "buslabel1" "buslabel2" ckt]
[BRANCH "label"]
PosAlongTheLine: The value that indicates the point where the new bus is to be inserted
relative to the location of the nearest of the two buses in terms of a percentage of the total line
length This value controls how the impedances of the new lines are set, as the impedance of
each section will equal the section’s corresponding percentage length multiplies by the
impedance of the original line.
NewBusNumber: The number of the new bus resulting from the tapping. Must be unique, that
is, it cannot be a number that identifies another number in the case.
ShuntModel: The way the original charging capacitance of the line is reassigned. The choices
are:
LINESHUNTS: The original charging capacitance is reassigned as line shunts at the original
terminal bus ends of the two new line segments. The charging capacitance of the two new
branch elements will be set to 0.
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CAPACITANCE: The original charging capacitance of the line is converted approximately using
percentage entered as PosAlongTheLine. In other words, the original capacitance will be
scaled and assigned to the new segments as charging capacitance.
The default ShuntModel is LINESHUNTS.
TreatAsMSLine: Set to YES or NO. YES means that a new multi-section line will be created that
is comprised of the two new lines. NO means that the two new lines will be controlled
independently of each other.
RenumberMSLineDummyBuses("filename");
Use this action to change the dummy bus numbers and names for one or more multi-section lines to
new numbers and names of your choosing. The new dummy bus numbers and names are loaded
from a file. The format of the data in the file is described in the help on the Multi-Section Lines
Display.
"filename": The file name of the file containing the specification of the new dummy bus
numbers and names.
Renumber3WXFormerStarBuses("filename");
Use this action to change the star bus number and name for one or more three winding transformer
star buses to new numbers and names of your choosing. The new star bus numbers and names are
loaded from a file. The format of the data in the file is described in the help on the three winding
transformer display.
"filename": The file name of the file containing the specification of the new star bus numbers
and names.
InterfacesAutoInsert(Type, DeleteExisting, UseDisplayFilters, Prefix, Limits);
Use this action to automatically insert a group of interfaces. The new of the new interfaces defaults
to "Area1-Area2" or "Zone1-Zone2" with an optional Prefix.
Type: The type of interfaces to insert. Choices are:
AREA: Area-to-area interfaces join adjacent areas (those that share at least one tie line).
ZONE: Zone-to-zone interfaces join adjacent interfaces (those that share at least one tie line).
DeleteExisting: Set to YES or NO. YES means that previously defined interfaces will be deleted
before the new interfaces are automatically inserted. NO means automatically inserted interfaces
will be added to the list of previously defined interfaces. If this parameter is not specified, then
YES is assumed.
UseDisplayFilters: Set to YES or NO. YES means that only Areas and Zones with their
Area/Zone filters set to YES will be used when automatically inserting interfaces. NO specifies all
Areas and Zones will be used to automatically insert interfaces regardless of their Area/Zone
filters. If this parameter is not specified, then NO is assumed.
Prefix: An optional prefix of up to three characters. Use this prefix to avoid duplicating names,
particularly when some of the areas or zones have the same name. If this parameter is not
specified, then "" is assumed.
Limits: Specifies the way the interfaces rating are set. Choices are:
AUTO: The interface rating is calculated based on the ratings of the components included in
the interface.
ZEROS: All the interface limits are set to zero.
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[value1, …, value8]: The set of rating values to be used for the interfaces. The eight values
must be specified, separated by commas.
The default parameter is ZEROS.
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Script Run Mode Actions
The following script commands are among those available in Run Mode:

Animate(DoAnimate);
CalculatePTDF

([transactor seller],

CalculatePTDFMultipleDirec
tions

[transactor buyer],

LinearMetho
d);

[AREA num]

[AREA num]

AC

[ZONE num]

[ZONE num]

DC

[SUPERAREA
"name"]

[SUPERAREA name]

DCPS

[INJECTIONGROUP
"name"]

[INJECTIONGROUP
name]

[BUS num]

[BUS num]

[SLACK]

[SLACK]

(StoreValuesForBranc
hes,

StoreValuesForInterfa
ces,

LinearMetho
d);

YES or NO

YES or NO

AC
DC
DCPS

CalculateLODF

CalculateLODFMatrix

CalculateTLR

([BRANCH
nearbusnum
farbusnum ckt],

LinearMethod);

(WhichOnes,

filterProcess,

filterMonitor,

MonitorOnlyClosed,

LinearMethod

OUTAGES
CLOSURES

ALL
SELECTED
AREAZONE
"filtername"

ALL
SELECTED
AREAZONE
"filtername"
SAME

YES
NO

DC
DCPS

([flowelement],

direction,

[transactor],

LinearMethod);

[INTERFACE
"name"]

BUYER

same as above for
PTDFs

AC

[BRANCH nearbusnum
farbusnum ckt]

SELLER
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DC
DCPS

CalculateTLRMultipleElement

CalculateVoltSense

CalculateFlowSense

CalculateLossSense

(TypeElement

WhichElement,

direction,

[transactor],

LinearMethod

BRANCH

SELECTED

BUYER

same as
above for
PTDFs

AC

INTERFACE

OVERLOAD

SELLER

BOTH

CTGOVERLOAD

DC
DCPS

([BUS
num]);
([flowelement],

FlowType);

[INTERFACE
"name"]

MW

[BRANCH
busnum1
busnum2 ckt]

MVAR
MVA

(FunctionType);
NONE
ISLAND
AREA
AREASA
SELECTED

CalculateVoltToTransferSense

CalculateVoltSelfSense

([transactor seller],

[transactor buyer],

TransferType

TurnOffAVR);

[AREA num]

[AREA num]

[P, Q, or PQ]

YES or NO

[ZONE num]

[ZONE num]

[SUPERAREA
"name"]

[SUPERAREA
name]

[INJECTIONGROUP
"name"]

[INJECTIONGROUP
name]

[BUS num]

[BUS num]

[SLACK]

[SLACK]

(filter);
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SetSensitivitiesAtOutOfServiceToClosest;
ZeroOutMismatches;

Animate(DoAnimate);
Use this action to animate all the open oneline diagrams.
DoAnimate: Set to YES or NO. YES means to start the animation of the open oneline diagrams,
while NO means that the animation will be paused.
CalculatePTDF([transactor seller], [transactor buyer], LinearMethod);
Use this action to calculate the PTDF values between a seller and a buyer. You may optionally
specify the linear calculation method. Note that the buyer and seller must not be same thing. If no
Linear Method is specified, Lossless DC will be used.
[transactor seller]: The seller (or source) of power. There are six possible settings:
[AREA num], [AREA "name"], [AREA "label"]
[ZONE num], [ZONE "name"], [ZONE "label"]
[SUPERAREA "name"], [SUPERAREA "label"]
[INJECTIONGROUP "name"], [INJECTIONGROUP "label"]
[BUS num], [BUS "name_nomkv"], [BUS "label"]
[SLACK]
[transactor buyer]: The buyer (or sink) of power. There are six possible settings, which are
the same as for the seller.
LinearMethod: The linear method to be used for the PTDF calculation. The options are:
AC: Calculation including losses.
DC: Lossless DC.
DCPS: Lossless DC that takes into account phase shifter operation.
CalculatePTDFMultipleDirections(StoreValuesForBranches, StoreValuesForInterfaces,
LinearMethod);
Use this action to calculate the PTDF values using multiple directions. Only directions with the field
INCLUDE set to YES will be analyzed when calculating the multiple direction PTDFs. You may
optionally specify the linear calculation method. If no Linear Method is specified, Lossless DC will be
used.
StoreValuesForBranches: Set to YES or NO. YES means that the PTDFs for lines/transformers
will be stored.
StoreValuesForInterfaces: Set to YES or NO. YES means that the PTDFs for interfaces will be
stored.
LinearMethod: The linear method to be used for the PTDF calculation. The options are:
AC: Calculation including losses.
DC: Lossless DC.
DCPS: Lossless DC that takes into account phase shifter operation.
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CalculateLODF([BRANCH nearbusnum farbusnum ckt], LinearMethod);
Use this action to calculate the Line Outage Distribution Factors (or the Line Closure Distribution
Factors) for a particular branch. If the branch is presently closed, then the LODF values will be
calculated, otherwise the LCDF values will be calculated. You may optionally specify the linear
calculation method as well. If no Linear Method is specified, Lossless DC will be used.
[BRANCH nearbusnum farbusnum ckt]: The branch whose status is being changed. Can
also use strings
[BRANCH "nearbusname_kv" "farbusname_kv" ckt]
[BRANCH "nearbuslabel" "farbuslabel" ckt]
[BRANCH "label"]
LinearMethod: The linear method to be used for the LODF calculation. The options are:
DC: Lossless DC.
DCPS: Llossless DC that takes into account phase shifter operation.
Note: AC is NOT an option for the LODF calculation.
CalculateLODFMatrix(WhichOnes, filterProcess, filterMonitor, MonitorOnlyClosed,
LinearMethod);
Use this action to calculate a matrix of LODF results comprised of multiple branches to be outaged
or closed and multiple branches for which the impact of the outages/closures is determined.
WhichOnes: Specify the type of sensitivities to be calculated.
OUTAGES: Outage sensitivities will be calculated for those branches meeting the filterProcess.
CLOSURES: Closure sensitivities will be calculated for those branches meeting the
filterProcess.
filterProcess: Specify a filter for the branches for which the outages or closures will be
implemented.
ALL: All AC transmission lines.
SELECTED: Only those branches whose Selected field is set to YES.
AREAZONE: Only those branches meeting the area/zone filter.
"filtername": Name of advanced filter. Advanced filters belonging to a different objecttype can
also be used. The "filtername" then takes on the form "<objecttype>objecttype's filtername".
filterMonitor: Specify a filter for the branches for which the impact of the outages or closures
will be determined.
ALL: All AC transmission lines.
SELECTED: Only those branches whose Selected field is set to YES.
AREAZONE:Only those branches meeting the area/zone filter.
"filtername": Name of advanced filter. Advanced filters belonging to a different objecttype can
also be used. The "filtername" then takes on the form "<objecttype>objecttype's filtername".
SAME: Same as set of branches to process as specified by filterProcess.
MonitorOnlyClosed: Set to YES to monitor only those branches that are closed. Set to NO to
monitor branches regardless of their status.
LinearMethod: The linear method to use in the LODF calculations.
DC: Lossless DC.
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DCPS: Lossless DC that takes into account phase shifter operation.
CalculateTLR([flow element], direction, [transactor], LinearMethod);
Use this action to calculate the TLR values a particular flow element (transmission line or interface).
You also specify one end of the potential transfer direction. You may optionally specify the linear
calculation method. If no Linear Method is specified, Lossless DC will be used.
[flow element]: This is the flow element we are interested in. Choices are:
[INTERFACE "name"]
[INTERFACE "label"]
[BRANCH nearbusnum farbusnum ckt]
[BRANCH "nearbusname_kv" "farbusname_kv" ckt]
[BRANCH "nearbuslabel" "farbuslabel" ckt]
[BRANCH "label"]
direction: the type of the transactor. Either BUYER or SELLER.
[transactor buyer]: the transactor of power. There are six possible settings.
[AREA num], [AREA "name"], [AREA "label"]
[ZONE num], [ZONE "name"], [ZONE "label"]
[SUPERAREA "name"], [SUPERAREA "label"]
[INJECTIONGROUP "name"], [INJECTIONGROUP "label"]
[BUS num], [BUS "name_nomkv"], [BUS "label"]
[SLACK]
LinearMethod: The linear method to be used for the calculation. The options are:
AC: Calculation including losses.
DC: Lossless DC.
DCPS: Lossless DC that takes into account phase shifter operation.
CalculateTLRMultipleElement(TypeElement, WhichElement, direction, [transactor],
LinearMethod);
Use this action to calculate the TLR values a multiple elements similar to as is done on the TLR
multiple elements dialog. You also specify one end of the potential transfer direction. You may
optionally specify the linear calculation method. If no Linear Method is specified, Lossless DC will be
used.
TypeElement : May be either INTERFACE, BRANCH, or BOTH
WhichElement : There are three choices which represent which elements of the TypeElement
specified will have TLR calculations performed.
SELECTED : Only branches or interfaces with their Selected Field = YES will be used.
OVERLOAD : Only branches that are presently overloaded using their normal ratings will be
used
CTGOVERLOAD : You must have first run the contingency analysis. A branch or interface is
included in the calculation if it has been overloaded during at least one contingency.
direction: the type of the transactor. Either BUYER or SELLER.
[transactor buyer]: the transactor of power. There are six possible settings.
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[AREA num], [AREA "name"], [AREA "label"]
[ZONE num], [ZONE "name"], [ZONE "label"]
[SUPERAREA "name"], [SUPERAREA "label"]
[INJECTIONGROUP "name"], [INJECTIONGROUP "label"]
[BUS num], [BUS "name_nomkv"], [BUS "label"]
[SLACK]
LinearMethod: The linear method to be used for the calculation. The options are:
AC: Calculation including losses.
DC: Lossless DC.
DCPS: Lossless DC that takes into account phase shifter operation.
CalculateVoltSense([BUS num]);
This calculates the sensitivity of a particular buses voltage to real and reactive power injections at all
buses in the system. (Note: this assumes that the power is injected at a given bus and taken out at
the slack bus).
[BUS num]: The bus to calculate sensitivities for.
CalculateFlowSense([flow element], FlowType);
This calculates the sensitivity of the MW, MVAR, or MVA flow of a line or interface to real and
reactive power injections at all buses in the system. (Note: this assumes that the power is injected
at a given bus and taken out at the slack bus).
[flow element]: This is the flow element we are interested in. Choices are:
[INTERFACE "name"]
[INTERFACE "label"]
[BRANCH busnum1 busnum2 ckt]
[BRANCH "name_kv1" "name_kv2" ckt]
[BRANCH "buslabel1" "buslabel2" ckt]
[BRANCH "label"]
FlowType: The type of flow to calculate this for. Either MW, MVAR, or MVA.
CalculateLossSense(FunctionType);
This action calculates the sensitivity of a real power loss function, PLosses, to bus real and reactive
power injections. Stated mathematically, this action calculates d PLosses/d Pi and d PLosses/d Qi ,
where Pi and Qi are the real and reactive power injections at bus i, respectively. Stated less formally,
this action indicates how losses would change if one more MW or Mvar of power were injected at
bus i.
FunctionType: Specifies how the losses are computed. Choices are:
NONE: No losses are calculated because a loss function is not specified.
ISLAND: Losses are calculated with respect to the losses in bus’ island. If the power system
consists of only one island, losses are computed with respect to the total system losses.
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AREA: Losses are calculated with respect to the total losses for the area containing bus i. This
is probably the most common loss function because usually one is concerned with minimizing
losses for a particular area rather than for the entire case.
AREASA: Losses are calculated with respect to the total losses for the area containing bus i if
bus i does not belong to a super area, and with respect to the total losses for the super area
containing bus i if bus i does belong to a super area.
SELECTED: Losses are calculated with respect to the total losses for a group of areas whose
selected field is set to YES.
CalculateVoltToTransferSense([transactor seller], [transactor buyer], TransferType,
TurnOffAVR);
This calculates the sensitivity of bus voltage to a real or reactive power transfer between a seller and
a buyer. The sensitivity is calculated for all buses in the system.
[transactor seller]: This is the seller (or source) of power. There are six possible settings:
[AREA num], [AREA "name"], [AREA "label"]
[ZONE num], [ZONE "name"], [ZONE "label"]
[SUPERAREA "name"], [SUPERAREA "label"]
[INJECTIONGROUP "name"], [INJECTIONGROUP "label"]
[BUS num], [BUS "name_nomkv"], [BUS "label"]
[SLACK]
[transactor buyer]: This is the buyer (or sink) of power. There are six possible settings, which
are the same as for the seller.
TransferType: The type of power transfer. The options are:
P – real power transfer
Q – reactive power transfer
PQ – both real and reactive power transfer. (Note: Real and reactive power transfers are
calculated independently, but both are calculated.)
TurnOffAVR: Set to YES or NO. Set to YES to turn off AVR control for generators participating
in the transfer. Set to NO to leave the AVR control unchanged for generators participating in the
transfer.
CalculateVoltSelfSense(filter);
This calculates the sensitivity of a particular bus’ voltage to real and reactive power injections at the
same bus. (Note: This assumes that the power is injected at a given bus and taken out at the slack
bus.)
filter: There are four options for the filter:
CalculateVoltSelfSense; : No filter specified means to merge all the buses of the system.
CalculateVoltSelfSense("filtername"); : "filtername" means to merge those buses that
meet the advanced filter. Advanced filters belonging to a different objecttype can also be
used. The "filtername" then takes on the form "<objecttype>objecttype's filtername".
CalculateVoltSelfSense(AREAZONE); : AREAZONE means to merge those buses that
meet the area/zone filters.
CalculateVoltSelfSense(SELECTED); : SELECTED means to merge those buses whose
selected field is set to YES.
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SetSensitivitiesAtOutOfServiceToClosest;
This will take the P Sensitivity and Q Sensitivity values calculated using CalculateTLR,
CalculateFlowSense, or CalculateVoltSense actions and then populate the respective values at outof-service buses so that they are equal to the value at the closest in service bus. The "distance" to
the in-service buses will be measured by the number of nodes. If an out-of-service bus is equally
close to a set of buses, then the average of that set of buses will be used.
ZeroOutMismatches;
With this script command, the bus shunts are changed at each bus that has a mismatch greater than
the MVA convergence tolerance so that the mismatch at that bus is forced to zero.
In addition to these general run mode actions, there are actions related to specific types of analysis:
PowerFlow, Contingency, ATC, Fault, PV and QV.
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Script PowerFlow Related Actions
The following actions are available in Run Mode:
DoCTGAction([contingency action]);
SolvePowerFlow(SolMethod, "filename1", "filename2", CreateIfNotFound1, CreateIfNotFound2);
ResetToFlatStart(FlatVoltagesAngles, ShuntsToMax, LTCsToMiddle, PSAnglesToMiddle);
SolvePrimalLP("filename1", "filename2", CreateIfNotFound1, CreateIfNotFound2);
InitializePrimalLP("filename1", "filename2", CreateIfNotFound1, CreateIfNotFound2);
SolveSinglePrimalLPOuterLoop("filename1", "filename2", CreateIfNotFound1, CreateIfNotFound2);
SolveFullSCOPF(BCMethod, "filename1", "filename2", CreateIfNotFound1, CreateIfNotFound2);
OPFWriteResultsAndOptions ("filename");
DiffFlowSetAsBase;
DiffFlowClearBase;
DiffFlowMode (diffmode);
PRESENT
BASE
DIFFERENCE
DoCTGAction([contingency action]);
Call this action to use the formats seen in the CTGElement subdata record for Contingency Data.
Note that all actions are supported, except COMPENSATION sections are not allowed.
SolvePowerFlow(SolMethod, "filename1", "filename2", CreateIfNotFound1,
CreateIfNotFound2);
Call this action to perform a single power flow solution. The parameters are all optional and specify a
conditional response depending on whether the solution is successfully found. If parameters are not
passed then default values will be used.
SolMethod The solution method to be used for the power flow calculation. The options are:
RECTNEWT: For Rectangular Newton-Raphson method.
POLARNEWTON: For Polar Newton-Raphson method.
GAUSSSEIDEL: For Gauss-Seidel method.
FASTDEC: For Fast Decoupled method.
DC: For DC method.
ROBUST: For ROBUST method.
The default method is RECTNEWT.
"filename1" The filename of the auxiliary file to be loaded if there is a successful solution. You
may also specify STOP, which means that all AUX file execution should stop under the condition.
Default Value is "".
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"filename2" The filename of the auxiliary file to be loaded if there is a NOT successful solution.
You may also specify STOP, which means that all AUX file execution should stop under the
condition. Default Value is "".
CreateIfNotFound1 Set to YES or NO. YES means that objects which can not be found will be
created while reading in DATA sections of filename1. Default Value is NO.
CreateIfNotFound2 Set to YES or NO. YES means that objects which can not be found will be
created while reading in DATA sections of filename2. Default Value is NO.
ResetToFlatStart (FlatVoltagesAngles, ShuntsToMax, LTCsToMiddle, PSAnglesToMiddle);
Use this action to initialize the Power Flow Solution to a "flat start." The parameters are all optional
and specify a conditional response depending on whether the solution is successfully found. If
parameters are not passed then default values will be used.
FlatVoltagesAngles Set to YES or NO. YES means setting all the voltage magnitudes and
generator setpoint voltages to 1.0 per unit and all the voltage angles to zero. Default Value is
YES.
ShuntsToMax Set to YES or NO. YES means to increase Switched Shunts Mvar half way to
maximum. Default Value is NO.
LTCsToMiddle Set to YES or NO. YES means setting the LTC Transformer Taps to middle of
range. Default Value is NO.
PSAnglesToMiddle Set to YES or NO. YES means setting Phase Shifter angles to middle of
range. Default Value is NO.
SolvePrimalLP("filename1", "filename2", CreateIfNotFound1, CreateIfNotFound2);
Call this action to perform a primal LP OPF solution. The parameters are all optional and specify a
conditional response depending on whether the solution is successfully found. If parameters are not
passed then default values will be used.
"filename1" The filename of the auxiliary file to be loaded if there is a successful solution. You
may also specify STOP, which means that all AUX file execution should stop under the condition.
Default Value is "".
"filename2" The filename of the auxiliary file to be loaded if there is a NOT successful solution.
You may also specify STOP, which means that all AUX file execution should stop under the
condition. Default Value is "".
CreateIfNotFound1 Set to YES or NO. YES means that objects which can not be found will be
created while reading in DATA sections of filename1. Default Value is NO.
CreateIfNotFound2 Set to YES or NO. YES means that objects which can not be found will be
created while reading in DATA sections of filename2. Default Value is NO.
SolveSinglePrimalLPOuterLoop("filename1", "filename2", CreateIfNotFound1,
CreateIfNotFound2);
This action is basically identical to the SolvePrimalLP action, except that this will only perform a
single optimization. The SolvePrimalLP will iterate between solving the power flow and an
optimization until this iteration converges. This action will only solve the optimization routine once,
then resolve the power flow once and then stop.
InitializePrimalLP("filename1", "filename2", CreateIfNotFound1, CreateIfNotFound2);
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This command clears all the structures and results of previous primal LP OPF solutions. The
parameters are all optional and specify a conditional response depending on whether the solution is
successfully found. If parameters are not passed then default values will be used.
"filename1" The filename of the auxiliary file to be loaded if there is a successful solution. You
may also specify STOP, which means that all AUX file execution should stop under the condition.
Default Value is "".
"filename2" The filename of the auxiliary file to be loaded if there is a NOT successful solution.
You may also specify STOP, which means that all AUX file execution should stop under the
condition. Default Value is "".
CreateIfNotFound1 Set to YES or NO. YES means that objects which can not be found will be
created while reading in DATA sections of filename1. Default Value is NO.
CreateIfNotFound2 Set to YES or NO. YES means that objects which can not be found will be
created while reading in DATA sections of filename2. Default Value is NO.
SolveFullSCOPF (BCMethod, "filename1", "filename2", CreateIfNotFound1,
CreateIfNotFound2);
Call this action to perform a full Security Constrained OPF solution. The parameters are all optional
and specify a conditional response depending on whether the solution is successfully found. If
parameters are not passed then default values will be used.
BCMethod The solution method to be used for solving the base case. The options are:
POWERFLOW – for single power flow algorithm.
OPF – for the optimal power flow algorithm.
Default Value is POWERFLOW.
"filename1" The filename of the auxiliary file to be loaded if there is a successful solution. You
may also specify STOP, which means that all AUX file execution should stop under the condition.
Default Value is "".
"filename2" The filename of the auxiliary file to be loaded if there is a NOT successful solution.
You may also specify STOP, which means that all AUX file execution should stop under the
condition. Default Value is "".
CreateIfNotFound1 Set to YES or NO. YES means that objects which can not be found will be
created while reading in DATA sections of filename1. Default Value is NO.
CreateIfNotFound2 Set to YES or NO. YES means that objects which can not be found will be
created while reading in DATA sections of filename2. Default Value is NO.
OPFWriteResultsAndOptions("filename");
Writes out all information related to OPF analysis as an auxiliary file. This includes Limit Monitoring
Settings, options for Areas, Buses, Branches, Interfaces, Generators, SuperAreas, OPF Solution
Options.
DiffFlowSetAsBase;
Call this action to set the present case as the base case for the difference flows abilities of Simulator.
DiffFlowClearBase;
Call this action to clear the base case for the difference flows abilities of Simulator.
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DiffFlowMode(diffmode);
Call this action to change the mode for the difference flows abilities of Simulator.
diffmode:
String that starts with ‘P’ changes it to PRESENT
String that starts with ‘B’ changes it to BASE
String that starts with ‘D’ changes it to DIFFERENCE
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Script Contingency Related Actions
The following actions are available in Run Mode:
CTGSolveAll;
CTGSolve("ContingencyName");
CTGSetAsReference;
CTGRestoreReference;
CTGProduceReport("filename");
CTGWriteResultsAndOptions("filename", [opt1, opt2, opt3, ... opt9], KeyField, UseDATASection);
CTGWriteFilePTI("filename", BusFormat, TruncateCTGLabels);
CTGAutoInsert;
CTGConvertAllToDeviceCTG;
CTGCalculateOTDF( [transactor seller], [transactor buyer], LinearMethod);
[AREA num] [AREA num] AC
[ZONE num] [ZONE num] DC
[SUPERAREA "name"] [SUPERAREA "name"] DCPS
[INJECTIONGROUP "name"] [INJECTIONGROUP "name"]
[BUS num] [BUS num]
[SLACK] [SLACK]
CTGSolveAll;
Call this action to solve all the contingencies which are not marked skip.
CTGSolve("ContingencyName");
Call this action solve a particular contingency. The contingency is denoted by the "Contingency
Name".
CTGSetAsReference;
Call this action to set the present system state as the reference for contingency analysis.
CTGRestoreReference;
Call this action to reset the system state to the reference state for contingency analysis.
CTGProduceReport("filename");
Produces a text-based contingency analysis report using the settings defined in CTG_Options.
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CTGWriteResultsAndOptions("filename", [opt1, opt2, opt3, ... opt9], KeyField,
UseDATASection);
Writes out information related to contingency analysis as an auxiliary file. The information included
in the auxiliary file depends on the options settings described below. Each of the nine options
settings parameters is either a YES or NO entry. If the options settings are not specified or blank,
the default entry given for each will be used.
"filename": name of AUX file to save
Opt1 - Save unlinked contingency actions, default = NO
Opt2 - Save contingency options, default = YES
Opt3 - Save limit monitoring settings, default = NO
Opt4 - Save general power flow solution options, default = YES
Opt5 - Save list display settings, default = NO
Opt6 - Save contingency results, default = YES
Opt7 - Save inactive violations, default = YES
Opt8 - Save interface definitions, default = NO
Opt9 - Save injection group definitions, default = NO
KeyField: indicates the identifier that should be used for the data. Valid entries are PRIMARY,
SECONDARY, or LABEL. The default setting is PRIMARY. PRIMARY will save using the bus
numbers and other primary key fields. SECONDARY will save using bus name and nominal kV
and other secondary fields. LABEL will save using device labels. If no labels are specified then the
primary key field will be used.
UseDATASection: set this to YES or NO. If set to YES, data that by default is specified using
SUBDATA sections will instead be specified using DATA sections. For example, the actions that
define a contingency by default are specified using a SUBDATA section. If choosing to use the
DATA section instead, each action will be specified in a DATA record belonging to the
ContingencyElement objecttype.
CTGWriteFilePTI("filename", BusFormat, TruncateCTGLabels);
Writes the contingency definitions to a PTI CON text file format.
"filename": name of the text file to save
BusFormat: the entries for the bus format are NUMBER, NAME8 or NAME12, which indicate to
save the contingency definitions using bus numbers, eight character bus names, or twelve
character bus names, respectively
TruncateCTGLabels: the entries for this field is either YES or NO, depending on if you would
like the output to truncate the contingency names to twelve characters or leave them as defined
if longer than twelve characters in Simulator
CTGAutoInsert;
Automatically generates a contingency list using the settings defined in CTG_Options.
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CTGConvertAllToDeviceCTG;
This command is intended for use with full topology models, where breakers and disconnects are
defined in addition to generators, loads, transmission lines, and so on. This function would have no
affect on a traditional planning model representation, which has no breakers or disconnects explicitly
defined.
The purpose of the function is to allow the user to take a contingency set that is defined with
outages of breakers and disconnects in a full topology model and convert them to outages of the
traditional planning model elements, such as generators, loads, transmission lines, etc. This would
be used in conjunction with the ability to save a full topology model as a consolidated model. A
consolidated model reduces the full model down to a traditional planning model by examining the
breaker and disconnect statuses, and reducing the system down by consolidating breakers and
disconnects that are in service. The resulting model is a smaller model with the traditional planning
elements represented, but breakers and disconnects have been removed and nodes aggregated into
bus representations. This function will also take the breaker and disconnect statuses and convert
contingencies defined with the breakers and disconnects and convert them into contingencies of the
planning model devices affected by opening the original breakers or disconnects. Thus you could
create a contingency set that is defined for the consolidated model, and can be run on the
consolidated model with the same results as if the original contingency set is run on the full topology
model.
Note that the contingency set generated depends on the statuses of the breakers and disconnects,
and that the contingencies created will be different for different statuses of breakers and
disconnects in the full topology model.
CTGCalculateOTDF([transactor seller], [transactor buyer], LinearMethod);
This action calculate OTDFs for each contingency-caused branch or interface violation. The values
calculated will be a measure of what percent of a transfer would appear on the branch or interface
after the respective contingency occurs. Realize for branch violations, that the sign of the OTDF
value will be relative to the direction of the MW flow found during the contingency analysis.
The parameters will be used to calculate the PTDFs for the transfer direction you are interested in.
These PTDF values will then be used throughout the OTDF calculation. Note that the buyer and
seller must not be same thing. If no Linear Method is specified, Lossless DC will be used.
NOTE: All the parameters are optional. If they are not specified, then the existing PTDFs will be
used.
[transactor seller]: The seller (or source) of power. There are six possible settings:
[AREA num]
[ZONE num]
[SUPERAREA "name"]
[INJECTIONGROUP "name"]
[BUS num]
[SLACK]
[transactor buyer]: The buyer (or sink) of power. There are six possible settings, which are
the same as for the seller.
LinearMethod: The linear method to be used for the PTDF calculation. The options are:
AC: for calculation including losses.
DC: for lossless DC.
DCPS: for lossless DC that takes into account phase shifter operation.
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Script ATC Related Actions
The following actions are available in Run Mode:
ATCDetermine

([transactor seller],
[AREA num]
[ZONE num]
[SUPERAREA
"name"]
[INJECTIONGROUP
"name"]
[BUS num]
[SLACK]

[transactor
buyer],
[AREA num]
[ZONE num]
[SUPERAREA
name]
INJECTIONGROUP
name]

DoDistributed);
YES
NO

[BUS num]
SLACK]

ATCRestoreInitialState;
ATCIncreaseTransferBy
ATCTakeMeToScenario

(amount);
(RL,

G,

ATCDetermineATCFor

(RL,

G,

ATCWriteResultsAndOption
s
ATCWriteToExcel

("filename",

AppendFile)
;

ATCWriteToText

("worksheetname")
;
("filename",

I)
;
I,

ApplyTransfer)
;

filetype);

ATCDetermine([transactor seller], [transactor buyer], DoDistributed);
Use this action to calculate the Available Transfer Capability (ATC) between a seller and a buyer.
Note that the buyer and seller must not be same thing. Other options regarding ATC calculations
should be set using a DATA section via the ATC_Options object type.
[transactor seller]: The seller (or source) of power. There are six possible settings
[AREA num], [AREA "name"], [AREA "label"]
[ZONE num], [ZONE "name"], [ZONE "label"]
[SUPERAREA "name"], [SUPERAREA "label"]
[INJECTIONGROUP "name"], [INJECTIONGROUP "label"]
[BUS num], [BUS "name_nomkv"], [BUS "label"]
[SLACK]
[transactor buyer]: The buyer (or sink) of power. There are six possible settings which are
the same as for the seller.
DoDistributed:Set to YES to use the distributed ATC solution method.
ATCRestoreInitialState;
Call this action to restore the initial state for the ATC tool.
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ATCIncreaseTransferBy(amount);
Call this action to increase the transfer between the buyer and seller.
ATCTakeMeToScenario(RL, G, I);
Call this action to set the present case according to Scenario RL, G, I.
ATCDetermineATCFor(RL, G, I, ApplyTransfer);
Call this action to determine the ATC for Scenario RL, G, I.
ApplyTransfer: Set this value to YES to leave the system state at the transfer level that was
determined. When using the Iterated Linear then Full Contingency solution method, the system
state will retain the transfer level but the contingency will not be applied.
ATCWriteResultsAndOptions("filename",AppendFile);
Writes out all information related to ATC analysis as an auxiliary file. This includes Contingency
Definitions, Limit Monitoring Settings, Solution Options, DataGrid settings relevant to ATC, ATC
Options, ATC results, as well as any Model Criteria that are used by the Contingency Definitions.
"filename": Name of the auxiliary file.
AppendFile: This is an optional parameter. YES means to append results to existing "filename".
NO means to overwrite "filename" with results. Default is YES.
ATCWriteToExcel("worksheetname");
Sends ATC analysis results to an Excel spreadsheet. This script command is available only for
Multiple Scenarios ATC analysis.
"worksheetname": The name of the Excel sheet where the results will be sent.
ATCWriteToText("filename",filetype);
This is used with Multiple Scenario ATC analysis. Multiple files are created with "filename" as the
primary identifier and the Interface scenario label appended to the end of the filename. Separate
files are created for each of the Interface scenarios. Results inside the files are separated into
sections based on the number of Rating/Load scenarios.
"filename": Primary identifier for the name of the file in which to save the results. "filename"
gets appended with the Interface scenario label to complete the filename.
filetype: Either TAB or CSV. This indicates the delimiter to use when writing out the file(s). This
is an optional parameter with TAB being the default if omitted.
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Script Fault Related Actions
The following actions are available in Run Mode:
Fault
Fault

([BUS
num],
([BRANCH
nearbusnum
farbusnum
ckt],

faultlocation,

faulttype,

R,

X);

faulttype,

R,

X)
;

SLG
LL
3PB
DLG

Fault([Bus num, faulttype, R, X]);
Fault([BRANCH nearbusnum farbusnum ckt], faultlocation, faulttype, R, X]);
Call this function to calculate the fault currents for a fault. If the fault element is a bus then do not
specify the fault location parameter. If the fault element is a branch, then the fault location is
required.
[Bus num]: This specifies the bus at which the fault occurs. You may also specify the bus using
secondary keys or labels:
[BUS "name_nomkv"]
[BUS "label"]
[BRANCH nearbusnum farbusnum ckt]: This specifies the branch on which the fault occurs.
You may also specify the branch using secondary keys or labels:
[BRANCH "name_kv1" "name_kv2" ckt]
[BRANCH "buslabel1" "buslabel2" ckt]
[BRANCH "label"]
Fault location: This specifies the percentage distance along the branch where the fault occurs.
This percent varies from 0 (meaning at the nearbus) to 100 (meaning at the far bus)
Faulttype: This specified the type of fault which occurs. There are four options:
SLG: Single Line To Ground fault
LL: Line to Line Fault
3PB: Three Phase Balanced Fault
DLG: Double Line to Group Fault.
R, X: These parameters are optional and specify the fault impedance. If none are specified, then
a fault impedance of zero is assumed.
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Script PV Related Actions
The following actions are available Run Mode:
PVSetSourceAndSink

([elementSource],
[INJECTIONGROUP
"name"]

[elementSink]);
[INJECTIONGROUP
"name"]

PVRun;
PVRun

([elementSource],
[INJECTIONGROUP "name"]

[elementSink]);
[INJECTIONGROUP "name"]

PVClear;
PVStartOver;
PVDestroy;
PVWriteResultsAndOptions
RefineModel

(objecttype,
AREA

("filename",

AppendFile);

filter,

Action
TRANSFORMERTAPS

ZONE

ForWhichValue);

SHUNTS
OFFAVR

Changes were made with Simulator version 14 to eliminate the need for a PV study name. To maintain
functionality with any existing processes that users might have in place using older script definitions,
scripts from older versions of Simulator will still be supported if the name is specified. However, the
name will just be ignored. The script formats given here reflect the changes for version 14.
The PVCreate script required in previous versions is no longer necessary in Simulator version 14.
Version 14 will still recognize this action if it is included and will simply set the source and sink for the
study. This does the same thing as PVSetSourceAndSink.
It is highly recommended that for any new processes the new script formats specified here be used.
PVSetSourceAndSink([elementSource], [elementSink]);
Call the function to specify the source and sink elements to perform the PV study.
[element source]: The source of power for the PV study. There is only one possible setting:
[INJECTIONGROUP "name"] or [INJECTIONGROUP "label"]
[element sink]: The sink of power for the PV study. There is only one possible setting, which
is the same as for the source.
PVRun;
Call the function to start the PV study.
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PVRun([elementSource], [elementSink]);
Call the function to specify the source and sink elements and start the PV study.
[element source]: The source of power for the PV study. There is only one possible setting:
[INJECTIONGROUP "name"] or [INJECTIONGROUP "label"]
[element sink]: The sink of power for the PV study. There is only one possible setting, which
is the same as for the source.
PVClear;
Call the function to clear all the results of the PV study.
PVStartOver;
Call the function to start over the PV study. This includes clear the activity log, clear results, restore
the initial state, set the current state as initial state, and initialize the step size.
PVDestroy;
Call the function to destroy the PV study. This will remove all results and prevent any restoration of
the initial state that is stored with the PV study.
PVWriteResultsAndOptions("filename", AppendFile);
Call this action to save all the PV results and options in the auxiliary file "filename".
AppendFile YES/NO optional parameter. Specifying NO will cause it to overwrite the existing
file. Specifying YES will cause it to append to the file. If not specified, then YES is assumed.
RefineModel(objecttype, filter, Action, Tolerance);
Call this function to refine the system model to fix modeling idiosyncrasies that cause premature loss
of convergence during PV and QV studies.
objecttype: The objecttype being selected.
AREA
ZONE
filter: There are three options for the filter:
RefineModel(…, "", …);: No filter specified means to select all objects of this type.
RefineModel(…, "filtername", …);: "filtername" means select those that meet the
advanced filter. Advanced filters belonging to a different objecttype can also be used. The
"filtername" then takes on the form "<objecttype>objecttype's filtername".
Action: The way the model will be refined. Choices are:
TRANSFORMERTAPS Fix all transformer taps at their present values if their Vmax – Vmin is
less than or equal to the user specified tolerance.
SHUNTS Fix all shunts at their present values if their Vmax – Vmin is less than or equal to the
user specified tolerance.
OFFAVR Remove units from AVR control, thus locking their MVAR output at its present value
if their Qmax – Qmin is less or equal to the user specified tolerance.
Tolerance: Tolerance value.
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Script QV Related Actions
The following actions are available in Run Mode:
QVRun

("filename",

InErrorMakeBaseSolvable);
YES or NO

NOTE: The QV study is always performed on selected buses.
QVWriteResult
sAndOptions

("filename");

RefineModel

(objecttype,
AREA
ZONE

filter,

Action
TRANSFORMERTAPS
SHUNTS
OFFAVR

ForWhichValue);

QVRun("filename", InErrorMakeBaseSolvable);
Call the function to start a QV study for the list of buses whose SELECTED? field is set to YES.
"filename": This specifies the file to which to save a comma-delimited version of the results.
InErrorMakeBaseSolvable: This specifies whether to perform a solvability analysis of the
base case if the pre-contingency base case can not be solved. If not specified, then YES is
assumed.
QVWriteResultsAndOptions("filename");
Call this action to save all the QV results and options in the auxiliary file "filename".
RefineModel(objecttype, filter, Action, Tolerance);
Call this function to refine the system model to fix modeling idiosyncrasies that cause premature loss
of convergence during PV and QV studies.
objecttype: The objecttype being selected.
AREA
ZONE
filter: There are three options for the filter:
RefineModel(…, "", …);: No filter specified means to select all objects of this type.
RefineModel(…, "filtername", …);: "filtername" means select those that meet the
advanced filter. Advanced filters belonging to a different objecttype can also be used. The
"filtername" then takes on the form "<objecttype>objecttype's filtername".
Action: The way the model will be refined. Choices are:
TRANSFORMERTAPS Fix all transformer taps at their present values if their Vmax – Vmin is
less than or equal to the user specified tolerance.
SHUNTS Fix all shunts at their present values if their Vmax – Vmin is less than or equal to the
user specified tolerance.
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OFFAVR Remove units from AVR control, thus locking their MVAR output at its present value
if their Qmax – Qmin is less or equal to the user specified tolerance.
Tolerance: Tolerance value.
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Script Topology Processing Related Actions
CloseWithBreakers

(objecttype,

"filtername",

OnlyEnergizeSpecifiedObjects);
The following action is available in Run Mode:
SaveConsolidatedCas
e

("filename"
,
[BusFormat
,

filettype,
TruncateCtgLabel
s,

AddCommentsForObjectLabels]
);

CloseWithBreakers(objecttype,"filtername",OnlyEnergizeSpecifiedObjects);
This action is used to specify which devices can be energized by closing breakers.
objecttype Objects that are valid to energize. Only allowed for Gen, Load Buses, Transmission
Lines, Switched Shunts, DC Lines, Bus Injection Groups and
Interfaces.
filtername "filtername" means select those that meet the advanced filter. Advanced filters
belonging to a different objecttype can also be used. The
"filtername" then takes on the form "<objecttype>objecttype's
filtername".
OnlyEnergizeSpecifiedObjects optional parameter, default is NO.
Yes –No extra objects in addition to those specified in the filter can be energized. Each
object will be evaluated individually.
No– Extra objects could be energized in addition to those specified if a group of breakers
required to energize a specified object also causes other objects to be energized. All objects
will be evaluated collectively for determining which objects can be energized, i.e. breakers
that cause one object to be energized might also be needed for another object to be
energized.
See the Close Breakers Overview topic for more information on how the close with breakers process
works.
SaveConsolidatedCase("filename", filetype, [BusFormat, TruncateCtgLabels,
AddCommentsForObjectLabels]);
This action saves the full topology model into a consolidated case.
“filename” : The name of the consolidated case file to be saved.
Filetype : Optional parameter to specifiy the type of the file to be saved. If omitted, the latest
version of the PWB will be used.
PWB – save a pwb file with the most recent version
PWBX – save a pwb with version X
PWPTI – save file with most recent PTI file format. When contingencies are present, they
are saved to a .CON file.
PWPTIXX – save the file with PTI version XX, where XX is between 23 and 32
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BusFormat : optional parameter used to specifiy the bus identifier format in the .CON file used
to store contingencies when saving a PTI file
Number – identify buses using number
Name8 – identify buses using the Name_kV identifier truncated to 8 characters
Name12 – identify buses usingthe Name_kV identifier truncated to 12 characters
TruncateCTGLabels : optional parameter used to specify if the contingency labels should be
truncated to 12 characters when saving the contingencies in PTI
format
YES – truncate the contingency labels to 12 characters
NO – do not truncate the contingency labels
AddCommentsForObjectLabels : (optional) YES adds object labels to the end of data records
when saving a RAW file. (default NO)
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Script Transient Stability Related Actions
The following actions are available in Run Mode:
TSSolveAll;
TSSolve

TSWriteOptions

TSSaveTwoBusEquivalent
TSCalculateSMIBEigenValu
es;
TSLoadGE
TSLoadPTI
TSLoadBPA
TSGetResults

(ContingencyName
,
StepSize,
("FileName",

[StartTime,

StopTime,

[SaveDynamicMod
el,

SaveStabilityOptio
ns,

SaveStabilityEvents
,
Keyfield]);
("PwbFileName",

SaveResultsSettin
gs,

SavePlotDefinition
s],

("FileName",
("FileName",
"BASEGENfilename
");
("FileName");

GENCCYN);
"MCREfilename",

"GNETfilename",

("FileName",
[Plots,
ObjectFields],

Single/Separate,
StartTime,

[Contingencies],
EndTime);

StepInCycles]);

[BUS]);

TSSolveAll;
Solves all defined transient contingencies which are not set to skip.
TSSolve("ContingencyName", [StartTime, StopTime, StepSize, StepInCycles]);
Solves only the specified contingency.
ContingencyName : The name of the contingency to solve
StartTime : (optional) Start time in seconds
StopTime : (optional) Stop time in seconds
StepSize : (optional) Step size in seconds
Example usage(s) :
TSSolve("ctg test");
TSSolve(ctg test);
TSSolve("test2");
TSSolve(test2);
TSSolve(test2, [0.0, 10, 0.5, Yes]);
TSSolve(test2, [1.0, 9, 0.5, Yes]);
TSSolve("test2", [1.0, 9, 0.01, No]);
TSWriteOptions("FileName",[SaveDynamicModel, SaveStabilityOptions,
SaveStabilityEvents, SaveResultsEvents, SavePlotDefinitions], KeyField);
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Save the transient stability option settings to an auxiliary file.
FileName : Name and path of the file to save
SaveDynamicModel : (optional) NO doesn’t save dynamic model (default YES)
SaveStabilityOptions : (optional) NO doesn’t save stability options (default YES)
SaveStabilityEvents : (optional) NO doesn’t save stability events (default YES)
SaveResultsSettings : (optional) NO doesn’t save results settings (default YES)
SavePlotDefinitions : (optional) NO doesn’t save plot definitions (default YES)
KeyField : (optional) Specifies key: can be Primary, Secondary, or Label (default Primary)
Example usage(s) :
TSWriteOptions(auxtest.aux);
TSWriteOptions("auxtest.aux");
TSWriteOptions("auxtest.aux", [YES, NO, NO, NO, NO]);
TSWriteOptions("auxtest.aux", [YES, NO, "", NO, NO, P]);
TSWriteOptions("auxtest.aux", [YES, NO, NO, "", YES, S]);
TSSaveTwoBusEquivalent ("PwbFileName", [BUS]);
Save the two bus equivalent model of a specified bus to a PWB file. Initialization to the start time is
always done before saving the two bus equivalent.
PwbFileName : Name and path for the output PWB file
BUS : Bus can be specified in three ways:
Number : [BUS busnum]
Name/NomkV : [BUS “busname_nominalKV”]
Label : [BUS “buslabel”]
Example usage(s) :
TSSaveTwoBusEquivalent("TwoBusTest.pwb",[Bus 2]);
TSCalculateSMIBEigenValues;
Calculate single machine infinite bus eigenvalues. Initialization to the start time is always done
before calculating eigenvalues.
To save out the SMIB results to a file, use the SaveData script function after the eigenvalues have
been calculated.
Example usage(s) :
TSCalculateSMIBEigenValues;
SaveData("C:\auxTest.aux", AUXDEF, PWTXGEN, [BusNum, BusName, GenID, AreaName,
TSGenMachineName, TSGenExciterName, TSGenGovernorName, TSGenStabilizerName,
TSEigenValueValid, TSNumEigenValue, TSNumEigenValueZero, TSEigenValueMax,
TSEigenValueMin, TSComplexEigenValue, TSComplexEigenValue:1, TSComplexEigenValue:2], []);
TSLoadGE("FileName", GENCCYN);
Loads transient stability data stored in the GE DYD format.
FileName : Name of the DYD file to load
GENCCYN : YES to split combined cycle units, NO to leave them alone
TSLoadPTI("FileName", "MCREfilename", "MTRLOfilename", "GNETfilename",
"BASEGENfilename");
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Loads transient stability data in the PTI format.
FileName : Name of the DYR file to load
MCREfilename : (optional) If not loading a MCRE file, specify “”
MTRLOfilename : (optional) If not loading a MTRLO file, specify “”
GNETfilename : (optional) If not loading a GNET file, specify “”
BASEGENfilename : (optional) If not loading a BASEGEN file, specify “”
TSLoadBPA("FileName");
Loads transient stability data stored in the BPA format.
FileName : Name of the BPA file to load
TSGetResults("FileName", Single/Separate, [Contingencies], [Plots, ObjectFields],
StartTime, EndTime]);
Use this to save out results for specific variables from plots, subplots, and object/field pairs after a
transient stability simulation has been run. If StartTime and StopTime are not specified, results for
the entire simulation time are obtained.
FileName : Name of the CSV result file to write out
Single/Separate : Determines whether the results are all saved in one file (Single) with name
“filename_Results.csv” or whether results for each transient contingency is saved in a separate
file (Separate) with name “filename_ctgname.csv.” A separate header file is also saved out, with
a name of “filename_Header.csv”.
Contingencies : A list of contingency names for which to save out results
Plots, ObjectFields : A list of plots and object/field pairs to save out for the specified
contingencies
StartTime : Start of the window of simulation time from which the results are to be retrieved
EndTime : End of the window of simulation time from which the results are to be retrieved
Example usage(s) :
TSGetResults("filename.csv", SEPARATE, [ctg test], ["Plot 'Gen_Rotor Angle", "Bus 4 |
frequency"]);
TSGetResults("filename.csv", SEPARATE, [test2, test3], ["Plot 'Gen_Rotor Angle'"], 0.0, 10.0);
TSGetResults("filename.csv", SEPARATE, ["test3", ctg test], ["Plot 'Gen_Rotor Angle'"], 0.0,
10.0);
TSGetResults("filename.csv", SINGLE, ["test2"], ["Plot 'Gen_Rotor Angle'"], 0.0, 10.0);
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Data Section
The Data Section of the script file format can contain numerous functions for modifying the data of a
power system case. The DATA section begins with a left curly brace and ends with a right curly brace.
DATA DataName (object_type, [list_of_fields], file_type_specifier, create_if_not_found)
{
data_list_1
.
.
.
data_list_n
}
Immediately following the DATA keyword, you may optionally include a DataName. By including the
DataName, you can make use of the script command LoadData("filename", DataName) to call this
particular data section from another auxiliary file.
The first line of the DATA section is referred to as the Data Argument List. The Data Argument List
defines the type and format of the data contained in the following section enclosed in curly braces.
Inside of each DATA section, data lists are given according to the data definition given in the Data
Argument List.
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Data Argument List
The DATA argument list identifies what the information section contains. A left and right parenthesis "(
)" mark the beginning and end of the argument list.
The file_type_specifier parameter distinguishes the information section as containing custom
auxiliary data (as opposed to Simulator’s native auxiliary formats), and indicates the format of the
data. Currently, the parser recognizes two values for file_type_specifier:
(blank) or AUXDEF
Data fields are space delimited
Data fields are comma delimited

CSV, AUXCSV, or CSVAUX

The create_if_not_found parameter allows the specification of whether or not one or more data
records that exist in the data section that do not link to existing data in the case be created when read
from the auxiliary file. The parameter is optional, and if omitted Simulator will prompt the user
regarding creating objects not found in the case from records in the data section. If the parameter is
specified as True, then objects not found will be created from the data records, and if False objects
not found will not be created from the data records. Data records for which objects already exist in the
model will be read and applied regardless of this parameter setting.
The object_type parameter identifies the type of object or data element the information section
describes or models. For example, if object_type equals BUS, then the data describes BUS objects.
Below is a list of many of the object types recognized by Simulator:
3WXFormer

DefDrawSuperArea

OPF_Options_and_Results

Area

DefDrawZone

OPFSolutionSummary

ATC_Options

Direction

Owner

ATCExtraMonitor

DynamicFormatting

PieSizeColorOptions

ATCGeneratorChange

Equiv_Options

PostPowerFlowActions

ATCInterfaceChange

ExportBidCurve

PTDF_Options

ATCLineChange

Filter

PVCurve_Options

ATCLineChangeB

GEMotor

PWCaseInformation

ATCScenario

Gen

PWFormOptions

ATCZoneChange

GeoDataViewStyle

PWLPOPFCTGViol

AuxFileExportFormatData

GlobalContingencyActions

PWLPTabRow

AuxFileExportFormatDisplay

GScenarioName

PWOPFTimePoint

BGCalculatedField

HintDefVAlues

PWPVResultListContainer

Branch

IG_AutoInsert_Options

QVCurve

Bus

ImportBidCurve

QVCurve_Options

BusGroupSwapRec

ImportExportBidCurve

RLScenarioName

BusNumberSwap

InjectionGroup

Scale_Options

BusViewFormOptions

Interface

Schedule

CaseInfo_Options

InterfaceAElement

ScreenLayer

ColorMap

InterfaceBElement

SelectByCriteriaSet

Contingency

IScenarioName

ShapefileExportDescription

Ctg_AutoInsert_Options

Limit_Monitoring_Options

ShortCut
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Ctg_Options

LimitCost

Shunt

CTGElementBlock

LimitSet

Sim_Environment_Options

CustomCaseInfo

Load

Sim_Misc_Options

CustomCaseInfoRow

LODF_Options

SimSimulation_Options

CustomColors

LPOPFMarginalControls

Sim_Solution_Options

CustomExpression

LPVariable

StudyMWTransactions

DataGrid

MessLog_Options

Substation

DCTransmissionLine

ModelCondition

SuperArea

DefDrawArea

ModelExpression

TLR_Options

DefDrawBackground

ModelFilter

TransferLimiter

DefDrawBus

MTDCRecord

Transformer

DefDrawGen

MultiSectionLine

TSSchedule

DefDrawInterface

MvarMarginalCostValues

UC_Options

DefDrawLineTransformer

MWMarginalCostValues

ViolationCTG

DefDrawLoad

MWTransaction

WhatOccurredDuringContingency

DefDrawShunt

Nomogram

XFCorrection

DefDrawSubstation

NomogramInterface

Zone

The list of object types Simulator’s auxiliary file parser can recognize will grow as new applications for
the technology are found. Within Simulator, you will always be able to obtain a list of the available
object_types by going to the Auxiliary Files ribbon group on the Window ribbon tab and choosing
Export Object Fields.
The list_of_fields parameter lists the types of values the ensuing records in the data section contain.
The order in which the fields are listed in list_of_fields dictates the order in which the fields will be
read from the file. Simulator currently recognizes over 3,000 different field types, each identified by a
specific field name. Because the available fields for an object may grow as new applications are
developed, you will always be able to obtain a list of the available object_types by going to the
Auxiliary Files ribbon group on the Window ribbon tab and choosing Export Object Fields.
Certainly, only a subset of these fields would be found in a typical custom auxiliary file. In crafting
applications to export custom auxiliary files, developers need concern themselves only the fields they
need to communicate between their applications and Simulator. A few points of interest regarding the
list_of_fields are:






The list_of_fields may take up several lines of the text file.
The list_of_fields should be encompased by braces [ ].
When encountering the PowerWorld comment string ‘//’ in one of these lines of the text file, all
text to the right of this is ignored.
Blank lines, or lines whose first characters are ‘//’ will be ignored as comments.
Field names must be separated by commas.

Example DATA Argument List
DATA (BUS, [BusNomKV, Bus, // comment here
ABCPhaseAngle: 1, ABCPhaseAngle: 2, ABCPhaseV, ABCPhaseV: 1,
// comments allowed here to
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// note that blank rows are ignored
AreaNum, BusAngle, BusB, BusCat, BusEquiv, BusG,
BusGenericSensV, BusKVVolt, BusLambda, BusLoadMVA, // more comment
BusLoadMW, BusLongName],True)
One general note regarding the field names however. Some field names may be augmented with a
field location. One example of this is the field LineMW. For a branch, there are two MW flows
associated with the line: one MW flow at the from bus, and one MW flow at the to bus. So that the
number of fields does not become huge, the same field name is used for both of these values. For the
from bus flow, we write LineMW: 0, and for the to bus flow, we write LineMW: 1. Note that fieldnames
such as LineMW: 0 may simply leave off the: 0.
The create_if_not_found field is optional. This specifies whether or not to create a new object if an
existing one is not found. If the value is YES, objects will be created. If the value is NO, objects will
not be created. If omitted, the default behavior of prompting the user about whether or not to create
a non-existing object will continue. If loading and auxiliary file using the LoadAux script command,
the create_if_not_found field for the data section will override the CreateIfNotFound field with
the script.
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Data Key Fields
Simulator uses certain fields to identify the specific object being described. These fields are called key
fields. For example, the key field for BUS objects is BusNum, because a bus can be identified uniquely
by its number. The key fields for GEN objects are BusNum and GenID. To properly identify each
object, the object’s key fields must be present. They can appear in any order in the list_of_fields
(i.e. they need not be the first fields listed in list_of_fields). As long as the key fields are present,
Simulator can identify the specific object. By going to the Auxiliary Files ribbon group on the Window
ribbon tab and choosing Export Case Object Fields you will obtain a list of fields available for each
object type. In this output, the key fields will appear with asterisks *.
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Data List
After the data argument list is completed, the Data list is given. The data section lists the values of the
fields for each object in the order specified in list_of_fields. The data section begins with a left curly
brace and ends with a right curly brace. A few points of interest regarding the value_list:










The value_list may take up several lines of the text file.
Each new data object must start on its own line of text.
When encountering the PowerWorld comment string ‘//’ in one of these lines of the text file, all
text to the right of this is ignored.
Blank lines, or lines whose first characters are ‘//’ will be ignored as comments.
Remember that the right curly brace must appear on its own line at the end of the data_list.
If the file_type_specifier is CSV, the values should be separated by commas. Otherwise,
separate the field names using spaces.
Strings can be enclosed in double quotes, but this is not required. You should however always
enclose strings that contain spaces (or commas) in quotes. Otherwise, strings containing commas
would cause errors for comma-delimited files, and spaces would cause errors for space-delimited
formatted files.
A string in the format &[ModelExpressionName]:[#digits]:[#decimals] will be treated as though
the value of the named model expression is entered in the field, with [#digits] total and
[#decimals] digits to the right of the decimal point. This format may be used in case information
displays as well as in AUX files.
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Data SubData Sections
The format described in the Data Section works well for most kinds of data in Simulator. It does not
work as well however for data that stores a list of objects. For example, a contingency stores some
information about itself (such as its name), and then a list of contingency elements, and possible a list
of limit violations as well. For data such as this, Simulator allows <SubData>, </SubData> tags that
store lists of information about a particular object. This formatting looks like the following:
DATA (object_type, [list_of_fields], file_type_specifier)
{
value_list_1
<SUBDATA subobject_type1>
precise format describing an object_type1
precise format describing an object_type1
.
.
.
</SUBDATA>
<SUBDATA subobject_type2>
precise format describing an object_type2
precise format describing an object_type2
.
.
.
</SUBDATA>
value_list_2
.
.
.
value_list_n
}
Note that the information contained inside the <SubData>, </SubData> tags may not be flexibly
defined. It must be written in a precisely defined order that will be documented for each SubData
type.
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Data ATC_Options
RLScenarioName
GScenarioName
IScenarioName
These three sections contain the pretty names of the RL Scenarios, G Scenarios, and I Scenarios.
Each line consists of two values: Scenario Number and a name string enclosed in quotes.
Scenario Number: The scenarios are number 0 through the number of scenarios minus 1.
Scenario Name: These represent the names of the various scenarios.
Example:
<SUBDATA RLScenarioName>
//Index Name
0 "Scenario Name 0"
1 "Scenario Name 1"
</SUBDATA>
ATCMemo
This section contains the memo text for the ATC analysis.
Example:
<SUBDATA ATCMemo>
//Memo
"Comments for the ATC analysis"
</SUBDATA>
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Data ATCExtraMonitor
ATCFlowValue
This subdata section contains a list of a flow values for specified transfer levels. Each line consists of
two values: Flow Value (flow on the monitored element) and a Transfer Level (in MW).
Flow Value: Contains a string describing which monitor this belongs to.
Transfer Level: Contains the value for this extra monitor at the last linear iteration.
Example:
<SUBDATA ATCFlowValue>
//MWFlow TransferLevel
94.05 55.30
105.18 80.58
109.02 107.76
</SUBDATA>
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Data ATCScenario
TransferLimiter
This subdata section contains a list of the TransferLimiters for this scenario. Each line contains fields
relating one of the Transferlimiters. The fields are writen out in the following order:
Limiting Element: Contains a description of the limiting element. The possible values are
"PowerFlow Divergence"
"AREA num"
"SUPERAREA name"
"ZONE num"
"BRANCH num1 num2 ckt"
"INJECTIONGROUP name"
"INTERFACE name"
Limiting Contingency: The name of the limiting contingency. If blank, then this means it’s a
limitation in the base case.
MaxFlow: The transfer limitation in MW.
PTDF: The PTDF on the limiting element in the base case (not in percent).
OTDF: The OTDF on the limiting element under the limiting contingency.
LimitUsed: The limit which was used to determine the MaxFlow in per unit.
PreTransEst: The estimated flow on the line after the contingency but before the transfer in
per unit.
MaxFlowAtLastIteration: The total transfer at the last iteration in per unit.
IterativelyFound: Either YES or NO depending on whether it was iteratively determined.
Example:
<SUBDATA TransferLimiter >
"BRANCH 40767 42103 1" "Contin" 2.84 -0.0771 -0.3883 -4.35 -4.35 -0.01 "-55.88" YES
"BRANCH 42100 42321 1" "Contin" 4.42 0.1078 0.5466 6.50 5.64 1.57 " 22.59" NO
"BRANCH 42168 42174 1" "Contin" 7.45 -0.0131 -0.0651 -1.39 -1.09 4.60 "-33.31" NO
"BRANCH 42168 42170 1" "Contin" 8.54 0.0131 0.0651 1.39 1.02 5.69 " 26.10" NO
"BRANCH 41004 49963 1" "Contin" 9.17 -0.0500 -0.1940 -4.39 -3.16 6.32 " 68.73" NO
"BRANCH 46403 49963 1" "Contin" 9.53 0.0500 0.1940 4.46 3.16 6.68 "-68.68" NO
"BRANCH 42163 42170 1" "Contin" 10.14 -0.0131 -0.0651 -1.39 -0.92 7.29 "-15.58" NO
</SUBDATA>
ATCExtraMonitor
This subdata section contains a list of the ATCExtraMonitors for this scenario. Each line contains
three fields relating one of the ATCExtraMonitors. The first field describes the ATCExtraMonitor
which this subdata corresponds to. The second and third variables are the initial value and sensitivity
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for this extra monitor for the scenario. An option fourth field may be included if we are using one of
the iterated ATC solution options. This field must be the String "ATCFlowValue".
Monitor Description: Contains a string describing which monitor this belongs to.
Initial Value: Contains the value for this extra monitor at the last linear iteration.
Sensitivity: Contains the sensitivity of this monitor.
ATCFlowValue: A string which signifies that a block will follow which stores a list of flow values
for specified transfer levels. Each line of the block consists of two values: Flow Value (flow on the
monitored element) and a Transfer Level (in MW). The block is terminated when a line of text
that starts with ‘END’ is encountered.
Example:
<SUBDATA ATCExtraMonitor>
"Interface<KEY1>Left-Right</KEY1>" 40.0735 0.633295
"Branch<KEY1>2</KEY1><KEY2>5</KEY2><KEY3>1</KEY3>" 78.7410 0.266589
</SUBDATA>

553
©2011 PowerWorld Corporation

Data AuxFileExportFormatData
DataBlockDescription
This subdata section is used to define the objects that should be included in an auxiliary file along
with their fields, subdata sections, and any filter used to specify which objects should be included.
Each line contains the following:
ObjectType: Name of the object to include in the auxiliary file.
[FieldList]: List of fields to include. Must be enclosed in brackets. This list can either be spacedelimited or comma-delimited.
[SubdataList]: List of subdata sections to include. This list must be enclosed in brackets and
can be either space-delimited or comma-delimited. Include empty brackets to not include
subdata or for objects that do not have any subdata sections.
"Filter": Description of the filter to use for determining which objects to include. This must be
enclosed in double quotes. If no filter is to be used, empty double quotes should be included.
Valid entries are: "", "filtername", "AREAZONE", and "SELECTED".
Example:
<SUBDATA DataBlockDescription>
// ObjectType [FieldList] [SubdataList] "Filter"
Area [AreaName, AreaNum] [] "SELECTED"
Gen [BusNum, BusName, GenID] [BidCurve, ReactiveCapability] ""
</SUBDATA>
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Data AuxFileExportFormatDisplay
DataBlockDescription
This subdata section is used to define the objects that should be included in an auxiliary file along
with their fields, subdata sections, and any filter used to specify which objects should be included.
Each line contains the following:
ObjectType: Name of the object to include in the auxiliary file.
[FieldList]: List of fields to include. Must be enclosed in brackets. This list can either be spacedelimited or comma-delimited.
[SubdataList]: List of subdata sections to include. This list must be enclosed in brackets and
can be either space-delimited or comma-delimited. Include empty brackets to not include
subdata or for objects that do not have any subdata sections.
"Filter": Description of the filter to use for determining which objects to include. This must be
enclosed in double quotes. If no filter is to be used, empty double quotes should be included.
Valid entries are: "", "filtername", "AREAZONE", and "SELECTED".
Example:
<SUBDATA DataBlockDescription>
// ObjectType [FieldList] [SubdataList] "Filter"
DisplayArea [AreaName, AreaNum, SOAuxiliaryID] [] ""
DisplayTransmissionLine [BusNum, BusNum:1, LineCircuit, SOAuxiliaryID] [Line] "Nominal
Voltage > 138 kV"
</SUBDATA>
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Data BGCalculatedField
Condition
Calculated Fields allow you to define a calculation over most network and aggregation objects along
with a few other types of objects. The calculation can then be used to show an aggregation
calculation on objects that link to these calculation objects in some manner. Part of the definition is
a filter which specifies which objects to operate over. This subdata section is identical to the
Condition subdata section of the Filter object type.
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Data Bus
MWMarginalCostValues
MvarMarginalCostValues
LPOPFMarginalControls
These three sections contain specific values computed for an OPF solution. In
MWMarginalCostValues or MvarMarginalCostValues these specific values are the MW or Mvar
marginal prices for each constraint. In LPOPFMarginalControls the values are the sensitivities of the
controls with respect to the cost of each bus.
Example:
<SUBDATA MWMarginalCostValues>
//Value
16.53
0.00
21.80
</SUBDATA>
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Data BusViewFormOptions
BusViewBusField
BusViewFarBusField
BusViewGenField
BusViewLineField
BusViewLoadField
BusViewShuntField
The values represent specific fields on the custom defined bus view onelines. Each line contains two
values:
Location : The various locations on the customized bus view contain slots for fields. This is the
slot number.
FieldDescription : This is a string enclosed in double quotes. The string itself is delimited by
the @ character. The string contains five values:
Name of Field: The name of the field. Special fields that appear
on dialog by default have special names.
Otherwise these are the same as the
fieldnames of the AUX file format (for the
"other fields" feature on the dialogs).
Total Digit: Number of total digits for a numeric field.
Decimal Points: Number of decimal points for a numeric field.
Color: This is the color of the field. It is not presently used.
Increment Value: This is the "delta per mouse" click for the
field.
Example:
<SUBDATA BusViewLineField>
0 "MW Flow@6@1@0@0"
1 "MVar Flow@6@1@0@0"
2 "MVA Flow@6@1@0@0"
3 "BusAngle:1@6@2@0@0"
</SUBDATA>
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Data ColorMap
ColorPoint
A colorpoint is simply described by a real number (between 0 and 100) indicating the percentage
breakpoint, an integer describing the color, and a field indicating if the color should be used or the
contour should be transparent. These three values are written on a single line of text. Each line
contains three values:
cmvalue: Real number between 0 and 100 (minimum to maximum value).
cmcolor: Integer between 0 and 16,777,216. Value is determined by taking the red, green and
blue components of the color and assigning them a value between 0 and 255. The color is then
equal to red + 256*green + 256*256*blue.
cmalpha: Integer between 0 and 255, where only 0 and 255 are valid values. A value of 0
indicates that the color point is transparent, while a value of 255 indicates that the color point is
opaque. If the alpha channel is omitted, a default value of 255 (opaque) will be assigned.
Example:
<SUBDATA ColorPoint>
// Value Color Alpha
100.0000 127 255
62.5000 65535 255
50.0000 8388479 0
12.5000 16711680 0
0.0000 8323072 255
</SUBDATA>
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Data Contingency
CTGElementAppend
The format for this data type is the same as described below for CTGElement, with the exception
that the elements listed in this data section will be added to the existing list of contingency
elements, instead of replace the existing elements.
CTGElement
A contingency element is described by up to four entries. All entries must be on a single line of text.
"Action" "ModelCriteria" Status //comment
Action: String describing the action associated with this element. See below for actions
available.
ModelCriteria: This is the name of a ModelFilter or ModelCondition under which this action
should be performed. This entry is optional. If it is not specified, then a blank (or no criteria) is
assumed. If you want to enter a Status, then use must specify "" as the ModelCriteria.
Status: Three options
CHECK: perform action if ModelCriteria is true.
ALWAYS: perform action regardless of ModelCriteria.
NEVER: do not perform action.
This entry is optional. If it is not specified, then CHECK is assumed.
Comment: All text to the right of the comment symbol (//) will be saved with the CTGElement
as a comment.
Possible Actions:
Calling of a name ContingencyBlock
CONTINGENCYBLOCK | name
Calls a ContingencyBlock and executes each of the actions in that block.
Transmission Line or Transformer outage or insertion
BRANCH | bus1# bus2# ckt | OPEN
| CLOSE
| OPENCBS
| CLOSECBS
Takes branch out of service, or puts it in service. For more description of the OpenCBS
action type see the Open Breakers topic. For more information on how the CloseCBS
action works see the Close Breakers Overview topic. Note: bus# values may be replaced
by a string enclosed in single quotes where the string is the name of the bus followed by
an underscore character and then the nominal voltage of the bus. These values may also
be replaced by a string enclosed in single quotes which represents the label of the bus.
Also, the entire sequence [bus1# bus2# ckt] may be replaced by the label of the branch.
Series Capacitor Bypass or In Service
SERIESCAP | bus1# bus2# ckt | BYPASS
| INSERVICE
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Bypasses a series capacitor, or puts it in service. Note: bus# values may be replaced by a
string enclosed in single quotes where the string is the name of the bus followed by an
underscore character and then the nominal voltage of the bus. These values may also be
replaced by a string enclosed in single quotes which represents the label of the bus. Also,
the entire sequence [bus1# bus2# ckt] may be replaced by the label of the branch.
DC Transmission Line outage or insertion
DCLine | bus1# bus2# ckt | OPEN
| CLOSE
| OPENCBS
| CLOSECBS
Takes DC Line out of service, or puts it in service. For more description of the OpenCBS
action type see the Open Breakers topic. For more information on how the CloseCBS action
works see the Close Breakers Overview topic. Note: bus# values may be replaced by a
string enclosed in single quotes where the string is the name of the bus followed by an
underscore character and then the nominal voltage of the bus. These values may also be
replaced by a string enclosed in single quotes which represents the label of the bus. Also,
the entire sequence [bus1# bus2# ckt] may be replaced by the label of the dc transmission
line.
DC Line set a specific value
DCLINE | bus1# bus2# ckt | SET_P_TO | value | MW
| | CHANGE_P_BY | | PERCENT
| | SET_I_TO | | AMPS
| | CHANGE_I_BY
Use to set the DC line setpoint to a particular value. Note: bus# values may be replaced
by a string enclosed in single quotes where the string is the name of the bus followed by
an underscore character and then the nominal voltage of the bus. These values may also
be replaced by a string enclosed in single quotes which represents the label of the bus.
Also, the entire sequence [bus1# bus2# ckt] may be replaced by the label of the dc
transmission line.
Phase Shifter set a specific value
PHASESHIFTER | bus1# bus2# ckt | SET_P_TO | value | MW
| | CHANGE_P_BY | | PERCENT
Use to set the phase shift angle to a particular value. Note: bus# values may be replaced
by a string enclosed in single quotes where the string is the name of the bus followed by
an underscore character and then the nominal voltage of the bus. These values may also
be replaced by a string enclosed in single quotes which represents the label of the bus.
Also, the entire sequence [bus1# bus2# ckt] may be replaced by the label of the branch.
3-Winding Transformer outage or insertion
3WXFORMER | bus1# bus2# bus3# ckt | OPEN
| CLOSE
| OPENCBS
| CLOSECBS
Takes all three windings of a 3-winding transformer out of service, or puts them in
service. For more description of the OpenCBS action type see the Open Breakers topic.
For more information on how the CloseCBS action works see the Close Breakers
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Overview topic. Note: bus# values may be replaced by a string enclosed in single quotes
where the string is the name of the bus followed by an underscore character and then
the nominal voltage of the bus. These values may also be replaced by a string enclosed
in single quotes which represents the label of the bus. Also, the entire sequence [bus1#
bus2# bus3# ckt] may be replaced by the label of the three winding transformer.
Interface outage or insertion
INTERFACE | name | OPEN
| CLOSE
| OPENCBS
| CLOSECBS
Takes all monitored branches in the interface out of service, or puts them all in service.
For more description of the OpenCBS action type see the Open Breakers topic. For more
information on how the CloseCBS action works see the Close Breakers Overview topic.
Note: the [name] may be replaced by the label of the interface.
Bus outage causes all lines connected to the bus to be outage
BUS | bus# | OPEN
| OPENCBS
Takes all branches connected to the bus out of service. Also outages all generation, load,
or shunts attached to the bus. For more description of the OpenCBS action type see the
Open Breakers topic. Note: bus# values may replaced by a string enclosed in single
quotes where the string is the name of the bus followed by an underscore character and
then the nominal voltage of the bus. These values may also be replaced by a string
enclosed in single quotes which represents the label of the bus.
Generator, Load, or Switched Shunt outage or insertion
GEN | bus# id | OPEN
LOAD | bus# id | CLOSE
SHUNT | bus# id | OPENCBS
| | CLOSECBS
INJECTIONGROUP | name
Takes a generator, load, or shunt out of service, or puts it in service. If specifying an
injection group, the status of all devices in the injection group will be changed. For more
description of the OpenCBS action type see the Open Breakers topic. For more
information on how the CloseCBS action works see the Close Breakers Overview topic.
Note: bus# values may be replaced by a string enclosed in single quotes where the
string is the name of the bus followed by an underscore character and then the nominal
voltage of the bus. These values may also be replaced by a string enclosed in single
quotes which represents the label of the bus. Also, the sequence [bus1# ckt] or [name]
may be replaced by the label of the device.
Generator, Load or Switched Shunt movement to another bus
GEN | bus1# | MOVE_PQ_TO | bus2# | value | MW
LOAD | bus1# id | MOVE_P_TO | | MVAR
SHUNT | | MOVE_Q_TO | PERCENT
Use to move generation, load or shunt at a bus1 over to bus2. This can be used on a bus
or specific device basis in specifying what to move. Note: bus# values may be replaced
by a string enclosed in single quotes where the string is the name of the bus followed by
an underscore character and then the nominal voltage of the bus. These values may also
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be replaced by a string enclosed in single quotes which represents the label of the bus.
When identifying specific devices, the device label can replace the bus number and
device id.
Generator, Load or Switched Shunt set or change a specific value
GEN | bus# | SET_P_TO | value | MW
LOAD | bus# id | SET_Q_TO | | MVAR
SHUNT | | SET_PQ_TO | PERCENT
| SET_VOLT_TO |
| CHANGE_P_BY |
| CHANGE_Q_BY |
| CHANGE_PQ_BY |
| CHANGE_VOLT_BY |
Use to set the generation, load, or shunt at a bus to a particular value. This can also be
used on a specific device. This can also be used to change by a specified amount. The
voltage setpoints only apply to SHUNTs and GENs. Note: bus# values may be replaced
by a string enclosed in single quotes where the string is the name of the bus followed by
an underscore character and then the nominal voltage of the bus. These values may also
be replaced by a string enclosed in single quotes which represents the label of the bus.
When identifying specific devices, the device label can replace the bus number and
device id.
Injection Group set a specific value
INJECTIONGROUP | name | SET_P_TO | value | MW
| PERCENT
Use to set the MW generation/load in an injection group to a particular value.
Injection Group change specific value
INJECTIONGROUP | name | CHANGE_P_TO | value | MW
| PERCENT
| MWMERITORDER
| PERCENTMERITORDER
| MWMERITORDEROPEN
| PERCENTMERITORDEROPEN
Use to change the MW generation/load in an injection group by a particular value.
MW and PERCENT : will change each point in the injection group by a value in proportion
to the participation factors of the group.
MWMERITORDER and PERCENTMERITORDER : will modify only generators points in the
injection group. Generators will be adjusted in order of highest relative participation
factor to lowest with each generator in the list being adjusted until it hits either its
maximum or minimum MW limit before moving on to the next generator. This process
continues until the desired injection is met. Generators will not be opened in the process
so all generators will continue to provide Mvar support.
MWMERITORDEROPEN and PERCENTMERITORDEROPEN : will modify only generator
points in the injection group. When chosen and the change in the MW output is negative,
then the merit order dispatch will be modified. In this case, the generator in the injection
group with the highest participation factor will have its status changed to Open, followed
by the second generator and so on. This will continue until the amount of MW opened is
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as close to the desired amount without exceeding the desired amount of drop. If a
generator would cause the desired gen drop amount to be exceeded, that generator is
skipped and the next generator in merit order is processed. If the change requested is
positive, then generators will be increased toward their maximum MW output in the
same manner as though this option were not chosen.
Note: the [name] may be replaced by the label of the injection group.
Execute a Power Flow Solution
SOLVEPOWERFLOW
Include this action to cause the solution of the contingency to be split into pieces.
Actions that are listed before each SOLVEPOWERFLOW call will be performed as a group.
Make-Up Power Compensation.
Only valid immediately following a SET, CHANGE, OPEN or CLOSE action on a Generator,
Shunt or Load. This describes how the change in MW or MVAR are picked up by buses
throughout the system. The values specify participation factors
COMPENSATION
bus#1 value1
bus#2 value2
...
END
Example:
<SUBDATA CTGElement>
// just some comments
// action

Model Criteria

Status

comment

"BRANCH
40821 40869 1
OPEN"

""

ALWAYS

//Raver - Paul
500 kV

"GEN 45041 1
OPEN"

""

ALWAYS

//Trip Unit #2

"BRANCH
42702 42727 1
OPEN"

"Line X Limited"

CHECK

//Open Fern
Hill

"GEN 40221 1
OPEN"

"Interface L1"

CHECK

//Drop ~600
MW

"GEN 40227 1
OPEN"

"Interface L2"

CHECK

//Drop ~1200
MW

"GEN 40221 1
OPEN"

"Interface L3"

CHECK

//Drop ~600
MW

"GEN 40227 1
OPEN"

"Interface L3+"

CHECK

//Drop ~1200
MW

</SUBDATA>
Note: ContingencyElement object types can also be created inside their own DATA section as well.
One of the key fields of the object is then the name of the contingency to which the
ContingencyElement belongs.
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LimitViol
A LimitViol is used to describe the results of a contingency analysis run. Each Limit Violation lists
eight values:
ViolType ViolElement Limit ViolValue PTDF PTDF InitialValue Reason
ViolType: One of six values describing the type of violation
BAMP: branch amp limit violation
BMVA: branch MVA limit violation
VLOW: bus low voltage limit violation
VHIGH: bus high voltage limit violation
INTER: interface MW limit violation
CUSTOM: Custom Monitor value
ViolElement: This field depends on the ViolType.
for VLOW, VHIGH: "bus1#" or "busname_buskv" or "buslabel"
for INTER: "interfacename" or "interfacelabel"
for BAMP, BMVA: "bus1# bus2# ckt violationbus# MWFlowDirection"
violationbus# is the bus number for the end of the branch which is violated
MWFlowDirection is the direction of the MW flow on the line. Potential values are "FROMTO"
or "TOFROM"
Note: each bus# may be replaced with the name underscore nominal kV string enclosed in
single quotes, or bus# values may be replaced by a string enclosed in single quotes
representing the label of the bus. Also, the entire sequence [bus1# bus2# ckt] may be
replaced by the label of the branch.
for CUSTOM: "custommonitorname deviceidentifier" where the deviceidentifier will use the key
fields or label as specified by the option selected when saving
Limit: This is the numerical limit which was violated.
ViolValue: This is the numerical value of the violation.
PTDF: This field is optional. It only makes sense for interface or branch violations. It stores a
sensitivity of the flow on the violating element during in the base case with respect to a transfer
direction This must be calculated using the Contingency Analysis Other Actions related to
Sensitivities.
OTDF: This field is optional. It only makes sense for interface or branch violations. It stores a
sensitivity of the flow on the violating element during this contingency with respect to a transfer
direction. This must be calculated using the Contingency Analysis Other Actions related to
Sensitivities.
InitialValue: This stores a number. This stores the base case value for the element which is
being violated. This is used to compare against when looking at change violations.
Reason: This will say whether this was a pure violation or is being reported as a violation
because the change from the base case is higher than a specified threshold.
LIMIT - means this is a violation of a line/interface/bus limit or simply a Custom Monitor
CHANGE - means this is being reported as a limit because the change from the initial value is
higher than allowed
Example:
<SUBDATA LimitViol>
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BAMP "1 3 1 1 FROMTO" 271.94031 398.48096 10.0 15.01 // Note OTDF/PTDF
INTER "Right-Top" 45.00000 85.84451 // Note OTDF/PTDF not included
</SUBDATA>
Note: ViolationCTG object types can also be directly created inside their own DATA section as well.
One of the key fields of the object is then the name of the contingency to which the ViolationCTG
belongs.
Sim_Solution_Options
These describe the power flow solution options which should be used under this particular
contingency. The format of the subdata section is two lines of text. The first line is a list of the
fieldtypes for Sim_Solution_Options which should be changed. The second line is a list of the values.
Note that in general, power flow solution options are stored at three different locations in
contingency analysis. When implementing a contingency, Simulator gives precendence to these
three locations in the following order:
1.
2.
3.

Contingency Record Options (stored with the particular contingency)
Contingency Tool Options (stored with CTG_Options)
The global solution options

WhatOccurredDuringContingency
Each line of this subdata section is part of a text description of what actually ended up being
implemented for this contingency. This will list which actions were executed and which actions
ended up being skipped because of their model criteria. Each line of the subdata section must be
enclosed in quotes.
Example:
<SUBDATA WhatOccurredDuringContingency>
"Applied: "
" OPEN Branch Two (2) TO Five (5) CKT 1 | | CHECK | | ELEMENT"
</SUBDATA>
ContingencyMonitoringException
Each line of this subdata section contains a string identifying a specially handled monitored element
for this contingency followed by a string indicating how this monitored element should be handled
with this contingency. The elements can be identified by their primary or secondary key fields or by
label. The element descriptions should be enclosed in quotes because they contain spaces.
Example:
<SUBDATA ContingencyMonitoringException>
"Branch '2' '3' '1'" "Exclude"
"Branch 'Three_138.00' 'Four_138.00'" "Include"
"Branch 'Line_2_5'" "Default"
</SUBDATA>
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Data CTG Options
Sim_Solution_Options
These describe the power flow solution options which should be used under this particular
contingency. The format of the subdata section is two lines of text. The first line is a list of the
fieldtypes for Sim_Solution_Options which should be changed. The second line is a list of the values.
Note that in general, power flow solution options are stored at three different locations in
contingency analysis. When implementing a contingency, Simulator gives precendence to these
three locations in the following order:




Contingency Record Options (stored with the particular contingency)
Contingency Tool Options (stored with CTG_Options)
The global solution options
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Data CTGElementBlock
CTGElement
This format is the same as for the Contingency objecttype, however, you can not call a
ContingencyBlock from within a contingencyblock.
CTGElementAppend
When a subdata section is defined as CTGElementAppend rather than CTGElement, the actions
of this subdata section will be appended to the contingency actions, instead of replacing them. This
format is the same as for the Contingency objecttype, however, you can not call a ContingencyBlock
from within a contingencyblock.
Note: CTGElementBlockElement object types can also be directly created inside their own
DATA section as well. One of the key fields of the object is then the name of the contingency block
to which the CTGElementBlockElement belongs.
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Data CustomCaseInfo
ColumnInfo
Each line of this SUBDATA section can be used for specifying the column width of particular columns
of the respective Custom Case Information Sheet. The line contains two values – the column and
then a column width. This is shown in the following example.
Example:
<SUBDATA ColumnInfo>
"SheetCol" 133
"SheetCol:1" 150
"SheetCol:2" 50
</SUBDATA>
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Data CustomColors
CustomColors
These describe the customized colors used in Simulator, which are specified by the user. A custom
color is an integer describing a color. Each custom color is written on a single line of text and is an
integer between 0 and 16,777,216. The value is determined by taking the red, green, and blue
components of the color and assigning them a value between 0 and 255. The color is then equal to
red + 256*green + 256*256*blue. Each line contains only one integer that corresponds to the color
specified.
Example:
<SUBDATA CustomColors>
9823301
8613240
</SUBDATA>
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Data DataGrid
ColumnInfo
Contains a description of the columns which are shown in the respective data grid. Each line of text
contains four fields: VariableName, ColumnWidth, TotalDigits, DecimalPoints
Variablename: Contains the variable which is shown in this column.
ColumnWidth: The column width.
TotalDigits: The total digits displayed for numerical values.
DecimalPoints: The decimal points shown for numerical values.
Example:
DATA (DataGrid, [DataGridName])
{
BUS
<SUBDATA COLUMNINFO>
BusNomVolt 100 8 2
AreaNum 50 8 2
ZoneNum 50 8 2
</SUBDATA>
BRANCHRUN
<subdata COLUMNINFO >
BusNomVolt: 0 100 8 2
BusNomVolt: 1 100 8 2
LineMW: 0 100 9 3
</SUBDATA>
}

571
©2011 PowerWorld Corporation

Data DynamicFormatting
DynamicFormattingContextObject
This subdata section contains a list of the display object types which are chosen to be selected. Each
line of the section consists of the following:
DisplayObjectType: The object type of the display object. These are generally the same as the
values seen in the subdata section SelectByCriteriaSetType of
SelectByCriteriaSet object types. The only exception is the string
CaseInfo, which is used for formatting applying to the case
information displays.
(WhichFields) : For display objects that can reference different fields, this sets which of those
fields it should select (e.g. select only Bus Name Fields). The value
may be either ALL or SPECIFIED.
(ListOfFields) : If WhichFields is set to SPECIFIED, then a delimited list of fields follows.
Example:
<SUBDATA DynamicFormattingContextObject>
// Note: CaseInfo applies to case information displays
CaseInfo "SPECIFIED" BusName
DisplayAreaField "ALL"
DisplayBus
DisplayBusField "SPECIFIED" BusName BusPUVolt BusNum
DisplayCircuitBreaker
DisplaySubstation
DisplaySubstationField "SPECIFIED" SubName SubNum BusNomVolt BGLoadMVR
DisplayTransmissionLine
DisplayTransmissionLineField "ALL"
</SUBDATA>
LineThicknessLookupMap
LineColorLookupMap
FillColorLookupMap
FontColorLookupMap
FontSizeLookupMap
BlinkColorLookupMap
XoutColorLookupMap
FlowColorLookupMap
SecondaryFlowColorLookupMap
The values of the lookup table for the characteristics that can be modified by the dynamic formatting
tool. The first line contains the two following fields:
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fieldname: It is the field that the lookup table is going to look for.
usediscrete: Set to YES or NO. If set to YES, the characteristic values will be discrete, meaning
that the characteristic value will correspond exactly to the one specified in the table. If set to NO,
the characteristic values will be continuous, which means the characteristic value will be an
interpolation of the high and low closest values specified in the table.
The following lines contain two fields:
fieldvalue: The value for the field.
characteristicvalue: The corresponding characteristic value for such field value.
Example:
<SUBDATA LineColorLookupMap>
// FieldName UseDiscrete
BusPUVolt YES
// FieldValue Color
1.02 16711808
1.05 8454143
1.1 16744703
</SUBDATA>
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Data Filter
Condition
Conditions store the conditions of the filter. Each condition is described by one line of text which can
contain up to five fields.
Variablename condition "value" ("othervalue") (fieldopt)
Variablename: It is one of the fields for the object_type specified. It may optional be followed
by a colon and a non-negative integer. If not specified, 0 is assumed.
Example: on a LINE, 0 = from bus, 1 = to bus
Thus: LineMW: 0 = the MW flow leaving the from bus
LineMW: 1 = the MW flow leaving the to bus
Condition: Possible Values Alternate1 Alternate2 Requirements
between >< requires other value
notbetween ~>< requires other value
equal = ==
notequal <> ~=
greaterthan >
lessthan <
greaterthanorequal >=
lessthanorequal <=
contains
notcontains
startswith
notstartswith
inrange
notinrange
meets
notmeets
isblank
notisblank
value: The value to compare to.
For fields associated with strings, this must be a string
For fields associated with real numbers, this must be a number.
For fields associated with integers, this is normally an integer, except when the Condition is
"inrange" or "notinrange". In this case, value is a comma/dash
separated number string.
(othervalue): If required, the other value to compare to.
(FieldOpt): Optional integer value with following meanings.
0 - strings are case insensitive, use number fields directly
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(0 is the default value if not otherwise specified)
1 - strings are case sensitive, take ABS of field values
Example:
DATA (FILTER, [objecttype, filtername, filterlogic, filterpre])
{
BUS "a bus filter" "AND" "no"
<SUBDATA CONDITION>
BusNomVolt > 100
AreaNum inrange "1-5 , 7 , 90-95"
ZoneNum between
</SUBDATA>
BRANCH "a branch filter" "OR" "no"
<subdata CONDITION>
BusNomVolt: 0 > 100 // Note location 0 means from bus
BusNomVolt: 1 > 100 // Note location 1 means to bus
LineMW: 0 > 100 1 // Note, final field 1 denotes absolute value
</SUBDATA>
}
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Data Gen
BidCurve
BidCurve subdata is used to define a piece-wise linear cost curve (or a bid curve). Each bid point
consists of two real numbers on a single line of text: a MW output and then the respective bid (or
marginal cost).
Example:
<SUBDATA BidCurve>
// MW Price[$/MWhr]
100.00 10.6
200.00 12.4
400.00 15.7
500.00 16.0
</SUBDATA>
ReactiveCapability
Reactive Capability subdata is used to the reactive capability curve of the generator. Each line of text
consists of three real numbers: a MW output, and then the respective Minimum MVAR and Maximum
MVAR output.
Example:
<SUBDATA ReactiveCapability>
// MW MinMVAR MaxMVAR
100.00 -60.00 60.00
200.00 -50.00 50.00
400.00 -30.00 20.00
500.00 -5.00 2.00
</SUBDATA>
Note: ReactiveCapability object types can also be directly created inside their own DATA section as
well. Two of the key fields of the object are then the bus number and generator ID of the generator
to which the ReactiveCapability point belongs.
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Data GeoDataViewStyle
TotalAreaValueMap
This subdata section is used to define the lookup table for determining the total area size of
geographic data view objects based on the value of a selected field. Two values are entered for each
mapping:
FieldValue: Value of the field selected for the Total Area attribute.
TotalArea: The total area size of the object.
Example:
<SUBDATA TotalAreaValueMap>
// FieldValue TotalArea
1.000 0
4.000 23
7.000 46
</SUBDATA>
RotationRateValueMap
This subdata section is used to define the lookup table for determining the rotation rate of
geographic data view objects based on the value of a selected field. Two values are entered for each
mapping:
FieldValue: Value of the field selected for the Rotation Rate attribute.
RotationRate: The rotation rate of the object. Entered in Hz.
Example:
<SUBDATA RotationRateValueMap>
// FieldValue RotationRate
1.000 0.00
4.000 0.10
7.000 0.20
</SUBDATA>
RotationAngleValueMap
This subdata section is used to define the lookup table for determining the rotation angle of
geographic data view objects based on the value of a selected field. Two values are entered for each
mapping:
FieldValue: Value of the field selected for the Rotation Angle attribute.
RotationAngle: The rotation angle of the object. Entered in degrees.
Example:
<SUBDATA RotationAngleValueMap>
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// FieldValue RotationAngle
1.000 -90.0
4.000 0.0
7.000 90.0
</SUBDATA>
LineThicknessValueMap
This subdata section is used to define the lookup table for determining the thickness of the border
line around geographic data view objects based on the value of a selected field. Two values are
entered for each mapping:
FieldValue: Value of the field selected for the Line Thickness attribute.
LineThickness: The line thickness of the border line around the object. This should be an
integer value.
Example:
<SUBDATA LineThicknessValueMap>
// FieldValue LineThickness
1.000 1
4.000 2
7.000 3
</SUBDATA>
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Data GlobalContingencyActions
CTGElementAppend
This format is the same as for the Contingency objecttype
CTGElement
This format is the same as for the Contingency objecttype
Note: GlobalContingencyActionsElement object types can also be directly created inside their own
DATA section as well.
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Data HintDefValues
HintObject
Stores the values for the custom hints. Each line has one value:
FieldDescription: This is a string enclosed in double quotes. The string itself is delimited by the
@ character. The string contains five values:
Name of Field: The name of the field. Special fields that appear on dialog by default have
special names. Otherwise these are the same as the fieldnames of the AUX file format (for the
"other fields" feature on the dialogs).
Total Digit: Number of total digits for a numeric field.
Decimal Points: Number of decimal points for a numeric field.
Include Suffix: Set to 0 for not including the suffix, and set to 1 to include it.
Field Preffix: The prefix text.
Example:
<SUBDATA HintObject>
"BusPUVolt@4@1@1@PU Volt ="
"BusAngle@4@1@1@Angle ="
</SUBDATA>
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Data InjectionGroup
PartPoint
A participation point is used to describe the contents of an injection group. Each participation point
lists six values:
PointType PointBusNum PointID PointParFac ParFacCalcType ParFacNotDynamic
PointType: One of two values describing the type of violation:
GEN: a generator
LOAD: a load
SHUNT: a switched shunt
INJECTIONGROUP: another injection group
PointBusNum: The bus number of the partpoint if the type is GEN, LOAD, or SHUNT. Value will
be blank for an injection group type. Note: bus# values may be replaced by a string enclosed in
double quotes where the string is the name of the bus followed by an underscore character and
then the nominal voltage of the bus. These values may also be replaced by a string enclosed in
double quotes that represents the label of the bus or a string representing the label of the
generator, load, or switched shunt.
PointID: For a GEN, LOAD, or SHUNT type, this is the id for the partpoint. For an
INJECTIONGROUP type, this is the name or label of the injection group.
PointParFac: The participation factor for the point.
ParFacCalcType: How the participation point is calculated. There are several options
depending on the PointType.
Generators: SPECIFIED, MAX GEN INC, MAX GEN DEC, or MAX GEN MW
Loads: SPECIFIED or LOAD MW
Shunts: SPECIFIED, MAX SHUNT INC, MAX SHUNT DEC, or MAX SHUNT MVAR
Injection Groups: SPECIFIED
ParFacNotDynamic: Should the participation factor be recalculated dynamically as the system
changes.
Example:
<SUBDATA PartPoint
"GEN" 1 "1" 1.00 "SPECIFIED" "NO"
"GEN" 2 "1" 5.00 "SPECIFIED" "NO"
"GEN" 4 "1" 104.96 "MAX GEN INC" "NO"
"GEN" 6 "1" 50.32 "MAX GEN DEC" "YES"
"GEN" 7 "1" 600.00 "MAX GEN MW" "NO"
"LOAD" 2 "1" 5.00 "SPECIFIED" "NO"
"LOAD" 5 "1" 130.00 "LOAD MW" "NO"
"LOAD" 6 "1" 200.00 "LOAD MW" "YES"
</SUBDATA>
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Note: PartPoint object types can also be directly created inside their own DATA section as well. One
of the key fields of the PartPoint object is then the name of the injection group to which the
participation point belongs.
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Data Interface
InterfaceElement
An interface’s subdata contains a list of the elements in the interface. Each line contains a text
description of the interface element. Note that this text description must be encompassed by
quotation marks. There are five kinds of elements allowed in an interface. Please note that the
direction specified in the monitoring elements is important.
"BRANCH num1 num2 ckt" Monitor the MW flow on the branch starting from bus num1
going to bus num2 on the branch this branch. (order of bus numbers defines the direction)
"AREA num1 num2" Monitor the sum of the AC tie line MW flows from area num1 to area
num2.
"ZONE num1 num2" Monitor the sum of the AC tie line MW flows from zone num1 to zone
num2.
"BRANCHOPEN num1 num2 ckt" When monitoring the elements in this interface, monitor
them under the contingency of opening this branch.
"BRANCHCLOSE num1 num2 ckt" When monitoring the elements in this interface, monitor
them under the contingency of closing this branch.
"DCLINE num1 num2 ckt" Monitor the flow on a DC line.
"INJECTIONGROUP 'name'" Monitor the net injection from an injection group (generation
contributes a positive injection, loads negative).
"GEN num1 id" Monitor the net injection from a generator (output is positive injection).
"LOAD num1 id" Monitor the net injection from a load (output is negative injection).
"MSLINE num1 num2 ckt" Monitor the MW flow on the multi-section line starting from bus
num1 going to bus num2 with circuit ckt.
"INTERFACE 'name'" Monitor the MW flow on the interface given by name.
Note: bus# values may be replaced by a string enclosed in single quotes where the string is the
name of the bus followed by an underscore character and then the nominal voltage of the bus.
Labels may also be used as follows:




bus# values for all element types may be replaced by a string enclosed in single quotes
where the string is the label of the bus
for GEN or LOAD elements, the section num1 id may be replaced by the device's label
for MSLINE, DCLINE, or BRANCH elements, the num1 num2 ckt section may be replaced by
the device's label

For the interface element type "BRANCH num1 num2 ckt" and "DCLINE num1 num2 ckt", an
optional field can also be written specifying whether the flow should be measured at the far end.
This field is either YES or NO.
Example:
<SUBDATA InterfaceElement
"BRANCH 8 9 1" NO // monitor the flow from bus 8 to bus 9 on this branch
"BRANCH 12 33 1" YES // monitor the flow from bus 12 to bus 33 on branch
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// measurefarend is set to true, therefore, we are
// monitoring the MW flow that arrives at bus 33
"AREA 2 1" // monitor tie line flow from area 2 to area 1
"ZONE 66 53" // monitor tie lines flows from zone 66 to zone 53
"BRANCHOPEN 5 6 1" // doe monitoring after branch opens
"BRANCHCLOSE 7 10 1" // doe monitoring after branch closes
</SUBDATA>
Note: InterfaceElement object types can also be directly created inside their own DATA section as
well. One of the key fields of the InterfaceElement object is then the name of the interface to which
the interface element belongs.
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Data KMLExportFormat
DataBlockDescription
This subdata section is used to describe the objects and fields that should be saved to a KML file.
Same format as for the AUXFileExportFormatData subdata section.
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Data LimitSet
LimitCost
LimitCost records describe the piece-wise unenforceable constraint cost records for use by
unenforceable line/interface limits in the OPF or SCOPF. Each row contains two values
PercentLimit: Percent of the transmission line limit.
Cost: Cost used at this line loading percentage value.
Example:
<SUBDATA LimitCost>
//Percent Cost [$/MWhr]
100.00 50.00
105.00 100.00
110.00 500.00
</SUBDATA>
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Data Load
BidCurve
BidCurve subdata is used to define a piece-wise linear benefit curve (or a bid curve). Each bid point
consists of two real numbers on a single line of text: a MW output and then the respective bid (or
marginal cost). These costs must be increasing for loads.
Example:
<SUBDATA BidCurve>
// MW Price[$/MWhr]
100.00 16.0
200.00 15.7
400.00 12.4
500.00 10.6
</SUBDATA>
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Data LPVariable
LPVariableCostSegment
Stores the cost segments for the LP variables. Each line contains four values:
Cost (Up): Cost associated with increasing the LP variable.
Minimum value: Minimum limit of the LP variable.
Maximum value: Maximum limit of the LP variable.
Artificial: Whether the cost segment is artificial or not.
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Data ModelCondition
Condition
ModelConditions are the combination of an object and a Filter. They are used to return when the
particular object meets the filter specified. As a results, the subdata section here is identical to the
Condition subdata section of a Filter. See the description there.
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Data ModelExpression
LookupTable
LookupTables are used inside Model Expressions sometimes. These lookup table represent either
one or two dimensional tables. If the first string in the SUBDATA section is "x1x2", the this signals
that it is a two dimensional lookup table. From that point on it will read the first row as "x2" lookup
points, and the first column in the remainder of the rows as the x1 lookup values.
Example:
DATA (MODELEXPRESSION, [CustomExpression,ObjectType,CustomExpressionStyle,
CustomExpressionString,WhoAmI,VariableName,WhoAmI:1,VariableName:1], AUXDEF)
{
// The following demonstrated a one dimensional lookup table
22.0000, "oneD", "Lookup", "",
"Gen<KEY1>1</KEY1><KEY2>1</KEY2>",
"Gen<KEY1>1</KEY1><KEY2>1</KEY2><VAR>GenMW</VAR>",
"", ""
<SUBDATA LookupTable>
// because it does not start with the string x1x2 this will
// represent a one dimensional lookup table
x1 value
0.000000 1.000000
11.000000 22.000000
111.000000 222.000000
</SUBDATA>
0.0000, "twod", "Lookup", "",
"Gen<KEY1>1</KEY1><KEY2>1</KEY2>",
"Gen<KEY1>1</KEY1><KEY2>1</KEY2><VAR>GenMW</VAR>",
"Gen<KEY1>6</KEY1><KEY2>1</KEY2>",
"Gen<KEY1>6</KEY1><KEY2>1</KEY2><VAR>GenMW</VAR>"
<SUBDATA LookupTable>
// because this starts with x1x2 this represent a two dimensional
// lookup table. The first column represents lookup values for x1.
// The first row represents lookup values for x2
x1x2 0.100000 0.300000 // these are lookup heading for x2
0.000000 1.000000 3.000000
11.000000 22.000000 33.000000
111.000000 222.000000 333.000000
</SUBDATA>
}
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Data ModelFilter
ModelCondition
A Model Filter’s subdata contains a list of each ModelCondition in the filter. Because a list of Model
Conditions is stored within Simulator, this subdata section only requires the name of each
ModelCondition on each line and whether or not the condition is using the NOT operator as part of
the Model Fitler.
Example:
<SUBDATA ModelCondition>
// ModelConditionName NotCondition
"Name of First Model Condition" "NO"
"Name of Second Model Condition" "NO"
"Name of Third Model Condition" "NO"
</SUBDATA>
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Data MTDCRecord
MTDCBus
For this SUBDTA section, each DC Bus is described on a single line of text with exactly 8 fields
specified.
DCBusNum: The number of the DC Bus. Note the DC bus numbers are independent of the AC
bus numbers.
DCBusName: The name of the DC bus enclosed in quotes.
ACTerminalBus: The AC terminal to which this DC bus is connected (via a MTDCConverter). If
the DC bus is not connected to any AC buses, then specify as zero. You may also specify this as
a string enclosed in double quotes with the bus name followed by an underscore character,
following by the nominal voltage of the bus.
DCResistanceToground: The resistance of the DC bus to ground. Not used by Simulator.
DCBusVoltage: The DC bus voltage in kV.
DCArea: The area that this DC bus belongs to.
DCZone: The zone that this DC bus belongs to.
DCOwner: The owner that this DC bus belongs to.
Note: MTDCBus object types can also be directly created inside their own DATA section as well. One
of the key fields of the object is then the number of the MTDCRecord to which the MTDCBus
belongs.
MTDCConverter
For this SUBDTA section, each AC/DC Converter is described by exactly 24 field which may be
spread across several lines of text. Simulator will keep reading lines of text until it finds 24 fields. All
text to the right of the 24th field (on the same line of text) will be ignored. The 24 fields are listed in
the following order:
BusNum: AC terminal bus number.
MTDCNBridges: Number of bridges for the converter.
MTDCConvEBas: Converter AC base voltage.
MTDCConvAngMxMn: Converter firing angle.
MTDCConvAngMxMn:1: Converter firing angle max.
MTDCConvAngMxMn:2: Converter firing angle min.
MTDCConvComm: Converter commutating resistance.
MTDCConvComm:1: Converter commutating reactance.
MTDCConvXFRat: Converter transformer ratio.
MTDCFixedACTap: Fixed AC tap.
MTDCConvTapVals: Converter tap.
MTDCConvTapVals:1: Converter tap max.
MTDCConvTapVals:2: Converter tap min.
MTDCConvTapVals:3: Converter tap step size.
MTDCConvSetVL: Converter setpoint value (current or power).
MTDCConvDCPF: Converter DC participation factor.
MTDCConvMarg: Converter margin (power or current).
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MTDCConvType: Converter type.
MTDCMaxConvCurrent: Converter Current Rating.
MTDCConvStatus: Converter Status.
MTDCConvSchedVolt: Converter scheduled DC voltage.
MTDCConvIDC: Converter DC current.
MTDCConvPQ: Converter real power.
MTDCConvPQ:1: Converter reactive power.
Note: MTDCConverter object types can also be directly created inside their own DATA section as
well. One of the key fields of the object is then the number of the MTDCRecord to which the
MTDCConverter belongs.
MTDCTransmissionLine
For this SUBDTA section, each DC Transmission Line is described on a single line of text with exactly
5 fields specified:
DCFromBusNum: From DC Bus Number.
DCToBusNum: To DC Bus Number.
CKTID: The DC Circuit ID.
Resistance: Resistance of the DC Line in Ohms.
Inductance: Inductance of the DC Line in mHenries (Not used by Simulator).
Example:
DATA (RECORD, [Num,Mode,ControlBus])
{
//-------------------------------------------------------------------------// The first Multi-Terminal DC Transmission Line Record
//-------------------------------------------------------------------------1 "Current" "SYLMAR3 (26098)"
<SUBDATA Bus>
//------------------------------------------------------------------// DC Bus data must appear on a single line of text
// The data consists of exactly 8 values
// DC Bus Num, DC Bus Name, AC Terminal Bus, DC Resistance to ground,
// DC Bus Voltage, DC Bus Area, DC Bus Zone, DC Bus Owner
//------------------------------------------------------------------3 "CELILO3P" 0 9999.00 497.92 40 404 1
4 "SYLMAR3P" 0 9999.00 439.02 26 404 1
7 "DC7" 41311 9999.00 497.93 40 404 1
8 "DC8" 41313 9999.00 497.94 40 404 1
9 "DC9" 26097 9999.00 439.01 26 404 1
10 "DC10" 26098 9999.00 439.00 26 404 1
</SUBDATA>
<SUBDATA Converter>
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//------------------------------------------------------------------// convert subdata keeps reading lines of text until it has found
// values specified for 24 fields. This can span any number of lines
// any values to the right of the 24th field found will be ignored
// The next converter will continue on the next line.
//------------------------------------------------------------------41311 2 525.00 20.25 24.00 5.00 0.0000 16.3100
0.391048 1.050000 1.000000 1.225000 0.950000 0.012500
1100.0000 1650.0000 0.0000 "Rect" 1650.0000 "Closed"
497.931 1100.0000 547.7241 295.3274
41313 4 232.50 15.36 17.50 5.00 0.0000 7.5130
0.457634 1.008700 1.030000 1.150000 0.990000 0.010000
2000.0000 2160.0000 0.1550 "Rect" 2160.0000 "Closed"
497.940 2000.0000 995.8800 561.8186
26097 2 230.00 20.90 24.00 5.00 0.0000 16.3100
0.892609 1.000000 1.100000 1.225000 0.950000 0.012500
-1100.0000 1650.0000 "" "Inv" 1650.0000 "Closed"
439.009 1100.0000 -482.9099 274.5227
26098 4 232.00 17.51 20.00 5.00 0.0000 7.5130
0.458621 1.008700 1.100000 1.120000 0.960000 0.010000
439.0000 2160.0000 "" "Inv" 2160.0000 "Closed"
439.000 1999.9999 -878.0000 544.2775
</SUBDATA>
<SUBDATA TransmissionLine>
//------------------------------------------------------------------// DC Transmission Segment information appears on a single line of
// text. It consists of exactly 5 value
// From DCBus, To DCBus, Circuit ID, Line Resistance, Line Inductance
//------------------------------------------------------------------3 4 "1" 19.0000 1300.0000
7 3 "1" 0.0100 0.0000
8 3 "1" 0.0100 0.0000
9 4 "1" 0.0100 0.0000
10 4 "1" 0.0100 0.0000
</SUBDATA>
//-------------------------------------------------------------------------// A second Multi-Terminal DC Transmission Line Record
//-------------------------------------------------------------------------2 "Current" "SYLMAR4 (26100)"
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<SUBDATA Bus>
5 "CELILO4P" 0 9999.00 497.92 40 404 1
6 "SYLMAR4P" 0 9999.00 439.02 26 404 1
11 "DC11" 41312 9999.00 497.93 40 404 1
12 "DC12" 41314 9999.00 497.94 40 404 1
13 "DC13" 26099 9999.00 439.01 26 404 1
14 "DC14" 26100 9999.00 439.00 26 404 1
</SUBDATA>
<SUBDATA Converter>
41312 2 525.00 20.26 24.00 5.00 0.0000 16.3100
0.391048 1.050000 1.000000 1.225000 0.950000 0.012500
1100.0000 1650.0000 0.0000 "Rect" 1650.0000 "Closed"
497.931 1100.0000 547.7241 295.3969
41314 4 232.50 15.45 17.50 5.00 0.0000 7.5130
0.457634 1.008700 1.030000 1.150000 0.990000 0.010000
2000.0000 2160.0000 0.1550 "Rect" 2160.0000 "Closed"
497.940 2000.0000 995.8800 562.9448
26099 2 230.00 20.90 24.00 5.00 0.0000 16.3100
0.892609 1.000000 1.100000 1.225000 0.950000 0.012500
-1100.0000 1650.0000 "" "Inv" 1650.0000 "Closed"
439.009 1100.0000 -482.9099 274.5227
26100 4 232.00 17.51 20.00 5.00 0.0000 7.5130
0.458621 1.008700 1.100000 1.120000 0.960000 0.010000
439.0000 2160.0000 "" "Inv" 2160.0000 "Closed"
439.000 1999.9999 -878.0000 544.2775
</SUBDATA>
<SUBDATA TransmissionLine>
5 6 "1" 19.0000 1300.0000
11 5 "1" 0.0100 0.0000
12 5 "1" 0.0100 0.0000
13 6 "1" 0.0100 0.0000
14 6 "1" 0.0100 0.0000
</SUBDATA>
}
Note: MTDCTransmissionLine object types can also be directly created inside their own DATA section
as well. One of the key fields of the object is then the number of the MTDCRecord to which the
MTDCTransmissionLine belongs.
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Data MultiSectionLine
Bus
A multi section line’s subdata contains a list of each dummy bus, starting with the one connected to
the From Bus of the MultiSectionLine and proceeding in order to the bus connected to the To Bus of
the Line. Note: bus# values may be replaced by a string enclosed in double quotes where the string
is the name of the bus followed by an underscore character and then the nominal voltage of the
bus, or the string may represent the label of the bus.
Example:
//----------------------------------------------------------------------------------------------------------// The following describes a multi-section line that connnects bus
// 2 - 1 - 5 - 6 - 3
//-----------------------------------------------------------------------------------------------------------DATA (MultiSectionLine, [BusNum, BusName, BusNum: 1, BusName: 1,
LineCircuit, MSLineNSections, MSLineStatus] )
{
2 "Two" 3 "Three" "&1" 2 "Closed"
<SUBDATA Bus>
1
5
6
</SUBDATA>
}
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Data Nomogram
InterfaceElementA
InterfaceElementB
InterfaceElementA values represent the interface elements for the first interface of the nomogram.
InterfaceElementB values represent the interface elements for the second interface of the
nomogram. The format of these SUBDATA sections is identical to the format of the InterfaceElement
SUBDATA section of a normal Interface.
NomogramBreakPoint
This subdata section contains a list of the vertex points on the nomogram limit curve.
Example:
<SUBDATA NomogramBreakPoint>
// LimA LimB
-100 -20
-100 100
80 50
60 -10
</SUBDATA>
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Data NomogramInterface
InterfaceElement
This follows the same convention as the InterfaceElement SUBDATA section described with the
Interface objecttype.
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Data Owner
Bus
This subdata section contains a list of the buses which are owned by this owner. Each line of text
contains the bus number. As an alternative to specifying the bus number, a string enclosed in double
quotes may be used where the string represents the name of the bus followed by an underscore
character and then the nominal voltage of the bus, or the string may represent the label of the bus.
Example:
<SUBDATA Bus>
1
35
65
</SUBDATA>
Load
This subdata section contains a list of the loads which are owned by this owner. Each line of text
contains the bus number followed by the load id. As an alternative to specifying the bus number, a
string enclosed in double quotes may be used where the string represents the name of the bus
followed by an underscore character and then the nominal voltage of the bus, or the string may
represent the label of the bus. Also, instead of specifying the bus and load id, the label of the load
enclosed in double quotes may be used.
Example:
<SUBDATA Load>
5 1 // shows ownership of the load at bus 5 with id of 1
423 1
</SUBDATA>
Gen
This subdata section contains a list of the generators which are owned by this owner and the
fraction of ownership. Each line of text contains the bus number, followed by the gen id, followed by
an integer showing the fraction of ownership. As an alternative to specifying the bus number, a
string enclosed in double quotes may be used where the string represents the name of the bus
followed by an underscore character and then the nominal voltage of the bus, or the string may
represent the label of the bus. Also, instead of specifying the bus and generator id, the label of the
generator enclosed in double quotes may be used.
Example:
<SUBDATA Gen>
78 1 50 // shows 50% ownership of generator at bus 78 with id of 1
23 3 70
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</SUBDATA>
Branch
This subdata section contains a list of the branchs which are owned by this owner and the fraction
of ownership. Each line of text contains the from bus number, followed by the to bus number,
followed by the circuit id, followed by an integer showing the fraction of ownership. As an alternative
to specifying the bus numbers, strings enclosed in double quotes may be used where the string
represents the name of the bus followed by an underscore character and then the nominal voltage
of the bus, or the string may represent the label of the bus. Also, instead of specifying the two
numbers and a circuit id, the label of the branch enclosed in double quotes may be used.
Example:
<SUBDATA Branch>
6 10 1 50 // shows 50% ownership of line from bus 6 to 10, circuit 1
</SUBDATA>
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Data PieChartGaugeStyle
ColorMap
This is a lookup table by percentage of scalar and color values. This lookup table will consist of
consecutive lines of text with exactly three values:
Percentage: This is the percentage at which the following scalar and color should be applied.
Scalar: A scalar (multiplier) on the size of the pie chart/gauge.
Color: A color for the pie chart/gauge.
Example:
<SUBDATA ColorMap>
//Percentage Scalar Color
85.0000 1.5000 33023
100.0000 2.0000 255
</SUBDATA>
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Data PostPowerFlowActions
CTGElementAppend
This format is the same as for the Contingency objecttype.
CTGElement
This format is the same as for the Contingency objecttype.
Note: PostPowerFlowActionsElement object types can also be directly created inside their own DATA
sections as well.
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Data PWCaseInformation
PWCaseHeader
This subdata section contains the Case Description in free-formatted text. Note: as it is read back
into Simulator all spaces from the start of each line are removed.
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Data PWFormOptions
PieSizeColorOptions
There can actually be several PieSizeColorOptions subdata sections for each PWFormOptions object.
The first line of each subdata section, the first line of text consist of exactly four values
ObjectName: The objectname of the type of object these settings apply to. Will be either be
BRANCH or INTERFACE.
FieldName: The fieldname for the pie charts that these settings apply to.
UseDiscrete: Set to YES to use a discrete mapping of colors and size scalars instead of
interpolating for intermediate values.
UseOtherSettings: Set to YES to default these settings to the BRANCH MVA values for BRANCH
object. This allows you to apply the same settings to all pie charts.
After this first line of text, if the UseOtherSettings Value is NO, then another line of text will contain
exactly three values:
ShowValue: This is the percentage at which the value should be drawn on the pie chart.
NormalSize: This is the scalar size multiplier which should be used for pie charts below the
lowest percentage specified in the lookup table.
NormalColor: This is the color which should be used for pie charts below the lowest percentage
specified in the lookup table.
Finally the remainder of the subdata section will contain a lookup table by percentage of scalar and
color values. This lookup table will consist of consecutive lines of text with exactly three values
Percentage: This is the percentage at which the follow scalar and color should be applied.
Scalar: A scalar (multiplier) on the size of the pie charts.
Color: A color for the pie charts.
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Data PWLPOPFCTGViol
OPFControlSense
OPFBusSenseP
OPFBusSenseQ
This stores the control sensitivities for each contingency violation during OPF/SCOPF analysis. Each
line contains one value:
Sensitivity: The value of the sensitivity with respect to each control in OPFControlSense or with
respect to each bus in OPFBusSenseP and OPFBusSenseQ.
Example:
<SUBDATA OPFControlSense>
// Value
1.000441679
2.447185E-7
-1.1109307E-6
1.6427327E-7
0
</SUBDATA>
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Data PWLPTabRow
LPBasisMatrix
This subdata section stores the basis matrix associated with the final LP OPF solution. Each line
contains two values:
Variable: The basic variable.
Value: The sensitivity of the constraint to the basic variable.
Example:
<SUBDATA LPBasisMatrix>
// Var Value
1 1.00000
2 1.00000
5 1.00000
6 1.00000
</SUBDATA>
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Data PWPVResultListContainer
PWPVResultObject
This subdata section contains the results of a particular PV Curve scenario (a particular contingency
or the base case). The data consists of two general sections: the first three rows of text contain the
"independent axis" of the PV Curve. The first row starts with the string INDNOM and is followed by a
list of numbers representing the nominal shift, the second row starts with INDEXP and is followed by
the export shift, and the third row starts with INDIMP and is followed by the import shift. Following
After these rows is a list of all the tracked quantities. Each tracked quantity row consists of three
parts which are separated by the strings ?f= and &v= . The first part of the string represents a
description of the power system object being tracked, the second part represents the field name
being tracked, and the third contains a list of all the values at the various shift levels.
Example:
<SUBDATA PWPVResultObject>
INDNOM 0.00 500.00 1000.00 1500.00 1750.00 1875.00 1975.00
INDEXP 0.00 500.00 1000.00 1500.00 1750.00 1875.00 1975.00
INDIMP 0.00 -417.23 -701.58 -890.58 -952.60 -975.35 -990.43
Bus '3'?f=BusPUVolt&v= 0.993 0.983 0.964 0.939 0.926 0.919 0.914
Bus '5'?f=BusPUVolt&v= 1.007 1.000 0.982 0.956 0.940 0.932 0.926
Gen '4' '1'?f=GenMVR&v= 19.99 245.27 523.62 831.13 986.84 1060.6 1118.7
Gen '6' '1'?f=GenMVR&v= -6.59 -120.84 -131.37 -39.53 48.35 103.8 154.5
</SUBDATA>
LimitViol
This subdata section contains the limit violations of a particular PV Curve scenario. This subdata
section would only exist if using the option to monitor limit violations with the PV tool. Each row
consists of an identifier, either VLOW or VHIGH, to indicate the type of limit violation followed by the
bus identifier based on the key field identifier chosen. The bus can be identified by number, name
and nominal kV combination, or label. The bus identifier is followed by the limit in use to identify a
voltage violation and this is followed by the voltage at the bus.
Example:
<SUBDATA LimitViol>
VLOW 3 1.00000 0.99017
VLOW 5 1.00000 0.98245
</SUBDATA>
PVBusInadequateVoltages
This subdata section contains a list of buses that are considered to have inadequate voltages at each
transfer level for a particular PV Curve scenario. This subdata section would only exist if using the
option to store inadequate voltages. The data consists of two general sections: the first row starts
with the string INDNOM and is followed by a list of numbers representing the nominal shift. The
second and subsequent rows list the buses and inadequate voltages for any bus that has an
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inadequate voltage at any transfer level. Each row starts with the bus identifier followed by the
voltages at that bus at the corresponding shift levels. If a voltage is not inadequate at a particular
transfer level, a blank entry will appear instead of a voltage value. The bus identifier is based on the
key field identifier chosen and can be number, name and nominal kV combination, or label.
Example:
<SUBDATA PVBusInadequateVoltages>
// INDNOM ShiftLevel1 ShiftLevel2 ...
// BUS Voltage1 Voltage2 ...
INDNOM 0.000 100.000 200.000 300.000 400.000 500.000
"Bus '3'" 0.99269 0.99278 0.99282 0.99280 0.99273 0.99262
"Bus '4'" "" 1.00000 "" "" ""
</SUBDATA>
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Data PWQVResultListContainer
PWPVResultObject
This subdata section contains the results of a particular QV Curve scenario. These results will exist
when tracking quantities with the QV curve tool. The data consists of two general sections: the first
three rows of text contain the "independent axis" of the QV Curve. The first three rows start with the
strings INDNOM, INDEXP, and INDIMP and are followed by a list of numbers representing the
setpoint voltage representing the V of the QV curve. Following after these rows is a list of all the
tracked quantities. Each tracked quantity row consists of three parts which are separated by the
strings ?f= and &v= . The first part of the string represents a description of the power system object
being tracked, the second part represents the field name being tracked, and the third contains a list
of all the values at the various setpoint voltage levels.
Example:
<SUBDATA PWPVResultObject>
INDNOM 1.100 1.093 1.083 1.073 1.063
INDEXP 1.100 1.093 1.083 1.073 1.063
INDIMP 1.100 1.093 1.083 1.073 1.063
Bus '1'?f=BusPUVolt&v=1.05000 1.05000 1.05000 1.05000 1.05000
Bus '1'?f=BusKVVolt&v=144.89999 144.89999 144.89999 144.89999 144.89999 </SUBDATA>
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Data QVCurve
QVPoints
This subdata section contains a list of the QV Curve points calculated for the respect QVCurve. Each
line consists of exactly four values:
PerUnitVoltage: The per unit voltage of the bus for a QV point.
FictitiousMvar: The amount of Mvar injection from the fictitious generator at this QV point.
ShuntDeviceMvar: The Mvar injection from any switched shunts at the bus.
TotalMvar: The total Mvar injection from switched shunts and the fictitious generator.
ReservesMvar: Total amount of Mvar reserves available at the bus.
ReservesTotalMvar: Total Mvar injection from the switched shunts, fictitious generator, and
available reserves.
Example:
DATA (QVCURVE, [BusNum,CaseName,qv_VQ0,qv_Q0,qv_Vmax,qv_QVmax,qv_VQmin,qv_Qmin,
qv_Vmin,qv_QVmin,Qinj_Vmax,Qinj_0,Qinj_min,Qinj_Vmin])
{
5 "BASECASE" 0.880 0.000 1.100 312.490 0.480 -221.072
0.180 -86.334 191.490 -77.373 -244.075 -89.562
<SUBDATA QVPoints>
// NOTE: This bus has a constant impedance
// switched shunt value of -100 Mvar at it.
// V(PU), Q(MVR), Q_shunt(MVR), Q_tot(MVR), Q_res(MVR), Q_tot_res(MVR)
1.1000, 312.4898, -121.0000, 191.4898, 0.0000, 191.4898
0.9800, 124.6619, -95.9656, 28.6963, 0.0000, 28.6963
0.7800, -96.6202, -60.7808, -157.4010, 0.0000, -157.4010
0.5800, -206.9895, -33.5960, -240.5855, 0.0000, -240.5855
0.3800, -207.4962, -14.4113, -221.9075, 0.0000, -221.9075
0.1800, -86.3336, -3.2284, -89.5620, 0.0000, -89.5620
</SUBDATA>
}
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Data QVCurve_Options
Sim_Solution_Options
This subdata section contains solution options that will be used when running QV Curves. See
explanation under the CTG_Options object type for more information.
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Data SelectByCriteriaSet
SelectByCriteriaSetType
This subdata section contains a list of the display object types which are chosen to be selected. Each
line of the section consists of the following:
DisplayObjectType: The object type of the display object.
(FilterName): A filter to apply to these types of objects. This field is optional, but must be given
if either of the following fields are given.
(WhichFields): For display objects that can reference different fields, this sets which of those
fields it should select (e.g. select only Bus Name Fields). The value may be either ALL or
SPECIFIED.
(ListOfFields): If WhichFields is set to SPECIFIED, then a delimited list of fields follows.
Example:
<SUBDATA SelectByCriteriaSetType>
DisplayAreaField "" "ALL"
DisplayBus ""
DisplayBusField "Name of Bus Filter" "SPECIFIED" BusName BusPUVolt BusNum
DisplayCircuitBreaker ""
DisplaySubstation ""
DisplaySubstationField "" "SPECIFIED" SubName SubNum BusNomVolt BGLoadMVR
DisplayTransmissionLine ""
DisplayTransmissionLineField "" "ALL"
</SUBDATA>
Area
This subdata section contains a list of areas which were chosen to be selected. Each line of the
section consists of either the number or the name. When generated automatically by PowerWorld
we also include the other identifier as a comment.
Example:
<SUBDATA Area>
18 // NEVADA
22 // SANDIEGO
30 // PG AND E
52 // AQUILA
</SUBDATA>
Zone

613
©2011 PowerWorld Corporation

This subdata section contains a list of zones which were chosen to be selected. Each line of the
section consists of either the number or the name. When generated automatically by PowerWorld
we also include the other identifier as a comment.
Example:
<SUBDATA Zone>
680 // ID SOLUT
682 // WY NE IN
</SUBDATA>
ScreenLayer
This subdata section contains a list of screen layers which were chosen to be selected. Each line of
the section consists of either the name.
Example:
<SUBDATA ScreenLayer>
"Border"
"Transmission Line Objects"
</SUBDATA>
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Data ShapeFileExportDescription
This object uses the same subdata sections as SelectByCriteriaSet. The only distinction is
that only buses and lines can be exported.
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Data StudyMWTransactions
ImportExportBidCurve
This subdata section contains the piecewise linear transactions cost curves for areas involved in a
MW transaction. Costs are only for areas that are not on OPF control. Curves must be monotonically
increasing. Each line corresponds to a point in the cost curve, and it has two values:
MW: The MW value. Use negative values for imports (purchase) and positive values for
exports (sales).
Price: The price in $/MWh.
Example:
<SUBDATA ImportExportBidCurve>
//MW Price[$/MWh]
-20.00 5.00
-10.00 10.00
0.00 15.00
10.00 20.00
20.00 45.00
30.00 70.00
</SUBDATA>
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Data SuperArea
SuperAreaArea
This subdata section contains a list of areas within each super area. Each line of text contains two
values, the area number followed by a participation factor for the area that can be optionally used.
Example:
<SUBDATA SuperAreaArea>
1 48.9
2 34.2
25 11.2
</SUBDATA>
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Data TSSchedule
SchedPointList
This section stores the schedule time points used in Time Step Simulation. Each line contains seven
values:
Date: The date of the point.
Hour: The hour of the point.
Pointtype: An integer specifying the point type.
0 – Numeric
1 – Boolean (Yes/No, Closed/Open)
2 – Text
Numeric Value: The numeric value if point type is Numeric. Otherwise it is just zero.
Boolean Value: The boolean value if point type is Boolean. Otherwise it is just false.
Text Value: The text value if point type is Text. Otherwise it is just an empty string.
Audiofilename: The audio filename associated to the point. If none, it is just an empty string.
Example:
<SUBDATA SchedPointList>
//Date Hour PointType NValue BValue TValue AValue
5/8/2006 0 1.00 NO
5/8/2006 6:00:00 AM 0 1.10 NO
5/8/2006 12:00:00 PM 0 1.25 NO
</SUBDATA>
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Data UserDefinedDataGrid
ColumnInfo
This follows the same convention as the ColumnInfo SUBDATA section described with the DataGrid
objecttype.
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Data View
ScreenLayer
This is a list of screen layer names that are hidden in the current view. Each screen layer name is on
a separate line of text.
Example:
<SUBDATA ScreenLayer>
//These are hidden screen layers
"pie layer"
</SUBDATA>
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Script Section
The SCRIPT section begins with a left curly brace and ends with a right curly brace.
SCRIPT ScriptName
{
script_statement_1
script_statement_2
.
.
.
script_statement_n
}
Scripts may optionally contain a ScriptName. This enables you to call a particular SCRIPT by using the
LoadScript action. After the optional name, the SCRIPT section begins with a left curly brace and ends
with a right curly brace. Inside of this, script statements can be given.
In general, a script statement has the following format:
Keyword(arg1, arg2, ...);








Statement starts with a keyword.
The keyword is followed by an argument list which is encompassed in parentheses ( ).
The arguments are separated by commas.
If a single argument is a list of things, this list is encompassed by braces [ ]. (eg. SetData)
Statements end with a semicolon.
Statements may take up several lines of the text file.
You may put more than one statement on a single text line.

Some features in Simulator are available exclusively in either RUN mode or EDIT mode. This
functionality is preserved in the script language. Versions of Simulator prior to 16.0 organized certain
functionality with the submode feature. While existing scripts designed to work with submodes will
function as before, moving between submodes is no longer necessary.
If the Script Command Execution Dialog is opened from Edit Mode, Simulator defaults to EDITmode.
If the Script Command Execution Dialog is opened from Run Mode (or when a script is initially
started), Simulator defaults to RUNmode.
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Script Actions for Display Auxiliary Files
The following actions are available to you regardless of the Mode:
AutoInsertBorders;
AutoInsertBuses

(LocationSo
urce,

MapProjection,

"Bus"

"Simple Conic"

"Substati
on"

"Mercator"

"File"

"x,y"

"filename",

AutoInsertBra
nches,
YES or NO

InsertIfNotAlready
Shown,
YES or NO

FileCoordinates);
"x,y"
"lon,lat"

AutoInsertLoads

(MinkV,

InsertTextFields,
YES or NO

AutoInsertGens

(MinkV,

InsertEquivObj
ects);
YES or NO

InsertTextFields);
YES or NO

AutoInsertSwitched
Shunts

(MinkV,

InsertTextFields);
YES or NO

AutoInsertLines

(MinkV,

InsertMSLin
es,

InsertTextFields,

(MinkV,

FieldDigits,

YES or NO

YES or NO

SBRImpedance,

NoStubsZBRs,

SingleCBZRs);

YES or NO

YES or NO

InsertOnlyIfNotAlread
yShown,

LineLocation,

YES or NO

0, 1, or 2

FieldDecimals,

TextPosition,
YES or NO

ShowMVar,
YES or
NO

ShowMVA,
YES or NO
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InsertZBRPieChart
s,

YES or NO

YES or
NO
AutoInsertLineFlow
Objects

InsertEquivObj
ects,

ShowUnits,
YES or NO

Size,

ShowMW,
YES or NO
ShowComplex);
YES or NO

AutoInsertSubstatio
ns

(LocationSo
urce,

MapProjecton,

"Bus"

"Simple Conic"

"Substati
on"

"Mercator"

"File"

"x,y"

"filename",

AutoInsertBra
nches,

InsertIfNotAlready
Shown,

YES or NO

YES or NO

FileCoordinates);
"x,y"
"lon,lat"

AutoInsertLineFlowP
ieCharts

(MinkV,

InsertOnlyIfNotAlread
yShown,
YES or NO

AutoInsertInterfaces

(InsertPieC
harts,

InsertMSLines,

Size);

YES or NO

PieChartSize);

YES or
NO
ResetStubLocations

(ZBRImped
ance,

NoStubsZBRs);
YES or NO

AutoInsertBorders;
Use this action to automatically insert borders according to the settings in the
AutoInsertBordersOptions object
AutoInsertBuses(LocationSource, MapProjection, AutoInsertBranches,
InsertIfNotAlreadyShown, “filename”, FileCoordinates);
Use this action to automatically insert buses based on specified location data.
LocationSource : “Bus”, “Substation” or “File”
MapProjection : “Simple Conic”, “Mercator” or “x,y”
AutoInsertBranches : YES to insert transmission lines when finished, NO not to
InsertOnlyIfNotAlreadyShown : YES if only buses that are not already shown should be
inserted, NO to insert all buses.
“filename” : (optional) path to location source file (if LocationSource is “File”)
FileCoordinates : (optional) format of coordinates in file “x,y” or “lon,lat” (if LocationSource is
“File”)
AutoInsertLoads(MinkV, InsertTextFields);
Use this action to automatically insert loads.
MinkV : Minimum kV level to insert (default=0)
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InsertTextFields : (optional) insert text fields (default=YES)
AutoInsertSwitchedShunts(MinkV, InsertTextFields);
Use this action to automatically insert switched shunts.
MinkV : Minimum kV level to insert (default=0)
InsertTextFields : (optional) insert text fields (default=YES)
AutoInsertLines(MinkV, InsertTextFields, InsertEquivObjects, InsertZBRPieCharts,
InsertMSLines, ZBRImpedance, NoStubsZBRs, SingleCBZRs);
Use this action to automatically insert lines.
MinkV : (optional) minimum kV level to insert (default=0)
InsertTextFields : (optional) insert text fields (default=YES)
InsertEquivObjects : (optional) insert Equivalenced Objects (default=YES)
InsertZBRPieCharts : (optional) insert pie charts for lines with no limit and bus ties
(default=NO)
InsertMSLines : (optional) insert MultiSecton Lines (default=YES)
ZBRImpedance : (optional) maximum PU impedance for bus ties (default =0.0001)
NoStubsZBRs : (optional) ignore stubs for bus ties (default=YES)
SingleCBZBRs : (optional) only insert a single circuit breaker (default=YES)
AutoInsertLineFlowObjects(MinkV, InsertOnlyIfNotAlreadyShown, LineLocation, Size,
FieldDigits, FieldDecimals, TextPosition, ShowMW, ShowMvar, ShowMVA, ShowUnits,
ShowComplex);
Use this action to automatically insert line flow objects.
MinkV : Minimum kV level to insert (default=0)
InsertOnlyIfNotAlreadyShown: (optional) if existing line flow objects are ignored
(default=YES)
LineLocation : (optional) where to insert flow objects (default=0)
0 : middle
1 : 10%/90%
2 : after stubs
Size : (optional) size (default=5.0)
FieldDigits : (optional) total digits in field (default=6)
FieldDecimals : (optional) digits to the right of the decimal (default=2)
TextPosition : (optional) position of fields relative to flow object (default=YES)
YES : above
NO : below
ShowMW : (optional) show MW field (default=YES)
ShowMvar : (optional) show Mvar field (default=YES)
ShowMVA : (optional) show MVA field (default=YES)
ShowSuffix : (optional) show field units (default=YES)
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ShowComplex : (optional) show complex form (MW+jMvar) (default=NO)
AutoInsertSubStations(LocationSource, MapProjection, AutoInsertBranches,
InsertIfNotAlreadyShown, “filename”, FileCoordinates);
Use this action to automatically insert substations based on specified location data.
LocationSource : “Bus”, “Substation” or “File”
MapProjection : “Simple Conic”, “Mercator” or “x,y”
AutoInsertBranches : YES to insert transmission lines when finished, NO not to
InsertOnlyIfNotAlreadyShown : YES if only buses that are not already shown should be
inserted, NO to insert all buses.
“filename” : (optional) path to location source file (if LocationSource is “File”)
FileCoordinates : (optional) format of coordinates in file “x,y” or “lon,lat” (if LocationSource is
“File”)
AutoInsertLineFlowPieCharts(MinkV, InsertOnlyIfNotAlreadyShown, InsertMSLines, Size);
Use this action to automatically insert line flow pie charts.
MinkV : Minimum kV level to insert (default=0)
InsertOnlyIfNotAlreadyShown: (optional) if existing line flow objects are ignored
(default=YES)
InsertMSLines : (optional) insert pie charts for Multi-Section Lines (default=YES)
Size : (optional) size (default=5.0)
AutoInsertInterfaces(InsertPieCharts, PieChartSize)
Use this action to automatically insert line flow objects.
InsertPieCharts : (optional) Insert pie charts as well (default=YES)
PieChartSize : (optional) default size of interface pie charts (default=50.0)
ResetStubLocations(ZBRImpedance, NoStubsZBRs)
Use this action to reset stub locations.
ZBRImpedance : (optional) max P.U. impedance for bus ties (default=0.0001)
NoStubsZBRs : (optional) Ignore stubs for bus ties (default=YES)
General Script Commands
The following script commands defined in the general Script section are available for display auxiliary
files as well:
ExitProgram
LoadScript
LoadData
SelectAll
UnSelectAll
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SetData
SaveData
SaveDataWithExtra
Delete
WriteToTextFile
SetData
CreateData
DeleteFile
RenameFile
CopyFile
SetCurrentDirectory
SaveObjectFields
SendToExcel
StopAuxFile
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Data Section for Display Auxiliary File
The Data Section of the script file format can contain numerous functions for modifying the data of a
power system case. The DATA section begins with a left curly brace and ends with a right curly brace.
DATA DataName (object_type, [list_of_fields], file_type_specifier, create_if_not_found)
{
data_list_1
.
.
.
data_list_n
}
Immediately following the DATA keyword, you may optionally include a DataName. Currently, this is
not used for anything because there are no script commands that are supported with the display
auxiliary files.
The first line of the DATA section is referred to as the Data Argument List. The Data Argument List
defines the type and format of the data contained in the following section enclosed in curly braces.
Inside of each DATA section, data lists are given according to the data definition given in the Data
Argument List.
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Data Argument List for Display Auxiliary File
The DATA argument list identifies what the information section contains. A left and right parenthesis "(
)" mark the beginning and end of the argument list.
The file_type_specifier parameter distinguishes the information section as containing custom
auxiliary data (as opposed to Simulator’s native auxiliary formats), and indicates the format of the
data. Currently, the parser recognizes two values for file_type_specifier:
(blank) or AUXDEF
Data fields are space delimited
Data fields are comma delimited

CSV, AUXCSV, or CSVAUX

The object_type parameter identifies the type of object or data element the information section
describes or models. For example, if object_type equals DISPLAYBUS, then the data describes
DISPLAY BUS objects. Below is a list of many of the object types recognized by Simulator:
CaseInformationMemo

DisplayLineFlowArrow

DisplayTransmissionLineField

ColorMap

DisplayLoad

DisplayZone

Contour

DisplayLoadField

DisplayZoneField

CustomColors

DisplayMultiSectionLine

DisplayZonePie

DisplayArea

DisplayMultiSectionLineField

DocumentLink

DisplayAreaField

DisplayMultiSectionLinePie

DynamicFormatting

DisplayAreaPie

DisplayOwner

Ellipse

DisplayBranchGauge

DisplayOwnerField

Filter

DisplayBranchPie

DisplayOwnerPie

GeoDataViewStyle

DisplayBus

DisplaySeriesCapacitor

GeographyDisplayOptions

DisplayBusField

DisplaySeriesCapacitorField

Group

DisplayBusPie

DisplayShunt

Line

DisplayCircuitBreaker

DisplayShuntField

OnelineField

DisplayDCTransmissionLine

DisplayShuntPie

OnelineLink

DisplayDCTransmissionLineField

DisplaySubstation

Picture

DisplayGen

DisplaySubstationField

PieChartGaugeStyle

DisplayGenericModelField

DisplaySubstationPie

PWFormOptions

DisplayGenField

DisplaySuperArea

Rectangle

DisplayGenPie

DisplaySuperAreaField

Screenlayer

DisplayInjectionGroup

DisplaySuperAreaPie

SelectByCriteriaSet

DisplayInjectionGroupPie

DisplayTransformer

Text

DisplayInterface

DisplayTransformerField

TextBox

DisplayInterfaceField

DisplayTransformerPie

View

DisplayInterfacePie

DisplayTransmissionLine

The list of object types Simulator’s auxiliary file parser can recognize will grow as new applications for
the technology are found. Within Simulator, you will always be able to obtain a list of the available
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object_types by going to the Auxiliary Files ribbon group on the Window ribbon tab and choosing
Export Display Object Fields.
The list_of_fields parameter lists the types of values the ensuing records in the data section contain.
The order in which the fields are listed in list_of_fields dictates the order in which the fields will be
read from the file. Simulator currently recognizes over 3,000 different field types, each identified by a
specific field name. Because the available fields for an object may grow as new applications are
developed, you will always be able to obtain a list of the available object_types by going to the
Auxiliary Files ribbon group on the Window ribbon tab and choosing Export Display Object
Fields. Certainly, only a subset of these fields would be found in a typical custom auxiliary file. In
crafting applications to export custom auxiliary files, developers need concern themselves only the
fields they need to communicate between their applications and Simulator. A few points of interest
regarding the list_of_fields are:






The list_of_fields may take up several lines of the text file.
The list_of_fields should be encompased by braces [ ].
When encountering the PowerWorld comment string ‘//’ in one of these lines of the text file, all
text to the right of this is ignored.
Blank lines, or lines whose first characters are ‘//’ will be ignored as comments.
Field names must be separated by commas.

Example DATA Argument List
DATA (DISPLAYBUS, [BusNom, SOAuxiliaryID, // comment here
SOX, SOY, SOThickness, SOColor, SOUseFillColor, SOFillColor,
// comments allowed here too
// note that blank rows are ignored
SOSize, SOWidth, SOOrientation, SOLevel, SOImmobile,
SLName, SOStyle, SODashed, // more comments
SOBelongsToGroup])
One general note regarding the field names however. Some field names may be augmented with a
field location. One example of this is the field BusNum when identifying branches. Bus numbers must
be used to identify the from and the to end of branches. To keep the number of fields from becoming
too large, the same field name is used for both of these values. The from bus number is written as
BusNum:0 and the to bus number is written as BusNum:1. Note that the :0 may be left off of field
names.
The create_if_not_found field is optional. This specifies whether or not to create a new object if an
existing one is not found. If the value is YES, objects will be created. If the value is NO, objects will
not be created. If omitted, the default behavior of prompting the user about whether or not to create
a non-existing object will continue. If loading and auxiliary file using the LoadAxd script command,
the create_if_not_found field for the data section will override the CreateIfNotFound field with
the script.
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Data Key Fields for Display Auxiliary File
Simulator uses certain fields to identify the specific object being described. These fields are called key
fields. For example, the key field for DISPLAYBUS objects is BusNum, because a bus can be identified
uniquely by its number. The key fields for DISPLAYGEN objects are BusNum and GenID. To properly
identify each object, the object’s key fields must be present. They can appear in any order in the
list_of_fields (i.e. they need not be the first fields listed in list_of_fields). As long as the key fields
are present, Simulator can identify the specific object.
Display objects have an additional key field used for identification because multiple objects can be
present on the same one-line diagram that represent the same power system element. This extra key
field is SOAuxiliaryID. This is a field that is unique for each type of display object and other key
field combination. If there are two display buses that represent bus one in the power system, the
SOAuxiliaryID field will be different for both. Simulator will automatically create unique identifiers
when these objects are created graphically. They can also be user specified but are forced to be
unique. This field does not need to be present when reading in a display auxiliary file, but if it is
missing, Simulator assumes that the ID is "1". This field is the only key field identifier for objects that
do not link to power system elements such as background lines and pictures, and therefore, should
always be included when reading in these objects or the expected results may not be achieved.
By going to the Auxiliary Files ribbon group on the Window ribbon tab and choosing Export
Display Object Fields you will obtain a list of fields available for each object type. In this output, the
key fields will appear with asterisks *.
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Data List for Display Auxiliary File
After the data argument list is completed, the Data list is given. The data section lists the values of the
fields for each object in the order specified in list_of_fields. The data section begins with a left curly
brace and ends with a right curly brace. A few points of interest regarding the value_list:










The value_list may take up several lines of the text file.
Each new data object must start on its own line of text.
When encountering the PowerWorld comment string ‘//’ in one of these lines of the text file, all
text to the right of this is ignored.
Blank lines, or lines whose first characters are ‘//’ will be ignored as comments.
Remember that the right curly brace must appear on its own line at the end of the data_list.
If the file_type_specifier is CSV, the values should be separated by commas. Otherwise,
separate the field names using spaces.
Strings can be enclosed in double quotes, but this is not required. You should however always
enclose strings that contain spaces (or commas) in quotes. Otherwise, strings containing commas
would cause errors for comma-delimited files, and spaces would cause errors for space-delimited
formatted files.
A string in the format &[ModelExpressionName]:[#digits]:[#decimals] will be treated as though
the value of the named model expression is entered in the field, with [#digits] total and
[#decimals] digits to the right of the decimal point. This format may be used in case information
displays as well as in AUX files.
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Special Data Sections
There are several object types that should be noted here because they can impact the reading of an
entire display auxiliary file, overall look of the resulting one-line diagram, or require special input to
properly import/export the object.
GeographyDisplayOptions
Most objects supported in the display auxiliary file have coordinates that can be specified in the
appropriate data sections. What these coordinates specify can be controlled by the
GEOGRAPHYDISPLAYOPTIONS object. This object has only two fields available: MapProjection and
ShowLonLat. There are three possible settings for MapProjection: "x,y", "Simple Conic", and
"Mercator". The choice of projection will determine how the x,y values for display objects are
interpreted. ShowLonLat can be either "YES" or "NO". If ShowLonLat is "YES", the setting specified
for the MapProjection will be the longitude,latitude projection used when reading/writing the object
x,y values. If ShowLonLat is "NO", the x,y values will always be interpreted as x,y regardless of the
MapProjection setting. This object should be placed in the display auxiliary file before any other
objects containing coordinates are read. If this object is not included in the auxiliary file, the
coordinates will be interpreted based on the current settings of map projection and whether or not
coordinates are showing longitude,latitude.
Picture
PICTURE objects represent background images that cannot be stored in a text file format. To
properly include a PICTURE object in a display auxiliary file, the file containing the image must be
saved and read along with the auxiliary file. The FileName field indicates the name and location of
the image file. If the image file cannot be found when reading in a display auxiliary file and
attempting to create a new object, no PICTURE object will be created. If attempting to update an
existing object and the image file cannot be found, the object will not be updated with a new image,
but the FileName field will be updated with the specified file name.
PWFormOptions
One-line display options that affect the current display settings can be changed by using the
PWFORMOPTIONS object. Usually, this object specifies named sets of options that can be selected
and used to change the various one-line display options through the GUI. By including a specially
named object, the current options can be changed through a display auxiliary file.
PWFORMOPTIONS are named using the OOName field. Setting this field to
"THESE_OPTIONS_ARE_APPLIED_TO_THE_CURRENT_DISPLAY" will apply the specified set of
options to the current one-line when the file is read. When saving the entire one-line to a display
auxiliary file, a PWFORMOPTIONS object with this name is added to the file by default.
View
Different views can be specified in the display auxiliary file using the VIEW object. Usually, this
object is used to specify named sets of options used to select and change the view through the GUI.
By including a specially named object, the current view can be changed through a display auxiliary
file. VIEW objects are named using the ViewName field. Setting this field to
"THIS_VIEW_IS_APPLIED_TO_THE_CURRENT_DISPLAY" will apply the specified set of view options
to the current one-line when the file is read. When saving the entire one-line to a display auxiliary
file, a VIEW object with this name is added to the file by default. If no view is specified as such
during loading, the display defaults to a Show Full view.
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Data Subdata Sections for Display Auxiliary File
The format described in the Data Section works well for most kinds of data in Simulator. It does not
work as well however for data that stores a list of objects. For example, a contingency stores some
information about itself (such as its name), and then a list of contingency elements, and possible a list
of limit violations as well. For data such as this, Simulator allows <SubData>, </SubData> tags that
store lists of information about a particular object. This formatting looks like the following:
DATA (object_type, [list_of_fields], file_type_specifier)
{
value_list_1
<SUBDATA subobject_type1>
precise format describing an object_type1
precise format describing an object_type1
.
.
.
</SUBDATA>
<SUBDATA subobject_type2>
precise format describing an object_type2
precise format describing an object_type2
.
.
.
</SUBDATA>
value_list_2
.
.
.
value_list_n
}
Note that the information contained inside the <SubData>, </SubData> tags may not be flexibly
defined. It must be written in a precisely defined order that will be documented for each SubData
type.
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Data Common Sections
ColorMap
Same format as in data auxiliary files.
CustomColors
Same format as in data auxiliary files.
DynamicFormatting
Same format as in data auxiliary files.
Filter
Same format as in data auxiliary files.
GeoDataViewStyle
Same format as in data auxiliary files.
PWFormOptions
Same format as in data auxiliary files.
SelectByCriteriaSet
Same format as in data auxiliary files.
UserDefinedDataGrid
Same format as in data auxiliary files.
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Data DisplayLine
DisplayDCTramisssionLine
DisplayInterface
DisplayMultiSectionLine
DisplaySeriesCapacitor
DisplayTransformer
DisplayTransmissionLine
Line
This is a list of points defining the graphical line used to represent the object. Each set of
coordinates can be enclosed in square brackets, [ ], or the brackets can be eliminated. The brackets
will be included when Simulator generates an auxiliary file. The individual coordinates are separated
by the specified delimiter, either a space or a comma, and if the brackets are included, the same
delimiter should be used to separate sets of coordinates. The list of points is in a somewhat free
form and sets of coordinates can span multiple lines. Each point should either be in x,y coordinates
or longitude,latitude coordinates. Which coordinates should be used depends on the current option
settings for map projection and whether or not coordinates should be shown in longitude,latitude. If
the display auxiliary file is automatically generated by Simulator, a comment will be included in the
subdata section indicating the coordinate system in use during file creation.
Example using brackets and a comma delimiter:
<SUBDATA Line>
//Coordinates are x,y
[14.00000000, 63.00000000], [14.00000000, 60.00000000],
[20.00000000, 45.00000000], [20.00000000, 42.00000000]
</SUBDATA>
Example with no brackets and a space delimiter:
<SUBDATA Line>
//Coordinates are x,y
14.00000000 63.00000000 14.00000000 60.00000000
20.00000000 45.00000000 20.00000000 42.00000000
</SUBDATA>
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Data PieChartGaugeStyle
ColorMap
This is a lookup table by percentage of scalar and color values. This lookup table will consist of
consecutive lines of text with exactly three values:
Percentage: This is the percentage at which the following scalar and color should be applied.
Scalar: A scalar (multiplier) on the size of the pie chart/gauge.
Color: A color for the pie chart/gauge.
Example:
<SUBDATA ColorMap>
//Percentage Scalar Color
85.0000 1.5000 33023
100.0000 2.0000 255
</SUBDATA>
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Data View
ScreenLayer
This is a list of screen layer names that are hidden in the current view. Each screen layer name is on
a separate line of text.
Example:
<SUBDATA ScreenLayer>
//These are hidden screen layers
"pie layer"
</SUBDATA>
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Simulator Options
Simulator provides a flexible environment for simulating power system operation by offering you
access to a number of customizable options. The Simulator Options Dialog houses pages of options
that you can customize to tailor the program to your needs.
To display the Simulator Options Dialog go to the Options ribbon tab, and choose Simulator Options
from the Case Options Ribbon Group. The Simulator Options button is also available on the Tools
ribbon tab on the Power Flow Tools ribbon group.
If a timed simulation is active when you open the dialog, it is automatically paused and will not resume
until you close the dialog.
There are seven categories of options for the Simulator Options dialog:
Case Information Display Options
Environment Options
File Management Options
Message Log Options
Oneline Options
Distributed Computing Options
Power Flow Solution Options
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Power Flow Solution Options
The Power Flow Solution Tab offers various options regarding how Simulator solves the power flow
problem. There are six sub-categories on the Power Flow Solutions tab: Common Options, Advanced
Options, Island-Based AGC, DC Options, General, and Storage. Each of these categories is shown on
tabs. Many of the options in the Power Flow Solution options will be of interest only to advanced users
of the package.
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Power Flow Solution: Common Options
The following options are all contained on the Common Options tab after choosing the Power Flow
Solution page of the Simulator Options.
Power Flow (Inner) Loop Options (see Solving the Power Flow for information on solution
loops)
MVA Convergence Tolerance
The MVA convergence tolerance serves as a measure for determining when the inner power flow
loop of the Power Flow Solution process has reached an acceptable solution. The MVA mismatch is
computed as the maximum real or reactive mismatch at any bus in the system. Usually, this value
should be around 0.1 MVA. If you are having difficulty solving a particular case, it may be helpful
to temporarily increase the MVA Convergence Tolerance to drive the solution closer to the actual
solution, and then re-solve from this solution using the smaller MVA tolerance.
Maximum Number of Iterations
This option defines the maximum number of iterations Simulator will perform during the Power
Flow Solution process in an effort to converge to a solution. If Simulator must exceed this number
of iterations, it assumes that the power flow case is not converging and will terminate the solution
process. If Simulator is configured to represent non-converging power flow cases as blackouts, the
screen will turn gray and the blackout warning message will appear.
Do Only One Iteration
If checked, then Simulator will only perform one iteration of the load flow solution process when
Single Solution is clicked, regardless of the Maximum Number of Iterations setting. This is useful
when playing with a case with which you are experiencing difficulty.
MW Control (Outer) Loop Options (see Solving the Power Flow for information on solution
loops)
Disable Automatic Generation Control (AGC)
If checked, the enforcement of the Generation Re-dispatch to account for MW interchange
constraints for all areas is disabled. By default, this option is not checked.
Enforce Generator MW Limits
If checked, then generator minimum and maximum MW limits are enforced for all generators
whose Enforce MW Limits field is set to true. See Generator Information Dialog for more
information. Otherwise, generator MW limits are not enforced. Note that when using the economic
dispatch or the Optimal Power Flow, the generator MW limits are always enforced regardless of
user-settings.
Topology Processing Options (These options are only available with the Topology
Processing add-on)
Use Topology Processing
This option is used for all Simulator applications: power flow, contingency analysis, sensitivity
calculations, etc. This option should ALWAYS be checked for real-time cases, while it should be
unchecked for planning cases. If a full-topology model was read and this option is not checked,
the power flow will try to solve the model without removing the switching devices resulting in a
very large ill-conditioned Jacobian. This option is also found on the Topology Processing Dialog.
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Close Breakers to Energize Switched Shunts
If checked, an attempt will be made to close breakers in order to energize a Switched Shunt that
is on either Discrete or Continuous control and is needed to meet its regulated value. This option
is applied as part of the switched shunt control any time that the power flow is solved.
Controller (Middle) Loop Options (see Solving the Power Flow for information on solution
loops)
Disable Checking Gen VAR Limits
If checked, the Mvar limits are ignored for all the generators in the case during a Power Flow
Solution. By default, this option is not selected.
Check Immediately
Before entering the inner power flow loop to solve the power flow equations, a decision is made
about each generator in the case as to whether it will be treated as a PV or a PQ bus. It is
assumed that a PV bus will maintain its setpoint voltage, while a PQ bus will maintain a constant
reactive power output (for instance when the generator is at a Mvar min or max limit). Normally,
the power flow equations are completely solved in an inner power flow loop using this assumption.
After completing the solution, generator Mvar limits are checked to see if they have been reached
(must change from PV to PQ), or if at a limit if the limit may be backed off of (must change from
PQ to PV). If any generators change PQ/PV status, then the inner power flow loop is resolved.
When the Check Immediately option is checked, the generator Mvar limits are checked after
every inner power flow loop iteration instead to see if generator limits have been reached, or if a
generator limit may be backed off. When this option is not checked then it will not check the
generator limits inside the inner power flow loop. In some situations performing this check inside
the inner power flow loop can help with convergence, however performing this check does slow
down the solution process. By default, this option is not selected.
Disable Switched Shunt (SS) Control
If checked, automatic control of switched shunts is disabled in all areas. By default, this option is
not selected.
Disable LTC Transformer Control
If checked, automatic control of LTC transformers is disabled in all areas. By default, this option is
not checked.
Disable Phase Shifter Transformer Control
If checked, then automatic control of phase shifting transformers is disabled in all areas. By
default, this option is not checked.
Transformer Stepping Methodology
Choose either Coordinated Sensitivities or Self-Sensitivity Only. The default value is Coordinated
Sensitivities.
When the regulated value of tap-changing or phase-shifting transformers move outside of their
regulation range, then Simulator attempts to bring those transformers back inside their range. By
default Simulator determines all the tap-changing and phase-shifter transformers which are out-ofrange and coordinates the movement of these transformers in an attempt to bring all the
regulated values back into range. This is what is called Coordinated Sensitivities. Generally this
results in a better convergence, however it also can be slower when a large number of
transformers are out-of-range together. Because it gets slower with a large number of transforms,
if more than 50 transformers are involved in the switching, Simulator will always use the Self-
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Sensitivity Only option. As the solution process continues however, the number of transformers
moving will reduce and eventually the Coordinated Sensitivities will be used again.
Choosing Self-Sensitivity Only will modify this methodology so that each transformer only looks at
the sensitivity of its regulated value with respect to changing its own tap or phase. This calculation
is faster, but may result in convergence problems due to transformers that interact with one
another.
Prevent Controller Oscillations
Sometimes, a power flow will fail to converge because certain automatic controls such as Mvar
limit enforcement at generators, transformer tap switching, and shunt switching oscillate between
their control bounds. These oscillations very often are due to modeling inaccuracies. If this option
is checked, Simulator will automatically detect such oscillating controls and fix them at their
current value so that they no longer oscillate. You may find this option helpful if you feel that the
modeling of automatic controls in your system is inaccurate.
Disable Transformer Tap Control of a Terminal Bus if Tap Sensitivity is the Wrong Sign
(Normally Check This)
As part of the solution process, if the transformer is regulating one of their own terminal buses
then simulator usually disable the transformer tap control of a terminal bus if the tap sensitivity
detect that the regulated bus will move the voltage to the opposite direction. If this option is
unchecked then simulator still will allow the transformer tap control even is the tap sensitivity
detect that the regulated bus will move the voltage to the opposite direction. It is recommended
to always lives this option checked.
Maximum Number Controller Loop Iterations
As part of the solution process, the outer loop of the solution algorithm is a check of any
necessary controller changes due to changes in controlled values from the last iteration of the
Newton-Raphson load flow solution. The maximum number of loops through the control change
algorithm can be set here. This is not the same as the Maximum Number of Iterations, which
applies to the actual Newton-Raphson inner loop algorithm, which solves that actual power flow.
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Power Flow Solution: Advanced Options
The following options are all contained on the Advanced Options tab after choosing the Power Flow
Solution page of the Simulator Options.
Dynamically add/remove slack buses as topology is changed
If checked, Simulator dynamically chooses a new slack bus for the islands if the user-input does not
adequately define slack buses. If a slack bus can not be determined for an island, the island cannot
be solved and will be isolated and ignored during the load flow solution. Also if there are multiple
slack buses specified in the same island, Simulator will choose only one of them as the slack bus.
When allowing dynamic slack bus assignment, the choice of the island slack bus is managed in
Simulator by internally maintaining a list of buses the user has identified as slack buses while in Edit
Mode. In Run Mode, electrical islands are then dynamically determined from the system topology. As
branch statuses are changed, this list of islands (and slack buses) will automatically change. An
island will be considered viable only if it meets the following criteria.
1.
2.

At least one island bus has some on-line generation with a positive Maximum MW Limit and
is NOT set to regulate the voltage at a bus in another island.
At least one island bus has a closed load (Note: It could still be a 0.0 MW load) OR the
island is connected to another island by a DC transmission line.

After the viability of each island is determined, a slack bus will be chosen for each viable island.
(Note: appropriate messages are written to the log when buses are turned into slack buses or
removed as slack buses). If an island has exactly one user-identified slack bus, then that is used as
the slack. If an island has greater than one user-identified slack bus, then the user-identified slack
bus which has the largest maximum generator MW output is used as the slack bus. If an island has
no user-identified slack buses, then one of the buses in the island will be automatically chosen as
the slack bus. When choosing this bus, the four criteria listed below are used. If buses are found
that meets all four criteria, then of those buses the one with the largest maximum generator MW
limit will be used. If no bus is found which meets these criteria, then of the buses that meet the first
three criteria, the one with the largest maximum generator MW limit will be used. Again, if no bus is
found, the first two criteria are used and so on. Under no circumstance will a generator set to any
kind of wind power control mode be selected as an island slack bus.
1.
2.
3.

4.

At least one generator at the bus is set to AVR = YES
The sum of the Maximum MW limits for generators at the bus is less than 5,000 MW (if
there is more, these are probably a fictitious MW limits)
Generators at the bus regulate their terminal bus (this will be required by the slack bus
anyway). However, if another bus with generation that does not regulate its terminal bus is
available and this other bus has a maximum MW output that is 5 times higher, it will be
chosen.
There is only one generator at the bus (it is just easier for the user to keep track of then)

Post Power Flow Solution Actions
Clicking this option will open the Post Power Flow Solution Actions dialog, where the user can specify
a list of actions to be executed at the end of every Full AC power flow solution.
Power Flow (Inner) Loop Options (see Solving the Power Flow for information on solution
loops)
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Disable Power Flow Optimal Multiplier
If checked, the Newton solution process will not use the optimal multiplier. The optimal multiplier
is a mathematically calculated step size for the Newton's Method iteration that prevents the
mismatch equations from increasing between iterations. A small value indicates that moving in the
direction of the Newton step will increase the mismatch equations. When the optimal multiplier
becomes too small, this is an indication that the power flow is not going to solve successfully and
Simulator will stop instead of creating extremely large mismatches. If this happens at a point
where the solution is not within the allowed tolerance for the Newton process, the Newton process
will result in a failed convergence to a valid solution.
Initialize From Flat Start Values
This option only applies to stand alone power flow solutions. Stand alone means a power flow
solution initiated by clicking on the Single Solution button on the Power Flow Tools group in the
Tools Ribbon Tab. This option does not apply to power flow solution initiated by the contingency
analysis, PV Curve, QV Curve, or ATC tools.
When checked, each Power Flow Solution is started assuming that all voltage magnitudes at buses
that are not being regulated by a generator or have attached generators are set to unity. If a bus
is regulated by a generator or is a generator bus, the voltage magnitude is set to the voltage
setpoint of the generator. Voltage angles are set to the voltage angle of the system slack bus. By
default, this option is not selected. Some power flow problems can be very difficult to solve from
flat start assumptions. Therefore, use this option sparingly.
Minimum Per Unit Voltage for Constant Current Loads
This option is used to model the impact that falling voltage has on loads throughout the system.
The default value is 0.5.
For constant current loads with a terminal bus below this per unit voltage, the value of the load
will fall off using a sine function so that the load is zero at zero terminal voltage, and so that the
derivative is continuous at the minimum per unit voltage for constant current loads.
Minimum Per Unit Voltage for Constant Power Loads
This option is used to model the impact that falling voltage has on loads throughout the system.
The default value is 0.7.
For constant power loads with a terminal bus below this per unit voltage, the value of the load will
fall off using a cosine function so that the load is zero at zero terminal voltage, and so that the
derivative is continuous at the minimum per unit voltage for constant current loads.
Control (Middle) Loop Options (see Solving the Power Flow for information on solution
loops)
Disable Treating Continuous Switched Shunts (SSs) as PV Buses
Continuous switched shunts are normally treated the same as a generator bus inside the inner
power flow loop (they are treated as buses with fixed power and voltage). Checking this option
will cause the continuous switched shunt to be treated as a constant impedance in the inner
power flow loop with all switch occurring in conjunction with other switched shunts in the voltage
control loop instead.
Disable Balancing of Parallel LTC Taps
Simulator has the capability to attempt to balance tap positions of parallel transformers, in an
attempt to avoid parallel transformers from going to opposite tap settings, inducing loop flow
through the parallel transformers. Checking this option disables the automatic balancing of parallel
transformers. The only transformers that will be balanced are those in parallel between the same
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terminal buses, or those in parallel between terminal buses that are connected with very-low
impedance branches.
Model Phase Shifters as Discrete Controls
If checked, then phase shifters will switch tap positions discretely based on the tap step size of the
phase shifting transformer. By default, this option is not checked, which means the phase shifters
will switch continuously, independent of the tap step size.
Minimum Sensitivity for LTC Control
This option specifies the minimum-voltage-to-tap sensitivity for LTC transformers. All transformers
having an absolute value of voltage-to-tap sensitivity below this value are automatically disabled
from automatic control. This prevents Simulator from changing transformer taps that have little
effect on their controlling voltage. The Transformer AVR Dialog shows the voltage-to-tap
sensitivity for each voltage-controlling transformer.
Disable Angle Smoothing
When a transmission branch status is changed from OPEN to CLOSED across a branch that has a
large voltage angle difference, this can introduce a very large initial power flow mismatch and cause
the inner power flow loop to diverge. Angle Smoothing will alleviate this large angle difference by
smoothing the angles in the system around the newly closed in branch resulting in much better
power flow convergence. Angle smoothing will also work if a series of branches are all closed in
together. Angle smoothing should be enabled by default, but checking this option will disable this.
Angle smoothing works best for individual branches or a series of branches that have been closed
that are not electrically near other branches that have been closed. If modifying a case and adding
in new transmission lines that are electrically near each other, it might be better for solution
convergence to disable angle smoothing.
Disable Angle Rotation Processing
At the end of a power flow solution, by Simulator looks at the bus voltage angles in the case to see
if any are near +/- 180 degrees. If the angles fall outside of +/- 160 degrees, then all angles in the
island will be rotated by the same amount so that the angle range in the islands is equally spaced
around zero degrees. Check this option to disable this feature.
Sharing of generator Vars across groups of buses during remote regulation
When several buses have generators that control the voltage at single bus, this option determines
the method used to determine each buses "share" of the MVar support. There are three options
1.
2.
3.

Allocate across buses using the user-specified remote regulation percentages. This option is
what is used by default and most closely matches the sharing seen in RAW files.
Allocate so all generators are at same relative point in their [min .. max] var range. This option
most closely matches the sharing seen in a few EMS solutions PowerWorld has seen.
Allocate across buses using the SUM OF user-specified remote regulation percentages. This
option most closely matches the sharing seen in EPC files.

It should be noted, generators at the same bus always allocate vars so they are at the same relative
point in their [min..max] MVar range. How vars are allocated to generators at the same bus has no
effect outside of that bus so options are not given for this sharing.
Include Loss Penalty Factors in ED
If checked, the economic dispatch calculation will consider losses in determining the most economic
generation dispatch. Otherwise, the generation dispatch calculation will disregard system losses.
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Enforce Convex Cost Curves in ED
The economic dispatch algorithm attempts to set the output of all generators that are set to be
automatically controlled so that the system’s load, losses, and interchange are met as economically
as possible. The algorithm is guaranteed to reach a unique solution only when all generator cost
curves, which model the variation of the cost of operating a unit with its output, are convex. If this
option is checked, Simulator will identify units whose operating point is outside the convex portion of
the cost curve and set them off automatic control.
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Post Power Flow Solution Actions Dialog
The Post Power Flow Solution Actions dialog describes a list of actions that are executed at the end of
every Full AC power flow solution, which means they are not performed for DC solutions. Normally,
these actions would all have Model criteria specified.
To open this dialog, select Simulator Options from the Case Options ribbon group on the Options
ribbon tab. Next, go to the Power Flow Solution category. Then click on the Advanced Options.
Finally click the button labeled Define Post Power Flow Solution Actions.
Check the Do Not Used Post Power Flow Solution Action List check-box to disable using any
actions defined in the list.
The action list display identifies the actions that comprise the post power flow solution action list.
Actions can be inserted or deleted by using the local menu on the dialog. Right-click on the display and
select Insert or Delete. Actions are inserted via the Contingency Element Dialog.
The action display is a type of Case Information Display and thus shares many common to all other
case information displays.
The Action List Display always contains the following fields:
Actions
This shows a string which describes the action. You may customize the format of the string that
describes the actions by right-clicking on the Action List Display and choosing Display
Descriptions By, and then choosing either Name, Num, Name/Num, PW File Format by Numbers,
PW File Format by Name/kV or PTI File Format.
Model Criteria
Simulator allows you to define Model Criteria, which consist of both Model Conditions and Model
Filters. These specify a criteria under which a contingency action would occur. For example, you
could specify that a generation outage only occur if the pre-contingency flow on a line is higher than
a specified amount. Normally, no Model Criteria will be specified, and this field will be blank. Also,
note that Model Criteria can be overridden by the Model Condition and Filter option on the
Contingency Options Tab. You can open a dialog to define Model Filters or Conditions by rightclicking on the Action List Display and choosing Define Model Criteria.
Status
Three options are available for this field





CHECK : The action will be executed only if the Model Criteria is true. It will also be executed if no
model criteria is specified. This is the default setting
ALWAYS: The action will always be executed, regardless of the Model Criteria.
NEVER: The action will never by executed, regardless of the Model Criteria.
POSTCHECK: This action is checked AFTER the other Check and Always actions have been
performed and the load flow solution solved. If the criteria specified for the Postcheck action are
met in the resulting load flow solution, then this action is taken and the load flow is again
resolved. This will recursively occur for all Postcheck actions until either all postcheck actions have
been taken, or the criteria for all remaining postcheck actions have not been met.

Note that the Never action allows you to disable a particular action without deleting it.
Comment
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A user-specified comment string that can be associated with this action. While this comment is not
used by Simulator in any way, these comments can be saved to be loaded at a later time. This is
provided for the user to add comments regarding the action. For example, for an action with a
Model Criteria you may could add a sentence explaining why the action is only performed under the
specified criteria.
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Power Flow Solution: Island-Based AGC
The following options are all contained on the Island-Based AGC tab after choosing the Power Flow
Solution page of the Simulator Options.
The Island Based AGC options allow the user to choose to dispatch generation by island instead of by
area or super area. The options available for dispatch here are:
Disable (Use the Area and Super Area Dispatch Settings)
When this option is selected, Island Based AGC is being used, and generators are dispatched
according to the usual area or super area generation dispatch.
Use Participation Factors of individual generators
When selected, the island-based AGC is used, based on the individual participation factors of each
generator within the island. Area and super area ACE requirements will be ignored, and all
generators in the island will be dispatched to serve load, losses, and any DC transfers to other
islands.
Note that if all generators with AGC = YES have participation factors also equal to 0.0, then all
make-up power will come from the island slack bus.
Calculate Participation Factors from Area Make Up Power Values
The AGC will dispatch generation by use area make up power values, instead of by individual
participation factor. What this means is that each area will be assigned a make up power value,
similar to assigning a participation factor to a generator. Based on the make up power value of each
area in the island, the amount of the generation dispatch needed will be divided amongst each area
based on its value. Higher value will account for more of the generation dispatch than areas with
smaller values. The within each area, the generation dispatch is handled on an individual generator
participation factor basis, where each generator will account for a portion of the dispatch that was
assigned to its area.
To specify the make up power values for each area, click on the Specify Are Make Up Power
Values button. Note that these settings are the same as those used by Contingency Analysis
Options Make Up Power, therefore changing these values will affect the contingency analysis.
For example, three areas have participation factors of 2, 1 and 1, respectively. If the total
generation redispatch in the island is 100 MW, then area 1 will account for 2 / (2+1+1), or 50%, of
the total. Therefore area 1 is expected to redispatch by 50 MW. If area 1 then has two generators
with participation factors of 4 and 1, they will account for the 50 MW by picking up 4 / (4+1) and 1 /
(4+1), or 80% and 20%, respectively, of the 50 MW needed from the area.
Note that if all areas have CTG Make Up Gen equal to 0.0, then all make-up power will come from
the island slack bus.
Dispatch using an Injection Group (Loads and Generators will respond)
Checking this option will allow for the island dispatch to be covered by change in generation and/or
load defined in an injection group.
Additional options are available when dispatching based on an injection group:
Allow only AGC Units to Vary
If this option is checked, only units whose AGC status is turned on will be allowed to participate
in the injection group dispatch.
Enforce unit MW limits
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If checked, then each generator’s defined MW limits will be strictly adhered to during the
redispatch.
Do not allow negative loads
When checked, loads included in the injection group are not allowed to drop below zero MW or
MVAR load demand.
How should reactive power load change as real power load is ramped?
You can choose to keep the ratio of real and reactive power constant for each load that is
included in the injection group, or you can specify a constant power factor that the MVAR value
will be determined from when the MW value is changed.
Island AGC Tolerance
This sets the AGC tolerance in MW for the real power balance of each island for all options except
Disable (Use the Area and Super Area Dispatch settings). Generation must equal load plus
losses plus DC line exports in each island. If necessary, each island slack bus output will vary during
the Power Flow (Inner) Loop solution to maintain the real power balance for the island. If it varies
more than the specified tolerance and if a form of Island-based AGC is specified, then adjustments
to AGCable units will be made in the MW Control (Outer) Loop according to the selected Islandbased AGC option.
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Power Flow Solution: DC Options
The following options are all contained on the DC Options tab after choosing the Power Flow Solution
page of the Simulator Options.
Use DC Approximation in Power Flow
When this box is checked, Simulator will solve the load flow using the DC Approximation method.
When not checked, Simulator performs the modified Full Newton AC load flow algorithm. Note that
once a case, especially a large one, has been solved using a DC approximation, it tends to be quite
difficult to revert back to the Full Newton AC load flow from a solved DC approximation.
DC Power Flow Model
Note: These choices also affect the calculation of sensitivities on the PTDF, LODF, and TLR dialogs
and ATC Tool calculations.
Generally, the only inputs that affects the DC Power Flow equations are line impedances and line
status (open/closed). However there are three possible modeling choices (for which there is not
general agreement in the industry) that will affect the "DC equations" in small ways. These choices
are made here on the DC Power Flow Model options
Ignore Series Resistance (r) or Ignore Series Conductance (g)
The series term of a transmission line consists of an r and x value which represent a complex
number impedance. In the DC power flow approximation, the value that used is the imaginary part
of the inverse of impedance (called admittance)
g + jb = 1 / (r + jx) = r / (r^2 + x^2) – j x / (r^2 + x^2)
Thus
g = r / (r^2 + x^2)
b = – x / (r^2 + x^2) *** This term is used in the DC power flow equations
The only term that is used in the DC power flow equations is the b term. Some say that a DC power
flow means that r = 0 which means that b = -1/x and g = 0. Others say that a DC power flow only
means assuming that g = 0, which means that b = - x / (r^2 + x^2). There is not a good
consensus in the industry as to what is correct regarding this, so Simulator offers an option as to
whether you ignore r or ignore g. The default option in PowerWorld is to ignore the resistance.
Ignore Transformer Impedance Correction Tables and Ignore Phase Shift Angle Effects
These are both ignored by default.
When a transformer impedance correction table is specified for a transformer, then the series
impedance of the transformer will vary by a multiplier with the tap or phase of the transformer. The
tap ratio is not generally relevant to a DC power flow, however the phase-shifter angle could very
when using the DC approximation. This option specifies whether to ignore the impact of this
impedance correction. For phase shifters the multiplier is normally between 1.00 and 1.50 and thus
tends to increase the impedances as you move away from zero degrees.
As a branches phase shift varies, the DC power flow equations could be modified to take this into
account. This effect results in the DC power flow equations for which the "b" term above is
multiplied by the cosine of the phase angle across the line. This effect tends to decrease the
impedance as you move away from zero degrees.
Because the impedance correction tends to increase impedance and the phase effect tends to
decrease impedance it is reasonable to ignore both of these, and this is done by default. The other
issue with not ignoring these is that both create a situation where the equations for the DC
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approximation are dependent on the system state. In other words, the matrix equations become a
function of the phase-shift angle. This results in a situation in which the matrices must be
recalculated and re-inverted each time a phase angle is moved. This removes some of the
advantages of the DC approximation. This can be especially problematic when using the OPF or
SCOPF.
Compensate for Losses by Adjusting the Load
Traditionally a DC load flow is treated as lossless. However, you can approximate the loss in the load
flow by artificially adjusting the load in the case to include estimated losses. To do so, click on the
DC Loss Setup button to open the DC Power Flow Loss Setup dialog for setting the DC Loss
Multipliers.
Compensate for Reactive Power Flows by Adjusting the Branch Limits …
One issue with DC load flow is how to treat the inclusion of reactive power flows. In a standard DC
load flow, the reactive flows are typically ignored, and the MW flow of a branch is compared to its
original MVA branch limit. However, Simulator also gives you the option to instead solve the DC load
flow and compute approximate MVAR flows by assuming the voltages in the system remain constant
when the DC load flow is solved.
Compensate for Dispatch Sensitivities with User-Specified Values
This option allows for the bus MW loss sensitivities to be used in the OPF and ED dispatch
algorithms, if the type of loss sensitivity on the General tab is set to User-Specified.
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DC Power Flow Loss Setup
To open the DC Power Flow Loss Setup dialog, select Simulator Options from the Case Options
ribbon group on the Options ribbon tab. On the Power Flow Solution page, click on the tab labeled DC
Options. Next, click the button labeled DC Loss Setup. This button will only be enabled when you
check the box to Use DC Approximation in Power Flow/OPF/SCOPF.
The DC Power Flow Loss Setup dialog gives you a location to apply approximate losses during a DC
load flow solution. The losses can be approximated by scaling the loads in the case to include an
approximation of losses. Loss multiplication factors can be applied individually by bus, or as a group by
area or by zone. Note that loss multipliers by area or by zone are just quick ways for setting the bus
multiplication factors for all buses in the group. You will see the value reflected for all buses in the
Buses page. If you wish to apply the same multiplication factor to the entire case, you can simply set
the Case DC Loss Multiplier at the bottom of the dialog. This will automatically set all buses in the case
to have the same DC Loss Multiplier specified.
Once the DC Loss Multipliers have been set, click OK to save the multipliers.
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Power Flow Solution: General
The following options are all contained on the General tab after choosing the Power Flow Solution
page of the Simulator Options.
Assumed MVA Per-Unit Base
This option allows the user to specify the MVA base to be used for the entire case. By default, this
value is set to 100 MVA. Click on the Change System Base button to change this value and then
update all the internal structures to store the proper values on the new base.
Bus Loss Sensitivity Function
Bus loss sensitivities indicate how island or area losses change with power injection at the bus. Here
you may choose to forego the calculation of bus loss sensitivities or to base them on island losses or
area losses. If the case consists of only one island, which, by definition, corresponds to the entire
system, then the bus loss sensitivities are measured with respect to total system losses. If the bus
sensitivities are set to User-Specified, the sensitivities will remain at their last calculated values,
according to the loss function type previously specified when the loss sensitivities were calculated.
Monitor/Enforce Contingent Interface Elements
This global location allows you to determine how contingency elements in an interface should be
treated in Simulator. You can choose to never include the impact of contingent elements on
interface flow, to only include contingent element impacts in the standard power flow or optimal
power flow routines, or in all solution routines including contingency analysis and security
constrained OPF.
It is not uncommon to ignore the impact of contingent elements when using the contingency
analysis or security constrained OPF tools, as they are already processing lists of contingencies and
evaluating flows on interfaces. Ignoring contingent elements within interface definitions allows for a
determination of the impact of other contingencies on the flows of the non-contingent elements
forming the interface, without impact from additional contingent element considerations.
Power Units for Display
Allows switching between displaying power values in Mega- units or Kilo- units.
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Power Flow Solution: Storage
The following options are all contained on the Storage tab after choosing the Power Flow Solution
page of the Simulator Options.
Simulator offers the ability to restore either the last power flow solution state or the state of the
system immediately before the last solution attempt. If your system has insufficient memory and you
are working with large systems, you may wish to disable one or both of these options.
Disable "Restore last solution"
Restoring the last solution will undo any changes made to the data that were made after the last
successful solution and return the case to the last valid solution. For large cases, the amount of
memory required to store the last solution can be significant. If this option is checked, Simulator will
not store this information in memory, and the last solution cannot be restored if a solution fails.
Disable "Restore state before failed solution attempt"
Restoring the state before failed solution attempt will undo only the attempted solution, but will
retain any changes to data that were made before the solution process. This allows the user to
return to the point just before the solution in order to add or remove changes in an effort to obtain a
valid solution. For large cases, the amount of memory required to store the state before a solution
attempt can be significant. If checked, Simulator will not store the state information in memory, and
the state before the failed solution cannot be restored.
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Message Log Options

Show Log
If checked, the message log is displayed. The message log shows detailed results of each Power
Flow Solution. Usually this log is NOT shown. However, if you are running into problems with a
simulation case, it can prove useful for debugging the case.
Show Time Stamps
Checking this option will display the date and time at which each message is posted in the message
log.
In log Messages, Identify buses by
This option allows the user to specify how to identify the buses in log messages. The options are by
numbers, by names, or by both numbers and names.
Include Nominal Voltages in Log
If checked, this option will make the buses to be displayed with their nominal voltages after their
name.
Suppress the following messages in the log
Checking the check-boxes in this option will remove the corresponding message writing to the log,
thus speeding up the computation process. The boxes to the right of the messages indicate the color
with which the messages will be displayed in the log.
An example of how these colors are reflected in the message log is shown in the following image.
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Environment Options
The Environment page provides you control over a number of display and simulation options. The first
section of the page contains a list of check boxes that you can use to designate the content of the
oneline displays.
These options include:
Do Not Solve While Animating (Display Only)
If checked, Simulator only displays the case; it does not solve the power flow equations. System
flows are determined by the initial values in the case file. This option should be checked if you
simply want to use Simulator to visualize a case that has already been solved. The advantage of the
display-only mode is that animation is significantly faster, particularly for large cases. The drawback
to the display-only mode is that the power flow equations are not automatically solved at each time
step; you must explicitly call for a Power Flow Solution using either the Single Solution button in
the Power Flow Tools ribbon group on the Tools ribbon tab or choose one of the solution options
under the Solve menu in the Power Flow Tools ribbon group.
Play/Animation Solution Method
This option is available only for OPF releases of Simulator. Use it to indicate whether Simulator’s
repetitive power flow should perform a normal power flow solution or an optimal power flow (OPF)
solution.
Solution Animation
Check Auto Start Solution Animation to automatically start the animation after loading the case.
Check Auto Solve On Load to automatically solve the power flow solution when the case is loaded.
Show Log
If checked, the message log is displayed. The message log shows detailed results of each Power
Flow Solution. Usually this log is NOT shown. However, if you are running into problems with a
simulation case, it can prove useful for debugging the case.
Disable Showing Blackouts
You can dramatize a power flow case’s failure to converge by representing it as a blackout. The
background of the oneline diagram will become a dark shade of gray, and a message box will appear
to announce that the system has experienced a blackout. To disable this behavior, select the Disable
Showing Blackouts box. Representing the failure to converge as a blackout can be very helpful for
presentation purposes. Very often, the power flow’s failure to converge can be traced to the
system’s inability to serve the load demand, a situation that requires that load be "blacked out," or
shed, to restore the system to a viable operating state. Thus, displaying the failure to converge as a
blackout has physical significance.
Disable AGC When Manually Changing Generator MW
When this option is checked, changing the MW output of a generator manually will automatically
remove a generator from Automatic Generation Control. If you wish for generators to maintain their
automatic generation control settings following a manual change of MW output, you must uncheck
this option.
Open Associated Oneline Diagrams
By default, Simulator has always attempted to open any diagrams that were open with a case file
when the case file was last closed. However, now you may uncheck this option and Simulator will
not attempt to open any oneline diagrams when a case is loaded.
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Auto Open Bus Records if No Oneline
If a case is opened in Simulator which does not have an associated oneline diagram, then Simulator
will automatically open the Bus Records case information display if this option is checked.
Allow to Prompt for comment when saving case
If checked it will force saving the case with comments by popping a dialog every time a case is
saved.
Auto Set Case as Base Case for Difference Flows when Loaded
This option allows the case to be set as a base case automatically after being loaded. This can be
done always or never, or only if the base case has not been set before opening the case.
Reset Default Positions and Styles for all Dialogs
Click this button to reset the default position, size and Free-Floating/Contained style of the dialogs.
See Window Basics for more information.
Custom Colors
This option allows the user to edit the custom colors used throughout all Simulator color dialogs.
Clock Style
The clock serves as a timer for timed simulations by showing the current time, the start time, and
the end time of the simulation. You can choose to hide the simulation clock by specifying a clock
style of None. Otherwise, to display the clock in its own window, choose Dialog, and to display the
clock on the program’s status bar, select Status Bar.
Measurement System
This option allows the user to choose English (Imperial) or Metric (SI) units for system
measurements. By default, this option is set to English units.
Recently Used File List Entries
The maximum number of file names and locations stored in the History List of the File menu.
Undo Memory Limit Per Oneline
The approximate maximum number of Megabytes allowed to be used in storing actions carried out
when editing a oneline diagram, which can be undone at any time.
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Oneline Options
These options are available on the Oneline tab of the PowerWorld Simulator Options dialog. It is
important to note that the options on this dialog apply to all oneline diagrams. There are also a large
number of options which apply only to an individual oneline diagram. The diagram-specific options are
specified on the Oneline Display Options Dialog.
There are two sub-categories on the Oneline Options tab: Visualization and File.
Visualization
Visualizing out-of-service elements
These three options allow you to choose how objects on the diagram should appear when they are
representing a power system device that is currently "open" or "out-of-service." The three options
are Blink, Use dashed lines, and Draw and X through off-line generators. The first two options apply
to any oneline object, while the third option is specific to generator objects only.
Set gen MW to min when closed from oneline
This option allows the generator MW value to be set to its minimum MW output after a circuit
breaker is clicked in the oneline display. Normally the generator's status is set to closed and the MW
value is reset to its previous value.
Show Oneline Hints
If checked, pop-up hints will appear when you drag the mouse over an object in the oneline. These
give information about the object; for example, for a generator the pop-up hint displays the bus
number, generator ID, the MW output and the MVAR output. You may also customize the pop-up
hints for each kind of display object by choosing Options > Custom Hint Values from the menu.
Show X,Y Coordinates
If checked, the (x,y) location of the cursor is monitored in the status bar at the bottom of the
screen. The (x,y) location of the cursor is only shown in Edit Mode. By default, this option is
selected.
Save Contour Image with Oneline File
If checked, and if a contour is being displayed on the oneline diagram, Simulator will store the
contour with the oneline diagram when you save the case or save the oneline. It will store the
contour as a bitmap.
Display Unlinked Elements in Run Mode
Typically, unlinked graphical objects are not visible in Run Mode. Checking this option will allow the
display of unlinked elements during Run Mode.
Enable Mouse Wheel Zooming
This option allow the use of the mouse wheel to zoom in and out in the currently selected oneline
diagram.
Maximum number of open onelines
Option to specify the maximum number of onelines that can be open simultaneously (this option
defaults to 10). If this maximum threshold is exceeded than PowerWorld will automatically close the
oneline whose most recent access is the oldest. By default a oneline can be closed in this manner,
but an additional oneline-specific option has been added that can be changed to prevent this
closure. This feature is useful for users who make extensive use of oneline links or substation display
object links which can make opening dozens of onelines very easy. Opening dozens of onelines can
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slow down the program substantially. If you have a main oneline from which other onelines are
automatically opened, then you may want to prevent the main oneline from closing.
Minimum Screen Font Size
The minimum font size at which text is visible on the screen. When text is rendered to the screen,
any text which is smaller than this font size will not be rendered. This is useful when zooming out on
a oneline diagram where a lot of text might become cluttered or hard to read on the screen.
Minimum Print/Copy Font Size
The minimum font size at which text can be printed or copied. This is useful if the application or
printer you are sending to can or cannot display smaller fonts. When text is printed, any text which
is smaller than this font size will not be printed. Normally the Minimum Print/Copy Font Size is
smaller than the Minimum Screen Font Size because the resolution of the printed document is much
higher than the screen resolution.
Transformer Symbol
Since transformer representation varies in different countries, this option allows the user to
represent transformers as coils or circles. By default, transformers are represented as coils.
Line Navigation Arrows
These settings control whether the Pixel Size of the arrows, how long in seconds it should take to
pan to the line end locations, and whether to show navigation hints as your mouse hovers over the
arrow. See Oneline Zoom and Panning for more information.
File
Automatic Loading of Display Auxiliary File
This option is used options to automatically load a Display Auxiliary File (AXD) with one specific
oneline. This setting is stored in the case (PWB) so that it only applies to onelines opened with the
specific case.The file full path location has to be specified in the Display Auxiliary File box.
Automatic Loading of Display Auxiliary File with ANY oneline (Only saved to the Registry)
This option is used options to automatically load a Display Auxiliary File (AXD) with each oneline that
is opened. This setting is stored in the windows registry so this applies to all onelines opened on the
computer. The file full path location has to be specified in the Display Auxiliary File box.
Main Oneline File
This option is used to identify the primary oneline diagram to use with the case. The main oneline is
the file that is displayed when you first open the case. The dropdown box lists all the oneline files
that reside in the same directory as the case. Select one of these files, or enter the full path of the
oneline you want to use if it does not appear in the dropdown box.
Use Default Oneline File
You can command Simulator to open a particular oneline diagram file if it cannot find a oneline
diagram file for the case you are trying to open. For example, there is no oneline diagram associated
with a PSS/E raw data file when you first read it into Simulator. However, if your application is such
that you will always use the same oneline file whenever you open a PSS/E raw file, check the Use
Default Oneline File to have Simulator open the oneline identified in the Default Oneline File
box whenever it encounters a case that has no associated oneline. The default oneline must exist in
the same directory as the case you are trying to open.
Automatically Show Full when opening any oneline
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This option is used to show the oneline diagram completely when opening any oneline. If the
oneline was previously saved in a particular location in the diagram, if at the moment of opening a
oneline this option is selected then the oneline will open showing the full oneline.
Edit Oneline Browsing Path
This option applies when you have Oneline Links included on a oneline diagram. Rather than specify
the full path and name of a oneline diagram as a oneline link, you can specify the file name only.
When the link is clicked in Run Mode, Simulator will check all directories listed here, in order, to try
and find the oneline file name stored with the link. This browsing path is also used when looking up
Shapefile Database Rcords and when finding the substation layout, URL, or command specified on
the Substation Information Dialog.
Save Onelines when Saving Case
By default, Simulator always saves any oneline diagrams that are open when the user chooses to
save the case (pwb) file. This option allows you to choose to be prompted to save oneline diagrams
when a case file is saved, or to never save onelines when the case file is saved.
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Case Information Display Options
PowerWorld uses numerous case information displays to showjavascript:RelatedTopic1.Click() in tabular
format. The options presented on this page of the PowerWorld Simulator Options Dialog control some
of the general features of the case information displays.
Enterable Field Color
Fields whose values can be directly entered on the case information displays are colored navy blue
by default. Click on the color field to change the color of enterable fields, or click the Change
button.
Toggleable Field Color
Fields whose values can be toggled (changed) by left-clicking on them are colored green by default.
Click on the color field to change the color of toggleable fields, or click the Change button.
At or Exceeding Limit Color
Fields whose values are at or exceeding a limit, are colored red by default. Click on the color field to
change the color of such fields, or click the Change button.
Normal Field
Fields that cannot be modified directly from the case information display are colored black by
default. Click on the color field to change the color of such fields, or click the Change button.
Special External Field
Fields that can be modified through an auxiliary file or by pasting data into a sheet from a
spreadsheet, but cannot be changed in a case information display, are colored black by default. Click
on the color field to change the color of such fields, or click the Change button.
Field not presently used
Fields whose values are overridden by other instances of the program are colored gray by default.
Click on the color field to change the color of such fields, or click the Change button.
Background
Background of cells is colored white by default. Click on the color field to change the color of the
background, or click the Change button.
Heading Background
Background of column and row headings is colored light gray by default. Click on the color field to
change the color of the heading background, or click the Change button.
Data Fill Background Color
Background of selected cells when propagating values is colored yellow by default. Click on the color
field to change the color of the heading background, or click the Change button.
Set Case Info Factory Default Colors
Clicking the Dark Colors button will reset the field and background colors to the defaults mentioned
above, which comprise dark colors for fields, and light colors for backgrounds. Clicking the Light
Colors button will set field and background colors to a specified set of light colors for fields and dark
colors for backgrounds.
Highlight Objects with Selected? = YES
Check this option to automatically highlight all case information rows that represent a model object
that has its "Selected" field set to YES. The row will then be highlighted using the color specified on
this dialog. This option will apply to all case information displays representing all types of objects.
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Save as Auxiliary File Data Format
This option allows the user to decide if the auxiliary files that can be saved from case information
displays should be space delimited files or comma delimited files.
Key Fields to Use in Subdata Sections
This option allows the user to decide whether to use primary or secondary key fields or labels for the
objects saved in the subdata section of an auxiliary file. In addition to being applied to the subdata
section of auxiliary files, this option is also used in some special cases to dictate how elements are
identified. The Labels topic contains additional information about this.
View/Modify Default Font
Clicking this button brings up a font dialog from which you can choose the font in which case
information displays should show their data. Selecting a new font, font size, style, or color and
pressing OK will change the default font, so that all case information displays will then employ a font
having the selected properties. Not an individual case information display can override this setting by
choosing a custom row height or font on the Display Options tab of the Display/Column Options
dialog.
Default Row Height
This option sets the default height of the rows in the case information displays. This field may need
to be changed depending on the screen size and font size of the computer. By default, the height is
set to 13. Not an individual case information display can override this setting by choosing a custom
row height or font on the Display Options tab of the Display/Column Options dialog.
Show Grid Lines
Grid lines are shown by default in case information displays. Unchecking this box will remove the
grid lines from the displays.
Column Headings
This option allows you to choose whether the column headings of the case information displays are
the normal column headings or are the variable names of the type of data stored in each column.
Variable names are the strings used when writing data out to an Auxiliary File. Change the headings
to variable names can be helpful when looking at or creating auxiliary files.
Use Word Wrap
Check this box to wrap the heading column text, breaking it in several rows to fit the current column
width. If unchecked, the column heading text will be displayed in only one row.
Highlight Key and Required Field Column Headings
If this option is checked, the key fields needed for identifying objects will be highlighted in the case
information display. These fields are important if you are planning on pasting data back into
Simulator from Excel or reading data in from an auxiliary file. If the necessary key fields are not
present in the Excel paste of auxiliary file, the data in those formats cannot be processed by
Simulator.
Similarly, the Required Field Column Headings can also be highlighted in the case information
display. In order for Simulator to create new objects by reading them from an auxiliary file or and
Excel paste, the required fields must be present in the pasted data or the object cannot be created.
Show Header Hints
This option allows the hints for the current field to be displayed when moving the cursor over the
column heading.
Copy/Send Options
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Typically when you copy information to the clipboard or send data to Excel from a case information
display, the first two rows of the copied information contain the type of object the data represents
(object name) and the column headings for each column of data. These rows are necessary if you
intend to paste the information back into Simulator, but they are unnecessary if you are only
exporting data to another program with no intention of pasting the information back into Simulator.
Thus, these two options allow you to choose which of the two rows, if either, you wish to have
copied along with the actual data from a case information display when pasting in another
application.
Disable Auto Refresh
This option prevents Simulator from automatically updating the contents of open case information
displays with each solution. If this option is not checked, the data in all open case information
displays will be updated automatically to reflect the system state calculated from each Power Flow
Solution.
Set Factory Defaults
Clicking on this button will reset the options to their defaults.
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File Management Options
There are two sub-categories on the File Management Options tab: PowerWorld Files, and EPC and
RAW Files.
PowerWorld Files
Automatic Loading of Auxiliary File
A default auxiliary file can be loaded when the present case is opened by checking the
Automatically load an auxiliary file when the present case is opened check box. The
auxiliary file given under Auxiliary File will then be loaded with the present case. The full path
needs to be included with the file name.
Automatic Loading of Auxiliary File with ANY Case
A default auxiliary file can be loaded when each case is opened by checking the Automatically
load an auxiliary file when ANY case is opened check box. The auxiliary file given under
Auxiliary File will then be loaded with each case. The full path needs to be included with the file
name.
Automatic Archiving of PWB Files
This option allows you to effectively make backup copies of your working case every time you save
the pwb file. For example, assume you have a case named Test Case.pwb. With the Automatic
Archiving turned on, saving the case will first create a copy of the original file and rename it Test
Case_1.pwb. The character used as a delimiter can be chosen optionally. The case with any changes
you have just made will then be saved as the new Test Case.pwb file. Each time you save the case,
the latest version is named Test Case.pwb, the last Test Case.pwb is renamed with the delimiter and
1 appended, and all other archived versions will be renamed with their number incremented by 1.
The number of archive versions to maintain can also be chosen by setting the maximum number of
archive files property. The automatically archived cases will be saved in the same directory from
which the last case was opened.
Autosave Every … Minutes
This option allows the user to specify how often (in minutes) the case is automatically saved. A
value of zero means that this option will not be used.
Save Unlinked Elements of contingency, interface and injection group records in the PWB
file
Checking this box allows saving any unlinked contingency, interface, and injection group records in
the PWB case. The unlinked elements are only created when read from an auxiliary file containing
unlinked records.
EPC and RAW Files
Display GE Additional Data in Case Information Displays
A large amount of data which is not relevant to the Simulator power flow solution is contained in the
GE EPC file. This data is now all read and stored in Simulator and Simulator’s PWB file format. By
default columns which represent this extra data are not available when choosing Display/Column
Options on a Case Information Display. If you would like these fields to be available, check this box.
Load Additional Data from ECF
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Older versions of Simulator did not read all the extra data from the GE EPC file and instead stored it
in files with the ECF extension. If you would like to read in one of these old ECF files, click this
button.
Remove Additional Data from Case
Because all of the extra data in the EPC can take up a lot of space (approximately doubles the PWB
file size and increases the memory foot-print of Simulator itself too), you may want to just delete all
this information. Click this button to permanently remove this data from your case.
GE EPC Motor Data Table
Part of the extra data read from the EPC file is Motor Data which does not map to an object used
inside PowerWorld. To see this information, click on this button.
PTI RAW Transactions due to tie-line loads
Loads may be assigned to a different area than the load’s terminal bus. PTI offers an option that
allows the user to ignore this assignment when calculating the tie-line flow for an area.
(AREA INT CODE = 1 FOR LINES ONLY)
(AREA INT CODE = 2 FOR LINES AND LOADS)
Simulator does not allow you to define a load this way and then choose to ignore it. Most RAW files
that PowerWorld has seen seem to be solved ignoring the loads that are in different areas than their
terminal bus by using the "lines only" option. To overcome this, when PowerWorld reads a RAW file,
MW Transactions are automatically created with the ID "RAW_LOAD". (You can optionally choose to
load the RAW file "with options". This will allow you to choose whether or not the transactions
should be added. See Case Formats for more information.) These transactions are between the
load’s area and its terminal bus and are created so that the export from each area correctly matches
a case solved using "lines only". If you know that your case was solved using "lines and loads", then
click the button Remove transaction due to tie-line loads. Clicking this will delete all the MW
Transactions with an ID of "RAW_LOAD". You may also click the button Add transactions due to
tie-line loads to recreate a list of transaction which represent flows between loads with different
areas than their terminal bus.
Transformer Regulated Bus Side
EPC and RAW files require the storage of which side of the transformer the regulated bus is on to
determine which direction to move the tap in order to regulate voltage. In PowerWorld the tap
sensitivity is always calculated when a transformer needs to move so this is not relavent. The
buttons are provided to determine this side. If you have a solved power flow solution, then using tap
sensitivities is good. If you do not have a solved power flow, then Recalculate using Closest Bus will
also work (this just determines how far away the regulated bus is from the FROM and TO bus by
summing up the total impedance that must be crossed to reach the regulated bus.)
hdbexport Files
Mapping of CBTyp to Branch Device Type
When loading an hdbexport CSV file, a Branch record in Simulator is created for each CB record. The
Branch Device Type for these branches is defined based on the CB's CBTyp using the following rules:

if CBTyp contains "CB" --> Breaker
Else if contains "LBD" --> Load Breaker Disconnect
Else if contains "GND" --> Ground Disconnect
Else if contains "FUSE" --> Fuse
Else utilize user-Defined rules specified below
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Else -- Disconnect
The Defined rules specified below can be defined in the bottom section of the hdbexport Files
tab. The Priority can be set here for the CBTyp and the Branch Device Type can be specified with
the following options: Breaker, Disconnect, Fuse, Ground Disconnect, or Load Break Disconnect .
Also after loading an hdbexport CSV file, if any CBTyp values were encountered that were not
recognized a dialog box similar to the Defined rules specified below will appear prompting the
user to designate the Branch Device Type rules for each CBTyp.
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Power Flow Tools Ribbon Group
The main function of the PowerWorld Simulator is to simulate the operation of an interconnected
power system. The simulation is accomplished by selecting Single Solution – Full Newton from
either the Quick Access Toolbar or the Power Flow Tools ribbon group on the Tools ribbon tab. This
activity performs a single Power Flow Solution. See Solving the Power Flow for more information.
The following tasks are also available from the Power Flow Tools ribbon group on the Tools ribbon
tab.

Single Solution – Full Newton
The main function of the PowerWorld Simulator is to simulate the operation of an interconnected
power system. The simulation is accomplished by selecting Single Solution – Full Newton from
the Power Flow Tools ribbon group on the Tools ribbon tab. This activity performs a single Power
Flow Solution. See Solving the Power Flow for more information. Also note that if presently in Edit
Mode, you wil be automatically taken to Run Mode when choosing this.
Simulator Options
When choosing any of the solution methods, the options as specified in the Simulator Options will
affect what calculation is performed. solves the power flow using the either the Full Newton AC load
flow or the DC Approximation load flow, as specified in the Simulator Options.
Play Button
Click this button to cause repeated solutions of the system and to cause the animation of oneline
diagrams
Pause/Stop Button
Click this button to stop the action of the Play button.
Restore Menu
The Restore menu offers option to either Restoring a Previous Solution or a Restore a Previous State

Sometimes a power flow attempt won't converge to a solution. When this occurs, the voltages
and angles calculated by the solution engine will not satisfy the real and reactive power balance
constraints at each bus. Then, the state currently stored in memory will not be an actual system
operating point. It is often very difficult to coax the system to solve once it has failed to
converge.
To help you recover from a solution attempt that has failed to converge (both timed simulations
and single solutions), Simulator offers you two options.
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After Simulator solves a system successfully, it will store the voltages and angles it found in
memory. If the changes that you then make to the system result in a system that can't be
solved, you can select Restore > Last Successful Solution from the Power Flow Tools
ribbon group on the Tools ribbon tab to reload the results of the last converged solution. After
reloading this information, Simulator will re-solve the system and refresh all displays.
In addition to restoring the last converged solution, Simulator also gives you the ability to restore
the state of the system as it was just prior to the unsuccessful solution attempt. This can be
thought of as "un-doing" the effect of the solution attempt. Before attempting a solution,
Simulator stores the state of the system in memory. If it solves the power flow successful,
Simulator will discard this pre-solution state. However, it the power flow fails to converge,
Simulator will keep the state in memory. To recover it, select Restore > State Before
Solution Attempt from the Power Flow Tools ribbon group on the Tools ribbon tab.
Simulator will replace the non-converged post-solution state with the pre-solution state and
refresh the displays. You can then play with the system to try to make it easier to solve.
If you are working with large systems, you should be aware that saving these system states can
consume a lot of memory. Therefore, Simulator offers you the option to disable one of both of
these features. To do this, select Simulator Options from the Case Options ribbon group on
the Options ribbon tab to open the Simulator Options Dialog, and then go to the Storage sub-tab
of the Solution tab. You will see two checkboxes there that can be modified to control whether or
not these extra system states are saved.
Solve Menu

Single Solution – Full Newton
The main function of the PowerWorld Simulator is to simulate the operation of an
interconnected power system. The simulation is accomplished by selecting Single Solution –
Full Newton from the Power Flow Tools ribbon group on the Tools ribbon tab, or from the
Quick Access Toolbar. This activity performs a single Power Flow Solution. See Solving the
Power Flow for more information. Also note that if presently in Edit Mode, you wil be
automatically taken to Run Mode when choosing this.
Polar NR Power Flow
This perform a Newton Rhapson power flow solution using polar coordinates instead of
rectangular coordinates as is normally done in Simulator.
DC Power Flow
This automatically change the Simulator Options to use the DC Approximation and then
immediately performs the DC power flow solution.
Reset to Flat Start
Select Solve > Reset to Flat Start from the Power Flow Tools ribbon group on the Tools
ribbon tab to initialize the Power Flow Solution to a "flat start." A flat start sets all the voltage
magnitudes and generator setpoint voltages to 1.0 per unit and all the voltage angles to zero.
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Usually, a flat start should be used only if the power flow is having problems converging. You
can also use the flat start option on the Simulator Options Dialog to initialize every solution
from a flat start.
Robust Solution Process
The Robust Solution Process provides a method to attempt to reach a solution when the
standard load flow (Newton-Raphson) solution fails. The robust process performs a solution in
a series of steps.
First, the robust solution will turn off all controls in the case. Then the load flow will be solved
using a fast decoupled power flow. If the fast decoupled power flow reaches a solution,
Simulator then immediately solves the load flow using the Newton-Raphson load flow, still
keeping the controls turned off. If the Newton-Raphson solution is also successful, Simulator
will begin adding controls back into the solution process, one type of control at a time. Thus
the generator MVAR controls are added back in, and the load flow is resolved. Then the
switched shunt controls are restored, and the load flow is again resolved. Simulator will
continue in this manner by reintroducing next the LTC control, followed by the area
interchange control, and lastly the phase shifter control. Furthermore, when reintroducing the
phase shifter control, the controls are added one at a time for each phase shifter, with a load
flow solution occurring after each.
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Solving the Power Flow
At its heart, Simulator is a Power Flow Solution engine. Power flow is a traditional power engineering
calculation that is performed to determine the flows on all lines and the voltages at all buses in the
system given the power injections at all buses and the voltage magnitudes at some of them.
The power flow problem entails solving a system of nonlinear equations. Solving a nonlinear system
requires the use of an iterative algorithm to hone in on the correct solution. Many nonlinear system
solvers have been developed, and PowerWorld provides access to the full Newton-Raphson method
with an optimal multiplier and the fast decoupled method.
Usually, the power flow computation converges quickly. However, it is certainly possible to model
conditions for which no Power Flow Solution exists, or for which the algorithm cannot converge to the
solution within the maximum number of iterations specified. For such situations, the message log will
provide a message indicating that the computation failed to converge. Furthermore, unless blackouts
are disabled, the screen is grayed, and a message indicating a blackout has occurred is shown.
In order to calculate the power flow solution, simply press the Single Solution button on the main
Program Toolbar. Clicking Single Solution actually performs several pre-processing activities and then
runs three nested loops which solve the power flow: MW Control (Outer) Loop, Controller (Middle)
Loop, and Power Flow (Inner) Loop.
Pre-Processing Activities
The Power Flow Loop is where the traditional power flow matrix equations are solved.
Angle Smoothing
When a transmission branch status is changed from OPEN to CLOSED across a branch that has a
large voltage angle difference, this can introduce a very large initial power flow mismatch and cause
the inner power flow loop to diverge. Angle Smoothing will alleviate this large angle difference by
smoothing the angles in the system around the newly closed in branch resulting in much better
power flow convergence. Angle smoothing will also work if a series of branches are all closed in
together. A message will be written to the message log to indicate this is occurring. Angle smoothing
should be enabled by default, but an option exists with the Advanced Power Flow Solution Options
to disable this. Angle smoothing works best for individual branches or a series of branches that have
been closed that are not electrically near other branches that have been closed. If modifying a case
and adding in new transmission lines that are electrically near each other, it might be better for
solution convergence to disable angle smoothing.
Generator Remote Regulation Viability
Generators are allowed to remotely regulate any bus in the system. However, if there is no
transmission path between the generator terminal bus and the remotely regulated bus which does
not pass over any other PV buses, then the generator will not be able to regulate this bus remotely.
Additionally this will introduce a numerical condition that makes the inner power flow loop not
converge. This pre-processing activity ensures catches this condition and prevents these generators
from performing voltage regulation. A message will be written to the message log to indicate this is
occurring.
Estimate MW Change Needed
When large changes in generation or load are made to the system, then ultimately this entire
mismatch will show up at the island slack buses during the first inner power flow loop. This can
cause the inner power flow loop to not converge. When automatic generation control is enabled for
this system, then this pre-processing activity will automatically try to initialize generator outputs
throughout the system to prevent the entire mismatch from appearing at the slack bus. Eventually
the MW Control (Outer) Loop will be executed to bring generators to their proper outputs as
specified by the Area or Island AGC choices.
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Low Impedances Lines Voltage Profile
When pre-processing the voltage profile, Simulator will look at groupings of buses connected by very
low impedances lines. If a bus in a grouping of energized buses has a zero voltage while other buses
in the group do not, the zero voltage will be changed to the first non-zero voltage found in the
grouping. This provides a much more reliable solution.
Estimate Voltages at Buses that Have Just Been Connected
As part of the pre-processing of voltages, voltages and angles at buses that have just had their
status changed from Disconnected to Connected will be estimated assuming that the voltages and
angles at buses that have not just changed status remain fixed. This will better facilitate power flow
convergence. A message will be written to the message log to indicate this is occurring.
Three Nested Loops
Power Flow (Inner) Loop : Red Loop
The Power Flow Loop is where the traditional power flow matrix equations are solved. There are
several Common and Advanced Solution options which affect this loop. In the message log, a RED
outline will be drawn around the inner power flow loop. Additionally, a PURPLE outline will be
drawn around any generator Mvar limit checking which occurs inside this loop.
Controller (Middle) Loop : Green Loop
Once the Power Flow Loop is solved, control devices check if their control requirements are being
met. Control devices are checked in the following order or precidence.
1.
2.
3.
4.

Generator Mvar Limit Checking
DC Line Solution
Switched Shunt Controls (each switched shunt or switched shunt control group is examined
individually)
Load-Tap-Changing (LTC) transformers and Phase Shifter (can be coordinated switching or
examined individually)

If any control devices requiring changes, then these changes are made and the power flow loop is
re-solved. This continues until no more control loop changes are made. There are several Common
and Advanced Solution options which affect this loop. In the message log, a GREEN outline will be
drawn around this loop.
MW Control (Outer) Loop : Blue Loop
After the Control Loop has completed, the MW Control loop is entered and generation (and possibly
load) is moved to meet the MW control options set in the case. Normally, MW control is done by
area control with each area varying generation to meet its own load, losses and interchange.
However, you may also use island-based control to dispatch MWs by island. If any MW control is
needed, then the Control Loop and Power Flow Loop interaction must be repeated and so on. In the
message log, a BLUE outline will be drawn around this loop.
A depiction of these loops and how you will see them represented in the message log is shown in
the following figure.
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Area Control
One of the most important aspects of interconnected power system operation is the requirement that
each operating area changes its total generation to match changes in the sum of its load plus losses
plus power transactions with other areas. This requirement is normally met by Automatic Generation
Control (AGC). The purpose of AGC is to ensure that the actual MW output of an area is equal to the
scheduled MW output of the area. The AGC system accomplishes this by first calculating the Area
Control Error (ACE), which is defined as
ACE = Pactual - Pscheduled
In Simulator, Pscheduled for an area is made up of the Area’s MW Transactions and the Area’s Unspecified
MW Export. MW Transactions represent the transfer of power between two areas in the power system.
This transaction is done presumably under a contract between the two areas. The advantage of using
MW transactions to describe these is that it ensures that the total export of all areas is consistent: if
one area is exporting 100 then another area is automatically importing that power. However, each
area also specifies a value called the Unspecified MW Export which can be entered on the Area
Information Dialog. The unspecified MW export represents an export of power from the area that goes
to an unspecified other area. When using unspecified MW exports, it is important that the total
unspecified MW exports in the system sum to zero. PowerWorld highly recommends that care be taken
when using unspecified exports.
Whenever the ACE is greater than zero, it means that the area is over generating and thus needs
either to decrease generation or to sell more. Likewise, whenever the ACE is less than zero, the area is
under generating and thus needs either to increase generation or to buy more. AGC works to keep the
ACE close to zero.
In Simulator, there are six options for implementing AGC:
No area control
The output of the generators does not change automatically. You must manually change the
generation to match system load/losses/transaction variation. All change in load/losses/transaction
in this area will be made up at the islands slack bus.
Participation Factor Control
The output of all the area’s generators who have their AGC field set to "YES" change automatically
to drive the area control error (ACE) to zero. Each generator’s output is changed in proportion to its
participation factor. Checking this option enables the Set Factors button on the Area MW Control
Options tab of the Area Information Dialog, which, when pressed, opens the Generator Participation
Factors Dialog. Participation Factor Control only adjusts generation when a change to the system
has taken place, such as changing the amount of load in the case, or defining new area to area
transactions.
In Participation Factor Control, the ACE is allocated to each AGC generator in the area in proportion
to that generator’s participation factor divided by the total of the participation factors for all AGC
generators in the area. A generator’s participation factor cannot be negative. By default, a
generator’s participation factor equals its current MW setpoint value, but individual participation
factors can be changed.
Economic Dispatch Control
The output of all AGC generators in the area changes automatically to drive the area control error
(ACE) to zero. Each generator’s output is changed so that the system is dispatched economically,
based on cost information entered for the generators in the case. Note that cost data is not
generally included in standard load flow data. Without realistic cost data entered into Simulator, the
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use of the economic dispatch algorithm may not be very useful. Cost data must be obtained from
another source and entered into a case in Simulator, either manually or through the use of Simulator
Auxiliary Files.
With Economic Dispatch (ED) Control, Simulator tries to change the output of the area’s AGC
generators economically so that the area’s operating cost is minimized. ED control recognizes that
some generators are less expensive than others and tries to use the least expensive generators to
the largest extent possible.
To do economic dispatch, we need to know how much it would cost to generate one more MW at a
particular generator. This is known as the incremental or marginal cost. For example, for the cubic
cost curve model, the incremental cost for each generator is modeled using the formula:
i = ICi (Pgi) = ( bi + 2ci Pgi + 3di (Pgi) 2 ) * fuelcost $/MWH
The plot of ICi(Pgi) as a function of Pgi is know as the incremental-cost curve. The economic
dispatch for a system occurs when the incremental costs for all the generators (i) are equal. This
value is known as the system  (lambda) or system incremental cost. Its value tells you how much it
would cost to generate one more MW for one hour. The system lambda becomes important when
trying to determine whether or not an area should buy or sell power. For example, if an area can
buy power for cheaper than it can generate it, it might be a good idea for the area to buy power.
Generators that are allowed to participate in economic dispatch control will have their MW limits
enforced regardless of how any of the options specifying that MW limits be enforced are set.
Area Slack Bus Control
Only the output of the area’s slack bus changes automatically to drive the area control error (ACE) to
zero. This type of generation control is usually only good for small disturbances to the injections
and/or transactions in a case, and can often fail to find a solution when larger disturbances are
examined.
Injection Group Area Slack Control
Only the Injection Group specified as the Injection Group Area Slack will change to automatically
drive the area control error (ACE) to zero. This allows you to be very specific with each area as to
which generation (or load) should vary to maintain ACE.
Optimal Power Flow (OPF)
The OPF option will only be available if you have the OPF add-on for PowerWorld Simulator. The
OPF control is very similar to the Economic Dispatch control in that it attempts to dispatch
generation to minimize costs. The additional function of the OPF is to minimize the costs while also
obeying line, transformer, and interface limit constraints. This option is also not useful without
realistic generator cost information, which usually must be obtained from another source and
entered into Simulator to augment a load flow case.
The OPF control also relies on the cost curve in order to perform an economically optimal power
flow. However, the OPF routine makes use of piecewise linear curves in its solution algorithm. This
does not prevent you from entering the cost information as cubic cost models, described by the
equation above. Rather Simulator’s OPF routine allows you to specify how to break up the cubic
curve and model it as a piecewise linear curve for the OPF algorithm.
Generators that are allowed to participate in OPF control will have their MW limits enforced
regardless of how any of the options specifying that MW limits be enforced are set.
In addition, you can also enter piecewise linear curves directly instead of the cubic cost curve models.
In fact, a mixture of piecewise linear and cubic models is acceptable. For the economic dispatch
routine, whichever type of model is entered will be used directly for each generator. For the OPF
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routine, all piecewise linear curves entered directly will be used as is, and any cubic models entered
will be converted to piecewise linear curves internally during the processing of the OPF algorithm.
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Area Control Error (ACE) Chart
The ACE chart plots the area control error for an area over time. For details on ACE, please see topic
Area Control. To access this display, go to the Tools ribbon tab, and choose Other > Charts > ACE
Chart from the Other Tools ribbon group. This option is only available in Run Mode. You may also
press the corresponding button on the Simulation Summary tab of the Area Information Dialog. If you
use the ribbon to view this chart, it shows information for the it shows information for the first area in
the case. The strip chart starts to plot the data when you open it, with new data appearing on the left.
You can change the scale of either the x-axis (the time axis) or the y-axis (Scheduled Transactions
axis) by right-clicking anywhere on the axis itself and specifying the new axis limits and number of
intervals.
Right-click on the display (except on the axes) to view the display’s local menu. The local menu is used
to print the strip chart, save the strip chart in a file, copy the strip chart to the Window’s clipboard, or
change the number of the area being displayed.
Use the display’s control-menu box to close the display (i.e. the ‘X’ button at the top right corner of the
form).
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Area Load and Generation Chart
The Load and Generation chart plots an area’s load + losses and generation in MW when you are
animating (playing) and solving the load flow every animation cycle. To access this display, go to the
Tools ribbon tab, and choose Other > Charts > Area Load and Generation Chart from the Other
Tools ribbon group. This option is only available in Run Mode. You may also press the corresponding
button on the Simulation Summary tab of the Area Information Dialog. If you use the ribbon to view
this chart, it shows information for the first area in the case. The strip chart starts to chart the data (if
animation is running) when you open it, with new data appearing on the left. You can change the
scale of either the x-axis (the time axis) or the y-axis (Load/Generation MW axis) by right-clicking
anywhere on the axis itself and specifying the axis limits and number of intervals.
Right-click on the display (except on the axes) to view the display’s local menu. The local menu is used
to print the strip chart, save the strip chart in a file, copy the strip chart to the Window’s clipboard, or
change the number of the area being displayed.
Use the display’s control-menu box to close the display (i.e. the ‘X’ button at the top right corner of the
form).
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Area Losses Chart
The Area Losses chart plots an area’s real power losses when you are animating (playing) and solving
the load flow every animation cycle. To access this display, go to the Tools ribbon tab, and choose
Other > Charts > Area Losses Chart from the Other Tools ribbon group. This option is only
available in Run Mode. You may also press the corresponding button on the Simulation Summary tab
of the Area Information Dialog. If you use the ribbon to view this chart, it shows information for the
first area in the case. The strip chart starts to chart the data (if animation is running) when you open
it, with new data appearing on the left. You can change the scale of either the x-axis (the time axis) or
the y-axis (Load/Generation MW axis) by right-clicking anywhere on the axis itself.
Right-click on the display (except on the axes) to view the display’s local menu. The local menu is used
to print the strip chart, save the strip chart in a file, copy the strip chart to the Window’s clipboard, or
change the number of the area being displayed.
Use the display’s control-menu box to close the display (i.e. the ‘X’ button at the top right corner of the
form).
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Area MW Transactions Chart
The Scheduled MW Transactions chart plots the scheduled real power (MW) transactions for an area
when you are animating (playing) and solving the load flow every animation cycle. To access this
display, go to the Tools ribbon tab, and choose Other > Charts > Area MW Transactions Chart
from the Other Tools ribbon group. This option is only available in Run Mode. You may also press the
corresponding button on the Simulation Summary tab of the Area Information Dialog. If you use the
ribbon to view this chart, it shows information for the first area in the case. The strip chart starts to
chart the data (if animation is running) when you open it, with new data appearing on the left. You
can change the scale of either the x-axis (the time axis) or the y-axis (Scheduled Transactions axis) by
right-clicking anywhere on the axis itself and specifying the new axis limits and number of intervals.
Right-click on the display (except on the axes) to view the display’s local menu. The local menu is used
to print the strip chart, save the strip chart in a file, copy the strip chart to the Window’s clipboard, or
change the number of the area being displayed.
Use the display’s control-menu box to close the display (i.e. the ‘X’ button at the top right corner of the
form).
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Area Average Cost Chart
The Average Cost per MWH chart plots the average cost per MWH for an area over time. This value is
calculated by dividing the total cost of operating the area (generation cost + purchased power cost revenue from power sales) by the MW load in the area. To access this display, go to the Tools ribbon
tab, and choose Other > Charts > Area Average Cost Chart from the Other Tools ribbon group.
This option is only available in Run Mode. You may also press the corresponding button on the
Simulation Summary tab of the Area Information Dialog. If you use the ribbon to view this chart, it
shows information for the first area in the case. The strip chart starts to plot the data when you open
it, with new data appearing on the left. You can change the scale of either the x-axis (the time axis) or
the y-axis (Scheduled Transactions axis) by right-clicking anywhere on the axis itself and specifying
the new axis limits and number of intervals. Note that as the area’s load increases, the average cost
per MWH tends to increase.
Right-click on the display (except on the axes) to view the display’s local menu. The local menu is used
to print the strip chart, save the strip chart in a file, copy the strip chart to the Window’s clipboard, or
change the number of the area being displayed.
Use the display’s control-menu box to close the display (i.e. the ‘X’ button at the top right corner of the
form).
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Edit Mode Overview
The Edit Mode is used to create and/or modify cases and onelines. You can use the Edit Mode to
create a case from scratch or to modify existing power flow cases stored in PowerWorld PWB or AUX
files, in the PTI Raw data format, GE PSLF EPC data format, or the IEEE Common Format. New users
may wish to view step-by-step tutorials on either
Creating a New Case from Scratch
Creating Onelines for an Existing Power Flow Case.
To enter the Edit Mode, select the Edit Mode button in the Mode ribbon group on any of the ribbon
tabs.
A powerful capability of the Simulator is its ability to a case by graphically placing/editing on a oneline
diagram. These display objects consist of both power system devices, such as buses, generators, and
transmission lines; and that show various system parameters, provide descriptive text, or function as a
static background.
Simulator’s oneline diagrams illustrate the current state of the components of the power system. Most
display objects correspond to records in the underlying power system model, but not all records in the
power system model need to have an associated display object. In fact, for large system models, it
may be that most of the system will not be illustrated. In such cases, you will want to devote more
detail to the more critical areas of the system so as not to clutter the view. Furthermore, it is possible
to associate more than one oneline with a single power flow case, and a single oneline may be
associated with multiple cases. This great flexibility can prove to be a big time-saver. Please see
Relationship Between Display Objects and the Power System Model for a more thorough discussion.
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Edit Mode General Procedures
In order to simplify the process of graphically constructing a power flow case, Simulator’s drawing
interface obeys the following conventions for most objects:
Inserting a New Object





Go to the Draw ribbon tab and use the menus on the Individual Insert ribbon group to add a
single oneline object type you would like to add to the oneline.
Left-click on the location on the display where you would like to position the object.
Once the object is placed, Simulator displays a dialog box that allows you to specify various
options for the object.
If desired, use all the options available on the Formatting ribbon group on the Draw ribbon tab to
change the appearance of the object once it has been placed.

Moving, Resizing, and Rotating an Existing Object






Select the object by clicking on the object with the left mouse button. Handles are displayed
around the object to indicate it has been selected.
To move the position of the object, place the mouse anywhere on the object except at a handle
location. Then drag the object around the screen by holding the left mouse button down.
To change the size of an object using the mouse, first select the object. Then place the mouse on
one of the object’s resizing (white) handles. The cursor will change to either a horizontal, vertical
or diagonal two-headed arrow shape. Then drag the mouse to change the object’s size. You can
also specify the size of most objects using their dialog boxes.
To rotate an object, first select the object. Then place the mouse over the rotation (green) handle
in the upper left corner of the selected object. The cursor will change to a rotation symbol. Clicking
and dragging will then rotate the object. Note that if an object (e.g., a pie chart or transmission
line) does not have a rotation handle in the upper left, the object cannot be rotated.

Viewing/Modifying Object Parameters


To view and/or change the options associated with a single object, right-click on the object. This
either displays the object’s dialog box directly, or it display’s the object, from which you can elect
to see the object’s dialog box.

Selecting Several Objects to Modify Their Appearance
Hold down the Shift key while clicking objects on the screen to select several objects at once. You
may then change the objects’ attributes, such as , by using all the options available on the
Formatting ribbon group on the Draw ribbon tab.
To move the objects that are selected, click and hold down the left mouse button on any of the
selected objects, drag the selected objects to a new location, and release the mouse button to place
them. You can also move the selected objects by holding the SHIFT key and simultaneously using
the UP, DOWN, LEFT, or RIGHT arrow keys (or use the Home, End, Page Up and Page Down keys to
move objects).
To select a set of objects use the many options available on the Select ribbon group on the Draw
ribbon tab to select a group of objects using a rectangle, ellipse or polygon selector. You can also
select only objects that meet some given criteria by using Select by Criteria. As an example, you can
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use Select By Criteria to select all the 345 kV transmission lines in a case. See Select ribbon group
for more detailed help.
Changing An Object’s Screen Appearance
Use all the options available on the Formatting ribbon group on the Draw ribbon tab to change the
screen appearance of either a selection of objects or the entire display.
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Draw Ribbon Tab
The Draw ribbon tab is primarily used to draw new oneline diagrams or edit existing onelines by
adding, moving, formatting, or resizing existing oneline objects. Most of the options on the Draw
ribbon tab are only available in Edit Mode. The Draw ribbon tab is shown below.

The Draw ribbon consists of seven ribbon groups described as follows
Mode Ribbon Group
Edit Mode
Switches the program to Edit Mode, which can be used to build a new case or to modify an
existing one.
Run Mode
Switches the program to Run Mode, which can be used to perform a single Power Flow
Solution or a timed simulation with animation.
Quick Insert Ribbon Group
The Quick Insert ribbon group contains buttons for creating a oneline diagram for a system
model you have already read into Simulator. If you are building out your network (or even
substation, area, or zone diagram), then using the Insert Palettes along with the Auto Insert
routines is most efficient. For detailed help see the Quick Insert ribbon group. If you would
instead like help on inserting a single object on your oneline diagram see the see the Individual
Insert ribbon group topic.
Individual Insert Ribbon Group
The Individual Insert ribbon group contains menus which provide access to buttons for inserting
individual oneline objects to the oneline diagram. If you are building out your network (or even
substation, area, or zone diagram), then it is much more efficient to use the Quick Insert ribbon
group. However, for complete access to all objects including those that can not be "quick inserted", see the help under the Individual Insert ribbon group topic.
Select Ribbon Group
The Select ribbon group contains options to help select multiple oneline objects simultaneously.
For more detailed help see the Selection ribbon group topic for more detailed help.
Formatting Ribbon Group
The Format ribbon group contains options for formatting the selected objects on your active
oneline. For more detailed help see the Formatting ribbon group topic for more detailed help.
Clipboard Ribbon Group
The Clipboard ribbon group contains options for copying and pasting oneline display objects.
For more detailed help see the Clipboard ribbon group topic for more detailed help.
Zoom Ribbon Group
The Zoom ribbon group contains buttons for navigating a oneline diagram. For more detailed
help see the Zoom ribbon group topic
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Oneline Display Options
The Oneline Display Options Dialog allows you to customize the appearance of the presently selected
oneline diagram. To view this dialog, either select Oneline Display Options from the Oneline
Options ribbon group on the Options ribbon tab, or choose Oneline Display Options from the
oneline’s local menu . Please see the Oneline Display Options Dialog help for more information.
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Anchored Objects
While in Edit Mode, Simulator allows certain objects to be attached, or anchored, to another object,
called the anchor. When an object that functions as an anchor is moved, all objects that are anchored
to it will move with it. This feature can be very useful when you move objects around the oneline
diagram in Edit Mode.
Anchoring has the property of "stacking" in Simulator. In other words, one object is anchored to
another, which is in turn anchored to yet another. The best way to describe this is by example. A
generator text field can be anchored to a generator. The generator, in turn, can be anchored to its
terminal bus. If you move the terminal bus, both the generator and its anchored fields also move with
the bus. However, if you just move the generator itself, only the generator fields will move with it. The
bus and all other objects anchored directly to the bus remain in their original location.
If anchors are deleted it is generally necessary to reset anchors on anchored objects go to the Draw
ribbon tab and choose Refresh Anchors on the Formatting ribbon group.
There are several types of anchored objects:
Buses
Loads, generators, switched shunts, bus fields, interfaces, transformers, transmission lines and
voltage gauges may be anchored to their associated bus. When the anchor bus is moved, these
anchored objects will move with it.
Substations
Similar to buses, any loads, generators, switched shunts, bus fields, interfaces, transformers, and
transmission lines may be anchored to their associated substations. When the anchor substation is
moved, these anchored objects will move with it.
Generators
Generator fields may be anchored to their associated generator. When the anchor generator is
moved, these anchored fields will move with it.
Loads
Load fields may be anchored to their associated load. When the anchor load is moved, these
anchored fields will move with it.
Switched Shunts
Switched shunt fields may be anchored to their associated switched shunt. When the anchor
switched shunt is moved, these anchored fields will move with it.
Area/Zone/Super Area Objects
Interfaces can be anchored to area/zone/super area objects.
Lines and Transformers
Circuit breakers, line flow pie charts, and line fields may be anchored to their associated
line/transformer. When the line/transformer is moved, these anchored objects will move with it.
Interfaces
Interface fields and interface pie charts can be anchored to their associated interface.
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Inserting and Placing Multiple Display Fields
Simulator provides a convenient method of adding display fields to a variety of oneline display objects
and placing them in default positions relative to the display object. Unlike the field placement
implemented by selecting Field from the Individual Insert ribbon group on the Draw ribbon tab, the
method described here allows you to place multiple fields around a display object in a single operation.
This option is available for several different types of objects, including buses, generators, lines and
transformers, shunts, and loads. The option can always be accessed by right clicking the display object
of interest and selecting the Add New Fields Around … option from the resulting local menu. This
brings up the Insert New Fields around Selected Objects Dialog. This dialog is divided into
several tabs by object type. Only tabs that correspond to the type of objects you have selected will be
available.
The tabs for inserting and placing multiple display fields for the various display objects (buses,
generators, lines/transformers, shunts, and loads) are virtually identical in content. The tab illustrates
the possible locations of the display fields for the various orientations of the display object. For
example, since buses may be oriented either horizontally or vertically, the dialog shows how each of
the eight possible bus fields would be positioned for each of the two orientations. Generators, loads,
and shunts each have four possible orientations, so the dialog identifies the locations for the possible
fields for each of the four orientations. Transmission lines and transformers can assume only one
orientation, and the dialog will thus show the possible field locations for that single orientation.
Each field location is identified on the illustrations with a label of the form Pos #. In order to modify
the settings, move your mouse over the position on the dialog you want to change and click. This will
bring up the appropriate Field Options Dialog such as the Bus Field Options, Generator Field Options,
Load Field Options, Switched Shunt Field Options, or the Line Field Options. Simply select the field you
want and choose OK. If you would like to set a default field to "none", click Remove Field instead of
OK.
Click OK to implement your choices for field additions and placement, or click Cancel to discard the
changes.
This help topic has gone over how to add new fields to existing display objects. It should be noted
from this discussion that all objects have an associated set of default fields that will be added to the
oneline when the objects are originally inserted. You may redefine the default fields selecting Default
Drawing Values from the Quick Insert ribbon group on the Draw ribbon tab and modifying the
Default Drawing Options Dialog.
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Setting Default Drawing Options
The Default Drawing Options Dialog is used to define the default sizes of new display objects, as well
as various other display parameters. These options are available only in Edit Mode.
To open this dialog choose Default Drawing Values on the General Options ribbon group of the
Options ribbon tab. These General Options are also available on the Oneline ribbon tab.
The Default Drawing Values Dialog is organized using a list showing the types of objects that can be
added to onelines. To view information about a particular type of object, select that object type from
the list and tables which describe the defaults available for that object will be populated. Two tabs will
be available. One will contain the majority of default options that are available for the selected display
object type, and the other will contain the default positions of fields that will be inserted when the
object is inserted.
Generally, the Default Drawing Values apply when you insert new objects on an oneline diagram.
Changing the Default Drawing Values does not automatically affect the existing objects already drawn
on the diagram. However, you can select multiple objects on a oneline diagram, and right-click on any
one object to invoke the object's popup menu. You will find the option Apply Default Draw Values,
which will modify the formatting of the selected objects to meet the default drawing value
specifications.
Variable Defaults depending on Voltage Level
Many kinds of objects can have more than one set of defaults specified depending on their voltage
level. When more than one set of defaults is specified, the table is always sorted by Nom kV.
A new object is inserted with properties corresponding to the default with the lowest Nom kV that
the object's nominal kV is larger than. If the object's nominal kV is smaller than all defaults, then it
will be set according to the default with the lowest nominal kV.
For instance, assume 4 sets of defaults are defined for buses roughly as follows
Nom kV Size
>400 15
>300 10
>200 8
>100 5
A new bus with nominal voltage of 345 kV is inserted with size 10.
A new bus with nominal voltage of 299 kV is inserted with size 8.
A new bus with nominal voltage of 69 kV is inserted with size 5.
In order to add another set of defaults for a kind of object, right-click on the table and choose
Insert from the local menu. In order to delete a set of defaults, right-click on the table and choose
Delete. Once you have inserted a new default, specify the new Nom kV for the default along with
the new defaults.
Notes: When you change the Nom kV of a default, the list always sorts itself according to Nom kV.
Insert will not be enabled in the local menu for objects that cannot have more than one set of
defaults. Delete will not be enabled if only one set of defaults is defined.
Modifying Values in the Default Drawing Values Dialog
The font colors in tables of this dialog follow the conventions of the Case Information Displays. Most
default values are enterable and can be modified by selecting the value you want to change and
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then typing in the new value. Other values are toggleable and can be changed by double-clicking on
the value. For reference regarding what the various "size" defaults mean, when the zoom level is at
its nominal value (100%), the size of the screen is 100 by 100. There are also some special kinds of
fields in this dialog which are discussed next.
Editing Colors and KV-Based Color Coding
In order to modify a color value, double-click on the colored rectangle to bring up the Color Dialog.
Then specify the color you want. For some defaults, such as fill color, it is possible to specify the
default color to be none. In order to set a color default to none, select the colored rectangle and
press the Delete key.
At times, a user may want to see the kV level of screen objects directly from the oneline diagam,
without having to open a text display. One way to do this is to color code the elements on the
oneline diagram according to kV level. Right-click on the table and choose Insert from the local
menu. Specify the Nom kV and color.
Editing Default Field Positions ("Pos1", "Pos2", etc…)
Many objects allow you to specify some default fields to be automatically added when a new object
is drawn. For example, you may want to insert the bus name next to all new Bus Objects. For
objects that allow the insertion of fields, a tab with field position diagrams will be available when
that object type is selected. In order to specify the default positions of fields, click on the tab
showing the field positions and click on the table row corresponding to the Nom kV of the defaults of
interest. For object types that do not allow specifying the defaults by Nom kV, simply update the
given position diagram. The position diagram will show the present settings for the new fields.
Positions that have a default specified will be highlighted and the name of the default field will be
shown. Positions with no default field will not be highlighted and will say "Pos1", "Pos2", etc…. For
objects that have more than one possible orientation (e.g. generators can be up, right, left or
down), there are multiple position diagrams showing the positions for each orientation.
In order to modify the settings, move your mouse over the position on the dialog you want to
change and click. This will bring up the appropriate Field Options Dialog such as the Bus Field
Options, Generator Field Options, Load Field Options, Switched Shunt Field Options, Line Field
Options, Interface Field Options, Substation Field Options, Area Field Options, Super Area Field
Options, or the Zone Field Options. Simply select the field you want and choose OK. If you would
like to set a default field to "none", click Remove Field instead of OK. You can also modify default
fields by double-clicking on the table for "Pos1", "Pos2", etc… This brings up the appropriate Field
Options Dialog as well. If you press the Delete key while on a "Pos" field in the table, it will set the
default field to "none".
Editing Stub Size and Stub Space
When utilizing the Automatically Insert Transmission Lines feature, the Stub Size and Stub Space
values are used. Simulator will draw each automatically inserted branch such that it emerges from
both its terminal buses at right angles. To accomplish this, Simulator draws each automatically
inserted branch in three segments: two stubs perpendicular to the terminal buses having a length
specified by the value supplied for Stub Size, and a third segment joining the two stubs. The
amount of space between lines as they converge into a bus is set by Stub Space.
If you do not want transmission line stubs to be inserted, then set Stub Size to none or to a
negative number. Note in order to set a value for Stub Space, Stub Size must be set to a positive
number first.
Editing CB Size
When you insert new transmission lines or transformers, circuit breakers will automatically be
inserted on the branch with their size specified by CB Size. If you do not want Circuit Breakers
inserted for a particular voltage level, then set CB Size to none or a negative number.
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Editing Pie Size
When you insert new transmission lines or transformers, pie charts will automatically be inserted on
the branch with their size specified by Pie Size. If you do not want pie charts inserted for a particular
voltage level, then set Pie Size to 'none' or a negative number.
Set Default Font
Click on this button to set the default font used for new text fields. This is the font which will be
used for all new text fields. Note however that the default font size set using this dialog is not used
unless the option Use the default font size for new text objects is selected. Otherwise, the
specific kind of object and voltage level specifies what the font size should be. For example, in the
Interface tab, one of the defaults is Font Size. New Interface Fields will use this font size.
Only Cut/Copy Display Objects, Not Power System Records
When you cut or delete an object from the oneline, Simulator needs to know whether you simply
want to delete the display object from the oneline or to purge the definition of the power system
object from the model. Check this box to tell Simulator to assume that it should always delete
objects just from the oneline display, not from the power system model.
Oneline / Bus View Background Color
To change the default oneline background color, click on the Change button to select a new color.
This color applies to both new oneline diagrams and the background color of the bus view oneline
diagram.
Recommended Multi-KV Level Defaults
Click this button to change the default options back to Simulator recommended values. Multiple sets
of default options will be specified based on voltage level for objects for which it is beneficial to do
this (i.e. transmission lines).
Recommended Single-KV Level Defaults
Click this button to change the default options back to Simulator recommended values. A single set
of default options will be specified for each object type.
Save All to Aux File and Load All From Aux File
The Default Drawing Options may also be stored in an Auxiliary File by Clicking the Save All to Aux
File button to save all these customizations to an Auxiliary File or by clicking the Load All From Aux
File to load all the custom hints from an Auxiliary File.
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Area Display Objects
Area records in the load flow data can be displayed as objects on a Simulator oneline diagram. This
can be useful for building a diagram on which you also want to include representations of groups of
devices by area.
To insert an Area object, select Aggregation > Area from the Individual Insert ribbon group on the
Draw ribbon tab. Then left-click on a oneline diagram in the location where the Area object should be
placed. This will open the Area Display Options dialog, which will allow you to choose the area
information to display, and set parameters for the displayed object. It is important to note that area
records, unlike other objects like buses and transmission lines, cannot be added to the load flow data
graphically. To add a new area record to the load flow case, you need to change the area designation
of a device in the load flow case to a new area number, or you need to insert a new area from the
Area Records.
Area objects can also be added by using the Area insert palette.
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Area Display Options Dialog
When you insert an area display object on a oneline diagram, Simulator opens the Area Display
Options dialog. This dialog is used to control various display and identity attributes of the area display
object. The dialog contains the following fields:
Number
This dropdown box lists the number of all areas in the case. Use this control to associate the display
object with the correct area.
Name
If you would prefer to search through areas by name rather than by number, use the Name
dropdown box to see a list of names of all the areas in the case.
Show Record Type Prefix
Check this box if you wish to place the prefix Area before the name/number caption in the object.
Prefix Text
Specify additional prefix text to be added before the Record Type prefix.
The remainder of the choices presented on the Area Display Options dialog pertain to the object’s
display appearance.
Style
Choose whether the display object should appear as a rectangle, rounded rectangle, or an ellipse.
Caption
Indicate how the display object should be identified to the user: by name, number, or both.
Width, Height
The dimensions of the new display object.
Click OK to save your selections and add the object to the oneline, or choose Cancel to terminate the
addition.
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Zone Display Objects
Zone records in the load flow data can be displayed as objects on a Simulator oneline diagram. This
can be useful for building a diagram on which you also want to include representations of groups of
devices by zone.
To insert a Zone object, select Aggregation > Zone from the Individual Insert ribbon group on the
Draw ribbon tab. Then left-click on a oneline diagram in the location where the Zone object should be
placed. This will open the Zone Display Options dialog, which will allow you to choose the zone
information to display, and set parameters for the displayed object. It is important to note that zone
records, unlike other objects like buses and transmission lines, cannot be added to the load flow data
graphically. To add a new zone record to the load flow case, you need to change the zone designation
of a device in the load flow case to a new zone number, or you need to insert a new zone from the
Zone Records.
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Zone Display Options Dialog
When you insert a zone display object on a oneline diagram, Simulator opens the Zone Display Options
dialog. This dialog is used to control various display and identity attributes of the zone display object.
The dialog contains the following fields:
Number
This drop down box lists the number of all zones in the case. Use this control to associate the
display object with the correct zone.
Name
If you would prefer to search through zones by name rather than by number, use the Name drop
down box to see a list of names of all the zones in the case.
Show Record Type Prefix
Check this box if you wish to place the prefix Zone before the name/number caption in the object.
Prefix Text
Specify additional prefix text to be added before the Record Type prefix.
The remainder of the choices presented on the Zone Display Options dialog pertain to the object’s
display appearance.
Style
Choose whether the display object should appear as a rectangle, rounded rectangle, or as an ellipse.
Caption
Indicate how the display object should be identified to the user: by name, number, or both.
Width, Height
The dimensions of the new display object.
Click OK to save your selections and add the object to the oneline, or choose Cancel to terminate the
addition.
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Super Area Display Objects
Super area records in the load flow data can be displayed as objects on a Simulator oneline diagram.
This can be useful for building a diagram on which you also want to include representations of groups
of devices by super areas.
To insert a Super Area object, select Aggregation > Super Area from the Individual Insert ribbon
group on the Draw ribbon tab. Then left-click on a oneline diagram in the location where the Super
Area object should be placed. This will open the Super Area Display Options dialog, which will allow
you to choose the super area information to display, and set parameters for the displayed object. It is
important to note that super area records, unlike other objects like buses and transmission lines,
cannot be added to the load flow data graphically. To add a new super area record to the load flow
case, you need to insert a new super area from the Super Area Records.
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Super Area Display Options Dialog
When you insert a super area display object on a oneline diagram, Simulator opens the Super Area
Display Options dialog. This dialog is used to control various display and identity attributes of the
super area display object. The dialog contains the following fields:
Number
This field is unused for super area objects. Super areas are identified by a unique super area name
instead.
Name
Use the Name dropdown box to see a list of names of all the super areas in the case.
Show Record Type Prefix
Check this box if you wish to place the prefix Super Area before the name/number caption in the
object.
Prefix Text
Specify additional prefix text to be added before the Record Type prefix.
The remainder of the choices presented on the Super Area Display Options dialog pertain to the
object’s display appearance.
Style
Choose whether the display object should appear as a rectangle, a rounded rectangle, or an ellipse.
Caption
Indicate how the display object should be identified to the user: by name, number, or both.
Width, Height
The dimensions of the new display object.
Click OK to save your selections and add the object to the oneline, or choose Cancel to terminate the
addition.
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Owner Display Objects
Owner records in the load flow data can be displayed as objects on a Simulator oneline diagram. This
can be useful for building a diagram on which you also want to include summary objects by owner, in
which information about the generation and load of the owner are indicated with the object.
To insert an Owner object, select Aggregation > Owner from the Individual Insert ribbon group on
the Draw ribbon tab. Then left-click on a oneline diagram in the location where the owner object
should be placed. This will open the Owner Display Options dialog, which will allow you to choose the
owner information to display, and set parameters for the displayed object.
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Owner Display Options Dialog
When you insert an owner display object on a oneline diagram, Simulator opens the Owner Display
Options dialog. This dialog is used to control various display and identity attributes of the owner
display object. The dialog contains the following fields:
Number
The owner number.
Name
The owner name.
Show Record Type Prefix
Check this box if you wish to place the prefix Owner before the name/number caption in the object.
Prefix Text
Specify additional prefix text to be added before the Owner prefix.
The remainder of the choices presented on the Owner Display Options dialog pertain to the object's
display appearance.
Style
Choose whether the display object should appear as a rectangle or as an ellipse.
Caption
Indicate how the display object should be identified to the user: by name, number, or both.
Width, Height
The dimensions of the new display object.
Click OK to save your selections and add the object to the oneline, or choose Cancel to terminate the
addition.
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Area Fields on Onelines
Area fields are used to show various values associated with a particular area of the power system.
Right clicking on the area field displays the Area Field Dialog.
Edit Mode
To enter a new area field, first select Field > Area Field from the Individual Insert ribbon group on
the Draw ribbon tab. Then, click on or near the area object or a bus in the area for which you want
to add a field. This calls up the Area Field Dialog. Verify that the area number is correct. By default,
this value is the number of the area associated with the closest area object, or if there are no area
objects, the closest bus. Enter the total number of digits the field should display as well as the
number of digits to the right of the decimal point. Depending on what the field is designed to
display, you may need to enter an additional area number. Finally, select the field type. Click OK to
save the field or Cancel to abort the operation.
With most types of area fields, an Area Number of 0 is valid and defines the field as showing
values for the entire system.
To modify the parameters of an existing area field, position the cursor anywhere on the area field
and right-click. This again brings up the Area Field Dialog. Use the Formattingoptions to change
various display attributes for the area field, including its font and background color.
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Zone Fields on Onelines
Zone field objects are used to show different values associated with zones and the system. This dialog
is used to view (and in a few cases modify) the parameters associated with these zone fields. To reach
this dialog, select Field > Zone Field from the Individual Insert ribbon group on the Draw ribbon tab
and click the desired field location on a oneline diagram in Edit Mode, or right-click on an existing zone
field on a oneline diagram.
Zone Number
Zone number associated with the field. When you insert fields graphically, this field is automatically
set to the zone number associated with the closest bus on the oneline. With most types of zone
fields, a Zone Number of 0 is valid and defines the field as showing values for the entire system.
Find…
If you do not know the exact zone number you are looking for, you can click this button to open the
advanced search engine.
Total Digits in Fields
Total number of digits to show in numerical fields.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point in numerical fields.
Rotation Angle in Degrees
The angle at which the text is to appear on the oneline diagram.
Other Zone Number
Some of the fields, such as MW Flow to Other Zone, require that a second area be specified. If
applicable, enter the second (other) zone here.
Delta per Mouse Click
This value is used only with the Sched Flow to Other Zone field type. When there is a nonzero
entry in this field, and the field type is Sched Flow to Other Zone, a spin button is shown to the
right of the zone field. When the up spin button is clicked, the flow to the other zone is increased by
this number of MW; when the down button is clicked, the scheduled flow is decreased by this
amount.
Field Value
Shows the current output for the zone field. Whenever you change the Type of Field selection, this
field is updated.
For the Sched Flow to Other Zone field type only, you can specify a new value in MW. Exports
are assumed to be positive.
Field Prefix
An optional string that precedes the field value.
Anchored
If the field is associated with a Zone Object on the diagram, the field can be anchored to the object
so that if the object gets moved on the diagram, the field will move with it.
Include Suffix
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If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
Used to determine the type of zone field to show.
Name
Zone name.
Number
Zone number (1 - 999).
MW Load, Mvar Load
If the zone number is nonzero, then these fields show Total MW or Mvar load for the zone. If the
zone number is zero, these fields show the total load in the entire system.
MW Generation, Mvar Generation
If the Zone Number is nonzero, then these fields show Total MW or Mvar generation for the
zone. If the Zone Number is zero, these fields show the total generation in the entire system.
MW Shunts, MVR Shunts
If the Zone Number is nonzero, then these fields show Total MW or Mvar shunt compensation for
the zone. If the Zone Number is zero, these fields show the total shunt compensation in the
entire system.
MW Flow to Other Zone, Mvar Flow to Other Zone
Total MW or Mvar flow from the zone specified in the Zone Number field to the zone specified in
the Other Zone Number field. The Zone Number field must correspond to a valid zone. If the
Other Zone Number field is zero, this field shows the zone's total MW or Mvar exports.
MW Losses, MVAr Losses
If the Zone Number is nonzero, then these fields show Total MW or Mvar losses for the zone. If
the Zone Number is zero, these fields show the total real or reactive losses in the entire system.
Load Schedule Multiplier
Indicates the current value of the MW multiplier applied to the zone's loads.
Select a Field
Allows you to choose any other field associated with a zone not explicitly listed as an option in
the Type of Field selection.
Select OK to save changes and close the dialog or Cancel to close dialog without saving your changes.
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Super Area Fields on Onelines
To display certain information about a super area, such as MW Load or MVAR losses, insert a super
area field. This can be done in Edit Mode by selecting Field > Super Area Field from the Individual
Insert ribbon group on the Draw ribbon tab. This will bring up the Super Area Field Information. From
here you can choose which super area to describe, how many digits in the field, and how many digits
to the right of the decimal. There are also 12 different field options to choose from. If a field value is
not defined, question marks will be shown.
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Owner Fields on Onelines
Owner field objects are used to show different values associated with owners. This dialog is used to
view and modify the parameters associated with these fields. To insert an Owner field, click on Field
> Owner Field in the Individual Insert ribbon group on the Draw ribbon tab.
Owner Number
Owner number associated with the field. When you insert fields graphically, this field is automatically
set to the owner number associated with the closest bus on the oneline.
Find by Number
To switch to a different owner in the field options dialog, you can enter the number in the Owner
Number field, and press the Find by Number button to update the dialog with information for the
new owner.
Owner Name
Name of the owner whose information is presently being displayed in the dialog.
Find by Name
To switch to a different owner in the field options dialog, you can enter the name in the Owner
Name field, and press the Find by Name button to update the dialog with information for the new
owner.
Total Digits in Fields
Total number of digits to show in the field.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Field Prefix
An optional string that precedes the field value.
Rotation Angle in Degrees
The angle at which the text is to appear on the oneline diagram.
Field Value
Shows the current output for the owner field. Whenever you change the Type of Field selection,
this field is updated.
Include Suffix
If the Include Suffix checkbox is checked, the corresponding field units will be displayed after the
current value. Otherwise, only the value without units will be shown.
Type of Field
Used to determine the type of owner field to show. You can choose from one of the six default
fields, or click on the Find Field… button to choose from a list of all available owner fields.
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Bus Display Objects
In power system analysis, the term "bus" is used to refer to the point where a number of electrical
devices, such as lines, loads or generators, join together. On the oneline diagram, buses are usually
represented with either a thick horizontal line or a thick vertical line. The bus thickness and color can
be customized.
Right-clicking on the bus will display its local menu. The local menu offers you the chance to view the
corresponding Bus Dialog, the Quick Power Flow List, and the Bus View Display. When the application
is in Edit Mode, the local menu will also allow you to add bus fields to the bus and to insert any
undrawn buses connected to the selected bus. Bus Fields are often placed close to the bus to indicate
its voltage magnitude, voltage angle, and other relevant information.
Edit Mode
To add a new bus to the case graphically, follow this simple procedure:






Select Network > Bus from the Individual Insert ribbon group of the Draw ribbon tab. This
prepares Simulator to insert a new bus.
Left-click on the oneline background at the location where you want to place the new bus. This
invokes the Bus Option Dialog.
Use the Bus Option Dialog to specify the number, name, size, thickness, orientation, area, zone,
and nominal voltage of the bus, as well as the load and shunt compensation connected to it. Every
bus must have a unique number.
The Bus Option Dialog will include a message just above the Bus Number field indicating that a
new bus will be inserted into the power system data model. This will appear as long as the Bus
Number that is selected does not already exist in the power system case.
Click OK on the Bus Option Dialog to finish creating the bus and to close the dialog. If you do not
wish to add the bus to the case, click Cancel.

If you are simply adding a symbol to the oneline diagram for a bus that has already been defined in
the case, many of the parameters you are asked to specify in step three will be filled in for you.
To modify the parameters for an existing bus, position the cursor on the bus and right-click to
invoke the bus' local menu. From the local menu, choose Bus Information Dialog to view the
associated Bus Dialog. You may change any of the parameters specified there. When a bus' number
is changed, the bus numbers associated with all of the devices attached to that bus are also
automatically changed. To renumber several buses simultaneously, please see Bus Renumbering
Dialog.
To modify any aspect of a bus' appearance, first select the bus, and then click any of the format
buttons found in the Formatting ribbon group on the Draw ribbon tab. You can change the length of
the bus (but not its thickness) by dragging the bus' resizing handles.
In order to delete an existing bus after selecting it, use either the Cut button, found in the Clipboard
ribbon group on the Draw ribbon tab, to preserve a copy of the bus on the Windows clipboard, or
Delete button, found in the Clipboard ribbon group on the Draw ribbon tab, to remove the bus
without copying it to the clipboard. You will be asked whether you want to remove both the display
object and its associated bus record, or merely the display object, leaving the bus in the power flow
model. If you will never be deleting a record from the power system model, you may also choose
the option labeled Always Delete Objects Only. Be careful when deleting existing buses with
attached devices. An error will occur during validation if you do not also delete the attached devices
or attach them to other buses.
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Bus Fields on Onelines
Bus field objects are used primarily to indicate various quantities associated with bus devices.
Furthermore, some bus field types, which are distinguished by an integrated spin button, may be used
to easily change bus device properties.
Run Mode
Right clicking on a bus field gives you the option to open the Bus Field Dialog or the Bus Information
Dialog.
Edit Mode
Simulator offers two options for adding bus fields to a oneline in Edit Mode. If you need to enter
only a single field, the easier approach may be to choose Field > Bus Field from the Individual
Insert ribbon group on the Draw ribbon tab and then select the bus to which you want to add the
field. This invokes the Bus Field Dialog. Enter the bus number associated with the device (the default
is the closest bus to the field), the total number of digits to show, and the number of digits to the
right of the decimal point. An optional Field Prefix can be used. Choosing to Include Suffix will
include relevant units for the type of field selected. The field can be Anchored to the bus that it
represents and the field can be rotated by a specified Rotation Angle in Degree. Finally, select the
type of field to show.
The second approach for adding new bus fields entails right-clicking the bus and selecting Add New
Fields Around Bus from the resulting local menu. See Inserting and Placing Multiple Display Fields
for more details.
To modify the parameters of an existing bus field, position the cursor anywhere on the object and
right-click. This brings up the Bus Field Dialog. Choose any of the format buttons on the Formatting
ribbon group on the Draw ribbon tab to change various display attributes of the field, including its
font and background color.
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Old Voltage Gauges
Voltage gauges provide a way to visualize the voltage of a bus relative to its high- and low-voltage
alarm limits. A gauge looks very much like a thermometer. As the temperature changes, the height of
the mercury in the thermometer moves up and down. One reads the temperature measured by the
thermometer by noting the marking that matches the top of the mercury. Voltage gauges in Simulator
work the same way. A voltage gauge has three markings on its side, each of which identifies a key
per-unit voltage level. Specifically, these three markings locate the minimum, maximum, and target
per-unit voltages. Often, the target voltage level is the nominal voltage, but this is not a requirement.
Inside the gauge is a filled region. The default color of the filled region is blue, but this can be
changed. When you create the voltage gauge, you associate it with a bus, and you specify its fill color
and its minimum, maximum, and target voltage levels. Once the gauge has been placed on a display,
it will reveal changes in its associated bus’s voltage by varying the height of its filled region. This tool
was introduced to provide an alternative to voltage contours to show the variation of voltage across a
region. Contouring can reveal the variation of only a single quantity at a time. For example, it is
impossible to contour bus voltage magnitude and bus voltage phase angle simultaneously. Voltage
gauges are helpful because they allow you to show the voltage profile superimposed on a contour of
some other quantity.
To add a voltage gauge to a display, switch to Edit Mode and select Pies / Gauges > Old Gauges
> Bus from the Individual Insert Ribbon Group on the Draw ribbon tab. The cursor will become a
crosshair. Click on the oneline diagram where you would like the new voltage gauge to appear. The
Voltage Gauge Options Dialog will appear. Use this dialog to define the minimum, maximum and target
voltages for the voltage gauge, as well as its fill color and whether it should be anchored to its
associated bus. After you click the "OK" button, the Voltage Gauge Options Dialog will close, and the
new voltage gauge will appear.
Once a gauge has been placed on the oneline, the height of its filled region will change as the voltage
of its associated bus changes. To modify any of the characteristics of the gauge, such as its key
voltage levels, fill color, and anchor setting, simply right-click on the bus voltage gauge to open the
Voltage Gauge Options Dialog again.
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Old Voltage Gauge Options Dialog
The Voltage Gauge Options Dialog is used to define and configure a bus voltage gauge. A bus voltage
gauge is associated with a particular bus and reveals the bus’s voltage relative to specified minimum,
maximum, and target per-unit voltage levels. The height of the colored column in the voltage gauge
indicates the bus’s voltage relative to these markings.
The dialog has the following controls:
Number, Name, and Find
Use the Number and Name dropdown boxes to identify the bus to which you want the gauge to
correspond. Select a bus number from the Number dropdown box to identify the bus by number,
and a bus name from the Name dropdown box to identify a bus by name. It may be more
convenient to press the Find to open the Find Dialog, which allows you to specify a bus by either
name or number using wildcards. When you first open the Bus Voltage Gauge Dialog, the bus name
and number will correspond to the bus object that was closest to the point where you clicked.
Minimum, Target, and Maximum
Use these three spin edit boxes in the Voltage levels group box to specify the minimum,
maximum, and target per-unit voltage levels. These settings determine where on the gauge its three
markings will be drawn.
The Minimum and Maximum value will be taken from the Limit Monitoring settings for the current
bus, unless you uncheck the option "Set Limits According to Current Limit Monitoring Settings".
Fill color
The Fill color box reveals the color that will be used to paint the filled region of the gauge. Click on
the Fill color box to open a Color Dialog, which you may then use to specify a different color.
Anchored
A bus voltage gauge is said to be anchored if, when you move its associated bus object, it moves
with it. Check the Anchored check box to ensure that the gauge will move with its associated bus.
Otherwise, when you move its associated bus object, the gauge will stay in its current position.
OK, Help, and Cancel
Click OK to finalize your settings. This will create a new voltage gauge object if you are trying to
create one from scratch, or it will modify the appearance and settings of an existing one if you have
chosen to modify one that has already been defined. Click Cancel to dispose of your changes. Click
the Help button to reveal this help text.
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Substation Display Objects
Substations in Simulator define a group of buses that are closely connected. Each bus can belong to
either one substation or no substation (called unassigned). By default in Simulator, all buses are not
assigned to a substation. This is done because all traditional text file power flow formats do not
include information regarding a bus' substation.
Substations are represented on the oneline as a rectangle with the name of the substation inside it.
Other information about the substation is also displayed on the rectangle:






The
The
The
The
The

upper left corner displays a generator symbol if generation exists in the substation.
upper right corner displays a load symbol if load exists in the substation.
lower right corner displays a shunt symbol if shunts exist in the substation.
lower left corner displays the number of buses inside the substation.
lower middle displays the maximum voltage level in the substation.

You can also customize the size, colors, and font name and style of a substation object. Note however
that the font size of the substation object is automatically changed by Simulator as you change the
size of the rectangle.
Right-clicking on the substation will display its local menu. The local menu offers you the chance to
view the corresponding Substation Information Dialog and the Substation View Display.

711
©2011 PowerWorld Corporation

Substation Fields on Onelines
To display certain information about a substation, such as MW Load or MVAR losses, insert a
substation field. This can be done in Edit Mode by selecting Fields > Substation Field from the
Individual Insert ribbon group on the Draw ribbon tab. This will bring up the Substation Field Options
dialog. From here you can choose which substation to describe, how many digits in the field, and how
many digits to the right of the decimal. There are also 8 different field options to choose from. If a
field value is not defined, question marks will be shown.
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Generator Display Objects
Generators are represented on the oneline as circles with a rotor symbol inside. The default rotor
symbol is a "dog bone," but other symbols can be selected. Multiple generators at a bus are allowed,
with each being distinguished by a unique character identifier.
Each generator symbol (except that corresponding to the slack) can be equipped with a circuit breaker
(see that can be used to change the status of the generator. You may toggle the generator status by
clicking on the circuit breaker while in Run Mode.
Generator fields are often placed close to the generator on the oneline to indicate the generator's
MW/Mvar output or other information associated with the generator.
Run Mode
When animation is active, the default flow of the arrows emerging from the generator is proportional
to its MW output. You can customize the appearance of this flow using the Animated Flows Tab of
the Oneline Display Options Dialog.
Right clicking on the generator brings up the generator submenu. This menu is used to display a
variety of information about the generator, including







Generator Information Dialog
Input-output curve
Fuel cost curve
Incremental cost curve
Heat-rate curve
Reactive capability curve

Edit Mode
To add a new generator to the case, select Network > Generator from the Individual Insert
ribbon group on the Draw ribbon tab. Then, place the cursor on the bus where you would like to
attach the generator, and click with the left mouse button. This calls up the Generator Dialog. The
bus number is automatically determined from the bus to which you attached the generator. The ID
field contains a an alphanumeric ID used to distinguish multiple generators at a bus. The default is
'1'.
Enter the size, the thickness of the lines (in pixels) used to display the device, orientation, rotor
symbol, and other parameters for the generator. Each generator can optionally contain a circuit
breaker for connecting or disconnecting the device in Simulator. Use options found with the Display
Object Options on the Oneline Display Options dialog to specify if a circuit breaker should be shown.
Select OK to add the generator. If you do not want to add the generator to the case, select Cancel.
To modify the parameters for an existing generator, position the cursor on the generator and rightclick. This again brings up the Generator Dialog. You can then change any parameter (be careful in
renumbering an existing generator). Use the Formatting ribbon group commands to change the
color, line thickness, and other display parameters.
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Generator Fields on Onelines
Generator field objects are used primarily to indicate various quantities associated with generation
devices. Furthermore, some generator field types, which are distinguished by an integrated spin
button, may be used to change generation device properties.
Run Mode
For generator fields with an associated spin button, clicking on the up/down arrows will change the
value of the associated field.
Right clicking on a generator field gives you the option to open the Generator Field Dialog or the
Generator Information Dialog.
Edit Mode
Simulator offers two options for adding generator fields to a oneline in Edit Mode. If you need to
enter only a single field, the easier approach may be to choose Field > Generator Field from the
Individual Insert ribbon group on the Draw ribbon tab and click near generator for which you
want to add the field. This invokes the Generator Field Dialog. Enter the bus number associated with
the device (the default is the bus associated to the closest generator to the field), the ID field, the
total number of digits to show, and the number of digits to the right of the decimal point. Next,
select the type of field to show. For generator actual MW and Setpoint MW types and load MW and
Mvar fields, specify a nonzero value in the Delta per Mouse Click to design a bus field with an
integrated spin control. The Gen AGC Status field is used to display the automatic generation control
status of the generator. The user can toggle this status in Simulator by clicking on the field.
Likewise, the Gen AVR Status field is used to display the automatic voltage regulation status of the
generator. Again, the user can toggle this status by clicking on the field.
The second approach for adding new generator fields entails right-clicking the bus and selecting Add
New Fields Around Generator from the resulting local menu. Please see Inserting and Placing
Multiple Display Fields for more details.
To modify the parameters of an existing generator field, position the cursor anywhere on the object
and right-click. This brings up the Generator Field Dialog. Choose , or from the Formatting ribbon
group to change various display attributes of the field, including its font and background color.
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Load Display Objects
Simulator models aggregate load at each system bus. Multiple loads at a bus are allowed. Each load
object on the oneline comes equipped with a circuit breaker. The status of the load corresponds to the
status of its circuit breaker. A circuit breaker is closed if it appears as a filled red square, and it is open
if it appears as a green square outline. In Run Mode, you may toggle the status of the load by clicking
on its associated circuit breaker.
Load fields are often placed close to the loads on the oneline to indicate their MW/Mvar value.
Run Mode
When animation is active, the flow of the arrows into the load is proportional to its current MW load.
You can customize the appearance of this flow using the Animated Flows Tab of the Oneline Display
Options Dialog.
Right clicking on a load (bus) field gives you the option to open the Load Field Dialog or the Load
Dialog.
Edit Mode
To add a new load to the case, select Network > Load from Individual Insert ribbon group on the
Draw ribbon tab. Then, select the bus to which you want to attach the load with the left mouse
button. This calls up the Load Dialog. The bus number is automatically determined from the bus to
which you attached the load. The ID field contains a two-character ID used to distinguish multiple
loads at a bus. The default ID is 1.
Enter the size, the thickness of the lines [in pixels] used to display the device, the orientation, and
the base MW and Mvar load values for the device. Usually, only the Constant Power fields are
specified as nonzero. The Constant Current and Constant Impedance fields are used to specify loads
that vary with voltage. Constant current loads vary proportionally with bus voltage, while constant
impedance loads vary with the square of the voltage. Specify the constant current and constant
impedance values assuming one per-unit voltage.
Select OK to add the load. If you do not want to add the load to the case, select Cancel.
To modify the parameters for an existing load, position the cursor on the load and right-click. Select
Load Information Dialog from the local menu to invoke the Load Dialog. You can then change any
parameter as desired. You can select from the Formatting ribbon group on the Draw ribbon tab to
change the drawing parameters of the load.
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Load Fields on Onelines
Load field objects are used primarily to indicate various quantities associated with load devices.
Furthermore, some load field types, which are distinguished by an integrated spin button, may be used
to change load device properties.
Run Mode
For load fields with an associated spin button, clicking on the up/down arrows will change the value
of the associated field.
Right clicking on a load field gives you the option to open the Load Field Dialog or the Load
Information Dialog.
Edit Mode
Simulator offers two options for adding load fields to a oneline in Edit Mode. If you need to enter
only a single field, the easier approach may be to choose Field > Load Field from the Individual
Insert ribbon group on the Draw ribbon tab and then select the load to which you want to add the
field. This invokes the Load Field Dialog. Enter the bus number associated with the device (the
default is the bus associated to the closest load to the field), the ID field, the total number of digits
to show, and the number of digits to the right of the decimal point. Next, select the type of field to
show.
The second approach for adding new generator fields entails right-clicking the bus and selecting Add
New Fields Around Load from the resulting local menu. Please see Inserting and Placing Multiple
Display Fields for more details.
To modify the parameters of an existing load field, position the cursor anywhere on the object and
right-click. This brings up the Load Field Dialog. Choose , or from the Formatting ribbon group on
the Draw ribbon tab to change various display attributes of the field, including its font and
background color.
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Transmission Line Display Objects
Transmission lines are represented on the onelines using multiple segment lines drawn between buses.
Transmission lines may be equipped with circuit breakers that can be used to change the line's status.
You can also add pie charts and line fields to transmission lines to indicate how heavily loaded the line
is. The appearance of transmission lines, including line thickness and color, may also be customized.
Run Mode
Simulator's animation feature can be used to indicate the magnitude of the flow on the transmission
line, either in MW or in terms of the line's percentage loading. You can customize the line flow
animation using the Animated Flows Options on the Oneline Display Options Dialog.
Right-clicking on a transmission line displays the line's local menu, from which you can choose to
inspect the Branch Information Dialog.
Edit Mode
To add a new transmission line to the case, first select Network > Transmission Line from the
Individual Insert ribbon group on the Draw ribbon tab. Then place the cursor on the first bus for the
transmission line (the from bus) and click the left mouse button. Add more segments to the line by
moving the cursor and clicking with the left mouse button. To complete adding a new line, place the
cursor on the second bus for the line (the to bus) and double-click with the left mouse button. This
calls up the Branch Options dialog. The from and to bus numbers are set automatically provided the
line starts and ends on existing buses. If there is just one line between the buses, the circuit number
should be "1." For multiple lines between buses, you must give each a unique circuit number. Enter
the thickness of the lines [in pixels] used to display the transmission line. Enter the per unit (100
MVA base by default) resistance, reactance, total charging susceptance (that is B not B/2) for the
line, and an MVA rating. Select OK to add the line. If you do not want to add the line to the case,
select Cancel.
To modify the parameters for an existing line, position the cursor anywhere on the line and rightclick. This brings up the Branch Options dialog, which you can use to change various line
parameters.
To change the physical appearance of the line (i.e. line color, line thickness, etc.), make use of the
tools in the Formatting ribbon group.
To change the shape of the line, first left-click on the line to select it. This causes handles to appear
at each vertex. You can then move any vertex clicking and holding the left mouse button down on
the vertex, dragging it to a new location, and then releasing the mouse button. To remove a vertex,
hold down the CTRL key and then click the vertex you would like to delete. To add a vertex, hold
down the CTRL key and then click on the line where you would like to add a vertex.
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Line Fields on Onelines
Line field objects are used to show values associated with lines, transformers and dc transmission
lines.
Run Mode
Right clicking on the line field gives you the option to open the Line Field Dialog or the Line
Information Dialog.
Edit Mode
To enter a new line field, select Field > Line Field from the Individual Insert ribbon group on the
Draw ribbon tab and select the line, transformer, or dc line to which you want to add the field. The
Line Field Dialog will open. Enter the near and far bus number associated with the device (the
default values for these fields correspond to the device on which you clicked) and the circuit number
of the device. The field will display the flow value at the near end of the device. Enter the total
number of digits to show on the screen and the number of digits to the right of the decimal point.
Finally, select the desired field type.
To modify the parameters of an existing line field, position the cursor anywhere on the object and
right-click. This again brings up the Line Field Dialog. Select from the Formatting ribbon group on
the Draw ribbon tab to change many of the line field's display attributes.
Another way to add line fields to the oneline entails right-clicking the line and selecting Add New
Fields Around Line from the resulting local menu. Please see Inserting and Placing Multiple Display
Fields for more details.
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Circuit Breakers on Onelines
Circuit breakers are used to open or close transmission lines and transformers. They are also used to
place generators, loads and switched shunts in or out of service. By default, closed circuit breakers are
shown as solid red squares, while open circuit breakers are shown as a green square outline. The color
and filled or unfilled properties of circuit breakers can be modified in the Oneline Display Options under
Display Object Options. Only those circuit breakers that are set to use the default shape will abide by
the shape specified with the Oneline Display Options. Circuit breakers for generators, loads, and
switched shunts always use the rectangle shape. Circuit breakers that are automatically inserted for
transmission lines and transformers will use the default shape unless the user specifies a different
shape.
To change the status of a breaker, left-click on the breaker while in run mode. A circuit breaker
directly controls the status of its associated display object. One breaker is shown on the line
connecting a generator, load, or shunt to its associated bus. Two breakers are shown by default on
transmission lines and transformers. Opening either of the line's circuit breakers opens the
transmission line or transformer; you do not have to open circuit breakers at both ends of the line.
Note: Circuit breakers cannot be placed on dc transmission lines.
Edit Mode
By default, when you add a new display object to a oneline diagram, the necessary circuit breakers
are automatically added at each end of the branch.
To add a new circuit breaker to the oneline, select Indication > Circuit Breaker from the
Individual Insert ribbon group on the Draw ribbon tab and then click the line to which you want to
add the breaker. The Circuit Breaker Options dialog will appear with the from and to bus numbers,
and the circuit number automatically set to identify the line you selected. Specify the size for the
switch and its initial status, as well as whether it will be anchored to the line so that it will move with
the line. Click OK to add the circuit breaker, or click Cancel to abort the process. To add more
circuit breakers to the line, simply repeat this procedure.
The shape of a branch circuit breaker can be user-specified on the Circuit Breaker Options dialog. If
the option to Use Default is selected for the Shape, the shape is dictated by the default circuit
breaker shape specified with the Oneline Display Options under the Display Object Options. If a nondefault shape is specified that requires an orientation, the Orientation option will be enabled.
To modify the parameters for an existing breaker, position the cursor anywhere on the device and
right-click. This invokes the Circuit Breaker Options Dialog, from which you can change many of the
breaker's parameters. Additional display settings for the circuit breaker can be accessed by selecting
from the Formatting ribbon group.
You can toggle the status of Transmission Line and Transformer circuit breakers while in Edit Mode
by right-clicking on the associated line or transformer and selecting Open Line or Close Line from
the local menu.
Run Mode
Circuit Breaker status can be toggled in Run Mode by Left-Clicking on a breaker to place its
associated object either in or out of service. If the simulation is currently running, any effects of
changing a circuit breaker’s status are immediately shown on the oneline.
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Line Flow Pie Charts on Onelines
The line flow pie charts are used to indicate the percentage MVA, MW, or Mvar loading of a
transmission line or a transformer. The degree to which the pie chart is filled shows how close the
device is to its limit (provided the device has a nonzero limit). A line flow pie chart becomes completely
filled when the device's flow meets or exceeds 100% of its rating.
For pie charts for objects that are not associated with line flows, see Pie Charts / Gauges.
Use the Pie Chart Options tab of the Oneline Display Options Dialog to customize various attributes of
all pie charts. The tab allows you to define a warning level at which the size and color of the pie charts
will change to a size and color you specify. The tab also allows you define a limit percent as well as the
size and color to which to change the pie charts when their corresponding devices violate their limits.
You can also specify whether the pie charts should reveal total power flow (MVA), real power flow
(MW), or reactive power flow (MVR). The oneline display options dialog can be invoked either by
selecting Oneline Display Options from the Oneline Options ribbon group on the Options ribbon
tab or by right-clicking on the background of the oneline diagram and selecting Oneline Display
Options from the resulting local menu.
Right clicking on the pie chart displays the Line Flow Pie Chart Options Dialog. This dialog allows you
to view the from and to bus numbers and the circuit number of the line/transformer associated with
the pie chart. You can change the pie chart's size and the MVA rating of the line/transformer
associated with the pie chart.
Edit Mode
To enter a new line flow pie chart, select Pies/Gauges > Line Flow Pie Chart from the Individual
Insert ribbon group on the Draw ribbon tab_Ref1411868421 and click on the line or transformer to
which you want to add the pie chart. This opens the Line Flow Pie Chart Options Dialog box. Enter
the near and far bus number associated with the device (these fields default to the terminal bus
numbers of the device on which you clicked), the circuit number of the device, and the desired size
of the pie chart. The field will display the flow value at the near end of the device. Enter the size of
the device. Select OK to insert the line flow pie chart. Otherwise, select Cancel.
To modify the parameters of an existing line flow pie chart, position the cursor anywhere on the
object and right-click. This again brings up the Line Flow Pie Chart Options Dialog box.
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Line Flow Gauges
Line flow gauges provide a way to visualize the flow of a transmission line or transformer relative to its
thermal rating. A gauge looks very much like a thermometer. As the temperature changes, the height
of the mercury in the thermometer moves up and down. One reads the temperature measured by the
thermometer by noting the marking that matches the top of the mercury. Line flow gauges in
Simulator work the same way. A line flow gauge has two markings on its side, one for the designated
minimum flow, and one for the designated maximum flow (the branch's rating). Inside the gauge is a
filled region. The default color of the filled region is blue, but this can be changed. When you create
the line flow gauge, you associate it with a transmission element, and you specify its fill color and its
minimum and maximum flow levels. Once the gauge has been placed on a display, it will reveal
changes in its associated branch's flow by varying the height of its filled region. This tool was
introduced to provide an alternative to line flow pie charts.
To add a line flow gauge to a display, switch to Edit Mode and select Pies / Gauges > Old Gauges
> Line from the Individual Insert ribbon group on the Draw ribbon tab. Click on the oneline diagram
where you would like the new line flow gauge to appear. The Line Flow Gauge Options Dialog will
appear. Use this dialog to define the minimum and maximum flows for the line flow gauge, as well as
its fill color and whether it should be anchored to its associated transmission element. After you click
the "OK" button, the Line Flow Gauge Options Dialog will close, and the new line flow gauge will
appear.
Once a gauge has been placed on the oneline, the height of its filled region will change as the flow of
its transmission element changes. To modify any of the characteristics of the gauge, such as its key
flow levels, fill color, and anchor setting, simply right-click on the line flow gauge to open the Line
Flow Gauge Options Dialog again.
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Line Flow Gauge Options Dialog
The Line Flow Gauge Options Dialog is used to define and configure a Line Flow gauge. A line flow
gauge is associated with a particular line and reveals the line’s flow relative to specified minimum and
maximum thermal flow levels. The height of the colored column in the line flow gauge indicates the
line’s flow relative to these markings.
The dialog has the following controls:
Number, Name, and Find
Use the Number and Name dropdown boxes, in addition to the Circuit field, to identify the
terminal buses to which the branch desired corresponds. It may be more convenient to press the
Find button to open the Find Dialog, which allows you to specify the line by either bus names or
numbers using wildcards. When you first open the Line Flow Gauge Dialog, the bus names and
numbers will correspond to the transmission line object that was closest to the point where you
clicked.
Minimum and Maximum
Use these two spin edit boxes in the MW Rating values group box to specify the minimum and
maximum flow levels. These settings determine where on the gauge its two markings will be drawn.
The Minimum and Maximum value will be taken from the Limit Monitoring settings for the current
transmission line, unless you uncheck the option "Set Limits According to Current Limit Monitoring
Settings".
Anchored
A line flow gauge is said to be anchored if, when you move its associated line object, the gauge
moves with it. Check the Anchored check box to ensure that the gauge will move with its associated
line. Otherwise, when you move its associated line object, the gauge will stay in its current position.
OK, Help, and Cancel
Click OK to finalize your settings. This will create a new line flow gauge object if you are trying to
create one from scratch, or it will modify the appearance and settings of an existing one if you have
chosen to modify one that has already been defined. Click Cancel to dispose of your changes.
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Line Flow Arrows on Onelines
There is a separate object, called a Line Flow Arrow, that can be added to a transmission line or
transformer. This object is different than the animated flow arrows that can be added to all
transmission branches through settings with the Oneline Display Options. The Line Flow Arrow is a
single static arrow that indicates the direction of MW flow on a transmission branch. The direction that
the arrow points indicates the direction of MW flow, and there are additional options that allow the
MW, Mvar, and MVA flow values to be displayed with the object.
To add a Line Flow Arrow to a transmission branch, select Indication > Line Flow Arrow from the
Individual Insert ribbon group on the Draw ribbon tab while in Edit mode, then left-click on the branch
to which the Line Flow Arrow should be added. The Line/Transformer Flow Object dialog will open.
The dialog contains the following options:
FromBus, ToBus, Circuit
The from bus, to bus, and circuit of the branch the arrow represents. The from bus indicates the
side of the branch at which the flow will be reported. The Find button can be used to open a dialog
that allows the selection of a branch.
Size
Size of the object.
Angle
Angle indicating how the object will be drawn. Enter this in degrees.
Anchored
Check this box to anchor the flow arrow to the branch that it represents. If anchored, the flow arrow
will move accordingly any time that the branch is moved.
Auto-determine angle when anchored
Check this box to have the angle of the flow arrow determined by the branch to which it is anchored
rather than using the user-specified value. The angle is determined by how the branch is drawn and
the direction of MW flow on the branch. It is a good idea to use this option by default. This will
ensure that the arrow is drawn correctly with the direction of flow.
Show MW, Show Mvar, Show MVA, Show Units
Check the appropriate box to show the selected flow value in text along with the flow arrow object.
Check the Show Units box to include units along with the value.
Flow Text Position
Select to place any flow text either Above Arrow or Below Arrow.
Total Digits in Field, Digits to Right of Decimal
Use these fields to indicate the total digits and digits to the right of the decimal for any values that
are shown in the flow text.
By default, line flow arrows will be drawn with a lime color. The color and other attributes can be
changed while in edit mode. To change how the line flow arrow is drawn, select the object to change
and then select Format from the Formatting ribbon group on the Draw ribbon tab. This will open the
Format Multiple Objects dialog and any attributes that can be modified will be enabled on this dialog.
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DC Transmission Line Display Objects
DC transmission lines are represented on the onelines using multiple segment lines drawn between
two buses. Line fields are often placed close to dc transmission lines on the oneline to indicate the
power flow through the device.
Note that, unlike ac transmission lines, dc transmission lines cannot be equipped with circuit breakers.
Run Mode
Simulator's animation feature can be used to indicate the magnitude of the flow on the dc
transmission line, either in MW or in terms of the line's percentage loading. You can customize the
line flow animation using the Animated Flows Options on the Oneline Display Options Dialog.
Right-clicking on a dc transmission line displays the line's local menu, from which you can choose to
inspect the DC Transmission Line Dialog.
Edit Mode
To add a new dc transmission line to the case, first select Network > DC Transmission Line from
the Individual Insert ribbon group on the Draw ribbon tab. Then place the cursor on the bus you
desire to be the rectifier bus for the line and click the left mouse button. Add more segments to the
line by moving the cursor and clicking with the left mouse button. To complete the new line, place
the cursor on the second bus for the line, which will serve as the inverter bus, and double-click the
left mouse button. This calls up the DC Transmission Line Dialog. If you successfully selected the
rectifier and inverter buses, their numbers will be automatically filled in for you when the dialog
opens.
The DC Transmission Line Record Dialog has four separate pages: Line Parameters, Rectifier
Parameters, Inverter Parameters, and Actual Flows. The separate pages can be accessed using the
tabs shown at the top of the dialog. These pages are used to set the modeling parameters
associated with the dc lines.
To modify the parameters for an existing dc transmission line, position the cursor anywhere on the
line and right-click. This will provide access to the corresponding DC Transmission Line Dialog, from
which you can modify any of the dc line's parameters. Select from the Formatting ribbon group on
the Draw ribbon tab to change the color and/or line thickness of the dc line.
To change the shape of the line, first left-click on the line to select it. This causes handles to appear
at each vertex. You can then move any vertex by clicking and holding the left mouse button down,
dragging the vertex to a new location, and releasing the mouse button. To remove a vertex, hold
down the CTRL key and then click the vertex you would like to delete. To add a vertex, hold down
the CTRL key and then click on the line where you would like to add a vertex.
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Multi-section Line Display Objects
Multi-section lines are represented on the onelines using a line segment with intermediate or "dummy"
bus representations. These objects are not the same as a normal transmission line. They do display
animated flows in run mode, but do not have pie charts, circuit breakers, or text fields currently
associated with the objects.
Run Mode
Simulator's animation feature can be used to indicate the magnitude of the flow on the transmission
line, either in MW or in terms of the line's percentage loading. You can customize the line flow
animation using the Animated Flows Options on the Oneline Display Options Dialog.
Right-clicking on a multi-section line displays the Multi-section Line Information Dialog.
Edit Mode
Unlike transmission lines and transformers, multi-section lines CANNOT be inserted in a case by
adding the mult-section line graphically. Therefore, when inserting a multi-section line object, the
data for the object must already exist in the case. A list of currently defined multi-section lines is
found in the model explorer under Aggregations > Multi-Section Lines. Right-clicking and
selecting Insert… in the table that opens will allow you to add new multi-section line information
via the Multi-Section Line Information dialog.
To insert the multi-section line object, first select Network > MS Transmission Line from the
Individual Insert ribbon group on the Draw ribbon tab. Then place the cursor on the first bus for the
transmission line (the "from" bus) and click the left mouse button. Add more segments to the line by
moving the cursor and clicking with the left mouse button. To complete adding a new line, place the
cursor on the second bus for the line (the "to" bus) and double-click with the left mouse button.
Completing the multi-section line opens the Multi-section Line Information dialog. At the bottom of
this dialog are display options for the line, such as line pixel thickness, symbol size (for the series
capacitor representations, if any,) anchored, and options for drawing the buses.
To change the shape of the line, first left-click on the line to select it. This causes handles to appear
at each vertex. You can then move any vertex clicking and holding the left mouse button down on
the vertex, dragging it to a new location, and then releasing the mouse button. To remove a vertex,
hold down the CTRL key and then click the vertex you would like to delete. To add a vertex, hold
down the CTRL key and then click on the line where you would like to add a vertex.
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Transformer Display Objects
Transformers are represented as transmission lines with two opposing coils drawn on one of the
segments. The transformer's line thickness, color, and symbol segment can be customized using the
Branch Options Edit mode dialog. Optionally, circuit breakers and pie charts can be placed on the
transformer. Clicking on the circuit breakers changes the status of the transformer.
Line fields are often placed close to transformers on the oneline to indicate the power flow through the
device. Transformer fields are often placed close to transformers on the oneline to indicate and control
their tap positions. See Transformer Modeling for details on modeling either LTC or phase shifting
transformers.
Run Mode
Simulator's animation feature can be used to indicate the magnitude of the flow through the
transmission line, either in MW or in terms of the transformer's percentage loading. You can
customize the line flow animation using the Animated Flows Options on the Oneline Display
Options Dialog.
Right-clicking on a transformer displays the line's local menu, from which you can choose to inspect
the Branch Information Dialog.
Edit Mode
New transformers are inserted in much the same way as transmission lines. To add a new
transformer to the case, first select Network > Transformer from the Individual Insert ribbon
group on the Draw ribbon tab. Then place the cursor on the first bus for the transformer (the from
bus) and click the left mouse button. Add more segments to the transformer by moving the cursor
and clicking with the left mouse button. To complete the new transformer, place the cursor on the
transformer's other terminal (the to bus) and double-click with the left mouse button. This calls up
the Branch Options dialog. The from and to bus numbers for the transformer should have been set
automatically. If there is just one transformer between the buses, the circuit number should be "1."
For multiple transformers between buses, you must give each a unique circuit number. Enter the
thickness of the lines [in pixels] used to display the transformer, the number of the line segment in
which you would like the transformer symbol drawn, and the size of the transformer symbol.
Enter the per unit (100 MVA base by default) resistance, reactance and charging susceptance for the
transformer, and an MVA rating. Enter the off-nominal tap ratio and the phase shift angle in
degrees. (For a transformer without tap or phase control, the off-nominal tap should be 1.0 and the
phase shift angle should be 0 degrees.)
Select the appropriate Automatic Control Option. If the transformer does not have tap control, select
No Automatic Control (this is the default). Select AVR (Automatic Voltage Regulation) if the
transformer changes its tap ratio to control the voltage at user specified regulation bus. Select
Reactive Power Control if the transformer changes its tap ratio to control the reactive power through
the transformer. Finally, select Phase Shift Control if the transformer changes its phase shift to
control the MW flow through the transformer. If you need any of the last three options, select the
Automatic Control Options button to set the parameters associated with the automatic control.
For AVR control, enter the number of the bus whose voltage is to be controlled, the allowable range
for the controlled voltage (in per unit), the minimum and maximum tap ratios (typical values are 0.9
and 1.1), and the step size for the discrete changes in the tap ratio (typical value is 0.00625).
For reactive power control, the control variable is always the reactive power measured at the from
bus (i.e., the tapped side) of the transformer. Positive flow is assumed to be going through the
transformer to the to bus. Enter the minimum and maximum allowable flows, the minimum and
maximum tap ratios (typical values are 0.9 and 1.1), and the step size for the discrete changes in
the tap ratio (typical value is 0.00625).
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For phase shift control, the MW flow through the transformer is the controlled value. Enter the bus
number of the terminal whose flow is controlled, the allowable range for the controlled flow (positive
flow is assumed to be into the transformer at the terminal entered in the previous field), the
minimum and maximum phase angles (typical values are -30 and 30), and the step size in degrees
(typical values are between 1 and 2).
Select OK to save the values and return to the Transformer Options Dialog; otherwise select
Cancel.
If you would like the transformer to be initially modeled as being on automatic control at the start of
the case, select the Automatic Control Active checkbox.
If you do not want to add the transformer to the case, select Cancel.
To modify the parameters for an existing transformer, position the cursor anywhere on the device
and right-click. This brings up the local menu from which you can choose to view the Line
Information Dialog. This will open the Branch Options dialog. Use this dialog to adjust many of the
transformer's electrical properties. The Formatting ribbon group provides tools to change the
transformer's color and/or line thickness.
See Transformer Modeling for details on modeling either LTC or phase shifting transformers.
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Transformer Fields on Onelines
Transformer fields are used to show field values specific to transformers, such as tap position, phase
angle, and more.
Run Mode
If there is a spin control integrated with the field, you can click on the spinner to change the field's
value by the associated Delta Per Mouse Click.
Right clicking on the transformer field gives the option to display the Transformer Field Dialog or the
Line/Transformer Information Dialog.
Edit Mode
To enter a new transformer field, select Field > Transformer Field from the Individual Insert
ribbon group on the Draw ribbon tab, and then click on the transformer object to which you want to
add the new field. This calls up the Transformer Field Dialog. Enter the from and to bus numbers
associated with the device (the default values for these fields correspond to the transformer on
which you clicked), and the circuit number of the device. Enter the total number of digits that the
field should display, as well as the number of digits to the right of the decimal point. Finally, specify
what the field should display: the off-nominal tap ratio, the off-nominal tap position, or the phase
shift angle in degrees.
To modify the parameters of an existing transformer field, position the cursor anywhere on the
object and right-click to bring up the Transformer Field Dialog. Use the tools of the Formatting
ribbon group to change various display attributes for the transformer field, including its font and
background color.
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Three Winding Transformer Display Objects
Three winding transformer display objects do not currently have as much functionality as other display
objects. They do provide a graphical representation for identifying where three winding transformers
are located in the network, but the display objects do not provide access to additional control
information for the transformer. Three winding transformer display objects cannot be anchored to
buses like other objects can, meaning that they will not move as other objects in the display are
moved around.
A three winding transformer can be added to a oneline display while in Edit mode by selecting
Network > Three-Winding Transformer from the Individual Insert ribbon group on the Draw
ribbon tab. This will change the mouse cursor to a cross-hair. Place the cross-hair on the oneline
background at the location where the new transformer should be placed and then left-click. This will
open the Three-Winding Transformer dialog.
The Three-Winding Transformer dialog contains information about the display of the three winding
transformer only. Use the Three Winding Transformer Display to view and change control parameters
and other information about the transformer. The dialog contains the following parameters:
Primary Number, Name, and Area
Number, name, and area number of the primary winding bus.
Secondary Number, Name, and Area
Number, name, and area number of the secondary winding bus.
Tertiary Number, Name, and Area
Number, name, and area number of the tertiary winding bus.
Circuit
Circuit ID of the three winding transformer.
When creating a new three winding transformer on the display, the primary, secondary, and tertiary
bus numbers and circuit ID must be provided that correspond to a three winding transformer that
already exists in the power flow case data model. The creation of a new three winding transformer in
the data model is not allowed by graphically inserting a transformer. The bus names and area
numbers are provided for informational purposes only and do not have to be entered when creating a
new display object.
Click the Find button next to the winding specifications to open a dialog that can be used to search for
an existing three winding transformer in the data model.
An existing three winding transformer display object can be assigned to a new three winding
transformer data object by changing the Primary, Secondary, Tertiary, and Circuit to match an existing
three winding transformer data object.
Labels
Optionally, create a label to identify the three winding transformer that the display object
represents. Assigning a label here will associate a label with three winding transformer in the data
model. See the Labels topic for more information about labels.
This entry is an exception for this dialog. All other fields are associated with the display object only.
This is the only field that is associated with the underlying data object that the display object
represents.
Display Size
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This is the vertical size of the object when displayed using Orientation Up or Down. This is the
horizontal size of the object when displayed using Orientation Left or Right. This is in Simulator
units.
Display Width
This is the vertical size of the object when displayed using Orientation Left or Right. This is the
horizontal size of the object when displayed using Orientation Up or Down. This is in Simulator units.
Pixel Thickness
Thickness in pixels of the lines used to draw the object.
Anchored
This option is permanently disabled. Currently, three winding transformer objects cannot be
anchored to other objects.
Orientation
Options are Right, Left, Up, and Down. The option selected determines the side of the object that
the secondary and tertiary windings are on relative to the primary winding.
Tertiary Orientation
This option determines the placing of the tertiary winding relative to the secondary winding. If the
Orientation is either Right or Left, the Tertiary Orientation options are either Up or Down. If the
Orientation is either Up or Down, the Tertiary Orientation options are either Right or Left.
Colors
Different colors can be specified for the Primary, Secondary, and Tertiary windings. Either left-click
on the color or click the Change button next to the appropriate winding to open a dialog that will
allow color selection.
OK, Cancel, Help
Click OK to apply any changes and close the dialog. Click Cancel to close the dialog without
applying any changes. Click Help to open this help topic.
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Series Capacitor Display Objects
Series capacitors are represented as transmission lines with two opposing parallel bars drawn on one
of the segments. The series capacitor’s line thickness, color and symbol segment can be customized
using the Branch Options Edit mode dialog. If the series capacitor branch is operating, but the series
capacitor status is set to Bypassed, a low impedance segment will be drawn around the series
capacitor symbol to indicate the capacitor has been bypassed. The capacitor status of Bypassed or In
Service can be toggled in run mode if the Series Capacitor Status field is displayed on the oneline
diagram. When a left-click is registered on the Series Capacitor Status field when in Run Mode, the
capacitor status is toggled. Note that this is not the same as the overall branch status of Open or
Closed.
Optionally, circuit breakers and pie charts can be placed on the series capacitor. Clicking the circuit
breakers changes the branch status of the series capacitor.
Run Mode
Simulator's animation feature can be used to indicate the magnitude of the flow through the series
capacitor, either in MW or in terms of the transformer's percentage loading. You can customize the
line flow animation using the Animated Flows Options on the Oneline Display Options Dialog.
Right-clicking on a series capacitor displays the line's local menu, from which you can choose to
inspect the Branch Information Dialog.
Edit Mode
New series capacitors are inserted in much the same way as transmission lines. To add a new series
capacitor to the case, select Network > Series Capacitor from the Individual Insert ribbon group
on the Draw ribbon tab. Then place the cursor on the first bus for the series capacitor (the from
bus) and click the left mouse button. Add more segments to the series capacitor by moving the
cursor and clicking with the left mouse button. To complete the new series capacitor, place the
cursor on the series capacitor's other terminal (the to bus) and double-click with the left mouse
button. This calls up the Branch Options dialog. The from and to bus numbers for the series
capacitor should have been set automatically. If there is just one branch between the buses, the
circuit number should be "1." For multiple branches between buses, you must give each a unique
circuit number. Enter the thickness of the lines [in pixels] used to display the series capacitor, the
number of the line segment in which you would like the series capacitor symbol drawn, and the size
of the series capacitor symbol.
Enter the per unit (100 MVA base by default) resistance, reactance and charging susceptance for the
series capacitor, and an MVA rating. On the Series Capacitor tab, check the box labeled Is Series
Capacitor to indicate that the branch model is a series capacitor device.
If you do not want to add the series capacitor to the case, select Cancel. Otherwise click OK to add
the series capacitor to the case.
To modify the parameters for an existing series capacitor, position the cursor anywhere on the
device and right-click. This brings up the local menu from which you can choose to view the Line
Information Dialog. This will open the Branch Options dialog. Use this dialog to adjust many of the
series capacitor's electrical properties.
See Series Capacitor Information for more details on modeling series capacitors.
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Series Capacitor Fields on Onelines
Series capacitor fields are used to show field values specific to series capacitors.
Run Mode
If the Series Capacitor field for capacitor status is displayed, the capacitor status can be toggled in
run mode when you left-click on the field.
Right-clicking on the series capacitor field gives the option to display the Series Capacitor Field
Dialog or the Branch Information Dialog.
Edit Mode
To enter a new series capacitor field, select Field > Series Capacitor Field from the Individual
Insert ribbon group on the Draw ribbon tab, and then click on or near the series capacitor object for
which you want to add the new field. This calls up the Series Capacitor Field Dialog. Enter the from
and to bus numbers associated with the device (the default values for these fields correspond to the
series capacitor on which you clicked), and the circuit number of the device. Enter the total number
of digits that the field should display, as well as the number of digits to the right of the decimal
point. Finally, specify what the field should display: the capacitor status or the series capacitance.
To modify the parameters of an existing series capacitor field, position the cursor anywhere on the
object and right-click to bring up the Series Capacitor Field Dialog.

732
©2011 PowerWorld Corporation

Switched Shunt Display Objects
Switched shunts are either capacitors that supply reactive power to the system or reactors that absorb
reactive power. Simulator represents switched shunts as a number of blocks of admittance that can be
switched in a number of discrete steps or over a continuous range. Switched shunt display objects
come equipped with a circuit breaker that indicates the shunt's status. If the switched shunt is closed,
the circuit breaker appears as a filled red square. If the switched shunt is open, the circuit breaker
appears as a green square outline. To change the status of the switched shunt, click the corresponding
circuit breaker.
Switched shunt fields are often placed next to switched shunts to indicate the amount of reactive
power supplied by the device. For switched shunts with such a field, you can manually increase the
reactive power supplied by the device (provided its control mode is discrete) by clicking on the uparrow associated with the device's reactive power field. Likewise, you can decrease the reactive power
supplied by the device by clicking on the down-arrow. To make the up/down arrows visible, set the
Delta per Mouse Click on the switched shunt field to a nonzero value.
Right-clicking on the switched shunt displays the Switched Shunt Dialog. Use the Switched Shunt
Dialog to inspect or modify the model of the switched shunt.
You can add a new switched shunt to the case in Edit Mode. Select Network > Switched Shunt
from the Individual Insert ribbon group on the Draw ribbon tab. Then click the bus where you would
like to attach the device. The Switched Shunt Dialog will appear. The bus number is automatically
determined from the bus to which you attached the capacitor. Enter the size, the thickness of the pen
[in pixels] used to draw the device, and its orientation. The Nominal Mvar field gives the amount of
reactive power the device would supply if its terminal voltage were 1.0 per unit. The Control Mode
field determines whether the switched shunt has a fixed value or will vary discretely or continuously
within its operating limits to maintain its terminal voltage within the voltage range specified in the
Voltage Regulation field.
The amount of shunt admittance is specified in the Switched Shunt Blocks table. The columns in this
field correspond to different blocks of admittance. The first row indicates the number of steps in each
block, and the second row gives the amount of nominal Mvars per step. The switched shunts are
always switched in the order specified in this field.
Select OK to add the device. If you do not want to add the switched shunt to the case, select Cancel.
To modify the parameters for an existing switched shunt, position the cursor on the device and rightclick. This again brings up the Switched Shunt Dialog. You can then change any parameter of the
switched shunt. Make use of the tools in the Formatting ribbon group to change the color and/or line
thickness.
To delete an existing switched shunt, use the Cut or Delete commands in the Clipboard ribbon group.
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Switched Shunt Fields on Onelines
Switched Shunt field objects are used primarily to indicate various quantities associated with switched
shunt devices. Furthermore, some switched shunt field types, which are distinguished by an integrated
spin button, may be used to change switched shunt device properties.
Run Mode
For switched shunt fields with an associated spin button, clicking on the up/down arrows will change
the value of the associated field.
Right clicking on a generator field gives you the option to open the Switched Shunt Field Dialog or
the Switched Shunt Information Dialog.
Edit Mode
Simulator offers two options for adding switched shunt fields to a oneline in Edit Mode. If you need
to enter only a single field, the easier approach may be to choose Field > Switched Shunt Field
from the Individual Insert ribbon group on the Draw ribbon tab, and then select the switched shunt
to which you want to add the field. This invokes the Switched Shunt Field Dialog. Enter the bus
number associated with the device (the default is the bus associated to the closest switched shunt to
the field), the ID field, the total number of digits to show, and the number of digits to the right of
the decimal point. Next, select the type of field to show.
The second approach for adding new switched shunt fields entails right-clicking the bus and
selecting Add New Fields Around Switched Shunt from the resulting local menu. Please see Inserting
and Placing Multiple Display Fields for more details.
To modify the parameters of an existing switched shunt field, position the cursor anywhere on the
object and right-click. This brings up the Switched Shunt Field Dialog. Make use of the tools on the
Formatting ribbon group to change various display attributes of the field, including its font and
background color.
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Interface Display Objects
Interface display objects are used on the onelines to visualize the flow of power through an interface
record. Interface records are used to show the net real power (MW) flow on a group consisting of one
or more of the following devices: 1) transmission lines and/or transformers, 2) total tie-lines between
two adjacent areas, and 3) total tie-lines between two adjacent zones. Only area-area and zone-zone
interface records can be displayed using interface display objects.
Interfaces, like transmission lines, are represented as multi-segment lines, except that they may be
drawn between area/zone objects in addition to buses. Drawing interface display objects involves the
same steps as drawing transmission lines and transformers. The line thickness and color of interface
objects may be customized by selecting from the Formatting ribbon group on the Draw ribbon tab.
Interface Fields and Interface Pie Charts are often placed close to or on the interface to indicate the
power flow through the device.
Run Mode
When animation is active, the flow of the arrows on the interface object may represent either the
MW flow through the interface or the currently calculated power transfer distribution factor (PTDF)
pertaining to that interface. You can customize the appearance of the animated flows using the
Animated Flows Tab of the Oneline Display Options Dialog available using the local menu.
Right-click on the interface to view the Interface Dialog for the interface.
Edit Mode
The quickest method of inserting new interface objects is to use the Auto Insert > Interfaces
from the Quick Insert ribbon group on the Draw ribbon tab. Please see Automatically Inserting
Interfaces for details.
To manually add a new interface object to the case, first select Aggregation > Interface from the
Individual Insert ribbon group on the Draw ribbon tab. Then place the cursor on the starting location
for the interface (usually an area/zone object or a bus object) and left-click. Add more segments to
the interface by moving the cursor and the left-clicking at the end of the segment. To finish adding
an interface, place the cursor on the terminal object for the interface and double-click. This then
calls up the Interface Dialog. Either select an existing interface, or define a new interface (see
Interface Dialog for details).
Interfaces can be anchored to either area/zone objects or bus objects.
To change the shape of the interface, first left-click on the object to select it. This causes handles to
appear at each vertex. You can then move any vertex by dragging it with the left mouse button
down. To remove a vertex, hold down the CTRL key and then click the vertex you would like to
delete. To add a vertex, hold down the CTRL key and then click on the interface where you would
like to add the vertex.
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Automatically Inserting Interface Display Objects
The Automatic Insertion of Interfaces Dialog is used to automatically insert interface objects on the
oneline diagram between existing area/zone display objects. Interface pie chart objects can also be
inserted as part of this process. The automatic insertion of interface display objects greatly accelerates
the construction of interface diagrams, which are particularly useful for animating the results of PTDF
calculations. Area-area and zone-zone interface records can be displayed using interface display
objects as well as interfaces comprised only of transmission branches.
Note that inserting interface objects on a oneline diagram does NOT add interface objects to the load
flow case. The interface definitions need to be added to the load flow case prior to automatically
inserting the graphical interface objects on a oneline diagram. The quickest way to add area to area or
zone to zone interface definitions in the load flow case is to automatically insert the definitions in the
interface case information display.
Once you have the interface definitions defined in the case, you can automatically insert the interface
objects on a diagram using the following procedure:








On a oneline diagram (either an already open diagram or a brand new one created by choosing
New Oneline from the application button), place area/ zone objects at the desired locations if
inserting area-area or zone-zone interface records. Otherwise, the terminal buses for the branch
elements in the interface should be inserted at the desired locations on the oneline diagram.
Go to the Draw ribbon tab and choose Auto Insert > Interfaces on the Quick Insert ribbon
group.
Check the Insert Pie Charts on Interfaces box to automatically insert interface pie chart
objects when the interfaces are inserted. If this option is selected, change the Default Size of
Interface Pie Charts to specify their size.
Choose the type of interfaces to insert. Area to Area or Zone to Zone Interfaces and
Line/Transformer Interfaces can be inserted. Area-area and zone-zone interfaces will be
drawn between the respective area and zone objects displayed on the oneline. Line/transformer
interfaces will be drawn based on the average location of the terminal buses of all transmission
lines comprising the interface. If inserting line/transformer interfaces, the option Minimum
Length of Line/Transformer Interfaces can be set to prevent interfaces that are too short
from being inserted.
Select OK to insert the new oneline objects. New interface objects are automatically inserted
based on the selected criteria for any corresponding interface record that is not already
represented.

Note that you can do this automatic insertion as often as you like. The Number of Interfaces Not
Shown field indicates how many interfaces still need to be added to the diagram to represent all
defined area-area, zone-zone, or line/transformer interfaces. It is a read-only field.
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Interface Fields on Onelines
Interface field objects are used to show values associated with interface records.
Run Mode
Right clicking on the interface field displays the Interface Field Dialog.
Edit Mode
To enter a new interface field, select Field > Interface Field from the Individual Insert ribbon
group on the Draw ribbon tab, and then click on the background of the oneline diagram where you
want the field placed. This calls up the Interface Field Dialog. Enter the name of the interface, the
total number of digits desired in the field, and the type of field.
To modify the parameters of an existing interface field, position the cursor anywhere on the object
and right-click. This again brings up the Interface Field Dialog.
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InterArea Flow Options Dialog
This dialog is outdated in PowerWorld Simulator version 5 and later. See help on the Interface Field
Information Dialog for the updated dialog.
When viewing an area diagram containing inter-area objects created using PowerWorld Simulator
version 4.2 or older, this dialog allows you to set text fields displaying either the actual or scheduled
MW flow on the inter-area object.
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Interface Pie Charts on Onelines
Interface pie charts are used to graphically show the percentage loading on an interface record. The
amount of shaded region of the pie chart indicates how close the interface is to its limit (provided the
interface has a nonzero limit). The appearance of the interface pie charts, including their color and the
ability to automatically change size based upon loading level, can be customized on the Oneline
Display Options Dialog.
Right-clicking on the interface pie chart displays the Interface Pie Chart Dialog. This dialog can be used
to customize the size of the pie chart, or change the interface's limit.
Edit Mode
To enter a new interface pie chart, select Pies/Gauges > Interface Pie Chart from the Individual
Insert ribbon group on the Draw ribbon tab. Then, click the left mouse on the interface object with
which you want to associate the pie chart. This calls up the Interface Pie Chart Dialog, which is used
to customize the appearance of the pie chart.
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Loading NERC Flowgates
This command reads flowgates from an Excel file and inserts them as interface records. The format for
this file should be similar to the files found at http://www.nerc.com/~oc/dfwg.html. To access this file
you must have a NERC-supplied username and password. At the time of writing we have not seen an
official description of the format -- currently Simulator just mimics the format found in this file.
Flowgates are used by NERC (under Policy 9) as proxies for transmission limitations and transmission
service usage on the interconnected electric power network. Simulator models flowgates using the
interface records. Interface records MAY include contingency elements.
The Load NERC Book of Flowgates from Excel option is available from the local menu of the
Interface Records display.
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Saving NERC Flowgates
This command writes all the interfaces to an Excel spreadsheet using the NERC flowgate format. See
the files found at http://www.nerc.com/~oc/dfwg.html for an example of the NERC format. To access
this file you must have a NERC-supplied username and password.
The Send NERC Book of Flowgates to Excel option is available from the Save As option of the
local menu of the Interface Records display.
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Injection Group Display Objects
Injection group display objects are used on onelines to show a summary of the total injection of an
injection group from generation and load. The summary shows only the MW injection.
An injection group display object can be added to a oneline by choosing Aggregation > Injection
Group from the Individual Insert ribbon group on the Draw ribbon tab. After selecting this option,
place the cursor at the location on the oneline where the injection group object should be placed and
left-click. This will open the Injection Group Display Options dialog with the following options available:
Name
Select the name of the injection group represented by the current display object. The drop-down will
contain the names of all currently defined injection groups. New injection groups cannot be created
through the injection group display object.
Style
The style dictates how the object will be drawn on the oneline. The injection group object is a simple
object that is either a Rectangle or Rounded Rectangle.
Caption
This option is used to determine how the injection group will be identified on the display object.
Currently, only the Name can be used as the identifier.
Width, Height
Specify the size of the object through these two options.
After an object has been created, the Injection Group Display Options dialog can be opened while in
Edit mode by right-clicking on the object. If in Run mode, the Injection Groups Dialog will open when
right-clicking on an injection group display object.
An injection group display object uses the same Default Drawing Values as those specified for an area
display object. To change how the object is drawn after it has been created, select the object to
change and then select Format from the Formatting ribbon group on the Draw ribbon tab. This will
open the Format Multiple Objects dialog, and any attributes that can be modified will be enabled on
this dialog. These format changes can only be done while in Edit mode.
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Links to Onelines and Auxiliary Files
Run Mode
Oneline Links
Oneline links are one of the mechanisms used in Simulator to allow you to view multiple oneline
diagrams on the same screen. By default, the oneline links are shown as blue rectangles surrounding
a text identifier of the linked oneline diagram. Double-clicking the left mouse button anywhere within
the oneline link object will display the linked oneline diagram, even if it has not already been
opened.
The ability to associate multiple oneline diagrams with a single case may prove particularly helpful
when dealing with large cases. If a single oneline diagram is used to display a case having many
buses, the diagram may become cluttered, and it will be difficult to analyze the case in sufficient
detail. The ability to associate additional onelines with the case and to call up those additional
onelines using one-links can significantly enhance your view of the system.
Oneline Links can be used to open oneline diagrams saved in either the PowerWorld Display file
(*.pwd) or Display Auxiliary file (*.axd).
Note that you can also use the Open Oneline command from the Application Button to open any
oneline diagram (*.pwd, *.axd) file directly. See Opening a Oneline Diagram for further details.
Auxiliary File Links
Auxiliary (*.aux) file links are one of the mechanisms used in Simulator to allow you to load auxiliary
files by simply clicking on a oneline object. By default, auxiliary file links are shown as blue
rectangles surrounding a text identifier of the linked auxiliary file. Double-clicking the left mouse
button anywhere within the auxiliary file link object will load the associated auxiliary file.
Note that you can also use the Load Auxiliary File command from the Application Button to open
any auxiliary file (*.aux) directly. See Auxiliary Files for further details.
Edit Mode
Oneline Links
To add a new oneline link to a oneline diagram, first select Background > Oneline Link from the
Individual Insert ribbon group on the Draw ribbon tab. Then, click the left mouse button at the
location where you would like to display the new link. The Oneline Link Options Dialog box will open,
asking you to enter the name of the file that stores the linked oneline and a caption for the clickable
oneline link object. The Browse button can also be used to open a dialog that will allow searching
for the file. Note that you can enter simply the name of the oneline file in this location or the
complete directory path and name. Simulator will look in the same directory as the case file by
default. However, you can also specify additional directory locations to search for oneline diagrams
by opening the Oneline Display Options Dialog (via Oneline Display Option from the Oneline
Options ribbon group on the Options ribbon tab, or from the Active ribbon group on the Onelines
ribbon tab), switching to Display Options on the left, and using the Edit Oneline Browsing Path
option to add additional search locations for oneline diagrams.
Oneline diagrams stored in either the PowerWorld Display format (*.pwd) or Display Auxiliary format
(*.axd) can be opened using oneline links. If using a Display Auxiliary format (*.axd) file, the
browsing path will not be used to find the file. The file must exist in the current directory or the full
directory path of the file must be specified.
Auxiliary File Links
To add a new auxiliary file link to a oneline diagram, first select Background > Auxiliary File Link
from the Individual Insert ribbon group on the Draw ribbon tab. Then, click the left mouse button at
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the location where you would like to display the new link. The Oneline and Auxiliary Link Options
Dialog will open, asking you to enter the name of the file that stores the linked auxiliary file and a
caption for the clickable auxiliary file link object. Note that you can simply enter the name of the
auxiliary file in this location. Simulator will look in the same directory as the case file.
Modifying Existing Links
To modify the parameters of an existing oneline or auxiliary file link, position the cursor anywhere
on the object and right-click. This invokes the Oneline Link Options Dialog, allowing you to change
the identity of the linked file and the caption. Select from the Formatting ribbon group on the Draw
ribbon tab to modify various display attributes of the oneline link, including font size and background
color.
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Document Links on Onelines
Just as you can link to other oneline displays from a oneline diagram using oneline link objects, you
can also link to documents and data on the world-wide web using Document Link Objects. When you
click on Document Link Objects in Run Mode, your system's default browser will be launched to
retrieve the linked URL address. This feature is not only for web URL's, though. Any file can be linked
and its associated application will automatically open. This means that presentations, documents and
spreadsheets can also be linked.
In addition to linking to objects online via a URL, it’s also possible to put in a local file name and have
that open when the document link is clicked. The behavior is the same as if you were to click on the
Windows Start button, then select Run.., then type in the file name.
To add a Document link to a oneline diagram, select Background > Document Link from the
Individual Insert ribbon group on the Draw ribbon tab. Then, click the left mouse on the oneline
diagram at the position where you would link to insert the Document link. The Document Link Options
Dialog box will appear, asking you to specify the world-wide web address to which to link as well as a
clickable caption to display on the oneline diagram. Enter the requested information and press OK to
add the Document link object to the oneline.
To modify the caption or address for a Document link object, right-click anywhere on its text. Specify
its new parameters in the Document Link Options Dialog and press OK. You may also modify various
aspects of its appearance, including the font size, by choosing from the Formatting ribbon group.
Note that Document links are active only in Run Mode. Clicking on a Document link object from the
Edit Mode will have no effect other than to select the object for placement, formatting, etc.
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Background Lines on Onelines
The background of an oneline diagram can display added lines, polylines, and filled polygons among
other items.
Edit Mode
To add a new background line, first go to the Draw ribbon tab and select Background >
Background Line from the Individual Insert ribbon group. Then to draw a series of straight line
segments on the background, follow these steps:



Position the mouse cursor where you want the series to begin and click and release the left mouse
button.
Move the mouse to the desired termination point of the first line segment. A straight segment will
follow your mouse movements. Click and release the left mouse button to complete the line
segment and prepare for drawing the next line segment, or double-click if this line segment is the
last segment you wish to draw.

To draw a freehand shape rather than a series of straight line segments, click and hold the left
mouse button where you would like the freehand shape to begin and drag the mouse to trace the
shape you desire (while holding the left mouse button down). Release the left mouse button to
complete the section of the freehand shape you have been drawing. At this point, you can add
either another freehand section or a straight line segment. When you have finished drawing in the
background, double click the mouse button.
Note that background display objects composed of straight line segments display significantly faster
than lines drawn freehand. Lines draw freehand (holding down mouse button) leave a vertex point
at every point on the screen, where a line composed of straight-line segments (left-clicking only
where you want a vertex point) takes considerably less effort for the PC to draw.
To change the color, line thickness, and fill color associated with the line, make use of the tools in
the Formatting ribbon group.
To change the shape of the line, first left-click on the line to select it. This causes handles to appear
at each vertex. You can then move any vertex by holding the left mouse button down and dragging
the vertex to a new location. To remove a vertex, hold down the CTRL key and then click the vertex
you would like to delete. To add a vertex, hold down the CTRL key and then click on the line where
you would like to add a vertex. Note that freehand lines are nothing more than a continuous series
of vertices.
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Background Lines Dialog
The Line Options Dialog is available while in edit mode by right-clicking on a background line and
selecting Open Dialog… This dialog contains options for formatting the selected background line.
Many of the options listed in this dialog can also be updated on the Format dialog.
Line Thickness
This field gives the thickness of the line in pixels.
Line Color
This field shows the current line color. To change the line’s color, click on the box displaying the
current color or click the Change button next to the line color. This will display the Color Dialog.
Select the desired color and select OK to change the color.
Use Background Fill
When this option is checked, the selected Fill Color will be used to fill the background of the line.
Fill Color
This field shows the current fill color. To change the fill color, click on the box that displays the
current fill color or click the Change button. This will display the Color Dialog. Select the desired
color and select OK to change the color.
Immobile
When this option is checked, the background line will be forced to stay in the same position and
cannot be moved by dragging it with the mouse.
List of Vertices
This grid lists the x,y coordinates for the vertices of the line in the order in which the line is drawn.
The coordinates will be displayed as longitude,latitude if the option to show coordinates in
longitiude,latitude is selected on the Oneline Display Options dialog and a valid map projection is in
use. The values for the coordinates can be changed by entering new values in the appropriate
position in the grid.
Shift X/Y Values
These options provide a means of updating all of the x and/or y values. The X Shift Value is the
offset by which all of the x values will be shifted. The Y Shift Value is the offset by which all of the
y values will be shifted. The resulting values will be the original values plus the value entered for the
shift. The Shift All Values button must be selected for the values entered in the shift fields to be
applied to the x,y values. After this button is selected, the coordinates shown in the grid will be
updated with the new values.
Scale X/Y Values
These options provide a means of updating all of the x and/or y values. The X Scale Value is the
value by which all of the x values will be scaled. The Y Scale Value is the values by which all of the
y values will be scaled. The resulting values will be the original values multiplied by the value
entered for the scale. The Scale All Values button must be selected for the values entered in the
scale fields to be applied to the x,y values. After this button is selected, the coordinates shown in the
grid will be updated with the new values.
OK, Save and Update Display, and Cancel
OK saves the changes and closes the dialog. Save and Update Display saves the changes and
updates the display without closing the dialog. Cancel closes the dialog without saving any changes.
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Background Rectangles on Onelines
The background of a oneline diagram can display rectangles among other items.
Edit Mode
To add a new rectangle, first go to the Draw ribbon tab and select Insert > Background
Rectangle from the Individual Insert ribbon group. Position the cursor where you would like to
place the upper left-hand corner of the rectangle and click with the left mouse button. A rectangle
having the default size is inserted. Drag the rectangle's resizing handles to resize/reshape the
rectangle.
To resize or reshape an existing rectangle, click on it to select it. The resizing handles will appear,
which you can then drag to reshape or resize the rectangle.
To change the color, line thickness or fill color of the rectangle, first select the rectangleby clicking
on it on the diagram, and then use the tools in the Formatting ribbon group on the Draw ribbon tab,
or right-click on it and select Format Background Rectangle from the local menu.
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Background Ellipses on Onelines
The background of a oneline diagram can display ellipses among other items.
Edit Mode
To add a new ellipse, first go to the Draw ribbon tab and select Background > Background
Ellipse from the Individual Insert ribbon group. Then position the cursor where you would like to
place the upper left-hand corner of the ellipse and click with the left mouse button. An ellipse having
the default size and shape is inserted. Drag the ellipse's resizing handles to resize/reshape it.
To resize or reshape an existing ellipse, click on it to select it. The resizing handles will appear,
which you can then drag to reshape or resize the ellipse.
Right-click on the ellipse and choose Format Background Ellipse, or select the ellipse and use the
tools in the Formatting ribbon group found on the Draw ribbon tab to change the color, line
thickness and fill color of the ellipse.
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Background Pictures on Onelines
The background of an oneline diagram can display a variety of objects, including lines, filled polygons,
and even pictures. The latter will be discussed in this section.
Edit Mode
Simulator can insert bitmaps, jpegs, enhanced and standard metafiles, and icons from files into the
oneline diagram. These pictures may either serve as a background or appear above other objects on
the oneline.
To add a picture object to the oneline diagram, go to the Draw ribbon tab and select Background
> Picture from the Individual Insert ribbon group. Then, click the oneline diagram at the point
where you would like the top left corner of the graphic to be placed. The Open Picture Dialog will
open, asking you to select the graphic file that you want to insert. When you select a file from the
dialog, the dialog displays a preview image so that you can be sure that you are selecting the right
file. When you have identified the file to insert, click OK. The image will then appear on the oneline.
It may be resized by dragging its resizing handles.
By default, pictures are inserted at the middle stack level. Thus, they hide most other oneline display
objects. To change the stack level of the picture, click it to select it, and then select the
Levels/Layers button found in the Formatting ribbon group of the Draw ribbon tab. From the
Levels/Layers Tab, select the stack level of your choice. The Base stack level places the picture
below all other oneline display objects, while the Top stack level will cause the picture to obscure all
other display objects.
To resize or reshape an existing picture object, click on it to select it and then drag its resizing
handles.
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Converting Background Lines
Background lines can be converted to other objects by splitting, merging, or converting to power
system objects. This can be done while in Edit mode. To convert a background line, right-click on a
selected background line on the oneline display and the local menu will be displayed with the
conversion options. Most options are available if only a single background line has been selected and
no other objects are selected. The following options are available for converting a background line:
Split Background Line
A background line can be split at a vertex or anywhere along the line. Click the point on the line
where the split should be made and then right-click and select the Split Background Line… option
from the local menu. Two background lines will result. This option is available only if exactly one
background line has been selected and no other objects have been selected.
Merge Background Lines
This option is only available if exactly two background lines have been selected. The two selected
background lines will be merged at the two closest ends and a single background line will result.
Convert to ac Transmission Line
After selecting this option, the Branch Options dialog will be displayed. The dialog options can be set
the same as they would be set when inserting an ac transmission line from the Insert menu. This
option is available only if exactly one background line has been selected and no other objects have
been selected.
Convert to Bus
After selecting this option, the Bus Information dialog will be displayed. The dialog options can be
set the same as they would be set when inserting a bus from the Insert menu. This option is
available only if exactly one background line has been selected and no other objects have been
selected.
Convert to Substation
After selecting this option, the Substation Information Dialog will be displayed. The dialog options
can be set the same as they would be set when inserting a substation from the Insert menu. This
option is available only if exactly one background line has been selected and no other objects have
been selected.

751
©2011 PowerWorld Corporation

Converting Background Ellipses
Background ellipses can be converted to power system objects. To convert a background ellipse, rightclick on a selected background ellipse on the oneline display and the local menu will be displayed with
the conversion options. The following options are available for converting a background ellipse:
Convert to Bus
After selecting this option, the Bus Information Dialog will be displayed. The dialog options can be
set the same as they would be set when inserting a bus from the Insert menu. This option is
available only if exactly one background ellipse has been selected and no other objects have been
selected.
Convert to Substation
After selecting this option, the Substation Information Dialog will be display. The dialog options can
be set the same as they would be set when inserting a substation from the Insert menu. This option
is available only if exactly one background ellipse has been selected and no other objects have been
selected.
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Converting Background Rectangles
Background rectangles can be converted to power system objects. To convert a background rectangle,
right-click on a selected background line on the oneline display and the local menu will be displayed
with the conversion options. The following options are available for converting a background
rectangle:
Convert to Bus
After selecting this option, the Bus Information Dialog will be displayed. The dialog options can be
set the same as they would be set when inserting a bus from the Insert menu. This option is
available only if exactly one background rectangle has been selected and no other objects have been
selected.
Convert to Substation
After selecting this option, the Substation Information Dialog will be display. The dialog options can
be set the same as they would be set when inserting a substation from the Insert menu. This option
is available only if exactly one background rectangle has been selected and no other objects have
been selected.
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Oneline Fields
The Oneline Fields are fields that can be placed on an oneline diagram that display values specific to
the current display of the diagram, such as x and y coordinate of the mouse cursor, animation rate,
zoom percentage, and x and y coordinate of the center of the diagram at the center of the screen.
These fields can be inserted on a oneline diagram by choosing Field > Oneline Field from the
Individual Insert ribbon group on the Draw ribbon tab.
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Text on Onelines
Text display objects are used to show single lines of text on the oneline.
Edit Mode
To add descriptive text to the oneline, select Background > Text in the Individual Insert ribbon
group on the Draw ribbon tab, and click the oneline where you would like the text to appear. The
Text Options Dialog will open, asking you to enter the desired text string, and the angle at which the
text is to appear on the oneline diagram.
To modify an existing text object, position the cursor anywhere on the text and right-click. The New
Text Options Dialog will appear, allowing you to edit the text. Use the font option of the Formatting
ribbon group to control the font and background color of the text object.
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Memo Text
Memo Text display objects are used to show several lines of text on the oneline within an enclosing
box.
Edit Mode
To add a Memo Text object to the oneline, select Background > Memo Text from the Individual
Insert ribbon group on the Draw ribbon tab. Then click and drag to create a rectangle on the
oneline; this rectangle will contain the lines of text you enter.
To modify the contents of a Memo Text object, position the cursor anywhere on the object and
right-click. To change the formatting of a Memo Text object, select the object with a left-click, then
select from the Formatting ribbon group on the Draw ribbon tab; this will bring up the Font
Properties tab of the Format Multiple Objects dialog box.
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Generic Model Fields
The Generic Model Fields are fields that can be placed on an oneline diagram that display any value for
any object in the case on the diagram. These fields can be inserted on an oneline diagram by choosing
Field > Generic Model Field from the Individual Insert ribbon group on the Draw ribbon tab.
This type of field comes in handy when you want to place a variety of fields on the diagram, without
inserting specific object-type fields. All fields of data are available in one location for placement on a
diagram.

757
©2011 PowerWorld Corporation

Supplemental Data Fields on Onelines
Supplemental Data Field objects represent information about Supplemental Data records. The
information that can be represented in these fields is the same in either Edit or Run Mode.
Supplemental Data Fields can be added to a oneline while in Edit Mode from Draw > Field >
Supplemental Data Field. After selecting this option, move the cursor to the location on the oneline
where the new field should be placed and left-click. The Supplemental Data Field Options dialog will
open.
The Supplemental Data Field Options dialog can be used to modify the properties of individual
supplemental data fields on the diagram. This dialog contains the following fields:
Classification
Select the Supplemental Classification from the drop-down list of available classifications.
Name
Select the Name of the Supplemental Data record from the drop-down list of available names. This
list is populated with the appropriate names based on the selected Classification.
Total Digits in Field
Total number of digits to show in the field.
Field Prefix
A prefix that can be specified and displayed with the selected value.
Digits to Right of Decimal
Number of digits to show to the right of the decimal point.
Field Value
The current value of the field being displayed.
Rotation Angle in Degrees
The angle at which the text will be displayed on the diagram.
Type of Field
Select a field from the drop-down list of available fields or click Find Field to search through the list
of available fields.
Select OK to close the dialog and save the changes, or click Cancel to close the dialog without saving
the changes.
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Pie Charts/Gauges: Lines
Pie Chart / Gauge Style
The Pie Chart Style box determines whether the line flow pie charts show the percentage loading of
the line based upon the MVA flow, the MW flow, the MVR flow, the line amp/transformer MVA flow,
the maximum percentage loading under contingency, or the PTDF value. The Line Gauge Style box
has the same setting options as the line flow pie charts.
Always Use Limiting Flow
Typically, the flow at opposite ends of a transmission line is slightly different due to losses across the
line. If this option is checked, the pie chart will correspond to limiting MVA value of the line,
independent of which end of the line that value occurs. Otherwise, the pie chart will always show
the MVA value at the from bus for the line.
Display Gauge Values in Percent
Check this option to display values in the line gauges as percent of loading instead of actual flow
values.
Color, Size and Percentage
This section of the options dialog allows you to customize the appearance of the line flow pie charts on
the diagram. The default options for the line flow pie charts are set on the MVA tab, and are always in
force for at least the MVA pie chart / gauge style. However, you can choose different settings for the
other styles by selecting the corresponding tab under the Color, Size and Percentage section. Each of
the other five styles can be set to use the same settings as defined for MVA by checking the given
option on the page. If this option is unchecked for a particular style, then any pie chart on the diagram
of that style type will use the specifically defined appearance options for that style type.
The following parameters are all available on each of the six style tab pages:
Show Value Percent
When a branch's loading exceeds the value specified in the Show Value Percent field, the
percentage loading is shown as text within the pie chart. The default is 80%.
Normal Size Scalar, Normal Color
The standard, pre-warning fill color and scaling factor for pie charts.
Warning / Limit Scalars and Colors
The table in this section allows you to choose different settings for the pie chart size and color,
based on the percentage value represented by the pie chart or gauge. Thus you can set up visual
clues as to when the flow on lines exceeds specified warning or limit levels. You can add and remove
points from this table by right-clicking in the table and using the Insert and Delete options from the
popup menu.
To modify the Percent and size Scalar for a record in the table, simply click on the value in the cell
and type in a new value. To change the color associated with the percent value, double click in the
Color cell to open the Color Chooser dialog.
Make normal color the same as the line to which the pie chart or gauge is anchored (if
any)
If checked, this option will cause the pie charts to assume the same normal colors as the
transmission lines to which they are anchored. This may be useful if the transmission lines are
colored according to their nominal voltage level.
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Only Apply Warning/Limit Colors and Resizing to Monitored Elements
If this option is checked, then only those pie charts that correspond to branches selected using the
Limit Monitoring Settings will change appearance to reflect warning and limit loading levels. If this
option is not checked, then all pie charts will obey the options prescribed in this dialog.
Some additional options are available for pie chart appearance in situations where the line itself is out
of service. Clicking on the tab labeled Open Parameters will display these options. You can choose
to have special formatting for open devices by checking the available option, and then defining the
appearance options for the pie charts on the open lines. The available options include scaling the size,
width of the border, border color, pie chart background color, and drawing an "X" symbol through the
pie chart.
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Pie Charts/Gauges: Interfaces
Pie Chart Style
The Pie Chart Style box determines whether the interface pie charts show the percentage loading of
the line based upon the MW flow, the maximum percentage loading under contingency, or the PTDF
value.
Color, Size and Percentage
This section of the options dialog allows you to customize the appearance of the interface flow pie
charts on the diagram. The default options for the interface flow pie charts are set on the Lines MVA
tab. However, you can choose different settings for the interface styles by selecting the corresponding
tab under the Color, Size and Percentage section. Each of the styles can be set to use the same
settings as defined for Lines MVA by checking the given option on the page. If this option is unchecked
for a particular style, then any interface pie chart on the diagram of that style type will use the
specifically defined appearance options for that style type.
The following parameters are all available on each of the six style tab pages:
Show Value Percent
When an interface's loading exceeds the value specified in the Show Value Percent field, the
percentage loading is shown as text within the pie chart. The default is 80%.
Normal Size Scalar, Normal Color
The standard, pre-warning fill color and scaling factor for pie charts.
Warning / Limit Scalars and Colors
The table in this section allows you to choose different settings for the pie chart size and color,
based on the percentage value represented by the pie chart or gauge. Thus you can set up visual
clues as to when the flow on interfaces exceeds specified warning or limit levels. You can add and
remove points from this table by right-clicking in the table and using the Insert and Delete options
from the popup menu.
To modify the Percent and size Scalar for a record in the table, simply click on the value in the cell
and type in a new value. To change the color associated with the percent value, double click in the
Color cell to open the Color Chooser dialog.
Make normal color the same as the line to which the pie chart or gauge is anchored (if
any)
If checked, this option will cause the pie charts to assume the same normal colors as the interface to
which they are anchored. This may be useful if the interfaces are colored differently on the diagram.
Only Apply Warning/Limit Colors and Resizing to Monitored Elements
If this option is checked, then only those pie charts that correspond to interfaces selected using the
Limit Monitoring Settings will change appearance to reflect warning and limit loading levels. If this
option is not checked, then all interface pie charts will obey the options prescribed in this dialog.
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Pie Charts/Gauges: Pie Chart/Gauge Styles
This section shows the Pie Chart/Gauge styles in a case information display. The user can edit several
of the fields directly. Otherwise, by right-clicking on any part of the case information display and
selecting on Show Dialog in the popup menu, the Pie Chart/Gauge Style dialog, where all the values
can be modified.
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Pie Charts/Gauges: General Options
Show Limit Set in Header
If this option is checked, the pie chart will display a text field showing the letter of the limit set
presently being used for the element.
Show Style in Footer
When checked, the pie chart will display a text field showing the style (MVA, MW, etc) that the pie
chart is set to (refer to the Style property described above.)
Max. Zoom Percentage for Full Resizing
The pie charts dynamically resize when you are zooming in and out on a oneline diagram. However,
you can limit the point at which the pie charts resize when zooming in by setting a zoom level in this
field. This helps prevent the pie charts from getting so large that they occupy the entire screen.
Min. Pie Chart Font Size for Warning/Limit
Specifies a minimum font size for displaying text in the pie chart object. This is useful when zooming
out on the diagram, to keep the text visible by setting a minimum font size.
Background Color
The background color for the pie charts is automatically set to be the same as the online
background. For a different color, select Specific color from the drop-down menu, and then click on
the rectangle to the right to select the color. For a clear background, select Clear from the dropdown
menu.
Pie Chart Relative Font Size
Slide the slider bar to select the font size for the pie chart. This will determine the size of the font
indicating the percentage on the pie chart.
Pie Chart Font Color
Slide the slider bar to select the font size for the pie chart. This will determine the size of the font
indicating the percentage on the pie chart.
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Pie Chart / Gauge Dialogs
There are a number of pie chart/gauge objects that can be added to one-line diagrams. These objects
are inserted via the Pies/Gauges menu in the Individual Insert ribbon group on the Draw ribbon tab
and include Areas, Buses, Generators, Injection Groups, Owners, Substations, Super Areas, Switched
Shunts, Transformers, and Zones. The dialogs for these objects contain a common set of options that
are required regardless of the object type. These common options as well as specific settings for the
different object types are detailed below.
The Pie Chart / Gauge Example shows how the fields in this dialog affect the pie chart or gauge
display. The items shown in the diagram are explained in more detail throughout this section and in
the Pie Chart / Gauge Style Dialog description.
Identification
All dialogs have a section at the top that identify the pie chart/gauge object based on the type of
device that the pie chart/gauge represents. The Find…button is available on most dialogs to open the
Find tool that can be used to advanced search for a device. Specific identifying information for the
different dialogs is given below:















AreaThe area that the pie chart/gauge represents is identified based on Area Number or Area
Name. To change the area that is represented, select an Area Number or Area Name from the
dropdown boxes or click the Find button. The dropdown boxes are populated with all areas in the
case.
BusThe bus that the pie chart/gauge represents is identified based on Bus Number or Bus
Name. To change the bus that is represented, select a Bus Number or Bus Name from the
dropdown boxes or click the Find button. The dropdown boxes are populated with all buses in the
case with valid area/zone/owner filters.
GeneratorThe generator that the pie chart/gauge represents is identified based on Bus Number
and Gen ID or Bus Name and Gen ID. To change the generator that is represented, select a
Bus Number or Bus Name from the dropdown boxes and change the Gen ID in the edit box or
click the Find button. The dropdown boxes are populated with all buses in the case with valid
area/zone/owner filters.
Injection GroupThe injection group that the pie chart/gauge represents is identified based on
the Injection Group Name. To change the injection group that is represented, select a new
name from the dropdown box. The dropdown box is populated with all injection groups in the
case.
OwnerThe owner that the pie chart/gauge represents is identified based on Owner Number or
Owner Name. To change the owner that is represented, select an Owner Number or Owner
Name from the dropdown boxes or click the Find button. The dropdown boxes are populated
with all owners in the case.
SubstationThe substation that the pie chart/gauge represents is identified based on Substation
Number, Substation Name, or Substation ID. To change the substation that is represented,
select a Substation Number, Substation Name, or Substation ID from the dropdown boxes
or click the Find button. The dropdown boxes are populated with all substations in the case.
Super AreaThe super area that the pie chart/gauge represents is identified based on Super Area
Name. To change the super area that is represented, select a new name from the dropdown box
or click the Find button. The dropdown box is populated with all super areas in the case.
Switched ShuntThe switched shunt that the pie chart/gauge represents is identified based on
Bus Number and ID or Bus Name and ID. To change the switched shunt that is represented,
select a Bus Number or Bus Name from the dropdown boxes and change the ID in the edit box
or click the Find button. The dropdown boxes are populated with all switched shunts in the case
with valid area/zone/owner filters.
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TransformerThe transformer that the pie chart/gauge represents is identified based on Near
Bus Number, Far Bus Number, and Circuit or Near Bus Name, Far Bus Name, and Circuit.
To change the transformer that is represented, click on the Find button to use the Find tool.
ZoneThe zone that the pie chart/gauge represents is identified based on Zone Number or Zone
Name. To change the zone that is represented, select a Zone Number or Zone Name from the
dropdown boxes or click the Find button. The dropdown boxes are populated with all zones in the
case.

Type of Field
Use this option to select the field to display in the pie chart/gauge. Fields that are deemed of more
common interest are listed for easy access. Any field associated with a particular device can be
selected by first choosing Select a Field and then finding the particular field in the dropdown listing
all available fields or by clicking Find Field and searching for the field of interest.
Current Value
Percent
This is the percent value calculated from the current value of the selected field. How the percent
is calculated is based on the selection of limits and deadband and options associated with the
Style. Details of the percent calculation are given in the Pie Chart/Gauge Style Dialog
description.
Value
This is the current value of the selected field.
In-Service
When checked, the device represented by the pie chart/gauge is in-service. This is given for
informational purposes only, as the status of devices cannot be changed from this dialog.
Display Information
Type
Select to display either a Pie Chart or Gauge.
Gauge Orientation
If Type option of Gauge is selected, set this option to draw either a Vertical or Horizontal gauge.
Anchored
When checked, the pie chart/gauge will be anchored to the display object representing the
selected device.
Size, Width, Use Fixed Gauge Width/Size Ratio
Size determines the size of a pie chart and the vertical side length of a vertical gauge or
horizontal side length of a horizontal gauge. Width is not applicable to a pie chart but
determines the horizontal side length of a vertical gauge or the vertical side length of a horizontal
gauge. Width is not enterable if the option of Use Fixed Gauge Width/Size Ratio is checked.
This option is checked if the Gauge Width is Always a Fixed Proportion of Size option is
checked on the Style dialog. The fixed width/size ratio is also set on the Style dialog.
Ignore Dynamic Sizing
When checked, any sizing based on the calculated percent will be ignored and the pie
chart/gauge will stay at the defined size. Options to set the sizing based on calculated percent
can be found on the Style dialog.
Ignore Dynamic Open Sizing
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When checked, any sizing of pie chart/gauges based on the device that is represented being outof-service will be ignored and the object will stay at the defined Size. Options to set the sizing
for open devices can be found on the Style dialog.
Always Show Value (Percent)
When checked, the options set on the Style dialog to display the percent on pie chart/gauges
are ignored and the percent value is always shown.
Style, Show Style Dialog
The Style defines the set of generic options that can be applied to any pie chart/gauge. An
already defined style can be selected from the dropdown. Click Show Style Dialog to modify an
existing style or to create a new style; this opens up the Pie Chart / Gauge Style Dialog.
Limits
Low Limit, High Limit
Determines the low and high values from which the percent will be calculated and the gauge fill
will be drawn. These values are not enterable if the limits are determined from the Style or
based on device limits. More information on how these limits are used in calculating the percent
is given in the Pie Chart Parameters Tab and Gauge Parameters Tab sections in the Pie
Chart/Gauge Style Dialog description.
Use Device Low Limit
When checked, the low limit will be determined from the low limit defined for the device for the
selected field type. If device limits are not defined for the selected field, this option will not be
enabled. If not enabled, the low limit will be based on the value entered in the Low Limit box.
Use Device High Limit
When checked, the high limit will be determined from the high limit defined for the device for the
selected field type. If device limits are not defined for the selected field, this option will not be
enabled. If not enabled, the high limit will be based on the value entered in the High Limit box.
Override with Limits from Style
When checked, the high and low limits from the selected Style will be used.
Zero Percent Deadband
Use Style Zero Percent Deadband
When checked, the zero percent high limit and zero percent low limits from the selected Style
will be used.
Zero Percent Low Limit, High Limit
Determines the low limit and high limit for the zero percent deadband from which the percent
will be calculated and the gauge fill will be drawn. These values are not enterable if the
deadband is determined from the Style. The deadband represents the range of values for which
the calculated percent will be zero. More information on how the deadband limits are used in
calculating the percent is given in the Pie Chart Parameters Tab and Gauge Parameters
Tab sections in the Pie Chart/Gauge Style Dialog description.
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Pie Chart / Gauge Style Dialog
The Pie Chart/Gauge Style Dialog is available from any of the pie chart/gauge dialogs by selecting
Show Style Dialog or from Options > Oneline Display Options… > Pie Charts/Gauges on the
Pie Charts/Gauge Styles tab.
This dialog lists options that can be commonly applied to pie chart/gauge objects so that these same
options do not have to be set for every individual object. The defined styles can be applied to any of
the new pie chart/ gauge objects that include Areas, Buses, Generators, Injection Groups, Owners,
Substations, Super Areas, Switched Shunts, Transformers, and Zones. These styles are currently not
applicable to Lines and Interfaces. Some options are related to options that are set for individual pie
chart/gauges. More information about individual object settings can be found in the Pie
Chart/Gauge Dialogs section.
The Pie Chart / Gauge Example shows how the fields in this dialog affect the pie chart or gauge
display. The items shown in the diagram are explained in more detail throughout this section and in
the Pie Chart / Gauge Dialogs description.
Creating and Saving Styles
Style Name
Drop-down box lists all currently defined pie chart/gauge styles. Select Add New to create a
new style. Select Rename to change the name of an existing style. Select Delete to remove an
existing style.
Save AXD
Save all currently defined pie chart/gauge styles to a Display Auxiliary file.
Load AXD
Load pie chart/gauge styles from a Display Auxiliary file.
Hide all Style Objects (except in edit mode)
When checked, the pie chart/gauge will not be visible in run mode.
Show Header (Object ID)
When checked, the header of the pie chart/gauge will contain identifying information about the
device that the pie chart/gauge represents.
Show Footer (Field Type)
When checked, the field type that is being used in the pie chart/gauge will be displayed in the footer
of the pie chart/gauge.
Default Style
When checked, this style is one of the default styles that are defined. Default styles cannot be
renamed or deleted. This is an informational field and cannot be changed by the user.
Limits and Zero Percent Deadband Values
Define the High and Low Limits to use when the option Override with Limits from Style is
selected for the pie chart/gauge that is using this style and the High and Low Zero Percent
Deadbands to use when the option Use Style Zero Percent Deadband is selected for the pie
chart/gauge that is using this style. The deadband represents the range of values for which the
calculated percent will be zero. More information is given in the Pie Chart Parameters Tab and
Gauge Parameters Tab sections on how the limits are used in calculating the percent.
The remainder of the dialog is broken down into four tabs:
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Standard Parameters
Open Parameters
Pie Chart Parameters
Gauge Parameters
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Pie Chart / Gauge Style Dialog - Standard Parameters Tab
Normal Scalar, Normal Fill Color
These are the standard, pre-warning scaling factor and fill color for pie chart/gauges. To change the
color, click on the color to open the Color dialog.
Font Color
Font color of the text displayed in the pie chart/gauge. To change the color, click on the color to
open the Color dialog.
Border Width
Width of any border portion of the pie chart/gauge. The border of a pie chart encloses the entire pie
chart as well as the filled portion of the pie chart. The border of a gauge encloses the entire gauge.
The border width also impacts the width of the lines marking the limits and deadband on the gauge.
Border Color
Color of any border portion of the pie chart/gauge. The border of a pie chart encloses the entire pie
chart as well as the filled portion of the pie chart. The border of a gauge encloses the entire gauge.
The border color also is the color used for the lines marking the limits and deadband on the gauge.
To change the color, click on the color to open the Color dialog.
Border Color Same as Fill Color
When checked, the border color will be the same color as the fill color and the color selected in the
Border Color will be ignored.
Background Color
The drop-down box allows selection of three options for the background color: Oneline Background,
Specific Color, and Clear. Oneline Background will color the pie chart/gauge background the same
color as the selected background color for the oneline. Specific Color will allow the selection of a
user specified color. To specify a color, click the box to the right of the drop-down to open the Color
dialog. The Clear option will not use a background color and objects underneath the pie/chart gauge
will be visible through the unfilled portions of the pie chart/gauge.
Relative Font Size
Modify the track bar to adjust the size of the font relative to the size of the pie chart/gauge.
Max Zoom Percent for Full Resize
Pie chart/gauges dynamically resize when zooming in and out on oneline diagrams. A limit can be
placed on the point at which the pie chart/gauges resize when zooming in by setting a zoom level in
this field. This helps prevent the pie chart/gauges from getting so large that they occupy the entire
screen.
Warning/Limit Scalars and Colors
The table in this section allows the definition of different settings for pie chart/gauge size and fill
color based on the percent value represented by the pie chart/gauge. Points can be added or
removed from this table by right-clicking in the table and using the Insert and Delete options from
the popup menu.
To modify the Percent and size Scalar for a record in the table, click on the value in the cell and type
in a new value. To change the color associated with the percent value, double click in the Color cell
to open the Color dialog.
Use Discrete Map
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When checked, discrete colors will be used for the pie chart/gauges based on the colors specified in
the table. Otherwise, colors will be blended if the percentage represented in the pie chart/gauge
falls between percentages defined in the table.
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Pie Chart / Gauge Style Dialog - Open Parameters Tab
Open parameters are applied to any pie chart/gauges when the device that they represent is out-ofservice.
Special Formatting for Open Devices
When checked, the Open Size Scalar, Open Border Width, and Open Border Color options are
applied when a device is out-of-service.
Use Special Open Background Color
When checked, the Open Background Color option is applied.
Open Symbol
When an Open Symbol other than None is selected, the symbol will be drawn in the selected Open
Symbol Color.
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Pie Chart / Gauge Style Dialog - Pie Chart Parameters Tab
Options given on this tab only apply to how pie charts are displayed.
Show Value Percent
When the percent of the pie chart/gauge exceeds the value specified in this field, the percent is
shown as text within the pie chart/gauge. The default is 80%.
Display of Values Below the Zero Percent Deadband
The selection of this option determines how to calculate the percent represented in pie charts. Four
parameters are required for determining this: low limit, high limit, zero percent low limit, and zero
percent high limit. These four limits are determined from options set with individual pie charts
and/or options set with the style. In general, the zero percent low limit and zero percent high limit
define the deadband in which the percent is zero. The percent is then determined based on where
the selected field value falls within the high limit and zero percent high limit and the low limit and
zero percent low limit. The specific calculations used for determining the percent is given for the
options below. In all cases if the limits are not defined correctly (i.e., none of the If..then statements
below apply), the percent will be returned as zero.







Allow negative percent values
o If (field value) > (zero percent high limit) and (high limit) > (zero percent high limit)
then
Percent = ((field value) – (zero percent high limit))/((high limit) – (zero percent high
limit))
o If (field value) < (zero percent low limit) and (low limit) < (zero percent low limit)
then
Percent = ((field value) – (zero percent low limit))/((zero percent low limit) – (low
limit))
Use absolute value (i.e., percent always >= 0)
o Same calculations as in Allow negative percent values except that the absolute
value of the calculated percentage is reported.
Low limit is zero percent
o The zero percent deadband limits are ignored in this option and the percent is
calculated based on the low and high limits only
o If (high limit) > (low limit) then
Percent = ((field value) – (low limit))/((high limit) – (low limit))
Treat values below zero deadband as zero
o If (field value) > (zero percent high limit) and (high limit) > (zero percent high limit)
then
Percent = ((field value) – (zero percent high limit))/((high limit) – (zero percent high
limit))
o If (field value) < (zero percent low limit) and (low limit) < (zero percent low limit)
then
Percent = 0
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Pie Chart / Gauge Style Dialog - Gauge Parameters Tab
Options given on this tab only apply to how gauges are displayed.
Show Limit Labels
When checked, text labels will be drawn with the gauge showing the four limits in use.
Include Units in Limit Labels
When checked, units will be included when the limit labels are shown.
Numeric Value Type
This option allows the numeric value to either be displayed as the Actual Value or the calculated
Percent value.
Display of Numeric Value
This option determines when the value of the field is displayed with the gauge. Never will not show
the value, Always will always show the value, and If Violating Warning/Limit Value will only
show the value if it is outside of the limit range that is currently in use.
Digits to Right of Decimal
This parameter determines how many digits to the right of the decimal are displayed in the limit
labels and the numeric value when they are shown with the gauge.
Gauge Width is Always a Fixed Proportion of Size
When checked, the Gauge Fixed Width/Size Ratio is used to determine the width of the gauge
as a proportion of the size (height). Note: the size of gauges is specified for individual gauges on the
pie chart/gauge dialogs.
Gauge Fixed Width/Size Ratio
Specifies the ratio of the gauge width to the size when the Gauge Width is Always a Fixed
Proportion of Size option is checked.
Percent Overhang on Top of Gauge
The overhang at the top of the gauge is the region above the high limit line. The size of this region
is defined as a percentage of the total size of the gauge.
Percent Overhang on Bottom of Gauge
The overhang at the bottom of the gauge is the region below the low limit line. The size of this
region is defined as a percentage of the total size of the gauge.
Gauge Fill and Percent Calculation
These options determine how the calculated percent will be displayed and how the gauge will be
filled. Four parameters are required for determining these: low limit, high limit, zero percent low
limit, and zero percent high limit. These four limits are determined from options set with individual
gauges and/or options set with the style. In all cases if the limits are not defined correctly, the
percent will be returned as zero.
Use Absolute Value for Percent
When checked, the displayed percent will be the absolute value of the calculated percent. This
option does not impact how the gauge will be filled.
Gauge Fill Options (Zero Percent Reference)
This option determines how the gauge will be filled. If Fill up or down from deadband is
selected, the fill will begin at the low or high deadband limit and continue up or down depending
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upon where the field value falls within the defined limits. If Fill up from bottom is selected, the
fill will begin at the bottom of the gauge and fill up to the field value.
Regardless of which fill option is selected, the following equations will be used to calculate the
percent based upon where the field value falls within the defined limits:
If (field value) > (zero percent high limit) and (high limit) > (zero percent high limit) then
Percent = ((field value) – (zero percent high limit))/((high limit) – (zero percent high
limit))
If (field value) < (zero percent low limit) and (low limit) < (zero percent low limit) then
Percent = ((field value) – (zero percent low limit))/((zero percent low limit) – (low
limit))
Ignore Deadband
When checked, deadband limits are ignored. This effectively forces the fill to start from the
bottom of the gauge and fill up to the field value. The percent is calculated based on the
following equation and will always be reported as the absolute value:
If ((high limit) – (low limit)) <> 0 then
Percent = ((field value) – (low limit))/((high limit) – (low limit))
Override Low Limits with a Value of Zero
When checked, the low limit value will be set to zero when determining the fill and calculating
the percent. This option is only applied if the Ignore Deadband check box is also checked. The
percent is calculated based on the following equation and will always be reported as the absolute
value:
If ((field value) > 0) and ((high limit) <> 0) then
Percent = (field value)/(high limit)
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Pie Chart / Gauge Example
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Palette Overview
The display object palettes are designed to help you lay out a new oneline diagram for a pre-existing
power flow model as quickly as possible. Display object palettes exist for Areas, Buses, Substations
and Zones. Palettes list the display objects that you have already added to the oneline, the display
objects that have not yet been drawn that neighbor those displayed objects, and the set of all display
objects that have not yet been added to the drawing. By selecting and dragging a display object name
from either the Undisplayed Neighbors list or the All Undisplayed list to a location on the oneline
diagram where you would like that object to appear, you can add that display object to the drawing
with very little effort.
To see which elements neighboring a particular device are already on the oneline diagram and which
are not, highlight a device in either the Displayed or All Undisplayed list. The Displayed
Neighbors and Undisplayed Neighbors columns will list the corresponding neighboring devices for
the selected device, allowing you to drag the undisplayed neighbors to the diagram if you wish.
The display object palettes, in conjunction with the of other devices, are especially useful for adding a
large region of an interconnection in relatively little time.
To display one of the four available palettes, select Show Insert Palette For from the Quick Insert
ribbon group on the Draw ribbon tab. To display the palette with the focus set to an object already
displayed, right-click on that object on the diagram and select *** Palette (where *** is the name of
the object type) from the popup menu.
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Using the Insert Palettes

The display object palettes are
designed to help you lay out a new
oneline diagram for a pre-existing
power flow model as quickly as
possible. Display object palettes exist
for Areas, Buses, Substations and
Zones. To open one of the palettes you
must be in Edit Modeand then go to the
Draw ribbon tab, and choose the Show
Insert Palette For Menu from the
Quick Insert ribbon group.
The Insert Palettes can be used in
conjunction with the various auto-insert
capabilities also found on the Quick
Insert ribbon group. These features
allow for the creation of oneline
diagrams much more quickly than
inserting oneline objects one at a time
using the Individual Insert ribbon
group.
When you choose one of the palettes
the dialog which appears will look like
the image below. The following image
shows the Bus Palette.

Palettes list the display objects that you have already added to the oneline, the display objects that
have not yet been drawn that neighbor those displayed objects, and the set of all display objects that
have not yet been added to the drawing.
The display object palettes feature the following controls:
Displayed
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Lists those objects defined in the power flow case that have already been added to the oneline
diagram. When you click on an entry in the Displayed list, the contents of the Displayed
Neighbors and Undisplayed Neighbors lists will be refreshed to identify all objects that neighbor
the display object you selected. Only the display objects matching the type of Insert Palette opened
will be shown in the list.
Double click on an entry in this list to pan to it so that the selected display object appears in the
center of the screen. If you are looking at the Insert Palette for Buses, you can right-click on an
entry and choose either Quick Power Flow List or Bus View to learn more about the selected bus.
Displayed Neighbors
Lists those objects defined in the power flow case that neighbor the display object selected in the
Displayed list that have already been drawn on the oneline diagram. You can make a "Displayed
Neighbor" the selected "Displayed" object by right-clicking on a display object in the Displayed
Neighbor List and selecting Make Current Displayed from the local menu. Only the display
objects matching the type of Insert Palette opened will be shown in the list.
Undisplayed Neighbors
Lists those display objects defined in the power flow case that neighbor the object selected in the
Displayed list that have not yet been drawn. To add the undrawn display object to the oneline
diagram, select its name with the left mouse button and keep the left mouse button pressed as you
move the mouse to the point on the oneline where you would like to drop the object. When you let
go of the left mouse button, the Information Dialog box for that display object will appear. (If you
do not want the information Dialog box to appear the use the right-click local menu to uncheck the
option to regarding showing the information dialog). Use the Information Dialog to change display
parameters for the object and click OK to finish dropping the object onto the oneline. The display
object you have just added will be appended to the end of the Displayed list and will also be added
to the History List so that you can identify its own undrawn neighbors quickly. Only the display
objects matching the type of Insert Palette opened will be shown in the list.
If you are looking at the Insert Palette for Buses, you can right-click on an entry and choose either
Quick Power Flow List or Bus View Display to learn more about the selected bus.
All Undisplayed
Lists those display objects defined in the power flow case that have not yet been added to the
oneline diagram, regardless of whether the object neighbors a displayed object or not. This list
functions identically to the Undisplayed Neighbors List. To add the undrawn display object to the
oneline diagram, select its name with the left mouse button and keep the left mouse button pressed
as you move the mouse to the point on the oneline where you would like to drop the object. When
you let go of the left mouse button, the Information Dialog box for that display object will appear.
(If you do not want the information Dialog box to appear the use the right-click local menu to
uncheck the option to regarding showing the information dialog). Use the Information Dialog to
change display parameters for the object and click OK to finish dropping the object onto the oneline.
The display object you have just added will be appended to the end of the Displayed list and will
also be added to the History List so that you can identify its undrawn neighbors quickly. Only the
display objects matching the type of Insert Palette opened will be shown in the list.
If you are looking at the Insert Palette for Buses, you can right-click on an entry and choose either
Quick Power Flow List or Bus View Display to learn more about the selected bus.
History List
Identifies the display objects you have added to the oneline diagram using the insert palettes since
the last time you opened the display object palette. Select a name from this list to display the
undrawn neighbors of the corresponding display object. Only the display objects matching the type
of Insert Palette opened will be shown in the list.
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Define a Filter
The Define a Filter button opens the Advanced Filters dialog. This dialog allows you to customize
which display objects appear in the various lists. This can be helpful, for example, if you wish to add
objects to the oneline that reside only in particular areas, or if you don't want objects less than a
certain voltage level to be listed.
When you click OK on the Advanced Filters dialog, the display object palette's lists will automatically
be updated to reflect the filter settings.
Close
Click Close when you are done using the display object palette.
Right-Click Local Menu of the Palette
There are several options available on the Right-Click
Search for : Click this option to search through the lists for a particular object. It will open the
familiar Find Object dialog.
Auto-Zoom When Panning : When double-clicking on the displayed objects in the palette, you
will automatically be panned so that object is in the center of the screen. Check this option to also
automatically zoom in/out to a reasonable level at the same time.
Export All Undisplayed List : Choose this option to export this list of undisplayed objects to a text
file.
Refresh Status : Choose this option to ensure that the list of Displayed/Undisplayed objects is
correct.
Show Dialog after Inserting : check or uncheck this option to control whether the information
dialog for the object will appear when using the palette
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Quick Insert Ribbon Group
The Quick Insert ribbon group contains buttons for creating a oneline diagram for a system model you
have already read into Simulator. If you are building out your network (or even substation, area, or
zone diagram), then using the Insert Palettes along with the Auto Insert routines is most efficient. If
you would instead like help on inserting a single object on your oneline diagram see the Individual
Insert ribbon group topic. Both of the ribbon groups are on the Draw ribbon tab. The Quick Insert
ribbon group is shown as follows.

Show Insert Palette for Menu
Choosing any of the items in the Show Insert Palette for
Menu will open up its respective Insert Palette. This Insert
palettes show a list of all objects that are already shown on
the oneline diagram as well as a list of objects which are
not. For more information see the Using the Insert Palettes
help topic.

Show Insert Palette for Menu
The first six options are used to automatically insert network
display objects that are connected to bus objects that have
already been drawn on the oneline.
Lines : Shows the Automatically Insert Lines Dialog
Interfaces : Shows the Automatically Insert Interfaces
Dialog
Generators : Shows the Automatically Insert Generators
Dialog
Loads : Shows the Automatically Insert Loads Dialog
Switched Shunts : Shows the Automatically Insert
Switched Shunts Dialog
Lines, Gens, Loads, Shunts : Shows a dialog for autoinserting lines, generators, loads, and shunts
simultaneously.
Reset Stub Locations : Will completely redo the
positioning of objects anchored to buses and substations in
the manner done when auto-inserting lines, gens, load, and
switched shunts.
The next four options provide methods for adding pie
charts, fields, circuit breakers and line flow objects around
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objects that have already been drawn on the oneline
diagram.
Line Flow Pie Charts : Select this to automatically insert
line flow pie charts on the transmission lines or transformers
objects that are selected.
Circuit Breakers : Select this to automatically insert circuit
breakers on the transmission lines or transformers objects
that are selected.
Line Flow Objects : Select this option to automatically
insert line flow objects on the transmission lines or
transformers objects that are selected.
Interface Flow Objects : Select this option to
automatically insert Interface flow objects on the interface
objects. The Interface Flow Arrow Object which behaves
very similar to the Line Flow Object show an arrow to
represent the MW flow direction and then shown text for
MW value and Mvar value with a sign relative to the MW
flow direction.
Add Fields Around : Select this option to insert fields
around the presently selected objects. It will then bring up
the Inserting and Placing Multiple Display Objects Dialog
The follow two options provide a mechanism for autoinserting bus or substation oneline objects. You must have
geographic longitude/latitude information in order to use
these options.
Buses : Shows the Automatically Insert Buses Dialog
Substations : Shows the Automatically Insert Substations
Dialog
The last two options provide a mechanism for inserting
background lines that represent geographic borders or from
a Shapefile.
Borders : Shows the Automatically Insert Borders Dialog
Insert GIS Data From Shapefile : Shows the Shapefile
Import Dialog
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Automatically Inserting Buses
Simulator can automatically insert buses on your oneline diagram if you have data regarding their
spatial or geographic location. To achieve this, go to the Draw ribbon tab and choose Auto Insert >
Buses on the Quick Insert ribbon group. This opens the Auto Insert Bus Dialog.
Note: Auto-insert buses is only for inserting bus objects on the diagram representing existing data. In
other words, you cannot use the auto-insert buses routine to add new buses to the load flow model.
See topics on loading data from auxiliary files or from Excel for creating new buses (or other objects)
in an existing load flow case.
Insert by longitude, latitude
If you have stored latitude and longitude information with the Bus records in Simulator, you can use
that information to automatically insert the buses on a oneline diagram. Select the option on the
dialog for finding bus locations based on Longitude and Latitude stored with data records.
When selected, the Map Projection option will become enabled. Choose the type of projection you
would like to be used for placing the buses on the diagram.
Insert by locations specified in a file
You must first specify the file which contains the location data. You must also specify whether the
file contains x,y coordinates or longitude, latitude coordinates. The format of the location data text
file is as follows:
The first line of this text file is ignored by Simulator. The following lines consist of three numbers:
Bus Number, X location, and Y location. If you are reading longitude, latitude, then X signifies
longitude and Y signifies latitude.
Num, X Location, Y Location
1, 24001.46, 19715.15
3, 24001.46, 19715.15
16, 24130.91, 19638.99
17, 24007.31, 19093.09
21, 23649.27, 18439.07
22, 23649.27, 18439.07
etc...
Simulator will place the buses on the oneline diagram at the X, Y locations given. If you specified
that the file contained longitude, latitude information, then select the Map Projection to use when
converting the longitude, latitude values from the file. The buses will be drawn according to default
bus object information defined in the Default Drawing Values for New Objects dialog.
If you would like Simulator to Autoinsert transmission lineswhen finished with the auto insertion
of your buses, check the box. Transmission lines and transformers will be automatically drawn based
on the Line/XFMR default options defined in the Default Drawing Values for New Objects dialog.
Check the Insert bus only if not already shown on the oneline to ensure that multiple display
objects are not inserted for the same element.
Clicking the OK button will instruct Simulator to continue by placing the buses according to the
specified settings on the dialog. Click Cancel to exit the process without inserting the buses.
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Automatically Inserting Transmission Lines
The Automatic Insertion of Lines/Transformers Dialog is used to automatically draw transmission lines
and transformers on the oneline diagram between existing bus display objects. Only branches that are
already defined in the power flow case can be added automatically; if you need to define a brand new
branch, see Transmission Line Display Objects. Thus, this option is useful only when you are starting
with an existing power flow case, not building a case from scratch.
To insert lines and transformers automatically, you must first have drawn the buses for each end of
the device. Simulator then draws the branch display objects connecting the buses for each
transmission line/transformer in the power flow case not already shown on the oneline.
To display the dialog, in the Edit Mode go to the Draw ribbon tab and choose Auto Insert > Lines on
the Quick Insert ribbon group.
The dialog has the following options:
Minimum kV Level
Simulator will automatically draw line and transformer display objects between terminals whose
nominal voltages meet or exceed the minimum kV level specified in this field. For a branch object to
be drawn, either one of its terminals must satisfy this criterion. This option is useful for suppressing
the automatic addition of generator step-up transformers if that kind of detail is not warranted.
Default Drawing Values
This button opens the Default Drawing Values Dialog. Options such as the automatic insertion of
transmission line stubs, text fields, circuit breakers, and pie charts are specified in the Default
Drawing Values Dialog.
Insert Text Fields
If this box is checked, the default fields associated with the transmission line will appear around the
transmission line.
Insert Equivalenced Objects
If this option is checked, equivalenced objects modeled as lines will also be automatically inserted
with the real transmission lines.
Use Only Selected Buses
Instead of having Simulator automatically insert line and transformer display objects throughout the
oneline diagram, you can force it to insert the new objects only between the bus display objects that
are currently selected. This option is enabled only when two or more bus display objects are
currently selected on the oneline.
Insert Pie Chart for Lines with No Limit and Bus Ties
If this option is checked, Simulator will add pie chart objects to the lines that have no given limit or
are bus ties as they are auto-inserted. Typically if a line is a bus tie or has no given limit, it is
meaningless to include a pie chart on the element, since no relevant information about the
transmission element can be gained from the pie chart object.
Insert Multi Section Lines
Check this option if you wish for Simulator to automatically insert lines designated as multi-section
lines as well.
Identifying Bus Ties
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This area deals with lines used as ties between breakers. These lines are modeled as zero
impedance connections. The identification of a branch as a bus tie depends on the value specified as
the Maximum P.U. Impedance for Bus Ties. Branches with total P.U. impedance below this
value will be considered bus ties when auto-inserted.
In this area two choices are given for how to insert the bus tie breakers: Do not insert stubs for
bus ties and Only insert a single circuit breaker. The first choice allows you to decide if line
stubs will be drawn when the tie breaker is inserted. The second sets whether or not only one circuit
breaker is inserted on the tie breaker. This could be useful for determining real lines from bus tie
breakers.
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Automatically Inserting Generators
The Automatic Insertion of Generators Dialog is used to automatically draw generators on the oneline
diagram on existing bus-display objects. Only generators that are already defined in the power flow
case can be added automatically; if you need to define a new generator, see Generator Display
Objects. Thus, this option is useful only when you are starting with an existing power flow case, not
building a case from scratch.
To insert generators automatically, you must first have drawn the terminal bus for each device.
Simulator then draws the generator display objects connected to the buses for each generator in the
power flow case not already shown on the oneline.
To display the dialog, in the Edit Mode go to the Draw ribbon tab and choose Auto Insert >
Generators on the Quick Insert ribbon group.
The dialog has the following options:
Minimum kV Level
Simulator will automatically draw generator display objects at terminal buses whose nominal
voltages meet or exceed the minimum kV level specified in this field. For a generator object to be
drawn, its terminal must satisfy this criterion.
Default Drawing Values
This button opens the Default Drawing Values Dialog. Options such as the automatic insertion of
text fields are specified in the Default Drawing Values Dialog.
Insert Text Fields
When this box is checked, the default fields associated with the generator will appear around the
generator, such as voltage, name, and/or MW.
Insert Equivalenced Objects
This field is not used when automatically inserting generators.
Use Only Selected Buses
Instead of having Simulator automatically insert generator display objects throughout the oneline
diagram, you can force it to insert the new objects only between the bus display objects that are
currently selected. This option is enabled only when two or more bus display objects are currently
selected on the oneline.
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Automatically Inserting Loads
The Automatic Insertion of Loads Dialog is used to automatically draw loads on the oneline diagram on
existing bus display objects. Only loads that are already defined in the power flow case can be added
automatically; if you need to define a brand new load, see Load Display Objects. Thus, this option is
useful only when you are starting with an existing power flow case, not building a case from scratch.
To insert loads automatically, you must first have drawn the terminal bus for each device. Simulator
then draws the load display objects connected to the buses for each load in the power flow case not
already shown on the oneline.
To display the dialog, in the Edit Mode go to the Draw ribbon tab and choose Auto Insert > Loads
on the Quick Insert ribbon group.
The dialog has the following options:
Minimum kV Level
Simulator will automatically draw load display objects at terminal buses whose nominal voltages
meet or exceed the minimum kV level specified in this field. For a load object to be drawn, its
terminal must satisfy this criterion.
Default Drawing Values
This button opens the Default Drawing Values Dialog. Options such as the automatic insertion of
text fields are specified in the Default Drawing Values Dialog.
Insert Text Fields
When this box is checked, the default fields associated with the load will appear with the loads, such
as MVAR and/or MW.
Insert Equivalenced Objects
If this option is checked, equivalenced objects modeled as loads will also be automatically inserted
with the real transmission lines.
Use Only Selected Buses
Instead of having Simulator automatically insert load display objects throughout the oneline
diagram, you can force it to insert the new objects only between the bus display objects that are
currently selected. This option is enabled only when two or more bus display objects are currently
selected on the oneline.

786
©2011 PowerWorld Corporation

Automatically Inserting Switched Shunts
The Automatic Insertion of Switched Shunts Dialog is used to automatically draw switched shunts on
the oneline diagram on existing bus-display objects. Only switched shunts that are already defined in
the power flow case can be added automatically; if you need to define a brand new switched shunt,
see Switched Shunt Display Objects. Thus, this option is useful only when you are starting with an
existing power flow case, not building a case from scratch.
To insert switched shunts automatically, you must first have drawn the terminal bus for each device.
Simulator then draws the switched shunt display objects connected to the buses for each switched
shunt in the power flow case not already shown on the oneline.
To display the dialog, in the Edit Mode go to the Draw ribbon tab and choose Auto Insert >
Switched Shunts on the Quick Insert ribbon group.
The dialog has the following options:
Minimum kV Level
Simulator will automatically draw switched shunt display objects at terminal buses whose nominal
voltages meet or exceed the minimum kV level specified in this field. For a switched shunt object to
be drawn, its terminal must satisfy this criterion.
Default Drawing Values
This button opens the Default Drawing Values Dialog. Options such as the automatic insertion of
text fields are specified in the Default Drawing Values Dialog.
Insert Text Fields
When this box is checked, the default fields associated with the switched shunt will appear around
the switched shunt, such as nominal MVAR.
Use Only Selected Buses
Instead of having Simulator automatically insert switched shunt display objects throughout the
oneline diagram, you can force it to insert the new objects only at the bus display objects that are
currently selected. This option is enabled only when two or more bus display objects are currently
selected on the oneline.
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Automatically Inserting Interface Display Objects
The Automatic Insertion of Interfaces Dialog is used to automatically insert interface objects on the
oneline diagram between existing area/zone display objects. Interface pie chart objects can also be
inserted as part of this process. The automatic insertion of interface display objects greatly accelerates
the construction of interface diagrams, which are particularly useful for animating the results of PTDF
calculations. Area-area and zone-zone interface records can be displayed using interface display
objects as well as interfaces comprised only of transmission branches.
Note that inserting interface objects on a oneline diagram does NOT add interface objects to the load
flow case. The interface definitions need to be added to the load flow case prior to automatically
inserting the graphical interface objects on a oneline diagram. The quickest way to add area to area or
zone to zone interface definitions in the load flow case is to automatically insert the definitions in the
interface case information display.
Once you have the interface definitions defined in the case, you can automatically insert the interface
objects on a diagram using the following procedure:








On a oneline diagram (either an already open diagram or a brand new one created by choosing
New Oneline from the application button), place area/ zone objects at the desired locations if
inserting area-area or zone-zone interface records. Otherwise, the terminal buses for the branch
elements in the interface should be inserted at the desired locations on the oneline diagram.
Go to the Draw ribbon tab and choose Auto Insert > Interfaces on the Quick Insert ribbon
group.
Check the Insert Pie Charts on Interfaces box to automatically insert interface pie chart
objects when the interfaces are inserted. If this option is selected, change the Default Size of
Interface Pie Charts to specify their size.
Choose the type of interfaces to insert. Area to Area or Zone to Zone Interfaces and
Line/Transformer Interfaces can be inserted. Area-area and zone-zone interfaces will be
drawn between the respective area and zone objects displayed on the oneline. Line/transformer
interfaces will be drawn based on the average location of the terminal buses of all transmission
lines comprising the interface. If inserting line/transformer interfaces, the option Minimum
Length of Line/Transformer Interfaces can be set to prevent interfaces that are too short
from being inserted.
Select OK to insert the new oneline objects. New interface objects are automatically inserted
based on the selected criteria for any corresponding interface record that is not already
represented.

Note that you can do this automatic insertion as often as you like. The Number of Interfaces Not
Shown field indicates how many interfaces still need to be added to the diagram to represent all
defined area-area, zone-zone, or line/transformer interfaces. It is a read-only field.
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Automatically Inserting Substations
Simulator can automatically insert substations on your oneline diagram if you have data regarding their
spatial or geographic location. To achieve this, go to the Draw ribbon tab and choose Auto Insert >
Substations on the Quick Insert ribbon group. This opens the Auto Insert Substation Dialog.
Insert by longitude, latitude
If you have stored latitude and longitude information with the Substation records in Simulator, you
can use that information to automatically insert the substations on a oneline diagram. Select the
option on the dialog for finding substation locations based on Longitude and Latitude stored
with data records. When selected, the Map Projection option will become enabled. Choose what
type of projection you would like to be used for placing the substations on the diagram.
Insert by locations specified in a file
You must first specify the file which contains the location data. You must also specify whether the
file contains x,y coordinates or longitude, latitude coordinates. The format of the location data text
file is as follows
The first line of this text file is ignored by Simulator. The following lines consist of three numbers:
Substation Number, X location, and Y location. If you are reading longitude, latitude then X signifies
longitude and Y signifies latitude.
Num, X Location, Y Location
1, 24001.46, 19715.15
3, 24001.46, 19715.15
16, 24130.91, 19638.99
17, 24007.31, 19093.09
21, 23649.27, 18439.07
22, 23649.27, 18439.07
etc...
Simulator will place the substations on the oneline diagram at the X, Y locations. If you specified
that the file contained longitude, latitude information, then select the Map Projection you would
like to be used when converting the longitude, latitude values from the file. The substations will be
drawn according to default substations object information defined in the Default Drawing Values for
New Objects dialog.
Finally, if you would like Simulator to Auto insert transmission lines when finished with the auto
insertion of your substations, check this box. Transmission lines and transformers will be automatically
drawn based on the Line/XFMR default options defined in the Default Drawing Values for New Objects
dialog.
Check the Insert substation only if not already shown on the oneline to ensure that multiple
display objects are not inserted for the same element.
Clicking the OK button will instruct Simulator to continue by placing the substations according to the
specified settings on the dialog. Click Cancel to exit the process without inserting the substations.
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Automatically Inserting Borders
PowerWorld Simulator allows you to automatically insert geographic borders, which PowerWorld
Corporation has drawn. These include the states in the United States of America and several
international borders as well. You may also define a border in a text file and insert this User-Defined
border. It is highly recommended that you create a diagram and insert borders before you begin
adding power system objects to the diagram.
To bring up the Auto Insert Borders Dialog, go to the Draw ribbon tab and choose Auto Insert >
Borders on the Quick Insert ribbon group.
Options
The Options tab allows you to set characteristics of the border lines when they are inserted on the
oneline diagram. Most of these options are available from the Format menu in Edit Mode, and can be
changed for a border by selecting the border(s) in Edit Mode and then selecting the appropriate option
from the Format menu to change the desired option(s).
Make border lines immobile
This option is very useful for preventing you from inadvertently moving the border lines in Edit Mode
once they have been placed.
Automatically link county and state borders to supplemental data
Background lines created from inserting borders can be linked to Supplemental Data records for
purposes of further identifying these objects. This is useful when applying filters, applying dynamic
formatting, using Select By Criteria, or defining custom hints with display objects created from
inserting the borders. This option is only available when inserting United States borders.
When this option is checked, background lines created for the borders will be automatically linked to
Supplemental Data records. If necessary, Supplemental Data records will be created with the
Classification being either State or County, depending on the Border Type selected when inserting
United States borders, and the Name being the name of either the state or county.
Line Options
Choose the line thickness and line color for the border lines.
Fill Options
Choose the fill options if you wish to "fill in" the border regions with a background fill color.
Stack Level
Choose the stack level for the border lines. The stack level affects which objects appear "over" or
"under" other objects on the diagram. Typically background lines are either placed in the
Background or Base levels, so that they appear beneath power system objects on the diagram.
Further we would recommend that if you are using background fill colors for the borders that you
choose a stack level of Base. The only difference between the Background and Base levels is that
the Base level objects can be right-clicked on in Run Mode and allows the default diagram popup
menu to appear. Right-clicking on Background level objects in Run Mode will not display the default
popup menu.
Layers
When Borders are automatically inserted on a diagram using this tool, a Borders screen layer will be
added to the layer drop-down box, if a Borders layer does not already exist for the oneline diagram.
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You can choose to leave the borders in the standard Default layer, to place the borders in the new
Borders layer, or you can create a new custom layer by clicking the Define Layers button. If no
default borders layer has been previously established (borders were previously inserted on the
oneline), the Borders layer or selected user created layer will be set as the default Borders layer.
The default Borders layer is different than the standard Default layer for objects. The default Borders
layer information is stored in the system registry, and is only used to recall which layer borders were
assigned to the previous time borders were automatically inserted.
Apply Default Drawing Values
Click this button to apply the Background line settings from the Default Drawing Values.
Border File Path
Designate the border file location.
PowerWorld Library
Pre-Defined Selections
Choose between North America, USA State Borders, Canadian Province Borders, or Entire World to
insert the selected region. These options make things quicker than selecting from the individual
menus if entire countries or continents are to be inserted.
Once you have selected the regions that you want to insert, Click OK.
United States
This tab allows you to select states in the United States that you want to insert. (Note: to select
several states to insert at once, use the Ctrl and Shift keys while clicking with your mouse.) These
states will be placed on the screen such that as you add new states they will be placed
geographically appropriately.
Include Hawaii and Alaska:Select all or any of these items to place these states on the screen.
Border Types: Select the type of border. State will only show the state border and the County will
show the state border as well as the counties of the state.
Once you have selected the states you want to insert, Click OK.
Canada
This tab allows you to select provinces in Canada that you want to insert. (Note: to select several
provinces to insert at once, use the Ctrl and Shift keys while clicking with your mouse.) These
provinces will be placed on the screen such that as you add new provinces they will be placed
geographically appropriately.
Once you have selected the provinces you want to insert, Click OK.
World
This tab allows to insert borders which PowerWorld Corporation has acquired for countries around
the world. PowerWorld Corporation will continue to add more border files as we receive them. Note:
if you have drawn a oneline which contains a geographic border you would like us to include in
future version of Simulator, please contact us at support@powerworld.com and we'll add it to our
next release.
Map Projection
This setting is important for anyone including border files outside of North America. By default,
Simulator draws borders using a simple conic projection referenced to North America. This can result
in border files of other countries being drawn incorrectly if based on this reference. To correctly
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draw borders of other countries around the world, select the Entire World setting, which uses a
Mercator projection.
User-Defined Borders
This tab allows you to read in a border from a text file that you create. The first row of this text file is
a comment row and is ignored when reading it in. After this it reads in the description of each
background line. This description starts with the number of points in the line followed by a list of x, y
coordinates. The file ends when the number of points for a line is read as -1. An example file follows:
Comment row
5
59, 60
10, 20
40.3, 95.20
89.3, 22.11
79.5, 34.56
45
40, 66
etc…
-1 this signifies the end of the file
To read the data, first specify the file name and location containing the data using the Browse button.
Next indicate if the file contains data in Longitude, Latitude or in converted Simulator X,Y coordinates.
If the data is Longitude and Latitude, then also specify if the map projection to use should be North
America (simple conic) or Entire World (Mercator).
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Clipboard Ribbon Group
The Clipboard ribbon group contains options for copying and pasting oneline objects while your are in
Edit Mode. It also provides access to the Undo drawing feature. This ribbon group is on the Draw
ribbon tab. The Group is shown below.

Undo
The Undo command is used in the edit mode to undo the last change made on the oneline
diagram. The Undo command will only undo graphical changes, and will not undo any data
changes in the power system model. See Relationship Between Display Objects and the
Power System Model for information on the display/model relationships.
Paste
The paste command copies the contents of the paste buffer (if any) onto the display at the
current cursor location. Use the Paste command from the Edit Menu. Note that the paste
buffer may contain both display objects and the underlying power system records. When
pasting, the display objects are pasted regardless of whether an identical display object
already exists on the oneline. In contrast, duplicate power system records are never pasted.
This is because, for example, it is acceptable to have two display objects referring to the
same generator, but the generator exists only as a single entity in the power system model.
See Relationship Between Display Objects and the Power System Model for further details.
Paste Special
Paste Special works the same as Paste, however it will also show a dialog asking the you to
choose between
Absolute Coordinates : objects will be pasted using the exact same x/y coordinate as the
copied objects had. This is useful when copying objects between two different oneline
diagrams which contain the same geographic background.
Coordinates Relative to Cursor : objects will be pasted relative to cursor instead of using
the exact x/y coordinates as the copied objects.
Copy
The Copy Command copies the currently selected object(s) into the paste buffer without
deleting them. For power system objects, such as buses, generators or transmission lines,
you are given an option of whether to copy just the display object(s), or copy both the display
object(s) and their underlying power system records. See Relationship Between Display
Objects and the Power System Model for further explanation of these choices. To copy only
the display object(s) and never the power system records from now on, select the Always
Copy Object(s) Only option. You will not be prompted again. You can disable this selection
on the Default Drawing Options Dialog.
Cut
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The Cut Command is used in the Edit Mode to delete the currently selected object(s). To
delete a set of objects, first select the objects. Then select the Cut command from the Edit
Menu. For power system objects, such as buses, generators or transmission lines, you are
given an option of whether to delete just the display object(s), or delete both the display
object(s) and their underlying power system records. See Relationship Between Display
Objects and the Power System Model for further explanation of these choices. To delete only
the display object(s) and never the power system records from now on, select the Always
Delete Object(s) Only option. You will not be prompted again. You can disable this
selection on the Default Drawing Options Dialog.
Unlike Delete, Cut also copies the selection into the paste buffer.
Delete
The Delete Command is used in the Edit Mode to delete the currently selected object(s). To
delete a set of objects, first select the objects. Then select the Delete command from the
Edit menu. For power system objects, such as buses, generators or transmission lines, you
are given an option of whether to delete just the display object(s), or delete both the display
object(s) and their underlying power system records. See Relationship Between Display
Objects and the Power System Model for further explanation of these choices. To delete only
the display object(s) and never the power system records from now on, select the Always
Delete Object(s) Only option. You will not be prompted again. You can disable this
selection on the Default Drawing Options Dialog.
Unlike Cut, Delete does not copy the selection into the paste buffer.
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Select by Criteria Dialog

To open the Select By Criteria Dialog go to the Draw ribbon tab and choose Select By Criteria
from the Select ribbon group.
The Select By Criteria Dialog provides a way of selecting objects that meet a specific set of criteria.
The criteria may include Area Numbers, Zone Numbers, Voltage Levels, Zoom Levels, and Object Type.
Use the dialog's controls to specify the selection criteria. Use the Area and Zone fields to select the
areas and zones in which you want to select display objects. Ranges of area and zone numbers can be
entered in the usual way, or you can check the All Areas or All Zones boxes to select all areas and
all zones. You can also use the Area and Zone tab pages to check or uncheck areas or zones in which
you want to select display objects.
Specify the max and min voltage levels for selected objects using the boxes that are provided, keeping
in mind that all voltages are in kV.
Specify the layers for selected objects in the Layers tab. If not all layers are selected, the Layers
Range option will be selected. If the All Layers option is clicked, then all the layers will be selected.
Next, select the type of object in which you are interested from the supplied list. To select items from
this list, check the box next to the type of field(s) you desire. Display object types that are followed by
a right-arrow, such as Area Fields, are expandable, meaning that they have several associated
subtypes. If you checked a field type that has subtypes, you can highlight the type in the list to see
the available subtype list. You can then more specifically select subtypes that you wish to include. By
default, all subtypes of a general object type are selected. You also have the option for the list to
display all fields available for a particular object type, or to display only the most commonly selected
fields.
You can also choose to associate an advanced filter with a particular type of object in the list for
selecting only objects of that type that meet the filter. To do so, right-click in the Filter column next to
the object type for which the filter applies, or click on Add/Modify Filter… Some objects cannot be
associated with an advanced filter, and the option will be disabled when that is the case for an object
selected in the dialog.
Checking the option Group By Object Type will consolidate all the items by categories. All subtypes
will automatically be included as a consequence. The filters are still available.
If the box Only Show Objects in Display or Already Selected is checked, only the items or
categories (depending on whether the Group By Object Type option is checked) of objects existing or
selected in the respective oneline diagram will be shown in the supplied list.
The buttons Check All and Uncheck All are useful to select/unselect all the items/groups in the list.
The button Check Only Text Fields is available only when the Group by Object Type is unchecked,
and when clicked on all the items that have text associated to them are selected, and the rest of the
items are unselected. Clicking on the Reset To Defaults button will remove all the current selections
and reset them to the default settings.
If you wish to select objects that do not have the chosen criteria, then check Select All Except What
Meets the Above Criteria.
If you wish to only select objects that are currently visible on the diagram (due to layering, etc.),
check the box labeled Select only currently visible objects to apply the criteria settings only to
objects on the diagram that are currently visible.
If the Select by Criteria Dialog is open and some display objects have already been selected, an
advanced selection option becomes available. If the box labeled Use as a filter on presently
selected objects is checked, the criteria chosen in the Select by Criteria Dialog will only affect the
previously selected objects. In other words, only the objects that were previously selected AND that
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match the chosen criteria will remain selected when the OK button is pressed. For example, you could
use all the options available on the Select ribbon group on the Draw ribbon tab to select a group of
objects on the oneline. Then using the Select by Criteria Dialog, choose the Bus criteria and check Use
as a filter on presently selected objects to select only the buses from the rectangular selected
group of objects.
Once you have selected the criteria and pressed OK, all objects that satisfy ALL the criteria will be
chosen. If the Select All Except What Meets the Above Criteria is unchecked, then the selected objects
will lie within the specified areas AND zones, the specified voltage level, and the specified zoom levels,
and will be of one of the drawing types specified.
You can save your settings for your Select by Criteria session with the case by clicking Save As to
save with a new name or Save to save with the current name. This allows you to re-open the Select
by Criteria dialog, and quickly recover settings you may have previously used. Use the Rename to
rename an already saved set, or Delete to remove a previously saved set of criteria.
If you have saved different criteria sets, you can export them all to an Auxiliary file by choosing Save
to AUX file. The Load All from AUX file will load an entire auxiliary file, regardless of whether it
contains Select by Criteria settings or not.
If you wish to clear all settings you have modified on the dialog, click the Reset to Defaults button.
Using this dialog in conjunction with the Format Selection Dialog, can be a very fast and easy way to
customize your displays.
NOTE: When choosing to select all tie lines, all objects associated with the tie line will also be selected.
This includes all line fields for the line as well as the two buses that are the endpoints of the line.
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Select Ribbon Group
The Select ribbon group contains options to help select multiple oneline objects simulateously. The
features in this topic are only available when you are in Edit Mode. This ribbon group is on the Draw
ribbon tab. The Group is shown below.

The features available on this ribbon group are described below.
Select by Criteria
Click on the Select by Criteria button to open the Select by Criteria Dialog. On oneline diagrams of
even a modest size, this is an extremely useful feature and PowerWorld highly encourages you to
use this feature.
Select Region
Use to select all objects in a particular region of the oneline. When the Region Type is Rectangle
or Ellipse, then after clicking the button, click and hold the left mouse button on the oneline at the
point where you would like to begin the selection. Then, drag the mouse to size the selection shape.
Finally, let go of the mouse button once every object you need to select has been selected by the
selection rectangle. When the Region Type is Polygon, then after clicking this button single click on
your oneline diagram for each vertex of the polygon. Finally, finish the selection by double-clicking
the mouse after which all objects inside your polygon will be selected.
Depending on the Select Mode below, every object located entirely Inside the region, or if you
have chosen Touching, then every object inside or partially touched will be selected. Selected
objects will have handles appear indicating that they have been selected.
Region Type
Specify a Rectangle, Polygon, or Ellipse. This controls the shape used to select objects on the
oneline diagram when using the Select Region button above.
Select Mode
This combo box specifies how the Select Region button above works. Choose Inside in order to
select only the objects completely inside the selection rectangle. Choose Touching in order to select
every object either partially touched by or completely inside the selection rectangle.
There are also other ways to select multiple objects



You can also select multiple objects manually by holding down the SHIFT key which clicking on
objects in Edit Mode. This will also add to your selection.
If you hold down the SHIFT and CTRL keys simultaneously and then click on your oneline diagram
and select a region it has the same affect as click on the Select Region button and selecting a
region on your oneline
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Grid/Highlight Unlinked Objects
The Grid/Highlight Unlinked Objects tab is only available in Edit mode. It controls the appearance of a
grid in the oneline. A grid is not visible by default, but can be setup from the Grid/Highlight Unlinked
Objects page of the Oneline Display Options dialog. Additional options are available from this dialog for
disabling anchors and highlighting unlinked objects on oneline diagrams.
Snap Objects to Grid
If checked, new objects placed on the oneline will be aligned with the grid; the grid does not need
to be visible on the oneline to align objects to it.
X Grid Spacing, Y Grid Spacing
These determine the horizontal and vertical spacing of the grid.
Display Grid Lines on Oneline
If checked, the grid lines will appear on the oneline
Horizontal Show Every, Vertical Show Every
These numbers determine the density of the visible gridlines; for fewer lines enter higher numbers.
Gridline Color
Click in the rectangle to choose the color of the gridlines. The default is grey.
Anchor Options
A check box is available for temporarily disabling anchors on a oneline diagram. This option will
disable the anchor properties of all objects on the oneline diagram.
Do not prompt regarding relinking objects after dragging
Check this check-box to avoid being prompted whether to relink a graphical object after this has
been dragged.
Highlighting of Unlinked Objects
Highlight Unlinked Objects with Color
Checking this box allows for any objects on all open oneline diagrams that are currently not
linked to any data in the case to be highlighted using the highlight color. To change the highlight
color used, left-click in the color box to choose a different color.
Minimum Highlighted Object Pixel Size
The minimum size, in pixels, of the highlight image. This is to prevent the highlight from being
unnoticeable when the zoom level is very low.
Extra Width for Highlighted Lines (pixels)
Sets an extra width parameter, in pixels, for highlighting line objects. This will make line object
highlights appear wider than other highlighted objects.
Display Unlinked Elements in Run Mode
This option allows the highlighting of unlinked elements when you switch to run mode. By default
the highlighting of unlinked elements is restricted to edit mode, to avoid confusion in run mode,
particularly when drawing contours.
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Using the Oneline Alignment Grid
The oneline alignment grid allows for buses and other objects to be easily aligned when placed onto a
oneline diagram. The alignment grid for a oneline diagram can be configured in the Oneline Display
Options dialog under the Grid/Highlight Unlinked page. You can open this display by selecting Oneline
Display Options from the Active ribbon group on the Onelines ribbon tab.
When the alignment grid is enabled most objects will snap to the grid while being moved on the
oneline. Depending on whether snap to grid is enabled or disabled, objects can individually be made to
do the opposite of the snap to grid setting by holding down the Alt key while dragging the object.
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Setting Background Color
The Background Color Dialog changes the background color for the display. To view this dialog, select
Oneline Display Options from the Active ribbon group on the Onelines ribbon tab, or right-click in
the background of the oneline and select Oneline Display Options from the local menu. Switch to
the Display Options tab, click Change Background Color, or click on the colored rectangle to bring
up the Color Dialog, which you can then use to select the new background color. Click OK to register
the new color. The Oneline Display Options dialog will provide a preview of the color you selected. To
define this color as the default background color to use in all new onelines you create, click the Set as
Default Background Color. Finally, click OK to save your color selection.
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Zoom, Pan, and Find
The Zoom, Pan, and Find Options Dialog is used to specify a desired zoom level and screen location or
to locate a particular bus or area/zone on the oneline. The dialog can be opened by right-clicking on
the background of the diagram and choosing Pan/Zoom Control from the oneline popup menu, or
by clicking on the Find button in the Zoom ribbon group on the Onelines ribbon tab. The dialog has
the following fields:
Find Objects on Oneline
The Find Object on Oneline section of the dialog is used to pan to any desired bus object , area/zone
object , branch object, interface object, or substation object on the oneline. The dialog makes use of
the advanced find functionality of Simulator to locate a device.
Only Include Objects Visible at Current Zoom Level
If checked (the default), then the Object ID combo box only lists those objects that are visible at
the current zoom level.
Object Type
Select the type of object to find: Buses, Areas or Zones, Interfaces, Substations and

Lines/Transformers.
Sort By

Specify whether you are entering the object by its number or by its name by choosing either Sort
by Name or Sort by Number. This option also determines how the entries in the list of objects are
sorted (either by number or by name).
Object ID
Enter the object’s number or name (depending on the sort type chosen) or select the object from
the list.
Allow Auto Updating on Selection
Check this box to automatically pan to the specified object. The object will be located at the center
of the oneline diagram.
Pan to Object on Oneline
Click this button to pan to the specified object if the Auto Updating box is not checked. The object
will be located at the center of the oneline diagram.
Auto-Zoom when Panning
Check this box to automatically change the zoom when panning to the specified object.
Zoom / Pan
The Oneline Zoom / Pan tab on this dialog is used to allow the user to specify either a new zoom level
and/or screen center and to define these as the new display default settings. The zoom level and
screen center can also be changed from the keyboard. Please see Oneline Zooming and Panning for
details.
Zoom Level
Enter the desired percentage zoom level (nominal is 100%).
Horizontal, Vertical
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Enter a desired location for the center of the screen. The nominal screen center is 50 horizontal and
50 vertical.
Pan/Zoom to New Location
Changes the screen center and zoom level to the values specified in the above fields.
Restore Default Values
Resets the zoom level and screen center to the default values.
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Default Drawing Values
The Default Drawing Options Dialog allows you to see and change the various default values used to
create new objects. To show this dialog select Default Drawing Values from the Quick Insert ribbon
group on the Draw ribbon tab.
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Formatting Ribbon Group
The Formatting ribbon group contains options for formatting the selected objects on your active
oneline. This group is on the Draw ribbon tab and its options are available only in Edit mode. The
options allow you to control such display object attributes as font, color, line styles, zoom-dependent
vissibility, and display layer level. The group is shown below.

A description of the actions on this group are as follows.

Format Buttons
Clicking this button will open the Format Dialog. The dialog which opens will have five tabs as
follows.
Font
Select this option to change the font with which the selected objects are displayed. The Font
Tab of the Format Selection Dialog is displayed.
Line/Fill
Select this option to change the line thickness and style with which a display object is drawn,
or the fill color for closed shapes. The Line/Fill Tab of the Format Selection Dialog is
displayed.
Levels/Layers
Select this option to change the stack level of an object, the layer the object is contained in,
and optional settings for when an object should resize. The Levels/Layers Tab of the Format
Selection Dialog is displayed.
Display/Size
Simulator can change the attributes of the way multiple objects are displayed using this
option, which opens the Display/Size page of the Format Selection Dialog. The size of the
objects can be adjusted, as well as the orientation of the object(s) from their terminal buses.
Objects can also be Anchored to their terminal buses or devices, or marked as Immobile,
meaning the object(s) cannot be moved on the oneline diagram.
Field
Select this option to change the attributes related to object text fields which are selected. The
Field Tab of the Format Selection Dialog is displayed.
Anchors
Invokes a command to refresh anchors on all oneline objects.
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Copy Format and Paste Format Buttons
The button on the left is the Copy Format button. After selecting an object this will copy all the
format properties of that object into an internal buffer. When you then subsequently select other
objects, you can click on the button on the right which is the Paste Format button. Clicking the
Paste Format button will bring up the Paste Format Dialog.
Send to Back, Bring to Front Buttons
After selecting a group of oneline objects using any of the methods described on the Select ribbon
group, you may then click the Send to Back button to cause all the objects selected to move to
underneath other objects. Click the Bring to Front button to bring objects to the top.
The Send to Back and Bring to Front menu options govern the visibility of display objects that
occupy the same screen stack level. All objects have an associated screen stack level, which may be
one of Base, Background, Middle, or Top. Objects having a screen stack level of Top obscure all
objects having stack levels of Middle, Background, or Base that occupy the same region of the
screen. They may or may not obscure objects having the same stack level of Top depending on the
order in which the objects having the same stack level are drawn. Selecting Send to Back for a
selected object will cause it to be obscured by all other same-level objects that occupy its location.
Selecting Bring to Front for a selected object will cause it to be drawn above all other same-level
objects that occupy the same region of the screen. The Send to Back and Bring to Front menu
options govern relative placement of objects only within stack levels. The Send to Back and Bring to
Front options do not affect the relative placement of objects having different stack levels.
Alignment Menu
The alignment menu provides access to the Alignment Dialog and direct access to options to align
the selected objects as specified in the menu items.
Grouping Menu
Grouping is only available for background oneline objects (background lines, ellipses, text, etc...).
This menu provides button to Group and Un-Group objects.
Layers Menu
The Layers Menus provide access for opening the Define Layers Dialog for the presently active
oneline diagram.
Underneath the button for defining layers is a list of the presently defined layers. You may check or
uncheck the various layers to hide or show the objects in those layers.
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Format Multiple Objects
The Format Multiple Objects dialog features five tabs of controls for modifying the display attributes of
selected object(s). Even though the dialog is very useful for formatting multiple objects, there is no
requirement than more than one object be selected to use the formatting dialog. To open the Format
Multiple Options dialog you must first use some of the options available on the Select ribbon group on
the Draw ribbon tab to select a group of objects. Next, right-click on any of the selected objects and
select Format Selection from the local menu. You may also bring up the Format Multiple Objects
dialog by going to the Formatting ribbon group on the Draw ribbon tab.
The options on the following tabs will be updated to reflect the types of objects selected. All options
will not be available for all objects. If multiple objects of different types are selected, options will only
be available if they are relevant for any of the types of objects selected.
Line/Fill
The Line/Fill tab is used to change the line size, color, and style and the fill color with which the
selected objects are drawn.
Levels/Layers
The Levels/Layers tab is used to change the stack level of an object, the layer the object is
contained in, and optional settings for when an object should resize.
Display/Size
The Display/Size tab controls the size and orientation of the selected objects.
Font
The Font tab is used to change the font used in text/font objects.
Field
The Field tab is used to change selected fields on the diagram to a different field designation. If all
of the selected fields are for the same type of object and field, you can select a different field to be
represented by the selected objects from the Field selection. You can also set the options for
including a suffix, the total digits in the field for numeric values, and the number of digits to the
right of the decimal.
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Paste Format Dialog
The Paste Format Dialog appears when you use the Paste Format button on the Formatting ribbon
group on the Draw ribbon tab. The dialog looks as follows

On this dialog check the attributes you would like to paste to the selected objects. Note that attributes
which are disabled in the Paste Format Dialog represent one of two things



The attribute was not relevant to the objects whose format was copied
The attribute was not the same for the objects whose format was copied
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Font Properties
The Font Tab allows you to define the font for the selected objects by choosing Font type, size, color
and effects. The page also allows you to control the default display font using the Make Default
button.
By clicking on Make Default, the current font name, size, and effects will be set as the default font
for the display. This has the same effect as opening the Default Drawing Values and setting the default
font.
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Line/Fill Properties
The Line/Fill tab of the Format Multiple Objects dialog is used to customize the line size/color and the
fill color of selected objects. You can view this tab by selecting from the Formatting ribbon group on
the Draw ribbon tab after object(s) have been selected on the oneline. This tab’s controls can be used
to change the appearance of most, but not all, screen objects. Only options that are relevant for the
types of objects selected will be enabled. The Line/Fill tab has the following fields/commands:
Line Thickness
Thickness of the line in pixels. Line can mean either an actual transmission line or background line
object, the lines used to draw objects like loads and switched shunts, or the border line that
surrounds objects like generators and buses.
Dashed
Allows setting a line to appear as a dashed line on the diagram. There are three types of line
dashing to choose from in the drop down menu for this option.
Line Color
This field shows the current line color. To change the line’s color, click on the box displaying the
current line color, or click the Change button next to the Line Color box. This displays the Color
dialog. Select the desired color and select OK to change the color, or click Cancel if you do not wish
to change the color.
Line Color 2
The Line Color 2 field applies only to transformer and generator objects. Check the Use Color 2
field to implement use of the color and specify the color through the color box. The color can be
changed in the same manner as described above for Line Color.
Transformers can be represented by different colors on each side of the transformer coils. This is
commonly used to color match each side of the transformer with the color used to represent the
voltage level of the transmission system on each particular side of the transformer. However, you
can customize the colors for selected transformers by modifying them here. The Line Color 2 field
ALWAYS applies to the high voltage side of the transformer.
The rotor image selected for generator objects can be filled with Line Color 2.
Use Background Fill
Click on this box to toggle whether or not to fill the background for the selected objects with the
selected background fill color. Text objects such as Text, Bus Fields, Generator Fields, Load Fields,
Switched Shunt Fields, Line Fields, Transformer Fields, Area Fields, background objects such as
Background Lines and Background Rectangles, and generator objects can be filled.
Fill Color
This field shows the current fill color. To change the fill color, click on the box that displays the
current fill color, or click the Change button next to this box. This displays the Color dialog. Click on
the desired color and the select OK to change the color, or click Cancel if you do not wish to change
the color.
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Levels/Layers Options
The Levels/Layers Tab is used to customize the stack level or layer an object is contained in. To set
layers for objects, select the objects on the oneline diagram (edit mode only) and then choose . The
Levels/Layers Options page of the Format Multiple Objects dialog will be displayed, with the following
settings available.
Stack Level
An object’s stack level dictates what objects it will appear above, and which objects it will appear
below on a oneline diagram. For example, circuit breaker and pie chart objects have a default stack
level of Top. Therefore anything with a stack level of Middle, Background or Base will appear
underneath pie charts and circuit breakers on the oneline diagram. Objects that are within the same
stack level and are drawn in the same location will result in the last object drawn being the visible
object on the diagram. You can toggle which elements within the same stack level at the same
location is visible using the Send to Back and Bring to Front buttons in the Formatting ribbon group
on the Draw ribbon tab.
Layers
Layers are different than stack levels in that layers are designed to allow the user to filter the
elements visible on a diagram (in run mode). Initially all diagram objects are in the same layer,
called Default. This default layer cannot be modified or deleted. However, you can introduce
additional layers using either the Add New… or Define… buttons. Clicking on Add New… will
open a dialog to name the new layer, and will automatically add the new layer to the case and
change the Layer name in the drop down list to the new layer. Clicking on Define… will open the
Screen Layers list display, which will allow you to manage the full list of layers defined for the
diagram. Once layers have been defined, you can choose which layer the selected objects belong to
by choosing the Layer name from the drop-down list by clicking on the down arrow to the right of
the layer name.
Settings for resizing when zooming
You can modify the maximum and minimum zoom levels at which the selected text fields will no
longer resize. Thus when zooming in or out on the diagram, text fields will resize according to the
zoom level until the minimum or maximum zoom level are reached. At that point, text fields will no
longer resize, but will stay fixed at their current size as you continue to zoom.
Maintain Fixed Screen Location (do not pan)
This option is available for text fields. When checked for selected text fields, these text fields will no
longer pan when you pan the rest of the diagram. This allows you to place text that will always be
visible, regardless of what part of the diagram you are observing. You can still move the individual
text field itself in edit mode.
Maintain Fixed Screen Size (do not resize on zoom)
This option is available for text fields. When checked for selected text fields, these text fields will no
longer resize when the zoom level of the diagram is changed. This allows you to place text that will
always be visible at a constant size, regardless of what zoom level you are currently observing on
the oneline diagram. You can still select the text fields themselves in edit mode and change their
font size.
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Screen Layers
The Screen Layers display can be invoked from either the Levels/Layers button in the Formatting
ribbon group in Edit Mode, or by right-clicking on the oneline diagram background and choosing Edit
Screen Layers.
Screen layers provide a method to filter objects on a oneline diagram based on either zoom level or to
which layer the objects are assigned. Initially each object is in a common layer called Default, which
cannot be modified or deleted. You can create new layers using the Screen Layers display.
Since the Screen Layers display is a Case Information Display, it shares the of other case information
displays. You can access many case information display features by right-clicking on the display to
invoke the local popup menu. Most importantly, this menu contains the options to Insert and Delete
screen layers.
To delete a screen layer, right-click on that layer in the display and select Delete from the popup
menu. The one exception is the Default layer, which cannot be deleted.
To insert a new screen layer, right-click on a record in the display and choose Insert from the popup
menu. This will open the Screen Layer Options dialog for defining the options of the new layer you are
inserting. You can also define a new layer by going to the Onelines ribbon tab, then on the Active
ribbon group choose Screen Layer > Define Screen Layer.
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Screen Layer Options
The Screen Layer Options are used to define options for new layers, or modify options for existing
layers. Devices can be added to a layer by choosing the layer name from the drop-down list on the
Levels/Layers Tab of the Format Multiple Objects dialog.
Name
Layers can have any name desired to describe the layer. The default naming convention is "Layer
#".
Show Layer
If this box is checked, any objects on the diagram which are contained in this layer may be visible.
This depends on the settings for low and high zoom level, described below. If the box is unchecked,
however, then any objects contained in this layer will be hidden. Only objects that are visible will be
used when calculating contours. Unlike Custom Display Detail, layers can be applied in both edit
mode and run mode.
Selectable in Edit Mode
By unchecking this box the user prevents the objects contained in this layer of being with the mouse
during Edit Mode. This is behavior is particularly desirable for elements (such as borders which are
pretty much already fixed) when editing oneline diagrams.
Use Conditional Display by Zoom Level
Objects can be displayed or hidden based on the Screen Layer to which they are assigned and the
current zoom level of the oneline diagram. Checking this box, and setting the Low Zoom Level and
High Zoom Level fields, dictates at what zoom range the objects contained in the zoom level will be
visible. If the zoom level is outside the range defined, any objects belonging to the screen layer will
be hidden. This also applies to both edit mode and run mode.
Memo
This tab allows the user to enter text in order to describe this layer.
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Format Field Properties
The Field tab of the Format Multiple Objects dialog can be used to modify the format of the selected
fields, or to change a set of selected fields from one field representation to another. Use the Select by
Criteria dialog to select fields of a particular type, right-click on any of the selected fields and choose
Format Selection from the popup menu.
Note that this option also applies to objects which display information related to specific object fields,
such as Line and Interface Pie Charts.
Object Type
This field will be filled in automatically based on the type of object the selected field(s) apply to. You
cannot change this field, which means that you can only change the selected field(s) to another field
for the same type of object.
Field
The field type of the selected field(s). To change the selected fields to a new field type, click on the
drop-down arrow of the combo box, or click on the Find… button, and select a new field from the
list of fields for the Object Type.
Include Suffix
Checking this option will add the unit suffix to the selected fields.
Total Digits in Field
Modify the number of digits to display in the field. This number includes the decimal and the
numbers to the right of the decimal.
Digits to Right of Decimal
Modify the number of the total digits that should appear to the right of the decimal.
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Display/Size Properties
Use the Display/Size tab of the Format Multiple Objects dialog to change the display size, orientation,
anchor property of the selected object(s).
Size
This field will change the characteristic display size of the selected object(s). The characteristic size
is normally the vertical size or height of display objects. In objects with different orientation choices,
the size is the most distinctive dimension of the object (e.g. in buses with right or left orientations,
the size is the horizontal dimension of the bus bar, but in buses with up or down orientations, the
size is the vertical dimension of the bus bar).
Width
This field will change the characteristic display width of the selected object(s). Similarly to the size,
the width represents the horizontal dimension or width of display objects. In objects with different
orientation choices, the width is the least distinctive dimension of the object (e.g. in buses with right
or left orientations, the width is the vertical dimension of the bus bar, but in buses with up or down
orientations, the width is the horizontal dimension of the bus bar).
Anchored
To toggle whether or not the selected object(s) are anchored , check or uncheck this option
Immobile
To force the selected object(s) to stay in the same position, check this option.
Orientation
This group will modify the orientation setting of the selected object(s). The possible settings will
change depending on the type of object selected. Some object types do not have an orientation.
Shape
Use this group to modify the shape of the selected display objects. Possible shape settings will
change depending on the type of objects selected. If objects of different types are selected and
these types do not have a common set of shapes possible, the shape option will be blank and the
shape cannot be changed.
For Substation objects, the Use Substation Layout Settings specifies that the shape selected in the
Substation Display Options will be used.
When generator objects are selected, the shape selection determines the shape of the rotor inside
the generator. The selections include images that represent possible generator fuel types including:
coal, hydro, natural gas, nuclear, oil, solar, and wind. The other images include a dog bone, sine
wave, or no rotor image. If selecting a rotor shape that can be filled, Line Color 2 on the Line/Fill
tab determines the fill color for the inside of the shape.
Number of Selected Objects
This field shows the number of objects that are currently selected on the oneline.
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Align Group Objects
The Align Group feature allows for selecting multiple objects on a oneline diagram and aligning them
in a specified manner. There are a couple of ways to perform the alignment.
First, select the objects on the diagram that you wish to align. Once you have selected all objects, you
can 1) right click on a selected object and choose Align Group Objects from the local popup menu
or 2) use the Alignment menu found in the Formatting ribbon group on the Draw ribbon tab.
The Align Group Objects option from the local menu will open the Align Dialog, which allows for
specifying the type of alignment desired. Alignment can be performed horizontally, vertically, or both.
In addition to alignment of the top, bottom, left and right edges of the selected objects, you can also
choose to have the objects snap to the drawing grid in the horizontal and/or vertical directions as well.
These alignment actions can also be selected directly from the Alignment menu found on the
Formatting ribbon group on the Draw ribbon tab.
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Refresh Anchors
The Refresh Anchors option of the Formatting ribbon group on the Draw ribbon tab allows you to
update or reset the anchoring of objects on a oneline diagram to their respective anchor. It can be
advantageous to use the Refresh Anchors option when opening onelines that were created by another
case, copying and pasting data between onelines, or renumbering objects on the oneline. This ensures
the anchoring of objects to the appropriate anchor on the oneline diagram.
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Clipboard Ribbon Group
The Clipboard ribbon group contains options for copying and pasting oneline objects while your are in
Edit Mode. It also provides access to the Undo drawing feature. This ribbon group is on the Draw
ribbon tab. The Group is shown below.

Undo
The Undo command is used in the edit mode to undo the last change made on the oneline
diagram. The Undo command will only undo graphical changes, and will not undo any data
changes in the power system model. See Relationship Between Display Objects and the
Power System Model for information on the display/model relationships.
Paste
The paste command copies the contents of the paste buffer (if any) onto the display at the
current cursor location. Use the Paste command from the Edit Menu. Note that the paste
buffer may contain both display objects and the underlying power system records. When
pasting, the display objects are pasted regardless of whether an identical display object
already exists on the oneline. In contrast, duplicate power system records are never pasted.
This is because, for example, it is acceptable to have two display objects referring to the
same generator, but the generator exists only as a single entity in the power system model.
See Relationship Between Display Objects and the Power System Model for further details.
Paste Special
Paste Special works the same as Paste, however it will also show a dialog asking the you to
choose between
Absolute Coordinates : objects will be pasted using the exact same x/y coordinate as the
copied objects had. This is useful when copying objects between two different oneline
diagrams which contain the same geographic background.
Coordinates Relative to Cursor : objects will be pasted relative to cursor instead of using
the exact x/y coordinates as the copied objects.
Copy
The Copy Command copies the currently selected object(s) into the paste buffer without
deleting them. For power system objects, such as buses, generators or transmission lines,
you are given an option of whether to copy just the display object(s), or copy both the display
object(s) and their underlying power system records. See Relationship Between Display
Objects and the Power System Model for further explanation of these choices. To copy only
the display object(s) and never the power system records from now on, select the Always
Copy Object(s) Only option. You will not be prompted again. You can disable this selection
on the Default Drawing Options Dialog.
Cut
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The Cut Command is used in the Edit Mode to delete the currently selected object(s). To
delete a set of objects, first select the objects. Then select the Cut command from the Edit
Menu. For power system objects, such as buses, generators or transmission lines, you are
given an option of whether to delete just the display object(s), or delete both the display
object(s) and their underlying power system records. See Relationship Between Display
Objects and the Power System Model for further explanation of these choices. To delete only
the display object(s) and never the power system records from now on, select the Always
Delete Object(s) Only option. You will not be prompted again. You can disable this
selection on the Default Drawing Options Dialog.
Unlike Delete, Cut also copies the selection into the paste buffer.
Delete
The Delete Command is used in the Edit Mode to delete the currently selected object(s). To
delete a set of objects, first select the objects. Then select the Delete command from the
Edit menu. For power system objects, such as buses, generators or transmission lines, you
are given an option of whether to delete just the display object(s), or delete both the display
object(s) and their underlying power system records. See Relationship Between Display
Objects and the Power System Model for further explanation of these choices. To delete only
the display object(s) and never the power system records from now on, select the Always
Delete Object(s) Only option. You will not be prompted again. You can disable this
selection on the Default Drawing Options Dialog.
Unlike Cut, Delete does not copy the selection into the paste buffer.
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Undo Command
The Undo command is used in the edit mode to undo the last change made on the oneline diagram.
The Undo command will only undo graphical changes, and will not undo any data changes in the
power system model. See Relationship Between Display Objects and the Power System Model for
information on the display/model relationships.

819
©2011 PowerWorld Corporation

Oneline Diagram Overview
The purpose of the oneline diagram is to show information about the power system graphically. Such
displays are called oneline diagrams (onelines) because the actual three-phase power system
components are represented using a single line. Simulator onelines "come alive" via:





Animation
Contouring
Zooming and panning capability and
Conditional display of objects

Additionally, a key aspect of Simulator is the ease with which it allows the user to examine and modify
many of the shown on the oneline diagram.
The user may open any number of oneline diagrams, including multiple copies of the same oneline.
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Relationship Between Display Objects and the Power System Model
Display Object:
An item shown on a oneline diagram. Display objects typically have an associated model object.
Examples include buses, transmission lines, transformers, generators and loads. Display objects not
associated with a model object are called unlinked objects.
Model Object:
A power system element contained in a case.
A key strength of the Simulator is its ability to allow users to manipulate a power system model
graphically. This capability greatly simplifies the work involved in developing or maintaining a power
system case for both novice and advanced users. However, it is important to keep in mind the
distinction between the shown on the onelines and the actual power system model, consisting of
model objects. A key concept is that any number of display objects, including none at all, can be
associated with a single model element.
Simulator uses a bus-oriented model. In other words, the model objects are either the buses
themselves, objects that are radially attached to a bus (i.e., loads, generators and switched shunts), or
objects that join two buses (i.e., transmission lines, transformers or dc lines). As long as there is a
one-to-one mapping between display objects and model objects, the distinction between the two could
be made entirely transparent to the user.
It is reasonable, and often quite useful, to use more than one display object to represent a single
model object. For example, by using the Conditional display of objects feature, two bus display objects
could be used on a single oneline to represent the same bus. One bus might be visible over a
particular zoom range, while another, with perhaps a different size/thickness, is visible over another
range. Alternatively, the same bus could be represented using display objects drawn on separate
onelines.
An ambiguity arises when the user uses the Cut command to delete an object. Is he or she deleting
just the Display Object or both the Display Object and the Model Object? To alleviate the problem,
Simulator prompts you when you are deleting a display object with an associated model object to
delete both the Display Object and its associated model object record, delete just the display object, or
cancel the delete.
In addition, there is no requirement that model objects have a corresponding display object. Thus, you
could use the oneline diagram to show just a fraction of the total system buses and other devices. You
can use the Case Information menu to view the model objects directly regardless of whether or not
they are shown on a oneline.
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Custom Hint Values
Simulator can be configured to show a short hint string when the mouse is hovered over objects on
the oneline diagrams. This hint string will appear in a yellow box as shown below.

This option must be set first by opening the Simulator Options dialog and then going to the Oneline
category and finally checking the Show Oneline Hints . The user may then customize what text and
values appear in the hint by choosing Custom Hint Values on the General Options ribbon group of
the Options ribbon tab. These General Options are also available on the Oneline ribbon tab.
This brings up a dialog on which customizations are made for each type of display object that can
show a hint.

Choose the type of object on the left side of the dialog. With this display object chosen, choose which
fields of this dialog you would like to include as part of the custom hint. Click the Add, Remove, or
Modify buttons to add, remove, or modify a field to the hint. Click the Up and Down buttons to
change the order in which the fields appear. On the dialog that appears after clicking Add or Modify,
you may customize the field with a prefix, modify the digits and decimal points, and specify whether to
show the units as a suffix. The Example column shows an example of what text will appear for the
hint.
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The Object Identifier is also available that will appear as the first line of the hint if chosen. To remove
this identifier, click the Remove ID button. When the object identifier is not being shown the
Remove ID button caption will change to Add ID. Click the Add ID button to add the object
identifier back to the hint. You may specify the format of the object identifier by setting the Show
Object Identifier with the following Identifier Type option appropriately.
The Delay before showing hints (ms) is to set the milliseconds time that the hint will show up
after you hover over an object and the Delay before hiding hints (ms) is the milliseconds time
before the hints are going to be hide. The Maximum hint width (pixels) is the maximum pixels
width that the yellow box of the hint will have.
By selecting the Set Hint Font a dialog will open to select the font type, font style and size of the text
in the hint box. Selecting Set Font to Window Default will set the text fonts to the Window defaults
values.
The hint customizations are stored with the PowerWorld Binary file (PWB) and in the Windows
Registry. The customizations affect all oneline diagrams (including the Bus View and Substation View).
The customizations may also be stored in an Auxiliary File for use in moving the customizations
between computers and cases. Click the Save All to Aux File button to save all these customizations
to an Auxiliary File or click the Load All From Aux File to load all the custom hints from an Auxiliary
File.
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Oneline Local Menu
The local menu provides access to a number of options and tools directly from the oneline. To display
the local menu, position the cursor on an empty portion of the oneline then click the right mouse
button. While most options are always available on the popup menu, a few options are only available
on the popup menu in run mode.
Find Object on Oneline (Edit and Run Modes)
Displays the Find Object on Oneline tab of the Zoom, Pan, and Find Objects dialog.
Oneline Display Options (Edit and Run Modes)
Displays the Oneline Display Options dialog. This dialog allows you to customize the appearance of
the oneline.
Pan/Zoom Control (Edit and Run Modes)
Displays the Zoom/Pan tab of the Zoom, Pan, and Find Objects dialog.
Edit Screen Layers (Edit and Run Modes)
Opens the Screen Layers case information display.
Show Layer (Edit and Run Modes)
Allows activation of any saved screen layer.
Save/Edit/Delete View (Edit and Run Modes)
Displays the Save View Level Dialog. This dialog is used to set defined locations on the oneline for
recalling specific views from a list of saved views.
Go To View (Edit and Run Modes)
Allows the user to go to a specific location and zoom level on the oneline by choosing from a list of
saved views. This option does nothing if no views are saved.
Contouring (Run Mode Only)
Displays the Contour Options Dialog. This dialog allows you to contour the system voltage
magnitudes or angles.
Difference Flows
Displays the Difference Flows Dialog. This dialog is used to compare two power system operating
points.
Dynamic Formatting (Active Oneline) (Edit and Run Modes in Oneline Diagrams)
Displays the Dynamic Formatting Dialog. This dialog is used to change the rendering of objects in
oneline diagrams according to the state of the represented object in the power system.
Dynamic Formatting (All Views) (Edit and Run Modes in Bus and Substation Views)
Displays the Dynamic Formatting Dialog. This dialog is used to change the rendering of objects in
bus and substation views according to the state of the represented object in the power system.
All Display Objects (Edit and Run Modes)
Opens the Display Object case information display, showing all the objects contained in the oneline
diagram.
Only Selected Display Objects (Edit Mode Only)
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Opens the Display Object case information display, showing only the currently selected objects in
the oneline diagram, by automatically checking the Show Only Objects Selected on Display box.
Load Display Auxiliary File (Edit and Run Modes)
Loads a display auxiliary file.
Print Oneline (Edit and Run Modes)
Sends a copy of the oneline diagram to the printer. Selecting this option has the same affect as
selecting File, Print Oneline from the main menu. See Printing Oneline Diagrams for more
information.
Copy Image to Clipboard (Edit and Run Modes)
Copies the oneline file into the Windows clipboard using the Windows Metafile format (*.wmf). You
can then paste the oneline into another program, such as a word processor. See Copying Onelines
to Other Programs for details.
Export Image to File (Edit and Run Modes)
Saves a copy of the entire oneline diagram image to a file. Oneline image files can be saved in
bitmap (*.BMP), Windows Metafile (*.WMF, *.EMF), JPEG (*.jpg), or GIF format (*.gif).
Toggle Full Screen (Run Mode Only)
Sets the oneline diagram display window to full screen size. This option hides all toolbars and status
bars. To return the window to normal, right-click on the oneline diagram and un-check the Full
Screen option.
Embed a Display (Run Mode Only)
Clicking on this option allows you to open another oneline diagram (or the same one) and embed
the new display inside the existing display. You can choose what percentage size the embedded
display should be, and where within the existing window the embedded window should be placed.
Form Control > (Edit and Run Modes)
Options on this submenu allow you to resize the window, shift the window, or close the window.
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Oneline Display Options Dialog
The Oneline Display Options dialog allows you to customize the display of the oneline diagram. You
can access this display by right-clicking anywhere on an empty portion of a oneline and selecting
Oneline Display Options from the resulting oneline local menu.
This dialog can also be display by going to the Options ribbon tab and choosing Oneline Display
Options from the Oneline Options ribbon group.
This dialog houses pages that govern various aspects of the oneline display. See Animated Flows,
Display Object Options, Display Options, Grid/Highlight Unlinked Objects, Geography/Coordinates,
Memo, Pie Charts / Gauges, Thumbnail View, or Substations for information on the respective tabs.
Older versions of Simulator used to support a movie maker tool useful with the onelines. See the
Movie Maker topic for suggestions on what tools to use instead.
Save Options to Case
Of important note is the general option at the bottom of this dialog labeled Save Options to Case.
What this allows you to do is define a set of oneline options in the dialog, and then save that
definition of options in the case by giving the definition a name. Once you have named that set of
options, you can recall it later by coming back to this dialog and choosing the name from the list of
option set names that appears near the bottom of the dialog. You can define as many different sets
of custom options as you wish. You can also use an option set saved with the case when you create
a oneline view using the Save Views dialog.
Also note that once you have defined these sets of Saved Oneline Options, you can then quickly
apply them to the active oneline diagram by using the Saved Options Menu on the Options ribbon
tab.
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Display Options
The Display Options page is found on the Oneline Display Options dialog. This page contains the
following option settings:
Display Detail
The Display Detail box allows you to control how much information is shown on the oneline display.
This option is available only in run mode. All elements on a oneline diagram are automatically visible
in edit mode. There are four choices for run mode detail filtering:
Minimal Show the oneline background, branch circuit breakers, generator MW output, and load
MW/MVR.
Moderate Show all Minimal information, along with bus voltages and all line flow pie charts.
Complete Show all information.
Custom Selecting this option and then clicking the Set… button opens the Custom Detail Dialog,
which allows you to customize the oneline diagram to hide objects that do not meet your desired
specifications. This dialog looks and works very similar to the Select By Criteria tool, allowing you to
choose objects filtered by area, zone, voltage, and screen layer.
Of course, in order for a certain display object to appear, it must have been placed there by the
person who designed the oneline.
Emphasize Specific Objects
This option allows you to choose to "emphasize" desired elements on a oneline diagram. The
emphasis is in the form of the emphasized elements being in full color, with de-emphasized
elements being muted colors.
To choose emphasis of certain elements, first check the box labeled Do Emphasis. When you first
check this box, it will open the Emphasis Filter dialog, which looks and works very similar to the
Select By Criteria tool. You can choose the oneline elements you wish to emphasize, and include
filtering by area, zone, voltage, and screen layer.
The degree of emphasis (muting of de-emphasized elements) can be controlled by the Emphasis
Amount slide bar.
Background Color
Select Change Background Color to select a different color for the oneline diagram background
color. Select the Set as Default Background Color option to set the background color as the
default for all oneline diagrams.
Use Absolute Values for MW Line Flows
If checked, this option will cause all MW flow text fields for lines to be displayed as the absolute
value of the flow. Otherwise, the MW flow text fields will be positive near the source end of the line
and negative near the sink end of the line. The value of this option is stored in the system registry,
and will be used by bus view and substation view diagrams when a oneline diagram with saved
oneline options is not available.
Use Absolute Values for Mvar Line Flows
If checked, this option will cause all Mvar flow text fields for lines to be displayed as the absolute
value of the flow. Otherwise, the Mvar flow text fields will be positive near the source end of the line
and negative near the sink end of the line. The value of this option is stored in the system registry,
and will be used by bus view and substation view diagrams when a oneline diagram with saved
oneline options is not available.
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Use Absolute Values for MW Interface Flows
If checked, this option will cause all MW flow text fields for interfaces to be displayed as the absolute
value of the flow. Otherwise, the MW flow text fields will be positive near the source end of the
interface and negative near the sink end of the interface. The value of this option is stored in the
system registry, and will be used by bus view and substation view diagrams when a oneline diagram
with saved oneline options is not available.
Enable Mouse Wheel Zooming
When this box is checked, zooming can be done with a mouse wheel. The default is off.
This option applies to all onelines instead of just the presently selected oneline.
Show Oneline Hints
When this box is checked, hovering the cursor over an object will briefly display information about
the object in a popup hint.
This option applies to all onelines instead of just the presently selected oneline.
Visualizing Out-of-Service Elements
Out-of-service elements can have optional visualization settings that makes them "stand out" in
relation to in-service devices on the oneline diagram. The options for out-of-service devices includes
Use Dashed Lines, Draw and X Through Off-Line Generators, and Blink. Additional controls
for the Blink option are available, for setting the blink interval and color. Any combination of these
options can be used for out-of-service elements, although the X option only applies to out-of-service
generators.
Browsing Path for Oneline Diagrams
This option applies when you have Oneline Links included on a oneline diagram. Rather than specify
the full path and name of a oneline diagram as a oneline link, you can specify the file name only.
When the link is clicked in Run Mode, Simulator will check all directories listed here, in order, to try
and find the oneline file name stored with the link.
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Pie Chart/Gauge Options
Show Pie Charts/Gauges in Run Mode
When this option is checked, the pie charts and line gauges will be visible during Run Mode.
Otherwise, they will be visible only during Edit Mode.
Only Show Pie Charts/Gauges if relevant data exists
The relevancy of pie charts and gauges depends on the style of the pie chart or gauge. For MVA,
MW, Mvar and Amp styles, the pie charts are considered irrelevant if the limits on the line or
interface are 0. For max percent loading under contingency, the pie chart is irrelevant if no
violation(s) under contingency occurred on the element. For the PTDF style, the pie chart is invalid if
the PTDF value has not been calculated for the line or interface.
The options for pie charts and gauges are split into four sections, discussed in the additional topics:
Pie Charts/Gauges: Lines
Pie Charts/Gauges: Interfaces
Pie Charts/Gauges: Pie Chart/Gauge Styles
Pie Charts/Gauges: General Options
Many of these same options are available on the Pie Chart menu found on the Options ribbon tab.
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Animated Flows Options
The fields on the Animated Flows page of the Oneline Display Options dialog are used to customize the
appearance of the animated flows on the oneline diagram.
Show Flow Symbols
Determines whether power flows are animated on the onelines. If this option is not checked, then
no flow symbols appear on the oneline.
Show Flows On
Allows you to choose whether or not to display animated flows individually on Branch, Load,
Generator and Shunt objects. Uncheck the box(es) for the objects that you do not wish to display
animated flows.
Base Flow Scaling on
Animated flows on onelines may depict either actual power flows or power transfer distribution
factors, depending on what you choose here. You can also choose to animate both the MW and
MVAR flows or the MW and PTDF flows simultaneously. The Custom Float 1 option allows user
specification of a value to depict in the flow animation. To use this option, values should be entered
in the Custom Floating Point 1 field for the appropriate devices.
Animate
This option determines whether or not the flow arrows are mobile or stationary on the oneline
diagram. Unchecking this box will cause the flow arrows to remain stationary on the diagram.
Scale Speed of Flow
Checking this box will cause the arrows to flow at a speed proportional to the represented quantity.
When it is not checked, all of the flows will be at the same speed.
Scale Size of Flow
If checked, the size of the animation symbols will vary to represent the magnitude of flow on the
element (respective of the Animation Parameter.) Otherwise, the symbol size will be the same on
all devices regardless of the magnitude represented.
Reset Animated Flow Offsets
This button allows the user to reset the animated flows to start at a specified offset position. Mostly
this would be used to reset the offset to 0, which would cause the animated flows to start at the
beginning of the line or element. Since the animation moves the flow arrows every time the load
flow is resolved, resetting flows to a specific offset could be useful for comparing different load flow
solutions by looking at differences in the animated flow objects.
Set Size, Density, and Reference Values for this oneline
Simulator detects the current zoom level and object parameters of the selected oneline diagram, and
automatically adjusts the animation settings in an attempt to optimize the animation quality.
Size
Determines the relative size of the animated flows on the devices. Increasing this number increases
the size of the flow symbols. This field may range from 1 to 999.
Density
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Determines the relative density of the animated flows on the devices. Increasing this value causes
Simulator to display a greater number of flow symbols per unit distance on the oneline. This value
may range from 1 to 999.
Scaling Based on
Determines whether the size and speed of animated flows represent actual flow or percentage
loading. This option applies only to transmission lines and transformers as flows on other devices,
such as loads and generators, always represent actual flow.
Max. Zoom Level to Scale Size
As a oneline is zoomed, the animated flow symbols increase in size. The value of Max. Zoom Level
to Scale Size caps the size of the animated flows so that zooming beyond this level results in no
further increase to the size of the flow symbols.
Maintain Density above Maximum Zoom Level
As a oneline is zoomed, the animated flow symbols decrease in density. Checking this box maintains
the density of the animated flows after the maximum zoom level has been reached.
Minimum Size in Pixels for In-service Elements
Allows the specification of a minimum size for the animated flow objects for power systems elements
that are in-service. The flow objects are sized based on the flow through the element. For elements
with very small flows, it is often difficult to see the flow objects, and the minimum size can be set to
make these flow objects more visible. The larger the minimum size value becomes, the more
uniform the flow objects will become as elements are no longer sized based on their actual flow but
rather the minimum size.
Reference Values for Scaling
Maximum flow reference for sizing the animated flows. The lower the MVA reference, the larger the
animated flows appear on the oneline diagram as the actual flow value is compared to the reference
value for scaling.
Symbol Shape
Simulator can display animated flows using directional arrows, circles, squares, or triangles.
Animation Rate
If the oneline animation is too fast or too slow, the animation rate can be adjusted by moving the
slide bar.
Symbol Fill Color
Shows the fill color used for the animated flows if Use Fill Color is checked. Double-click on these
fields to change the colors of the six different types of animated flows.
Use Fill Color
Checked if animated flow symbols should be filled using the Fill Color.
Show PTDF Counter Flow
Check this option if you wish for PTDF values that are in the opposite direction of the actual flow to
be displayed using a different symbol color when visualizing PTDFs.
Many of these same options are available on the Animation Menu found on the Options ribbon tab.
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Thumbnail View
The thumbnail view allows the user to see an overview of the oneline diagram in a smaller window in a
specified location on the oneline diagram. The thumbnail view is useful when the user has zoomed in
to a specific area of the oneline diagram, but still wants to see what part of the system they are
observing on a larger scale as they pan around the diagram. The other application is to observe a
more detailed part of the system in the thumbnail view as the user moves the cursor over the oneline
diagram. The thumbnail view is not visible by default, but can be set up and displayed from the
Oneline Display Options dialog. The options for the thumbnail view are:
Show ThumbNail View
If checked, the thumbnail view will be visible in the specified corner of the oneline diagram.
Size of ThumbNail View
The size of the thumbnail view as a percentage of the size of the oneline diagram.
Zoom level of Thumbnail View
The amount to multiply the oneline diagram zoom level for display in the thumbnail view. The higher
the multiplier, the more of the diagram you will see in the thumbnail view. You can instead indicate
that the thumbnail view should display the diagram at a specified zoom level rather than a
dynamically scaled zoom level based on the current diagram's zoom level.
Location
Choose the location on the oneline diagram in which the thumbnail view is to appear.
Border Width in Pixels
The pixel thickness of the border around the thumbnail view.
Background Color
If Use One-line Background Color is checked, the thumbnail background color will be the same
as the oneline diagram. If it is not checked, then a different thumbnail background color can be
selected by clicking on the colored box next to the Use Custom Background Color label.
Thumbnail view follows mouse cursor
This setting is very useful when is combined with the Zoom Level. Using a low multiplier and
checking the Thumbnail view follows mouse cursor box will show a more detailed part of the system
over which the cursor is being moved.
Percent Transparent
This setting allows you to make the thumbnail window completely opaque, completely transparent,
or some measure in between. The more transparent the thumbnail window, the more detail of the
underlying oneline diagram is visible through the thumbnail window.
Many of these same options are available on the Thumb Nail options menufound on the Options ribbon
tab.
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Thumb Nail Menu
The Thumbnail View Options quick menu provides access to most of the options contained in the
Thumbnail View Options dialog in an individual manner through menu commands. Select the Thumb
Nail option from the Oneline Options ribbon group on the Options ribbon tab to access the menu.

This quick menu contains the following default buttons, in order from top to bottom:










Show thumbnail on the screen
Thumbnail location on the screen
Size of Thumbnail View, as a percentage of the window size
Zoom out type (divide or zoom level)
Zoom out factor, defining the ratio of the diagram seen in the thumbnail relative to what is visible
in the diagram itself.
Enable/Disable Thumbnail View to follow mouse cursor
Enable/Disable Using the Same Background as the main window
Background Color, if not the same as the main window
Line width of the border around the thumbnail window
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Display Object Options
The Display Object Options page is found on the Oneline Display Options dialog. This page contains
options for formatting various display objects, displaying circuit breakers on loads, generators, and
switched shunts, and formatting circuit breakers for transmission branches.
General Options (All) Tab
Percent of Injection Group/Owner object height used by name
This option allows the user to specify the height of the name with respect to the rectangle of the
injection group graphical objects.
Display Circuit Breakers in Generators, Loads and Switched Shunts
Uncheck this box to hide circuit breakers from appearing in generators, loads, and switched shunts.
If this option is checked, the user can use Display breakers on… to select individually what
elements can display circuit breakers.
These options dictate only if circuit breakers will be shown on elements that are closed, i.e. Status =
Closed for the individual element. Circuit breakers will always be shown for devices that are open,
i.e. Status = Open for the individual element. This is useful in identifying possible data errors
especially for cases where breakers are explicitly modeled. In these cases, the explicitly modeled
breakers are used to open and close generators, loads, and switched shunts rather than changing
the Status of the device. An open circuit breaker symbol at the individual elements would then
indicate that the Status of the device needs to be set to Closed.
Transformer Symbol
This option allows the selection of Coils or Circles to represent a transformer. This option allows a
different specification of how transformers should be displayed for each individual oneline diagram.
There is also an option that is applied by default for all onelines. Use the Default selection to use the
setting found with the Simulator Options: Oneline options.
Display Rotors in Generators
Uncheck this box to hide the rotors of the generators.
The shape of the rotor can be changed by using the Rotor Shape option found with the generator
display options on the generator dialog in Edit mode or the Shape option found on the Display/Size
tab of the Format Multiple Objects dialog.
Change in Gen Rotor Angle per Refresh (degrees)
This value specifies the change in the rotor angle every time the animated flows refresh. This means
that the greater the angle value, the faster the rotor will seem to rotate when the oneline is
animated. Entering a negative number will cause the rotor to spin counter-clockwise.
Show Field Inside Generator
Fields can be shown inside generator objects. Select a field from the drop-down box or use the Find
button to search through the list of fields available for a generator. Set the field to No Field to not
display any field inside generator objects. Set the Digits and Decimals for floating point fields.
Adjust the Relative Font Size to change the size of the font relative to the generator object size.
To ensure that the field fits entirely inside each generator object, check the option to Dynamically
decrease the font size so that the field fits inside the generator.
Multi-Section Line Display Objects
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Intermediate Bus Rotation Angle
Normally, the intermediate buses are perpendicular to the line. The value entered here can rotate
the intermediate bus with respect to the original position. Therefore, a value of 0 degrees, will
keep the intermediate buses perpendicular to the line, while a value of 90 degrees will set the
intermediate buses aligned to the line.
Intermediate Bus Relative Size
This option is actually a multiplier for the size of the intermediate buses specified for each multisection display object.
Bus Field Voltage Option
This option allows the user to specify in which units the bus fields with Bus Voltage as type of field
will be displayed. This setting is only valid when the type of field selected is Bus Voltage in the Bus
Field Information dialog. Choosing a voltage field in the Select Field will return the voltage value in
the specific units of the field.
Circuit Breakers Tab
Circuit Breaker Display Objects > Normally Closed
This section is used to specify the colors for all the circuit breakers normally closed in the oneline
diagram. The colors that can be modified are the border and fill colors for presently closed and open
circuit breakers. In order to change a color, click on the color box or on the Change button. Check
Use Fill to use the specified fill color.
Circuit Breaker Display Objects > Normally Open
This section is used to specify the colors for all the circuit breakers normally open in the oneline
diagram. The colors that can be modified are the border and fill colors for presently closed and open
circuit breakers. In order to change a color, click on the color box or on the Change button. Check
Use Fill to use the specified fill color.
Shape
Specify the shape of circuit breakers on transmission lines and transformers. The breakers shown on
loads, generators, and switched shunts will always be the default rectangle shape.
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Substation Display Options
The Substations tab of the Oneline Display Options dialog provides parameters for customizing the
appearance of Substation display objects. This tab is only available if the case contains at least one
substation.
The upper right-hand corner of the Substation page displays a template of the substation object’s
appearance in terms of locations or "zones" where information can be displayed on the object. The
rest of the page can be used to describe the appearance of the object and the information that
appears in the substation objects.
Upper % of Height
This percentage indicates how much of the object is populated by the "upper" zone of the object.
This includes the Upper Field, Upper Left (UL) and Upper Right (UR). As you decrease this
percentage, the upper zone will get smaller, increasing the Identifer (middle) zone automatically,
and vice-versa if you increase the percentage of the upper zone.
Identifier % of Height
This is the percentage of the height of the substation object that is occupied by the identifier or
"middle" zone. This is the substation identifier section of the object.
Lower % of Height
This is the percentage of the substation object that is occupied by the "lower" zone of the object.
This includes the Lower Field, Lower Left (LL) and Lower Right (LR). Unlike the previous two
percentages, this percentage cannot be directly modified. Instead, it is automatically determined
based on the settings of the Upper and Identifier percentages.
Left % of Width
This percentage indicates how much of the object is populated by the "left" zone of the object. This
includes the Upper Left (UL) and Lower Left (LL). As you decrease this percentage, the left zone will
get smaller, increasing the Identifier (middle) zone automatically, and vice-versa of you increase the
percentage of the left zone.
Identifier % of Width
This is the percentage of the width of the substation object that is occupied by the identifier or
"middle" zone. This is the substation identifier section of the object.
Right % of Width
This percentage indicates how much of the object is populated by the "right" zone of the object.
This includes the Upper RIght (UR) and Lower Right (LR). As you decrease this percentage, the right
zone will get smaller, increasing the Identifier (middle) zone automatically, and vice-versa of you
increase the percentage of the right zone.
Buffer Percent
The buffer width for the height settings provide a buffer zone of the percentage width specified
horizontally between the Identifier section and the upper / lower field sections. Similarly, the buffer
width for the left and right width fields indicates a percentage buffer vertically between the upper /
lower field zones and the four corner zones.
Substation Identifier
Choose how the identifier will be displayed for the substation. Choose to display by name, by
number, or by combinations of name and number. The identifier will be displayed in the Identifier or
"middle" zone of the substation object.
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Shape
Select the shape used for substations that are not overriding the Substation Layout Settings.
What should be done when identifier text does not fit inside the width
As the name of this option suggest, you can choose how the text in the identifier section of the
object should be modified if resizing of the substation object causes the text to be too large for the
modified size.
Extra Substation Fields
These four fields, two of which are represented as the Upper Field and Lower Field on the template,
can be customized to display any substation field of your choosing. Use the drop-down arrow of the
appropriate box to choose a field, or use the Find button to pull up a list of fields to choose from.
Once the field has been chosen, set the digits and number of decimal places for the field. Also check
Units? to show the units if the extra fields.
Upper-Left Symbol (UL)
Choose what symbol to display in the upper-left zone of the substation object. You can choose from
None, Switched Shunt, Generator, Number of Buses, and Load. If the substation contains at least
one type of the chosen object, a symbol representing that type of object will be displayed in the
Upper-Left location of the object to indicate such a presence. By default, the Upper-Left zone will
display the Generator symbol.
Upper-Right Symbol (UR)
Choose what symbol to display in the upper-right zone of the substation object. You can choose
from None, Switched Shunt, Generator, Number of Buses, and Load. If the substation contains at
least one type of the chosen object, a symbol representing that type of object will be displayed in
the Upper-Right location of the object to indicate such a presence. By default, the Upper-Right zone
will display the Load symbol.
Lower Left Symbol (LL)
Choose what symbol to display in the lower-left zone of the substation object. You can choose from
None, Switched Shunt, Generator, Number of Buses, and Load. If the substation contains at least
one type of the chosen object, a symbol representing that type of object will be displayed in the
Lower-Left location of the object to indicate such a presence. By default, the Lower-Left zone will
display the number of buses in the substation.
Lower-Right Symbol (LR)
Choose what symbol to display in the lower-right zone of the substation object. You can choose from
None, Switched Shunt, Generator, Number of Buses, and Load. If the substation contains at least
one type of the chosen object, a symbol representing that type of object will be displayed in the
Lower-Right location of the object to indicate such a presence. By default, the Lower-Right zone will
display the Switched Shunt symbol.
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Oneline Animation
An important feature of PowerWorld Simulator is its support of animated onelines. The use of efficient
display algorithms allow animation rates that are typically greater than several times per second, even
on large cases and on onelines with a significant number of objects. The extensive use of animation
makes the display "come alive" so that system conditions can be ascertained more easily.
In Simulator, animation is started from Run Mode by selecting the Play button in the Power Flow
Tools ribbon group on the Tools ribbon tab. In Viewer, animation is started automatically when you
load a case.
The animation can be controlled and customized from the Animated Flows Tab of the Oneline Display
Options dialog. To access this dialog, select Oneline Display Options from the Oneline Options
ribbon group on the Options ribbon tab, or right-click on an empty area of the oneline diagram and
select Oneline Display Options from the resulting local menu.
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Copying Onelines to Other Programs
The onelines can be easily copied to other programs. This allows you to add PowerWorld onelines to
your word processor documents or slide presentations. The simplest way to copy a oneline diagram to
another program is to use the Windows Clipboard. This is accomplished as follows:





In Simulator or Viewer, zoom and/or pan the display to the portion of the oneline diagram you
would like to copy.
Right-click on an empty portion of the oneline to display the local menu.
Select Copy Image to Clipboard menu item. This places a copy of the oneline into the Window's
clipboard.
In the other program, use Paste or Paste Special to copy the contents of the clipboard into that
program. The oneline is pasted into the program using the Metafile format.

In addition, oneline diagrams can also be saved as image files by right-clicking on an empty portion of
the diagram and choosing Export Image to File.
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Display Explorer
The Display Objects case information display presents data describing each graphical object in the
oneline diagram. This display functions in the exact same manner as the Model Explorer and is thus
called the Display Explorer instead. The Display Explorer contains Case Information Displays and
therefore can be used in a manner consistent with all other case information displays. It has a case
information toolbar from which you can print, copy, and modify its records as well as view the
information dialog of its associated power system object if it has any. You can also sort the object
records by clicking on the heading of the field by which you want to sort. Additionally, when Simulator
is in Edit Mode, the toolbar Records menu allows you to remove existing objects from the oneline
diagram.
To show the Display Objects case information display, go to the Onelines ribbon tab, then on the
Active ribbon group select List Display > All Display Objects.
As mentioned above, the Display Explorer functions identically to the Model Explorer. The only
differences in functionality are due to additional options found on the bottom left of the dialog. This
offers the following additional features.
Show Only Objects Selected
By checking this box, only the selected display objects currently selected in the oneline diagram will
be shown.
How to List Grouped Objects
This specifies how to list grouped objects if there are any in the oneline diagram. The choices are to
list individually the components of the group, to list only the groups, or to list both the individual
elements and the groups. If there are not grouped objects in the oneline diagram, this control is
disabled.
Save Complete Display to AXD
By clicking this button, all the objects that are shown in the case information display will be saved to
a display auxiliary file.
By default, the display object records case information display contains the following fields:
Type
The type of display object.
X/Longitude Location, Y/Latitude Location
The x and y coordinates of the object’s location.
Layer Name
The layer name to which the display object is assigned.
Layer Shown, Selectable in Edit Mode, Low Zoom Level, High Zoom Level
These fields only display information about the layer to which the display object belongs. Therefore,
the values for these fields can only be modified through the Screen Layer case information dialog or
the Screen Layer dialog.
Anchored
This field indicates whether or not the display object is an anchored object. If the display object can
not be an anchored object, then the field is empty.
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Font Size
For text objects, this field shows the font size.
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List Unlinked Display Objects
An unlinked object is a display object not linked to a record in the power system model (model object).
The existence of unlinked display objects on a oneline diagram can be misleading because they have
zero flows and zero bus voltages associated with them. See Object Relationships for more information.
Go to the Onelines ribbon tab, then on the Active ribbon group choose List Display > Unlinked
Display Objects from the main menu in Edit Mode to identify unlinked objects.

Unlinked Display Objects Dialog
Total Number of Unlinked Display Objects
Indicates the total number of unlinked objects on the display. Ideally, this number should be zero. If
nonzero, the unlinked objects are identified in the table by type, screen location, and zoom range
over which the object is visible.
Delete Unlinked Objects
Click on this button to permanently remove all unlinked objects from the display. Exercise this option
carefully. Generally, you will want to do this either when you have substantially modified a power
flow case, such as by creating an equivalent, or when you are using the oneline with a new power
system case.
View Options for Highlighting Unlinked Objects on the Oneline
Click on this button will open the Grid/Highlight Unlinked Objects tab of the Oneline Display Options
Dialog.
Type, X/Y Location
The remainder of the display shows the type, location, identification, layer, applicable zoom level,
anchored property, and font size for each unlinked object. This table is a type of Case Information
Display and thus behaves similarly to all other case information displays. Right-click on a record in
this table to invoke the local menu. Select Pan to Object on Open Onelines to locate and select
the unlinked object on the oneline diagram.
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All Display Objects
This display works in the exact same manner as the Model Explorer and is thus called the Display
Explorer instead. This show all of the Display Objects information.
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Supplemental Data
Supplemental Data can be used to identify display objects that do not represent power system
elements. User defined data types can be created and linked to display objects for use in filtering,
dynamic formatting, Select by Criteria, and custom hints.
Supplemental Classification Definition
A Supplemental Classification is used to group Supplemental Data records into categories. As an
example, if using Supplemental Data records to identify geographical borders, a Supplemental
Classification could be Country. Each Supplemental Data record uses exactly one Supplemental
Classification record.
Supplemental Classification records are defined by one key field:
Name
This field uniquely identifies the classification and cannot be blank.
Supplemental Data Definition
Supplemental data records are defined by two required key fields:
Classification
This is the Supplemental Classification Name. This field cannot be blank.
Name
This is a unique identifier used to further define the Classification. If using supplemental data
records to identify geographical borders, the Name could be United States to go with a
Classification of Country. This field cannot be blank.
In addition to the Classification and Name, geographic information, expressions, and custom strings,
integers, and floating point values can be assigned to supplemental data records. This information
can be entered in the Supplemental Data Case Information Display discussed below.
Displaying Supplemental Data Records
Supplemental Data records are displayed in the Supplemental Data Case Information Display found
on the Model Explorer under Case Information and Auxiliary > Supplemental Data. This
display consists of two tabs, Supplemental Classification and Supplemental Data. The table on
the Supplemental Classification tab lists all of the Classifications that have been defined. The table
on the Supplemental Data tab lists all of the Supplemental Data records that have been defined and
provides the means for creating new Supplemental Data records AND Supplemental Classification
records. Supplemental Classification records cannot be created under the Supplemental Classification
tab.
Creating Supplemental Data Records
To create a new Supplemental Data record, from the Supplemental Data tab, right-click on the
table and choose Insert from the local menu. The Define Supplemental Data dialog will open.
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Either select an existing Classification from the drop-down box or create a new Classification by
clicking New. (If creating a new Classification,another dialog box will open with a prompt for the
Classification Name.) Type in a Name for the record. To create the record and close the dialog click
OK. To create the record without closing the dialog click Save.To exit the dialog without creating
the record click Cancel.
Linking Display Objects to Supplemental Data
Display objects that cannot be linked to a power system element can be linked to a Supplemental
Data record. These display objects include Background Line, Background Rectangle, Background
Ellipse, Background Picture, Text, Case Information Memo, Oneline Field, Oneline Link, Document
Link, Memo Text, and Generic Model Field.
Linking any of these objects to supplemental data must be done through the Display Explorer
found under Onelines > All Display Objects. From the Explore tab, choose the display object
type to link. If they are not already displayed, the Supplemental Data Classification and
Supplemental Data Name fields must be added to the list of fields in the table. Simply enter the
appropriate Classification and Name in the fields to link a particular display object to a Supplemental
Data record.
Once a display object is linked to a supplemental data record, the information in the supplemental
data record can be used to filter, dynamically format, Select by Criteria, and display custom hints for
that display object.
Because there is no requirement to link display objects that cannot be linked to power system
elements to supplemental data records, these objects will not be highlighted along with other
unlinked elements when they are not linked to a supplemental data record.
Automatic Linking of Supplemental Data When Inserting Geographic Information
Background objects (lines and ellipses) created from inserting objects from borders included with
Simulator and shapefiles can be linked automatically to supplemental data records.
When auto inserting borders included with Simulator, the option to Automatically link county
and state borders to supplemental data needs to be checked for this to occur.
When inserting background objects from shapefiles, there are several options that need to be set for
proper linking to supplemental data. These options are available on the Identify tab of the GIS
Shapefile Data Dialog.
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Movie Maker
Simulator no longer contains a built-in movie maker tool. Instead, PowerWorld Corporation
recommends other movie making tools that can be used from outside of Simulator. Please refer to the
PowerWorld website at www.powerworld.com/support/videocapture.asp for references to these third
party movie tools.
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Map Projections
Background on Map Projections
In order to create a map of a spherical object such as the Earth it is first necessary to convert the
Earth coordinates of latitude and longitude into a two-dimensional coordinate system needed for a
map. This conversion from the spherical coordinates of latitude and longitude to some xy Cartesian
coordinate system is called a map projection. Mapmakers and mathematicians throughout history
have invented many map projections. For each map, the mapmaker must decide which projection
will look best for his or her purposes. This will depend on what part of the globe is being drawn, the
size of the area being drawn, and the shape of the object being drawn. In general, map projections
fall into three standard classes: cylindrical, conical, and planar. For a complete analysis of the topic
of map projections see reference 1.
For maps of North America, PowerWorld supports a Simple Conic map projection which is described
below.
For maps of the entire Earth, PowerWorld supports a Mercator projection which is described below.
Simple Equidistant Conic Map Projection
For maps made of the 48 conterminous states in the United States, maps are often made using one
of the conical map projections. These projections can be recognized by the constant latitude lines
that are seen as arcs. When looking at the U.S./Canadian border in the western United States, you
will see that it curves on maps made using a conical projection, even though this is a constant
latitude border. Several conical projections exist including the Albers Equal-Area Projection, Lambert
Conformal Projection, and Simple Equidistant Projection. They can be visualized as taking the globe
and placing a cone over it as shown in Figure 1 and then using this to map the coordinates to the xy
plane shown at the right. Constant longitude lines are seen as straight lines and constant latitude
lines are seen as arcs on the resulting map.

The equations for converting back and forth between (longitude,latitude) and (x,y) using the simple
equidistant projection are described next. These equations are taken from reference 1.
First, you must specify seven values that are parameters of the mapping:
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For these values, the following variables are defined:

Then given a latitude = ϕ and a longitude = λ, calculate the x and y coordinate using

And given an x and y coordinate, calculate the latitude(ϕ) and longitude(λ) using

Figure 2 shows more clearly what some of these variables are.
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Maps made using PowerWorld's built-in map borders for North America use the following
parameters:

These numbers were thus set to be the default map projection numbers within PowerWorld. This
projection will work well for the one-line diagrams with PowerWorld Corporation has created on the
same standard background.
Mercator Projection Use in PowerWorld
For the Mercator Projection, PowerWorld assumes R = 30700.0 units. From this, given a latitude = ϕ
and a longitude = λ, calculate the x and y coordinate using

And given an x and y coordinate, we calculate the latitude(ϕ) and longitude(λ) using
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Great Circle Distance Dialog
To find the Great Circle Distance between any two points of longitude, latitude, select GIS Tools >
Great Circle Distance from the Active ribbon group on the Onelines ribbon tab and the Great Circle
Distance Dialog will be displayed. This can be done in Edit or Run Mode.
The Great Circle Distance Dialog allows the calculation of distance between two points of longitude,
latitude. The Great Circle Distance Calculation assumes that the earth is a sphere and makes no
adjustments for the actual flattening of the earth. The two longitude, latitude points can either be
entered manually for any two valid points or can be chosen from valid longitude, latitude values stored
with either buses or substations. Valid longitude values are between -180 and 180 degrees. Valid
latitude values are between -90 and 90 degrees. The calculated distance is given in either kilometers
or miles.
From Location
Click the Choose From Location button to choose either the location of a bus or substation as the
From Location. The Latitude (degrees) and Longitude (degrees) entries for the From
Location will be filled in with the latitude, longitude information that is stored with the chosen
element in the case data. These entries are not based on the location of a display object, if one
exists, of the chosen element. If the element does not have valid geographic information stored, the
values that are entered for the latitude, longitude will not be valid.
The Latitude, Longitude entries can also be entered manually.
To Location
Click the Choose To Location button to choose either the location of a bus or substation as the To
Location. The Latitude (degrees) and Longitude (degrees) entries for the To Location will be
filled in with the latitude, longitude information that is stored with the chosen element in the case
data. These entries are not based on the location of a display object, if one exists, of the chosen
element. If the element does not have valid geographic information stored, the values that are
entered for the latitude, longitude will not be valid.
The Latitude, Longitude entries can also be entered manually.
Units
Choose the units in which to report the calculated distance.
Calculate Distance
Click this button to calculate the distance in the chosen Units between the From Location and the
To Location. The calculated distance will appear in the box above the button. Error in input data will
be returned if there is a problem with any of the latitude, longitude information.
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Great Circle Distance Calculation
The Great Circle Distance Calculation allows the calculation of distance between two points of
longitude, latitude. The Great Circle Distance Calculation assumes that the earth is a sphere and
makes no adjustments for the actual flattening of the earth.
The calculation consists of the following parameters:

The distance in kilometers between the starting and ending location is determined from the following
equation:

This calculation is used with several GIS tools to determine the distance between two locations or
facilities on a diagram.
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Populate Lon,Lat with Display X,Y
To populate the longitude,latitude fields of buses and substations with the locations of corresponding
display objects converted to longitude,latitude using the selected projection, go to the Onelines ribbon
tab, then on the Active ribbon group choose GIS Tools > Populate Lon,Lat with Display X,Y.
The Populate Lon,Lat with Display X,Y Dialog will be displayed. This can be done in either Edit or Run
Mode. The dialog will show which map projection is currently in use for the oneline. Users should be
careful to not change the map projection once one has been established so that all objects on the
oneline are consistently using the same projection. If no projection has been set, the dialog shows
None (x,y) as the Map Projection, selecting a map projection will establish that map projection as the
current oneline map projection.
Map Projection
None (x,y)
No map projection is in use.
North American (simple conic)
This projection is better when dealing with longitude, latitude points in North America. This is
the projection that has been used in Simulator for years in defining geographic borders and
placing then on a oneline.
Entire World (Mercator)
This projection is better when dealing with longitude, latitude points spread throughout the
world.
Click Populate Longitude,Latitude to complete the conversion. The longitude, latitude values
converted from display x, y coordinates can be viewed on the bus and substation case information
displays or the information dialogs.
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Geography/Coordinates
The option is available to display screen coordinates in longitude, latitude instead of x,y. This option
can be set by selecting Oneline Display Options from the Onelines ribbon tab or the Options ribbon
tab. The following options are located under the Geography/Coordinates category.
Map Projection in Use
The map projection indicates which projection has been selected for inserting objects on the oneline.
Users should be careful to not change a projection once one has been established. Otherwise, there
is the risk that different objects will be inserted with different projections.
Show longitude, latitude coordinates when showing x, y coordinates
When this option is checked and a map projection other than None (x,y) is selected, longitude,
latitude coordinates will be displayed anywhere that x,y screen coordinates are normally displayed.
This option will only be enabled when a map projection other than None (x,y) has been selected.
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Shape File Import
Simulator allows you to import ESRI shapefiles (*.shp/*.dbf pairs) as a group of background lines or
points on a oneline diagram. There are several locations where you may open the GIS Shapefile
Import Dialog.




Go to the Onelines ribbon tab, then on the Active ribbon group choose GIS Tools > Insert GIS
Data from Shapefile.
Go to the Draw ribbon tab, then on the Individual Insert ribbon group choose Background >
Insert GIS Data from Shapefile
Go to the Draw ribbon tab, then on the Quick Insert ribbon group choose Auto Insert > Insert
GIS Data from Shapefile

The GIS Shapefile Data Dialog has the following sections:
Control
Modify
Identify
Format
Shape List
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GIS Shapefile Data: Control
This is the first page of the GIS Shapefile Data dialog. The control page contains the controls for
reading a shapefile into Simulator and provides some basic information on the shapes read from the
file.
Read in Shapefile
Pressing this button will allow you to choose a shapefile and will load it into Simulator for placement
on the currently selected oneline diagram.
Save Shapefile
Clicking this button will save to file the shapefile information currently loaded in memory. This option
is useful if making changes to shape format attributes or eliminating certain shapes from those read
in and then saving these changes in the shapefile format.
Shapefile Information
Once the shapefile has been loaded into memory, this section will be populated with general
information on the number of shapes loaded, and the maximum and minimum X and Y values
(usually in longitude and latitude.)
Transfer Shapefile Objects to Oneline
If you are ready to place the shapes on the oneline diagram, but want to continue working with
existing shapes or read more shapes from another file, press the Transfer Shapes to Oneline and
Clear button. This will keep the dialog open following the transfer. It also gives you options of what
should happen to the current shapes in memory after you have transferred them to the diagram.
You can choose to clear only the shapes that were transferred, all of the shapes, or none of the
shapes. The first choice relates to options you have on the Shapefile Objects page regarding
whether or not to transfer certain shapes from the shapefile to the diagram.
Insert Into Layer
Before transferring the shapes to the oneline diagram, you can choose which layer the shapes
should be assigned to. If you wish to place the shapes into a new undefined layer, click on the
Define Layer button to access the Screen Layers table.
Transfer Shapes to Oneline and Close
If you wish to transfer the currently loaded shapes to the oneline and close the dialog (clearing the
shapes from memory), press this button to complete the process.
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GIS Shapefile Data: Identify
After using the Control page to read in shapes from a shapefile but before placing them on the
diagram, identification options can be specified on the Identify page.
Identification String for Display Auxiliary Files
Shapefile shapes are created as background objects when added to a diagram. If using display
auxiliary files to create or edit diagrams, objects must be uniquely identified. Because background
objects typically do not link to an object in the power flow case, and therefore have no other unique
means of identification, a unique ID string must be assigned to objects created via shapefiles. This
unique identifier populates the Auxiliary ID field used in display auxiliary files and can be viewed
from the Display Explorer.
Prefix
Optionally, a prefix can be concatenated with the selected Attribute to further identify the shape.
Attribute
The drop-down box is populated with the fields that are available with the .dbf file. Choose a
field whose value will be used to uniquely identify the shape. By default, the Record Number of
the shape is used for identification if no other Attribute is selected.
Suffix
Optionally, a suffix can be concatenated with the selected Attribute to further identify the shape.
Linkage to Supplemental Data
Background objects created from shapefiles can be linked to Supplemental Data records for
purposes of further identifying the objects. This is useful when applying filters, applying dynamic
formatting, using Select By Criteria, or defining custom hints with display objects created from
shapefiles.
Link Display Objects to Supplemental Data
Check this box to link the background objects created from shapefile shapes to Supplemental
Data records.
Supplemental Classification
Select an existing Supplemental Classification from the drop-down box or click New to create a
new Supplemental Classification.
Attribute for Supplemental Data Name
Select an Attribute from the drop-down box. The list of attributes is populated from the fields
that are available in the .dbf file. For each unique Attribute value, a supplemental data record will
be created with the chosen Supplemental Classification and with its Name set to the Attribute
value.
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GIS Shapefile Data: Modify
After using the Control page to read in shapes from a shapefile but before placing them on the
diagram, the Modify page can be used to modify the XY attributes of the shapes.
Map Projection
There are two map projections you can choose from when placing the shapes onto a oneline
diagram. The choices are:



North American (simple conic)
Entire World (Mercator)

Once you have selected which projection to use, click on the Convert to Specified Map
Projection button to process the conversion on the shapes currently in memory.
Shift/Scale Shapefile X/Y Data
You also have the option to shift the XY coordinates of shapes or scale them by scalar values. To
shift shapes, enter scalar shift values for the X value and Y value and press the Shift XY Data
button. To scale the XY coordinates, enter scalar scaling factors for the X and Y value, and press the
Scale XY Data button.
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GIS Shapefile Data: Format
After using the Control page to read in shapes from a shapefile but before placing them on the
diagram, the Format page can be used to modify the appearance attributes of the shapes.
Change Shape Format Characteristics
Point Size
The size of points read from the shapefile can be adjusted when transferred to the oneline
diagram.
Line/Border Thickness
Choose the pixel thickness of the shapefile lines when transferred to the oneline diagram.
Line/Border Color
Set the line color of the shapefile lines when transferred to the oneline diagram.
Fill Color for Points/Polygons
Set the fill color of the shapefile points and polygons when transferred to the oneline diagram.
The box labeled Use Fill Color must be checked as well.
Stack Level
Indicate which stack level should be applied to the shapes when they are transferred to the
oneline diagram.
Immobile
Check this box if you wish for the shape file objects to be immobile once they are transferred to
the oneline diagram. This will prevent you from inadvertently selecting and moving the shapefile
objects on the oneline diagram while in Edit mode.
Set all shape format attributes to the values above
Once you have finished changing the format settings for the shapes, press this button to apply
them for the transfer of shapes to the oneline diagram.
Automatic Color Mapping
Available Attributes
To customize the shapefile shapes based on a field value read from the .dbf file, select an
attribute from the list.
Color Map
Select a color map to apply to the selected attribute. To modify existing or create new color
maps, click on the Modify Color Maps button. The color of the object will then be based on
where its selected attribute value maps to the selected color map.
Change Border Color, Change Fill Color
These two boxes allow you to choose if the color map selected should apply to the border color,
the fill color, or both.
Change Color Based on Attribute/Color Map
Once you have finished setting the color map for a selected attribute, press this button to apply
the settings before the transfer of shapes to the oneline diagram.
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GIS Shapefile Data: Shape List
After using the Control page to read in shapes from a shapefile but before placing them on the
diagram, the Shape List page can be used to flag shapes for inclusion in the transfer and customize
the appearance attributes of specific shapes.
This page will be blank until you have actually read a shapefile into memory. Once you have done so,
you will see a list of all shapes read from the file. The table allows you to customize the appearance
and attributes of a specific shape, similar to the options on the Format page.
In addition, you also can choose to include or exclude shapes from the transfer to the oneline
diagram. This gives you the greatest flexibility for hand-picking which shapes you want to add to a
oneline diagram.
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Shapefile Database Record Dialog
The Shapefile Database Record dialog is available by selecting Show Shapefile Fields… from the
local popup menu (obtained by right-clicking on a display object) of any display object that was
created from a shapefile. This menu option will not be available for display objects that were not
created from a shapefile. This dialog provides information read from the database file (.dbf) associated
with the shapefile from which the display object was created. Each time that this dialog is displayed,
the database file is read to fill in the field information. The field information is not stored in the
PowerWorld display file (.pwd) so the associated database file must be available for this information to
be displayed.
File Name
This is the path and name of the database file (.dbf) associated with the shapefile from which the
display object was created.
Record Number
This is the record number of the display object within the shapefile.
List of Fields
This list details the fields and values belonging to the given record number in the database file.
Edit Oneline Browsing Path
Select this option to update the Oneline Browsing Path. This browsing path will be used to search all
listed directories for the database file specified in File Name if it cannot be found in the directory
specified with the File Name.

864
©2011 PowerWorld Corporation

Export Oneline As Shapefile
Display objects can be exported into shapefile formats (.shp/.dbf pairs) by going to the Onelines
ribbon tab, then in the Active ribbon group, choosing GIS Tools > Export Oneline as Shapefile.
This will open the Select Objects and Fields to Export Dialog, which is similar to the Select by Criteria
Dialog.
The dialog is used to select one type of display object to export to the shapefile and the criteria used
to select which specific objects will be included in the export.
Selecting Areas and Zones
Use the Area and Zone fields to select the areas and zones in which to select display objects.
Ranges of area and zone numbers can be entered in the usual way, or the All Areas or All Zone
boxes can be checked to select all areas and all zones respectively. The Areas and Zones tab pages
can also be used to select the areas and zones in which to select display objects.
Selecting Voltage Levels
Specify the max and min voltage levels using the boxes that are provided, keeping in mind that all
voltages are in kV. The All Voltages box can be checked to include all voltages without requiring
the specification of a voltage range.
Selecting Layers
All layers can be selected by choosing the All option for Layers. If specific layers are to be selected,
the Range option should be selected and the Layers tab should be used to check and uncheck
specific layers in which to select display objects.
Type of Drawing Object
Select the type of object to export in the Type of Drawing Object dropdown box. Alternatively,
the Find… button next to the dropdown can be used to select the object type from a list of
available object types.
Filter
The Filter dropdown box provides a list of filters available for the selected Type of Drawing Object.
The Find… button next to this dropdown can be used to find a filter or define a new filter for the
selected object type. Filter options will not be enabled when an object type that does not allow
filtering is selected.
Selecting Fields
The Fields list will be populated for object types that have associated fields. The selected fields will
be written to the database file (.dbf) along with the value of the field. When the Specified option is
selected, individual fields can be chosen by checking the box next to specific fields. When the All
option is selected, then all fields associated with the selected type of object will be included in the
database file. When the Show Only Commonly Used Fields option is checked, only those fields
that are deemed to be commonly used will be displayed in the list. To show all fields associated with
the selected object type, uncheck this box. Use the Check All and Uncheck All buttons to check all
or uncheck all of the fields.
Advanced Selection Criteria
If only objects that are currently visible on the display (due to layering, etc.) are to be selected,
check the box labeled Select only currently visible objects. If some display objects have been
selected prior to opening the dialog, an advanced selection option becomes available. If the box
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labeled Use as a filter on presently selected objects is checked, the criteria chosen in the
dialog will only affect the previously selected objects. In other words, only the objects that were
previously selected AND that match the chosen criteria will remain selected when exporting to the
shapefile.
Export Coordinates in Longitude,Latitude
If a valid map projection has been selected for displaying display object coordinates in
longitude,latitude, then the option to Export coordinates in longitude,latitude will be enabled.
(A valid map projection can be set with the Map Projection in Use Option found in the
Geography/Coordinates category of the Oneline Display Options dialog.) By default, the Export
coordinates in longitude,latitude option will be checked when it is enabled. When checked, the
coordinates of the display objects will be exported to the shapefile in longitude,latitude instead of
PowerWorld Simulator x,y coordinates.
Saving Shapefile Export Descriptions
Shapefile Export Description settings can be saved with the case by clicking Save As to save with a
new name or Save to save with the current name. This will allow the quick recovery of settings that
may have been previously used. Use the Rename button to rename an already saved set or the
Delete button to remove a previously saved set of criteria. If Shapefile Export Description sets have
been saved, they can be exported to an auxiliary file by choosing Save to AUX file. The Load
from AUX file button will load an entire auxiliary file regardless of whether it contains Shapefile
Export Descriptions or not.
Saving the Shapefile
After all criteria have been set, click OK. A dialog will open prompting for the name of the file to
save. Enter a file name and click Save. The type of file that is specified in the dialog is a shapefile
with .shp extension, however, three files will be saved. All files will have the name specified in the
save dialog, but the extensions will be .shp, .dbf, and .shx.
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Insert Measure Line
Distances between display objects can be approximated by inserting a measure line on the display. A
measure line is similar to a background line. It can be drawn as a straight line between two points or
as a line with many vertices and segments. By default, a measure line is drawn as a yellow line with a
pixel thickness of 4.
To insert a measure line go to the Onelines ribbon tab, then on the Active ribbon group choose GIS
Tools > Insert Measure Line. Then position the mouse cursor on the display where the line should
begin and click and release the left mouse button. Move the mouse to the desired termination point of
the first line segment. A straight segment will follow the mouse movements. Click and release the left
mouse button to complete the line segment and to prepare for drawing the next segment, or doubleclick if this is the last line segment. To draw a freehand shape rather than a series of straight line
segments, click and hold the left mouse button where the freehand shape begins and drag the mouse
to trace the desired shape (while holding the left mouse button down). Release the left mouse button
to complete the section of the freehand shape. At this point, either another freehand section or a
straight line segment can be added. When all desired freehand and straight line segments have been
added, double-click the left mouse button to complete the line.
To change the shape of the line, first left click on the line to select it. Handles will appear at each
vertex. A vertex can be moved by holding the left mouse button down and dragging the vertex to a
new location. To remove a vertex, hold down the CTRL key and then click the vertex you would like to
delete. To add a vertex, hold down the CTRL key and then click on the line where the new vertex
should be added. Note that freehand lines are nothing more than a continuous series of vertices.
Once the measure line has been added to the display, the length of the line can be displayed by rightclicking on the line and selecting Measure Length… from the local menu. The units of the length are
dependent on the map projection in use and whether the option to Show longitude,latitude
coordinates when showing x,y coordinates is checked on the Oneline Display Options dialog. If
the map projection in use is something other than x,y and the option to show longitude,latitude
coordinates is checked, the length will be given in miles and kilometers. Otherwise, the length will be
given in Simulator units. The Great Circle Distance calculation is used to determine the distance
between vertices on the line to determine the approximate length in miles and kilometers.
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Delete All Measure Lines
All measure lines can be deleted from the display. To do this go to the Onelines ribbon tab, then on
the Active ribbon group choose GIS Tools > Delete All Measure Lines.
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Path Distances from Bus or Group
To access the Determine Path Distances from Bus or Group dialog go to the Tools ribbon tab, and
choose Connections > Determine Path Distances to Bus from the Other Tools ribbon group.
The Determine Path Distances from Bus or Group dialog provides a way to calculate how far
electrically every bus in the system is from a particular starting point.
After clicking the Calculate button, all buses that are part of the start element will be labeled
internally as being a path distance zero. Then a calculation will be done that determines for each bus
in the system the shortest total path length in getting from each bus to the Start Element. Buses that
cannot reach the Start Element will be flagged with a very large distance (by default 10,000). The
results of the calculation will then be copied into the Bus Field specified under the Bus Field to
Populate option. The results will be displayed in a case information display at the bottom of the dialog.
The options on the dialog are described below.
Start Element Type and Element
Choose an element type to be either a Bus, Substation, Area, Zone, Super Area or Injection Group.
Then use the object chooser to choose the particular object to be the starting element. For more
help on the object choose see the Find Dialog Basics.
Distance Measure
Choose the distance measure that will be used to determine distances between nodes. Each branch
will be treated as having a length based on the choice below. Note: negative values are not allowed,
therefore negative values will be treated as extremely small lengths instead.
X - Per unit series reactance.
|Z| - Magnitude of the series impedance (based on the per unit reactance and resistance).
Length - Length field for each branch.
Number of Nodes - Length of 1.0 is used for all branches.
Other - When choosing Other, click the Find.. button to choose any numeric field of a
branch.Lines to Process
Lines to Process
Regardless of the Distance Measure above, you can choose which branches allowed to be traversed
when finding the shortest path.
All - All branches are allowed to be traversed.
Only Closed - Only branches that are presently closed can be traversed.
Filter - Only branches that meet the advanced filter specified can be traversed. Click Define...
to choose or create and advanced filter.
Selected - Only branches whose Selected? field is set to YES can be traversed.Bus Field to
Populate
Bus Field to Populate
Choose a field into which the resulting path distances will be copied. It is recommended that you use
the custom floating point or integer fields for this purpose.
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Closet Facilities to Point
To produce a list of display objects and their distance from a point selected on the one-line diagram,
go to the Onelines ribbon tab, then on the Active ribbon group choose GIS Tools > Closest
Facilities to Point. After selecting this option, the mouse cursor will become a crosshair. Move the
cursor to a location on the diagram and left-click. A dialog will open listing all of the display objects
and their distance from the selected point in ascending distance from the point.
Select to Show Display Objects of Type
This allows the option of showing all display objects in one list or only listing objects of a particular
type.
Distance
This field is listed by default with the display objects. This shows the distance between a given
display object and the selected point. The location of the selected point is given by the
X/Longitude and Y/Latitude fields on the dialog. The location of a given object is provided by the
X/Longitude Location and Y/Latitude Location fields with the display object. The units of the
distance is given in the Units field on the dialog.
X/Longitude and Y/Latitude
Each display object listed has a corresponding X/Longitude Location and Y/Latitude Location
field. The X/Longitude and Y/Latitude fields given on the dialog provide the location of the point
that was selected on the diagram. The fields on the dialog can also be manually adjusted to
determine the distance between the display objects and a given coordinate.
All of the fields that give the location of either the display object or the point selected on the
diagram are given in x,y coordinates if a valid map projection is not selected or the option to show
coordinates in longitude, latitude is not selected. Otherwise, the coordinates will be longitude,
latitude. Both of these options can be set from the Oneline Display Options dialog in the
Geography/Coordinates category.
Units
This indicates the units that the distance is in. The units will be in PowerWorld units if a valid map
projection is not selected or the option to show coordinates in longitude, latitude is not selected.
Otherwise, the units will be in either miles or kilometers. To display the distance in miles, the option
to use the English Measurement System must be selected on the PowerWorld Simulator Options
dialog under the Environment category. Select Metric (SI) as the Measurement System to display
the distance in kilometers.
Recalculate Distances
Click this button to recalculate distances after changing the coordinates of the selected point by
entering new values for the X/Longitude or Y/Latitude fields.
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Oneline Screen Coordinates
Onelines can be any size and can contain any number of objects. The size and position of objects on
the screen are specified in terms of x-y "oneline screen coordinates." When the zoom level is 100%
the size of the oneline in screen coordinates is 100 by 100. More generally, the size of the oneline is
1002 divided by the zoom level in both the x and y directions.
The default screen center is the point (50,50) but this can be easily changed (See Oneline Panning and
Zooming.) Negative screen coordinates are allowed. Usually you will not have to be concerned about
an object's location in screen coordinates.
The Status Bar displays the current cursor screen coordinates while in Edit Mode.

Status Bar Showing Screen Coordinates
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Oneline Zooming and Panning
All oneline diagrams permit zooming and panning. Zooming and panning are very important tools for
building and investigating large oneline diagrams that occupy more than a single screen of viewing
area. Moreover, the display of various objects can be set to depend on the zoom level. See Oneline
Conditional Display of Objects for more information on this feature.
The following mechanisms are provided for zooming or panning a oneline:
Line Navigation Arrows
For transmission lines whose end-points are not visible at the present pan/zoom level, small Line
Navigation Arrows will appear where the line exits the present window. If you click on these arrows,
the oneline will automatically pan over to the other end of the transmission line. The oneline will
zoom out as it moves away from the present position and zoom back in until it finishes at the same
zoom level with the endpoint in the middle of the oneline. On the Oneline Tab of the Simulator
Options dialog you can control three attributes for these arrows
1.
2.
3.

The size in pixels (default is 9)
How fast the program pan/zooms to the new location in seconds. (Making this shorter gets you
there faster, but you lose some of the overview information of where you're going as you pan to
the new location.)
Whether to show hints as you move the mouse over the arrows.

Zooming on Onelines
Zooming involves adjusting the oneline diagram's display area by changing the magnification of the
view. Zoom in on a oneline to have the screen display less of the complete oneline diagram, and
zoom out on a oneline to have the screen display more of the complete oneline diagram.
To zoom on a oneline diagram using the keyboard, follow these instructions:







Use CTRL-up arrow to zoom in
Use CTRL-page up to zoom in quickly
Use CTRL-down arrow to zoom out
Use CTRL-page down to zoom out quickly
The Zoom ribbon group offers additional zooming options:
Use the Zoom in on Area button of the Zoom ribbon group to select a region on which to
zoom.
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Use the Show Full button of the Zoom ribbon group to zoom the display out to show the
entire oneline.
Use the Find button of the Zoom ribbon group to display the Pan/Zoom Dialog.
Use the Save View button of the Active ribbon group to display the Save View Dialog, or click
on the drop down arrow on the Save View button to choose from a list of saved views.
Use the Rectangular Zoom Selector to select a section of the diagram to zoom into using a
selection box. After clicking button (symbolized with a magnifying glass over a dashed
rectangle,) left click and hold the mouse button down on the diagram, drag the mouse to select
part of the diagram inside a box, then release the mouse button. Simulator will zoom into the
region selected inside the box.

Panning on onelines
Panning moves the screen's focus point around the oneline diagram. You can pan left, right, up, or
down to view different portions of the complete oneline diagram.
To pan around the oneline using the keyboard, follow these instructions:







Use the arrow keys to move in the desired direction
Use page up to move up quickly
Use page down to move down quickly
Use the Home key to move left quickly
Use the End key to move right quickly
Left-click and hold the mouse button down anywhere on the background of the diagram. Make
sure you do not click on an object on the diagram. While holding the left mouse button down,
drag the mouse in any direction to "drag" the diagram in that direction.

You can also use the Pan/Zoom Dialog to pan to a specific location, or even to a specific bus. You
can display the Pan/Zoom Dialog either by pressing the Find button on the Zoom ribbon group of
the Onelines ribbon tab or by selectingPan/Zoom Control from the oneline diagram's local menu.
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Save View Level Dialog
The Save View Level Dialog is used to save an (x,y) location and zoom level, contour description,
and/or hidden layer application for a oneline diagram in an easily accessible list for quick recall and
application to the diagram. This dialog can be called by selecting the Save/Edit/Delete View option
from the oneline local menu.
You can also define a new layer by going to the Onelines ribbon tab, then on the Active ribbon group
choose Save View > Save View.
Recalling a saved view can be done by either right-clicking on the background to access the oneline
local menu and choosing a view from the Go To View list, or by clicking on the drop down arrow on
the Save View button and selecting a view from the resulting list. Selecting a saved view
automatically moves the oneline diagram location to the (x,y) coordinates and zoom level, applies a
stored contour, and/or applies hidden layers stored with the selected view.
This dialog can be used for creating a new view, editing an existing view, or deleting an existing view.
The Save View Level Dialog has the following options:
View Name
This is the name that the view will be stored under in the saved view list. This must be a unique
name for each view saved with the oneline diagram. By default this field is blank. To edit an existing
view, choose the desired view from the drop down list.
Save Display Information in View
When checked, the view will store an x-y coordinate and zoom level to associate with the view.
When the view is selected for display, the diagram will center on the x-y coordinate at the defined
zoom level.
X-Coordinate
The x-coordinate for the view. This value will default to the current x-coordinate for the oneline
diagram, or will change to a saved value if a saved view is chosen from the View Name drop down
list. This value can be modified by the user.
Y-Coordinate
The y-coordinate for the view. This value will default to the current y-coordinate for the oneline
diagram, or will change to a saved value if a saved view is chosen from the View Name drop down
list. This value can be modified by the user.
Zoom Level
The zoom level for the view. This value will default to the current zoom level for the oneline
diagram, or will change to a saved value if a saved view is chosen from the View Name drop down
list. This value can be modified by the user.
Save Contour Information in View
If a contour is being displayed when the view is created, you can choose to save the contour
information with the view by checking this box. Saving a contour with a view will display that
contour when you switch to that view. You also have the option of saving a blank contour with the
view. This is indicated by a Contour Object of ‘None’ and a Contour Field of ‘None.’ If you save a
blank contour, no contour will be displayed when switching to that view. If you don’t save any
contour with the view, then any existing contour will be applied when switching to that view.
Contour Object

874
©2011 PowerWorld Corporation

This section displays the type of object the stored contour pertains to. This field cannot be changed
from this location.
Contour Field
Displays the type of value the stored contour pertains to. This field cannot be changed from this
location.
Link to Oneline Display Options Settings
In the Oneline Display Options in Simulator, you can save various sets of options with a case for
quickly recalling oneline diagram settings by name. This option allows you to include a custom
defined option set by name with the current view. Note that you first must have created and saved a
custom set of options for a diagram from the Oneline Display Options dialog before this option on
the Save Views dialog will be enabled.
Save Hidden Layers
Since Simulator allows the use of layers to display or hide objects on the diagram, views also can
optionally store the layer settings when the view is created. The window below this checkbox will list
the layers that are presently hidden on the diagram. When this view is recalled, the layers in this list
will be hidden if they were stored with the view.
Save
This button will save a new view or modify the values for an existing view of the name in the View
Name field.
Delete
This button will delete the currently open view from the saved view list. The dialog information will
default to the saved view information of the previous view in the list.
OK
This button will save a new view or modify the values of an existing view of the name in the View
Name field, and will close the Save View Level Dialog.
Save to AXD
By clicking this button, all the views will be saved to a display auxiliary file.
Load from AXD
This button will load all the views saved in a display auxiliary file.
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Window Ribbon Tab
The Window ribbon consists of buttons and menus that provide access to customizing the windows in
the user interface. It also provides access to help topics and topics regarding the Auxiliary File Format.
The ribbon is shown below.

The Case Information ribbon is broken into four ribbon groups
Mode Ribbon Group
Edit Mode
Switches the program to Edit Mode, which can be used to build a new case or to modify an
existing one.
Run Mode
Switches the program to Run Mode, which can be used to perform a single Power Flow
Solution or a timed simulation with animation.
Window Ribbon Group
Open Windows Menu
The Open Windows Menu provides a convenient method of switching between open windows.
This includes User Interface Dialogs, Case Information Displays, and Oneline diagrams.

Switch to Free-Floating Windows (Switch to Standard Container Window)
Choosing this option toggles the program from between two different window environment
1. All diagrams and dialogs are contained within the Simulator program shell
2. All diagrams and dialogs are free-floating on your monitor.
For more information see the Window Basics.
Reset to Defaults
The program keeps track of dialog Free-Floating/Contained Style, Size, and Position. Clicking
this button will reset all these to the factory default settings. Nearly all dialogs in will then be
reset back to Contained with a default size and position as well. For more information on
Style, Size and Position, see Window Basics.
Refresh Displays
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Redraws (refreshes) each of the open windows. Simulator usually automatically refreshes the
open windows as necessary. However, this action allows you to trigger the refresh when you
want it.
Ribbon Settings Menu
This menu contains options for customizing your ribbon.

Ribbon Colors : You can change the color scheme to either Blue, Silver or Black
Legacy Menus : Choose to Hide or Show a special Menus ribbon tab. The Menus ribbon tab
mimics the menu and toolbar structure that existed in older versions of Simulator.
Arrange Windows
The options under Arrange Windows are Tile Horizontally, Tile Vertically, and Cascade. Tile
rearranges the open oneline diagrams such that the total window area is divided equally
among all of them and each is completely visible. Cascade Rearrange all open windows such
that all they appear on top of each other while leaving the title bars visible.
Toggle Full Screen
Toggle full screen makes the currently selected diagram window switch to full screen mode.
Full screen mode will dedicate the screen to the window, with all other windows, including the
Simulator menus and toolbars, to be hidden. To get back to normal mode, right-click on the
diagram in full screen mode and select Toggle Full Screen from the popup menu.
Help Ribbon Group
Contents
Opens the Simulator Options Dialog.
Set Help File
Opens the Case Description Dialog.
About
Click this to open the About dialog. The About dialog contains information about the software
as well as showing you the Build Date of your version of Simulator. PowerWorld release patch
version of Simulator on our website. These patch versions are named by date and is shown
on the About dialog.
There is also an option on the About dialog to Change License Key. This allows selection of a
new license key file. Add ons are controlled through the license key. If you are using different
versions of Simulator with different add ons, this option provides the mechanism for switching
between the different versions of Simulator. You will need a different license key file if you
are using different licenses for Simulator that have different add ons.
PowerWorld Website
Click this to open your default web browser to the PowerWorld Corporation Website.
Check for Updates
This button will open the PowerWorld website to the patch download page. You will be
required to enter your Account Username and Product ID (password) to check for and
download patches for your version of Simulator.
Auxiliary File Ribbon Group
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Load Auxiliary
Choose this option to load an Auxiliary File.
Load Display Auxiliary File
Choose this option to load a Display Auxiliary File to append to the active oneline.
Auxiliary File Format
Opens the Bus View Oneline which provides a graphical display which allows you to quickly
browse information about a bus and everything connect to that bus.
Export Display Object Fields Menu
Export Case Object Fields Menu
Choose these options to export a list of fields for each type of object in a case (or a Oneline
Display). The list also indicates which fields are key fields and required fields for each object.
You can output this list of fields as either a text file or into Excel.
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Oneline Conditional Display of Objects
Along with supporting zooming and panning, the onelines permit the conditional display of objects.
That is, it is possible to specify display objects so they are visible only at particular zooming ranges.
This enables the oneline to show additional details as the user zooms in and fewer details when the
user zooms out.
Please note that the zoom levels are defined as percentages. If you want an object to display only
between 50% and 150%, you must select 50 and 150 as the zoom level boundaries.
This option is available by assigning objects on the diagram to a Layer. Layers can be defined and set
to objects on the Format Multiple Objects dialog.
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Keyboard Short Cut Actions Dialog
The Keyboard Short Cut Actions dialog allows the user to associate a keyboard shortcut to a
determined oneline diagram, and even to a particular view of that diagram. When the keyboard
shortcut is pressed, the oneline diagram is opened (if it was closed) and brought to the front. When a
view is also associated, then the user is taken to such a view.
To open the Keyboard Short Cut Actions Dialog, select Keyboard Shortcuts on the General
Options ribbon group of the Options ribbon tab. These General Options are also available on the
Oneline ribbon tab.
The dialog has the following controls:
Keyboard Shortcuts
Lists all the keyboard shortcuts. When selecting a keyboard shortcut, it will show the oneline and the
view associated to the selected keyboard shortcut. If your keyboard has an extra row of function
keys, then you can check the box labeled Include F13-F24. If a shortcut has been defined for the
respective key, then it will be highlighted and a string will summarize the action of the shortcut
Clear All
Clicking this button will delete all the associations of all the listed shortcuts.
Save Shortcut
Click this button after entering a oneline diagram and eventually a view so they can be associated
with the selected keyboard shortcut.
Delete Shortcut
Click this button to delete the associations of the selected keyboard shortcut with any oneline
diagram and view.
Create Shortcut
This indicates the keyboard shortcut to which the below actions will be assigned. The available
actions are to Open a Oneline and to Open an Auxiliary File
Open Oneline
The following options are available for opening oneline actions:
Oneline and View: Oneline
Shows the path and the name of the oneline diagram which will be opened when the selected
keyboard shortcut is pressed. If the field is blank, then no oneline diagram is associated to the
keyboard shortcut. You can click Browse to find the oneline diagram.
Oneline and View: View
Shows the name of the view belonging to the associated oneline diagram to which the user will
be taken when the selected keyboard shortcut is pressed. If the field is blank, then no view is
associated to the keyboard shortcut.
Action for already open onelines
If the oneline being requested by the shortcut key is already open, then this option determines
what should be done. Choices are to close the oneline, bring the oneline to the front, or to open
a new oneline.
Where to open oneline
When opening a oneline via a shortcut key, you may do one of the following:
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Separate Window (open the oneline as normal)
Separate Window – Toggle Full Screen (open normal and then toggle it to full screen)
Embed the Active Oneline Window (opens the oneline and embeds it inside the presently
active oneline diagram)

Note: if onelines already exist which have been toggled to full screen, and a short cut key is used
to open a window that will not be toggled to full screen, then all other onelines present open will
be switched to normal mode instead of full screen mode.
Size and Location
This specifies the relative size and location you would like the oneline to be opened at. When
opening the oneline normally, the percentage is relative to the size of the container window.
When opening the oneline embedded in the active oneline, the percentage is relative to the size
of the active oneline.
Make embedded oneline borderless
When embedding the oneline inside the presently active oneline, this option will make the
embedded oneline borderless.
Open Auxiliary File
The following options are available for opening auxiliary file action:
Filename
Shows the path and the name of the auxiliary file which will be opened when the selected
keyboard shortcut is pressed. If the field is blank, then no auxiliary file is associated to the
keyboard shortcut. You can click Browse to find the auxiliary file.
Section name
Shows the name of the script or data section belonging to the associated auxiliary file which will
be executed when the selected keyboard shortcut is pressed. If the field is blank, then no specific
section is associated to the keyboard shortcut, so all script and data sections will be loaded.
Create objects if they do not already exist
Check this box to indicate that new objects in the auxiliary file should automatically be created.
Save/Load shortcuts to/from an Auxiliary File
Click the Save button to save all the shortcuts to an auxiliary file. Click the Load button to load the
shortcuts saved in an auxiliary file. The shortcuts saved in the auxiliary file will replace the shortcuts
saved in the dialog.
Close
Closes this dialog.
In addition to the shortcuts displayed on this dialog, Simulator also offers standard windows editing
shortcuts such as:
Ctrl + x – Cut Command
Ctrl + c – Copy Command
Ctrl + v – Paste Command
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Printing Oneline Diagrams
To print a oneline diagram, select Print Oneline from the Application Button or right-click on the
oneline background and select Print Window from the popup menu. This opens the Print Options
Dialog, which you can use to configure the print job, including its size, orientation, border, and title
bar. You can even choose to print a oneline to multiple pages using Simulator's multi-page printing.
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Print Options Dialog
The Print Options Dialog is used to configure the printing of oneline diagrams (including bus view
displays) and of strip charts. To print a oneline diagram, select Print Oneline from the Application
Button. To print a strip chart, right-click on it to invoke its local menu, and then select Print Window.
In both cases, Simulator will open the Print Options Dialog.
The Print Options Dialog has three tabs:
Page Layout
This tab sheet contains options for how the diagram will appear on the printed page. It presents the
following controls:
Margins
Specify the horizontal and vertical margins in either inches or centimeters.
Scaling
Set this option to Proportional to print the oneline diagram or strip chart such that the screen’s
aspect ratio is maintained. Set this option to Fit to Page to force the printout to take up all
available space on the page in both horizontal and vertical directions.
Draw Border
Places a border to be drawn around the oneline diagram or strip chart.
The second tab controls the printing of a title bar. Check the Print Title Bar box to print a title bar
at the bottom of the diagram. Checking this box displays a number of options that allow you to
specify various items to include in the title bar. If you don’t want to include certain items on the plot,
simply leave those fields blank.
The title bar is split horizontally into three sections. If you specify values for all requested items,
they will be arranged in the title bar as follows:
Company | Description Line 1 | Date
Department | Description Line 2 | Drawing #
Author | Description Line 3 | Title
Multi-Page
This tab allows the oneline diagram to be "divided" into a specified number of sections for printing the
oneline to several pages. A multi-page oneline can be useful for including "close-up" views of areas of
a diagram in a report, or the multiple pages can be cut and combined to form a larger printed oneline
if a plotter is not available. The Multi-Page tab presents the following controls:
Grid Size
Choose this value to subdivide the oneline into an N by N grid. You can then choose which sections
of the oneline to print based on the grid overlay. The maximum size is 10 x 10.
Choosing What to Print
A low resolution picture of your oneline is shown on the Multi-Page tab. Gridlines are drawn over
the diagram to show where the oneline has been subdivided based on the Grid Size chosen.
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To remove a grid section from the printout, click on the oneline image in the corresponding section
of the grid (Please note that the grid size should be more than 1 to select a grid section). The
selected section of the grid will become dark to indicate you wish to prevent the section from
printing.
To add a grid section back into the print job, click on a darkened section of the grid to allow that
section of the oneline to be printed.
The number of pages you have chosen to print will be shown on the dialog. When printing out a
multi-page oneline with a title bar, the page number will appear on the title bar in the form "Column
Letter"-"Row Number". For example, if the Grid Size is 4, the pages are numbered A-1 through D-4.
Click Print to send the document to the printer, or Cancel to abort the print. Click Setup to view the
default Windows printer dialog, which will allow you to specify whether to print the figure in portrait or
landscape modes and to set various printer-specific properties.
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Printer Setup
Choose Printer Setup from the Application Button to configure the printer using the standard
Windows printer setup dialog. This dialog allows you to define which printer to use for printing from
Simulator, the size of the printed page, the page’s orientation, and additional properties that are
specific to the printer you are using.
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Contouring
Simulator can create and animate a contour map of various system quantities, such as voltage
magnitudes and angles, MW transactions, transmission loading, and real and reactive load. Such
displays resemble a contour map of temperatures like you might see shown on a weather forecast.
Contouring can significantly improve understanding of a large interconnected system, helping identify
congestion pockets and Mvar-deficient regions and providing an overview of how power flows through
the bulk power system.
The Contour Options Dialog controls Simulator’s contouring capabilities. To access it, click the right
mouse button on an empty area of the oneline and choose Contouring from the resulting local menu,
or choose Contouring from the Active ribbon group on the Onelines ribbon tab.
Contouring is available in both Run Mode and Edit Mode, however when you switch from Run Mode
back to Edit Mode, Simulator automatically removes the contour from the oneline diagrams. You can
still choose to reapply the contour while in edit mode however.
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Contouring Options
The Contour Options Dialog allows you to draw contour maps of many system quantities, such as bus
voltages or angles, transmission line and interface MVA loadings, and transmission line and interface
PTDFs.
To access this dialog, click the right mouse button on an empty area of the oneline and choose
Contouring from the resulting local menu, or choose Contouring > Contouring from the Active
ribbon group on the Onelines ribbon tab. The Contour Options Dialog has three tabs: the Contour
Type Tab, the Contour Type Options Tab, and the Custom Color Map Tab.
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Contour Type
Contour Type options can be set from the Contour Type tab on the Contour Options dialog.
Object
Simulator can contour several different values. To specify what Simulator should contour, first
choose the type of display object; the options are Bus, Line, Interface, Area, Generator, Substation,
Zone or Injection Group. Once the object is chosen, you must then choose the numerical value to be
contoured by specifying it in the Value dropdown box.
Note: to contour a value for a type of object, representations of that type of object must be present
on the oneline diagram. Choosing to contour an object type that is not represented on the diagram
will result in no contour being drawn on the diagram.
Value
Select the quantity to contour from the Value dropdown box or click the Find… button to find the
desired field (it is normally easier to use the Find button). See NOTE at the end of this help topic.
Filter Object Values
The name of the advanced filter that is currently applied to the contour. Click Define to create a new
Advanced Filter to use during contouring. Applying a filter means that only objects that meet the
filter will affect the contour image. Objects which do not meet the filter will be ignored.
Data Points per Line
This specifies the number of data points used to represent the graphical line. The contouring
algorithm is based on values at specific coordinates in the oneline space. When contouring
transmission line or interface objects, the line is represented by a series of points spaced equally
along the graphical line.
No Data Color
This setting allows you to choose the contour color used for parts of the contour for which there are
not objects nor data for the type of contour selected. The choices for No Data Color are Specific
Color, Color Map Percentage,Background Color, and Transparent. By default, Specific Color is
selected and set to white. If you wish to change the specific color to use, click on the color box to
the right and choose a different color from the popup dialog. If you select Color Map Percentage, the
Color Map % field will become enabled, and you can select a value from 0 to 100. The value you
enter will associate the No Data Color with the color located at that percentage in the selected color
map. If Background Color is chosen, the No Data Color will always be whatever color has been set
as the normal background color for the oneline diagram. Lastly, if Transparent is chosen, the parts
of the contour for which there are not objects nor data for the type of contour selected will be
transparent and any objects on the oneline diagram will be displayed as usual.
Draw Color Key
Checking this box will cause the contour to draw a color key showing which colors are mapped to
which values. You can also give the color key a title, unit label, and specify the number of digits to
display in numerical values.
Title
Title for the color key.
Entry Labels
Units of the contoured value displayed on the color key.
Dec. Pts.
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Number of decimal places of the contoured value displayed on the color key.
Scalar
Multiplication factor that can be applied to the values when drawing the color key. Normally this
value should be 1.0.
Use Equal Spacing For Discrete Maps
This option will draw the color key with equal spacing for all colors in the map, regardless of how
close or distant the values the colors represent. This option only applies to discrete color maps.
Color Map
Choose from various predefined color maps using the color map combo-box. A color map, along with
the values specified, defines how values are mapped to a color on the contour image.
If a color map showing both high and low values is desired (such as for bus voltages), use of "Blue
= Low, Red = High" is recommended. If a color map showing only high values is desired (such as
for line flows), use of "Weather Radar, Nominal to High" is recommended.
A user may also define additional color maps by going to the Custom Color Map Tab.
Reverse Color Map Colors
Check this check-box to reverse the colors of the selected color map, so the low color becomes the
high color, and vice versa.
Brightness
Modify the brightness track bar to change the brightness of the color map.
Use absolute value
Check this check-box to use the absolute values of the quantity selected at the Value dropdown box
(above).
Ignore Above Max
Check this check-box to completely ignore values above the maximum percentage. This means that
data which is larger than the Max % will not be used in calculating the contour image. This is similar
to using an Advanced Filter to Filter Object Values, but provides a quick way to do so.
Values
For all color maps that come with PowerWorld by default, the conversion of a value to a color is
done in two steps. The value is first interpolated to a percentage by using up to 5 user-specified
values (maximum, break high, nominal, break low and minimum) that correspond to specific
percentages (100%, 75%, 50%, 25%, and 0%). This percentage is then interpolated through the
color map and a color is determined.

User may define their own color maps which convert percentage to color, but they may also define
color maps which directly translate values into colors without the intermediate calculation of a
percent. For more information on this see the creation of a Custom Color Map.
The value range values are described as follows:
Maximum The largest value allowed in the contour. All values above this will be mapped to the
highest color. This value corresponds to 100% in the color map.
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Break High This value is used by some color maps to highlight a lower limit. This value corresponds
to 75% in the color map.
Nominal This value is the nominal value for the contour. Values around this will be mapped to the
middle color. This value corresponds to 50% in the color map.
Break Low This value is used by some color maps to highlight a lower limit. This value corresponds
to 25% in the color map.
Minimum The smallest value allowed in the contour. All values below this will be mapped to the
lowest color. This value corresponds to 0% in the color map.
Note: a representation of the color map is shown to the right of the values.
Ignore Below Min
Check this check-box to completely ignore values below the minimum percentage. This means that
data which is smaller than the Min % will not be used in calculating the contour image. This is
similar to using an Advanced Filter to Filter Object Values, but provides a quick way to do so.
Ignore Zero Values
Check this box to completely ignore zero values in the contour. This is similar to using an Advanced
Filter to Filter Object Values, but provides a quick way to do so. If there is a need to ignore values
that are almost but not exactly zero, then create an Advanced Filter to Filter Object Values.
Interpretation
This combo box specifies how to interpret the values of the data points. The options are:
Fixed Values The data point values are not modified. The maximum, minimum, nominal, and
break values are the ones entered directly in the units of the value being contoured. This is what
should normally be used.
Dynamic Values The data point values are not modified. However the maximum, minimum,
nominal, and break values are determined dynamically from the data point values as follows:
Maximum = Maximum data point value; Minimum = Minimum data point value; Nominal = Average
data point value; Break High = (Max + Average)/2; and Break Low = (Min + Average)/2.
Standard Deviations All the data point values will be used to determine a mean and standard
deviation. The data point values will then be converted to represent the number of standard
deviations they are from the mean. Thus a value equal to the mean will be changed to a 0, a value
1.5 standard deviations higher than the mean will be changed to 1.5, and so on.
Percentiles All the data point values will be sorted from lowest to highest. The value will then be
set equal to the 100 times the sort location divided by the number of data points. Thus the highest
value will be given a value of 100 and the lowest a value of 1.
Save Contour Image with Oneline
Checking this box will allow a displayed contour to be saved with a oneline diagram. If a contour is
saved with a oneline diagram, the next time the oneline diagram is opened the contour will
automatically be redrawn as well. The displayed contour is saved as a Bitmap image.
Continuously Update Contours
Normally contouring is only done on a snap shot of the power system state. However, you can also
set Simulator to automatically update the contour every time the display is redrawn. In this way, an
animation of the contour can be created. If you would like to create this animation, simply check the
Continuously Update Contours checkbox. Note, however, that this will slow down the animation of
the display, as the program must recalculate the contour at each step. If this slows down your
display too much, try lowering the contour resolution to speed it up.
Note Regarding Values
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Contours of most values create an image where the color around a data object is primarily related to
the value of only that object. Some values however create "density-like" contours, where the color is
related to the sum of the data object's values nearby. These include:







Bus / Load MW
Bus / Load Mvar
Bus / Load MVA
Bus / Cust Expr (Density)
Area / Pos Spin Reserve
Area / Neg Spin Reserve
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Contour Type Options
Object
Simulator can contour several different values. To specify what Simulator should contour, first
choose the type of display object; the options are Bus, Line, Interface, Area, Generator, Substation,
Zone or Injection Group. Once the object is chosen, you must then choose the numerical value to be
contoured by specifying it in the Value dropdown box.
If multi-section lines objects exist on the oneline diagram and the type of object to contour is Line,
the contour for the multi-section line object will reflect the series of AC lines that it represents. If the
type of object to contour is Bus, the locations of intermediate buses will be contoured.
Note: to contour a value for a type of object, representations of that type of object must be present
on the oneline diagram. Choosing to contour an object type that is not represented on the diagram
will result in no contour being drawn on the diagram.
Value
Select the quantity to contour from the Value dropdown box or click the Find… button to find the
desired field (it is normally easier to use the Find button). Note: see Contour Type for more
information.
Filter Object Values
The name of the advanced filter that is currently applied to the contour. Click Define to create a new
Advanced Filter to use during contouring. Applying a filter means that only objects that meet the
filter will affect the contour image. Objects which do not meet the filter will be ignored.
Influence Region
This track bar determines how far away each data point influences the contour image. A larger
influence region results in each data point influencing more of the contour at the expense of longer
screen refresh times.
Use Dynamic Influence Region
Dynamic influence distance determines how far out the contour should go when determining which
buses influence the contour value for a screen point. The actual distance is the minimum of either
1) a common value for all screen points that depends upon user parameters [e.g., the dynamic
region points value]), and now 2) the distance that includes the number of buses associated with
the dynamic influence field. The primary reason for this option is speed, particularly when zoomed
in on dense portions of the display. You should not see much impact on the contour itself.
Kind of Value
This option allows you to choose to contour based on the Actual Value or the Density Value. The
Actual Value uses the weighted average of the data for computing the contour. The Actual Value
method is most commonly used for contouring in Simulator. On occasion, the Density of Values
method does not work as well. One example is contouring generator MW values. If you have four
buses in close proximity, each with 100 MW of generation, and compare the contour with a single
bus with 400 MW of generation, the contour based on the weighted average will look drastically
different, despite the amount of generation being the same in each region. Using the Density Value
option will correct the disparity, and the contour around these two different groups of generation
would look basically the same.
Use Fade to Value
Checking this check box will allow to use the Fade to Value and Begin Fade Percentage options.
Fade to Value
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The value to which a data point's value fades as it moves away from its location.
Begin Fade Percentage
While moving away from a data point, the data point’s value decays towards the "Fade to" Value.
The Begin Fade Percentage specifies when the contour starts to fade as a percentage of the
largest distance for which this data point influences the contour.
Contour Resolution
This value determines the relative resolution of the contour. Increasing the contour resolution
increases the level of detail represented on the map but will lengthen screen refresh times. Reducing
the screen refresh time will yield less detail and shorter screen refresh times.
Low Resolution Display when Zooming or Panning
Do Low Resolution Speedup
Check this option to enable drawing contours in low resolution while zooming or panning. Low
resolution images are drawn much faster than high resolution images.
Low Resolution Normalized Percent
Set a percentage of resolution between 0.01 (1%) and 1 (100%). A smaller value translates to a
lower resolution image.
Time Delay in Seconds before Redrawing at Full Resolution
Set the number of seconds Simulator will pause before returning the contour to full resolution
following zooming and panning.
Minimum Resolution in Pixels for Low Resolution Displays
Specify the minimum resolution allowed (in pixels) when Simulator draws the low resolution
image.
Use GPU to accelerate contour calculation
As it describes, checking this option will use the GPU processor to perform contour calculations that
will accelerate computation time.
Use 32 bit texture format
As it describes, checking this option will use a 32 bit texture format for countours.
When Animating, Only Update Contour if Something Changed
As it describes, checking this option will suppress redrawing the contour during animation unless one
or more of the contoured values changes.
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Custom Color Map
Custom Color Maps can be defined from the Custom Color Map tab found on the Contour Options
dialog. Custom color maps allow you to define completely new color maps for create new color maps
from existing default color maps.
Color Map
Choose from various predefined color maps using the color map combo-box. A color map, along with
the values specified, defines how values are mapped to a color on the contour image.
If a color map showing both high and low values is desired (such as for bus voltages), use of "Blue
= Low, Red = High" is recommended. If a color map showing only high values is desired (such as
for line flows), use of "Weather Radar, Nominal to High" is recommended.
Reverse Color Map Colors
This check-box reverse the mapping of the color map, converting the colors corresponding to the
high values into the colors for the low values, and vice-versa.
Brightness
Modify the brightness track bar to change the brightness of the color map.
Make Discrete Color Map
Check this check-box to make a discrete color map, that is without having smooth transitions
between colors.
Contour Type Values to Use
These check-boxes signify which values from the Contour Type Values Tab are used by the Color
Map. There must be at least two contour type values checked.
Color Grid
The color grid on the right side of this page allows you to change the colors for each percentage
breakpoint. In addition, you can add or delete breakpoints as well.
To change the color for a specific breakpoint, simply left-click on the color for the breakpoint you
want to change. The Color dialog will open, and you can choose a new color for that breakpoint.
Setting the Transparent field to YES will make the contour transparent for data values that meet the
specified percentage breakpoint. Setting the Transparent field to NO will show the data values with
the specified color. To change a value in the Transparent field, left-click on the value and it will
toggle between YES and NO.
To add a breakpoint, right-click on a breakpoint position above or below where you would like the
new breakpoint inserted. A popup menu will open, and you can select Add Above or Add Below,
depending on where you wish the new breakpoint to be. Simulator will insert the breakpoint, and
will automatically set the color and percentage at the midpoint between the two breakpoints above
and below the inserted breakpoint. You can then click on the color to change it, or click on the
percentage to type in a new value. The new percentage value should be between the values of the
adjacent breakpoints.
To delete a breakpoint, right-click on the breakpoint you wish to delete, and choose Delete from the
popup menu.
Color By…
This option allows the user to interpret the breakpoints values as percentage values or as direct
values.
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For all color maps that come with PowerWorld by default, the conversion of a value to a color is
done in two steps. The value is first interpolated to a percentage by using up to 5 user-specified
values (maximum, break high, nominal, break low and minimum) that correspond to specific
percentages (100%, 75%, 50%, 25%, and 0%). This percentage is then interpolated through the
color map and a color is determined.

Color maps which directly translate values into colors without the intermediate calculation of a
percent may also be created. This is done by setting Color By to Value.
Save As…
To save the present color map as a new color map, click this button. Then specify a name for the
new color map.
Save
To save changes that have been made to the present color map, click this button.
Rename
To rename the present color map, click this button.
Delete
To delete the present color map, click this button.
Store Color Maps in File
To store all custom color maps in a file for loading into another case, click this button. If you have
saved any custom color maps with the current case, you will be prompted to choose a file name and
location for saving the custom color maps. Color Maps are saved in the Auxiliary File Format.
Load Color Maps from File
If you have created custom color maps in a different case and saved them to a file, you can click
this button to load those color maps into your current case. Color Maps are loaded in the Auxiliary
File Format.
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Functional Description of Contour Options
Functional Description of the Contour Options
The previous help topics discussed basic contour options in the order they are arranged on the dialog.
The dialog is arranged so that the most important options are on the first tab and other on the
Contour Type Options tab. This help topic discusses the options in a manner which better describes
how the contour is actually created. A contour is calculated generally by a five-step process

1.
2.
3.
4.
5.

Build a list of all possible data points (graphical locations)
Remove items that meet criteria from the list of data points
Assign a value to each data point
Calculate "virtual values" on a grid of points
Convert each "virtual values" into a color to create the contour image

Step 1: Build a list of data points (graphical locations)
The following options determine a list of potential data points (could also be called graphical
locations) which will be used to calculate the contour image.
Object - Simulator can contour several different values. To specify what Simulator should contour,
first choose the type of object. This corresponds to the type of display object that is drawn on the
oneline diagram. For instance if you want to contour a substation value, then you must have
substations drawn on your diagram. This selection narrows the set of quantities that can be
contoured, which is specified in the Value dropdown box.
Data points Per Line - The contouring algorithm for lines is no different than for points, except
that each line is represented by several points. For objects which are represented by graphical lines,
this option will specify the number of data point which should be used to represent the line.
Step 2: Remove items that meet criteria from the list of data points
After a complete list of potential data points is made, there are then several options for filtering out
things from this list which you do not want to effect the calculation of the contour image.
Filter - If you wish for the contour to be limited to only certain devices that meet specific criteria,
click on this button to define an Advanced Filter for the contour
Ignore Above Max - Check this check-box to completely ignore values above the maximum
percentage. This means that data which is larger than the Max % will not be used in calculating the
contour image
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Ignore Above Min - Check this check-box to completely ignore values below the minimum
percentage. This means that data which is smaller than the Min % will not be used in calculating the
contour image
Ignore Zero Values - Check this check-box to completely ignore values that are zero.
Step 3: Assign a value to each data point
After Step 2, a list of potential data points has been created and a value must now be assigned to
each data point. The following options specify how this is done.
Value - select the quantity to contour from the Value dropdown box or click the Find Value button to
find the desired field.
Use absolute value - This check-box will modify the Value specified so that it uses the absolute
value.
Interpretation – When interpretation is set to either Standard Deviations or Percentiles, then the
value of the data point will be modified.
If Standard Deviations is chosen, then all the data point values will be used to determine a
mean and standard deviation. The data point values will then be converted to represent the
number of standard deviations they are from the mean. Thus a value equal to the mean will be
changed to a 0, a value 1.5 standard deviations higher than the mean will be changed to 1.5,
and so on. Similar,
If Percentiles is chosen, then all the data point values will be sorted from lowest to highest.
The value will then be set equal to the 100 times the sort location divided by the number of data
points. Thus the highest value will be given a value of 100 and the lowest a value of 1.
Step 4. Calculate "virtual values" on a grid of points
After Step 3, we now have a list of data points and a value assigned to each data point. We now
must create a grid of points that represents "virtual values" throughout the entire graphical space.
The values on this grid will be calculated based on the data point values
Contour Resolution - setting determine the size of the grid of points which will be superimposed
on the present oneline diagram. The higher the resolution the more number of grid points will be
used to represent the contour (and thus make the calculation of the contour image slower)
Influence Region - each data point value will effect only the grid locations that are "near" it. The
distance that is considered "near" is determined by the Influence Region. Setting the influence
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region higher will result in each data point effecting a larger portion of the contour image (and thus
making the calculation of the contour image slower)
Kind of Value - The calculation of the virtual value at a particular grid point is done by first building
a list of data points that are within the "influence distance" of the grid point. The Kind of Value
setting determines what process is used to calculate the virtual value from this list of values.
Actual Value (Weighted Average) - The virtual value is calculated as the weighted average
value, weighted by the distance from the grid point. This means that virtual value half-way
between two data points will be the average of the two data point values.
Density of Values (Weighted Sum) - The virtual value is calculated as the sum of value that
within the influence region. This means that virtual value half-way between two data points will
be the sum of the two data point values.
Actual Value (Only Closest) - The virtual value is assigned as the value of the closest data
point.

Fade to Value and Begin Fade Percentage - In the middle of a contour image the colors look
consistent because the virtual values are calculated using a good number of data points which
surround it. Sometimes at the edge of a contour image however, the colors can become skewed
because there are very few data points influencing it. Using a fade to value can help this situation,
but will skew the entire contour image in general instead. Without using the fade to value, the raw
data point values will be used when calculating virtual value.
When using the fade to value, while moving away from a data point, the data point’s value decays
towards the "Fade to" Value. The Begin Fade Percentage specifies when the contour starts to fade
as a percentage of the largest distance for which this data point influences the contour.
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Step 5. Convert each "virtual values" into a color to create the contour image
After Step 4, a grid of virtual values has been calculated. At this point, must specify how these
numbers map to colors. This done through the user of a Color Map.
Color Map - Choose from various predefined color maps using the color map combo-box. A color
map, along with the values specified, defines how values are mapped to a color on the contour
image. A user may also define additional color maps by going to the Custom Color Map Tab.
Brightness - this value is used to brighten or darken the colors specified in the color map.
Values - These values along with the color map define how to convert your values into a color for
the contour. The values are:
Maximum - The largest value allowed in the contour. All values above this will be mapped to
the highest color. This value corresponds to 100% in the color map.
Break High - This value is used by some color maps to highlight a lower limit. This value
corresponds to 75% in the color map.
Nominal - This value is the nominal value for the contour. Values around this will be mapped to
the middle color. This value corresponds to 50% in the color map.
Break Low - This value is used by some color maps to highlight a lower limit. This value
corresponds to 25% in the color map.
Minimum - The smallest value allowed in the contour. All values below this will be mapped to
the lowest color. This value corresponds to 0% in the color map.
Interpretation - Most frequently this option will be set to Fixed Values meaning values for
maximum, break high, etc… are entered directly in the units of the value being contoured. If
Interpretation is set to Standard Deviations or Percentiles then as mentioned earlier the values
mean something different. The options Dynamic Values will process this list of data point values
and automatically set the values as follows: Maximum = Maximum data point value; Minimum =
Minimum data point value; Nominal = Average data point value; Break High = (Max + Average)/2;
and Break Low = (Min + Average)/2.
No Data Color - It is likely that some the grid points will not be within the influence of any of the
data points. The color of these points is determined by no data color setting.
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Dynamic Formatting Overview
The Dynamic Formatting dialog will allow the specification of how a graphical object will be rendered
depending on the power system object that is representing. The graphical object refers to objects in
the oneline diagram, in bus and substation views, as well as to some parameters of the case
information displays.
The case and the one-line diagrams will have each a list of Dynamic Formatting settings. The Dynamic
Formatting settings defined in the case are always applied to bus and substation views, and optionally
they can be applied to the case information displays. The one line diagrams will use its own settings,
but optionally can use the general settings defined with the case.
In general, the oneline dynamic formatting settings have a higher priority, followed by the case
dynamic formatting settings, and this can't be reversed. Also, inside each of the list of dynamic
formatting settings, a priority can be specified, so that objects can be rendered according to the
settings with the highest priority.
In the case of the oneline diagrams, the dynamic formatting settings will only be applied during Run
Mode. However, these settings can be modified at any time, without regard for the mode.
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Dynamic Formatting Dialog
The Dynamic Formatting dialog for the active oneline can be accessed by:



Selecting Dynamic Formatting >
Active Oneline on the General Options ribbon group of
the Options ribbon tab. These General Options are also available on the Oneline ribbon tab.
Selecting Dynamic Formatting (Active Oneline) from the oneline local menu, or

The Dynamic Formatting dialog for the general case information displays, bus and substation views,
and for all onelines can be accessed by:



Selecting Dynamic Formatting >
Case Info / All Views And Onelines on the General
Options ribbon group of the Options ribbon tab. These General Options are also available on the
Oneline ribbon tab.
Selecting Dynamic Formatting (All Views) from the bus view local menu or the substation
view local menu, or

This dialog presents the following options:
Set Format Priority
It is possible to have multiple dynamic format definitions created and stored with a case and/or
active oneline diagram. This option allows you to set a format priority order for all of the dynamic
format definitions, so that any diagram objects that meet more than one dynamic filter will use the
settings of the dynamic filter with the highest set priority.
Allow Oneline to use dynamic formatting defined with case
This option will only be available when the dynamic formatting settings correspond to an active
oneline. It indicates whether or not the oneline diagram will use the dynamic formatting definitions
specified in the case.
Object Type
The type of power system object with graphical representation, such as a bus, a load, a generator,
etc.
Filter Criteria
The filter that applies to the object type defined. The Dynamic Formatting settings will apply to the
graphical object only if the corresponding power system object meets the specified filter. If the
criteria box is empty, the Dynamic Formatting settings will assume that all the objects of the
specified type meet the criteria.
Formatting Active
If this option is unchecked, the dynamic formatting definition will be ignored when the objects are
rendered. Otherwise, it will be applied if there are graphical objects whose characteristics match the
rest of the characteristics defined in this dialog.
Force visibility
When this option is checked, the objects will be displayed (assuming the dynamic formatting applies
to them) independently of the visibility of the layer to which such objects belong, and with no
regards of the low and high zoom levels.
Show Lookup Tables
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Checking this box will display the Use Lookup options with the characteristic settings. The Use
Lookup option with certain field characteristics allow you to define a table of different field values
and corresponding characteristic values. If you check Show Lookup tables, and then check the Use
Lookup field next to one of the characteristics, you will open the Lookup definition table. This table
allows you to select a field for the Object Type you have selected. This field is the field that you
define values for in the left column of the lookup table. To insert entries in the lookup table, rightclick in the table grid and choose Insert from the popup menu. This will place a default record in the
table. Modify the Field Value that Simulator should look for in the table, and a corresponding
Characteristic Value that should be used for the field value given. For example, you could use a
lookup table with Line Thickness for transmission line objects, where the thickness of the line would
vary based on the amount of flow on the line. Different thicknesses could be assigned to different
levels of flow using a lookup table.
Context
In the Context Objects, the user will specify what specific type of graphical objects the dynamic
formatting will apply to. This list view will be populated with the Case Information Display object (if
the dynamic formatting definitions set correspond to the general case), plus the several graphical
objects related to the Object Type. (For buses, for example, it will include the graphical bus, the bus
fields, and the bus gauge).
Fields
In the Fields list view, the user will be able to select which fields the dynamic formatting settings will
apply to. This view will be populated only for those context objects with fields, such as the Case
Information Display and the Object Fields. This list is only visible when you choose certain types of
context objects in the context objects list.
Show Only Commonly Used Fields
If this option is checked, only a reduced list of selected fields will be displayed. Otherwise, all the
fields belonging to the object will be shown.
Characteristics
The characteristics that the user will be allowed to modify dynamically. These include line thickness,
style, color, and background color; font name, size, color, and style; highlight color; surround shape,
color and thickness; color and magnification of the ‘X’ on top of the objects; and blinking color and
interval.
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Difference Flows
The Difference Flows feature provides an easy mechanism for comparing two power system cases.
For example, Difference Flows can be used to show the difference in transmission line flows and bus
voltages resulting from a contingency or a change in power transfer between two areas. Difference
Flow is available in both Run Mode and Edit Mode, however when you switch from Run Mode back to
Edit Mode, Simulator automatically resets you to the Present Case. This is done so that you do not
accidentally try to edit data while in Difference or Base Case mode. Once you are in Edit Mode
however, you can still manually switch back to Difference or Base Case Mode.
For more information about how to use Difference Flows see Using Difference Flows.
The Difference Flows Dialog can be accessed by:




Go to the Tools ribbon tab, and choose Difference Flows > Difference Flows from the Other
Tools Ribbon Group. .
Selecting Difference Flows from the oneline local menu.
All Difference Flows Actions are controlled via the Difference Flows Dialosg or the drop-down list
on the Difference Flows toolbar button.

Case Type to Display
Use of this feature affects all aspects of the Simulator environment. When using the Difference
Flows tool, information shown on oneline diagrams, case information displays, and power flow lists is
governed by which of the three Difference Flow Case Types (base, present or difference) is currently
being displayed.
Key Field to Use
The difference flows feature must make a comparison between the Present Case and the Base Case
to determine which objects between these two case match one another. The Key Fields to Use
specifies whether this matching is done using Primary Keys (bus numbers), Secondary Keys (bus
names/Nom kV pair), or by Label.
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Difference Flows: Case Types
When using the Difference Flows tool, information shown on oneline diagrams, case information
displays, and power flow lists is governed by which of the three case types is currently being
displayed. Difference Flow is available in both Run Mode and Edit Mode, however when you switch
from Run Mode back to Edit Mode, Simulator automatically resets you to the Present Case. This is
done so that you do not accidentally try to edit data while in Difference or Base Case mode. Once you
are in Edit Mode however, you can still manually switch back to Difference or Base Case Mode.
The case types available are:




Base Case – A solved power system that serves as the reference for the difference flows tool. To
establish a base case, set up a solved power system corresponding to the desired operating point.
Open the Difference Flows Dialog and click the button labeled Set Present as Base Case.
Present Case – The operating point used in the Difference Flows comparison. Note: The Present
Case must have the same numbering scheme as the Base Case for proper operation of the
Difference Flows tool. See Topological Differences for more information.
Difference Case – The difference between the Present Case and the Base Case values. The
values displayed in the Difference Case are established using the Base Case as the reference.
When showing status fields for branches, generators, etc... fields will show up as either
OPEN/CLOSED or CLOSED/OPEN if the status changed. The status in the present case will be listed
first. A similar format will be used for fields such as generator AGC Status and other text fields.

To toggle between the different case views, open the Difference Flows Dialog and select the desired
case type. Alternatively, you can click the Difference Flows button in the Other Tools Ribbon Group
on the Tools ribbon tab and select the desired case type.
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Using Difference Flows
To use the Difference Flows tool:








Set up a solved power system corresponding to a desired operating point. This operating point will
be defined as the Base Case.
Select Difference Flows from the Run Mode ribbon group on the Tools ribbon tab, or select
Difference Flows from the oneline local menu in Run Mode.
On the Difference Flows Dialog, click the button labeled Set Present as Base Case. This
stores the current operating point as the Base Case.

Define the operating point (Present Case) for which to perform the difference flows comparison.
The Present Case may be developed either by modifying the Base Case as desired and re-solving,
or by opening a new case selecting Open Case from the Application Button. In the latter
situation, the new case that you open must have the same bus numbering scheme as the Base
Case.
See Difference Flow Case Types for information on toggling between case views. The currently
displayed case type is shown in the PowerWorld Simulator Status Bar. When viewing either the
Base Case or Difference Case, the corresponding status bar display will be highlighted.

Note that the Difference Flows tool can only be used in Run Mode and the status bar will not display a
case type while in Edit Mode.
When showing the Difference Case, most of the fields shown on the onelines and case information
displays show the difference between the present value and its Base Case value. For example, on the
Generator Records Display, an entry of 0.0 in the MW field indicates that the real power output of the
generator did not change. An entry of 10.0 in the MW field indicates that the present real power
output of the generator is 10 MW greater than it was in the Base Case.
At any time during a simulation, you can set the present case as the Base Case by clicking the
corresponding button on the Difference Flows Dialog.
Conversely, if you have made changes to the present case, and you wish to revert to some or all of
the base case values, you can click on the Reset Case… button. When you click this button, the
dialog will expand to show you options for resetting specific types of values to their base case values.
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Expanded Difference Flows Dialog
Once you have indicated which types of values you want to reset (by default, all are selected), you can
click on the Reset Present Case to Base Case Values button to complete the process of reverting
to base case values. Note: once you have finished resetting to the base case values, you can hide the
Reset options by clicking the Hide Reset Button in the upper right hand corner of the Reset options
panel.
The oneline diagrams and case information displays cannot indicate structural differences in the case
very well, such as the addition or removal of a device. To identify such differences, make use of the
Present Topological Differences from Base Case tool to identify topology differences.
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Present Topological Differences from Base Case
The Present Topological Differences from Base Case option provides the users a way to compare the
topological differences between two difference cases in Simulator.
To compare two cases topologically, you must load the first case you wish to use as the reference into
Simulator. Use the Difference Flows tool to set the case as the base case in memory. Once the
reference case has been stored as the base case, open the second or comparison case into Simulator.
Now if you check the Tools ribbon tab, and choose the Difference Flows Menu on the Other Tools
Ribbon Group, you will see the option Present Topological Differences from Base Case. Choosing
this option will open the dialog to display the topological differences.

Topological Differences Dialog
The Topological Differences Dialog contains five tabs. All but the Summary tab are
instances of Case Information Displays and thus exhibit characteristics and controls
similar to other displays.
Summary
A listing of the types of objects in the case. The first column displays the number of NEW devices in
the comparison case that were not in the base case. Alternately, the Removed column displays the
number of devices in the base case that do NOT exist in the comparison case. The third column
simply displays the number of items that were matched between the two cases.
Elements Added
Tabular listings of all objects that exist in the comparison case, but not in the reference case.
Elements Removed
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Tabular listings of all objects that exist in the reference case, but are not present in the comparison
case. A right-click option from the pop-up menu on the Elements Removed tables allows for saving
the removed elements selected to a GE EPC file format.
Elements in Both
Tabular listings of all objects present in both cases.
Create Bus Swap List
Used for setting up a bus renumbering list. It is possible that discrepancies in topology between the
comparison case and the reference case can be due to a difference in bus numbering between the
two cases. Renumbering the buses in the comparison case may take care of most of the topology
discrepancies that are reported in this instance.
Data Objects and Fields
The Save and Send Options on the topological difference dialog makes it possible to save Elements
Added, Elements Removed, and Elements In Both to file. In addition to these options, special objects
and an object field are available to make accessing these objects easier using script actions and will
allow the user to customize the fields stored in the file. When the removed elements are saved in the
GE EPC file format the elements are saved with a status value of -4.
To provide easier access to the objects that have been identified as being removed when viewing the
topological differences, special object types have been created that allow these objects to be accessed
via script commands. These objects provide access to the Elements Removed. All of the object names
start with Removed with the rest of the name just being the usual object name. To identify buses use
the object name RemovedBus. To get generators use RemovedGen, etc. These objects can be
accessed through the SaveData script command and GetParametersMultipleElement through SimAuto.
These object types can only be stored to an auxiliary file. They cannot be read back in, but, the file
headers and object types can be modified to make use of the data or the data can simply be used as
documentation of case differences.
A field is available for all object types that can be used with the difference flows tool. This field is
found under Difference Flow\In Diff. Flows Base Case? and indicated whether or not an object
was in the difference flows base case. This field is useful for filtering only the new elements that are
only in the present case, field value = NO, or all of the elements in both the present and base case,
field value = YES. This will make it possible to use script actions or filters to return only the Elements
Added or Elements In Both.
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Limit Monitoring Settings
Simulator offers many tools to study the capabilities of a power system. Examples include:






Contingency Analysis
Available Transfer Capability (ATC)
Optimal Power Flow (OPF)
Security Constrained OPF (SCOPF) Overview
PV Curve and QV Curve Tool

All of these tools make extensive use of power system limits. Limits for various power system elements
include:




MVA (or Amp) limits on transmission lines and transformers
MW limits on Interfaces
High and low voltage limits for Buses

The accuracy of all these limits is very important, as is the specification of which limits should be
monitored. While ensuring the accuracy of input data such as power system limits must be left to the
user, PowerWorld Simulator provides several ways to specify which limits should be monitored. Limit
Monitoring is specified according to settings for the Area, Zone and Limit Group to which the power
system element belongs. A power system element is monitored only if ALL of the following conditions
are met.
Conditions for Monitoring an Element’s Limit





Its
Its
Its
Its

Monitor field is set to YES
Limit Group is Enabled
Area is set to Report Limits and it meets the KV range for reporting
Zone is set to Report Limits and it meets the KV range for reporting

The Limit Monitoring Settings Dialog gives you ability to specify all these settings to setup the limits
you want to monitor, and thus enforce in the various tools that Simulator provides.
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Limit Monitoring Settings and Limit Violations Dialog
The Limit Monitoring Settings Dialog gives you ability to specify which limits you want to monitor, and
thus enforce in the various tools that Simulator provides. In general, keep in mind that a bus,
transmission line/transformer, or interface’s limit is monitored only if the following conditions are met.
Conditions for Monitoring an Element’s Limit





Its
Its
Its
Its

Monitor field is set to YES
Limit Group is Enabled
Area is set to Report Limits and it meets the KV range for reporting
Zone is set to Report Limits and it meets the KV range for reporting

The following fields are shown on the display:
Elements To Show
Change this value to modify which elements are displayed in the Buses, Lines, and Interfaces. Set it
to…
All Elements to show all Buses, Lines and Interfaces regardless of monitoring settings.
Monitored Elements to only display Buses, Lines and Interfaces that meet the conditions
for monitoring. See Limit Monitoring Settings for more information on setting which values
are monitored.
Violating Elements to only display Buses, Lines and Interfaces that are violating. See Limit
Monitoring Settings for more information on setting what is considered a violation.
Number of Violations
The following fields provide summary information on the types of violations that are currently
present in the case:
High Voltage Buses and Low Voltage Buses
Shows the total number of bus voltage magnitude violations. These violations are shown on the
Bus Voltage Magnitude Limit Violations Display.
Low Voltage Suspects
Shows the total number of buses whose voltages have fallen below a designated internal threshold
to indicate a low voltage solution is being reached in some location in the system.
Line/Transformer Violations
Shows the total number of line/transformer violations. These violations are shown on Line and
Transformer Limit Display.
Interface Violations
Indicates the total number of interface violations. These violations are shown on the Interface
Violations Display.
Limit Group Values
This part of the dialog shows information about the Limit Groups with greater description shown
below.
Save/Load Monitoring Settings
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The Save and Load Monitoring Settings buttons allow the user to save the current set or load a
previously saved set of Limit Monitoring Settings options. The options are saved in a PowerWorld
Auxiliary File text format.
Do not monitor radial lines and buses
Check this box to ignore limits on radial lines and buses throughout the case. In this instance a
radial bus is defined as a bus that is connected to the rest of the power system by a single in-service
transmission line. A radial line is the defined as a line connected to a radial bus. This means that in a
5 lines in series that connect to a radial load, only the last bus and last line will be considered radial.
If you would like to better determine which lines are "radial" in a more traditional sense, use the
feature Branches that Create Islands that allows you to easily generate a list of branches that if
taken out of service will split an existing island into two. These represent lines which may be
considered radial.
Tabs on the Limit Monitoring Dialog
The tabs on the Limit Monitoring Settings Dialog allow you to change these settings. These tabs
contain tables showing lists of the respective elements. Since these tables are another variety of the
Case Information Displays, you may interact with it in a familiar manner. Click on any of the field
headings to sort by that field. Right-click on the display to call up the display’s local menu. From the
local menu, you can print the violations, copy the violation records to the Windows clipboard for use
with another application, modify the format and content of the violations listing, view the information
dialog of the respective element, and view the Quick Power Flow List or Bus View Display.
Buses Tab
Each tab shows a list of the respective type of power system element. The important columns
include:
Number, Name:Bus number between 1 and 99,999, and its alphanumeric identifier.
Area Name:Alphanumeric identifier of the bus’ area.
Monitor: toggle this between YES and NO to set whether the specific element should be
monitored.
Limit Group: toggle this value to specify which Limit Group the element belongs to
PU Volt:Bus’ per unit voltage magnitude.
Volt (kV): Bus’ actual voltage magnitude in kV. This is the per unit voltage magnitude
multiplied by the bus’ nominal voltage.
Limit Low PU Volt: Bus' individual low voltage limit used when the bus is set to use specific
voltage limits other than the default voltage limit defined in the bus' limit group. This field is
not enabled unless the "Use Specific Limits" option for the bus is set to YES. The value will
then reflect the low per unit voltage limit specified in one of the eight low voltage limit sets
that can be defined with the bus. Which voltage limit set's value is displayed depends on
which limit set is specified as the "Bus Low Rate Set" in the limit group to which the bus is
assigned.
Limit High PU Volt: Bus' individual high voltage limit used when the bus is set to use
specific voltage limits other than the default voltage limit defined in the bus' limit group. This
field is not enabled unless the "Use Specific Limits" option for the bus is set to YES. The value
will then reflect the high per unit voltage limit specified in one of the eight high voltage limit
sets that can be defined with the bus. Which voltage limit set's value is displayed depends on
which limit set is specified as the "Bus High Rate Set" in the limit group to which the bus is
assigned.
911
©2011 PowerWorld Corporation

Contingency Limit Low PU Volt: Bus' individual low voltage limit used during a
contingency when the bus is set to use specific voltage limits other than the default voltage
limit defined in the bus' limit group. This field is not enabled unless the "Use Specific Limits"
option for the bus is set to YES. The value will then reflect the contingency low per unit
voltage limit specified in one of the eight contingency low voltage limit sets that can be
defined with the bus. Which contingency voltage limit set's value is displayed depends on
which limit set is specified as the "Bus CTG Low Rate Set" in the limit group to which the bus
is assigned.
Contingency Limit High PU Volt: Bus' individual high voltage limit used during a
contingency when the bus is set to use specific voltage limits other than the default voltage
limit defined in the bus' limit group. This field is not enabled unless the "Use Specific Limits"
option for the bus is set to YES. The value will then reflect the contingency high per unit
voltage limit specified in one of the eight contingency high voltage limit sets that can be
defined with the bus. Which contingency voltage limit set's value is displayed depends on
which limit set is specified as the "Bus CTG High Rate Set" in the limit group to which the bus
is assigned.
Note: If Elements to Show is set to Monitored Elements, then only elements which meet the
conditions for monitoring will be displayed in these lists.
If using the Integrated Topology Processing add-on, an Only show the primary bus for each
superbus checkbox will be available. Checking this box will limit the buses shown to only those that
are primary buses. This provides a quick means of removing the clutter of redundant data. The
primary buses and superbuses are determined from the base case topology.
Lines Tab
Each tab shows a list of the respective type of power system element. The important columns
include
From Bus Number and Name:Bus number at name at the from terminal of the line. For
transformers, the from bus is the tapped side. Right- clicking on either of these fields allows
you to see all the flows measured at the "from" bus using the Quick Power Flow List or Bus
View Display local menu options.
To Bus Number and Name:Bus number at name at the to terminal of the line. For
transformers, the to bus is the untapped side. Right-clicking on either of these fields allows
you to see all the flows into the "to" bus using the Quick Power Flow List or Bus View Display
local menu options.
Circuit:Two-character identifier used to distinguish between multiple lines joining the same
two buses.
Monitor: toggle this between YES and NO to set whether the specific element should be
monitored.
Limit Group: toggle this value to specify which Limit Groups the element belongs to
Used Limiting Flow, Limit, Used % of Limit:The flow at the end of the branch selected
for measurement, and its MVA or Amp limit. The percentage equivalent of the flow to it’s limit
is given in the Used % of Limit column.
MVA or Amps?: Units used with the Max Flow and the Limit field. All flows are expressed
either in MVA or amps.
Note: If Elements to Show is set to Monitored Elements, then only elements which meet the
conditions for monitoring will be displayed in these lists.
Interfaces and Nomograms Tab
Similar to the Buses and Lines Tabs shown above. The important columns are the Monitor and
Limit Group columns
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Area Reporting and Zone Reporting Tabs
These tabs display all the Areas and Zones in the system. The important columns are
Report Limits:toggle this between YES and NO to set whether the specific element should
be monitored.
Report Min kV and Report Max kV:Only buses and lines within this kV range will be
monitored.
Modify/Create Limit Group Tab
Every power system elements belongs to a single Limit Group. By default, all power system elements
are in the same Limit Group that is named "Default". New limit groups can be added by rightclicking in the table and choosing Insert from the popup menu. Additional limit groups give the
flexibility of assigning devices to different groups, where each group can have its own set of defined
limit information.
The limit group stores important values regarding the enforcement and monitoring of the power
system elements within the Limit Group. The values are:
Disabled: Set the value to YES to ignore all power system element limits in the Limit Group.
Set the value to NO to monitor limits according to the settings of the Limit Group.
Branch Percentage: The percentage to which Simulator’s study tools will limit a line or
transformer. Typically this is 100%, but it can be modified. In Contingency Analysis, then
lines will be flagged as violated if they exceed this percentage. In performing an Optimal
Power Flow, all attempts will be made to keep the line below this percentage.
Line Rate Set: You may define eight different ratings to transmission lines or transformers
(for more information see Line/Transformer Information). Change this value to specify which
rating set should be used for lines/transformers in the limit group.
Contingency Line Rate Set: This field specifies the rating set used for post-contingency
monitoring of Lines/Transformers.
Amps or MVA: Limits for transmission lines and transformers are always entered in MVA.
However, when reporting limit violations, it is common to check transmission line limits in
terms of their amp loading. If the Treat Line Limits As Equivalent Amps is checked, the limits
for transmission lines are reported in amps rather than MVA. If this box is not checked, limits
for both transmission lines and transformers are expressed in MVA.
For reference, note that the amp rating of a line is derived from the MVA rating using the
formula

Also note that the reported Amp% and MVA% will be different by a factor of the per unit
voltage at the bus terminal at which the limiting flow is determined. This is often a point of
confusion as the expectation might be that the percent loading would be the same regardless
of which reporting method is used:

When doing contingency analysis and the Power Flow Solution Options are set to Use the
DC Approximation in Power Flow, this option will be ignored. Line limits will always be
reported in MVA when using the DC approximation.
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Interface Percentage: The percentage to which Simulator’s study tools will limit an
interface. Typically this is 100%, but it can be modified. In Contingency Analysis, then
interfaces will be flagged as violated if they exceed this percentage. In performing an Optimal
Power Flow, all attempts will be made to keep the interface below this percentage.
Interface Rate Set: You may define eight different ratings to an interface. Change this
value to specify which rating set should be used for interfaces in the limit group.
Interface Contingency Rate Set: This field specifies the rating set used for postcontingency monitoring of Interfaces during Contingency Analysis.
Low PU Volt: Buses will be flagged as violated if they fall below this per unit voltage.
High PU Volt: Buses will be flagged as violated if they go above this per unit voltage.
Contingency Low PU Volt: Buses will be flagged as violated during contingencies if they
fall below this per unit voltage.
Contingency High PU Volt: Buses will be flagged as violated during contingencies if they
go above this per unit voltage.
Bus Low Rate Set: This field value indicates which bus voltage rating set should be used for
normal (non-contingency) low voltage violation reporting.
Bus High Rate Set: This field value indicates which bus voltage rating set should be used
for normal (non-contingency) high voltage violation reporting.
Bus Contingency Low Rate Set: This field value indicates which bus voltage rating set
should be used for low voltage contingency violation reporting.
Bus Contingency High Rate Set: This field value indicates which bus voltage rating set
should be used for high voltage contingency violation reporting.
Nomogram Percentage: The percentage to which Simulator’s study tools will limit a
nomogram.
Limiting End: Specified as higher or lower, this field determines whether the higher or the
lower flow amount on the element is used for reporting a limit violation. If you use higher, it
is possible that the lower flow is not violating the line limit. If you use lower, then you are
guaranteed that the element limit is being violated at both ends of the element.
Use Limit Cost: If this field is set to yes, you are enabling the capability to have a cost
function associated with enforcing constraints. This cost function can be viewed as similar to
a generator cost function, in that as the constraint becomes overloaded by larger amounts,
the marginal cost of enforcing the constraint will increase. For setting the piecewise linear
limit cost curve, right-click and choose show dialog from the popup menu to access the Limit
Group Dialog.
Often monitoring elements according to Area and/or Zone is all that you need. However, if you need
to monitor specific groups of power system elements and not others then you need to create some
new Limit Groups.
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Limit Group Dialog
The Limit Group Dialog reflects much of the same information that is summarized in the Limit
Monitoring Settings Dialog’s Modify/Create Limit Groups page. The same information can be
changed here as on the previously mentioned display. One important feature that is unique to this
dialog is the ability to define a piecewise linear limit cost curve, which can be used for setting up "soft"
constraints used in the Optimal Power Flow.
To access this dialog, right-click on one of the limit groups defined on the Modify/Create Limit
Groups page of the Limit Monitoring Settings dialog and choose Show Dialog.
Limit Group Name
Identifies the name of the Limit Group that is currently selected. Select a different limit group from
the dropdown to modify parameters for that group.
Disabled
Check this option to ignore all power system element limits in the Limit Group. Leave the box
unchecked to monitor limits according to the settings of the Limit Group.
Add New Limit Group
Clicking this button will create a new limit group, displaying a dialog in which the name for the new
limit group can be specified.
Rename Limit Group
Clicking this button will display a dialog in which a new name for the current limit group can be
specified.
Lines/Interfaces
% of Limit for Reporting (Branches)
The percentage to which Simulator’s study tools will limit a line or transformer. Typically this is
100%, but it can be modified. In Contingency Analysis, lines will be flagged as violated if they
exceed this percentage. In performing an Optimal Power Flow, all attempts will be made to keep the
line below this percentage.
Line/Transformer Rating Set
You may define eight different ratings to transmission lines or transformers (for more information
see the Branch Information Dialog or Branch Options dialog). Change this value to specify which
rating set should be used for lines/transformers in the limit group.
Line/Transformer Contingency Rating Set
This field specifies the rating set used for post-contingency monitoring of Lines/Transformers.
Treat Transmission Line Limits as Equivalent Amps
Limits for transmission lines and transformers are always entered in MVA. However, when reporting
limit violations, it is common to check transmission line limits in terms of their amp loading. If the
Treat Line Limits As Equivalent Amps is checked, the limits for transmission lines are reported in
amps rather than MVA. If this box is not checked, limits for both transmission lines and transformers
are expressed in MVA.
For reference, note that the amp rating of a line is derived from the MVA rating using the formula
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When doing contingency analysis and the Power Flow Solution Options are set to Use the
DC Approximation in Power Flow, this option will be ignored. Line limits will always be reported in
MVA when using the DC approximation.
Limiting End of Line
Specified as higher or lower, this field determines whether the higher or the lower flow amount on
the element is used for reporting a limit violation. If you use higher, it is possible that the lower flow
is not violating the line limit. If you use lower, then you are guaranteed that the element limit is
being violated at both ends of the element.
% of Limit for Reporting (Interfaces)
The percentage to which Simulator’s study tools will limit an interface. Typically this is 100%, but it
can be modified. In Contingency Analysis, interfaces will be flagged as violated if they exceed this
percentage. In performing an Optimal Power Flow, all attempts will be made to keep the interface
below this percentage.
Interface Rating Set
You may define eight different ratings to an interface. Change this value to specify which rating set
should be used for interfaces in the limit group.
Interface Contingency Rating Set
This field specifies the rating set used for post-contingency monitoring of Interfaces during
Contingency Analysis.
% of Limit for Reporting (Nomograms)
The percentage to which Simulator’s study tools will limit a nomogram.
Use Limit Cost
If this field is checked, you are enabling the capability to have a cost function associated with
enforcing constraints. This cost function can be viewed as similar to a generator cost function, in
that as the constraint becomes overloaded by larger amounts, the marginal cost of enforcing the
constraint will increase.
Once the box is checked, the table for defining the limit cost function will become enabled. The
starting point (% Flow) must be at or above 100%. You can then begin inserting additional points in
the piecewise linear curve by right-clicking in the table and selecting Insert Point from the popup
menu, followed by entering the new percent flow and marginal cost. Note that the cost function
must be strictly increasing, meaning the next marginal cost value must be equal to or greater than
the immediately previous value.
When constraints are given the ability to use this limit cost curve, it effectively gives the optimal
power flow the ability to "dispatch" the limit of the elements according to the marginal costs of the
limit cost curve. You are determining the point on the limit cost curve where the shadow price of
enforcing the constraint is met. Thus the OPF routine will determine how much you will allow the
element to be overloaded by giving the element the piecewise linear curve. The OPF will solve the
problem, and optimize the constraints as it determines shadow prices for each constraint and adjusts
the limit accordingly during the iterations of the routine. Since these are somewhat flexible limit
assignments to the elements, they are sometimes considered "soft" constraints.
Buses/Summary
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Low Per Unit Limit
Buses will be flagged as violated if they fall below this per unit voltage.
High Per Unit Limit
Buses will be flagged as violated if they fall below this per unit voltage.
Low-voltage solution flag
Enter a per unit value at which you wish to measure a voltage and consider the solution to be a low
voltage solution.
Include Out-Of-Service Buses
Check this check-box to include out-of-service buses.
Bus Low Rating Set and Bus High Rating Set
Individual buses may either take their limit values from the Low/High Per Unit Limits specified, or
they may use their own bus-specific limits. Buses that have their own bus-specific limits defined will
use the rating sets specified with these settings. In order for the bus-specific limits to be used for a
particular bus, the Use Bus-Specific field for the bus must be set to YES.
Elements using Limit Group
Lists the number of elements that are members of the selected limit group.
Contingency Options
Contingency analysis options allow the monitoring of elements based on how they are impacted by a
contingency relative to base case flows or voltages. Options are available to Never report violations
if the change due to the contingency is not great enough or Always report as a violation if the
change is considered significant enough. These options are also available with Limit Group specific
settings along with options to Report as a violation if a bus becomes disconnected during a
contingency and select How to Monitor Voltage Changes(either per unit or percentage changes).
To use these options as specified with the Limit Group, check the Use group specific contingency
options checkbox. When running contingency analysis, these settings will override the ones that are
specified with the contingency options on the Advanced Limit Monitoring tab.
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Difference Flows
The Difference Flows feature provides an easy mechanism for comparing two power system cases.
For example, Difference Flows can be used to show the difference in transmission line flows and bus
voltages resulting from a contingency or a change in power transfer between two areas. Difference
Flow is available in both Run Mode and Edit Mode, however when you switch from Run Mode back to
Edit Mode, Simulator automatically resets you to the Present Case. This is done so that you do not
accidentally try to edit data while in Difference or Base Case mode. Once you are in Edit Mode
however, you can still manually switch back to Difference or Base Case Mode.
For more information about how to use Difference Flows see Using Difference Flows.
The Difference Flows Dialog can be accessed by:




Go to the Tools ribbon tab, and choose Difference Flows > Difference Flows from the Other
Tools Ribbon Group. .
Selecting Difference Flows from the oneline local menu.
All Difference Flows Actions are controlled via the Difference Flows Dialosg or the drop-down list
on the Difference Flows toolbar button.

Case Type to Display
Use of this feature affects all aspects of the Simulator environment. When using the Difference
Flows tool, information shown on oneline diagrams, case information displays, and power flow lists is
governed by which of the three Difference Flow Case Types (base, present or difference) is currently
being displayed.
Key Field to Use
The difference flows feature must make a comparison between the Present Case and the Base Case
to determine which objects between these two case match one another. The Key Fields to Use
specifies whether this matching is done using Primary Keys (bus numbers), Secondary Keys (bus
names/Nom kV pair), or by Label.
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Difference Flows: Case Types
When using the Difference Flows tool, information shown on oneline diagrams, case information
displays, and power flow lists is governed by which of the three case types is currently being
displayed. Difference Flow is available in both Run Mode and Edit Mode, however when you switch
from Run Mode back to Edit Mode, Simulator automatically resets you to the Present Case. This is
done so that you do not accidentally try to edit data while in Difference or Base Case mode. Once you
are in Edit Mode however, you can still manually switch back to Difference or Base Case Mode.
The case types available are:




Base Case – A solved power system that serves as the reference for the difference flows tool. To
establish a base case, set up a solved power system corresponding to the desired operating point.
Open the Difference Flows Dialog and click the button labeled Set Present as Base Case.
Present Case – The operating point used in the Difference Flows comparison. Note: The Present
Case must have the same numbering scheme as the Base Case for proper operation of the
Difference Flows tool. See Topological Differences for more information.
Difference Case – The difference between the Present Case and the Base Case values. The
values displayed in the Difference Case are established using the Base Case as the reference.
When showing status fields for branches, generators, etc... fields will show up as either
OPEN/CLOSED or CLOSED/OPEN if the status changed. The status in the present case will be listed
first. A similar format will be used for fields such as generator AGC Status and other text fields.

To toggle between the different case views, open the Difference Flows Dialog and select the desired
case type. Alternatively, you can click the Difference Flows button in the Other Tools Ribbon Group
on the Tools ribbon tab and select the desired case type.
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Using Difference Flows
To use the Difference Flows tool:








Set up a solved power system corresponding to a desired operating point. This operating point will
be defined as the Base Case.
Select Difference Flows from the Run Mode ribbon group on the Tools ribbon tab, or select
Difference Flows from the oneline local menu in Run Mode.
On the Difference Flows Dialog, click the button labeled Set Present as Base Case. This
stores the current operating point as the Base Case.

Define the operating point (Present Case) for which to perform the difference flows comparison.
The Present Case may be developed either by modifying the Base Case as desired and re-solving,
or by opening a new case selecting Open Case from the Application Button. In the latter
situation, the new case that you open must have the same bus numbering scheme as the Base
Case.
See Difference Flow Case Types for information on toggling between case views. The currently
displayed case type is shown in the PowerWorld Simulator Status Bar. When viewing either the
Base Case or Difference Case, the corresponding status bar display will be highlighted.

Note that the Difference Flows tool can only be used in Run Mode and the status bar will not display a
case type while in Edit Mode.
When showing the Difference Case, most of the fields shown on the onelines and case information
displays show the difference between the present value and its Base Case value. For example, on the
Generator Records Display, an entry of 0.0 in the MW field indicates that the real power output of the
generator did not change. An entry of 10.0 in the MW field indicates that the present real power
output of the generator is 10 MW greater than it was in the Base Case.
At any time during a simulation, you can set the present case as the Base Case by clicking the
corresponding button on the Difference Flows Dialog.
Conversely, if you have made changes to the present case, and you wish to revert to some or all of
the base case values, you can click on the Reset Case… button. When you click this button, the
dialog will expand to show you options for resetting specific types of values to their base case values.
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Expanded Difference Flows Dialog
Once you have indicated which types of values you want to reset (by default, all are selected), you can
click on the Reset Present Case to Base Case Values button to complete the process of reverting
to base case values. Note: once you have finished resetting to the base case values, you can hide the
Reset options by clicking the Hide Reset Button in the upper right hand corner of the Reset options
panel.
The oneline diagrams and case information displays cannot indicate structural differences in the case
very well, such as the addition or removal of a device. To identify such differences, make use of the
Present Topological Differences from Base Case tool to identify topology differences.

921
©2011 PowerWorld Corporation

Present Topological Differences from Base Case
The Present Topological Differences from Base Case option provides the users a way to compare the
topological differences between two difference cases in Simulator.
To compare two cases topologically, you must load the first case you wish to use as the reference into
Simulator. Use the Difference Flows tool to set the case as the base case in memory. Once the
reference case has been stored as the base case, open the second or comparison case into Simulator.
Now if you check the Tools ribbon tab, and choose the Difference Flows Menu on the Other Tools
Ribbon Group, you will see the option Present Topological Differences from Base Case. Choosing
this option will open the dialog to display the topological differences.

Topological Differences Dialog
The Topological Differences Dialog contains five tabs. All but the Summary tab are
instances of Case Information Displays and thus exhibit characteristics and controls
similar to other displays.
Summary
A listing of the types of objects in the case. The first column displays the number of NEW devices in
the comparison case that were not in the base case. Alternately, the Removed column displays the
number of devices in the base case that do NOT exist in the comparison case. The third column
simply displays the number of items that were matched between the two cases.
Elements Added
Tabular listings of all objects that exist in the comparison case, but not in the reference case.
Elements Removed
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Tabular listings of all objects that exist in the reference case, but are not present in the comparison
case. A right-click option from the pop-up menu on the Elements Removed tables allows for saving
the removed elements selected to a GE EPC file format.
Elements in Both
Tabular listings of all objects present in both cases.
Create Bus Swap List
Used for setting up a bus renumbering list. It is possible that discrepancies in topology between the
comparison case and the reference case can be due to a difference in bus numbering between the
two cases. Renumbering the buses in the comparison case may take care of most of the topology
discrepancies that are reported in this instance.
Data Objects and Fields
The Save and Send Options on the topological difference dialog makes it possible to save Elements
Added, Elements Removed, and Elements In Both to file. In addition to these options, special objects
and an object field are available to make accessing these objects easier using script actions and will
allow the user to customize the fields stored in the file. When the removed elements are saved in the
GE EPC file format the elements are saved with a status value of -4.
To provide easier access to the objects that have been identified as being removed when viewing the
topological differences, special object types have been created that allow these objects to be accessed
via script commands. These objects provide access to the Elements Removed. All of the object names
start with Removed with the rest of the name just being the usual object name. To identify buses use
the object name RemovedBus. To get generators use RemovedGen, etc. These objects can be
accessed through the SaveData script command and GetParametersMultipleElement through SimAuto.
These object types can only be stored to an auxiliary file. They cannot be read back in, but, the file
headers and object types can be modified to make use of the data or the data can simply be used as
documentation of case differences.
A field is available for all object types that can be used with the difference flows tool. This field is
found under Difference Flow\In Diff. Flows Base Case? and indicated whether or not an object
was in the difference flows base case. This field is useful for filtering only the new elements that are
only in the present case, field value = NO, or all of the elements in both the present and base case,
field value = YES. This will make it possible to use script actions or filters to return only the Elements
Added or Elements In Both.
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Scaling
Use the Power System Scaling Dialog to scale the load, generation, or bus shunts uniformly for
either the entire case or a group of selected buses. This display allows you to scale any of the
following values:







Bus real power load
Bus reactive power load
Generator real power output
Real component of the bus shunt admittance
Capacitive component of the bus shunt admittance
Reactive component of the bus shunt admittance

To display the Power System Scaling Dialog, go to the Tools ribbon tab, and choose Scale Case from
the Other Tools ribbon group. When the dialog appears, you may begin to select the buses to be
scaled. Buses can be selected individually or in a group by areas or zones. In addition, if you already
have specific groups of devices defined as an injection group, you can choose to scale values
associated with the injection group.
Scale by Bus
The button on the left labeled Bus enables selection of loads, generators and shunts by the bus to
which the devices are attached. Selection of the buses can be done individually, by their area
grouping, by their zone grouping, or by their super area grouping. Scaling is done on the buses chosen
regardless of the area, zone, or super area specification. Options for areas, zones, and super areas are
included only to aid in selecting and unselecting buses to be scaled. This is important to keep in mind
if loads or generators are assigned to a different area or zone than their terminal bus.
The Buses Table lists the name and number of all buses in the system and whether or not each bus
will participate in the scaling. Similarly, the Areas, Zones, and Super Area tables list the names and
numbers of all areas, zones or super areas in the system and whether or not each area will participate
in the scaling. Simulator initially assumes that no buses are to be scaled. The Power System Scaling
Dialog furnishes a number of ways to select the subset of buses to be scaled:






Use the Add to Scaling fields to enter either a range of areas, zones and/or buses to scale.
Use the Remove from Scaling fields to enter either a range of areas, zones and/or buses to omit
from the scaling.
Use the Select buses using a network cut button to define a Network Cut to choose a custom
set of buses within a portion of the system to be scaled or omitted from the scaling.
Use the Buses,Areas, Zones and Super Areas tables to change the scaling status of individual
buses. Simply double-click on the Scale field for a bus, area, zone or super area to toggle its
value.
Click the Set All to Yes button to scale the entire case. Click the Set All to No button to remove
the entire case from scaling.

Changing the scaling for an area, zone or super area changes the scaling status for all buses in the
grouping. For example, to scale all the buses in a single area, first click Set All to No. Then, click on
the Scale field for the desired area in the Area Table. To scale all buses in an area except for a select
few, repeat the above process, but then click on the Scale field for the buses not to scale.
As you select the buses to be scaled, the fields in the Totals for Selected Buses are updated to
indicate the total load, generation, or shunt compensation that will be scaled.
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Once you have selected the buses, you can either use the Scale By fields to enter a new scaling
factor for each of the quantities or use the New Value fields to specify a new value directly. If you do
not wish to scale a particular type of device, such as bus shunts, simply leave the Scale By field as
unity.
To ensure that the reactive power is scaled proportionately to maintain the current load power factor,
click the Constant P/Q Ratio option. To enforce generator limits when scaling generation, check the
Enforce Gen MW Limits option. To scale generation and load to enforce ACE, check Scale Gen to
Keep ACE Constant. When Simulator scales generation, all generator power outputs at the selected
buses are scaled by the specified factor, regardless of area control. To scale only generators whose
AGC field is set to YES, check Scale Only AGCable Generation and Load. To scale both in-service
and out-of-service loads, check Scale Out-Of-Service Loads.
Finally, click Do Scaling to scale the load, generation, or shunt compensation.
Scale by Area
The button on the left side of the dialog labeled Area enables the selection of loads, generators and
shunts based on the area designation of the device itself. Loads, generators and shunts can have a
different area designation than the terminal bus to which the device is attached. In these cases, it is
sometimes necessary to use the Scale by Area option to choose only the devices that are designated
within a certain area, instead of all devices at a particular bus.
To specify the devices within certain areas to be scaled, toggle the Scale property of the areas desired
in the Areas table, or use the Add to Scaling and Remove from Scaling fields to enter ranges of
area numbers to be included or excluded from the scaling.
Scale by Zone
The button on the left side of the dialog labeled Zone enables the selection of loads, generators and
shunts based on the zone designation of the device itself. This is identical to the concept described
immediately above in the discussion on Scale by Area. As was the case with the area designation,
loads, generators and shunts can have a different zone designation than the terminal bus to which the
devices are attached.
To specify the devices within certain zones to be scaled, toggle the Scale property of the zones
desired in the Areas table, or use the Add to Scaling and Remove from Scaling fields to enter
ranges of zone numbers to be included or excluded from the scaling.
Scale by Injection Group
If injection groups have been defined for the case, you can scale the generation, load, and switched
shunt values for the injection group by first clicking on the Injection Groups button. The Buses
Table will be replaced with a new table listing the Injection Groups in the case. To choose the
injection groups to scale, double-click the Scale field to toggle the value between No and Yes. As
Scale fields are toggled to Yes, the Net Injection fields will update to display the totals for the
selected injection groups. When all of the desired injection groups have been selected, either the
Scale By or the New Value fields can be modified for a desired new value for the selected injection
groups. Keep in mind that the scaling is done based on net injection and will be done in proportion to
the defined participation points.
To ensure that the reactive power is scaled proportionately to maintain the current load power factor,
click the Constant P/Q Ratio option. To enforce generator limits when scaling generation, check the
Enforce Gen MW Limits option. When Simulator scales generation, all generator power outputs at
the selected buses are scaled by the specified factor, regardless of area control.
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Checking the Scale in Merit Order option will scale generators in the order of highest to lowest
normalized participation factor. This means that each generator participating in the injection group will
be moved to either its maximum or minimum limit, depending on the direction of the scaling, before
the output of the next generator in the list is changed, until the total scale amount is achieved. If this
option is checked, generator MW limits will be enforced regardless of the status of the Enforce Gen
MW Limits option.
Check the Scale Only AGCable Generation and Load option to scale only those generators and
loads whose AGC field is set to YES. If the Ignore AGC flag to calculate participation but use
AGC flag to scale individual loads or generators option is checked, the Scale Only AGCAble
Generation and Load is not enabled and will be ignored. If this option is checked, then all
generators and loads, regardless of their AGC status, will be used to calculate the participation
percentages for all participating elements. Only those generators and loads whose AGC field is set to
YES will actually be scaled. Normally, if choosing to scale only AGCable generation and load, only those
elements whose AGC status is YES will be used to calculate the participation percentages.
The choice of Scale Starting Point impacts the reference point from which the scaling starts. Scale
from Present Value scales by adding an incremental change to the present MW values based on the
difference between the New Value and Original Value. Scale from Zero sets all participating
elements to zero injection (0 MW load or generation) and then scales to the New Value from that
starting point. When using the Scale from Zero option, only a single injection group can be scaled at
a time. The following example explains the difference between these two options:
Suppose that Load 1 is 800 MW and Load 2 is 700 MW. These two loads are the only elements in
an injection group and they both have a participation factor of 0.5. The desired New Value is
1600 MW. Choosing Scale from Present Value will result in Load1 being 850 MW and Load 2
being 750 MW. The incremental change in the total load is 100 MW and both loads pick up half
of this change. Choosing Scale from Zero will result in Load 1 being 800 MW and Load 2 being
800 MW. Both loads have been scaled to 0 MW initially and they each pick up half of the desired
1600 MW total load.
The Scale Load Field options provide a way of scaling load that is out-of-service. Selecting Actual
MW (MW Column) will scale only those loads that are in-service. (The MW column in the load case
information display reflects the total in-service load at a bus.) Selecting Modeled MW (ignore load
and bus status) will scale all load regardless of the load and bus status.
Click Do Scaling to scale the selected injection groups.
Scale by Owners
You can scale the generation and load values by ownership by first clicking on the Owners button.
The Buses Table will be replaced with a new table listing the Owners in the case. To choose the
owners to scale, double-click the Scale field to toggle the value between No and Yes. As Scale fields
are toggled to Yes, the Generator and Load MW and Mvar fields will update to display the totals for the
selected owner. When all of the desired owners have been selected, either the Scale By or the New
Value fields can be modified for a desired new value for the selected owners.
To ensure that the reactive power is scaled proportionately to maintain the current load power factor,
click the Constant P/Q Ratio option. To enforce generator limits when scaling generation, check the
Enforce Gen MW Limits option. To scale generation and load to enforce ACE, check Scale Gen to
Keep ACE Constant. When Simulator scales generation, all generator power outputs at the selected
buses are scaled by the specified factor, regardless of area control. To scale only generators whose
AGC field is set to YES, check Scale Only AGCable Generation. To scale both in-service and out-ofservice loads, check Scale Out-Of-Service Loads.
Finally, click Do Scaling to scale the load and generation for the selected owners.

926
©2011 PowerWorld Corporation

Note: When scaling generators with multiple owners, the scaling will be done on the entire output of
these generators, regardless of the fact that not all of the owners have been set to scale. If this is not
a desired behavior, you can define multiple generators at the bus, each with 100% ownership.
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Path Distances from Bus or Group
To access the Determine Path Distances from Bus or Group dialog go to the Tools ribbon tab, and
choose Connections > Determine Path Distances to Bus from the Other Tools ribbon group.
The Determine Path Distances from Bus or Group dialog provides a way to calculate how far
electrically every bus in the system is from a particular starting point.
After clicking the Calculate button, all buses that are part of the start element will be labeled
internally as being a path distance zero. Then a calculation will be done that determines for each bus
in the system the shortest total path length in getting from each bus to the Start Element. Buses that
cannot reach the Start Element will be flagged with a very large distance (by default 10,000). The
results of the calculation will then be copied into the Bus Field specified under the Bus Field to
Populate option. The results will be displayed in a case information display at the bottom of the dialog.
The options on the dialog are described below.
Start Element Type and Element
Choose an element type to be either a Bus, Substation, Area, Zone, Super Area or Injection Group.
Then use the object chooser to choose the particular object to be the starting element. For more
help on the object choose see the Find Dialog Basics.
Distance Measure
Choose the distance measure that will be used to determine distances between nodes. Each branch
will be treated as having a length based on the choice below. Note: negative values are not allowed,
therefore negative values will be treated as extremely small lengths instead.
X - Per unit series reactance.
|Z| - Magnitude of the series impedance (based on the per unit reactance and resistance).
Length - Length field for each branch.
Number of Nodes - Length of 1.0 is used for all branches.
Other - When choosing Other, click the Find.. button to choose any numeric field of a
branch.Lines to Process
Lines to Process
Regardless of the Distance Measure above, you can choose which branches allowed to be traversed
when finding the shortest path.
All - All branches are allowed to be traversed.
Only Closed - Only branches that are presently closed can be traversed.
Filter - Only branches that meet the advanced filter specified can be traversed. Click Define...
to choose or create and advanced filter.
Selected - Only branches whose Selected? field is set to YES can be traversed.Bus Field to
Populate
Bus Field to Populate
Choose a field into which the resulting path distances will be copied. It is recommended that you use
the custom floating point or integer fields for this purpose.
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Shortest Path Between Elements
To access the Shortest Path Between Elements go to the Tools ribbon tab, and choose Connections
> Determine Shortest Path Between... from the Other Tools ribbon group. The Determine
Shortest Path Between dialog provides a way to find the shortest electrical pathway between two parts
of the power system.
After clicking the Calculate button, the shortest path of AC branches will be determined with the first
bus being inside the Start Element and the last bus being inside the End Element. Options described
below allow the user to choose the Start Element, End Element, Distance Measure for each branch,
and branches that are allowed to be traversed. The results will be displayed in a case information
display at the bottom of the dialog showing the sequence of buses that are traversed between the
start and end elements.
The options on the dialog are described below.
Start Element Type and Element
Choose an element type to be either a Bus, Substation, Area, Zone, Super Area or Injection Group.
Then use the object chooser to choose the particular object to be the starting element. For more
help on the object choose see the Find Dialog Basics.
End Element Type and Element
Choose an element type to be either a Bus, Substation, Area, Zone, Super Area or Injection Group.
Then use the object chooser to choose the particular object to be the ending element. For more help
on the object choose see the Find Dialog Basics.
Distance Measure
Choose the distance measure that will be used to determine distances between nodes. Each branch
will be treated as having a length based on the choice below. Note: negative values are not allowed,
therefore negative values will be treated as extremely small lengths instead.
X - Per unit series reactance.
|Z| - Magnitude of the series impedance (based on the per unit reactance and resistance).
Length - Length field for each branch.
Number of Nodes - Length of 1.0 is used for all branches.
Other - When choosing Other, click the Find.. button to choose any numeric field of a branch.
Lines to Process
Regardless of the Distance Measure above, you can choose which branches are allowed to be
traversed when finding the shortest path.
All - All branches are allowed to be traversed.
Only Closed - Only branches that are presently closed can be traversed.
Filter - Only branches that meet the advanced filter specified can be traversed. Click Define...
to choose or create and advanced filter.
Selected - Only branches whose Selected? field is set to YES can be traversed.
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Find Circulating MW or MVAr Flows Dialog

To access the Circulating Mvar and MW Flow Cycle Dialog go to the Tools ribbon tab, and
chooseConnections > Find Circulating MW or Mvar Flows... from the Other Tools ribbon group.
Circulating power flows are possible in power systems and can lead to unnecessary power losses and
voltage drops in the transmission system. The most common example is circulating Mvars caused by
transformers with unbalanced tap ratios. This dialog provides a tool to detect and highlight the
circulating real and reactive flows in a power system and also provides a metric to rank the severity of
these circulating flows.
A Flow Cycle is defined as a series of transmission branches with positive flows that can be traversed
to form a loop. Normally these types of cycles are not possible in a power system, but certain
configurations of transformer tap ratios or phase shifts can results in circulating Mvar or MW flows.
The detailed theory behind this tool is completely described in the follow paper: C. Davis, James
Weber, and Kyle Johnson, “Circulating MW and Mvar flows in large systems,” in North American Power
Symposium, Oct. 2009. You may also email PowerWorld for more details.
Dialog Options
Find Cycles
Click this button to recalculate the list of Flow Cycles after making changes in the other options.
Cycle Type to Find
Choose whether to locate circulating Mvars (much more common) or circulating MWs. Changing
this option will automatically recalculate the list of Flow Cycle
Flow Threshold
When searching for flow cycles, enter a threshold below which flows will be ignored. This is
needed to remove trivial flow cycles which are below the solution tolerance and are just generally
of little interest.
Maximum Related Cycles
It is possible (and quite common) for many related cycles to be found in one power system. A
group of related cycles is defined as a group of cycles which can all be mutually reached by from
one another by traversing a series of positive branch flows. (Mathematicians would call this
grouping a Strongly Connection Component of a directed graph). Groups of cycles which can be
reach from one another can be combined in many ways to form many new cycles. To prevent
the results in Simulator from displaying millions of cycles, this value is entered limit the number
of related cycles which will be returned by entering this value. Simulator will return the cycles
which have the largest minimum flow.
After finding the Flow Cycles, the lists at the bottom of the dialog show the flow cycle results. The top
list shows the list of Flow Cycles. As you click on a particular flow cycle, the bottom list will show the
Branches in Selected Flow Cycle (or Buses). There are also tabs which show Branches in any
Cycle and Buses in Any Cycle. You can use these case information displays to mark all the branches
that are in a cycle and then use a visualization tool such as Dynamic Formatting or Contouring to show
visually show the Flow Cycles on a one-line diagram. Example pictures of this are shown at the bottom
of this topic.
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Flow Cycle List Display Results
The Flow Cycle List has the following columns by default.
Related Cycle Group
Related Cycle Group Number will be the same for that which can be reached from one another.
These cycles are likely related to one another.
Area Names
Comma delimited list of area names which are traversed by the cycle.
Loss Mvar Reduction, Loss MW Reduction
Estimate of the reduction in Mvar (or MW) losses in the entire cycle if the circulating flow is
removed. The larger this number is, the more severe the circulating flow is. The list is sorted by
the Loss Mvar Reduction by default.
Cycle X-Weighted Average
Shows the weighted average flow in the cycle weighted by the series reactance (X) values.
Cycle Min Flow
Shows the minimum flow on any branch in the cycle. The larger this number is, the more severe
the circulating flow is.
Lines in Cycle
Number of lines (branches) in the cycle.
Min Bus Num, Max Bus Num
Shows the Minimum and Maximum bus number traversed in the cycle
Min Tap Ratio, Max Tap Ratio
Show the minimum and maximum tap ratio on any branch in the cycle.
Max Percentage MVA Flow
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Shows the maximum percent MVA flow on any branch in the cycle.
Branches in Selected Flow Cycle
The Branches in Selected Flow Cycle list has the following columns by default.
Cycle Flow
Magnitude of branch's flow for the cycle (the minimum of the from and to flow).
Cycle Flow Direction
Direction of flow in cycle relative to line's direction
Loss Mvar Reduction, Loss MW Reduction
Estimate of the reduction in MW and Mvar losses on this branch if the circulating flow is removed
Tap Ratio
Tap Ratio of the branch
Phase (Deg)
Phase Shift of the branch
Example Visualizations show circulating Mvar Flows
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Find Branches that Create Islands
To access the Find Branches that Create Islands, go to the Tools ribbon tab, and choose Connections
> Find Branches that Create Islands from the Other Tools ribbon group.
There are several options for selecting which ac lines to process.
Line Processing Options
All ac Lines
All ac lines in the power system model will be processed.
Use Area/Zone/Owner Filter
All ac lines that meet the defined Area/Zone/Owner Filters will be processed.
Select Area/Zone… to display the Area/Zone/Owner Filters dialog.
Use Selected
All ac lines that have the Selected? field set to ‘YES’ will be processed.
Click Select Lines… to display all ac lines and change the Selected? field.
Meets Filter
All ac lines that meet a selected advanced filter will be processed.
Use the drop down box to select a defined advanced filter or click Define Filter to display the
Advanced Filters for Branch Dialog. This dialog will allow you to define a new advanced filter for
a branch or update an existing filter.
By checking Do not display radial lines creating a single bus island those lines that only island a
single bus will not be displayed with the results.
Click Determine Branches to start the processing once all options have been set.
Because the processing of ac lines in a large power system may take some time, there is an Abort
button that is enabled once the line processing has started that will stop the processing at any point.
The list of resulting ac lines that create islands will be displayed under Branches that Create
Islands. To show the list of buses that are islanded by an outage of any line in the list, select a line
and the Islanded Buses list will be populated. Both the Branches that Create Islands list and the
Islanded Buses list are case information displays and have the same local menu options and
characteristics of other case information displays.

934
©2011 PowerWorld Corporation

Overview of Facility Analysis in PowerWorld Simulator
Facility Analysis is used to study the topological redundancy of interconnect-specific electric facilities.
This application determines the minimum set of AC transmission lines and transformers that, when
opened or removed from the system, would electrically isolate a set of Facility buses from a set of
External buses.
The tool is an application of the augmenting path max flow min cut algorithm with modifications to
handle electric networks.
The Facility analysis process has two steps:
1.
2.

The Select the Buses dialog is used to specify the External and Facility buses. Multiple selections of
the External buses can be done using any of the area or zone selectors. The Facility buses are
specified by setting the Selected field of buses to YES.
The Facility Analysis dialog is used to determine the Min Cut and visualize the branches that
belong to the min cut.

The Facility analysis application runs in Edit Mode and takes into consideration the open or closed
status of the branches. Open lines are considered as not present in the system. The figure below
illustrates the functionality of the Facility Analysis tool.
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Facility Analysis Dialog
This dialog is used to determine the branches that would isolate the Facility from the External region
as specified in the Select the Busesdialog. When switching to the Facility Analysis page, the application
builds a graph data structure and reports information regarding the External Region and the Facility.
To access the Facility Analysis Dialog go to the Tools ribbon tab, and choose Connections > Facility
Analysis Dialog from the Other Tools ribbon group.
Select the Buses
The options and use of this page are described in their entirety in the topic titled Bus Selection Page.
Facility Analysis
External Region
The external region is a set of buses from which the Facility would be isolated. Although the buses in
the external region may not be adjacent to each other, the algorithm will assume that any of these
buses can supply electricity to the Facility and thus the buses in the External region are considered
to be connected. The External region is defined using the Select the Busesdialog.
External Region - Number of Buses
Indicates the number of buses in the External region. This number is equal to the number of buses
in the system that were labeled as External in the Select the Buses dialog. There should be at least
one bus in the external region.
External Region - Capacity
Indicates the number of branches that connect the external buses to study buses in the system. This
is the outgoing graph flow capacity from the External region toward the Facility.
Facility
Is the set of buses that constitute the Facility. Although the buses in the Facility may not be adjacent
to each other, the algorithm will assume that any of these buses may receive power from the
External region, and thus the Facility buses are considered to be connected to each other.
Facility - Number of Buses
Indicates the number of buses in the Facility. This number is equal to the number of buses in the
system that were labeled as Study and whose Selected field is set to YES. There should be at least
one bus in the Facility.
Note that if a bus was specified to be External and its Selected field is YES, then the application will
issue an error, since Facility buses cannot be in the External region. In such cases the status will
indicate that the graph structure is incomplete.
Facility - Capacity
Indicates the number of branches that connect Facility buses with study buses. This number is equal
to the outgoing graph flow capacity from the Facility toward the External region.
Status
Shows the status of the Facility Analysis application. If the External region and the Facility are
specified, the status will indicate that the graph structure is ready. During execution of the Min Cut
algorithm, the status shows the number of the augmenting paths found so far and the number of
branches in the current path.
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Find Minimum Cut
Press this button to initiate the Min Cut algorithm. The button is inactive if the graph structure is
incomplete, i.e., there is either no external bus or facility bus, or facility buses were found inside the
External region.
Show Paths
Toggle this button to visualize the augmenting paths at the bottom of the form. The augmenting
paths are listed in the order in which they were found. Note that the first path has fewer nodes,
since the algorithm uses a shortest (least number of nodes) path routine. For each augmenting path
the number of buses in the path, as well as the corresponding bus numbers are listed in the dialog.
This button is enabled only if a min cut has been found.
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Augmenting Path Max Flow Min Cut Algorithm
The augmenting path max flow – min cut algorithm is used to identify the minimum number of
branches that need to be opened or removed from the system in order to isolate the Facility (power
system device) from an External region.
The algorithm is an application of the Max Flow - Min Cut theorem, which states that the maximum
flow that can be transferred from a set of source nodes to a set of sink nodes across a graph equals
the capacity of the minimum cut. The facility analysis in Simulator finds a min cut, although this cut
may not be unique.
The application consists of three stages:
1.

2.

3.

Convert the electric network to a graph structure
In this stage, each branch of the system is converted to an undirected arc with graph flow capacity
equal to one. Thus, only one unit of graph flow can be sent through a branch. The Facility buses
and the External buses are converted to Facility and External supernodes, respectively. This
effectively reduces the problem to finding the min cut between these two supernodes. The number
of nodes and capacities of the Facility and the External region are also computed during this stage.
Find the Max Flow using the Augmenting Path Algorithm
This is an iterative process. At each step, the algorithm finds a new augmenting path from the
Facility to the External region and augments the graph flow along this path in one unit.
Consequently, the branches in the path won’t be available for flow augmentation in the next step.
Each new path is determined using a shortest path routine. The algorithm stops when no
augmenting path from the Facility to the External region can be found. The number of units
transferred from the Facility to the External region (path augmentations) reaches the number of
branches in a certain cut. Note that the number of branches in the min cut can not exceed the
capacity of either the Facility or the External region.
Determine the branches in the min cut
The identification of the branches that constitute the min cut consists in tracking down labels in
the buses and branches used during each path augmentation.
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Graph Flow
Most network and graph theory applications use the concept of flow to represent any object that can
be transported, such as communication packets or trucks, but also connectivity properties of graphs.
In the augmenting path max flow min cut algorithm the flow is an artificial concept used to represent
topological connectivity of buses. Two buses are adjacent if flow can be sent from one to the other
through a branch.
Graph Flow Capacity of a Branch
Networks that transport some flow are said to be capacitated if its arcs (here synonym of
"branches") have some limit associated to the flow transportation. For instance, capacity of a
communication channel, or number of trucks that can be simultaneously on a certain road. The
algorithm used in the Facility Analysis assigns a capacity of one to each branch. This means that the
branch can be used only once for "connecting" two nodes.
Graph Flow Capacity of a Cut
The capacity of a topological cut is equal to the sum of the capacities of its arcs. In the Facility
Analysis, the capacity of the min cut is equal to the number of branches in the min cut, since each
branch has a capacity of one.
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Governor Power Flow
The Governor Power Flow dialog shows all information related to solving a governor power flow. The
dialog is accessed by selecting Other > Governor Power Flow from the Other Tools ribbon group
on the Tools ribbon tab. Using this dialog, you can modify settings related to solving the case while on
Governor or "Island-Based Automatic Generation Control (AGC)".
The Governor Power Flow Dialog has two tabs, Options and Generator Options, which are described
below.
Generator Options Tab
This tab sheet presents a case information display with all the generators of the case. The columns
shown in the display are helpful when looking at solving a Governor Power Flow.
Options Tab
This section describes the options available on the Options tab of the Governor Power Flow
dialog. The dialog is accessed by selecting Other > Governor Power Flow from the Other
Tools ribbon group on the Tools ribbon tab.
This tab sheet presents the following controls:
Disable Automatic Generation Control
Disables automatic MW generation changes during the power flow solution.
Island AGC Tolerance
The ACE mismatch tolerance allowed for the Island to be considered solved in terms of
generation dispatch.
Island-Based Automatic Generation Control
Select how the generations should be controlled for the dispatch.
 Disabled: The area and super area dispatch settings from the case will be used
 Use Participation Factors of individual generators: Each generator will have it’s own
participation factor, and will contribute according to its participation factor divided by the
sum of all participation factors of all other generators in the same island.
 Calculate Participation Factors from Area Make Up Power Values: Each area is assigned a
"factor" as to how it should participate towards the generation dispatch in the island.
This is similar to participation factors for generators. The total percentage the area
contributes towards the generation change needed in the island is equal to its individual
factor divided by the sum of all area make up power factors. Then within each area, the
generator participation factors determine how the area’s percentage is made up of
available generation within the area. The area make up power values can be set in the
table of areas on the right hand side of the dialog.
 Dispatch using an Injection Group: The island dispatch will be made up by a combination
of generators and loads, defined in an injection group that can be selected from the
dropdown list.
How should reactive power load change as real power load is ramped?
If you are using an injection group with load as part of the dispatch, then you can specify
how the reactive power load should respond as the real power demand of loads changes with
the dispatch. The reactive power can either be kept at the starting ratio of real and reactive
power of the load, or the MVAR amount can change at each load by a specified power factor.
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Governor Power Flow: Generator Options (Ignore Area/Zone/Owner filter) Tab
This tab sheet presents a case information display with all the generators of the case. The columns
shown in the display are helpful when looking at solving a Governor Power Flow.
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Governor Power Flow: Options Tab
This section describes the options available on the Options tab of the Governor Power Flow dialog. The
dialog is accessed by selecting Other > Governor Power Flow from the Other Tools ribbon group
on the Tools ribbon tab.
This tab sheet presents the following controls:
Disable Automatic Generation Control
Disables automatic MW generation changes during the power flow solution.
Island AGC Tolerance
The ACE mismatch tolerance allowed for the Island to be considered solved in terms of generation
dispatch.
Island-Based Automatic Generation Control
Select how the generations should be controlled for the dispatch.






Disabled: The area and super area dispatch settings from the case will be used
Use Participation Factors of individual generators: Each generator will have it’s own
participation factor, and will contribute according to its participation factor divided by the sum
of all participation factors of all other generators in the same island.
Calculate Participation Factors from Area Make Up Power Values: Each area is assigned a
"factor" as to how it should participate towards the generation dispatch in the island. This is
similar to participation factors for generators. The total percentage the area contributes
towards the generation change needed in the island is equal to its individual factor divided by
the sum of all area make up power factors. Then within each area, the generator participation
factors determine how the area’s percentage is made up of available generation within the
area. The area make up power values can be set in the table of areas on the right hand side of
the dialog.
Dispatch using an Injection Group: The island dispatch will be made up by a combination of
generators and loads, defined in an injection group that can be selected from the dropdown
list.

How should reactive power load change as real power load is ramped?
If you are using an injection group with load as part of the dispatch, then you can specify how the
reactive power load should respond as the real power demand of loads changes with the dispatch.
The reactive power can either be kept at the starting ratio of real and reactive power of the load, or
the MVAR amount can change at each load by a specified power factor.
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Set Generator Participation Factors
Participation factor control is another of Simulator’s mechanisms for distributing an area’s responsibility
to serve its load, losses, and interchange. It is particularly well-suited to implementing automatic
generation control (AGC) when you do not have good economic information for an area’s generators.
With participation factor control, the amount of power that each generator contributes to meeting its
areas load, loss, and interchange responsibilities is controlled by the size of its participation factor. The
unit that has the largest participation factor contributes the most, and the unit that has the smallest
participation factor contributes the least.
The Set Generator Participation Factors Dialog gives you a convenient way to define the
participation factors for multiple generators. You can set the participation factor according to a number
of different formulae and then apply this prescription to all generators in a specific area, all generators
in a specific zone, all generators in the system, or all generators whose display filters are currently set
to true.
To display the Set Generator Participation Factors Dialog, you first need to open the Area
Information Dialog and switch to the Area MW Control Options page. The Area Information Dialog has
a button labeled Set Participation Factors that is enabled only if the Participation Factor Control
option is selected under the Area Control Options heading. Set the area on participation factor control
by selecting the Participation Factors option, and then press the Set Participation Factors option.
The Set Generator Participation Factors Dialog is divided into two parts. The first part, which occupies
the top half of the form, allows you to indicate how the participation factors should be calculated or
set for each generator. Your options include:
Max MW Rating of Generator The participation factor for each generator is set to the generator’s
maximum MW capability.
Difference Between Max and Current Output The participation factor for each generator is set
to the generator’s reserve power, so that each generator participates in proportion to how much it
has left to contribute.
Constant Value of The participation factor for each generator is set to the same hard-coded value.
File The participation factor for each generator is read from a file. The first line of the file should
contain the keyword NUMBERS or NAMES indicating whether generators are identified by bus
number or by bus name in the file. All subsequent lines should be comma-delimited and contain
three fields: the number or name of the generator’s bus, the generator’s id, and the generator’s
participation factor.
If you choose any of the first three options, you then must tell Simulator to what generators you want
to assign the participation factors. To assign the participation factors to all generators in a specific
area, select the All Generators in Area option, and then choose the area from the adjacent
dropdown box. If you want to assign the participation factors to all generators in a specific zone, select
the All Generators in Zone option, and then choose the zone from the adjacent dropdown box. If
you want to assign the participation factor to all generators in the system regardless of their area or
zone affiliation, select the All Generators in System option. Finally, if you want to assign the
participation factor to just those generators whose display filter criteria evaluates to true, choose the
All Generators With Valid Display Filters option.
If you instead chose to read participation factors from a file, only those generators whose factors you
read from the file will have their factors set by this action. However, unless each generator’s
associated area is set to control generator output using participation factor control, this information
will be ignored. To make sure that each generator’s area is set to participation factor control, check
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the Set Corresponding Areas to Participation Factor Control box. Then, each corresponding
area will be set to participation factor control.
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Set Selected Field
The Set Selected Field option is an often unused featured in Simulator, but can at times prove very
useful. Each object in Simulator has a property called Selected?, which does nothing in Simulator
other than allow the user to choose a specialized set of objects for some other purpose, such as
advanced filtering a display. The user can add a column to most types of case information displays
which shows the value of the Selected property for the type of object being observed. By default, this
field is always set to No. However, the user can change the value of this field, and then sort the
column, filter the display, or any other action that can normally be performed on a column of a Yes/No
type.
Set Selected Field to YES from a Oneline diagram
If you right-click on a group of selected oneline objects, one of the local menu options that appears
is Set Selected Field to YES. Choose this option to change the Selected field for all the underlying
data objects' Selected field to YES.

Set Selected Field for Network Cut
In addition to modifying the Selected property manually in a case information display, it is also
possible to define a group of buses' Selected property by defining a network cut on the system.
Choosing the Set Selected Field for Network Cut option from the Tools menu will open the
network cut dialog automatically for setting the Selected property of a group of objects according
to a desired cut plane chosen.
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Network Cut
The Network Cut tool is another method for choosing sets of buses for such features as Scaling or
Equivalencing.
The use of the network cut method is to define a set of branches as the "cut" plane, then choose a
bus on one side or the other of the cut to indicate which side of the cut you are interested in. The
network cut dialog provides the functionality necessary for defining the network cut.
Defining Network Cut
The first step in defining the network cut is to choose the branches which define the cut plane in the
system. The one caution is to be sure you select a closed loop cut plane. In other words, you must
select a set of branches which completely topologically separates two portions of the system. If you
only choose a partial cut plane, which does not completely cut the system in two distinct pieces,
then attempted use of the ill-defined cut plane will fail.
To choose the branches which define the cut plane, simply highlight the branches by clicking on
them in the list. For each branch you highlight, you must click on arrow button (pointing to the box
on the right) to add the branch to your cut plane definition. You can make use of the control (Ctrl)
and shift keys to select multiple branches at one time in the list of branches. Note that you can also
select a cut plane similarly using interfaces or DC lines.
Once you have the branches (or interfaces or DC lines) selected which form the cut plane, you then
need to choose a bus on either side of the cut plane to indicate which side you are interested in. The
bottom panel on the display allows you to locate and select this bus.
Require Paths to be Energized
This option can be checked if the branches forming a network cut should be energized to be
included.
Include How Many Tiers of Neighbors
Once the network cut has been defined by a set of branches and the bus defining which side of
the cut is being examined has been chosen, this option will then include buses within so many
tiers of the network cut boundary, on the opposite side of the cut as the specified bus. If the
number of tiers is set to zero, then the buses examined will only be those on the same side of
the cut as the bus selected.
Setting the Field
Once the network cut has been defined and the side of the cut to be examined has been chosen, the
appropriate field for each bus in the area of interest can be set. If the network cut is for the
equivalencing tool, then the field to set is the Which System property, which defines if a bus is in
the external or study system when creating an equivalent. If the network cut is for the scaling tool,
then the field to set is the Scale property, which defines if a bus is to be included in a scaling
action.
Filter by KV
The buses within the network cut can be filtered by nominal voltage level before the field(s) are
set. Only buses that are within the network cut and are within the nominal KV level specified will
have their fields set to the desired value.
Use Area/Zone Filters

946
©2011 PowerWorld Corporation

The buses within the network cut can be filtered by the area or zone in which they are contained
before the field(s) are set. Only buses that are within the network cut and whose area meets the
defined Area/Zone filter specified will have their fields set to the desired value.
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Create New Areas for Islands
When an area spans multiple electric islands, area MW interchange control may not be possible.
Consider two scenarios shown below. The scenario on the left has Area #1 that spans three islands
while Area #2 is contained within a single island. Island C contains both Area #1 and Area #2.
Because Area #1 only spans one island that contains more than one area, area interchange control is
allowed. When balancing the area interchange in Island C, it can easily be determined what generators
will respond. Only those generators in Area #1 in Island C will respond with interchange between Area
#2. Internally when the power flow solution is solved, Simulator creates temporary areas for the
portion of Area #1 that is in Island A and the portion that is in Island B. This ensures that only those
generators that are in Island C will respond to interchange with Area #2. In this scenario, both Area
#1 and Area #2 are allowed to be on area interchange control.
The scenario on the right has Area #2 that spans two islands and Area #1 that spans three islands.
Because both of the areas are contained in islands that have more than one area, area interchange
control is not allowed for both Area #1 and Area #2. Control is not allowed because Simulator does
not have enough information to determine in which islands the area transactions are supposed to
occur. In this scenario, Simulator will turn off AGC for areas that meet these conditions.

With the Create New Areas for Islands option, permanent areas can be created that match the areas
that Simulator creates temporarily while solving the power flow. New areas will get created if an area
is on AGC, spans multiple viable islands, and only one of those islands has more than one area in it. An
island is considered viable if it has closed non-zero load and an online generator or it has an online
generator that is connected to the rest of the system via a DC line. For an area meeting these criteria,
new areas will get created for the portion of the area in islands that contain only one area. If an area
spans multiple islands and each island contains only a single area, new areas will get created for the
islands that have the fewest buses. New areas will only get created if there are generators on AGC or
online load in more than one of the islands in which the area has buses. New areas will use the same
AGC method as their original area unless that area in on area slack bus control. In that case, the new
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areas will be on no AGC. New areas will be names with the original area name with the slack bus for
the island appended.
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Browse PWB File Headers
The Browse PWB File Headers is accessed by selecting Other > Browse PWB File Headersfrom the
Other Tools ribbon group on the Tools ribbon tab.
When selected, Simulator will prompt you to specify a directory containing PWB files for which you
wish to preview the header (case description) text. Once the directory has been specified, Simulator
will obtain the case description for each PWB file in the directory, and write them all into the Simulator
message log.
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Browse Open Onelines
All the objects in all the open .pwd files can be listed in the Browse Oneline Environment dialog. To do
so, go to the Onelines ribbon tab, Active ribbon group and choose List Display > Browse open
onelines in Edit Mode or Run Mode. The power system objects are listed on tabs according to their
type. For instance, all the buses and bus fields are listed in the Buses tab while all the generators and
generator fields are listed in the Generators tab. The Others tab lists all the objects on the onelines
which are not associated with power system elements, e.g. background lines or images. The All tab
lists all the objects in all the open onelines. The default display columns for each grid include the
oneline file name of the object and the type of the object. Objects that are linked to case elements
also have identifying information about the data element that they represent. The Others and All
pages include the default display columns for generic display objects.
The oneline displays can be panned to the selected object. To do so, select one object from the
Browse Oneline Environment dialog and right click to invoke the local popup menu. Click
ScreenObject Records > Pan to Object on Open Onelines. This will bring the oneline with the
selected object to the front and pan to the selected object. When panning, the browsing dialog can be
kept on top if Keep browsing dialog on the top when choosing Pan Oneline to Object is
checked. Otherwise, the dialog will be sent to back when panning.
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Unused Bus Numbers
When making changes to a power system case, it is often beneficial to know which bus numbers are
still available. To save a list of unused bus numbers to a text file, while in Edit Mode, go to the Tools
ribbon tab, and choose Modify Case > List of Unused Bus Numbers from the Edit Mode ribbon
group. Enter a range of bus numbers in the dialog and click OK. In the Save As Dialog, specify the
text file where the list of bus numbers should be written and click Save. Only those unused bus
numbers in the specified range will be listed in the file. Clicking Cancel at any point will abort saving
the list to a file.
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Equivalents
An equivalent power system is a power system model of smaller dimension than the original system
that approximates the behavior of the original system reasonably well. In reality, most power system
models are actually an "equivalent" of a much larger interconnected network. When performing power
system studies, it may be desirable to reduce the size of the system model even further so that it may
be solved more quickly.
To bring up the Equivalents Display, while in Edit Mode, go to the Tools ribbon tab, and choose
Equivalencing... from the Edit Mode ribbon group.
The most important part of constructing an equivalent is determining which buses should be explicitly
retained in the equivalent, and which buses should be equivalenced, or removed from the case.
Several definitions are useful here:
Study System
The buses that are to be retained.
External System
The buses that are to be equivalenced.
Boundary Buses
Any buses in the study system that are connected to buses in the external system.
How well the equivalent system approximates the behavior of the original system depends upon which
buses are retained in the study system. Retaining more buses yields results that more closely match
those of the original case, but at the expense of greater computation time. The number of buses to
retain in the study system depends upon how the equivalenced system will be used. Building system
equivalents is as much an art as it is a science, with few solid rules of thumb. However, to improve
accuracy, you should retain as many generator units as possible.
The actual equivalent is constructed by performing a matrix reduction on the bus admittance matrix. A
result of this process is the creation of "equivalent" transmission lines that join boundary buses
equipped with equivalent shunts or loads. Equivalent lines typically have a circuit identifier of 99, but
have also been seen to have other numerical values between 90 and 99, or an alphanumeric identifier
of EQ. Since many of the equivalent lines created during the matrix reduction have very high
impedance values, an option is provided to ignore equivalent lines with impedances exceeding a
specified threshold value. Additionally, an option is provided to convert the equivalent shunts added at
the boundary buses to constant PQ loads. These PQ loads will be given circuit identifiers similar to
those given to equivalent transmission lines.
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Equivalents Display
The Equivalents Display is used to construct equivalent systems. An Equivalent System is a system
of smaller dimension that exhibits similar power flow properties. Equivalent systems are constructed to
help accelerate computation time without sacrificing a significant amount of accuracy. For more
information, please see Equivalents.
To bring up the Equivalents Display, while in Edit Mode, go to the Tools ribbon tab, and choose
Equivalencing... from the Edit Mode ribbon group. This display contains two pages, the Select The
Buses Pageand the Create The Equivalent Page. Use the Bus Selection Page to partition the
power system into the study system and the external system. Use the Create Equivalent Page to




Save the external system in a file
Extract the external system
Build an Equivalent

Each of these tasks is described below.
Select The Buses Page
To perform any of the tasks described on the Create Equivalent Page, you first need to specify the
study system and the external system. Do this by directly assigning buses to the desired system. The
Select The Buses Page has been designed to provide a number of powerful and complimentary ways
of accomplishing this task.
The most important point to keep in mind when using this page is that membership in the study
system and the external system is on a bus-by-bus basis (as opposed to by areas or zones). Thus,
each bus is either in the study system or the equivalent system. Each bus’ current assignment is
indicated in the Buses list, which is shown on the bottom left corner of the page. The Buses list is a
Case Information display and can be manipulated similar to other displays. By default, all buses initially
reside in the study system. Please see Select The Buses Page for more details.
Create The Equivalent Page
The Create Equivalent Page allows you to save the external system in a file, to delete the external
system, and to build the power system equivalent.
Build Equivalent
This procedure constructs an equivalent system. For background on equivalents, please see
Equivalents. The following sections contain the options for building an equivalent.
Delete All External Generators or Retain Generators with Max MW Ratings Above
If the Delete All External Generators checkbox is checked, the equivalencing routine will
remove all external generators from the case, regardless of their MW rating. Otherwise, the
equivalencing routine will add to the study system any generators originally in the external
system whose real power output exceeds the specified value. Retaining large generators often
makes an equivalent significantly more accurate. If you do not wish to retain any additional
generators, check the Delete All External Generators checkbox.
Retain Remotely Regulated Buses
Some generators and transformers regulate buses other than their terminals. When this box is
checked, these remotely regulated buses are automatically included in the equivalent if the
regulating generator or transformer is included. If the box is not checked, the regulated bus is
set to the terminal of the retained object. It is strongly recommended that you leave this box
checked at all times.
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Retain Branch Terminals For
This section allows you to customize the retention of branch terminals for special-case types of
branches. You may choose to retain terminal buses for transformers, zero impedance ties, area
tie lines, and/or zone tie lines.
Max Per Unit Impedance for Equivalent Lines
During the equivalencing process, a number of equivalent lines are created joining the boundary
buses. All equivalent lines with per unit impedance values above this threshold are ignored.
Two Character Circuit ID for New Equivalent Lines
Choose the circuit identifier to be used for the equivalent lines that are created. Choose between
97, 98, 99 or EQ for circuit IDs of equivalent lines.
Remove External Objects from Onelines
This feature removes display objects associated with the external system from any open
onelines.
Convert Equivalent Shunts to PQ Loads
During the equivalencing process, shunt elements are added at the boundary buses. Check this
box if you would like these equivalent shunts converted to constant PQ loads. If this option is
checked, equivalent loads are created with a load ID of 99.
Remove Radial Systems
Checking this option results in all radial connections in the network to be reduced to their nearest
non-radial bus (i.e. node.) The equivalencing routine will iteratively reduce the network when this
option is checked, until no more radial connections exist in the system.
Delete Empty Areas/Zones/Substations that occur from Equivalencing
Since equivalencing is a process which ultimately removes buses from the system, and Areas,
Zones and Substations are system devices which are groups of buses, this option will
automatically remove the definition of these types of objects when all buses within them are
removed from the case during the creation of the equivalent.
Adjust Area Unspecified Interchange to Zero Out ACE
Selecting this option will allow Simulator to automatically change the unspecified MW interchange
amounts of each area to remove any non-zero ACE discrepancies caused by the equivalencing.
This will help prevent these discrepancies from being assigned to the system slack bus.
Include Generator Dynamic Equivalents
Selecting this option will allow Simulator to automatically create dynamic equivalents of
generators.
Minimum PU H for New Equivalent Generators
During the equivalencing process, a number of equivalent generators are created. All equivalent
generators with per unit impedance values below this threshold are ignored.
Two Character Circuit ID for New Equivalent Generators
Enter the circuit identifier to be used for the equivalent generators that are created. Default is
EQ.
Select Build Equivalent System to construct the equivalent system. Constructing an equivalent
system permanently removes the external system from the case and adds a number of equivalent
lines and shunts/loads.
Saving the External System in a File
This procedure allows an external system to be saved in a file without deleting the external
system. This option is useful for allowing you to save a portion of the system in a file, modify it
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using perhaps another program, and then use Append Case to append the modified file to the
original case.
When saving the external case, there are two options: 1) save just the external case, or 2) save the
external case and any ties to the original case. Option one just saves the external case, while option
two saves the external case and any transmission lines or transformers that connect the external
system to the rest of the system. Save just the external case if you are planning to use the external
case as a standalone case. Save the external case and its ties if you are planning to modify the
external case and then to append it back to the original case.
Click Save External System to save the external system in a file. You will be prompted for the
desired case format.
Deleting the External System
This procedure deletes the external system from the original case. All devices in the external system
are removed, including any buses and lines/transformers in the external system and any
lines/transformers that join the external system to the study system. Check the Remove External
Objects from Onelines to remove any display objects linked to the external system from the open
onelines.
This command permanently removes the external system from the case; an equivalent system is
not created. Select Delete External System to actually delete the system.
Merge Bus Shunts Across Zero Impedance Branches
This procedure merges bus shunts that are across zero-impedance branches.
Merge Bus Shunt Values Above
During the merging process, only will merge bus shunts values above this threshold.
Merge Across Branches
During the merging process, only will merge bus shunts across branches with X, R less than the
specified threshold.
Merge Shunts
Press the button to merge the shunt buses as specified by the previous options.
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Select The Buses
The Bus Selection page is currently used with two displays:



The Equivalencing Display, to partition the system into the study subsystem ("Study") and the
external subsystem ("External").
The Facility Analysis Dialog, to determine the buses in the external subsystem from which the
buses in the facility would be isolated.

The following description concerns the Equivalencing Display, but the functionality of the Bus Selection
Page is similar for both applications.
Buses, Areas, and Zones lists
For both equivalencing and facility analysis, use these lists to manually change the system
designation of individual buses, areas, or zones. Note that changing the system designation on the
area or zone tab is just another form of changing the designation of study / external system of
individual buses. Click on the Which System? field in each of these tables to toggle the object’s
affiliation with the study or external systems, subject to the values of the Filter by kV option and
the Include how many tiers of neighbors? field.
In addition, the bus selection table for facility analysis contains one additional column labeled
Selected. This Yes or No field indicates which buses in the Study system belong to the Facility
being analyzed. Double-clicking one of the fields in this column will toggle the value of the field
between Yes and No.
External
Use these fields to specify a range of areas, zones, or buses to be added to the external system. The
Filter by kV and Include how many tiers of neighbors? controls will also shape the selection of
buses to add to the external system.
Study
Use these fields to specify a range of areas, zones, or buses to be added to the study system. The
Filter by kV and Include how many tiers of neighbors? controls will also shape the selection of
buses to add to the study system.
Include how many tiers of neighbors?
This value indicates the number of tiers of neighbors to carry with each selected bus when adding
the selected bus to either the study or external system. For example, if Neighbor Tiers is 1 and we
elect to add bus X to the external system, both bus X and its first tier of neighbors will be added to
the external system. If Neighbor Tiers is 0, only bus X will be added to the external system.
Filter by kV
If the Filter by kV box is checked, then only buses having a nominal voltage level between the
values given in the Max kV and Min kV fields can be selected.
Set All As External
Click this button to assign all buses to the external system.
Set Branch Terminals External or Study
Clicking either of these two buttons allows setting advanced filter criteria which define a branch or
group of branches. Once the criteria are set, clicking Filter will select the terminal buses of all
branches meeting the filter criteria, and set those buses to either the External or Study system,
depending on which button was pressed.
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Select Buses using a Network Cut
A custom network cut can be defined for choosing which buses should remain in either the Study or
External system.
Save Buses to File
Once the system has been partitioned, this command allows you to store the numbers of the buses
of the study system in a text file.
Load Buses from File
Click on this button to load a listing of the buses to be included in the study system from a text file.
You will be prompted to select the text file. The format of this text file is such that one bus number
occupies each line. Any buses not identified in this file are defined as being in the external system.
Example
Assume you would like to create an equivalent containing all the buses in areas 1-5 and 10, plus any
tie buses, and bus number 2050.





Since initially all buses are in the study system, first enter 1-1000 in the Areas field of Add to
External System. Since the area of every bus is within this range, this places all the buses in
the external system. Alternatively, click Set All as External to accomplish the same objective.
Set Include how many tiers of neighbors? to 1. This indicates that all subsequent
selections will affect the specified buses and their first tier of neighbors.
In the Areas field of Add to Study System, enter 1-5,10. This places all the buses in these
areas, plus any tie buses (since Neighbor Tiers is 1), into the study system.
In the Buses list, double-click in the Which System field for bus 2050 to change its status
from External back to Study.
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Appending a Case
The Append Case command allows you to append additional power system components to an existing
case. Unlike the Open Case command, Append Case does not delete the existing case (if any) before
loading the selected case. To append a case to the existing case, go to the Tools ribbon tab and
choose Modify Case > Append Case from the Edit Mode ribbon group.
The Append Case command can be useful when used in conjunction with the Equivalencing Display.
See the Case Formats topic for information on special handling of data that occurs when appending a
case using specific file formats.
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Merging Buses
Two or more buses can be merged to a new bus in Edit Mode with the loads, generators, and shunts
of the buses merged moved to the new bus. The transmission lines among the buses merged will be
deleted while the transmission lines connecting the merged buses and buses which are not selected to
merge will be moved to the new bus.
To join two or more buses together using the oneline display, select at least two power system
elements (at least one of them being a bus), then right click on one of the selected elements to invoke
the popup menu and select Merge selected buses. In the Bus Merging Dialog, specify the buses to
merge further if needed by clicking Add and/or Delete button. To add buses to merge, click Add and
select all the needed buses in the Choose a Bus dialog and click OK. To delete from already selected
buses, select the buses to delete and click the Delete button.
Once you have the elements to merge selected, enter the number, name, nominal voltage, zone
number, area number and substation number for the new bus. These properties can be set to be the
same as one of buses to merge by selecting it in the Specify buses to merge box and pressing the
Set new bus properties same as selected bus.
Buses can also be merged in the Bus Case Information Display. To do so, select a cell and right click to
popup the local menu. Select Merge selected buses. The buses to merge and the properties of the
new bus can be edited in the Bus Merging Dialog.
When buses are merged from the oneline diagram, the selected buses will be joined in both the PWB
case and the oneline. When buses are merged from the bus grid, the selected buses will be joined only
in the PWB case but not in the oneline. This might result in bus objects not connected to bus records
in the oneline.
NOTE:Special consideration is taken when merging buses that are part of a multi-section line. If a) all
buses are part of a multi-section line, b) all buses are contiguous within the multi-section line definition
(all connected in series), c) include at most only one of the two multi-section line's terminal buses, and
d) the resulting merge would leave at least two remaining sections of the multi-section line, then the
multi-section line record will remain defined and be modified to reflect the changes incurred by
merging buses and removing line sections within the record. If ANY of the above criteria are NOT met
when one or more buses within a multi-section line grouping are being merged, the merge will be
performed but the multi-section line record will be removed. The actual system devices will remain (in
their post-merged state) but there will no longer be a multi-section line record grouping any of the
devices for multi-section line reporting.

960
©2011 PowerWorld Corporation

Splitting Buses
Simulator assists you in transforming one bus into two connected buses. This process is called splitting
a bus. In performing the split, the user is able to decide which equipment to keep connected to the
original bus and which equipment to move to the new bus. Because this activity impacts the structure
of the power flow equations, bus splitting can be performed only in Edit Mode.
To split a bus from the oneline diagram, right click on the bus you wish to split, and click Split Bus
from the resulting local menu. To split a bus from the Bus Case Information Display, right-click on its
corresponding record and again click Split Bus from the resulting local menu. In either case, the Split
Bus Dialog will appear.
Multi-section lines merit special consideration during bus split operations. These are the rules
Simulator follows when you try to split a bus that is part of a multi-section line. If the original bus is
the endpoint bus of a multi-section line and the ending line segment was transferred to the new bus,
then the new bus becomes the new ending terminal of the multi-section line. If the original bus was a
dummy bus of the multi-section line, and if exactly one of the branches connected to the original bus
is rerouted to the new bus, then both the new bus and the original bus will be dummy buses in the
reconstituted multi-section line. If neither or both of the lines connected to the original dummy bus
were rerouted to the new bus, then the multi-section line definition is eliminated, since Simulator has
no way to determine how the multi-section line should be redefined.
A final consideration involving bus splits is how sequence data is treated. If you have defined sequence
data for fault analysis, Simulator will recalculate the sequence data for the original and new buses
after the split. In this case, the zero sequence impedance for the new branch that connects the
original and the new bus will be set to j0.0001.
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Split Bus Dialog
The Split Bus dialog contains two sections labeled Existing Bus and New Bus. These sections enable
you to designate the bus you want to split and the name and number of the new bus created by the
bus split operation. If you opened the Split Bus Dialog from either the Bus Case Information Display or
an oneline diagram, the Existing Bus Name and Number fields will be read-only and will identify the
bus you selected. However, if you opened the Split Bus Dialog from the Modify Case Menu on the
Edit Mode ribbon group on the Tools ribbon tab, you will first have to choose a bus to split. In this
case, use the Find… speed button located next to the Existing Bus label to select the bus to split, or
simply type its number in the Existing Bus Number field. Then, provide the name and number for the
new bus to create using the New Bus Name and Name fields. The number you specify in the New Bus
Number field must be unique; it cannot be a number that identifies another bus in the case. If you do
specify an existing number, Simulator will issue an error message and require you to specify a
different number. If you choose not to specify a name for the new bus, Simulator will set the name of
the new bus to be the same as the bus’s number.
Once you have identified the bus to split and the name and number for the new bus resulting from the
split, you may then specify whether a bus tie should be inserted between the existing bus and the
soon-to-be-created new bus. By checking the Insert bus tie between existing and new buses
checkbox, you command Simulator to place a very low-impedance bus tie between the bus to split and
its offspring. The new branch will have an impedance of 0.0000 + j0.0001 ohms. If the bus tie should
be inserted as an open branch, check the Normally open checkbox. This option becomes available,
of course, only if you elect to have Simulator automatically add the new bus tie.
After you have finished making your selections, click OK. Simulator will create the new bus, assign its
electrical attributes to match those of the existing bus, and add the bus to the power system model. If
a oneline diagram is currently active and the existing bus is represented on it, Simulator will add a
symbol for the new bus to the diagram, placing it immediately to the right of the existing bus’s symbol.
If you elected to create a bus tie between the existing and new buses, Simulator will also add a
symbol for the bus tie to the diagram.
Finally, Simulator will automatically open the Equipment Mover Dialog to help you manage the transfer
of equipment from the existing bus to the new bus.
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Equipment Mover
Simulator provides a convenient tool for transferring equipment between buses. Simulator allows you
to move bus shunts, loads, generators, switched shunts, and transmission lines between buses. For
loads, generators, and both varieties of shunts, Simulator offers you the ability to transfer all or part of
the equipment from the origin bus to the destination bus.
Equipment may be transferred between buses using the Equipment Mover Dialog. The Equipment
Mover Dialog can be opened in any of four ways:






Go to the Tools ribbon tab and choose Modify Case < Move Bus Equipment... from the Edit
Mode ribbon group.
On the oneline display right-click on the bus from which you want to move equipment and select
Move Equipment… from the resulting local menu.
From a Bus Case Information Display, right-click on the record corresponding to the bus from
which you want to move equipment and select Move Equipment … from the resulting local
menu.
As the final step of the Split Bus operation.

Regardless of the approach you take, Simulator will then open the Equipment Mover Dialog. The
Equipment Mover Dialog consists of three sections. The top portion of the dialog is split in two sections
that identify the bus from which equipment will be transferred (on the left) and the bus equipment will
be transferred to (on the right). If the dialog was opened as the final operation of the Split Bus
operation, these two buses will be hard-coded to identify the original bus and the bus resulting from
the split. If the dialog was opened from the main menu, you must select both the origin and
destination buses from lists that are reminiscent of case information displays. If the dialog was opened
using one of the other two methods, the origin bus will be set to the bus you selected, and you will
then have to choose the destination bus. To select a bus to be an origin or destination bus, simply
select the corresponding record from the appropriate list.
Once the origin and destination buses have been identified, you must then select the equipment to
transfer from the origin to the destination bus using the case information display that occupies the
bottom of the dialog. To move a particular piece of equipment, toggle the value of the Move Object?
field to YES. To move just portions of loads, generators, or shunts from the origin to the destination
bus, adjust the value of the Move % field from 100.0 to the percentage you desire.
Once you have selected the equipment you wish to transfer, click the Move equipment button.
Simulator will adjust the power system model to reflect your equipment transfer requests.
Furthermore, Simulator will provide you an opportunity to manually adjust all open oneline diagrams to
reflect the equipment transfers. To facilitate this activity, Simulator will open a Potential Misplacements
Dialog for each oneline that displays the origin bus. The Potential Misplacements Dialog lists the
display objects associated with the equipment that had just been transferred from the origin to the
destination bus. By clicking on an entry in this list, you can pan the associated oneline diagram to
focus on that object. This allows you to identify display objects that perhaps should be relocated to
reflect their new bus associations. Once you have finished addressing these potentially misplaced
display objects, click the OK button to close the Potential Misplacements Dialog.
If you find that you would like to reopen the Potential Misplacements Dialog after you have closed it,
click the List most recent transfers button. This will reopen the Potential Misplacements Dialog
associated with the most recent equipment transfer operation.
To conclude the equipment transfer operation, click the Close button.
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Potential Misplacements Dialog
In the wake of an equipment transfer operation using the Equipment Mover Dialog, some oneline
display objects may be out of place. To ease the task of correcting these misplacements, Simulator
provides the Potential Misplacements Dialog. Simulator opens a Potential Misplacements Dialog for
each oneline that displays the bus that served as the origin for equipment transfer. The Potential
Misplacements Dialog lists the display objects associated with the equipment that had just been
transferred from the origin to the destination bus. By clicking on an entry in this list, you can pan the
associated oneline diagram to focus on that object. This allows you to identify display objects that
perhaps should be relocated to reflect their new bus associations. Once you have finished addressing
these potentially misplaced display objects, click the OK button to close the Potential Misplacements
Dialog.
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Tapping Transmission Lines
Simulator eases the process of inserting a bus at some location along an existing transmission line.
This feature can be extremely useful when you want to add a new generation site to a model, for
example. Rather than having to delete an existing line, place the bus, and draw two new transmission
lines, Simulator simplifies the task to a one-step process.
A line can be tapped from a oneline diagram, the transmission line case information display, or by
going to the Tools ribbon tab and choosing Modify Case > Tap Transmission Line from the Edit
Mode ribbon group. From the oneline diagram, right-click on a transmission line and select Insert
Line Tap from the popup menu. From the case information display, simply right-click on the
corresponding branch record and select Tap Transmission Line from the popup menu. Any of these
methods will open the Automatic Line Tap Dialog for setting up and inserting the new bus.
Note that transmission lines may be split only from Edit Mode. You cannot access this functionality
from Run Mode.
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Automatic Line Tap Dialog
The Automatic Line Tap Dialog will allow you to define the settings to use for inserting a new bus
along a transmission line. The transmission line to tap will be represented in the panel at the top of
the dialog, displayed as a Near Bus and Far Bus. If the Automatic Line Tap Dialog was opened by
right-clicking a line on a oneline diagram, or by right-clicking on a record in the case information
display, the line will already be selected in the panel. You can change the line selection by first
choosing the Near Bus you desire, and then selecting the Far Bus from the list of possible
connections to the chosen Near Bus. Note that the percentage entered in the Position along line
field will be in relation to the selected Near Bus. The inserted bus and new sections of the tapped line
will adhere to the following settings:
Position along line
The field labeled Position along line will indicate the point where you right-clicked the mouse
relative to the location of the Near Bus to the mouse-click in terms of a percentage of the total line
length. In other words, if the line is 10 units long, and you clicked the right mouse at location 7 units
from the Near Bus end of the line, the Position along line will indicate 70%. If you opened the
Automatic Line Tap Dialog from the case information display or the Tools ribbon tab, the Position
along Line will be set to 50%. In either case, you can adjust this setting to place the new bus more
precisely. The placement of the new bus controls how the impedances of the new lines are set, as
the impedance of each section will equal the section’s corresponding percentage length multiplied by
the impedance of the original line. Note that the original charging capacitance of the line will be
reassigned as determined by the selection under the Shunt Model option.
New Bus Number
By default, Simulator will find and set an unused bus number for you, but you can specify the
number to be used for the new bus, between 1 and 2147483647. If you enter a bus number that
already exists, you will be prompted to enter a different number when you click the Tap button.
New Bus Name
Specify a name to be assigned to the new bus. By default this field is blank, and if left blank
Simulator will set the name of the bus the same as the new bus number.
New Bus Area
You can specify the area for the new bus to be the same as the Near Bus, the Far Bus, or another
value of your specification. If you select the Specify option, the edit box and find button will
become enabled. You can then enter an area number manually, or click Find to locate an area from
the list of areas currently in the case. If you want a new area to be assigned to the case for this bus,
simply enter an unused area number manually in the box, and Simulator will automatically set up
the new area record for the case. You can then open the Area Information Display and set the name
and other values for the new area.
New Bus Zone
You can specify the zone for the new bus to be the same as the Near Bus, the Far Bus, or another
zone of your specification. If you select the Specify option, the edit box and find button will become
enabled. You can then enter a zone number manually, or click Find to locate a zone from the list of
zones currently in the case. If you want a new zone to be assigned to the case for this bus, simply
enter an unused zone number manually in the box, and Simulator will automatically set up the new
zone record for the case. You can then open the Zone Information Display and set the name and
other values for the new Zone.
Shunt Model
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Options determines how the charging B and G values of the transmission line are handled. By
default, Simulator will use the long-line PI equivalent equations to determine appropriate values for
B and G for the two new lines. Alternatively, you can assign the original charging capacitance as line
shunts at the original terminal bus ends of the two new line segments in which case the charging
capacitance of the two new branch elements will be set to 0.
Treat sections as a multi-section line
Check the box labeled Treat sections as a multi-section line to force the status of the two new
line sections to be controlled in unison. Checking this box will cause a multi-section line to be
created comprised of the two new line sections. See Multi-Section Line Information for details.
Click the Tap button to close the Automatic Line Tap Dialog and perform the line tap. If a value on the
dialog is not set properly, a warning message will appear, and you will need to either change the
specified value or cancel the process.
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Merge Line Terminals
A transmission line can be removed from a load flow case without losing the electrical connectivity of
the line's two terminal buses by merging the line terminals into a single bus. The command to merge
line terminals can be performed in two ways, and can only be invoked when Simulator is in Edit mode.
First, a MergeLineTerminals script command can be invoked in Script mode or from an auxiliary file.
The only parameter of the script command is a filter parameter, which must be populated with either
the name of an advanced filter (with the name in quotation marks) or with the text SELECTED (no
quotation marks.) If an advanced filter is given, Simulator will find all transmission lines that meet the
advanced filter definition, and will individually merge the line terminals of each line one at a time.
Simulator will retain the From bus information as the new merged bus information for each line, with
one exception. If a line was removed by merging its terminals that was the first or last segment of a
multi-section line, the multi-section line terminal bus information will always be retained as the new
merged bus.
The second way a line or lines can be chosen to have their line terminal buses merged is to select a
set of lines in the branches table of the model explorer, and to then right-click in the table and bring
up the popup menu. The option to Merge Terminals is located under the Branch Records submenu.
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Bus Renumbering Dialog
The Renumber Buses Display allows you to change the bus numbers for either the entire power
system case, and/or for any open oneline diagrams. To show this display, while in Edit Mode, go to the
Tools ribbon tab, and choose Renumber > Renumber Buses from the Edit Mode ribbon group.
The bus renumbering feature is provided because it is sometimes necessary to renumber buses in the
power system model, either to make room for new buses or to move buses to a different zone or area
that has a different numbering scheme. It may also be necessary to renumber bus display objects on
the oneline if you want to use the oneline with a case other than the one for which it was originally
designed. The bus renumbering feature provides a convenient way of accomplishing this.
The table at the bottom of the Bus Renumbering Dialog is used to manage the lists of current bus
numbers and any desired changes to the numbering scheme. You can specify the bus numbers to
change and their new values by directly typing them into the table. Alternatively, you can generate the
bus list automatically by selecting one of the Automatic Setup of Bus List Options and clicking the
Setup Bus Swap List button. The Automatic Setup options allow you to add to the list all buses in
the case, all buses in the case subject to the area/zone/owner filter constraints, all buses currently
displayed on the oneline, or a set of numbers from a text file.
The table behaves just like a Case Information Display and thus has a local menu that can be invoked
by clicking the right mouse button. Select Insert from the local menu to insert a new bus number to
change, or select Delete to delete a bus number that is currently in the list. Select Show Dialog to
display the Bus Information Dialog corresponding to the bus number on which you right-clicked. You
may clear the entire list by pressing the Clear Bus List button.
Once you have indicated which buses you would like to renumber in the table, select an option from
Bus Change Options to specify where you would like to implement the changes (in both the case
and the oneline, in the case only, or in the oneline only). Make the changes by pressing the Change
Bus Numbers button. Close the dialog by pressing Close.
The Automatic Setup of Bus List and Bus Change options deserve further discussion. See for further
details or click NEXT.
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Bus Renumbering: Automatic Setup of Bus List Options
This section of the Bus Renumbering Dialog is used to generate automatically a list of the buses to be
renumbered. Select an option from the list and click on the Setup Bus Swap List button to generate
the list, or Clear Bus Swap List to clear the list.
Load All Buses in Cases
Creates entries in the table for every bus in the system. By default the new bus number is the same
as the old bus number. Of course you do not have to renumber every bus. If you would like a bus to
keep its same number, either add that bus to the table, or simply have an entry with the old and
new bus numbers identical.
Load Buses with Valid Area/Zone Filters
Same as the Load All Buses In Case option except only those buses with valid area/zone/owner
filters are added. This allows you to easily modify the bus numbers in just an area or zone.
Load Only Buses on Oneline
Creates entries in the table only for those buses on the current oneline. This option is most useful
when you are just changing the buses on the onelines.
Load Buses From Text File
Creates entries in the table using an external text file. The format of this file is as follows:
1 11 Specifies converting from old bus number 1 to new bus number 11
2 22 Specifies converting from old bus number 2 to new bus number 22
etc.
Freshen Current Oneline
The Freshen Current Oneline option is designed to help you quickly renumber an existing oneline to
work with a new numbering scheme. You will find this method helpful if you have been using the
oneline with a case and now must use it with a different case having a different set of bus numbers,
but the same bus names. Freshen Current Oneline will try to match the buses on the oneline with
the buses in the new case by matching bus names and kV, rather than by number (which is how
Simulator usually tries to link bus display objects with bus records in the case). The best way to
learn how to use Freshen Current Oneline is to consider the following example:
To update an old oneline to work with a new bus numbering scheme:








Open the oneline and the old case with which it was used.
Choose Renumber > Renumber Buses from the Edit Mode ribbon group on the Tools ribbon
tab.
Select Load Only Buses on Oneline and press the Setup Bus Swap List button.
Change the Swap? field values all to Yes.
Right click on the table and choose Save List to File. Give the file a name. For this example, we'll
name the file "oldscheme.txt." This file will contain the list of buses represented on the oneline,
specifying each bus's number, name, kV, and area.
Close the old case.
Open the new case and the oneline you wish to renumber. If any other onelines open with the
case, close them. You want only the oneline you wish to renumber to be shown.
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Choose Renumber > Renumber Buses from the Edit Mode ribbon group on the Tools ribbon
tab.
Select Freshen Current Oneline and specify the file "oldscheme.txt" (for this example). Click the
Setup Bus Swap List button. Simulator will match the old numbering scheme used in the oneline
with elements in the new case by name and kV. If it finds more than one match, it will use the
element's area name as a tie breaker. If it still can't reconcile the multiple matches, it will add both
renumbering options to the table.
Go through the new list and make sure that you want to swap the buses that are listed. If you do,
change the Swap? field value for each to Yes (you can do this quickly for all buses by rightclicking on the Swap? column and choosing Toggle All Yes). Be sure to reconcile any duplicate
bus renumbering suggestions. These are cases for which Simulator could not determine how to
renumber the buses because a bus on the diagram matches more than one bus in the case by
name, kV, and area.
Click the Change Bus Numbers button at the bottom of the form.

Once the oneline has been renumbered, save it with the case by selecting Save Case (or Save
Case As if you wish to give it a different name) from the Application Button. See Bus Change
Options for additional details.

971
©2011 PowerWorld Corporation

Bus Renumbering: Bus Change Options
This option is used to specify which buses to change.
Change Both Case and Onelines (default)
Renumbers the buses in both the case and any open oneline diagrams.
Change Only Case
Only renumbers the buses in the case. The oneline bus numbers are not changed.
Change Only Onelines
Only renumbers the buses on the onelines. The case itself is not changed. You would want to select
this option if you have already changed the case (or loaded a different one), but now have several
onelines based on that case that also need to be changed. See Automatic Setup of Bus List Options
for more details. This is the most commonly used option.
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Renumber Areas/Zones/Substations Dialog
The Renumber Areas/Zones/Substations Dialog is available while in Edit Mode, by going to the Tools
ribbon tab, and choosing Renumber > Renumber Areas/Zones/Substations from the Edit Mode
ribbon group.This dialog allows the renumbering of areas, zones, and substations for either the entire
power system, and/or for any open oneline diagrams. This dialog is similar to the Renumber Buses
Dialog.
This feature is provided because it is sometimes necessary to renumber areas, zones, or substations in
the power system model, either to make room for new elements or to move elements to different
area, zones, or substations that have a different numbering scheme. It may also be necessary to
renumber display objects on the oneline if the oneline is used with a case other than the one for which
it was originally designed. The areas/zones/substations renumbering feature provides a convenient
way of accomplishing this.
The table at the bottom of the Renumber Areas/Zones/Substations Dialog is used to manage the list of
areas, zones, and substations available for renumbering. This list is populated by selecting one of the
Automatic Setup of Swap List options. The Automatic Setup options allow the addition of all areas,
zones, or substations in the case or only those on the oneline. An option is also available to read the
swap information from a file or to setup the swap list based on the current oneline. The Types to
Insert option is available for specifying whether or not to add areas, zones, and substations to the
swap list. Once the swap list option and types to insert have been selected, click the Setup Swap
List to populate the table.
The table behaves just like a Case Information Display and thus has a local menu that can be invoked
by clicking the right mouse button. Select one of the Insert options from the local menu to insert a
new area, zone, or substation number to change, or select Delete to delete an element number that
is currently in the list. The entire list may be cleared by clicking the Clear Swap List button. The
Present Number for the element is specified in the list. Change the New Number field to specify
the updated number of the area, zone, or substation.
The Renumber Options allows the specification of where the renumbering changes should be
implemented. The changes can be applied to the power system case only, the oneline only, or both
the case and the oneline.
Once the elements to renumber have been specified and the New Number fields have been set
appropriately, implement the changes by pressing the Renumber button. The changes will be applied
to the case and/or oneline as specified in the Renumber Options. Close the dialog by pressing
Close.
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Power Transfer Distribution Factors
The Power Transfer Distribution Factor (PTDF) display is used to calculate the incremental distribution
factors associated with power transfers between two regions. These regions can be defined by areas,
zones, super areas, single buses, injection groups or the system slack. These values provide a
linearized approximation of how the flow on the transmission lines and interfaces change in response
to transaction between the Seller and the Buyer. These values can then be visualized on the onelines
using animated flows (see below for details). When considering areas, zones, or super areas as part of
the transaction, the transaction for which the PTDFs are calculated is modeled by scaling the output of
all generators on AGC in the source and sink areas in proportion to their relative participation factors.
Generators in the source area increase their output, while generators in the sink area decrease their
output. When including injection groups as part of the transaction, the AGC status of any participating
generators does not matter. All generators in the injection group with non-zero participation factors
will be included in the transaction. When loads are included in injection groups, loads in the Seller
would be decreased in order to effect a transaction and loads in the Buyer would be increased in order
to effect a transaction. Of course, the PTDF calculation is a linear calculation and no changes are
actually made to the output of generators or loads to study the impact of the transaction.
An important aspect to consider in calculating the PTDF is how the losses associated with the transfer
are allocated. Simulator assumes that the Seller increases its injection by 100% of the transfer amount
(generators increase and loads decrease), while the Buyer decreases its injection (generators decrease
and loads increase) by 100% of the transaction minus any change in system losses. In other
words, the Buyer accounts for the entire change in the system losses. Of course it is possible that a
transfer may result in decreased system losses; for that case, the Buyer’s change in injection will be
greater than 100% of the transfer.
To Calculate the Power Transfer Distribution Factors:




Perform an initial Power Flow Solution.
In Run Mode, click on the Tools ribbon tab and select Power Transfer Distribution Factors
(PTDFs) from the Sensitivities menu on the Run Mode ribbon group to open the Power
Transfer Distribution Factors Dialog.
Supply the requested information on the Power Transfer Distribution Factors Dialog and click the
Calculate PTDFs button. The distribution factors are calculated and displayed for the element set
of your choice in the table at the bottom of the dialog.

The animated flows that appear on the oneline diagram may represent either actual flows or PTDF
values. To specify that the display should show distribution factors, click the button labeled
Visualize PTDFs. Once this button is clicked, the flow arrows on all open onelines will represent
distribution factors, any transmission line pie charts will show PTDF values, and the caption of the
button will change to Visualize Actual Power Flows. Click the button again to visualize actual
power flows instead of distribution factors.
Note that when calculating PTDF values for interfaces that include contingent elements, the PTDF
values reported are actually what are referred to as an Outage Transfer Distribution Factor (OTDF).
See Line Outage Distribution Factors (LODFs) for more information.
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Power Transfer Distribution Factors Dialog
The PTDF Dialog enables you to control and to view the results of power transfer distribution factor
calculations. To access this dialog go to the Tools ribbon tab, and choose Sensitivities > Power
Transfer Distribution Factors from the Run Mode ribbon group. This is only available in Run Mode.
It is allowed to open two PTDF dialogs, but when doing this Simulator forces one dialog to show
"Single" Directions, while the second dialog shows "Multiple" directions.
The dialog has the following options:
Linear Calculation Method
PTDFs may be calculated using either the full power flow Jacobian or only a portion of it. If you
select the Linearized AC Approximation option, the sensitivity of the monitored element’s flow
will be calculated as a function of both its real and reactive power components to the voltage
magnitude and angle of its terminal buses. When using the AC method, losses are included in the
calculation. Simulator assumes that the change in losses is taken care of by the Buyer.
If you instead select the Lossless DC Approximation option, branch flow sensitivity is calculated
by estimating the real power that flows through the monitored element only from the difference in
angles measured across its terminals. This method assumes that there are no losses.
The Lossless DC with Phase Shifters Approximation option is similar to the Lossless DC,
except additional constraints are placed on the calculations that assume that the change in flow
across active phase-shifting transformers is zero.
Note: The Lossless DC methods will be affected by the DC Power Flow Model settings in Power
Flow Solution: DC Options. Click on the DC Model Options button to open the dialog which sets
these options.
Directions
This option allows you to choose to define a single direction PTDF using the Seller and Buyer Type
related fields, or to define multiple transfer directions between many different entities. If you choose
to use multiple directions, the Seller and Buyer Type fields are replaced by the Direction Records
display for viewing and defining directions.
For Single Direction: Seller Type, Buyer Type
Distribution factors can be calculated for power transfers between combinations of areas, zones,
super areas, participation groups, or to a slack bus. Use the seller type and buyer type options to
indicate the type of the selling and purchasing entities. These fields are only present for single
direction PTDFs. When choosing Area, Zone, or Super Area, this really means all generators in the
Area, Zone or Super Area weighted by the generator participation factor.
For Single Direction: Seller, Buyer
These drop-down boxes allow you to select the selling and buying entities. Their contents are filled
when you select the seller and buyer types. These fields are only present for single direction PTDFs.
For Single Direction: Reverse Buyer/Seller
Click this button to re-calculate PTDFs for the direction that is the reverse of the direction currently
shown. For example, if you have just calculated PTDFs for a transaction from area A to area B, press
this button to calculate and display PTDFs for a transaction from area B to area A. This option is only
present for single direction PTDFs.
Calculate PTDFs
Click on this button to update the PTDF values. The results table will reveal the latest calculations.
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Automatically Recalculate
If checked, the PTDFs are automatically recalculated every time the power flow is solved.
Calculate MW-Distance
Click this button to open the MW * Distance Calculations form. This form allows you to calculate
MW * Distance values for the transaction for which you calculated PTDFs. See MW-Distance
Calculations for more information.
Increase in Losses
This is a read-only field that indicates the change in system losses caused by the transfer from the
selling area to the buying area. The change is expressed as a percentage of the transfer amount.
This will only be non-zero when using the Linearized AC calculation method.
Use Area/Zone Filters
If this box is checked, then the results table at the bottom of the dialog will include only records
associated with devices located in areas or zones included in the area/zone/owner filter set.
Only Show Above %
Restricts the result set to show only those PTDFs that exceed a specified value.
Visualize Actual Power Flows, Visualize PTDFs
Select to toggle the onelines between showing the actual power flows and the PTDF flows. Selecting
this button changes the Flow Visualization field for all the visible onelines. You can also change this
field manually using the Oneline Display Options Dialog. When choosing to visualize PTDFs, the
animated flow arrows will represent PTDF values, and any transmission line pie charts will also be
changed to show PTDFs.
Tables of Results
The tables of results occupy the bottom of the PTDF Dialog. They are a set of case-information
displays and thus share many characteristics common to all other case information displays. The
tables will show results for lines/transformers, interfaces, areas, zones, generators, and phase
shifters. The tables feature a local menu from which you can print, copy, or modify its records as
well as view the information dialog of its associated element. You can also sort the area records by
clicking on the heading of the field by which you want to sort.
Lines/Transformers
Shows the transaction distribution factors for the lines and transformers. The following fields are
shown:
From Number, From Name, To Number, To Name, Circuit
Identifiers for the transmission line or transformer.
% PTDF From
Distribution factor associated with the MW flow at the "from bus" end of the line or transformer,
specified as a percentage of the transaction amount.
% PTDF To
Distribution factor associated with the MW flow at the "to bus" end of the line or transformer,
specified as a percentage of the transaction amount.
% Losses
Shows the percentage of the PTDF assigned as losses.
Nom KV (Max) and Nom KV (Min)
Displays the maximum and minimum nominal voltages for the line. This is useful for identifying
transformers and which end of the PTDF relates to which nominal voltage.
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Interfaces
Shows the transaction distribution factors for the interface records. The following fields are shown:
Name
Alphanumeric identifier for the interface.
Number
Numeric identifier for the interface.
% PTDF
Distribution factor associated with the MW flow through the interface, specified as a percentage
of the transaction amount. A positive value indicates the transaction would result in an increase
in the flow through the interface.
Interface MW Flow
Amount of real power flowing on the interface.
Has Contingency
Signifies if an element of the interface is violating a limit.
Areas and Zones
Shows the impact the transaction has on the losses for the area or zone. The following fields are
shown:
Area/Zone Number and Name
Number and name identifiers for the area or the zone
Losses %
Change in the losses in the area or zone, specified as a percentage of the transaction amount. A
positive number indicates that the transaction would result in increased losses in the area or
zone, while a negative number indicates that the transaction would result in decreased
losses.
Gen Chg %
Total change in all of the generators in area or zone, specified as a percentage of the transaction
amount. For areas, this field should show 100% in the selling area, and 100% minus the change
in system losses in the buying area.
Generators
Shows the marginal participation of each generator in the transaction. The following fields are
shown:
Number of Bus, Name of Bus, ID
Generator’s terminal bus number and alphanumeric identifier, and the id for the generator.
Area Num of Gen, Area Name of Gen
Name and number of the generator’s area.
Gen Chg %
Assumed participation of the generator in the transaction, specified as a percentage of the
transaction amount. This value is directly proportional to the participation factor for the
generator, provided the generator is available for AGC and is free to move in the specified
direction (i.e., is not at a MW limit). The generator’s participation factor and AGC status are
modified on the Generator Dialog, which can be displayed by right-clicking anywhere in the
record’s row in the table and selecting the Show Dialog option.
Phase Shifters
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Shows the transaction distribution factors for the phase shifters. This applies when using the
Lossless DC with Phase Shifters calculation method. The following fields are shown:
From Number, From Name, To Number, To Name, Circuit
Identifiers for the phase shifter.
Status
Indicates whether or not the phase shifter is in-service.
Phase (Deg)
The current phase angle of the transformer.
XF Auto
Indicates if the phase shifter is currently enabled for automatic control.
Deg per MW
This field indicates the amount of angle change, in degrees, that would be required to keep the
flow across the transformer constant for a one MW transfer between the seller and the buyer.
Tap Min, Tap Max
The minimum and maximum tap positions for the phase shifter.
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Directions Display
The Directions Display appears in the upper-right corner of the PTDF window when you select Multiple
Directions for the PTDF Type. The Directions Display is a case information display that allows
directions to be defined for performing multiple direction Power Transfer Distribution Factors. The
Directions Display allows you to insert, delete, and modify directions using options available from the
display's local menu. When directions are modified or inserted individually, the Directions Dialog will be
displayed for entering the information. In addition to individually defining directions, they can also be
automatically inserted using the Auto Insert Directions dialog.
Each record in the display shows the following default information:
Number, Name
A unique number and name given to the defined direction.
Source Type, Source Name
The name and type of the direction source.
Sink Type, Sink Name
The name and type of the direction sink.
Include
Determines if the direction is to be analyzed when calculating the multiple direction PTDFs.
Processed
Displays if the direction has already been processed for a multiple direction PTDF analysis.
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Directions Dialog
Directions are objects that are defined and used when computing a Power Transfer Distribution Factor
using multiple directions.
The Directions Dialog can be used to insert a new direction or to modify the information for an
existing direction. This dialog can be called by choosing Insert or Show Dialog from the Directions
Display local menu.
The options that can be set from this dialog include:
Name of Direction
The name for the direction. If you are entering a new direction, you can enter a new direction name.
If you are modifying an existing direction, the name of the currently viewed direction will be
displayed. A drop down list shows a list of currently defined direction names, and choosing one from
the list will display that direction's information in the dialog. The up and down arrows next to the
field also allow you to scroll through the list of defined directions.
Direction Number
If you are entering a new direction, you can put in a new direction number. If you are viewing or
modifying an existing direction, the direction's number will be displayed.
Source
Select the type of the transfer direction source. Once the type has been selected, the advanced find
list will be enabled, allowing you to search for the specific object or group of objects to set as the
direction source.
Sink
Select the type of the transfer direction sink. Once the type has been selected, the advanced find list
will be enabled, allowing you to search for the specific object or group of objects to set as the
direction sink.
Include in list of monitored directions
Determines if the direction is to be analyzed when calculating the multiple direction PTDF's.
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Auto Insert Directions
Multiple directions can be automatically inserted for PTDF studies using the Auto Insert Directions
dialog. This option can be selected from the local menu of the Directions Display by right-clicking and
choosing Direction Records > Auto Insert Directions.
The layout of the dialog is as follows:
Type of Direction
There are six types of directions that can be automatically defined. Area to Slack, Zone to Slack
and Injection Group to Slack will define directions from areas, zones or injection groups to the
slack bus of the system. Area to Area, Zone to Zone and Inj. Group to Inj. Group will define
directions from areas to other areas, zones to other zones, or injection groups to other injection
groups.
Delete Existing Directions
When checked, any previously defined directions will be deleted before the new directions are
automatically inserted. If not checked, then automatically inserted directions will be added to the list
of previously defined directions. By not deleting existing directions before automatically inserting
new directions, it is possible to have more than one direction defined with the same source and sink.
Only Insert for Areas or Zones with Display Filters Set
If checked, then only Areas and Zones with their Area/Zone/Owner Filters set to Yes will be used
when automatically inserting directions.
Starting Number, Increment By
The Starting Number will be the first number used when automatically numbering the
automatically inserted directions. Each subsequent direction added will be numbered according to
the Starting Number and the Increment By value.
Insert Directions
Insert Directions will perform the automatic insertion routine for the directions, according to the
defined options.
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Calculate MW-Distance
Simulator can estimate MW * Distance quantities for the system’s areas and zones that result from a
specified transaction. Given a transaction from a specified source to a specified sink, Simulator uses
power transfer distribution factors (PTDFs) to estimate the change in flow for each line in the system
that results from the transaction. For each line, multiplying the line’s change in flow by its length then
gives the MW * Distance index for that line. Simulator then sums the MW * Distance indices by area
and by zone to obtain the total MW * Distance for each area and zone in response to the specified
transaction.
Because the MW * Distance calculations use PTDFs, you must access the MW * Distance functionality
from the PTDF Dialog. Once you have calculated PTDFs for a particular transaction by pressing the
Calculate PTDFs button, click the Calculate MW * Distance button to bring up the MW *
Distance Calculations Dialog.
The top portion of the MW * Distance Calculations Dialog is used to set the lengths of the lines in the
case. Although line length is represented as a data element in the power flow case, it often is left
blank. However, Simulator needs line length information if it is to calculate MW * Distance indices.
Simulator offers a few options regarding the source of line length information. If you do not have
access to line lengths, either from the existing case or an external text file, Simulator can estimate line
lengths for you. It does this by using the Ohms/Length values you specify in the table for lines of
various kV. Simply indicate the voltage levels in the first row of the table, and the corresponding ohms
or reactance per length in the second column. You do not need to differentiate here between English
and metric units, because the calculation is independent of the measurement system. If you want the
length estimates calculated using this table to overwrite any line lengths that may already be present
in the case, be sure to check the Always Estimate Length checkbox; otherwise, the new estimates
will set the lengths only of lines whose pre-defined length isn’t greater than zero. If you want the
estimates to populate the lengths of lines in the model so that, when you save the model, the
estimated lengths are saved as part of the model, check the Save Estimates With Case. (This
provides a handy way to set line lengths for a case that might not have any defined.) Note that, in
performing these estimates, transformers are defined as having zero length. If you do not want
Simulator to estimate line lengths but instead want to use the line lengths that are currently stored in
memory, check the Do Not Use Length Estimates box. Finally, if you want to load line lengths from
a text file, click the Load Line Lengths from File button. This file can be either comma- or spacedelimited, and each line must have the following fields in the order specified:
From_Bus_Number To_Bus_Number Circuit_ID Length
Once Simulator knows how to calculate line lengths, it can calculate MW*distance indices for each area
and zone. Specify the amount of MW that will be transacted in the Size of Transaction textbox. You
may use the arrows to increase or decrease the size of the transaction. Simulator assumes that the
transaction is to occur between the source and sink groups for which you just calculated PTDFs. Press
the button labeled Calculate to compute the indices. Two tables are populated with the results of the
calculation, one for areas, and another for zones. Use the tabs to switch between the two tables.
These tables are Case Information Displays and thus share common to all case information displays.
Thus, you can sort the tables, add or delete columns, access the area and zone dialogs, print the
tables, and save their content as HTML.
Several options can be set to customize the calculation of MW*Distance. These options are reached
from the MW*Distance Options Dialog.
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MW-Distance Options
The calculation of MW*Distance quantities can be customized in a number of ways. These options are
set from the MW*Distance Options Dialog.
Include Tie Lines Only
If this box is checked, then the only branches that contribute to the MW*Distance calculation are
those that tie two areas together. Otherwise, both tie lines and lines internal to areas and zones are
included in the calculation. In the latter case, tie lines are assumed to belong to the area that owns
the metered end of the branch.
Internal Flows
If you choose to include both tie line flows and flows internal to areas and zones in calculating
MW*Distance quantities, you have two options for how to treat internal flows. You can ignore flows
resulting from the transaction that flow in the reverse direction of the existing flow on a branch by
checking the Include flow increases only checkbox. You can also choose to treat all such
counterflows as negative contributions to an area or zone’s MW * Distance value by checking the
Deduct flow reductions checkbox.
Omit Branches
To omit branches for which the PTDF corresponding to the transaction is less than a specified value,
specify a nonzero percentage in this textbox.
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Line Outage Distribution Factors (LODFs)
Line Outage Distribution Factors (LODFs) are a sensitivity measure of how a change in a line’s status
affects the flows on other lines in the system. On an energized line, the LODF calculation determines
the percentage of the present line flow that will be show up on other transmission lines after the
outage of the line. For example, consider an energized line, called LineX, whose present MW flow is
100 MW. If the LODFs are found to be
LODFs for LineX outage
LineX -100%
LineY + 10%
LineZ - 30%
This means that after the outage of LineX, the flow on LineX will decrease by 100 MW (of course),
LineY will increase by 10 MW, and LineZ will decrease by 30 MW. The "flow on Line X" here means the
flow at the from bus going toward the to bus.Line Outage Distribution Factors (LODFs)
Similarly, sensitivities can by calculated for the insertion of a presently open line. In this case, the
LODF determines the percentage of the post-insertion line flow that will come from the other
transmission line after the insertion. The "LODF" might better be named a Line Closure Distribution
Factor (LCDF) in this case.
To calculate the LODFs:




Perform an initial Power Flow Solution.
In Run Mode, select Sensitivities > Line Outage Distribution Factors (LODFs) from the
Rune Mode ribbon group on the Tools ribbon tab to open the Line Outage Distribution Factors
Dialog.
Supply the requested information on the Line Outage Distribution Factors Dialog and click the
Calculate LODFs button.

What else are LODFs used for?
LODFs are used extensively when modeling the linear impact of contingencies in Simulator. This is
true for the calculation of PTDFs for interfaces which contain a contingent element, as well as when
performing Linear ATC analysis that includes branch contingencies.
When calculating "PTDF" values for interfaces that include contingent elements, the PTDF values
reported are actually what are referred to as an Outage Transfer Distribution Factor (OTDF). An
OTDF is similar to PTDF, except an OTDF provides a linearized approximation of the post-outage
change in flow on a transmission line in response to a transaction between the Seller and the Buyer.
The OTDF value is a function of PTDF values and LODF values. For a single line outage, the OTDF
value for line x during the outage of line y is
OTDFx = PTDFx + LODFx,y * PTDFy
where PTDFx and PTDFy are the PTDFs for line x and y respectively, and LODFx,y is the LODF for
line x during the outage of line y. More complex equations are involved when studying contingencies
that include multiple line outages, but the basic idea is the same.
When performing Linear ATC analysis along with calculating OTDFs, Simulator determines the
linearized approximation of the post-outage flow on the line. This is similarly determined as
OutageFlowX = PreOutageFlowX + LODFx,y* PreOutageFlowY
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where PreOutageFlowX and PreOutageFlowY are the pre-outage flow on lines x and y.
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Line Outage Distribution Factors Dialog
The LODF Dialog enables you to control and to view the results of Line Outage Distribution Factor
calculations. You access this dialog by selecting Sensitivities > Line Outage Distribution Factors
(LODFs) from the Run Mode ribbon group on the Tools ribbon tab in Run Mode only.
It is allowed to open two LODF dialogs, but when doing this Simulator forces one dialog to show a
"Single LODF" calculation, while the second dialog shows the "LODF Matrix".
The following describes the sections of the dialog:
The dialog has the following options:
Output Option
Choose Single LODF to calculate only the sensitivities related to the status change of a single
transmission line. Choose LODF matrix to calculate a matrix of sensitivities.
For Single LODF: Specify Near Bus, Far Bus
Specify the line whose status modification you would like to determine sensitivities to. The direction
of the near/far chosen is important. Switching the near and far bus around will change the sign of all
the LODF sensitivities.
For Single LODF: Action
Check Outage Sensitivities to determine sensitivities for the outage of a line.
Check Closure Sensitivities to determine sensitivities for the closure of a presently outaged line. The
LODF might better be named a Line Closure Distribution Factor (LCDF) in this case.
For LODF Matrix: Specify Lines to Process (Outage or Closure) and Lines to Monitor
Choose which lines to process and which lines to monitor by choosing either all AC lines, only those
that meet the area/zone/owner filters, only lines with Selected field set to YES, or only those lines
that meet an Advanced Filter. After choosing Calculate LODFs, each row of the results represents
the line being outaged/closed. Each column of the results represent the line begin monitored and
the corresponding LODF/LCDF for that line.
Linear Calculation Method
Linearized AC
This calculation method is not available for LODF sensitivities.
Lossless DC
Uses the DC power flow approximation.
Lossless DC with Phase Shifters
Check this to include the impact of phase shifter controllers with the Lossless DC calculation. By
checking this, it is assumed that operating phase shifters will maintain their control requirements
after the line outage.
Note: The Lossless DC methods will be affected by the DC Power Flow Model settings in Power
Flow Solution: DC Options. Click on the DC Model Options button to open the dialog which sets
these options.
Calculate LODFs
Click this to calculate the LODFs and update the display.
Advanced LODF Calculation
Opens the Advanced LODF Calculation dialog for setting additional options for the calculation.
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LODFs Tab
After calculating a LODF Matrix, each row of the results represents the line being outaged/closed. Each
column of the results represent the line begin monitored and the corresponding LODF/LCDF for that
line.
When calculating LODFs for a single branch, This tab contains a table showing a list of the lines in the
case. Since this table us another variety of the Case Information Displays, you may interact with it in a
familiar manner. Click on any of the field headings to sort by that field. Right-click on the display to call
up the display’s local menu. From the local menu, you can print the violations, copy the violation
records to the Windows clipboard for use with another application, modify the format and content of
the listing, view the information dialog of the respective element, and view the Quick Power Flow List
or Bus View Display.
The default fields for the tab are as follows:
From Bus Number and Name
"From" bus number and name. Right- clicking on either of these fields allows you to see all the flows
measured at the "from" bus using the Quick Power Flow List or Bus View Display local menu options.
To Bus Number and Name
"To" bus number and name. Right-clicking on either of these fields allows you to see all the flows
into the "to" bus using the Quick Power Flow List or Bus View Display local menu options.
Circuit
Two-character identifier used to distinguish between multiple lines joining the same two buses.
%LODF
The LODF value for the line.
From MW, To MW
The present MW flows on the line at the "from" bus and the "to" bus.
From CTG MW, To CTG MW
The projected MW flows after the change in line status on the line at the "from" bus and the "to"
bus.
Note: LODFs are always calculated using a DC power flow technique.
Interface LODFs
This tab will only appear if calculating LODFs for a single branch and will not appear if doing the LODF
matrix calculation. This tab lists LODFs for interfaces. These LODFs are calculated based on the LODFs
of the individual branches that comprise the interface.
The default fields for this tab are as follows:
Number
This is the number of the given interface.
Name
This is the name of the given interface.
% LODF
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This is the LODF value for the interface. This is calculated from the LODFs of the individual branches
that comprise the interface. This is simply a sum of the branch LODFs based on the direction that
the branch is defined in the interface and the monitored direction of the branch in the interface.
Interface MW Flow
The present MW flow on the interface.
CTG MW
The projected MW flow on the interface based on outaging the specified branch.
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Advanced LODF Calculation Dialog
The Advanced LODF Calculation Dialog can be opened by clicking on the Advanced LODF Calculation
button found on the Line Outage Distribution Factors (LODFs) dialog. The advanced calculation dialog
allows you to calculate the LODFs for several different contingent lines in one batch process. First, you
need to use the Contingency Analysis Tool to define which contingent lines to use (all contingencies
that contain a single branch outage will be used.) Also, only lines that are being monitored will have
their LODFs calculated. See Limit Monitoring Settings to change which lines are monitored.
The output from the advanced LODF calculation process is saved to a file for import into another
program for analysis. This dialog defines how to save the Advanced LODF results to a file for importing
in another program.
Format to Save in
You can choose to save the advanced LODF results as "Monitored Branch, Contingency" pairs for
PROMOD, or as a matrix in a comma-delimited text file. The comma-delimited text file is useful for
loading the results into a spreadsheet program.
Only save pairs with an LODF whose absolute value is greater than
This field allows you to filter out elements whose LODF is below a certain value.
Only Include Monitored Branches whose MW flow increases
This field allows you to filter out monitored elements whose MW flow did not increase in the LODF
calculation.
Maximum Columns Per Text File
This field is important when you are saving a matrix in a comma-delimited text file. Most
spreadsheet programs have limits on the number of columns they can display. The default is 256,
which happens to be the maximum number of columns allowed in Excel.
LODF Number Format
You can choose to have the LODF values stored in either scientific notation, or as a specified length
decimal number.
File Name
You must enter a file name and location or Browse for a file for saving the LODF data.
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Transmission Loading Relief Sensitivities
Transmission Loading Relief (TLR) Sensitivities are similar to the Power Transfer Distribution Factors.
Both TLR Sensitivities and PTDFs measure the sensitivity of the flow on a device to a transaction. To
calculate PTDFs, you specify a source group and a sink group, and Simulator determines the
percentage of a single transfer between the source and sink that flows on each of several monitored
elements. For TLR sensitivities, you specify a single device, such as a transmission line, to monitor,
and a group that serves either as source or as sink. Simulator then determines the sensitivity of the
flow on the single monitored element to many different transactions involving the group you specified
as the source or sink. To summarize, PTDFs express the sensitivity of many monitored elements to a
single transaction, whereas TLR sensitivities gauge the sensitivity of a single monitored element to
many different power transfers.
"TLR" stands for "Transmission Loading Relief." TLR is an industry-wide tool for managing transmission
utilization to prevent overload situations that put the system at risk. For example, suppose a particular
line is loaded beyond its thermal limit. Its owner will request that a TLR program be initiated, which
dictates that all transactions for which 5% or more of the exchanged power flows on the overloaded
element be curtailed. The TLR sensitivity tool in Simulator is useful for pinpointing those transactions
that would be curtailed. Suppose we use the TLR tool to determine where area A can purchase power
from while the TLR for the overloaded element is in place. We specify area A as the buyer area,
identify the overloaded line, and tell Simulator to perform the calculation. Simulator will then list the
sensitivity of the flow on the overloaded line to power exchanges between all other generators, areas,
and buses to area A. Any transaction for which the sensitivity exceeds 5% would be curtailed;
anything below 5% would be allowed to continue.
To calculate TLR Sensitivities, select Tools > Sensitivities > TLR Sensitivities from the main
menu. This will open the TLR Sensitivities dialog, which will allow you to set TLR Sensitivities options
and then calculate the sensitivities.
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TLR Sensitivities Dialog
The TLR Sensitivities dialog allows you to calculate Transmission Loading Relief Sensitivities for the
load flow case at its solved load flow point. To access this dialog go to the Tools ribbon tab, and
choose Sensitivities > TLR Sensitivities / Generation Shift Factors from the Run Mode ribbon
group. This is only available in Run Mode.
It is allowed to open two TLR Sensitivities dialogs, but when doing this Simulator forces one dialog to
show the Line/XFMR or Interface device type, while the second dialog shows Multiple Elements
device type.
The following describes the sections of the dialog:
Device Type
Select whether you want to calculate the sensitivities for a transmission line/transformer, for an
interface, or for multiple elements. To calculate sensitivities for an interface, you must have the
interface defined in the case.
When you choose an individual line/transformer or interface, you need to specify the device by
selecting it from the list of devices. In this case you specify the From Bus, To Bus, and circuit
identifier for a branch, or the interface name or number. When you select the Multiple Elements
option, the device selection area of the dialog changes to allow you to select a TLR Multiple Device
Type. The TLR results display changes accordingly in order to accommodate TLR sensitivities for
multiple elements.
Line/XFMR or Interface Only: Choose device
Specify the From Bus, To Bus, and circuit identifier for a branch, or the interface name, number, and
monitored flow direction.
For multiple elements, specify the multiple device type. Choices are: selected lines/transformers,
selected interfaces, overloaded lines/transformers in the base case, overloaded interfaces in the
base, overloaded lines/transformers during the set of contingencies, and overloaded interfaces
during the set of contingencies.
Multiple Elements Only: Select Lines/XFMRs
Opens the case information display for lines/transformers. To include a line/transformer in the TLR
study, set the Selected? field to Yes.
Multiple Elements Only: Select Interfaces
Opens the case information display for interfaces. To include an interface in the TLR study, set the
Selected? field to Yes.
Transactor Type
Specify if the sensitivities will be calculated for the transactor being the buyer or the seller.
Transactor Object
Specify what the transactor will be. The choices are Area, Zone, Super Area, Slack, Injection Group,
and Bus. When choosing Area, Zone, or Super Area, this really means all generators in the Area,
Zone or Super Area weighted by the generator participation factor.
If using the Integrated Topology Processing add-on, an Only show the primary bus for each
superbus checkbox will be available on the Buses tab. Checking this box will limit the buses shown
on that tab and the list of Bus transactors to only those that are primary buses. This provides a
quick means of removing the clutter of redundant data. The primary buses and superbuses are
determined from the base case topology.
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TLR Sensitivities
Specify if the next set of calculated TLR sensitivities should replace the currently calculated values,
or be appended to the current values. The normal option is to Clear before Calculate. When
choosing to Append, then as new calculations are performed, the results will only replace the
existing sensitivity value store if the new value is larger than the old value. (Note: in this situation,
negative values are considered smaller than positive values).
PTDF Calculation Method
Choose the solution method to use for calculating the sensitivities similar as done on the PTDF
Dialog.
Note: The Lossless DC methods will be affected by the DC Power Flow Model settings in Power
Flow Solution: DC Options. Click on the DC Model Options button to open the dialog which sets
these options.
Calculate TLR Sensitivities
Click the button to calculate the sensitivities. The calculation processing through each bus and
determines the sensitivity of the MW flow of selected device with respect to a change of real power
at each bus. When the transactor type is buyer, then the assumption is that power is injected at
each bus and absorbed at the transactor object. When the transactor type is seller, then the
assumption is that power is injected at each transactor object and absorbed at each bus.
DC Model Options
Click this button to open the DC Options page. Here you can adjust the DC options you want used if
you are computing the PTDFs with a Lossless DC approximation.
Include only AGCAble Generators
If checked, then only generators available for automatic generation control will be included in the
TLR sensitivity calculations.
Set Sensitivities At Out-Of-Service Buses Equal to Closest
Click this button to approximate the sensitivities at out-of-service buses with the sensitivity of the
closest bus. Otherwise the out-of-service buses will display sensitivities of 0 when the sensitivities
are calculated.
Line/XFMR or Interface Only: Bus, Generator, Load, Injection Group, and Area
Sensitivities
The Bus Sensitivities show the values calculated at each bus. Generator sensitivities show the same
information but have only a list of generators with the P Sensitivity column showing the sensitivity
calculated at the terminal bus. The Load sensitivities are similar to the generator sensitivities in that
they show the same information as the bus sensitivities but only show the list of loads with the P
Sensitivity column giving the sensitivity calculated at the terminal bus. The Injection Group
sensitivities represent averages of the bus sensitivities weighted by the participation factors of each
generator, load, or switched shunt in the group. All participation factors are included in this
calculation regardless of the AGC status of any included generators. The Area Sensitivities calculated
represent a weighted average of the generator buses in the area with the weighting done by
generator participation factor.
If using the Integrated Topology Processing add-on, an Only show the primary bus for each
superbus checkbox will be available on the Buses tab. Checking this box will limit the buses shown
on that tab and the list of Bus transactors to only those that are primary buses. This provides a
quick means of removing the clutter of redundant data. The primary buses and superbuses are
determined from the base case topology.
Multiple Elements Only: Multiple Bus, Generators, Loads, and Injection Group Sensitivities
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The Multiple Bus Sensitivities show the values calculated at each bus for each device examined
during the analysis. Multiple Generator and Load Sensitivities show the same information but have
only a list of either generators or loads with the P Sensitivity column showing the sensitivity
calculated at the terminal bus. The Multiple Injection Group Sensitivities represent averages of
multiple bus sensitivities weighted by the participation factor of each generator, load, or switched
shunt in the group. All participation factors are included in this calculation regardless of the AGC
status of any included generator.
If using the Integrated Topology Processing add-on, an Only show the primary bus for each
superbus checkbox will be available on the Buses tab. Checking this box will limit the buses shown
on that tab and the list of Bus transactors to only those that are primary buses. This provides a
quick means of removing the clutter of redundant data. The primary buses and superbuses are
determined from the base case topology.
The results of the multiple element analysis can be accessed using script commands or SimAuto by
using the variable MULTBUSTLRSENS with the appropriate data object: Bus, Gen, Load, or
InjectionGroup. There will be as many variables with the MULTBUSTLRSENS name and appropriate
location number as there are elements that were studied. The location numbers start at 0. The
results are assigned in the order that the elements are included in the list of branches or interfaces
to be studied. For example, if the list of branches includes five branches defined in the case in the
following order: 1 to 2, 2 to 4, 4 to 3, 3 to 1, 2 to 3, and branches 2 to 4 and 4 to 3 are selected for
inclusion in the multiple element TLR calculation, MULTBUSTLRSENS:0 will correspond to branch 2
to 4 and MULTBUSTLRSENS:1 will correspond to branch 4 to 3 for all sets of results. When selecting
devices to study based on them being overloaded or contingency-overloaded, the results will appear
in the order that the overloaded elements are defined with the case. To determine which elements
are overloaded in the base case, use the LINELIMITPERCENT:2 field with Branch data objects and
the FGPERCENT field with Interface data objects. If these fields are greater than 100 percent then
the element is overloaded. The CTGVIOL variable can be used with the Branch or Interface data
type to determine if an element is overloaded due to a contingency. This field will be non-zero for
any element that has overloads due to contingencies.
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TLR Multiple Device Type
The Multiple Device Type selector allows you to specify a group of elements for which Transmission
Loading Relief (TLR) sensitivities will be calculated. The Multiple Device Type selection is accessible
only when you choose the Multiple Elements option from the Device Type in the TLR Sensitivity dialog.
Selected Devices
Select Lines/XFMRs
Select the Selected Devices option, and click on this button to open a dialog to choose the lines
and transformers to be included in the calculation. Toggle the Selected field in the Lines and
Transformer Case Information Display to Yes for the branches you wish to include. If the
Selected field is not available in the information display, add that column to the display by rightclicking in the display and selecting Display/Column Options. The ETLR of selected Lines/XFMRs
is the algebraic sum of the TLRs of each individual element. The WTLR uses as weight the
current MW flow in the element.
Select Interfaces
Select the Selected Devices option, and click on this button to open a dialog to choose the
interfaces to be included in the calculation. Toggle the Selected field in the interfaces Case
Information Display to Yes for the interfaces you wish to include. If the Selected field is not
available in the information display, add that column to the display by right-clicking in the display
and selecting Display/Column Options. The ETLR of the selected interfaces is the sum of the
TLRs of the interfaces that have a limit different from zero. The WTLR uses as weight the MW
flow in the interface.
Overloaded Devices
Select this option to include in the multiple element TLR calculation the branches and/or interfaces
that are overloaded in the present case based on the Limit Monitoring Settings and Limit Violations
Dialog. The list of the overloaded branches and interfaces is available in the Limit Monitoring
Settings and Limit Violations information display.
CTG Overloaded Devices
Select this option to include in the multiple element TLR calculation the branches and/or interfaces
that were identified as overloaded by the Contingency Analysis tool. A branch or interface is included
in the calculation if it has been overloaded during at least one contingency. The list of branches and
interfaces identified as overloaded can be accessed from the View Results By Element page in the
Contingency Analysis dialog.
The ETLR of the CTG overloaded lines and transformers is the algebraic sum of the individual TLRs.
The WTLR uses as weight the Aggregate MVA Overload of each transmission line and transformer,
which is defined as the sum of the MVA overload in the line or transformer across the contingencies
that caused a violation in that particular line or transformer. The Aggregate MVA Overload and a
related field, the Aggregate Percent Overload of a line or transformer, are measures of the weakness
of that transmission line on the grid. The Aggregated MVA Overload and the Aggregate Percent
Overload are line and transformer fields that can be displayed in the Case Information Display, used
in Contouring, etc.
The ETLR of the CTG overloaded interfaces is the algebraic sum of the individual TLRs. The WTLR
uses as weight the Aggregate MW Overload of each interface, which is defined as the sum of the
MW overload of the interface across the contingencies that caused a violation in that interface. The
Aggregate MW Overload and a related field, the Aggregate Percent Overload of an interface are
measures of the weakness of the interface. These two interface fields can be displayed in the Case
Information Display, used in Contouring, etc.
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Effective Transmission Loading Relief (ETLR)
In the same manner as the TLR represents the MW increase in an element per MW transfer, the
ETLR column in the Mult. Bus Sensitivity table represents the total MW increase in all the elements
in the set per MW increase of the transaction. Let us suppose that the set contains two transmission
lines: A and B and assume that for a 1 MW transfer from bus i to the transactor, the flow in line A
increases in 0.5 MW and the flow in line B decreases in -0.3. Then the ETLR of bus i is +0.2 since
that is the total MW increase in the elements in the set. The ETLR provides a measure of the
simultaneous MW change in multiple elements, and thus the overall effect in flows on the element of
the set. The ETLR is a bus field that can be included in the bus Case Information Display, used in
Contouring, etc.
Weighted Transmission Loading Relief (WTLR)
The WTLR column in the Mult. Bus Sensitivity table weights the sensitivities based on the flow or
overload flow values of the element. It is a measure of the value of a certain bus to relief
transmission loading. The buses with the highest WTLR (or lowest WTLR, depending on the
transactor type) are identified as the most effective buses to mitigate transmission loading
considering multiple elements. The WTLR is a bus field that can be included in the bus Case
Information Display, used in Contouring, etc.
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Generation Shift Factor Sensitivities
Generation Shift Factor (GSF) Sensitivities are a specific kind of TLR calculation. GSFs always involve a
transfer with the slack bus being the Buyer. Other than this, GSF and TLR calculations are identical.
See TLR Sensitivities for more information.
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Loss Sensitivities
To access the Loss Sensitivities dialog go to the Tools ribbon tab, and choose Sensitivities > Loss
Sensitivities from the Run Mode ribbon group. This is only available in Run Mode.
The Bus Marginal Loss Sensitivities Dialog is used to calculate and display the sensitivity of a real
power loss function, PLosses, to bus real and reactive power injections. Stated mathematically, the
display calculates d PLosses/d Pi and d PLosses/d Qi , where Pi and Qi are the real and reactive power
injections at bus i, respectively.
Stated less formally, the display indicates how losses would change if one more MW or Mvar of power
were injected at bus i. Simulator can calculate the losses for a bus relative to losses in the bus’ island
or area, to losses in a select group of areas, or, if the bus belongs to a super area, to losses in the bus’
super area. How Simulator computes the losses is governed by the value of the Loss FunctionType
option.
The Loss Function Type may assume one of the following six values:
Do Not Calculate Bus Loss Sensitivities
No Losses are calculated because a loss function is not specified.
Each Electrical Island
Losses are calculated with respect to the losses in bus’ island. If the power system consists of only
one island, losses are computed with respect to the total system losses.
Each Area
Losses are calculated with respect to the total losses for the area containing bus i. This is probably
the most common loss function because usually one is concerned with minimizing losses for a
particular area rather than for the entire case.
Each Area or Super Area
Losses are calculated with respect to the total losses for the area containing bus i if bus i does not
belong to a super area, and with respect to the total losses for the super area containing bus i if bus
i does belong to a super area. When a case contains Super Areas this is more commonly done.
When Simulator calculates loss sensitivities internally for use in the Economic Dispatch or the
Optimal Power Flow calculation, this is the option which is used.
Areas Selected on Loss Sensitivity Form
Losses are calculated with respect to the total losses for a group of areas, specified in the Selected
Areas table.
User-Specified
If you select User-Specified as the loss function type, the values last calculated using a different loss
function type will become fixed. Thus you can force the loss sensitivities to remain constant when
used in other features and tools of Simulator.
In steady-state power system operation, total generation must always equal total load plus losses.
Therefore, the real power injection at a single bus cannot be changed arbitrarily; it must be met by a
corresponding change somewhere else in the system so that the total power remains balanced. In
other words, the change in power injection must somehow be absorbed. How the injection is absorbed
depends on the Loss Function Type. If the Loss Function Type is Each Island, the injection is
absorbed by the island slack. For the Each Area and Selected Areas loss functions, the injection is
absorbed at the area tie-lines.
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The loss sensitivities are calculated by modeling an injection of power at a bus and then assuming that
this injection is absorbed by the island slack bus. The sensitivity then shows how much the losses (for
the region of interest) increase when you transfer 1 MW at the injection bus to the island slack. The
"region of interest" is what was chosen as Island, Each Area, or Selected Areas.
Therefore, the "absolute numbers" given by the loss sensitivity dialogs are not directly meaningful
because we are always assuming that the absorbing point is the island slack bus. What is meaningful
is the "difference" between sensitivity numbers.
Example:
Assume the sensitivities are calculated to be
Bus A Loss MW Sensitivity = -0.04 = Asens
Bus B Loss MW Sensitivity = -0.02 = Bsens
Bus C Loss MW Sensitivity = +0.03 = Csens
Using these we can then look at the sensitivity of generic transfers between these buses by using
"superposition".
Consider the following change in injections modeling a transfer of power from Bus A to Buses B and C.
Bus A injection = +10 MW = AMW
Bus B injection = - 6 MW = BMW
Bus C injection = - 4 MW = CMW
An estimate of the change in losses can then be calculated as
Loss Change = (AMW)(Asens) + (BMW)(Bsens) + (CMW)(Csens)
= (+10)(-0.04) + (- 6)(-0.02) + (- 4)(+0.03)
= -0.4 MW
The Bus Marginal Loss Sensitivities Dialog houses the following controls:
Selected Areas Table
This table is used only when the Loss Function Type is set to Selected Areas; otherwise, it is
ignored. Left-click on the Include field to include or exclude areas from the loss function.
Calculate Marginal Loss Sensitivities Button
Once the loss function type has been specified, click this button to calculate the bus marginal loss
sensitivities and update the Bus Marginal Loss Sensitivities table.
Bus Marginal Loss Sensitivities Table
This table shows the bus marginal loss sensitivities for all buses with valid Area/Zone/Owner filters.
The Bus Marginal Loss Sensitivities Table is a type of Case Information Display and thus exhibits
features and behavior similar to all other case information displays. It has a local menu from which
you can choose to find out more about a particular bus. You can sort records by any of the listed
fields by clicking on the column headings. The table contains the following fields:
Number, Name: Number and name of the bus.
Area Number, Area Name: Number and name of the bus’ area.
Loss MW Sens:. Sensitivity of the loss function to an increase in the real power injection
(generated power assumed positive) at the bus.
Penalty Factors: Computed penalty factor of each bus.
MVR Sens:. Sensitivity of the loss function to an increase in the reactive power injection
(generated power assumed positive) at the bus.
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If using the Integrated Topology Processing add-on, an Only show the primary bus for each
superbus checkbox will be available for this table. Checking this box will limit the buses show to
only those that are primary buses. This provides a quick means of removing the clutter of redundant
data. The primary buses and superbuses are determined from the base case topology.
Just Generators Marginal Loss Sensitivities Table
This table shows the bus marginal loss sensitivities for only the generator terminal buses with valid
Area/Zone/Owner filters. This table is otherwise identical to the displayed values and table operation
as the Bus Marginal Loss Sensitivities Table described above.
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Flow and Voltage Sensitivities
To access the Flows and Voltages Sensitivities dialog go to the Tools ribbon tab, and choose
Sensitivities > Flows and Voltages Sensitivities from the Run Mode ribbon group. This is only
available in Run Mode.
The grids that occupy all of the tabs on this dialog lists each device of the particular type in the
system, subject to the Area/Zone/Owner Filter settings. This grids are case information displays, and
thus shares properties and controls common to all other case information displays.
Single Meter, Multiple Transfers
The Single Meter, Multiple Transfers tab shows the effect an additional injection of real or reactive
power at a bus has on various parameters. If a bus is a PV bus, instead of determining the impact
that additional injection of reactive power at the bus has, the impact of changing the voltage
setpoint at the bus is determined. Additionally, the sensitivities of the Flow Type will be determined
due to phase shifter phase, transformer tap, and switched shunt nominal injection changes.
Device Type and Associated Flow Type
The following device types can be selected with their associated Flow Type.
Line/XFMR
MW - real power flow on the branch
Mvar - reactive power flow on the branch
MVA - apparent power flow on the branch
Interface
MW - real power flow on the interface
Mvar - reactive power flow on the interface
MVA - apparent power flow on the interface
Bus
Magnitude - voltage magnitude in per unit at the bus
Mvar - reactive power injection at the bus
Generator
Mvar - reactive power injection at the generator. When determining this sensitivity, the
sensitivity of the total Mvar injection at the generator bus is determined. This is the same
value that would be returned if picking Device Type of Bus and Flow Type of Mvar. This total
is apportioned to specific generators at a bus based on their proportion of the total Mvar
range for the bus. Only generators that are online and on AVR control are included in the
calculation.
After selecting a Device Type, a particular device must be selected from the object chooser.
Whenever you make a change to any of these settings, click Calculate Sensitivities to update
the grids with the new sensitivities.
Buses Tab
The buses tab provides sensitivities for injecting real or reactive power at a bus or changing the
voltage setpoint at a bus. All injections assume that the power is absorbed at the island slack
bus.
The bus fields (to add see Display/Column Options) of interest after this calculation include:
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Sensitivity: Injection dValue/dP -->(P Sensitivity) gives the sensitivity of the selected Flow Type
to an injection of real power at the bus selected in the row of the results
Sensitivity: Injection dValue/dQ --> (Q Sensitivity) gives the sensitivity of the selected Flow
Type to an injection of reactive power at the bus in the row of the results. This value is only
calculated for PQ buses.
Sensitivity: Injection dValue/dVsetpoint (for PV bus) --> (V Sensitivity) gives the sensitivity of
the selected Flow Type to a change in voltage setpoint at the bus in the row of the results. This
value is only calculated for PV buses.
Sensitivity: Injection dAngle/dP (radians/MW) --> (AngleP Sensitivity) gives the sensitivity of
voltage angle to an injection of real power at the bus in the row of the results. This value is
only calculated when the Device Type is Bus and the Flow Type is Magnitude.
Sensitivity: Injection dAngle/dQ (radians/Mvar) --> (AngleQ Sensitivity) gives the sensitivity of
voltage angle to an injection of reactive power at the bus in the row of the results. This value is
only calculated when the Device Type is Bus and the Flow Type is Magnitude.

The option labeled Set Out-Of-Service allows you to approximate the sensitivities at out-ofservice buses with the sensitivity of the closest bus. Otherwise the out-of-service buses will
display sensitivities of 0 when the sensitivities are calculated.
If the Integrated Topology Processing add-on is available, the Only show the primary bus for
each superbus checkbox will be available. When checked, the buses that show up in the table
will be limited to only those that are primary nodes. The determination of primary nodes is based
on the base case topology. This provides an easy filter to eliminate redundant data. This option
also limits the buses that appear in the chooser list when the Device Type is Bus.
Generators Tab
The generators tab provides the same sensitivity information that is available on the Buses Tab
except that only generator buses are listed. This provides an easy way to filter out only generator
buses.
Loads Tab
The loads tab provides the same sensitivity information that is available on the Buses Tab except
that only load buses are listed. This provides an easy way to filter out only load buses.
Phase Shifters Tab
This tab provides a listing of all phase shifters in the case. The Sensitivity: Flow/Voltage with
respect to Phase --> Sensitivity/Degree field gives the sensitivity of the Flow Type to a change
in phase shifter phase.
LTC Transformers Tab
This tab provides a listing of all transformers in the case. The Sensitivity: Flow/Voltage with
respect to Tap --> LTC Sensitivity field gives the sensitivity of the Flow Type to a change in
transformer tap.
Switched Shunts Tab
This tab provides a listing of all switched shunts in the case. The Sensitivity: Q Nominal Injection
--> Q Sensitivity field gives the sensitivity of the Flow Type to a change in nominal Mvar
injection at a switched shunt.
Single Transfer, Multiple Meters
The Single Transfer, Multiple Meters tab shows the effect of a single transfer of real or reactive
power on all the voltages in the system. To specify the transfer, choose the Seller and Buyer in the
same manner done on the Power Transfer Distribution Factors dialog. Then specify whether the
calculation of Real Power (P), Reactive Power (Q), or both are of interest.
Click Calculate Sensitivities to perform the calculations.
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After clicking Calculate Sensitivities, each row of the results gives the sensitivity of voltage at the
respective bus to the power transfer defined by the seller and buyer. The bus columns (to add see
Display/Column Options) of interest after this calculation include:


Sensitivity: Transfer dV/dP (per unit/MW) --> VP Sensitivity gives the sensitivity of voltage to a
real power transfer



Sensitivity: Transfer dV/dQ (per unit/Mvar) --> VQ Sensitivity gives the sensitivity of voltage to
a reactive power transfer




Sensitivity: Transfer dAngle/dP (radians/MW) --> AngleP Transfer Sensitivity gives the
sensitivity of voltage angle to a real power transfer

Sensitivity: Transfer dAngle/dQ (radians/Mvar) --> AngleQ Transfer Sensitivity gives the
sensitivity of voltage angle to a reactive power transfer

The check box option Set generators off AVR and continuous switched shunts to fixed at
buses participating in the transfer is also available. Selecting this option will turn off AVR
control for generators and continuous switched shunts at buses containing generators participating
in the transfer with a non-zero participation factor, resolve the power flow, calculate the voltage
sensitivities, turn the AVR control back on for those generators and switched shunts for which it was
changed, and then resolve the power flow. Stated another way, this option assumes that all
generators and switched shunts at buses participating in the transfer maintain a constant reactive
power output and do not maintain their voltage setpoint. With this option, affected buses become
PQ buses instead of PV buses in the Jacobian. PV buses will have a zero sensitivity to injection
changes because the voltage is fixed at the regulated setpoint, so in order to actually determine the
impact of the injection at these buses, they need to be made into PQ buses.
If the Integrated Topology Processing add-on is available, the Only show the primary bus for
each superbus checkbox will be available. When checked, the buses that show up in the table will
be limited to only those that are primary nodes. The determination of primary nodes is based on the
base case topology. This provides an easy filter to eliminate redundant data. This option also limits
the buses that appear in the transactor lists when either the Seller or Buyer type is Bus.
Self Sensitivity
The Self Sensitivity tab shows the effect of an injection of real or reactive power at a bus on its own
voltage (assuming everything is absorbed at the island slack bus). It processes through each bus
calculating its own self-sensitivity only.
Each row of the results gives the sensitivity of voltage at the respective bus to a power injection at
the same bus. dV/dP gives the sensitivity of voltage to real power injection and dV/dQ gives the
sensitivity of voltage to reactive power injection. To speed up the calculation, sensitivities are
calculated only for the buses displayed in the Bus Sensitivities grid. The bus columns (to add see
Display/Column Options) of interest after this calculation include:


Sensitivity: Self dV/dP (per unit/MW) --> dV/dP gives the sensitivity of voltage magnitude to an
injection of real power



Sensitivity: Self dV/dQ (per unit/Mvar) --> dV/dQ gives the sensitivity of voltage magnitude to
an injection of reactive power




Sensitivity: Self dAngle/dP (radians/MW) --> dAngle/dP gives the sensitivity of voltage angle to
an injection of real power

Sensitivity: Self dAngle/dQ (radians/Mvar) --> dAngle/dQgives the sensitivity of voltage angle
to an injection of reactive power

If the Integrated Topology Processing add-on is available, the Only show the primary bus for
each superbus checkbox will be available. When checked, the buses that show up in the table will
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be limited to only those that are primary nodes. The determination of primary nodes is based on the
base case topology. This provides an easy filter to eliminate redundant data.
Multiple Meters, Single Control Change
The Multiple Meters, Single Control Change tab shows the impact on various quantities to a change
in a control setpoint in the system.
The Control Types that can be selected:





Generator Voltage Setpoint - sensitivity of changing the voltage setpoint at a generator in
pu. Control unit is pu.
Transformer Tap Ratio - sensitivity of changing the transformer's tap ratio. Control unit is
the tap ratio.
Phase Shifter Phase Shift - sensitivity of change the phase shifter phase angle. Control unit
is degrees expect when calculating angle sensitivities and then it is radians.
Switched Shunt Nominal Mvar - sensitivity of changing the nominal Mvar injection at a
switched shunt. Control unit is Mvar.

Once the Control Type is selected, the specific device must be selected from the object chooser.
Click Calculate Sensitivities to perform the calculations.
The sensitivities that are calculated show up on the various tabs:
Buses



Sensitivity: dV/dControl (per unit/control unit) --> dV/dControlgives the sensitivity of the
bus voltage in per unit to the selected Control Type

Sensitivity: dAngle/dControl (radians/control unit) --> dAngle/dControl gives the sensitivity
of the bus angle in radians to the selected Control Type



Sensitivity: dQ/dControl (Mvar/control unit) --> dQ/dControl gives the sensitivity of the bus
Mvar injection to the selected Control Type

If the Integrated Topology Processing add-on is available, the Only show the primary bus
for each superbus checkbox will be available. When checked, the buses that show up in the
table will be limited to only those that are primary nodes. The determination of primary nodes
is based on the base case topology. This provides an easy filter to eliminate redundant data.
Generators


Sensitivity: dQ/dControl (Mvar/control unit) --> dQ/dControl gives the sensitivity of the

generator Mvar injection to the selected Control Type. When determining this sensitivity,
the sensitivity of the total Mvar injection at the generator bus is determined. This total is
apportioned to specific generators at a bus based on their proportion of the total Mvar
range for the bus. Only generators that are online and on AVR control are included in the
calculation.
Branches


Sensitivity: dP/dControl (MW/control unit) --> dP/dControlgives the sensitivity of the branch
MW flow to the selected Control Type
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Sensitivity: dQ/dControl (Mvar/control unit) --> dQ/dControl gives the sensitivity of the
branch Mvar flow to the selected Control Type

Interfaces


Sensitivity: dP/dControl (MW/control unit) --> dP/dControlgives the sensitivity of the



Sensitivity: dQ/dControl (Mvar/control unit) --> dQ/dControl gives the sensitivity of the

interface MW flow to the selected Control Type

interface Mvar flow to the selected Control Type

Click Close to close the Flows and Voltages Dialog.
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Line Loading Replicator
The Line Loading Replicator will attempt to set the loading on a transmission line or interface to a
desired real power flow amount. This is accomplished by calculating distribution factors for a selected
group of loads and generators to determine how the real power injection of these elements can be
adjusted to produce the desired flow. If the desired flow cannot be met, the new flow amount that can
be achieved and the injection changes required to meet this flow will be reported. Minimum and
maximum MW limits for loads and generators will be enforced when calculating the injection changes.
To open the Line Loading Replicator, go to the Tools ribbon tab, and choose Line Loading
Replicator from the Run Mode ribbon group. This is only available in Run Mode.
Select Device
Device Type
Select whether to adjust the flow on a transmission line/transformer or an interface. All devices must
already be defined in the case.
Device Identifier
Specify the near bus, far bus, and circuit identifier for a branch or the interface name and number
for an interface. Branches will be monitored in the near bus to far bus direction and interfaces will
be monitored in the direction in which they are defined to be monitored.
Present Flow
Present real power flow on the selected device.
Desired Flow
Desired real power flow on the selected device. The difference between the Desired Flow and the
Present Flow (Desired Flow – Present Flow) will be the flow change for which injection changes will
be calculated.
Available Injection Groups
Injection Group Identifier
Specify the injection group name and number that contains the loads and generators whose
injection can be changed to reach the Desired Flow. The injection group must already be defined in
the case. The injection group definition is used simply for selecting the group of elements to be used
in the calculations; the participation factors defined with the participation points in the injection
group are not used in the Line Loading Replicator tool.
Only Include AGCAble Generation and Load
If checked, only those loads and generators in the selected injection group whose AGC status is YES
will be included in the calculations.
Calculation Method
Select the method used to calculate the distribution factors used to determine real power injection
changes.
Max and Min Load Limits for Injection Changes
Use Max and Min Load Values
If checked, the maximum and minimum load values will come from the maximum and minimum
values defined with each individual load record.
Set Max and Min Load Values
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Click this button to show the Load Records Case Information Display. The maximum and minimum
load values can be defined by displaying the Max MW and Min MW fields and setting the values as
appropriate.
Use Multiplier on Present Value
If checked, the minimum and maximum value for each load will be determined by applying the Min
Multiplier and Max Multiplier to the present load value.
Calculate Injection Changes
Click this button to calculate the injection changes required to meet the Desired Flow on the selected
device.
Injection Changes
This is a case information display that will provide a summary of the injection changes needed, and
the elements that can effect these changes, in order to meet the Flow Achieved on the selected
device. The Flow Achieved will differ from the Desired Flow if there are not enough injection
changes available to meet the Desired Flow.
The results are reported in terms of injection. For generators, a positive injection means an increase
in generator output and a negative injection means a decrease in generator output. For loads, the
opposite is true; a positive injection means a decrease in load and a negative injection means an
increase in load.
Injection Change, Present Injection, and New Injection fields will be shown by default. These
Present Injection and New Injection fields are both calculated based on the present injection of the
given element with the New Injection value also being dependent on the Injection Change value.
The Present Injection and New Injection values will be updated any time that the present injection
for an element changes in the power system. This is important to keep in mind if making any
changes to the power flow case while the Line Loading Replicator dialog is open.
Injection changes are calculated so that generator and load limits are enforced. Which load limits
are used is determined in the Max and Min Load Limits for Injection Changes option settings.
The generator limits used are the minimum and maximum limits defined with each generator. These
limits can be accessed from the Generator Case Information Display. The load and generator limits
can also be displayed in the Injection Changes table by adding the Min MW and Max MW fields to
the table.
Total Injection Increase/Decrease
This value is the amount of injection increase and decrease required to meet the Flow Achieved. The
net injection will be zero.
Flow Achieved
Flow amount that can be achieved by implementing the Injection Changes listed. This value will
differ from the Desired Flow if there are not enough injection changes available to meet the Desired
Flow.
Implement Injection Changes
Click this button to make changes to the power flow case to match the calculated Injection Changes.
Automatic generation control (AGC) and phase shifter control are disabled for the entire case when
choosing to implement changes.
Implement Injection Changes and Solve Power Flow
Click this button to make changes to the power flow case to match the calculated Injection Changes
and then solve the power flow. The power flow is solved with the settings that are specified in the
Power Flow Solution Options specified with Simulator Options. When choosing to implement
changes, these options are updated so that automatic generation control (AGC) and phase shifter
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control are disabled globally for the case. The Present Flow value is updated after the completion of
the power flow solution.
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Contingency Analysis: An Introduction
Contingency analysis is a vitally important part of any power system analysis effort. Industry planners
and operators must analyze power systems covering scenarios such as the long-term effects on the
transmission system of both new generation facilities and projected growth in load. Market analysts
and planners must make informed decisions regarding transactions for energy trade - whether that
trade is for the next hour or months down the road. PowerWorld Simulator’s Contingency Analysis
tools provide the ability not only to analyze a power system in its base case topology, but also to
analyze the system that results from any statistically likely contingent scenario.
Industry planning and operating criteria often refer to the n-1 rule, which holds that a system must
operate in a stable and secure manner following any single transmission or generation outage. In
PowerWorld Simulator, the individual contingency conditions can also be tailored to consist of either a
single element (such as the loss of a transmission line or transformer), or multiple elements (such as
the loss of a generator, several buses and a number of branches simultaneously). See Available
Contingency Actions for a complete list of possible contingency actions.
Simulator can be set to use a Full Newton solution or use a DC Load Flow method to analyze each
contingency. The Full Newton approach is not as fast as a DC Load Flow, but the results tend to be
significantly more accurate and allow for gauging voltage/var effects.
The Tutorial is a great place to start learning about using Simulator’s Contingency Analysis Tool. We
also recommend reviewing the Terminology used throughout the Contingency Analysis help files prior
to continuing.
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Available Contingency Actions
The current edition of Simulator can process lists of contingencies including the following:
For Transmission Lines and Transformers (Branches)



The opening or closing of transmission lines and transformers
Opening all breakers to isolate and open a line or transformer

For individual Generators, Loads, or Switched Shunts



Loss or recovery of a particular generator, load, or switched shunt
Opening all breakers to isolate and open a particular generator, load, or switched shunt

For all the Generation, Load, or Switched Shunt at a particular bus





Movement of generation, load, or switched shunt MWs or Mvars to another terminal bus
Changing or setting of load, switched shunt, or generator MWs or Mvars
Change or setting of a generator or switched shunt voltage setpoint
Opening all breakers to isolate and open a particular generator, load or switched shunt

For Buses


Opening of all lines connected to a bus

For Interfaces



Opening or closing of all lines or transformers in an interface
Opening all breakers to isolate and open all lines or transformers in an interface

For Injection Groups




Opening, closing, or changing of output of all devices in an injection group
Setting or Changing the net MW Injection by a Percent or MW value and by proportion or by merit
order
Opening all breakers to isolate and open all devices in an injection group

Series Capacitors



Bypassing or placing series capacitors in service
Setting of the Series Reactance by percent or to a particular per unit value

Phase-Shifting Transformers


Changing or setting the Phase-Shifter Regulation MW value

DC Transmission Lines



Opening or closing DC Lines
Changing DC Line setpoint MW or Amp values
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Three-Winding Transformers



Opening or closing all legs of three winding transformers
Opening all breakers to isolate and open all legs of a three winding transformer

Solving the Power Flow
Contingency Block
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Contingency Analysis: Terms
Contingency – Contingencies are the basis of the Contingency Analysis tool. A single contingency can
contain a single contingency element (referred to as n-1 contingencies) or multiple contingency
elements.
Contingency Action - A statistically likely condition that could occur during power system operation.
See Available Contingency Actions for a listing of actions supported by Simulator.
Model Criteria – Criteria under which a contingency action will occur. For example, the user can
specify that a generation outage only occur if the pre-contingency flow on a line is higher than a
specified amount. Simulator allows you to define Model Criteria, which consist of both Model
Conditions and Model Filters. Normally, no Model Criteria will be specified for a given action.
Contingency Element – Consists of a single Contingency Action and its associated Model Criteria,
Status and Comment (optional). Multiple Contingency Elements can be defined for a single
Contingency.
Contingency Definition – A listing of the Contingency Elements assigned to a Contingency.
Global Action – A Global Action is a list of contingency elements that occur for ALL contingencies
unless an Inclusion Filter is specified that allows defining with which contingencies the action will be
included. The elements included in a Global Action do not have to be entered as individual elements in
each contingency.
Contingency Block – A list of Contingency Actions. A Contingency Block can be applied to individual
Contingencies by including the block as a Contingency Element.
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Contingency Analysis Power Flow Solution Options
By default, the contingency analysis will use the same options as the power flow algorithm when
solving each contingency. You may also override these options for all contingencies, and/or for a
specific contingency. This results in the ability to set the power flow solution options in contingency
analysis at three different levels
1.
2.
3.

Contingency Specific Options (see Contingency Definition Dialog)
Contingency Analysis Options (see Contingency Options Tab)
General Power Flow Solution Options (see Power Flow Solution Options)

When Simulator executes a particular contingency, it will first look at options specified for that
contingency. Any options which are defined for this contingency will be used. Other options set as Use
Default will look to the Contingency Analysis Options. Again, any options which are defined for
contingency analysis will be used. Finally, options marked in the Contingency Analysis Options as Use
Default will be set to the same setting as the power flow solution options.
In order to specify options for a specific contingency, click on the Define/Modify Solution Options
button on the Contingency Definition Dialog. In order to specify options for all contingencies, click on
the Define/Modify Solution Options button on the Contingency Options: Modeling/Basics page.
Both of these will bring up the Contingency Analysis Power Flow Solution Options dialog.
This dialog contains many options regarding the power flow solution. For options which are a
numerical value, just specify a new value to use. For options which are specified by a check-box, the
check-box will have three settings: use option, do no use option, and use default. For a more detailed
explanation of each option see the Power Flow Solution Options.
To set the values to be the same as the present power flow solution options, click the Set same as
for Power Flow button. To set all options back to use default, click the Clear All Settings button.
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Contingency Case References
Contingency Analysis always stores a Reference State or pre-contingency state. The Reference State
stores information pertaining to:











Buses
Switched Shunts
Limit Groups
Loads
Branches
Generators
Areas / Super Areas
MW Transactions
DC and Multi-Terminal DC Lines
Power Flow Solution Options

See Reference State Information for details on the specific information stored.
The reference state is loaded into memory prior to the execution of each contingency during automatic
processing of the contingency list. This ensures that all contingencies start from a common Base Case.
Furthermore, the system is set back to the reference state following completion of the automatic
processing. Note: The system is not restored to the reference state when the Solve Selected
Contingency option is selected from the Contingency Record Display’s local menu (see Reference
State Solution Options for more information).
The reference state is always stored in Simulator after the first instance of opening the contingency
analysis form. Therefore, opening the contingency analysis again may result in a prompt from the
program. This prompt will ask you if you wish to set the contingency analysis reference state to the
current state of the system (in case you have made changes since the last contingency analysis run),
or if you wish to keep the existing contingency analysis reference state (which was set by previously
opening the contingency analysis dialog.) Note that if you choose the second option, any changes you
may have made to the case outside of the contingency analysis will be lost, as the reference state
stored with the contingency analysis tool will reset the system state to the reference state.
Click here for information on defining the reference state.
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Contingency Case References - State Information
Simulator stores the following information with the Contingency Analysis Reference State. This list
should include all of the information that can be directly accessed by the user. Care should be taken
with modifying any data that is not stored in the reference state as it will not be restored at the end of
each contingency.
Bus State





In or out of service
Voltage Magnitude and angle
Boolean expression stating whether any load exists at the bus (this is used because some of the
contingency actions such as MOVE GEN will create a fictitious load if there is no generation at the
destination bus)
MW Marginal Cost

Switched Shunt State









In or out of service
Nom value MW, Mvar
Control mode (FIXED/DISCRETE/CONTINUOUS)
Description of Mvar blocks
Low/high range for control regulation
Target value for control regulation
Discrete Control Options - Use Continuous Element, Single Largest Step, Minimum and Maximum
Susceptance
Use High Target Value and High Target Value

Limit Group State


Rating sets for normal operation (Line, Interface…A, B, etc…)

Load State









In or out of service
Constant power MW and Mvar components of load
Constant current MW and Mvar components assuming one per unit voltage
Constant impedance MW and Mvar components assuming one per unit voltage
MW Scale
Mvar Scale
AGC Status
Min/Max Load MW

Line State





In or out of service
Bypassed?
Transformer Control - Control Mode (YES/NO for transformers, Not Enabled/Enabled for Power
Flow/Enabled for OPF Only for phase shifters), Regulation Minimum/Maximum, Line Drop
Compensation Reactance (X), Use Line Drop Compensation
Tap ratio
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Phase shift
Series Reactance X (only for series capacitors because a contingency element can change this)

DC Line State









In or out of service
Control Mode
Setpoint
Setpoint voltage
Resistance
Compounding Resistance
Rectifier and Inverter Tap Value
Firing Angles (alpha and gamma)

Multi-Terminal DC Line State





In or out of service
Control Mode
Bus of ac converter station controlling dc voltage
For each converter - converter setpoint, firing angle, tap, and in or out of service

Generator State















In or out of service
MW Output
Mvar Output
Max/Min MW Output
Participation Factor
Max/Min Mvar Output
Voltage Setpoint
Regulated Bus Number
AGC Status (YES/NO)
AVR Status (YES/NO)
Capability Curve
Use Capability Curve?
Line Drop Compensation Impedance
Line Drop Compensation Status (YES/NO/POSTCTG)

Area State and Super Area State






Unspecified MW Transactions
MW Scale
Mvar Scale
AGC Status
Use Area Participation Factors? (for Super Area)

MW Transaction



MW Value
Enabled Status

Power Flow Solution Options
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The following options can be set as part of the contingency-specific power flow solution options:



















MVA Convergence Tolerance
Maximum Number of Iterations
Initialize from Flat Start
Disable Power Flow Optimal Multiplier
Dynamically add/remove slack buses as topology is changed (Allow Multiple Islands)
Disable Checking Gen MVAR Limits
Check Gen MVAR Limits Immediately
Disable Switched Shunt Control
Disable Treating Continuous SSs as PV Buses
Disable LTC Transformer Control
Min. Sensitivity for LTC Control
Disable Balancing of Parallel LTC Taps
Disable Phase Shifter Control
Model Phase Shifters as Discrete Controls
Enforce Generator MW Limits
Prevent Controller Oscillations
Maximum Number of Voltage Control Loop Iterations
Min. pu voltage for constant power load

The following are included as part of the reference state but are not included as contingency-specific
power flow solution options:






Min. pu voltage for constant current load
Disable Angle Rotation Processing
Sharing of generator vars across groups of buses during remote regulation
Transformer Stepping Methodology
Use Topology Processing
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Contingency Case References - Defining the Reference State
The reference state is initially defined as the power system state that exists when the contingency
analysis is opened for the first time for a given power flow case during a Simulator session. See
Reference State Information for details on the specific information stored in the reference state.

Setting the reference state
The reference state can be changed each time that the Contingency Analysis Dialog is opened after
having already established a reference state. The Setting Reference State When Contingency Analysis
is Opened option is available for determining how the reference state should be set when the dialog is
re-opened during a Simulator session.
To change the reference while the Contingency Analysis Dialog is open, select the Set as Reference
option from the Other > button on the Contingencies Tab of the Contingency Analysis Dialog. The
reference state can also be redefined using the Solve and Set as Reference option from the
Contingency Record Display’s local menu (See Reference State Solution Options for more information).
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Contingency Case References - Reference State Solution Options

Contingency Record Display Local Menu
When you solve contingencies one at a time, you may choose between the Solve Selected
Contingency and Solve and Set As Reference options from the Contingency Record Display's local
menu.
Solve Selected Contingency causes Simulator to first load the reference state into memory then
solve the contingency. Following the solution, the reference state is not restored ; the system state
then reflects the power system flows of the post-contingency state. The advantage of this approach is
the ability to implement a contingency and then modify the system looking for possible actions that
might mitigate violations caused by the contingency. Be aware; however, that prior to solving another
contingency, Simulator will reset the system state to reference state thereby removing all
modifications made following the previous contingency solution. The user may also automatically
restore the system state to reference state by selecting Other > Restore Reference from the
Contingency Analysis Dialog.
Solve and Set As Reference acts the same as Solve Selected Contingency with one exception. After
executing the contingency, the post-contingency state is automatically set as the reference state. As a
result, all subsequent contingencies will use the post-contingent state as the Reference State.
Click here for details on the specific information stored in the reference state.
Click here for information on defining the reference state.
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Contingency Analysis: Defining Contingencies
There are four options for defining contingencies. The user may: Load Contingencies from a File, Auto
Insert Contingencies, or use the local menu to either Insert contingencies or Quick Insert a Single
Element Contingency.
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Auto Insert Contingencies
Simulator allows you to automatically generate a contingency list containing branch, generator and/or
bus outages. To accomplish this, click the Auto Insert button along the bottom of the Contingency
Analysis Dialog or right-click on the list of contingencies table in the Contingencies Tab and select
Insert Special > Auto Insert Contingencies…. This opens the Auto Insertion of
Contingencies Dialog.
When automatically inserting contingencies, you must specify the type, options and naming
conventions you want for the new contingencies. You must also specify whether to delete or retain
existing contingencies.
Auto Insertion of Contingencies Dialog
The Auto Insertion of Contingencies dialog has the following controls:
Automatically generate contingency involving a…
The options available in this box define what to add to each automatically inserted contingency
element. You can choose single transmission line, transformer, transmission line or transformer,
generating unit, or bus contingencies. Choosing one of these options results in each contingency
containing only one element of the specific type.
You can also define contingencies containing multiple outages by checking the Combination of…
option, and then specifying how many of each type of element (Lines, Transformers, and Generating
Units) you want considered in the contingency. When you use the Combination of… option,
Simulator will automatically determine all possible combinations for the element types specified
(based on the settings in Optionsused to filter elements) and create the contingencies. Combination
contingencies do not currently allow the inclusion of bus contingencies.
Restrict to Parallel or Common
These options will be enabled if choosing to do combinations where more than 1 of either a
transmission line, transformer, or generator are specified.
No restrictions (All)
All combinations will be created.
Common substation
If multiple lines are to be grouped together, only combinations of lines where at least one
terminal of each line is in a common substation will be included. If multiple transformers are
to be grouped together, only combinations of transformers where at least one terminal of
each transformer is in a common substation will be included. If multiple generators are to be
grouped together, only combinations of generators that are in the same substation will be
included. There is no requirement that the combinations of different types of elements are
contained in the same substation. For example, combinations of lines with generators will
ensure that all of the lines grouped together are in the same substations and all of the
generators grouped together are in the same substation, but the groups of lines and
generators grouped together can be in different substations.
Common bus
This option works the same as the Common substation option except that common objects
are grouped such that they have a common bus instead of substation.
Parallel Branch (Common bus for gens)
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If multiple lines are grouped together, only combinations of lines where both terminal buses
of the lines are the same will be grouped together. If multiple transformers are grouped
together, only combinations of transformers where both terminals buses of the transformers
are the same will be grouped together. If multiple generators are grouped together, only
combinations of generators at the same bus will be included. There is no requirement that the
combinations of different types of elements be parallel. For example, combinations of lines
must be parallel but they can be combined with generators that are at a different bus than
either of the line terminal buses.
Action Type to Create
Two options are available for specifying how the actions for the individual contingency elements
should be defined. When defining contingency actions that involving opening an element, two
formats are available: OPEN or OPEN BREAKERS TO ISOLATE. The OPEN format will implement an
open action by changing the status of the affected element. The OPEN BREAKERS TO ISOLATE
format will identify all breakers that should be opened in order to isolate the element. This option is
very useful when using a full topology model in which breakers are identified in the case. Select the
Open option to create the OPEN contingency definitions or the Open Breakers option to create the
OPEN BREAKERS TO ISOLATE contingency definitions.
Options
When Simulator auto-generates the contingency records for the element types specified, the options
in this section will further determine which elements are included and which elements are ignored.
Delete Existing Contingencies
When checked, any previously existing contingency records will be deleted before any
automatically created contingencies are inserted.
Use Area/Zone Filters
When checked, the elements included in the auto-generated contingencies will be only elements
that are within areas and zones defined in the Area/Zone/Owner Filters dialog. You may edit the
Area/Zone/Owner filters by clicking on the Edit Area/Zone Filters button.
Only include … meeting an advanced filter
When checked, the branches, generators, or buses included in the auto-generated contingencies
will be only those elements meeting conditions outlined by an advanced filter. To set the
conditions to be used, click the respective Define… Filter button.
Only include elements within X buses of bus
When checked, only elements that are electrically within X number of buses from the specified
bus will be included when creating the contingencies. For example, consider bus 1 is electrically
connected to bus 2, which is in turn connected to bus 3. If we specify the bus to be bus 1, and
choose to include only elements that are within 0 buses of bus 1, then the contingency record
will include the branch between buses 1 and 2, and if desired any generators attached to bus 1.
However, the branch between buses 2 and 3 and any devices attached to bus 2 and 3 will NOT
be included in the contingency because bus 2 is electrically 1 bus away from bus 1.
To specify the bus used, you can find the bus by using the search engine. The search engine
allows you to search by name or number. If you know the bus number, choose Sort by Number,
and type the bus number in the search box. If you know the name of the bus, choose Sort by
Name, and type the name of the bus in the search box. If you are not sure of the name of the
bus, you can use wildcard characters to search through the list of buses until you find the desired
bus.
How to name the contingencies
This section allows you to define how each automatically inserted contingency record will be named.
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Identify … using prefix
These four fields allow you to set a specific prefix for generators, lines, transformers and buses
so that you can easily determine what type or types of contingencies are modeled in the autogenerated contingency records. By default, the prefixes are G for generators, L for lines, T for
transformers and B for buses. However, you can change these prefixes to any character or set of
characters you wish.
Identify buses by
This field allows you to specify whether each contingency is labeled using the bus numbers, bus
names, or both as identifiers. Whichever type of identifier you choose here will be combined with
the defined prefixes to uniquely define the individual contingency elements within each autogenerated contingency record.
Include Nominal Voltages
When this check box is checked, the nominal voltage of buses will be included in contingency
labels.
Do Insert Contingencies
Press this button to generate the contingency list once all other options have been set.
Save to Aux
Press this button to save the dialog settings to an auxiliary file so that they can be recalled for later
use.
Cancel
Press this button to abandon creation of contingencies and close the dialog.
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Loading Contingencies from a File
Simulator can load contingency definitions from a text file. The contingencies may be specified in one
of three formats:




Simulator Auxiliary File Format (*.aux) (also see Contingency Subdata)
Simulator Version 5-7 Contingency File Format (*.ctg) (see the old users manual, or contact
PowerWorld Corporation)
PTI PSS/E-formatted Contingency Files (*.con).

To load contingencies from a text file, click the Load button along the bottom of the contingency
analysis dialog. A dialog box will be provided for you to specify the file from which to load the
contingency records. Specify the file type in the Files of Type dropdown box, and select the
appropriate file. If contingency records have already been defined for the case with which you are
working, you will be asked if you wish to delete the existing contingencies. Respond affirmatively to
delete the existing contingencies before adding the new ones from the specified files. Otherwise, click
No, and the contingencies loaded from the file will be appended to the already existing list.
Simulator is also capable of loading bus throw over data from PTI PSS/E-formatted load throw over
files.
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PSS/E Contingency Format
Simulator can read and write parts of the contingency format used by Power Technology’s PSS/E. The
current version of Simulator supports all parts of this format, except it does not recognize PTI’s
Automatic Contingency Specification flags. If you need Simulator to support these keywords, contact
PowerWorld Corporation to express your need. Otherwise, we recommend you make use of
Simulator’s Auto-Contingency creation tool.
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PSS/E Load Throw Over Files
Simulator can read load throw over settings used by Power Technology’s PSS/E. These files typically
have the extension of *.thr or *.dat. Note, however, that any modifications made to load throw over
settings cannot be saved back to the PSS/E throw over file (only read access is currently available).
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Saving Contingency Records to a File
Simulator can save contingency definitions to a text file. To save contingencies:






Click the Save button on the contingency analysis dialog. This action will save all contingency
definitions and contingency options. Choosing the Simulator Auxiliary File Format provides a
Contingency Settings dialog with options to save related settings such as limit monitoring settings,
general power flow solution options, and list display settings in the same auxiliary file. Contingency
Elements may also be defined in the auxiliary file using Bus Numbers, Bus Name and Nominal kV,
or Label.
Select Save As… from the local menu of the contingency records display . Several options for
saving contingency information to Simulator’s Auxiliary File Format are available:
o Auxiliary File... This action will save the information from the columns presently shown on
the contingency records display, plus the contingency elements for each contingency
record.
o Auxiliary File (only selected records)... This action will save the information from the
columns presently shown on the contingency records display and the contingency records
currently selected, plus the contingency elements for each selected contingency record.
o Auxiliary File (only selected records/columns)... This action will save the information
from the columns and the contingency records currently selected, plus the contingency
elements for each selected contingency record.
o Auxiliary File (all contingency related info)... This action is identical to that of the
Save button on the contingency analysis dialog (see above).
o Auxiliary File (all contingency related info/only selected records)... This action is
identical to that of the Save button on the contingency analysis dialog (see above), except
only definitions of the selected contingencies will be saved.
o Options for other file formats are also available, as are typically shown on case information
local menus. Such other formats are generally not suitable for loading contingency
information back into Simulator.
Click the Save to Aux button on the Auto Insertion of Contingencies Dialog. This action will save
the Auto Insertion options, but not the contingencies themselves.

The contingencies may be specified in one of three formats




Simulator Auxiliary File Format (*.aux) (also see Contingency Subdata)
Simulator Version 5-7 Contingency File Format (*.ctg) (see the old users manual, or contact
PowerWorld Corporation)
PTI PSS/E-formatted Contingency Files (*.con). This format includes an option to truncate the
contingency labels to 8 or 12 characters for compatibility with versions of PSS/E that do not
support longer labels. The truncated labels will be named such that each is unique. There is also
an option to use bus name and bus nominal kV in identification of contingency elements.

To specify the format for the contingency file, set the Save As Type option accordingly.
Note that there are limitations when saving to the Simulator Version 5-7 format or the PTI PSS/E
formatted files.
Limitations on the Simulator Version 5-7 format




Does not support the actions SET or CHANGE.
Does not support the action MOVE, except for Loads.
Does not support any actions regarding an Interface
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Does not support any actions regarding a Bus

Limitations on the PTI PSS/E format


Does not support any actions regarding an Interface
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Contingency Global Actions
Contingency Global Actions allow you to define a list of contingency elements that occur for ALL
contingencies and do not have to be entered as individual elements in each contingency. These
contingency elements are defined and processed in the same manner as contingency elements defined
with specific contingencies. A global action can be excluded from not being included with all
contingencies by using the Inclusion Filter described below.
Contingency global actions are defined from the Contingency Global Actions display accessed via the
Contingency Definitions grouping found on the Options tab of the Contingency Analysis dialog. Rightclick on the table to open the Contingency Element Dialog, which allows the additional of contingency
elements to be treated as part of the global actions.
When used with global actions, the Contingency Element Dialog will be modified to allow selecting an
Inclusion Filter to use with a global action. The Inclusion Filter is an advanced filter or device filter
that gets applied to each contingency. If the contingency meets the Inclusion Filter defined with a
particular global action, that contingency will include that global action. Otherwise, a global action will
be ignored for that contingency. To select an Inclusion Filter for a global action, click the Add/Modify
button. This will open the advanced filter dialog that will allow selection of the filter. To include a
global action will all contingencies, leave the Inclusion Filter blank. The Inclusion Filter is evaluated in
the reference case to determine if a contingency meets the filter.
The format of the string that describes the actions and the Model Criteria and Status fields are set
in the same manner as described in the Contingency Definition Display.
To disable the use of the Global Actions, check the Do Not Use Global Action List option found at
the top of the display.
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Contingency Blocks
Contingency Blocks are very similar to a Contingency Record, however no results can be associated
with them. Contingency Blocks consist of a list of contingency actions. The block is then given a name
so that any Contingency Record can call on a Contingency Block. When a contingency block is included
as part of a contingency, the Contingency Record will incorporate all the actions from the contingency
block into the actions performed by the contingency.
Contingency blocks are defined from the Contingency Blocks display accessed via the Contingency
Definitions grouping found on the Options tab of the Contingency Analysis dialog. Right-clicking in the
Contingency Blocks grid and choosing Insert allows you to insert a new Contingency Block. A dialog
very similar to the Contingency Definition Dialog will open. Use this dialog to insert elements into the
contingency block, create additional contingency blocks, or modify existing contingency blocks. Once a
new contingency block has been created, actions can be added to the block by right-clicking in the
Contingency Definition grid and choosing Insert. This will open the Contingency Element Dialog that
allows the addition and modification of elements in the contingency block. When using the
Contingency Element Dialog with Contingency Blocks, the option to insert an Element Type of
Contingency Block is not available.
The format of the string that describes the contingency block actions and the Model Criteria and
Status fields are set in the same manner as described in the Contingency Definition Display.
To disable the use of a Contingency Block, set the Skip field to YES. When a Contingency Block is
disabled, all of the actions defined in the block will be ignored in all of the contingencies in which the
block is included.
Once Contingency Blocks have been defined, a new Element Type, Contingency Block will appear on
the Contingency Element Dialog. You may then add a contingency block to a contingency by rightclicking on a contingency in the Contingency Records list display, choose show dialog (or insert if you
are adding a new contingency record), click on Insert New Element, and choose Contingency Block
from the list of element types.
Using a contingency block is an easy way to include a set of common actions in multiple contingency
scenarios, without having to re-define the actions for each contingency.
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Contingency Analysis Dialog Overview
Simulator’s contingency analysis tools can be accessed only from Run Mode. To access this dialog go
to the Tools ribbon tab, and choose Contingency Analysis from the Run Mode ribbon group. This
will open the Contingency Analysis dialog.
Each tab of the contingency analysis dialog covers a particular aspect of the analysis.
The Contingencies tab is used primarily to manage the contingency list and to learn basic information
regarding each contingency and the violations that it causes.
The Options tab contains a panel on the left which provides access to all the options for contingency
analysis. The tab enables you to dictate various parameters for the analysis that govern such things as
how violations are flagged in both the Base Case and for contingency conditions and what information
should be included in the contingency report. It also provides access to more complex contingency
definitions and as well as Distributed Computing options.
The Results tab contains a panel on the left which provides access to look through the results of the
contingency analysis. It include the ability to View Result by Element as well as by contingency. Other
convenient summaries of contingency analysis results are also available as well as the ability to write
results to a Text File.
For more description of how to perform a contingency analysis Simulation see Running the
Contingency Analysis.
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Running the Contingency Analysis
To run the contingency analysis means to model and solve one or more contingencies from the case’s
current contingency list. Simulator’s Contingency Analysis Dialog gives you several options for running
the contingency analysis. You may




Run every contingency in the contingency list (except, of course, for those you have designated to
skip using the Contingency Records Display).
Run a selected contingency to identify its limit violations and then leave the system in this postcontingency state. (Realize that prior to solving another contingency, Simulator will reset the
system state to the reference state. For more information see Contingency Case References).
Run a selected contingency to identify its limit violations and keep the resulting case as the new
reference point for further contingency analysis runs.

To run the complete contingency list, do any one of the following:



Right-click on the Contingency Records Display to bring up its local menu and select Run
Contingency Analysis.
Click the Start Run button at the bottom of the Contingency Analysis Dialog.

To pause the contingency run once it has started, click either Pause Run at the bottom of the
Contingency Analysis Dialog. To resume a paused contingency run, click the Continue button .
Finally, to terminate a contingency run, click the Abort button next to the Pause/ Continue button.
The status indicator will inform you of the run’s current state.
To solve a single contingency, identify its violations, and then leave the system in this postcontingency, select the contingency you wish to model in the Contingency Records Display, right-click
to invoke the display’s local menu, and select Contingency records > Solve Selected
Contingency. (Realize that prior to solving another contingency, Simulator will reset the system state
to the reference state).
To solve a single contingency and set it as the reference (starting) case for further contingency
analysis activity, select the contingency you wish to model in the Contingency Records Display, rightclick to invoke the display’s local menu, and select Contingency records > Solve and Set As
Reference. Simulator will model the selected contingency, flag its violations, and leave the resulting
case in memory so your future work will affect the post-contingency system rather than the original
pre-contingency state. See Contingency Case References for more information.
The Refresh Displays After Each Contingency checkbox is used to force a refresh of the counters
after each contingency, which may slow down processing of the contingency set (accordingly, this box
is unchecked by default to maximize solution speed).
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Other Contingency Actions
By clicking the Other > button on the Contingency Analysis dialog, you have access to several
actions.
Delete All Contingencies
Click this to delete all the contingencies presently stored in memory.
Clear All Contingency Results
Click this to clear all the results of the contingencies from memory. This will not delete the
contingencies.
Set As Reference
Click this to set the case presently in memory as the Reference State for contingency analysis. For
more information on the reference state, see Contingency Case References.
Restore Reference
Click this to set the state of the present power system case back to the contingency analysis
reference state. For more information on the reference state, see Contingency Case References.
Convert to Device Contingencies
This command is intended for use with full topology models, where breakers and disconnects are
defined in addition to generators, loads, transmission lines, etc. This function would have no affect
on a traditional planning model representation in which no breakers or disconnects are explicitly
defined.
The purpose of this option is to allow the user to take a contingency set that is defined with outages
of breakers and disconnects in a full topology model and convert them to outages of the traditional
planning model elements, such as generators, loads, transmission lines, etc. This would be used in
conjunction with the ability to save a full topology model as a consolidated model. A consolidated
model reduces the full model down to a traditional planning model by examining the breaker and
disconnect statuses and reducing the system down by consolidating breakers and disconnects that
are in service. The resulting model is a smaller model with the traditional planning elements
represented, but breakers and disconnects have been removed and nodes aggregated into bus
representations. This function will also take the breaker and disconnect statuses and convert them
into contingencies of the planning model devices affected by opening the original breakers or
disconnects. Thus, you could create a contingency that is defined for the consolidated model and
can be run on the consolidated model with the same results as if the original contingency set is run
on the full topology model.
The contingency set generated depends on the statuses of the breakers and disconnects, and the
contingencies created will be different for the different statuses of breakers and disconnects in the
full topology model.
Combined Tables
Contingency Violation Matrices
Clicking Process Contingency Results will go through the existing contingency analysis tool
results and build tables showing the limit violation values for all violated lines, interfaces, and buses
and the contingencies for which each element is violated. Upon opening, it is possible to limit
processing to branches, buses, and/or interfaces. Also, you can specify whether to display
percentages or actual flows in the resulting tables.
Contingency Violation List
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Contingency Violation List lists all violations from the current contingency set in a tabular format.
This lists eliminates possible clutter by not listing those contingencies for which there are no
violations.
Contingency Element Definitions
Contingency Violation List lists all contingency actions from the current contingency set in a tabular
format.
Produce Report
To produce a detailed report of the results of the contingency analysis, click Produce Report. This
will launch a save window that will save the information you customized on the Report Writing page.
You will also be given the option of viewing the report in WordPad immediately after creating the
file.
What Actually Occurred?
After running contingency analysis, click this to produce a list of actions that occurred during the
selected contingency. This is especially useful for identifying those actions conditional on Model
Criteria were applied.
Compare Two Lists of Contingency Results
Click this to open a dialog which allows you to specify two sets of contingency analysis results to
compare. For more information on this comparison, see Comparing Contingency Analysis Results.
Filter Results Using Limit Monitoring Settings
Click this to filter the contingency analysis results using the present Limit Monitoring Settings. This
action will go through each violation for each contingency and verify that the element that was
violated is set to be monitored. If the element is not set to be monitored, then Simulator will flag the
violation internally as inactive. You will then not be able to see these violations on any of the
displays, although they will still be saved in memory until you delete these contingencies, or
reprocess them. These violations will also not be saved when you choose to save the contingency
results.
Because the violations are saved in memory however, you can get them back without reprocessing
the contingency list. To do this, change your Limit Monitoring Settings so that those violations will be
set for monitoring again. Then click this option again.
When using this option, keep in mind that Simulator cannot filter results that do not exist in
memory. If the filter is to be used to filter out different percentages of overload, then the
contingency analysis should be run with the lowest percentage desired. For example, if the filter
option is to be used to give all of those elements that are loaded above 70% of their limit and then
those that are loaded above 90% of their limit, the contingency analysis should be run with the Limit
Monitoring Settings defined to monitor elements that are loaded at 70% of their limit. Also, keep in
mind that the more elements are monitored the slower the processing will be.
Auto-fill Blank Contingency Element Comments
Selecting this option will fill the Comment field of the Contingency actions in the Contingency
Definition table with a copy of the contingency action definition. The action description itself cannot
be modified, but the comment can be modified to be more descriptive of the action being taken, for
your own reference.
Sensitivity Calculations >
Simulator provides the PTDF tool for calculating the impact of a MW transfer on all the transmission
lines in the system. The Simulator ATC tool further extends the linearized methods by integrating
linearized contingency analysis with the PTDF calculations. The sensitivity calculations provided here
are an extension of this. They allow you to ask the question, How will each contingency-caused
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branch or interface violation be affected by a MW transfer?. Note: this calculation is not
relevant for bus violations.
Calculate OTDFs using existing PTDFs
Before executing this, you must first go to the PTDF Dialog and calculate the PTDFs for the
transfer direction you are interested in. These PTDF values will then be used throughout the
OTDF calculation. Click this to calculate OTDFs for each contingency-caused branch or interface
violation. The values calculated will be a measure of what percent of a transfer would appear on
the branch or interface after the respective contingency occurs. Realize for branch violations, that
the sign of the OTDF value will be relative to the direction of the MW flow found during the
contingency analysis (see the Element description on the Contingency Violations Display).
Filter out Violations Using OTDFs
Once you have calculated the OTDFs using the existing PTDFs, you can then filter the results by
selecting this option. A dialog will appear for you to enter a minimum OTDF value. All violations
that have an OTDF smaller than this number will be flagged as inactive and will not show up in
the list of violations. See the note above regarding the Filter Results using Limit Monitoring
Settings to better understand how inactive violations are treated.
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Contingency Analysis Dialog: Contingencies Tab
The Contingencies tab of the Contingency Analysis dialog provides tools for managing and simulating
lists of contingencies. The top portion of the page lists the contingency records that have been defined
for the case. This table is called the Contingency Records Display. The contingency records display is a
type of case information display and thus shares many of the properties and controls common to all
other case information displays. By right-clicking on the display, you gain access to its local menu,
which offers several choices:










Insert allows you to insert a new contingency record
Insert Special gives the following options:
o Quick Insert of Single Element Contingency which allows you to quickly specify a
single element contingency via the Contingency Element Dialog
o Auto Insert Contingencies which opens up the Auto Insert Contingencies dialog
o Merge Pairs of Selected Contingencies which generates every possible pair of
contingencies based on the selected contingencies. For instance, if you select 4
contingencies (A, B, C, D), then click Merge Pairs of Selected Contingencies, 6 new
contingencies will be generated: A+B, A+C, A+D, B+C, B+D, and C+D.
o Clone Contingencies which makes copies of each selected contingency
o Join Active Contingenciescreates new contingencies that are the join of the current
contingency list and a list read in from an auxiliary file. Contingencies with their Skip
property set to YES will not be included in the join.
Delete allows you to delete a particular contingency
Show Dialog displays the Contingency Definition Dialog corresponding to a particular contingency
Contingency Records gives the following options:
o Run Contingency Analysis (see Running the Contingency Analysis)
o Filter Results Using Limit Monitoring Settings (see Other Contingency Actions)
o Solve Selected Contingency (see Contingency Case References - Reference State
Solution Options)
o Solve and Set as Reference (see Contingency Case References - Reference State
Solution Options)
o Compare Two Lists of Contingency Results (see Other Contingency Actions)
o Apply Selected Contingency which applies the actions in the contingency definition, but
does not solve the contingency or calculate violations.
o What Actually Occurred? (see Other Contingency Actions)
Many other options (e.g., printing, finding, and sorting) which are characteristic of case
information displays.
Save As gives several options characteristic of case information displays as well as options unique
to the contingency records display:
o Auxiliary File, Auxiliary File (only selected records), and Auxiliary File (only
selected records/columns) will only save contingency definitions. Any supporting data
such as contingency blocks, global actions, model criteria, etc. will not be saved. To make
sure that this supporting data is saved, use one of the (all contingency related info)
options described below.
o Auxiliary File (all contingency related info) first opens a file dialog for specification of
the auxiliary file. Clicking Save from the file dialog opens a Contingency Settings dialog
for specification of related settings to save in the same auxiliary file, including Contingency
Options, Limit Monitoring Settings, General Power Flow Solution Options, List Display
Settings (Case Information Customization), Contingency Results, and whether or not to
save unlinked elements. Definitions of all contingencies are also saved. This has the same
functionality as clicking the Save button in the bottom panel.
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o

Auxiliary File (all contingency related/only selected records) has the same
functionality as Auxiliary File (all contingency related info), except contingency
definition(s) are only saved for the selected contingency record(s). You may also specify
related settings to save.

You can also sort the display’s contents by any field just by clicking on the field’s heading. The default
fields shown in the contingency records display are described at the bottom of this page.
As you scroll through the records in the contingency records display, you will notice that the contents
of the tables that occupy the middle third of the contingency analysis dialog change. These tables are
the Contingency Definition Display and the Contingency Violations Display. These displays show the
violations and definition for the contingency that is selected in the contingency records display at the
top of the dialog. You may optionally hide the Contingency Definition Display by clicking on the X to
the upper right of this display. To show the display again, click on the O to reopen it. You may change
the relative width of the Contingency Definition and Violations display by moving your mouse over the
line between the displays until your cursor changes. Then left click and drag to modify these widths.
When you first load a new contingency list into memory, the current status indicator along the bottom
of the display will indicate the contingencies have been Initialized. During a contingency analysis run,
the current status indicator may take on the values Running, Paused, Aborted, or Finished.
The contingency tab of the contingency analysis dialog offers several ways to run the contingency
analysis. To start a run, you may click the Start Run button. Alternatively, you may choose Run
Contingency Analysis from the local menu of the contingency records display. Once a contingency
analysis run has started, you may pause it at any time by clicking the Pause Run button, after which
you may resume the run by clicking Continue. In addition to running the full set of contingencies, you
may also choose to run just a single contingency. See Running the Contingency Analysis for more
details.
Several other actions related to contingency analysis are also available from the Contingencies Tab.
These are accessed by clicking on the Other Actions > button. They are described on the Other
Contingency Actions page.
You may close the Contingency Analysis Dialog at any time either by clicking Close or by selecting
Close from the local menu of the Contingency Records Display or the Contingency Violations Display.
By default, the contingency records display presents the following fields:
Label
The name of the contingency.
Skip
Indicates whether Simulator should skip the corresponding contingency in performing the
contingency analysis. If the value of the Skip field is Yes for a contingency, then that contingency
will not be implemented when performing the contingency analysis. This is a toggleable field, which
means that you can toggle its value by double-clicking the field.
Processed
Indicates whether the contingency has been analyzed yet as part of the current contingency run.
Solved
If the contingency has not yet been processed, which means that the contingency has not yet been
implemented, then the value of this field is No. For contingencies that have been processed, the
Solved field indicates whether the power flow case that resulted from the contingency could be
solved to within tolerance. If the resulting power flow case could not be solved, you should
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investigate the contingency closely to determine if that contingency is indeed harmful to the stability
of the system.
Post-CTG AUX
The auxiliary file specified here will be loaded at the start of this contingency, which can be used to
alter the reference state for this contingency. If an auxiliary file is specified here, the contingency
options Post-Contingency Auxiliary File will not be loaded for this contingency.
Double-click a cell to edit the specified post-contingency auxiliary file. A specified post-contingency
auxiliary file may be removed using the Contingency Definition Dialog.
Note: Only data stored with the contingency reference state will be "reset" when the reference state
is restored. Therefore, only data stored with the reference state should be loaded via a postcontingency auxiliary file. Click here for details on the specific information stored with the reference
state.
Islanded Load
Displays the sum of the amount of load that was islanded from the rest of the system due to the
contingency. This load is inaccessible from the rest of the system.
QV Autoplot?
This option must be toggled to Yes if you intend to run a QV Analysis and automatically plot the QV
curve for one or more contingency scenarios.
Violations
Identifies the number of violations caused by the particular contingency. This number represents the
total number of contingencies (branch thermal violations + bus violations + interface violations) that
were caused by the contingency. Depending on how you have configured the reporting of Base Case
violations (see Base Case of the Options Tab), this number may include all, some, or none of the
violations that were present in the Base Case model.
Max Branch %
Indicates the percentage overload of the worst-case branch violation. If there are no branch
violations, this field will be blank.
Min Volt
Indicates the lowest bus voltage resulting from the contingency. If there are no low voltage
violations, this field will be blank.
Max Volt
Indicates the highest bus voltage resulting from the contingency. If there are no high voltage
violations, this field will be blank.
Max Interface %
Indicates the percentage overload of the worst-case interface violation. If there are no interface
violations, this field will be blank.
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Contingency Definition Display
The Contingency Definition Display lists the Elements assigned to the selected Contingency. This
display appears on both the Contingency Tab and the Lines, Buses, Interfaces Tab of the Contingency
Analysis Dialog, it also appears on the Contingency Definition Dialog.
Select Insert from the local menu to add elements to the contingency. Right-click on a specific
element in the display and select Delete from the local menu to remove the element from the
contingency.
The contingency definition display is a type of Case Information Display and shares many
characteristics and controls common to all other case information displays.
The Contingency Definition Display always contains the following fields:
Actions
This shows a string which describes the action. You may customize the format of the string that
describes the contingency actions by right-clicking on the Contingency Definition Display and
choosing Display Descriptions By, and then choosing Name, Num, Name/Num, PW File Format by
Numbers, PW File Format by Name/kV, PTI File Format, or Label.
Model Criteria
Simulator allows you to define Model Criteria, which can consist of both Model Conditions and Model
Filters. These specify a criterion under which a contingency action would occur. For example, you
could specify that a generation outage only occur if the pre-contingency flow on a line is higher than
a specified amount. Normally, no Model Criteria will be specified, and this field will be blank. Also,
note that Model Criteria can be overridden by the Model Condition and Filter option found on
the Model Conditions page accessed from the Contingency Definitions grouping on the Options tab
of the Contingency Analysis dialog. Model Criteria can be defined from the local menu
(CTGElement records > Define Model Criteria option) on the Contingency Definition Display,
from the Add (Model Criteria) button on the Contingency Element Dialog, or by using the Model
Conditions and Model Filters pages in the Contingency Definitions grouping on the Options tab of
the Contingency Analysis dialog.
Status
Double click the Status field to toggle through the available options. The possibilities are:





Check : The action will only be executed if the Model Criteria are true or if no Model Criteria
are specified. Check is the default status setting.
Always: The action will always be executed, regardless of the Model Criteria.
Never: The action will never by executed, regardless of the Model Criteria. This allows you to
disable a particular contingency action without deleting it.
PostCheck: This action will be considered AFTER all Check and Always actions have been
performed and the load flow solution solved. If the Model Criteria specified for the PostCheck
action are met in the solved load flow solution (or if no Model Criteria are specified), then this
action is taken and the load flow is again resolved. If the model conditions are not met, the
action is skipped. This process repeats recursively for all Postcheck actions until complete. This
behavior only occurs when the Calculation Method for the analysis is set to Full Power Flow.
Because the power flow is not solved when either of the two dc methods is selected, the
PostCheck status instead acts as a Check status.

Comment
An optional user-specified data string associated with the action. For example, for an action with
Model Criteria specified, you could add a sentence explaining why the action is only performed under
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the specified criteria. While this comment is not used by Simulator in any way, it is saved with the
contingency element when saving contingency records in contingency auxiliary data files.

1039
©2011 PowerWorld Corporation

Contingency Violations Display
The Contingency Violations Display is used to list the violations that were caused by the contingency
selected in the Contingency Records Display.
The contingency violations display lists all of the power system elements that become violated as a
result of the selected contingency. If you have selected a violation, you may click on the Show
related contingencies button to view all contingencies that cause a violation on this power system
element. Clicking this button automatically moves you to the Results tab and selects the appropriate
power system element. You can also right-click on a violation in the list and choose Show Dialog from
the popup menu to see the information dialog of the violated element. In addition to showing
violations for branches, buses, or interfaces, results for Custom Monitors will also be displayed here.
Custom Monitors are not violations, but are specific quantities that are tracked in addition to the limit
monitoring.
If the contingency selected in the Contingency Records Display resulted in no violations or has not yet
been processed, the Contingency Violations Display will display the words None Defined. This display is
a type of Case Information Display and thus shares many characteristics and controls common to all
other case information displays. You can sort the list of violations by any field simply by clicking on
that field’s caption.
The Combined Tables button provides access to the Combined Tables options described in Other
Contingency Actions. In addition to these options, there is one other option for displaying What
actually occurred? Selecting this will display a dialog box giving the details of the actions applied
during the contingency and any actions that may have been skipped.
By default, the Contingency Violations Display contains the following fields:
Category
The type of violation that occurred. If the violation is only due to the options set in Advanced Limit
Monitoring, then the type will start with the word Change.
Valid categories include:
Branch Amp - branch violated due to current limit being exceeded
Branch MVA - branch violated due to MVA limit being exceeded
Bus Low Volts - bus violated due to low voltage limit being exceeded
Bus High Volts - bus violated due to high voltage limit being exceeded
Bus dV/dQ - bus violated due to dV/dQ sensitivity exceeding specified change threshold
Bus Neg dV/dQ - bus violated due to the dV/dQ sensitivity becoming negative
Bus Disconnected- bus violated due to becoming disconnected during the contingency
Nomogram MW- nomogram violated due to MW limit being exceeded
Interface MW - interface violated due to MW limit being exceeded
Custom - value of specific object field being monitored
Element
A character string that describes the element that suffered the violation or the element that is being
monitored with a Custom Monitor. For violations, this can either be a branch, a bus, or an interface.
For Custom Monitors, this can be any object type that can be monitored with the custom monitors.
When the element is a branch, this string provides you with three pieces of information:



The branch that was violated
The terminal of the branch which had the highest loading
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The direction of the flow on this branch

Example 1: Jamie (22) -> Amy (33) CKT 1 at Amy (33)
This means that a branch connecting Jamie(22) to Amy (33) with circuit ID 1 is violated. The
violation is at the Amy(33) terminal. The -> indicates that the flow on this line is from Jamie
toward Amy.
Example 2: Xena (55) <- Harley (77) CKT 1 at Harley (77)
This means that a branch connecting Xena (55) to Harley (77) with circuit ID 1 is violated. The
violation is at the Harley (77) terminal. The flow on this line is from Harley toward Xena.
For Custom Monitors, the string identifies the type of object that is being monitored, the identifier of
the object that is being monitored, and the variablename of the specific field that is being
monitored.
Value
Indicates the value of the violating quantity. For example, if the category of the violation is Branch
Amp and the Value field is x, then the current on the violated element is x.
For Custom Monitors this is the value of the monitored field following the contingency.
Limit
Identifies the limit value that was violated. For example, if the category of the violation is Branch
Amp and the Limit field is y, then the limit on the current that may flow through the element is y.
For Custom Monitors this will always be zero.
Percent
The actual flow value for the element as a percentage of the limit.
For Custom Monitors this will always be blank.
Area Name Assoc.
Lists the areas with which the violated element is associated. If the element is a branch, Area Name
identifies the area in which each of the branch’s terminal resides. If the element is a bus, Area Name
identifies the area in which the bus resides. If the element is an area-to-area interface, Area Name
will identify the areas that the interface ties; otherwise, it will read N/A.
For Custom Monitors this will always be blank.
Nom kV Assoc.
Identifies the maximum voltage level associated with the violated element. If the violated element is
a branch, then Nom kV lists the nominal voltage of its higher-voltage terminal. If the violated
element is a bus, then Nom kV simply identifies the bus’ nominal voltage. If the violated element is
an interface that is made up strictly of branches, Nom kV lists the maximum nominal voltage of its
terminals; otherwise, it will appear as -9999.9.
For Custom Monitors this will always be blank.
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Contingency Definition Dialog
The Contingency Definition Dialog (shown below) serves as an information source for displaying the
Contingency Element (or Elements) associated with individual Contingencies defined in the case. You
can use the Contingency Definition Dialog to scroll through the list of elements, to view and modify
their definitions, to insert new elements in a contingency or to delete a contingency. You may access
this dialog by choosing either Show Dialog or Insert from the local menu of the Contingency
Records Display.
After making changes, click OK to save your changes and close the dialog. Click Cancel to close the
dialog without saving your changes. Click Save to save your changes (including the addition of a new
contingency) without closing the dialog (this allows you to keep working with the dialog). Click Delete
to remove the selected contingency from the contingency list.

Contingency Definition Dialog
The Contingency Definition Dialog has the following controls that are available regardless of the tab
that is currently selected:
Contingency Label
Identifies the name of the currently displayed contingency. Use the drop-down arrow to select a
different contingency, or use the scroll buttons to navigate through the list of contingencies. When
adding a new contingency, Contingency Label will show New Contingency. The user can change the
Contingency Label by clicking Rename.
Add New
Click the Add New button to add a new contingency to the contingency list for the case. You will be
prompted to enter a unique name for the new contingency. After naming the new contingency, the
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name appears in the Contingency Label and you can insert new elements in the contingency
definition.
Rename
Allows you to rename the selected contingency.
Find
Opens a dialog that will allow the use of advanced search methods for finding a particular
contingency.
Definition Tab
Insert New Element
Click this button to add a new element to the contingency. This will open the Contingency
Element Dialog, used to define the Action, Model Criteria and Comment associated with the
element. When you return to the Contingency Definition Dialog, the display will contain the newly
inserted element.
Clear All
Removes all elements from the contingency definition. The Contingency Elements Table will then
appear blank, indicating that the contingency involves no associated actions.
Definitions Display
The Contingency Definitions Display lists the Elements assigned to the selected Contingency.
Select Insert from the local menu or click on the Insert New Element button to add elements
to the contingency. Right-click on a specific element in the display and select Delete from the
local menu to remove the element from the contingency. For more information about this
display, see the Contingency Definitions Display.
Define Solution Options
Click this button to open the Contingency Solution Options Dialog, used to define specific power
flow solutions options for use under the selected contingency.
Use Specific Solution Options
Check this box to enable the use of Contingency Specific Solution Options (see Define Solution
Options above).
Ignore ALL contingency specific solution options
If checked, all contingency specific options, either defined individually for the specific
contingency or defined globally in the contingency options for all contingencies, are ignored. The
solution options as saved with the case will be used.
Post-Contingency Auxiliary File
The auxiliary file specified here will be loaded at the start of this contingency, which can be used
to alter the reference state for this contingency. If an auxiliary file is specified here, the
contingency options Post-Contingency Auxiliary File will not be loaded for this contingency. This
file is applied before any contingency-specific solution options are applied. The contingency
actions are then implemented after any contingency-specific solution options are applied.
Click the Browse button to open a file dialog for file selection. To remove the file, delete the
contents of the text box.
If the file specified does not include a file path, then Simulator will look in the presently active
directory, otherwise the file path specified will be used. If the post-contingency AUX file can not
be found in this location, then Simulator will look to see if a file by this name exists in the
directory from which the presently loading case was read. If a file is specified and still can not be
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found, then when running the analysis from the contingency analysis dialog, Simulator will show
a dialog requesting you to find the file or remove the option.
Only data stored with the contingency reference state will be "reset" when the reference state is
restored. Therefore, only data stored with the reference state should be loaded via a postcontingency auxiliary file. Click here for details on the specific information stored with the
reference state.
Custom Tab
The Custom page of the dialog contains two sections: custom fields and memo.
The custom fields section allows access to setting and changing the values for custom fields that
have been defined for the contingency. Defining custom fields is detailed in Custom Field
Descriptions.
The Memo section of the dialog is simply a location to log information about the contingency. Any
information entered in the memo box will be stored with the case when the case is saved to a PWB
file.
Monitoring Exceptions Tab
Monitoring exceptions can be defined for each contingency. Defining exceptions is useful when
specific elements need to be excluded or included for monitoring on a contingency-by-contingency
basis. Click here for more information about monitoring exceptions.
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Contingency Analysis Dialog: Options Tab
The Options tab of the Contingency Analysis dialog enables you to control many parameters that
govern how the contingency analysis flags violations, deals with violations that appeared in the Base
Case, and documents the violations in the form of a report.
On the left of the Contingency Options tab there is a pane summarizing all the available options. This
pane is split into the following 5 major groupings:






Modeling: contains various options for how devices respond during a contingency which are
described in the topics Basics, Generator Post-Contingency AGC, Bus Load Throw Over, Generator
Maximum MW Response, Generator Line Drop and RCC, and Post-Contingency Auxiliary File.
Limit Monitoring: contains options regarding special limit monitoring features for contingency
analysis described in Advanced Limit Monitoring, Monitoring Exceptions, and Custom Monitors.
Contingency Definitions : contains listings of contingency blocks , global actions, model
conditions, model filters, model expressions, and other convenient listings of contingency
elements.
Distributed Computing : contains special distributed computing options for contingency analysis
Miscellaneous

1045
©2011 PowerWorld Corporation

Contingency Options: Modeling Basics
These options are all available on the Contingency Analysis dialog under the Contingency Options tab
under the Modeling grouping.
Calculation Method
The calculation method defines how the power flow is solved during the contingency analysis. By
default, Simulator uses a Full Power Flow for each contingency. For a large set of contingencies
and a large case, this can take some time to complete. The Full Power Flow option can utilize either
an AC solution or DC solution depending on whether or not the Power Flow Solution Options are set
to Use the DC Approximation in Power Flow. Alternatively, the contingency analysis can be done by
calculating the linear approximation of the impact of the contingencies by choosing either the
Linearized Lossless DC or Linearized Lossless DC with Phase Shifters method. These two
methods will both solve a set of contingencies much faster than the full power flow. The Lossless DC
methods utilize sensitivities of devices to calculate the load flow in a linear fashion. The only
difference between the two lossless DC methods is that the first method treats all phase shifters as
free-flowing, while the method with phase shifters will hold all in-service phase shifters at their
present MW flow value.
If the Power Flow Solution Options are set to Use the DC Approximation in Power Flow, the
linearized methods will not be available. Also, if the DC approximation is in use, the option with the
Limit Monitoring Settings to Treat Transmission Line Limits as Equivalent Amps will be ignored. Line
limits will always be reported in MVA.
Limit Monitoring Settings
Click this button to open the Limit Monitoring Settings Dialog to change the limit settings for
monitored elements. See Limit Monitoring Settings for more details.
For DC methods, allow amp limits by assuming a constant voltage magnitude
If a Lossless DC calculation method has been selected from the Modeling Tab, this option will
become available. If checked, Simulator will allow converting MVA limits to Amp limits by assuming
constant voltage magnitudes based on the state operating point just prior to the contingency
calculations. Converting to amp limits is only enforced if the Limit Monitoring Settings Option of
Treat Transmission Line Limits as Equivalent Amps is checked. When this option is checked, the
contingency loading of the line will be calculated from the post-contingency current on the line and
the calculated amp limit.
Retry solution using the Robust Solution Process after a contingency solution failure
Checking this option will force the contingency analysis routine to attempt a robust solution following
the failure of a standard Newton-Raphson solution. The robust solution attempt does not guarantee
convergence, but will attempt to slowly approach a convergence solution if possible. This process is
described in more detail under Simulation Control.
Note: The Robust Solution Process is not used regardless of how this option is set when solving
contingencies as part of either the PV or QV analysis available with the PVQV add-on.
Use specific solution options for contingencies
When checked, Simulator will use a different set of Solution Options when solving the contingencies
defined in the contingency set. To define the solution options used during the contingency analysis,
click the Define Solution Options button to open the Contingency Solution Options Dialog.
Do Not Use Post Power Flow Solution Action List
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Checking this option prevents any globally defined post power flow solution actions defined with the
case from being evaluated and performed in the post-contingency power flow solution during
contingency analysis runs.
Model reactive power for DC methods by…
When you choose to use one of the Lossless DC calculation methods, you can also specify how to
handle changes in reactive power during the calculations. The lossless DC methods are based on the
real power MW in the system, thus an assumption needs to be made about the reaction of the Mvar
flows during the linear calculations.
The choices are:
Ignoring reactive power
Reactive power is completely ignored. This results in the MW flow only being compared to the
limits of the elements in the system. It is important to recognize this fact, as branch and
transformer limits are usually given in complex power (MVA) ratings, thus, ignoring reactive
power results in comparing active power flow (MW) to total complex power limits (MVA.).
Assuming constant voltage magnitude
One way to include reactive power in the linearized DC results is to assume the voltage
magnitudes remain constant during the linearized DC contingency analysis. Thus, the MW flows
are determined from the linearized calculations, and the MVAR flows are calculated from the
resulting flows and constant voltage magnitudes. Thus you will still receive an approximate
complex power flow on each element (MVA), which can then be directly compared to the
complex power limit of the element.
Assuming reactive power does not change
Another way to include reactive power in the linearized DC results is to assume that the reactive
power magnitudes remain constant during the linearized analysis. Thus, the MW flows are
determined from the linearized calculations, and the complex power flow of each element can be
approximated using the calculated MW flows and the assumed constant Mvar flows from the
base case. This again allows the approximate complex flow on each element to be compared to
the complex power limit of the element.
Make-Up Power
When solving a contingency, the make-up power defines how the post-contingency solution
accounts for the change in system losses, generation, and load. There are three options for this
make-up power.
Determine make-up using:
Area Participation Factors specified below
Simulator models this by temporarily switching to Island-Based AGC and using the Calculate
Participation Factors from Area Make Up Power Values option during the contingency
solution. The values specifying the CTG Make Up Gen for each area are used to determine the
contribution of each area in an island to the amount of make-up power needed. Within each
area, the individual participation factors of generators on AGC determine how much power will
come from each generator.
Note that if all areas have CTG Make Up Gen equal to 0.0, then all make-up power will come
from the island slack bus. This option generally yields faster solution times, but a concentration
of make up power at the island slack bus may not accurately represent the response of the
system following a contingency.The Calculate Participation Factors from Area Make Up Power
Values section of Island-Based AGC describes this in further detail.
Generator Participation Factors From Entire Case Directly
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Simulator models this by temporarily switching to Island-Based AGC and using the Use
Participation Factors of Individual Generators option during the contingency solution. The
individual participation factors of each generator within each island are used to determine how
each generator meets the make-up power needs of the island. Area and super area interchange
(ACE) requirements are ignored, and all generators on AGC are dispatched to account for the
changes in system losses, generation, and load. This option is usually the best approximation of
post-contingent system behavior, but may yield longer solution times than island slack bus makeup power (Area Participation Factors specified below with CTG Make Up Gen set to zero
for all areas).
Same as Power Flow Case
This uses the area interchange options specified in the normal power flow.
Make-up Power Tolerance
This specifies the tolerance of the Island-Based AGC used for both the Area Participation
Factors specified below and Generator Participation Factors From Entire Case Directly
options.
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Contingency Options: Generator Post-Contingency AGC
The Generator Post-Contingency AGC display can be opened from the Modeling group of the
Contingency Analysis dialog Options page. This display provides a specialized generator display with
specific fields used for setting the post-contingency AGC response of individual generators.
Set the Post-CTG Prevent AGC Response field to indicate whether or not a generator should be on
AGC post-contingency. By default, generators are NOT set to prevent AGC response post-contingency.
Possible options for this field are:
YES - This means that the generator will NOT respond post-contingency. AGC is disabled postcontingency regardless of the generator's AGC setting.
NO - This means that the generator will respond according to its AGC setting. If AGC = YES then
the generator will respond post-contingency.
RESPOND - This means that the generator WILL respond post-contingency. AGC is enabled postcontingency regardless of the generator's AGC setting.
Use the Post-CTG Part. Factor field to specify the participation factor to be used post-contingency. A
value of same indicates that the generator should use the same participation factor as set with the
generator record Part. Factor field. Otherwise, set a numerical value for the post-contingency
participation factor to use a factor other than the normal participation factor.
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Contingency Options: Bus Load Throw Over Records
The Bus Load Throw Over list display, which is opened from the Modeling group of the Contingency
Analysis dialog Options page, provides you with the capability to define how load at a bus should be
transferred to a different bus if the original terminal bus becomes disconnected from the system. This
is referred to in Simulator as "throw over." This tool is most useful when performing contingency
analysis scenarios in which buses containing loads become disconnected and you wish to analyze the
impact on the system of switching the load from the disconnected bus to another bus that is still in
service.
Load throw over will only attempt to move the load once, from the original bus to the load throw over
bus. If the load throw over bus is already disconnected from the system, then the load will be treated
as dropped during the contingency solution.
NOTE: The load throw over is only used when running the contingency analysis tool to analyze
contingency effects on the system. Load throw over records are not used during manual solution of
the power flow, even if you manually disconnect a bus with load and perform a load flow solution.
The Bus Load Throw Over display has the following fields:
Number, Name
The bus number and name of the load’s terminal bus.
Nom kV
The nominal voltage level of the load’s terminal bus.
Load Throw Over Bus Number
Enter the number of the bus you wish to have the load transferred to, should the original load
terminal bus become disconnected during a contingency in the contingency analysis. The Load
Throwover Bus Name_kV field will be automatically populated.
Load Throw Over Bus Name_kV
Enter the bus name and nominal kV (separated by a _ between the name and nominal kV) of the
bus you wish the load to be transferred to, should the original load terminal bus become
disconnected during a contingency in the contingency analysis. The Load Throw Over Bus
Number will be automatically populated if the corresponding Bus Name_kV is found.
If choosing to identify objects by labels, this field can also be used to display and enter the label of
the load throw over bus.
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Contingency Options: Generator Maximum MW Response
The Generator Maximum MW display can be opened from the Modeling group of the Contingency
Analysis dialog Options page. This display provides a specialized generator display with specific fields
used for setting the post-contingency maximum MW response of individual generators.
Use the CTG Max Response MWfield for entering the contingency maximum response. During the
post-contingency power flow solution, a user may enter a MW amount specifying the maximum
amount of generator response from a generator. By default, these values are blank. If you enter a
value in this column, the generator response will be limited to this absolute MW response (response
may be either an increase or a decrease). Regardless of the response settings, a generator will not
respond unless its AGC field is set to YES or any Generator Post-Contingency AGC conditions are set
such that the generator will be on AGC post-contingency.
The maximum MW response for a given generator will only be enforced if enforcing generator MW
limits for that generator. The maximum MW response is implemented by adjusting the generator
minimum and maximum limits in order to limit the response, e.g. (New Max MW) = (Present MW) +
(Generator Max MW Response) and (New Min MW) = (Present MW) - (Generator Max MW
Response). Therefore, the maximum MW response will only be implemented if a generator's limits
are enforced.
Generator maximum MW responses will be enforced, as long as generator MW limits are also
enforced, when using all contingency calculation methods including the Full Power Flow method with
the power flow in either AC or DC mode and the linearized lossless DC methods.
Note: The user may also add a column called CTG Max Response % to the generator display.
When entering data in this column, the CTG Max Response MW values will be set at a respective
percent of the maximum MW output of the generator. If a generator’s maximum MW output is less
than or equal to zero, then the Maximum Response will always be set to zero.
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Contingency Options: Generator Line Drop and Reactive Current Compensation
The Generator Line Drop and RCC display can be opened from the Modeling group of the
Contingency Analysis dialog Options page. This display provides a specialized generator display with
specific fields used for setting the line drop and reactive current compensation parameters for
individual generators.
Line Drop and Reactive Current Compensation represent an alternative method for performing
generator voltage control. While on LDC/RCC control, the generator will vary its MVAR output in a
manner that maintains the bus voltage at a fictitious bus that is a user-specified electrical impedance
of XLDC_RCC away from the generator. This is called Line Drop Compensation when the
impedance specified is positive, and Reactive Current Drop Compensation when the impedance
specified is negative. If the absolute value of XLDC_RCC is less than or equal to 2*10-6*MVA Base,
the generator will regulate its terminal bus. (For a typical case with an MVA Base of 100 MVA, this
value is 0.0002.)
The impedance is specified by entering a value for XLDC_RCC and the setpoint voltage is the same
as used when regulating a generator in the more traditional manner. A generator will perform
LDC/RCC control when it meets the following conditions:



AVR = YES
Use LDC_RCC = YES

If any generators at a bus are set to Use LDC_RCC, this action will disable all traditional AVR
control for generators at that bus. Other generators operating on LDC/RCC control are allowed, but
no traditional AVR.
As a third special setting, the field Use LDC_RCC may also be set to PostCTG for use in
contingency analysis. When a generator is set to PostCTG while implementing the post-contingency
power flow, the generator will change the Use LDC_RCC value to YES, thereby activating this new
voltage control method for the generator. After the reference state is restored in the contingency
analysis however, the generator will return back to a setting of PostCTG.
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Contingency Options: Post-Contingency Auxiliary File
Options for specifying the Post-Contingency Auxiliary File can be accessed from the Modeling group
of the Contingency Analysis dialog Options page. These options provide a means of specifying the
post-contingency auxiliary file that can be applied to all contingencies.
The auxiliary file specified here is loaded at the start of each contingency (except for contingencies
that have a post-contingency auxiliary file specific to that contingency). This file is applied before
any contingency-specific solution options are applied. The contingency actions are then implemented
after any contingency-specific solution options are applied. In this way, very specialized postcontingency settings can be specified. An example use of this feature could be changing the
generator voltage setpoints or AVR status for the post-contingency solution or changing generator
AGC status for the post-contingency.
If the file specified does not include a file path, then Simulator will look in the presently active
directory, otherwise the file path specified will be used. If the post-contingency AUX file can not be
found in this location, then Simulator will look to see if a file by this name exists in the directory
from which the presently loading case was read. If a file is specified and still can not be found, then
when running the analysis from the contingency analysis dialog, Simulator will show a dialog
requesting you to find the file or remove the option.
Only data stored with the contingency reference state will be "reset" when the reference state is
restored. Therefore, only data stored with the reference state should be loaded via a postcontingency auxiliary file. Click here for details on the specific information stored with the reference
state.
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Contingency Options: Limit Monitoring
These options are all available on the Contingency Analysis Dialog under the Contingency Options Tab
under the Limit Monitoring grouping. In general all the Limit Monitoring Settings specified with the
case are used to determine what is eligible for monitoring. These settings can all be seen by clicking
the Limit Monitoring Settings button. Other contingency-analysis specific limit monitoring settings
are configured on this section as follows





Advanced Limit Monitoring : the options on this page allow you to configure limit monitoring
depending on how the value changes in relation to the reference case value.
Monitoring Exceptions : the options on this page allow you to configure exceptions to the normal
Limit Monitoring Settings. Exceptions may cause a line to be included or excluded.
Custom Monitors : the options on this page allow you to configure objects and associated fields to
be monitored during a contingency analysis run in addition to the devices that are monitored using
the Limit Monitoring Settings.
When using Integrated Topology Processing, monitor only the primary bus for each
superbus : checking this box will reduce the repeated bus voltage limit violation that would
appear for buses at the same super bus. This box is checked by default.
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Contingency Options: Advanced Limit Monitoring
These options are all available on the Contingency Analysis dialog under the Contingency Options tab
under the Limit Monitoring grouping.
The Advanced Limit Monitoring page allows you to shape how limit violations are detected and
reported.
Many of these settings can also be specified on a Limit Group-specific basis. See the Limit Group
Dialog for more information. If specified for a limit group, those settings will supersede those specified
here with the contingency options.
Never report violations if…
This section controls the reporting of violations that should NEVER be reported. Minimum changes in
branch flows, voltages, and interface flows which must be met before a device is reported as
violating a limit can be specified. These options will only be used if the checkbox is checked at the
beginning of this section. The minimum change values may be specified for:
Increase in line/transformer flows – This is the minimum change in percentage points that the
loading on a line/transformer must increase before the line/transformer gets reported as a violation.
For example, if this value is set to 2%, line limits are being monitored at 100%, and a line has a
base case loading of 99% and a post-contingency loading of 100%, the line will not get reported as
a violation.
Decrease in low bus voltage – This is the minimum change in a bus voltage that must occur for a
bus low voltage violation to be reported. For example, if this value is set to 0.05 pu, the low voltage
limit on a bus is 0.90 pu, the base case voltage at the bus is 0.91 pu, and the post-contingency
voltage at the bus is 0.89 pu, this bus will not be reported as a low voltage violation.
Increase in high bus voltage – This is the minimum change in a bus voltage that must occur for
bus high voltage violation to be reported. For example, if this value is set to 0.05 pu, the high
voltage limit on a bus is 1.1 pu, the base case voltage at the bus is 1.09 pu, and the postcontingency voltage at the bus is 1.11 pu, this bus will not be reported as a high voltage violation.
Increase in interface flows – This is the minimum change in percentage points that the loading
on an interface must increase before the interface gets reported as a violation. For example, if this
value is set to 2%, interfaces are being monitored at 100%, and an interface has a base case
loading of 99% and a post-contingency loading of 100%, the interface will not get reported as a
violation.
Always report as a violation if…
This section allows you to specify the minimum change in flow or voltage at which point any device
meeting the minimum change requirement will ALWAYS be reported, EVEN if the actual device limit
(flow or voltage) is NOT violated. In other words, these options allow the reporting of large changes
in flow or voltage, even if the device's actual limit is NOT itself violated. These options will only be
used if the checkbox is checked at the beginning of this section. The minimum change values may
be specified for:
Increase in line/transformer flows – This is the minimum change in line/transformer flow in
percentage points that the loading on a line/transformer must increase so that the line/transformer
gets reported as a violation even if the loading does not exceed the element’s limit. For example, if
this value is set to 2%, line limits are being monitored at 100%, and a line has a base case loading
of 50% and a post-contingency loading of 63%, this line will be reported as a violation even though
the post-contingency loading does not exceed the limit.
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Decrease in low bus voltage – This is the minimum amount that a bus voltage must decrease for
a bus low voltage violation to be reported even if the resulting voltage is higher than the bus low
voltage limit. For example, if this value is set to 0.05 pu, the low voltage limit at a bus is 0.90 pu,
the base case voltage at the bus is 1.0 pu, and the post-contingency voltage at the bus is 0.95 pu,
this bus will be reported as a low voltage violation.
Increase in high bus voltage – This is the minimum amount that a bus voltage must increase for
a bus high voltage violation to be reported even if the resulting voltage is lower than the bus high
voltage limit. For example, if this value is set to 0.05 pu, the high voltage limit at a bus is 1.10 pu,
the base case voltage at the bus is 1.0 pu, and the post-contingency voltage at the bus is 1.05 pu,
this bus will be reported as a high voltage violation.
Increase in interface flows – This is the minimum change in interface flow in percentage points
that the loading on an interface must increase so that the interface gets reported as a violation even
if the loading does not exceed the interface limit. For example, if this value is set to 2%, interface
limits are being monitored at 100%, and an interface has a base case loading of 75% and a postcontingency loading of 77%, this interface will be reported as a violation even though the postcontingency loading does not exceed the limit.
Caution should be used when using the Always report… options because this may result in a very
large number of reported violations.
Report changes in bus dV/dQ sensitivity
Check this option to enable reporting changes in voltage to reactive power sensitivity for buses in
the post-contingency solution. Set the sensitivity multiplier to the minimum change in sensitivity for
reporting the value(s) under contingency. Any sensitivity that changes by the given multiple will be
reported. You can also define an advanced bus filter using the Define Filter button, and choose
either the newly defined bus filter or a previously existing bus filter for reporting dV/dQ sensitivity
changes at only buses that meet the defined filter.
Also, regardless of the sensitivity multiple setting, any bus that meets the filter and has a negative
dV/dQ will be reported as a violation.
Caution should be used when selecting this option. Calculating the dV/dQ sensitivities requires more
computation time. Define a filter so that the dV/dQ sensitivities are only calculated for those buses
for which it is important to calculate these values.
Report as a violations if a bus becomes disconnected
When checked, buses that become disconnected from the system due to a contingency will be
reported as violations.
Re-reporting of base case violations
This section controls the reporting of Base Case violations. Because the concern of contingency
analysis often is to identify those limitations that result directly from a particular outage or event,
you may desire not to report all violations that were present in the Base Case with each
contingency-specific set of violations. These options allow you to specify just how much of the Base
Case violation information to report for each contingency. It gives you three options:
Do not report Base Case violations
When this option is checked, any element that was violated in the Base Case is omitted from the
set of violations listed for each contingency.
List all Base Case violations for all contingencies
When this option is checked, all elements that were violated in the Base Case and are still
violated post-contingency are included in the set of violations listed for each contingency.
Use these criteria
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When this option is checked, only those elements that were violated in the Base Case and that
meet the four criteria listed below will be listed with the contingency-specific violations. The four
criteria include:
Minimum % increase in line/transformer flows: Only those branches that were violated in
the Base Case whose flow has increased by at least this amount as a result of the contingency
will be listed as contingency violations.
Minimum per-unit decrease in low bus voltage: Only those bus voltages that were violated
in the Base Case that have decreased by at least this amount as a result of the contingency will
be listed as contingency violations.
Minimum per-unit increase in high bus voltage: Only those bus voltages that were violated
in the Base Case that have increased by at least this amount as a result of the contingency will
be listed as contingency violations.
Minimum % increase in interface flows: Only those interfaces that were violated in the
Base Case whose flow has increased by at least this amount as a result of the contingency will be
listed as contingency violations.
Percentage values here are expressed in reference to a limit rather than either the base case
value or post-contingency flow value. When calculating the percentage for the Base Case
violations used in the comparisons, the post-contingency rating sets are used. Comparisons made
using percentage changes for branches are done using percentage points and not as a
percentage of the actual change. For example, if the value for the minimum percent increase in
line flow is 2%, lines are monitored at 100%, and a line is loaded at 100% in the base case and,
the line must be loaded to at least 102% post-contingency to be reported.
How to Monitor Voltage Changes
Voltage changes can be monitored either directly on the amount of the bus per unit voltage, or
based instead on a percentage change in per unit voltage from the base case per unit voltage
values.
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Monitoring Exceptions
These options are all available on the Contingency Analysis Dialog under the Contingency Options Tab
under the Limit Monitoring grouping.
Monitoring exceptions can be used for bus, line, or interface elements to create special rules specifying
how specific elements will be monitored under a specific contingency. These rules are exceptions to
the case limit monitoring options that are set via the Limit Monitoring Settings and Limit Violations
Dialog. Monitoring exceptions allow the inclusion or exclusion of monitoring a particular element during
a specific contingency. Monitoring exceptions override the monitor status of an element as specified
with the case limit monitoring settings.
Monitoring exceptions can be defined and used as given below:
Monitoring Exceptions Dialog
The Monitoring Exceptions dialog is found on the Monitoring Exceptions tab of the Contingency
Definition Dialog. This dialog provides a list of all exceptions that are defined for the selected
contingency and provides options about how to apply the exceptions.

Use of Monitoring Exceptions
Use these exceptions - Select this option to enable use of the monitoring exceptions that are
defined for this contingency. The defined exceptions will apply in addition to the case Limit
Monitoring Settings.
Ignore these exceptions - Select this option to disable use of the monitoring exceptions that
are defined for this contingency. Only the case Limit Monitoring Settings will apply.
Use only these exceptions and ignore the Limit Monitoring Settings - Select this option
to completely ignore the monitoring defined with the case Limit Monitoring Settings. Only those
exceptions with a Monitor Exception Status of Include will be monitored for this contingency.
If the monitoring exceptions list is empty, nothing will be monitored for this contingency.
Monitoring Exceptions Table
The table lists all monitoring exceptions associated with the selected contingency. The standard
fields that are listed in the table are detailed in the Monitoring Exceptions display section given
below.
To insert a new monitoring exception, right-click on the table and choose Insert from the local
menu. To edit an existing monitoring exception, right-click on the table and choose Show
Dialog from the local menu. Either action will open the Define Monitoring Exceptions dialog.
Monitoring Exceptions Display
The Monitoring Exceptions display is found on the Monitoring Exceptions subtab of the Contingency
Analysis dialog Options tab. The Monitoring Exceptions display is a class of Case Information Display
and therefore can be used in a manner consistent with other case information displays.
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This display lists all elements that have been selected as monitoring exceptions for all contingencies.
The same default fields that are listed with this table are also listed with the Monitoring Exceptions
Table that is found on the Monitoring Exceptions dialog detailed above.
The default fields include:
Contingency - This is the name of the contingency for which the exception applies.
Contingency Use Monitoring Exceptions - Value of the Use of Monitoring Exceptions option that
can be set for each contingency. This option can only be set from the Monitoring Exceptions dialog.
Valid entries are:
Use - Use these exceptions
Ignore - Ignore these exceptions
Only - Use only these exceptions and ignore the Limit Monitoring Settings
Monitored Element - Bus, Branch, or Interface that is an exception to the monitoring. Element is
identified by object type and key fields.
Monitor Exception Status - Determines how an element is monitored as an exception to the case
limit monitoring settings.
Valid entries are:
Include - The selected object will be included for monitoring with this contingency regardless of
its status in the case limit monitoring settings.
Exclude - The selected object will be excluded in the monitoring with this contingency
regardless of its status in the case limit monitoring settings.
Default - The selected object will obey its monitoring status in the case limit monitoring
settings. Use this option when a particular monitoring exception should be ignored for a
particular case but the object should remain in the list of monitoring exceptions.
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Define Monitoring Exceptions Dialog
This dialog is used to define exceptions for monitoring elements during specific contingencies. This
dialog will open when choosing to insert a new exception or changing an exception from either the
Monitoring Exceptions dialog or the Monitoring Exceptions display.

Contingency Label
This gives the contingency for which the monitoring exception applies. Click the Change button to
search through a list of all contingencies and select a different contingency. If inserting or changing
monitoring exceptions from the Monitoring Exceptions dialog that is shown with a given contingency,
the contingency cannot be changed and the Change button will not be enabled.
Monitor Type
Three types of elements can be used for monitoring exceptions: bus, line, and interface. When
changing the Monitor Type, the list of objects in the Object Selector will be updated accordingly.
Monitor Status
Include - The selected object will be included for monitoring with this contingency regardless of its
status in the case limit monitoring settings.
Exclude - The selected object will be excluded in the monitoring with this contingency regardless of
its status in the case limit monitoring settings.
Default - The selected object will obey its monitoring status in the case limit monitoring settings.
Use this option when a particular monitoring exception should be ignored for a particular case but
the object should remain in the list of monitoring exceptions.
Object Selector
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Use this to select the object for the monitoring exception. Lists all objects in the case of the type
selected under Monitor Type. Use the filtering and search methods to better manage the list in
making a selection.
OK, Cancel
Click OK to accept the monitoring exception changes for the selected contingency and close the
dialog. Click Cancel to close the dialog without accepting the changes.
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Custom Monitors
Custom Monitors can be defined, modified, and viewed from the Contingency Analysis dialog under the
Contingency Options tab under the Limit Monitoring page. Custom Monitors are also available in the
Model Explorer in the Contingency Analysis folder under Custom Monitors.
Custom Monitors can be used to monitor specific objects and fields in addition to the devices that are
monitored using the Limit Monitoring Settings. Custom monitors do not represent violations, but
rather, specific object fields that are of interest during the contingency analysis. Results for custom
monitors will appear in the Contingency Violations Display and Contingency Results tab on the View
Results By Element page.
The Custom Monitors table is a type of case information display and thus shares many of the
properties and controls common to all other case information displays. Existing custom monitors can
be edited directly in the table or by choosing Show Dialog either from the local menu obtained by
right-clicking or choosing this option from the Case Information Toolbar. To create a new Custom
Monitor, choose Insert from the local menu or Case Information Toolbar.
The dialog for creating and modifying a custom monitor has the following options:
Element Type
Type of element to be monitored. One must be selected. Available elements types include: Area,
Branch, Bus, DC Transmission Line, Generator, Injection Group, Interface, Limit Set, Load, Model
Expression, Multi-Terminal DC Record, Nomogram, Owner, Substation, Super Area, Switched Shunt,
Transformer, and Zone.
Custom Monitor Name
Name of the custom monitor. Each custom monitor must have a unique name. A default name will
be created based on existing custom monitors. Click the Rename button to open a dialog that will
allow you to change the name.
Enabled
Check this box for the specified object(s) and field to be monitored during a contingency analysis
run. When this box is not checked, no results will appear for the custom monitor following a
contingency analysis run.
Choose Object
All Objects of Element Type
Select this option to monitor all objects of the selected Element Type.
Specific Object
Select this option to monitor only a specific object of the selected Element Type. When this
option is selected, the dialog will be modified with a chooser box that will allow selection of a
specific object.
Choose a Field
Select the field to be monitored for the selected Element Type. A field must be selected.
Choose a Pre Filter
Name of an advanced filter or device filter. This is an optional field that can be left blank. If this is
specified, an object must meet this filter in the contingency reference state in order for it to be
monitored in the contingency analysis run. This filter can be used in conjunction with the option for
monitoring All Objects of Element Type to select a specific set of objects rather than all objects
of the selected Element Type.
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Click the Add/Modify button to specify this filter.
Choose a Post Filter
Name of an advanced filter or device filter. This is an optional field that can be left blank. If this is
specified, an object must meet this filter in the post-contingency state in order for it to be monitored
in the contingency analysis run.
Click the Add/Modify button to specify this filter.
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Contingency Options: Contingency Definitions

These options are all available on the Contingency Analysis dialog under the Contingency Options tab
under the Contingency Definitions grouping:
All Contingency Elements
Contains a combined list of all the contingency elements for all contingency records.
Contingency Blocks and Global Actions
A contingency block stores a list of contingency actions and has a name (or label) associated with it.
A contingency block can then be called from a contingency record. This allows you to define a block
of common actions you wish to have processed during several different contingencies, and then
assign the block to each contingency instead of constantly redefining the same actions for each
contingency. The Contingency Block Elements contains a combined list of all the contingency
block elements for all contingency blocks.
A global action is an action that will automatically be processed as part of EACH contingency unless
an Inclusion Filter is specified that allows defining with which contingencies the action will be
included. Thus, if you have actions that are to be performed in every single contingency you define,
you can insert it once in the global actions list, and Simulator will automatically use the defined
action for every contingency it processes.
Model Conditions
Clicking this button allows you to define model conditions. Model Conditions may be used as part of
the Model Criteria defined with Contingency Elements.
Model Filters
Clicking this button allows you to define model filters. Model Filters may be used as part of the
Model Criteria defined with Contingency Elements. Generator Post-Contingency AGC
Model Expressions
Clicking this button brings up a list of the model expressions. You may then insert a model
expression by right-clicking on the list and choosing Insert. This will bring up the Define Model
Custom Expressions dialog. Model Expressions may be used as part of Model Conditions.
Model Condition and Filter options
This section allows you to choose how assumptions about Model Conditions and Model Filters are
made during the contingency analysis. Assumptions about the Model Conditions and Model Filters
will impact how the Model Criteria are evaluated for contingency elements. You can specify to
Verify Model Conditions and Filters, Assume Model Conditions and Filters are TRUE, or
Assume Model Conditions and Filters are FALSE.
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Contingency Options: Distributed Computing
The Distributed Contingency Analysis tool is available as an add-on to the base Simulator
package. Contact PowerWorld Corporation for more details.
These options are all available on the Contingency Analysis Dialog under the Contingency Options Tab
under the Distributed Computing Grouping.
Distributed Computing is available for use with Contingency Analysis. In order to use distributed
computing you must first configure a list of remote computers which can be utilized along with
appropriate authentication information for those computers. The computer list and authentication
information is common to all the distributed computing tools in Simulator and can be found in the
Simulator Options Dialog, or reached with the Distributed Computing Options button. They are
described in Distributed Computing Options.
The only two options specific to Contingency Analysis for Distributed Computing are as follows
Use Distributed Computing
Check this box to signify that when processing contingencies distributed computing should be used.
Number of Contingencies per Process
When distributed computing is used for contingency analysis, the entire list of contingencies to be
solved will be split up into groups of contingencies. This setting specifies the number of
contingencies to include in each group. During the distributed computing, Simulator will sent a group
of contingencies to each computer available as specified in the Distributed Computing Options. As
the remote computers complete a group, Simulator will send another grouping to that computer.
This will continue until the contingency analysis results are completed.
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Contingency Options: Miscellaneous
These options are all available on the Contingency Analysis dialog under the Contingency Options tab
under the Miscellaneous grouping.
Always save results with the contingency list when you save it to a file
If this option is checked, the violation results for each contingency will also be stored in an auxiliary
file when the list of contingencies is saved to an auxiliary file. This allows for recovering the results
of a contingency analysis run for a case, without reloading and re-running all the contingencies
saved in the file.
Save contingency analysis definitions/results in the case PWB file
If this option is checked, the contingency definitions and any processed results will be saved with
the load flow case in the PWB file when you save the case.
Setting Reference Case when Contingency Analysis is Opened
These options determine how the reference case for the contingency analysis is treated each time
you re-open the contingency analysis. The first time you open the contingency analysis tool for a
particular power flow case during a Simulator session, Simulator stores the current state of the
power flow case as the reference case for the contingency analysis results. (See Contingency Case
References - Defining the Reference State for more information.) However, each subsequent time
you open the contingency analysis dialog in the same Simulator session, Simulator needs to know
how to set the reference state for the case. The choices are:
Always set reference case to the current case
This option will always assume that any changes you have made to the load flow case since the
contingency analysis was last opened should be applied and will store the current state of the
load flow as the new reference state for the contingency analysis.
Always use the existing contingency analysis reference case
This option will assume that the original reference case stored when the contingency analysis
tool was originally launched should always be the reference state for the contingency analysis.
This means that any changes that have been made to the load flow case since the initial launch
of the contingency analysis will be lost, as the contingency analysis tool will reset the load flow
state to the state stored with the first contingency analysis instance.
Prompt for which reference case to use (the current case or the pre-existing reference
case) whenever the Contingency Analysis Form is opened
When this option is checked, you will always be prompted when you re-open the contingency
analysis following the initial instance. You will then have the option to choose from one of the
two previous settings, to either set the reference state to the current case or use the existing
reference case currently stored with the contingency analysis tool.
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Contingency Analysis: Results Tab

The Results tab of the Contingency Analysis dialog contains many options for viewing the results of a
contingency analysis run.









View Results by Element : navigate the list of limit violations by the element which is violated.
View Results by Contingency : navigate the list of limit violations by the contingency which caused
the violation. Essentially shows the same layout as seen on the Contingencies Tab.
Contingency Violations List : get a combined list of all contingency/limiting element pairs which
results in a violation
What Actually Occurred : Get a list of actions that occurred during the selected contingency. This
is especially useful for identifying those actions conditional on Model Criteria were applied. It is
also helpful when using the special Open with Breakers contingency actions because the list will
indicate which breakers need to be opened to isolate the devices.
Contingency Violation Matrices : Provides access to a dialog where a matrix of contingency versus
limit elements can be created with entries showing the flow or voltage of the element to the
respective contingency.
Text File Report Writing : provides options for writing out a text file report
Summary : a simple text summary showing the progress of the contingency analysis run.
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Contingency Results: View Results By Element
These contingency results are all available on the Contingency Analysis dialog under the Contingency
Analysis: Results tab.
The View Results By Element category contains five sub-pages: Lines/Transformers, Buses, Interfaces,
Nomogram Interfaces, and Custom Monitors. The information contained on each of the sub-pages
provides an alternate method of viewing information similar to that contained on the Contingencies
tab. The individual pages show model objects (subject to area/zone/owner and advanced filters) only
if they are associated with specific contingencies. For objects other than Custom Monitors, the user
can select any model object on its respective page to see how many times a violation occurred on the
device during a run of a set of contingencies. When a particular device is selected, the two pages at
the bottom give the details of the analysis for the selected device.
Note: the information contained in the Contingencies and Contingency Definition sections of the View
Results By Element page is object specific. The information present only pertains to contingencies that
resulted in violations on the selected object.
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Contingency Results: View Results By Element - Contingencies Section
The Contingencies section gives a list of all the contingencies that caused a violation on the selected
device during the analysis. This display is very similar to the Contingency Violations Display. While the
Contingency Violations Display shows the elements violated under the contingency , this display shows
the contingencies that caused the violation. If you then select one of the contingencies in this list, the
Contingency Definition section displays the actions that took place during the selected contingency.
Also, when you have selected a contingency from this list, you can click the Show Other Violations
button. This will change your dialog to the contingencies tab and select the contingency you have
selected, thus allow you to see other violations caused by this contingency.
The Combined Tables button provides access to the Combined Tables options described in Other
Contingency Actions. In addition to these options, there is one other option for displaying What
actually occurred? found under the Combined Tables button. Selecting this will display a dialog box
giving the details of the actions applied during all contingencies and any actions that may have been
skipped.
This page provides an easier way to check the contingency results when you are concerned with the
results for a specific device in the system. The View Results By Element page provides a much easier
tool for this kind of examination, as opposed to looking through each contingency on the
Contingencies tab and trying to find each instance of a violation on the desired element.
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Contingency Definition Display
The Contingency Definition Display lists the Elements assigned to the selected Contingency. This
display appears on both the Contingency Tab and the Lines, Buses, Interfaces Tab of the Contingency
Analysis Dialog, it also appears on the Contingency Definition Dialog.
Select Insert from the local menu to add elements to the contingency. Right-click on a specific
element in the display and select Delete from the local menu to remove the element from the
contingency.
The contingency definition display is a type of Case Information Display and shares many
characteristics and controls common to all other case information displays.
The Contingency Definition Display always contains the following fields:
Actions
This shows a string which describes the action. You may customize the format of the string that
describes the contingency actions by right-clicking on the Contingency Definition Display and
choosing Display Descriptions By, and then choosing Name, Num, Name/Num, PW File Format by
Numbers, PW File Format by Name/kV, PTI File Format, or Label.
Model Criteria
Simulator allows you to define Model Criteria, which can consist of both Model Conditions and Model
Filters. These specify a criterion under which a contingency action would occur. For example, you
could specify that a generation outage only occur if the pre-contingency flow on a line is higher than
a specified amount. Normally, no Model Criteria will be specified, and this field will be blank. Also,
note that Model Criteria can be overridden by the Model Condition and Filter option found on
the Model Conditions page accessed from the Contingency Definitions grouping on the Options tab
of the Contingency Analysis dialog. Model Criteria can be defined from the local menu
(CTGElement records > Define Model Criteria option) on the Contingency Definition Display,
from the Add (Model Criteria) button on the Contingency Element Dialog, or by using the Model
Conditions and Model Filters pages in the Contingency Definitions grouping on the Options tab of
the Contingency Analysis dialog.
Status
Double click the Status field to toggle through the available options. The possibilities are:





Check : The action will only be executed if the Model Criteria are true or if no Model Criteria
are specified. Check is the default status setting.
Always: The action will always be executed, regardless of the Model Criteria.
Never: The action will never by executed, regardless of the Model Criteria. This allows you to
disable a particular contingency action without deleting it.
PostCheck: This action will be considered AFTER all Check and Always actions have been
performed and the load flow solution solved. If the Model Criteria specified for the PostCheck
action are met in the solved load flow solution (or if no Model Criteria are specified), then this
action is taken and the load flow is again resolved. If the model conditions are not met, the
action is skipped. This process repeats recursively for all Postcheck actions until complete. This
behavior only occurs when the Calculation Method for the analysis is set to Full Power Flow.
Because the power flow is not solved when either of the two dc methods is selected, the
PostCheck status instead acts as a Check status.

Comment
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An optional user-specified data string associated with the action. For example, for an action with
Model Criteria specified, you could add a sentence explaining why the action is only performed under
the specified criteria. While this comment is not used by Simulator in any way, it is saved with the
contingency element when saving contingency records in contingency auxiliary data files.

1071
©2011 PowerWorld Corporation

Contingency Options Tab: Report Writing
These options are all available on the Contingency Analysis Dialog under the Results Tab.
Simulator can produce a report that details the results of the contingency analysis. The Report Writing
Tab allows you to control the content and appearance of the report. By default, the report will identify
each contingency, whether or not it could be solved, and what violations resulted from it. By selecting
options on this tab, you can include additional information in the report.
Optional Report Contents
Case Summary
The case summary prints the Case Description and then tallies the number of different power
system components in the model.
Option Settings
If this item is checked, the report will list each of the options selected on the Options Tab of the
Contingency Analysis Dialog.
Monitored Areas, Monitored Zones
If either of these items is checked, the report will identify the areas and/or zones in which
Simulator has looked for limit violations, and over what voltage ranges.
Line Flow, Interface Flow, and Bus Voltage Extremes
If one of these items is checked, the report will list the worst-case line flows or voltages seen for
each monitored element during the contingency analysis. None, one, two, or all three of these
can be chosen at one time.
Base Case Outages
If this item is checked, the report will list the limit violations that existed in the Base Case.
All
Selecting this option will select all of the other options.
Identify buses by
This setting determines how the buses are listed in the data stored in the report. You can choose to
have the buses displayed by number or name only, or by a combination of the number and name.
You can also choose to identify with nominal voltage by checking the box labeled Identify with
Nominal Voltage.
Show the actions involved in each contingency
If this box is checked, the definition of each contingency will be included in the report. The definition
of each contingency simply identifies the actions that were implemented as part of the contingency.
Report only contingencies that cause violations
Checking this option will cause only the contingencies that cause violations to be shown in the
report. Any contingency that did not cause a violation will not be included in the report. This option
is useful if you wish to limit the size of the contingency report.
Report only limit type with violations for each contingency
Checking this option will result in reporting only the contingency violations of the type checked in the
Limit Type Violations to Include box.
Report Inactive Violations and show all Rating Sets
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When this box is checked, all violations that are normally being ignored during the contingency
analysis (for example, base case violations) will be written to the report. Included with this option is
the ability to show the different rating sets for each violated element.
Limit Type Violations to Include
Check the boxes of the types of violations you would like to be written to the report. This
corresponds to the Report only limit type with violations for each contingency option above.
Maximum Violations of a single type to report
Enter the value of the maximum number of violations of a single type to be written to the report.
Create database-friendly tables
Checking this box will create three additional files for viewing contingency results:
FILENAME_ctgelem, FILENAME_ctgviol, and FILENAME_ctgstat where FILENAME is the name of the
file where the main report is saved. The user can choose which symbol to use to separate the
columns by choosing a delimiting symbol. These files can be easily imported into a database or
spreadsheet program such as Access or Excel as delimited text files, where they can be analyzed
more rigorously. These files will be automatically created and saved in the same folder as the main
report.
Produce Report
Clicking this button will open a Save Dialog for selecting the file to which the report should be
written. The file is saved as a text file (*.txt). Enter the file path and name and click Save to write
the report to the selected file. After saving the file, a dialog will provide the option of viewing the
report file immediately.
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Contingency Results: Summary
These options are all available on the Contingency Analysis Dialog under the Results Tab.
The Summary Tab of the Contingency Analysis Dialog provides additional information on the status of
the contingency analysis run and allows you to start, pause, resume, and abort the contingency run.
The top half of the Summary Tab charts the progress of the contingency analysis run and issues
warning messages when a particular contingency fails to solve. The next section features counters that
indicate the total number of contingencies that comprise the list, the number of these contingencies
that have been processed thus far, the number of contingencies that failed to solve, and the total
number of violations that have been flagged.
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Comparing Contingency Analysis Results
After performing an automated contingency analysis, the results of the analysis can be saved to an
auxiliary file. Once the results have been saved to a file, they can then be compared to different
results in another file or to results existing in memory in the Contingency Analysis tool. To compare
two sets of contingencies, do the following:






Process each set of contingencies and save the results for at least one set in an auxiliary file.
o To save a contingency list, right-click on the list of contingencies and choose Save As >
Auxiliary File.
o In the Save Contingency File Dialog, choose a name for the file, and then click Save.
o You will then be prompted to choose options for saving the contingency list to an auxiliary
file. By default, the contingency definitions themselves are saved, along with the
contingency options. The optional information you may choose to save are the Limit
Monitoring Settings, General Power Flow Solution Options, List Display Settings, and
Contingency Results. When saving the contingency results with the file, you may also
choose to include inactive violations.
Inactive violations are considered violations on elements for a DIFFERENT limit than what is
currently being monitored. For example, a branch may have an A limit rating of 50 MVA,
and a B limit rating of 100 MVA. Consider if the B limits are being used to report violations
during a contingency. A value of 75 MVA flow on the branch would not be reported in the
contingency analysis as a violation, considering the B limit of 100 MVA is being used.
However, Simulator internally will flag the element as a potential violation if the limit set
used is switched to the A rating set. Simulator considers these types of situations as inactive
violations. These are kept track of to allow the user to easily switch the rating set used for
reporting violations from one set to another and see the results immediately, without having
to re-run the entire contingency set to determine the violations for the new rating set.
Choosing to include the inactive violations when saving an auxiliary file maintains this
flexibility when the contingency definitions and results are read into a case from an auxiliary
file. You can also choose for the identifiers used in the file to be either the bus numbers or
the bus name and nominal kV voltage.
Note: For comparing two lists of contingency results, you MUST save the contingency
results with each of the two auxiliary files being compared.
o Click OK to save the contingencies and the results to the auxiliary file specified.
Once you have two different lists of contingency results (at least one of the lists must be saved in
an auxiliary file), right-click on the contingency list and choose Compare Two Lists of
Contingency Results or choose Other > Compare Two Lists of Contingency Results. This
will bring up a dialog on which you have to specify the Contingency Lists you are interested in
comparing. You must specify the Controlling Contingency List and the Comparison
Contingency List. The definitions of these two lists are found below.
Click on the Browse buttons to specify the two Contingency Lists you would like to compare. You
can also choose to use the presently open Contingency List as either the Controlling Contingency
List or the Comparison Contingency List.

Controlling Contingency List:
The list that controls what is displayed on the dialog. Only contingencies that are defined in this
list will be displayed on the form. Only violations that occur for contingencies in this list will
appear in the Violations List for each contingency.
Comparison Contingency List:
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This is the list to which the Controlling Contingencies will be compared. Comparisons will occur
for those contingencies in the lists that have the same CONTINGENCY NAME. Note that
contingencies in the Comparison list whose CONTINGENCY NAME does not match one of those
in the Controlling list will not be displayed. Also, violations which occur in a specific Comparison
contingency that do not occur in the respective Controlling contingency will not be displayed.
Example:
A user has a power system case and a list of contingencies. The user runs contingency analysis
on this system for this list of contingencies. The results are saved in a file called comparison.aux.
The user now changes the system state, possibly adding in a 500 MW transaction between two
areas. The contingency analysis is run on this new state of the system for the list of
contingencies. The results are saved in a file called controlling.aux. You should define the
contingency results you are more interested in viewing as the Controlling List because this list
determines what is shown on the dialog. In this case, we are more interested in seeing the
violations caused when the transaction is in place, so that list is defined as the Controlling List.
The comparison of the two sets of contingencies is now done by right-clicking and choosing
Compare Two Contingency List Results. The file controlling.aux is set as the Controlling
List and comparison.aux as the Comparison List.


After clicking OK on the dialog, the contingency lists will be read from the specified files or from
the presently open list. After Simulator has completed reading these files, a prompt will appear
which asks, "Would you like to set the dialog with default columns for comparing
contingency lists?". It is recommended that you choose YES so that the case information
displays on the Contingency Dialog will automatically be set to show fields that will help you
compare the two lists of contingencies. For information on the default fields used when comparing
contingencies see Comparing Contingencies List Displays.
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Comparing Contingencies List Displays
When comparing two sets of contingency results, there are several additional default fields added to
several list displays which help you compare the results. These fields are described below for the
various list displays.
Contingencies Records on Contingencies Tab
Violations
The total number of violations for this contingency under the Controlling List.
Comp Violations
The total number of violations for this contingency under the Comparison List.
New Violations
The number of violations which occur in the Controlling List which do not occur in the Comparison
List.
Max Branch % (Max Interface %)
The highest branch (interface) violation caused by this contingency in the Controlling List.
Comp Max Branch % (Comp Max Interface %)
The highest branch (interface) violation caused by this contingency in the Comparison List.
Worst Branch Violation (Worst Interface Violation)
This is the maximum of the following two values: [Worst Increase Violation] and [Worst New
Violation - 100%]
Min Volt (Max Volt)
The worst violation in the controlling list.
Comp Min Volt (Comp Max Volt)
The worst violation in the comparison list.
Worst LowV Violation (Worst HighV Violation)
The worst new violation.
Contingency Violations Display on Contingencies Tab and Contingency Violations on the
View Results By Element Page
When Viewing Lines/Transformers, Buses, Interfaces, or Nomogram Interfaces
Value
The value of the violation under the controlling list.
Comp Value
The value of the violation under the comparison list.
Diff Value
The difference between Value and Comp Value
Limit
The limit of the element in the controlling list.
Comp Limit
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The limit of the element in the comparison list.
Diff Limit
The difference between Limit and Comp Limit
Percent
The percent violation in the controlling list.
Comp Percent
The percent violation in the comparison list.
Diff Percent
The difference between Percent and Comp Percent
Contingency Violations on the View Results By Element Page When Viewing Custom
Monitors
Value
The value of the monitor under the controlling list.
Reference Value
The value of the monitor in the reference state under the controlling list.
Change Value
The difference between Value and Reference Value
Comp Value
The value of the monitor under the comparison list.
Diff Value
The difference between Value and Comp Value
Line/Transformer (Interface) Records on the View Results By Element Page
Violations
This shows the number of branch (interface) violations which occurred in the Controlling List
New Violations
This shows the number of branch (interface) violations which occurred in the Controlling List, but did
not occur in the Comparison List.
Max % Loading Cont.
The worst branch (interface) violation in the controlling list.
Max % Ld Cont Comp
The worst branch (interface) violation which occurred in the comparison list.
Worst Increased Violation
The worst increase in a branch (interface) violation from the comparison list to the controlling list.
Bus Records on the View Results By Element Page
Violations
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This shows the number of violations which occurred in the Controlling List
New Violations
This shows the number of violations which occurred in the Controlling List, but did not occur in the
Comparison List.
Max Voltage Cont.
The worst high voltage violation in the controlling list.
Max Voltage Cont Comp
The worst high voltage violation which occurred in the comparison list.
Worst Max Volt CTG Change
The worst increase in a high voltage violation.
Min Voltage Cont.
The worst low voltage violation in the controlling list.
Min Voltage Cont Comp
The worst low voltage violation which occurred in the comparison list.
Worst Min Volt CTG Change
The worst decrease in a low voltage violation.
Nomogram Interfaces Records on the View Results By Element Page
Violations
This shows the number of violations which occurred in the controlling list.
Max % Loading Cont.
The worst nomogram interface violation in the controlling list.
Custom Monitor Records on the View Results By Element Page
No changes.
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Contingency Element Dialog
The Contingency Element Dialog provides information on the individual elements that comprise a
contingency definition. You may use this dialog to modify an existing contingency’s definition or to add
elements to new or existing contingencies.
There are several ways to open the Contingency Element Dialog:




By pressing the Insert New Element button on the Contingency Definition Dialog.
By right-clicking on a Contingency Definition Display and choosing Insert or Show Dialog.
By right-clicking on the Contingency Tab of the Contingency Analysis Dialog and choosing Insert
Special > Quick Insert of Single Element Contingency.

After making the desired changes, click OK to save changes and close the dialog or click Cancel to
close the dialog without saving your changes.
Click Delete to remove the element from the contingency.
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Contingency Element Dialog
The Contingency Element Dialog has the following controls:
Element Type
Indicates whether the element involved in the contingency action is a branch, generator, load,
switched shunt, bus, interface, injection group, series capacitor, DC line, phase shifter, contingency
block or solve power flow. The Element Type will dictate what Action Types are available, and the
selection of the Element Type, in conjunction with the Action Type, Amount, and in options
settings, determines what actually happens during the contingency.
What actually happens during a contingency action based on the Element Type, Action Type, and
in options is described in detail below:
Branch
If Branch Device Types other than Line exist in the case, a special filtering drop down will
appear that allows selecting branches by device type. Selecting a particular type will limit the
entries in the chooser display to branches of that type.
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Open
The Open action will set the Status of the selected branch to Openif the branch Status is
Closed. If the branch Status is already Open, this action does nothing.
Open Breakers
See the special topic on Open Breakers for more detail.
Close
The Close action will set the Status of the selected branch to Closed if the branch Status is
Open. If the branch Status is already Closed, this action does nothing.
Close Breakers
See the Close Breakers for Contingencies topic below.
Generator
Open
The Open action will set the Status of the selected generator to Open if the generator Status
is Closed. If the generator Status is already Open, this action does nothing.
When using the Open action, the Make-up Power Sources button is enabled and power
sources can be specified to account for the changes in generation due to the contingency
action.
Open Breakers
See the special topic on Open Breakers for more detail.
Close
The Close action will set the Status of the selected generator to Closed if the generator Status
is Open. If the generator Status is already Closed, this action does nothing.
When using the Close action, the Make-up Power Sources button is enabled and power
sources can be specified to account for the changes in generation due to the contingency
action.
Close Breakers
See the Close Breakers for Contingencies topic below.
Move
The Move action allows the transferring of generation from an existing generator bus to
another bus. A generator move can be done on a bus basis (impacting the total generation of
all generators at the selected bus) or can be targeted at a specific generator. Generators that
are adjusted by the Move action will have their AGC Status set to No. If there are no on-line
generators at the selected generator bus, no generation move will occur. Generation may be
moved in Percent or MW. A Percent move will move the specified percent of the current
generator MW and Mvar to the defined Bus to Move to. A MW move will move the specified
amount of generator MW to the Bus to Move to. The Move amount can be either positive or
negative. A positive amount will decrease the output of the selected generator bus, and a
negative amount will increase the output of the selected generator bus. The Bus to Move to
will respond accordingly.
If a generator already exists at the bus to which the generation is being moved, the
generation at that bus is adjusted according to the move amount. If a generator does not
exist but a load exists, then the load is adjusted by the move amount. If no generator or load
exists, then a load is added at the bus and the injection is set according to the move amount.
In terms of power injection, positive generation is the same as negative load.
Set To
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The Set To action will set the selected bus’ generation or specified generator's parameters to
a specified Amount. Generator Set To actions can be done on a bus basis (impacting the
total generation of all generators at the selected bus) or can be targeted at a specified
generator. Generators that are adjusted by a Set To action will have their AGC Status set to
No. If there are no on-line generators at the selected generator bus, no generation change
will occur. Generator parameters can be set in Percent, MW, or Setpoint Voltage. When
the generation is set in Percent, total generator MW output will be set to a value based on
the specified percent of the current total generator MW output. When the generation is set in
MW, total generator MW output will be set to the specified MW amount. When the
generation is set in Setpoint Voltage, the voltage set-point of all generators at the selected
bus will be set to the specified amount in per unit.
When using the Set To action, the Make-up Power Sources button is enabled and power
sources can be specified to account for the changes in generation due to the contingency
action.
Change By
The Change By action will change the selected bus’ generation or specified generator's
parameters by a specified Amount. Generator Change By actions can be done on a bus basis
(impacting the total generation of all generators at the selected bus) or can be targeted at a
specified generator. Generators that are adjusted by a Change By action will have their AGC
Status set to No. If there are no on-line generators at the selected generator bus, no
generation change will occur. Generator parameters can be changed in Percent, MW, or
Setpoint Voltage. When the change is in Percent, total generator MW output will be
changed based on the specified percent of the total current generator MW output. When the
change is in MW, total generator MW output will be changed by the specified MW amount.
When the change is in Setpoint Voltage, the voltage set-point of all generators at the
selected bus will be changed by the specified amount in per unit.
When using the Change By action, the Make-up Power Sources button is enabled and
power sources can be specified to account for the changes in generation due to the
contingency action.
Load
Open
The Open action will set the Status of the selected load to Open if the load Status is Closed. If
the load Status is already Open, this action does nothing.
When using the Open action, the Make-up Power Sources button is enabled and power
sources can be specified to account for the changes in load due to the contingency action.
Open Breakers
See the special topic on Open Breakers for more detail.
Close
The Close action will set the Status of the selected load to Closed if the load Status is Open. If
the load Status is already Closed, this action does nothing.
When using the Close action, the Make-up Power Sources button is enabled and power
sources can be specified to account for the changes in load due to the contingency action.
Close Breakers
See the Close Breakers for Contingencies topic below.
Move
The Move action allows the transferring of load from an existing load bus to another bus. A
load move can be done on a bus basis (impacting the total load of all loads at the selected
bus) or can be targeted at a specific load. Load may be moved in MW (const pf),
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Percent,MW, or Mvar. The load amount that is moved is the total actual load and may be
different than the nominal load if the area of the load has a Load MW Multiplier other than
1.0 or the load contains constant impedance or constant current components. If there is no
on-line load at the selected load bus or the bus at which the load is located is Open, no load
move will occur. A MW (const pf) move will move the specified amount of load MW to the
Bus to Move to while moving a Mvar amount that will maintain a constant power factor at
the selected load bus. A Percent move will move the specified percent of the present load
MW and Mvar to the defined Bus to Move to. A MW move will move the specified amount of
the load MW to the Bus to Move to. A Mvar move will move the specified amount of the load
Mvar to the Bus to Move to. The Move amount can be either positive or negative. A positive
amount will decrease the load at the selected bus, and a negative amount will increase the
load at the selected bus. The Bus to Move to will respond accordingly.
If a load already exists at the bus to which the load is being moved, the load at that bus is
adjusted according to the move amount. If no load exists, then a load is added at the bus
and the load is set according to the move amount.
Set To
The Set To action will set the selected bus’ load parameters to a specified Amount. Load Set
To actions can be done on a bus basis (impacting the total load of all loads at the selected
bus) or can be targeted at a specific load. Load parameters can be set in MW (const pf),
Percent, MW, or Mvar. The load value that is set for each of these options is the actual
constant power component of the load. This value may be different than the nominal
constant power component of the load if the area that contains the load has a Load MW
Multiplier other than 1.0. If there is no on-line load at the selected load bus and the bus at
which the load is located is Closed, load status at the selected load bus will change so that
one load is Closed and the total constant power load at the bus will be set to the specified
amount. If the bus at which the load is located is Open or there is no existing load, either
Open or Closed, at that bus, then no load change will occur. When the load is set in MW
(const pf), the actual constant power MW will be set to the specified amount and the actual
constant power Mvar will be set so that a constant power factor is maintained at the load bus.
When the load is set in Percent, the actual constant power MW and Mvar will be set to the
specified percent of the present load MW and Mvar. When the load is set in MW, the actual
constant power MW at the selected load will be set to the specified amount. When the load is
set in Mvar, the actual constant power Mvar at the selected load will be set to the specified
amount.
When using the Set To action, the Make-up Power Sources button is enabled and power
sources can be specified to account for the changes in load due to the contingency action.
Change By
The Change By action will change the selected bus’ load parameters by a specified Amount.
Load Change By actions can be done on a bus basis (impacting the total load of all loads at
the selected bus) or can be targeted at a specific load. Load parameters can be changed in
MW (const pf), Percent, MW, or Mvar. The load value that is changed for each of these
options is the actual constant power component of the load. This value may be different than
the nominal constant power component of the load if the area that contains the load has a
Load MW Multiplier other than 1.0. If there is no on-line load at the selected load bus or the
bus at which the load is located is Open, no load move will occur. When the load is changed
in MW (const pf), the actual constant power MW will be changed by the specified amount
and the actual constant power Mvar will be changed so that a constant power factor is
maintained at the load bus. When the load is changed in Percent, the actual constant power
MW and Mvar will be changed by the specified percent of the present load MW and Mvar.
When the load is changed in MW, the actual constant power MW at the selected load bus will
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be changed by the specified amount. When the load is changed in Mvar, the actual constant
power Mvar at the selected load bus will be changed by the specified amount.
When using the Change By action, the Make-up Power Sources button is enabled and
power sources can be specified to account for the changes in load due to the contingency
action.
Switched Shunt
Open
The Open action will set the Status of the selected switched shunt to Open if the switched
shunt Status is Closed. If the switched shunt Status is already Open, this action does nothing.
When using the Open action, the Make-up Power Sources button is enabled and power
sources can be specified to account for the changes in the real power portion of the switched
shunt due to the contingency action.
Open Breakers
See the special topic on Open Breakers for more detail.
Close
The Close action will set the Status of the selected switched shunt to Closed if the switched
shunt Status is Open. If the switched shunt Status is already Closed, this action does nothing.
When using the Close action, the Make-up Power Sources button is enabled and power
sources can be specified to account for the changes in the real power portion of the switched
shunt due to the contingency action.
Close Breakers
See the Close Breakers for Contingencies topic below.
Move
The Move action allows the transferring of switched shunt MW and/or Mvar from an existing
switched shunt bus to another bus. A switched shunt move can be done on a bus basis
(impacting the total shunt output of all switched shunts at the selected bus) or can be
targeted at a specific switched shunt. During the move action, the nominal values of the
switched shunts are adjusted, and switched shunts that are adjusted have their Control Mode
set to Fixed. If there are no switched shunts at the selected switched shunt bus with a Status
of Closed, no switched shunt move will occur. Switched shunt Moves may be done in
Percent, MW, or Mvar. A switched shunt Move in Percent will move the specified percent
of present nominal MW and Mvar at the switched shunt bus to the defined Bus to Move to.
A MW move will move the specified amount of switched shunt MW to the Bus to Move to. A
Mvar move will move the specified amount of switched shunt Mvar to the Bus to Move to.
The Move amount can be either positive or negative. A positive amount will decrease the
nominal MW and/or Mvar at the selected switched shunt bus, and a negative amount will
increase the nominal MW and/or Mvar at the selected switched shunt bus. The Bus to Move
to will respond accordingly.
If a switched shunt exists at the bus to which the switched shunt MW and/or Mvar is being
moved, the switched shunt at that bus is adjusted according to the move amount. If there are
existing switched shunts at the Bus to Move to but all of them have a Status of Open, the first
switched shunt Status will be set to Closed, the Control Mode will be set to Fixed, and the
nominal MW and/or Mvar will be adjusted according to the move amount. If no switched
shunt exists at the Bus to Move to, then the nominal constant impedance load is adjusted
according to the move amount. If no switched shunt exists at that bus, then a switched shunt
is added and the nominal injection is adjusted according to the move amount.
Set To
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The Set To action will set the selected bus’ switched shunt parameters to a specified
Amount. Switched shunt Set To actions can be done on a bus basis (impacting the total
shunt output of all switched shunts at the selected bus) or can be targeted at a specific
switched shunt. Switched shunts that are adjusted during Set To actions have their Control
Mode set to Fixed. Switched shunt parameters can be set in Percent, MW, Mvar, or
Setpoint Voltage. When a switched shunt bus is set in Percent, the nominal MW and Mvar
are set to the specified percent of the present nominal MW and Mvar of the switched shunt
bus. When the switched shunt bus is set in MW, the nominal MW is set to the specified
amount. When the switched shunt bus is set in Mvar, the nominal Mvar is set to the specified
amount. When the switched shunt bus is set in Setpoint Voltage, the Target Value of the
controllable switched shunt at the bus is set to the specified amount. Switched shunts may
either regulate voltage or generator Mvar. The amount entered for the Setpoint Voltage is
considered to be in per unit when the switched shunt is regulating voltage and is considered
to be in Mvar when regulating generator Mvar. If there are no switched shunts at the selected
bus with a Status of Closed when setting MW or Mvar amounts, the Status of the first
switched shunt at the bus will be set to Closed, the Control Mode will be set to Fixed, and the
nominal value will be set appropriately.
When using the Set To action, the Make-up Power Sources button is enabled and power
sources can be specified to account for the changes in switched shunt MW due to the
contingency action.
Change By
The Change By action will change the selected bus’ switched shunt parameters by a specified
Amount. Switched shunt Change By actions can be done on a bus basis (impacting the total
shunt output of all switched shunts at the selected bus) or can be targeted at a specific
switched shunt. Switched shunts that are adjusted during the Change By action have their
Control Mode set to Fixed. Switched shunt parameters can be changed in Percent, MW,
Mvar, or Setpoint Voltage. When a switched shunt bus is changed in Percent, the
nominal MW and Mvar are changed by the specified percent of the present nominal MW and
Mvar of the switched shunt bus. When the switched shunt bus is changed in MW, the
nominal MW is changed by the specified amount. When the switched shunt bus is changed in
Mvar, the nominal Mvar is changed by the specified amount. When the switched shunt bus is
changed in Setpoint Voltage, the Target Value of the controllable switched shunt at the bus
is change by the specified amount. Switched shunts may either regulate voltage or generator
Mvar. The amount entered for the Setpoint Voltage change is considered to be in per unit
when the switched shunt is regulating voltage and is considered to be in Mvar when
regulating generator Mvar. If there are no switched shunts at the selected bus with a Status
of Closed when setting MW or Mvar amount, the Status of the first switched shunt at the bus
will be set to Closed, the Control Mode will be set to Fixed, and the nominal value will be set
appropriately.
When using the Change By action, the Make-up Power Sources button is enabled and
power sources can be specified to account for the changes in switched shunt MW due to the
contingency action.
Bus
Open
The Open action will set the Status of all ac branches connected to the selected bus to Open.
If all of the ac branches are already open, then this action does nothing.
Open Breakers
See the special topic on Open Breakers for more detail.
Interface
Open
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The Open action will set the Status of all ac branches in the selected interface to Open. If all
of the ac branches are already open, then this action does nothing. The Status of any dc
lines, generators, loads, or injection groups that are part of the interface will remain
unchanged due to the contingency action. If the selected interface contains additional
interfaces, the Status of all ac branches in the additional interfaces will also be set to Open.
Open Breakers
See the special topic on Open Breakers for more detail.
Close
The Close action will set the Status of all ac branches in the selected interface to Closed. If all
of the ac branches are already closed, then this action does nothing. The Status of any dc
lines, generators, loads, or injection groups that are part of the interface will remain
unchanged due to the contingency action. If the selected interface contains additional
interfaces, the Status of all ac branches in the additional interfaces will also be set to Closed.
Close Breakers
See the Close Breakers for Contingencies topic below.
Injection Group
Open
The Open action will set the Status of all generators and loads in the selected injection group
to Open if the Status is Closed. If the Status is already Open, this action does nothing. If the
injection group contains other injection groups, the Status of the generators and loads in the
other injection groups will also be set to Open.
When using the Open action, the Make-up Power Sources button is enabled and power
sources can be specified to account for real power changes due to the status changes of
generators and loads in the contingency action.
Open Breakers
See the special topic on Open Breakers for more detail.
Close
The Close action will set the Status of all generators and loads in the selected injection group
to Closed if the Status is Open. If the Status is already Closed, this action does nothing. If the
injection group contains other injection groups, the Status of the generators and loads in the
other injection groups will also be set to Closed.
When using the Close action, the Make-up Power Sources button is enabled and power
sources can be specified to account for real power changes due to the status changes of
generators and loads in the contingency action.
Close Breakers
See the Close Breakers for Contingencies topic below.
Set To
The Set To action will set the real power injection of the injection group to the specified
Amount. If loads are included in the injection group, the Mvar load will be adjusted by
keeping the power factor constant. The injection can be set in Percent or MW. When setting
the injection in Percent, the real power injection is set to the specified percent of the present
real power injection. The present real power injection of the injection group is determined by
taking the difference between the total generator MW and total load MW in the injection
group. When setting the injection in MW, the real power injection is set to the specified
amount.
A checkbox is also available which says Use Merit Order For Generators. Normally when
not checking this box all generators and loads in the injection group are adjusted according to
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their relative participation factors and thus all with non-zero participation factors will be
adjusted to meet the desired injection. When checking the option Use Merit Order for
Generators, only generators will be adjusted to meet the desired injection. Generators will
be adjusted in order of highest relative participation factor to lowest with each generator in
the list being adjusted until it hits either its maximum or minimum MW limit before moving on
to the next generator. This process continues until the desired injection is met. Note that
generators will not be changed opened in the process so all generators will continue to
provide Mvar support.
If Use Merit Order For Generators is checked, another checkbox labeled Open
Generators in Merit Order will be available. If this option is chosen and the MW output
being requested is lower than the existing MW output of the generators in the injection
group, then the merit order dispatch will be modified. (Note: PowerWorld's expectation is that
the Change By option would most frequently be used with this option.) In this case, the
generator in the injection group with the highest participation factor will have its status
changed to Open, followed by the second generator and so on. This will continue until the
amount of MW opened is as close to the desired amount as possible but has not exceeded
the desired amount of change. If opening a generator will cause the amount of MW opened
to exceed the desired amount, that generator will be skipped and the next one in merit order
will be examined. If the MW output requested is higher than the present MW output, then
generators will be increased toward their maximum MW output in the same manner as
though this option was not chosen.
When using the Set To action, the Make-up Power Sources button is enabled and power
sources can be specified to account for real power changes due to the status changes of
generators and loads in the contingency action.
Change By
The Change By action will change the real power injection of the injection group to the
specified Amount. If loads are included in the injection group, the Mvar load will be adjusted
by keeping the power factor constant. The injection can be set in Percent or MW. When
setting the injection in Percent, the real power injection is set to the specified percent of the
present real power injection. The present real power injection of the injection group is
determined by taking the difference between the total generator MW and total load MW in
the injection group. When setting the injection in MW, the real power injection is set to the
specified amount.
A checkbox is also available which says Use Merit Order For Generators. Normally when
not checking this box all generators and loads in the injection group are adjusted according to
their relative participation factors and thus all with non-zero participation factors will be
adjusted to meet the desired injection. When checking the option Use Merit Order for
Generators, only generators will be adjusted to meet the desired injection. Generators will
be adjusted in order of highest relative participation factor to lowest with each generator in
the list being adjusted until it hits either its maximum or minimum MW limit before moving on
to the next generator. This process continues until the desired injection is met. Note that
generators will not be changed opened in the process so all generators will continue to
provide Mvar support.
If Use Merit Order For Generators is checked, another checkbox labeled Open
Generators in Merit Order will be available. If this option is chosen and if the MW output
change being requested is negative, then the merit order dispatch will be modified. In this
case, the generator in the injection group with the highest participation factor will have its
status changed to Open, followed by the second generator and so on. This will continue until
the amount of MW opened is as close to the desired amount as possible but has not
exceeded the desired amount of change. If opening a generator will cause the amount of MW
opened to exceed the desired amount, that generator will be skipped and the next one in
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merit order will be examined. If the change requested is positive, then generators will be
increased toward their maximum MW output in the same manner as though this option was
not chosen.
When using the Change By action, the Make-up Power Sources button is enabled and
power sources can be specified to account for real power changes due to the status changes
of generators and loads in the contingency action.
Series Capacitor
Bypass
The Bypass action will change the Bypass Status of the selected series capacitor to Bypassed
if the Bypass Status is Not Bypassed. If the Bypass Status is already Bypassed, this action
does nothing.
Inservice
The Inservice action will change the Bypass Status of the selected series capacitor to Not
Bypassed if the Bypass Status is Bypassed. If the Bypass Status is already Not Bypassed, this
action does nothing.
Set To
The Set To action will set the series reactance of the series capacitor to a specified Amount.
The reactance may be set in X (percent) or X (per unit). If the reactance of the series
capacitor is set in X (percent), the per unit reactance is set to the specified percent of the
present per unit reactance of the series capacitor. If the reactance is set in X (per unit), the
per unit reactance of the series capacitor is set to the specified amount.
DC Line
Open
The Open action will set the Control Mode of the selected dc line to Blocked. If the dc line is
already blocked, this action does nothing.
Open Breakers
See the special topic on Open Breakers for more detail.
Close
The Close action will set the Control Mode of the selected dc line to either Power or Current.
When selecting the Close action, the Amount must be specified for the new Setpoint of the
dc line in either MW or Amps. If specifying the Setpoint in MW, the Control Mode of the dc
line will be set to Power. If specifying the Setpoint in Amps, the Control Mode of the dc line
will be set to Current.
Close Breakers
See the Close Breakers for Contingencies topic below.
Set To
The Set To action will set the selected dc line’s Setpoint to a specified Amount and could
possibly change the Control Mode of the line. The Setpoint can be set in Percent, MW, or
Amps. When the dc line’s Setpoint is set in Percent, the Setpoint is set to the specified
percentage of the present Setpoint of the line and the Control Mode remains unchanged. If
the Control Mode is presently Blocked, the resulting Setpoint will be 0 regardless of the
Amount entered. When the Setpoint is set in MW, the Setpoint is set to the specified MW
amount, and the Control Mode is changed to Power if the Control Mode is presently Current.
If the Control Mode is Blocked or Power, then the Control Mode remains unchanged. When
the Setpoint is set in Amps, the Setpoint is set to the specified current amount, and the
Control Mode is set to Current if the Control Mode is presently Power. If the Control Mode is
Blocked or Current, then the Control Mode remains unchanged.
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Change By
The Change By action will change the selected dc line’s Setpoint by the specified Amount
and could possibly change the Control Mode of the line. The Setpoint can be changed in
Percent, MW, or Amps. When the dc line’s Setpoint is changed in Percent, the Setpoint is
changed by the specified percentage of the present Setpoint of the line and the Control Mode
remains unchanged. If the Control Mode is presently Blocked, the resulting Setpoint will be 0
regardless of the Amount entered. When the Setpoint is changed in MW, the Setpoint is
changed by the specified MW amount, and the Control Mode is changed to Power if the
Control Mode is presently Current. If the Control Mode is Blocked or Power, then the Control
Mode remains unchanged. When the Setpoint is changed in Amps, the Setpoint is changed
by the specified current amount, and the Control Mode is set to Current if the Control Mode is
presently Power. If the Control Mode is Blocked or Current, the Control Mode remains
unchanged.
When the Control Mode changes from either Power to Current or from Current to
Power, the appropriate conversions are done so that the resulting Setpoint value
reflects the original Setpoint and the change in Setpoint in the same units.
Phase Shifter
Set To
The Set To action will set the middle of the regulation range of the selected phase shifter to
the specified Amount. The middle of the regulation range is calculated by taking the average
of the Regulation Minimum MW Flow and Regulation Maximum MW Flow. The middle of the
regulation can be set in Percent or MW. If the middle of the regulation range is set in
Percent, the middle of the range is set to the specified percent of the present middle of the
regulation range. If the middle of the regulation range is set in MW, then the middle of the
regulation range is set to the specified amount. Regardless of the method used to set the
middle of the regulation range, the regulation range will remain the same, but the Regulation
Minimum MW Flow and Regulation Maximum MW Flow will be adjusted so that the specified
middle of the regulation range is met.
Change By
The Change By action will change the middle of the regulation range of the selected phase
shifter by the specified Amount. The middle of the regulation range is calculated by taking
the average of the Regulation Minimum MW Flow and the Regulation Maximum MW Flow.
The middle of the regulation range can be changed in Percent or MW. When the middle of
the regulation range is changed in Percent, the change is based on the specified percent of
the present middle of the regulation range. When the middle of the regulation range is
changed in MW, the middle of the present regulation range is changed by the specified
amount. Regardless of the method used to change the middle of the regulation range, the
regulation range will remain the same, but the Regulation Minimum MW Flow and Regulation
Maximum MW Flow will be adjusted so that the specified middle of the regulation range is
met.
3-Winding Transformer
Open
The Open action will set the Status of the selected three-winding transformer to Open if the
three-winding transformer Status is Closed. If the three-winding transformer Status is already
Open, this action does nothing.
Open Breakers
See the special topic on Open Breakers for more detail.
Close
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The Close action will set the Status of the selected three-winding transformer to Closed if the
three-winding transformer Status is Open. If the three-winding transformer Status is already
Closed, this action does nothing.
Close Breakers
See the Close Breakers for Contingencies topic below.
Solve Power Flow
The solve power flow type is unique in that you can include an action that forces Simulator to
solve the power flow as part of the contingency. There are rare special cases of sophisticated
contingency definitions this can be used for, as requested by one or more PowerWorld
customers. The load flow is already generally solved for each contingency as part of the
processing.
If a contingency has one or more Solve Power Flow actions, then there will be a few changes in
how the contingency definition display behaves.




Sorting of the list of actions is no longer allowed. This is because the order of the actions is
now important to how the contingency is processed.
When you right-click on the list of contingency actions there will be two new options for
Move Up and Move Down. These can be used to reorder the actions.
On the Contingency Definition Dialog, there will be up/down arrows on the right of the
dialog that may be used to reorder the actions.

Contingency Block
The individual actions of the Contingency Block are applied according to how they are defined.
There are no Action Types available for a Contingency Block.
Choose the Element
Use this portion of the dialog to choose the element involved in this action. This behaves the same
as the Advanced Find Dialogs used throughout the software.
Action Type
Defines the change specified by the contingency action. The Action Types available depend on the
Element Type selected. Possible Action Types include: Open, Close, Move, Set To, Change By,
Bypass, and Inservice. The behavior of each of these actions for the different elements is described
with the Element Types.
Amount
Enterable fields used to specify the quantity of change desired for the contingency element. The
Amount fields are enabled when the Action Type is set to Move, Set To, or Change By. The
availability of these Action Type options changes depending on the Element Type selected. The top
field is used to define a Constant, Field, or Model Expression depending on the entry selected in the
bottom drop-down box. Use the Find button to display a dialog listing Fields or Model Expressions.
This dialog behaves the same as the Advanced Find Dialogs used throughout Simulator.
The Amount of change that occurs is based on the value of the top field entry. The top entry field is
a constant, field name, or model expression name. When this entry is a field name, then the value of
the change is based on the value of the selected element field when the contingency occurs. When
this entry is a model expression, then the value of the change is based on the value of the selected
model expression when the contingency occurs.
The Amount of change that occurs for the selected element is based on the value entered in the top
field and the parameter set with the in options. The availability of the in options will change based
on the Element Type selected and the Action Type selected. The availability of these options is
described in detail with the Element Types.
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Make-up Power Sources
Power injection contingency actions result in power imbalances - typically picked up by the system
slack - that may result in Power Flow Convergence Problems. Simulator provides the option of
specifying Make-up Power Sources for generation, load, injection group, and switched shunt
contingencies to both offset the resulting real power imbalance and provide a more realistic
simulation. See Make-up Power Sources for more information.
Model Criteria
Click the Add button to specify a criterion under which the contingency action will occur. Either a
Model Filter or Model Condition can be selected for the Model Criteria. For example, the user can
specify that a generation outage only occur if the pre-contingency flow on a line is higher than a
specified amount. This condition should be specified as a Model Condition and then this condition
selected as the Model Criteria. Normally, no Model Criteria will be specified for a given action and
this field will be blank.
Comment
An optional user-specified comment string associated with the action. For example, for an action
with Model Criteria specified, you could add a sentence explaining why the action is only performed
under the specified criteria. While this comment is not used by Simulator in any way, it is saved with
the contingency element when saving contingency records in contingency auxiliary data files or with
the case PWB file.
Close Breakers for Contingencies
When using the Close Breakers contingency action, breakers are identified individually for each
element that is using this action and the element is not already energized. A list of breakers to be
closed is created for each affected element regardless of whether closing the breakers will actually
energize the element. The lists of breakers for each individual element are merged into a set of
unique breakers. New temporary contingency actions are created for these breakers so that when
the contingency action is actually implemented, the selected breakers are closed instead of the
element itself changing status. Once the contingency has been implemented and solved, the
temporary contingency actions are removed so that the user never sees the actions created for the
breakers. During the actual contingency solution, the What Actually Occurred? list will be updated
and can be examined in the results to determine what breakers were needed to energize the device,
even though the actions created for the breakers are removed after the contingency has been
examined.
The Close Breakers contingency action is only available for contingency records and is not
available for contingency block definitions or for global contingency actions.
More information about how breakers are selected can be found in the Close Breakers Overview
topic.
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Contingency Element: Open Breakers
The contingency action type Open Breakers is available for each contingency element type for which
the Open action type is available. This includes the following element types: Branch, Bus, Load,
Generator, Switched Shunt, DC Line, Injection Group, and Interface. This action type is only available
for contingency records and is not available for contingency block definitions or for global contingency
actions.
In order to handle the Open Breakers contingency elements, before one contingency's solution is
performed, the list of contingency elements for that contingency is processed by looking for elements
which use Open Breakers. For elements with this action type, all the terminal buses of the respective
device are processed using the algorithm below to determine which breakers to open to isolate the
device (and possible which generators to outage). The basic idea of the algorithm is to search for a list
of breakers that will isolate all the terminal buses of the device from in-service generation. The
algorithm will also return a list of online generators which must be opened to isolate the bus as well.
Remember that a breaker is specified by setting the Branch Device Type to Breaker.
Using the list of breakers and generators found from the algorithm, contingency analysis augments the
contingency element list with a dynamically created list of contingency elements of action type Open
for each breaker and generator device. The dynamically created elements are given the same Model
Criteria and Status as the contingency element which required their creation. Note that if multiple
Open Breakers contingency elements require the same breaker to open, then one new contingency
element will be created. When Open Breakers contingency elements have different Model Criteria,
then a new contingency element will be created for each unique Model Criteria. During the actual
contingency solution, the What Actually Occurred? list will be updated and can be examined in the
results to determine what breakers were needed to isolate the device. Finally, after the contingency
solution is completed, all the dynamically created contingency elements are deleted, and as a result
the user can only see which breakers or generators were opened by looking at the What Actually
Occurred list.
For brevity in the context of tools that either automatically switch or identify breakers to close a
device, the term breaker is used to indicate any type of device that can be switched automatically.
This includes Branch Device Types Breaker and Load Break Disconnect. If the model has no
branches defined with either of these Branch Device Types, this option will not work because the
algorithm will never find any breakers. See the Full Topology Model topic for more information on
defining breakers.
Algorithm description for Open with Breakers
This algorithm is applied to each terminal bus of the device specified. For generators, loads, shunt,
and buses this is done on a single bus only. For an Injection Group however, each generator, load,
and shunt in the injection group will be processed in turn. Starting at each terminal bus of the device
and marching outwards, the algorithm traverses closed branches (except for breakers), dc lines, and
multi-terminal DC lines and will flag any closed breakers at buses which are visited. The buses that
are visited are also flagged. (Note: the algorithm will NOT traverse across the breakers with for an
exception noted below). When buses are visited that have online generators, a list of generators is
maintained that must be opened as well. In order to prevent the degenerate case where breakers do
not fully isolate any portion of the network, only 10 buses with online generation are permitted for
visitation. If more than 10 buses are encountered with online generation, then the algorithm will
immediately abort and a log message is written saying that the device "cannot be isolated from
online generation".
If this part of the algorithm completes it will have obtained a list of flagged breakers and a list of
visited buses (as well as a list of generators to open). The list of flagged breakers is then examined
to ensure that each breaker actually isolates the original device. Each flagged breaker will be
examined and if a flagged breaker has a terminal bus that is NOT in the list of visited buses, then
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this breaker disconnects the device from another part of the system and will be maintained.
Breakers for which both terminal buses have been visited will be discarded because these breakers
do not actually isolate anything. If at least one flagged breaker is maintained then the process is
deemed successful and the contingency will outage the list of maintained flagged breakers. If all the
flagged breakers are discarded, then the breakers do not isolate anything, and therefore a log
message is written saying that "no part of the system can be isolated," and nothing is done.
A few special notes:
1.

2.
3.

4.

If there is another contingency action inside this same contingency that specifies an action
type of Open or OpenCBs for a generator device, encountering that generator won't count
toward the list of generators to open or the maximum of 10 buses to encounter with online
generation. The same is done for any generator connected to a bus or inside an injection
group, if the bus or injection group has a contingency action of type Open or OpenCBs.
If there is a contingency action inside this same contingency that specifies a breaker with
action type Open Breakers, the algorithm will traverse across this breaker (this models a
breaker failure where a breaker is supposed to open but fails to operate.)
If there is a contingency action inside this same contingency which specifies an action type
of Open for a branch or DC line device, the algorithm will NOT traverse across that branch
or DC line. The same is done for any branch which is part of a three-winding transformer,
interface, or connected to a bus if the three-winding transformer, interface, or bus has a
contingency action of type Open.
While a list of generators to open is maintained, if no online load is encountered while
traversing buses in the algorithm, then the generator OPEN contingency actions will not be
created. This is because the breakers will create an isolated island with no load and thus
opening the generation is not necessary.
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Make-Up Power Sources
Generator, load, injection group, and switched shunt contingencies may cause imbalances between
generated power and demand. The default way to handle these imbalances is to assign them to the
system slack. However, this is probably unrealistic and, depending on the size of the unit or load
involved, convergence problems may result.
To implement more local compensation for generation, load, injection group, and switched shunt
changes, use the Make-Up Power Sources Dialog. This dialog can be accessed by from the
Contingency Element Dialog by clicking the button labeled Make-Up Power Sources. Most of the
dialog is occupied by a grid that lists bus numbers and relative contributions. This grid is a Case
Information Display, so its behavior should be familiar. For example, right-click on the grid to display
its local menu.
We shall call those buses that must compensate for the changes caused by a generator, load, injection
group, or switched shunt contingency "compensators". To insert a new compensator, select Insert
from the grid’s local menu. This opens another dialog, where you should specify the bus number of the
compensator and its contribution. Specify the contribution of the compensator either as a percentage
or as a fixed number of MW. If a particular contingency has multiple compensators, then the choice of
basis for the contribution (either MW or percent) should be consistent for each. After identifying the
compensator, click OK. The grid should update with your newly added compensator.
To delete an existing compensator, select it from the grid and select Delete from the local menu.
To determine how much each compensator contributes to the imbalance, each contribution value is
normalized to the total sum of all contribution values. This allows the values to be entered in either
percent or MW. Keep in mind that when entering the values in percent that the sum of all contribution
values should equal 100 or the actual contribution amounts will not occur in the expected percentages.
Compensators account for the changes caused by a generator, load, injection group, or switched shunt
contingency by changing either generation or load to satisfy its defined contribution. For example,
suppose compensator contributions are specified as percentages, and Simulator needs to compensate
for 100 MW lost in a particular generation contingency. Suppose the contingency has 4 compensators
defined as follows:
Bus Number Contribution
1 20
2 30
3 10
4 40
Suppose buses 1 and 2 are load buses, and buses 3 and 4 are generators. Then bus 1’s load will
decrease by 20 MW, bus 2’s load will decrease by 30 MW, bus 3’s generation will increase by 10 MW,
and bus 4’s generation will increase by 40 MW. These changes will be instituted regardless of the
compensators’ operating limits or AGC status. In fact, any compensating units will be set off AGC to
ensure that the prevailing AGC control does not distort the dictates of the contingency. Furthermore,
maximum MW limits on generators will not be checked.
If a compensator has both generators and loads attached to it, the generator will take precedence.
The generator will function as the compensating device, and the load will be left unchanged.
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Contingency Make-Up Sources Dialog
Simulator allows you to specify buses that will serve as compensators to account for changes in the
balance between generation and demand caused by generator and load contingencies. This dialog
allows you to define or adjust the amount of power supplied by a compensator. For more information,
please see Make-Up Power Sources.
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Tutorial: Contingency Analysis
This tutorial will walk you through the basic commands necessary to insert contingencies and have
Simulator automatically analyze the results. Please see Introduction to Contingency Analysis for the
necessary background information regarding the capabilities and uses of the Contingency Analysis
tool.
For this tutorial, we will use an existing 7-bus case.




Open case B7SCOPF from the Program Files/PowerWorld/Simulator/Sample Cases directory.
Ensure Simulator is in Run Mode.
Select Contingency Analysis from the Run Mode ribbon group on the Tools ribbon tab.
Simulator opens the Contingency Analysis Dialog.

The next section of the tutorial discusses Defining Contingencies and provides an example of
inserting a single element contingency.
1 2 3 4 5 6 7 8 9 10 11
Next
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Tutorial: Contingency Analysis - Page 2
Defining Contingencies
Contingencies can be either Single Element or Multiple Element. A single element contingency has only
one associated contingent action. Click here for more information on the terminology used. There are
four options for defining contingencies. The user may: Load Contingencies from a File, Auto Insert
Contingencies, or use the local menu to either Insert contingencies or Quick Insert of Single
Element Contingency. This tutorial will utilize the Auto Insert and Quick Insert tools.
Quick Insert of Single Contingency Element


Right-click on the grid (as shown below) and select Insert Special > Quick Insertof Single
Element Contingency from the local menu. Simulator opens the Contingency Element Dialog.
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Contingency Analysis Dialog

Contingency Element Dialog
Note: The active fields in this dialog depend upon which Element Type is selected.
The defined action for this contingency will be to change the load at bus 2 by 25%.




Select Load under Element Type and 2 (2) #1 [138 KV] under Choose the Element.
Select Change By under Action Type.
Enter 25 for Amount, choose Constant from the drop-down box, then select Percent under the
field labeled in.

Note that you can enter either positive or negative values in the Amount field to specify the direction
that you want the change to occur (i.e. for a load contingency, entering a positive Amount increases
the power consumed by the load, a negative value would decrease the load’s power consumption).
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Power injection contingency actions result in power imbalances - typically picked up by the system
slack - that may result in Power Flow Convergence Problems. Simulator provides the option of
specifying Make-up Power Sources for generation, load, injection group, and switched shunt
contingencies to both offset the resulting imbalance and provide a more realistic simulation. See Makeup Power Sources for more information. See Model Criteria and Comment in the Contingency Element
Dialog for more information on those fields. For the purpose of this tutorial, we will not use these
fields.


Click OK to insert the contingency element.

The lower right portion of the Contingencies Tab contains a Contingency Definition list display. This
display lists all elements (actions) associated with the selected contingency. Since we inserted a single
element contingency, there is only one element shown in the Definition.

Contingencies Tab – Definition Display
The next portion of the tutorial provides an example of Auto Insertion of Contingency Elements.
1 2 3 4 5 6 7 8 9 10 11
Prev Next
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Tutorial: Contingency Analysis - Page 3
Simulator allows you to automatically generate a contingency list containing branch, generator and/or
bus outages. To accomplish this, right-click in the Contingencies grid on the Contingency Analysis
Dialog, and select Insert Special > Auto Insert Contingencies from the popup menu. This opens
the Auto Insertion of Contingencies Dialog.

Auto Insertion of Contingencies Dialog
We will insert contingencies for all branches and generators. This will require two executions of the
auto insert tool.


Verify that Single Transmission Line or Transformer is selected.

When using the Auto Insert tool, you can limit the contingencies inserted to only those meeting a
defined filter. We want to insert contingencies for all branches and generators so no filtering is
desired.
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Click to remove the checkmark in Use Area/Zone Filters.
Verify that no other options are selected.
Click the Do Insert Contingencies button to accept the remaining default values and
automatically insert the branch contingencies.
Click Yes when asked to confirm the insertion of 11 contingencies.

Note that the Contingencies Tab of the Contingency Analysis Dialog now shows 12 contingencies.



Right-click on the list display of the contingencies tab and select Insert Special > Auto Insert
Contingencies from the local menu.
Select Single Generating Unit then click the Do Insert Contingencies button. Click Yes to
complete the auto insert of 4 generator contingencies.

Note that the Auto Insert tool did not insert a contingency for the generator connected to the Slack
Bus. You can manually insert slack bus generator contingencies.
The contingencies tab now shows 16 contingency records. You can click on an individual record and
view its information in the Contingency Definition section of the Contingencies Tab.
The next section of the tutorial discusses running the contingency analysis.
1 2 3 4 5 6 7 8 9 10 11
Prev Next
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Tutorial: Contingency Analysis - Page 4
When running the Contingency Analysis, the user has three options:
1.
2.
3.

Run every contingency on the list of contingencies (click Start Run on the Contingencies Tab,
click Start on the Summary Tab or select Run Contingency Analysis from the local menu of the
list of contingencies)
Run a single contingency (discussed in the advanced tutorial section) or
Run a single contingency then save the post-contingency state as the new reference state (also
discussed in the advanced tutorial section)

We will run every contingency in the list for this portion of the tutorial.


Press Start Run on the Contingencies Tab. Note: Pause and Abort buttons are available on the
dialog while the contingency analysis is running. These may prove useful when processing a long
list of contingencies.

The results from the run are shown in the Contingency Analysis Dialog.

Contingency Analysis Dialog – Contingencies Tab

1103
©2011 PowerWorld Corporation

Note: The Refresh Displays after Each Contingency option (lower right) can slow down the
analysis significantly when running a long list of contingencies.
The contingency analysis results are sorted on the contingencies tab in descending order by worst
violation. We see that there were three violations resulting from the contingency analysis (one for each
of the first three contingency records displayed) and that no unsolvable load flows resulted (as shown
in the Status Section of the Contingencies Tab.) If you enlarge the Contingency Analysis Dialog (by
dragging either side or the corner of the pane) you see more information in the Status Window,
specifically, "Finished with 3 Violations and 0 Unsolvable Contingencies. Initial State Restored."
Contingency Analysis always stores a Reference State or pre-contingency state. The Reference State
stores information pertaining to: buses, switched shunts, limit groups, loads, branches, generators,
areas / super areas, and power flow solution options.
Both prior to and following completion of solving a list of contingencies, the reference state is loaded
into memory. This ensures that all contingency analysis solutions start from a common base case and
that the system is restored to its initial state following a solution. The last sentence in the Status
portion of the dialog, "Initial State Restored," tells the user that the simulation case was restored to
the reference state upon completion of the Contingency Analysis Run. See Contingency Case
References for more information on the Reference State.
The Violations Section (lower left) of the Contingencies Tab provides a description of each violation
resulting from the execution of the contingency selected in the list of contingencies. Scroll through the
list of contingencies to view information about the resulting violations for each.
Note: You can hide the Contingency Definition section of the Contingencies Tab by clicking the
button.

1 2 3 4 5 6 7 8 9 10 11
Prev Next
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Tutorial: Contingency Analysis - Page 5
The Summary Tab of the Contingency Analysis Dialog provides the status of the present contingency
analysis run.

Contingency Analysis Dialog – Summary Tab
1 2 3 4 5 6 7 8 9 10 11
Prev Next
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Tutorial: Contingency Analysis - Page 6



Click on the View Results By Element page of the dialog.

The View Results By Element page contains five sub-pages: Lines/Transformers, Buses, Interfaces,
Nomogram Interfaces, and Custom Monitors. The information contained on each of the sub-pages
provides an alternate method of viewing information similar to that contained on the Contingencies
tab. The individual pages show model objects (subject to area/zone/owner filters) only if they are
associated with specific contingencies.

Contingency Analysis Dialog – View Results By Element
With the exception of Custom Monitors, the user can select any model object on its respective sheet to
see how many times a violation occurred on the device during the contingency analysis. When a
particular device is selected, the Contingencies and Contingency Definition sections give the details of
the specific contingencies that caused the violation (or violations) on the selected device. For example,
on the Lines/Transformers page:






Select the line from 2 to 5 as shown above. This line had one violation on the most recent
contingency analysis run. The contingencies section shows which contingency caused the violation
and the contingency definition section details the elements that define the contingency.
Switch back to the Contingencies tab of the dialog.
Scroll down in the list of contingencies and select the contingency labeled CHANGE LOAD AT BUS
2 (2)
Right-click on the element displayed in the Contingency Definition Section of the Contingencies tab
Select Show Dialog from the local menu.
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Modify the element’s Action to: Set To 600 MW (const pf) using the Action Type, Amount, and
in fields of the Contingency Element Dialog.
Click OK to close the dialog. The Contingency Definition should now show SET LOAD AT BUS
2_138 (2) TO 600.00 MW (const pf).
Click Start Run on the dialog and Yes when asked to confirm.
Following the run, the Status field now shows, "Finished with 7 Violations and…" The increase in
load resulted in four contingency violations not present during the last run.
Again select the contingency labeled SET LOAD AT BUS 2… on the list display. The Violations
section shows the four branch violations that occurred for the selected contingency.
Now switch to the Lines/Transformers sub-page of the View Results By Element page.
Select the line from 2 to 5. This line experienced violations under two contingencies during the
run. The Contingencies section now shows the details of both contingencies (opening line 5 to 7
and changing the load at bus 2) that caused overloads on the line. Notice that the information in
the Contingency Definition section is specific to the Contingency selected in the Contingencies
section.

Note: The Show Related Contingencies and Show Other Violations buttons (on the
Contingencies and View Results By Element pages respectively) provide a fast method of switching
between the two pages and viewing related information.
1 2 3 4 5 6 7 8 9 10 11
Prev Next
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Tutorial: Contingency Analysis - Page 7
You now have enough information to effectively utilize PowerWorld Simulator’s Contingency Analysis
tool. The remaining portions of the tutorial introduce the full capabilities of the Contingency Analysis
tool and provide links to the applicable Help files.
Contingency Records
There are four methods of defining contingencies. See Defining Contingencies for more information.
Contingency Records can also be saved to or loaded from a file.
Contingency Blocks and Global Actions
The user may desire to have a common set of actions occur during more than one (or all)
contingencies. Instead of repeatedly defining the same contingency element (or elements) in multiple
contingencies, Simulator provides the option to use Contingency Blocks and/or Global Actions.
A Contingency Block is a set of contingency actions that can be defined and then called upon by
individual contingency records.
Global Actions are actions defined by the user that will occur during all contingencies unless an
Inclusion Filter is specified that allows defining with which contingencies the action will be included.
Contingency Solution Options
By default, the contingency analysis will use the same options as the power flow algorithm when
solving each contingency. You may also override these options for all contingencies, and/or for a
specific contingency. This results in the ability to set the power flow solution options in contingency
analysis at three different levels
1.
2.
3.

Contingency Specific Options (see Contingency Definition Dialog)
Contingency Analysis Options (see Contingency Options Tab)
General Power Flow Solution Options (see Power Flow Solution Options)

When Simulator executes a particular contingency, it will first look at options specified for that
contingency. Any options defined for the contingency will be used. Other options set to use default will
look to the Contingency Analysis Options. Again, any options defined for contingency analysis will be
used. Finally, options marked in the Contingency Analysis Options as use default will be set to the
same setting as the power flow solution options.

1 2 3 4 5 6 7 8 9 10 11
Prev Next
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Tutorial: Contingency Analysis - Page 8
Reference State
The Reference State (introduced on page 4 of the tutorial) can prove very useful to advanced users if
they know how to exploit its capabilities. When running a list of contingencies the reference state is
loaded into memory prior to executing each contingency. The system is restored to the reference state
following the contingency analysis run. In addition to running an entire contingency list, the user also
has the option to solve individual contingencies by right clicking on the desired contingency - on the
Contingencies tab of the Contingency Analysis Dialog - and selecting either Solve Selected
Contingency or Solve and Set as Reference from the local menu.
Solve Selected Contingency causes Simulator to first load the reference state into memory then
solve the contingency. THE SYSTEM STATE IS NOT RESTORED TO THE REFERENCE STATE
FOLLOWING THE SOLUTION; the system state then reflects the power system flows of the postcontingency state. The advantage of this approach is the ability to implement a contingency and then
modify the system looking for possible actions that might mitigate violations caused by the
contingency. Be aware; however, that prior to solving another contingency, Simulator will reset the
system state to the reference state thereby removing all modifications made following the previous
contingency solution. The user may also automatically restore the system state to the reference state
by selecting Other > Restore Reference from the Contingency Analysis Dialog.
Solve and Set As Reference acts the same as Solve Selected Contingency with one exception. After
executing the contingency, the post-contingency state is automatically set as the reference state. As a
result, all subsequent contingencies will use the post-contingent state as the Reference State.
Make-up Power Sources
Power injection contingency actions result in power imbalances - typically picked up by the system
slack - that may result in Power Flow Convergence Problems. Simulator provides the option of
specifying Make-up Power Sources for generation, load, injection group, and switched shunt
contingencies to both offset the resulting imbalance and provide a more realistic simulation. See Makeup Power Sources for more information.

1 2 3 4 5 6 7 8 9 10 11
Prev Next
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Tutorial: Contingency Analysis - Page 9
Contingency Elements
A contingency element consists of a single Contingency Action and its associated Model Criteria, Status
and Comment (optional). Multiple Contingency Elements can be defined for a single Contingency.
Contingency Action - Click here for a list of available contingency actions.
Model Criteria - Model Criteria are criteria under which the contingency action will occur and consist
of both Model Conditions and Model Filters.
Status – The status field of a contingency element can take one of four values: CHECK, ALWAYS,
NEVER or POSTCHECK.





CHECK - The action will be executed if the Model Criteria are true or if no Model Criteria are
specified. CHECK is the default status setting.
ALWAYS - The action will always be executed, regardless of the Model Criteria.
NEVER - The action will never by executed, regardless of the Model Criteria. This allows you to
disable a particular contingency action without deleting it.
POSTCHECK – Following completion of all CHECK and ALWAYS actions, the contingency analysis
tool runs the load flow solution. POSTCHECK actions are then addressed recursively until all are
complete. The execution of POSTCHECK actions follows the same rules as CHECK actions with the
exception of not being checked until the load flow has been solved. If the Model Criteria specified
for the POSTCHECK action are met in the solved load flow solution (or if no Model Criteria are
specified), then the action is taken and the load flow is again resolved. If the model conditions are
not met, the action is skipped.

For more information, see Contingency Definition Display.
1 2 3 4 5 6 7 8 9 10 11
Prev Next
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Tutorial: Contingency Analysis - Page 10
Contingency Analysis Dialog – Options Tab Overview
The bulk of the Options Tab contains five groupings, each of which concerns a different aspect of the
contingency analysis. A brief description of the actions allowed via each grouping follows. Click on the
headings below for more information on each.
Modeling
The modeling group allows the user to:











Define the Contingency Analysis Load Flow Calculation Method
Specify Limit Monitoring Settings
Instruct Simulator to retry the solution using the Robust Solution Process following a failure to
converge
Specify the use of specific solution options for contingencies
Specify Make-up Power for the post-contingency solution
Define Bus Load Throw-Over Records – BLTRs provide the capability to define how load at a bus
should be transferred to a different bus if the original terminal bus becomes disconnected from the
system during a contingency
Define Generator Maximum MW Responses in Post-Contingency – allows the user to limit the
absolute MW response of a generator during a contingency
Define Generator Line Drop Compensation (LDC) and Reactive Current Compensation (RCC) – LDC
and RCC controls allow the user to model the real-time control done at some real generators
Specify a post-contingency aux file to be loaded at the start of each contingency. This allows the
setting of very specialized post contingency settings.
Specify how reactive power is modeled for DC calculation methods

Limit Monitoring
The Limit Monitoring grouping contains the following:



Advanced Limit Monitoring page that allows you to shape how limit violations are detected and
reported
Monitoring Exceptions display

Contingency Definitions
The Contingency Definitions grouping allows the user to:




Define Contingency Blocks and Global Actions (refer to Page 7 of the tutorial)
Define Model Criteria (Expressions, Conditions and Filters)
Specify Model Criteria Options

Distributed Computing
This page contains special distributed computing options for contingency analysis.
Miscellaneous
The Miscellaneous sub-tab provides options pertaining to the loading and saving of contingency
records as well as specifying how the reference state should be established when the contingency
analysis tool is accessed.
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Tutorial: Contingency Analysis - Page 11
Contingency Analysis Dialog – Other Contingency Actions
The Other > buttonon the Contingencies tab and the View Results By Element page of the
Contingency Analysis dialog, provides access to a number of additional contingency actions. Some of
the actions available include:









Deleting all contingencies
Clearing contingency results
Setting or restoring the reference state
Producing combined tables of results
Producing detailed reports of results
Comparing lists of contingencies
Filtering results
Auto-filling blank comment fields and performing sensitivity calculations such as OTDFs and
PTDFs.

For more information, see Other Contingency Actions.
1 2 3 4 5 6 7 8 9 10 11
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1113
©2011 PowerWorld Corporation

Time Step Simulation
The Time Step Simulation tool allows you to specify operating conditions and obtain power flow
solutions for a set of points in time. It provides the tools needed to analyze the operation of a power
system hour by hour or by intervals down to one second.
Time Step Simulation is available in the base Simulator package. If you own Simulator, you can start
taking advantage of this valuable tool right away. In addition, if you own Simulator OPF or SCOPF
licenses, you can solve OPF and SCOPF scenarios on a time point to time point basis and use the tool
to evaluate the behavior of prices and operating constraints. The tool will obtain the optimized
generation dispatch for each time point of the analysis horizon.
In order to access the Time Step Simulation, go to the Tools ribbon tab, and choose Time Step
Simulation from the Run Mode ribbon group. This is only available in Run mode. The following topics
describe key components of the time step simulation tool:












Time Step Simulation Quick Start
Time Step Simulation Dialog
Specifying and Maintaining a List of Time Points
Loading Input Data
Setting up Scheduled Input Data
Storing Input Data and Results
Running a Timed Simulation
Time Step Simulation Toolbar
Running OPF and SCOPF Simulations
Application of Controller Time Delays
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Time Step Simulation: Quick Start
This topic will get you started with using the Time Step Simulation tool and help you become familiar
with the basics of setting up a time step simulation run.
The Time Step Simulation dialog is displayed when you access the Time Step Simulation by selecting
Time Step Simulation from the Run Mode ribbon group on the Tools ribbon tab. This dialog contains
several pages. The Summary page is used to define and control the time points you want to analyze.
As an example, we will assume that you have hourly load data for tomorrow and that you want to
determine the system bus voltages for each hour. You would do the following:
Step One: Set the List of Time Points
In order to create a list of points, right-click on the Summary page and select Insert New
Timepoint(s), which brings up the New Timepoint Dialog. In this dialog, select tomorrow’s date
from the drop down calendar component. Set the field Total Number of Timepoints to Enter to
24. Assume the other default values are acceptable and click OK. This will insert 24 time points, one
for each hour starting tomorrow at 12:00 AM.
Step Two: Specify Input Data
Input data is specified on the Input Page. In this example your input data corresponds to hourly
loads. Select the MW Loads sub-page. In order to specify hourly load values you have to insert a
column for each load. Right-click on the grid and select Time Point Records > Insert/Scale
Load Column(s) to bring up the Insert/Scale Column Dialog. In the selector component, select the
load for which you want to specify hourly values. You can press the shift key to select multiple
elements. Then press the blue Arrow Button to pass the selected loads to the right side of the
selector. Select OK to insert the new column(s). Now you can specify the hourly MW values for
those loads.
Step Three: Specify the Custom Results
Obtaining solutions for a large number of time points has the potential to create unnecessary burden
in memory and storage due to the large amount of data that can be generated. For this reason, the
Time Step Simulation tool allows you to explicitly specify what quantities you want to display and
store. This is done on the Results page. This page contains grids for many devices including
Generators, Lines, etc. In this example we want to analyze the bus voltage magnitudes. We specify
what quantities we want to store as results for each object by clicking the View/Modify button,
which brings up the Custom Results Selection Dialog. In this dialog select the Buses page and click
the Add/Remove Fields button to bring up the list of Available Bus Fields. Find the Per Unit
Voltage field and Add this to the list of Selected Fieldsand then click OK when done modifying
fields. Results will be saved only for those buses that have the Time Selected field on the grid set
to YES. Set this field to YES for the buses that you want to save. Click the Save and Close button
to save the custom results settings, i.e., which objects, fields and records are to be kept during the
solution; in this case bus voltages.
Step Four: Run the Simulation
The upper part of the Time Step Simulation dialog contains buttons used to control the simulation.
To do a full run of the 24 hours click the Do Run button. The Last Result box shows the progress
of the simulation as each time point is being solved. If you are in the Results – Buses page, you
will see that a column was added for each bus set to YES in the Custom Results Selection
Dialog. Each column shows the bus per unit voltage. Recall that you can right-click on any
Simulator grid and select Plot Column to obtain a plot of the column values. If you select cells
spanning all the bus per unit voltage columns, you will obtain the voltage profiles for each bus,
versus time.
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If you are in the Summary page, the Processed column shows that each point was in fact
processed and solved.
Step Five: Save the Results
Once you have completed the simulation, you can save the results in a Time Series Binary (.tsb)
file by pressing the Save TSB File button. This file will contain all the input data, the simulation
options, the custom results settings, and the results. You can reload this .tsb file any time by
pressing the Read TSB File button.
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Time Step Simulation Dialog
The Time Step Simulation dialog is used to control and visualize the time simulation. The top section of
the form contains buttons for data input/output and buttons to control the progress of the simulation.
The main part of the form has a number of Time Step Simulation pages that contain grids and options
where input data can be specified and simulation results can be examined.

Input/Output Buttons
Insert Time Points
Press this button to open the New Timepoint Dialog that allows specification of time point starting
date and time, number of time points to enter, and the interval between time points.
Read TSB File
Press this button to read a Time Series Binary file (.tsb File). This files stores input and scheduled
data, the simulation options and the results.
Save TSB File
Press this button to save the input, custom inputs and scheduled data, the simulation options, and
the results and custom results in a Time Series Binary file (.tsb file).
Clear Results
Press this button to clear any results stored with the time step simulation.
Delete All
Press this button to delete all information associated with a time step simulation including, results,
selection of objects and fields for results, schedules, schedule subscriptions, and time points.
Simulation Control Buttons
During the solution, the Time Step Simulation solves each time point in a sequential manner. During
this process, the Simulation can be in one of three states:
1.
2.

Reset: When the simulation has not started, when it has been completed, or when it has been
paused and then reset.
Running: When the simulation is solving time points sequentially.
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3.

Paused: When the user has paused the simulation. The simulation actually waits until the present
time point is solved in order to pause. If the simulation includes an SCOPF solution, all the
contingencies are processed and the system is optimized before the simulation is paused. Note
that once a time point is solved its results are available on the various grids.

The user controls the Time Step Simulation by means of the following control buttons:
Starting Time
Use this selector to specify a start time point other than the first time point in the list. The simulation
will disregard the time points before the selected start time point.
Ending Time
Use this selector to specify an end time point other than the end time point in the list. The
simulation will stop after processing the selected end time point.
Do Run [Pause Solution, Continue Solution]
Press this button to initialize the Time Step Simulation and go through all the time points until the
last time point or a time point with theSkip field set to Pause is found. As the simulation takes
place, the Last Result Boxwill be updated with messages. In addition, the Summary page will
change the Processed and Solved fields from NO to YES, reflecting the simulation progress. The
Results grids will be updated once the solution for a time point has been found.
When the Simulation starts, the simulation status changes to Running, and the Do Run button
changes its caption to Pause Solution. Press this button to pause the Solution. The simulation will
continue until the current time point is solved entirely. Once the Simulation status is set to Paused,
the Do Run button caption changes to Continue Solution. Press this button to continue the
solution.
Do Single Point
Use this button to solve the next time point. You can see the last processed point in the Last
Result box. You can also select a specific starting point by using the Starting Time selector.
Do Previous Point
Use this button to solve the previous time point. You can see the last processed point in the Last
Result box. You can also select a specific starting point by using the Starting Time selector.
Reset Run
Use this button to go back to the first time point and initialize the simulation. This action does not
delete the results of the time points processed so far, but it resets all the Processed fields to NO.

Last Result
The last result box in the lower left corner of the dialog is used to show solution progress messages.
The messages indicate correct solutions or errors in the solution of the particular time point. It also
shows the progress of the contingency analysis during a SCOPF solution.
Present Time
If you are solving the time points using a timed simulation, the Present Time of the process is
displayed in this field.
Refresh All Displays Each Time Step
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Check this box to have all displays refresh after each time step. This could slow the process down if
there are a number of displays open.
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Time Step Simulation Toolbar
The purpose of this toolbar (besides providing shortcuts) is to command a Time Step Simulation
without having to keep the Time Step Simulation dialog in a non-minimized state. This is particularly
important during a Timed Simulation, in which you want to see the changes on the oneline diagram as
they occur in time.

The figure shows the main functions of the toolbar. [Reset/Solve Previous Point/Play/Solve Next Time
Point/Pause Control Buttons; Last Result Box; Present Time; Progress Bar, and Timed Simulation
Options]. All of the buttons are disabled until a list of time points have been defined in the Summary
page. The Time Step Simulation Toolbar is available in Run mode and is visible only when the Time
Step Simulation dialog is open. Minimize the Time Step Simulation dialog to prevent it from obscuring
the oneline.
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Time Step Simulation Pages
The Time Step Simulation dialog contains a number of pages used to specify input and scheduled
data, and to examine the results of the simulation. See the following topics for a detailed explanation
of each page:
Summary
Input
Results
Results: Constraints
Options
TSB Description
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Time Step Simulation: Summary
The Summary page of the Time Step Simulation dialog is used to define the time points and display a
summary of the simulation. Most of the commands to manage time points can be accessed from the
Summary page local menu.
Once time points are defined, the Summary page presents the following columns for each time point:
Date
The date of the time point. To modify the date, right-click and select Time Point records >
Change Timepoint Time on the local menu. This will open the Change Timepoint Time Dialog.
Time
The time of the time point to the second. To modify the time, right-click and select Time Point
records > Change Timepoint Time from the local menu. This will open the Change Timepoint
Time Dialog.
Skip
Set this field to YES to include the time point in the simulation. If set to NO, the input data and any
scheduled actions that occur at this time point are not applied to the power system.
Processed
This field is set to YES if the simulation has processed the time point. This includes applying the
input data, applying the scheduled actions, and solving the power flow for that particular time point.
Solution Type
The time point can be solved using one of the following Solution Types: Single Solution,
Unconstrained OPF, optimal power flow (OPF), and security-constrained optimal power flow
(SCOPF). The last three solution types require the Simulator OPF/SCOPF add-ons. See Running OPF
and SCOPF Time Step Simulations for more information.
Run Contingencies
If the case has a defined set of contingencies, you can choose to run the contingency analysis for
each time point by setting this option to YES.
Solved
This will be set to an integer value indicating at what point a solution was obtained for the time
point under the specified Solution Type.
Num Loads
Total number of loads for which input data has been specified.
Total MW Load
Total MW load specified as input data for the time point.
Total Mvar Load
Total reactive load specified as input data for the time point.
Num Gens
Total number of generators in the system for which input data has been specified.
Total MW Gen
Total MW of generation specified in the input data.
Pre Script Cmd
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The Time Step Simulation has the capability of running a pre script command before each time point
is solved. The pre script command can be run either before applying the input data and scheduled
actions or right after applying the input data and scheduled actions but is always run before the
power flow solution is solved. See Time Step Simulation: Options for more information on specifying
when the pre script command is run. See the Script Command section to learn the details about
performing Simulator actions using script commands.
Post Script Cmd
The Time Step Simulation has the capability of running a post script command right after the time
point is solved. The post script command can be run either before storing results or after storing
results. See Time Step Simulation: Options for more infomration on specifying when the post script
command is run. See the Script Command section to learn the details about performing Simulator
actions using the script language.
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Time Step Simulation: Summary Local Menu
The local menu of the Time Step Simulation Summary page is used to perform a number of logical
actions on the time point grid and is, as every Simulator local menu, accessed by right-clicking
anywhere on the grid. When selected from the Summary page, the local menu shows the following
additional time step simulation specific options:
Time Point records > Apply Time Point
Simulator applies the input data of that particular time point to the power system model, without
solving the time point. Upon selection of this option, the time point information can be visualized in
the Case Information Displays.
Time Point records > Solve Time Point
This option applies the time point input and the scheduled data to the power system and solves the
time point with the specified Solution Type.
Time Point records > Change Timepoint Time
This option allows the user to modify the date/time of the selected time point through the Change
Timepoint Time Dialog. If the new date/time belongs to an existing point in the list, an error
message is displayed. The time points can be specified with a precision of up to 1 second.
Insert New Timepoint(s)
Use this option to insert new time points into the time point list. This selection brings up the New
Timepoint Dialog.
Delete Entire Timepoint Record
Use this option to delete the selected time point and all of the input data and custom results for that
time point.
Set/Toggle/Columns > Plot Column(s)
Use this option to automatically generate column plots. By default, in the Time Step Simulation
grids, the column plots display graphs of column data versus the date/time column (the combination
of the date and time columns).
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Time Step Simulation: Input
The Time Step Simulation dialog Input page is used to specify input data per time point, scheduled
data, time step actions, and custom inputs. This requires that the list of time points have been
created. See the Specifying and Maintaining a List of Timepoints topic for details on managing the list
of time points.
The Input page contains several pages that can be grouped in four types: Input Pages, Schedule
Pages, Time Step Actions Page, and Custom Inputs Pages.
Input Pages
The time point input pages (MW Loads, Mvar Loads, Actual MW Generation, Maximum Generation,
Line Status, Area Loads, Zone Loads, and Injection Groups) are Matrix Grids that are used to specify
data on an time point by time point manner. In order to tell Simulator that we want to specify time
point data for a particular object type (e.g. load, generator, line, etc.) we need to add that particular
object to the corresponding grid. For instance, suppose that you want to specify MW data for Load 1
at bus 1. Go to the MW Loads page, right-click and select Time Point records > Insert/Scale
Load Column(s) to bring up the Insert/Scale Column Dialog. In this dialog, you can select the load
and add it as a column to the MW Loads grid. The corresponding values at each time point for that
particular load can then be entered in the grid.
Use the Area Loads and Zone Loads pages to specify the MW load for an entire Area or Zone at a
particular time point. When Simulator applies the input data to solve a time point, it will scale the
load of the specified area or zone to match the value entered for that time point.
Use the Injection Groups page to specify to total MW injection from an injection group at a particular
time point. All loads and generators in an injection group will have their MW injection changed in
proportion to their participation factor specified with the injection group to meet the specified MW
injection. Generators will have their minimum and maximum MW limits enforced. Mvar injections will
not be modified as part of this input. If a zero injection value is specified for a time point, no
modifications will be made to the injection group for that time point. To zero out the injection,
change the value to a very small number, e.g. 0.01.
Schedule Pages
The schedule pages (Schedules page and Sched Subscriptions page) are used to specify scheduled
input data, i.e., data that more naturally spans multiple time points rather than being defined at
each time point. Examples of data that can be scheduled are scheduled transactions, generator
statuses, line statuses, etc. For a detailed explanation on how to set up scheduled data, please read
the Setting Up Scheduled Input Data section.
Time Step Actions Page
Use this page to specify Time Step Actions. These are conditional actions that can be applied during
a time step simulation run if their Model Criteria evaluates to true for a specified time period.
Custom Inputs Pages
Custom inputs allow the selection of specific objects, object numeric fields, and the specification of
what each selected field should be set to for a particular time point.
The top portion of this page is used to select the objects and fields and specify how the selection of
objects and fields should be displayed in the grids contained on the bottom portion of the page. The
selection of objects and fields for custom inputs is identical to the selection of objects and fields on
the Results page.
Once the objects and fields have been selected, the grids will be updated with a column for each of
the selected object and field combinations. Use these columns to specify the values for the selected
fields at each time point.
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Matrix Grids
Matrix Grids are a special type of data grids used in the input and results pages of the Time Step
Simulation tool. In these grids, the time dimension is assigned to the rows and the object fields (load
MW, generator MW output, etc) are assigned to the columns. The column header corresponds to the
ID of the object. The number of columns of the grid depends on the user options and simulation
results:
Hourly Input Pages
In the case of input pages, the user has to specify hourly data for each object, e.g., load, generator,
area. Thus the user adds each column to the grid explicitly.
Custom Result Pages
In the custom result pages, a column is created for each object whose results have been specified to
be stored.
Constraint Pages
Since the constraints are determined at solution time, the columns appear only when constraints
have been detected during the solution.
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Time Step Simulation: Results Constraints
The Results Constraints page of the Time Step Simulation dialog is used to convey results that are
specific to an optimal power flow type of study. This page is only available with the OPF and SCOPF
add-ons of Simulator. When the OPF solution type is used to solve a time point, the status of the
system during that particular time is optimized so that the total operating cost of the system is
minimized, and the normal operation constraints are enforced. In addition, the SCOPF solution type
enforces contingency constraints. The OPF and SCOPF solutions contain information about the
elements that determine the LMPs, the binding constraints, the violating contingencies, and changes in
the control settings.
The information related to contingencies on these pages is available only in the SCOPF Simulator addon.
The pages of the Results: Constraints page are:
Results Summary
This page is similar to the Summary Page, except that it contains additional operating information
such as:
Initial Cost
The cost of operating the system given the initial generator set points and a standard power flow
solution. No controls are moved to minimize cost.
Unconstrained Cost
The total operating cost after the controls are moved to minimize cost, without enforcing any
normal operation or contingency constraint. The result is an operating cost that corresponds to
an Economic Dispatch solution.
Unconstrained LMP
The average marginal price of the system under unconstrained optimization.
Final Cost
The total operating cost after a constrained (OPF or SCOPF) solution has been obtained.
LMP
(Average, Standard Deviation, Minimum and Maximum): Metrics of the LMP values.
Binding Lines
Number of transmission lines and transformers that are binding after the OPF/SCOPF solution
has been determined.
# CTGs Unsolvable
Number of unsolvable contingencies. These are severe contingencies that would cause the power
flow solution to fail for that particular time point scenario. Unsolvability of the power flow case is
related to maximum loadability conditions.
You can access the details of the binding elements by right-clicking and selecting Show Binding
Constraint Dialog on the local menu.
Binding Lines
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This is a matrix grid that shows information for transmission lines and transformers that become
binding constraints during the OPF or SCOPF solutions. A similar page is available for binding
interfaces.
When transmission lines or transformer thermal ratings become binding constraints for a time point,
a column is automatically added, forming in this manner the matrix grid. You can access the details
of the binding line or transformer by right-clicking and selecting Show Binding Constraint Dialog
on the local menu. The grid also shows the following summary columns:
Processed
Gets set to YES if the time point was correctly processed.
CTGs with Viols
Number of contingencies that presented one or more violations (violating contingencies).
# CTGs Unsolveable
Number of unsolvable contingencies for the time point.
BC Line Viols
Number of transmission line and transformer violations that were identified in the base case.
# Line Viol
Number of transmission line and transformer thermal violations.
Binding Lines
Number of binding lines in the OPF/SCOPF solution.
Line Unenforceable
Number of lines with unenforceable limits.
Binding Interfaces
This is a matrix grid that shows information for interfaces that become binding constraints during
the OPF or SCOPF solutions. A similar page for lines is available.
When interfaces become binding constraints for a time point, a column is automatically added to the
matrix grid. You can access the details of the binding interface by right clicking and selecting Show
Binding Constraint Dialog on the local menu. The grid also shows the following summary
columns:
Processed
Gets set to YES if the time point was correctly processed.
CTGs with Viols
Number of contingencies that presented violations (violating contingencies)
# CTGs Unsolveable
Number of unsolvable contingencies for the time point.
BC Interface Viols
Number of interface violations that were identified in the base case.
# Interface Viol
Number of interface violations.
Binding Interface
Number of binding interfaces in the OPF/SCOPF solution.
Interface Unenforceable
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Number of interfaces with unenforceable limits.
Binding Contingencies
This matrix grid shows information similar to that found on the Binding Lines and Binding Interfaces
pages. Here though the data is organized by contingencies, which allows easy identification of the
most severe contingencies. Each column of the matrix grid corresponds to a contingency. You can
access the details of the binding element by right-clicking and selecting Show Binding Constraint
Dialog on the local menu. The grid also shows the following summary columns:
Processed
Gets set to YES if the time point was correctly processed.
CTGs with Viols
Number of contingencies that presented violations (violating contingencies) .
# Line Viol
Number of transmission line and transformer thermal violations.
Binding Lines
Number of binding lines in the OPF/SCOPF solution.
Binding Interfaces
Number of binding interfaces in the OPF/SCOPF solution.
Binding Line Summary Matrix
This matrix grid shows the number of time points for which a line has been binding due to each
contingency. In this case, the rows correspond to binding lines, and the columns to violating
contingencies. The grid also shows the following summary columns:
From Number
Binding line from bus number
To Number
Binding line to bus number
Circuit
Binding line circuit ID
Total Hrs
Total number of time points for which the line was binding (in the overall simulation).
Total Hrs Unenforceable
Total number of time points for which the line constraint was unenforceable (in the overall
simulation).
Binding Line Summary List
Shows information similar to the Binding Line Summary Matrix but in form of a list. The same
line may appear several times under different contingencies. Besides the information on the
Binding Line Summary Matrix, this grid shows the following fields:
Contingency Name
Contingency that causes the line constraint to be binding
Avg MC
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Time Average MVA Marginal Cost
Max MC
Time Maximum MVA Marginal Cost
Min MC
Time Minimum MVA Marginal Cost
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Time Step Simulation: Binding Elements Dialog
This dialog is called from the Results: Constraints Page of the Time Step Simulation dialog. Right-click
on a time point record in any of the Results Summary, Binding Lines, Binding Interfaces, or Binding
Contingencies tables, and select Show Binding Constraint Dialog from the local menu. The dialog
shows the binding line and interface constraints determined by the OPF/SCOPF solution. The Time
selector allows easy navigation through the list of time points.
The grid section of the dialog shows the following:
Type
Either line or interface flow
Constraint ID
Line or Interface ID
Contingency Name
Name of the contingency under which the constraint becomes binding.
MVA Marg. Cost.
Marginal cost of enforcing the constraint. For lines, the limit corresponds to the thermal (MVA) limit.
For interfaces, it is given by a MW limit.
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Time Step Simulation: Results
The results of the Time Step Simulation are presented on the grids of the Results page. The Time Step
Simulation allows you to specify what objects (buses, lines, generators, loads, etc.) and what object
fields (bus voltage, bus LMP, gen MW, etc.) should be displayed on the results grids. This gives the
user the flexibility needed to explore the relevant results, avoiding at the same time the problem of
storing a massive amount of results, most of which may not be relevant. Storage is a critical aspect of
the Time Step Simulation, since a set of results comparable to full a PF/OPF/SCOPF solution is
generated for each timepoint.
The Results page has two sections: The top section is used to set up the options needed to customize
the results display. The grid section is used to display the actual results.
Results Page: Top Section
This section includes the following options:
View/Modify
Press this button to access the Custom Results Selection Dialog. This dialog is used to specify the
objects and object fields for which results will be stored.
Load
The custom result definitions set up in the Custom Results Selection Dialog can be saved in a
Custom Results File (*.tsc) in order to use them with different *.tsb files or Simulator cases. Press
this button to Load the results file and apply the result definitions to the current time step
simulation.
Save
Press this button to save the result definitions in a Custom Results File (*.tsc).
Group Results by
The results grids for Areas, Buses, etc. are Matrix Grids that present the time point results for each
type of object. For instance, suppose that we want to store the bus voltage magnitude and angle.
The Buses grid will show columns for the time point values of voltage magnitude and voltage angle
of selected each bus.
Objects: The columns will be grouped by objects, e.g., all the fields of bus 1, then all the fields of
bus 2, etc.
Fields: The columns will be grouped by fields, e.g. all the bus p.u. voltages, then all the bus LMPs,
etc.
Identify Results by
The results grids for Areas, Buses, etc. create one column for each object field specified in the
Custom Results Selection Dialog. The column header thus identifies the particular object for which
time point results are displayed. This identification can be made based on the object Number,
Name or Number + Name combination.
Results Page: Grid Section
This grid section is used to display the results of the Results Grids.
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Time Step Simulation: Custom Results Selection Dialog
This dialog is used to specify what objects and object fields will be stored during a Time Step
Simulation and will be displayed on the Results grids. This dialog is opened using the View/Modify
button on the Results page of the Time Step Simulation dialog.
To specify that a particular field be stored for a certain object:
1.
2.
3.

Click on the page of the object type to store (Areas, Buses, etc.)
Set to YES the Time Selected field of those objects for which you want to store information.
Click the Add/Remove Fields button to open the Select Fields dialog. Fields contained in the
Selected Fields list will be stored for each of the selected objects. To move fields between the
Available Fields and Selected Fields lists, drag the fields between lists or select fields and use the
Add and Remove buttons as appropriate. Once the fields are selected click the OK button to save
the changes and close the dialog.

Once you are done with the selections, press the Save and Close button to apply the customization.
The Results grid pages will be filled with the corresponding columns after the Time Step Simulation
starts.
Note that the actual results and the result customization will be stored in the .tsb file. For more
information about saving the Time Step Simulation results, please read the Storing Input Data and
Results section.
Fields for Areas, Buses, Generators, Injection Groups, Interfaces, Lines, Loads, Owners, Super Areas,
Switched Shunts, Transformers, and Zones can be specified to be displayed on the grids and stored in
the .tsb file.
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Time Step Simulation: Results Grids
These are the grids of the Results page that contain Time Step Simulation results based on the fields
and objects selected using the Custom Results Selection Dialog. The fields and objects must be
selected before the time step simulation run is started in order for those results to show up in the
grids.
There is one page for each type of object: Areas, Buses, Generators, Injection Groups, Interfaces,
Lines, Loads, Owners, Superareas, Switched Shunts, Transformers and Zones.
These pages are all Matrix Grids. Each column of a grid corresponds to a field of a specific object of
the power system, e.g., KV voltage of bus 1. Each row of the grid corresponds to a timepoint.
Note that you can plot the results of the grid versus the timepoint date time by right-clicking on the
grid and selecting Set/Toggle/Columns > Plot Column(s) from the local menu.
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Time Step Simulation: Options
The Options page of the Time Step Simulation dialog contains options to control how input data is
applied and how output results are presented and stored.
Area and Zone Load Scaling
In many practical studies, data of individual MW loads may not be available for all the loads in a
control area for each time point. In order to simulate load variations, Simulator allows you to specify
the Area or Zone Total MW Load values for each time point in the Area Loads and Zone Loads
pages of the Input page. Thus, the Time Step Simulation load data may be a combination of:




Areas or zones where each individual load is specified
Areas or zones where only the total MW load is known
Areas or zones where some individual loads and the total area load are known

If you have specified individual load values for a load within an area or zone that is also set to be
scaled to a total MW value, Simulator will adjust the individual load to the individual value first, and
then the load will be scaled with the rest of the loads in the area or zone to achieve the total MW
value desired for the time point. The final load will be the total value specified for the area or zone.
When time point values are specified for areas and zones within the same time step input, only one
or the other can be used. This can be set in the Use Time Point Values of option.
You can also specify in the Reactive Power Scaling option how the reactive power is treated
when the load is scaled. You can choose to have the reactive power scaled to keep the power factor
constant, or for the reactive power to remain fixed at its original value.
Solution Options
These options control the solution process.
Pause if Power Flow Does Not Solve
The simulation is stopped at the time point where a power flow solution cannot be obtained.
This is an indication of wrong data or a system brought to its loadability or transfer capability
limit.
Enable Power Flow Area Interchange Control
This option ensures that the area interchange control, if possible, is enforced in the case.
Turn generators off AGC when output changes
At each time point, generators can be adjusted by specifying Gen Actual MW values on the Input
page or as part of Injection Groups that have their injection changed on the Input page. If area
interchange is enabled for the case and associated area or super area where generation changes
have been made, this may cause the generators to move away from their values specified on the
Input pages. To prevent this, use this option to disable AGC for these generators so that they will
not move because of automatic MW control schemes.
Pricing Options
These options are available only in the OPF/SCOPF add on.
Solve Unconstrained Case
Select this option when you want an unconstrained solution to be obtained before an OPF or
SCOPF solution for each time point.
Price Hydro Generation at Marginal Cost
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During OPF and SCOPF simulations, hydro generation may experience large changes in output
due to its low marginal cost. However, hydro generation is often not as cheap if limited water
levels and dam restrictions are observed. These considerations are usually taken care of in the
hydro-thermal coordination solution, outside of Simulator. In the OPF and SCOPF solutions it is
important to assign a reasonable price to hydro generation to avoid large generation output
deviations. A common mechanism to do that is to first obtain the system marginal cost, and then
assign this cost to the hydro units.
Reset Hydro Gen Price at the End of Time Period
Choose this option to make the hydro generation price be reset for the next time point solution.
Save Binding Constraints
The binding constraints determined in the OPF/SCOPF are stored.
Time Step Simulation Options
The Time Step Simulation can be performed in two ways:
Continuous
With this option time points are solved one after another as soon as one time point finishes. The
purpose of the simulation is to obtain the solutions for all time points as quickly as possible.
Timed
With this option the solutions are simulated as they would occur in actual time. The difference in
date/time between two time points in the list defines a delay to start the solution of the next
point. A Time Scale is used to set the speed of the simulation with respect to actual time.
Suppose that you have 3 time points defined at the following date/times:
1/20/05 1:00 AM
1/20/05 2:00 AM
1/20/05 4:00 AM
Assume also that the Time Scale is 1 hour runs in 10 seconds. If you start the Timed
Simulation you would see the conditions of the first time point applied to the power system
immediately, the conditions of the second time point applied 10 seconds later, and those of the
third point applied 20 seconds after the second point. The delays on the simulation allow you to
see how the quantities evolve in actual time. In addition, you can animate the time simulation
while each time point is being solved. The visualization of the Timed Simulation is enhanced
when you use the Time Step Simulation Toolbar.
Step Type
This section of options allows you to specify if the data for each time point should be applied
only, or if the data should be applied and the load flow solved. Use Apply and Solve to apply
the input data and actually solve the power flow. Use Just Apply Data to apply the input data
and not solve the power flow. Check the Apply Input Data box to apply input data and custom
input data. This does not include scheduled data. Check the Apply Schedule Data box to apply
scheduled data.
Any pre-script or post-script commands will be applied regardless of how these options are set.
Auto Load TSB File Options (saved in case pwb file)
These are options that relate the power system case (.pwb file) to the time series binary file (.tsb
file). These options are saved with the .pwb case.
Automatically Load Default *.tsb File
The .tsb file specified in the Default *.tsb file is loaded automatically when opening the .pwb
case. If the file cannot be found, a message will be issued.
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Automatically Run Simulation after Loading *.tsb
This option is only relevant if the .tsb file was automatically loaded. This instructs the Time Step
Simulation form to start the simulation immediately following loading the .tsb file.
Automatically Set Default *.tsb File to Current *.tsb File
When leaving Simulator, the current time series information is saved in the Default *.tsb file.
Default *.tsb File
Default path and name of the *.tsb file.
Save the Default *.tsb File after Finishing the Run
If this option is checked, immediately upon finishing the simulation run, the settings and results
are saved in the Default *.tsb file.
Result Storage Options
These options allow the selection of where the results from the simulation are directed.
Store results in memory
Only store the results in the computer's random access memory (RAM). This option is prone to
running out of memory when many fields are stored over many time points.
Only store results in csv file
With this option the results are sent directly to a CSV file without filling up computer memory.
Keep in mind that when this option is chosen, the Results grids will not contain any data.
Store in memory and csv file
With this option the results will be stored both in the computer's memory and sent to CSV file.
CSV Object ID Options
When choosing to store results in a CSV file, this option will determine if the objects will be
identified by Primary key (number), Secondary key (name), or Label.
CSV File Identifier
This is a label that will be prepended to every generated CSV file if choosing to send results to
CSV. Files are generated for each result type. For example if a user is storing bus voltage and
angle, the results will be stored in a file named CSV File Identifier_Buses.csv. A separate file will
be created for each of the results types to store data of that type.
CSV Output Path
This specifies the computer or mapped network drive where the CSV results will be stored.
Auto Contouring Options
The Time Step Simulation allows you to contour quantities on the oneline diagram using Simulator
Contouring at each time point. Optionally, these contour diagrams can be saved in different formats.
No Auto Contouring
Contouring is not used during the Time Step Simulation. Although using the Timed Simulation
you can see the quantities change and the animation take place on the diagrams, the contouring
is not displayed.
Contour but Do not Save
Contouring takes place at each time point, but the diagrams are not saved.
Save in File as Bitmap
The contouring diagrams generated at each time point are saved in Bitmap format.
Save in File as JPEG
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The contouring diagrams generated at each time point are saved in JPEG format.
Contour File Name Format
The Bitmap or JPEG contouring diagrams are saved using the specified format, which includes
the time point date/time.
Run Pre-Script Command
This option allows the pre-script command to be run Before Applying Input Data or Right After
Applying Input Data. Input data includes any hourly input data and scheduled actions. With either
setting, the pre-script command is applied prior to solving the power flow solution for the time point.
Run Post-Script Command
This option allows the post-script command to be run either Before Storing Results or After Storing
Results. Running the post-script command before storing the results could be useful in situations in
which sensitivity analysis is done based on the solution of the time point and these sensitivities need
to be stored as part of the results for that time point. Running the post-script command after storing
the results could be useful in situations in which a specific control setting was used for the current
time point and needs to be restored to the original setting before moving on to the next time point.
Set Reference Case
The reference case is the case that will be restored when resetting the simulation or starting a
simulation run. The reference case is initially set to be the case in memory when Time Step
Simulation dialog is first opened. If changes are made to the case in memory while the Time Step
Simulation dialog is open and these changes need to be reflected in the reference case, click this
button to set the case that is currently in memory to be the reference case.
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Time Step Simulation: Specifying and Maintaining a List of Timepoints
The list of time points is the basis for the Time Step Simulation. Simulator will go through the list of
time points and solve each one of them in sequence. Results will be available only for those time
points specified in the list. Intervals as small as one second can define a time point.
Whether you start with an empty list or you already have time points in it, you can insert new time
points by right-clicking in the Summary page and selecting Insert New Timepoint(s). This will
bring up the New Time Point Dialog.
The list of time points will always be sorted based on the date/time shown on the Date and Time
columns in the Summary page. Thus, if you create a new time point with an intermediate date/time,
Simulator will insert it at the appropriate place in the list. If you need to change the date/time of a
time point you can right-click in the Summary grid and select Time Point records > Change
Timepoint Time to bring up the Change Timepoint Time Dialog. This dialog is similar to the New
Timepoint Dialog, with the exception that instead of specifying the date/time for a new time point, you
will be modifying the date/time of an existing time point. If the date/time matches the date/time of an
existing time point, a warning message is issued.
Each time point is linked to its results data in what is called a Timepoint Record. The Timepoint
Record contains the date and time of the time point, all the input data specified for that point, and if
any, the results that have been obtained for that time point. If you delete a time point, the entire
record is deleted with it. In order to delete the time point you can right-click in the Summary grid and
select Delete Entire Timepoint Record. Note that you can vertically select cells in this grid and
delete several time point records at a time.
Suppose that you have 1:00 AM and 3:00 AM time points that have associated with them hourly MW
load data. If you insert 2:00 AM data, the 2:00 AM cell of the MW load will appear empty. If you run a
study, no data will be applied to the power system at 2:00 AM, but you will get a result (identical to
the one of 1:00 AM). You need to fill the 2:00 AM cells with data in order for the values to be applied
at that time point and obtain the correct results for 2:00 AM.

1139
©2011 PowerWorld Corporation

Time Step Simulation: New Timepoint Dialog
The New Timepoint Dialog is used to define new time points for a Time Step Simulation. This dialog is
accessed from the Time Step Simulation dialog by right-clicking on any of the grids that displays time
points and selecting Insert New Timepoint(s) from the local menu or clicking the Insert Time
Points button at the top of the dialog. One or multiple time points can be defined at once. Use the
date drop-down box to bring up a calendar for easy selection of the date. Note that the calendar has
visual controls that allow you to navigate through months or years, which allows you to set the desired
date easily.
If this is the first time point you will insert in the list, by default the dialog is populated with today’s
date at 12:00 AM. If there are other points in the list, the default is one hour after the date/time of the
last time point.
The other options in this dialog are:
Date
Use this control to select the date of the time point. You can use the visual controls or the up or
down arrow keys to modify the date.
Time
Use the control to enter the hour, minute, second, and AM/PM description of the time. Once you are
positioned on the hour, minute, second, or AM/PM values, you can use the up/down arrow buttons
for easy selection without having to type. Note that the time points are specified with a precision of
up to 1 second.
Total Number of Timepoints to Enter
By default this field is set to 24, meaning that you will enter an entire day's worth of time points with
the specified date and time if the interval is left at the default specification of one hour.
New Timepoint Interval: Hours
If the Total Number of Timepoints to Enter is more than one, this field is used to specify the
hour(s) of the interval between each time point. Time points will be Hours + Minutes + Seconds
apart. Default is one hour.
New Timepoint Interval: Minutes
If the Total Number of Timepoints to Enter is more than one, this field is used to specify the
minute(s) of the interval between each time point. Time points will be Hours + Minutes + Seconds
apart. Default is zero minutes.
New Timepoint Interval: Seconds
If the Total Number of Timepoints to Enter is more than one, this field is used to specify the
second(s) of the interval between each time point. Time points will be Hours + Minutes + Seconds
apart. Default is zero minutes.
OK, Cancel
Click OK to close the dialog and insert the specified time points. Click Cancel to close the dialog and
abandon any changes.
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Time Step Simulation: Change Timepoint Time Dialog
The Change Timepoint Time Dialog is used to modify the date/time of a time point for the Time Step
Simulation. Only one time point time can be changed at a time. If the new time assigned to the time
point already exists, a warning message is generated prompting for the input of a different date/time.
If the new date/time does not exist, the time point will be moved to the correct position in the time
point list.
The Change Timepoint Time Dialog is accessed by right-clicking on any of the Summary, Input, and
Results Time Step Simulation pages that list the time point date/time and choosing Time Point
records > Change Timepoint Time from the local menu.
Date
Click the calendar icon to use the calendar control to select the date of the time point. You can also
position the mouse cursor over the month, day, or year and use the up/down keys on the keyboard
to adjust these fields.
Time
Use the control to enter the hour, minute, seconds and AM/PM description of the time. Once the
mouse cursor is positioned on the hour, minute, seconds or AM/PM value, you can use the up/down
keys on the keyboard for easy selection without having to type. Note that the time points are
specified with a precision of up to 1 second.
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Time Step Simulation: TSB Case Description
This page is used to describe the time series binary file (.tsb file) for informational purposes. Use the
memo box that comprises most of this page to comment on the case, .tsb file, time step simulation, or
anything else that is relevant. These comments will be stored with the .tsb file. The Version Used to
Store the TSB File and the Simulator Build Dateare also provided.

1142
©2011 PowerWorld Corporation

Time Step Simulation: Insert/Scale Column Dialog
The Insert/Scale Column Dialog is opened from the Input page grids of the Time Step Simulation
dialog. These matrix grids are used to specify input data for MW Loads, Mvar Loads, Generator MW,
Generator Maximum MW, Area Loads, Zone Loads, and Injection Groups. Time point data for each
particular object is specified in columns. When no column has been added to the grid, the Insert/Scale
Column Dialog allows you only to select the new object. When there are existing columns on the grid,
the dialog allows you to insert a New Column either alone or based on the values of the existing
columns. This option is available because values such as load MW data tend to experience similar
fluctuations in time.
Current Column
If there are existing columns and the Insert/Scale Column Dialog is called from one of these existing
input data columns, this field shows the position of that column. This field tells the user what column
the New Column will be based on.
Action
These options determine how the new column will be inserted.
Scale Entire Current Column
This option is available only when the current column corresponds to an existing input data
column. When applied, the new column takes the values of the current column scaled by the
Scaling Factor.
Scale Selected Rows of Current Column
This option allows you to select a group of contiguous rows of a column and scale only those
rows of the Current Column by the Scaling Factor.
Insert New Column Derived from Current Column
This option applies the Scaling Factor to the values of the of the Current Column and uses
these scaled values to populate the New Column.
Scaling Factor
Factor used for scaling the current column, selected rows of the current column, or inserting a
new column derived from the current column.
Load Scaling
These options are available only when inserting Load columns and are used to scale Real and
Reactive Load, Just Real Load, or Just Reactive Load.
New Columns Selector
Use this selector to specify the ID of the object(s) that will be added as new column(s) to the grid.
The bottom section of the dialog is a selector that allows you to specify one or multiple objects at a
time and add columns for them by passing the objects from the left list to the right list. All of the
options available with the selector may not be shown by default. Click on the down arrow located to
the left of the Sort by option to open the menu that allows selection of which options to display. This
selector has the following options:
Sort by Name
Check this option to sort the list of available objects by name
Sort by Number
Check this option to sort the list of available objects by number
Define/Find Filter
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Press this button to filter the list of available objects using an Advanced Filter.
Use Area/Zone Filters
Check this box to filter the list of available objects using the Area/Zone filters.
Search Next/Search All
By typing the start of the name of an object in the edit line, you can search the next object or all
the objects available that match the search pattern. You can also use wildcards to search for
objects.
List of Objects
The objects in the list are selected by clicking on them. Multiple objects that are together can be
selected by clicking the mouse while holding the SHIFT key. Multiple objects that are not
contiguous in the list can be selected by clicking the mouse while holding the CTRL key.
Select All/Clear All
Use these buttons to select or clear all items selected in the list of objects.
Select Button
Press the blue arrow button to pass the selected objects from the left list to the right list.
Remove Button
Press the trash can button to remove the objects selected in the right list.
For more information about methods to specify input data, please read the Loading Input Data
section.
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Time Step Simulation: Loading Input Data
The Time Step Simulation allows you to specify the operating conditions of your power system through
input data. The input data can be of two types:
Scheduled Data, which is specified for data that more naturally spans multiple time points rather
than being defined at each time point. To set up scheduled data see the Setting up Scheduled Input
Data section.
Time Point-Based Data is specified for each time point in the Input pages. There are several ways
to specify input data:





By entering data manually on the Input pages.
By deriving or scaling values from another column using the Insert/Scale Column Dialog.
By loading previously formatted data from Excel or .csv files through the Read Buttons in the
Time Step Simulation Dialog.
By pasting data from Excel directly to the grid. A common way to do that is to:
o Set up the desired time points and data columns on the grids of the Input pages
o Copy the template to Excel by right-clicking and selecting Copy/Paste/Send > Send All
to Excel on the local menu
o Fill the Excel sheet with the appropriate data
o Paste the data back to the data grid by selecting and copying it in the Excel sheet, including
the column headers, and then right-clicking on the grid back in Simulator and selecting
Copy/Paste/Send > Paste on the local menu
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Time Step Simulation: Setting up Scheduled Input Data
There area two types of input data for the Time Step Simulation:
Time Point-Based Data, which is described in the Loading Input Data section; and,
Scheduled Data, which is specified for data that more naturally spans multiple time points rather
than being defined at each time point. In this section we describe how to specify this type of input
data.
Although it is possible to specify the operating conditions of a power system exclusively by quantities
at each time point, there are several quantities whose specification would be redundant and would
require significant memory storage if defined in this manner. Examples of such quantities are:









The status of a transmission line that is taken out of service on a particular date and time for
maintenance.
The status of a generator, which follows a particular maintenance schedule.
A generator’s voltage set point that is different during the day or at night.
A scheduled transaction between to areas that has different MW set points applied at 10 am, 4 pm
and 10 pm.
A capacitor connection status for a Mvar block that is used only during the day.
An industrial load that operates at different levels for different shifts.
A peaker generating unit that operates only during certain hours of the day
Any many others

All of these quantities can be specified by introducing the concept of Schedule. A schedule is a list of
pairs (Date Time, Value), where the value can be numerical, conditional (Yes/No or Closed/Open) or
text. The Schedule can have any number of time points and can be periodic. The schedule defines the
"shape" of how a quantity varies in time. In order to define a schedule, go to the Schedules sub-page
of the Input page, right-click on the grid and select Insert New Schedule to bring up the Schedule
Dialog.
Once a schedule has been created, we can assign an object field, such as the status of a transmission
line or the MW output of a generator to the schedule by means of a Schedule Subscription. The
object field will follow the schedule "shape" in time. The use of Schedule and Schedule Subscription
objects gives us great flexibility in specifying how quantities should vary. In particular, it is possible to
assign many fields to the same schedule. In order to define a Schedule Subscription, go to the
Sched Subscriptions sub-page of the Input page, and right-click on the grid and select Insert New
Subscription to bring up the Schedule Subscription Dialog.
An important feature of the Schedules is that their date/times do not need to match the date/times of
the list of time points (time points listed in the Summary page). Suppose that your list of time points
are defined hourly for the next day: 1am, 2am, etc. up to 11pm. You can schedule a particular action
to take place at 2:35 am and see the results of that action in the next time point, i.e., 3 am. A special
logic takes care of applying scheduled actions at appropriate time points asynchronously.
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Time Step Simulation: Schedule Dialog
The Schedule Dialog is opened from the Schedules page of the Time Step Simulation dialog by rightclicking on the Schedules grid and choosing Insert New Schedule or Show Dialog for an existing
schedule. This dialog is used to define or modify a schedule. A schedule is a list of time points together
with a numeric, conditional (Yes/No or Closed/Open) or text value that defines the "shape" of how a
quantity should vary in time. The time points are listed on the grid section of the dialog. The dialog
also contains a number of options that define the schedule.
When a schedule is created, the time step simulation inserts by default four time points for the current
date with a numeric value of zero in every point. You can then change the date and times of the
schedule time points and specify different values.
Schedule Dialog Local Menu Actions
The Schedule Dialog grid, as with any other Simulator grid has a local menu that is accessed by rightclicking on any cell. The most important options of this local menu are:
Insert New Point(s)
Select this option to bring up the New Schedule Point Dialog. This is the same at the New Time
Point Dialog but is used here to insert Schedule time points.
SchedPoint records > Change Time
Select this option if you want to change the date/time of a schedule time point. The selection brings
up the Change Time Dialog, which is the same Change Timepoint Time Dialog used here to
change the date/time of a schedule time point.
Delete
Use this option to delete the current schedule time point.
Set/Toggle/Columns > Select Column(s)
Use this option to select an entire column. Note that you can use this option and then delete all the
time points.
Copy/Paste/Send > Send All to Excel
Use this option to copy the values in the Schedule grid to Excel. You can then easily modify the
values using Excel and then Paste back the new schedule points into Simulator.
Timepoint List Options
These options provide shortcuts to some of the local menu actions related to the maintenance of the
list of Schedule time points:
Add Point
Adds a new time point at the end of the list. By default the date/time of the new time point is one
hour after the last time point. If there are no time points in the list, a time point is inserted with
today’s date at 12:00 AM.
Delete Point
Deletes the selected time point(s).
Shift Date Time Buttons
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Use these buttons to move by one week, day, hour, minute or second the date time of the selected
time point.
Schedule Options
The upper part of the Schedule Dialog is used to define other schedule options:
Schedule Name
Enter the name you want to give to the schedule. This is how you will identify the schedule when
you set up schedule subscriptions. If the user does not specify otherwise, Simulator assigns names
Sched1, Sched2, etc. as new schedules are created.
Name Suffix
This is a string automatically generated by Simulator, which is used to display the main
characteristics of the Schedule together with the name. The Name Suffix is composed of three
strings separated by periods:
[Num, Y/N, or Txt]: Indicates whether the schedule values are numeric, conditional or text.
[NPER or PERadbhcmds]: The string indicates whether the schedule is non-periodic (NPER) or
periodic (PER). If it is periodic, it indicates the days (a), hours (b), minutes (c), and seconds (d) of
the period.
[Nn]: Indicates the number of time points (n) of the Schedule.
By looking at the Schedule suffix, the user effectively avoids writing long names for the Schedule to
characterize its properties.
Value Type

Numeric, conditional (Yes/No or Closed/Open) or Text. When you toggle this selection, the value
column in the Schedule grid changes its heading from Numerical Value to Yes/No Value to Text
Value, and the numerical cells (blue) are changed to Yes/No cells (green), indicating that you can
toggle the cell value, to blank for Text Value. Note that numeric fields, such as Load MW, Schedule
Transactions MW etc., will subscribe to a Numeric Schedule, whereas fields such as Line Status will
subscribe to a Yes/No Schedule. Text schedules can be subscribed to custom string and memo
fields. For more details on how to subscribe to schedules, see the Schedule Subscriptions topic.
Interpolate Values Between Time Points
The purpose of creating a schedule is to modify data that does not need to be defined for each
individual Time Step Simulation time point. When this option is checked, the value for a schedule will
be interpolated for the current time point based on the values specified for the schedule time points.
Apply Schedule Points as Events
When this option is checked, schedule values will only be applied if the time point matches the
schedule time point. The values will not change for time points that do not match a schedule time
point. For example, assume that a schedule has time points at 6:00 AM with a value of 50 and 11:00
AM with a value of 75. Assume that a generator is subscribed to this schedule. Also, assume that the
time step simulation contains time points for every hour between 1:00 AM and 11:00 PM. For the
time points between 1:00 AM and 5:00 AM the output of the generator will remain at what is was in
the base case, unless of course there is some other input data that changes the output of this
generator. If there is some other input or manual intervention that changes the output of the
generator, the output of the generator will not be changed again by the schedule until 6:00 AM. At
6:00 AM the output of the generator will change to 50. At 7:00 AM the output of the generator will
not be updated and remain at 50, unless the output of the generator is changed by some other
input or manual intervention. The same is true for time points 8:00 AM through 10:00 AM. At 11:00
AM the output of the generator will change to 75 because of the schedule.
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When this option is not checked, the schedule will be applied at every time point. Assume the same
example as above. For the time points between 1:00 AM and 5:00 AM the output of the generator
will not be impacted by the schedule. At 6:00 AM the schedule will be applied and the output of the
generator will change to 50. At 7:00 AM the schedule will be applied again and the output will again
be set to 50. The same thing will occur at the time points between 8:00 AM and 10:00 AM. At 11:00
AM the schedule will be applied and the output will change to 75. At each time point after 11:00 AM
the schedule will be applied at the output will change to 75. This means that if some other input or
manual intervention causes the output of the generator to change between time points, at each time
point the schedule will be applied and the output of the generator will be updated to match the
schedule.
Periodic Options
A schedule becomes periodic when its values are repeated every certain period specified in days,
hours, minutes and/or seconds. A logic condition for a schedule to be periodic is that its period be
larger than the time span between the date/time of the last time point and the first time point in the
schedule. For instance, if the schedule has three time points at 1:00 AM, 2:00 AM and 4:00 AM, the
span is 3 hours. Thus the schedule period must be 4 hours or more. If this condition does not hold,
Simulator issues a warning message.
Repeat Every
Check this box to make the schedule periodic. The schedule must have a total period greater than 0
to be considered periodic. The schedule period is the number of days plus the number of hour plus
the number of hours plus the number of seconds specified.
Days
A positive integer that specifies the number of days of the schedule period.
Hours
A positive integer from 0 to 23 that specifies the number of hours of the schedule period.
Minutes
A positive integer from 0 to 59 that specifies the number of minutes of the scheduled period.
Seconds
A positive integer from 0 to 59 that specifies the number of seconds of the scheduled period.
Valid From
When checked, this option sets a validity date for the schedule, whether it is periodic or not. No
schedule actions will be applied to the power system before this date. By default, the Valid From
date is set to Jan 01, 2000, at 12:00 AM.
Valid Until
When checked, this option sets a validity date for the schedule, whether it is periodic or not. No
schedule actions will be applied to the power system after this date. By default, the Valid Until date
is set to Dec 31, 2030, at 12:00 AM.
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Time Step Simulation: Schedules
The Schedules sub-page of the Time Step Simulation dialog Input page is used to display all of the
defined schedules and their properties. Schedules are used to define input which is specified for data
that more naturally spans multiple time points rather than being defined at each time point. Schedules
define the "shape" of how a quantity should vary in time.
The most relevant options of the local menu, obtained by right-clicking on the grid of this page are:
Schedules Page Local Menu Actions
Insert New Schedule
Selecting this option will open the Schedule Dialog which allows the definition of a new schedule.
Delete
Select this option to delete the current Schedule.
Show Dialog
Select this option to bring up the Schedule Dialog with the information of the current Schedule.
Schedule Page Fields
The Schedules sub-page contains the following information about schedules:
Name
Name of the schedule.
Suffix
Schedule suffix used to provide a short-hand description of how the schedule is defined. For a
description on how the suffix is created, please see the Schedule Dialog section.
Periodic
Indicates whether or not the schedule periodically repeats for a specified period of time (defined in
days, hours, minutes, and/or seconds).
Period Days, Hours, Minutes, and Seconds
If the schedule is periodic, number of days, hours, minutes, and seconds in the schedule period.
Valid From
Set this to YES if the schedule is valid only from a specified starting date/time.
Period Start Date
If specifying a start date/time from which the schedule is valid, this is the start date.
Period Start Hour
If specifying a start date/time from which the schedule is valid, this is the start time.
Valid Until
Set this to YES if the schedule is valid only up to a specified ending date/time.
Period End Date
If specifying an end date/time up to which the schedule is valid, this is the end date.
Period End Hour
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If specifying an end date/time up to which the schedule is valid, this is the end time.
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Time Step Simulation: Schedule Subscription Dialog
This dialog is used to define and display the options of a Schedule Subscription. Schedule
Subscriptions tell the Time Step Simulation that a specific object field (Gen MW, Line Status, Scheduled
Transaction MW, etc.) should vary according to the "shape" specified in a Schedule. This dialog can be
accessed from the local menu of the Schedule Subscriptions page of the Time Step Simulation dialog.
Simulator objects have a large number of fields, which can be classified as numeric, boolean, or text.
Numeric fields, whether integer or real, can subscribe to Numeric Schedules, boolean fields can
subscribe to Yes/No Schedules, and text fields can subscribe to Text Schedules. Thus, a condition for a
field to subscribe to a schedule is that a schedule of its type be already defined.
The dialog includes the following options:
Active
Indicates that the schedule subscription is active. If this box is not checked, the schedule
subscription is defined, but no schedule action will be applied to the power system.
Object Type
Use this selector to specify the object type that you want to subscribe to a schedule. Currently,
Simulator supports Generators, Loads, Line/Transformers, Shunts, Areas, Transactions, Zones,
Interfaces, and DC Lines. When you select an Object Type, three things happen:




The Object ID list is populated with the elements of the object type present in the power flow
case and the first element is displayed by default.
The Field selector is populated with the enterable fields corresponding to that particular Object
Type and the first field is displayed by default.
The type of the first field (Numeric, Yes/No or Text) is identified and the Schedule selector is
populated with the existing schedules of that type.

Object ID
Use this selector to specify the particular object of a particular Object Type whose field you want to
subscribe to a schedule. The Object ID has above it a string that indicates how the ID of the object
is built depending on the Object Type. For instance, when the Object Type is Generator, the
Object ID is specified as the Bus Number and then the Gen ID.
Select/View Objects
Press this button to bring up the Add Schedule Subscribers Dialog. This dialog is used to select
multiple objects of the specified type, for which a field will subscribe to the schedule. When multiple
objects are selected, the Object ID indicates "Multiple Objects" followed by the number of objects
that will be selected. If there are objects whose fields are subscribed to a schedule, these objects
will appear in the right side selection list, because they are currently subscribing to the schedule.
Field
Use this selector to indicate the particular Field that you want to subscribe to a schedule.
Depending on the type, the Dialog indicates whether the Field should subscribe to a Numeric,
Yes/No, or Text schedule. Once you have selected the Field, the Schedule selector is populated
only with the schedules of that particular type.
Schedule
Use this selector to specify the schedule to which the Field should be subscribed.
Time Shift
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The time shift options can be used to Delay or Advance applying the scheduled actions by the
specified Delay Days, Delay Hours, Delay Minutes, or Delay Seconds. For instance, suppose
that you have setup a schedule so that a new 100 MW generating unit enters online on March 10 th.
The entering schedule is complex and consists of increasing the output in steps of 20 MW each hour
starting at 10 am. Suppose that due to unexpected events, the connection of the unit must be put
off by two days. Instead of modifying the entire schedule, you could set a 2 day Delay so that the
unit enters online on March 12th at 10 am.
If instead the new unit can go online ahead of schedule on March 8 th, the Time Shift can be set to
Advance for 2 days so that the unit will go online earlier.
Subscription Type
In addition to the time shift, the value "shape" defined by a numeric schedule can be altered by
making the subscription Relative.
Absolute
Select this option so that the field takes the exact value specified in the schedule.
Relative
The numeric values of the schedule can be altered by a Multiplier and a Value Shift. In this
linear modification, the value of the field that is applied to the power system will be equal to:
Actual Field Value = Multiplier * Schedule Value + Value Shift
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Time Step Simulation: Schedule Subscriptions Page
This sub-page is found on the Input page of the Time Step Simulation dialog and is used to display all
of the schedule subscriptions and their properties. Once a schedule has been created, we can assign
an object field, such as the status of a transmission line or the MW output of a generator to the
schedule by means of a Schedule Subscription. The object field will follow the schedule "shape" in
time. The use of Schedule and Schedule Subscription objects gives us great flexibility in specifying how
quantities should vary.
The most relevant options of the local menu, obtained by right-clicking on the grid of this page are:
Schedule Subscriptions Page Local Menu Actions
Insert New Subscription
Use this option to define a new schedule subscription through the Schedule Subscription Dialog.
Delete
This option deletes the current schedule subscription.
Show Dialog
This option brings up the Schedule Subscription Dialog with the information of the current schedule
subscription.
Schedule Subscriptions Page Fields
The Schedule Subscriptions Page shows the following information:
Object
Object Type: Generator, Load, Line/Transformer, Shunt, Area, Transaction, Zone, Interface, or DC
Line
Object IDs
Are explained in the following table:
Object Type

Object ID1

Object ID2

Object ID3

(Numeric)

Numeric

String[2]

Generator

Bus Number

Gen ID

Load

Bus Number

Load ID

Line/Transfor
mer

From Bus
Number

Shunt

Bus Number

Area

Area Number

Transaction

From Area
Number

Zone

Zone Number

Interface

Interface
Number

DC Line

Rectifier

To Bus Number

Shunt ID
To Area Number

ID

Inverter

ID
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Circuit ID

Number

Number

Object Field
Field that subscribes to the schedule.
Schedule Name
Name portion of the schedule name and suffix identifier.
Schedule Suffix
Suffix portion of the schedule name and suffix identifier.
Active
Set this to YES so that the schedule values will actually be applied to the power system.
Relative
If this is NO the field takes the exact schedule values. If this is YES the schedule takes the value of
the schedule scaled by a multiplier plus Value Shift.
Multiplier
Scaling factor used when the subscription is Relative.
Value Shift
Shift value used when the subscription is Relative.
Delay/Advance?
Indicates if the schedule should be delayed or advanced to a new point indicated by the shift values.
A delay will cause the schedule to start later in time. An advance will cause the schedule to start
earlier in time. See the Schedule Subscription Dialog for more details on this option.
Day Shift
Number of days of the schedule time delay/advance.
Hour Shift
Number of hours of the schedule time delay/advance.
Minute Shift
Number of minutes of the schedule time delay/advance.
Second Shift
Number of seconds of the schedule time delay/advance.
Schedule Subscriptions can be saved and loaded from auxiliary files using options found on the local
menu obtained by right-clicking on the table or using the case information toolbar.

1155
©2011 PowerWorld Corporation

Time Step Simulation: Application of Controller Time Delays
During a Time Step Simulation run, special control actions can be implemented for transformers and
switched shunts. These control actions allow time delays to be used so that a specified period of time
passes, while a device is outside of its regulation range, before that device can implement a control
change that will attempt to bring the device back within its regulation range. Multiple transformers and
switched shunts can be on this type of control.
In addition to transformers and switched shunts that allow switching time delays during a time step
simulation run, there are special Time Step Actions that can be utilized during a time step simulation
run. Time Step Actions perform some action (e.g. opening a branch, moving load, changing generator
output, etc.) once a specified Model Criteria evaluates to true and remains true for the specified time
delay.
Time delays will only be used in a time step simulation if doing a complete time step simulation run. A
complete run is one that is started using the Do Run button on the Time Step Simulation dialog and is
allowed to run to completion without running any time steps out of order or repeating time steps. If
not doing a complete time step simulation run, any transformers and switched shunts that model time
delays will ignore the time delay settings and operate based on all other relevant control settings and
Time Step Actions will be ignored.
When doing a complete time step simulation run, application of time delays fits into the time step
simulation process in the following manner:





Start the time step simulation by clicking the Do Run button on the Time Step Simulation dialog
Initialize time delay objects and check for data errors
 If any data errors result, provide user option to continue with Simulator fixing the errors or abort
the run so that the user can fix the errors
 Transformers and switched shunts that are modeling switching delays are turned off automatic
control so that they will not move during the power flow solutions
Process a time point
 If applying pre-script command before applying input data, run pre-script command
 If Apply Input Data
 Update loads, MW and Mvar
 Update generators, MW and Max MW
 Update line statuses
 Update area loads, MW and Mvar
 Update zone loads, MW and Mvar
 Update injection group injections
 Apply custom inputs
 If Apply Schedule Data
 Apply schedule actions
 If Input Data and Schedule Data can be applied with no errors or not applying these at all
 If applying pre-script command after applying input data, run pre-script command
 If choosing to Apply and Solve
 Solve power flow
 If successful power flow solution
 If any objects modeling time delay, check for time delay implementation
 Transformers
 Switched Shunts
 Time Step Actions
 If any system changes, solve power flow
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If still successful power flow solution (time delay actions implemented and power
flow solves or no time delay actions implemented)
 If Solution Type <> Single Solution, run unconstrained OPF, OPF, or SCOPF
 If Run Contingencies = YES, run contingency analysis
 If applying post-script command before storing results, run post-script command
 Store results
 If applying post-script command after storing results, run post-script command
Continue processing time points until all completed
Restore time delay objects to original control modes
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Switched Shunt Control: Time Step Options
Switched Shunt Time Step Options are found on the Time Step Options subtab of the Control
Options tab of the Switched Shunt Information dialog in either Edit mode or Run mode. These options
can be modified if the switched shunt is on either discrete or continuous automatic control. The
options are only used as part of the Time Step Simulation tool.
These options allow the specification of time delays between the time when a switched shunt is
considered in violation of its regulation range and the time when the switched shunt nominal Mvar is
changed by stepping through Mvar blocks in an attempt to bring the switched shunt back within its
regulation range. Because time delays are involved, it is only possible in Simulator to use this type of
control during a Time Step Simulation when there is an accounting of system changes over time.
The options described below dictate how an individual switched shunt using time delays will be
evaluated during a time step simulation. For a description of the overall process of how switching time
delays and time delay actions are applied during a time step simulation run, see the Time Step
Simulation: Application of Controller Time Delays topic.
The following options are available for specifying switched shunt time delays:
Model Switching Delay in Time Step Simulation
Check this box to use the time delay during a time step simulation AND indicate that this switched
shunt should be on control during the time step simulation. Simulator only allows one switched
shunt at a given bus to be on automatic control. During the time step simulation, multiple shunts are
allowed to be on control, but some special handling must be done for this to happen. For a switched
shunt to be on control during the time step simulation, at least one switched shunt at its bus must
have its Control Mode set to Discrete or Continuousand that switched shunt must also have its
Model Switching Delay in Time Step Simulation option checked. All of the other switched
shunts must have their Control Mode set to Fixed. Fixed switched shunts that also have their Model
Switching Delay in Time Step Simulation option checked will be on control during the time step
simulation. The control mode for the switched shunt that is not fixed will dictate the control mode
for all of the fixed switched shunts during the time step simulation. If a switched shunt is allowed to
be on control during the time step simulation and a time step simulation is processing, the switched
shunt nominal Mvar setting will only be allowed to change (step through Mvar blocks) if the switched
shunt is violating its regulation range for the specified period of time. During a power flow solution
outside of the time step simulation, the switched shunt will operate in the usual manner based on all
relevant control settings without implementing any time delay in the switching.
When this box is not checked, the switched shunt will operate in the usual manner based on all
relevant control settings without implementing any time delay in the switching during the time step
simulation and any power flow solutions outside of the time step simulation.
During the time step simulation, switched shunt switching delays will only be implemented if doing a
complete time step simulation run. A complete run is one that is started using the Do Run button on
the Time Step Simulation dialog and is allowed to run to completion without running any time steps
out of order or repeating time steps.
The Regulation Low Value and High Value specified on the Parameters tab of the Switched Shunt
Information dialog are used to define the primary regulation range when modeling a switching
delay.
At each time step, the regulated value of the switched shunt will be checked to determine if it falls
outside of the regulation range. If so, a timer will be started to determine how long the value is
outside of the regulation range. If the timer has already been started and the regulated value is still
outside and on the same side of the regulation range, the appropriate time delay, as described
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below, will be used to determine if the switched shunt has been outside its regulation range for the
specified amount of time and is now allowed to start stepping through Mvar blocks to bring the
regulated value back in range. Once the switched shunt is allowed to start switching, the timer will
be reset and the appropriate time delay will be used to determine when the next move can occur if
the regulated value continues to remain outside the regulation range and on the same side of the
range. Once the regulated value falls inside the regulation range or the regulated value switches
sides of the regulation range, the timer will be reset.
Maximum Steps to Move
Once a switched shunt has been outside of its regulation range for the specified period of time
and is actually allowed to switch, this is the maximum amount of steps that it is allowed to move
at the current time step even if additional steps would be required to bring the switched shunt
back within its regulation range.
First Move Delay (Below and Above) (secs.)
These two options specify the amount of time to wait in seconds before the switched shunt is
allowed to switch if its regulated value falls outside of the regulation range. These values must
be specified in whole seconds with the minimum delay being 1. These delays are used when the
regulated value first falls outside its regulation range and the switched shunt has not started to
switch. Once the switched shunt has started to switch, but the regulated value still remains
outside its regulation range on the same side of the range and needs to continue stepping
through Mvar blocks, the Next Move Delays will be used. Once the regulated value falls inside the
regulation range or the regulated value switches sides of the range (i.e. it was below the range
and is now above), the First Move Delays will be used if the regulated value again falls outside
the regulation range.
The Below entry specifies the delay to use when the regulated value is below the regulation
range. The Above entry specifies the delay to use when the regulated value is above the
regulation range.
Next Move Delay (Below and Above) (secs.)
These two options specify the amount of time to wait in seconds before the switched shunt is
allowed to switch if its regulated value falls outside of the regulation range. These values must
be specified in whole seconds with the minimum delay being 1. These delays are used once the
switched shunt has started to switch but the regulated value remains outside of the regulation
range on the same side of the range and needs to continue stepping through Mvar blocks. The
Next Move Delay will continue to be used for subsequent delays as long as the regulated value
remains outside of and on the same side of the regulation range. Once the regulated value falls
inside the regulation range or the regulated value switches sides of the range, the First Move
Delays will be used if the regulated value again falls outside of the regulation range.
The Below entry specifies the delay to use when the regulated value is below the regulation
range. The Above entry specifies the delay to use when the regulated value is above the
regulation range.
Use Secondary Regulation Range
Check this box to specify a secondary regulation range that is different than the primary range
specified with the switched shunt. The secondary range can only be used if the primary range is also
used (i.e. Model Switching Delay in Time Step Simulation is checked). The expectation is that this
range will be larger and the delays would be shorter to model the fact that the controls will act more
quickly to a very large deviation.
To properly define the regulation ranges, one of the ranges must be completely contained within the
other range. This is necessary to prevent conflicting control actions in which one range would
require nominal Mvar changes to increase the regulated value while another range would require
nominal Mvar changes to decrease the regulated value.
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The secondary regulation range works somewhat independently of the primary regulation range. At
each time step, the secondary regulation range is checked first. If the regulated value falls outside
of the secondary regulation range, a timer is started for the secondary regulation range. If the timer
for the secondary regulation range has already been started, the regulated value is still outside of
the secondary regulation range and on the same side of the range, and the appropriate secondary
time delay is met such that the switched shunt is allowed to switch, the timers for both the primary
and secondary regulation ranges are reset and whether or not the primary regulation range is
violated is not checked at that time step. If the secondary regulation range timer has not exceeded
the appropriate time delay or the regulated value is within the secondary regulation range, the
primary regulation range is checked to see if the regulated value is outside of that range. If the
regulated value falls outside of the primary regulation range, a timer is started for the primary
regulation range. If the timer for the primary regulation range has already been started, the
regulated value is still outside of the primary regulation range and on the same side of the range,
and the appropriate primary time delay is met such that the switched shunt is allowed to switch, the
timers for both the primary and secondary regulation ranges will be reset. Once the switched shunt
has started stepping through Mvar blocks for either of the regulation ranges and continues to remain
outside one or both regulation ranges and on the same side of the appropriate range, the Next Move
Delay, appropriate for the given range, will be used by both ranges to determine when the next
move can occur.
Secondary Minimum and Secondary Maximum
Use these fields to specify the secondary regulation range.
Secondary Max Steps to Move
Once a switched shunt has been outside of its secondary regulation range for the specified
period of time and is actually allowed to switch, this is the maximum amount of steps that it is
allowed to move at the current time step even if additional steps would be required to bring the
switched shunt back within its secondary regulation range.
Sec. First Move Delay (Below and Above) (secs.)
When using the secondary regulation range, define the time delays in the same manner as
described above for the primary regulation range in First Move Delay (Below and Above)
(secs.).
Sec. Next Move Delay (Below and Above) (secs.)
When using the secondary regulation range, define the time delays in the same manner as
described above for the primary regulation range in Next Move Delay (Below and Above)
(secs.).
Processing Switched Shunts
At each time step, all switched shunts that are allowed to be on control during the time step
simulation are processed to determine if their regulated values are outside of their regulation range.
If they are and the time delay has been met such that the switched shunt is allowed to switch in an
attempt to bring the regulated value back inside the regulation range, that switched shunt is marked
for further processing. The options specified above determine the outcome of this initial check.
Further processing marches through the list of switched shunts that are allowed to switch one-byone. They are processed in the order of ascending bus number with only one switched shunt at a
bus allowed to be on control at a time. If there are multiple switched shunts at a bus that are
allowed to be on control during the time step simulation, these are processed one-by-one in iterative
steps. For each iteration of this process, the one switched shunt at each bus that is allowed to be on
control will be checked to determine if its regulated value is still outside of its regulation range and
adjust its Mvar injection if necessary. If any adjustments are made, an estimate is made of any
impact on system voltages and the voltages are updated before the next switched shunt in the list is
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processed. In this way, an estimate is made of the impact that one switched shunt adjustment has
on the others. This process is repeated with only one switched shunt at a given bus allowed to be on
control at a time until all switched shunts that are allowed to be on control during the time step
simulation have been processed.
As an example, assume that at a given time step there are 6 switched shunts with regulated values
outside of their regulation ranges and the necessary time delays have passed so that an attempt
needs to be made to adjust these switched shunts to bring the regulated values back in range.
Shunt A is at bus 1, shunts B and C are at bus 2, and Shunts D, E, and F are at bus 3. All shunts
that are not being processed because of their time delay being met are set to be on fixed control.
Shunts A, B, and D are set to their specified control mode while shunts C, E, and F are set to fixed.
The shunts on control are then processed in the manner described above that determines the shunt
adjustments and estimates new voltages. Shunts C, E, and F still have not been processed. Shunts
A, B, and D are set to fixed with shunts C and E being set to their specified control modes. These
shunts are then processed in the order of ascending bus number as described above. At the next
iteration, all of the shunts are fixed except shunt F. This process will continue with only a single
shunt at a given bus on control until all shunts that have met their time delay have been processed.
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Time Step Actions
Time Step Actions are special actions that can be implemented during a Time Step Simulation run.
These actions are very similar to contingency actions except that a model criteria and time delay must
be specified. During a time step simulation run, a time step action will be implemented if is model
criteria evaluates to true for the specified time delay.
At each time step, the model criteria for a time step action is evaluated. If it evaluates to true, a timer
is started to determine how long the model criteria evaluates to true. If at any time step the model
criteria evaluates to false, the timer will be stopped. If the timer has already been started, the model
criteria still evaluates to true, and the specified time delay has been met or exceeded, the action will
be implemented. Once a time step action is implemented during a time step simulation run, the action
cannot be implemented again for the duration of that time step simulation run.
During the time step simulation, time step actions will only be evaluated and implemented if doing a
complete time step simulation run. A complete run is one that is started using the Do Run button on
the Time Step Simulation dialog and is allowed to run to completion without running any time steps
out of order or repeating time steps. Time step actions are not currently used with any other tools.
The above describes how an individual time step action will be evaluated during a time step simulation
run. For a description of the overall process of how switching time delays and time delay actions are
applied during a time step simulation run, see the Time Step Simulation: Application of Time Delays
topic.
Time step actions can be created or modified by accessing the Time Step Actions display available on
the Model Explorer in the Solution Details folder or the Input page of the Time Step Simulation dialog.
This display is a type of Case Information Display and has the abilities common to this type of display.
To create a new time step action, right-click on the display and choose Insert. To modify an existing
record, either edit the information directly in the table or right-click and choose Show Dialog to bring
up the Time Step Actions dialog.
The Time Step Actions dialog is very similar to the Contingency Element dialog. Specifying Element
Type and Action Type for time step actions is done in exactly the same manner as for contingency
element actions, with a few exceptions. Time step actions do not allow the Element Types of Solve
Power Flow or Contingency Block to be included. Time step actions must specify a Model Criteria. A
time step action cannot be created without a valid model criteria. If at some point prior to the time
step simulation run a model criteria gets deleted, a time step action using that model criteria will not
be evaluated during the time step run. The Time Delay must also be specified for a time step action.
The Time Delay is specified in whole seconds with the minimum allowed being 1. Valid Status options
are CHECK and NEVER. Set the Status to NEVER to prevent a time step action from being evaluated
and implemented during a time step simulation run.
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Transformer Control: Time Step Options
Transformer Time Step Options are found on the Time Step Options tab of the Transformer Control
Info dialog (this dialog is different based on the automatic control types of Voltage Regulation (AVR),
Reactive Power Control, and Phase Shift Control). These options can be modified if the transformer is
on some sort of automatic control. The options are only used as part of the Time Step Simulation tool.
These options allow the specification of time delays between the time when a transformer is
considered in violation of its regulation range and the time when the transformer tap settings are
actually changed in an attempt to bring the transformer back within its regulation range. Because time
delays are involved, it is only possible in Simulator to use this type of control during a Time Step
Simulation when there is an accounting of system changes over time.
The options described below dictate how an individual transformer using time delays will be evaluated
during a time step simulation. For a description of the overall process of how switching time delays
and time delay actions are applied during a time step simulation run, see the Time Step Simulation:
Application of Time Delays topic.
The following options are available for specifying transformer time delays:
Model Tap Delay in Time Step Simulation
Check this box to use the time delay during a time step simulation. If this option it checked, the
transformer is on automatic control (transformer must allow automatic control at the device, area,
and global level), and a time step simulation is processing, the transformer tap (phase angle if a
phase shifter) setting will only be allowed to move if the transformer is violating its regulation range
for the specified period of time. During a power flow solution outside of the time step simulation, the
transformer will operate in the usual manner based on all relevant control settings without
implementing any time delay in the switching.
When this box is not checked, the transformer will operate in the usual manner based on all relevant
control settings without implementing any time delay in the switching during the time step
simulation and any power flow solutions outside of the time step simulation.
During the time step simulation, transformer tap delays will only be implemented if doing a complete
time step simulation run. A complete run is one that is started using the Do Run button on the Time
Step Simulation dialog and is allowed to run to completion without running any time steps out of
order or repeating time steps.
The Regulation Minimum and Maximum values specified on the Common Options tab of the
Transformer Control Info dialog are used to define the primary regulation range when modeling a
tap delay.
At each time step, the regulated value of the transformer will be checked to determine if it falls
outside of the regulation range. If so, a timer will be started to determine how long the value is
outside of the regulation range. If the timer has already been started and the regulated value is still
outside and on the same side of the regulation range, the appropriate time delay, as described
below, will be used to determine if the transformer has been outside its regulation range for the
specified amount of time and is now allowed to start moving tap positions to bring the regulated
value back in range. Once the transformer is allowed to move tap positions, the timer will be reset
and the appropriate time delay will be used to determine when the next move can occur if the
regulated value continues to remain outside the regulation range and on the same side of the range.
Once the regulated value falls inside the regulation range or the regulated value switches sides of
the regulation range, the timer will be reset.
Maximum Steps to Move
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Once a transformer has been outside of its regulation range for the specified period of time and
is actually allowed to change tap positions (phase angle if a phase shifter), this is the maximum
amount of steps that it is allowed to move at the current time step even if additional steps would
be required to bring the transformer back within its regulation range.
First Move Delay (Below and Above) (secs.)
These two options specify the amount of time to wait in seconds before the transformer is
allowed to change tap positions (phase angle if a phase shifter) if its regulated value falls outside
of the regulation range. These values must be specified in whole seconds with the minimum
delay being 1. These delays are used when the regulated value first falls outside its regulation
range and the transformer has not started to change tap positions. Once the transformer has
started to change tap positions, but the regulated value still remains outside its regulation range
on the same side of the range and needs to continue changing tap positions, the Next Move
Delays will be used. Once the regulated value falls inside the regulation range or the regulated
value switches sides of the range (i.e. it was below the range and is now above), the First Move
Delays will be used if the regulated value again falls outside the regulation range.
The Below entry specifies the delay to use when the regulated value is below the regulation
range. The Above entry specifies the delay to use when the regulated value is above the
regulation range.
Next Move Delay (Below and Above) (secs.)
These two options specify the amount of time to wait in seconds before the transformer is
allowed to change tap positions (phase angle if a phase shifter) if its regulated value falls outside
of the regulation range. These values must be specified in whole seconds with the minimum
delay being 1. These delays are used once the transformer has started to change tap positions
but the regulated value remains outside of the regulation range on the same side of the range
and needs to continue changing tap positions. The Next Move Delay will continue to be used for
subsequent delays as long as the regulated value remains outside of and on the same side of the
regulation range. Once the regulated value falls inside the regulation range or the regulated
value switches sides of the range, the First Move Delays will be used if the regulated value again
falls outside of the regulation range.
The Below entry specifies the delay to use when the regulated value is below the regulation
range. The Above entry specifies the delay to use when the regulated value is above the
regulation range.
Use Secondary Regulation Range
Check this box to specify a secondary regulation range that is different than the primary range
specified with the transformer. The secondary range can only be used if the primary range is also
used (i.e. Model Tap Delay in Time Step Simulation is checked). The expectation is that this range
will be larger and the delays would be shorter to model the fact that the controls will act more
quickly to a very large deviation.
To properly define the regulation ranges, one of the ranges must be completely contained within the
other range. This is necessary to prevent conflicting control actions in which one range would
require tap changes to increase the regulated value while another range would require tap changes
to decrease the regulated value.
The secondary regulation range works somewhat independently of the primary regulation range. At
each time step, the secondary regulation range is checked first. If the regulated value falls outside
of the secondary regulation range, a timer is started for the secondary regulation range. If the timer
for the secondary regulation range has already been started, the regulated value is still outside of
the secondary regulation range and on the same side of the range, and the appropriate secondary
time delay is met such that the transformer is allowed to change tap positions, the timers for both
the primary and secondary regulation ranges are reset and whether or not the primary regulation
range is violated is not checked at that time step. If the secondary regulation range timer has not
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exceeded the appropriate time delay or the regulated value is within the secondary regulation range,
the primary regulation range is checked to see if the regulated value is outside of that range. If the
regulated value falls outside of the primary regulation range, a timer is started for the primary
regulation range. If the timer for the primary regulation range has already been started, the
regulated value is still outside of the primary regulation range and on the same side of the range,
and the appropriate primary time delay is met such that the transformer is allowed to change tap
positions, the timers for both the primary and secondary regulation ranges will be reset. Once the
transformer has started to move tap positions for either of the regulation ranges and continues to
remain outside one or both regulation ranges and on the same side of the appropriate range, the
Next Move Delay, appropriate for the given range, will be used by both ranges to determine when
the next move can occur.
Secondary Minimum and Secondary Maximum
Use these fields to specify the secondary regulation range.
Secondary Max Steps to Move
Once a transformer has been outside of its secondary regulation range for the specified period of
time and is actually allowed to change tap positions (phase angle if a phase shifter), this is the
maximum amount of steps that it is allowed to move at the current time step even if additional
steps would be required to bring the transformer back within its secondary regulation range.
Sec. First Move Delay (Below and Above) (secs.)
When using the secondary regulation range, define the time delays in the same manner as
described above for the primary regulation range in First Move Delay (Below and Above)
(secs.).
Sec. Next Move Delay (Below and Above) (secs.)
When using the secondary regulation range, define the time delays in the same manner as
described above for the primary regulation range in Next Move Delay (Below and Above)
(secs.).
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Time Step Simulation: Running a Timed Simulation
A Time Step Simulation can be run either as a Continuous or Timed simulation. The type of simulation
is set up on the Options page in the Time Step Simulation Options subsection of the Time Step
Simulation dialog.
By default, the Do Run button of the Time Step Simulation dialog will run a Continuous Simulation,
i.e., a simulation in which each time point is solved immediately after the previous time point. In this
case the purpose of the Simulation is to obtain solution for the time points as fast as possible. As the
solution progresses, the results for each time point in every time point grid are refreshed, showing the
user the evolution of the Simulation. Please read the Time Step Simulation Quick Start section for a
quick introduction on how to run a Continuous Simulation.
On the other hand, the Time Step Simulation tool can also be used to run a Timed Simulation. In
this case, the Simulation takes place according to a time scale proportional to the date/times of the
time points. When you click the Do Run button, the Simulation progresses as if it was running in
actual time. The simulation can also be paused and reset at any time by using the Pause Solution
and Reset Run buttons of the Time Step Simulation dialog.
The following are some of the things you can do with the Timed Simulation:







You can hide the Time Step Simulation dialog and control the simulation by using the Time Step
Simulation Toolbar, which contains buttons such as Do Run, Pause, Reset, etc. that mimic the
control buttons of the dialog.
You can visualize how the quantities vary proportionally to actual time after each time step is
applied. Recall that the Time Scale defined in the Options page indicates the relationship
between the actual time and the time scale defined for the time points in seconds per hour. Thus,
a Time Scale value of 60 will indicate that one hour of time span between two time points will
occur in 60 seconds of actual time in the Timed Simulation.
You can also animate the flows of the solution of a time point while you wait for the solution of the
next one.
You can contour the online diagrams and see how the visualization changes as the quantities vary
in time, and in addition, you can save those contour diagrams as JPEG or bitmaps for each
timepoint.
Finally, you can act on the system (by closing capacitors, changing generator outputs, etc) before
the next time point is applied to simulate operating actions in response to system conditions.

All of these actions are very powerful in presentations on how a power system would evolve in time
across different scenarios.
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Time Step Simulation: Running OPF and SCOPF Simulations
A Time Step Simulation can be used to obtain optimal power flow and security-constrained optimal
power flow solutions on a time point by time point basis for users that have the OPF and SCOPF addons. On the Summary page, the following Solution Types can be specified:





Power Flow
Unconstrained Optimal Power Flow, which is equivalent to Economic Dispatch
Optimal Power Flow (OPF)
Security-Constrained Optimal Power Flow.

Note that different time points can be solved by any of the previously listed solution methods in the
same time step simulation. However, the solution settings of the previous time points are used as
initial conditions for the solution of the next time point.
Simulator OPF and SCOPF tools are among the most advanced optimization packages for power
systems. They have been extended in the latest versions of Simulator with many features, and have
become complex analysis system. For users that are unfamiliar with the OPF/SCOPF solutions, read the
sections on Optimal Power Flow and Security-Constrained Optimal Power Flow before setting up
OPF/SCOPF time step simulations.
Power Flow Time Step Simulation
The power flow simulation allows the user to obtain AC or DC power flow solutions for a set of time
points. During the Time Step Simulation all the power flow options defined in the Simulator Options
page as well as in other dialogs are used for the solution. A key concept of the Time Step Simulation is
that if you select Solve Time Point from the Summary page or from the grids of the Input page, you
would obtain the same solution that if you would hit the Single Solution Button. This is true, when
the input data does not contain schedule data but only time point input data. If your Simulation
contains schedule data, there may have been scheduled actions that were applied in previous time
points that are not being applied when you select the Solve Time Point option.
The power flow solution will observe all the power balance constraints, control limits and area
interchange constraint defined in the power flow settings.
Unconstrained OPF Time Step Simulation
In the unconstrained OPF solution, the Time Step Simulation removes all the constraints that would
normally act in the OPF and optimizes the system to find the minimum operating cost settings. In
doing so, Simulator will change the set points of the specified controls (generators and phase shifters)
to minimize the cost of all Areas and Superareas set to OPF AGC control.
Besides the power flow solution options, the Unconstrained OPF simulation will take all the options
that have been defined for a regular OPF solution. Most of these options are defined in the OPF
Options Dialog, which is accessed using the OPF Options and Results button on the Add Ons ribbon
tab. All the settings such as objective function, cost of unenforceable constraints, control available,
prices for controls, etc. are defined in this dialog. Other options are defined for each particular object
such as generators, loads, areas, lines, interfaces, etc.
OPF Time Step Simulation
When using the OPF solution type, the Time Step Simulation applies the time point and schedule input
data and optimizes the control areas set to OPF to minimize cost while enforcing normal operation
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constraints: transmission line thermal limits, interface limits, generator control limits, and load control
limits. In doing so, the OPF algorithm detects the controls that need to be moved, the constraints that
are binding at the solution point, and the unenforceable constraints, i.e., constraints that cannot be
enforced with the available controls.
Some of the quantities that are of interest in the solution of the OPF algorithm are:





Locational Marginal Prices: These need to be selected for display on the Buses Results page.
Average LMP prices and other LMP metrics can also be displayed in the Results page for Areas,
Injection Groups, Super Areas, and Zones.
Binding Constraints as well as Marginal Cost of Limit Enforcement for lines and interfaces.
These fields can be seen in the Results: Constraints page and can be added to the Results page
for Lines, Transformers, and Interfaces.
Unconstrained, Final and Congestion Cost, displayed in the Results Summary Page for the
entire system. These costs can also be displayed for Areas, Owners, Superareas and Zones in the
Results page.
Profit $/hr for Generators, Owners, Superareas, Areas, and Zones can be displayed in the
corresponding grids of the Results page.

SCOPF Time Step Simulation
The SCOPF combines the power of Simulator’s OPF with the Contingency Analysis Tool to optimize a
system for minimum cost while enforcing both normal operation and contingency constraints. At each
time point, the SCOPF solution provides the optimal operation of the system so that if contingencies
occur they would not create security violations. The locational marginal prices created in this manner
are security-constrained signals to the market.
The solution of SCOPF Time Step Simulation depends on the options that have been set up for the
following tools:






Power Flow
Optimal Power Flow
Contingency Analysis
Security Constrained Optimal Power Flow
Time Domain OPF Options

The SCOPF Time Step Simulation does the following for each time point:









Applies the input data to the power system
Applies scheduled actions determined by the schedule input data
Solves a power flow
If specified, solves an unconstrained optimal power flow (economic dispatch)
Initializes the base case of the security constrained OPF by solving a power flow or an OPF
For the initial system conditions, solves the list of contingencies
Solves the SCOPF optimization problem: minimizes operating cost while enforcing normal and
contingent constraints
Displays the results in all the result grids

The SCOPF is on its own a complex computation that often requires significant computer resources.
This is due mostly to the solution of the list of contingencies and the calculation of their sensitivities.
The size of the problem can be dimensioned by:
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Size of the system, given by the number of buses and the areas to be optimized. This is difficult to
reduce since the optimization problem is normally defined for a certain region.
Number of contingencies, which can be reduced by developing a contingency screening using peak
loading conditions.
Number of constraints (monitored elements), which can be reduced by selecting critical element,
e.g. interfaces and higher voltage transmission lines.
Number of time points in the list.

Another mechanism to speed up the computation of the PF/OPF/SCOPF Time Step Simulation is to use
DC solutions in some of the internal routines:




AC or DC power flow
AC or DC contingency analysis. This one will produce the larger time savings.
AC or DC SCOPF
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Time Step Simulation: Storing Input Data and Results
In large cases, the amount of data that can be potentially generated by a Time Step Simulation is
significant considering that results for a full PF/OPF/SCOPF solution are available for each time point. A
convenient method to store large amounts of data is to save the data in a binary file. The input data,
both time point and scheduled data, as well as the results can be stored in a Time Series Binary
File, referred to in this help guide as the .tsb file.
Here is a summary of what will be stored in the .tsb file when you click the Save TSB File button in
the Time Step Simulation Dialog:










All input data, defined in the Input pages for MW Load, Mvar Loads, Generator MW, Generator
Maximum MW, Line Status, Area Total MW Load, Zone Total MW Load, and Injection Groups.
All scheduled input data, defined by the combination of Schedules and Schedule Subscriptions
specified in the corresponding Input pages.
The values displayed on the grids of the Results: Constraints page for Binding Lines, Binding
Interfaces, Binding Contingencies, and the Binding Line Matrix and List.
The customization settings defined on the pages of the Custom Results Selection Dialog for the
time point results of Areas, Buses, Generators, Switched Shunts, Injection Groups, Interfaces,
Lines, Loads, Owners, Superareas, Transformers, and Zones.
The customized results on the pages of the Results page for time point field values of Areas,
Buses, Generators, Switched Shunts, Injection Groups, Interfaces, Lines, Loads, Owners,
Superareas, Transformers, and Zones. Recall that many fields can be defined for each type of
object.
The options defined in the Options page, except the options set up in the Auto Load TSB File
Options, which are saved with the .pwb case.
The data of the last solution run contained in the Summary page: Skip, Processed and Solved
fields.
The .tsb file description

Note: Recall that the data of any Simulator grid can be copied to the clipboard and to Excel by
selecting the options found on the local menu accessed by right-clicking on the grid.
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Fault Analysis
Fault analysis can only be performed when Simulator is in Run Mode. There are three ways to start a
fault analysis study:





Go to the Tools ribbon tab, and choose Fault Analysis from the Run Mode ribbon group. This is
only available in Run Mode.
Right click on a bus and choose Fault… to perform a fault analysis at that bus
Right click on a line and choose Fault… to perform a fault analysis at that point on the line

All of these options will open the Fault Analysis dialog. If you opened the dialog by right-clicking on a
bus or line, the fault information on that bus or line will already be filled in. If you selected the Fault
Analysis… option from the Tools ribbon tab, the information about the location of the fault will need
to be provided.
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Fault Analysis Dialog
The Fault Analysis dialog can be used to perform a fault analysis study on the currently loaded
power system. A fault study can only be performed while Simulator is in run mode, since the load flow
must be validated and solved before a fault study can be calculated. If you are observing single fault
analysis results in the fault analysis dialog and switch to edit mode, the dialog will automatically be
closed and the single fault analysis results will be cleared from memory. Multiple fault results displayed
in the Fault Definitions table are maintained when switching to edit mode, but may no longer be
relevant when switching back to run mode, depending on what was done to the power system data in
edit mode.
The fault analysis has two choices for calculating fault results. The first option is calculating the fault
current at multiple defined points for a general summary of several faults, and the second is
calculating detailed fault results and fault current flows for a single fault point.
Simulator stores fault data in the PowerWorld binary file along with the load flow data, but by default
most other load flow formats store fault data in separate files. The fault data can be stored in and
loaded from an external file, but if no fault data is present in a PowerWorld binary file or loaded from
an external file before a fault analysis is run, Simulator will use the load flow data as default values for
the analysis. Fault data values can also be modified for specific devices by opening a specific device's
information dialog and looking at the Fault… tab. Devices that require sequence specific data for fault
analysis are buses (for sequence load injections), generators, switched shunts, transmission lines, and
transformers.
Phase shifts in a fault analysis calculation can be very important for calculating the correct fault
currents and voltages throughout the system. The phase shifts that are applied for transmission lines
and transformers are taken from the load flow values of phase entered with each specific transmission
element. While transformers can have their transformer configurations specified (i.e. Delta-Wye,
Grounded Wye-Delta, etc.), these configurations are NOT used to determine phase shift angles, ONLY
to determine the proper grounding on each side of the transformer. The phase shifts that are applied
are taken from the load flow data phase values for the transmission elements. If no phase shifts are
entered in the load flow data, the fault analysis will treat all elements as having zero phase shift.
Phase shift values can be entered manually for each transmission element, but are also included in
most load flow formats and will be read into Simulator when loading a load flow data file.
Note that the bus chosen for the fault is always set to a 0 degree reference, and all other buses are
shifted according to this reference.
Load Data / Save Data
These two buttons allow loading from and saving to external files. Currently the two types of files
supported are PSS/E Sequence Data files (.seq) and PowerWorld Simulator Auxiliary files (.aux).
Either one of these formats can be loaded and saved.
Note that typically Simulator assumes that if no zero sequence data is given for a branch that the
zero sequence impedance is defaulted to 2.5 times the positive sequence impedance. However, in
the case of reading in data from a PSS/E sequence data file, you are given the option to instead
treat branches with now explicitly given zero sequence data as open circuits in the zero sequence
network.
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Fault Analysis Bus Records
This dialog has the same functionality available as Case Information displays. The purpose of this
display is to tabulate the results of the fault analysis calculations. By default, the phase voltage
magnitudes and angles are displayed. In addition, the sequence voltages and angles can also be
added by modifying the display using the Display/Column Options dialog.
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Fault Analysis Generator Records
This dialog has the same functionality available as Case Information displays. The purpose of this
display is to tabulate the results of the fault analysis calculations. By default, the phase current
magnitudes are displayed for the terminal end of the generator. The phase current angles, as well as
the sequence current magnitudes and angles, can be added by modifying the display using the
Display/Column Options dialog. The magnitude and angle direction reference is always given as out of
the generator and into the terminal bus.
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Fault Analysis Line Records
This dialog has the same functionality available as Case Information displays. The purpose of this
display is to tabulate the results of the fault analysis calculations. By default, the phase current
magnitudes are displayed for each end of the branch. The phase current angles, as well as the
sequence current magnitudes and angles, can be added by modifying the display using the
Display/Column Options dialog. The magnitude and angle direction reference is always given as out of
or away from a bus.
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Mutual Impedance Records
The Mutual Impedance Records table is a Case Information Display and can be customized like any
other case information display. The zero sequence mutual impedance records displayed in this table
can be either read from a sequence data file, or created manually by choosing Insert… from the local
menu.
The common fields displayed on the Mutual Impedance Records display are:
L1 From Bus, L1 To Bus, and L1 Ckt ID
These fields represent the from bus number, to bus number, and circuit identifier for the first
mutually coupled line.
L2 From Bus, L2 To Bus, and L2 Ckt ID
These fields represent the from bus number, to bus number, and circuit identifier for the second
mutually coupled line.
Mutual R, Mutual X
The mutual impedance, in terms of the resistance and reactance (per unit). The dot convention of
the mutual impedance assumes the From bus of each line to be the dotted terminal, with the sign of
the mutual impedance values being set according to this convention.
L1 Mut. Start, L1 Mut. End
The starting point and ending point of the mutually coupled portion of the first mutually coupled
line. The values are between 0 and 1, and represent a position on the line as a percentage of the
total line length. These fields are only used when evaluating an in-line fault to determine the affect
of the mutual impedance on each side of the fault point on the line.
L2 Mut. Start, L2 Mut. End
The starting point and ending point of the mutually coupled portion of the second mutually coupled
line. The values are between 0 and 1, and represent a position on the line as a percentage of the
total line length. These fields are only used when evaluating an in-line fault to determine the affect
of the mutual impedance on each side of the fault point on the line.
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Mutual Impedance Record Dialog
The Mutual Impedance Record dialog can be used to modify or add zero sequence mutual
impedance records to the sequence data for a case. When the dialog is opened using the Show
Dialog… option from the Mutual Impedance Records table local menu, the information for the record
selected in the table will automatically be displayed. The information for that record can be modified,
or a different record can be selected by selecting different lines in the Line 1 and Line 2 Identifier
sections. Note that the drop down list of buses for the From Bus fields always contain all the buses in
the case. However, once the From Bus has been selected, the drop down list of the corresponding To
Bus field will only contain bus numbers of buses that are connected to the From Bus. If a mutual
impedance record already exists for the lines selected, the information for that record will be
displayed. If a mutual impedance record does not exist for the selected lines, then the mutual
impedance fields will display default values. When the default values are changed, and either Save or
OK are selected, a new mutual impedance record is added to the data.
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Fault Analysis Load Records
This dialog has the same functionality available as Case Information displays. The purpose of this
display is to tabulate the results of the fault analysis calculations. By default, the phase current
magnitudes are displayed for the terminal end of the load. The phase current angles, as well as the
sequence current magnitudes and angles, can be added by modifying the display using the
Display/Column Options dialog. The magnitude and angle direction reference is always given as out of
the bus and into the load.
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Fault Analysis Switched Shunt Records
This display has the same functionality available as Case Information displays. The purpose of this
display is to tabulate the results of the fault analysis calculations. By default, the phase current
magnitudes are displayed for the terminal end of the switched shunt. The phase current angles, as
well as the sequence current magnitudes and angles, can be added by modifying the display using the
Display/Column Options dialog. The magnitude and angle direction reference is always given as out of
the bus and into the switched shunt.
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PowerWorld Simulator PV/QV Overview
The PV and QV tools are only available if you have purchased the PVQV add-on to the base
Simulator package. Contact PowerWorld Corporation for details about ordering the PVQV
version of Simulator.
PVQV, PowerWorld's voltage adequacy and stability assessment add-on, is used to analyze the voltage
characteristics of a power system.
PowerWorld Corporation also offers Optimal Power Flow (OPF), Available Transfer Capability ATC,
Simulation Automation Server (SimAuto), and Security Constrained Optimal Power Flow (SCOPF)
among other add-ons. For more information see .
The PowerWorld Simulator (Simulator) is an interactive power system simulation package designed to
simulate high voltage power system operation. In the base package, Simulator solves the power flow
equations using a Newton-Raphson power flow algorithm. However, with the voltage adequacy and
stability (PVQV) add-on the user can solve multiple power flow solutions in order to generate a PV
curve for a particular transfer or a QV curve at a given bus.
The PVQV functionality is accessed using the PV and QV Curves (PVQV) ribbon group from the Add
Ons ribbon tab. The commands available in this ribbon group are Refine Model, PV Curves, and QV
Curves.
The purpose of the PVQV add-on is monitor system voltages, or other user specified parameters, as a
real power transfer is increased or reactive power is injected at selected buses. The PVQV add-on uses
the Simulator built-in Newton Raphson power flow algorithm to accomplish this task. After PV and QV
simulations are completed, the user can choose to graph any of the monitored system parameters,
designated in Quantities to Track.
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PV Curves
Simulator's PV Curves tool provides the ability to produce plots of maximum power transfer (PV)
curves for voltage at any bus in the system, as well as 2-dimensional plots of various quantities
tracked during the simulation. In Run Mode, select PV Curves... from the Add Ons ribbon tab to
open the PV Curves dialog. The PV Curves dialog allows you to specify the quantities to be tracked
during the simulation, control solution parameters, set violation boundaries, and run the PV analysis.
The PV curve process will automatically solve a sequence of power flows at incremental levels of
power transfer between a source Injection Group and a sink Injection Group. Injection Groups may
contain generators, loads, or a combination of both. Each Contingency defined in the Contingency
Analysis Tool that is not flagged to be skipped will be processed and tracked as a separate PV
Scenario, along with the pre-contingent base case, at each incremental power transfer. After each
successful power flow solution, the user-specified Quantities to Track are recorded and the transfer is
increased by the next increment. If a power flow solution fails, then the last successful solution for
that scenario is applied and a smaller incremental transfer is applied. The process concludes after
finding the maximum power transfer for the user-specified number of critical scenarios.
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PV Curves Dialog
To display this dialog, go to the Add Ons ribbon tab and select PV Curves from the PV and QV
Curves (PVQV) ribbon group.
The PV Curves dialog contains all of the setup and controls for processing and analyzing the PV curve
analysis. The dialog is broken down into several pages:
Setup
Quantities to track
Limit violations
PV output
QV setup
PV results (Note: Launching the analysis is done from this page.)
New Plots

There are several buttons at the bottom of the dialog that are available regardless of the selected
page.

Save Auxiliary...
Clicking this button will prompt for a filename in which to save an auxiliary file. PV-specific results
and option settings are not saved with the case when it is saved to file. Use this option to store any
results and settings that need to be retained for future use.
The PV Curve Tool Settings dialog shown below will be displayed with options for specific data to
include in the auxiliary file. Check the box next to a particular data set to save this data in the
auxiliary file. Which key field to use when identifying objects in the file can also be specified on this
dialog. Click OK on this dialog to finalize saving the file or Cancel to abandon the file save.
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Load Auxiliary...
Clicking this button will open a dialog to allow the user to select an auxiliary file to load. This is
intended to be used for loading any relevant option settings to be used during the PV analysis. The
dialog will be updated according to the option settings loaded from the file.
Launch QV curve tool...
This button will launch the QV Curves tool using the options specified on the QV setup tab. This
button is disabled when using Integrated Topology Processing.
Help
Displays this help page.
Close
This will close the dialog without running the analysis. The currently set options will be saved, and
the dialog will not close unless all option settings are valid.
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PV Curves: Setup
The Setup tab is found on the PV Curves dialog.

The Setup tab contains the options for defining the source and sink for the PV study transfer. The PV
tool expects the source and the sink to be injection groups defined by the user.
Source
Use this drop-down box to identify the source injection group. To model an increase in transfer,
generator points in the source injection group will increase their output, and load points will
decrease their magnitude in amounts proportional to their participation factors.
If the injection group to use for the source has not already been created, click the View/Define
Groups button in order to create it. After the injection group has been created, it will show up in this
drop-down box and can then be selected.
Sink
Use this drop-down box to identify the sink injection group. To model an increase in transfer,
generator points in the sink injection group will decrease their output, and load points will increase
their magnitude in amounts proportional to their participation factors.
If the injection group to use for the sink has not already been created, click the View/Define Groups
button in order to create it. After the injection group has been created, it will show up in this dropdown box and can then be selected.
View/Define Groups
If injection groups have not been previously defined in the current case, they can be created by
clicking on this button. To create a new injection group, right-click on the resulting injection group
case information display and choose Insert from the popup menu.
Alternatively, if a list of injection groups has been previously saved in an auxiliary file, they can be
loaded into the current case by right-clicking on the resulting injection group case information
display and choosing Load > Auxiliary File from the popup menu.
Once the source and sink points have been defined, the PV study will model an increasing transfer of
power from the source points to the sink points. The transfer process is performed incrementally,
based upon user specified options on how the transfer should vary during the solution process.
The remainder of the setup options are found on sub-tabs for Common Options and Advanced
Options.
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PV Curves Setup: Common Options
These options are located the Common Options sub-tab found on the Setup tab of the PV Curves
dialog. These are the options most commonly adjusted for the PV analysis.

Initial Step Size (MW)
This option indicates the initial increment in which the transfer will be increased following each
successful iteration. The default value is 100 MW.
Minimum Step Size (MW)
Whenever the PV process fails to solve the system at a given transfer level, it will return to the
previously solved transfer level, reduce the step size by the specified factor, and then try to solve
the system with the transfer incremented by the newly reduced step size. The Minimum Step Size
option specifies the minimum size this increment can be. Once the system fails to solve when the
step size is at this value, the process will conclude that we have come very close to the voltage
collapse point and terminate the analysis. So, the minimum step size essentially functions as a
tolerance for computing the voltage collapse point. The default value is 10 MW. The minimum step
size must be greater than or equal to 0.1 MW.
See the topic below about Tolerances in PV Tool for more information about how the minimum
step size interacts with the Island-Based AGC Tolerance and power flow MVA Convergence
Tolerance.
When convergence fails, reduce step by a factor of…
Whenever the PV process fails to solve the system at a given transfer level, it will reduce the
transfer step size by the value specified for this option. The default value is 2. Therefore, the
process will start incrementing the transfer in 100 MW steps. When it reaches a transfer level that it
cannot solve, it will return to the last solved transfer level, reduce the step size to 50 MW, increment
the transfer by 50 MW, and attempt to solve the case again. The next time it fails to solve, it will
reduce the step size to 25 MW, and then to 12.5 MW, and finally to 6.25 MW. Since 6.25 MW is less
than the Minimum Step Size value of 10 MW, it will instead use a final step size of 10 MW. Once
the system fails to converge with this step size, the analysis will terminate because it concludes that
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it has arrived at the voltage collapse point, within the specified tolerance. This value must be greater
than or equal to 1.01.
Stop when transfer exceeds
Check this box to terminate the PV analysis once the transfer between the source and sink reaches
an amount equal to the MW value specified.
Island-Based AGC Tolerance
When implementing the transfer, island-based AGC is used. Injection changes for the transfer are
first made to the source injection group, and when the power flow is solved, the sink injection group
is adjusted for any injection changes due to the source injection group changes and any changes in
losses due to the transfer. Because the process to determine required injection changes during the
power flow solution MW control loop is an iterative process, a tolerance value must be specified to
determine when the changes to the sink injection group are acceptable. This tolerance is NOT the
same value that is set with the power flow solution options for specifying island-based AGC.
As a general rule of thumb, the Minimum Step Size should be at least 2 times larger than this
tolerance. If not, all changes due to an incremental transfer that is smaller than this tolerance will
actually occur between the source and the system slack instead of the source and the sink.
See the topic below about Tolerances in PV Tool for more information about how the
AGC tolerance interacts with the Minimum Step Size and power flow MVA Convergence
Tolerance.
Allow only AGC units to vary
Individual generating units are distinguished according to whether they do or do not participate in
the automatic generation control (AGC) effort. Each generator has a field that determines whether
or not that particular generator is AGC-able. By checking this option, only those generators whose
AGC field is set to YES will contribute to the power transfer being studied. Otherwise, all units in the
injection groups will be allowed to participate regardless of their AGC status.
Enforce unit MW limits
If this option is checked, the output of any participating generating unit will be kept within its
designed operating range of MinMW < Output < MaxMW. When a unit is pegged at one of its limits,
participation factors of the other points in the limited generator's injection group will be adjusted to
pick up the difference.
If this option is checked and during the ramping all units in either the source or sink hit their limits,
the scenario for which the ramping is being done will be considered critical. The Critical Reason for
the scenario will reflect whether the source or sink ran out of resources.
Do not allow negative loads
This is the analog of the previous option for loads. If a load is used as a source point (or sink point
when choosing to apply the reverse transfer), it will be decreased to make power available for the
transfer. Checking this option will instruct the PV process to keep loads from falling below 0 MW. If a
particular load is capped at 0 MW, participation factors for the remaining points in its injection group
will be recalculated to make up the difference. If there are not enough resources in the injection
group to continue with the transfer, the scenario for which the ramping is being done will be
considered critical. The Critical Reason for the scenario will reflect whether the source or sink ran
out of resources.
Dispatch generators in merit order
Two different methods of merit order dispatch are available. The basic method is implemented by
checking the Use box for the Source or Sink. When using the basic method, injection group
generators will be dispatched by moving individual generators to their maximum/minimum outputs
in succession based on their relative participation factors ordered from highest to lowest. To
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dispatch the source injection group in merit order, check the box next to Source. To dispatch the
sink injection group in merit order, check the box next to Sink. When using the basic option,
generator unit MW limits will be enforced for those units participating in the merit order dispatch
regardless of how the Enforce unit MW limits option is set.
The second method involves dispatching generators so that they are dispatched within an economic
range. To implement this option, the Use box must be checked along with the Use Economic box.
To dispatch the source injection group in economic merit order check the boxes next to Source, and
to dispatch the sink injection group in economic merit order check the boxes next to Sink. Details
about how economic merit order dispatch is performed can be found under the Generator Economic
Merit Order Dispatch topic.
When using either of the merit order options and an injection group contains loads along with
generators, only the generators will be adjusted and the loads will not participate in the injection
changes. If using merit order dispatch and an injection group contains ONLY loads, the loads will be
adjusted according to their participation factors and merit order dispatch will not be used.
Stop after finding at least ... critical scenarios
A large number of contingencies can be specified for analysis. Usually, there is only concern with
determining a certain number of the most critical scenarios instead of running each scenario to its
critical point. Set this number to stop the analysis of all scenarios once the specified number of
critical scenarios has been found. It should be noted that this number really serves to find at least
the specified number of critical scenarios. Depending on when a scenario becomes critical in the
process, it is possible that more than the specified number of critical scenarios will be found.
Before implementing a new transfer step for all contingencies, the number of scenarios that are
already critical is checked against the number of critical scenarios to find. If at that point the number
found is greater than or equal to the number specified, the process will stop. At each transfer step,
all contingencies that are not already critical are implemented and a power flow solution is
attempted for each contingency. If any contingency does not solve, that contingency is evaluated
independently to determine the transfer level at which it becomes critical. If multiple contingencies
cannot be solved at a particular transfer step, all of these contingencies will be evaluated
independently to determine the transfer level at which it becomes critical. All contingencies are
evaluated even if this would cause the number of critical scenarios found to exceed the specified
number of critical scenarios to find.
Skip contingencies
The PV Curve tool computes PV curves for both the base topology and for any contingencies that
have been defined, unless the Skip contingencies checkbox is checked. If the Skip
contingencies checkbox is checked, a PV curve will be computed only for the model in its present
(base case) topology.
Manage contingency list…
Clicking this button will open the contingency analysis dialog for managing or inserting contingencies
to be processed during the PV analysis. Contingencies defined and marked for processing in the
contingency analysis dialog will be included. Only those contingencies whose Skip field is set to NO
will be included in the PV analysis.
Note: The Robust Solution Process option that can be utilized with the contingency analysis when a
contingency solution failure occurs is not applied when a contingency is implemented during the PV
analysis. Most other options defined with contingency analysis such as contingency specific solution
options and make-up power specifications are used when applying a contingency during the PV
analysis. The exception here is for the contingency-specific solution option for Minimum Per Unit
Voltage for Constant Power Load. This is always set to 0 pu during the PV analysis.
Run base case to completion
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The PV curve tool is designed to ramp a transfer until the prescribed number of critical scenarios,
including both critical contingencies and critical base topology, have been found. If the requested
number of critical scenarios have all been identified as being associated with contingencies, the tool
will not reveal how much a transfer can be ramped for the base topology, unless the Run base
case to completion checkbox is checked. Checking this checkbox forces the tool to continue to
ramp the transfer until the base case can no longer be solved, regardless of whether the requested
number of critical transfer level / topology combinations have been found.
If using the Stop when transfer exceeds option, it is possible that the base case will not be run
to completion if the specified transfer level is exceeded before the critical point for the base case is
found.
Base Case Solution Options …
Click this button to bring up the Simulator Options Dialog. This allows the specification of the
solution options to use for solving pre-contingency cases and the options used when no
contingency-specific solution options are defined. Changing these options affect all power flow
computations, even those outside the PV process.
Because the goal is to stress the system while performing the PV analysis, there are two power flow
solution options that are set internally as part of the PV process. These are the options that specify
the minimum per unit voltage for constant power and constant current loads. These options are both
set to 0 pu and override any user-specified settings.

These options are both set to 0 pu during both the base case solution and any contingency case
solution.
Tolerances in PV Tool
Tolerances must be set correctly with the PV tool or injection changes will end up being picked up by
the system slack instead of the sink injection group or no injection changes will be made at all. The
Minimum Step Size will dictate what the MVA Convergence Tolerance, set with the Power Flow
Solution Options on the Simulator Options Dialog, and the Island-Based AGC Tolerance can be.
Before the analysis starts, the MVA Convergence Tolerance will be checked to make sure that it is
less than 0.1*(Minimum Step Size). If not, the MVA Convergence Tolerance will be set to
0.1*(Minimum Step Size). The Island-Based AGC Tolerance will also be checked to make sure that it
is less than 0.5*(Minimum Step Size). If not, the Island-Based AGC Tolerance will be set to
0.5*(Minimum Step Size). The MVA Convergence Tolerance will then be checked to make sure that
it is less than 0.2*(Island-Based AGC Tolerance). If not, the MVA Convergence Tolerance will be set
to 0.2*(Island-Based AGC Tolerance). This will order the tolerances such that (MVA Convergence
Tolerance) < (Island-Based AGC Tolerance) < (Minimum Step Size). The original tolerances will be
restored when the initial state stored with the PV tool is restored.
Another issue dealing with tolerances is cumulative system slack error. The cumulative system slack
error will be recorded after each ramping step. This is done so that an attempt can be made to keep
the system slack from deviating more than the Island-Based AGC Tolerance over all of the ramping
by adjusting for this error during the next ramping step. This error will be applied to the amount of
change required from the sink injection group in an attempt to bring the system slack back towards
its original output. Without this accounting it is possible that the system slack could move by the
Island-Based AGC Tolerance at each ramping step, and the overall results would be that the system
slack could move (Island-Based AGC Tolerance) * (Number of ramping steps) by the completion of
the process. With this accounting, the system slack may move up and down slightly over the course
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of all ramping, but on average will stay near its starting output within the Island-Based AGC
Tolerance.
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PV Curves Setup: Advanced Options
These options are found on the Advanced Options sub-tab located on the Setup tab of the PV Curves
dialog.

The power transfer that occurs during the PV analysis is a real power (MW) transfer. Loads can be
specified as part of either the source or sink injection group that define the transfer. When loads are
included in the transfer, the default is to only adjust the real power (MW) component of the load and
leave the reactive power (Mvar) component constant. If any change is made to the reactive power
load (Mvar) during the transfer, the default is to have all changes be made to the constant power
component of the load. The Advanced Options tab allows specification of load variation for both real
and reactive load to be something other than the defaults during the transfer.
The transfer amount and how the transfer is adjusted are determined by options found on the
Common Options tab.
How should reactive power load change as real power load is ramped?
Total read power load changes, ΔP, at each load are determined based on the load's participation
factor as defined with its associated injection group and the amount of transfer that is being
implemented. ΔP is then used in conjunction with the selected reactive power change option to
determine the associated total reactive power change, ΔQ, at each load.
Maintain the MW/MVAR ratio at each load, but then scale MVAR by a factor of
The total reactive power change, ΔQ, is determined based on the power factor, pf, at each
nominal load (Pnom,Qnom) prior to the load change and the change in total real power load, ΔP, due
to the transfer. The power factor is determined by the following:
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An additional multiplier, pfQMult, can be specified in order to modify the total reactive power
load change to allow adjustment away from the present power factor. This multiplier is 1.0 by
default. The change in reactive power load is then:

Maintaining a constant MW/MVAR ratio implies a sign convention that is lost when applying the
arctan function to the ratio. An additional check is done to make sure that the calculated ΔQ is in
the correct direction (maintains the correct leading or lagging power factor).

When loads are specified as constant power, constant current, and constant impedance
components (ZIP components) rather than simply all constant power, the total load becomes a
function of voltage. Maintaining a constant power factor at each load requires that we use
nominal load (load at 1.0 pu voltage) that does not change as a function of voltage. When only
constant power components are specified, the actual load is the same as the nominal load.
Therefore, in all situations the power factor is determined based on the nominal load.
As MW changes, change the MVAR at a power factor of
This option allows the specification of power factor, pfspecified, for defining the total reactive power
change, ΔQ, at a load. The change in reactive power load is then dependent on the change in
total real power load due to the transfer, ΔP, and this specified power factor.

For this option, ΔQ is assumed to be in the same direction (has the same sign) as ΔP .
Load Component Variation
The total real power load change, ΔP, at a load during a PV transfer is determined by the load's
participation factor as defined with its associated injection group and the amount of transfer that is
being implemented. The total reactive power load change, ΔQ, is determined by the option selected
for how reactive power should change during ramping as explained in the previous section. Total
load change, (ΔP,ΔQ), at a load can be broken into ZIP components for constant power ( ΔPS,ΔQS),
constant current (ΔPI,ΔQI), and constant impedance (ΔPZ,ΔQZ). During the PV transfer, the user can
specify how changes in load due to the transfer should be split among these components.
The constant current and constant impedance components are a function of voltage and the nominal
values specified for these components. Because of this, it becomes important to determine the load
changes for the components based on nominal voltage and then apply these changes to the nominal
components.
All changes apply to constant power (S MW, S MVAR)
All changes to load will be made to the constant power component:

The constant power component of load is not dependent on voltage so the total load change can
be applied directly to the constant power component.
Vary in proportion to existing Z,I,P ratios
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This option will change the load at a given load such that the ratios of the ZIP components do
not change during the load adjustment. The existing ZIP ratios at a load are determined based
on the present nominal load prior to any change due to the transfer. The existing total nominal
power (Pnom,Qnom) at a load is the sum of the components:

The component ratios are simply the ratio of each nominal component to the total nominal load
at a load:

The resulting change in nominal load for each load component at a load is then the product of
the ratio of each component and the total nominal power change:

Where the total nominal power change is determined from the total power change required at a
load as a function of the present voltage, V, at the bus:

ΔQnom is calculated from ΔPnom based on the selection of the option on how reactive power should
change during the ramping as described in the previous section.
Vary using proportions specified below:
The factors are divided into four groups: real power load in the source injection group, real
power load in the sink injection group, reactive power load in the source injection group, and
reactive power load in the sink injection group. Each of these groups determines how the various
components will change based on whether the load change is being done to real or reactive load
and whether the load is part of the source or sink injection group. The default setting for each
group is to apply changes only to the constant power component; Power (S) factor is 1 while all
other factors are 0. The sum of the factors for each grouping must add up to 1. The
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Impedance (Z) factors are not enterable and are calculated to ensure that the sum is always 1.
Simply adjust the Power (S) and Current (I) factors to appropriate values and the
Impedance (Z) factor will be set automatically.
The calculation for determining the change in load components is done the same as described
above when using existing ZIP ratios except that the ratios are user-specified here.
Reverse Transfer
The standard way of performing a PV analysis is to increase a transfer from the source to the sink in
positive step increments determined by the Initial Step Size and other parameters that control the
size of the step. When a contingency does not solve at zero transfer (base case conditions), it might
be possible to find a solvable point by adjusting generation and/or load in the system. The Reverse
Transfer option will attempt to find this solvable point by increasing a transfer from the sink to the
source (instead of source to sink). This is done by incrementing the transfer from the source to the
sink in negative step increments, effectively making the transfer go from the sink to the source.
When the Apply Reverse Transfer box is checked, an attempt will be made at finding a solvable
point by applying the reverse transfer (sink to source) for any contingency that will not solve at zero
transfer. A condition for this option to be used is that the base case power flow must solve.
When choosing to attempt the reverse transfer for contingencies that will not solve, all unsolvable
contingencies will be processed even if the number of unsolvable contingencies exceeds the number
of critical scenarios specified on the Results tab. The reverse transfer process will be done for all
unsolvable contingencies prior to the standard PV process. After the reverse transfer process
completes, the standard PV process (positive transfer from source to sink) will be performed on all
contingencies that do solve at zero transfer level as long as the number of critical scenarios specified
is not exceeded already by the number of contingencies that wouldn't solve as zero transfer.
The initial step magnitude by which the transfer is increased is the Initial Step Size specified with the
Common Options. When a transfer level is found at which a contingency will solve, the step
magnitude is reduced by the reduction factor specified with the Common Options. This is done in an
attempt to find the minimum transfer required to reach a solvable point. This process will continue
until a solvable point is found for each contingency of the Maximum Reverse Transfer (MW > 0)
threshold is exceeded. It is likely that no solvable point can be found for some contingencies. The
Maximum Reverse Transfer threshold should be set such that a reasonable transfer amount is
attempted before abandoning the attempt at finding a solvable point. This process could be very
time consuming if there are a number of contingencies that do not solve at zero transfer.
In addition to attempting to find a solvable point, the reverse transfer process can also attempt to
find a solvable point at which all voltages are considered adequate. To check for adequate voltages
during the reverse transfer process, check the option to Stop when voltage becomes
inadequate that is found on the Limit Violations tab of the PV Curves dialog. This will force the
process to find a reverse transfer point at which the contingency solves and all voltages are above
the voltage level specified as inadequate. The inadequate voltage level is specified with the Voltage
level to consider inadequate option also found on the Limit Violations tab.
If a reverse transfer point is found at which a contingency will solve, and voltages are adequate if
choosing to include that check, the results for the scenario will list the Critical Reason as SRT original critical reason with original critical reason being the reason why the contingency was
considered not to be solved at the zero transfer level. The Max Export, Max Import, and Max
Shift values that are reported are the minimum (in magnitude) transfer levels at which the
contingency will solve and any voltage conditions are met. Values for any parameters that are being
tracked through Quantities to Track will also be recorded at this transfer level. If there are multiple
steps at which the contingency will solve and any voltage conditions are met while trying to find the
minimum step, multiple transfer level points will be recorded making it possible to plot a few points
of a PV curve.
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If during the reverse transfer process no point can be found for which a contingency will solve and
voltage conditions are met, the original results will be reported as if the reverse transfer process was
not attempted.
If enforcing generator MW limits and/or not allowing negative loads during the transfer causes either
the source or sink to not have enough resources to meet the required transfer, two other Critical
Reason messages are possible. If the sink is maxed during the transfer, the Critical Reason will be
given as RT Sink Maxed - original critical reason. If the source is maxed during the transfer, the
Critical Reason will be given as RT Source Maxed - original critical reason. The Max Export, Max
Import, and Max Shift values reported will be the values at which either the source or sink hit
limits. Either of these messages indicates that the contingency will not solve or voltage conditions
are not met, but the reverse transfer cannot continue because there are not enough resources in
either the source or sink to do so. If either the source or sink is at its limits the contingency solution
will still be attempted. If the contingency does solve and the voltage conditions are met, the Critical
Reason will be given as SRT - original critical reason.
When the reverse transfer process completes, the system state is returned to the base case state in
place when the PV analysis was first initiated. No reverse transfer amount will remain in the system
state upon completion of the reverse transfer process even if the analysis is such that only the
reverse transfer process is completed and no forward transfer scenarios are attempted.
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PV/QV Quantities to Track
Specification of quantities to track during analysis is almost identical for both the PV and QV analysis
(exceptions will be noted below). For PV analysis, the Quantities to Track tab is accessed from the PV
Curves dialog, and for the QV analysis, this tab is accessed from the QV Curves dialog. Quantities to
track are monitored and stored as the transfer increases for the PV analysis or the voltage set-point
changes for the QV analysis. Any unselected system parameters will not be saved. The Quantities to
Track page contains several sub-tabs that allow the monitoring of different types of objects including:
buses, generators, injection groups, lines, transformers, shunts, interfaces, and the case as a whole.
There is also a sub-tab for monitoring devices at limits.
Each of the object sub-tabs contains fields that can be tracked during the PV analysis. The default
tracking for all of these fields is NO. To monitor a particular quantity, double-click the corresponding
field entry to toggle it to YES, or in the case of some line quantities, the appropriate monitoring
direction.
Quantities that are tracked can be plotted using the Plot page. They can also be stored to an auxiliary
file with both the PV and QV tools. With the QV analysis a special file is created that stores the tracked
quantities. For more information on this see the Extra Monitoring File section with the QV
Curves Options: Output topic.
Buses
Voltage - per unit voltage
kV Voltage - actual voltage in kV
Angle - voltage angle in degrees
MW Load - total real power load
Mvar Load - total reactive power load
dV/dQ - sensitivity of voltage to change in reactive power injection at the same bus
VP Sensitivity - sensitivity of voltage change due to real power transfer. For PV analysis this is the
sensitivity of the voltage at the bus due to the selected transfer from source to sink. This is a
meaningless quantity for the QV analysis and should not be monitored.
VP sensitivities can also be calculated using the Flow and Voltage Sensitivities tool. With this tool
there is an option to turn AVR control off for generators and continuous switched shunts that are at
buses participating in the transfer. This same option is not available when calculating these
sensitivities during the PV analysis because of the overhead of additional power flow solutions that
would be required at each transfer step to implement this option. Leaving devices on AVR control
will maintain the voltage setpoint at the regulated buses creating PV buses in the power flow
Jacobian. At PV buses the sensitivity of voltage to a transfer will be zero.
Shunt Inj - total switched shunt reactive power (Mvar) output
For PV analysis if the intent is to trace PV curves, it makes sense to monitor at least one bus
voltage. The process will not automatically monitor and store voltage quantities.
For QV analysis, per unit voltage will be monitored automatically for all buses selected to be included
in the QV analysis.
If the Integrated Topology Processing add-on is available, an additional option will be available on
the Buses tracking tab, the Modify Existing Bus Tracking to Track Only Single Bus Per Super
Bus button. When using topology processing, only a single bus per super bus will be in the
consolidated case. That means that the parameters for each bus in the super bus will be the same,
i.e. same voltage magnitude and angle, etc. This button can be used to eliminate any excess
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tracking that would just take up computer memory by tracking essentially the same quantities at the
same bus multiple times. To take advantage of this option and only track a single bus per super bus,
first set up the bus tracking to track all of the necessary quantities. Then push the Modify... button.
The field entries in the table will then be updated to only include a single bus per super bus. When
determining the primary node (the primary node is the bus that will ultimately be tracked during the
analysis) and super buses, the active defined contingencies will be used to determine how the case
is consolidated. Because the consolidation can be different based on the contingency set, or lack
thereof, it is best to just define the tracking to include all necessary buses and use this option to
refine the list down to a single bus per super bus rather than manually trying to maintain such a list.
Generators
Gen MW - real power output
Gen Mvar - reactive power output
Mvar Reserve - reactive power reserves in the positive direction (Max Mvar - Mvar)
Groups
This allows the monitoring of injection group parameters.
Mvar Reserve - total reactive power reserves in the positive direction for all generators in the
group (Max Mvar - Mvar)
Gen MW - total real power output of all generators in the group
Gen Mvar - total reactive power output of all generators in the group
Load MW - total real power load for all loads in the group
Load Mvar - total reactive power load for all loads in the group
Lines
Note: all branches (whether transmission lines or transformers) appear on the Lines sub-tab.
Branch MW - real power flow on the branch in either the FROM-TO or TO-FROM direction
Branch Mvar - reactive power flow on the branch in either the FROM-TO or TO-FROM direction
Branch MVA - total power flow on the branch in either the FROM-TO or TO-FROM direction
Branch MW Loss - real power loss
Branch Mvar Loss - reactive power loss
Branch PTDF - Power Transfer Distribution Factor on the branch due to a defined real power
transfer. This parameter only makes sense when doing the PV analysis. The PTDF is calculated for
the transfer from the selected source to sink. This is a meaningless quantity for the QV analysis and
should not be monitored.
Xfmr Tap - tap ratio if the branch is a transformer
For the flow (Branch MW, Branch Mvar, and Branch MVA) and Branch PTDF fields, double-clicking on
a particular entry will toggle its value from NO to FROM-TO, and double-clicking again will toggle its
value to TO-FROM. Double-clicking on a loss field or Xfmr Tap field will toggle the value between
YES and NO.
Transformers
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Note: all branches (whether transmission lines or transformers) appear on the Lines sub-tab. See
Lines above for setting up common branch quantities. Only branches containing transformers will
appear on the Transformers sub-tab.
Type - set the transformer type (Fixed, LTC, Mvar, or Phase)
Reg Val - regulated value for the transformer control
Tap Pos - tap position
Reg Err - deviation of the regulated value from the regulation Min/Max range
All fields specified above except for the Type field are used to determine which quantities should be
monitored and stored during the analysis. The Type field can be accessed here in order to change
the type of transformer. The type will not be monitored during the analysis.
Shunts
This allows the monitoring of switched shunt parameters.
Actual Q - actual reactive power output
Actual P - actual real power output
Nom Q - nominal reactive power output
Nom P - nominal real power output
Reg Err - deviation of the regulated value from the regulation Min/Max range. This can either be in
per unit voltage or Mvar depending on the type of regulation that the shunt is doing.
Reg Val - value of regulated quantity at the regulated bus. This can either be in per unit voltage or
Mvar depending on the type of regulation that the shunt is doing.
Interfaces
MW Flow - real power flow
Mvar Flow - reactive power flow
MVA Flow - total power flow
MW Loss - real power losses
Mvar Loss - reactive power losses
Interface PTDF - Power Transfer Distribution Factor on the interface due to a defined real power
transfer. This parameter only makes sense when doing the PV analysis. The PTDF is calculated for
the transfer from the selected source to sink. This is a meaningless quantity for the QV analysis and
should not be monitored.
Case
These options allow the tracking of case quantities to provide a better picture of what is going on in
the case as a whole without requiring the individual tracking of quantities that make up the case
total. These quantities are determined in the same manner as those found in the Case Totals section
of the Case Summary dialog.
Available quantities for tracking include:
Load MW/Mvar - total real or reactive power load for the entire case
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Generation MW/Mvar - total real or reactive power generation for the entire case
Shunts MW/Mvar - total real or reactive shunt injection from switched shunts, bus shunts, and
line shunts. A positive value will indicate shunt load where a negative value will indicate shunt
compensation such as capacitance.
Losses MW/Mvar - total real or reactive power losses for the entire case
ATC Extra Monitors
This option is only available when using the PV Curves tool. The following will appear at the bottom
of the Quantities to Track tab accessed from the PV Curves dialog.

ATC Extra Monitors are typically used with the ATC add-on tool to monitor special branches or
interfaces in addition to ones monitored by setting the Limit Monitoring Settings. This would be done
for example if trying to determine an interface flow limit so that interface can be used as a proxy for
limiting the transfer between a source and a sink. This same functionality is desirable when using
the PV analysis. Both the ATC and PV analyses are similar in that they study the impacts of real
power transfers. The ATC analysis is concerned with thermal limitations while the PV analysis looks
at voltage stability limitations. Use of the ATC Extra Monitors with the PV analysis could be
additionally useful for developing a proxy interface to help prevent voltage stability problems.
Click the Define ATC Extra Monitors button to view a list of existing ATC Extra Monitors or create
new ones. To include monitoring of these elements at part of the PV analysis, check the Include
ATC Extra Monitors box.
When monitoring ATC Extra Monitors with the PV analysis, the real power (MW) flow on the
specified branches and/or interfaces will be monitored at each base case transfer level. No
monitoring is done with contingencies implemented.
ATC Extra Monitors can be added to the Overview table, available on the PV Results tab, via the
Display/Column Options... dialog. When displayed in this table, the value reported with the extra
monitor is the flow on the extra monitor at the Max Shift level of transfer for the given scenario.
Values for ATC Extra Monitors will only be displayed in the Overview table for critical scenarios.
Values for ATC Extra Monitors can also be displayed in the Overview table for transfer levels at
which inadequate voltages are found. These values will only be available if using the option found on
the Limit Violations tab to Store inadequate voltages. Fields for reporting these values are found
in the Inadequate Voltage folder in the list of available fields for the Overview table. The value
reported for each extra monitor is the flow on the extra monitor at the Inadequate Voltage
Nominal Shift transfer level.
Access to the ATC Extra Monitor values stored at transfer levels other than the Max Shift transfer for
critical scenarios and values stored for non-critical scenarios is available through SUBDATA sections
of the PWPVResultListContainer data type that is saved when saving PV results to an auxiliary file or
in the output file saved when choosing to save results to file from the PV output tab.
Devices at Limits
The Devices at Limits sub-tab allows the selection of various options to track devices that hit or
back off limits during the PV analysis. Generators and switched shunts at var limits, LTC
transformers at tap limits, and lines and interfaces at thermal limits can all be tracked.
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To track the limits of any of these devices, check the appropriate checkbox. Next to each checkbox
there is a dropdown box for selecting an advanced filter to apply to the tracking. A new filter can be
defined for a particular device by clicking the Define button next to that device. The filter will limit
the number of devices that get tracked. It is a good idea to define a filter for tracking devices so
that all elements in the case will not be tracked. Keep in mind that tracking any quantities will take
up space in the computer memory. If too many devices are tracked, it is possible to run out of
memory.
With these options, device limits are only tracked in the base case at valid transfer levels. No device
limit tracking is done with contingencies implemented.
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PV Curves: Limit Violations
The Limit violations tab is found on the PV Curves dialog and allows the definition of what should be
considered a violation of a monitored voltage. It also provides specification of parameters that will
force the PV process to stop if voltages become inadequate. When choosing to report limit violations in
the PV Curve Tool, if no limit violations are found then the minimum voltage is reported instead.

Identify bus voltages with...
These options will store monitored bus voltages that violate either their high or low voltage limit as
of the last successful solution for each scenario. Only those buses that are set to be monitored
based on the Limit Monitoring Settings will be monitored, and the low and high voltage limits for
each bus are also determined by the limit monitoring settings.
Low Voltage Violations - check this box to store the buses that have low voltage violations
High Voltage Violations - check this box to store the buses that have high voltage violations
Limit Group Definitions - click this button to open the Limiting Monitoring Settings dialog
When choosing to identify limit violations, the Overview table on the PV Results tab will contain
information about the number of violations (#Viol), worst voltage violation (Worst V Viol), and bus
at which the worst voltage violation occurs (Worst V Bus). Also, for any scenario in which a violation
occurs, the Show Violations option is enabled on the local right-click menu of the Overview table.
Choosing this option will open a table detailing all of the violations.
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Inadequate voltage level
Stop when voltage becomes inadequate
Checking this box will stop the PV process for a scenario when any monitored bus voltage falls
below the inadequate voltage threshold. The Limit Monitoring Settings dictate which buses are
monitored.
Store inadequate voltages
Checking this box will store all inadequate bus voltages encountered for each scenario. The Limit
Monitoring Settings dictate which buses are monitored. A list of inadequate voltages for each
scenario at each transfer level will then be available for viewing as one of the local menu options
obtained by right-clicking on the Overview table (PV Curve records > Show Inadequate
Voltages). Inadequate voltages will also be stored in the SUBDATA section of the
PWPVResultListContainer DATA section when storing PV results to an auxiliary file.
Interpolate inadequate voltages- If checked add the ability to estimate at what transfer level
a voltage becomes inadequate by linearly interpolating between the two transfer levels where it
goes from adequate to inadequate.
There are several fields available on the Overview table that provide summary information about
the inadequate voltages:
Inadequate Voltage Nominal Shift- nominal transfer level at which the first inadequate
voltage is recorded
Inadequate Voltage Worst Voltage- minimum voltage of all buses that have inadequate
voltages at the Inadequate Voltage Nominal Shift transfer level
Inadequate Voltage Worst Voltage Bus- bus with the minimum voltage of all buses that
have inadequate voltages at the Inadequate Voltage Nominal Shift transfer level
Inadequate Voltage ATC Mon- if any ATC Extra Monitors are being tracked during the
analysis, this will list of the flow on the given extra monitor at the Inadequate Voltage Nominal
Shift transfer level
If choosing to Stop when voltage becomes inadequate, no inadequate voltages will be
stored even if this option is selected. When a scenario becomes critical because of inadequate
voltages, the results that are given in the Overview table are from the last transfer level at which
all voltages were adequate. The inadequate voltage reported in the results is the voltage that
would be inadequate if we went beyond the reported transfer level. Because of how the
reporting works to report the last non-critical results, it makes sense that there would not be any
inadequate voltages stored.
The inadequate voltage threshold when either of the options above is checked is determined by the
following options:
Specify voltage for all buses in pu - specify a single inadequate voltage threshold to be used for
all monitored buses
Use Low Voltage Violation Limits for each bus - use the limit monitoring settings
Use a specified Low Voltage Limit Set - select a limit set to specify the limit from the dropdown. Up to four (A-D) specific limit sets can be specified for a bus. When using this option, all
monitored buses should have the selected limit set specified. If not, the default low voltage limit will
be -1.
Do not consider radial buses to have inadequate voltage (including buses that become
radial due to a contingency) - check this box to exclude monitoring buses that are radial
regardless of whether they are radial because they are connected to the system by a single line or
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because they are radial because they are connected to the system via a single in-service line (i.e.
they could have more connections but all but one of the connections is open).
This option works somewhat in conjunction with a similar option found on the Limit Monitoring
Settings dialog. The option Do not monitor radial lines and buses found on the Limit Monitoring
Settings dialog will exclude any bus from monitoring if it is radial in the base case. This limit
monitoring settings option considers buses to be radial if they are connected by a single branch and
only a single branch. When the limit monitoring settings option is selected, radial buses by that
definition will be excluded from the PV monitoring. When the PV option is selected, buses that are
connected by only a single in-service branch after the application of any scenario contingency, or in
the base case if there is no contingency, are considered radial and will be excluded from the
monitoring. The PV option is enforced regardless of whether or not the option with the limit
monitoring settings is selected.
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PV Curves: Output
The Output tab is found on the PV Curves dialog and allows the designation of where data should be
logged.
During the PV analysis, the value of each monitored quantity is recorded at each solved transfer level.
This data will only be present in memory unless some output file is specified.
Specifying File for Results
Save results to file
Click this option to save results to a file. In the adjacent text box supply the complete path and
name for the output file. If a directory is included with the output file and it does not exist, the
directory will be created. If the directory cannot be created, an error will result and the PV
analysis will not start. Click the Browse button to open a save dialog that will allow selection of
the output file. Click the View button to open the specified output file in a text editor. The View
button will be enabled if the specified output file exists.
The results will be saved as a comma-separated variable file regardless of the file extension
chosen. Set the file extension to .CSV to make the file type more recognizable by programs such
as Excel. If using the save dialog opened with the Browse button, the Save as type field on the
save dialog should be set to reflect the desired file extension. Regardless of the file extension
chosen, the file is a text file with all contents separated by commas.
When saving results to a file, a log file will also be created that indicates how long the entire PV
process took and the different base case and contingency scenarios examined at each nominal
shift level. This log file will use the same file name specified for the output file with "_LOG"
appended to the end of the file name. The log file will be saved with .TXT extension. If running
multiple instances of Simulator for PV analysis, a unique file name must be given to each set of
results to avoid overwriting results created from other instances.
Transpose results
Click this option to transpose the columns and rows in each section of the output file. The output
file is divided in sections for each of the studied scenarios. The default file format organizes the
file so that each row represents a transfer level and each column represents a tracked quantity.
The transposed file is formatted such that each row represents a tracked quantity with each
column representing a transfer level. This format is useful when the number of tracked quantities
exceeds the number of transfer levels.
Single Header File
Additional file formats are available when saving results to file when not transposing the file. If
using the default output format (Single Header file option and Transpose results option both
unchecked), each scenario will be written as a section with a header line at the beginning of each
section indicating what fields are included. Scenarios that become critical during the analysis will
be listed with the base case scenario at the shift level at which they became critical. An example
of this format is given below:
Example for Default PV Output:
RESULTS FOR PV STUDY "PVSTUDY" *
*Scenario** "base case"
"Nominal", "Export", "Import","Bus 3 (Three_138.0) PU Volt","Bus 5 (Five_138.0) PU
Volt","Newly Critical"
0.0000, 0.0000, 0.0000, 0.9927, 1.0066,
100.0000,100.0000,-98.7365, 0.9928, 1.0062,
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200.0000,200.0000,-193.4265, 0.9928, 1.0054,
300.0000,300.0000, -278.6270, 0.9928, 1.0043,
400.0000,400.0000, -365.9341, 0.9927, 1.0031,
500.0000,500.0000,-449.7520, 0.9926, 1.0015,
600.0000,599.9999,-525.2490, 0.9924, 0.9996,
650.0000,650.0000,-563.8931, 0.9923, 0.9986,
675.0000,674.9999,-582.8196, 0.9923, 0.9980,L_00002Two-00006SixC1 (Reached Nose)
If choosing to use a Single Header File by checking this option, only a single field header will
be shown at the top of the file. The first line of the file indicates that these are the results for a
PV study. Following the header are lines indicating scenarios that have become critical during the
analysis. Following this information is the single header line that indicates what fields are
provided with the results. Following the header are the results for each scenario. An example is
given below:
Example Single Header File Output:
RESULTS FOR PV STUDY "PVSTUDY"
"Newly Critical","L_00002Two-00006SixC1 (Reached Nose)"
"Scenario","Nominal","Export","Import","Bus 3 (Three_138.0) PU Volt","Bus 5 (Five_138.0) PU
Volt"
base case, 0.0000, 0.0000, 0.0000, 0.9927, 1.0066
base case, 100.0000,100.0000, -98.7366, 0.9928, 1.0062
base case, 200.0000,200.0000,-193.4267, 0.9928, 1.0054
base case, 300.0000,300.0000,-278.6272, 0.9928, 1.0043
base case, 400.0000,400.0000,-365.9344, 0.9927, 1.0031
base case, 500.0000,500.0000,-449.7524, 0.9926, 1.0015
base case, 600.0000,599.9999,-525.2494, 0.9924, 0.9996
base case, 650.0000,650.0000,-563.8935, 0.9923, 0.9986
base case, 675.0000,674.9999,-582.8201, 0.9923, 0.9980
L_00001One-00002TwoC1, 0.0000, 0.0000, 0.0000, 0.9906, 1.0067
L_00001One-00002TwoC1, 100.0000, 100.0000,-98.7366, 0.9882, 1.0062
L_00001One-00002TwoC1, 200.0000, 200.0000,-193.4267, 0.9849, 1.0053
State Archiving
In addition to saving how the monitored quantities vary with the transfer, the entire system state
can be saved to file at regular intervals during the analysis. This can be helpful if for analyzing
particular transfer levels more closely after the analysis is complete. Keep in mind that, depending
on the size of your system, archiving states frequently can require significant disk space and will
delay the process.
The state that is saved to file has automatic generation control disabled for the entire case. This is
to prevent confusion when these cases are opened. With this option disabled and any changes are
made to a case, the only generator that will move will be the system slack. The onus is then on the
user to decide if automatic generation control should be enabled for the case and how this will be
handled on an area, superarea, or island-wide basis.
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When using Integrated Topology Processing, state archiving is available. The state will be archived
using the consolidated planning-type model.
The following options are available for archiving states:
Do not save system states
This is the default option. No system states will be saved to file.
Save only the base case for each critical contingency
The base case state without the contingency implemented will be saved to file for each scenario
that is critical. The state will be saved at the transfer level that is reported as the critical Max
Shift value as given in the Results.
Save all states
Choosing this option will save to file all scenarios at each valid transfer level. Contingency
scenarios will be saved with the contingency implemented, unless at the critical transfer level. If
a scenario is critical, the base case state without the contingency implemented will be saved at
the critical transfer level. For critical scenarios, the critical transfer level is the value that is
reported as the Max Shift value given in the Results. The base case state with just the transfer
implemented will also be saved for all scenarios at all transfer levels at which the scenario will
solve.
Save state as
Use this drop-down to select the file type that should be used when archiving states. Files can be
saved as PowerWorld auxiliary files (*.aux), PowerWorld binary files (*.pwb), or both.
Where should they be stored?
Specify the directory where state files should be saved. Click the Browse button to open a
dialog to use for selecting the directory.
Specify a prefix to use in naming the state archives
Saved state files will be distinguished by a naming convention based on the scenario name and
transfer level or critical state indicator and scenario name. Use a prefix to further distinguish
these files if saving multiple study results to the same directory.
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PV Curves: QV Setup
The QV Setup tab is found on the PV Curves dialog. This page provides options for setting up a QV
analysis and for automatically launching the QV analysis upon completion of the PV analysis.
When using Integrated Topology Processing, the automatic launching of the QV analysis is disabled.

The PV curve tool stresses the system by increasing a transfer between injection groups. Eventually,
the transfer is increased so much that the power flow can no longer be solved. Under the assumptions
of static voltage stability assessment, the point at which the system becomes unsolvable is regarded as
the point of voltage collapse. Voltage collapse tends to be a localized phenomenon associated with a
lack of reactive voltage support at a bus or group of connected buses. It is important to identify this
group of stressed buses so that efforts can be properly directed to reinforce the system. QV analysis is
often used to identify the buses that are most prone to a voltage collapse because they are close to
having insufficient reactive support.
The design of the PVQV add-on to Simulator acknowledges the important role that QV analysis plays in
identifying the buses that are most heavily stressed by a transfer. The approach is straightforward.
First, perform a PV curve analysis that models a transfer from source to sink for both base and
contingency topologies. This will yield a number of PV curves that terminate at a transfer level that
causes the system to become unsolvable for each topology. For each of these critical transfer level /
contingency pairs, perform a QV analysis at a set of buses to try to determine which area or areas
constitute the epicenter of the collapse. The set of buses at which the QV analysis is performed can be
predefined by the user and supplemented by the list of buses that have the lowest voltage magnitudes
or the highest VQ sensitivities.
To specify that the QV analysis automatically be launched after finishing a PV study, check the box
labeled Automatically launch QV analysis at end of PV computation. After the PV curve has
found all the critical cases it has been asked to identify, it will launch the QV Curve Tool. The buses
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the QV Curve Tool will analyze will then come from two groups: those that the user has pre-selected,
and those that the tool automatically identified because they are among the lowest-voltage buses or
have the highest VQ sensitivities. Whether or not to include the lowest-voltage buses or highest VQ
sensitivity buses are options that need to be set by the user. Pre-selected buses for the QV analysis
must also be set by the user. All of these options need to be specified in the QV options file that is
required to be specified in order to automatically launch the QV analysis.
The remainder of the options that must be specified in order to perform the QV analysis automatically
are described below:
QV options file
Specify the name of the file that contains settings for a variety of options associated with the QV
study in this text box. Use the Browse button to locate this file using a file dialog. The QV options
file should specify which buses should be selected for which to draw QV curves.
Among the topics that may be addressed by the QV options file is whether buses should be
automatically selected as buses for which to draw QV curves based on their voltage or VQ
sensitivity. The easiest way to build a QV options file is to use the QV Curve Tool to specify the
settings of the various options and to save these settings in a file.
How should scenarios be handled?
QV curves can be drawn for the selected buses either for all the scenarios that the PV tool has
processed (select Consider all scenarios in the current list) or just for the scenarios that the PV
Curve tool determined to be critical (select Consider just the unsolved scenarios).
The transfer level at which a scenario is studied with the QV curve tool is based on other options
that can be set with the PV tool. If choosing to archive states, and at a minimum archiving the
critical scenarios, as set on the Output tab, critical scenarios will be studied at the last transfer level
at which each scenario was successfully solved. Another condition is that the states must be saved
as PowerWorld auxiliary (*.aux) files.
If not choosing to archive critical states, the critical state auxiliary file does not exist, or studying
non-critical scenarios, the transfer level at which a scenario is studied in the QV curve tool is the last
transfer level that the PV tool attempted to model. This transfer level is the level that is in place in
the state that the case is left in upon completion of the PV analysis.
QV accelerator settings
This group of controls allows the definition of a voltage window over which each QV curve should be
calculated.
Do not use shortcuts; trace the entire QV curve
Each QV curve will be computed over the voltage range specified for the bus in the QV options
file. This voltage range may be specific to that bus or may be a window what has been defined
for the entire run.
Trace abbreviated QV curves using these settings...
The voltage range over which each bus's QV curve will be computed will be customized according
to the values specified for Max voltage increase and Max voltage decrease. For example, if
a bus is currently at 0.9 pu voltage for a particular scenario and the max voltage increase is
specified to be 0.1 with the max voltage decrease specified to be 0.3, the QV curve for that bus
for that scenario will be traced over the voltage range 0.6 pu to 1.0 pu.
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PV Curves: PV Results
The PV Results page is found on the PV Curves dialog. This is the page from which the PV analysis is
launched and provides access to all of the results. This page is divided into some general information
at the top and sub-tabs at the bottom that provide details about the results.

Run
Click this button to start the analysis.
Stop
Click this button to stop the analysis once it has been started. This button will only be enabled if the
analysis has been started.
Status information
Status messages will be displayed as scenarios are examined and the power transfer changes.
Summary information about the transfer
The Present nominal shift and Present step size fields will provide information about the
present power transfer being examined. Gen MW and Load MW totals for both the source and sink
injection group will also update as the power transfer changes to give an indication of the status of
each group.
View detailed results
Click this button to open a text editor that contains detailed solution results. The results are in the
same format as the output file described on the Output tab.
Other actions >>
Clicking this button opens a menu that provides access to a number of other options:
View activity log
This option will be enabled if choosing to save the output to a file via options found on the
Output tab. If enabled and selected, the log file will be displayed.
View detailed results
This option does the same thing as the View detailed results button described above.
Clear results
This option will destroy all of the results. Nothing is done to the system state.
Save critical contingencies
Only those contingencies for critical scenarios will be saved to an auxiliary file. Selecting this
option will open a dialog prompting for a file name. In addition to contingency definitions,
1208
©2011 PowerWorld Corporation

additional data including limit monitoring settings, contingency solution options, and power flow
solution options will be saved.
Restore initial state
When the PV analysis first starts running, the present system state is stored in memory and
identified as the initial state. Choose this option to return back to the initial state.
When the analysis completes, the state that the case is left in is the last analyzed scenario with
the transfer in place but any contingency removed (i.e. base case state at the critical transfer
level). If the last analyzed scenario is a reverse transfer scenario, the system state that is in
place is the base case state in place when the PV analysis first starts running. The reverse
transfer process always restores to the base case state upon completion.
The initial state can also be set by the Set current state as initial option. If this is done,
choosing to restore initial state will return back to whatever the set initial state was.
Restore last solved state
When the analysis completes, the state that the case is left in is the last analyzed scenario with
the transfer in place but any contingency removed (i.e. base case state at the critical transfer
level). This option can be used to set the state to the last solved state. The last solved state is
the base case state at the last transfer level at which it was studied and solved. This transfer
level will most likely be higher than the transfer level at the last studied critical scenario. If the
last analyzed scenario is a reverse transfer scenario, the last solved state is the base case state
in place when the PV analysis first starts running.
The way that the process works when ramping in the positive direction is to ramp the transfer by
the specified step size in the base case. The base case state at the last solved ramped amount
becomes the last solved state. Then all contingency scenarios are tested. If any contingency does
not solve at the present transfer level, the contingency is studied individually to determine the
transfer level at which it becomes critical. This transfer level will most likely be less than the last
solved state transfer level.
Set current state as initial
Choose this option to set the initial state to be the current state. This might be useful if doing
analysis outside of the PV tool and needing to be able to return to the present state. The
Restore initial state option can then be used to return to the state designated as the initial
state. This option might also be useful if desiring to do another analysis starting from the present
state and choosing to do this by using the Start over option. The Start over option will restore
back to the initial state before starting any analysis so it is important that the initial state be set
correctly.
Keep in mind that once the Run button is clicked to start the analysis, whatever state is
presently in place will be designated as the initial state.
Start over
This option will destroy any existing results, clear the log, clear all plots and plot controls, and
restore the system state to the initial state. See comments in the Restore initial state and Set
current state as initial options for more details on the initial state.
Run QV tool
This option will launch the QV analysis by opening the QV Curves dialog and then starting the
analysis. The options specified on the QV setup tab will be used for the analysis.
This option will not be enabled if using Integrated Topology Processing.
Details about the sub-tabs at the bottom of page can be found at the following:
Overview
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Plot
Track Limits
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PV Curves Results: Overview
The Overview sub-tab is found on the PV Results tab of the PV Curves dialog. This page provides a
summary of all scenarios studied and their results. This table will update as the analysis progresses.

The overview is a case information display and therefore can be used in a manner consistent with all
other case information displays.
There are a number of fields that are shown by default on the display:
PV Scenario
Name of the scenario. Either base case or the contingency name.
Critical?

YES if the scenario is considered to be critical. Otherwise, NO.
Critical Reason
This will be blank as long as the scenario is not critical. If the scenario is critical, there are a number
of reasons that could be displayed explaining why the scenario is critical:
Reached Nose - The power flow failed to solve so the system is considered to be at the nose of the
PV curve.
Inadequate Voltage - The process stopped because at least one voltage is considered inadequate.
This reason will only occur when using the option specified on the Limit Violations tab to Stop
when voltages become inadequate. The message will be appended with the bus and voltage of
the bus with the lowest inadequate voltage.
Source Maxed - The source no longer has enough resources to continue the power transfer.
Source resources are affected by the options Enforce unit MW limits and Do not allow
negative loads found on the Common Options sub-tab of the Setup tab. They could also be
affected if choosing to use merit order dispatch in which unit limits are always enforced.
Sink Maxed - The sink no longer has enough resources to continue the power transfer. Sink
resources are affected by the options Enforce unit MW limits and Do not allow negative loads
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found on the Common Options sub-tab of the Setup tab. They could also be affected if choosing to
use merit order dispatch in which unit limits are always enforced.
SRT - Indicates that a solvable reverse transfer has been found when choosing to use the reverse
transfer option found on the Advanced Options sub-tab of the Setup tab. This message is appended
with the original critical reason that required the use of the reverse transfer.
RT Source Maxed - Indicates that the source no longer has enough resources to continue the
power transfer when using the reverse transfer option found on the Advanced Options sub-tab of
the Setup tab. This message is appended with the original critical reason that required the use of the
reverse transfer.
RT Sink Maxed - Indicates that the sink no longer has enough resources to continue the power
transfer when using the reverse transfer option found on the Advanced Options sub-tab of the Setup
tab. This message is appended with the original critical reason that required the use of the reverse
transfer.
Reached Nose in Base Case - This message will only occur for a contingency scenario. It
indicates that the contingency scenario is actually less limiting than the base case scenario and that
the analysis of the contingency scenario cannot continue because of the base case limitation. The
power transfer is always ramped in the base case prior to implementing the contingency. The
contingency cannot be attempted unless the base case solves with the transfer implemented.
Max Shift
This value will only be filled in for critical scenarios. This is the nominal shift that was implemented
to reach the critical scenario. The nominal shift is the actual accumulated transfer that was
attempted.
Note: With a few exceptions, shift values (includes Max Shift, Max Export, and Max Import) that are
reported are from the last solved solution before the critical point was reached. Because the critical
point is not considered a valid solution, no valid shift can be determined at this point. Therefore, the
values that are reported are as close to this point as the process can get within the tolerances
specified for the transfer step size. Exceptions to this occur when using the reverse transfer option.
In this case, the values that are reported are for the minimum transfer level at which the
contingency will solve and all voltages are adequate. Another exception occurs when a scenario
becomes critical because of inadequate voltages at the zero transfer level. Because the scenario can
be solved at this point, the shift values will be recorded at the actual step at which the voltages are
inadequate. If a case becomes critical due to inadequate voltages and is not at the zero transfer
level, the shift values reported for these will follow the rule that they come from the last solved step
at which all voltages were adequate. The recording of values determined by Quantities to Track will
also follow these same rules.
If a scenario is critical because either the source or sink does not have enough resources to continue
the power transfer, the shift values and tracked quantities that are reported are at the maximum
transfer level that can be achieved without source and sink limits being violated.
Max Export
This value will only be filled in for critical scenarios. This is the amount that the injection changed in
the source injection group due to the transfer and contingency implementation. This value's
magnitude can differ from the Max Shift value due to injection changes resulting from make-up
power requirements from the contingency.
See note with Max Shift for additional explanation on how shift values are recorded.
Max Import
This value will only be filled in for critical scenarios. This is the amount that the injection changes in
the sink injection group due to the transfer, loss changes due to the transfer, and contingency
implementation. This value's magnitude can differ from the Max Shift value due to the injection
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changes resulting from make-up power requirements from the contingency and making up for losses
due to the transfer. The sink injection group is designated to account for all losses due to the
transfer.
See note with Max Shift for additional explanation on how shift values are recorded.
#Viol, Worst V Viol, Worst V Bus
These fields will be filled when choosing to monitor low or high voltage violations and there are
violations for a given scenario. The options to monitor voltage violations are found on the Limit
violations tab. These fields give the total number of all bus violations for a scenario, the voltage of
the worst violation, and the bus at which the worst violation occurs, respectively. The worst violation
is considered to be the one with the lowest voltage.
Max P Mism Bus #, Max P Mism Bus Name, Max MW Mism
These fields will only be filled in for critical scenarios. These give the bus number, bus name, and
real power mismatch for the bus with the maximum real power mismatch for the power flow solution
at which the scenario becomes critical. For scenarios that are at the nose of the PV curve, the
mismatch should reflect the fact that the power flow solution will not converge and might give some
insight into problem areas of the system.
Max Q Mism Bus #, Max Q Mism Bus Name, Max Mvar Mism
These fields will only be filled in for critical scenarios. These give the bus number, bus name, and
reactive power mismatch for the bus with the maximum reactive power mismatch for the power flow
solution at which the scenario becomes critical. For scenarios that are at the nose of the PV curve,
the mismatch should reflect the fact that the power flow solution will not converge and might give
some insight into problem areas of the system.
The right-click local menu has several options specific to PV results:
Show Dialog
Choosing this option will open the Contingency Definition dialog for the associated scenario's
contingency. This dialog can be used to examine the contingency and make any necessary changes.
PV Curve records
There are three PV tool specific options available under this menu item:
Show Violations...
This option is available when choosing to monitor low or high voltage violations and there are
violations for a given scenario. The options to monitor voltage violations are found on the Limit
violations tab. When monitoring voltage violations, any bus voltages that violate limits will be
stored for each scenario at the last studied transfer level. Choose Show Violations... for a given
scenario to display a table of buses that have voltage violations.
Restore critical state
This option will restore the system state to the selected critical state. This means that the critical
transfer and any associated contingency will be implemented. This option is only available if
choosing to archive system states as set on the PV output tab. At a minimum the option to save
critical states must be selected. Another condition is that the states must be saved as
PowerWorld auxiliary (*.aux) files.
Because state archiving is disabled when using Integrated Topology Processing, this option to
restore critical states is also disabled.
Show Inadequate Voltages...
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This option is available when choosing to store inadequate voltages and there are inadequate
voltages for a given scenario. The option to store inadequate voltages is found on the Limit
violations tab. Choose Show Inadequate Voltages... to open a table listing any bus that has an
inadequate voltage for any transfer level for the given scenario and the voltage for each listed
bus at each studied transfer level. If a bus voltage is blank, that means the voltage at that bus
was not inadequate for that transfer level.
Calculated Fields
Calculated fields are available for use with the PV results. The object type that is used for the PV
results is PV Curve. This type of calculated field can only be used with PV results. Calculated fields
are useful when doing advanced filtering that might involve returning, for example, only the scenario
with the lowest inadequate voltage at the lowest inadequate transfer level. Calculated fields are
needed to return the lowest inadequate transfer level and then the lowest inadequate voltage that
occurs at a transfer level less than or equal to the lowest inadequate transfer level. This type of
filtering is needed because it would be possible for inadequate voltages to occur for different
scenarios at the same transfer level. The most critical would then be interpreted as the scenario that
produces the lowest inadequate voltage.
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PV/QV Curves Results: Plot
Plotting functionality is almost identical for both the PV analysis and QV analysis (exceptions will be
noted below). For PV analysis, the Plot tab is accessed from the PV Results tab of the PV Curves
dialog. For QV analysis, the Plots tab is accessed from the QV Results tab of the QV Curves dialog. Any
of the values selected to be monitored can be plotted using this display.

The page is broken into two basic sections: the left and right half. The right half of the display allows
selection of the scenarios that should be included on a given plot. The left half allows selection of the
quantities that will be charted on the plot.
Selecting Scenarios to Plot
The right half of the display gives a table of all scenarios that were studied. Change the Plot? field
to YES to include a scenario in the current plot. The Plot? field is a toggleable field and can be
changed from YES to NO and back again by double-clicking on the appropriate entry. Any scenario
whose Plot? field is set to YES will be included on the same plot once the Plot button is clicked.
The Always include base case box should be checked if the base case scenario should be
included in the plot along with any other scenarios selected. This option is not available for QV
results plotting.
Before a plot can be created, the quantities to plot must also be set. The results for each selected
element will be plotted for each of the selected scenarios.
Selecting Quantities to Plot
The left half of the display gives the various options for selecting what quantities should be plotted.
The Horizontal axis value drop-down contains any parameters that were monitored. Additionally,
for the PV analysis, this drop-down also contains the independent quantities (Nominal Shift, Export,
and Import) recorded during the analysis. If the Pre-contingency box is checked, the x values for
each plotted scenario will come from the base case instead of the results of a given scenario. The
Pre-contingency check box is not available for QV results plotting.
The Vertical axis value type drop-down contains a list of all the types of values that were
monitored. The type selected in this drop-down will determine the actual elements that are listed in
the Plot values for these elements table. To include an element in the plot, change the Plot?
field to YES for that element. The Plot? field is a toggleable field and can be changed from YES to
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NO and back again by double-clicking on the appropriate entry. Any element whose Plot? field is set
to YES will be included in the same plot once the Plot button is clicked.
Before a plot can be created, the scenarios to plot must also be set. The results for each selected
element will be plotted for each of the selected scenarios.
Plot Title
Optional field that can be set to add a title to a plot and distinguish one plot from another.
Plot
After selecting the scenarios and values to plot, click this button to actually generate the plot. The
plot will appear in its own window. The number of plots that can be created is limited only by
computer system memory.
Right-clicking on a plot will expose a local menu with several options. The plot can be saved as a
bitmap, Windows metafile, JPEF, or text file by clicking Save and selecting the appropriate file type.
Copy will allow the plot to be copied and pasted into other applications. Print will send the plot to a
printer that can be configured by selecting the Printer Setup option. Selecting Close will close the
plot window.
Clear
Click this button to reset all of the Plot? fields to NO for both the scenarios to plot and the values to
plot.
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PV/QV Curves Results: Track Limits
The Track Limits sub-tab is found on the PV Results tab of the PV Curves dialog or the QV Results tab
of the QV Curves dialog. The results displayed are similar for both the PV and QV analysis. This page
provides access to the results of tracking devices at limits which are determined in the same manner
for both the PV and QV analysis.

The page is divided into several additional sub-tabs for the different types of devices that can be
tracked. Tables on each tab are similar in that they list all of the devices of that type that were
tracked. For PV analysis, each column of the table is the transfer amount at which the device limits
were checked. For PV analysis, device limits are only checked for base case conditions (i.e. no
contingencies are applied). For QV analysis, each column of the table is the per-unit voltage set-point
for the study bus during the scenario in which the limits were checked. The results show where each
element was located relative to its min/max limits during each step of the analysis using the indicators
of Within Limits, Within Range, At Max, and At Min. To simplify the display and exclude those elements
that were always within their limits during all steps of the process, check the box Filter out devices
that never hit or backoff a limit during the PV run.
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PV Curves New Plots
The New Plots page is found on the PV Curve dialog. The Plots page is broken into two sub-tabs that
provide the means for creating and modifying plots: Plots Page
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QV Curves
The QV Curves tool provides the ability to compute QV curves for any bus in the system. A QV analysis
studies how variations in reactive power (Q) injection at a bus affects the voltage (V) at that same
bus. Other system parameters can also be monitored as the reactive power injection changes.
To create a QV curve, a fictitious generator (synchronous condenser) is placed at a bus that is being
studied. The voltage set-point of this generator is varied and its var output is allowed to be any valued
needed to meet this voltage set-point. The vertical axis (y-axis) of a QV curve depicts the output of the
fictitious generator in Mvar. The horizontal (x-axis) depicts the respective voltage under this condition.
The base case operating point of the system is represented by the x-intercept of the curve. This is the
point where the fictitious generator is at 0 Mvar output and represents the base case. There are
situations in which the output of the fictitious generator is not 0 Mvar in the base case, but these will
be explained with the appropriate option settings. When considering a contingency scenario in
the QV analysis, the term base case operating point will also be used. This is the starting
case that represents the system prior to performing any analysis for the curve tracing.
Tracing down the curve from higher to lower voltage set-points represents a decrease in the fictitious
generator's Mvar output which is representative of an increase in Mvar load. The curve is then tracing
what the voltage would be as the Mvar load increases. At some point the Mvar value of the generator
will stop decreasing and the bottom of the curve will be reached. This point represents the maximum
increase in load Mvar that can occur at this bus before voltage collapse is reached.
The following shows a typical QV curve. The plot is actually a VQ curve, but this is traditionally called
the QV curve.

The following plot shows a situation in which there is not enough Mvar reserve. There is no base case
operating point as the curve never crosses the x-axis. The difference between the bottom of the curve
and the x-axis is the amount of Mvar injection needed to achieve a solvable case and to come out of
collapse.
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To use the QV Curves tool, select QV Curves on the PV and QV Curves (PVQV) ribbon group on
the Add Ons ribbon tab. The QV Curves dialog will open from which buses to be monitored can be
specified, options for the QV curves can be set, and the QV curve analysis can be run.
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QV Curves Dialog
To display this dialog, go to the Add Ons ribbon tab and select QV Curves from the PV and QV
Curves (PVQV) ribbon group.
The QV Curves dialog contains all of the setup and controls for processing and analyzing the QV curve
analysis. The dialog is broken down into several pages:
Buses
Quantities to Track
Options
Results
There is a section at the top of the dialog containing the Run button that will be displayed regardless
of the page that is selected.

When all options have been set, click Run to start the QV analysis. The progress of the analysis can
be monitored from the Results tab. While the analysis is in progress, the Run button will become a
Stop button that can be clicked to stop the analysis.
When running the QV analysis, the first step is to make sure that the base case is solvable. If it is not
solvable, a message will prompt the user to decide if a solvability analysis be done of the base case. A
solvability analysis on the base case will process each of the buses selected for analysis. As each bus is
processed, the fake generator (synchronous condenser) that is normally added to trace the QV curve
at a bus will first be used to determine if Mvar injection/absorption can be adjusted such that a
solvable point is found. This process can be quite time consuming. The process first tries to find a
solvable point by increasing the studied setpoint voltage and tracing up the curve up to the maximum
voltage. It is more likely that a solvable point will be found tracing up the curve due to the increased
Mvar injection required to meet the setpoint voltage. If a solvable point is found, this solvable point
with the fake generator injection/absorption in place will then be the starting point for the QV curve
tracing. Because the base case is not solvable, no attempt will be made at solving any contingency
scenarios. If the base case is not solvable and the solvability analysis is not done, the QV process will
stop.
There are also several buttons at the bottom of the dialog that are available regardless of the selected
page.

Save ...
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Clicking this button will prompt for a filename in which to save an auxiliary file. QV-specific results
and option settings are not saved with the case when it is saved to file. Use this option to store any
results and settings that need to be retained for future use.
The QV Curve Tool Settings dialog shown below will be displayed with options for specific data to
include in the auxiliary file. Check the box next to a particular data set to save this data in the
auxiliary file. Which key field to use when identifying objects in the file can also be specified on this
dialog. Click OK on this dialog to finalize saving the file or Cancel to abandon the file save.

Load ...
Clicking this button will open a dialog to allow the user to select an auxiliary file to load. This is
intended to be used for loading any relevant option settings to be used during the QV analysis. The
dialog will be updated according to the option settings loaded from the file.
Help
Displays this help page.
Close
This will close the dialog without running the analysis. The currently set options will be saved, and
the dialog will not close unless all option settings are valid. Any results will remain in memory as
long as the power flow case remains in memory. QV curve results and option settings are not saved
with the case when it is saved to file.
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QV Curves: Buses
The Buses page is found on the QV Curves dialog.

The Buses page is used to designate the buses at which QV curves should be calculated. Depending
on other options that are selected, a QV curve will be determined for each selected bus for the base
case and any selected contingencies. Each bus/contingency (or base case) pair comprise a
QV scenario.
By default, the table lists all buses in the case. This table is a bus case information display and filtering
can be applied to this table to make the selection of buses easier. Several QV-specific fields are listed
by default:
Selected?
Set this field to YES to calculate a QV curve for this bus. This field can be toggled between YES and
NO by double-clicking on the appropriate entry.
Min Volt
Specify the minimum voltage at which the analysis will be performed for this particular bus. If this is
not specified, the default minimum voltage set with the default options is used. Only non-default
values will be shown. If the value is changed to the default setting, the cell will be set blank.
Max Volt
Specify the maximum voltage at which the analysis will be performed for this particular bus. If this is
not specified, the default maximum voltage set with the default options is used. Only non-default
values will be shown. If the value is changed to the default setting, the cell will be set blank.
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Step Size
Increment between voltage set-points used to trace the curve for this particular bus. If this is not
specified, the default step size set with the default options is used. Only non-default values will be
shown. If the value is changed to the default setting, the cell will be set blank.
Modify Selected Buses to Select Only Singe Bus Per Super Bus
This button will only be visible if the Integrated Topology Processing add-on is available. When using
topology processing, only a single bus per super bus will be in the consolidated case. That means
that the parameters for each bus in the super bus will be the same, i.e. same voltage magnitude and
angle, etc. This button can be used to eliminate any excess QV curves that would just take up
computer memory by drawing essentially the same curve multiple times for the same super bus. To
take advantage of this option and only select a single bus per super bus, first set up the bus
selection to monitor all of the necessary buses and then push the Modify... button. The Selected
field in the table will then be updated to only include a single bus per super bus. When determining
the primary node (the primary node is the bus that will ultimately be the one monitored during the
analysis) and super buses, the active defined contingencies will be used to determine how the case
is consolidated. Because the consolidation can be different based on the contingency set, or lack
thereof, it is best to just define the selected buses to include all necessary buses and use this option
to refine the list down to a single bus per super bus rather than manually trying to maintain such a
list.
Buses can also be selected for analysis by using several options found at the bottom of the dialog. A
range of bus numbers or the name of a bus can be specified in the appropriate boxes. Clicking
the Add button for either entry will set the Selected? field to YES for the designated buses. These
options are used to make setting the Selected? field more convenient.
There is another set of options that will have the QV tool determine which buses should be analyzed in
addition to those already selected.
Additionally, automatically draw curves for
Check this box to optionally draw additional curves based on certain conditions. Set the number of
lowest-voltage buses and/or highest dv/dq buses at which curves should be traced. The dv/dq
sensitivity is the sensitivity of voltage at a bus to an injection of reactive power at the same bus. The
sensitivities are ranked based on their magnitude. These lowest-voltage buses and highest dv/dq
buses are determined for each scenario once any contingency has been applied. Use the from limit
group drop-down to specify which buses should be considered when evaluating these conditions.
Only buses that are assigned to the selected limit group will be considered.
If the buses identified when evaluating these conditions already have been selected by the user, no
additional buses will be selected to make sure that the number of additional buses to include is
achieved by buses that have not been user selected.
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QV Curves: Options
The Options tab is found on the QV Curves dialog. The Options page contains several additional subtabs from which parameters necessary for carrying out a QV analysis can be set:
Solution
Contingencies
Output
The Restore Defaults button is available on the Options tab regardless of the sub-tab that is
selected. Clicking this button will set all options found on any of the sub-tabs to the default settings.
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QV Curves Options: Solution
These options are found on the Solution sub-tab located on the Options page of the QV Curves dialog.

Default solution parameters
Voltage step size (pu)
Increment between voltage set-points used to trace a QV curve. This is the default value that will
be applied to a bus unless a bus-specific value is specified.
Minimum voltage (pu)
Minimum voltage at which the analysis will be performed. This is the default value that will be
applied to a bus unless a bus-specific value is specified.
There are three ways to set the minimum voltage that will be used for a particular bus. The
default value will be used unless a bus-specific value is specified. A third option is possible if
launching the QV analysis upon finishing the PV analysis and choosing to use QV accelerator
settings. If using the accelerator settings, the bus-specific minimum voltage will be set based on
the accelerator settings. More information is available about launching the QV analysis from the
PV analysis and setting the accelerator settings on the QV Setup tab of the PV Curves dialog.
Maximum voltage (pu)
Maximum voltage at which the analysis will be performed. This is the default value that will be
applied to a bus unless a bus-specific value is specified.
There are three ways to set the maximum voltage that will be used for a particular bus. The
default value will be used unless a bus-specific value is specified. A third option is possible if
launching the QV analysis upon finishing the PV analysis and choosing to use QV accelerator
settings. If using the accelerator settings, the bus-specific maximum voltage will be set based on
the accelerator settings. More information is available about launching the QV analysis from the
PV analysis and setting the accelerator settings on the QV Setup tab of the PV Curves dialog.
Use initial voltage as Vmax
Check this box to use the initial voltage at a bus as the maximum voltage at which the analysis
will be performed. This option overrides any of the other options that set the maximum voltage
for a bus. The initial voltage at a bus is determined prior to starting the QV analysis but after
applying contingencies and applying any additional var support necessary to make an unsolvable
scenario solvable.
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Power flow solution options
Global solution options
Click this button to bring up the Simulator Options Dialog. This allows the specification of the
solution options to use for solving pre-contingency cases and the options used when no
contingency-specific solution options are defined. Changing these options affect all power flow
computations, even those outside the QV process.
The global solution options will be used in the QV analysis unless QV-specific solution options are
defined using the option described below. If contingency-specific solution options are defined for
a contingency, those options will override both the QV-specific solution options and the global
solution options.
QV Power Flow Solution Options
Click this button to bring up a dialog that allows specification of QV-specific power flow solution
options. These are the same options that are described in the Simulator Options Dialog for Power
Flow Solution Options. The QV-specific solution options will override the global solution options.
If contingency-specific solution options are defined for a contingency, those options will override
both the QV-specific solution options and the global solution options.
Because the goal is to stress the system while performing the QV analysis, there are two power flow
solution options that are set internally as part of the QV process. These are the options that specify
the minimum per unit voltage for constant power and constant current loads. These options are both
set to 0 pu and override any user-specified settings.

These options are both set to 0 pu during both the base case solution and any contingency case
solution.
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QV Curves Options: Contingencies
These options are found on the Contingencies sub-tab located on the Options page of the QV Curves
dialog.

Process each of the currently defined contingencies
Check this box to have contingencies included in the QV analysis.
QV curves can be calculated for the specified buses for both base and contingency conditions. To
analyze a set of contingencies, these must be defined using the separate Contingency Analysis
Dialog. Any contingency whose Skip field is set to NO will then be included in the QV analysis.
Another option that is relevant to the QV analysis that must be set for a contingency on the
contingency analysis dialog is the QV Autoplot field. This field must be set to YES in order to have
a QV curve plotted automatically for a contingency scenario. More information about the option to
plot curves automatically is found on the Output sub-tab.
Contingencies for inclusion with the QV analysis can also be specified based on the results of the PV
analysis if choosing to launch the QV analysis immediately following the PV analysis. More
information on launching the QV analysis upon completion of the PV analysis is found on the QV
Setup tab on the PV Curves dialog. Even when specifying contingencies based on the PV analysis,
this check box must be checked in order to actually include the contingencies with the QV analysis.
Note: The Robust Solution Process option that can be utilized with the contingency analysis when a
contingency solution failure occurs is not applied when a contingency is implemented during the QV
analysis. All other options defined with contingency analysis such as contingency-specific solution
options and make-up power specifications are used when applying a contingency during the QV
analysis.
Skip base case
Check this box to prevent the computation of QV curves for base case conditions.
Attempt to make unsolvable contingencies solvable with synchronous condenser
Some contingencies may not solve when implemented. If this box is checked, an attempt will be
made to make an unsolvable contingency solvable by providing additional var injection/absorption
through use of a fictitious generator (synchronous condenser). As each selected bus is processed,
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the fake generator (synchronous condenser) that is normally added to trace the QV curve at a bus,
will first be used to determine if Mvar injection/absorption can be adjusted such that a solvable point
is found. This process can be quite time consuming. The process first tries to find a solvable point by
increasing the studied setpoint voltage and tracing up the curve up to the maximum voltage. It is
more likely that a solvable point will be found tracing up the curve due to the increased Mvar
injection required to meet the setpoint voltage. If a solvable point is found, this solvable point with
the fake generator injection/absorption in place will then be the starting point for the QV curve
tracing.
The Q0 results field found on the Listing sub-tab of the Results tab indicates the injection of the
fake generator at the base case or initial contingency solution point. This field being non-zero is
indicative of an unsolvable contingency with the value of the field being the Mvar injection required
to solve the contingency.
Finding a solvable point can be time consuming if there are a number of contingencies that do not
solve and a large number of buses are selected for analysis. Uncheck this box if long solution times
become an issue.
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QV Curves Options: Output
These options are found on the Output sub-tab located on the Options page of the QV Curves dialog.

Extra Monitoring File
During the analysis, there will be an extra file that gets created for QV results that has little to do
with the settings on this page. This is the file used to store the Quantities to track. This file will
always be created. There is no option that can be set that will prevent it from being created. By
default this file will be named ExtraMonitoring.csv and will be stored in the current directory. If a
filename is specified in the Save result in file box, the extra monitoring file will be named using
the filename specified with _ExtraMonitoring appended to the filename. The file extension will be the
same as that specified with the filename. Regardless of the specified file extension, this file will be a
comma-delimited text file.
The results for the tracked quantities will also be stored in an auxiliary file if choosing to store the
QV results to file. The extra monitoring file is not meant to replace this but to simply provide a
format that is easy to load into Excel for analysis outside of Simulator.
Save results in comma-delimited format
A comma-delimited file format for QV results exists for easy import into a spreadsheet. This file
format cannot be loaded back into Simulator. If this functionality is required, it is suggested that the
results be saved in an auxiliary file. To save the results to an auxiliary file, click the Save... button
found at the bottom of the QV Curves dialog. The values saved to the comma-delimited file are the
same values that are saved in the SUBDATA section for QVCurve data saved to an auxiliary file.
The comma-delimited file is grouped into sections for each scenario. Each scenario is identified by a
header than indicates the bus and either base case or contingency identifier. The header is followed
by a line that provides the field order of the actual data. The field line is followed by lines of data.
Each scenario grouping is separated by a blank line. All results are sorted by the voltage setpoint.
The fields have the following meaning:
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V(PU) - per-unit voltage set-point
Q_sync(MVR) - output of the fake generator (synchronous condenser)
Q_shunt(MVR) - any existing on-line switched shunt output
Q_tot(MVR) - Q_sync + Q_shunt
Q_res(MVR) - available reserve at the bus
Q_tot_res(MVR) - Q_sync + Q_shunt + Q_res
Here is an example of the comma-delimited file:
**BUS** 3 (Three_138.0),**CASE** L_000001ONE-000003THREEC1
V(PU), Q_sync(MVR), Q_shunt(MVR), Q_tot(MVR), Q_res(MVR), Q_tot_res(MVR)
1.1000, 437.5849, 48.4000, 485.9849, 242.0000, 727.9849
1.0962, 419.8296, 48.0627, 467.8923, 240.3136, 708.2059
1.0862, 374.1186, 47.1898, 421.3083, 235.9489, 657.2572
1.0762, 329.2408, 46.3248, 375.5656, 231.6243, 607.1899
1.0662, 285.1944, 45.4679, 330.6623, 227.3396, 558.0020
1.0562, 241.9775, 44.6190, 286.5965, 223.0950, 509.6915
1.0462, 199.5884, 43.7781, 243.3665, 218.8904, 462.2568
1.0362, 158.0253, 42.9451, 200.9705, 214.7257, 415.6962
1.0262, 117.2866, 42.1202, 159.4069, 210.6011, 370.0079
1.0162, 77.3706, 41.3033, 118.6739, 206.5164, 325.1904
1.0062, 38.2757, 40.4944, 78.7701, 202.4718, 281.2419
0.9962, 0.0000, 39.6934, 39.6934, 198.4671, 238.1605
0.9962, 0.0000, 39.6934, 39.6934, 0.0000, 39.6934
0.9962, 0.0000, 39.6934, 39.6934, -119.0803, -79.3869
0.9862, -37.4572, 38.9005, 1.4433, -116.7015, -115.2582
0.9762, -74.0981, 38.1156, -35.9825, -114.3467, -150.3292
0.9662, -109.9612, 37.3386, -72.6225, -112.0160, -184.6385
0.9562, -144.9682, 36.5697, -108.3985, -109.7092, -218.1077
0.9462, -179.1652, 35.8088, -143.3564, -107.4264, -250.7828
0.9362, -212.5517, 35.0559, -177.4958, -105.1676, -282.6635
Save Results to File
Check this box to actually save the results to the file specified by Save results in file.
Save results in file
Specify the name and file path of the file to which to save the results. This option will be enabled
when the Save Results to File option is checked. Click the Browse button to open a dialog
that will allow selection of the file path and name.
Plot curves as they are computed
Check this box to draw and update QV curve plots during each step of the QV analysis process. In
order to have QV curves automatically plotted for a contingency during each step of the analysis, the
QV Autoplot field belonging to that contingency must be set to YES on the Contingency Analysis
Dialog.
1231
©2011 PowerWorld Corporation

If curves are not plotted at they are computed, they can be easily created upon completion of the
analysis from an option found on the Listing sub-tab on the Results tab.
When plotting V versus Q, treat Q as...
There are several options that determine how the Q quantity should be plotted on a QV curve.
These options are applicable whether plotting the curves automatically as they are computed or
plotting the curves upon completion of the analysis.
An example plot is shown below with examples of the plots that result from the four possible options
for how to treat Q.
The output of the fictitious synchronous condenser (Qsync)
Select this option to treat Q as the output of the fake generator (synchronous condenser) only.
This is the Q_sync(MVR) curve shown in the example plot below.
The total reactive injection at the bus, including shunts but excluding load
Select this option to treat Q as the sum of the output of the fake generator (synchronous
condenser) and any existing on-line shunts at the bus. Shunts include both bus shunts and
switched shunts. This is the Q_tot(MVR) curve shown in the example plot below.
Include reserves (status = closed, generators on AVR, switched shunts not fixed)
Check this box to offset the Q values by the appropriate Mvar reserves values.
When the QV curve is traced for a given bus, any existing switched shunts on control at that bus
are turned off control and any existing generators on AVR control at that bus are turned off
control. The amount of Mvar support that these devices can provide is then recorded and
determined at each voltage set-point. These are the reserves values. Only devices that are online and on control will be included. This means that for a generator the AVR status = YES and
for a switched shunt the control mode must not be Fixed.
The amount of down (decrease) reserves at a given voltage set-point for a switched shunt is
determined by the difference between the current nominal output of the shunt and its minimum
nominal output multiplied by the square of the voltage set-point: (Nominal Mvar - Min Nominal
Mvar)*V2. The amount of down (decrease) reserves for a generator at a given voltage set-point
is the difference between the current output and the minimum Mvar output: (Mvar Output - Min
Mvars). The amount of up (increase) reserves at a given voltage set-point for a switched shunt is
determined by the difference between the maximum nominal output of the shunt and its current
nominal output multiplied by the square of the voltage set-point: (Max Nominal Mvar - Nominal
Mvar)*V2. The amount of up (increase) reserves for a generator at a given voltage set-point is
the difference between the maximum Mvar output and the current output: (Max Mvars - Mvar
Output). The total reserves of each type at any voltage set-point is the sum of reserves of that
type for all qualifying switched shunts and generators at the studied bus.
Which type (up or down) of reserves to consider at a particular voltage set-point is determined
based on the location of the voltage set-point relative to the base case operating voltage. When
considering contingencies, the base case operating voltage is the voltage at a bus following
implementation of the contingency but before any QV curve tracing is started. If the voltage setpoint is less than the base case operating voltage, the up reserves are considered. This part of
the curve represents an increase in the Mvar load at a bus. The difference in the bottom of the
curve and the x-axis is the amount that the Mvar load at a bus can be increased before voltage
collapse. Being able to inject additional Mvar through available reserves will further increase this
margin. When plotting including reserves, the portion of the curve to the left of the base case
operating point is then offset downward by the amount of up reserves that are available at each
voltage set-point, thus increasing the margin before collapse. The portion of the curve to the
right of the base case operating point is then offset upward based on the amount of down
reserves available at each voltage set-point.
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Instead of listing an absolute value of reserves available, the Q_res(MVR) value as reported with
the QV output results (either comma-delimited file or auxiliary file) is reflective of the offset
required when plotting the curve including the reserves.
When choosing to include reserves, the values that are plotted are either Q_sync_res(MVR) or
Q_tot_res(MVR). The Q_sync_res(MVR) value is not included in the QV output results (either
comma-delimited file or auxiliary file) but is equal to the sum of Q_sync(MVR) and Q_res(MVR):
Q_sync_res(MVR) = Q_sync(MVR) + Q_res(MVR). Q_sync_res(MVR) represents the combination
of selecting the option to plot The output of the synchronous condenser and including
reserves. Q_tot_res(MVR) represents the combination of selecting the option to plot The total
reactive injection at the bus... and including reserves.

Note: The reserves and the existing injection in the above plot are represented solely by switched
shunts. All of the curves tend to converge toward the same Q at lower voltages. This is because of
the relationship of the actual output of a switched shunt to the nominal output: (Actual Mvar) =
(Nominal Mvar)*V2.
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PV/QV Quantities to Track
Specification of quantities to track during analysis is almost identical for both the PV and QV analysis
(exceptions will be noted below). For PV analysis, the Quantities to Track tab is accessed from the PV
Curves dialog, and for the QV analysis, this tab is accessed from the QV Curves dialog. Quantities to
track are monitored and stored as the transfer increases for the PV analysis or the voltage set-point
changes for the QV analysis. Any unselected system parameters will not be saved. The Quantities to
Track page contains several sub-tabs that allow the monitoring of different types of objects including:
buses, generators, injection groups, lines, transformers, shunts, interfaces, and the case as a whole.
There is also a sub-tab for monitoring devices at limits.
Each of the object sub-tabs contains fields that can be tracked during the PV analysis. The default
tracking for all of these fields is NO. To monitor a particular quantity, double-click the corresponding
field entry to toggle it to YES, or in the case of some line quantities, the appropriate monitoring
direction.
Quantities that are tracked can be plotted using the Plot page. They can also be stored to an auxiliary
file with both the PV and QV tools. With the QV analysis a special file is created that stores the tracked
quantities. For more information on this see the Extra Monitoring File section with the QV
Curves Options: Output topic.
Buses
Voltage - per unit voltage
kV Voltage - actual voltage in kV
Angle - voltage angle in degrees
MW Load - total real power load
Mvar Load - total reactive power load
dV/dQ - sensitivity of voltage to change in reactive power injection at the same bus
VP Sensitivity - sensitivity of voltage change due to real power transfer. For PV analysis this is the
sensitivity of the voltage at the bus due to the selected transfer from source to sink. This is a
meaningless quantity for the QV analysis and should not be monitored.
VP sensitivities can also be calculated using the Flow and Voltage Sensitivities tool. With this tool
there is an option to turn AVR control off for generators and continuous switched shunts that are at
buses participating in the transfer. This same option is not available when calculating these
sensitivities during the PV analysis because of the overhead of additional power flow solutions that
would be required at each transfer step to implement this option. Leaving devices on AVR control
will maintain the voltage setpoint at the regulated buses creating PV buses in the power flow
Jacobian. At PV buses the sensitivity of voltage to a transfer will be zero.
Shunt Inj - total switched shunt reactive power (Mvar) output
For PV analysis if the intent is to trace PV curves, it makes sense to monitor at least one bus
voltage. The process will not automatically monitor and store voltage quantities.
For QV analysis, per unit voltage will be monitored automatically for all buses selected to be included
in the QV analysis.
If the Integrated Topology Processing add-on is available, an additional option will be available on
the Buses tracking tab, the Modify Existing Bus Tracking to Track Only Single Bus Per Super
Bus button. When using topology processing, only a single bus per super bus will be in the
consolidated case. That means that the parameters for each bus in the super bus will be the same,
i.e. same voltage magnitude and angle, etc. This button can be used to eliminate any excess
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tracking that would just take up computer memory by tracking essentially the same quantities at the
same bus multiple times. To take advantage of this option and only track a single bus per super bus,
first set up the bus tracking to track all of the necessary quantities. Then push the Modify... button.
The field entries in the table will then be updated to only include a single bus per super bus. When
determining the primary node (the primary node is the bus that will ultimately be tracked during the
analysis) and super buses, the active defined contingencies will be used to determine how the case
is consolidated. Because the consolidation can be different based on the contingency set, or lack
thereof, it is best to just define the tracking to include all necessary buses and use this option to
refine the list down to a single bus per super bus rather than manually trying to maintain such a list.
Generators
Gen MW - real power output
Gen Mvar - reactive power output
Mvar Reserve - reactive power reserves in the positive direction (Max Mvar - Mvar)
Groups
This allows the monitoring of injection group parameters.
Mvar Reserve - total reactive power reserves in the positive direction for all generators in the
group (Max Mvar - Mvar)
Gen MW - total real power output of all generators in the group
Gen Mvar - total reactive power output of all generators in the group
Load MW - total real power load for all loads in the group
Load Mvar - total reactive power load for all loads in the group
Lines
Note: all branches (whether transmission lines or transformers) appear on the Lines sub-tab.
Branch MW - real power flow on the branch in either the FROM-TO or TO-FROM direction
Branch Mvar - reactive power flow on the branch in either the FROM-TO or TO-FROM direction
Branch MVA - total power flow on the branch in either the FROM-TO or TO-FROM direction
Branch MW Loss - real power loss
Branch Mvar Loss - reactive power loss
Branch PTDF - Power Transfer Distribution Factor on the branch due to a defined real power
transfer. This parameter only makes sense when doing the PV analysis. The PTDF is calculated for
the transfer from the selected source to sink. This is a meaningless quantity for the QV analysis and
should not be monitored.
Xfmr Tap - tap ratio if the branch is a transformer
For the flow (Branch MW, Branch Mvar, and Branch MVA) and Branch PTDF fields, double-clicking on
a particular entry will toggle its value from NO to FROM-TO, and double-clicking again will toggle its
value to TO-FROM. Double-clicking on a loss field or Xfmr Tap field will toggle the value between
YES and NO.
Transformers
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Note: all branches (whether transmission lines or transformers) appear on the Lines sub-tab. See
Lines above for setting up common branch quantities. Only branches containing transformers will
appear on the Transformers sub-tab.
Type - set the transformer type (Fixed, LTC, Mvar, or Phase)
Reg Val - regulated value for the transformer control
Tap Pos - tap position
Reg Err - deviation of the regulated value from the regulation Min/Max range
All fields specified above except for the Type field are used to determine which quantities should be
monitored and stored during the analysis. The Type field can be accessed here in order to change
the type of transformer. The type will not be monitored during the analysis.
Shunts
This allows the monitoring of switched shunt parameters.
Actual Q - actual reactive power output
Actual P - actual real power output
Nom Q - nominal reactive power output
Nom P - nominal real power output
Reg Err - deviation of the regulated value from the regulation Min/Max range. This can either be in
per unit voltage or Mvar depending on the type of regulation that the shunt is doing.
Reg Val - value of regulated quantity at the regulated bus. This can either be in per unit voltage or
Mvar depending on the type of regulation that the shunt is doing.
Interfaces
MW Flow - real power flow
Mvar Flow - reactive power flow
MVA Flow - total power flow
MW Loss - real power losses
Mvar Loss - reactive power losses
Interface PTDF - Power Transfer Distribution Factor on the interface due to a defined real power
transfer. This parameter only makes sense when doing the PV analysis. The PTDF is calculated for
the transfer from the selected source to sink. This is a meaningless quantity for the QV analysis and
should not be monitored.
Case
These options allow the tracking of case quantities to provide a better picture of what is going on in
the case as a whole without requiring the individual tracking of quantities that make up the case
total. These quantities are determined in the same manner as those found in the Case Totals section
of the Case Summary dialog.
Available quantities for tracking include:
Load MW/Mvar - total real or reactive power load for the entire case
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Generation MW/Mvar - total real or reactive power generation for the entire case
Shunts MW/Mvar - total real or reactive shunt injection from switched shunts, bus shunts, and
line shunts. A positive value will indicate shunt load where a negative value will indicate shunt
compensation such as capacitance.
Losses MW/Mvar - total real or reactive power losses for the entire case
ATC Extra Monitors
This option is only available when using the PV Curves tool. The following will appear at the bottom
of the Quantities to Track tab accessed from the PV Curves dialog.

ATC Extra Monitors are typically used with the ATC add-on tool to monitor special branches or
interfaces in addition to ones monitored by setting the Limit Monitoring Settings. This would be done
for example if trying to determine an interface flow limit so that interface can be used as a proxy for
limiting the transfer between a source and a sink. This same functionality is desirable when using
the PV analysis. Both the ATC and PV analyses are similar in that they study the impacts of real
power transfers. The ATC analysis is concerned with thermal limitations while the PV analysis looks
at voltage stability limitations. Use of the ATC Extra Monitors with the PV analysis could be
additionally useful for developing a proxy interface to help prevent voltage stability problems.
Click the Define ATC Extra Monitors button to view a list of existing ATC Extra Monitors or create
new ones. To include monitoring of these elements at part of the PV analysis, check the Include
ATC Extra Monitors box.
When monitoring ATC Extra Monitors with the PV analysis, the real power (MW) flow on the
specified branches and/or interfaces will be monitored at each base case transfer level. No
monitoring is done with contingencies implemented.
ATC Extra Monitors can be added to the Overview table, available on the PV Results tab, via the
Display/Column Options... dialog. When displayed in this table, the value reported with the extra
monitor is the flow on the extra monitor at the Max Shift level of transfer for the given scenario.
Values for ATC Extra Monitors will only be displayed in the Overview table for critical scenarios.
Values for ATC Extra Monitors can also be displayed in the Overview table for transfer levels at
which inadequate voltages are found. These values will only be available if using the option found on
the Limit Violations tab to Store inadequate voltages. Fields for reporting these values are found
in the Inadequate Voltage folder in the list of available fields for the Overview table. The value
reported for each extra monitor is the flow on the extra monitor at the Inadequate Voltage
Nominal Shift transfer level.
Access to the ATC Extra Monitor values stored at transfer levels other than the Max Shift transfer for
critical scenarios and values stored for non-critical scenarios is available through SUBDATA sections
of the PWPVResultListContainer data type that is saved when saving PV results to an auxiliary file or
in the output file saved when choosing to save results to file from the PV output tab.
Devices at Limits
The Devices at Limits sub-tab allows the selection of various options to track devices that hit or
back off limits during the PV analysis. Generators and switched shunts at var limits, LTC
transformers at tap limits, and lines and interfaces at thermal limits can all be tracked.

1237
©2011 PowerWorld Corporation

To track the limits of any of these devices, check the appropriate checkbox. Next to each checkbox
there is a dropdown box for selecting an advanced filter to apply to the tracking. A new filter can be
defined for a particular device by clicking the Define button next to that device. The filter will limit
the number of devices that get tracked. It is a good idea to define a filter for tracking devices so
that all elements in the case will not be tracked. Keep in mind that tracking any quantities will take
up space in the computer memory. If too many devices are tracked, it is possible to run out of
memory.
With these options, device limits are only tracked in the base case at valid transfer levels. No device
limit tracking is done with contingencies implemented.
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QV Curves: Results
The Results tab is found on the QV Curves dialog. This page provides access to all of the QV results.
This page is divided into several additional sub-tabs from which different categories of results are
available:
Listing
Plots
Track Limits
The Results tab also displays messages about the progress of the analysis. The messages are
displayed regardless of the sub-tab that is selected.
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QV Curves Results: Listing
The Listing sub-tab is found on the Results page of the QV Curves dialog. This page provides a
summary of all scenarios studied and their results. This table will update as the analysis progresses.

The listing is a case information display and therefore can be used in a manner consistent with all
other case information displays.
There are a number of fields that are shown by default on the display:
Number, Name, Nom kV
Number, name, and nominal kV voltage of the studied bus, respectively. This along with the Case
Name identifies the scenario.
Case Name
Either BASECASE or the name of a contingency. This along with the Number, Name, and Nom kV
identifies the scenario.
V at Q0
Per-unit voltage in the starting case (base case operating point). The starting case is either the base
case or a contingency case. This is the voltage that is recorded prior to starting any QV curve
tracing. This is the voltage at Q0.
If the case is not solvable and a successful attempt is made at finding the solvable point by using
the fake generator to provide Mvar injection, this is the voltage recorded once the case becomes
solvable.
Q0
Mvar output of the fake generator in the starting case (base case operating point). The starting case
is either the base case or contingency case. This is the Mvar output that is recorded prior to starting
any QV curve tracing.
If the case is not solvable and a successful attempt is made at finding the solvable point by using
the fake generator to provide Mvar injection, this is the Mvar output of the fake generator that is
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required to make the case solvable. Therefore, a non-zero entry means that the initial starting case
was not solvable.
Qinj_0
Total Mvar injection in the starting case (base case operating point). The starting case is either the
base case or contingency case. This is the total injection that is recorded prior to starting any QV
curve tracing. This includes the shunt injection from bus shunts and switched shunts and the output
of the fake generator.
Vmax
Maximum per-unit voltage that was recorded.
Q at VMax
Mvar injection of the fake generator at the maximum per-unit voltage that was recorded, Vmax.
Qinj at Vmax
Total Mvar injection at the maximum per-unit voltage that was recorded, Vmax. This includes the
shunt injection from bus shunts and switched shunts and the output of the fake generator.
V at Qmin
Per-unit voltage at the minimum recorded fake generator injection, Qmin.
Qmin
Minimum recorded fake generator injection. If negative, this is the amount that the Mvar load can be
increased before voltage collapse. If positive, this is the amount of Mvar injection required to come
out of collapse and achieve a solvable case.
Qinj_min
Total minimum recorded Mvar injection. This includes the shunt injection from bus shunts and
switched shunts and the output of the fake generator.
Vmin
Minimum per-unit voltage that was recorded.
Q at Vmin
Mvar injection of the fake generator at the minimum per-unit voltage that was recorded, Vmin.
Qinj at Vmin
Total Mvar injection at the minimum per-unit voltage that was recorded, Vmin. This includes the
shunt injection from bus shunts and switched shunt and the output of the fake generator.
The right-click local menu has one option specific to QV results:
Plot QV Curve
This will plot the QV curve for the selected scenario. What value of Q to plot is determined by the
options selected for how to treat Q as found on the Output sub-tab of the Options page. If multiple
scenarios are selected, the curves for the multiple scenarios will be shown on the same plot.
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PV/QV Curves Results: Plot
Plotting functionality is almost identical for both the PV analysis and QV analysis (exceptions will be
noted below). For PV analysis, the Plot tab is accessed from the PV Results tab of the PV Curves
dialog. For QV analysis, the Plots tab is accessed from the QV Results tab of the QV Curves dialog. Any
of the values selected to be monitored can be plotted using this display.

The page is broken into two basic sections: the left and right half. The right half of the display allows
selection of the scenarios that should be included on a given plot. The left half allows selection of the
quantities that will be charted on the plot.
Selecting Scenarios to Plot
The right half of the display gives a table of all scenarios that were studied. Change the Plot? field
to YES to include a scenario in the current plot. The Plot? field is a toggleable field and can be
changed from YES to NO and back again by double-clicking on the appropriate entry. Any scenario
whose Plot? field is set to YES will be included on the same plot once the Plot button is clicked.
The Always include base case box should be checked if the base case scenario should be
included in the plot along with any other scenarios selected. This option is not available for QV
results plotting.
Before a plot can be created, the quantities to plot must also be set. The results for each selected
element will be plotted for each of the selected scenarios.
Selecting Quantities to Plot
The left half of the display gives the various options for selecting what quantities should be plotted.
The Horizontal axis value drop-down contains any parameters that were monitored. Additionally,
for the PV analysis, this drop-down also contains the independent quantities (Nominal Shift, Export,
and Import) recorded during the analysis. If the Pre-contingency box is checked, the x values for
each plotted scenario will come from the base case instead of the results of a given scenario. The
Pre-contingency check box is not available for QV results plotting.
The Vertical axis value type drop-down contains a list of all the types of values that were
monitored. The type selected in this drop-down will determine the actual elements that are listed in
the Plot values for these elements table. To include an element in the plot, change the Plot?
field to YES for that element. The Plot? field is a toggleable field and can be changed from YES to
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NO and back again by double-clicking on the appropriate entry. Any element whose Plot? field is set
to YES will be included in the same plot once the Plot button is clicked.
Before a plot can be created, the scenarios to plot must also be set. The results for each selected
element will be plotted for each of the selected scenarios.
Plot Title
Optional field that can be set to add a title to a plot and distinguish one plot from another.
Plot
After selecting the scenarios and values to plot, click this button to actually generate the plot. The
plot will appear in its own window. The number of plots that can be created is limited only by
computer system memory.
Right-clicking on a plot will expose a local menu with several options. The plot can be saved as a
bitmap, Windows metafile, JPEF, or text file by clicking Save and selecting the appropriate file type.
Copy will allow the plot to be copied and pasted into other applications. Print will send the plot to a
printer that can be configured by selecting the Printer Setup option. Selecting Close will close the
plot window.
Clear
Click this button to reset all of the Plot? fields to NO for both the scenarios to plot and the values to
plot.
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PV/QV Curves Results: Track Limits
The Track Limits sub-tab is found on the PV Results tab of the PV Curves dialog or the QV Results tab
of the QV Curves dialog. The results displayed are similar for both the PV and QV analysis. This page
provides access to the results of tracking devices at limits which are determined in the same manner
for both the PV and QV analysis.

The page is divided into several additional sub-tabs for the different types of devices that can be
tracked. Tables on each tab are similar in that they list all of the devices of that type that were
tracked. For PV analysis, each column of the table is the transfer amount at which the device limits
were checked. For PV analysis, device limits are only checked for base case conditions (i.e. no
contingencies are applied). For QV analysis, each column of the table is the per-unit voltage set-point
for the study bus during the scenario in which the limits were checked. The results show where each
element was located relative to its min/max limits during each step of the analysis using the indicators
of Within Limits, Within Range, At Max, and At Min. To simplify the display and exclude those elements
that were always within their limits during all steps of the process, check the box Filter out devices
that never hit or backoff a limit during the PV run.
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PV/QV Refine Model
Modeling idiosyncrasies may exist that cause premature loss of convergence during either a PV or QV
analysis. The PVQV add-on has a tool to modify the currently open case in an attempt to fix some of
these idiosyncrasies. This is the Refine Model tool that is available on the Add Ons ribbon tab in the
PV and QV Curves (PVQV) ribbon group.

The case can be refined with the following options:
Fix transformer taps
If there are transformers that have Vmax and Vmin that are very close together, the power flow may
have a difficult time converging. This option allows the user to fix all transformer taps at their
present values if their Vmax - Vmin is less than or equal to the user specified tolerance.
Fix shunts
If there are switched shunts that have Vmax and Vmin that are very close together, the power flow
may have a difficult time converging. This option allows the user to fix all switched shunts at their
present values if their Vmax-Vmin is less than or equal to the user specified tolerance.
Take units off AVR control
If there are generators that have Qmax and Qmin that are very close together, the power flow may
have a difficult time converging. This option allows the user to remove these units from AVR control,
thus locking their MVAR output at its present value, if their Qmax - Qmin is less than or equal to the
user specified tolerance.
Apply to
These refinements will only be applied to those areas or zones that have the Apply? field set as YES
in this dialog box. This field can be toggled between YES and NO by left-clicking on the appropriate
entry.
OK
Click this button to make the selected changes to the currently open power flow case. After the
changes are made the Close button must be clicked to close the dialog. If any changes have been
made and the dialog is closed, the user will be prompted to save the case to a file.
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Close
Click this button to close the dialog without implementing any changes to the power flow case in
memory.
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PowerWorld Simulator Optimal Power Flow Overview
Note: The OPF option in PowerWorld Simulator is only available if you have purchased the
OPF add-on to the base package. To learn more about the OPF, please feel free to read
through the information contained in these help files. Contact PowerWorld Corporation for
details about ordering the OPF version of Simulator.
The PowerWorld Simulator (Simulator) is an interactive power system simulation package designed to
simulate high voltage power system operation. In the standard mode Simulator solves the power flow
equations using a Newton-Raphson power flow algorithm. However with the optimal power flow (OPF)
enhancement, Simulator OPF can also solve these equations using an OPF. In particular, Simulator
OPF uses a linear programming (LP) OPF implementation.
All of the OPF commands and options are accessed using the LP OPF main menu item. Other
commands in this menu are used to specify input options, see results, and store/retrieve OPF specific
data into auxiliary files.
The purpose of an OPF is to minimize an objective (or cost) function by changing different system
controls taking into account both equality and inequality constraints which are used to model the
power balance constraints and various operating limits.
In Simulator OPF the LP OPF determines the optimal solution by iterating between solving a standard
power and then solving a linear program to change the system controls to remove any limit violations.
See OPF Primal LP for more details.

1247
©2011 PowerWorld Corporation

OPF Objective Function
The objective of the OPF algorithm is to minimize the OPF objective function, subject to various
equality and inequality constraints. Since the objective of the OPF is to minimize an objective function,
what objective function is used has a significant impact on the final solution.
Currently two objective functions are available in Simulator OPF: Minimum Cost and Minimum Control
Change. Minimum Cost attempts to minimize the sum of the total generation costs in specified areas
or super areas. Minimum Control Change attempts to minimize the sum of the absolute values of the
changes in the generation in the specified areas or super areas.
To include an area or super area in the OPF objective function, simply change the Area AGC Status
field to "OPF" on the OPF Area Records Display or the Super Area AGC Status field to "OPF" on the
OPF Super Area Records Display. This gives you great flexibility in defining the OPF study. For example
you can set the OPF to minimize costs for the entire system, or just selected areas or super areas.
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OPF Equality and Inequality Constraints
In solving a constrained optimization problem, such as the OPF, there are two general classes of
constraints, equality and inequality. Equality constraints are constraints that always have to be
enforced. That is, they are always "binding". For example in the OPF the real and reactive power
balance equations at system buses must always be satisfied (at least to within a user specified
tolerance); likewise the area MW interchange constraints. In contrast, inequality constraints may or
may not be binding. For example, a line MVA flow may or may not be at its limit, or a generator real
power output may or may not be at its maximum limit.
An important point to note is because the OPF is solved by iterating between a power flow solution
and an LP solution, some of the constraints are enforced during the power flow solution and some
constraints are enforced during the LP solution. The constraints enforced during the power flow are,
for the most part, the constraints that are enforced during any power flow solution. These include the
bus power balance equations, the generator voltage set point constraints, and the reactive power
limits on the generators. What differentiate the LP OPF from a standard power flow are the constraints
that are explicitly enforced by the LP. These include the following constraints:
Equality Constraints
Inequality Constraints
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OPF Equality Constraints
Area MW Interchange
The area MW interchange constraints are enforced during the LP for those areas that have an AGC
Status equal to OPF provided the area is not part of a super area that is also set on AGC. The AGC
Status field for an area can be set using the OPF Area Records display, while the AGC Status field
for the super area (if any) is set using the OPF Super Area Records display. Areas whose interchange
is enforced during the LP do not have their interchange enforced during the power flow solution that
is done as part of the LP process; during the power flow these areas are treated as though they
were off of AGC (and hence the output of generators in that area is not varied during the power
flow).
It is perfectly acceptable to have some areas on OPF AGC control and to have other areas on the
more traditional power flow area AGC such as ED or Part. AGC. The interchange for such areas is
controlled during the power flow solution.
Following a successful solution, marginal costs are calculated for the area interchange constraints;
these values are displayed on the OPF Area Records display and can be contoured. See OPF
Marginal Costs for details.
Bus MW and Mvar power balance
Enforced during the power flow solution. Following a successful solution, marginal costs are
calculated for the bus MW (real power) balance constraint; these values are displayed on the OPF
Bus Records display and can be contoured.
Generator Voltage Setpoint
Enforced during the power flow solution. Following a successful solution, marginal costs are
calculated for the voltage setpoint constraint; these values are displayed on the OPF Bus Records
display .
Super Area MW Interchange
Super area interchange constraints are enforced similar to the area constraints. That is, super area
interchange constraints are enforced during the LP only for those super areas that have an AGC
Status equal to OPF. The AGC Status field can be set using the OPF Super Area Records display.
During the power flow solution that is part of the LP process, such super areas are treated as though
they were off of AGC.
Interface MW limits when treated as Equality
Interface MW limits are enforced during the LP solution. Interface MW limits are normally treated as
inequality constraints (see Inequality Constraints ), however they can optionally be treated as
equality constraints. See the Interface Dialog for information on how to treat the limit as an equality
constraint.
Transmission Line and Transformer (Branch) MVA limits
Branch MVA limits are enforced during the LP solution. Branch MVA limits are normally treated as
inequality constraints (see Inequality Constraints ), however they can optionally be treated as
equality constraints. See the Branch Information Dialog for information on how to treat the limit as
an equality constraint.
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OPF Inequality Constraints
The following classes of inequality constraints are enforced during the OPF solution.
Generator real power limits
Generator real power limits are enforced during the LP solution.
Generator reactive power limits
Generator reactive power limits are enforced during the power flow solution.
Interface MW limits
Interface MW limits are enforced during the LP solution. In short, interface records are used to
represent the aggregate flow through a number of different devices (see Interface Records for
details). During the LP the MW flow through the interface is constrained to be less than or equal to a
user specified percentage of its limit, provided the interface is active for enforcement. For an
interface to be active for enforcement the following three conditions must be met:






Interface enforcement must not be disabled for the case. This field can be set from either the
OPF Options and Results dialog or the OPF Interface Records display. The default is that case
interface enforcement is not disabled. Also note that interface flow is limited to a percent of its
limit as specified by the interface's Limit Monitoring Settings.
Interface enforcement must be active for at least one of the interface's areas. Note, an
interface is assumed to be in each area that contains at least one of its components. This field
can be set from the OPF Area Records display. Note: the default is that interface enforcement
is not active, so be sure to activate this if you want these constraints enforced.
Enforcement must be active for each individual interface. This field can be set from the OPF
Interface Records display or in the Limit Monitoring Settings Dialog. The default is active.

Each interface that is active for enforcement is modeled as an inequality constraint, which may be
either binding or not binding. If the constraint is not binding then it does not impact the solution. If
a constraint is binding then it has an associated marginal cost of enforcement, which is shown on
the OPF Interface Records display.
Transmission Line and Transformer (Branch) MVA Limits
Transmission line and transformer (branch) MVA limits are enforced during the LP solution. During
the LP the branch line flow is constrained to be less than or equal to a user specified percentage of
its limit, provided the branch is active for enforcement. For a branch to be active for enforcement
the following three conditions must be met:






Line/Transformer enforcement must not be disabled for the case. This field can be set from
either the OPF and Results Options dialog or the OPF Line/Transformer Records display. The
default is that case line/transformer enforcement is not disabled. Also note that the branch flow
is limited to a percent of its limit as specified by the branche's Limit Monitoring Settings.
Branch enforcement must be active for the branch's area. For tie-lines enforcement must be
active for either area. This field can be set from the OPF Line/Transformer Records display. The
default is that branch enforcement is not active, so be sure to activate this if you want these
constraints enforced.
Enforcement must be active for each individual branch. This field can be set from the OPF
Line/Transformer Records display or in the Limit Monitoring Settings Dialog. The default is
active.
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Each branch that is active for enforcement is modeled as an inequality constraint, which may be
either binding or not binding. If the constraint is not binding then it does not impact the solution. If
a constraint is binding then it has an associated marginal cost of enforcement, which is shown on
the OPF Line/Transformer Records display.
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Determining Set of Active Inequality Constraints
A key issue in quickly solving the OPF is for the LP to effectively determine the set of active inequality
constraints. Currently this includes the line MVA limits and the interface MW limits. Because the speed
of the LP varies as the cube of the number of constraints active in the LP basis, it is extremely
important to keep this number as small as possible. Therefore it would be very computationally
prohibitive to setup an inequality constraint for each transmission line and interface (except in very
small systems.)
The solution of setting up constraints only for those inequality constraints that are actually violating
their limits is a step in the right direction, but suffers from the problem that during a solution a line
may initially be violating its limit and then after the first iteration it is no longer violating. However if it
is not subsequently included as a constraint during the next iteration the solution may simply oscillate
between enforcing/unenforcing this constraint. This problem can be resolved by keeping that
constraint in the basis even though it is no longer binding.
However this raises a question about how to handle these constraints during future OPF solutions. For
example what would happen if a user solved the OPF, and then immediately resolved the OPF.
Following the first solution the constraint would be enforced so that it may actually be less than its
limit. However if this constraint is not included in the LP basis during the next solution the constraint
may immediately violate during the first iteration, requiring a number of iterations just to return to the
original initial solution.
Simulator solves this issue by keeping track of the enforced constraints from one solution to the next.
Constraints are only removed from the basis if they the fall below a specified percentage of their limit.
This percentage is enterable on the Constraint Options page of the OPF Options and Results Dialog.
This prevents the set of constraints in the basis from building up over time as a number of different
system conditions (and hence constraints) are studied. Also, at any time this set of constraints can be
cleared using the Initialize OPF Button on the OPF Options and Results Dialog.
Also, the user is free to specify that a particular constraint always be included in the basis. This is
done by toggling the Constraint field to "Always" on the OPF Line/Transformer Records or OPF
Interface Records displays.
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OPF Unenforceable Constraints
The goal of the LP OPF is to minimize the objective function subject to the user specified constraints.
However there is no guarantee that it is even possible to simultaneously satisfy all of the specified
constraints. In fact, it is quite easy to create a system in which all of the constraints cannot be
enforced. A simple example is a two bus system consisting of a single generator supplying a single
load through a transmission line. If the transmission line MVA rating is below the MVA of the load then
it is impossible to supply this load while simultaneously satisfying the transmission line constraint. In
Simulator OPF such a situation is known as an unenforceable constraint. In studying large systems,
such as the U.S FERC 715 cases, such situations actually appear to be quite common. Seemingly
unenforceable constraints are often due to a lack of controls available to the LP OPF or due to faulty
limits entered in the case. In such cases unenforceable constraints can be corrected by making more
controls available to the LP OPF or correcting the limits.
Simulator OPF allows you to solve systems with unenforceable constraints by only enforcing those
constraints that have a marginal cost below a user specified tolerance. These tolerances are specified
on the OPF Options Constraint Options Page. Any constraints that have marginal costs above these
values are not enforced, including any unenforceable constraints. This functionality is implemented in
Simulator OPF through the use of slack variables. Slack variables are artificial variables introduced
during the LP solution in order to satisfy the constraints with the slack variable costs equal to the user
specified values. Then, during the LP solution the slack variables are usually removed from the LP
basis. The only time this does not occur is if the constraint can not be enforced with a marginal cost
less than the specified value. The number of unenforceable constraints are shown on the OPF Option
Solution Results Page.
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OPF Marginal Costs
During any constrained minimization there is a cost associated with enforcing the equality constraints
and the binding inequality constraints. These costs are known as the marginal costs.
In Simulator OPF marginal costs are calculated for the following record types:
Bus MW Equality Constraints
The Bus MW marginal costs tell the incremental cost to supply one additional MW of load at the
specified bus. These values can be viewed on the OPF Bus Records display; they can also be
contoured or viewed on the one-lines using bus fields.
In the absence of any binding inequality constraints (such was Line MVA constraints) all of the bus
marginal costs in an area should be identical. Bus marginal costs can only be determined for buses
that are in areas or super areas on OPF control.
Area MW Equality Constraints
The Area MW marginal costs tell the incremental cost for the specified area to import one additional
MW of load from the system slack bus. These values can be viewed on the OPF Area Records
display; they can also be contoured or viewed on the one-lines using area fields. In the absence of
any binding inequality constraints the area MW marginal cost is identical to the bus MW marginal
costs for all the buses in the area. When there are binding inequality constraints this is no longer the
case.
Super Area MW Equality Constraints
The Super Area MW marginal costs are identical to the area marginal costs except they apply to
super areas rather than areas.
Interface MW Constraints
The Interface MW marginal costs tell the incremental cost of enforcing the interface MW constraints.
These values are only nonzero if the interface constraint is actually active (binding); they can be
viewed using the OPF Interface Records display.
Line/Transformer MVA Constraints
The Line/Transformer marginal costs tell the incremental cost of enforcing the line or transformer
MVA constraint. These values are only nonzero if the line or transformer constraint is actually active;
they can be viewed using the OPF Line/Transformer Records display.
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OPF Primal LP
Go to the Add Ons ribbon tab and select Primal LP from the OPF ribbon group to solve the OPF using
the primal LP algorithm.
In Simulator OPF the LP OPF determines the optimal solution by iterating between solving a standard
power flow and then solving a linear program to change the system controls to remove any limit
violations. The basic steps in the LP OPF algorithm are
1.
2.
3.

4.
5.
6.

Solve the power flow
Linearize the power system about the current power flow solution. Both constraints and controls
are linearized.
Solve the linearly-constrained OPF problem using a primal LP algorithm, computing the
incremental change in the control variables. Slack variables are introduced to make the problem
initially feasible. That is, the slack variables are used to satisfy the equality and inequality
constraints. The slack variables typically have high costs so that during the iteration the slack
variables change to satisfy the constraints. The LP then determines the optimal, feasible solution
for the linear problem.
Update the control variables and resolve the power flow.
If the changes in the control variables are below a tolerance then the solution has been reached;
otherwise go to step 2.
Finish by resolving the power flow.
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OPF Future Enhancements
While we certainly plan on introducing additional functionality in future releases, we do want to be as
clear as possible about what functionality is not currently provided.
The current version of Simulator OPF allows users to calculate the optimal solution to a power system
using generator real power MW outputs and phase shifters as controls, while enforcing area, super
area, interface MW and line/transformer MVA constraints. Marginal losses can also be included in the
OPF calculation.
Some functionality that is not included in the current version of Simulator OPF, and which we hope to
include in future versions, include the following:





Enforcing bus low/high voltage magnitudes as limits
Including additional devices as controls, such as generator voltage setpoints, LTC transformers,
switched shunts.
Allowing the optimization of different cost functions.
Additional functionality as suggested by customers.
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OPF Options and Results
The OPF Options and Results dialog allows you to customize the OPF solution. To display this dialog,
go to the Add Ons ribbon tab and select Options and Results from the OPF ribbon group. The
dialog consists of three general pages; Options, Results and LP Solution Details.
The Options page has four tabs as well, Common Options, Constraint Options, Control Options, and
Advanced Options
The Results page has four tabs, Bus MW Marginal Price Details, Bus Mvar Marginal Price Details, Bus
Marginal Controls, and Solution Summary.
The LP Solutions Page has five tabs, All LP Variables, LP Basic Variables, LP Basis Matrix, Inverse of LP
Basis, and Trace Solution.
The dialog also has several buttons at the bottom of the display:
OK, Cancel
Select to close the dialog. Selecting OK saves your changes while Cancel does not. Note that
changes are also saved anytime you select Solve LP OPF or Single Outer Loop.
Solve LP OPF
Solves the OPF using the Primal LP algorithm. Equivalent to selecting Primal LP from the Optimal
Power Flow ribbon group on the Add Ons ribbon tab.
Single Outer Loop
Does a single outer loop of the Primal LP algorithm.
Initialize LP OPF
Returns the LP OPF variables to their original states.
Print
Prints the selected page of the dialog.
Help
Displays this help page. To view help for a particular page place the cursor on the page and press
the F1 key.
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OPF Options: Common Options
The OPF Dialog, Common Options page displays general options associated with the OPF solution. The
display contains the following fields:
Objective Function
Allows a choice of solving the LP using either a minimum cost or a minimum control change objective
function.
OPF Reserves Options
These options are only available with the OPF Reserves add-on.
Include OPF Reserve Requirements
Check this box to include OPF reserve constraints in the OPF calculation.
Use a Single Control for Up/Down Regulation
Check this box to use a single bidirectional control for regulating reserve up or down. A unit will
provide the same amount of regulating reserve up or down.
LP Control Variables
Disable All Phase Shifter Controls
Prevents phase shifters from attempting to control devices during the OPF solution.
Disable All Generator MW Controls
Prevents generators from shifting MW output during the OPF solution.
Disable All Load MW Controls
Prevents loads from shifting MW demand during the OPF solution.
Disable Area-toArea MW Transaction Controls
Prevents MW transactions between areas from being dispatched during the OPF solution.
Disable DC Transmission Line MW Controls
Prevents shifting of DC Transmission Line MW transfers during the OPF solution.
LP Options
Maximum Number of LP Iterations
Maximum number of allowable iterations for the LP portion of the LP OPF. How many iterations are
required to obtain a solution depends, among other things, upon the number of breakpoints in the
control cost models. Since each LP iteration can only move from one breakpoint to the next, the
finer the model the more iterations required. However the LP is quite fast so a large number of
iterations can be performed quite quickly. Default = 1000. Select Treat Maximum LP Iterations
Solutions as Valid will treat the maximum number of iteration as a valid solution in the LP OPF.
Phase Shifter Cost ($ / Degree)
Specifies the assumed cost for moving phase shifting transformer taps away from their initial values.
The purpose for this fictitious cost is approximate the cost of actually changing the angle of a phase
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shifting transformer, and to avoid large changes in phase shifter angles that have very little impact
on the system. This field may be zero. Default = $ 0.10 / Degree.
Calculate Bus Marginal Cost of Reactive Power
When this option is checked, the OPF algorithm will also calculate the marginal cost of reactive
power at each bus. Typically the result of interest from the OPF algorithm is the MW marginal cost
of each bus (the LMP), but the MVAR marginal cost can be determined as well.
Save Full OPF Results in PWB File
When checked, Simulator will store the full set of results, including the LP matrix, in the PowerWorld
Binary case file.
Do Detailed LP Logging
When checked, Simulator will write details on the LP algorithm solution during each pivot of the LP
matrix. This is useful for debugging LP solution issues when running a LP OPF solution.
Start with Last Valid OPF Solution
When checked, Simulator will start the LP OPF solution process using the most recent OPF solution
as the initial conditions.
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OPF Options: Constraint Options
The OPF Dialog, Constraint Options page displays options associated with the enforcement of the
constraints by the OPF. The display contains the following fields:
Line/Transformer Constraints
Disable Line/Transformer MVA Limit Enforcement
Select to disable enforcement of Line/Transformer MVA constraints for the entire case.
Percent Correction Tolerance
Specifies a tolerance for the enforcement of line/transformer MVA flows. The tolerance is necessary
to prevent solution oscillations due to the non-linear nature of the actual constraints.
Violated elements are always enforced to their limits multiplied by the MVA Enforcement Percentage.
If power systems were completely linear then following the LP solution the constraint would actually
be equal to this value. However because of nonlinearities, the constraint is close to this value but
usually not identical to the value. The Percent Correction Tolerance is used to tell the OPF how close
is close enough. Provided all the constraints are violating their limits by less than the correction
tolerance percentage the optimal solution is assumed to have been found. You may set this value as
low as you like, but setting it too close to zero may result in convergence difficulties. The default is 2
percent.
MVA Auto Release Percentage
Specifies a MVA level at which transmission lines can be released as an OPF constraint equation if
the branch MVA flow falls below the level specified.
Maximum Violation Cost ($/MWhr)
If a branch MVA limit cannot be enforced during an OPF solution, the branch will be assigned a
fictitious cost of enforcement equal to this value. This value is usually rather large in order to easily
determine where the unenforceable constraint is occurring. The default value is 1000 $/MWhr.
Enforce Line/Transformer MW Flow Limits (Not MVA)
Checking this box will cause Simulator to treat the limits of the transmission elements as MW limits
instead of MVA limits. Thus Simulator will report violations on these elements in the OPF based on
the MW flow of the element versus the element’s MVA rating.
Interface Constraints
Disable Interface MW Limit Enforcement
Select to disable enforcement of Interface MW constraints for the entire case.
Percent Correction Tolerance, MW Auto Release Percentage, Maximum Violation Cost
($/MWhr)
These fields are equivalent to the entries described above for Line/Transformer MVA Constraints
except that they apply to Interface MW constraints.
Monitor/Enforce Contingent Interface Limits
This option allows you to choose if contingency elements in interfaces should be enforced during the
OPF solution. Even if they are not enforced, the flows on the remaining elements in the interface will
be monitored. The choices you have for enforcing contingency elements in interfaces during the OPF
are Never, Power Flow/OPF but not CA/SCOPF, or All Applications including CA/SCOPF. The reason
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CA (contingency analysis) and SCOPF (Security Constrained OPF) are singled out is because those
two tools are already looking at contingency actions separately, outside of the interface definitions.
Therefore it may be desired to ignore the inclusion of contingency elements within an interface
definition when using these two tools.
Phase Shifting Transformer Regulation Limits
Disable Phase Shifter Regulation Limit Enforcement
Select to disable enforcement of Phase Shifter regulation limit constraints for the entire case.
For a phase shifter, there are two limits which can be enforced during the OPF—the MVA branch
rating, and the regulation minimum and maximum MW flow. Checking this option will globally
disable the enforcement of the regulation minimum and maximum MW flow for all phase shifters.
In Range Cost ($/degreehr)
The cost of changing a phase shifter angle away from zero degrees in $/degreehr, when the angle is
within the allowable range of the phase shifter.
Maximum Violation Cost ($/MWhr)
If a phase shifter regulation limit cannot be enforced during an OPF solution, it will be assigned a
fictitious cost of enforcement equal to this value. This value is usually rather large in order to easily
determine where the unenforceable constraint is occurring. The default value is 1000 $/MWhr.
Limit Monitoring Settings…
This button opens the Limit Monitoring Settings dialog, which allows you to change the enforcement
percentages for monitored elements.
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OPF Options: Control Options
The LP OPF Dialog, Control Options page displays options for generator control and power flow
solution. The display contains the following options:
Generator Control Options
Allow Commitment of Fast Start Generators
If this option is checked, then generators designated as Fast Start generators can be turned on or
"committed" if the OPF routine determines that doing so would reduce the overall generating costs
of the system.
See the Fast Start description in the help on OPF Generator Records for a more detailed description
of the Fast Start option of generators.
Allow Decommitment of Fast Start Generators
If this option is checked, then generators designated as Fast Start generators can be turned off or
"de-committed" if the OPF routine determines that doing so would reduce the overall generating
costs of the system.
See the Fast Start description in the help on OPF Generator Records for a more detailed description
of the Fast Start option of generators.
Round to On Percentage if Min Limit
Generators designated as Fast Start generators will be turned On when the generator output is at
the value specified by this option.
Modeling Generators without Piecewise Linear Cost Curves
The following fields specify how the OPF should handle generators that are specified as having a cubic
cost model. Because the OPF is based upon an LP implementation, all control costs must be modeled
using piecewise linear cost curves. These options permit an automatic conversion of cubic models to
piecewise linear models. Alternatively, you can very easily convert the cubic models manually using the
# Cost Curve Points field on the OPF Generator Records display or using the generator dialog.
Generators Cost Models
This field specifies how generators with cubic cost models should be handled in the OPF. The field
has three values
Ignore Them - Generators with cubic cost models are Ignored during the OPF solution. That is,
they are considered as though their AGC status was off.
Change to Specified Points per Curve - A piecewise linear cost model is automatically inserted
for the generator with a fixed number of points specified in the Total Points Per Cost Curve field
described below. This curve will approximate the generator's cubic cost model as closely as possible;
the existing cubic model is not modified. This is the default value.
Change to Specified MWs per Segment - A piecewise linear cost model is automatically inserted
for the generator such that each segment in the cost model covers the amount of MWs specified in
the MWs per Cost Curve Segment field described below. This curve will approximate the
generator's cubic cost model as closely as possible; the existing cubic model is not modified.
Total Points Per Cost Curve
Specifies the total number of segments that should be automatically inserted into the piecewise
linear cost models for those generators that are modeled using cubic cost functions. This is only
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done if the Generator Cost Modeling field is Change to Specified Points per Curve. Default =
5.
MWs per Cost Curve Segment
Specifies the number of MWs for each segment of the piecewise linear cost models that are
automatically inserted for those generators that are modeled using cubic cost functions. This is only
done if the Generator Cost Modeling field is Change to Specified MWs per Segment. Default
= 10 MW.
Save Existing Piecewise Linear Cost Curves
Generators that are modeled with cubic cost curves may have existing piecewise linear cost curves
which may have been manually entered by the user. These curves may or may not resemble the
cubic cost function. During the OPF solution the existing piecewise linear cost curves are replaced
with the auto-created cost curves. If this option is checked then the existing piecewise linear cost
curves are restored at the end of the OPF. The default and recommended option is false since this
allows one to view the actual cost curves used by the OPF.
If you would like to use a particular piecewise linear cost function simply make sure that the
generator is modeled using the piecewise linear model, which can be set on the OPF Generator
Records display.
Modeling of OPF Areas/Superareas
During the Initial OPF Power Flow Solution
Choose what manner of generation control you wish to be employed in the FIRST power flow
solution the OPF will perform, which will establish the base case load flow condition for performing
the subsequent OPF generation dispatch.
During Stand-Alone Power Flow Solutions
Choose what manner of generation control you wish to be employed in all load flow solutions
FOLLOWING the initial load flow solution. In other words, after the LP OPF routine has determined
the new generation dispatch, what type generation dispatch should be used during the normal load
flow solution.
NOTE: it is NOT recommended that you use Economic Dispatch in this case, although it is an
available option. The reason it is not recommended is that you will remove the optimal dispatch
(including constraints) just determined by the OPF in favor of lowest cost economic dispatch, which
will likely result in the re-introduction of overloaded elements that were corrected by the OPF
dispatch in the first place.
Treat Area/Superarea MW Constraints as unenforceable even when the ACE is less than
the AGC Tolerance (default is checked)
This option by default is checked, which means that if Simulator solves an OPF and the generators in
an area or super area are all either at their minimum or maximum outputs, and the area control
error is still not 0, then the area MW constraint is considered unenforceable and Simulator will assign
a large penalty cost (usually $5,000/MWhr) to the LMP's of the area. However, if you deselect this
option, you give Simulator the additional control of checking the ACE mismatch against the AGC
tolerance for the area, and if the ACE mismatch is less than the AGC tolerance, Simulator will
"acquire" the mismatch amount from the system slack bus for the area, and the area will not be
considered unenforceable in the OPF solution. The AGC tolerance is usually small, and therefore the
amount of power taken from the system slack bus will also be small. The purpose of this option is to
allow for valid LMP solutions in an area that is meant to reach its full minimum or maximum
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generator capability, but that losses and numerical rounding results in the ACE mismatch deviating
slightly from 0. It is not advised to uncheck this option if you have areas with large AGC tolerances.
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OPF Options: Advanced Options
Detection of LP Cycling
This option allows for advanced tweaking of when cycling is detected in the LP. It is recommended
that users leave the default settings in place.
Minimum Number of Degenerate Iterations to Assume Cycling
To prevent inaccurate identification of cycling in the LP solution, the minimum number of
degenerate iterations before cycling is identified can be specified manually in this box.
Minimum Number of Degenerate Iterations Multiplied by Number of Tableau Rows
To prevent inaccurate identification of cycling in the LP solution, the minimum number of
degenerate iterations as a multiple of the number of tableau rows can be specified manually in
this box.
Number of Sequential Degenerate Iterations for Last Case
This displays the number of degenerate iterations detected when performing the most recent
OPF solution.
Power Flow Recalculation
Choose one of the options to determine how often the power flow is resolved. The three options are,
"When total generator MW change > than tolerance"; "After each LP solution"; and "Only at end of
LP OPF". If the power flow is not resolved, linear sensitivities are used to determine which
constraints enter the LP tableau.
Total Generator Change Tolerance (MW)
Specifies the total generator change tolerance. The default is 500 MW.
After each LP solution
Resolves the power flow upon completion of each LP solution
Only at end of LP OPF
Resolves the power flow only after the LP OPF has completed.
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OPF Options: Solution Summary
The OPF Dialog, Solution Summary page displays general results from the last OPF solution. Click the
Save as Aux button to save these results to a Simulator Auxiliary file.
The display contains the following fields, none of which can be directly changed:
General Results
Solution Start Time, Solution End Time
The starting time and ending time of the OPF solution algorithm.
Total Solution Time, Last Solution Status
Time and status of the last OPF solution.
Number of LP Iterations
Total number of LP iterations used during the last OPF solution. The maximum number of iterations
is specified in the Maximum Number of Iterations field of the General Options page.
Initial Cost Function Value
Initial value of the OPF cost function. During the OPF the solution algorithm seeks to minimize the
cost function, subject to the equality and inequality constraints.
Final Cost Function Value
Final value of the OPF cost function.
Final Slack Cost Value
The slack cost value is an artificial cost that is only non-zero when there are one or more
unenforceable constraints.
Final Total Cost Value
The addition of the final cost function value and the final slack cost value.
Number of Buses in OPF
This field contains the total number of buses that are in areas or super areas that are on OPF
control. Thus this field need not be equal to the total number of buses in the case. Marginal costs
are only calculated for buses in OPF controlled areas or super areas.
Highest Bus Marginal Cost, Lowest Bus Marginal Cost, Average Bus Marginal Cost
Highest, lowest and average marginal cost for the buses that are in OPF controlled areas or super
areas.
Bus MC Standard Deviation
The standard deviation of the Bus Marginal Cost.
Area and Superarea Constraints
Unenforceable Area Constraints
Number of unenforceable area constraints.
Unenforceable Superarea Constraints
Number of unenforceable superarea constraints.
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Line MVA Constraints
The Line MVA Constraints fields present results associated with the enforcement of the line MVA
constraints.
Number of Initial Violations, MVA Sum of Initial Violations
Total number of lines that initially exceeded their MVA limits and were eligible for enforcement by
the OPF. For these lines only, the MVA Sum of Initial Violations field contains sum of the
absolute values of the line's actual MVA flow minus the line's MVA limit.
Number of Binding Lines
Total number of lines that are constrained to their limit value.
Highest Line MVA Marginal Cost
The highest Marginal Cost for an MVA change on a line.
Number of Unenforceable Violations
Total number of lines whose MVA flows can not be enforced by the OPF using the available controls.
MVA Sum of Unenforceable Violations
For all the unenforceable lines, this field contains the sum of the absolute values of the line's actual
MVA flow minus the line's MVA limit.
Interface MW Constraints
The Interface MW Constraints field present results associated with the enforcement of the
interface MW constraints.
Number of Initial Violations, MW Sum of Initial Violations
Total number of interfaces that initially exceeded their MW limits and were eligible for enforcement
by the OPF. For these interfaces only, the MW Sum of Initial Violations field contains the sum of
the absolute values of the interface's actual MW flow minus the interface's MW limit.
Number of Binding Interfaces
Total number of interfaces that are constrained to their limit value.
Highest Interface MW Marginal Cost
The highest Marginal Cost for an MVA change on an interface.
Number of Unenforceable Violations
Total number of interfaces whose MW flows can not be enforced by the OPF using the available
controls.
MW Sum of Unenforceable Violations
For all the unenforceable interfaces, this field contains the sum of the absolute values of the
interface's actual MW flow minus the interface's MW limit.
Generator MW Control Limit Violations
The Generator MW Control Limit Violations fields present results associated with the enforcement
of the generator MW limit constraints.
Number of Initial Violations, MW Sum of Initial Violations
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Total number of generators that initially exceeded their MW limits and were eligible for enforcement
by the OPF. For these generators only, the MW Sum of Initial Violations field contains the sum
of the absolute values of the generators’ actual MW output minus the generators’ MW limits.
Number of Unenforceable Violations
Total number of generators whose MW limits can not be enforced by the OPF using the available
controls.
MW Sum of Unenforceable Violations
For all the generators with unenforceable limits, this field contains the sum of the absolute values of
the generators’ actual MW output minus the generators MW limits.
Transformer Regulation Constraints
The Transformer Regulation Constraints fields present results associated with the enforcement of
phase shifting transformer regulation.
Number of Initial Violations
Total number of phase shifting transformers that initially exceeded their MW set point limits and
were eligible for enforcement by the OPF.
Number of Binding Constraints
Total number of phase shifting transformers that are set at their minimum or maximum regulation
value.
Number of Unenforceable Violations
Total number of phase shifting transformers whose MW regulation limits can not be enforced by the
OPF using the available controls.
Fast Start Generators
The Fast Start Generators fields present results associated with the commitment/decommitment of
fast start generators.
Number of Generators Turned On
Total number of fast start generators turned on during the OPF solution
Number of Generators Turned Off
Total number of fast start generators turned off during the OPF solution
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OPF Options: All LP Variables
The OPF Dialog, All LP Basic Variables page displays the basic and non-basic variables associated with
the final LP solution. This page is usually only of interest to users interested in the specifics of the LP
solution. Right click anywhere in the display to copy a portion or all of the display to the Window's
clipboard, or to print the results.
The display lists each of the LP variables, showing the following fields for each:
ID
Variable identifier.
Original Value
The initial value of the LP variable before OPF optimization.
Value
The final value of the LP variable after OPF optimization.
Delta Value
The difference between the original value field and the value field.
BasicVar
Shows the index of the basic variables in the LP basis. If the value is zero, the variable is non-basic.
NonBasicVar
Shows the index of the non-basic variable. If the value is zero, the variable is basic.
Cost(Down)
The cost associated with decreasing the LP variable. The field will also show if the variable is at its
max or min limit.
Cost(Up)
The cost associated with increasing the LP variable. The field will also show if the variable is at its
max or min limit.
Down Range
The available range to decrease the basic variable before a new constraint is hit.
Up Range
The available range to increase the basic variable before a new constraint is hit.
Reduced Cost Up
The cost reduction that would be experienced if an LP variable increases. If a constraint is at the
limit, the field shows the change in cost of constraint enforcement.
Reduced Cost Down
The cost reduction that would be experienced if an LP variable decreases. If a constraint is at the
limit, the field shows the change in cost of constraint enforcement.
At Breakpoint?
Yes, if the LP variable is at a break point.
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OPF Options: LP Basic Variables
The OPF Dialog, LP Basic Variables page displays the basic variables associated with the final LP
solution. This page is usually only of interest to users interested in the specifics of the LP solution.
Right click anywhere in the display to copy a portion or all of the display to the Window's clipboard, or
to print the results.
The display lists each of the basic variables, showing the following fields for each:
ID
Basic variable identifier.
Original Value
The initial value of the basic LP variable before the OPF optimization.
Value
The final value of the basic LP variable after the OPF optimization.
Delta Value
The difference between the original value field and the value of the basic variable.
Basic Var
Shows the indices of the basic variables in the LP basis.
Cost(Up)
The cost associated with increasing the basic variable.
Down Range
The available range to decrease the basic variable before a new constraint is hit.
Up Range
The available range to increase the basic variable before a new constraint is hit.
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OPF Options: LP Basis Matrix
The OPF Dialog, LP Basis Matrix page displays the basis matrix associated with the final LP solution.
This page is usually only of interest to users interested in knowing the specifics of the LP solution.
Knowing the basis matrix can be helpful in figuring out why a particular power system is exhibiting a
particular behavior. The rows of the basis matrix are the binding constraints, while the columns of the
basis matrix are the basic variables. The entries in the basis matrix then give the sensitivity of each
constraint to each of the basic variables. The width of the columns in the matrix can also be adjusted
using the Column Widths field. Finally, you can right-click anywhere in the matrix to copy the matrix
to the Window's clipboard or to print the matrix.
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OPF Options: Bus MW Marginal Price Details
The Bus MW Marginal Price Details page displays a grid containing the MW marginal prices computed
for an OPF solution. If no OPF solution has been run, the values will all be zero. The grid used for
displaying the information is a Case Information Display, which can be modified, sorted, printed, etc.,
as described in the discussion of Case Information Displays.
One key feature of this display is the breakdown in the bus MW marginal cost into three components:
the cost of energy, the cost of congestion, and the cost of losses. Also, while the bus MW marginal
cost does not change based on the reference, the costs of energy, congestion, and losses are
reference dependent. This reference is set on a per-area (or per-super area) basis in the Area
information dialog OPF tab (or the Super Area information dialog OPF tab).
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OPF Options: Bus MVAR Marginal Price Details
The Bus MVAR Marginal Price Details page displays a grid containing the MVAR marginal prices
computed for an OPF solution. If no OPF solution has been run, or if the option to compute MVAR
marginal prices has not been selected, the values will all be zero. The grid used for displaying the
information is a Case Information Display, which can be modified, sorted, printed, etc., as described in
the discussion of Case Information Displays.
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OPF Options: Bus Marginal Controls
This display shows the sensitivities of the controls with respect to the cost at each bus. A change in a
system control will have the indicated effect in the marginal cost at the system buses. Vice-versa, the
marginal cost at a bus is affected by changes in the value of the basic variables.
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OPF Options: Inverse of LP Basis
The OPF Dialog, LP Basis Matrix page displays the inverse of the basis matrix. The width of the
columns in the matrix can also be adjusted using the Column Widths field. Finally, right-click
somewhere in the matrix to copy the matrix to the Window's clipboard or to print the matrix.
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OPF Options: Trace Solution
The OPF Dialog, Trace Solution page will trace the LP OPF of the Solution of either the basic variables
values or all the store variable values. This page is usually only of interest to users interested in the
specifics of the LP solution during the OPF run. By selecting Do not trace solution, no LP OPF solution
will be tracked when performing an OPF. Right click anywhere in the display to copy a portion or all of
the display to the Window's clipboard, or to print the results.
The display lists each of the basic variables, showing the following fields for each:
ID
Basic variable identifier.

1277
©2011 PowerWorld Corporation

OPF Area Records
Displays OPF specific information about each area record in the case. To show this display select
Optimal Power Flow > Results > Areas in the Model Explorer or OPF Areas from the OPF Case
Info menu found in the Optimal Power Flow (OPF) ribbon group on the Add Ons ribbon tab while
in Run mode. The OPF Area Records Display is a class of Case Information Display and therefore can
be used in a manner consistent with the other case information displays. Specific formatting options
are available from the local menu, which can be accessed by right-clicking on any field in the display.
By default the display contains the following fields:
Number, Name
Area’s integer number and its alphanumeric identifier, 255 characters maximum.
AGC Status
Area's automatic generation control status. This is the same field shown on the Area Records
Display. The field indicates whether or not the area's generation is changing automatically to control
the area interchange.
To be included in the OPF, this field MUST be OPF. The generation costs for areas that are on OPF
control are included in the OPF objective function; otherwise they are not. Note that if the area is
part of a super area that is on AGC control, this field value is ignored.
Double-click on the field to toggle its value.
XF Phase
Specifies whether phase shifting transformers in the area are available as controls. If Yes then all
transformers in the area which have their Automatic Control Active are available for control; the
Automatic Control status for a transformer is set on the Branch Information Dialog. If No then no
transformers in the area are available for control.
Branch MVA
Specifies whether or not the MVA limits should be enforced for transmission lines and transformers
that have at least one terminal in this area. For a transmission line or transformer to be included,
Line/Transformer MVA Limit Enforcement must not be disabled on the OPF Options and Results
Dialog, and the individual line/transformer must be enabled for enforcement on the OPF
Line/Transformer display.
Interface MW
Specifies whether or not the MW limits should be enforced for interfaces that have at least one
element in this area. For an interface to be included, Interface MW Limit Enforcement must not be
disabled on the OPF Options and Results Dialog, and the individual interfaces must be enabled for
enforcement on the OPF Interface display.
Load MW Dispatch
Specifies whether or not the MW load demand in an area should be included as available for redispatch during an OPF solution. In order for loads to be included in OPF re-dispatch, each individual
load within the area must be available for control, and have either a fixed cost benefit or a
piecewise-linear cost benefit curve provided. The option to Disable All Load MW Controls must also
not be selected on the OPF Options and Results Dialog.
DC Line MW Control
Specifies whether or not DC line MW setpoints can be modified for DC lines that have at least one
terminal in this area. For a DC line to be included, DC Transmission Line MW Controls must not be
disabled on the OPF Options and Results Dialog.
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Include Marg. Losses
Specifies whether or not marginal losses should be included for the area during the OPF solution.
MW Marg. Cost Ave
For an OPF solved case this field shows the average of the bus MW marginal costs for all the buses
in the area. If there is no congestion then all of the marginal costs should be equal.
MW Marg. Cost St.Dev., Min., Max.
For an OPF solved case these fields show the standard deviation of the bus MW marginal costs for
all the buses in the area, the minimum and the maximum bus MW marginal costs.
Report Limits
Specifies whether or not the kV limits should be reported. If this is set to NO, all of the other area
options described above will be ignored because the area will not be included in any monitoring
during the OPF.
Report Min kV, Report Max kV
Specifies the values for minimum and maximum kV levels to report. Defaults are 0 and 9999. This
allows further determination of what elements that belong to the area will be included in the OPF
enforcement. Only elements with nominal voltages in the specified Min/Max kV range will be
included.
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OPF Bus Records
Displays OPF specific information about each bus record with a valid area/zone/owner filter. To show
this display select Optimal Power Flow > Results > Buses in the Model Explorer. The OPF Bus
Records Display is a class of Case Information Display and therefore can be used in a manner
consistent with the other case information displays. Specific formatting options are available from the
local menu, which can be accessed by right-clicking on any field in the display. The columns can also
be sorted by right-clicking on the heading of the field.
By default the display contains the following fields
Number, Name
Bus’s number, between 1 and 2,147,483,647 (equals 2^31 minus 1), and its alphanumeric identifier.
Area Name
Name of the bus's area.
MW Marg. Cost
Marginal change in the objective function for a one MW change in the real power load at the bus.
MVR Marg. Cost
Marginal change in the objective function for a one Mvar change in the reactive load at the bus.
Volt Marg. Cost
Marginal change in the objective function for a 0.01 per unit change in the voltage setpoint for the
bus. This field is only valid at bus’s whose terminal voltage is controlled by one or more generators.

Note from the developers – this field is still under construction – do not use it yet.
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OPF Generator Records
Displays OPF specific information about each generator record with a valid area/zone/owner filter. To
show this display select Optimal Power Flow > Results > Generator Records in the Model
Explorer. The OPF Generator Records Display is a class of Case Information Display and therefore can
be used in a manner consistent with the other case information displays. Specific formatting options
are available from the local menu, which can be accessed by right-clicking on any field in the display.
By default the display contains the following fields:
Number, Name
Number and name of the bus to which the generator is attached. The display's local menu offers you
the opportunity to view the Quick Power Flow List and the Bus View Display for this bus. You can
also use the local men to view the generator's dialog.
ID
Alphanumeric ID used to distinguish multiple generators at the same bus.
Area Name of Gen
Name of the generator's area.
AGC
Designates whether the generator's real power output is governed by automatic generation control
(AGC). If the AGC field is set to Yes the generator is on AGC in the standard power flow. When a
generator is on AGC its real power output is varied automatically, provided the generator is part of
an area or super area that is also on automatic control.
In Simulator OPF the default operating mode is that only generators on AGC control are eligible to
be OPF controls. In addition, the generator's area or super area must have AGC Status of "OPF".
However in rare instances you may wish to always make a generator available for control or never
make the generator available for control. This value is specified using OPF MW Control field.
Fast Start
Designates whether the generator is available as a Fast Start generator during the OPF solution
process. Fast start generators are another type of control available to the Optimal Power Flow
solution routine. The OPF routine can determine if a generator labeled as a fast start generator
would be beneficial in reducing the overall system costs of generation dispatch. If a fast start
generator is off-line, but could reduce the cost of the system, then the OPF routine will turn on the
generator, and increase the generator's dispatch towards optimizing the system generating cost.
Conversely, if a fast start generator is on-line, and the OPF routine determines that reducing the
generator's output to 0 would reduce the total generation cost, then the OPF routine will shut off the
generator.
Generally speaking, the fast start options should only be used with units with zero Minimum MW
limits. Hence it is really aimed at hydro units, or small units which do not need a non-zero minimum
MW output for valid operation. This requirement is needed because changing a unit's status is only
valid in the OPF routine if it is determined that the unit should dispatch 0 MW to optimize the
generating costs of the system.
OPF MW Control
Designates whether the generator's real power output should be included as a control variable in the
OPF. This field, which can be toggled, has three possible values:



"If AGCable" - Generator's control availability depends upon its AGC status.
"Yes" - Generator is available as a control, regardless of its AGC status.
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"No" - Generator is NOT available as a control, regardless of its AGC status.

Note: in order to be a control the generator must also be in an area or super area on "OPF" control.
Gen MW
The real power output of the generator.
Cost Shift $/MWh, Cost Multiplier
The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the purpose
of assessing how variations in bids impact profit. The cost function is affected based on the following
equation:
(Original Cost Function + Cost Shift) * Cost Multiplier
Cost $/Hr
The total cost of the generator, including the impact of the cost shift and cost multiplier.
MW Marg. Cost
Tells the marginal cost, in $ / MWhr, to supply one additional MW of load at this bus. If a generator
is available as a control and is not at either its minimum or maximum limit or a cost model
breakpoint, then the MW Marg. Cost field will be identical to the generator's current marginal cost.
However the usual case is for the generator to be at either a limit or a cost model breakpoint so the
usual situation is that the MW Marg. Cost field values IS NOT equal to the generator's marginal
cost.
IC for OPF
Incremental cost of the generator at its current operating point.
Initial MW
The initial real power output of the generator at the beginning of the OPF solution. You can reset
the case back to these values by selecting the LP OPF, Restore Previous Control Settings menu item.
This menu item is only available following a successful OPF solution.
Initial Cost
The initial generator cost at the beginning of the OPF solution.
Delta MW
Change in the generator's real power output as a result of the OPF.
Delta Cost
Change in the generator's cost as a result of the OPF.
Min MW, Max MW
Minimum and maximum real power output of the generator.
Cost Model
The current cost model being used for the generator. The field value is either "Cubic", indicating that
the generator's operating costs are being modeled using a cubic cost function, or "Piecewise Linear",
indicating the operating costs are being modeled using a piecewise linear cost function. Toggle the
field to change the model. Note that a generator may simultaneously have a cubic model and a
piecewise linear model.
Because the OPF uses a linear programming approach, the generator's operating costs are ALWAYS
modeled using the piecewise linear model. Generators with an existing cubic cost model are either
1) ignored as OPF controls, or 2) have a piecewise linear cost model automatically created from the
cubic model, depending upon the values specified on the OPF Options and Results Dialog.
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# Cost Curve Points
Shows the number of segments in the piecewise linear model. If no piecewise linear model exists
then this field is zero; the generator's costs are being modeled using the cubic function. For such
generators you can automatically setup a piecewise linear model simply by entering a non-zero value
for the number of points. A piecewise linear model is created that matches as closely as possible the
existing cubic model.
Fuel Type
Specifies the fuel type of the generator, if it is known; double-click to toggle through the options.
Options are Unknown, Coal, Gas, Hydro, Hydro Pumped, Nuclear, Petroleum, Solar, Wind, and
Other.
Profit $/hr
Shows the profit of the generator. Profit is calculated using this equation:
Profit = (GenMW * MW Marg Cost ) – [ Evaluation of the Generator Cost Function ]
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OPF Interface Records
Displays OPF specific information about the interface records in the case. To show select Optimal
Power Flow > Results > Interfaces from the Model Explorer. This display is actually a page of a
display showing all the potential inequality constraints in the power system. The top portion of the
display repeats the fields shown on the Constraint Options page of the OPF Options and Results dialog.
To view the Interface records click on the Interfaces tab. This displays the interfaces page which is a
class of Case Information Display and therefore can be used in a manner consistent with the other
case information displays. Specific formatting options are available from the local menu, which can be
accessed by right-clicking on any field in the page.
By default the Interface Records page contains the following fields:
Name
Name of the interface.
Monitor
Specifies whether or not the interface MW limit is enforced in the OPF solution.
Interface MW
The amount of MW flow on the interface.
MW Limit
The interface MW limit.
Percent
The amount of MW flow on the interface as a percentage of the limit.
Monitor Direction
The direction on the interface in which the flow is being monitored.
Monitor Both Directions
If set to YES, then the interface flow will be monitored in both directions. Otherwise, it will only be
monitored in the Monitor Direction.
MW Marg. Cost $ / MWh
The marginal cost of enforcing the limit on the interface.
Constraint Status
This field will be set to Binding if the interface limit is a binding constraint in the OPF solution, or
Unenforceable if the interface limit is unenforceable with the available control set.
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OPF Nomogram Records
This list displays OPF specific information about the nomogram records in the case. To show the list,
select Optimal Power Flow > Results > Nomograms in the Model Explorer. This display is
actually a page of a display showing all the potential inequality constraints in the power system. The
top portion of the display repeats the fields shown on the Constraint Options page of the OPF Options
and Results dialog.
To view the nomogram records click on the Nomogram Interfaces tab. This displays the nomogram
interfaces page which is a class of Case Information Display and therefore can be used in a manner
consistent with the other case information displays. Specific formatting options are available from the
local menu, which can be accessed by right-clicking on any field in the page.
By default the Interface Records page contains the following fields:
Nomo. Name
Name of the nomogram.
Nomo. Seg.
The segment of the nomogram. Each segment of the nomogram is treated as a separate constraint
in the OPF, and therefore is listed individually in the OPF nomogram table.
Monitor
This field will be set to YES if the nomogram segment is monitored during the OPF.
Interface MW Flow
The total MW flow for the segment of the nomogram.
MW Limit
The segment MW limit.
Percent
The amount of MW flow on the segment as a percentage of the segment’s limit.
Monitor Direction
The direction on the segment in which the flow is being monitored.
Monitor Both Directions
Yes or No field indicating if both directions should be monitored at the same time.
MW Marg. Cost $ / MWh
The marginal cost of enforcing the limit on the segment.
Constraint
This field will be set to Binding if the nomogram limit is a binding constraint in the OPF solution, or
Unenforceable if the nomogram limit is unenforceable with the available control set.
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OPF Line/Transformer Records
Displays OPF specific information about the line and transformer records in the case. To show the
display select Optimal Power Flow > Results > Branches in the Model Explorer. This display is
actually a page of a display showing all the potential inequality constraints in the power system. The
top portion of the display repeats the fields shown on the Constraint Options page of the OPF Options
and Results dialog.
To view the Line and Transformer records click on the Line/Transformers tab. This displays the
Line/Transformer page which is a class of Case Information Display and therefore can be used in a
manner consistent with the other case information displays. Specific formatting options are available
from the local menu, which can be accessed by right-clicking on any field in the display.
By default the display contains the following fields:
From Number, From Name, From Area Name
Number, Name, and Area Name of the From bus.
To Number, To Name, To Area Name
Number, Name, and Area Name of the To bus.
Circuit
Circuit identifier for the branch.
Monitor
Specifies whether or not the branch's MVA limit will be enforced in the OPF solution.
Max MVA
The maximum MVA flow on the branch. Value is determined based on the end of the branch with
the higher MVA flow.
% of MVA Limit (Max)
The maximum MVA flow as a percentage of the branch MVA limit. Value is determined based on the
end of the branch with the higher MVA flow.
Lim MVA
The MVA limit for the branch.
MVA Marg. Cost ($/MVAhr)
The marginal cost of changing the MVA flow on the branch (i.e., if the line rating were to increase by
1 MVA, what savings could be had).
Constraint
This field will be set to Binding if the branch limit is a binding constraint in the OPF solution, or
Unenforceable if the branch limit is unenforceable with the available control set.
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OPF DC Lines Records
Displays OPF specific information about the DC lines in the case. To show select Optimal Power
Flow > Results > DC Lines in the Model Explorer. This display is a class of Case Information Display
and therefore can be used in a manner consistent with the other case information displays. Specific
formatting options are available from the local menu, which can be accessed by right-clicking on any
field in the display.
By default the display contains the same fields as the normal DC Line Records case information
display, with the following additional fields:
OPF Control
Set to YES if the DC line is to be controlled during the OPF. To be controlled, at least one of the
terminals of the DC line must lie in an area that is on OPF control and this must be set to YES.
Min MW or amps, Max MW or amps
The minimum and maximum power (or current) setpoints allowed for the DC line.
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OPF Load Records
Displays OPF specific information about each load record with a valid area/zone/owner filter. To show
this display select Optimal Power Flow > Results > Loads in the Model Explorer. The OPF Load
Records Display is a class of Case Information Display and therefore can be used in a manner
consistent with the other case information displays. Specific formatting options are available from the
local menu, which can be accessed by right-clicking on any field in the display.
By default the display contains the following fields:
Number, Name
Number and name of the bus to which the load is attached. The display's local menu offers you the
opportunity to view the Quick Power Flow List and the Bus View Display for this bus. You can also
use the local menu to view the generator's dialog.
ID
Alphanumeric ID used to distinguish multiple loads at the same bus.
Area Name of Load
Name of the load’s area.
AGC
Designates whether the load’s real power demand is governed by automatic generation control
(AGC). If the AGC field is set to Yes the load is on AGC in the standard power flow. When a load is
on AGC its real power output is varied automatically during an OPF or SCOPF solution ONLY,
provided the load is part of an area or super area that is also on OPF control. Loads will not be
dispatched if the area is on some other form of AGC control.
In Simulator OPF the default operating mode is that only loads on AGC control are eligible to be OPF
controls. In addition, the load’s area or super area must have AGC Status of "OPF", and the area
must have its Load MW Dispatch set to YES.
MW
The real power output of the load.
Cost Shift $/MWh, Cost Multiplier
The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the purpose
of assessing how variations in bids impact profit. The cost function is affected based on the following
equation:
(Original Cost Function + Cost Shift) * Cost Multiplier
Hourly Benefit
The total benefit of the load, including the impact of the cost shift and cost multiplier.
MW Marg. Cost
Tells the marginal cost, in $ / MWhr, to reduce one additional MW of load at this bus. If a load is
available as a control and is not at either its minimum or maximum limit or a cost model breakpoint,
then the MW Marg. Cost field will be identical to the load’s current marginal cost. However the
usual case is for the load to be at either a limit or a cost model breakpoint so the usual situation is
that the MW Marg. Cost field value IS NOT equal to the load’s marginal cost.
Inc. Benefit
Incremental benefit of the load at it’s current operating point.
Initial MW
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The initial real power demand of the load at the beginning of the OPF solution.
Initial Cost
The initial load cost at the beginning of the OPF solution.
Delta MW
Change in the load's real power output as a result of the OPF.
Delta Cost
Change in the load's cost as a result of the OPF.
Min MW, Max MW
Minimum and maximum real power demand of the load.
# of Benefit Curve Points
Shows the number of segments in the piecewise linear model. If no piecewise linear model exists
then this field is zero.
Profit $/hr
Shows the profit of the load.
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OPF Super Area Records
Displays OPF specific information about each super area record in the case. To show this display select
Optimal Power Flow > Results > Super Areas in the Model Explorer. The OPF Super Area
Records Display is a class of Case Information Display and therefore can be used in a manner
consistent with the other case information displays. Specific formatting options are available from the
local menu, which can be accessed by right-clicking on any field in the display.
By default the display contains the following fields:
Super Area
Alpha-numeric identifier of the super area.
AGC Status
Super area's automatic generation control status. This is the same field shown on the Super Area
Records display. The field indicates whether or not the super area's generation is changing
automatically to control the super area's interchange.
The super area AGC Status field always overrides the AGC Status for the individual areas, except
when it is set to "Off AGC".
To be included in the OPF this field MUST be "OPF". In that case the generation costs for all the
areas in the super area are included in the OPF objective function. Otherwise they are only included
if the super area AGC Status is "Off AGC" and their particular area's AGC Status is on "OPF". Doubleclick on the field to toggle its value.
Num Areas
Number of areas in the super area. To see the individual areas use the local menu to view the Super
Area dialog.
Include Marg. Losses
Specifies whether or not to include marginal losses in OPF calculations for this super area.
MW Marg. Cost Ave.
If the super area is on "OPF" control then for a solved case this field shows the average of the bus
MW marginal costs for all the buses in the super area. If there is no congestion then all of the
marginal costs should be equal.
MW Marg. Cost St. Dev.
Standard deviation of the bus MW marginal costs for the buses in the super area.
ACE MW
Area control error for the super area.
Gen MW, Load MW
Total real power generation and load in the super area.
Total Sched MW, Int MW
Scheduled and actual interchange real power interchange between the super area and the rest of
the system. Both of these fields are the algebraic summation of the scheduled and actual
interchange for the areas in the super area.
Loss MW
Total real power losses for the super area.
MW Marg. Cost Min, MW Marg. Cost Max
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Minimum and maximum of all the bus MW marginal costs for the buses in the super area.

1291
©2011 PowerWorld Corporation

OPF Controls
The following classes of controls are available during the OPF solution. Note, individual classes of
controls can be enabled/disabled for the entire case using the OPF Options and Results dialog and for
particular areas using the OPF Area Records display. Also, all classes of controls have associated
minimum/maximum limits which are always enforced.
Generator MW output and Fast Start commitment
The generator MW outputs are the major control for controlling the MW flow in the network and for
minimizing the objective function. Only generators in areas or super areas that are on "OPF" control
are eligible for control; otherwise the generator's MW output remains fixed at its initial value.
Whether a particular generator is available for control also depends upon the status of its AGC and
OPF MW Control fields. These fields are set on the OPF Generator Records display. For Fast Start
Generators, it is also possible to use the startup and shutdown of these generators as a control. See
OPF Options: Control Options for more details.
Phase shifting Transformer tap position
Phase shifting transformers are used primarily to control the flow of real power in the network.
When phase shifting transformers are controlled in the OPF routine, the phase angle is allowed to
move anywhere within the phase angle range of the device in order to help alleviate violations on
other branches in the system. The flow on the phase shifter is allowed to violate the prescribed MW
range given for the phase shifter, but is NOT allowed to violate the MVA rating of the device.
Additionally, in order for a phase shifter to be included in the OPF solution dispatch, the XF Phase
property of the area must be set to YES. Each individual phase shifter also has a property for being
included in the OPF control that must be turned on in order for the phase shifter to participate in the
OPF dispatch. This option can be set for a phase shifting transformer by opening its Information
Dialog and checking the OPF Phase Shifter Control options on the OPF page of the dialog.
Load MW Dispatch
The load MW demands can also be included as controls for re-dispatch during an OPF solution. The
concept of controlling a load is generally the same as controlling a generator. Loads can be assigned
piecewise linear benefit curves, and included in the OPF dispatch algorithm. Only areas whose AGC
control is set to "OPF" are eligible for control. Furthermore, the OPF area’s Load MW Dispatch
property must also be set to YES. Each area load that is to be included for OPF dispatch must have a
benefit model defined, and have its Available for AGC field set to YES. These fields can be set in the
OPF Load Records display.
DC Line MW setpoint
DC Line MW setpoints can be used as controls in the OPF. See OPF DC Lines Records.
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OPF Phase Shifter Records
Displays OPF specific information about each phase shifter record in the case. To show this display,
select Optimal Power Flow > Results > Phase Shifters in the Model Explorer. The OPF Phase
Shifter Records display is a class of Case Information Display and therefore can be used in a manner
consistent with the other case information displays. Specific formatting options are available from the
local menu, which can be accessed by right-clicking on any field in the display. The columns can also
be sorted by right-clicking on the heading of the field.
By default the display contains the following fields:
From Number, From Name
The name and number of the bus at the From end of the phase shifter.
To Number, To Name
The name and number of the bus at the To end of the phase shifter.
Circuit
The circuit identifier for the phase shifter.
OPF Control
Specifies whether or not the phase shifter is available for control during an OPF solution.
Area PS Control
Specifies if automatic phase shifter control has been enabled for the area containing the particular
phase shifting transformer. If the area phase shifter control is disabled, all phase shifting
transformers within the area will remain fixed at their initial settings during the entirety of the OPF
solution process. This setting overrides the individual automatic control settings of each phase
shifting transformer within the area.
XF Auto
Specifies if the transformer automatic control is enabled. If an individual transformer's automatic
control is disabled, it will remain at it's initial settings during the entirety of the OPF solution process.
Phase (Deg)
The actual phase shift of the phase shifter, in degrees.
Initial Degrees
The initial phase angle before the OPF solution was calculated.
Delta Degrees
The change in the phase angle during the OPF solution.
Tap Min, Tap Max
The minimum and maximum tap positions allowed for the phase shifter operation.
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OPF Example - Introduction
As a simple example of using the OPF, consider the seven bus, three area system contained in the file
B7OPF.pwb (included with the PowerWorld Simulator). For this case all three areas are initially on
Economic Dispatch (ED) AGC control and hence by default would not be included in the OPF solution.
Also, the initial interchange between the areas is equal to zero and the generators are modeled using
cubic cost functions.
To initially solve the case using the standard power flow, select Single Solution in the Power Flow
Tools ribbon group on the Tools ribbon tab. The case should look like the following figure:

B7OPF Case Solved using Economic Dispatch
Now we'll modify the case to set the three areas for OPF control. To do this, select Optimal Power
Flow > Results > Areas in the Model Explorer to display the OPF Area Records display. Toggle the
AGC status for each of the three areas to change it to "OPF". Now select Primal LP in the OPF ribbon
group on the Add Ons ribbon tab to solve the case using the LP OPF. The results should look similar to
the figure below. The one-line shows the hourly cost for each area and the total case hourly cost,
equal to $ 16,888 / hr.
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B7OPF Case Solved using LP OPF
Note that the results are very similar but not identical to the economic dispatch case. We would expect
the cases to be similar since for cases with no congestion the OPF solution should be (ideally) equal to
the economic dispatch solution. The difference between the two is because in the LP OPF the
generator cost functions are converted from a cubic model to a piece-wise linear model using a user
specified number of segments, which is 5 segments by default. This value can be viewed/modified
from the Control Options page of the OPF Options and Results display.
Change the Total Points Per Cost Curve field to 100 and resolve. The results are shown in the
figure below, which now are almost identical to the economic dispatch results. The disadvantage in
using a large number of cost segments is that it degrades the performance of the LP OPF slightly on
larger cases.
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B7OPF Case Solved using LP OPF with 100 Cost Segments for Generators
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OPF Example - Marginal Costs
Using the OPF solution from the previous page, select Optimal Power Flow > Results > Buses in
the Model Explorer to view the bus marginal costs and Optimal Power Flow > Results > Areas in
the Model Explorer to view the area marginal costs. The results should be as shown below.

Seven Bus Case Bus Marginal Costs

Seven Bus Case Area Marginal Costs
Note that the marginal costs for all the buses in an area are identical to the area's MW marginal cost.
This is the expected result for systems without any line congestion. The area MW marginal costs are
not identical. This is because currently each area is independently enforcing its own MW interchange.
In the next example we'll jointly dispatch the three areas by combining them into a single super area.
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OPF Example - Super Areas
To jointly dispatch the three areas we'll first combine them into a single super area. To setup the
super area first select Optimal Power Flow > Results > Super Areas from the Model Explorer to
display the OPF Super Area Records display (alternatively you could also use the Aggregations >
Super Areas display). To enter a new super area, right click on the "None Defined" entry in the first
row of the display to show the display's local menu. Select Insert. This displays the super area dialog.
Select Rename and enter a name for the new super area, "ThreeAreas." To add the three areas to
the new super area enter "1-3" in the New Area #'s field and then select Add New Areas by
Number (alternatively you could select the areas from the New Area Name list). Also, to enable the
super area for control, set the Super Area Control Options field (AGC Status) to Optimal Power
Flow Control. Select the Ok button to save the new super area.
Before resolving the OPF, let’s temporarily disable enforcement of line MVA constraints. You can do
this from the Constraint Options page of the OPF Options and Results dialog. Check the Disable
Line/Transformer MVA Limit Enforcement.
Also, now would be a good time to save the changes. To avoid overwriting the existing B7OPF file,
select Save Case As from the Application button to save the case (pwb and pwd files) with a different
name, say B7OPFSA (SA for super area).
Select Primal LP from the OPF ribbon group on the Add Ons ribbon tab to resolve the OPF. The
results should be as shown below.

OPF Solution with Super Area WITHOUT Enforcing Line MVA Constraints
With the super area the individual area interchange constraints are no longer enforced. This permits
the free interchange of power between the areas, resulting in an overall decrease in the total case
hourly cost from $ 16,887 / hr to $ 16,227 / hr. View the OPF Bus Records display to verify that all the
bus marginal costs are identical, equal to $ 17.10 / MWh. Of course the key problem with solving the
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system using the super area is that now there are line violations. These violations will be removed next
by enforcing the line MVA constraints.
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OPF Example - Enforcing Line MVA Constraints
To remove the line MVA violations go back to the Constraint Options Page of the OPF Options and
Results dialog. Uncheck the Disable Line/Transformer MVA Limit Enforcement.
Now resolve the LP OPF, enforcing the line constraints. The resultant solution is shown below.

OPF Solution with Super Area WITH Line MVA Constraint Enforcement
With line constraint enforcement active the OPF optimally redispatches the generation taking into
account the line MVA limits. However, enforcing these line constraints comes at a cost. Notice that the
total case hourly cost has increased from $ 16,227 / hr to $ 16,548 / hr, which is still substantially less
than the $ 16,887 / hr figure we had for the case without the superarea.
Enforcing the line constraints also has an impact on the bus marginal costs, shown below.

Impact of Line MVA Enforcement on the Bus Marginal Costs
The actual marginal cost of enforcing the line constraint can also be viewed on the OPF
Line/Transformer MVA Records display. The MVA Marg. Cost tells the marginal cost of enforcing the
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constraint, expressed in units of $ / MVA / hr. Left-click on the MVA Marg Cost field header to sort
the display using this field.
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Security Constrained Optimal Power Flow Overview
Note: The SCOPF option in PowerWorld Simulator is only available if you have purchased
the SCOPF and OPF add-ons to the base package. To learn more about the SCOPF, please
feel free to read through the information contained in these help files. Contact
PowerWorld Corporation for details about ordering the SCOPF and OPF versions of
Simulator.
The optimal power flow (OPF) algorithm has the purpose of minimizing an objective function (usually
total operation cost) by changing different system controls while meeting power balance constraints
and enforcing base case operating limits. Normally however, the secure operation of a power system
requires that there be no unmanageable contingency violations. Thus, the minimization of the
objective function requires considering contingencies. This is achieved using a security constrained
optimal power flow (SCOPF) algorithm.
While the optimal power flow (OPF) algorithm determines the optimal state of the system by iterating
between solving a power flow and solving a linear program that changes the system controls, during
the SCOPF solution process in addition to solving the base case power flow, all contingencies must also
be solved. The linear program which then runs changes the system controls to remove contingency
violations as well as base case operating violations.
The SCOPF algorithm makes control adjustments to the base case (pre-contingency condition) to
prevent violations in the post-contingency conditions. If enough controls are available in the system,
the solution minimizes the objective function and the system enforces contingency violations. If the
system does not have enough controls, then some violations may be persistent under certain
contingencies. Those represent unenforceable constraints, which result in high bus marginal costs.
The commands and options for the SCOPF are accessed by selecting the SCOPF option from the OPF
ribbon group on the Add Ons ribbon tab. The SCOPF function uses the OPF options defined in the OPF
Options and Results dialog and the contingency settings specified in the contingency analysis dialog.
Please read through the OPF and the contingency analysis help for more information about these
settings. We encourage you to become familiar with Simulator OPF and the contingency analysis tool
before running SCOPF simulations. Other commands in the SCOPF dialog are used to specify the base
case solution process and for accessing the SCOPF results.
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SCOPF Objective Function
The SCOPF objective function uses the function defined in the OPF settings. There are two objective
functions in Simulator: Minimum Cost and Minimum Control Change. Minimum Cost attempts to
minimize the sum of the total generation costs in specified areas or super areas. Minimum Control
Change attempts to minimize the sum of the absolute value of the change in the generation in the
specified areas or super areas. The objective function is set up in the OPF Options and Results dialog.
The result of the SCOPF will be different from the OPF solution because the SCOPF meets additional
inequality constraints associated with the contingency violations.
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SCOPF Dialog
The SCOPF dialog allows the user to control options of Security Constrained OPF, as well as to access
the optimization results.
The SCOPF can be run from this dialog using the Run Full Security Constrained OPF button at the
top of the form.
There are three pages of information included in this form:
Options
Results
LP Solution Details
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SCOPF Solution Process
The SCOPF involves three major steps that can be solved either automatically or manually from the
SCOPF control dialog:




Initialization to setup the SCOPF LP tableau and the control structures
Contingency analysis calculation and storage of control sensitivities associated with each
contingency violation
SCOPF iterations, which include an LP solution and a power flow solution. During each LP step in
the LP routine, the algorithm enforces the newest most severe contingency violation. After each
violation is processed, all of the unprocessed violations are updated. This step is crucial since often
resolving the most severe violation resolves numerous other violations. For instance, a single line
might be overloaded in a number of contingencies: fixing the worst contingency fixes the others as
well. On the other hand, processing some violations may result in new violations. In order to verify
that no new violations have been created by the control changes made, the SCOPF will go back to
step two and reprocess all the contingencies and the new base solution. The number of times this
iteration occurs is determined by the Maximum Number of Outer Loop Iterations.

The SCOPF terminates when all the contingency violations have been processed. Note that the user
can rerun the SCOPF by repeating the solution process if they want to verify the contingency violation
enforcement at the new optimal operating point.
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SCOPF Results
The Results page of the Security Constrained Optimal Power Flow form provides information on the
results of the latest SCOPF solution, including the contingency violations included, the marginal price
details, and the marginal control details.
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SCOPF Equality and Inequality Constraints
Two general types of constraints are involved in the SCOPF solution: equality and inequality
constraints. Equality constraints are constraints that have to be enforced. That is, they are always
"binding". For example in the SCOPF, as well as in the OPF and in the power flow, the real and
reactive power balance equations at system buses must always be satisfied (at least to within a user
specified tolerance). In contrast, inequality constraints may or may not be binding. For example, a line
MVA flow under a certain contingency may or may not be at its limit.
The SCOPF problem is solved by iterating between a power flow solution and a contingency
constrained LP solution, some of the constraints are enforced during the power flow solution and some
constraints are enforced during the LP solution. The constraints enforced during the power flow are,
for the most part, the constraints that are enforced during any power flow solution. These include the
bus power balance equations, the generator voltage set point constraints, and the reactive power
limits on the generators. What differentiates the SCOPF from a standard power flow and from the OPF
are the constraints that are explicitly enforced by the LP solver. These include the following
constraints:
Equality Constraints
Inequality Constraints
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SCOPF Equality Constraints
The SCOPF equality constraints are the same as the OPF equality constraints: Area MW interchange,
bus MW and Mvar power balance, Generator voltage setpoint and super area MW interchange.
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SCOPF Inequality Constraints
The following classes of inequality constraints are enforced during the SCOPF solution.
Generator real power limits
Generator real power limits are enforced during the SCOPF LP solution.
Generator reactive power limits
Generator reactive power limits are enforced during the SCOPF LP solution.
Interface MW Limits
Interface MW limits are enforced during the SCOPF solution. Interfaces are used to represent the
aggregate flow through a number of different devices. During the SCOPF the MW post-contingency
flow through the interface is constrained to be less than or equal to a user specified percentage of
its limit, provided the interface is active for enforcement. For an interface to be active for
enforcement the following three conditions must be met:






Interface enforcement must not be disabled for the case. This field can be set from either the
OPF Constraints Dailog or the OPF interfaces records. As default, the interface enforcement is
not disabled. Note that interface flow is limited to a percent of its limit as specified by the
interface's Limit Monitoring Settings.
Interface enforcement must be active for at least one of the interface's areas. Note, an
interface is assumed to be in each area that contains at least one of its components. This field
can be set from the OPF Area Records display. Note: the default is that interface enforcement
is not active, so be sure to activate this if you want these constraints enforced.
Enforcement must be active for each individual interface. This field can be specified from the
OPF interfaces records display or in the Limit Monitoring Settings dialog. The default is active.

Each interface that is active for enforcement is modeled as an inequality constraint, which may be
either binding or not binding. If the constraint is not binding then it does not impact the solution. If
a constraint is binding then it has an associated marginal cost of contingency enforcement. When
manually solving the SCOPF one can skip a contingency violation associated to the interface by
setting the Include field of the SCOPF CTG Violations dialog to No.
Transmission Line and Transformer (Branch) MVA Limits
Transmission line and transformer (branch) MVA limits are enforced during the SCOPF solution.
During the LP the post-contingency branch line flow is constrained to be less than or equal to a user
specified percentage of its limit, provided the branch is active for enforcement. For a branch to be
active for enforcement the following three conditions must be met:






Line/Transformer enforcement must not be disabled for the case. This field can be set from
either the OPF constraints dialog or the OPF Line/Transformer Records display. The default is
that case line/transformer enforcement is not disabled. Also note that the branch flow is limited
to a percent of its limit as specified by the branch's Limit Monitoring Settings.
Branch enforcement must be active for the branch's area. Enforcement for tie-lines must be
active for either area. This field can be set from the OPF Line/Transformer Records display. The
default is that branch enforcement is not active, so be sure to activate this if you want these
constraints enforced.
Enforcement must be active for each individual branch. This field can be set from the OPF
Line/Transformer Records display or in the Limit Monitoring Settings Dialog. The default is
active.
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Each branch that is active for enforcement is modeled as an inequality constraint, which may be
either binding or not binding under contingency conditions. If the constraint is not binding then it
does not impact the solution. If a constraint is binding then it has an associated marginal cost of
enforcing the contingency constraint, which is shown on the SCOPF Bus Marginal Price Details
dialog. When manually solving the SCOPF one can skip a contingency violation associated to the
branch by setting the Include field of the SCOPF CTG Violations dialog to No.
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SCOPF Control
The control dialog allows the user to manually or automatically run a SCOPF simulation and visualize
the execution of the simulation. The SCOPF solution process involves three steps: base case solution
and initialization, contingency analysis, and SCOPF iterations.
Run Full Security Constrained OPF
Press this button to run the three steps of the SCOPF solution automatically. The SCOPF will solve
the base case using the selected method, will use the currently stored list of contingencies during
the contingency analysis step, and will take the CA results and sensitivities to iterate in order to
obtain the optimal solution that minimizes cost and enforces contingency violations.
Options
Maximum Number of Outer Loop Iterations
Indicates the number of maximum outer loop iterations. The outer loop iterations determines how
many times the contingency analysis will be re-run following a successful SCOPF dispatch. In this
manner, Simulator will look for new violations that may occur due to the new generation dispatch.
Consider Binding Contingent Violations from Last SCOPF Solution
When checked, this option ensures that the contingent violations from the last SCOPF solution are
included in the current SCOPF solution. This option is helpful in preventing the SCOPF from hunting
between having a constraint binding in one solution, and resolving with it not binding in a later
solution because it was previously remedied. This option should generally always be checked, unless
the user is sure that the previous solution has no bearing on the current solution, such as having
made major changes to the system since the previous solution.
Initialize SCOPF with Previously Binding Constraints
When checked, this option results in the SCOPF solution process starts with the exact same LP
tableau from the last solution. This can make for fairly fast solutions (recognizing that the
contingency analysis needs to be resolved) when the changes to the system are small. Simulator
automatically uses this option when doing multiple outer loops of the SCOPF. This option allows the
user to solve the outer loops (set the outer loop counter to 1) by repeatedly solving the SCOPF
manually, potentially making modifications between solutions if desired.
Set Solution as Contingency Analysis Reference Case
Check this field to set the solution of the SCOPF as the contingency analysis reference. If the system
has enough controls to remove all the contingency violations, a rerun of the contingency analysis
using the SCOPF solution as the reference should report no branch violations.
Maximum Number of Contingency Violations Allow Per Element
Specify the maximum number of contingency violations that the SCOPF analysis should allow per
element. After completing the power flow solutions for the base case and the contingencies, only
this number of contingency violations per element are then passed to the linear programming
algorithm. The assumption is that if you fix the 10 worst contingency violations for an element then
the others will also be fixed.
Basecase Solution Method
Specifies whether the solution of the base case is performed using the power flow algorithm or the
optimal power flow algorithm. The selection will affect the initial conditions of the system and
consequently the contingency analysis results and the sensitivities used by the LP solver. Currently
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the SCOPF does not resolve the contingency analysis during the optimization since this is
computationally expensive. See the SCOPF solution process for details.
Handling of Contingent Violations Due to Radial Load
It is often common when computing a security constrained OPF to have violations occur on branches
due to radial load. In these instances, there is no way to adjust controls to continue to serve the
load, without overloading the serving element. Therefore you can choose how contingent violations
of this type should be handled by the SCOPF. You can choose to flag them but not include them in
the SCOPF, ignore them completely, or include the violations in the SCOPF. Note that if you include
the violations in the SCOPF, the SCOPF algorithm will not be able to remove the violation on the
element via generation dispatch. However, it may be able to do so if the load in question has a load
benefit curve defined and is available for load shed dispatch in the SCOPF routine.
DC SCOPF Options
The DC options given for the SCOPF revolve around the treatment of Line Outage Distribution
Factors (LODF) during the DC SCOPF solution. You can choose to discard the LODFs when the
SCOPF is finished, store them in memory (lost when Simulator is closed,) or in memory and in the
PWB file (if saved.)
If the LODFs have been stored and you wish to clear them (they can require quite a bit of RAM
depending on the number of contingencies and size of the case,) you can press the button labeled
Clear Stored Contingency Analysis LODFs.
SCOPF Results Summary
Number of Outer Loop Iterations
The number of outer loop iterations required to solve the SCOPF.
Number of Contingent Violations
Number of violations from the contingency analysis portion of the solution, which are used to
attempt to determine the security constrained dispatch.
SCOPF Start Time, SCOPF End Time
Physical time when the SCOPF solution process started and finished.
Total Solution Time (Seconds)
Length of time needed to determine the SCOPF solution.
Total LP Iterations
Total number of Linear Programming iterations necessary to determine the SCOPF solution.
Contingency Analysis Input
Number of Active Contingencies
The number of contingencies included in the SCOPF simulation. Specific contingencies may be
excluded from the simulation in the contingency analysis dialog by changing the skip field of a
contingency to YES. The contingency analysis dialog can be conveniently accessed from the
SCOPF control dialog.
View Contingency Analysis Form
Clicking this button shows the contingency analysis dialog.
Contingency Analysis Results
This window allows the user to monitor the details of the contingency analysis step. During
contingencies, the outage actions, the solution of each contingency, and the solution of the CA run
are reported.
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SCOPF CTG Violations
The contingency violations page is available from the Results tab of the Security Constrained Optimal
Power Flow form. The display lists the results from the latest contingency analysis run including the
violations that were included in the SCOPF and the final error for each violation. This dialog may
change if the user reruns the SCOPF by solving the contingency analysis using the SCOPF solution as
contingency analysis reference. Right click any where in the display to copy a portion or all of the
display to the Window's clipboard, or to print the results.
The display shows the following fields:
Contingency Name
This is the contingency label. By default single line contingencies start with an "L", single generator
outages with a "G", and single transformer outages start with an "X".
Category
Currently, the SCOPF considers only branch and interface violations. Thus, the category of the
contingencies should be branch MVA or Interface.
Element
Shows information about the specific element that presented the violation. When the violation
occurs in a branch, this column includes the identifiers of the sending and receiving ends of the
branch, the circuit, and the direction of the violating flow. Since Interfaces are directed, this field will
present only the interface name in the case of violating interfaces.
Value
The percentage flow that appears in the branch during the contingency prior to optimization. If this
number is larger than the scaled limit, the violation needs to be removed.
Scaled Limit
The scaled limit corresponds to the Line/Transformer Percentage specified in the limit monitoring
settings dialog. By specifying this limit to be higher than 100% some of the contingency violations
might be effectively relaxed. Sometimes this helps the OPF and the SCOPF obtain a feasible solution.
On the other hand, it is often required to analyze the performance of the system if branches would
have higher ratings.
New Value
The percentage flow that appears in the branch during the contingency after SCOPF optimization. If
this number is larger than the scaled limit, the contingency violation has not been removed and it is
therefore unenforceable. If the value is equal to the scaled limit, then the contingency violation
constraint would be binding. If the value is smaller than the scaled limit, the contingency violation
has been removed.
Error
The difference between the new value and the scaled limit. If the error is positive, the line is
unenforceable. If the error is zero, the constraint has been corrected.
Included
Indicates if the contingency violation was included as a constraint in the SCOPF solution.
Marginal Cost
Indicates the cost associated with the contingency violation. If the constraint is unenforceable, the
marginal cost is assigned arbitrarily as a high value in the OPF constraint options dialog.
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Unenforceable
Indicates whether the contingency violations is unenforceable, i.e., the system has not enough
controls to relieve the branch overload when the contingency occurs.
Skip Violation?
Change this field to NO if the contingency violations should not be included as a SCOPF constraint.
This is sometimes useful in order to analyze the effect of the contingency violation in the SCOPF
solution. This field may be toggled when doing a manual SCOPF solution.
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SCOPF LP Solution Details
The LP Solution Details page of the Security Constrained Optimal Power Flow form provides
information on the linear program solution of the SCOPF, including a list of All LP Variables, LP Basic
Variables, and LP Basis Matrix. This information applies to the linear programming tableau solution
method.
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SCOPF All LP Variables
The SCOPF All LP Variables dialog displays the basic and non-basic variables associated with the final
LP SCOPF solution. Users interested in the specifics of the LP SCOPF can access this page to obtain
internal information about the SCOPF solution. To see the display, open the Security Constrained
Optimal Power Flow form, click on the LP Solution Details tab, and access the All LP Variables page.
Right click any where in the display to copy a portion or all of the display to the Window's clipboard, or
to print the results.
The display lists each of the LP variables with the following fields:
ID
Variable identifier.
Org. Value
The initial value of the LP variable before SCOPF optimization.
Value
The final value of the LP variable after SCOPF optimization.
Delta Value
The difference between the original value field and the value field.
Basic Var
Shows the index of the basic variables in the LP basis. If the value is zero, the variable is non-basic.
These values are set up after the SCOPF calculates the contingency violation sensitivities.
NonBasicVar
Shows the index of the non-basic variable. If the value is zero, the variable is basic.
Cost(Down)
The cost associated with decreasing the LP variable. The field will show if the variable is at its max
or min limit.
Cost(Up)
The cost associated with increasing the LP variable. The field will show if the variable is at its max or
min limit.
Down Range
The available range to decrease the basic variable before a new constraint is hit under a contingency
condition.
Up Range
The available range to increase the basic variable before a new constraint is hit under a contingency
condition.
Reduced Cost Up
The cost reduction that would be experimented if a LP variable increases. If a constraint is at the
limit, the field shows the change in cost of constraint enforcement.
Reduced Cost Down
The cost reduction that would be experimented if a LP variable decreases. If a constraint is at the
limit, the field shows the change in cost of constraint enforcement.
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At Breakpoint
Yes, if the LP variable is at a break point.
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SCOPF LP Basic Variables
The LP Basic Variables (from the SCOPF LP Solution Details page) displays the basic variables of the
final LP solution. The basic variables may correspond to controls that can be altered to minimize the
objective function, or slack variables associated with unenforceable constraints. Users interested in the
specifics of the LP SCOPF can access this page to obtain internal information about the SCOPF
solution. Right click any where in the display to copy a portion or all of the display to the Window's
clipboard, or to print the results.
The display lists each LP variable with the following fields:
ID
Basic variable identifier.
Org. Value
The initial value of the basic LP variable before the SCOPF optimization.
Value
The final value of the basic LP variable after the SCOPF optimization.
Delta Value
The difference between the original value field and the value of the basic variable.
Basic Var
Shows the indices of the basic variables in the LP basis.
Cost(Up)
The cost associated with increasing the basic variable.
Down Range
The available range to decrease the basic variable before a new constraint is hit under a contingency
condition.
Up Range
The available range to increase the basic variable before a new constraint is hit under a contingency
condition.
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SCOPF LP Basis Matrix
The LP Basis Matrix page of the SCOPF LP Solution Details tab displays the basis matrix associated
with the final SCOPF LP solution. There is one row per constraint and one column per basic variable.
Additional columns summarize information associated with each constraint. This page is usually only of
interest to users interested in knowing the specifics of the SCOPF solution. Knowing the basis matrix
can be helpful in figuring out why a particular SCOPF solution exhibits a certain behavior. The entries
in the basis matrix give the sensitivity of each constraint to each of the basic variables.
As any case info display in simulator, right click to see options to copy information to the clipboard and
to perform standard windows actions, such as printing.
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SCOPF Bus Marginal Price Details
This display (from the SCOPF Results page) shows information about the components of the marginal
cost at each bus. The display is relevant to see how the bus marginal cost depends on the cost of
enforcing system constraints such as branch limits and area equality constraints. This display is useful
for indicating which constraints are contributing towards the determination of the marginal price at
each bus.
As any case info display in Simulator this display can be customized and the information copied,
printed, and saved by accessing the local menu option with the mouse right click.
One key feature of this display is the breakdown in the bus MW marginal cost into three components:
the cost of energy, the cost of congestion, and the cost of losses. Also, while the bus MW marginal
cost does not change based on the reference, the costs of energy, congestion, and losses are
reference dependent. This reference is set on a per-area (or per-super area) basis in the Area
information dialog OPF tab (or the Super Area information dialog OPF tab).
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SCOPF Bus Marginal Controls
This display (from the SCOPF Results page) shows the sensitivities of the controls with respect to the
cost at each bus. A change in a system control will have the indicated effect in the marginal cost at the
system buses. Vice-versa, the marginal cost at a bus is affected by changes in the value of the basic
variables.
The Marginal Controls page can be accessed by opening the Security Constrained Optimal Power Flow
form, and clicking on the Results tab.

1322
©2011 PowerWorld Corporation

SCOPF Example: Introduction
In this section we introduce an example of using the SCOPF. Consider the seven bus, three area
system contained in the file B7SCOPF (included with the PowerWorld Simulator). This case is the same
case used in the OPF example, except that the line from bus 2 to 3 has now a 100MVA rating, lines 1
to 2, 1 to 3 and 2 to 5 have a 120MVA rating, and all three areas are initially on OPF control. To
initially solve the case using the optimal power flow, select Primal LP in the OPF ribbon group on the
Add Ons ribbon tab. The solution obtained is shown below. The total case hourly cost is $16,011 / hr.

B7SCOPF Case Solved using OPF
We are interested in determining an optimal solution that meets security constraints under
contingency conditions. In order to show that the current OPF solution does not enforce contingency
violations, take line 1 to 2 out of service by clicking in a circuit breaker. Then solve the power flow by
pressing the Single Solution button. The result indicates that line 1 to 2 is overloaded 32%. The
SCOPF algorithm will attempt to move the operating solution such that no contingency violation occurs
in the system. Close line 1 to 2 back in service.
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B7SCOPF Power Flow Solution with line 1-2 open
The next step is to specify the contingency conditions that the system should withstand. In order to do
that, we access the Contingency Analysis dialog under Tools. Note that we can also access this dialog
from the SCOPF control dialog by selecting Add Ons > Security Constrained OPF and pressing the
View Contingency Analysis Form button on the Options page. The B7SCOPF case does not have
contingencies associated with it. Insert single line contingencies in the contingency list by pressing the
Auto Insertbutton located at the bottom left of the Contingency Analysis dialog. in the Auto Insert
Dialog select the option for Single Transmission Line or Transformerand select Numbers under
the Identify buses by field. Select Do Insert Contingencies. This will prompt to insert 11 single line
contingencies corresponding to all the lines in the system. Select Yes. You can now close the
Contingency Analysis dialog.
Return to the Security Constrained Optimal Power Flow Form. You can set the SCOPF to use
the OPF solution as the base by selecting Solve base case using optimal power flow.
You can now solve the SCOPF by pressing the Run Full Security Constrained OPF. This will
process the contingency violations and iteratively solve the LP program and the power flow equations
to minimize the objective function and enforce equality and inequality constraints. The solution is
shown below. The total operating cost is now $16,048 /hr. The increase in operating cost is due to
enforcing security constraints. If a new contingency analysis is performed using the optimal solution as
the reference, it will be found that no contingency violations occur for the contingencies in the list, i.e.,
branch flows are less than (or equal to) 100% in the post contingency condition. Thus, the system
meets all the specified constraints. You can analyze the SCOPF results by browsing the information in
the SCOPF tabs. Note that the CTG Constraints dialog does not show unenforceable constraints, but
the branch violation of line 2 to 5 due to the contingency 5 to 7 is now binding.
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B7SCOPF Case Solved using SCOPF: The system now meets the contingency constraints.
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SCOPF Example: Marginal Prices
Using the SCOPF solution from the previous page, select the Bus Marginal Price Details from the
Results page of the SCOPF Dialog to view the detail of the marginal price components. Note in the
following Figure that each area constraint contributes equally to the marginal cost of the buses in that
area. The binding inequality constraint from bus 2 to 5 makes further contribution to the bus marginal
price of buses in area Top.

Seven Bus Case SCOPF Bus Marginal Price Details
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SCOPF Example: Unenforceable Constraints
Using the same example as above, reduce the MVA rating of line 2 to 5 to 90 MVA. The initial base
case LP OPF solution is the same as in the previous example. Consider the same contingency list.
When the contingencies are solved using the initial OPF solution as the reference, seven contingency
violations need to be removed. The CTG dialog after simulation is presented in the following figure.

CTG Dialog after SCOPF Solution
We note that the constraint from bus 2 to 5 under a contingency from 5 to 7 is unenforceable. There
are not enough system controls to enforce the contingency constraint. A $ 1,000 / hr cost is assigned
to unenforceable constraints in this case. The cost of not enforcing constraints can be specified in the
OPF Constraint Options Dialog.
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Optimal Power Flow Reserves Overview
Note: The OPF Reserves tool in PowerWorld Simulator is only available if you have
purchased the OPF Reserves and OPF add-ons to the base package. To learn more about
the OPF Reserves, please read through the information contained in these help files.
Contact PowerWorld Corporation for details about ordering the OPF and OPF Reserves
version of Simulator.
In order to prevent load disconnections and loss of stability during normal operation or in the case of
unexpected events, power systems should operate with an adequate level of Reserve. Reserve is an
ancillary service needed for the successful operation of the system and the electricity market. This
service can be obtained in a regulated, mandatory manner, or it can be provided by an Ancillary
Services Reserves Market. Simulator OPF Reserves is the tool used to simulate Ancillary Services
Reserve Markets.
In the Reserves Market, the generators (and sometimes loads) supply bids to sell the ability to take
demand (increase their output) in a fast manner if called to do so. While an energy-only market has
only one product, active energy, the Reserves Market includes the energy product and several reserve
services: regulating, spinning and supplemental reserve. Similar to electricity markets for energy,
which deal with active power, the reserve market focuses only on active power reserves.
The optimal power flow (OPF) algorithm by itself is able to simulate energy-only electricity markets by
determining the minimum cost or minimum control change dispatch subject to normal operation
constraints. The OPF Reserves considers special OPF Reserve Constraints at the area and zone level,
and OPF Reserve Controls provided by generators or loads. OPF Reserves will thus simultaneously cooptimize energy and reserve and maximize total social surplus producing both energy (LMP) and
Reserve Marginal Clearing Prices (RMCP).
The commands and options for the OPF Reserves are integrated with the OPF tool.
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OPF Reserves Topics
The commands and options for the OPF Reserves are integrated with the OPF tool. The OPF Reserves
option is activated from the Common Options tab of the OPF Options and Results dialog by checking
the Include OPF Reserve Requirements box.
The following topics provide details about how the OPF Reserves are integrated into the OPF tool and
options and input data can be set:









OPF Reserves Controls
OPF Reserves Constraints
OPF Reserves Objective Function
OPF Reserves Results and Pricing
OPF Reserves Case Information Display
Area and Zone Reserve Requirements Curves
Generator and Load OPF Reserve Bids
OPF Reserves Example
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OPF Reserves Controls
Generators can provide the following types of reserve:




Regulation Reserve (RR) is provided by online fast units, usually tied to AGC primary control, and
capable to regulate the small positive or negative imbalances caused by the random nature of
loads.
Spinning Reserve (SR) is provided by online units and is used to take larger variations of load and
losses and unexpected events.
Supplemental Reserve (XR) is provided by online or offline fast-start units. This type of reserve is
used to correct large imbalances caused by contingencies.

Spinning and supplemental reserve are positive quantities. Regulation reserve is a bidirectional control.
There are two ways to model regulation controls: As two independent controls: regulation reserve up
(RR+) and regulation reserve down (RR-). As a single control: in this case the unit provides the same
amount of regulating reserve in both directions. In order to tell Simulator whether to use a single
bidirectional control for regulating reserve up or down, go to the OPF Options and Results Dialog and
check the Use a Single Control for Up/Down Regulation box.
Spinning and supplemental reserves combined together provide Contingency Reserve (CR)
Contingency reserve plus regulating reserve up is called Operating Reserve (OR)
The following relations are then established:
RR+ + SR + XR = OR
RR+ +

CR = OR

Data for the reserve controls can be specified from the Generator Information dialog, the Load
Information dialog, or from the corresponding case information displays accessible from the Model
Explorer > Optimal Power Flow > Results > Reserve Results.
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Generator and Load OPF Reserves Bids
Generators and loads can both be providers of reserve services. Similar options exist for both in setting
the OPF Reserve Bids parameters. These options can be set for generators on the Cost tab of the
Generator Information dialog and for loads on the OPF Load Dispatch tab of the Load Information
dialog.
OPF Regulating Reserves
These options are only available for generators.
Up Reserve MW - Value in MW of the cleared regulating reserve up. This value is determined by
the OPF Reserves solution and is non-enterable by the user.
Down Reserve MW - Value in MW of the cleared regulating reserve down. This value is
determined by the OPF Reserves solution and is non-enterable by the user. When a single
bidirectional control is used for up and down reserve, the MW value of the cleared Up Reserve and
Down Reserve will be the same.
Available for Regulating Reserves - Check this box to declare this unit as a provider of
regulating reserves service.
Price [$/MWh] - This is the bid submitted for the block of regulating up and down reserves.
Maximum MW Increase - This is the size in MW of the block of the regulating reserve up bid
submitted to the market. The cleared regulating reserve up cannot be larger than this value.
Maximum MW Decrease - This is the size in MW of the block of regulating reserve down bid
submitted to the market. The cleared regulating reserve down cannot be larger than this value.
OPF Contingency Reserves
These options are available for both generators and loads.
Spinning Available - Check this box to declare this unit/load as a provider of spinning reserve
service.
Supplemental Available - Check this box to declare this unit/load as a provider of supplemental
reserve service.
Reserve MW - Value in MW of the cleared spinning and supplemental reserves. These values are
determined by the OPF solution and are non-enterable by the user.
Price [$/MWh] - This is the bid submitted for the corresponding blocks of spinning and
supplemental reserve.
Max MW Increase - For spinning and supplemental reserve this is the size of the reserves block
submitted to the market. The cleared reserves cannot be larger that these values.
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OPF Reserves Constraints
Reserve constraints in the OPF Reserves tool are specified at the area and zone level. Overlapping
constraints are handled if an area contains several zones or if a zone spans several areas. For each
type of reserve specified, the total reserve of the area or zone must be equal or greater than a certain
level of reserve requirement in MW:





Operating Reserve: OR ≥ ORREQ
Regulating Reserve: RR ≥ RRREQ
Contingency Reserve: CR ≥ CRREQ
Some systems require that a percentage of the contingency reserve be spinning: SR ≥ %CR

Reserve requirements are input as incremental demand curves. These can be defined for both areas
and zones and are described in more detail in the Area and Zone Reserve Requirement Curves topic.
The reserve requirement demand curves are specified by pairs of (MW,$/MWh) values that form a stair
function. The demand curve should be monotonically decreasing, i.e., while the MW values increase,
the $/MWH values should decrease.
Sometimes, ancillary services markets rules specify a single reserve requirement value and price. For
instance, 300MW at $500/MWh. This requirement can be modeled by a demand curve that contains
two points: 0.0 MW at 300 $/MWh, and 300 MW at 0.0 $/MWh.
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Area and Zone OPF Reserve Requirement Curves
Simulator OPF Reserves requires the user to specify area or zone reserve constraints as reserve
demand curves for different types of requirements: operating, regulating and contingency.
Simulator OPF Reserves allows reserve constraints to be specified at the area and zone level or both,
including overlapping regions. The data needed to specify reserve constraints at the zone level is
identical to that needed for area reserve constraints.
Reserves Requirement Curves are found on the OPF tab of the Area Information dialog and the OPF
tab of either the edit or run mode Zone Information dialog.
The reserve requirement incremental demand curves are specified by a set of pairs of (MW,$/MWh)
values that form a stair function. The incremental demand curve should be monotonically decreasing,
i.e., while MW values increase, $/MWH values should decrease.
Sometimes, ancillary services markets rules specify a single reserve requirement and its price. For
instance 300MW at $500/MWh. This requirement would be modeled by a demand curve that contains
two points: 0.0 MW at 300 $/MWh, and 300 MW at 0.0 $/MWh.
Enforce Operating Reserve Requirement in OPF - Check this box to make the specified operating
reserve demand curve be enforced by the OPF Reserves tool.
Enforce Regulating Reserve Requirement in OPF - Check this box to make the specified
regulating reserve demand curve be enforced by the OPF Reserves tool.
Enforce Contingency Reserve Requirement in OPF - Check this box to make the specified
contingency reserve demand curve be enforced by the OPF Reserves tool.
Results Page - This page shows total results at the area level for different types of reserve
quantities: regulating reserve up, regulating reserve down, spinning reserve, supplemental reserve,
contingency reserve and operation reserve.
Enforce - Whether a specific type of reserve is enforced for the area. Only regulating,
contingency and operation reserve can be enforce at the area or zone level.
Cleared MW - Total reserve cleared in the area, for each reserve type.
Max Reserve MW - Total available reserve in the area for each reserve type.
Hourly Cost $/hr - Total cost of providing the reserve service in the area for each reserve type.
Price $/MWh - Reserve Marginal Clearing Price (RMCP) for each reserve type. This price is a
result of enforcing the reserve constraints, and thus it is only available for regulation,
contingency and operation reserves.
Hourly Benefit $/Hr - Benefit provided by enforcing reserve constraints at the area level. This
benefit is derived from the enforced reserve demand requirements, and it is only available for
regulation, contingency and operation reserves.
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OPF Reserves Objective Function
The power system should operate exceeding level of the different types of reserves. The benefit
associated with a reserve type is equal to the reserve consumer surplus (area below the reserve
demand curve and above the equilibrium RMCP). In order to provide reserve, some generators will
need to reduce their output to make room for the assigned reserve level. Thus in general, meeting the
reserve requirements will result in increased energy prices. In Simulator, the OPF reserves problem is
solved using an application of sequential linear programming embedded in the OPF solver. The LP
problem consists in maximizing total surplus:
Total Surplus = Benefit - Costs
Where the benefits include:





Up Regulation Reserve Surplus
Down Regulation Reserve Surplus
Contingency Reserve Surplus
Operating Reserve Surplus

And the costs include:





Up Regulation Reserve Cost
Down Regulation Reserve Cost
Spinning Reserve Cost
Supplemental Reserve Cost
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OPF Reserves Results and Pricing
The results of co-optimization of energy and reserves as implemented in Reserve Markets are:




Optimal generation dispatch MW set-points and reserve assignments
Energy locational marginal prices (LMP)
Reserve market clearing prices (RMCP)

The energy locational marginal prices are different than the prices that would be obtained if reserve
requirements are not consider. Usually, LMPs are higher in simultaneous energy and reserve
optimization. This is due to some generators having to back-off their output to meet reserve control
assignments.
As the bus LMP values correspond to the change in operating cost when an additional MW of active
power load is served at that bus, the RMCP correspond to the change in operating surplus when an
additional MW of a certain type of reserve is required to be provided at that bus. Each area or zone
that specifies reserve requirements will have a RMCP. If particular, the RMCP of buses in overlapping
zones and areas will be the result of adding the corresponding RMCP associated with each constraint.
The bus components of the RMCP can be accessed from the Bus MW Marginal Prices Details page in
the OPF Options and Results Dialog. RMCP fields will show up automatically for each constraint type
that is binding.
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OPF Reserves Case Information Display
A special category of case information display is available from the Model Explorer to access common
OPF reserves data. From the Model Explorer select the Optimal Power Flow > Results > Reserve
Results. The same set of reserve case information displays can be accessed from the Add Ons ribbon
tab under the Optimal Power Flow ribbon group > OPF Case Info > OPF Reserves.
These case information displays include input and output data for the Reserves Markets, such as
areas, zones, generator and loads. They have been customized with fields relevant to OPF Reserves.
For instance, generator and loads include:





Availability of each reserve type: regulating, spinning, supplemental
Maximum reserve available for each reserve type
Single value bid price for the reserve bid block, for each reserve type
Resulting RMCP for each reserve type

The area and zone information displays include:




Enforcement of reserve constraints: regulating, contingency, and operation
Total cleared reserve for each type
Total reserve cost and benefit for each type
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OPF Reserves Example
In this section, we present an example of the OPF Reserves in action. Consider the 10 bus, 7
generator case contained in the B10Reserve.pwb case (included with PowerWorld Simulator). This
case has 2 areas and 3 zones.

First solve the LP OPF without reserves by clicking LP Primal from the Add Ons ribbon group. Check
the log to confirm a successful OPF solution. The initial LP OPF solution without reserves presents a
binding transmission line as shown in the Figure.
The first step to solving the OPF with reserves is to set up the reserve control availability and reserve
bids from the Add Ons ribbon group > OPF Case Info > OPF Reserves > Generators case
information display. The following parameters, which in this example will be set up in a tabular
manner, can also be set in the individual Generator Information dialog. Let us set regulation, spinning
and supplemental generator reserve availability as follows:
Gen Reg. Avail SPN Avail
1
YES
NO
2
YES
YES
4
NO
YES
7
YES
NO
8
YES
YES
9
NO
YES
10
NO
NO
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SUP Avail
NO
NO
YES
YES
NO
YES
YES

Then, let us set up the following reserve blocks and prices (reserve bids) in the same case information
diagram.

Once the generator and/or load reserve controls have been specified, the second step is to set up the
reserve constraints for the control areas and/or zones. Let us set up the following data by accessing
each individual Area Information dialog or Zone Information dialog. Recall, that a single level reserve
requirement such as 150 MW @ 400 $/MWh is set by entering two points in the reserve demand
curve: 0.0 MW at 400 $/MWh and 150 MW at 0.0 $/MWh.

Let us now solve the OPF enforcing reserve requirements. Go to the Add Ons ribbon tab and choose
OPF Options and Results in the Optimal Power Flow ribbon group. Check the box Include OPF
Reserve Requirements. Click the Solve LP OPF button from the dialog or the Primal LP button from
the Add Ons ribbon tab.
The OPF Reserves, will enforce reserve constraints for each reserve type and for each area and zone
whose Enforce Field is set to YES. In addition, OPF Reserve will observe the following constraints:




Transmission line limits
Generator MW Max and Min limits for the total energy plus reserve controls
Area scheduled interchange. For this case, there is a 100 MW export from Area A to Area B.

To explore the results, go to the Generators page in OPF Reserve Results in the Model Explorer. The
results include generator MW dispatch and assignment of all the reserve services. Note that in this
example, some of the generators have reached their reserve bid limits for certain units and types of
reserve.
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Results can be explored at the area or zone level by accessing the individual Area Information dialog
or Zone Information dialog, going to the OPF tab, and the Results subtab of the Reserve Requirement
Curves. For instance, the Results for Area A are as shown in the next Figure. For each area, the results
page shows the enforcement of different types of regulation, the total cleared reserve, the total
available reserve, the reserve cost per hour, the reserve price, and the hourly benefit, which
corresponds to the area below the demand curve and above the equilibrium RMCP level.

The Results tab of the OPF Options and Results dialog shows the details of Bus MW marginal prices,
including energy, congestion and losses, and the reserve prices associated with the area or zone
reserve constraints. The corresponding linear programming details will list among the LP variables the
reserve controls specified by the user. The LP tableau will include specific rows for the enforced
reserve constraints at the area and zone level, etc. Reserve results can be visualized as any other
generator, load or bus object field in Simulator.

1339
©2011 PowerWorld Corporation

It should be mentioned that OPF Reserves is fully incorporated with the Time Step Simulation (TSS)
tool, so hourly OPF runs including reserves can be performed and results versus time stored. However,
currently OPF Reserves cannot be used simultaneously with the SCOPF tool.
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Available Transfer Capability (ATC) Analysis
The ATC Analysis tool is only available if you have purchased the ATC add-on to the base
Simulator package. Contact PowerWorld Corporation for details about ordering the ATC
version of Simulator.
Available Transfer Capability (ATC) analysis determines the maximum incremental MW transfer
possible between two parts of a power system without violating any specified limits. Most often, this
transfer is between two areas in the system, but can be customized to specific groups of system
devices.
Simulator’s ATC analysis makes use of several tools that are available elsewhere in Simulator. These
include:





Power Transfer Distribution Factors (PTDFs): determine the linear impact of a transfer (or changes
in power injection) on the elements of the power system.
Line Outage Distribution Factors (LODFs): determine the linear impact of a line outage on the
elements of the power system.
Contingency Analysis: studies the impact of a list of contingencies on the power system.
Limit Monitoring Settings: control which elements of the system are monitored for limit violations.

You do not directly use these other tools when using Simulator’s ATC analysis tool, but Simulator uses
the settings and algorithms in the background to determine ATC. Thus, it is helpful to be
knowledgeable on their use, as it will help you in interpreting the results of an ATC analysis.



Simulator provides three methods of determining the ATC for a transfer direction. See : ATC
Solution Methods

For information on how to use the Simulator ATC tool, see Available Transfer Capability Dialog.
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Available Transfer Capability Dialog
The Available Transfer Capability dialog provides an interface for performing and viewing the results of
Available Transfer Capability Analysis. ATC analysis is typically only done on the present power system
state or scenario (called Single Scenario ATC Analysis). Click here for information on performing
multiple scenarios analysis.
To open the ATC dialog, go to the Add Ons ribbon tab and select Available Transfer Capability
(ATC) from the ATC ribbon tab. The dialog opens to the Single Scenario ATC Analysis version with the
Options page, Common Options sub-tab visible.

The ATC dialog is divided in three pages: Options, Analysis, and Result. If Analyze Multiple
Scenarios has been checked on the Advanced Options sub-tab of the Options page, the layout of the
ATC dialog is slightly different—see Multiple Scenarios ATC Dialog.
In addition, the following buttons can be used to save/load ATC analysis settings:
Save/Load Settings
ATC Analysis settings can be saved by selecting Save Settings on the ATC dialog. This allows you
to repeat the analysis without having to reconfigure the settings. Select Load Settings to retrieve
previously saved settings.
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ATC Dialog: Options
The Options page is available on the Available Transfer Capability dialog. This page is subdivided into
four sub-tabs:

Common Options
Define Contingencies
This sub-tab is similar to the Contingencies Tab of the Contingency Analysis Dialog. The user can
insert, auto-insert, define and/or delete contingency records. See Contingency Analysis for detailed
information on defining contingencies.
Advanced Options
Memo
Notes related to the ATC analysis, or anything else for that matter, can be entered on this sub-tab.
These notes will be saved to an auxiliary file if choosing to save the ATC settings.
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ATC Dialog Options: Common Options
The Common Options sub-tab is found on the Options page of the Available Transfer Capability dialog.

The following parameters can be set on the Common Options page:
Seller Type, Buyer Type
For the ATC Solution Method of Single Linear Step (SL), transfer limits can be calculated for transfers
between combinations of areas, zones, super areas, injection groups, buses, or to the system slack
bus. For the iterated linear step ATC Solution Methods (IL and IL then full contingency solution),
transfer limits can be calculated for transfers between areas, super areas or injection groups only.
Use the seller type and buyer type options to indicate the type of the selling and purchasing entities.
Seller, Buyer
These dropdown boxes allow you to select the selling and buying entities. The contents of each
depend on the Seller/Buyer Types selected. Clicking the Find Seller and Find Buyer buttons allows
you to use Simulator’s Advanced Search Engine to locate the desired entities.
The Seller defines where power is injection into the system and the Buyer defines where power is
taken out of the system. The transfer is simulated by increasing generation or decreasing load in the
Seller and decreasing generation or increasing load in the Buyer. The ATC Analysis Methods Solution Methods go into greater detail about how the impact of the transfer is actually determined.
When areas, zones, or super areas are selected to be either the Seller or Buyer, only on-line
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generators in the defined group that are on AGC control are allowed to participate in the transfer.
Each generator participates in the transfer in proportion to its participation factor. When injection
groups are selected to be either the Seller or Buyer, only on-line generators and loads defined with
the injection group are allowed to participate in the transfer. Each element participates in the
transfer in proportion to the participation factor defined with its participation point in the injection
group. When a single bus is selected as the Seller or Buyer then all of the power injection change
needed for the transfer comes from that bus. It does not matter if there is a generator or load at
that bus. When the slack is selected for the Seller, then all of the power injection change needed for
the seller side of the transfer comes from the island slack bus for the island in which the Buyer
belongs. When the slack is selected as the Buyer, then all of the power injection change needed for
the buyer side of the transfer comes from the island slack bus for the island in which the Seller
belongs.
Generator and load MW limits are not enforced regardless of the type of buyer and seller. Error
messages will be displayed if the Seller and Buyer are not both completely contained within the
same electrical island.
Reverse Buyer/Seller Button
Click this button to reverse the direction currently shown. The buyer becomes the seller, and the
seller the buyer.
Linear Calculation Method
The ATC analysis tool can use either a Lossless DC or Lossless DC with Phase Shifters
calculation method for obtaining the ATC results.
If you select the Lossless DC option, branch flow sensitivity is calculated by estimating the real
power that flows through the monitored element only from the difference in angles measured across
its terminals.
The Lossless DC with Phase Shifters method, a modification to the lossless dc approximation, takes
into account phase shifter operation. It is especially useful when the ATC tool continually reports
overloads on branches that obviously will not overload because of the operation of a phase shifting
transformer. This method assumes that the phase shifter angles may change to any value to ensure
that the line flow on those lines does not change.
The Linearized AC method is not yet available.
Enable Phase Shifters Post-Contingency
This option becomes enabled when you choose the Lossless DC with Phase Shifters linear
calculation method. It allows you to choose whether or not phase shifter control should be enforced
during post-contingency ATC calculations. When this option is checked, it is assumed that phase
shifter angles may change to keep the line flow from changing after the contingency has been
applied. Otherwise, it is assumed that phase shifters only maintain the flow in the pre-contingency
state and the angles do not change in the post-contingency state. Base case (pre-contingency)
transfer limiters will still be determined with phase shifters enforced, regardless of the setting of this
option when the Lossless DC with Phase Shifters option is checked.
Include Contingencies Check Box
Check this box to include contingencies (inserted or loaded using the Contingency Analysis Tool) in
the ATC analysis. Note that minimizing the number of contingencies considered greatly improves
solution speed as well as computer memory requirements for doing ATC Analysis. Therefore, be
careful in choosing which contingencies to use with the ATC tool. Setting the Skip field to YES for a
particular contingency will exclude it from the ATC analysis.
The ATC tool uses the same contingency records as the contingency analysis tool. Contingency
results may be invalid following ATC analysis. If necessary, save contingency results to an auxiliary
file prior to running the ATC analysis.
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Contingency elements have an associated Status that determines under what conditions a particular
action will be implemented. When ATC values are calculated using linear methods, contingency
actions are not actually implemented. Because contingency actions are not actually implemented,
POSTCHECK actions cannot be applied after other actions have been performed and the power flow
has been solved. Instead, POSTCHECK actions act as CHECK actions during linear ATC analysis
(Single Linear Step Method). During linear ATC analysis whether or not model criteria are met for
CHECK and POSTCHECK contingency actions will be determined at the base transfer level rather
than at the transfer level that determines the limiting transfer. The base transfer level is the transfer
level at which the linear ATC values are actually determined. In most cases this will be the zero
transfer level, but this can be different if using one of the iterated ATC methods.
Report Base Case Limitations Check Box
When checked, the ATC tool will report transfer limitations from the base case (pre-contingency).
Report Generation Reserve Limitations Check Box
When checked, the ATC tool will report transfer limitations from generation reserve.
Generator and load MW limits are not enforced when calculating linear sensitivities used to
determine the transfer MW limits. However, checking this option provides an indication of when
power transfers are limited based on generator maximum or minimum MW limits or the amount of
load that is on-line. When this option is checked and there are limitations to how much power can
be transferred because of max/min generator limits or the on-line load, additional Transfer Limiters
will be present in the results. The Limiting Element will indicate either the Buyer or Seller and the
Transfer Limit in MW will be the amount of transfer that can be achieved before the Buyer or Seller
exceeds some limitation to generation or load. When considering reserve limits for the Seller,
generators will be included in the reserve limit by taking the difference between the generator
maximum MW limit and the present output and loads will be included in the reserve limit by the
present amount of on-line load. When considering reserve limits for the Buyer, generators will be
included in the reserve limit by taking the difference between the present output of the generators
and the minimum MW limit and loads will be included by an arbitrary value of 9999.9 MW. Loads are
included in this manner because maximum and minimum limits on loads are not currently used in
the ATC tool.
For example, assume than an area that currently has 200 MW on-line and a total maximum MW
output of 250 MW for all on-line generators that are on AGC control is defined as the Seller. A 50
MW generation reserve limitation will be reported for this area. As another example, assume that an
injection group currently has 50 MW of on-line generation with a total maximum MW output of 150
MW and 50 MW of on-line load is defined as the Seller. A 150 MW reserve limitation will be reported
for this injection group.
No generation reserve limitations are reported when the seller or buyer type is a bus or the slack.
If using one of the iterated methods, this option will be ignored except during the first single linear
step. Reserve limitations may be reported from this step, but limitations of this type will not be
iterated on during the individual iteration process. If choosing to enforce generator MW limits
appropriately with the type of transactors that are defined, reserve limits will still be reported,
regardless of this option setting, if they are hit during any step of the iterative process when
ramping is occurring. See the detailed descriptions of either the Iterated Linear Step (IL) or Iterated
Linear Step (IL) then Full CTG Solution method for more information about how reserve limits are
checked during the iterated methods.
Limit Monitoring Settings Button
Click this button to open the Limit Monitoring Settings Dialog. Limiting Elements will only be reported
for those elements that are selected to be monitored. Note that minimizing the number of monitored
power system elements greatly improves solution speed as well as computer memory requirements
for doing ATC Analysis.
1346
©2011 PowerWorld Corporation

Monitoring Exceptions can be used to include or exclude specific monitored elements on a
contingency-by-contingency basis.
Transfer Result Reporting Options
The options in this section of the ATC dialog are discussed in detail in the topic on Transfer Result
Reporting Options.
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ATC Dialog Common Options: Transfer Result Reporting Options
These options are found in the Transfer Result Report Options section on the Common Options subtab of the Options page found on the Available Transfer Capability dialog.
Transfer Limiters To Save
This value tells Simulator how many total Transfer Limiters to save. Simulator will save those
Transfer Limiters with the lowest Transfer Limitation. An explanation of a Transfer Limiter follows:
During Linear ATC Analysis, Simulator determines the Transfer Limitation (See Available Transfer
Capability Analysis) for each transmission line and interface during each contingency and the base
case. From this Simulator develops a list of Transfer Limiters. A Transfer Limit contains three key
pieces of information:




Transfer Limit in MW
Limiting Element: Transmission branch (or interface) that causes the limit
Limiting Contingency: Contingency that is applied to cause the Limiting Element to overload (if
it is a limit without any contingency applied, then the contingency will say Base Case)

Thus if we are monitoring 1000 transmission lines during 99 contingencies plus 1 base case, there
would be 100,000 Transfer Limiters calculated. We are not concerned with all 100,000 limitations,
therefore, only the limitations with the smallest Transfer Limit in MW are reported.
Max Limiters per CTG
When analyzing a long list of contingencies, the worst transfer limitations may all occur during the
same contingency. Set this value to limit the number of Transfer Limiters saved that are associated
with a given contingency.
Max Limiters per Element
When analyzing a long list of contingencies, the worst transfer limitations may all be overloads of
the same limiting element. Set this value to limit the number of Transfer Limiters saved that are
associated with a given Limiting Element.
Max MW Limitation
This value defines the maximum transfer to report between the buyer and seller. Simulator will
compute the ATC analysis results until the transfer amount reaches the value in this field and only
report the results meeting the other reporting criteria up to this MW limitation.
When using one of the iterated methods, this option is only applied during the initial Single Linear
Step portion of the method. Once individual limiters are being iterated on, this option will be
ignored.
Ignore Elements with OTDFs below
Simulator will not report Transfer Limitations for elements with OTDF values less than this userspecified value. The default value is 0.5%, meaning that for a 100 MW transfer, there would be only
a 0.5 MW increase in flow on the Limiting Element. The OTDF cutoff is only used with transfer
limitations that include contingencies.
Ignore Elements with PTDFs below
Simulator will not report Transfer Limitations for elements with PTDF values less than this userspecified value. The default value is 0.5%. The PTDF cutoff is only used with transfer limitations that
do not include contingencies, i.e. base case limitations.
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For interfaces that include contingent elements, no additional contingencies will be studied on top of
the contingencies that are part of the interface. The cutoff value to use for the OTDF is the
minimum of the OTDF and PTDF cutoff values.
The transfer limitation functions involve dividing by the PTDF or OTDF values for each branch or
interface to calculate the Transfer Limit. This leads to two facts:



The accuracy of the transfer limitation is less for lines that have very small PTDF or OTDF
values.
A very small PTDF or OTDF value means that the transfer has very little impact on the line.

These two facts often result in Linear ATC analysis reporting inaccurate transfer limitations for lines
that are largely unaffected by the transfer. It is not uncommon to have a transfer limitation report
an extremely negative transfer limit (e.g. -1.9E28 MW). A branch which is overloaded by a very
small percentage, but which has a very small OTDF value often causes this. If the OTDF value is
0.001%, then a branch overloaded by 1 MW will result in a transfer limitation of -100,000 MW.
This motivates the usefulness of ignoring elements with small PTDFs and OTDFs.
All of these options work together to determine the list of limiters that shows up in the results. The
Limit Monitoring Settings determine elements that will be considered for monitoring. The list of defined
contingencies determines the contingencies. Every combination of monitored elements and
contingencies will be tested. Monitoring exceptions can also be used to include or exclude monitored
elements on a contingency-by-contingency basis. If the PTDF and/or OTDF cutoffs, as appropriate, are
met for the monitored element/contingency pair, the monitored element and contingency are then
checked against the Max Limiters per Element and Max Limiters per CTG conditions.
For each monitored element, a maximum, X, of Max Limiters per Element is kept during the initial
processing. Only the most limiting X limiters for that element are retained. The transfer limiter with the
highest transfer limit value will get pushed out of the list for an element if a new combination of
monitored element/contingency is more limiting than what is currently in the list. For each
contingency, a maximum, Y, of Max Limiters per CTG is kept during the initial processing. Only the
most limiting Y limiters that for contingency are retained. The transfer limiter with the highest transfer
limit value will get pushed out of the list for a contingency if a new combination of monitored
element/contingency is more limiting that what is currently in the list. Once all monitored
element/contingency pairs have been processed, all of the individual lists for limiting elements and
contingencies are merged into one big list that is sorted by transfer limit, limiting element, and
contingency. This sorted list is then traversed in the order of increasing transfer limit to create the final
list that enforces the Max Limiter per Element, Max Limiters per CTG, Transfer Limiters to
Save, and Max MW Limitation conditions. If there are no monitored element/contingency pairs that
are below the Max MW Limitation, the monitored element/contingency pair with the lowest transfer
limit value will be the only record reported in the results.
The following is an example of how this process works:
Max Limiters per CTG = 2, Max Elements per Limiter = 1
Limiting Element Lists
Line A contains transfer limiter for CTG B with ATC = 500
Line B contains transfer limiter for CTG B with ATC = 50
Line C contains transfer limiter for CTG X with ATC = 125
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Line D contains transfer limiter for CTG A with ATC = 750
Line H contains transfer limiter for CTG B with ATC = 10
Line Z contains transfer limiter for CTG D with ATC = 10
Contingency Lists
CTG A - Line B with ATC = 1500, Line C with ATC = 1750
CTG B - Line H with ATC = 10, Line Z with ATC = 25
CTG C - Line D with ATC = 1000
CTG D - Line Z with ATC = 10
CTG X - Line C with ATC = 125
Now combine the lists and sort based on ATC, limiting element, and contingency. Duplicate entries
can exist in the list because the same limiting element/contingency pair can be stored in both the
limiting element list and the contingency list.
10 Line H/CTG B
10 Line H/CTG B
10 Line Z/CTG D
10 Line Z/CTG D
25 Line Z/CTG B
50 Line B/CTG B
125 Line C/CTG X
125 Line C/CTG X
500 Line A/CTG B
750 Line C/CTG A
1000 Line D/CTG A
1500 Line B/CTG A
1750 Line C/CTG A
Now go through the sorted list above to produce the final results list that abides by all conditions.
10 Line H/CTG B
10 Line Z/CTG D
50 Line B/CTG B
125 Line C/CTG X
1000 Line D/CTG A
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ATC Dialog Options: Advanced Options
The Advanced Options sub-tab is found on the Options page of the Available Transfer Capability
dialog.

The following parameters can be set on the Advanced Options sub-tab:
ATC Solution Method
One of the solution methods for determining the ATC of a specified transfer direction.
If using either the Iterated Linear Step (IL) or (IL) then Full CTG Solution method, and the seller and
buyer are either areas or super areas, and the automatic generation control method for the case is
not set to area/super area control, an error message will be produced and the analysis will not
continue. In the ATC analysis, transfers between areas are implemented by adding a transaction
between areas which requires them to be on area interchange control in order to meet the ACE
requirement. If the case was just switched to this control method without the areas already being on
area control, the dispatch for the case could drastically change. The burden is left on the user to
ensure that control methods are set up correctly. If the case is not already on area interchange
control, but one of the island-based methods, and putting it on area control would drastically change
the case, the ATC analysis can still be done between areas if injection groups are created to
represent the areas and the analysis is then done using these injection groups as the seller and
buyer.
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Linearize Makeup Power Calculation
When doing the linear ATC calculations, any contingencies that cause a MW change (e.g. dropping
generation or changing load) require makeup power to compensate for the change in MW. When
this option is checked, a precalculation is done at the beginning of each linear step calculation that
determines the impact of makeup power on line flows. When a particular contingency is processed,
the effect of makeup power on all monitored lines will be determined by multiplying the
precalculated effect of makeup power on a line by the total amount of makeup power needed for
the contingency. This calculation is slightly faster than calculating the impact of the makeup power
separately for each contingency, but it will not take into account the fact that larger amounts of
required makeup power may cause generators to hit their limits.
Define Extra Monitors
Simulator’s ATC tool determines the maximum amount of MW transfer between the seller and buyer.
If you would like to also determine the flow on additional lines or interfaces at the transfer levels
determined by the ATC tool, you can utilize Extra Monitors. Click the Define Extra Monitors button
to open the ATC Extra Monitors dialog. The flow on the extra monitors will be reported for each
transfer limiter determined.
Analyze Multiple Scenarios
Check Analyze Multiple Scenarios to perform ATC Analysis on several scenarios. See
ATC Dialog for Multiple Scenarios for more information on Multiple Scenario Analysis.
Model Reactive Power for Linear Methods By…
The linearized methods used in the ATC tool are based only on the changes in real power MW in the
system, thus an assumption needs to be made about the reaction of the Mvar flows during the linear
calculations. The chosen assumption allows a MW limit to be calculated from the defined MVA limit
for use in determining the ATC values. Before applying the option for handling reactive power, the
specified MVA limit for a branch is used to determine the starting MVA limit. The Limit Monitoring
Settings can cause an adjustment the defined MVA limit based on the Branch Percentage
specified. The modified limit that is used in the calculations is then:

The choices for adjusting the MVA Limit for reactive power are then:
Ignoring reactive power – reactive power is completely ignored. The MW limit of a line is
assumed to be the modified MVA limit of the line:

Assuming constant voltage magnitude – reactive power is adjusted to hold voltage
magnitudes constant. This option uses the intersection of a branch's operating circle and limiting
circle to adjust the limit. The operating circle defines a circle of valid MW and Mvar values for a
branch as a transfer takes place across the system. The limiting circle has a radius equal to the
modified MVA limit of the branch.
Assuming reactive power does not change – reactive power is held at pre-ATC solution
levels. The MW limit for each line is calculated from the MVA limit and the reactive power at the
pre-ATC solution level:

For Linear Methods, Allow Amp Limits by Assuming a Constant Voltage Magnitude
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If checked, Simulator will allow converting MVA limits to Amp limits by assuming constant voltage
magnitudes based on the base case full AC load flow operating point just prior to the ATC linear
calculations. This option will only be used if the Limit Monitoring Settings Option of Treat Line Limits
as Equivalent Amps is checked.
This option will cause the ATC tool to internally use a modified MVA limit which is equal to the userspecified MVA rating multiplied by the actual terminal voltages of the line. This results in a modified
MVA rating which is higher than the user-specified MVA rating when the voltage on the line is higher
than nominal and lower when the voltage is lower than nominal. For purposes of calculating the ATC
values, a MW limit is determined from the MVA rating based on how this option is set and how the
reactive power is modeled.
Ignoring reactive power

Assuming reactive power does not change

where V is the voltage at the end of the branch from which the limit is taken. The Transfer Limit
is calculated at each end of a branch and the most limiting value is reported as the Transfer Limit
for a given branch.
Transfer Calculation Options
Note: The Transfer Calculation Options section is disabled if the Single Linear Step Solution Method is
selected.
Transfer Tolerance
This is the tolerance used during the Iterated Linear Step or (IL) then Full CTG Solution methods.
The iterated methods will finish if the transfer step amount for the next iteration is less than this
tolerance. The default is 10 MW.
When Iterating, Ignore Limiters below
The iterated techniques perform additional analysis on individual transfer limitations in the order
of increasing Transfer Limit in MW. When using one of the iterated techniques, transfer
limitations with Transfer Limit values below a certain threshold can be ignored for the iterated
portion of the process. Transfer limitations with Transfer Limit values equal to or below the value
set with this option may still appear in the results, but they will not be iterated on individually.
Once an individual limiter is being iterated on, this value will no longer be used. This means that
during the individual iteration process, the transfer level for a limiter can fall below this threshold.
Transfer Limiters to Iterate on
This is the number of transfer limiters to iterate on in the Iterated Linear Step or (IL) then Full
CTG Solution methods. The default is 1. The transfer limiters actually iterated on are determined
by selecting the number of limiters set in this option in ascending order of Transfer Limit with the
Transfer Limit at or above the value set in the When Iterating, Ignore Limiters below
option.
Power Flow Solution Options
This button brings up the Power Flow Solution Options Dialog. This allows the specification of the
solution options to use for solving pre-contingency cases and the options used when no
contingency-specific solution options are defined. Changing these options affects all power flow
computations, even those outside the ATC process.
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Because the goal is to stress the system while performing the ATC analysis, there are two power
flow solution options that are set internally as part of the ATC process. These are the options
that specify the minimum per unit voltage for constant power and constant current loads. These
options are both set to 0 pu and override any user-specified settings.

These options are both set to 0 pu during both the base case solution and any contingency case
solution.
Injection Group Options
This button brings up a dialog from which options associated with injection groups can be set.
These are the same options that get set for injection groups when using Island-based AGC and
dispatching using an injection group; the ATC process switches to using an island-based AGC
when iterating and using injection groups for the seller and buyer. The options that can be set
are Island AGC Tolerance, Allow only AGC units to vary, Enforce unit MW limits, Do not allow
negative loads, and how reactive power load should change as real power load is changed.
The sink injection group is set as the injection group to use in the dispatch. When implementing
the transfer ramping, the source injection group is ramped to the required amount and then the
power flow is solved with the sink injection group picking up any required changes. These
changes include adjusting injection in response to change in the source injection group as well as
any changes in losses due to the transfer.
Define Contingency Solution Options
Click this button to open the Contingency Solution Options Dialog. These are the same options
that are set with the contingency analysis options.
Use Specific Solution Options
When checked, the ATC tool will use the solution options defined by pressing the Define
Contingency Solution Options button for contingency analysis. When not checked, all
solutions will use the options defined by pressing the Power Flow Solution Options button.
Regardless of the specific contingency solution option settings, there are two options that will be
set internally by the ATC process and will override any user-specified settings. These are the
options for minimum per unit voltage for constant power and constant current loads. These
options are described in more detail in the Power Flow Solution Options section above.
Force all transfer ramping to occur in pre-contingency states and repeat full CTG
solutions
When using the iterated solution methods, the typical iterated operation is to solve for the
transfer step amount in the post-contingency state, and then apply the transfer step amount to
the post-contingency state and resolve for the next transfer step amount. When this option is
checked, the transfer step amount for each iteration is calculated in the post-contingency state,
but the power flow state is restored to the pre-contingency state before the transfer step amount
is applied. The contingency is then applied after the transfer step amount has been ramped and
the transfer step amount for the next iteration is calculated after the contingency has been
applied. The purpose of this is to take into account the possibility of conditional actions in the
contingency definitions that may not be active in the early steps of the iterated calculations, but
may become active at some point during the application of the iterated steps.
Iterate on failed contingency
This option is only enabled when the option to Force all transfer ramping to occur in precontingency states and repeat full CTG solutions is selected. When this option is checked
and the power flow fails to solve after the contingency has been applied, a new iteration loop is
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entered to determine the highest transfer level at which the contingency can be solved. This loop
attempts to determine a more accurate transfer level at which the contingency fails to solve
rather than simply reporting the transfer level at which the last power flow was successful
regardless of the current step size. To start the iterative process, the current step size is reduced
by half. The ramping is performed and the contingency is solved. The step size will remain the
same as long as the contingency can be solved. If the contingency fails to solve, the step size will
be reduced by half again. The ramping will continue until the contingency no longer solves, the
accumulated transfer during the process meets the original step size, or the step size becomes
smaller than the step size tolerance.
An additional check is done during the iterative process on the failed contingency. When the
contingency does solve, the flow on the monitored element is checked to determine if it exceeds
its limit. If it is overloaded, the step size will be reduced by half until the monitored element is no
longer over its limit. While this check is being done on the monitored element limit, the ramping
continues out to the specified amount and the contingency is solved.
During the entire iterative process on a failed contingency solution, the step size is limited to be
between zero and the step size which was ramped when the contingency failed to solve for the
first time.
Tolerances in ATC Tool
When using one of the iterated methods, tolerances must be set correctly with the ATC tool or
injection changes will end up being picked up by the system slack instead of the seller and buyer or
no injection changes will be made at all. When studying a transfer between injection groups, the
Transfer Tolerance will dictate what the MVA Convergence Tolerance, set with the Power Flow
Solution Options on the Simulator Options Dialog, and the Island-Based AGC Tolerance can be.
Before the analysis starts, the MVA Convergence Tolerance will be checked to make sure that it is
less than 0.1*(Transfer Tolerance). If not, the MVA Convergence Tolerance will be set to
0.1*(Transfer Tolerance). The Island-Based AGC Tolerance will also be checked to make sure that it
is less than 0.5*(Transfer Tolerance). If not, the Island-Based AGC Tolerance will be set to
0.5*(Transfer Tolerance). The MVA Convergence Tolerance will then be checked to make sure that it
is less than 0.2*(Island-Based AGC Tolerance). If not, the MVA Convergence Tolerance will be set to
0.2*(Island-Based AGC Tolerance). This will order the tolerances such that (MVA Convergence
Tolerance) < (Island-Based AGC Tolerance) < (Transfer Tolerance). The original tolerances will be
restored when the initial state stored with the ATC tool is restored.
When studying a transfer between areas or super areas, there are two AGC tolerances to deal with.
These are both checked to make sure that they are less than 0.5*(Transfer Tolerance) and are set
to that value if they are not. Both of these tolerances should also be greater than the MVA
convergence tolerance. The smaller of the two tolerances in multiplied by 0.2 and the
MVA convergence tolerance must be less than this value. If not, the MVA convergence tolerance is
set to 0.2*(smaller of the two area/super area AGC tolerances). All tolerances will be restored to
their original values when the initial state stored with the ATC tool is restored.
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ATC Extra Monitors Dialog
Simulator’s ATC tool determines the maximum amount of MW transfer between the seller and buyer. If
you would like to also determine the flow on additional lines or interfaces at the transfer levels
determined by the ATC tool, you can utilize ATC Extra Monitors. To open the Extra Monitors dialog,
click the Define Extra Monitors button on the Advanced Options tab of the ATC Analysis Dialog.
The ATC Extra Monitors Display lists all of the ATC Extra Monitors defined. This list display is a Case
Information Display, and therefore has the same functionality as other common displays. See Adding
and Removing Extra Monitors below.

Extra Monitors Dialog
The default fields shown on this display are:
ATC ExMon Desc
This is a description of the monitored value. Presently, this is always MW flow.
ATC ExMon Obj
The power system element that is being monitored. This will be either a transmission branch or an
interface.
Monitor Limit
This is the MW limit of the element being monitored.
Relative Monitor
Set this to a positive value to further filter the Transfer Limitations reported on the Transfer Limiters
Display. By default, Relative Monitor is set to none, and no additional filtering of limitations is
performed. If this value is greater than zero, only Transfer Limitations that meet the following
condition are included in the results.

This provides a measure of how much an interface or branch is affected by the transfer relative to
its MW limit.
The relative monitor sensitivity check is not done if using one of the iterated ATC methods and in
the process of iterating on individual limiters. The assumption is that once a limiter meets the initial
check and it is being iterated on that the limiter should be kept regardless of its relative monitor
sensitivity.
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Adding and Removing Extra Monitors
To delete an Extra Monitor, right-click on the desired record on the list display and select Delete.
To insert an Extra Monitor, right-click on the list display and select Insert. This opens the insert
dialog.

Insert Extra Monitors Dialog
Choose whether you want to monitor an Interface or Line MW flow. Next choose the interface or
branch to be monitored. Note that the insert dialog allows the use of Simulator’s Advanced Search
Engine and techniques to aid in locating the desired interface or branch. Click OK to insert the
record.

1357
©2011 PowerWorld Corporation

ATC Dialog: Result
The Result page is found on the Available Transfer Capability dialog. This page is visible when
performing ATC analysis on a single system state. The Result page consists of two sections: A Transfer
Limiters Display and a Contingency Definition Display.

The Transfer Limiters Display contains tabbed pages containing information on Branch, Interface, and
Nomogram Limiters. The user can also choose to display All Limiters. See Transfer Limiters for more
information.
The Contingency Definition section displays information on the limiting contingency for selected
transfer limiter if the user checked Include Contingencies on the Common Options tab.
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ATC Dialog: Analysis
The Analysis page, found on the Available Transfer Capability dialog, is used to control the analysis
process. The scrollable window displays a record of user-initiated actions relating to the analysis.

The Analysis page has the following controls:
Start Analysis
The Start Analysis button begins the ATC Analysis using the settings and options defined by the
user in the ATC Analysis Dialog. Progress of the ATC Analysis is shown in the scrollable pane of the
ATC dialog – Analysis page window. Note that you can still interact with other features of Simulator
when the ATC dialog is open, and care must be taken while actually running the ATC solution, as
any changes to the data while the ATC solution is calculating will invalidate the results.
Abort Calculation
When using one of the iterative ATC Solution Methods, or while analyzing Multiple Scenarios, click
this button to abort the calculation.
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Note: This does not immediately abort the solution. Simulator must restore the system state before
completing the abort. Also, after aborting the solution, it should be assumed that the results are not
valid. The exception could be if multiple scenarios have fully completed before hitting the abort
button. Any study or scenario in progress when Abort is clicked should definitely be considered not
valid.
Restore Initial State
Click this button to restore the system state to the initial state. The initial state is the state in
memory when the ATC analysis is started. The initial state is only stored if using one of the iterative
ATC Solution Methods or analyzing Multiple Scenarios. The initial state is also stored when opening
the ATC dialog if an initial state has already been stored.
Increase Transfer
Click this button to open the Ramp Transfer Up dialog in order to increase (or decrease) the transfer
level manually. This transfer remains in the system state if the dialog is closed without restoring the
initial state.
Additional analysis can be done on a case that has had the transfer increased by using the ATC tool;
however, the control method used in the ATC tool may differ from that in use once the ATC tool has
been exited. When injection groups are used to increase the transfer, the AGC method that is used
is island-based AGC. The AGC method is then restored to what it was prior to increasing the
transfer. If this same method is not used for subsequent analysis, the dispatch and system state will
be modified from the state with the transfer applied. When using areas or super areas for increasing
the transfer, the area or super area is put on participation factor control for the ramping.
Areas/super areas participating in the transfer will remain on participation factor control following
the ramping, but the same problem can exist as with the injection groups if the same AGC method is
not in use with subsequent analysis after the transfer ramping.
If using areas or super areas for increasing the transfer, a transaction is added to the MW
Transactions to implement the transfer. This transaction can be identified by the special ID that is
assigned to it, TEMP_ATC_TRANSACTION. This transaction will remain in the case if closing the ATC
dialog without restoring the initial state.
When increasing the transfer, the rules for the various tolerances involved in the transfer and power
flow solution described in the Tolerances in ATC Tool section described in the Advanced Options
topic apply. The only exception is that the original tolerances are not restored at the end of the
transfer increase because the initial state is not restored.
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Multiple Scenario Available Transfer Capability Dialog
To perform Available Transfer Capability Analysis for several system scenarios, check Analyze
Multiple Scenarios on the Advanced Options tab of the Available Transfer Capability dialog. When
Analyze Multiple Scenarios is not checked, the available pages are Options, Analysis and Result. When
Analyze Multiple Scenarios is checked then the following changes occur:






Distributed Computing page appears
Scenarios page appears
Results page appears
Result page is removed (replaced by Results)
Combined Results page appears

By defining multiple scenarios, Simulator allows you to calculate ATC values for several different power
system states automatically. Scenarios can be modified along three axes:




Line Rating/Zone Load Scenarios (weather-related scenarios)
Generation Scenarios (generation profiles)
Interface constraints
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See Scenarios page for more information.
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Available Transfer Capability : Distributed Computing
The Distributed Contingency Analysis tool is available as an add-on to the base Simulator
package. Contact PowerWorld Corporation for more details.
These options are all available on the Available Transfer Capability Dialog under the Distributed
Computing Grouping.
Distributed Computing is available for use in distributing multiple scenario ATC simulations. In order to
use distributed computing you must first configure a list of remote computers which can be utilized
along with appropriate authentication information for those computers. The computer list and
authentication information is common to all the distributed computing tools in Simulator and can be
found in the Simulator Options Dialog, or reached with the Distributed Computing Options button.
They are described in Distributed Computing Options .
The only option specific to ATC Analysis for Distributed Computing is the following
Use Distributed Computing
Check this box to signify that when processing multiple scenario ATC simulations distributed
computing should be used.
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Multiple Scenario ATC Dialog: Scenarios
The Scenarios page of the Multiple Scenario ATC Analysis is available on the Available Transfer
Capability Dialog when selecting the option to Analyze Multiple Scenarios on the Advanced Options
tab of the Available Transfer Capability dialog.
By defining multiple scenarios, Simulator allows you to calculate ATC values for several different power
system states automatically. Scenarios can be modified along three axes:




Line Rating/Zone Load Scenarios (weather-related scenarios)
Generation Scenarios (generation profiles)
Interface constraints

Each of the different scenario types can be defined on its own tab. Each tab contains a list of the
power system elements that will be modified during different scenarios. These lists are a familiar Case
Information Display providing the same functionality as other displays.
To insert a new power system element into the list, right-click on the list (below the headings) and
choose Insert.
If a power system element does not show up in one of the lists of elements for a particular scenario,
then it will retain its base case value during that scenario.
When saving or loading scenario elements in an auxiliary file, the elements are usually identified by
primary key fields. Optionally, these elements can be identified by label. See the Label topic for more
information about this.
Line Ratings/Zone Loads Tab
Use this tab to define Line Ratings and Zone Loads scenarios.
Line Ratings and Zone Loads are varied together when analyzing scenarios. This was chosen
because they often vary together as a function of the weather. Notice that three sub-tabs (labeled
Line Ratings A, Line Ratings B, and Zone Loads) appear at the top of the Line Ratings/Zone Loads
tab.
Line Ratings A and B
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The A rating is typically used as a base case rating, whereas the B limit is typically used as a line
rating under contingency. The way line ratings are utilized is defined in Limit Monitoring Settings.
A checkbox, Only Monitor Scenarios Limits, appears on both of these sub-tabs. Check this
box to override the normal Limit Monitoring Settings and monitor only the lines that are defined
as part of either the Line Ratings A or Line Ratings B lists. When this option is in use, rating A will
be used for base case limitations, and rating B will be used for contingency limitations. If a line is
not in both lists, the rating that is specified will be used for both base case and contingency
limitations. During the ATC calculations, Limit Monitoring Settings will be modified internally to
only monitor the specified lines. Once the analysis is complete, the Limit Monitoring Settings will
be their original settings.
Zone Loads
The Zones sub-tab has additional options used to specify how Mvar load should vary as the MW
load is updated. Only MW load is specified in the scenarios. To specify how the Mvar load should
vary, select either Assume Constant Power Factor to have the Mvar load vary with the MW
by the same power factor that exists in the base case or No Change in Mvar to keep the Mvar
load constant.
When determining how zone loads should be modified during each scenario, the AGC status of
each load is used to determine how the MW portion of the load should be modified. For each
zone to be modified, the Total MW load for all connected loads in the zone is determined
regardless of AGC status. The Total AGC MW load for all connected loads in the zone is
determined for only those loads where AGC = YES. If Total AGC MW > 0 then only those loads
where AGC = YES will be modified. The multiplier for load changes becomes, multiplier = 1 +
(Load MW Change)/(Total AGC MW). If Total AGC MW = 0, all loads in the zone will be modified
during the scenario regardless of the AGC status and the multiplier becomes multiplier = 1 +
(Load MW Change)/(Total MW). Load MW Change is determined by taking the new MW load
value specified with the scenario and subtracting off the Total MW, (Load MW Change) = (New
MW Load Value) - (Total MW). If Total MW = 0 meaning that there is presently no connected
load in the zone, no load changes will be made. If Total AGC MW > 0, only those loads where
AGC = YES that are in-service will be modified with the new MW load at each load becoming the
present MW load multiplied by the multiplier (1 + (Load MW Change)/(Total AGC MW)). If Total
AGC MW = 0, all loads that are in-service will be modified with the new MW load at each bus
becoming the present MW load multiplier by the multiplier (1 + (Load MW Change)/(Total MW)).
Generator Outputs Tab
Use this tab to define scenario changes for generator MW output. Specify a zero output to take a
generator off-line. Specifying a non-zero output will force the status of the generator to be closed,
meaning that a generator that is currently off-line can be brought on-line during a scenario. The
AGC status of a scenario generator will be set to NO so that any changes made via a scenario will
not be undone by any automatic generation control schemes. If the bus to which the generator is
connected is not in-service, simply changing the generator status to closed will not put the generator
in-service. If the case has breakers defined, an attempt will be made to ensure that a generator is
truly in-service by closing any open breakers that would cause it to be out-of-service. This is done
whenever breakers have been defined in the case. Transmission branches can be identified as
breakers by using the Branch Device Type field on the Line and Transformers Display.
Interface Ratings Tab
Use this tab to define scenario changes for interface MW ratings.
Applying Scenarios
When scenarios are applied, all of the changes specified in the scenario are not applied at once.
Generator and load changes that cause injection changes will force the power flow to solve if the
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injection change exceeds a certain threshold. Currently this threshold is 500 MW. Changes will
accumulate until this condition is met and then the power flow will be solved. If the power flow fails
to converge at any point during this process, the process for making changes for that type of
scenario change is aborted, e.g. if there are 10 load changes to be made and accumulated change
for the first 5 changes exceeds 500 MW the power flow is solved. If it fails to converge, the changes
for the last 5 load changes will not be applied. The system state that remains will not be a state that
contains all of the changes for the scenario. Over all scenario types changes are applied in the
following order: Line Rating A, Line Rating B, Generator, Load, and Interface. The power flow will
only be applied for the changes that affect injection, i.e. generators and loads. If the power flow
fails at any step during this process, the remaining changes will not be applied.
The Scenarios page has these additional controls:
Number of Defined Scenarios per Element Type
On each tab, you may enter how many different scenarios should be defined for that kind of power
system element. For instance if you set Generation Scenarios to 5, then list display on the
Generation Tab will provide 5 columns labeled G0, G1, G2, G3, and G4. Generation outputs should
then be entered into each cell representing the generation output in each scenario.
Total Scenarios
Once you have specified the scenarios, Simulator is able to perform ATC Analysis on every
combination of the axes. For example, assume you have the following:




10 sets of line ratings and zones load
8 sets of generation profiles
3 interface constraints

This yields a total of 240 different scenarios to calculate (10*8*3 = 240 ). Be warned that the more
scenarios you analyze the longer the computation will take.
Set Scenario Names
This button will bring up the Scenario Names dialog, where a different name can be assigned to
each scenario.
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Multiple Scenario ATC Dialog: Results
The Results page of the Multiple Scenario ATC Analysis is available on the Available Transfer Capability
dialog when selecting the option to Analyze Multiple Scenarios on the Advanced Options tab of the
Available Transfer Capability dialog.
Once you have defined your scenarios and started the ATC Analysis, you can switch to the Results
page to see the progress that ATC Analysis is making.

The primary part of the Results page contains a spreadsheet-like look-up table display. The layout of
the display is dictated by the Axis Order selected. Note that because there are three axes possible,
the row and column entries represent the first two axes while the third axis is represented by tabs at
the top of the table. See Local Menu Options for information regarding the options available when
right-clicking within the table.
This dialog has the following controls:
Axis Order
This menu is used to select the desired axis order. The three axes correspond to the three Scenarios
tabs.
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One axis has heading labels G0, G1, … for the Generation Scenarios,
Another with heading labels RL0, RL1, … for the Rating/Load Scenarios,
A third with heading labels I0, I1, … for the Interface Scenarios.

Field to Show
Use this dropdown to select which field is shown in the Results Display. By default this is set to
Transfer Limit, but any field associated with a transfer limiter can be displayed. Click the Find
button to open a dialog that allows search options for determining which field to select.
Show Transfer Limiters
Click the Show Transfer Limiters button to view the Transfer Limiters found under each scenario.
This will open a separate dialog that displays a list of the Transfer Limiters. To see the Transfer
Limiters for a particular scenario, click on the workbook cell that represents the scenario you are
interested in and the separate dialog will update appropriately.
Write to Excel
This button will send the results to an Excel spreadsheet.
Save to Text Files
This option will allow the user to save the results in an auxiliary file.
Results Display
The primary part of the Results tab contains a spreadsheet-like look-up table display. The values
shown in the table for each scenario are for the field selected with the Field to Show option. By
default this is the Transfer Limit. The value that is reported corresponds to the transfer limiter with
the most limiting Transfer Limit. If using one of the iterated methods, the most limiting Transfer
Limit is determined from all limiters that have been iterated on.
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Multiple Scenario ATC Analysis Results: Local Menu Options
The Results page of the Multiple Scenario ATC Analysis is available on the Available Transfer Capability
dialog when selecting the option to Analyze Multiple Scenarios on the Advanced Options tab of the
Available Transfer Capability dialog.
Right-clicking on the table contained on the Results page will bring up a local menu containing several
other options. The first several options are only enabled if a cell that represents a scenario is rightclicked. These options will perform an operation with respect to the Scenario:
Take me to Scenario …
Implements the changes in the Scenario resulting in a modified system state. Transfer limits are not
calculated.
Determine Transfer Limit For Scenario …
Calculates the ATC for the Scenario, and then sets the system state back to the Initial State.
Determine Transfer Limit for Selected Scenarios
This option is available if multiple scenarios are selected. Multiple scenarios can be selected by
holding down the CTRL key and left-clicking on the desired scenarios. When this option is selected,
transfer limits for all of the highlighted scenarios will be calculated. The system state will be restored
to the Initial State upon completion of all calculations.
Take me to the Transfer Limit For Scenario …
Performs ATC analysis for the Scenario, and then ramps the transfer to the lowest transfer limit
found. If using one of the iterated methods, the transfer limit used for the ramping is the lowest one
that is iteratively found.
Other options on this local menu are not related to the Scenario that has been clicked.
Increase Transfer for Present System State
Increments the transfer level for the present system state by a user-defined amount.
Return to Initial State
Returns the system state to the Initial State. The initial state is the state in memory when the
ATC analysis is started. The initial state is only stored if using one of the iterative ATC Solution
Methods or analyzing Multiple Scenarios. The initial state is also stored when opening the ATC dialog
if an initial state has already been stored.
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Multiple Scenario ATC Dialog: Combined Results
The Combined Results page of the Multiple Scenario ATC Analysis is available on the Available Transfer
Capability dialog when selecting the option to Analyze Multiple Scenarios on the Advanced Options
tab of the Available Transfer Capability dialog.

The tables on the Combined Results page show the transfer limitations under ALL scenarios. The
scenarios are identified by the default fields ATCLineZoneChanges, ATCGenChanges, and
ATCInterfaceChanges. When defining scenarios for Line Ratings/Zone Loads, Generator Outputs, and
Interface Ratings each corresponding scenario is given an integer identifier. The entries in the table
fields correspond to these integer identifiers. Transfer limitations can be filtered based on the type of
limitation by switching between the All Limiters, Branch Limiters, Interface Limiters, and Nomogram
Interface Limiters sub-tabs, but the tables on any of these sub-tabs will still contain the relevant type
of limiters from all scenarios. The transfer limiter results and remaining fields correspond to those
described in the Transfer Limiters Display section.
The ATCLineZoneChanges, ATCGenChanges, and ATCInterfaceChanges fields can be used when
interacting with the ATC results using auxiliary files and SimAuto to get access to the multiple scenario
results. These fields should be used with the TRANSFERLIMITER data type to specify the ATC scenario
to which a transfer limitation corresponds. These fields are extra key fields for this data type. If these
fields are blank or omitted from input data, the limitations are assumed to go with the standard single
set of ATC results.
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ATC Dialog: Transfer Limiters Display
The Transfer Limiters Display shows the results of ATC Analysis. This display appears either on the
Result page of the Available Transfer Capability dialog or as a separate window when performing
Multiple Scenario Available Transfer Capability Analysis.
The display contains four different tabs: All Limiters, Branch Limiters, Interface Limiters, and
Nomogram Interface Limiters.
The Contingency Definition display at the bottom of the window shows information on the defined
contingency that caused the limitation selected from one of the four tabbed pages of limiters. For
more information on this display, see Contingency Analysis - Contingency Definition Display.

Transfer Limiters Display
The Transfer Limiters Display has the following controls:
All Limiters Tab
The All Limiters tab shows a list of all the transfer limitations found. This includes limitations on
branches, interfaces, areas, zones, etc…
Branch Limiters Tab
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The Branch Limiters tab only shows those limitations with a transmission line or transformer as the
limiting element. The limiting element description for the Branch Limiters tab is replaced by the bus
numbers and names of the limiting element.
Interface Limiters Tab
The Interface Limiters tab only shows those limitations with an interface as the limiting element. The
limiting element description is replaced by the name of the interface.
Nomogram Interface Limiters Tab
The Nomogram Interface Limiters tab only shows those limitations with a nomogram interface as the
limiting element. The limiting element description is replaced by the name and segment of the
nomogram interface.
Limiters Fields
Transfer Limit (shown by default)
The Transfer Limit Field shows the Transfer Limit in MW for the Limiting Element during the
Limiting Contingency. This value depends on the ATC Solution Method Used:





Single Linear Step (SL): Only one Linear ATC step is performed. The Transfer Limit values
are those found during this step.
Iterated Linear Step (IL): The Single Linear Step method is iterated during this method.
The Transfer Limiters shown are those found during the final step performed. The actual
Transfer Limit values are the values found at the last step plus the accumulated amount the
transfer has been ramped. The Transfer Limitation(s) that were iterated on individually are
highlighted in yellow.
Iterated Linear Step (IL) then Full CTG: The Transfer Limits shown for the Transfer
Limitation(s) that were used when iterating are equal to the accumulated amount that the
transfer was ramped during the initial Iterated Linear Step and then the contingency
analysis step. These limitations are highlighted in cyan. The Transfer Limits shown for all
other limiters are the results of the initial Iterated Linear Step calculation performed before
iterating on individual limitations for the contingency analysis.

For the iterated methods the Iteratively Found field, Limiting Element field, and color indicators
are used to highlight the Transfer Limitations when certain situations are encountered. Unless
otherwise indicated, the keyword listed below will show up in the Iteratively Found field:







YES (yellow) - Indicates the Transfer Limitation(s) that were iterated on individually during
the Iterated Linear Step (IL) method or Iterated Linear Step (IL) then Full CTG method
when studying base case limitations. The Transfer Limit that is reported is the thermal
limitation.
FULL (aqua) - Indicates the Transfer Limitation(s) that were iterated on individually during
the Iterated Linear Step (IL) then Full CTG method. The Transfer Limit that is reported is
the thermal limitation.
OSCILLATING (lime green) - This keyword will show up in the Limiting Element field. This
indicates that the number of iterations has exceeded the maximum number of allowed
iterations. This is set at 100 internally. The Transfer Limit that is reported is the
accumulated transfer amount that has been ramped as of the last successful solution. It is
very unlikely that this limitation should occur because there are other mechanisms in place
to prevent oscillations in the process.
POWERFLOW_DIVERGENCE (fuchsia) - If the Limiting Element field also contains
POWERFLOW DIVERGENCE this indicates that this type of limit was encountered when
iterating on all limiters at the start of the process. If the Limiting Element lists an actual
limiting element, this indicates that this type of limit was encountered during the process
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where an individual limiter is being iterated on. If using the Iterated Linear Step (IL) then
Full CTG method this is the step that occurs before actually applying the contingency. The
Transfer Limit that is reported is the total amount that could be ramped before the power
flow failed to converge. This transfer limitation means that the full desired transfer amount
cannot be achieved.
RAMP_FAIL_IN_FULL (fuchsia) - If using the Iterated Linear Step (IL) then Full CTG
method and forcing the transfer ramping to occur pre-contingency, this type of limiter will
occur only when iterating on individual limiters. This indicates that the power flow was not
able to solve while ramping the transfer and not because the contingency failed to solve.
The Transfer Limit that is reported is the accumulated transfer amount that has been
ramped as of the last successful solution at which the contingency solved.
RAMP_FAIL_IN_BASE (gray) - This type of limiter will not be reported for new studies
run with Simulator version 16 or later. It is being retained for the purposes of reporting
limiters that were saved with Simulator version 15 and earlier. This type of limitation is the
same as a POWERFLOW_DIVERGENCE limiter and would only be reported for a transfer
limitation for the base case or when using the Iterated Linear Step (IL) method.
RAMP_FAIL_IN_FULL_AFTER_CTG (gray) - This type of limiter would only be reported
if using the Iterated Linear Step (IL) then Full CTG method and ramping the transfer postcontingency when the full ramping amount cannot be achieved. The Transfer Limit that is
reported is the total amount that could be ramped before the power flow failed to converge.
CTG_FAIL_IN_FULL (orange) - Indicates that the contingency failed to solve at some
point during the Iterated Linear Step (IL) then Full CTG method. This type of limiter would
be reported when NOT using the option to iterate on failed contingencies. The Transfer
Limit that is reported is the accumulated transfer amount that has been ramped as of the
last successful solution in which the contingency solved. If the contingency fails to solve
immediately following the completion of the iterated process on the individual limiter
without the contingency implemented, the Transfer Limit that is reported is the
accumulated transfer amount achieved from that process without the contingency
implemented.
CTG_FAIL_ITERATED (red) - Indicates that the contingency failed to solve at some point
during the Iterated Linear Step (IL) then Full CTG method and using the option to iterate on
failed contingencies. The Transfer Limit that is reported is the accumulated amount that is
possible without overloading the monitored element and in which the contingency solves.
Using the iterated method attempts to get as close as possible (within specified tolerances)
to the highest transfer amount at which the contingency will solve. This is very similar to a
PV nose point.
CTG_FAIL_IN_BASE (purple) - Indicates that the contingency failed to solve at zero
transfer level (base case failure) when using the Iterated Linear Step (IL) then Full CTG
method and choosing to iterated on failed contingencies. The Transfer Limit that is reported
is the accumulated transfer amount that was ramped during the iterated process on the
individual limiter without the contingency implemented.

Limiting Element (shown by default)
Shows a text description of the limiting element. This will contain either the actual limiting
element or some additional information about a limiter. Special keywords that can appear are
OSCILLATING and POWERFLOW DIVERGENCE. There are described in more detail above in the
Transfer Limit description. If reporting reserve limits and either the source or sink will hit a
reserve limit at a particular transfer level, the name of the source or sink will appear as the
limiting element.
Limiting CTG (shown by default)
Shows the name of the limiting contingency.
% OTDF (shown by default)
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This is the OTDF (or PTDF if the Limiting CTG is Base Case) on the Limiting Element for the
transfer direction that is being studied. In other words, this is a linear estimate of the percent of
the transfer that will appear on the Limiting Element if the Limiting CTG occurs.
Note: For iterated techniques, this is the PTDF or OTDF at the last Linear Iteration.
Pre-Transfer Value Estimate (shown by default)
If a contingency is not included in the Limiter, this is equal to the Initial Value. When a
contingency is included in the Limiter, this is the linear estimate of the post-contingency flow
before any transfer occurs. See Available Transfer Capability Analysis.
Note: For iterated techniques, this is the estimate at the last Linear Iteration.
Limit Used (shown by default)
This is the value of the Limit being used by the ATC for the Limiting Element during the Limiting
CTG. It reflects what is specified in Limit Monitoring Settings and options set on the Advanced
Options tab.
MVA the Limit Used is based on
This is the unaltered MVA limit that is defined with a particular limiting element. This is the
starting point for determining the Limit Used that reflects Limiting Monitoring Settings and
options that are set on the Advanced Options tab.
Iteratively Found
String indicating if the limitation was found using one of the iterated methods. Possibilities for
this are NO, YES, FULL, CTG_FAIL_IN_FULL, CTG_FAIL_IN_BASE, CTG_FAIL_ITERATED,
POWERFLOW_DIVERGENCE, RAMP_FAIL_IN_FULL, and RAMP_FAIL_IN_FULL_AFTER_CTG. The
various entries correspond to the limit being highlighted in different colors. Additional information
about what the different entries mean is given above in the Transfer Limit description.
Contingency Definition Display
This display shows information on the defined contingency that caused the limitation selected from
one of the four tabbed pages of limiters. For more information on this display, see Contingency
Analysis - Contingency Definition Display.
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ATC Analysis Methods: Solution Methods
Simulator provides three methods of determining ATC.




Single Linear Step (SL)
Iterated Linear Step (IL)
Iterated Linear Step (IL) then Full Contingency Solution
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ATC Analysis Methods: Single Linear Step (SL)
The Single Linear Step approach is the most common ATC method. This method of ATC analysis uses
only information about the present system state and sensitivities (mathematical derivatives) about the
present system state. These sensitivities are embodied in the PTDF and LODF calculations.
Consider a transmission line with a limit of 10 MW, present loading of 5 MW and a PTDF of 10%. The
estimated maximum transfer without causing an overload on the line is

Transfer Limitation = (Limit – Present Loading) / PTDF = (10 – 5) / 0.1 = 50 MW
When including contingency analysis, the OTDF (Outage Transfer Distribution Factor) and linearized
estimates of post-contingency flows are used to determine the Transfer Limitation.

Transfer Limitation = (Limit – Post-Contingency Loading) / OTDF
If we find the Transfer Limitation for every transmission branch (and interface) during each
contingency, then the ATC is equal to the smallest Transfer Limit value.
Contingency elements have an associated Status that determines under what conditions a particular
action will be implemented. When ATC values are calculated using the single linear step method,
contingency actions are not actually implemented. Because contingency actions are not actually
implemented, POSTCHECK actions cannot be applied after other actions have been performed and the
power flow has been solved. Instead, POSTCHECK actions act as CHECK actions during the single
linear step method. Whether or not model criteria are met for CHECK and POSTCHECK contingency
actions will be determined at the zero transfer level rather than at the transfer level that determines
the limiting transfer.
Note: Simulator also monitors the possibility that a transfer will reduce the flow on a line until the line
reaches its limit for flow in the opposite direction.
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ATC Analysis Methods: Iterated Linear Step (IL)
The Single Linear Step is an extremely fast method for determining the ATC. However, because it only
uses present operating point information, controller changes are not taken into account. The
linearization assumes that all controllers are fixed. The Iterated Linear Step (IL) method provides an
alternative to the Single Linear Step that allows controller changes, but still performs its analysis in a
reasonable amount of time. The (IL) method operates as follows:






Perform Single Linear Step
Set the Stepsize = Minimum Transfer Limitation found in Single Linear Step which is greater than
the specified When iterating, Ignore Limiters below value
If [abs(Stepsize) <= Tolerance] or [Iterations >= 100] then stop
o If the maximum 100 number of iterations is reached, a transfer limitation will be reported
highlighted in lime green with the Iteratively Found field set to OSCILLATING indicating that
the iterated process is oscillating. The Transfer Limit that is reported is the accumulated
transfer amount that has been ramped as of the last successful solution. The maximum
number of iterations is a value that is set internally. It is unlikely that this limit will ever be
reached because other mechanisms are in place to prevent oscillations.
o The iteration count is reset at the beginning of the iteration process.
Implement transfer by amount of Stepsize and resolve power flow
o The power flow is solved according to the options set with the Power Flow Solution Options.
o When calculating a transfer between injection groups, the Island-Based AGC Power Flow
Solution Options applicable to dispatch using an injection group are used when determining
which generators and loads will participate in the transfer. These options include whether or
not AGC status should be considered when determining which units will participate in the
ramping, whether or not to enforce generator MW limits, and whether or not to allow
negative loads. The power factor to use when adjusting load is also specified with these
options.
o To prevent oscillation of the solution, the Stepsize may be limited if the sign of the Stepsize
changes throughout the iterations. At each iteration, the direction of the Stepsize is checked
and the Stepsize is bounded based on the accumulated transfer at each iteration. The
accumulated transfer is the total amount that the transfer between the seller and buyer has
been ramped. The accumulated transfer is updated with the current Stepsize once it has
been determined that Stepsize can be achieved. At the start of the iterated process,
LowBound is initialized to a large negative number and HighBound is initialized to a large
positive number. At each iteration the following checks are performed:
If Stepsize > 0 then LowBound = (Accumulated Transfer)
Else If Stepsize < 0 then HighBound = (Accumulated Transfer)
If Stepsize >= (HighBound - Accumulated Transfer)*0.7
Then Stepsize = (HighBound – Accumulated Transfer)*0.7
Else If Stepsize <= (LowBound - Accumulated Transfer)*0.7
o

Then Stepsize = (LowBound – Accumulated Transfer)*0.7
During the implementation of the transfer, if the full Stepsize cannot be achieved, an
attempt is made to implement as much of the transfer as possible in smaller stepsizes by
reducing the stepsize by half. The stepsize reduction continues until a stepsize is found at
which the power flow will solve. Once this stepsize is found, an attempt will be made to
ramp to the original full stepsize using the smaller reduced stepsize. If at any point in this
process a stepsize cannot be ramped, an iterative process will be used to reduce the
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o

o

o

stepsize so as much as possible of the full original stepsize can be ramped. An internal
tolerance is used to prevent the stepsize from becoming too small.
If the power flow fails to converge at this point without being able to implement the full
Stepsize transfer, a transfer limitation will be reported highlighted in fuchsia with the
Iteratively Found field set to POWERFLOW_DIVERGENCE. The Transfer Limit that is
reported is the total amount that could be ramped before the power flow failed to converge.
This transfer limitation means that the full desired transfer amount cannot be achieved.
o If the full transfer amount cannot be achieved in this process when all limiters are
being iterated on, the iterative process will continue and iterate on individual limiters.
o When all limiters are being iterated on, the Limiting Element will show POWERFLOW
DIVERGENCE in addition to the Iteratively Found field showing
POWERFLOW_DIVERGENCE. This indicates exactly where in the process the ramping
could not be achieved.
o If the full transfer amount cannot be achieved in this process when individual limiters
are being iterated on, the analysis method selected will dictate how the process
continues. If using the Iterated Linear Step (IL) method, a Transfer Limit will be
reported that is the total amount that could be ramped before the power flow failed
to converge and this limiter will be highlighted in fuchsia with the Iteratively Found
field set to POWERFLOW_DIVERGENCE. If the Iterated Linear Step (IL) method is
being used as part of the Full CTG Solution method, the process will continue into
the contingency solution step unless the limiter that is being iterated on is a base
case limitation. If the limiter is a base case limitation, a Transfer Limit will be
reported the same as if using the Iterated Linear Step (IL) method.
o If using the Iterated Linear (IL) then Full CTG method and ramping postcontingency, e.g. the option to Force all transfer ramping to occur in precontingency states and repeat full CTG solutions is NOT checked, and the full
transfer amount cannot be achieved, a transfer limitation will be reported highlighted
in gray with the Iteratively Found field set to RAMP_FAIL_IN_FULL_AFTER_CTG. The
Transfer Limit that is reported is the total amount that could be ramped before the
power flow failed to converge.
The ramping of the transfer is done so that each step adjusts injection from a common
starting point so that the ramping is effectively done in the same direction even if the
Stepsize backs off the transfer. At the start of the iterated process, the base case
generation and load values are stored. At each step where transfer ramping occurs, the
generation and load values are returned to their base case levels and the transfer ramping
is implemented from that point. As an example, take the situation where 1000 MW is
ramped. The next Stepsize is calculated to be -100 MW. The total transfer amount achieved
is then 900 MW. If ramping does not proceed in the same direction, generators that hit
maximum limits when ramping out to 1000 MW will back off from these limits when
ramping the -100 MW Stepsize. Ramping out to the total transfer amount of 900 MW in one
step causes generators to hit their limits and stay there. If the ramping does not proceed in
the same direction, ramping out by the total amount in one step and ramping by backing
off the transfer will yield different results because some generators will no longer be at
limits when ramping in steps. Ramping in the same direction is intended to prevent this
discrepancy with generators at limits.
Reserve limits on generators and loads participating in the transfer will be checked if the
option to enforce limits is active for the selected transactors. Reverse limits are checked
regardless of how the option to Report Generation Reserve Limits is set with the
Common Options. For areas and super areas this means that the global enforcement of
generator limits is active, the area enforcement of limits is active, and there is at least one
generator whose enforcement of limits is active and this generator is on AGC control. For
injection groups this means that the enforcement of limits for the injection group is active.
When a reserve limit is found, the current iterations will stop and a transfer limit will be
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reported with the reserve limit and the area, super area, or injection group that is at a limit.
If a reserve limit is encountered during the step where all transfer limiters are iterated on
together, the entire ATC process will stop. If a reserve limit is encountered during the step
where a limiter is being iterated on individually, the iterations will only stop for that limiter;
other limiters will be processed if they do not hit a reserve limit as well.
At new operating point, go back to first step and repeat

As the initial iteration process is performed, the transfer limiter may be different (i.e. the contingency
and limiting element pair may be different) during each iteration. Once the Stepsize is determined to
be less than or equal to the tolerance (or the maximum number of iterations is met) the order of the
limiters is set.
At this point, the first user specified Transfer Limiters to Iterate On are taken from the list of
limiters and the above process is repeated for each limiter individually, with the contingency and
limiting element pair of each limiter remaining set as determined in the initial process. Some limiters
that will appear in the list of limiters are not valid for iterating on individually. These limiters include
those indicating the full transfer amount could not be ramped in the initial process and those indicating
that a reserve limitation has been met on the source or sink. These type of limiters will be skipped
when choosing those to iterate on individually. Transfer limitations for transfer limits found by iterating
on them individually will be highlighted in yellow in the results and the Iteratively Found field will be
set to YES.
This method takes into account controller changes that occur as you ramp out to the transfer level,
but still avoids the full simulation of contingencies.
This method can be applied between combinations of areas and super areas, OR between two
injection groups. Combinations of areas/superareas and injection groups are not allowed.
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ATC Analysis Methods: Iterated Linear Step (IL) then Full CTG Solution
This method takes the solution process a step further than just the Iterated Linear (IL) method.
Instead of using linear sensitivities to calculate the impact of contingencies on the transfer limits, full
contingencies are implemented and solved with a full power flow solution. Be aware however, that this
calculation method can be extremely slow.
The initial iteration process of (IL) then Full CTG Solution method starts by performing the steps
outlined in the Iterated Linear (IL) process. As the initial iteration process is performed, the transfer
limiter may be different (i.e. the contingency and limiting element pair may be different) during each
iteration. Once the Stepsize is determined to be less than or equal to the tolerance (or the maximum
number of iterations is met) the order of the limiters is set.
At this point, the first user specified Transfer Limiters to Iterate On are taken from the list of
limiters and the steps outlined in the Iterated Linear (IL) process are repeated for each limiter
individually, with the contingency and limiting element pair of each limiter remaining set as determined
in the initial process. Some limiters that will appear in the list of limiters are not valid for iterating on
individually. These limiters include those indicating the full transfer amount could not be ramped in the
initial process and those indicating that a reserve limitation has been met on the source or sink. These
type of limiters will be skipped when choosing those to iterate on individually.
Once the iterated process has been repeated for an individual limiter, there are two different ways that
the processing of the full contingency can proceed. If choosing to NOT Force all transfer ramping
to occur in pre-contingency states and repeat full CTG solutions, the contingency of each
transfer limiter is then enforced in the power flow topology, and a power flow solution is performed to
give a new contingency power flow solution to use as the base for each transfer limiter. If the option
to Use Specific Solution Options for Contingencies is checked, then the power flow is solved
with the options defined with the Contingency Solution Options. Otherwise, the power flow is solved
with the options specified with the Power Flow Solution Options. In either case, the Make-Up Power
option specified with the contingency analysis options is used when applying the contingency. The
iterative process outlined in the Iterated Linear (IL) method is then repeated again for each individual
transfer limiter with the specified contingency of each limiter actually in place in the power flow
solution. If the contingency solution fails to converge, the transfer limitation will be reported
highlighted in orange with the Iteratively Found field set to CTG_FAIL_IN_FULL, and the Transfer Limit
that is reported will be the value determined from the iterated process performed on the individual
limiter before the contingency was applied.
If choosing to Force all transfer ramping to occur in pre-contingency states and repeat full
CTG solutions, after the iterated process is complete for an individual limiter, the contingency of
each transfer limiter is fully implemented in the following steps:




Store the system state following the iterated process on the individual limiter
o At this point the accumulated transfer amount is the total amount that has been transferred
following completion of the iterated process on the individual limiter.
o The Stepsize is zero for the first iteration.
Apply the contingency and perform full power flow solution
o If the option to Use Specific Solution Options for Contingencies is checked, then the
power flow is solved with the options defined with the Contingency Solution Options.
Otherwise, the power flow is solved with the options specified with the Power Flow Solution
Options. In either case, the Make-Up Power option specified with the contingency analysis
options is used when applying the contingency.
o If the option to Iterate on failed contingency is NOT checked and the power flow fails
to solve, the iterated process for the individual limiter will stop and a transfer limitation will
be reported highlighted in orange with the Iteratively Found field set to CTG_FAIL_IN_FULL.
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The Transfer Limit that is reported is the accumulated transfer amount that has been
ramped as of the last successful solution in which the contingency solved. If the
contingency fails to solve immediately following the completion of the iterated process on
the individual limiter without the contingency implemented, the Transfer Limit that is
reported is the accumulated transfer amount achieved from that process without the
contingency implemented.
o If the option to Iterate on failed contingency IS checked and the power flow fails to
solve, a new iteration loop is entered to determine the highest transfer level at which the
contingency can be solved. This loop attempts to determine a more accurate transfer level
at which the contingency fails to solve rather than simply reporting the transfer level at
which the last power flow was successful regardless of the current Stepsize. To start the
iterative process, the current Stepsize is reduced by half. The ramping is performed and the
contingency is solved. The Stepsize will remain the same as long as the contingency can be
solved. If the contingency fails to solve, the Stepsize will be reduced by half again. The
ramping will continue until the contingency no longer solves, the accumulated transfer
during the process meets the original Stepsize, or the Stepsize becomes smaller than the
Stepsize tolerance.
o An additional check is done if the contingency does solve during this process; the
flow on the monitored element is checked to determine if it exceeds its limit. If it is
overloaded, the Stepsize will be reduced by half until the monitored element is no
longer over its limit. While this check is being done on the monitored element limit,
the ramping continues out to the specified amount and the contingency is solved.
During this entire process, the Stepsize is limited to be between zero and the
Stepsize that was ramped when the contingency failed to solve for the first time.
When the iterative process on the failed contingency completes, the iterations are
done for this particular limiter. The Transfer Limit that is reported is the accumulated
amount that is possible without overloading the monitored element and in which the
contingency solves. The limiter will be reported highlighted in red with the Iteratively
Found field set to CTG_FAIL_ITERATED if the monitored element is not loaded to its
limit. If during this process, the monitored element is at its thermal limit and the
contingency solves, the Iteratively Found field is set to FULL and the limiter will be
highlighted in aqua.
o If the contingency fails to solve at any transfer level (base case failure), the limiter
will be reported highlighted in purple with the Iteratively Found field set to
CTG_FAIL_IN_BASE. The Transfer Limit that is reported is the accumulated transfer
amount that was achieved from the iterated process on the individual limiter without
the contingency implemented.
o If the power flow solution is successful, update the accumulated transfer with the Stepsize.
Perform Single Linear Step on the individual limiter
o The Stepsize is the Transfer Limit found for the individual limiter. If the Stepsize is less than
the specified When iterating, Ignore Limiters below value minus the accumulated
transfer amount, it is set to zero.
If [abs(Stepsize) <= Tolerance] or [Iterations >= 100] then stop
o If the maximum 100 number of iterations is reached, a transfer limitation will be reported
highlighted in lime green with the Iteratively Found field set to OSCILLATING indicating that
the iterated process is oscillating. The Transfer Limit that is reported is the accumulated
transfer amount that has been ramped as of the last successful solution. The maximum
number of iterations is a value that is set internally. It is unlikely that this limit will ever be
reached because other mechanisms are in place to prevent oscillations.
o The iteration count is reset at the beginning of the contingency iteration process for each
individual limiter.
Restore system to the state stored in the first step

1381
©2011 PowerWorld Corporation

o



This step removes the contingency that was implemented so that the transfer ramping
occurs prior to the contingency being applied.
Implement transfer by amount of Stepsize and resolve power flow
o The power flow is solved according to the options set with the Power Flow Solution Options.
o When calculating a transfer between injection groups, the Island-Based AGC Power Flow
Solution Options applicable to dispatch using an injection group are used when determining
which generators and loads will participate in the transfer. These options include whether or
not AGC status should be considered when determining which units will participate in the
ramping, whether or not to enforce generator MW limits, and whether or not to allow
negative loads. The power factor to use when adjusting load is also specified with these
options.
o To prevent oscillation of the solution, the Stepsize may be limited if the sign of the Stepsize
changes throughout the iterations. At each iteration, the direction of the Stepsize is checked
and the Stepsize is bounded based on the accumulated transfer at each iteration. The
accumulated transfer is the total amount that the transfer between the seller and buyer has
been ramped. The accumulated transfer is updated with the current Stepsize once it has
been determined that Stepsize can be achieved. At the start of the iterated process,
LowBound is initialized to a large negative number and HighBound is initialized to a large
positive number. At each iteration the following checks are performed:
If Stepsize > 0 then LowBound = (Accumulated Transfer)
Else If Stepsize < 0 then HighBound = (Accumulated Transfer)
If Stepsize >= (HighBound - Accumulated Transfer)*0.7
Then Stepsize = (HighBound – Accumulated Transfer)*0.7
Else If Stepsize <= (LowBound - Accumulated Transfer)*0.7
o

o

o

o

Then Stepsize = (LowBound – Accumulated Transfer)*0.7
During the implementation of the transfer, if the full Stepsize cannot be achieved, an
attempt is made to implement as much of the transfer as possible in smaller stepsizes by
reducing the stepsize by half. The stepsize reduction continues until a stepsize is found at
which the power flow will solve. Once this stepsize is found, an attempt will be made to
ramp to the original full stepsize using the smaller reduced stepsize. If at any point in this
process a stepsize cannot be ramped, an iterative process will be used to reduce the
stepsize so as much as possible of the full original stepsize can be ramped. An internal
tolerance is used to prevent the stepsize from becoming too small.
The ramping of the transfer is done so that each step adjusts injection from a common
starting point so that the ramping is effectively done in the same direction even if the
Stepsize backs off the transfer. Additional details about this are provided in the steps of the
Iterated Linear (IL) process.
If the power flow fails to solve at this point without being able to implement the full
Stepsize transfer, the iterated process for the individual limiter will stop and a transfer
limitation will be reported highlighted in fuchsia with the Iteratively Found field set to
RAMP_FAIL_IN_FULL. The Transfer Limit that is reported is the accumulated transfer
amount that has been ramped as of the last successful solution at which the contingency
solved. The Transfer Limit reported does not indicate the portion of the Stepsize that could
be ramped before the power flow fails to solve.
Reserve limits on generators and loads participating in the transfer will be checked if the
option to enforce limits is active for the selected transactors. Reserve limits are checked
regardless of how the option to Report Generation Reserve Limits is set with the
Common Options. For areas and super areas this means that the global enforcement of
generator limits is active, the area enforcement of limits is active, and there is at least one
generator whose enforcement of limits is active and this generator is on AGC control. For
injection groups this means that the enforcement of limits for the injection group is active.
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When a reserve limit is found, the current iterations will stop and a transfer limit will be
reported with the reserve limit and the area, super area, or injection group that is at a limit.
Go back to second step and repeat

Transfer limitations found by implementing the full contingency solution are highlighted in aqua in the
results with the Iteratively Found field set to FULL.
This method can be applied between combinations of areas and superareas, OR between two injection
groups. Combinations of areas/superareas and injection groups are not allowed.
When using this method, the PTDF and OTDF cutoff values are set to 0.01% internally by the ATC
process when iterating on individual limiters. Once limiters are in the list as having acceptable
distribution factors following the process where all limiters are iterated on as a whole, they should not
be eliminated during the process when they are being iterated on individually. Actual implementation
of the contingency as opposed to the linear determination of the impact of the contingency could lead
to some large differences in the distribution factor post-contingency for some contingency scenarios.
The only time that these differences could be a problem is if implementation of the contingency
actually causes the monitored element to no longer be limiting, i.e. the distribution factor goes to zero.
If this happens for any limiter, that limiter will be marked internally as having an infinite transfer
amount, will show up in the results with a very large transfer limiter value, and will be excluded from
the count of the number of limiters that have been iterated on. The next limiter in the list will then be
processed until the number of Transfer Limiters to Iterate on has been met or there are no more
limiters.
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Simulator Automation Server (SimAuto) Overview
The SimAuto tool is only available if you have purchased the SimAuto add-on to the base
Simulator package. Contact PowerWorld Corporation for details about ordering the
SimAuto version of Simulator.
PowerWorld Corporation also offers Optimal Power Flow (OPF), Available Transfer Capability ATC,
Simulation Automation Server (SimAuto), and Security Constrained Optimal Power Flow (SCOPF) addons. For more information see.
SimAuto provides PowerWorld customers the ability to access PowerWorld Simulator functionality
within a program written externally by the user. The Simulator Automation Server acts as a COM
object, which can be accessed from various programming languages that have COM compatibility.
Examples of programming tools with COM compatibility are Borland Delphi, Microsoft Visual C++,
Microsoft Visual Basic, and Matlab (among others). For more information on COM Objects and
Automation Servers, see the help for Microsoft Windows.
The Automation Server of Simulator works very well in combination with Simulator Script Commands
and Auxiliary Files. It is beneficial to become familiar with these topics when considering using the
Simulator Automation Server.
Previous users of SimAuto in Version 9 will need to update their function calls to SimAuto functions.
PowerWorld Corporation found it imperative to change the function calls for SimAuto, in order to
remedy irreconcilable problems when using SimAuto with some programming languages. The
documentation provided should provide adequate help on the changes needed, but as always, if any
questions arise, please contact PowerWorld Corporation for more information.
Note: When Simulator is launched using the SimAuto object, any currently running instances of
Simulator launched manually will be unaffected. SimAuto will launch a separate background instance
of Simulator so that any manually opened instances of Simulator can continue to be used by the user.
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Installing Simulator Automation Server
Note that previous users of SimAuto in Version 9 will need to update their function calls to SimAuto
functions. PowerWorld Corporation found it imperative to change the function calls for SimAuto, in
order to remedy irreconcilable problems when using SimAuto with some programming languages. The
documentation provided should provide adequate help on the changes needed, but as always, if any
questions arise, please contact PowerWorld Corporation for more information.
Installing the Simulator Automation Server requires no additional steps beyond installing PowerWorld
Simulator as normal. When a version of PowerWorld Simulator containing the Simulator Automation
Server is installed on your computer, the install program automatically adds the information needed by
the Simulator Automation Server to the registry.
If for some reason the registration fails, be sure you have the SimAuto add-on for Simulator and you
have either run the application on the computer or run the command pwrworld / regserver at the
command line. If instead you would like SimAuto to un-register itself as a COM object, run the
command pwrworld /unregserver at the command line.
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Including Simulator Automation Server Functions
Before you can access the functions defined by the Simulator Automation Server when writing the
code for your external program, you must first include the library of functions defined for the Simulator
Automation Server. This kind of library is referred to as a Type Library, which describes the available
functions in a manner that can be interpreted by different programming languages. Importing a Type
Library from another program is usually fairly simple, but the procedure does vary depending on the
programming tool you are using. Please see the help for your programming tool of choice on how to
import a Type Library or COM functions from another program.
Examples
The following examples are just a few specific examples for certain programming media. The
procedure may be different for other programming media not listed. In addition, a procedure given
for a certain type of programming media may be one variation from several possible procedures for
accomplishing the same task.
Borland Delphi







Install the version of PowerWorld Simulator with the Simulator Automation Server included.
In Delphi, choose Import Type Library… from the Project menu.
In the list of libraries, search for and choose pwrworld Library.
If pwrworld Library is not in the list, click Add. Find and choose the Pwrworld.exe file from the
PowerWorld Simulator directory, and click Open.
You should see the class name TSimulatorAuto in the list of Class names.
Click Install to include the PowerWorld Simulator Type Library.

Microsoft Visual Basic for Applications



No additional tasks are necessary
Importing Type Library still works (See Including Functions for version 9).

Microsoft Visual C++




Install the version of PowerWorld Simulator with the Simulation Automation Server included.
Add #import "…\powerworld.exe" in your external program code, using the full path to
the PowerWorld Simulator executable program.
Add using namespace pwrworld in your external program code.

Matlab v.6.5 r.13


No additional tasks are necessary.
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Connecting to Simulator Automation Server
Once the Type Library or COM functions have been included in your programming environment, the
Simulator Automation Server can be handled as any other object in your code. The method for
assigning and connecting to the Simulator Automation Server can vary depending on the programming
environment used, but the idea is basically the same. You define a variable in your program to point to
the server object, which is called SimulatorAuto. If the Type Library was imported properly, you should
have full access to the SimulatorAuto object and its defined functions. Again, the procedure for
creating the object and connecting to SimulatorAuto may vary for different programming languages.
Check the help for your programming environment on connecting to COM or Automation servers.
Examples
The following examples are just a few specific examples for certain programming media. The
procedure may be different for other programming media not listed. In addition, a procedure given
for a certain type of programming media may be one variation from several possible procedures for
accomplishing the same task.
Borland Delphi 5







Add pwrworld_TLB to the uses section of your unit.
Declare a variable globally or as part of another object: A : ISimulatorAuto
Initialize the variable: A := nil
To connect to the Simulator Automation Server, create the connection: A :=
CoSimulatorAuto.create
Perform function calls to the Simulator Automation Server: Output :=
A.SomeFunction(parameters)
To close the connection to the Simulator Automation Server, remove the reference by again
setting: A := nil

Microsoft Visual Basic for Applications
Early Binding:


To connect to the Simulator Automation Server, create the connection initializing the variable:
Dim A as New pwrworld.SimulatorAuto

Late Binding:



Declare a variable globally or as part of another object or function: Dim A As Object
To connect to the Simulator Automation Server, create the connection:
Set A = CreateObject("pwrworld.SimulatorAuto")

Both Early and Late Binding:




Perform function calls to the Simulator Automation Server: Output = A.SomeFunction
parameters
To close the connection to the Simulator Automation Server, remove the reference: Set A =
Nothing
If Type Library was imported, connection can also be achieved as in version 9 (See Connecting
to Simulator Automation Server in version 9).
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Microsoft Visual C++





Declare a variable globally or as part of another object or function: IsimulatorAutoPtr *A
Declare a variable globally or as part of another object or function: CLSID clsid
Declare a variable globally or as part of another object or function: HRESULT hr
Obtain the class identifier (clsid) with the following command:
hr = CLSIDFromProgID(L"pwrworld.SimulatorAuto", &clsid)




Initialize variable A: A = new IsimulatorAutoPtr
To connect to the Simulator Automation Server, create the connection:
hr = A>CreateInstance(clsid, NULL, CLSCTX_SERVER)




Perform function calls to the Simulator Automation Server: Output =
A.SomeFunction(parameters)
To close the connection to the Simulator Automation Server, release the reference:
hr = A>Release()

Matlab v.6.5 r.13


To connect to the Simulator Automation Server, create the connection:
A = actxserver(‘pwrworld.SimulatorAuto’)




Perform function calls to the Simulator Automation Server: Output =
A.SomeFunction(parameters)
To close the connection to the Simulator Automation Server, delete the connection: delete(A)
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Passing Data to the Simulator Automation Server
Passing Data to the Simulator Automation Server
All data to the Simulator Automation Server is passed by value rather than by reference (in pointer
terminology, this corresponds to sending data instead of pointer to data; in Microsoft Visual Basic®,
this corresponds to sending data ByVal instead of ByRef). This makes the marshalling of data between
client software and the COM object much easier.
No Optional Parameters
There are no optional parameters for any of the Simulator Automation functions. All functions must be
called with every argument filled.
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Getting Data from the Simulator Automation Server
The Output Structure
Every function called on the SimulatorAuto object returns the same value, Output, which has a welldefined structure.
Output is of type VARIANT, and is an array of VARIANTs. Output is zero-indexed.
The first element always contains any errors occurring during execution. For those functions returning
more than one element in the Output array (e.g. ListOfDevices), explanation is provided below when
discussing the specific method.
Error Handling
As mentioned above, the first item in the Output VARIANT array, Output[0], contains any errors
occurring during the function’s execution. If no errors occurred during the function’s execution,
Output[0] will be set to an empty BSTR (string) represented in most languages by either ‘’ or "".
Error Format
If an error string is returned, it will be in the following format:
[method name]: [error_explanation]
e.g. RunScriptCommand: Error occurred processing script command – check
command syntax
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Simulator Automation Server Functions
The following list of functions is currently available once the SimulatorAuto object is set in your code.
Check the help sections on these functions to see more detail on the particular function.
ChangeParameters
ChangeParametersSingleElement
ChangeParametersMultipleElement
ChangeParametersMultipleElementFlatInput
CloseCase
GetCaseHeader
GetParametersSingleElement
GetParametersMultipleElement
GetParametersMultipleElementFlatOutput
GetParameters (for compatibility with version 9)
ListOfDevices
ListOfDevicesAsVariantStrings
ListOfDevicesFlatOutput
OpenCase
ProcessAuxFile
RunScriptCommand
GetFieldList
SaveState
LoadState
SaveCase
SendToExcel
WriteAuxFile
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ChangeParameters Function
The ChangeParameters function has been replaced by the ChangeParametersSingleElement function.
ChangeParameters can still be called as before, but will now just automatically call
ChangeParametersSingleElement, and pass on the parameters to that function.
Function Prototype
ChangeParameters(ObjectType, ParamList, Values)
Parameter Definitions
ObjectType : String The type of object you are changing parameters for.
ParamList : Variant A variant array storing strings (COM Type BSTR). This array stores a list
of PowerWorld object field variables, as defined in the section on PowerWorld Object Fields.
The ParamList must contain the key field variables for the specific device, or the device cannot
be identified.
Values : Variant A variant array storing variants. This array can store any type of information
(integer, string, etc.) in each array position. A value should be passed for each field variable
given in the ParamList. The Values array must contain the key field values for the specific
device, or the device cannot be identified.
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ChangeParametersSingleElement Function
The ChangeParametersSingleElement function allows you to set a list of parameters for a single object
in a case loaded into the Simulator Automation Server. In addition to changing parameters for objects,
this function can also be used to set options for some of the Simulator tools, such as ATC and OPF.
This function is identical in setup to the GetParametersSingleElement function, with the exception that
the Values array must contain a value for each field variable given in the ParamList array.
Function Prototype
ChangeParametersSingleElement(ObjectType, ParamList, Values)
Parameter Definitions
ObjectType : String The type of object you are changing parameters for.
ParamList : Variant A variant array storing strings (COM Type BSTR). This array stores a list
of PowerWorld object field variables, as defined in the section on PowerWorld Object Fields.
The ParamList must contain the key field variables or label for the specific device, or the device
cannot be identified.
Values : Variant A variant array storing variants. This array can store any type of information
(integer, string, etc.) in each array position. A value should be passed for each field variable
given in the ParamList. The Values array must contain the key field values for the specific
device, or the device cannot be identified.
Output
ChangeParametersSingleElement only returns the first element in Output, the error string.
Notes
The ParameterList and Values arrays must be the same size, as each parameter must have a
corresponding value to be assigned.
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ChangeParametersSingleElement Sample Code
Borland® Delphi
Var ParamList, ValueList : OLEVariant
// Set ParamList up to modify the maximum number of iterations
// and the system base for the power flow simulations
ParamList := VarArrayCreate([1,2], varOleStr);
ParamList[1] := 'MaxItr';
ParamList[2] := 'SBase';
// ValueList is setup with 41 and 410 for MaxItr and SBase,
// respectively
ValueList := VarArrayCreate([1,2], varOleStr);
ValueList[1] := 41;
ValueList[2] := 410;
// Make the ChangeParametersSingleElement call
Output = SimAuto.ChangeParametersSingleElement('Sim_Solution_Options', _
ParamList, ValueList)
Microsoft® Visual Basic for Applications
' Set ParamList up to modify the maximum number of iterations
' and the system base for the power flow simulations
Dim ParamList As Variant
ParamList = Array("MaxItr", "Sbase")
' ValueList is setup with 41 and 410 for MaxItr and SBase,
' respectively
Dim ValueList As Variant
ValueList = Array(45, 90)
' Make the ChangeParametersSingleElement call
Output = SimAuto.ChangeParametersSingleElement("Sim_Solution_Options", _
ParamList, ValueList)
Matlab®
% Set ParamList up to modify the maximum number of iterations
% and the system base for the power flow simulations
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ParamList = {'MaxItr' 'Sbase'};
% values is setup with 41 and 410 for MaxItr and SBase,
% respectively
values = [41 410];
% Convert the values matrix to a set of cells for passing
% through the COM interface
ValueList = num2cell(values);
' Make the ChangeParametersSingleElement call
Output = SimAuto.ChangeParametersSingleElement('Sim_Solution_Options', _
ParamList, ValueList)

1395
©2011 PowerWorld Corporation

ChangeParametersMultipleElement Function
The ChangeParametersMultipleElement function allows you to set parameters for multiple objects of
the same type in a case loaded into the Simulator Automation Server. This function is very similar to
the ChangeParametersSingleElement, but allows for modifying multiple elements with a single function
call. The advantage of this function is that it is much faster to change multiple elements with a single
function call than it is to repeatedly call ChangeParametersSingleElement multiple times.
Function Prototype
ChangeParametersMultipleElement(ObjectType, ParamList, Values)
Parameter Definitions
ObjectType : String The type of object you are changing parameters for.
ParamList : Variant A variant array storing strings (COM Type BSTR). This array stores a list
of PowerWorld object field variables, as defined in the section on PowerWorld Object Fields.
The ParamList must contain the key field variables for the specific device, or the device cannot
be identified.
ValueList : Variant A variant array storing arrays of variants. This is the difference between
the multiple element and single element change parameter functions. This array stores a list of
arrays of values matching the fields laid out in ParamList. You construct ValueList by creating an
array of variants with the necessary parameters for each device, and then inserting each
individual array of values into the ValueList array. SimAuto will pick out each array from
ValueList, and calls ChangeParametersSingleElement internally for each array of values in
ValueList.
Output
ChangeParametersMultipleElement only returns the first element in Output, the error string.
Notes
The ParameterList and each array of values stored in ValueList must be the same size, as each
parameter must have a corresponding value to be assigned.
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ChangeParametersMultipleElement Sample Code
Borland® Delphi
Var ParamList, ValueList : OLEVariant
// Set ParamList up to modify the MW output of generators
ParamList := VarArrayCreate([1,3], varOleStr);
ParamList[1] := 'BusNum';
ParamList[2] := 'GenID';
ParamList[3] := ‘GenMW’;
// ValueList is setup with MW values for generators at buses 1 and 2
ValueList := VarArrayCreate([1,2], varOleStr);
For k := 1 to 2 do begin
IndValueList := VarArrayCreate([1,3], varOleStr);
IndValueList[1] := k;
IndValueList[2] := ‘1’;
IndValueList[3] := k*10;
ValueList[k] := IndValueList;
End;
// Make the ChangeParametersMultipleElement call
Output = SimAuto.ChangeParametersMultipleElement('Sim_Solution_Options', _
ParamList, ValueList)
Microsoft® Visual Basic for Applications
' Set ParamList up to modify the MW output of generators
Dim ParamList As Variant
ParamList = Array("BusNum", "GenID", "GenMW")
' ValueList is setup with MW values for generators at buses 1 and 2
Dim ValueList(2) As Variant
For k = 0 to 1
Dim IndValueList As Variant
IndValueList = Array(k+1,"1",(k+1)*10)
ValueList(k) = IndValueList
Next
' Make the ChangeParametersMultipleElement call
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Output = SimAuto.ChangeParametersMultipleElement("Sim_Solution_Options", _
ParamList, ValueList)

1398
©2011 PowerWorld Corporation

ChangeParametersMultipleElementFlatInput Function
The ChangeParametersMultipleElementFlatInput function allows you to set parameters for multiple
objects of the same type in a case loaded into the Simulator Automation Server. This function is very
similar to the ChangeParametersMultipleElement, but uses a single dimensioned array of values as
input instead of a multi-dimensioned array of arrays. The advantage of this function is that it is much
faster to change multiple elements with a single function call than it is to repeatedly call
ChangeParametersSingleElement multiple times. An additional advantage over
ChangeParametersMultipleElement is that you can still take advantage of the speed improvement,
even if the programming language you are using does not support multi-dimensioned arrays.
Function Prototype
ChangeParametersMultipleElement(ObjectType, ParamList, NoOfObjects, ValueList)
Parameter Definitions
ObjectType : String The type of object you are changing parameters for.
ParamList : Variant A variant array storing strings (COM Type BSTR). This array stores a list
of PowerWorld object field variables, as defined in the section on PowerWorld Object Fields.
The ParamList must contain the key field variables for the specific device, or the device cannot
be identified.
NoOfObjects You must pass an integer number of devices that are passing values for.
SimAuto will automatically check that the number of parameters for each device (counted from
ParamList) and the number of objects integer correspond to the number of values in value list
(counted from ValueList.)
ValueList : Variant A variant array storing a list of variants. Value list can be an array with
many values, as it is a single dimensioned array of all values for all devices that are being
changed. The structure of the ValueList array is such that all of the parameters for the first
object are listed first, then all parameters for the second object, and so on. The parameters
must be in the same order as given in ParamList. In other words, your array would look like:
ValueList = Array(Obj1Param1, Obj1Param2, Obj2Param1, Obj2Param2,Obj3Param1, …,
ObjNParam1, ObjNParam2)
Output
ChangeParametersMultipleElementFlatInput only returns the first element in Output, the error
string.
Notes
If the number of parameters given in ParamList multiplied by the number of objects passed
does not equal the total number of values in ValueList, SimAuto will abort the function call.
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ChangeParametersMultipleElementFlatInput Sample Code
Borland® Delphi
Var ParamList, ValueList : OLEVariant
// Set ParamList up to modify the MW output of generators
ParamList := VarArrayCreate([1,3], varOleStr);
ParamList[1] := 'BusNum';
ParamList[2] := 'GenID';
ParamList[3] := ‘GenMW’;
// ValueList is setup with MW values for generators at buses 1 and 2
NumObjects := 2;
NumFields := NumObjects * 3;
ValueList := VarArrayCreate([1,NumFields], varOleStr);
For k := 0 to 1 do begin
ValueList[3*k+1] := k;
ValueList[3*k+2] := ‘1’;
ValueList[3*k+3] := k*10;
End;
// Make the ChangeParametersMultipleElementFlatInput call
Output = SimAuto.ChangeParametersMultipleElementFlatInput('Sim_Solution_Options', _
ParamList, NumObjects, ValueList)
Microsoft® Visual Basic for Applications
' Set ParamList up to modify the MW output of generators
Dim ParamList As Variant
ParamList = Array("BusNum", "GenID", "GenMW")
' ValueList is setup with MW values for generators at buses 1 and 2
NumObjects = 2
NumFields = NumObjects * 3
Dim ValueList(NumObjects) As Variant
For k = 0 to 1
ValueList(3*k+1) = k
ValueList[3*k+2] := ‘1’;
ValueList[3*k+3] := k*10;
Next
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' Make the ChangeParametersMultipleElementFlatInput call
Output = SimAuto.ChangeParametersMultipleElementFlatInput("Sim_Solution_Options", _
ParamList, NumObjects, ValueList)
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CloseCase Function
The CloseCase function is used to close a load flow case loaded in the Simulator Automation Server.
This function should be called at some point after the OpenCase function.
Function Prototype
CloseCase()
Parameter Definitions
No parameters are passed.
Output
CloseClase returns only one element in Output—any errors which may have occurred when
attempting to close the case.
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CloseCase Function: Sample Code
Borland® Delphi
Output := SimAuto.CloseCase();
Microsoft® Visual Basic for Applications
Output = SimAuto.CloseCase()
Matlab®
Output = SimAuto.CloseCase
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GetFieldList Function
The GetFieldList function is used to find all fields contained within a given object type.
Function Prototype
GetFieldList(ObjectType)
Parameter Definitions
ObjectType : String The type of object for which the fields are requested.
Output
GetFieldList returns two elements of the Output array. The first element, as with the other
functions, returns any errors that might have occurred. The second element of the Output array
contains an n x 4 array of fields. The layout of this array is virtually identical to the output
obtained by going to Help > Export Case Object Fields from the main menu of Simulator.
The first column, corresponding to the (n,0) column in the field array, specifies which fields are
key fields for the object. The second column, (n,1), contains the internal name of the field. The
third column, (n,2), contains the type of data stored in the string (e.g. String, Integer, Real).
The fourth column, (n,3), contains the display-friendly name of the field.
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GetFieldList Function: Sample Code
Microsoft® Visual Basic for Applications
Dim objecttype As String
' Object type to obtain
objecttype = "branch"
' Make the GetField call
Output = SimAuto.GetFieldList(objecttype)
Matlab®
% Object type to obtain
objecttype = 'branch';
% Make the GetField call
Output = SimAuto.GetFieldList(objecttype);
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GetParametersSingleElement Function
The GetParametersSingleElement function is used to request the values of specified fields for a
particular object in the load flow case. For returning field values for multiple objects, you can use a
loop to make repeated calls to the GetParametersSingleElement function, and pass the object and
desired field information for each object. This function is identical in setup to the ChangeParameters
function, with the exception that the Values array will be updated with the values for the field variables
defined in ParamList.
Function Prototype
GetParametersSingleElement(ObjectType, ParamList, Values)
Parameter Definitions
ObjectType : String The type of object you are changing parameters for.
ParamList : Variant A variant array storing strings. This array stores a list of PowerWorld
object field variables, as defined in the section on PowerWorld Object Fields. The ParamList must
contain the key field variables or label for the specific device, or the device cannot be identified.
The remaining field variables in the array define which values to retrieve from Simulator.
Values : Variant A variant array storing variants. This array can store any type of information
(integer, string, etc.) in each array position. Values must be passed for the key field variables in
ParamList, in the same array position. The remaining field positions in the Values array should be
set to zero.
Output
GetParametersSingleElement returns both the first element in Output—containing any errors
occurring during execution of the function—and a second element in Output. The second
element returned in the Output structure is a one dimensional array containing the values
corresponding to the fields specified in ParamList.
The Output structure of GetParametersSingleElement is shown in the following figure.
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GetParametersSingleElement Function: Sample Code Borland® Delphi
// This example retrieves some parameters for bus 2 of the loaded
// case, using the GetParametersSingleElement function, as well as
// the old GetParameters function
procedure TMainForm.RunGPSEClick(Sender: TObject);
var
Output : OLEVariant;
FieldBusArray, ValueBusArray : OLEVariant;
i : Integer;
begin
// Declares fields array to be sent to Excel
FieldBusArray := VarArrayCreate([1,5], varOleStr);
FieldBusArray[1] := 'pwBusNum';
FieldBusArray[2] := 'pwBusname';
FieldBusArray[3] := 'pwBusKVVolt';
FieldBusArray[4] := 'pwBusPUVolt';
FieldBusArray[5] := 'pwBusAngle';
ValueBusArray := varArrayCreate([1,5],varOleStr);
ValueBusArray[1] := 2; // To get parameters for bus 2
ValueBusArray[2] := 0;
ValueBusArray[3] := 0;
ValueBusArray[4] := 0;
ValueBusArray[5] := 0;
// Gets parameters with GetParametersSingleElement function
Output := SimAuto.GetParametersSingleElement('bus', FieldBusArray, ValueBusArray);
if (string(Output[0]) <> '') then
StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0])
else
begin
StatusBar1.Panels[1].Text := 'Parameters got.';
Memo1.Lines.Add('== GetParametersSingleElement ==');
Memo1.Lines.Add('Value : Output[1][i]');
for i := VarArrayLowBound(Output[1],1) to VarArrayHighBound(Output[1],1) do begin
Memo1.Lines.Add(FieldBusArray[i] + ' : ' + string(Output[1][i]));
end;
Memo1.Lines.Add('');
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end;
// Gets parameters with old function GetParameters
Output := SimAuto.GetParameters('bus', FieldBusArray, ValueBusArray);
if (string(Output[0]) <> '') then
StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0])
else
begin
StatusBar1.Panels[1].Text := 'Parameters got.';
Memo1.Lines.Add('== GetParameters ==');
Memo1.Lines.Add('Value : Output[1][i]');
for i := VarArrayLowBound(Output[1],1) to VarArrayHighBound(Output[1],1) do begin
Memo1.Lines.Add(FieldBusArray[i] + ' : ' + string(Output[1][i]));
end;
Memo1.Lines.Add('');
end;
end;
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GetParametersSingleElement Function: Sample Code Matlab®
% This example loads all buses in the case, and then gets
% some parameters of the last bus in the list
% validcase is a global variable – check case is open
if validcase
% Gets all buses in the case
output = simauto.ListOfDevices('bus','');
if ~(strcmp(output{1},''))
disp(output{1})
validbusarray = false;
else
% Puts the buses in row vector busarray
for i=size(output{2}{1},1):size(output{2}{1},2)
busarray(i,1) = output{2}{1}(i);
end
disp('Succesful ListOfDevices')
disp(busarray)
validbusarray = true;
end
end
% validbusarray is a global variable – check buses are loaded
if validcase & validbusarray
% Gets parameters for last bus of busarray
fieldarray = {'pwbusnum' 'pwbusname' 'pwbusvolt' 'pwbusangle'};
valuearray = [busarray(size(busarray,1)) '0' '0' '0'];
valuelist = num2cell(valuearray);
output = simauto.GetParametersSingleElement('bus',fieldarray,valuelist);
if ~(strcmp(output{1},''))
disp(output{1})
else
% Puts the buses in row vector busparam
paramlist = transpose(output{2});
for i=size(paramlist,1):size(paramlist,2)
busparam(i,1) = paramlist(i);
end
disp('Succesful GetParameters for Bus')
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disp(fieldarray)
disp(busparam)
end
end
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GetParametersSingleElement Function: Sample Code Microsoft® Visual Basic for Excel
Private Sub btnGetParametersSingleElement_Click()
Dim objtype, filter As String
Dim xlWB As Excel.Workbook
Set xlApp = Excel.Application
' Checks connection and open case
' SimAuto and caseopen are global variables
If Not SimAuto Is Nothing And caseopen Then
objtype = "bus"
Dim fieldArray As Variant
fieldArray = Array("pwBusNum", "pwBusName", "pwBusKVVolt", _
"pwBusPUVolt", "pwBusAngle")
Dim ValueArray As Variant
ValueArray = Array(1, 0, 0, 0, 0)
output = SimAuto.GetParameters(objtype, fieldArray, ValueArray)
If output(0) <> "" Then
DisplayErrorMessage output(0)
Else
DisplayMessage "Succesful GetParametersSingleElement"
' Prepares additional worksheet
Set xlWB = xlApp.Workbooks.Add
' Copies list of devices in worksheet
With xlWB
Sheets("sheet2").Activate
Sheets("sheet2").Name = "GetParametersSingleElement"
With Sheets("GetParametersSingleElement")
Dim i As Integer
Range(Cells(1, 5), Cells(200, 7)).Clear
Cells(1, 1) = "List of Devices for " + objtype + ":"
' Setup fields as subheader
For i = LBound(fieldArray) To UBound(fieldArray)
Cells(2, i + 1) = fieldArray(i)
Next i
' Determine number of fields retrieved
Dim lowfld, highfld As Integer
lowfld = LBound(output(1), 1)
highfld = UBound(output(1), 1)
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DisplayMessage "Number of Fields: " + Str(lowfld) + Str(highfld)
For i = lowfld To highfld
Cells(j + 3, i + 1) = output(1)(i)
Next i
End With
End With
End If
End If
End Sub
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GetParametersMultipleElement Function
The GetParametersMultipleElement function is used to request the values of specified fields for a set of
objects in the load flow case. The function can return values for all devices of a particular type, or can
return values for only a list of devices of a particular type based on an advanced filter defined for the
loaded case.
Function Prototype
GetParametersMultipleElement(ObjectType, ParamList, FilterName)
Parameter Definitions
ObjectType : String The type of object you are changing parameters for.
ParamList : Variant A variant array storing strings. This array stores a list of PowerWorld
object field variables, as defined in the section on PowerWorld Object Fields. The ParamList must
contain the key field variables or label for the specific device, or the device cannot be identified.
The remaining field variables in the array define which values to retrieve from Simulator.
FilterName : String The name of an advanced filter defined in the load flow case open in the
Simulator Automation Server. If no filter is desired, then simply pass an empty string. If a filter
name is passed but the filter cannot be found in the loaded case, the server will default to
returning all objects in the case of type ObjType.
Output
GetParametersMultipleElement returns a set of nested arrays containing the parameter values for
the device type requested. The number of arrays of values returned depends on the number of
fields in ParamList.
The Output structure of GetParametersMultipleElement is shown in the following figure.
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As you can see, to access the first parameter value for the first device, Output[1][0][0] would be
the correct array index. For example, the bus number for the first bus would be stored at
Output[1][0][0] after calling
Output = GetParametersMultipleElement('Bus',fieldarray, ''), and assuming
that we have fieldarray = Array(pwBusnum, pwBusName).
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GetParametersMultipleElement Sample Code Borland® Delphi
// This example retrieves some parameters for all buses of the
// loaded case, using the GetParametersMultipleElement function
procedure TMainForm.RunGPMEClick(Sender: TObject);
var
FieldBusArray : OLEVariant;
i,j : Integer;
begin
// Declares fields array to be sent to Excel
FieldBusArray := VarArrayCreate([1,5], varOleStr);
FieldBusArray[1] := 'pwBusNum';
FieldBusArray[2] := 'pwBusname';
FieldBusArray[3] := 'pwBusKVVolt';
FieldBusArray[4] := 'pwBusPUVolt';
FieldBusArray[5] := 'pwBusAngle';
// Gets parameters with Multiple Element function
Output := SimAuto.GetParametersMultipleElement('bus', FieldBusArray, '');
if (string(Output[0]) <> '') then
StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0])
else
begin
StatusBar1.Panels[1].Text := 'Parameters got.';
Memo1.Lines.Add('== GetParametersMultipleElement ==');
Memo1.Lines.Add('Value : Output[1][i][j]');
for i := VarArrayLowBound(Output[1],1) to VarArrayHighBound(Output[1],1) do begin
for j := VarArrayLowBound(Output[1][i],1) to VarArrayHighBound(Output[1][i],1)
do begin
Memo1.Lines.Add(FieldBusArray[i] + '(' + IntToStr(j) + ') : ' +
string(Output[1][i][j]));
end;
end;
Memo1.Lines.Add('');
end;
end;
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GetParametersMultipleElement Function: Sample Code Matlab®
% This example loads all buses in the case, and then gets
% some parameters of such buses
% validcase is a global variable – check case is open
if validcase
% Gets all buses in the case
output = simauto.ListOfDevices('bus', '');
if ~(strcmp(output{1},''))
disp(output{1})
validbusarray = false;
else
% Puts the buses in row vector busarray
for i=size(output{2}{1},1):size(output{2}{1},2)
busarray(i,1) = output{2}{1}(i);
end
disp('Succesful ListOfDevices')
disp(busarray)
validbusarray = true;
end
end
% validbusarray is a global variable – check buses are loaded
if validcase & validbusarray
% Gets parameters for all buses
fieldarray = {'pwbusnum' 'pwbusname' 'pwbusvolt' 'pwbusangle'};
output = simauto.GetParametersMultipleElement('bus', fieldarray,' ');
if ~(strcmp(output{1},''))
disp(output{1})
else
% Puts the buses in matrix busesparam
paramlist = transpose(output{2});
for i=size(paramlist,1):size(paramlist,2)
for j=size(paramlist{i},2):size(paramlist{i},1)
busesparam(j,i) = paramlist{i}(j);
end
end
disp('Succesful GetParametersMultipleElement')
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disp(fieldarray)
disp(busesparam)
end
end
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GetParametersMultipleElement Function: Sample Code Microsoft® Visual Basic for Excel
Private Sub btnGetParametersMultiple_Click()
Dim objtype, filter As String
Dim xlWB As Excel.Workbook
Set xlApp = Excel.Application
' Checks connection and open case
' SimAuto and caseopen are global variables
If Not SimAuto Is Nothing And caseopen Then
objtype = "bus"
filter = ""
Dim fieldArray As Variant
fieldArray = Array("pwBusNum", "pwBusName", "pwBusKVVolt", _
"pwBusPUVolt", "pwBusAngle")
output = SimAuto.GetParametersMultipleElement(objtype, fieldArray, filter)
If output(0) <> "" Then
DisplayErrorMessage output(0)
Else
DisplayMessage "Succesful GetParametersSingleElement"
' Prepares additional worksheet
Set xlWB = xlApp.Workbooks.Add
' Copies list of devices in worksheet
With xlWB
Sheets("sheet2").Activate
Sheets("sheet2").Name = "GetParametersSingleElement"
With Sheets("GetParametersSingleElement")
Dim i, j As Integer
Range(Cells(1, 5), Cells(200, 7)).Clear
Cells(1, 1) = "List of Devices for " + objtype + ":"
' Setup fields as subheader
For i = LBound(fieldArray) To UBound(fieldArray)
Cells(2, i + 1) = fieldArray(i)
Next i
' Determine number of fields retrieved
Dim lowfld, highfld As Integer
lowfld = LBound(output(1), 1)
highfld = UBound(output(1), 1)
' Determine number of objects retrieved
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Dim lowobj, highobj As Integer
lowobj = LBound(output(1)(lowkeyf), 1)
highobj = UBound(output(1)(lowkeyf), 1)
DisplayMessage "Number of Fields: " + Str(lowfld) + Str(highfld)
DisplayMessage "Number of objects: " + Str(lowobj) + Str(highobj)
For i = lowfld To highfld
For j = lowobj To highobj
Cells(j + 3, i + 1) = output(1)(i)(j)
Next j
Next i
End With
End With
End If
End If
End Sub
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GetParametersMultipleElementFlatOutput Function
This function operates the same as the GetParametersMultipleElement function, only with one notable
difference. The values returned as the output of the function are returned in a single-dimensional
vector array, instead of the multi-dimensional array as described in the GetParametersMultipleElement
topic. The function returns the parameter values for the device type requested, and the number of
values returned depends on the ParamList and any advanced filter that impacts the number of devices
returned.
The format of the output array is the following:
[errorString, NumberOfObjectsReturned, NumberOfFieldsPerObject, Ob1Fld1, Ob1Fld2, …,
Ob(n)Fld(m-1), Ob(n)Fld(m)]
The data is thus returned in a single dimension array, where the parameters
NumberOfObjectsReturned and NumberOfFieldsPerObject tell you how the rest of the array is
populated. Following the NumberOfObjectsReturned parameter is the start of the data. The data is
listed as all fields for object 1, then all fields for object 2, and so on. You can parse the array using the
NumberOf… parameters for objects and fields.
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GetParameters Function
This function is maintained in versions of Simulator later than version 9 for compatibility with Simulator
version 9. This function is replaced by GetParametersSingleElement. See also
GetParametersMultipleElement.
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ListOfDevices Function
The ListOfDevices function is used to request a list of objects and their key fields from the Simulator
Automation Server. The function can return all devices of a particular type, or can return only a list of
devices of a particular type based on an advanced filter defined for the loaded case. This function is
best used in conjunction with a looping procedure and the ChangeParameters or
GetParametersSingleElement functions to process a group of devices.
Function Prototype
ListOfDevices(ObjType, filterName)
Parameter Definitions
ObjType : String The type of object for which you are acquiring the list of devices.
FilterName : String The name of an advanced filter defined in the load flow case open in the
Simulator Automation Server. If no filter is desired, then simply pass an empty string. If the filter
cannot be found, the server will default to returning all objects in the case of type ObjType.
Output
ListOfDevices returns a set of nested arrays containing the key field values for the device type
requested. The number of arrays of values returned depends on the object type selected. For
instance, buses have only one key field (the bus number) so calling ListOfDevices for buses will
return only one array of values—the bus numbers. On the other hand, calling ListOfDevices for
branches will return three arrays of values—the "From" bus, "To" bus, and ID—for each branch
in the case meeting the specified filter.
The arrays containing the key field values for each device are arranged as shown in the following
figure.

1423
©2011 PowerWorld Corporation

As you can see, to access the first key field value for the first device, Output[1][0][0] would be
the correct array index. For example, the bus number (which is the bus key field) for the first bus
would be stored at Output[1][0][0] after calling Output = ListOfDevices('Bus', '').
One unique limitation of the ListOfDevices function from other SimAuto functions is that this is
the only function that returns the output as strongly typed variables. The bus numbers are
always returned as Long Integers, and the Circuit ID values are returned as strings. This was
actually an oversight during the design of SimAuto. In all other SimAuto functions, the values are
returned as Variant types, with each value within the variant being a string. This was the
intended operation for this function as well. Since the Automation Server interface was released
with the errant inclusion of the ListOfDevices function, it could not be modified. Therefore,
another function, ListOfDevicesAsVariantStrings, has been created. This function returns all
values in variant variables, with each as a string within the variant type.
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ListOfDevices Function: Sample Code for Borland® Delphi
Sample Code
// Runs Available Transfer Capability Routine
// Executes ATC Calculations among all areas
// and sends results to Excel
procedure TMainForm.RunATCClick(Sender: TObject);
var
i, j, LowB, HighB : Integer;
ValuesAreaArray : OLEVariant;
begin
// Obtain all the areas
Output := SimAuto.ListOfDevices('area', '');
if (string(Output[0]) <> '') then
StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0])
else
begin
ValuesAreaArray := Output[1][0];
LowB := VarArrayLowBound(ValuesAreaArray, 1);
HighB := VarArrayHighBound(ValuesAreaArray, 1);
// Executes loop
for i := LowB to HighB do
for j := LowB to HighB do begin
if (i <> j) then begin
// Runs ATC calculations
OutputATC := SimAuto.RunScriptCommand('entermode(atc); ' +
'atcdetermine([Area ' + IntToStr(ValuesAreaArray[i]) +
'], [Area ' + IntToStr(ValuesAreaArray[j]) + '])');
if (string(OutputATC[0]) <> '') then
StatusBar1.Panels[1].Text := 'Error: ' + string(OutputATC[0])
else begin
// Sends ATC results to Excel
Output := SimAuto.SendToExcel('transferlimiter', '', 'all');
if (string(Output[0]) <> '') then
StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0])
else
StatusBar1.Panels[1].Text := 'ATC calculations done.';
end;
end;
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end;
end;
end;
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ListOfDevices Function: Sample Code for Matlab®
Sample Code
%A list of branches is desired, without using any filter
DeviceType = 'Branch';
FilterName = '';
%Execute the ListOfDevices command
Output = SimAuto.ListOfDevices(DeviceType,FilterName);
%If the first cell in SimAutoOutput ~= '', then that means an error
%occurred.
if ~(strcmp(SimAutoOutput{1},''))
disp(SimAutoOutput{1})
else
%Otherwise, no errors. Display the branch information.
disp('ListOfDevices successful')
%Devicelist1 contains the From: bus number
%Devicelist2 contains the To: bus number
%Devicelist3 contains the Bus identifier
devicelist1 = double(transpose(SimAutoOutput{2}{1}));
devicelist2 = double(transpose(SimAutoOutput{2}{2}));
devicelist3 = SimAutoOutput{2}{3};
%If the device list is greater than 25, don't bother attempting to
%display it on the screen.
if (size(devicelist1,1) > 25)
disp('Device list exceeds 25; use ''devicelist'' to manage list of devices')
else
%Otherwise, display the branches' information.
disp(DeviceType)
disp('From/To/Identifier')
for counter = 1:size(devicelist1,1)
%num2str converts the numbers within devicelist1 and
%devicelist2 to strings for output with disp(). the char()
%function is called on devicelist3's members because the
%SimAuto object returns a character array (as opposed to a
%properly Matlab-format string) and this array must be
%converted to a Matlab-format string.
disp([num2str(devicelist1(counter)) ' ' ...
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num2str(devicelist2(counter)) ' ' ...
char(devicelist3(counter))])
end
end
end
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ListOfDevices Function: Sample Code for Microsoft® Visual Basic for Excel
Sample Code
Private Sub DisplayMessage(ByVal SentText As String)
TextBox.Text = TextBox.Text + SentText + vbCrLf + vbCrLf
End Sub
Private Sub btnListOfDevices_Click()
Dim objtype, filter As String
Dim xlWB As Excel.Workbook
Set xlApp = Excel.Application
' Checks connection and open case
' SimAuto and caseopen are global variables
If Not SimAuto Is Nothing And caseopen Then
objtype = "branch"
filter = ""
output = SimAuto.ListOfDevices(objtype, filter)
If output(0) <> "" Then
DisplayMessage output(0)
Else
DisplayMessage "Succesful List Of Devices"
' Prepares additional worksheet
Set xlWB = xlApp.Workbooks.Add
' Copies list of devices in worksheet
With xlWB
Sheets("sheet1").Activate
Sheets("sheet1").Name = "ListOfDevices"
With Sheets("ListOfDevices")
Dim i, j As Integer
Range(Cells(1, 5), Cells(200, 7)).Clear
Cells(1, 1) = "List of Devices for " + objtype + ":"
Cells(2, 1) = "From Bus Num"
Cells(2, 2) = "To Bus Num"
Cells(2, 3) = "ID"
' Determine number of key fields retrieved
Dim lowkeyf, highkeyf As Integer
lowkeyf = LBound(output(1), 1)
highkeyf = UBound(output(1), 1)
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DisplayMessage "Number of Key Fields: " + Str(lowkeyf) + Str(highkeyf)
' Determine number of objects retrieved
Dim lowobj, highobj As Integer
lowobj = LBound(output(1)(lowkeyf), 1)
highobj = UBound(output(1)(lowkeyf), 1)
DisplayMessage "Number of objects: " + Str(lowobj) + Str(highobj)
For i = lowkeyf To highkeyf
For j = lowobj To highobj
Cells(j + 3, i + 1) = output(1)(i)(j)
Next j
Next i
End With
End With
End If
End If
End Sub
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ListOfDevicesAsVariantStrings Function
This function operates the same as the ListOfDevices function, only with one notable difference. The
values returned as the output of the function are returned as Variants of type String. The
ListOfDevices function was errantly released returning the values strongly typed as Integers and
Strings directly, whereas all other SimAuto functions returned data as Variants of type String. This
function was added to also return the data in the same manner. This solved some compatibility issues
with some software languages.
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ListOfDevicesFlatOutput Function
This function operates the same as the ListOfDevices function, only with one notable difference. The
values returned as the output of the function are returned in a single-dimensional vector array, instead
of the multi-dimensional array as described in the ListOfDevices topic. The function returns the key
field values for the device, typically in the order of bus number 1, bus number 2 (where applicable),
and circuit identifier (where applicable). These are the most common key fields, but some object types
do have other key fields as well.
The format of the output array is the following:
[errorString, NumberOfObjectsReturned, NumberOfFieldsPerObject, Ob1Fld1, Ob1Fld2, …,
Ob(n)Fld(m-1), Ob(n)Fld(m)]
The data is thus returned in a single dimension array, where the parameters
NumberOfObjectsReturned and NumberOfFieldsPerObject tell you how the rest of the array is
populated. Following the NumberOfObjectsReturned parameter is the start of the data. The data is
listed as all fields for object 1, then all fields for object 2, and so on. You can parse the array using the
NumberOf… parameters for objects and fields.
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LoadState Function
LoadState is used to load the system state previously saved with the SaveState function. Note that
LoadState will not properly function if the system topology has changed due to the addition or removal
of the system elements.
Function Prototype
LoadState()
Parameter Definitions
No parameters are passed.
Output
LoadState returns only one element in Output—any errors which may have occurred when
attempting to execute the function.
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LoadState Function: Sample Code
Microsoft® Visual Basic for Applications
' Make the LoadState call
Output = SimAuto.LoadState()
Matlab®
% Make the LoadState call
Output = SimAuto.LoadState();
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OpenCase Function
The OpenCase function will load a PowerWorld Simulator load flow file into the Simulator Automation
Server. This is equivalent to opening a file using the File > Open Case menu option in Simulator.
Function Prototype
OpenCase(FileName)
Parameter Definitions
FileName : String The name of the PowerWorld Simulator case file to be loaded into the
Simulator Automation Server. This string includes the directory location and full file name.
Output
OpenCase returns only one element in Output—if the file cannot be found or an error occurs
while reading the file.
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OpenCase Function: Sample Code
Borland® Delphi
Output := SimAuto.OpenCase('c:\simauto\examples\b7opf.pwb');
if (string(Output[0]) <> '') then
StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0]);
else
begin
StatusBar1.Panels[1].Text := 'Open Case successful.';
// Perform activities with opened case
end;
Microsoft® Visual Basic for Applications
Output = SimAuto.OpenCase("c:\simauto\examples\b7opf.pwb")
If output(0) <> "" Then
MsgBox(output(0))
Else
' Perform activities with the opened case
End If
Matlab®
Output = SimAuto.OpenCase('c:\simauto\examples\b7opf.pwb')
%If the first cell in Output ~= '', then that means an error
%occurred.
if ~(strcmp(Output{1},''))
disp(Output{1})
else
%Otherwise, no errors. Perform activities.
disp('Open Case successful')
end
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ProcessAuxFile Function
The ProcessAuxFile function will load a PowerWorld Auxiliary file into the Simulator Automation
Server. This allows you to create a text file (conforming to the PowerWorld Auxiliary file format) that
can list a set of data changes and other information for making batch changes in Simulator
Function Prototype
ProcessAuxFile(FileName)
Parameter Definitions
FileName : String The name of the PowerWorld Auxiliary file to be loaded into the Simulator
Automation Server. This string includes the directory location and full file name.
Output
ProcessAuxFile returns only one element in Output—any errors which may have occurred when
attempting to load the file.
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ProcessAuxFile Function: Sample Code
Microsoft® Visual Basic for Applications
Dim filename As String
' Setup name of aux file to run
filename = "c:\b7opf_ctglist.aux"
' Make the processAuxFile call
Output = SimAuto.ProcessAuxFile(filename)
Matlab®
% Setup name of aux file to run
filename = 'c:\b7opf_ctglist.aux';
% Make the processAuxFile call
Output = SimAuto.ProcessAuxFile(filename);
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RunScriptCommand Function
The RunScriptCommand function is used to execute a list of script statements. The script actions are
those included in the script sections of the Auxiliary Files. If an error occurs trying to run a script
command, an error will be returned through EString.
Function Prototype
RunScriptCommand(Statements)
Parameter Definitions
Statements : String The block of script actions to be executed. Each script statement must end
in a semicolon. The block of script actions should not be enclosed in curly braces.
Output
RunScriptCommand returns only one element in Output—any errors which may have occurred
when attempting to load or run the auxiliary file.

1439
©2011 PowerWorld Corporation

RunScriptCommand Function: Sample Code
Microsoft® Visual Basic for Applications
Dim scriptcommand As String
' Set script command to cause Simulator to enter Run Mode
scriptcommand = "EnterMode(RUN)"
' Make the RunScriptCommand call
Output = SimAuto.RunSCriptCommand(scriptcommand);
' Set script command to cause Simulator to perform a single,
' standard solution
scriptcommand = "SolvePowerFlow(RECTNEWT)"
' Make the RunScriptCommand call
Output = SimAuto.RunSCriptCommand(scriptcommand);
Matlab®
% Set script command to cause Simulator to enter Run Mode
scriptcommand = 'EnterMode(RUN)';
% Make the RunScriptCommand call
Output = SimAuto.RunSCriptCommand(scriptcommand);
% Set script command to cause Simulator to perform a single,
% standard solution
scriptcommand = 'SolvePowerFlow(RECTNEWT)';
% Make the RunScriptCommand call
Output = SimAuto.RunSCriptCommand(scriptcommand);
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SaveCase Function
The SaveCase function is used to save a case previously loaded in the Simulator Automation Server
using the OpenCase function. The function allows you to specify a file name and a format for the save
file.
Function Prototype
SaveCase(FileName, EString, FileType, Overwrite)
Parameter Definitions
FileName : String The name of the file you wish to save as, including file path.
FileType : String A string indicating the format of the written case file. An empty string will
return an error. The following list is the currently supported list of string identifiers and the file
types they represent.
"PTI23" PTI version 23 (raw)
"PTI24" PTI version 24 (raw)
"PTI25" PTI version 25 (raw)
"PTI26" PTI version 26 (raw)
"PTI27" PTI version 27/28 (raw)
"PTI29" PTI version 29 (raw)
"PTI30" PTI version 30 (raw)
"PTI31" PTI version 31 (raw)
"GE" GE PSLF (epc)
"IEEE" IEEE common format (cf)
"PWB70" PowerWorld Binary version 7.0 (pwb)
"PWB" PowerWorld Binary (most recent) (pwb)
Overwrite : Boolean A Boolean value which indicates whether to overwrite a file if FileName
already exists. If Overwrite is set to false and the file specified by FileName already exists,
SaveCase will return an error message and do nothing to the file.
Output
SaveCase returns only one element in Output—any errors which may have occurred when
attempting to save the case.
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SaveCase Function: Sample Code
Microsoft® Visual Basic for Applications
' Save the case as a PWB file
Output = SimAuto.SaveCase("c:\b7opfcopy.pwb", "PWB", true)
' Save the case as a PTI file
Output = SimAuto.SaveCase("c:\b7opfcopy.raw", "PTI", true)
Matlab®
% Setup name of PWB file to write
filenamepwb = 'c:\b7opfcopy.pwb';
% Setup name of PTI file to write
filenamepti = 'c:\b7opfcopy.raw';
% Make the SaveCase call for the PWB file
Output = SimAuto.SaveCase(filenamepwb, ‘PWB’, true);
% Make the SaveCase call for the PTI file
Output = SimAuto.SaveCase(filenamepti, ‘PWB’, true);
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SaveState Function
SaveState is used to save the current state of the power system. This can be useful if you are
interested in comparing various cases, much as the Difference Flows feature works in the Simulator
application.
Function Prototype
SaveState()
Parameter Definitions
No parameters are passed.
Output
SaveState returns only one element in Output—any errors which may have occurred when
attempting to execute the function.
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SaveState Function: Sample Code
Microsoft® Visual Basic for Applications
' Make the SaveState call
Output = SimAuto.SaveState()
Matlab®
% Make the SaveState call
Output = SimAuto.SaveState();
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SendToExcel Function
The SendToExcel function can be called to send data from the Simulator Automation Server to an
Excel spreadsheet. The function is flexible in that you can specify the type of object data you want to
export, an advanced filter name for a filter you want to use, and as many or as few field types as
desired that are supported by the type of object. The first time this function is called, a new instance
of Excel will be started, and the data requested will be pasted to a new sheet. For each subsequent
call of this function, the requested data will be pasted to a new sheet within the same workbook, until
the workbook is closed.
Function Prototype
SendToExcel(ObjectType, FilterName, FieldList)
Parameter Definitions
ObjectType : String A string describing the type of object for which your are requesting data.
FilterName : String The name of an advanced filter which was previously defined in the case
before being loaded in the Simulator Automation Server. If no filter is desired, then simply pass
an empty string. If a filter name is passed but the filter cannot be found in the loaded case, no
filter is used.
FieldList : Variant This parameter must either be an array of fields for the given object or the
string "all". As an array, FieldList contains an array of strings, where each string represents an
object field variable, as defined in the section on PowerWorld Object Variables. If, instead of an
array of strings, the single string "all" is passed, the Simulator Automation Server will use
predefined default fields when exporting the data.
Output
SendToExcel returns only one element in Output—any errors which may have occurred when
attempting to execute the function.
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SendToExcel Function: Sample Code
Microsoft® Visual Basic for Applications
Dim FieldList As Variant
' Setup fieldlist to send the bus number, gen id and gen agc to Excel
FieldList = Array("pwBusNum", "pwGenID", "pwGenAGCAble")
' Make the SendToExcel call
' By specifying the parameter FieldList, only the three fields
' for each generator will be returned
Output = SimAuto.SendToExcel("gen", "", "FieldList")
' Sending the string "all" instead of a fieldlist array
' writes all predefined fields to the Excel spreadsheet
Output = SimAuto.SendToExcel("gen", "", "all")
Note: This function call will send the values of the fields in FieldList to an Excel workbook for all the
generators in the load flow case. If a filter name had been passed instead of an empty string,
Simulator would have located and used a pre-defined advanced filter and applied it to the information
if it was found.
Matlab®
% Setup fieldlist to send the bus number, gen id and gen agc to Excel
fieldlist = {'pwBusNum' 'pwGenID' 'pwGenAGCAble' };
% Make the SendToExcel call
Output = SimAuto.SendToExcel('gen', '' , FieldList);
% Sending the string 'all' instead of a fieldlist array
% writes all predefined fields to the Excel spreadsheet
Output = SimAuto.SendToExcel('gen', '', 'all');
Note: This function call will send the values of the fields in FieldList to an Excel workbook for all the
generators in the load flow case. If a filter name had been passed instead of an empty string,
Simulator would have located and used a pre-defined advanced filter and applied it to the information
if it was found.
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TSGetContingencyResults Function
TSGetCongencyResults function
The TSGetContingencyResults function is used to read transient stability results into an external
program (i.e. Matlab or VB) using SimAuto.
This function is analogous to the script command TSGetResults, where rather than saving out results
to a file, the results are passed back directly to the SimAuto COM object and may be further
processed by an external program. As with TSGetResults, this function should only be used after the
simulation is run (for example, use this after running script commands TSSolveAll or TSSolve).
Function Prototype
TSGetContingencyResults(CtgName, ObjFieldList, StartTime, StopTime)
Parameter Definitions
CtgName : String The contingency to obtain results from. Only one contingency be obtained
at a time.
ObjFieldList: VariantA variant array of strings which may contain plots, subplots, or individual
object/field pairs specifying the result variables to obtain.
StartTime : String The time in seconds in the simulation to begin retrieving results. If not
specified, the start time of the simulation is used.
StopTime : String The time in seconds in the simulation to stop retrieving results. If not
specified, the end time of the simulation is used.
Output
The SimAuto output for this function is a Variant which contains three levels. Output(0) displays
an error message, if any. Output(1) displays the header which describes the variables that were
saved out. Output(2) displays the time series data (numerical results from simulation),
corresponding to the variables described in the header. MATLAB indexing begins at 1 instead of
0, so add one to all the indices shown when using MATLAB.
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TSGetContingencyResults Sample Code
Sample code (VB):
Set mySimAuto = New pwrworld.SimulatorAuto
Output = mySimAuto.OpenCase("G:\wscc_9busCacheTest.pwb")
If Output(0) <> "" Then
DisplayErrorMessage Output(0)
End If
Dim objFieldList As Variant
objFieldList = Array("Plot 'Gen_Rotor Angle'", "Bus 4 | frequency")
Output = mySimAuto.TSGetContingencyResults("ctgname1", objFieldList, "0.0", "10.0")
If Output(0) <> "" Then
DisplayErrorMessage Output(0)
End If
Set SimAuto = Nothing
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Sample code (Matlab):
%Initialize SimAuto object
SimAuto = actxserver('pwrworld.SimulatorAuto');
%Initialize SimAutoOutput which is used to store the output of every method call
clear SimAutoOutput;
SimAutoOutput = {''};
%Open the case
SimAutoOutput = SimAuto.OpenCase('G:\wscc_9busCacheTest.pwb');
if ~(strcmp(SimAutoOutput{1},''))
disp(SimAutoOutput{1})
else
disp('OpenCase successful')
end
%%
% Here we get the results for all of the angles directly into Matlab via SimAuto
%%
newCtgName = 'ctgName';
objFieldList = {'"Plot ''Gen_Rotor Angle''"' };
SimAutoOutput = SimAuto.TSGetContingencyResults(newCtgName, objFieldList , '0.0', '10.0');
if ~(strcmp(SimAutoOutput{1},''))
disp(SimAutoOutput{1})
else
disp('GetTSResultsInSimAuto successful')
%Get the results
localResults = SimAutoOutput{3};
%Get the header variables to use for plot labels
Header = SimAutoOutput{2};
% Convert a matrix of strings into a matrix of numbers and plot them
localResultsMat = str2double(localResults);
plot(localResultsMat(:,1), localResultsMat(:,[2:size(localResultsMat,2)]));
title(['Transient stability results for ', newCtgName]);
TimeSeriesNames = Header([4:size(Header,1)],2);
legend(TimeSeriesNames); % these labels come from the HEADER
xlabel('time')
ylabel('Generator rotor angle (degrees)');
end
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%Delete (close) the COM object.
delete(SimAuto);
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WriteAuxFile Function
The WriteAuxFile function can be used to write data from the case in the Simulator Automation Server
to a PowerWorld Auxiliary file. The function is flexible in that you can specify the type of object data
you want to export, an advanced filter name for a filter you want to use, and as many or as few field
types as desired that are supported by the type of object. In addition, you can specify a new file name
for each call to WriteAuxFile, or you can specify the same file name and append the data to the file.
Function Prototype
WriteAuxFile(FileName, FilterName, ObjectType, EString, ToAppend, FieldList)
Parameter Definitions
FileName : String The name of the PowerWorld Auxiliary file you wish to save.
FilterName : String The name of an advanced filter which was previously defined in the case
before being loaded in the Simulator Automation Server. If no filter is desired, then simply pass
an empty string. If a filter name is passed but the filter cannot be found in the loaded case, no
filter is used.
ObjectType : String A string describing the type of object for which your are requesting data.
ToAppend : Boolean If you have given a file name of an auxiliary file that already exists, then
the file will either be appended to or overwritten according to the setting of this parameter. If
ToAppend is False and the file already exists, WriteAuxFile will return an error message and do
nothing to the file.
FieldList : Variant This parameter must either be an array of fields for the given object or the
string "all". As an array, FieldList contains an array of strings, where each string represents an
object field variable, as defined in the section on PowerWorld Object Variables. If, instead of an
array of strings, the single string "all" is passed, the Simulator Automation Server will use
predefined default fields when exporting the data.
Output
WriteAuxFile returns only one element in Output—any errors which may have occurred when
attempting to execute the function.
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WriteAuxFile Function: Sample Code
Microsoft® Visual Basic for Applications
Dim FieldList As Variant
Dim auxfilename As String
' Setup FieldList to send the bus number, gen id and gen agc
FieldList = Array("pwBusNum", "pwGenID", "pwGenAGCAble")
' Aux file to write to
auxfilename = "c:\businfo.aux"
' Make the WriteAuxFile call
' By specifying the parameter FieldList, only the three fields
' for each generator will be returned
Output = SimAuto.WriteAuxFile(auxfilename, "", "gen", true, FieldList)
' Sending the string "all" instead of the FieldList array
' writes all predefined fields to the Excel spreadsheet
Output = SimAuto.SendToExcel(auxfilename, "", "gen", true, "all")
Note: This function call will send the values of the fields in FieldList to an auxiliary file for all the
generators in the load flow case. If a filter name had been passed instead of an empty string,
Simulator would have located and used a pre-defined advanced filter and applied it to the information
if it was found.
Matlab®
% Setup FieldList to send the bus number, gen id and gen agc
fieldlist = {'pwBusNum' 'pwGenID' 'pwGenAGCAble' };
% Aux file to write to
auxfilename = 'c:\businfo.aux';
% Make the WriteAuxFile call
Output = SimAuto.WriteAuxFile(auxfilename, '', 'gen', true, FieldList);
% Sending the string 'all' instead of the FieldList array
% writes all predefined fields to the .aux file
Output = SimAuto.WriteAuxFile(auxfilename, '', 'gen', true, 'all');
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Note: This function call will send the values of the fields in FieldList to an auxiliary file for all the
generators in the load flow case. If a filter name had been passed instead of an empty string,
Simulator would have located and used a pre-defined advanced filter and applied it to the information
if it was found.
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Simulator Automation Server Properties
The following list of parameters is currently available once the SimulatorAuto object is set in your
code. Check the help sections on these properties to see more detail on the particular property.
ExcelApp
CurrentDir
ProcessID
RequestBuildDate

1456
©2011 PowerWorld Corporation

ExcelApp Property
The Simulator Automation Server has the ability to send data from Simulator to an Excel spreadsheet
using the SendToExcel. By default, the Simulator Automation Server starts an instance of Excel the
first time one of the above functions is called. Each subsequent call to these two functions will then
send data to the same instance of Excel, until it is manually closed by the user. The ExcelApp property
allows the user to gain access to the instance of Excel used by the Simulator Automation Server from
within its own code. Thus the user can write code to manipulate the external instance of Excel. In
addition, the ExcelApp property can be set by the user’s code, meaning that the user can initialize an
external instance of Excel from within their own code and set the ExcelApp property to their external
instance of Excel. Simulator itself is limited to starting only one instance of Excel on its own, but with
the ExcelApp property allowing you to set the instance of Excel that Simulator uses on the fly, you can
generate multiple instances of Excel within your code, and handle setting the ExcelApp property of the
Simulator Automation server to the desired Excel instance depending on the data you want to send to
Excel.
The ExcelApp property is a variable of type Variant that returns the pointer to an object representing
the external instance of Excel.
ExcelApp : Variant
To gain access to the external instance of Excel stored in the ExcelApp property, you first need to
initialize a variable as an object. The following are a couple of examples in Borland Delphi and
Microsoft Visual Basic.
Examples
Borland Delphi 5






Var MyExc : TObject
MyExc = SimAuto.ExcelApp{Makes the connection to the external instance}

{Perform activities with the Excel instance}
MyExc.Quit{Closes the external instance if called; do not call if you wish the instance to
remain open}
MyExc.Free{Removes the connection to the external instance}

Microsoft Visual Basic






Dim MyExc As Variant
Set MyExc = SimAuto.ExcelApp{Makes the connection to the external instance}

{Perform activities with the Excel instance}
MyExc.Quit{Closes the external instance if called; do not call if you wish the instance to
remain open}
Set MyExc = Nothing{Removes the connection to the external instance}
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ExcelApp Property: Sample Code
Microsoft® Visual Basic for Applications
Dim ExcelObject As Variant
If Not (IsEmpty(SimAuto.ExcelApp)) Then
Set ExcelObject = SimAuto.ExcelApp
ExcelObject.DisplayAlerts = False
ExcelObject.Quit
Else
MsgBox("Attempted to obtain Excel COM object from " + _
"Simulator, but there is not one open.")
End If
Matlab®

MATLAB is currently unable to handle COM object properties returning COM objects themselves, such
as the ExcelApp property of Simulator.
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CurrentDir Property
The CurrentDir property of the Simulator Automation Server allows you to retrieve or set the working
directory for the currently running SimulatorAuto process. This is most useful if using relative
filenames (e.g. "relativename.aux" versus "C:\Program Files\PowerWorld\Working\abosultename.aux")
when specifying files.

1459
©2011 PowerWorld Corporation

CurrentDir Property: Sample Code
Microsoft® Visual Basic for Applications
' Display the current directory
MsgBox(SimAuto.CurrentDir)
' Set the current directory to c:\
SimAuto.CurrentDir = "c:\"
Matlab®
% Display the current directory
disp(SimAuto.CurrentDir)
% Set the current directory to c:\
SimAuto.CurrentDir = 'c:\';
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ProcessID Property
The ProcessID property of the Simulator Automation Server allows you to retrieve the process ID of
the currently running SimulatorAuto process, as can also be seen through the Task Manager in
Windows® NT 4, 2000 and XP. This information can be useful if a forced shutdown of the
SimulatorAuto object is needed, as all calls to the SimulatorAuto object are synchronous. This means
the SimulatorAuto object will not be destroyed until all calls, no matter the time of execution, have
completed.
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ProcessID Property: Sample Code
Microsoft® Visual Basic for Applications
' Display the process ID
MsgBox(SimAuto.ProcessID)
Matlab®
% Display the process ID
disp(num2str(SimAuto.ProcessID))
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RequestBuildDate Property
The RequestBuildDate property of the Simulator Automation Server allows you to retrieve the build
date of the PowerWorld Simulator executable currently running with the SimulatorAuto process. The
property returns an integer value that represents a date. This information is useful for verifying the
release version of the executable.
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PowerWorld Object Variables
The ability to access power system data for different objects through various Simulator Automation
Server Functions is based on variables defined in Simulator that can be referred to as Object Field
Variables. Each object (i.e. bus, generator, etc.) can have numerous fields associated with it. Each of
these fields, in turn, has a variable associated with the field to enable access to the field for the
purpose of acquiring or changing data. For example, the GetParametersSingleElement function has a
parameter called ParamList, which is intended to store a list of Object Field Variables for a particular
type of object. When the function is called, the Simulator Automation Server will return the values
associated with each particular field variable for the type of object specified. These field variables allow
for complete flexibility by the user in specifying as many or as few fields for a particular object when
acquiring or changing data.
Examples of Field Variables
BusGenMW
BusNum
Simulator has literally hundreds of parameters spanning numerous types of device and option
specifications. Rather than list all of the field variables and the value they represent in this help file, we
have enabled Simulator to automatically generate a text file containing the field variables and a
description of what value the variable represents. PowerWorld Corporation highly recommends that
you examine this list. To generate this text file, run PowerWorld Simulator and access the Help menu.
Choose the option Export Case Object Fields… The list of fields can either be saved to a text file or
sent to Excel. The list will consist of the field variables, the type of variable (string, integer, etc.), and
a description of the value the field variable represents, with key fields for different objects marked with
an asterisk. The field variables will also be split into sections based on the type of object they are valid
for. Note that the same field variable may be available for more than one object, but that the value
represented by the field variable might vary for different objects.
Examples of Field Variables in Listing
BusGenMW Real 'Bus Gen MW'
* BusNum Integer 'Bus Number' (* denotes key field in text file)
ATC_MaxLimElements Integer 'Max # Limiting Elements'
The last note on the Object Field Variables is that some of the object field variables are reused for
more than one value for an object. For example, a transmission line has "from" and "to" buses
associated with the line. Rather than have separate field variables for values at each terminal bus, the
same field variable is used for both, with a colon followed by a number appended to the variable to
signify which bus the value represents. As an example, consider the field variable for bus per unit
voltage, which is BusPUVolt. Since there are two buses per line, the "From" bus voltage would be
represented as BusPUVolt:0, and the "To" bus voltage would be represented as BusPUVolt:1. The
enumeration of the field variables always starts with 0 for the first instance. You may note that in the
text file of field values that you don't see any field variables with :0 appended to them. Since we did
not want you to have to always append the :0 on all field variables, the default for a field variable with
no appended :# is 0. Thus you would only need to be concerned with appending the :# for field
variables that require a number greater than 0.
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Simulator Automation Server (version 9)
NOTE: The function calls for version 9 of SimAuto have become obsolete in version 10. The
reason for the change was due to problems that arose with the structure of the functions
in certain programming languages. The function structures have been modified for version
10 of Simulator. If you have code written that uses version 9 SimAuto function structures,
it is fairly straightforward to convert the function calls from version 9 to version 10.
Please see the updated section on the Simulator Automation Server for version 10. If you
still have questions, please contact PowerWorld Corporation.
The PowerWorld Automation Server is only available to customers who have purchased the SimAuto
add-on for PowerWorld Simulator. The PowerWorld Simulator Automation Server is intended for
enabling a PowerWorld customer with the ability to access PowerWorld Simulator functionality from
within a program written externally by the user. The Simulator Automation Server acts as a COM
object, which can be accessed from various different programming languages that have COM
compatibility. Examples of programming tools with COM compatibility are Borland Delphi, Microsoft
Visual C++, and Microsoft Visual Basic, just to name a few. For more information on COM and
Automation servers, see the help for Microsoft Windows.
The Automation Server of Simulator works very well in combination with Simulator Script Commands
and Auxiliary Files. It is beneficial to become familiar with these topics when considering using the
Simulator Automation Server.
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Installing Simulator Automation Server (version 9)
Installing the Simulator Automation Server requires no additional steps beyond installing PowerWorld
Simulator as normal. When a version of PowerWorld Simulator containing the Simulator Automation
Server is installed on your computer, the install program automatically adds the information needed by
the Simulator Automation Server to the registry.
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Including Simulator Automation Server Functions (version 9)
Before you can access the functions defined by the Simulator Automation Server when writing the
code for your external program, you must first include the library of functions defined for the Simulator
Automation Server. This kind of library is referred to as a Type Library, which describes the available
functions in a manner that can be interpreted by different programming languages. Importing a Type
Library from another program is usually fairly simple, but the procedure does vary depending on the
programming tool you are using. Please see the help for your programming tool of choice on how to
import a Type Library or COM functions from another program.
Examples
The following examples are just a few specific examples for certain programming media. The
procedure may be different for other programming media not listed. In addition, a procedure given
for a certain type of programming media may be one variation from several possible procedures for
accomplishing the same task.
Borland Delphi 5







Install the version of PowerWorld Simulator with the Simulator Automation Server included.
In Delphi 5, choose Import Type Library… from the Project menu.
In the list of libraries, search for and choose pwrworld Library.
If pwrworld Library is not in the list, click Add. Find and choose the Pwrworld.exe file from the
PowerWorld Simulator directory, and click Open.
You should see the class name TSimulatorAuto in the list of Class names.
Click Install to include the PowerWorld Simulator Type Library.

Microsoft Visual Basic





Install the version of PowerWorld Simulator with the Simulator Automation Server included.
In VB, choose References… from the Tools menu. Find and choose pwrworld Library from
the list of references.
If pwrworld Library is not in the list, click Browse. Change the file type to *.exe, find and
choose the Pwrworld.exe file from the PowerWorld Simulator directory, and click Open.
Click OK to install the Simulator Type Library reference.

Microsoft Visual C++




Install the version of PowerWorld Simulator with the Simulation Automation Server included.
Add #import "…\powerworld.exe" in your external program code, using the full path to
the PowerWorld Simulator executable program.
Add using namespace pwrworld in your external program code.
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Connecting to Simulator Automation Server (version 9)
Once the Type Library or COM functions have been included in your programming environment, the
Simulator Automation Server can be handled as any other object in your code. The method for
assigning and connecting to the Simulator Automation Server can vary depending on the programming
environment used, but the idea is basically the same. You define a variable in your program to point to
the server object, which is called SimulatorAuto. If the Type Library was imported properly, you should
have full access to the SimulatorAuto object and its defined functions. Again, the procedure for
creating the object and connecting to SimulatorAuto may vary for different programming languages.
Check the help for your programming environment on connecting to COM or Automation servers.
Examples
The following examples are just a few specific examples for certain programming media. The
procedure may be different for other programming media not listed. In addition, a procedure given
for a certain type of programming media may be one variation from several possible procedures for
accomplishing the same task.
Borland Delphi 5







Add pwrworld_TLB to the uses section of your unit.
Declare a variable globally or as part of another object: A : ISimulatorAuto.
Initialize the variable: A := nil.
To connect to the Simulator Automation Server, create the connection: A :=
CoSimulatorAuto.create.
Perform function calls to the Simulator Automation Server: A.SomeFunction(parameters).
To close the connection to the Simulator Automation Server, remove the reference by again
setting: A := nil.

Microsoft Visual Basic





Declare a variable globally or as part of another object or function: Public A As
SimulatorAuto.
To connect to the Simulator Automation Server, create the connection: Set A = New
SimulatorAuto.
Perform function calls to the Simulator Automation Server: A.SomeFunction parameters.
To close the connection to the Simulator Automation Server, remove the reference: Set A =
Nothing.

Microsoft Visual C++








Declare a variable globally or as part of another object or function: IsimulatorAutoPtr *A.
Declare a variable globally or as part of another object or function: CLSID clsid.
Declare a variable globally or as part of another object or function: HRESULT hr.
Obtain the class identifier (clsid) with the following command: hr =
CLSIDFromProgID(L"pwrworld.SimulatorAuto", &clsid).
Initialize variable A: A = new IsimulatorAutoPtr.
To connect to the Simulator Automation Server, create the connection: hr =
A>CreateInstance(clsid, NULL, CLSCTX_SERVER).
Perform function calls to the Simulator Automation Server: A.SomeFunction(parameters).
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To close the connection to the Simulator Automation Server, release the reference: hr =
A>Release().
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Simulator Automation Server Properties (version 9)
The following list of parameters is currently available once the SimulatorAuto object is set in your
code. Check the help sections on these properties to see more detail on the particular property.
ExcelApp
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ExcelApp Property (version 9)
The Simulator Automation Server has the ability to send data from Simulator to an Excel spreadsheet
using the SendToExcel. By default, the Simulator Automation Server starts an instance of Excel the
first time one of the above functions is called. Each subsequent call to these two functions will then
send data to the same instance of Excel, until it is manually closed by the user. The ExcelApp property
allows the user to gain access to the instance of Excel used by the Simulator Automation Server from
within their own code. Thus the user can write code to manipulate the external instance of Excel. In
addition, the ExcelApp property can be set by the user’s code, meaning that the user can initialize an
external instance of Excel from within their own code and set the ExcelApp property to their external
instance of Excel. Simulator itself is limited to starting only one instance of Excel on its own, but with
the ExcelApp property allowing you to set the instance of Excel that Simulator uses on the fly, you can
generate multiple instances of Excel within your code, and handle setting the ExcelApp property of the
Simulator Automation server to the desired Excel instance depending on the data you want to send to
Excel.
The ExcelApp property is a variable of type Variant that returns the pointer to an object representing
the external instance of Excel.
ExcelApp : Variant
To gain access to the external instance of Excel stored in the ExcelApp property, you first need to
initialize a variable as an object.
The following are a couple of examples in Borland Delphi and Microsoft Visual Basic.
Examples
Borland Delphi 5






Var MyExc : TObject
MyExc = SimAuto.ExcelApp{Makes the connection to the external instance}

{Perform activities with the Excel instance}
MyExc.Quit{Closes the external instance if called; do not call if you wish the instance to
remain open}
MyExc.Free{Removes the connection to the external instance}

Microsoft Visual Basic






Dim MyExc As Object
Set MyExc = SimAuto.ExcelApp{Makes the connection to the external instance}

{Perform activities with the Excel instance}
MyExc.Quit{Closes the external instance if called; do not call if you wish the instance to
remain open}
Set MyExc = Nothing{Removes the connection to the external instance}
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Simulator Automation Server Functions (version 9)
The following list of functions is currently available once the SimulatorAuto object is set in your code.
Check the help sections on these functions to see more detail on the particular function.
ChangeParameters
CloseCase
GetParameters
ListOfDevices
LoadContingencies
OpenCase
ProcessAuxFile
RunScriptCommand
SaveCase
SendToExcel
WriteAuxFile
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ChangeParameters Function (version 9)
The ChangeParameters function allows you to set a list of parameters for a specific object in a case
loaded into the Simulator Automation Server. In addition to changing parameters for objects, this
function can also be used to set options for some of the Simulator tools, such as ATC and OPF. This
function is identical in setup to the GetParameters function, with the exception that the Values array
must contain a value for each field variable given in the ParamList array.
ChangeParameters(tObjectType, ParamList, Values, EString)
Parameter Definitions
TobjectType : String The type of object you are changing parameters for. No default.
ParamList : Variant A variant array storing strings. This array stores a list of PowerWorld
object field variables, as defined in the section on PowerWorld Object Fields. The ParamList
must contain the key field variables for the specific device, or the device cannot be identified.
No Default.
Values : Variant A variant array storing variants. This array can store any type of information
(integer, string, etc.) in each array position. A value should be passed for each field variable
given in the ParamList. The Values array must contain the key field values for the specific
device, or the device cannot be identified. No Default.
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable a string representing an
error that may have occurred in the Simulator Automation Server. If no error occurred, the
EString variable will return an empty string.
Example
ChangeParameters("gen", [pwBusNum, pwGenID, pwGenAGCAble], [1, "1", "Yes"],
EString)
This function call will change the AGC Status of bus number one, generator ID number 1, to
"Yes", meaning the generator will be included in AGC if it's area is on AGC control.
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CloseCase Function (version 9)
The CloseCase function is used to close a load flow case loaded in the Simulator Automation Server.
This function should be called at some point after the OpenCase function. An error will be returned
through the EString parameter if an error occurred while trying to close the case.
CloseCase(EString)
Parameter Definitions
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable a string representing an
error that may have occurred in the Simulator Automation Server. If no error occurred, the
EString variable will return an empty string.
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GetParameters Function (version 9)
The GetParameters function is used to request the values of specified fields for a particular object in
the load flow case. For returning field values for multiple objects, you can use a loop to make repeated
calls to the GetParameters function, and pass the object and desired field information for each object.
This function is identical in setup to the ChangeParameters function, with the exception that the
Values array will be updated with the values for the field variables defined in ParamList.
GetParameters(tObjectType, ParamList, Values, EString)
Parameter Definitions
TobjectType : String The type of object you are changing parameters for. No default.
ParamList : Variant A variant array storing strings. This array stores a list of PowerWorld
object field variables, as defined in the section on PowerWorld Object Fields. The ParamList must
contain the key field variables for the specific device, or the device cannot be identified. The
remaining field variables in the array define which values to retrieve from Simulator. No Default.
Values : Variant A variant array storing variants. This array can store any type of information
(integer, string, etc.) in each array position. Values must be passed for the key field variables in
ParamList, in the same array position. The remaining field positions in the Values array can
initially be filled with either empty strings or zeroes, as the values will be replaced when the
function is processed. No Default.
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable a string representing an
error that may have occurred in the Simulator Automation Server. If no error occurred, the
EString variable will return an empty string.
Example
GetParameters("gen", [pwBusNum, pwGenID, pwGenAGCAble], ValArray = [1, "1",
""], EString)
This function call will return the AGC Status of bus number one, generator ID number 1, in the
ValArray variable. Note that the generator bus number and ID had to be passed into the
function, while the remaining field could be assigned an empty string. If the bus number and ID
had not been passed, an error would have been returned since Simulator would not be able to
identify a generator. With a valid bus number and ID for the generator, the ValArray variable
would have returned an array of the following format: ValArray = [1, "1", "Yes"].
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ListOfDevices Function (version 9)
The ListOfDevices function is used to request a list of objects and their key fields from the Simulator
Automation Server. The function can return all devices of a particular type, or can return only a list of
devices of a particular type based on an advanced filter defined for the loaded case. This function is
best used in conjunction with a looping procedure and the ChangeParameters or GetParameters
functions to process a group of devices.
ListOfDevices(tObjType, EString, filterName, objList1, {objList2}, {objList3})
Parameter Definitions
TobjType : String The type of object for which you are acquiring the list of devices. No default.
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable a string representing an
error that may have occurred in the Simulator Automation Server. If no error occurred, the
EString variable will return an empty string.
FilterName : String The name of an advanced filter defined in the load flow case open in the
Simulator Automation Server. If the filter cannot be found, the server will default to returning all
objects in the case of type TobjType.
ObjList1 : Variant This parameter must be assigned a variable declared as a Variant. The
Simulator Simulation Server will return a variant array filled with the first key field for the devices
of type TobjType. This parameter is required for all types of devices.
ObjList2 : Variant This parameter may be optional. For device types that only have one key
field, you can omit passing a variable for this parameter. If the device type requested has two or
more key fields, then this parameter must be assigned a variable declared as a Variant. The
Simulator Simulation Server will return a variant array filled with the second key field for the
devices of type TobjType.
ObjList3 : Variant This parameter may be optional. For device types that have one or two key
fields, you can omit passing a variable for this parameter. If the device type requested has three
key fields, then this parameter must be assigned a variable declared as a Variant. The Simulator
Simulation Server will return a variant array filled with the third key field for the devices of type
TobjType.
Example
ListOfDevices("gen", EString, "", objList1, objList2)
This function call will return a list of all generators in the load flow case. By passing an empty
string as the filter name, Simulator will not use an advanced filter before returning the generator
key fields. Since generators have two key fields, bus number and ID, it was required to pass two
variant array variables to receive the key fields. Each generator in the case would have its bus
number returned in objList1 and ID in objList2. The corresponding bus number and ID are stored
in the same index position in the two arrays. If only one variant array, objList1, had been passed
in this instance, an error would have been returned stating more arrays were necessary. If the
third variant array, objList3, had been included, Simulator would have still returned the key fields
in objList1 and objList2, and would have returned objList3 as an empty variant.
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LoadContingencies Function (version 9)
The LoadContingencies function can be used to read a set of predefined contingencies from a
PowerWorld Auxiliary Contingency file. Thus once you have defined a set of contingencies in
Simulator and saved the list to a PowerWorld Auxiliary file, you can specify the filename with this
function and the Simulator Automation Server will load the contingencies into memory.
LoadContingencies(fileName, EString, {tAppend})
Parameter Definitions
Filename : String The name of the PowerWorld Auxiliary file containing the defined
contingencies. If the file cannot be found, and error will be returned through EString.
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable a string representing an
error that may have occurred in the Simulator Automation Server. If no error occurred, the
EString variable will return an empty string.
TAppend : Boolean This parameter is optional. If you have more than one list of contingencies
in separate files, you can append the lists together in the Simulator Automation Client by passing
the Boolean value True in this parameter. The default if not passed is False, meaning any
existing contingencies in the Simulator Automation Client would be cleared prior to loading the
new list.
Example
LoadContingencies("c:\my files\ctgfile.aux", EString, True)
This function call will load a previously created list of contingencies that was saved in the
PowerWorld Auxiliary file format. The file name string identifies the location and name of the
auxiliary file. By passing the value True in the optional parameter tAppend, Simulator will read
the list of contingencies and add them to any existing contingencies already loaded in Simulator.
Contingencies in the list existing list with the same name as contingencies in the appending list
will be replaced by the records in the appending list.
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OpenCase Function (version 9)
The OpenCase function will load a PowerWorld Simulator load flow file into the Simulator Automation
Server. If an error occurs trying to open the case, an error message will be returned through EString.
OpenCase(filename, EString)
Parameter Definitions
FileName : String The name of the PowerWorld Simulator case file to be loaded into the
Simulator Automation Server. This string includes the directory location and full file name. If the
file cannot be found or an error occurs while reading the file, an error message will be returned
through EString.
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable a string representing an
error that may have occurred in the Simulator Automation Server. If no error occurred, the
EString variable will return an empty string.
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ProcessAuxFile Function (version 9)
The ProcessAuxFile function will load a PowerWorld Auxiliary file into the Simulator Automation
Server. This allows you to create a text file (conforming to the PowerWorld Auxiliary file format) that
can list a set of data changes and other information for making batch changes in Simulator. If an error
occurs while processing the auxiliary file, an error message is returned through EString.
ProcessAuxFile(filename, EString)
Parameter Definitions
FileName : String The name of the PowerWorld Auxiliary file to be loaded into the Simulator
Automation Server. This string includes the directory location and full file name.
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable a string representing an
error that may have occurred in the Simulator Automation Server. If no error occurred, the
EString variable will return an empty string.
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RunScriptCommand Function (version 9)
The RunScriptCommand function is used to execute a list of script statements. The script actions are
those included in the script sections of the Auxiliary Files. If an error occurs trying to run a script
command, an error will be returned through EString.
RunScriptCommand(Statements, EString)
Parameter Definitions
Statements : String The block of script actions to be executed. Each script statement must
end in a semicolon. The block of script actions should not be enclosed
in curly braces.
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable
a string representing an error that may have occurred in the Simulator
Automation Server. If no error occurred, the EString variable will return
an empty string.
Example
RunScriptCommand("Entermode(RUN); SolvePowerFlow;", EString)
This function call will switch to Run mode and then will solve the power flow of the present
case.
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SaveCase Function (version 9)
The SaveCase function is used to save a case previously loaded in the Simulator Automation Server
using the OpenCase function. The function allows you to specify a file name and a format for the save
file. If an error occurs while trying to save a case, an error message is returned through EString.
SaveCase(fileName, EString, {fileType}, {Overwrite})
Parameter Definitions
fileName : String The name of the file you wish to save as, including file path. No default.
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable a string representing an
error that may have occurred in the Simulator Automation Server. If no error occurred, the
EString variable will return an empty string.
fileType : String This parameter is optional. If you desire to save the case in a format other
than the current PowerWorld Binary (pwb) format, you must specify the type of format in this
parameter as a string. If the parameter is not passed, the format type defaults to the most
recent version of PowerWorld binary (pwb) file. If a string is passed for this parameter, it must at
least be the "PWB" string. An empty string will return an error. The following list is the currently
supported list of string identifiers and the file types they represent.
"PTI23" PTI version 23 (raw)
"PTI24" PTI version 24 (raw)
"PTI25" PTI version 25 (raw)
"PTI26" PTI version 26 (raw)
"PTI27" PTI version 27 (raw)
"GE" GE PSLF (epc)
"IEEE" IEEE common format (cf)
"PWB70" PowerWorld Binary version 7.0 (pwb)
"PWB" PowerWorld Binary (most recent) (pwb)
Overwrite : Boolean This parameter is optional. If you do not want to overwrite a file with the
same name as passed in filename, you must specify this parameter as False. Default is True.
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SendToExcel Function (version 9)
The SendToExcel function can be called to send data from the Simulator Automation Server to an
Excel spreadsheet. The function is flexible in that you can specify the type of object data you want to
export, an advanced filter name for a filter you want to use, and as many or as few field types as
desired that are supported by the type of object. The first time this function is called, a new instance
of Excel will be started, and the data requested will be pasted to a new sheet. For each subsequent
call of this function, the requested data will be pasted to a new sheet within the same workbook, until
the workbook is closed. If an error occurs while trying to send data to Excel, an error message is
returned through EString.
SendToExcel(tObjectType, filterName, EString, {tFieldList})
Parameter Definitions
tObjectType : String A string describing the type of object for which your are requesting data.
No Default.
filterName : String The name of an advanced filter which was previously defined in the case
before being loaded in the Simulator Automation Server. If no filter is desired, then simply pass
an empty string. If a filter name is passed but the filter cannot be found in the loaded case, no
filter is used. Default is an empty string.
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable a string representing an
error that may have occurred in the Simulator Automation Server. If no error occurred, the
EString variable will return an empty string.
TFieldList : Variant This parameter is optional. A variant array of strings, where each string
represents an object field variable, as defined in the section on PowerWorld Object Variables. If
no array is passed, the Simulator Automation Server will use predefined default fields when
exporting the data.
Example
SendToExcel("gen", "", EString, [pwBusNum, pwGenID, pwGenAGCAble])
This function call will send the values of the fields in tFieldList to an Excel workbook for all the
generators in the load flow case. If a filter name had been passed instead of an empty string,
Simulator would have located and used a pre-defined advanced filter and applied it to the
information if it was found. By specifying the fields in the optional parameter tFieldList, only the
three field values for each generator will be returned. If the optional parameter tFieldList had
been omitted, Simulator would have returned internally defined default information for the
generators.
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WriteAuxFile Function (version 9)
The WriteAuxFile function can be used to write data from the case in the Simulator Automation Server
to a PowerWorld Auxiliary file. The function is flexible in that you can specify the type of object data
you want to export, an advanced filter name for a filter you want to use, and as many or as few field
types as desired that are supported by the type of object. In addition, you can specify a new file name
for each call to WriteAuxFile, or you can specify the same file name and append the data to the file. If
an error occurs while trying to write the auxiliary file, an error message is returned through EString.
WriteAuxFile(fileName, filterName, tObjectType, EString, {tAppend}, {tFieldList})
Parameter Definitions
FileName : String The name of the PowerWorld Auxiliary file you wish to save. No default.
filterName : String The name of an advanced filter which was previously defined in the case
before being loaded in the Simulator Automation Server. If no filter is desired, then simply pass
an empty string. If a filter name is passed but the filter cannot be found in the loaded case, no
filter is used. Default is an empty string.
tObjectType : String A string describing the type of object for which your are requesting data.
No Default.
EString : Variant This parameter must be assigned a variable declared as a Variant. This
parameter is for a return value only, and will assign the passed variable a string representing an
error that may have occurred in the Simulator Automation Server. If no error occurred, the
EString variable will return an empty string.
TAppend : Boolean This parameter is optional. If you have given a file name of an auxiliary file
that already exists, then the file will either be appended to or overwritten according to the
setting of this parameter. If the parameter is not passed, the Simulator Automation Server
assumes false.
TFieldList : Variant This parameter is optional. A variant array of strings, where each string
represents an object field variable, as defined in the section on PowerWorld Object Variables. If
no array is passed, the Simulator Automation Server will use predefined default fields when
exporting the data.
Example
WriteAuxFile("c:\my files\myauxfile.aux", "", "gen", EString, False, [pwBusNum,
pwGenID, pwGenAGCAble])
This function call will send the values of the fields in tFieldList to a PowerWorld Auxiliary file for
all the generators in the load flow case. If a filter name had been passed instead of an empty
string, Simulator would have located and used a pre-defined advanced filter and applied it to the
information if it was found. By specifying the fields in the optional parameter tFieldList, only the
three field values for each generator will be returned. If the optional parameter tFieldList had
been omitted, Simulator would have returned internally defined default information for the
generators. Since the tFieldList optional parameter was included, the tAppend optional parameter
also had to be included, even though it's default value is already False.
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PowerWorld Object Variables (Version 9)
The ability to access power system data for different objects through various Simulator Automation
Server functions is based on variables defined in Simulator that can be referred to as Object Field
Variables. Each object (i.e. bus, generator, etc.) can have numerous fields associated with it. Each of
these fields, in turn, has a variable associated with the field to enable access to the field for the
purpose of acquiring or changing data. For example, the GetParameters function has a parameter
called ParamList, which is intended to store a list of Object Field Variables for a particular type of
object. When the function is called, the Simulator Automation Server will return the values associated
with each particular field variable for the type of object specified. These field variables allow for
complete flexibility by the user in specifying as many or as few fields for a particular object when
acquiring or changing data.
Examples of Field Variables
PWBusGenMW
PWBusNum
Simulator has literally hundreds of parameters spanning numerous types of device and option
specifications. Rather than list all of the field variables and the value they represent in this help file, we
have enabled Simulator to automatically generate a text file containing the field variables and a
description of what value the variable represents. PowerWorld Corporation highly recommends that
you examine this list. To generate this text file, run PowerWorld Simulator and access the Help menu.
Choose the option Export Object Fields… Specify a file name and location for saving the file, and
click Save. Simulator will save out the field variables, the type of variable (string, integer, etc.), and a
description of the value the field variable represents, with key fields for different objects marked with
an asterisk. The field variables will also be split into sections based on the type of object they are valid
for. Note that the same field variable may be available for more than one object, but that the value
represented by the field variable might vary for different objects.
Examples of Field Variables in Listing
PwBusGenMW Real 'Bus Gen MW'
* PwBusNum Integer 'Bus Number' (* denotes key field in text file)
ATC_MaxLimElements Integer 'Max # Limiting Elements'
The last note on the Object Field Variables is that some of the object field variables are reused for
more than one value for an object. For example, a transmission line has "from" and "to" buses
associated with the line. Rather than have separate field variables for values at each terminal bus, the
same field variable is used for both, with a colon followed by a number appended to the variable to
signify which bus the value represents. As an example, consider the field variable for bus per unit
voltage, which is PWBusPUVolt. Since there are two buses per line, the "From" bus voltage would be
represented as PWBusPUVolt:0, and the "To" bus voltage would be represented as PWBusPUVolt:1.
The enumeration of the field variables always starts with 0 for the first instance. You may note that in
the text file of field values that you don't see any field variables with :0 appended to them. Since we
did not want you to have to always append the :0 on all field variables, the default for a field variable
with no appended :# is 0. Thus you would only need to be concerned with appending the :# for field
variables that require a number greater than 0.
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Integrated Topology Processing Overview
The Integrated Topology Processing tool is available only if you have purchased the
Integrated Topology Processing add-on to the base Simulator package. Contact
PowerWorld Corporation for details about ordering Integrated Topology Processing for
Simulator.
Integrated Topology Processing is a Simulator add-on, which allows you to solve EMS-type, fulltopology models in a numerically robust and transparent manner. Planning cases, traditionally used in
the planning environment by tools such as Simulator, correspond to a less-detailed, electrically
equivalent snapshot of the full-topology model.
Integrated Topology Processing extends Simulator applications traditionally used by planners so they
can operate in an operations real-time environment.
Integrated Topology Processing is fully integrated with the functions of the Simulator base package
including power flow, contingency analysis, and sensitivity calculations, as well as with the OPF,
SCOPF, Transient Stability, ATC, and PVQV add-ons.
Simulator's Integrated Topology Processing is different from traditional EMS topology processing,
which requires converting the full-topology model into a consolidated, planning case, to numerically
solve network applications such as power flow and state estimation. Simulator's Integrated Topology
Processing dynamically obtains an equivalent consolidated representation of the full-topology model by
dynamically reassigning the connection pointers of all of the devices. In Simulator, no "case
conversion" takes place. The consolidated representation has the same topology and is electrically
equivalent to the corresponding planning case.
Only the full-topology model is stored in memory. We call this novel implementation "Single-Model"
Integrated Topology Processing.
Simulator's Integrated Topology Processing allows complete unification of power system planning and
operations unification regarding network models and application environment. Typical uses of
Integrated Topology Processing are:





In the real-time production environment through SimAuto automation, yielding implementations of
true real-time applications: real-time power flow, real-time contingency analysis (Security
Assessment - SA), real-time transient stability (Dynamic Security Assessment - DSA), PVQV
(Voltage Stability Assessment - VSA), real-time SCOPF (Security-Constrained Economic Dispatch SCED).
In near real-time operations by allowing simulation of real-time full-topology cases from the EMS.
In the planning environment by allowing extensive study of the real-time system.

Simulator's Integrated Topology Processing consists of two main features:



An algorithm that takes place behind the scenes that is used internally during numeric solutions
such as power flow, ATC, etc.
A tool to convert the real-time model to a traditional planning case that can be consumed by
planning software not able to operate on full-topology models.

We invite you to continue reading the following Integrated Topology Processing topics:
Full-Topology Model
Superbuses
Subnets
Consolidation
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Primary Bus Priority Scheme
Illustration of Consolidation Process
Consolidated Representation
Consolidated Superbus View
Integrated Topology Processing Dialog
Power Flow Using Topology Processing
Ill-Conditioned Jacobian
Contingency Analysis Using Integrated Topology Processing
Incremental Topology Processing
Integrated Topology Processing in Applications
Saving the Planning Case
Planning Cases
Primary Bus Mapping
Breaker-to-Device Contingency Conversion
Device Derived Status
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Integrated Topology Processing: Full-Topology Model
Real-time applications require modeling the power network at a level of detail that includes all the
switching devices such as circuit breakers and disconnects and other very low-impedance branch
devices. For instance, an operator must have information about specific breaker statuses to coordinate
device maintenance procedures.
These detailed models are referred to as “node-breaker” or “full-topology” models. This type of model
cannot be solved directly in conventional planning applications because of the large number of very
low-impedance branches resulting from the switching devices. The power flow would be forced to use
an Ill-Conditioned Jacobian matrix if these low-impedances were directly modeled. In order to solve
the power flow on a full-topology model, Simulator dynamically obtains a Consolidated Representation
of the power network by dynamically moving the device connection pointers.
Simulator models all type of branch objects as transmission line records. To aid in the consolidation,
additional input parameters are necessary to properly identify the type of branch object that is being
modeled and determine whether or not that branch can be eliminated during consolidation. These
fields are accessible from the Topology group in the Available Fields for the Line and Transformer
Display in the Model Explorer. Two relevant input fields needed for Topology Processing are:
Branch Device Type
Type of branch specified as Transformer, Line, SeriesCap, Breaker, Load Break Disconnect,
Disconnect, ZBR (Zero-Impedance Branch), Fuse, and Ground Disconnect.
For brevity in the context of tools that either automatically switch or identify breakers to either
open or close a device, the term breaker is used to indicate any type of device that can be
switched automatically. This includes branch devices of type Breaker and Load Break Disconnect.
Allow Consolidation of Branch
This is a YES or NO field, which tells Simulator to eliminate closed switching devices and other
very low-impedance branches from the network model during consolidation. Only branches that
have a Branch Device Type equal to Breaker, Load Break Disconnect, Disconnect, ZBR, Fuse,
or Ground Disconnect can be consolidated. If an element is of this type and is set not to be
consolidated, it will be preserved in the model and its default impedance value will be used in the
power flow equations. In the context of consolidation, the term breakeror switching device can
be used to include any of the device types that can be consolidated.
There are other instances in which a branch that is marked as allowed to be consolidated will not
be consolidated:









Branches that are area tie lines
Branches that are connected to a multi-terminal dc line converter
Branches that are part of a Model Condition
Branches that are part of a Model Expression
Branches that are part of a Post Power Flow Solution action
Branches that are part of Transient Stability event
Branches that are part of a contingency action if not using Incremental Topology Processing
Branches that are part of an interface unless the branch is in series with a device that
cannot be consolidated, e.g. transformer, line, load, generator, etc. The interface will be
automatically modified to monitor the series device instead of the branch so that the branch
can be consolidated.
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Simulator models all of the system connection points: Busbars, Junctions, Terminals, etc. as buses.
Topology Bus Type
Type of connection point. Valid entries include BusbarSection, Junction, Internal_3WND, Ground.
Topology Processing provides an optional input field for buses to aid in the consolidation:
Node Priority
Priority level of the bus to become a primary bus. This overrides the default Primary Bus Priority
Scheme level for this bus.
Topology Processing determines two bus fields as part of the consolidation:
Primary Node
Bus to which all the device connection pointers in a Superbus will point to during Consolidation.
Node Neighbor List
If this is a Primary Bus, this contains a list of all buses that belong to the superbus in which this
bus is contained. This entry is blank for buses that are not primary buses.
These four bus fields are available under the Topology group in the Available Fields for the Bus Display
found on the Model Explorer.
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Integrated Topology Processing: Superbuses
A SuperBus in the Full-Topology Model is a group of buses connected through CLOSED switching
devices or other CLOSED very low-impedance branch devices. All the buses in a Superbus have the
same voltage phasor, i.e., they correspond to the same electric point. As the status of switching
devices change, superbuses change correspondingly, sometimes resulting in superbus merging or
splitting.
Superbuses are set automatically when the case is read from the binary or aux file and they are
updated at the beginning of a power flow solution or sensitivity calculation to capture possible changes
in the status of switching devices. The details of the Superbus records is available in the Model
Explorer under Solution Details > Superbuses.
A superbus in the Full-Topology Model would correspond to a bus in the electrically equivalent
bus/branch planning case.
Each Superbus in a system belongs to only one Subnet.
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Integrated Topology Processing: Subnets
A Subnet is a group of buses connected through switching devices or other very low-impedance
branches devices regardless of their open or closed status. Subnets are bounded by transmission line
and transformer terminals. Subnets on a system hence do not depend on the status of breakers, but
only on the presence of devices. Subnets do not change unless equipment is added or removed from
the physical model.
A Subnet can contain one or more Superbuses.
A Superbus belongs to only one subnet.
Subnets and Superbuses are set automatically when the case is read from the binary or aux file.
The list of subnets and the details of subnet records can be seen on the Model Explorer under
Solution Details > Subnets.
The example below shows a subnet that has four nodes. The shown breakers statuses results in two
superbuses. If either breaker is closed, the two superbuses will merge.
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Integrated Topology Processing: Consolidation
Consolidation consists in moving the connection pointers of all the devices within a Superbus to a
specially selected bus called the Primary Bus, and hiding not needed switching devices and buses. The
Primary Bus is selected based on a default Primary Bus Priority Scheme.
Prior to consolidation, all the power system devices in a superbus, such as generators, loads, shunts
and transmission line terminals are connected to their actual terminal buses in the physical system.
After consolidation all the devices are connected to their corresponding Primary Bus. This makes the
status and actually, the presence of switching devices in a superbus irrelevant, allowing the application
to disregard them during the numerical solutions. A list of the branch device types that are allowed to
be consolidated and exceptions to when these branch device types are not consolidated can be found
in the Full-Topology Model topic. We say that the full-topology model is in a consolidated state and we
call the representation of the system after consolidation, the Consolidated Representation.
After consolidation, the topology of the full-topology model is identical to that of an equivalent
planning case and the models are electrically identical. However, in Simulator no case conversion takes
place. Only the full-topology model exists in memory.
The following link contains an example illustrating the consolidation process: Illustration of Process.
The user is never allowed to interact with the model while it is in a consolidated state.
The user does not have access to the Consolidated Representation unless it is saved as a planning
case as described in the section Saving the Planning Case.
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Integrated Topology Processing Consolidation: Primary Bus Priority Scheme
During Consolidation, the devices connected to the buses of a superbus change their connection
pointers to point to the Primary Bus. In this manner, all the devices appear to be connected to primary
buses only.
By default, the selection of the primary bus takes place using the following priority scheme, in
descending order of priority:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.

Slack bus (highest priority)
Multi-Terminal DC Line Terminals
Generator Regulated Bus
Switched Shunt Regulated Bus
LTC Regulated Bus
DC Line Terminal
Generator Terminal
Switched Shunt Terminal
Load Terminal
Branch with Device Type = Series Capacitor
Branch with Device Type = Transformer
Branch with Device Type = Line
Branch with Device Type = ZBR
Branch with Device Type = Breaker
Branch with Device Type = Load Break Disconnect
Branch with Device Type = Disconnect
Branch with Device Type = Fuse
Branch with Device Type = Ground Disconnect

In case of ties, the minimum bus number is selected as the primary bus.
There is also an optional integer field available with each bus called Topology\Node Priority. When
this is specified for a bus, the bus with the highest Node Priority is chosen as the primary node. By
default this Node Priority is 0 for all buses, and thus the priority defaults to the scheme specified
above.
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Integrated Topology Processing Consolidation: Illustration of Process
Consider the following 11-bus, full-topology model. Given the breaker statuses, this system would
contain 4 superbuses shown in the next figure.

We apply consolidation to the system above considering that the primary buses of each superbus are
buses 1, 4, 7 and 10. The system topology at this point (which is never seen by the user) would looks
as follows.

At this consolidated state, the breakers and the non primary bus buses could be removed without
affecting the power flow solution.

1494
©2011 PowerWorld Corporation

Integrated Topology Processing: Consolidated Representation
A consolidated representation of a full-topology model is one obtained when the system is in a
consolidated state. In this state all the connection pointers of devices and device terminals have been
moved to the primary buses of the Superbuses as part of the Consolidation process.
The user does not have access to the Consolidated Representation records unless it is saved as a
planning case as described in the section Saving the Planning Case. However, the Consolidated
Representation can be navigated using the Consolidated Superbus View.
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Integrated Topology Processing: Consolidated Superbus View
Simulator’s Bus View provides a feature that allows a Full-Topology Model to be navigated using the
Consolidated Representation, in which only the primary buses are shown. This gives the appearance to
the user of navigating the electrically equivalent planning case.
The Consolidated Superbus View is accessed from the Bus View Display. If the current case is set up
such that superbuses can be identified, there will be a drop-down box at the top of the Bus View
Display that will allow switching between the Full Topology representation and the Consolidated
Superbus representation.
The Consolidated Superbus View has the following conventions:





Shows radial-connected generator, load, and switched shunt buses above the main (primary) bus
For series connections of buses, the main branch shown will be the first branch that is marked as
NOT available for consolidation (i.e. AllowConsolidation = NO)
All generator, load, and switched shunt devices will appear connected to their Primary Bus instead
of the actual bus
Only branches that connect different superbuses will be shown. This means that closed circuit
breaker will not appear on the consolidated superbus view because they connect two buses that
are in the same superbus.

An example full-topology model is shown below. Each gray region represents a superbus. The large
buses and numbers in each superbus represent the primary bus for that superbus.

The associated full-topology bus view and the consolidated superbus view for the above model is
shown below:
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Integrated Topology Processing Dialog
To open the Topology Processing Dialog select Topology Processing found on the Add Ons ribbon
tab in the Topology Processing ribbon group. This dialog includes options to solve the Power Flow
Using Topology Processing, perform Contingency Analysis Using Topology Processing, and for Saving
the Consolidated Case.

Power Flow Solution Options
Use Consolidation (This is a Full-Topology Model)
This option is used for all Simulator applications: power flow, contingency analysis, sensitivity
calculations, etc. This option should ALWAYS be checked for real-time cases, while it should be
unchecked for planning cases. If a full-topology model was read and this option is not checked,
the power flow will try to solve the model without removing the switching devices resulting in a
very large ill-conditioned Jacobian. This option is also found on the Power Flow Solution Common
Options page of the Simulator Options dialog.
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Contingency Analysis
These options are shown on this dialog for informational purposes only. These can be accessed and
set from the Contingency Analysis dialog on the Options tab and Modeling sub-tab. These options
are described in more detail in the Contingency Analysis Using Topology Processing topic.
Consolidated Case Save Options
These options allow the saving of the consolidated representation as a traditional planning case.
More detail about these options is provided in the Saving the Planning Case topic.
Options found on the Primary Bus Mapping tab are described in the Primary Bus Mapping topic.
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Integrated Topology Processing: Power Flow Using Topology Processing
In order to perform numerical solutions using Integrated Topology Processing, Simulator does the
following:
Consolidates the system relocating the devices and removing not needed breakers and non primary
buses.
Performs the numerical calculation.
De-consolidates the system by restoring breakers and relocating the devices to their original buses.
This step also maps the values of the primary buses to all the buses in the superbus.
This is transparent to the user, who only needs to tell Simulator to use consolidation. The option that
needs to be set to use consolidation is found on the Topology Processing Dialog and also on the Power
Flow Solution page of the Simulator Options dialog.
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Integrated Topology Processing: Ill-Conditioned Jacobian
Matrix A in the linear equation Ax = b is ill-conditioned if small changes in the entries of the vector b
radically change the solution vector x. Ill-conditioned matrices are particularly troublesome in iterative
solvers such as AC power flow algorithm implementations. One iteration of the AC power flow solves
the linear equations J Δx = Δy where J is the Jacobian matrix, Δx is the vector of voltage magnitude
and angle differences and Δy is the vector of real and reactive power mismatches.
A power flow Jacobian can become ill-conditioned if the system branches present reactances that
differ in orders of magnitude, such as very short lines or zero impedance branches. Because the
reactance of switching devices is negligible compared to that of transmission lines and transformers,
modeling but a short number of switching devices in the Jacobian is prohibitive. The lower the value of
the reactance, the more ill-conditioned the Jacobian will become. On the other hand, if the assumed
reactance value is not too low, the solution would be inaccurate resulting in larger bus voltage angles.
In Simulator switching devices that are present in Full-Topology Models are handled by Integrated
Topology Processing, producing an exact and robust numerical solution.
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Integrated Topology Processing: Contingency Analysis Using Topology Processing
Simulator Integrated Topology Processing allows solving contingencies in the Full-Topology Model.
EMS systems model contingencies through a list of real system actions. For instance, opening a line
involves opening the set of breakers that electrically isolate the device. The same contingency action in
a planning environment would be modeled as a single contingency action: OPEN LINE. Simulator
provides a special contingency action called Open with Breakers which enables this type of modeling.
There is also a Close with Breakers contingency action that enables modeling breakers to energize a
device instead of using a planning-type contingency action to change the status of the device itself.
There is an option to determine whether to monitor all buses or only the primary node in each
superbus during contingency analysis, When using Integrated Topology Processing, monitor
only the primary bus for each superbus. This is found on the Contingency Analysis dialog on the
Options tab on the Limit Monitoring page.
The option to determine how contingencies should be modeled within topology processing is found on
the Contingency Analysis dialog on the Options tab and Modeling\Basics page in the Topology
Processing Mode grouping.

Preserve All Breakers Included in Contingencies
If this option is selected, contingency analysis will not treat contingency breakers as zero impedance
branches and will keep all of them in the model. Hence, the consolidated representation is obtained
only once upfront before the first contingency, and this representation is used to solve all the
contingencies. Using this option, the consolidated representation is smaller than the full model, but
is not the smallest possible. If the number of contingencies and breaker actions is large, many
breakers will be preserved in the case. If the percentage of preserved breakers is significant, this
may result in an Ill-Conditioned Jacobian during the contingency solution.
Use Incremental Topology Processing Mode
In this option, contingency analysis uses an Incremental Topology Processing approach to solve
each contingency. Since usually the number of contingency actions in a contingency is small (usually
around 4 to 10), only a small number of Subnets are affected by a contingency. The topology of all
the other subnets remains unchanged. When this option is used, Simulator does a full consolidation
before the first contingency and then for each contingency, the topology of just the affected subnets
is re-processed (determining superbuses and primary buses, and updating the connection pointers).
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Incremental Topology Processing provides a more robust solution and should be used whenever
possible.
Incremental Topology Processing cannot be used for applications that use linearization and that
require a constant size of the bus array, such as sensitivity analysis. For instance, ATC will
automatically use the contingency analysis Preserve Breakers Included in Contingencies
option.
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Contingency Element: Open Breakers
The contingency action type Open Breakers is available for each contingency element type for which
the Open action type is available. This includes the following element types: Branch, Bus, Load,
Generator, Switched Shunt, DC Line, Injection Group, and Interface. This action type is only available
for contingency records and is not available for contingency block definitions or for global contingency
actions.
In order to handle the Open Breakers contingency elements, before one contingency's solution is
performed, the list of contingency elements for that contingency is processed by looking for elements
which use Open Breakers. For elements with this action type, all the terminal buses of the respective
device are processed using the algorithm below to determine which breakers to open to isolate the
device (and possible which generators to outage). The basic idea of the algorithm is to search for a list
of breakers that will isolate all the terminal buses of the device from in-service generation. The
algorithm will also return a list of online generators which must be opened to isolate the bus as well.
Remember that a breaker is specified by setting the Branch Device Type to Breaker.
Using the list of breakers and generators found from the algorithm, contingency analysis augments the
contingency element list with a dynamically created list of contingency elements of action type Open
for each breaker and generator device. The dynamically created elements are given the same Model
Criteria and Status as the contingency element which required their creation. Note that if multiple
Open Breakers contingency elements require the same breaker to open, then one new contingency
element will be created. When Open Breakers contingency elements have different Model Criteria,
then a new contingency element will be created for each unique Model Criteria. During the actual
contingency solution, the What Actually Occurred? list will be updated and can be examined in the
results to determine what breakers were needed to isolate the device. Finally, after the contingency
solution is completed, all the dynamically created contingency elements are deleted, and as a result
the user can only see which breakers or generators were opened by looking at the What Actually
Occurred list.
For brevity in the context of tools that either automatically switch or identify breakers to close a
device, the term breaker is used to indicate any type of device that can be switched automatically.
This includes Branch Device Types Breaker and Load Break Disconnect. If the model has no
branches defined with either of these Branch Device Types, this option will not work because the
algorithm will never find any breakers. See the Full Topology Model topic for more information on
defining breakers.
Algorithm description for Open with Breakers
This algorithm is applied to each terminal bus of the device specified. For generators, loads, shunt,
and buses this is done on a single bus only. For an Injection Group however, each generator, load,
and shunt in the injection group will be processed in turn. Starting at each terminal bus of the device
and marching outwards, the algorithm traverses closed branches (except for breakers), dc lines, and
multi-terminal DC lines and will flag any closed breakers at buses which are visited. The buses that
are visited are also flagged. (Note: the algorithm will NOT traverse across the breakers with for an
exception noted below). When buses are visited that have online generators, a list of generators is
maintained that must be opened as well. In order to prevent the degenerate case where breakers do
not fully isolate any portion of the network, only 10 buses with online generation are permitted for
visitation. If more than 10 buses are encountered with online generation, then the algorithm will
immediately abort and a log message is written saying that the device "cannot be isolated from
online generation".
If this part of the algorithm completes it will have obtained a list of flagged breakers and a list of
visited buses (as well as a list of generators to open). The list of flagged breakers is then examined
to ensure that each breaker actually isolates the original device. Each flagged breaker will be
examined and if a flagged breaker has a terminal bus that is NOT in the list of visited buses, then
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this breaker disconnects the device from another part of the system and will be maintained.
Breakers for which both terminal buses have been visited will be discarded because these breakers
do not actually isolate anything. If at least one flagged breaker is maintained then the process is
deemed successful and the contingency will outage the list of maintained flagged breakers. If all the
flagged breakers are discarded, then the breakers do not isolate anything, and therefore a log
message is written saying that "no part of the system can be isolated," and nothing is done.
A few special notes:
1.

2.
3.

4.

If there is another contingency action inside this same contingency that specifies an action
type of Open or OpenCBs for a generator device, encountering that generator won't count
toward the list of generators to open or the maximum of 10 buses to encounter with online
generation. The same is done for any generator connected to a bus or inside an injection
group, if the bus or injection group has a contingency action of type Open or OpenCBs.
If there is a contingency action inside this same contingency that specifies a breaker with
action type Open Breakers, the algorithm will traverse across this breaker (this models a
breaker failure where a breaker is supposed to open but fails to operate.)
If there is a contingency action inside this same contingency which specifies an action type
of Open for a branch or DC line device, the algorithm will NOT traverse across that branch
or DC line. The same is done for any branch which is part of a three-winding transformer,
interface, or connected to a bus if the three-winding transformer, interface, or bus has a
contingency action of type Open.
While a list of generators to open is maintained, if no online load is encountered while
traversing buses in the algorithm, then the generator OPEN contingency actions will not be
created. This is because the breakers will create an isolated island with no load and thus
opening the generation is not necessary.
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Integrated Topology Processing: Incremental Topology Processing
Incremental Topology Processing is a technique used to update the Consolidated Representation of the
system in a very fast manner. It is particularly useful during Contingency Analysis, where it does the
following:
Consolidate entire case
For each contingency do
Apply switching device actions and identify subnets with changed topology
Expand affected subnets to full-topology detail
Reconsolidate affected subnets with post-contingency topology
Solve post-contingency power flow
Determine and store limit violations
Reset affected subnets to pre-contingency topology
Restore pre-contingency power system state
End
Deconsolidate entire case
Incremental Topology Processing is very fast, taking on the order of a few milliseconds.
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Integrated Topology Processing: Topology Processing in Applications
Simulator applications such as ATC and OPF use a hierarchical scheme where Consolidation takes
place only at the beginning of the numerical solution process. Consolidation in lower functions takes
place only if it has not taken place already in higher-level functions.

Following completion of the application, de-consolidation occurs in the function level in which the
consolidation originally occurred. This process is very similar to the one described for solving the
power flow using integrated topology processing. There can be some exceptions to this when using
Contingency Analysis. The Contingency Analysis Using Integrated Topology Processing topic provides
more details on this.
Once the input data is set in the Full-Topology Model fields, the applications work in the same manner
as with regular Planning Cases.
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Integrated Topology Processing: Saving the Planning Case
Integrated Topology Processing allows you to save the Consolidated Representation of the FullTopology Model as a traditional Planning Case (bus/branch model), in any of the formats supported by
Simulator.
Although the saved case can be reopened in Simulator as a regular case, the user should note that the
topology of this case will depend on the statuses of the breakers in the Full-Topology Model. If the
statuses of the switching devices in the Full-Topology Model are continuously changing as is the case
when the case comes from a real-time Retriever implementation, then the topology of the saved cases
will be slightly different minute to minute.
The saving tool is available on the Topology Processing Dialog in the Consolidated Case Save Options
section.

Save Consolidated Case Now
Click this button to save the case in any of the supported formats.
Open Non-Energized Branches
If the terminal buses of a transmission line or transformer are not energized, then assume the
element is open.
Convert Shunts to Blocks
Some systems have several shunts in a superbus, and some formats support only one shunt per
bus. This option allows modeling those shunts as an aggregate device.
Do not save contingencies (will make smallest case size)
Use this option if contingency analysis will not take place on the saved case.
Save contingencies (must preserve all elements including breakers)
All the contingencies, the contingency actions, and all the switching devices included in contingency
actions will be preserved and saved in the consolidated case. It makes a big difference to perform a
Breaker-to-Device Contingency Conversion before saving the case. Usually most of the breaker
contingencies can be converted to device contingencies requiring just a small number of breakers to
be preserved in the case. Some planning tools have limitations regarding the number of low
impedance branches that can be modeled and will not be able to read and solve the Planning Case if
it contains a large number of switching devices.
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Integrated Topology Processing: Planning Cases
Planning Cases are a high-level, simplified view of the actual network, in which all the switching
devices have been removed. Planning Cases use a bus/branch model that uses the bus numbers as
key fields for all the system elements. Full-Topology Models on the other hand, are detailed
representations of the physical system that include circuit breakers and disconnects. Simulator
Topology Processing allows complete model unification and provides a unified application environment
to simulate both types of models.
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Integrated Topology Processing: Saving the Planning Case
Integrated Topology Processing allows you to save the Consolidated Representation of the FullTopology Model as a traditional Planning Case (bus/branch model), in any of the formats supported by
Simulator.
Although the saved case can be reopened in Simulator as a regular case, the user should note that the
topology of this case will depend on the statuses of the breakers in the Full-Topology Model. If the
statuses of the switching devices in the Full-Topology Model are continuously changing as is the case
when the case comes from a real-time Retriever implementation, then the topology of the saved cases
will be slightly different minute to minute.
The saving tool is available on the Topology Processing Dialog in the Consolidated Case Save Options
section.

Save Consolidated Case Now
Click this button to save the case in any of the supported formats.
Open Non-Energized Branches
If the terminal buses of a transmission line or transformer are not energized, then assume the
element is open.
Convert Shunts to Blocks
Some systems have several shunts in a superbus, and some formats support only one shunt per
bus. This option allows modeling those shunts as an aggregate device.
Do not save contingencies (will make smallest case size)
Use this option if contingency analysis will not take place on the saved case.
Save contingencies (must preserve all elements including breakers)
All the contingencies, the contingency actions, and all the switching devices included in contingency
actions will be preserved and saved in the consolidated case. It makes a big difference to perform a
Breaker-to-Device Contingency Conversion before saving the case. Usually most of the breaker
contingencies can be converted to device contingencies requiring just a small number of breakers to
be preserved in the case. Some planning tools have limitations regarding the number of low
impedance branches that can be modeled and will not be able to read and solve the Planning Case if
it contains a large number of switching devices.
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Integrated Topology Processing: Primary Bus Mapping
Sometimes, it is necessary to explore or export the topology relations between superbuses and buses
in the Full-Topology Model and its Consolidated Representation. Because different sets of switching
devices can be preserved by Simulator when solving the Power Flow Using Topology Processing, when
solving the Contingency Analysis Using Topology Processing, and when Saving the Planning Case,
there will be different mappings for each one of these actions.
Primay Bus Mapping options are available on the Primary Bus Mapping tab of the Topology
Processing Dialog.

This display shows a detailed mapping of superbuses to buses. By changing the selection for which
mapping to view, the corresponding mapping that would take place is shown in this case information
display.
Power Flow Solution
Provides the mapping used when solving the power flow.
Contingency Analysis
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Provides the mapping used when solving contingencies.
Saved Consolidated Case
Provides the corresponding topology relations between the full-topology model and the consolidated
case to be saved.
This mapping can be saved as an auxiliary file from the local menu of the display (right-click and
choose Save As > Auxiliary File...) or from the case information toolbar.
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Integrated Topology Processing: Breaker-to-Device Contingency Conversion
While operation contingencies are defined using breaker actions, planning cases use simplified device
contingency actions. For instance, the outage of a single transmission line is modeled in EMS systems
as the set of the actual circuit breaker actions that physically de-energize the transmission line. On the
planning side, the same contingency is modeled as a single contingency action related to the
transmission device: OPEN LINE.
A feature of PowerWorld’s Integrated Topology Processing is the ability to convert operations-type,
circuit breaker contingencies to their electrically equivalent device contingencies for single outage,
multiple outages, or complex post-contingency topologies. While both the breaker contingencies and
the device contingencies can be solved on the Full-Topology Model, breaker contingencies MUST be
converted to device contingencies in order to solve them on the consolidated Planning Case.
Some complex breaker contingencies cannot be converted to electrically equivalent topologies by
simply changing the energization status of devices. A subset of the breakers involved in those
contingencies may need to be preserved in the case to entirely reproduce the electric topology.
The Breaker-to-Device Contingency Conversion is launched from the Contingency Analysis Dialog >
Other button > Convert to Device Contingencies. This routine will convert all the contingencies in
the list. The contingency analysis status box will indicate the progress of the contingency conversion
process. The log will also provide messages during the conversion.

The new list of converted device contingencies will replace the original list of breaker contingencies
previously displayed on the Contingency Analysis Dialog. The list of device contingencies can be solved
directly on the Full-Topology Model. On average, device contingencies include less device actions per
contingency compared to breaker actions. For instance, a single line outage usually requires opening
several circuit breakers, whereas the device contingency equivalent requires a single OPEN LINE
contingency action.
In order to reflect the conversion process, the actions in the Contingency Definitions include device
actions with the name of the device: Line, Transformer, Load, Gen, etc. and also Breaker if breakers
need to be preserved for a given contingency.
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Device Derived Status
Differences exist between planning models and full-topology EMS models when it comes to
determining if a device is energized and what the status is of the device.
With planning software and bus-branch models, two distinct fields exist: Status and Energized. The
Status field is an explicit field that exists to determine if a device is open or closed. This is needed
because breakers are not modeled. The Energized field indicates if the device is actually energized
which will be affected by the status of branches.
With full-topology EMS models, breaker or disconnect status determines the status of other devices,
i.e. whether or not they are energized. No explicit status field exists for other devices like generators,
loads, lines, transformers, etc. Typically when using a full-topology model in Simulator, the Status of
non-switching devices (generators, loads, lines, etc.) will be set to Closed. A hybrid model with only
parts of the system modeled with breaker detail can still use the Status field for non-switching
devices.
The actual status of a device can be confusing, especially for those accustomed to a planning model.
To eliminate confusion, the Derived Status field will be used to indicate the status with which
planning model users are accustomed.
Derived Status is determined by the following:




Energized = YES --> Derived Status = Closed
Status = Open --> Device Status = Open
Energized = NO and Status = Closed --> Ambiguous
 Search starting at the device terminals across branches with Status = Closed looking for
closed breakers
 If closed breaker is found --> Derived Status = Closed
 If no closed breakers are found --> Derived Status = Open

The following example illustrates how the Derived Status field is set for various devices based on
their Energized and Status fields. In this example the yellow highlighted region represents the
energize portion of the system. In the region that is shown, all devices are energized and all breakers
are closed.
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In the next example some breakers have been opened to open the lower line in the diagram. Again,
the yellow highlighted region is the portion of the system that is energized. The Status of the line is
still Closed, but it is no longer Energized. This is the ambiguous situation described above. The
Derived Status is Open because searching out from the terminals of the line only open breakers are
found before encountering any closed breakers.
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In this last example, additional breakers have been opened, enlarging the region that is not energized.
The upper line in the diagram has a Status of Closed and is not Energized due to the status of the
open breakers. This again is the ambiguous situation described above. The Derived Status is Closed
because closed breakers can be found by searching out from the terminals of the line before
encountering any open breakers.
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Transient Stability Overview
The Transient Stability tool is available as an add-on to the base Simulator package.
Contact PowerWorld Corporation for more details.
Transient stability studies analyze the system response to disturbances such as the loss of generation,
line-switching operations, faults, and sudden load changes in the first several seconds following the
disturbance. Following a disturbance, synchronous machine frequencies undergo transient deviations
from synchronous frequency. The objective of a transient stability study is to determine whether or not
machines will return to synchronous frequency following a disturbance.
For more detail on the transient stability modeling see the following links







Generator Modeling
Wind Machine Modeling
DC Transmission Line Modeling
Load Characteristic and Relay Modeling
Transient Stability Numerical Integration
PlayIn Modeling

For more detail on how to use the Transient Stability tool see the following links




Transient Stability: Model Data Management
 Stability tab of the Generator, Load, DC Line, etc... Dialogs
 Transient Stability Case Information Drop-Down
 Transient Stability Folder in the Model Explorer
 Transient Stability Block Diagrams
 Reading/Writing Transient Stability Data to various File Formats
Transient Stability Analysis dialog
 Simulation
 Options
 Results Storage
 Plots
 Results
 Transient Limit Monitors
 States/Manual Control
 Validation
 SMIB Eigenvalues

1518
©2011 PowerWorld Corporation

Transient Stability Overview: Generator Models
Generator models are the most complex models in a transient stability tool. Generators can have
many classes of dynamic model assigned to them including machine models, exciters, governors,
stabilizers, and other models. You may define multiple models of each class of model to a generator,
but for machine models, exciters, governors, and stabilizers, there can be only one active model.
The relationship between these four models is shown in the figure below, along with the variables
which are passed between the models. This is not an exhaustive list, but represents the typical
relationships between the models.
Other stability models such as excitation limiters, Voltage Compensation, the turbine load controller
(LCFB1) or a generator relay model may also be specified.
For wind generator models, similar relationships exist between a wind machine model, electrical
model, mechanical model, and a pseudo-governor model. For more information about wind turbine
modeling in Simulator, see the Wind Turbine Modeling help topic.
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Governor Response Limits
There is a special generator field in Simulator called Transient Stability\Governor Response Limits.
The field determines the response of the governor control limits during a transient stability run.
Options are Normal, Down Only, or Fixed. When loading from an EPC file a Baseload flag value of 0
maps Normal, 1 maps to Down Only, and 2 or more maps to Fixed.
A value of Normal means that the limits specified in the governor model will be used for the
simulation. A value of Down Only means that the upper limit is set equal to the initial condition value
(and thus control can only go down). A value of Fixed means that both the upper and lower limits
are set equal to the initial condition (and thus control will be approximately constant). Note that the
power output of the generator can still vary for those turbines whose MW output is sensitive to
speed (because the speed can obviously still vary).
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Also, this field will always be shown as a default field when looking at a case information display
showing a list of governors.
Special Accommodation for handling Line Drop Compensation
In modeling the WECC system, a stability issue was encountered at several hydro units such as John
Day. The issue, which is described in the papers listed below, arises because of how the exciters for
some hydro units with dual generators have been configured to enhance system voltage stability.
Rather than regulating their terminal voltage, or a point internal to the generator (using
compensation), the generator exciters have been configured using line drop compensation to
regulate a point midway through the step-up transformer. This is illustrated in the below figure,
which reproduces Figure 3 from the Murdoch/Sanchez-Gasca paper below. The advantage of this
approach is it allows the generator exciters to directly regulate a point close to the transmission
system (perhaps 50 to 80% of the way through the step-up transformer). If there is just one
generator feeding through the transformer then this control can be modeled in the normal fashion.
However when there are two generators, an extremely common configuration at hydro plants,
physically the exciter inputs at each plant need to receive the currents from both machines in order
to insure they are both regulating the same line drop compensated voltage. If this is not done, then
the controls will end up fighting each other, driving the excitation current for one generator to its
maximum and for the other generator to its minimum. Therefore to correctly model this situation,
the PowerWorld Simulator transient stability excitation modeling code has been enhanced to include
both generator currents in situations in which line drop compensation causes the regulated voltage
to be beyond the generator’s terminal. Otherwise the traditional code is used.

NOTE:
When modeling a GENCLS model with H=0 and D=0 it is treated as an infinite bus.
A. Murdoch, J.J. Sanchez-Gasca, “Excitation Control for High Side Voltage Regulation,” Proc. IEEE
PES 2000 Summer Meeting, July 2000, pp. 285-289.
C.W. Taylor, “Line drop compensation, high side voltage control, secondary voltage control – why
not control a generator like a static var compensator,” Proc. IEEE PES 2000 Summer Meeting, July
2000, pp. 307-310
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Transient Stability Overview: Wind Modeling
While strictly speaking, wind turbine models do not have an "exciter", "governor", or "stabilizer" in the
way that a traditional synchronous generator model does, the relationships between the wind machine
model, electrical model, mechanical model, and a pseudo-governor model are very similiar. As a result,
when looking at generators in the Simulator user interface, the various wind models will be listed
under the traditional categories for synchronous machines of "machine model", "exciter", "governor",
or "stabilizer". Examples are shown below.
Wind Machine Models

GENWRI, GENWTG, WT1G, WT1G1, WT2G1, WT3G,
WT3G1, WT3GW, WT4G1

Wind Electrical Models

EXWTG1, EXWTGE, WT2E1, WT3E, WT3E1, WT4E1

listed as Exciters
Wind Mechanical Models

WNDTGE, WNDTRB, WT12T1, WT1T, WT3T, WT3T1

listed as Governors
Wind Pitch Control or Aerodynamic Models

WT12A1, WT1P, WT3P, WT3P1

listed as Stabilizers
It will obviously not make any sense to configure a generator to use a wind machine model with a
traditional synchronous machine exciter model and governor, so care should be taken not to setup
such configurations. Presently Simulator does not check for such gross input errors.
A wind farm usually consists of many small (several MW) turbines. Each individual turbine’s voltage is
usually less than 1 kV (600 V is common) with a step-up transformer to increase the voltage to several
dozen kV (34.5 kV common). The wind farm is usually modeled in aggregate requiring the aggregate
model to account for impedance of collector system and then model per unit values at N times
individual values. How accurate the aggregation is remains an open question.
There are four major types of wind turbine models used in transient stability studies which will each be
considered in detail shortly.





Type
Type
Type
Type

1
2
3
4

:
:
:
:

Induction generators with fixed rotor resistance
Induction generators with variable rotor resistance
Doubly-fed induction generators
Full converter generators

Type 1: Induction generators with fixed rotor resistance
The most basic representation of a Type 1 wind turbine is as a conventional induction machine,
however inertia is modeled with the machine. More detailed representations also include using a
two-mass model (one mass for the generator and one for the turbine), and a pseudo governor.
Inertia is sometimes modeled with the machine and sometimes as a governor in Simulator. A
pseudo-governor is modeled as either a governor or a stabilizer in Simulator (depending on how
inertia is modeled).
The MOTOR1 and GENIND models from the GE DYD file are the same, except for a sign convention
on the current. They have integrated inertia. They cannot be used with other Type 1
governor/stabilizer models so no turbine dynamics are included. The CIMTR1, CIMTR2, CIMTR3, and
CIMTR4 models from the PTI DYR file have the same restrictions as with the MOTOR1 and GENIND
models .
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The WT1G model is the GE DYD representation for a Type 1 wind turbine, while the WT1G1 is the
PTI DYR model. Electrically they are quite similar to the GENIND model, except they do not include
any inertia. Therefore they must be modeled with a WT1T (GE) or WT12T1 (PTI) model, both of
which are included in the list of governors. The WT1T/WT12T1 models can represent the
generator/turbine using either a one mass or two mass model. Both of these governors can also be
used with Type 2 Wind Turbines.
The WT1P (GE) and WT12A1 (PTI) models represent a pseudo governor response model. These
models are listed inside Simulator as a stabilizer models. The inputs to these models are machine
speed and electrical output, while the output of the model is mechanical power. Again, these models
can be used for both Type 1 and Type 2 wind turbines. It is recommended that you use the
[machine / governor / stabilizer] grouping of [WT1G / WT1T / WT1P] or [WT1G1 / WT12T1 /
WT12A1] to represent Type 1 wind machines.
Type 2 : Induction generators with variable rotor resistance
The Type 2 models augment the Type 1 by allowing for variable rotor resistance control in the
wound rotor induction generator. This model is used to represent wind turbines such as the Vestas
V80. Resistance control is represented by a PowerWorld Simulator using a model from the "exciter"
list. Inertia is included with some machine models, or is included with a pseudo governor model.
PowerWorld supports two classes of Type 2 models. From the GE DYD file we support the
combination of the GENWRI machine, EXWTG1 exciter, and WNDTRB governor. From the PTI DYR
file we support the combination of the WT2G1 machine, WT2E1 exciter, WT12T1 governor, and
WT12A1 stabilizer.
Modeling Using GENWRI, EXWTG1, and WNTRB models
The GENWRI models represents a single cage induction generator, and also includes a single
mass inertia model with the machine. The initial operating slip must be given. From this,
PowerWorld then calculates the necessary resistance to match this slip. The EXWTG1 exciter
specifies the minimum and maximum external rotor resistance. The WNDTRB models the blade
pitch control with an input of rotor speed and an output of Pmech. The resistance is set initially
to match default slip of -0.04. During the fault the resistance increases to compensate for the
increased speed.
Modeling Using WT2G1, WT2E1, WT12T1, and WT12A1 models
The W2G1 model is the PTI representation for a Type 2 wind turbine which should be similar to
the GE models. These are all based on new standards which are being developed for wind
turbine modeling. Electrically it is quite similar to the GENWRI model, except they do not include
any inertia. Therefore they must be modeled with a WT1T (GE) or WT12T1 (PTI) model, both of
which are included in Simulator as governor models. They also can use the WT1P or WT12A1
pseudo governors (which are included in Simulator as stabilizer models). The initial operating
point is given by the R_Rot_Max field, which specifies the total rotor resistance. The external
rotor resistance is controlled using the WT2E1 model, which is modeled in Simulator as an
exciter.
The WT2E1 model controls the external resistance between values given by Rotrv_min and
Rotrv_max. The inputs to WT2E1 are rotor speed and electrical power. Rotor speed is converted
to an equivalent power using a piecewise linear slip-power curve that is entered with the WT2G1
model. The curve is assumed to have odd symmetry (f(-x) = -f(x)). An offset is added to model
to get it to initialize to zero.
Type 3 : Doubly-fed induction generators
Modeling using the WT3G ,WT3E, WT3T and WT3P models
The GE DYD file supports a combination of models of a WT3G machine model, WT3E exciter,
WT3T governor, and WT3P stabilizer to model a Type 3 wind generator. The WT3G model
represents the generator behavior of the Type 3 and is the interface with network equations. The
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WT3E model represents the reactive power control. The inputs to WT3E are the generator real
and reactive power, and the voltages at the terminal and regulated bus, while the outputs are
Eqcmd and Ipcmd. The WT3T model represents the mechanical equations. The WT3T inputs are
the blade pitch and electrical power, while output is the rotor/turbine speeds. The WT3P model
represents the pitch control. The WT3P input is the generator speed/power, while the output is
pitch angle.
Modeling using the WT3G1, W3G2 ,WT3E1, WT3T1 and WT3P1 models
The PTI Type 3 models are very similar to the GE models except some default values are
different. There are two machine models: WT3G1 and WT3G2. The WT3G2, an enhancement to
the WT3G1, is recommended for new studies. WT3E1 is almost identical to WT3E (parameters in
different order in the file format and PTI allows different negative rate limit). The WT3T1 is
identical to WT3T. The WT3P1 is identical to WT3P (parameters in different order in the file
format).
Detailed Models for common GE 1.5, 1.6, and 3.5 MW Turbines
GE provides more detailed models for their popular 1.5 MW, 1.6 MW and 3.5 MW turbines. These
are modeled using the GEWTG (machine), EXWTGE (exciter), and WNDTGE (governor). The
WNDTGE model combines the wind turbine model with the pitch control model; both one and
two mass models are supported. PowerWorld provides the GE defaults for all three units for both
single and double mass, and for either 60 or 50 Hz. When reading an EXWTGE model from a
DYD file, PowerWorld automatically detects older record formats, reading parameters in the
appropriate order for the format. Note that the latest updates on the GE wind/solar models are
available at http://www.gepower.com/prod_serv/products/utility_software/en/ge_pslf/index.htm
Type 4 : Full Converter Models
To model full converter wind turbines, use the WT4G1 machine model and WT4E1 exciter model.
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Transient Stability Overview: Loads
Most Load Characteristic Models as well as Load Relay Models in Simulator are allowed to apply to
either a load, bus, owner, zone, area, or the entire system. During the dynamic simulation, a particular
load record will use a the following priority when determining what to use as the load characteristic or
load relay model in the stability simulation.








If a load-specific model exist, this will be used
Else if a bus-specific model exists at the terminal bus, this will be used
Else if an owner-specific model exists for the load's owner, this will be used
Else if an zone-specific model exists for the load's zone, this will be used
Else if an area-specific model exists for the area's zone, this will be used
Else if an system-specific model exists for the power system, this will be used
Else the Load Modeling option specified on the Transient Stability Dialog's Option\Power System
Model section will be used. (For relays if the default will be to not use a relay model at all)

Also note that for some types of models such as the MOTORW induction machine model, the model
only applies to a specified percentage of the load. The remaining percentage of the load will use the
algebraic model using the logic above.
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Transient Stability Overview : DC Transmission Lines
For transient stability simulations, DC transmission lines without a dynamic model specified are
modeled as part of the algebraic network equations in much the same way they are modeled in a
power flow solution for steady state analysis. The only exception when moving to a stability simulation
is that all DC lines (as well as DC converters for multi-terminal DC lines) are assumed to operate in
current control mode during the stability simulation. For those which are configured for power control
mode in the steady state power flow input, Simulator will change the control mode to current and
change the setpoint to the steady state current on the device.
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Transient Contour Toolbar
The Transient Contour Toolbar is a special toolbar for generating a time-sequenced series of contour
images based on the transient stability results. The results of the transient stability must have already
been calculated and either stored to RAM or stored to Hard Drive as discussed in the Results Storage.
When generating a plot, an attempt will be made to retrieve from the results stored to RAM. If results
are not available for a particular plot series in RAM, then results will be retrieved from those values
stored to Hard Drive. If they are still not available then a plot will be generated which omits any plot
series for which data can not be retrieved.
The Transient Contour Toolbar looks as follows.
This toolbar can be opened in one of two ways
1.
2.

Click the Show Transient Contour Toolbar option from the Transient Stability Case Info Menu.
Click the Show Transient Contour Toolbar button at the bottom of the Transient Stability
Analysis Dialog.

The various buttons on this table are described from left to right below.
Close
Click this button to hide the Transient Contour Toolbar.
Reset
Click this button to reset the time of the data being contoured back to the start time stored with the
results. A contour image is automatically generated at this start time then.
Back
Click this button to move the present time of the data being contoured backward the number of
stored time points specified by the Step per Animate option.
Play
Click this to continue moving the contour visualization forward in time with each animation frame
determined by the Steps per Animate option
Forward
Click this button to move the present time of the data being contoured forward by the number of
stored time points specified by the Step per Animate option.
Pause
Click this button to
Steps per Animate
The entry of this integer value determines how time progresses when clicking the other buttons
here.
Present Time
Shows the present time of the data being visualized by the contour
Start and End Time
Show the start and end time of the data available for visualization from the results.
Device Type and Field
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Modifying the Device Type and Field in tandem determines which objects are to have values
contoured and which field determines the contour value. The devices available will be an overlap
between those devices which can by contoured and those devices for which results can be saved in
the transient stability tool. This list of available fields will look very similar to the list available on the
Plot Designer.
Options
Clicking this button shows the Contour Options Dialog for a special Transient Contour Value field.
This value will be populated according to the Device Type and Field options above.
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Transient Stability Numerical Integration
The simulation of a transient stability event involves solving a set of differential and algebraic
equations. PowerWorld Simulator uses a second order Runge-Kutta integration method to simulate the
differential equations. A few special topics related to the integration method are as follows.
Handling Ignored States
In a commercial software package, each model must be implemented in a generic manner which
accounts for all possible configurations that model may take. Because of this, Simulator must
implement the maximum number of system state variables possible for each model. The software
must then determine from the input data whether or not to ignore a particular state. As an example
consider the ESAC1A exciter shown in the block diagram below.

If the parameters Tc and Tb are both entered with a value of zero, tThis indicates that the state
associated with the lead lag block will not be a dynamic state and instead will always be equal to the
input value. Simulator's integration engine automatically handles these situations and the derivative
of particular states will be reported as Ignored in the interface in these situations as shown in
Transient Stability Data: Object Dialogs. Also the propagation of values will automatically be
handled. For example, any change to the input to the Tc block will immediately propagate to the
output of that block.
Sub-Interval Integration
Like most commercial transient stability software, PowerWorld Simulator uses an explicit integration
approach that alternates between solving the differential equations and solving the algebraic
network power balance equations. This approach can be quite useful provided there are no model
dynamics with time constants faster than the transient stability time step (using ½ cycle). However
for some transient stability models, such as the EXST1 exciter model, and during induction motor
startup, these conditions can be violated. To avoid numerical instabilities with these models, we
have implemented a technique known as sub-interval integration. When using this approach, within
each transient stability time step the differential equations for some specific models are integrated
using a much smaller time step with the assumption that during these shorter time steps the
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algebraic (network) variables remain fixed. This approach has proven to be quite successful in
integrating very fast dynamics.
As an example, the two figures below show the internal sub-transient voltages for an induction
motor startup for one second of simulation time. In order to show the fast voltage transients that
can occur during motor startup, the first figure is integrated with a very small time step (1/20 cycle)
without the subinterval integration. Note the oscillations that occur during the first 0.1 seconds, with
a frequency on the order of 60 Hz. The second figure repeats the first except using the new subinterval functionality and a time step of one cycle. Because of the longer time step, the faster
oscillations are no longer visible, but the response is numerically stable and is quite similar to the
case with the much smaller time step. Without subinterval integration this case is numerically
unstable with a time step of 1/5 cycle. Two key advantages of the subinterval integration approach
with the longer time step are 1) that network algebraic equations are evaluated much less
frequently, and 2) the subinterval integration is only applied to the handful of models for which it is
required.
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Transient Stability Overview: PlayIn
PlayIn models are used to play input data into the transient stability tool at a specified time. The
models are set to be used as a generator, a reference signal or a governor. Respectively there are
three types of PlayIn models available: PlayInGen, PlayInRef, PlayInGov and PlayInEx. The data for
the models can be set manually using the PlayIn Configuration model type inside the Transient
Stability folder on the Model Explorer.
In the PlayIn Configuration model type you can insert a PlayIn model signal by its name and
specified Offset to be applied when play in that particular model. To insert a new PlayIn model, right
click on the PlayIn entry and choose Insert. This will open a dialog to enter the PlayIn model Name.
Then after pressing OK the PlayIn Time offset can be specified. To insert data to a particular PlayIn
Model right click on the entry and choose Show Dialog. This will open another dialog with a case
information display to enter the data for the PlayIn Model. The Dialog have the PayInName which
can be rename and also the Time Offset can be changed. Below there are two tabs: Signals Info and
Signals.
In the Signal Info tab you specified the Signal Index as well as a respective name, scale, offset and
filter. These signals are the signals that the PlayIn Model will have. For example, a PlayIn generator
will need a signal for the amplitude of the Thevenin source and the frequency of the generator. The
scale is used to scale the signal to a particular value. The offset will be applied to the signal to
match the initial condition of the particular signal established in the initialization of the model. The
filter values is a time constant, such as for a filter block [1/(1+sT)], used to filter the signal.
In the Signal Tab the signal value can be specified for the particular signal index. To insert a new
signal time right click in an entry and choose insert. This will open a dialog to specify a time for the
signals.
The other easy way to enter PlayIn signals and new PlayIn models is to use an auxiliary file with the
desired signals and the desired data values, offset, scale and filter values.
PlayInGen Model
The PlayIn Gen model is a generator model to play in data to the transient stability tool. The PlayIn
Gen models a generator Thevenin voltage amplitude source in p.u. and the frequency amplitude in
p.u.
The model can be entered in the generator dialog Machine Models Stability Tab and will required the
following:






PlayIn Model Signal applied for the particular generator.
VIndex: Index of the Thevenin Voltage amplitude signal.
FIndex: Index of the frequency amplitude signal.
Rth: The Thevenin resistance of the generator in p.u.
Xth: The Thevenin reactance of the generator in p.u.

PlayInRef Model
The PlayIn Gen model is a voltage regulator and governor reference model to play in data to the
transient stability tool. The PlayInRef models a voltage regulator reference voltage in p.u. and the
governor reference Pref (Speed-load reference) in p.u.
The model can be entered in the generator dialog Other Models Stability Tab and will required the
following:



PlayIn Model Signal applied for the particular generator.
VIndex: Index of the voltage regulator reference signal.
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FIndex: Index of the governor reference signal.

PlayInGov Model
The PlayIn Gov model is a governor model to play in data to the transient stability tool. The
PlayInGov models a governor mechanical power (Pmech) in p.u.
The model can be entered in the generator dialog Governors Stability Tab and will required the
following:



PlayIn Model Signal applied for the particular generator.
FIndex: Index of the governor Pmech reference signal.

PlayInEx Model
The PlayIn Gov model is a n exciter model to play in data to the transient stability tool. The PlayInEx
models an exciter field voltage in p.u.
The model can be entered in the generator dialog Exciters Stability Tab and will required the
following:



PlayIn Model Signal applied for the particular generator.
FIndex: Index of the exciter field voltage signal.
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Transient Stability: Model Data Management
The Transient Stability tool introduces a very large amount of additional input data which must be
entered to define the dynamic models of the system. Interaction with this data is completely
integrated with the rest of PowerWorld Simulator and is done primarily through the following methods






Stability tab of the Generator, Load, DC Line, etc... Dialogs
Transient Stability Case Information Drop-Down
Transient Stability Folder in the Model Explorer
Transient Stability Block Diagrams
Reading/Writing Transient Stability Data to various File Formats

Details on these methods are found in the individual topics.
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Transient Stability Data: Object Dialogs
On the various option dialogs for devices such as Generators, Load, Switched Shunts, DC Lines, and
Transmission Lines, there will be a tab labeled Stability. On this tab you will be able to define the
appropriate dynamic models for the device. An example of the generator dialog's Stability tab is shown
as below.

All of these tabs have a similar layout which includes the following attributes
Insert Button
Clicking this button to insert a new model. A dialog will appear prompting you to choose which
specific type of dynamic model to add for the object.
Delete Button
Clicking this button to delete a model.
Type Drop-Down
Shows a list of the presently defined models for this class. A model which is active will say Active
before giving the name of the model. Normally there will only be one model of each class, but
Simulator does permit you to define multiple models. For some models only one can be active at a
time.
Active Check-box
There will be a check-box to make a dynamic model Active or Not Active. When a model is not active
then it will be included in the dynamic simulation. Also note that for some classes of models you can
have only one active model at a time. Governors, Exciters, Machine Models, and Stabilizers for
generators all behave this way, however if you're defining a relay model you may have more than
one active.
Show Block Diagram Button
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When clicking this button, the BlockDiagrams.pdf Adobe Acrobat file will automatically be opened
which contains all the dynamic model block diagrams. This PDF file will automatically be navigated
to show the block diagram of the presently model.
Parameter List
At the bottom of the tab is a panel with numerical edit boxes allowing you to define all the input
parameter values for the model. Next to each edit box is the name of the parameter. In addition to
this if you hover the mouse over the edit box a hint will appear with a more detailed description of
the parameter. The edit box, the non-default parameters will be highlighted as bold.
Special Options only on the Generator Dialogs
Set to Default
On the generator dialog there are options to change the parameters to PowerWorld's default
settings.
Option to enter values on either the Device MVA base or the System MVA base
Normally per unit values for stability data are entered on the MVA base of the device. If you
would like to change to enter data on the System MVA base instead, change this option. (Note:
this option only affects the dialog entries. Entries in the case information displays will always be
on the device MVA base.)
Several Model Class Tabs
Generator dialogs will list sub-tabs for Machine Models, Exciters, Governors, Stabilizers, and
Other Models. Each of these sub-tabs has the same layout.
Step-up Transformer Tab
Information about an assumed step-up transformer may also be included with the generator and
can be entered here.
Terminal and State Tab
After the transient stability run has been initialized on the Transient Stability Dialog, you may go
to the Terminal and State Tab to View information about the terminal values and dynamic states.
Under this tab will be several more sub-tabs as follows
Bus/Setpoint Values: Shows voltage and current on the system MVA base at the terminal bus.
Shows the MW, Mvar and MVA being injected into the system at the terminal bus as well. Also
shows the Exciter Setpoint (Vref) and Governor Setpoint (Pref) values if appropriate.
Terminal Values: Shows the Terminal Voltage and Current on the device per unit base.
Mechanical MW, Accelerating MW, and Terminal MW. Also shows information about the internal
rotor angle, Frequency Deviation (omega), and acceleration. Also shows information about the
Field Voltage and Current and the Direct and Quadrature axis terminal and internal voltages and
currents
Several Model Class State Tabs: tabs for Machine Models, Exciters, Governors, and Stabilizers
will be available. Each will contain a list of the present states for the model as well as the
derivatives of each state. For the derivative values, the states are sometimes ignored (such as
when a time constant is zero). If this is true for the model, the derivative will be listed as
Ignored.
Special Options only on the Load Dialog
Type Drop-Down Modification
Because for a load model, the model can be inherited from the bus, owner, zone, area or system,
the model listed under the Type drop-down may not be associated directly with the Load object.
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If this is the case the model list will show the string Inherited. For inherited models you will not
be able to edit the Parameter List directly. To edit the parameter list you will need to go to the
dialog for that particular object in the Transient Stability portion of the Model Explorer.
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Transient Stability Case Info Menu
The Stability Case Info menu is available by selecting Stability Case Info in the Transient Stability
(TS) ribbon group on the Add Ons ribbon tab.

The menu provides direct access to several case information displays that show default columns
related to input and output of the transient stability tool. There are also options available for loading
and saving transient stability models.
Transient Stability
Choose this option to open the Transient Stability Analysis dialog.
Show Transient Contour Toolbar
Choose this option to make the Transient Contour Toolbar visible.
Case Information\Exciters, Governors, Machine Models, Stabilizers, DC Line Models, Load
Characteristic Models, Load Relays
Choosing any of these options will open a case information display for the appropriate model type.
This same information can be accessed through the Transient Stability folder on the Model
Explorer.
The stability case information displays can be used to change and define new models with the case.
For a more complete description of the Model Explorer interaction with the transient stability models,
see the Transient Stability Model Explorer help topic.
Transient Stability Case Summary
Choose this option to view a summary of transient stability models defined in the case. The
summary includes the model name, whether the model is active or inactive, and whether or not the
model is fully supported in Simulator. (For a small number of models, the model can be read by
Simulator but is not actually supported for stability simulation. These models are marked as Fully
Supported = NO).
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Transient Stability Generator Summary
Choose this option to view a summary of all generators in the case and any stability models that
have been defined for each generator. Inactive models are shown in parenthesis. Use toggle to
change active status of models. If multiple models exist for a particular model type, they are listed
separated by commas.

Models Supported Status
Choose this option to view a list of all models which can be created in PowerWorld Simulator along
with designations regarding what other software supports these models, and whether Simulator is
able to include these models in the stability simulation.

Load/Save Transient Stability Data
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Choose the appropriate option to save or load transient stability model data in the desired format.
Models are supported in the Simulator auxiliary file format (*.aux), BPA dynamics data format
(*.swi), GE dynamics data format (*.dyd or *.dyc), and PTI dynamics data format (*.dyr). MCRE
*.rwm files, MTRLD *.dat files, GNET *.idv files, and BASEGEN *.dat files can also be applied. For
more details about loading the GE DYD file see the Reading DYD files help topic.
Clear All Transient Stability Data
Choose this option to delete all transient stability models.
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Transient Stability Model Explorer
On the Explore pane on the Model Explorer, there is a folder for Transient Stability. Immediately under
this folder is a Summary folder containing links to Generator Model Use, Model Support Status, and
Models in Use. These three features are discussed in more detail in the Transient Stability Case Info
Menu topic. Under this folder is a list of the various classes of models such as Exciter, Stabilizer, Load
Characteristic, etc. which are available in the transient stability tool. When choosing one of these
entries, the right portion of the Model Explorer will be populated with a case information display
showing models of that class. In addition there will be a new pane showing the specific types of that
class of model. This pane has the following attributes










Gray text indicates a model type which is not presently used by any device in the present power
system case
The number in parenthesis next to the model name indicates the number of models of that type
which are used by a device in the present power system case
Green icons indicate that the model is fully supported by the transient stability numerical
integration Simulator.
Red icons indicate that the model is not supported by the transient stability numerical integration
in Simulator. When encountering a new model, PowerWorld will first configure the ability to define
the model as well as read and write it from various file formats. After that the model will be
implemented. Our intention over time is that all red icons will become green icons.
At the bottom of the pane is a set of 4 check boxes showing PW only, BPA, PTI, and GE. These
indicate which model types to show in the list depending one whether that model is supported by
another software package. If you want to see only models which are support by the BPA
IPF program then uncheck the other three check boxes and check the BPA check box. For a
complete listing of all models and where they are supported see the Summary\Model Support
Status in the Model Explorer.
The list of specific types will always include an entry at the top of All which lists all the models of
that class. Below this will be a list of all the specific types of that model class. As you click on the
various entries in the pane, the case information display will be populated accordingly.
At the bottom are buttons to Save or Load dynamic data from an external file.

The following shows such a listing for the generator Exciter models.

1541
©2011 PowerWorld Corporation

All
On the listing which shows all models, there will only be columns which show identifiers for the
object as well as two generic columns common to all models. The Fully Supported column is a
YES/NO column which shows whether the model is supported by Simulator's transient stability
numerical integration (the fast majority will say YES). The Device Status column will show either
Active or Not Active depending on whether the device is specified to be used in the numerical
integration.
Specific Model Type
When you choose a particular model type, additional columns will appear showing all the input
parameters for that model type. This is depicted in the image below.

Show Block Diagram Button
At the top-right of the case information displays listing models will be the Show Block Diagram
button. When clicking this button, the BlockDiagrams.pdf Adobe Acrobat file will automatically be
opened which contains all the dynamic model block diagrams. This PDF file will automatically be
navigated to show the block diagram of the presently selected model in the case information display.
Load Characteristic Models
Load models in Simulator are configured to apply to either a load, bus, owner, zone, area, or the
entire case. This is discussed in more detail in Transient Stability Overview. As a result you will see
special folders at the bottom of the specific model type list for Load-Specific, Bus-Specific, OwnerSpecific, Zone-Specific, Area-Specific, and System-Specific.
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Transient Stability Data: Block Diagrams
As part of the help documentation, Simulator includes an Adobe Acrobat File names Block
Diagrams.pdf which contains all the block diagrams of dynamic models implemented in PowerWorld
Simulator. This file can be automatically opened and the appropriate block diagram navigated to from
both the Transient Stability Case Information Displays and from the Stability Tab on the Generator,
Load, DC Line, etc... dialogs. The format of these block diagrams is very standardized. The block
diagram will appropriately label all the input parameters for the model type. There will also be a list of
the dynamic states which exist for the model. These states will be labeled by number with a circle the
number. In addition there will be a comment regarding whether another software product supports
this model. The following is an example for the ESAC1A excitation system.
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Transient Stability Data from External files
Transient Stability data can be read from several external file types including a PowerWorld Auxiliary
File (AUX), PTI File (DYR), GE File (DYD), or BPA File (SWI). Access for loading these files is found in
several places within Simulator.





Menus within the Application Menu
Bottom of the specific model pane on the Transient Stability portion of the Model Explorer,
Options within Stability Case Info Menu,
Buttons at the bottom of the Transient Stability Dialog.

Save to Auxiliary
in the will prompt for a filename in which to save an auxiliary file. Use this option to store any
results and settings that need to be retained for future use or use with different power flow cases.
Transient stability-specific results and option settings can optionally be saved with the PowerWorld
binary file (*.pwb).
Load Auxiliary
Clicking this button will open a dialog to allow the user to select an auxiliary file to load. This is
intended to be used for loading any relevant option settings to be used during the transient stability
analysis. The dialog will be updated according to the option settings loaded from the file.
Save GE DYD Data, Save PTI DYR Data, Save BPA SWI Data
Choosing this option will allow you to save models to the appropriate file format. Note that only
models which are supported by the specific format will be saved to the file. For a list of which
models are supported by which format see the Model Support Status case information display. When
saving a DYD file, the model names are always stored lower case. When saving a DYR file, a GNET
*.idv and a BASEGEN *.dat are also saved. The filename and path used are the same as for the DYR
file, except "_GNET" and "_BASEGEN" are appended to the file names.
Load GE DYD Data, Load PTI DYR Data, Load BPA SWI Data
Choosing this option will allow you to load models from the GE DYD file format. Selecting the option
"DYR file with options" will allow you to specify a MCRE *.rwm file to split up generators, a MTRLD
*.dat file to split up motors, a GNET *.idv file to disable generator models, and a BASEGEN *.dat file
to specify the Governor Response Limits flag for generators. "Load Specific PTI DYR Helper Files"
allows you to apply those files on their own.
When loading from a GE DYD file a few special features have been implemented.

GE DYD: Special Handling for the Generator Baseload Flag
When loading GE EPC files, a flag exists in the EPC file with each generator record called the
"Baseload flag". This field determines how governor limits are handled during a transient stability
run. This feature is supported using Simulator generator field called Transient Stability\Governor
Response Limits . For more information see the Transient Stability Overview: Generator Models
topic.
GE DYD: Special Handling of EPCMOD models
In many example DYD files which PowerWorld has encountered, there are EPCMOD records which
represents a user-defined model htat represent a Series Capacitor Relay and a Capacitor Relay
Model. Because these models were so common, PowerWorld added two new kinds of relays to our
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model suite. The CAPRELAY model can be assigned to a switched shunt record. This represents a
relay which can open and close a switched shunt based on a definite time relay measuring voltage.
A SERIESCAPRELAY model can be assigned to a branch and used to bypass and place back inservice
a series capacitor branch.
When parsing the DYD file, Simulator will detect an EPCMOD record and if that record refers to the
EPCL program "MSC01.p", then we automatically assume it represents a switched shunt relay and
create a CAPRELAY model. An appropriate log message will be written indicating this has occurred
such as the following: "Info: An EPCMOD record using "MSC01.P" was found. Simulator will attempt
to read following as a CAPRELAY: 30.000 1.2000".
When parsing the DYD file, Simulator will detect an EPCMOD record and if that record refers to the
EPCL program "MSC02_R1.p", then we automatically assume it represents a series cap relay and
create a SERIESCAPRELAY model. An appropriate log message will be written indicating this has
occurred.
GE DYD: Special Handling of GENCC models
In the DYD often represent cross-compound generators in a special manner. A cross-compound
generator represents two generators which both operate off the same steam plant. In a DYD file a
cross-compound plant will be represented by 2 machine models, 2 exciters, 2 stabilizers, and 1
governor. In DYD files, the governor will be either the IEEEG1 or CRCMGV governors. Ideally, the
power flow model represented by the EPC file will model these two generators explicitly and thus the
DYD file will refer to the two generators when specifying the machines, exciters, stabilizer and
governor. The DYD file however also supports a special machine model called the GENCC which is
really just a GENTPF model but it signals to the tool reading the DYD file that two generators in the
DYD file may represent one generator in the EPC file.
To accommodate this situation, Simulator's DYD parser has been written to first go through the
entire DYD file and look for any bus which has only one generator in the existing case (EPC file), but
the DYD file has 2 GENCC records at the bus with IDs that do NOT match any existing generator. If
this situation is found, the user will be asked whether they would like to automatically split the
existing generator into two generators to accommodate this modeling. If you choose yes, then the
case will be permanently modified to split the generators into two. An appropriate log message will
be written indicating this has occurred such as the following: "Info: New generator created at
ALAMT3 G (24003) #L and existing generator ID changed to #H because 2 GENCC records found for
Bus ALAMT3 G (24003) with IDs "H" and "L", but only one generator exists in the case at this bus
with id "3"."
Also note that the GENCC records in the DYD file have parameters Pfac and Qfac which determine
the percentage of MW and Mvar assigned to each generator. When the generators are split into 2
units, the following fields are multiplied by appropriate normalized Pfac and Qfac values: MW output,
Max MW, Min MW, Mvar output, Max Mvar, and Min Mvar. The MVABase will also be multiplied but
only if the GENCC record did not include this as part of its definition (normally it is included in the
DYD file).
GE DYC: Appending changes
When loading files with the extension ".dyc", the contents are automatically appended to the
existing models.
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Transient Stability Analysis Dialog
To display this dialog, go to the Add Ons ribbon tab and select Transient Stability from the
Transient Stability (TS) ribbon group.
All of the help documentation will discuss how this dialog functions when you are simulating only a
single transient contingency event. When changing the Process Contingencies option to Multiple
Contingencies instead, the dialog will change in small ways throughout. For a description of how the
dialog behaves differently when running multiple contingencies, see the Transient Stability Dialog
Multiple Contingencies help topic.

The dialog is broken down into several steps designed to take the user through the setup, processing,
and analysis of results. The pages are as follows:
Simulation

Define the transient contingency elements which describe the event to simulate.
Specify start time, end time, and time step.

Options

Specify the options: General, Power System Model, Result Options, and Generic
Limit Monitors

Results Storage

Specify what results to store during the simulation for viewing, plotting, and
contouring later. Also specify whether to store to RAM, store to Hard-Drive, both,
or neither (when using Transient Limit Monitors appropriately, it may be
unnecessary to store the actual numerical results.)

Plots

Build plot descriptions to both view results and specify what to store to RAM

Results

View the numeric results of the simulation as well as a summary of events that
occurred
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Transient Limit
Monitors

Define transient limit monitors to look for violations of stability criteria during the
simulation. For example, look for a specific drop in frequency that lasts for period
of time.

States/Manual
Control

Provides ability to manual step through the simulation a few time steps at a time.
Also gives access to view the initialized stability state variables and initial state
limit violations.

Validation

Provides options to validate the stability data specified for possible errors and
warning.

SMIB
Eigenvalues

Perform Single Machine Infinite Bus (SMIB) analysis on each generator in the
system to help debug potential model errors which lead to instability.

There are several buttons at the top of the dialog that are normally available regardless of the selected
page.

Run Transient Stability
Click this button to start the analysis once all options and models have been set.
Pause
Click this button to pause a study that is in progress.
Abort
Click this button to stop a study that is in progress.
Simulation Status
Indicates the progress of a study.
For Contingency:
This drop-down determines which contingency is presently being studied. See the Transient Stability
Dialog Multiple Contingencies for processing multiple transient contingencies simultaneously.
Add, Delete, Rename
Click these buttons to Add, Delete, or Rename Transient Contingencies. See the Simulation topic for
more details.
There are several buttons at the bottom of the dialog that are available regardless of the selected
page.
Save All Settings To...
1548
©2011 PowerWorld Corporation

Clicking this button will show a drop-down menu for saving transient stability data to an external file.
More details are found in the Transient Stability Data from External files help topic.
Load All Settings From...
Clicking this button will show a drop-down menu for loading transient stability data from an external
file. More details are found in the Transient Stability Data from External files help topic.
Show Transient Contour Toolbar
Clicking this button will automatically add a toolbar to the bottom of the main window in Simulator.
This toolbar allows you to visualize the results of the stability run through a series of contour
images. It's operating is described in more detail in the Transient Contour Toolbar Topic.
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Transient Stability Analysis: Simulation
The Simulation Control page is available on the Transient Stability Analysis dialog.
The Transient Stability Dialog allows you to define a particular transient stability event which you want
to study. PowerWorld refers to this as a Transient Stability Contingency because in concept it is similar
to the contingency analysis run using power flow solutions. The goal is to simulate a particular
contingency to see if it causes any problems for the system. The contingency will consist of one or
more events. For example, a transient contingency with only one event might be to model the outage
of a generator with the goal of seeing how the governor response of the remaining generators handles
this. Another contingency might be to model a fault at a bus which requires two events: one to initiate
the fault and a second to clear the fault.

Defining a Transient Contingency
When the Process Contingencies option is set to One Contingency at a Time, the dialog will
appear as depicted below. When defining multiple transient contingencies see Transient Stability:
Running Multiple Contingencies.
Use the Add, Delete, and Rename buttons to manage your transient contingencies. The drop-down
allows you to choose the presently active transient contingency. Transient Contingencies differ from
the power-flow based contingency analysis most importantly by introducing the concept of timing.
Transient Contingencies require you to specify a Start Time and an End Time for the simulation,
both specified in seconds. You must also specify a simulation time step which will be used by the
numerical integration software. The following parameters for the transient contingencies are
specified at the top of the dialog.
Add..
Click to add a new transient contingencies. The new contingency will automatically be given an
unused name starting with "My Transient Contingency". Note that when choosing to Store
Results to Hard Drive, then name of the transient contingency will determine the name of the file
to which results are stored.
Delete...
Click to Delete the present contingency. Note that at least one transient contingency must always
exist. If you choose to delete the only transient contingency defined, then a new empty transient
contingency names "My Transient Contingency" will automatically be created.
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Rename
Click this button to be prompted to rename the present transient contingency.
Start Time, End Time
Specify the start and end time of the analysis in seconds.
Time Step
The time step is entered in either seconds or cycles (60 cycles/second) depending on the setting
of the Specify Time Step in option. This value will change to reflect the appropriate units if the
Specify Time Step in option is changed.
Specify Time Step in
The Time Step can either be specified in seconds or cycles. Changing this option will update the
value specified in Time Step to reflect the appropriate units. The time step may be specified in
seconds or in a number of cycles. For instance, for large studies PowerWorld recommends that
you use a half cycle as a time step
Defining Transient Contingency Elements
Once you've specified this timing, you must then specify the transient contingency elements. Again
they are similar to contingency elements for power-flow based simulation, except that these events
must have a time associated with them. An example shown in the figure above is a transient
contingency which faults a bus at 0.2 seconds and then clears the fault at 0.3 seconds.
Insert Elements
Click this button to open the Transient Stability Contingency Element Dialog.
Clear All Elements
Click this button to delete all currently defined events.
Insert Apply and Clear Fault
Clicking this button also opens Transient Stability Contingency Element Dialog, however the
dialog will be modified to only allow the specification of a bus fault or a branch line fault. There
will also be an option on the dialog to enter the Clearing Time in Seconds. This provide a
convenient way to more quickly enter a fault and the clearing time of that fault instead of having
to enter the dialog twice.
Element Table
This table provides a listing of all transient stability elements that are currently defined. This is a
case information display and provides the case information toolbar and local right-click menu for
options. New events can be inserted through the Insert menu/toolbar item. Events can be
deleted through the Delete menu/toolbar item. Use the Show Dialog option to open the
Transient Stability Contingency Element Dialog to modify the event. Model criteria can be applied
to transient contingency actions in this table as well. The action will then only be applied of the
initial conditions meet the model criteria.
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Transient Stability Contingency Element Dialog
The Transient Stability Contingency Element Dialog is used to specify specific transient stability events
and when they occur during the analysis.

Event Description
Drop-down containing a list of all currently defined events. An even description will be created
automatically based on the event time, event object, and even action. This drop-down can be used
to switch between events and make any necessary modifications.
Object Type
Specify the object type for the event. The type of object chosen will change the type of events that
can occur.
Choose the Element
This list will be updated as the Object Type is changed. This list contains all of the available objects
for the selected Object Type. Select a specific object from this list for which the event will be
applied.
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Event Time
Specify the time in seconds at which the event occurs.
Event Type, Event Parameters
The type of event and parameters will change depending on the Object Type chosen. Valid options
are:
Bus
Apply Fault
Apply the specified fault type.
Fault Type - Balanced 3 Phase, Single Line to Ground, Line to Line, or Double Line to Ground
Fault Across - Solid, with Impedance and specifying PU Resistance and PU Reactance,
or with Admittance specifying PU Conductance and PU Susceptance
Clear Fault
Clear a fault.
Open
Opens all AC lines connected to a bus.
Generator
Open
Open the generator.
Close
Close the generator.
Ramp Values
Ramp the output of the generator as defined by the Action Field. Options for the Action
Field are MVA at Bus, Exciter Setpoint (Vref) and Governor Setpoint (Pref). Specify that the
output be ramped By Value or Percentage. Specify the End Time in seconds at which the
ramping stops.
Set Values
Set the output of the generator as defined by the Action Field. Options for the Action Field
are MVA at Bus, Exciter Setpoint (Vref) and Governor Setpoint (Pref). Specify that the output
be set By Value or Percentage.
Load
Open, Close
Specify that the load either be opened or closed.
Set Values
Set the output of the generator as defined by the Action Field. Option for the Action Field is
MW, Exciter Setpoint (Vref) and Governor Setpoint (Pref). Specify that the output be set By
Value or Percentage.
Switched Shunt
Open, Close
Specify that the load either be opened or closed.
AC Line/Transformer
Apply Fault
Apply the specified fault type.
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Fault Type - Balanced 3 Phase, Single Line to Ground, Line to Line, or Double Line to Ground
Fault Across - Solid, with Impedance and specifying PU Resistance and PU Reactance,
or with Admittance specifying PU Conductance and PU Susceptance
Percent Location (near to far) - Specify the location of the fault as a percentage of the
distance from the near end of the line. A fault at the near end would be a percentage of 0%
and a fault at the far end would be percentage of 100%.
Clear Fault
Clear a fault.
Open
Which End - Both Ends, From End Only, To End Only, One Phase Open
Close
Which End - Both Ends, From End Only, To End Only
Bypass, and Not Bypass
Use this option to either Bypass or Not Bypass a branch. Normally we would expect this
branch to be a series capacitor or reactor.
DC Line
Open
Open the entire DC line.
Injection Group
Open
P or Q - MW, MVAr
Device - Generation, Loads, Shunts
MW or MVAr - Amount to open. The amount to open will be based on the initial condition of
the device (not the transient condition), and devices will be opened in order of highest
participation factor to lowest participation until at least the amount specified has been
exceeded.
OK
Click this button to accept any changes and close the dialog.
Save
Click this button to save any modifications to the current event. The dialog will remain open.
Insert
Click this button to create a new event with the specified parameters.
Delete
Click this button to delete the current event as defined by the Event Description.
Help
Click this button to open this help topic.
Cancel
Close the dialog without saving any of the changes.
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Transient Stability Analysis: Options
The Options page is found on the Transient Stability Analysis dialog. The Options page is broken down
into several sub-categories of options described as follows.
General : options for various user interface choices of how data is displays and how the user interacts
Power System Model : options for the actual transient stability numerical simulation
Result Options : options for how the results are stored during the simulation
Generic Limit Monitors : special options that apply generic limit monitors to all objects during the
simulation
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Transient Stability Analysis Options: General
The General sub-tab is found on the Options page of the Transient Stability Analysis dialog. This
contains various choices of how data is displayed in the user interface and how you interact with the
user interface.

MVA Base for Input/Display of Generator Values
Specify the MVA base to use for generators: either the MVA base value entered for each individual
generator or the MVA base value specified for the case.
Identify Buses in Events and Results by
Choose how to identify any buses that appear in transient stability events and results. Buses can be
identified by number or name or a combination of both. The nominal kV of the bus can also be used
as part of the identifier.
When Case has a Transient Stability Model Show Confirmation Dialog
If in the middle or at the end of a transient stability simulation the user tries to save the case,
Simulator can prompt whether to save the case with the power system state after the transient
stability simulation or to save the case with the power system state in place prior to starting the
transient stability analysis. This option determines when the prompt will appear. If not prompted,
the state will remain in the state following the transient stability simulation.
Automatic Update and Transfer Results to Power Flow Options
Specify the interval in time steps to update the displays or when to transfer results to the power flow
model. Also, specify whether or not the displays should be updated and when/if results should be
transferred to the power flow model. Any open plots will be refreshed automatically when
performing the interval check while running transient stability.
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Transient Stability Analysis Options: Power System Model
The Power System Model sub-tab is found on the Options page of the Transient Stability Analysis
dialog. This contains options for how the actual transient stability numerical simulation is performed.

Power System Values
Nominal System Frequency (Hz)
Set the nominal system frequency in hertz. The default is 60 Hz.
System MVA Base
MVA base for the system. The value cannot be changed here and is shown for informational
purposes only. To change this value, go to the Power Flow Solution General page found under
Simulator Options.
Network Equation Solution Options
Solution Tolerance (MVA)
Specify the convergence tolerance used in the transient stability's power flow algorithm. This
option setting only affects the transient stability power flow algorithm and does not affect the
power flow model.
Maximum Iterations
Specify the maximum number of iterations allowed in the transient stability's power flow
algorithm. This option setting only affects the transient stability power flow algorithm and does
not affect the power flow model.
Force Network Equation Update
Specify a time in seconds which forces a full network equation update every so many seconds.
This option can be helpful to avoid small unit oscillations caused by small mismatches.
Use Voltage Extrapolation
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When this option is checked, an estimate of the voltage at time step will use the voltage at the
previous three time steps to estimate what the next voltage will be. This essentially models the
voltage as a quadratic function of time based on the last three time steps and creates an
estimate of what the next voltage will be. This greatly aids in the initial guess sof the network
equation voltages at a time step and helps speed up the simulation.
Inner Loop Mismatch Scalar
PowerWorld Simulator uses a second order Runge-Kutta integration method. As a result network
equation solutions are sometimes done at intermediate time steps as part of the integration
method. Specifying a scalar here which is larger than 1.0 will allow those intermediate network
equation solution to have a larger mismatch.
Infinite Bus Modeling
Select whether or not to use infinite buses. If using infinite buses, the power system slack bus(es)
will be used as the infinite buses. If not using infinite buses, then an Angle Reference must be
selected on the Result Options. At infinite buses the angle does not change. When using infinite
buses, these are used as the angle reference.
Default Load Model
Specify what load model to use by default in the transient stability simulation when the load does
not have a load model characteristic defined. Normally it is best to define a load characteristic model
specifically (it is even possible to define a load characteristic model which applies to the entire case),
but if one is not specified this default will be used.
Minimum Per Unit Voltages for
When modeling loads as Constant Power Models or Constant Current Models, the load will
start to fall off by a particular function if the voltage falls below the specified value. The values
specified here are the same as the values for minimum voltages specified on the Power Flow
Solution Advanced Options page found under Simulator Options. Clicking the Change button will
open the Power Flow Solution Advanced Options page.
Ignore Speed Effects in Generator Swing Equation
The generator swing equation includes a term divides the Mechanical Power by the per unit speed of
the generator. Checking this box will ignore this speed effect. Normally you should not ignore this
effect.
Governor Fast Valving
A few specific governor models such as TGOV3 include an effect called Fast Valving. This option
specifies at what time the fast valving option is initiated. After choosing when you would like it to
initiate you then specify either a frequency deviation in rad/sec or a time in second as the parameter
Fast Valving Parameter (rad/sec or sec).
Exciter Saturation Model
Option to specify the type of saturation function to use for an exciter model. Choices are Quadratic
(GE Approach), Scaled Quadratic, or Exponential. When loading a PSLF DYD file it defaults to the
Quadratic exciter saturation function. When loading a PSS/E DYR file it defaults to the Scaled
Quadratic exciter saturation function. When loading a IPF SWI file it defaults to the Exponential
exciter saturation function.
Integration Method
Option to specify whether to use the Second Order Runga-Kutta Order 2 (RK2) or Euler's method for
the integration time step.
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Transient Stability Dialog Options: Result Options
The Result Options sub-tab is found on the Options page of the Transient Stability Analysis dialog. The
options on the Result Options determine how the results are stored during the simulation.

Time to Begin Checking for Minimum and Maximum Results
Minimum and maximum values for several bus and generator parameters are automatically stored
during the analysis. This option determines when the recording of these minimum and maximum
values should begin.
If you choose After last event, then the recording of minimum and maximum results will start after
the last transient contingency element is processed for the simulation. This is the most common
option and is used to prevent the recording of very low voltages during a fault event from being
recorded as the minimum result when you are really only concerned with how the voltages recover
after the fault clears.
If you choose Immediately, then the minimum and maximum result recording will start at the
beginning of the simulation.
If choosing to use a Custom Time, a field will appear that will allow entry of a specific time in
seconds when recording should begin.
Angle Reference Options
Note: if infinite buses are being modeled as part of the Power System Model options, this option is
not used and the fixed angle at infinite bus is automatically used as the reference.
Generator Rotor Angles in a transient stability simulation are calculated with respect to what is called
the synchronous reference frame. The synchronous reference frame represents how the angles
would move with respect to a theoretical rotating reference frame based on the system nominal
frequency. When a transient stability simulation converges to a new steady state frequency which is
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higher than nominal frequency, then inherently the rotor angles as expressed in this synchronous
reference frame will continue to increase toward infinity. This will not indicate instability as long as
the angles in relation to one another converge upon a new steady state.
The use of the synchronous reference leads to the angle reference option. This option specifies a
reference which will be used to calculate an angle reference at each time step in a simulation. This
angle reference will be calculated across the entire system. The generator field Rotor Angle recorded
at a particular time in the results will then be equal to this system angle reference subtracted from
the rotor angle on the synchronous reference frame. (Note: normally an angle reference option
should be chosen because the generator rotor angle in the synchronous reference frame may be
stored as an independent result variable called Rotor Angle, No Shift, which is distinct from the Rotor
Angle.)
When looking at a plot of rotor angles in the synchronous reference frame, the plot may look as
shown on the left below. If a angle reference option is chosen, then when plotting generator rotor
angles, the plot will instead look as shown on the right. Both plots show the same system, but the
plot on the right more clearly shows that the system is stable.

The options for angle reference are as follows


Average of Generator Angles : reference equals the straight average of all rotor angles in the
system






Weighted Average of Generator Angles : reference equals the average of all rotor angles in the
system weighted by each generators MVA base.

Specified Angle Reference Generator Terminal Angle : the terminal bus angle of the generator

specified on the dialog as the Angle Reference Generator will be used.
Specified Angle Reference Generator Internal Angle: the internal bus angle of the generator
specified on the dialog as the Angle Reference Generator will be used.
Synchronous Reference Frame (No Angle Shift) : no reference angle is used so all rotor angles are
reported on the synchronous reference frame.

Angle Reference Generator
This option must be set if the option for Angle Reference Option is set to one of the choices for
using a specific generator.
Initialize with Reference Angle at Zero
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This initializes the reference angle, regardless of the method selected for determining the reference
angle, to zero at the beginning of the analysis. In practice this is done by recording the starting
reference angle. At each time step the reference angle is determined and then this is offset by
subtracting the original reference angle value from the current reference angle value and this new
value becomes what is used as the reference angle at each time step.
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Transient Stability Dialog Options: Generic Limit Monitors
The Generic Limit Monitors sub-tab is found on the Options page of the Transient Stability Analysis
dialog. It contains the following special options apply generic limit monitors to all objects during the
simulation.

Synchronous Generator Limit Monitors
Only Apply to Generators Without Relays is a check-box which chooses to apply these generic
limit monitors only to generators which do not have their own generator relay (such as a GP1)
assigned to them.
There are three generic limit monitors which can be applied to all synchronous generators. These
limit monitors are as follows




Absolute Angle Deviation : monitors for synchronous generators whose rotor angle increases to
a value which is substantially different than the initial rotor angle. This is a very crude attempt to
monitor for out-of-step generators.
Over Frequency : monitors for synchronous generators which experience high frequency.
Under Frequency : monitors for synchronous generators which experience low frequency.

The limit monitors can then be configured to look for a violation of a specified Pickup Value that
occurs for a specified Pickup Time. If a violation occurs you then specify an action to take due to this
violation which can be either Ignore, Log Warning, Trip (Open), or Abort. Ignore does nothing. Log
Warning will return an Event in the Transient Stability Results indicating that a violation occurred
and when it occurred. Trip (Open) will cause the generator to trip off-line (an event will also be
logged stating this). If Trip (Open) is chosen then the generator will trip after a delay in cycles
specified by the Breaker Delay Time (cycles). Finally, Abort will causing the simulation to
immediately abort when the limit monitor violation occurs.
For more customizable limit monitors, see the Transient Limit Monitors section.
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Maximum Allowable Angle Difference (degrees)
This parameter determines the maximum allowable angle difference between any two generator
rotor angles in the case. If this value is exceeded, the transient stability analysis will stop
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Transient Stability Dialog Options: Distributed Computing
The Distributed Transient Stability Analysis tool is available as an add-on to the base
Simulator package. Contact PowerWorld Corporation for more details.
The Distributed Computing sub-tab is found on the Options page of the Transient Stability Analysis
dialog.
Distributed Computing is available for use with Transient Stability Analysis. In order to use distributed
computing you must first configure a list of remote computers which can be utilized along with
appropriate authentication information for those computers. The computer list and authentication
information is common to all the distributed computing tools in Simulator and can be found in the
Simulator Options Dialog, or reached with the Distributed Computing Options button in the Distributed
Computing sub-tab. They are described in Distributed Computing Options.
The only option specific to Transient Stability Analysis for Distributed Computing is the following
Use Distributed Computing
Check this box to signify that when processing contingencies distributed computing should be used.
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Transient Stability Analysis: Results Storage
The Results Storage page is found on the Transient Stability Analysis dialog. The settings on this page
determine




What results are stored during the stability simulation.
Where results are stored: RAM, Hard Drive, Both, or Neither.
The frequency with which results are stored.

You may want to store results to RAM so that they can be viewed in the Transient Stability Results:
Time Values. Be careful however because if too many results are stored you will run out of RAM
causing the simulation to fail or generally slow down your computer.
When storing results to Hard Drive you can be much more free with how much data is saved. After
running you will still be able to load those results into RAM later (using the Load from Hard Drive
File into RAM results specified by Store to RAM Options button, and you will also be able to
visualize Plot Charts directly from the hard drive results.
When using the Transient Limit Monitors, it can be reasonable to run a simulation which does not
store any numeric results of the simulation. This is because when the goal is only to verify that all
system performance criteria as described by the transient limit monitors are met, then the actual
numerical results are not necessary.
Store Results to RAM
Check this box to store results using the Save to RAM Options.
Store Results to Hard Drive
Check this box to store results using the Save to Hard Drive Options.
Save the Results stored in RAM in the PWB file
The user can select to just store the transient stability parameters, store the parameters results, or
not store either the transient stability parameters or results in the *.pwb file. Storing transient
stability information in the *.pwb file makes it convenient to open a case and run the transient
stability analysis, but storing this information, especially the results, could significantly increase the
size of the *.pwb file. Auxiliary files can also be used for storing the parameters and results instead
of, or in addition to, storing this information in the *.pwb file.
Save Results Every n Time Steps
When writing results to RAM or the Hard Drive, specify the number of time steps after which results
should be stored. If a value of 10 is entered then results will only be stored every 10 time steps.
Note: this setting will NOT effect the use of Generic Limit Monitors or Transient Limit Monitors . The
Generic Limit Monitors and Transient Limit Monitors are an integrated part of the numerical
integration solution and are checked at every time step regardless of how frequently results are
saved to RAM or the Hard Drive.
Load from Hard Drive File into RAM results specified by Store to RAM Options
Click this button to cause Simulator to go out to the file specified in Save to Hard Drive Options and
load in the values specified by the Store to RAM options into RAM. On the Transient Stability Results:
Time Values, only results stored in RAM can be viewed in the case information displays.

1565
©2011 PowerWorld Corporation

1566
©2011 PowerWorld Corporation

Transient Stability: Results Storage: Storage to RAM
The Results Storage page is found on the Transient Stability Analysis dialog.
This section describes how to choose which results to store to RAM during the transient stability
simulation. You may want to store results to RAM so that they can be viewed in the Transient Stability
Results: Time Values. Be careful however because if too many results are stored you will run out of
RAM causing the simulation to fail or generally slow down your computer. The Store to RAM Options
mostly consist of a list of all the various objects in the model and a list of field which can be stored
during the transient simulation. This is depicted in the figure below. Any information needed for a
subplot's horizontal axis data is automatically stored to RAM.

Tables of Devices
Results for Generators, Buses, Loads, Switched Shunts, Branches, DC Lines, Multi-Terminal DC
Records, Multi-Terminal DC Converters, Areas, Zones, Interfaces, and Injection Groups can be
stored during the transient stability analysis. Each type of object has a list of transient stability
related parameters that can be stored. Toggling the appropriate field to YES for an object will store
that parameter for the selected object. Some objects such as generators also have dynamic models
associated with them for which dynamic states can be stored. For these you will see columns for
Machine States, Exciter States, Governor States, etc... which can be set to YES to store those
states. Each object also has a Save All field. If this field is set to YES for a particular object, all
transient stability related fields (except dynamic states) will be stored for that particular object
without having to set all of the fields to YES for all of the parameters. For dynamic states you can
not use the Save All field and must toggle the specific state field instead.
Also note that any values which are set to be part of a plot series in a plot definition will
automatically be stored to RAM
All results are presently stored in memory. This means that a memory limitation could be reached is
storing a large number of results.
Save Results for Open Devices
Check this box to save results for devices that are currently open. It is possible that a device that is
currently open could be closed during the transient stability analysis so this device should not be
excluded from the results.
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Set All NO
Click the Set All NO button to reset all fields regarding RAM storage for the present tab being
viewed to NO.
Set All NO for All Types
Click the Set All NO for All Types button to reset all fields regarding RAM storage to NO for all
object types.
Set Save All by Type...
Click this bus to bring up a dialog containing check-boxes which allows you to choose which device
types to toggle the Save All paramter to YES for. There will also be check-boxes regarding the
various dynamic model state fields.
Plotting
Transient stability results are usually interpreted with the assistance of some sort of plot. There can
be a large amount of data to sort through and options on this page as well as the Plots page are
designed to assist in setting up meaningful plots. Plot Definitions must be created in order to view a
plot. The plot buttons contained on the Results to Save page assist in creating Plot Definitions
outside of the Plots page. See the Plots page for more detailed information about Plot Definitions
and plot parameters. Once options on the Results to Save page are used to create plots, the plot
definitions will show up on the Plots page.
In order to make a plot, objects and fields to include in the plot must be specified. How many
objects and fields are selected will determine which of the following buttons are enabled and how
the plot will be designed. To select objects and fields for a plot, simply select cells in the appropriate
device table that include the fields and objects to show on a plot.
For example, to plot all generator rotor angles on a single plot, go to the Generators tab and select
all of the records under the Rotor Angle field. After selecting the objects and fields, click the
appropriate plot button, as described below, to create the plot definition.

As another example, to plot only the rotor angles and terminal MW value of only generators 1 and 2,
go to the Generators tab. Move the MW Terminal field so that it is next to the Rotor Angle field. This
can be done by using the Display/Column Options dialog or holding down the CTRL key and
dragging a column to move it to a different place in the table. Select the records for generator 1 and
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2 under both the Rotor Angle and MW Terminal fields. After selecting the objects and fields, click the
appropriate plot button, as described below, to create the plot definition.
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Make Plot
This button is enabled when at least one object record for a transient stability field is selected.
This option will create a plot definition with a single subplot with all selected objects and fields
appearing on the same axis group.
Make Plot Group by Field
This button is enabled when more than one transient stability field is selected. This option will
create a plot definition with a single subplot with a separate axis group for each of the selected
fields. All selected objects will appear on a given axis group.
Make Plot Group by Object
This button is enabled when more than one transient stability object is selected. This option will
create a plot definition with a single subplot with a separate axis group for each of the selected
objects. All selected fields will appear on a given axis group.
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Transient Stability: Results Storage: Storage to Hard Drive
The Results Storage page is found on the Transient Stability Analysis dialog.
This section describes how to choose which results to store to Hard Drive during the transient stability
simulation. Results which are stored to Hard Drive can still be directly visualized using Simulator's
Plotting tools. The options are depicted in the figure below.

Location
Specify the directory on your computer in which to store the results. For each transient contingency,
one file will be written to this directory. The filename will be the name of the contingency with the
*.TSR file extension. When a transient stability simulation is started for a particular transient
contingency, if a file already exists in this directory with the appropriate name then the file will be
emptied and replaced with the results from the new stability run.
If this field is left blank, Simulator will attempt to save data in the same directory the case was
loaded from. If a directory is specified but does not exist, Simulator will give you the option to create
that directory or abort the run.
Because a large amount of data will be written to this file, it is best to not use a network drive which
may cause some latency in writing results during the simulation. This latency can slow down the
numerical simulation if the network drive is slow.
Object Types to Include
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A list of objects types for which transient stability results can be stored. All fields (including the
dynamic states) will be stored for each object in the TSR file. The only filtering allowed presently is
to limit the results by the Area/Zone/Owner filters by checking the box Only store every result for
objects which meet the Area/Zone Filters. Clicking the Edit Area/Zone Filters will open the
Area/Zone/Owner filters case information display.
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Transient Stability Analysis: Plots
The Plots page is found on the Transient Stability Analysis dialog. The Plots page is broken into two
sub-tabs that provide the means for creating and modifying plots:
Plot Designer
This page is used to create and modify plots.
Plot Definition Grids
This page provides summary case information displays of the various components comprising a plot:
Plots, Sub Plots, Axis Groups, and Plot Series. Once plots have been created using the Plot Designer,
they can be modified through the Plot Definition Grids. These grids also provide the format in which
plots are stored in auxiliary files.
Once you have created a plot see the Transient Stability Dialog: User Interaction with Plots for many
ways to interact with that plot to better view the results.
Plotting of transient stability results is an integral part of a transient stability tool. It is a primary
mechanism through which transient stability results are viewed. Simulator has been designed to give a
great deal of flexibility in the design of your plots allowing for multiple charts on a single plot as well
as multiple vertical axes on a single chart. To discuss this in detail let us first define four objects which
make up a plot definition





Plot : a single window showing plotted results which may consist of 1 or more subplots
Subplot: A subplot represents the actual graphical chart. It contains a single horizontal axis which

is shared by all plot series contained in the subplot. The subplot contains one or more axis groups
which represent vertical axes. For many plots there will be only one subplot
Axis Group : A single axis group may contain many plot series. A single axis group represents a
vertical axis which is shared by all the plot series it contains. For many subplots there will be only
one axis group.
Plot Series : A single plot series is a graphical line representing the trace of one numeric data
series. For instance it may be the frequency of a particular bus.

As a simple example, consider the figure on the first figure below showing a plot that contains one
subplot, that contains 1 axis group, that contains 1 plot series. Plots may also be much more complex
as shown by the second figure below which has multiple subplots and multiple axis groups. Finally, the
bottom-right subplot of the third example shows a subplot using a horizontal axis which is different
than Time and thus shows a state space plot.
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A more complicated example consisting of multiple plots, subplots, axis groups, and plot series is
shown below:
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Transient Stability Analysis Plots: Plot Designer
The Plot Designer sub-tab is found on Plots page of the Transient Stability Analysis dialog. Settings on
this page determine which results will be plotted and when the plots will be made visible during the
transient stability analysis.
The Plot Designer page is broken into three main sections. The left side of the page allows for the
selection of devices and fields that should be included in a plot. The middle section defines the plots
that are created and how these should be defined in terms of subplots and axis groups. The right
section of the page allows modification of all of the plot components. The dialog is shown below.

Creating a New Plot
A new plot can be created in a number of ways:





If no existing plot exists, simply selecting a Device Type, Choose Fields, and Choose Objects
and then clicking the Add >>, Add >> Group Fields, or Add >> Group Objects buttons will
create a new plot with a default name. (You may also drag a selection of fields over to the middle
section listing the plot components to create a new plot).
Click the Add Plot button found under the Plots, Subplots, Axis Groups list. A prompt will
appear asking for the name of the plot. Enter the name and click OK. Then use the Device Type,
Choose Fields, and Choose Objects options and the Add >> buttons to add data to a plot.
Right-click on the Plots, Subplots, Axis Groups list and select Add Plot. A prompt will appear
asking for the name of the plot. Enter the name and click OK. Then use the Device Type,
Choose Fields, and Choose Objects options and the Add >> buttons to add data to a plot.
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Click the Add Plot button found on the Plot sub-tab that is part of the Plots, Subplots, Axis
Groups section. A prompt will appear asking for the name of the plot. Enter the name and click
OK. Then use the Device Type, Choose Fields, and Choose Objects options and the Add >>
buttons to add data to a plot.
Select fields and objects in the Results to Save tables.
From the list of Transient Limit Monitor Violations.

Right Section: Editing of Plot Definition
Most of the topic below discusses the creating of plot components. After plot components are
created, selecting a particular plot component (plot, subplot, axis group, plot series) from the list in
the middle of this portion of the dialog will change the sub-tabs that are available to the right of the
list. Each of these sub-tabs allows for modifications of the different plot components as well as the
components in which a particular component is contained, e.g. selecting a plot series will allow for
modification of that particular series as well as the axis group in which the series is contained, the
subplot in which the axis group is contained, and the plot in which the subplot is contained. Options
can be changed for a plot before the plot is generated or while the plot is showing. Changing any of
the options on the sub-tabs described below will update the current plot. Possible sub-tabs are as
follows:







Plot
Chart
Horizontal Axis
Vertical Axis
Plot Series List
Plot Series

Device Type
Select the device type from the drop-down of all allowed types. Changing the device type will update
the Choose Fields and Choose Objects accordingly.
Choose Fields
Choose the fields to be added to a plot. Multiple fields can be selected by holding down the CTRL
key and selecting individual fields with the mouse, or holding down the Shift key and selecting the
beginning and ending of a range with the mouse. You may also left-click and drag a list of fields
here over to the middle section showing a list of plot components.
Dynamic States, Other Fields and Inputs
At the top of the field list is a list of the common fields which can be saved as part of the Results
Storage. For some types of objects, below this are several folders showing either Dynamic Model
Input Fields, Dynamic Model Other Fields, or Dynamic Model States. The states represent the
actually states of the dynamic equations of the mode. Other field represents other values of
interest for the object which are not actually a state variable. Finally the input fields represent
special input values to the dynamic model. Examples of input fields are the governor setpoint
(Pref) and the exciter setpoint (Vref).
The entries underneath these folders will change as you select different objects from the
Choose Objects pane. By default the entries will be very generic saying "Input 1", "Other 1",
"State 1", "State 2", etc... If the selected object has a dynamic model associated with it then the
entries will change to reflect this. If multiple objects are selected then the entries will only
change if all objects selected have the same name for the specified State, Input, or Other field.
Choose Objects
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Choose the objects to be added to a plot. Multiple fields can be selected by dragging the mouse
down a selection, holding down the CTRL key and selecting individual fields with the mouse. The
font colors of the objects lists in this list indicate whether any results are available for plotting
presently. Black text indicates that there are no results available. Green text indicates that values are
stored in RAM for this object. Blue text indicates that values are stored on the Hard Drive for this
object.
Add >>
When clicked the selected fields and objects will be added to the appropriate plot component. Fields
are selected from the Choose Fields list and objects are selected from the Choose Objects list.
This button is enabled under the following conditions if at least one field and one object are
selected:
Plot selected that contains only one subplot and one axis group - plot series for each
field and object will be added to the selected plot in the single axis group and subplot
Subplot selected that contains only one axis group - plot series for each field and object
will be added to the selected subplot in the single axis group
Axis group selected - plot series for each field and object will be added to the selected axis
group
In any of these case if a plot series already exists for the selected field and object, a new plot
series will not be added.
Add >> Group Fields
When clicked the selected fields and objects will be added to the appropriate plot component. Fields
are selected from the Choose Fields list and objects are selected from the Choose Objects list.
This button is enabled under the following conditions if at least one object and more than one field
are selected:
Plot selected that contains only one subplot - axis groups will be created for each of the
selected fields and plot series for each of the selected objects will be placed in each new axis
group
Subplot selected - axis groups will be created in the selected subplot for each of the selected
fields and plot series for each of the selected objects will be placed in each new axis group
Axis group selected - axis groups will be created in the subplot that contains the selected axis
group. A new axis group will be created for each of the selected fields and plot series for each of
the selected objects will be placed in each new axis group.
In any of these cases if an axis group for a selected field already exists in the corresponding
subplot, a new axis group will not be created, but the plot series will be added to the existing
axis group. If a plot series for a selected object already exists in the axis group, a new plot series
will not be added. For an axis group to exist for a selected field, the axis group can only contain
plot series for that particular field.
Add >> Group Objects
When clicked the selected fields and objects will be added to the appropriate plot component. Fields
are selected from the Choose Fields list and objects are selected from the Choose Objects list.
This button is enabled under the following conditions if at least one field and more than one object
are selected:
Plot selected that contains only one subplot - axis groups will be created for each of the
selected objects and a plot series for each of the selected fields will be placed in each new axis
group
Subplot selected - axis groups will be created in the selected subplot for each of the selected
objects and plot series for each of the selected fields will be place in each new axis group
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Axis group selected - axis groups will be created in the subplot that contains the selected axis
group. A new axis group will be created for each of the selected objects and plot series for each
of the selected fields will be place in each new axis group.
In any of these cases if an axis group for a selected object already exists in the corresponding
subplot, a new axis group will not be created, but the plot series will be added to the existing
axis group. If a plot series for a selected field already exists in the axis group, a new plot series
will not be added. For an axis group to exist for a selected object, the axis group can only
contain plot series for that particular object.
Generate Selected Plots
Click this button to generate plots for those selected in the Plots, Subplot, Axis Groups list. For a
plot to be selected either the plot itself or one of its components needs to be selected. When
generating a plot, an attempt will be made to retrieve from the results stored to RAM. If results are
not available for a particular plot series in RAM, then results will be retrieved from those values
stored to Hard Drive. If they are still not available then a plot will be generated which omits any plot
series for which data can not be retrieved.
Close All Plots
Click this button to close all open plots.
Show Selected Plot Data in Case Info
Click this button to open a case info display
Save Plot Definitions to Auxiliary File
Click this button to save all of the plot definitions to an auxiliary file. This is useful when running
analyses on power system models with common devices.
Plots, Subplots, Axis Groups
This is a listing of all plots that have been created along with associated subplots, axis groups, and
data series. The list is arranged as a group of folders. Each plot is contained in its own folder. If
there is more than one subplot for a plot, each subplot will be contained in a folder. Each subplot
then contains a list of axis groups. If there is more than one axis group for a subplot, each axis
group will be contained in a folder. Each axis group then contains a list of the plot series that it
contains.
When adding devices and fields to a plot, the plot component selected in this list will determine
where the data will be added when clicking one of the Add >> buttons. The Add >> buttons will
be enabled according to the component selected in this list and the combination of devices and
fields selected in Choose Fields and Choose Objects. Note you may also drag a list of fields from
the Choose Fields portion of the dialog over to this listing to add new plots or add new plot series
to the respective plot component.
There are several buttons located at the bottom of the plot listing. These buttons affect what and
how things are shown in the list.
Add Plot
Click this button to add a new plot to the list.
Delete
The caption and functionality of this button will change depending on the particular type of plot
component that is selected in the list. Clicking this button will then delete the selected
component and any other components that are contained in the selected component. For
example, if an axis group is selected and the Delete button is clicked, all plot series contained in
the axis group will be deleted along with the axis group.
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Note: you may also delete plot components by dragging them from this listing over to the
Choose Fields pane.
Collapse All
Click this button to collapse all folders in the list.
Expand All
Click this button to expand all folders in the list.
Right-clicking on components in the list will open a local menu that allows various options for adding
or deleting plot components. The options that are available will change depending on the component
selected.

Components can be moved from one plot to another or from one component to another by simply
clicking and dragging the component to the new location. The new location must be a valid
component that can contain the component being moved or the parent component for the new
location must be able to contain the component being moved. For example, a subplot can be moved
and dropped on an axis group with the subplot being placed in the plot containing the axis group.
Note: you may also delete plot components by dragging them from this listing over to the Choose
Fields pane.
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Transient Stability Analysis Plot Designer: Plot
The Plot sub-tab is available on the Transient Stability Analysis dialog on the Plot Designer sub-tab of
the Plots page. This tab provides information about the Plot that is currently selected in the Plots,
Subplots, Axis Groups list found on the Plot Designer sub-tab. A plot is selected if any of its
corresponding subplots, axis groups, or plot series are selected in the list.

Plot Name
Name of the currently selected plot.
Rename Plot
Click this button to rename the currently selected plot. A dialog box will open in which the new plot
name should be entered. Click OK on this dialog to change the plot name or Cancel to abandon the
change.
Add Plot
Click this button to create a new plot. A dialog will open prompting for a name for the new plot. Click
OK to create the new plot or Cancel to abandon the addition.
Delete Plot
Click this button to delete the currently selected plot.
When to show the plot
Set this option to determine when a plot should be shown. A plot can automatically be shown at the
completion of a stability run or on execution of a stability run. If showing on execution, the plot will
be updated as the analysis progresses. If set to be shown manually, the plot must be selected in the
Plots, Subplots, Axis Groups list found on the Plot Designer page and the Generate Selected
Plots button must be clicked in order to be shown. A plot can be shown manually in this manner at
any time even if one of the options to show the plot automatically is selected.
Tile Subplots Mode
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This option will only be enabled if a plot contains more than one subplot. This option dictates how
the subplots will be placed within the plot window. If choosing None (user-specified locations),
the location of the subplot should be specified with the Location option found on the Chart sub-tab.
Auto-Save an Image of the Plot
Specify when and how plot images are saved to the Results Storage Hard Drive location. When
defines when images are stored (can be Never, After each contingency, Multiple Plot at the end, or
Both). File Type defines the format the image being saved (can be a Metafile *.EMF, JPEG *.jpg,
Bitmap *.bmp, or a GIF *.gif). Image Pixel Width/Height specifies the dimensions of the saved
image.
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Transient Stability Analysis Plot Designer: Title Block
The Title Block sub-tab is available on the Transient Stability Analysis dialog on the Plot Designer subtab of the Plots page. This tab provides information about the title block for a given plot.

Plot Name
Name of the currently selected plot.
Rename Plot
Click this button to rename the currently selected plot. A dialog box will open in which the new plot
name should be entered. Click OK on this dialog to change the plot name or Cancel to abandon the
change.
Add Plot
Click this button to create a new plot. A dialog will open prompting for a name for the new plot. Click
OK to create the new plot or Cancel to abandon the addition.
Delete Plot
Click this button to delete the currently selected plot.
Show Title Block on Plot
Check this box to display the title block on the plot.
Show Date and Time in Title Block
Check this box to include the date and time in the title block on the plot.
Title Block Height %
This defines the portion of the overall window area dedicated to the title block.
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Right Memo Width %
This defines the portion of the space dedicated to the title block memos taken up by the right
memo. Note that the width this setting references is the combined width of the right and left
memos, which is not necessarily the full width of the plot window.
Font Size
Set the font size of the memo text and date/time text here.
Where to show the title block
Set the location of the title block in the plot display window, either Top of Plot or Bottom of Plot
Left/Right Memos
These contain the text displayed in the memos to the left and right sides of the title block. Special
strings may be entered, preceded by a '@' symbol, which will be automatically interpreted as an
appropriate string to place in the memo.
@CTGName will display the appropriate contingency name
@CASENAME will show the name of the case presently open.
@BUILDDATE will show the Simulator patch build date. @DATETIME will show the present date
and time.
@DATE will show the present date.
@TIME will show the present time.
Show Logo Image in Title Block
Check this box to display an image to the far left of the title block. You can specify an image with
the "Logo Image" file browser, or leave the file path blank to use the PowerWorld logo.
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Transient Stability Analysis Plot Designer: Chart
The Chart sub-tab is available on the Transient Stability Analysis dialog on the Plot Designer sub-tab of
the Plots page. This tab provides information about the subplot that is currently selected in the Plots,
Subplots, Axis Groups list found on the Plot Designer sub-tab. A subplot is selected if any of its
corresponding axis groups or plot series are selected in the list.

The Chart portion of the subplot is the background, header, and footer of the subplot.
Subplot Number
This is an informational field. Each subplot is assigned a number when it is created. The user cannot
change this value.
Add Subplot
Click this button to add a subplot to the currently selected plot.
Delete Subplot
Click this button to delete the currently selected subplot.
Visible
Check this box to make the subplot visible when its corresponding plot is shown.
Background Color
Click the color box or the Change button to select a new color for the chart background.
Title
Check the Visible box to make a chart title shown. Check the Specify Color box and choose an
desired color to specify a font color for the title. Specify the Font Size and the actual title text in the
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box provided. Special strings may be entered, preceded by a '@' symbol, which will be automatically
interpreted as an appropriate string to place in the title.
@CTGName will display the appropriate contingency name
@CASENAME will show the name of the case presently open.
@BUILDDATE will show the Simulator patch build date. @DATETIME will show the present date
and time.
@DATE will show the present date.
@TIME will show the present time.
Footer
Check the Visible box to make a chart footer shown. Check the Specify Color box and choose an
desired color to specify a font color for the footer. Specify the Font Size and the actual footer text
in the box provided. Special strings may be entered, as described above.
Location
Set the Top, Bottom, Left, and Right location of the subplot within the plot window if choosing
the option for user-specified subplot locations with the Tile Subplots Mode option found on the
Plot sub-tab.
Advanced Options Filename
There are a number of advanced options associated with a chart that are only accessible through
the local menu found on each subplot. This option allows a file containing these advanced options to
be associated with the current subplot. If a file is specified, the advanced options contained in that
file will be used when generating the subplot. Use the Browse button to browse for a file and use
the Clear button to no longer associate a file with the current subplot. For more information about
the advanced options, see the Navigating Around a Plot, Advanced Options section.
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Transient Stability Analysis Plot Designer: Horizontal Axis
The Horizontal Axis sub-tab is available on the Transient Stability Analysis dialog on the Plot Designer
sub-tab of the Plots page. This tab provides information about the subplot that is currently selected in
the Plots, Subplots, Axis Groups list found on the Plot Designer sub-tab. A subplot is selected if any
of its corresponding axis groups or plot series are selected in the list.

The horizontal axis is shared by all plot series on the selected subplot.
Subplot Number
This is an informational field. Each subplot is assigned a number when it is created. The user cannot
change this value.
Add Subplot
Click this button to add a subplot to the currently selected plot.
Delete Subplot
Click this button to delete the currently selected subplot.
Show Horizontal Axis on Plot
Check this box to show the horizontal axis on the current subplot.
Inverted
Check this box to have the scale on the horizontal axis go from high to low values when moving left
to right along the axis.
Logarithmic
Check this box to use a logarithmic scale on the horizontal axis of the current subplot.
Title
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Check the Visible box to make a horizontal axis title shown. Check the Specify Color box and
choose an desired color to specify a font color for the title. Specify the Font Size and the actual title
text in the box provided. Special strings may be entered, preceded by a '@' symbol, which will be
automatically interpreted as an appropriate string to place in the title.
@CTGName will display the appropriate contingency name
@CASENAME will show the name of the case presently open.
@BUILDDATE will show the Simulator patch build date. @DATETIME will show the present date
and time.
@DATE will show the present date.
@TIME will show the present time.
Scale
Maximum
Check the box next to Automatic to have the maximum value on the scale automatically
determined based on the results or uncheck this box and specify the value manually. Check the
box next to Round to have the maximum value rounded when the Automatic checkbox is also
checked.
Increment
Specify the increment between scale markings. If zero is specified, the increment will be
determined automatically.
Minimum
Check the box next to Automatic to have the minimum value on the scale automatically
determined based on the results or uncheck this box and specify the value manually. Check the
box next to Round to have the minimum value rounded when the Automatic checkbox is also
checked.
Horizontal Axis Value
The horizontal axis value is normally chosen to be time. This is the default if nothing else is selected.
However, the option is allowed to choose a different value for the horizontal axis.
Clear
Click this button to restore the horizontal axis value to the default of Time.
Object Plotted
Select an object to be used for the horizontal axis values.
Field Plotted
Select the field for the associated object to be used for the horizontal axis values.
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Transient Stability Analysis Plot Designer: Vertical Axis
The Vertical Axis sub-tab is available on the Transient Stability Analysis dialog on the Plot Designer
sub-tab of the Plots page. This tab provides information about the axis group that is currently selected
in the Plots, Subplots, Axis Groups list found on the Plot Designer sub-tab. An axis group is
selected if any of its corresponding plot series are selected in the list.

The vertical axis is shared by all plot series in the selected axis group.
Axis Group Number
This is an informational field. Each axis group is assigned a number when it is created. The user
cannot change this value.
Add Axis Group
Click this button to add an axis group to the currently selected subplot.
Delete Axis Group
Click this button to delete the currently selected axis group.
Show Vertical Axis on Plot
Check this box to show the vertical axis for this access group on the current subplot.
Inverted
Check this box to have the scale on the vertical axis go from high to low values when moving
bottom to top along the axis.
Logarithmic
Check this box to use a logarithmic scale on the vertical axis of the current axis group.
Title
Check the Visible box to make the vertical axis title shown for the current axis group. Check the
Specify Color box and choose an desired color to specify a font color for the title. Specify the Font
Size and the actual title text in the box provided. Special strings may be entered, preceded by a '@'
symbol, which will be automatically interpreted as an appropriate string to place in the title.
@CTGName will display the appropriate contingency name
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@CASENAME will show the name of the case presently open.
@BUILDDATE will show the Simulator patch build date. @DATETIME will show the present date
and time.
@DATE will show the present date.
@TIME will show the present time.
Scale
Maximum
Check the box next to Automatic to have the maximum value on the scale automatically
determined based on the results or uncheck this box and specify the value manually. Check the
box next to Round to have the maximum value rounded when the Automatic checkbox is also
checked.
Increment
Specify the increment between scale markings. If zero is specified, the increment will be
determined automatically.
Minimum
Check the box next to Automatic to have the minimum value on the scale automatically
determined based on the results or uncheck this box and specify the value manually. Check the
box next to Round to have the minimum value rounded when the Automatic checkbox is also
checked.
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Transient Stability Analysis Plot Designer: Plot Series List
The Plot Series List sub-tab is available on the Transient Stability Analysis dialog on the Plot Designer
sub-tab of the Plots page. This tab provides information about the plot series contained in the axis
group that is currently selected in the Plots, Subplots, Axis Groups list found on the Plot Designer
sub-tab.

Axis Group Number
This is an informational field. Each axis group is assigned a number when it is created. The user
cannot change this value.
Add Axis Group
Click this button to add an axis group to the currently selected subplot.
Delete Axis Group
Click this button to delete the currently selected axis group.
Plot Series List Table
This is a case information display listing all of the plot series contained in the currently selected axis
group. Common options like color, thickness, and style that determine how a plot series is shown
are listed in this display and can be modified here. The same fields can be modified for a single
selected plot series on the Plot Series sub-tab.
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Transient Stability Analysis Plot Designer: Plot Series
The Plot Series sub-tab is available on the Transient Stability Analysis dialog on the Plot Designer subtab of the Plots page. This tab provides information about the plot series that is currently selected in
the Plots, Subplots, Axis Groups list found on the Plot Designer sub-tab.

Object plotted
This shows the object that is represented by the selected plot series. This is for informational
purposes only and cannot be changed here.
Field plotted
This shows the field that is represented by the selected plot series. This is for informational purposes
only and cannot be changed here.
Delete Plot Series
Click this button to delete the selected plot series.
Plot Series Visible
Check this box for the plot series to be shown on the plot.
Color
Click the color box or the Change button to select the color of the line drawn for the plot series.
Plot Series Type
Select whether the plot series should be shown by a Line Series or a Point Series. If shown by a
Point Series, the Point Attributes options will be enabled allowing selection of the style and size of
the points.
Line Attributes
These options will only be enabled if the Plot Series Type is a Line Series.
Style
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Solid, Dashed, Dot, Dash Dot, and Dash Dot Dot are the valid options for the line style.
Thickness
Set the thickness of the line.
Stairs
Select whether the line series should be drawn with No stairs, Stair, or Inverted stair. The stair
options connected successive points in a stair pattern instead of a straight line.
Symbol Every
Set this option to something other than zero if a symbol should be placed on the line for better
identification. Making this value larger will make the symbol placing less dense. Use the Point
Attributes options to define the style and size of the symbols.
Point Attributes
These options will only be enabled if the Plot Series Type is a Point Series or choosing to include
symbols on a Line Series by setting the Symbol Every option to something other than zero.
Style
This determines the shape of any plot series symbols.
Height
This sets the vertical size of the plot series symbols.
Width
This sets the horizontal size of the plot series symbols.

1594
©2011 PowerWorld Corporation

Transient Stability Dialog: User Interaction with Plots
The Plots page is found on the Transient Stability Analysis dialog.
A set of common user-interaction features with the plot has been implemented. To Pan on a chart,
simply right-click and drag on the plot. This will move the view up, down, left, or right depending on
which direction you drag the mouse. To zoom in on the plot, left-click and drag towards to the left and
form a square into which the view will zoom. To zoom out on plot left-click and drag towards the right
and the view will zoom back out to the default zoomed out view.
Navigating Around a Plot
Pan Around Plot
Right-click on the background portion of a subplot and drag with the mouse.
Zoom In
Left-click on the background portion of a subplot and drag down with the mouse.
Zoom Out
Left-click on the background portion of a subplot and drag up with the mouse. The view will
zoom back out to the default zoomed out view of the plot.
Data Information
Left-clicking on a plot series will provide information about the selected point. This will also be
shown in a hint which appears as you hover your mouse over a particular plot series.
Making Plot Series Visible
Below each subplot chart there is a key listing all of the plot series on that subplot. Check and
uncheck the box next to a plot series to make that plot series visible or not visible. (Note: after a
chart has more than 12 plot series, the legend is not drawn by default.)
Chart Local Menu
A local menu is available for the chart by right-clicking below the chart portion of a subplot, rightclicking on a plot series, or clicking the little drop-down arrow found in the bottom right-hand corner
of each subplot. (Note: Right-clicking on the region of the chart showing the plot series will not bring
up this menu because right-clicking activates the dragging on these charts.) The choices which
appear are as follows.
Print Preview...
Provides the ability to access a print options for the chart
Export...
Provides the ability to export an image of the chart to file types including an Enhanced Metafile,
Bitmap, JPEG, PDF, SVG, PNG, VML, or EPS
Copy
Will copy the image as a metafile to the Windows clipboard so that the image can then be pasted
into another program.
Export with Options
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Provides access to export images, but in addition provides access to export the data behind the
plot series to a text file, XML, HTML or Excel. To export data you must go to the Data tab on the
dialog which appears.
Advanced Options
Remember that the most common options available for plots and associated components are
discussed in the Plot Designer section.
There are a number of advanced options that are associated with a subplot. These advanced
options are only accessible through a local menu available with each subplot. These advanced
options can be saved or loaded from file.
Load Advanced Results
Choose this option to open a file which has the Advanced Options stored in it.
Save Advanced Result
Choose this option to save a file which has the Advanced Options stored in it.
Print All Charts and Title Block
Prints the current plot display
Copy All Charts and Title Block
Loads the current plot display onto the clipboard
Close All Plots
Closes all open plots.
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Transient Stability Transient Limit Monitors
The Transient Limit Monitors page is found on the Transient Stability Analysis dialog.
When running a transient stability simulation, the actual numerical results and plotting is useful, but
sometimes what you really want to know is if and when any particular Operating Standards were
violated. For example, tn the Western United States there are particular standards for voltage dips and
frequency deviations referred to as WECC Category B and WECC Category C standards. You can think
of this similarly to how Limit Monitoring works in traditional power flow based contingency analysis. In
traditional contingency analysis we do not report the voltage at every bus and the flow on every line
during each contingency. Instead we only report violations of limits, which greatly reduces the amount
of output data created by the tool.
In order to provide the ability to flag violations of these standards, PowerWorld has created an object
called a Transient Limit Monitor which provides a great deal of flexibility for allowing the simulation to
automatically monitor for these types of standards without requiring us to store the entire trace of
each monitored quantity. When creating a transient stability monitor, you choose a field for a
particular type of object and then build a description of what is considered a limit violation.
Defining Transient Limit Monitors
To define Transient Limit Monitors, look on the Transient Stability dialog under Transient Limit
Monitors and choose the Transient Limit Monitors option. When choosing this a case information
display listing the transient limit monitors will be shown. For more information see Transient Stability
: Defining Transient Limit Monitors.
Viewing Transient Limit Monitor Violations
While running a transient stability simulation, violations of the transient limit monitors defined will be
recorded and listed under the Transient Limit Monitors\Monitor Violations table on the Transient
Stability Analysis Dialog. Monitor Violations will be designated by which transient contingency caused
them so that when running multiple transient contingencies you will be able to see which
contingency caused the violation. It may be feasible for you to abandon storing all the transient
stability numerical results and instead only store the violations of the limit monitors. If violations are
found you can then revisit the run and store appropriate results. For more information on monitor
violations seeTransient Stability : Transient Limit Monitors Violations.
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Transient Stability : Defining Transient Limit Monitors
The Transient Limit Monitors page is found on the Transient Stability Analysis dialog.
When inserting a new transient limit monitor you are presented with the following dialog. This gives
you great flexibility in defining monitors for the various values which can be recorded in a transient
stability run. Note that there are some very simple Generic Limit Monitors for synchronous machines
which are define as part of the Transient Stability options that may also be of use.

In the top portion of the dialog you first give the transient limit monitor a name. There is then an
option to make a transient limit monitor Active or not. Below the middle of the dialog there is the
Action To Take options: Log Violation Only, Abort Simulation or Trip (Open) Device. The Log
Violation Only will show the violation only in the message log. The Abort Simulation will abort
simulation at a specified time after a violation of the monitor occurs. The Trip (Open) Device will
option to trip/open a device" if a monitoring violation occurs (this works for Buses, AC Lines,
Generators, Loads, and DC Lines). There is also a choice for Maximum number of violations of
this limit monitor to store. This is needed so that too many limit violations of the same limit
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monitor are not created. If you know the lowest 100 bus frequencies, you don't need any more than
that.
There are then choices to specify the device type and a filter which together will determine all
the objects which are ultimately monitored by the transient limit monitor. Note that a decision
regarding which objects meet the filter will be done at the start of a stability simulation based on the
steady state values of the power system. You then specify which field of the device type will be
monitored.
The top portion of the dialog describes which particular object/field pair traces are going to be
monitored. The bottom portion of the dialog will define what shape of the trace will be considered a
limit violation. For the basic limit monitor you specify three values: Limit Value, Limit Duration,
and Limit Type. These choices work together to determine what is considered a violation. Typically
limit types are Lower and a trace will be considered violated if the value is below the Limit Value for
a duration specified by Limit Duration. For a Upper limit type, then it must be above the Limit Value
instead. The choice for Meaning of the values specified affect how the Limit Value and values
specified for special triggers discussed shortly are interpreted. The first choice is Actual Value which
simply means the limit value represents the exact numerical value considered a violation. The other
choices are based on a deviation from the initial steady state value or a percent or percent deviation
from the initial value. As an example, for a system with a 60 Hz nominal frequency, the following are
equivalent: [Actual value = 59.6 Hz] and [Deviation from initial value = -0.4 Hz]. Similarly, when
monitoring a voltage the following are equivalent: [Percent of initial value = 70%] and [Percent
deviation from initial value = -30%]. Finally there is a option ABS: After using meaning, take
absolute value, which will take the absolute value of the value.
By default the transient limit monitoring does not start until after the last user-specified contingency
event occurs. This is done because values such as voltage will obviously be violating during a bus
fault (they'll be zero!), so what you really want to know is whether the voltage is below a value for a
specified duration after the fault clears. To change this default behavior, there are also special
options available by clicking on the Show Special Triggers to Start or Stop Transient Limit
Monitoring button which allow you to specify triggers for when the monitoring starts and stops.
These are shown in the dialog below. The values specified here will obey the choice for Meaning of
the values specified discussed above.

Built-In Transient Limit Monitors for WECC Standards
Simulator has built in the ability to automatically insert transient limit monitors which represent
WECC Category B and WECC Category C standards. This can be inserted going to the Transient Limit
Monitors case information display choosing the Records menu dropdown from the case information
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toolbar and then choosing the appropriate option for Build WECC Category B Standard
Monitors or Build WECC Category C Standard Monitors. Note that by default the WECC
Category B standard monitors are always inserted into a new power system case. The standards are
initially marked as Active = NO however so they must be set to Active = YES in order to use them.
The WECC Category B Standards create four transient limit monitors.





WECC Category B Voltage Dip for Non-Load Buses will monitor all non-load buses for any voltage

dip of 30% below the initial voltage value at any time.
WECC Category B Voltage Dip for Load Bus will monitor all load buses for a voltage dip of 25%
below the initial voltage at any time.
WECC Category B Voltage Dip for Load Bus Duration will monitor all load buses for a voltage dip of
20% below the initial voltage for a duration of 0.3333 seconds (20 cycles) and the dialog is shown
above.
WECC Category B Frequency will monitor all load buses for a frequency dip below 59.6 Hz for a
duration of 0.10 seconds (6 cycles) and the dialog is shown to the right as an example.

The WECC Category C Standards create three transient limit monitors.


WECC Category C Voltage Dip Any Bus will monitor all buses for a voltage dip of 30% below the
initial voltage at any time.




WECC Category C Voltage Dip Any Bus Duration will monitor all buses for a voltage dip of 20%

below the initial voltage for a duration of 0.6667 seconds (40 cycles).
WECC Category C Frequency will monitor all load buses for a frequency dip below 59.0 Hz for a
duration of 0.10 seconds (6 cycles).
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Transient Stability : Transient Limit Monitors Violations
The Transient Limit Monitors page is found on the Transient Stability Analysis dialog.
As a transient stability run is processed, any violations of the Transient Limit Monitors will be stored as
a monitor violation and can be seen in the Monitor Violations table. An example is shown in the
following case information display. Note that there is an option in the Records Menu for this object
to Make a New Plot. Choosing to make a new plot will automatically create a new plot definition on
the Plot Designer portion of the dialog.

The key fields for the Monitor Violations will be the Limit Monitor Name, Transient Contingency Name,
and the identity of the violated device. In addition to these keys, up to four additional points will be
reported. Each of these four points will be represented by a value and a time of value representing the
y-x point of the trace for that point. This gives up to 8 additional values. The four points are depicted
in the following figure.

A description of the four points are as follows.




Point A represents the initial time at which the trace has violated the Limit Value. When processing
the transient stability run, a monitor violation will not be generated at the point but the trace will
start to be tracked. Also note that as soon as the trace no longer violates the limit value, point A
will essentially be reset.
Once a Point A has been encountered and the trace is being tracked, a value/time pair for Point B
will be maintained as part of the result to indicate when the most extreme violation of the limit
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value occurs. Note that point B may occur before or after point C depending on the shape of the
trace.
Point C represents the time at which the trace completely violates the limit monitoring. At this
point the limit value has been violated for the appropriate limit duration. Once this violation occurs
then a Transient Limit Monitor Violation object will be generated for the results. Points A and B will
be stored at this point as well, although point B may be modified if the trace continues to get
worse. If the limit duration is zero, then point C and point A are the same point.
After the violation occurs, the tracking of the trace will continue to see if at a later time during the
simulation the value no longer violates the Limit Value. If this occurs then a Point D will also be
stored with the monitor violation object. This provides information about how long the value was
ultimately violated so that you know if you almost met the standard. For instance if you have a
limit duration of 0.3333 seconds (20 cycles) you might want to know the difference between a
violation that lasted 0.34 seconds and one that lasted 1.2 seconds.

1602
©2011 PowerWorld Corporation

Transient Stability Analysis: Results
The Results page is found on the Transient Stability Analysis dialog. This page provides a summary of
various results from a transient stability analysis run.

The Results page is divided into several sub-tabs:
Time Values from RAM
This page contains a table of all results selected with Results to Store to RAM. For details on this
display see Transient Stability Results: Time Values from RAM.
Minimum/Maximum Values
The Minimum/Maximum Values tab contains two lists: one of generators and one of buses. Each list
contains summary information for the objects. The bus list contains information about the maximum
and minimum voltage values and time. The generator list contains maximum and minimum
information about angles and frequency. Note that when the Process Contingencies option is set
to One Contingency at a Time, the list will only apply to the presently active contingency chosen
from the For Contingency drop-down menu. (See Transient Stability: Running Multiple
Contingencies.)
Summary
Time Solution Started
Time that the transient stability analysis started.
Time to Solve (Seconds)
Amount of computing time needed to solve the analysis.
Maximum Angle Difference (Deg)
Maximum angle difference between any two generator rotors at any time during the analysis.
Time of Max. Angle Diff. (Seconds)
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Analysis time at which the maximum angle difference occurred.
Newton Solution Results
This contains information about the Newton Solutions needed during the Simulation
Events
The Events tab will show a list of events which occurred during the stability run. The user-defined
transient contingency elements will be listed in the event list. In addition, any actions caused by the
action of a relay or motor tripping action of one of the stability models may be listed as an event.
Solution Details
This page provides some summary information about the Newton solution results.

1604
©2011 PowerWorld Corporation

Transient Stability Results: Time Values from RAM
The Time Values from RAM are found as a sub-tab under he Results page is found on the Transient
Stability Analysis dialog. The table lists values for each of the selected objects and fields as columns
and the various time steps as rows. Note that for time-step at which an event (such as a fault) occurs,
there may be multiple time steps listed showing the same time. The first listed time step will represent
the system state immediately before that time (T-) and the second listed time step will represent the
system state immediately after the events occur. There are also options along the left to choose which
fields to show as columns as well a column filtering options to use an advanced filter to limit the
columns. Finally there is an option to specify whether columns should be sorted first by Object then
Field or by Field then Object. This is all depicted in the following image.
Note that when the Process Contingencies option is set to One Contingency at a Time, the list will
only apply to the presently active contingency chosen from the For Contingency drop-down menu.
(See Transient Stability: Running Multiple Contingencies.)
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Transient Stability Analysis: States/Manual Control
The States/Manual Control page is found on the Transient Stability Analysis dialog. This page provides
a means to manually control a transient stability run and view generator and bus states at each step of
the process. It will be very helpful in determine which part of the system is causing an instability. It is
also helpful to look at initial State Limit Violations as described below. Also note that when you first
open the Transient Stability Dialog, Simulator does not immediately initialize the transient stability
simulation. This initialization obviously occurs when you start simulation, but it also occurs when you
switch to either the States/Manual Control or the SMIB Eigenvalues.
One particular good use of this section is to sort by the Derivative column under the All States sub-tab
to ensure of that the state derivatives are all near zero at the initialized system state. Note: many
induction motor states will never be exactly zero because their initial states must be determined by an
iterative process, but in general derivatives should be very near zero. Another good use of this section
is to look at the initial condition State Limit Violations.

Reset to Start Time
Click this button to reset the simulation back to the start time as specified on the Simulation Control
page.
Run Until Specified Time
Click this button to run to the specified Run Until Time. The Run Until Time should be set in
seconds. The simulation is run from the present time to this specified time. The current time is
shown in the Simulation Status field that is displayed at the top of the Transient Stability Analysis
dialog. The Run Until Time must be later than the present simulation time.
Do Specified Number of Timestep(s)
Click this button to run the specified Number of Timesteps to Do. The simulation starts at the
present time and does the number of timesteps. The current time is shown in the Simulation Status
field that is displayed at the top of the Transient Stability Analysis dialog.
Transfer Present State to Power Flow
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Click this button to transfer the present state resulting from the transient stability analysis to the
power flow model. The present state is not transferred to the power flow model when running the
transient stability analysis when not using the manual mode.
Restore Power Flow Model
Click this button to restore the power flow model to the pre-transient stability analysis state. This
option can be used when the transient stability state information has been transferred to the power
flow model.
Save Time Snapshot
Click this button to save the power flow model to file with the present transient stability results.
Transient stability results will only be saved if choosing a file type of either *.pwb or *.aux. If the
transient stability state has been transferred to the power flow model, the power flow model is first
restored to the pre-transient stability analysis state before saving.
All States
This sub-tab contains a list of every state in the dynamic simulation. The Value of each state is listed
along with the Derivative of the state.
State Limit Violations
This sub-tab contains a list of all the state limit violations in the initialized system.
Generators and Buses
This sub-tab contains a list of all the present terminal values for the generators and buses. These
are the same values you can see on the Transient Stability Data: Object Dialogs and include fields
such as Field Voltage, Rotor Angle, Accelerating MW, etc...
In the Generators sub-tab, in addition to getting all the present terminal values for the generators by
right-clicking on the Generator entries and choosing Save Two Bus Equivalent from the local menu,
you can save the Two Bus system from the selected bus to an infinite bus. When writing out this
two bus equivalent model, generators automatically set to AVR = NO In addition when saving the
Two Bus equivalent it can save a GENCLS model on the slack bus saved to represent an infinite bus.
Transient Stability YBus
This sub-tab displays the transient stability Y-Bus following the last transient stability analysis
timestep.
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Transient Stability Analysis: Validation
The Validation page is found on the Transient Stability Analysis dialog.
Because a transient stability simulation is a numerical integration of a set of equations, the numerical
integration imposes some restrictions on the input data in order to prevent numerical instability.
Numerical instability is instability caused not by the actual power system but by the limitations of the
computer algorithms used to perform numerical integration. Simulator provides the ability to both
validate the model and auto-correct many of the input values. These features are available on the
Validation portion of the Transient Stability Dialog as shown in the following figure. Clicking the Run
Validation button will run the validation and clicking the Run AutoCorrection button will modify
many of the input values. In Simulator running the auto correction will permanently change your input
data. Running both of these features will generate a list of validation errors, validation warnings, and
informational messages. Validation errors are typically related to time constants or machine reactance
values as discussed below. Validation errors may also appear for models which have been read in but
are not supported by the numerical integration. Validation warnings will appear for things such as a
generator model which has no machine model, a generator connected to a bus with zero voltage, or
for parameters outside of their expected range. Information messages also appear for parameters
outside of the expected range, and when using the Auto Correction tools messages regarding changes
to input values will appear.

Unsupported Models
Determine how to proceed if an unsupported transient stability model is defined for any element. An
error will prevent the transient stability analysis from running and provide a message. A warning will
set the status of any unsupported models to inactive and provide a message. No error or warning
will set the status of any unsupported models to inactive but provide no message.
Minimum time constant size as multiple of time step
For limits on time constants as discussed below, this the multiple of the time step used in the
validation routines.
Time of Last Validation
This shows the time that the last validation check was run. This time is either from the last time that
the process was run manually or part of the check done at the beginning of a transient stability
analysis run.
Errors: and Warnings:
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Provides a count of the number of errors and warnings that have been found. Errors will prevent the
transient stability analysis from being run.
Summary Tables
This page is divided into three sub-tabs: Validation Errors, Validation Warnings, and
Informational Messages. The Validation Errors page provides a list of any objects that have
errors and provides a description of the error. Any errors will prevent the transient stability analysis
from being run. The Validation Warnings page also provides a list of any objects that have
problems and provides a description of the error. The difference is that warnings are not considered
to be severe enough to prevent the transient stability analysis from being run. The Informational
Messages page lists objects and messages about any errors or warnings that have been autocorrected by the software.
Common Validation Messages
Minimum time constant size as multiple of time step
The most common limitations are on time constants in the various dynamic models. There are
several common restrictions on a time constant. For a simple integration block [1/(sT)], the time
constant must be greater than a specified multiple of the integration time step and cannot be
zero.
The second common type of restriction on a time constant, such as for a filter block [1/(1+sT)],
is similar except that it also allows the time step to be zero. If the time step is zero then the filter
block is ignored in the integration and results in an ignored state as discussed in Transient
Stability Numerical Integration.
A third common type of restriction applies across two different time constants such as for a leadlag block [(1+sT1)/(1+sT2)]. For a lead-lag block the denominator time constant must be
greater than a multiple of the time step. It can also be zero, but if it is zero, then the causality
requires that the numerator’s time constant also be zfero.
Model validation like this must be built into the software throughout to avoid numerical
instability; or as in the case of violating causality, we must avoid breaking fundamental laws of
physics. For Simulator our testing has shown that for most model time steps must be at least 2-4
times the integration time step when using our 2nd order Runga-Kutta numerical integration
technique.
Machine Model Reactance Validation
Another set of data which should be validated is related to the various reactance values of
synchronous machine models. These reactance values are specified on the d-axis and q-axis and
are referred to as synchronous reactance (Xd and Xq), transient reactance (Xdp and Xqp),
subtransient reactance (Xdpp and Xqpp), and leakage reactance (Xl). In order for the equations
which model the machine to be numerically stable, the reactance must obey the following
relationships: [Xl>Xqpp>Xqp>Xq] and [Xl>Xdpp>Xdp>Xd]. A violation of any of these
relationships can cause numerical instability and also just fundamentally does not make sense.
Despite this, these types of errors are very common.
When encountering models which do not obey these relationships, PowerWorld Simulator will
perform the following error checking, and when using auto-correction will make the following
changes to the input data.
if Xqp > Xq then Xqp = 0.8*Xq
if Xdp > Xd then Xdp = 0.8*Xd
if Xqpp > Xqp then Xqpp = 0.8*Xqp
if Xdpp > Xdp then Xdpp = 0.8*Xdp
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if Xl > Xqpp then Xl = 0.8*Xqpp
if Xl > Xdpp then Xl = 0.8*Xdpp
As a reminder though, running the auto-correction in Simulator will permanently change your
input data.
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Transient Stability Dialog: SMIB Eigenvalues (Single Machine Infinite Bus)
The SMIB Eigenvalues are found on the Transient Stability Analysis dialog.
The Single Machine Infinite Bus (SMIB) Eigenvalue Analysis is another model error checking tool which
was added to Simulator. In PowerWorld's own testing, this has proven invaluable while performing
model data input checking. The SMIB eigenvalue tool internally builds a dynamic model of one
generator connected to an infinite bus. All of that generator's dynamic models (machine model,
exciter, governor, and stabilizer) are included in this model. A linear matrix of all the dynamic states is
constructed at the steady state solution and eigenvalue and eigenvector analysis is run on this matrix.
These features are available on the SMIB Eigenvalues portion of the Transient Stability Dialog. To
generate these results, click on the Run SMIB Eigen Analysis button. After running the SMIB Eigen
Analysis, it is very useful to sort the results descending by the Max Eigenvalue column to show any
positive eigenvalues (as shown in the first figure below), or to sort ascending by Min EigenValue to
show negative eigenvalues with a large magnitude (as shown in the second figure below). Positive
eigenvalues represent potentially unstable system states, while very large negative eigenvalues
represent extremely fast system states which can cause numerical instability. Often times the large
negative eigenvalues will be caused by particular exciter models such as the EXST1_GE and REXS
models which contain extremely fast feedback loops. The particular models require special
consideration in the numeric integration algorithm because of this and are discussed more in the
Transient Stability Numerical Integration topic regarding sub-interval integration.
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In addition to getting the eigenvalue information by right-clicking on the SMIB entries and choosing
Show SMIB dialog from the local menu, you can open a dialog which shows you the A matrix and the
details regarding the eigenvalues and participation factors determined from the eigenvector analysis.
The participation factors indicate which particular system states are most contributing to the particular
eigenvalue. The following shows an example of the Eigenvalues for one of the generators which had a
positive eigenvalue.

In some testing this small positive eigenvalue always appeared for these hydro power plants. When
looking at the eigenvector analysis though it pointed us toward looking at the PI feedback look in the
PIDGOV governor model. In looking at the input data, it was seen that the Rperm (droop) of those
governors had a negative value which ultimately leads to an unstable governor. In this manner it
validated the SMIB tool as correctly showing the input data which led to the positive eigenvalue.
Also by right-clicking on the SMIB entries and choosing Save Two Bus Equivalent from the local menu,
you can save the Two Bus system from the selected bus to an infinite bus. When writing out this two
bus equivalent model, generators automatically set to AVR = NO In addition when saving the Two Bus
equivalent it can save a GENCLS model on the slack bus saved to represent an infinite bus.
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Transient Stability: Running Multiple Contingencies
Most of the help documentation discusses how Transient Stability Dialog functions when you are
simulating only a single transient contingency event. When changing the Process Contingencies
option to Multiple Contingencies instead, the dialog will change in small ways throughout. This topic
discusses how the dialog behaves differently when running multiple contingencies.
The ultimate goal of the transient stability tool is to run multiple potential transient contingencies to
determine if any violations of any standards has occurred. When running multiple contingencies, our
design goal was to make a transient stability run very similar to running a contingency analysis run
using repeated power flow solutions. The transient stability interface has been designed to provide the
ability to simulate and interact with multiple stability runs simultaneously. Obviously the speed of such
a simulation will be much slower than for contingency analysis, but the goal for the tool should be to
emulate the contingency analysis environment. These sections discuss three topics related to achieving
this goal: user interface implications, data storage, and the use of transient limit monitors.
General User Interface Changes
When choosing to process multiple contingencies, the Simulation portion of the Transient Stability
dialog into a form which looks very similar to PowerWorld's existing contingency analysis tool. At the
top will be a list of the transient contingency definitions with columns for the Start Time, End Time,
Cycles for Step, and Time Step. When you select a particular transient contingency from this list, the
list at the bottom of the dialog will show the particular elements which are part of the selected
transient contingency. This is shown in the figure below.

Also note that the States/Manual Control portion of the dialog is removed. The assumption is that
you will not want to manually step through a stability run a few time steps at a time if you're
running multiple transient contingencies. The Plots and Results (for viewing tabular result) are
changed when interpreting multiple contingency analysis runs. These will be discussed shortly.
Other portions of the dialog have very few changes. The Options do not change at all and will apply
to all transient contingencies. The Results Storage will also apply to all transient contingencies.
Validation and SMIB Eigenvalues only apply to the initial steady state system so they will also not
change. Transient Limit Monitors do not change because they apply to all contingencies and each of
the Transient Limit Violations always reference a particular transient contingency.
Plots for Multiple Contingency Results
The Plots portion of the Transient Stability dialog changes slightly when processing multiple
contingency results. By default, a dropdown allows you to choose for which transient contingency a
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plot will be drawn. When creating a plot for only one contingency the behavior is identical as
described in Section 6. You may also check the box Plot Multiple Contingencies which will modify
the behavior of plotting. When doing this you should then click the button Choose Contingencies
to Plot which brings up a list of all the Transient Contingencies defined in the case. This is all
depicted in the following figure.

On the list of contingencies there will be five new columns with values that may be specified and
whose affect is described as follows. Setting Show to YES will cause plot series for that contingency
to be generated. If a plot has 10 subplot series inside of it and you choose to show results for 4
transient contingencies, then the resulting chart will contain each of those 10 plot series for each of
the 4 contingencies and thus contain 40 plot series. Changing the Plot Color will allow each plot
series for that particular contingency to use this color, overriding what was specified with the plot
definition. Similarly the Dashed, Thickness, and Point Symbol may be changed with the resulting
attribute applied to all plot series for the particular contingency overriding what is specified with the
plot definition.
In this way you can generate a plot showing multiple traces from multiple transient contingency
simulations. An example is shown below of a state space plot for two different faults, with a different
color used for each contingency.
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Tabular Results for Multiple Contingency Analysis Simulations
Showing of tabular results was already extremely intricate for looking at only one transient
contingency event. At this time the user interface has not been designed to support viewing tabular
results for multiple transient contingency simulations simultaneously. As a result when going to the
Results portion of the transient stability dialog it will be modified slightly to provide a dropdown that
allows you to choose for which transient contingency to view results. This is shown in the figure
below. From this point the behavior is identical as described in Transient Stability Results: Time
Values.

1615
©2011 PowerWorld Corporation

Distributed Computing Add-Ons
The Distributed tools are available as an add-on to the base Simulator package. Contact
PowerWorld Corporation for more details. The us of Distributed tools in Simulator requires
the user of the SimAuto add-on as well
Some tools in Simulator have been enabled to use Simulator's Distributed Computing capabilities. In
order to use Distributed Computing a list of computers is provided to Simulator which are available for
distributed computing. This list is managed in one place in Simulator and applies to all tools in
Simulator that can be enabled for distributed computing. Tools which can use Distributed Computing
are as follows:





Contingency Analysis : can distribute groups of contingencies
Available Transfer Capability : can distribute multiple-scenario ATC calculations
Transient Stability : can distribute transient contingencies
QV Curves : planned for later release but not completed yet

Along with this list of computers, appropriate login authentication must be provided for each remote
computer to ensure that the Windows operating system security allows the remote processes to be
started and results to be passed back to Simulator. These passwords are then encrypted and
decrypted by Simulator using a Master Password as described below. For more technical details about
password security please contact PowerWorld.
Buttons commonly available for distributed computing are described as follows.
Insert Computer
Inserts a new computer into the list of computers available for distributed computing.
Verify Computers Available
Checks each computer in the list of distributed computing machines for availability, and sets
the Enabled, Available, and Cores fields accordingly.
Enter Master Password
Allows the user to enter the password used to decrypt all of the distributed machine login
credentials. If the master password has not been defined, then the user is asked to provide a
new master password.
Forget Master Password
Tells Simulator to forget the already entered master password. The user will not be able to
perform a distributed analysis until the master password has been re-entered.
Change Master Password
Tells Simulator to re-encrypt all credentials using a new master password.
Reset all authentication
Clears all authentication information including the master password and all distributed
machine login credentials.
To add login authentication information for a particular Distributed Computer, go to the Records
Menu or the right-click local menu under Distributed Computer records and choose the following
options.
Add or change authentication info...
Adds or changes login credentials for all currently selected distributed machines. If a master
password has not been defined, the user will be prompted to provide a new master password.
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If the master password has been defined but not entered, the user will be prompted to enter
the current master password.
Note: Adding authentication for the local machine is not needed and should not be provided.
If authentication information is added for the local machine it will result in an "Access is
denied" error from Windows.
Remove authentication info
Removes login credentials for all currently selected distributed machines.
The columns with the Distributed Computer List are as follows
Computer Name
Name of the computer on the local network.
Auth Info Stored?
Column will say YES if login authentication information is stored with this computer.
Processes
Specifies the number of processes which will be started on this when performing distributed
computer. For computers with multiple cores and/or multiple processors it may be
advantageous to execute multiple processes.
Enabled
Set this to NO to disable the use of this computer when using distributed computing. Set to
YES to use the computer.
Available
When the Verify Computers Available button is clicked, Simulator will determine this field
automatically. It shows whether the remote computer is available for use in distributed
computing.
Cores
Shows the number cores available on the computer.
# Errors
Shows the number of errors encountered when trying to use the computer for distributed
computing.
Max # Errors
Enter a number for the maximum number of errors which can be encountered with a
computer before the distributed computing will stop attempting to use the computer for
computation. By default this value is set to 1 because it is assumed that a failure will
Domain, Password, Username
Shows the domain, username, and password of the login information in an encrypted form.
These values can be saved and loaded from an AUX file in encrypted form but you must not
attempt to edit them directly. They must be encrypted and decrypted through the Master
Password at all times, thus to make changes to these you must use the Add or change
authentication info and Remove authentication info local menu buttons only. If
authentication fails then Simulator will not use the computer for distributed computing.
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Tutorial: Creating a New Case Page 1 of 13
This procedure describes how to create a simple power system model using PowerWorld Simulator.
This procedure was developed for use with version 13 and later of the package. If you have an earlier
version, please contact PowerWorld Corporation at info@powerworld.com for information on
upgrading, or visit the website at http://www.powerworld.com.

To begin, double-click on the PowerWorld Simulator icon.
This starts Simulator. Simulator is
used to create new cases, modify existing cases, and (of course) simulate power systems. In this
example, we will build a new case from scratch. To create a case from an existing power flow case
instead, please see Creating a Case from an Existing Power Flow File.
To create a new case, select New Case from PowerWorld icon
in the upper left corner of the
program. The screen background will turn white, the default background color for new PowerWorld
oneline diagram. Oneline diagrams are used in power system analysis to represent the actual threephase power system using a single line to represent each three-phase device.
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Tutorial: Inserting a Bus Page 2 of 13
The most important component of the power system model is the bus. Buses are used to represent
junction points in the power system where a number of devices are connected together. In building a
power system model using Simulator, you will draw buses onto the oneline diagram, attach devices
such as generators and loads to the buses, and connect different buses together with transmission
lines and transformers.
To insert a bus:



Select Network > Bus from the Individual Insert ribbon group on the Draw ribbon tab. This
prepares Simulator to insert a new bus.
Left-click on the oneline background at the location where you want to place the new bus. This
invokes the Bus Option Dialog (pictured below), which is used to specify the name, orientation,
shape, size, width, area, zone, and nominal voltage of the bus, as well as the load and shunt
compensation connected to the bus .
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The Bus Number field automatically displays ‘1’. Simulator requires that each bus have a unique
number. For convenience, accept the default value. Historically, the Bus Name field was limited to
eight characters. That limitation is no longer imposed in Simulator. Many users still choose to limit
the bus name to eight characters by convention and for ease in converting cases to other formats
(such as .epc or .raw). For this example, enter ‘One’.
Next, check the System Slack Bus field, which is located in the Bus Voltage portion of the Bus
Information Tab. The Slack Bus is a modeling construct that ensures that the power system has
enough generation to meet the load. In other words, the slack bus "picks up the slack" caused by
system losses or unbalanced generation and load.
Click OK on the Bus Option Dialog to finish creating the bus and to close the dialog. After the
dialog box closes, the new bus appears on the oneline at the location you specified.
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Tutorial: Inserting a Generator Page 3 of 13
Next we are going to attach a generator to the bus. Generators may be inserted in a manner similar to
inserting a bus:



Select Network > Generator from the Individual Insert ribbon group on the Draw ribbon tab.
Left-click the bus on the oneline diagram to which you want to attach the generator (for this
example, click on the slack bus – bus One.) The Generator Option Dialog (pictured below) will
automatically open. The dialog is used to specify the new generator’s unit identifier, display size,
orientation, MW output and limits, reactive power limits, set point voltage, and cost model.



Every generator must have a MW Output specified when the generator is inserted. Make sure the
MW and Voltage Control tab is selected. Enter ‘413’ in the MW Output Field. Note: the MW Output
specified for a generator connected to the system slack bus is arbitrary because the generator’s
true output depends on system load and losses.
Select the Display Information tab. The Orientation field is used to specify the direction the
generator will extend from the bus. The Anchored checkbox forces the generator to move with its
specified bus when repositioning the bus on the oneline.
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Click OK on the Generator Option Dialog to accept the default values for all other fields. After the
dialog box closes, the new generator will appear on the oneline attached to the previously selected
bus. The oneline diagram should resemble the image shown below.
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Tutorial: Saving the Case Page 4 of 13
To save the work that we have done so far, select Save Case from the Application Button, or click on
the Save Case
button. Before the case is saved, Simulator validates the case to make sure that it
does not contain any errors. Results from this validation are displayed in the Message Log display,
usually shown in the lower right-hand corner of the display. If the log is not visible, click the Log on
the Log group under Tools. Since we have not yet named the case, the Save As dialog is displayed.
Enter a file name and select OK. By default the case is saved using the PowerWorld Binary format
(*.pwb). When saving the case in the future, you will not have to reenter its name. Simulator also asks
you to supply a name for saving the oneline diagram we have been drawing. The oneline diagram files
have a default extension of *.pwd, which identifies them as PowerWorld Display files. Supply the same
name as you gave to the case. Note that, because the case and the oneline are stored in separate
files, multiple onelines can be assigned to the same case, and the same oneline can be used by many
cases.
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Tutorial: Entering a Second Bus with Load Page 5 of 13
To enter the second bus:





Select Network > Bus from the Individual Insert ribbon group on the Draw ribbon tab.
Click on the oneline diagram somewhere to the right of the first bus. In the Bus Options Dialog
(pictured below) leave the bus number at the default value of 2, and enter the name ‘Two’ in the
Bus Name field.
We will model a 200 MW, 100 Mvar load at the bus. Select the Attached Devices tab. Under the
Load Summary Information heading enter ‘200’ in the Base MW field and ‘100’ in the Base Mvar
field.
Click OK to accept all other default values, close the Bus Options Dialog, and insert the bus.

At this point, the oneline diagram does not show the load at bus 2, even though it is represented in
the power system model (you can confirm this by right-clicking on bus 2, selecting Bus Information
Dialog from the resulting local menu, and inspecting the Load Summary Information fields again).
To draw the load on the oneline diagram:



Select Network > Load from the Individual Insert ribbon group on the Draw ribbon tab.
Left-click in the center of this bus. The Load Options Dialog box (pictured below) automatically
opens. The Constant Power MW and Mvar fields confirm that the load is 200 MW and 100 Mvar. In
addition to constant power loads, Simulator also allows the modeling of voltage dependent loads.
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Select Up in the Orientation field under the Load Information tab to make the load point up. Verify
that the anchored box is checked to force the load to move with the selected bus.
Click OK to accept the default values for all remaining fields, close the Load Options dialog, and
insert the load. A circuit breaker symbol is automatically included with each load.

To move objects on the oneline:




Left-click on the desired object. Drag and drop the object to the new location by holding the left
mouse button down while moving the mouse. Note: you can also move all objects on the oneline
simultaneously by left-clicking on the diagram (not on a specific object) then dragging and
dropping in the desired location.
To move bus 2, left click on bus 2 (not on the attached load). Drag the bus to a new location. Note
that the load moves with the bus because it is anchored. You can change the location of attached
devices connected to a bus, such as generators and loads, by the same procedure.

The oneline diagram should now resemble the image shown below.
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Tutorial: Inserting a Transmission Line Page 6 of 13
Transmission lines are used to connect buses together. To insert a transmission line:







Select Network > Transmission Line from the Individual Insert ribbon group on the Draw
ribbon tab.
Left-click at the point where you want the new line to originate. This point is usually located on
one of the proposed line’s terminal buses. For this example, originate the line at bus One.
Transmission lines and transformers are drawn as a series of line segments. Without holding down
the mouse button, drag the mouse up. Notice that a line segment connected to the point of origin
will follow your mouse movements. To terminate a line segment, click the left mouse button. Each
time you click the mouse to terminate a line segment, a new vertex is defined for the line. To draw
the next line segment, move the mouse to the desired location of the next vertex. Note: the
vertices may later be moved or deleted to reshape the line. To create curved lines, hold the left
mouse button down while dragging.
To terminate the final line segment and conclude drawing the line, double click the left mouse
button at the desired termination point (bus Two for this example). The termination point is
usually the transmission line’s other terminal bus.
The Branch Options dialog automatically appears (shown below). The dialog should already
contain a 1 in the From Bus Number field and a 2 in the To Bus Number Field. If not, you probably
did not have the cursor directly on the bus when you were drawing the line. If this is the case,
simply enter the correct bus numbers in the corresponding fields.
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The Series Resistance, Series Reactance, and Shunt Charging fields are used to enter the per unit
parameters associated with the line. The Shunt Charging field contains the total per unit charging
capacitance for the line. Enter 0.02 in the Resistance field, 0.08 in the Reactance field and 0.1 in
the Shunt Charging field.
The Limit (MVA) fields contain the MVA ratings for the line; enter a value of 1000 in the Limit A
(MVA) field.
Click OK to accept all remaining field default values, close the Transmission Line/Transformer
Dialog, and insert the new line.

By default, the transmission line is anchored to both terminal buses. If you try to move bus 2, the
transmission line should move with it.
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Tutorial: Inserting a Line Flow Pie Chart on a Transmission Line Page 7 of 13
When the line is drawn it automatically it has a line flow pie chart included. You can include additional
line flow pie charts by selecting Pies/Gauges > Line Flow Pie Chart from the Individual Insert
ribbon group on the Draw ribbon tab, and then clicking near a line. The Line/Transformer Flow Pie
Chart dialog box appears (shown below). Make sure that the From Bus and To Bus have the correct
numbers, that the MVA rating is correct, and that Anchored is checked. You may change the size of
the pie chart by typing in a value or using the arrows.

Color and behavior of pie charts are set in the Oneline Display Options display; right-click anywhere in
the background of the oneline, select Oneline Display Options from the pop-up menu, then select the
Pie Charts tab (pictured below).
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Tutorial: Inserting Circuit Breakers Page 8 of 13
Circuit breakers are used to control the status of the line. (If the line already has circuit breakers at
each end, then Simulator has been instructed to insert circuit breakers automatically. You can
configure this option from the Default Drawing Options Dialog).
To insert a Circuit Breaker:




Click somewhere on the line near bus One then select Indication > Circuit Breaker from the
Individual Insert ribbon group on the Draw ribbon tab, then click on the line near bus One. You
should immediately see the Circuit Breaker Options dialog (shown below) with the From Bus and
To Bus fields correctly set to ‘1’ and ‘2’. If they are ‘0’, enter the correct value. Set the Size field to
‘1’ (you can either enter a 1, or use the spin arrows in change the value).
Click OK to insert the circuit breaker.

In Simulator, the location of the circuit breaker does not matter, because changing the status of the
circuit breaker changes the status of the entire line. However, since most transmission lines have
circuit breakers at each end, we will also place a circuit breaker near bus 2. To accomplish this, repeat
the above process near bus 2.
Save your case. Your oneline should now look similar to the image below.
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Tutorial: Inserting a Transformer Page 9 of 13
To insert a transformer we first need to insert a bus at a different voltage level. Insert a new bus in
the bottom of the oneline, named Three, and enter 69 KV for its nominal voltage in the Bus Options
dialog box.
To insert a transformer between buses 2 and 3:






Either go to Network > Transformer from the Individual Insert ribbon group on the Draw
ribbon tab.
Click on bus 2, and then draw a line to bus 3 as you did for a transmission line. The Branch
Options dialog automatically appears.

On the Parameters tab, enter 0.02 for Series Resistance, 0.08 for Series Reactance, 0.1 for
Shunt Charging and 1000 for Limit A (MVA).
Select the Transformer Control tab. Note that the Off-nominal Turns Ratio displays 1.000. The
true transformer turns ratio does not need to be specified as it is automatically determined by the
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ratio of nominal voltages between the From Bus and To Bus. The Off-nominal Turns Ratio is used
to adjust the transformer tap setting on per-unit values of bus voltages as referenced to their
respective base values for per-unit calculation.
Click OK to accept the default values, close the dialog and insert the transformer.
Repeat this procedure to add a transformer between buses 1 and 3.

Add a 400 MW, 200 Mvar load to bus 3:




Right-click on bus 3 and select Bus Information Dialog. Select the Attached Devices tab.
Click Add or Edit Bus Load.
Under Constant Power enter 400 in the MW Value field. Enter 200 in Mvar Value field. Click OK.
Note that Base MW and Base Mvar display the respective values. Click OK.

The load is now attached to the bus even though it is not displayed on the oneline. To display the load
as an object on the oneline, you can either use the Auto Insert feature or follow the procedure
utilized earlier. To Auto Insert the load:



Select Auto Insert > Loads… from the Quick Insert ribbon group on the Draw ribbon tab. The
Automatic Insertion of Loads dialog opens automatically.
Click OK to accept the default values and insert the load object on the oneline.

Note that Lines, Loads, Interfaces, Generators and Switched Shunts can all be inserted as objects on a
oneline using the Auto Insert tool if a record already exists for the device.




Left-click and drag the load to the desired location on bus 3. Note: you can resize the bus object
on the oneline by left-clicking on the bus then dragging either end-point vertex to the desired bus
size.
Right-click on the load and select Load Information Dialog. You can change the load
orientation and verify all load parameters in this dialog.
Click OK.

Next we are going to attach a 300 MW generator to the bus 3:





Select Network > Generator from the Individual Insert ribbon group on the Draw ribbon tab.
Left-click on bus 3. The Generator Option Dialog opens.
Select the Power and Voltage Control tab. Enter ‘300’ in the MW Output Field.
Click OK on the Generator Option Dialog to accept the default values for all other fields. After the
dialog box closes, the new generator appears on the oneline attached to bus 3.

Your oneline should now resemble the image shown below.
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Tutorial: Inserting a Switched Shunt Page 10 of 13
Switched shunts usually consist of either capacitors to supply reactive power (in MVAR) to the system,
or reactors to absorb reactive power. The switched shunts are represented by a number of blocks of
admittance that can be switched in a number of discrete steps. If at least one block is in service, the
shunt is said to be online. The shunt’s corresponding circuit breaker is used to determine and / or
toggle the switched shunt’s status.






To insert a switched shunt at bus 3, select Network > Switched Shunt from the Individual
Insert ribbon group on the Draw ribbon tab.
Click on or near bus 3. The Switched Shunt Options dialog box appears (pictured below).
Verify that the bus number is 3; if it is not, change it.
Enter 10 for the Nominal Mvar.
Click OK to accept the default values of the remaining fields, close the dialog, and insert the
switched shunt.

Your oneline should now look similar to the image below.
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Tutorial: Inserting Text, Bus and Line Fields Page 11 of 13
Informational fields can be entered directly on the oneline to allow for ease of monitoring when a case
is animating.
To insert a general text field:








Select Background > Text from the Individual Insert ribbon group on the Draw ribbon tab. Leftclick on the oneline in the desired text location to bring up the Text Object Dialog. (For this
example, left-click in the top center of the oneline.)
Type the string "First Case" in the Enter the text field. Click OK.
To format the text, ensure the text is selected on the one-line then select from the Formatting
ribbon group on the Draw ribbon tab. This displays the Font Tab of the Format Selection Dialog.
Set the font size to 26 and the font color to blue.
To change the text background color, select from the Formatting ribbon group on the Draw
ribbon tab, which summons the Line/Fill Options Tab . If the format menu is already open, click on
the Line/Fill Options Tab of the Format Selection Dialog. Check the Use Background Fill box to give
the text a white background, and then click OK.
Inserted text can be moved using the same method as any other object on the oneline

Fields can also display object-related quantities. By default, Simulator has inserted the bus names,
generator and load MW and MVAR, and switched shunt MVAR. For this example, we will add a Bus
Voltage Magnitude field to each bus and fields showing the power flow on the transmission line and
the transformers. Note that object fields can be formatted just like text fields by using the Format
menu.
To add additional fields to the display of a particular bus:



Right-click on the bus to bring up the bus’ local menu.
Select Add New Fields Around Bus from the local menu. This opens the Insert Bus Fields Dialog
(pictured below). You may add up to 8 fields per bus. Select the position where you would like to
add the new field (position 5 for this example) then click OK.
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This opens the Bus Field Options dialog (shown below); select the field Bus Voltage to add in the
selected position and click OK.
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The parameter and position are displayed as highlighted in the Insert New Fields dialog. Click OK.
Note that the specified bus field has been added to the oneline diagram.
Repeat this procedure for the other two buses. If necessary, you may move fields manually with
the mouse.

Fields can also be inserted using the Background > Field option from the Individual Insert ribbon
group on the Draw ribbon tab.
Next, we will insert fields showing the power flow at each end of the transmission line.


Select Field > Transmission Line Field from the Individual Insert ribbon group on the Draw
ribbon tab.

Line fields show information about transmission lines and transformers. For line fields, flow is always
specified at an end of the transmission line or transformer. The end is normally determined
automatically by the insertion point.









Left-click near both bus 1 and the transmission line between buses 1 and 2 in the location you
want the power flow text to appear. The Line Field Options dialog (shown below) opens
automatically.
The Near Bus and Far Bus fields should show 1 and 2 respectively. If they do not, enter the
correct values.
Select MW Flow then click OK. The field is displayed on the oneline in the location you specified.
Note that the field can be moved and formatted as previously discussed.
Select Field > Transmission Line Field from the Individual Insert ribbon group on the Draw
ribbon tab.
Left-click near both bus 2 and the transmission line between buses 1 and 2 in the location you
want the power flow text to appear. The Line Field Options dialog (shown below) opens
automatically.
Now the Near Bus and Far Bus fields should show 2 and 1 respectively. If they do not, enter the
correct values.
Select MW Flow then click OK.
Repeat the procedure to insert Mvar Flow fields for the two locations.

We also desire to monitor the MW and Mvar flows on the lines joining buses 1 and 3 and buses 2 and
3 via the transformers. The same commands are used as those used to insert fields for the
transmission line.



Repeat the above steps to insert MW (and Mvar) Flow fields on the lines joining buses 1 and 3
and buses 2 and 3 via the transformers.
At this point, your first oneline diagram should resemble the one shown below.
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Save the case.
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Tutorial: Solving the Case Page 12 of 13
To solve a case, you must be in run mode:


Click on Run Mode button in the Mode ribbon group. Note that if the case has validation errors a
warning will appear. You will need to rectify the problems before you can enter Run Mode. Some
validation warning may also appear in the message log.



Press the Play
button in the Power Flow Tools ribbon group on the Tools ribbon tab to
begin the simulation. Alternatively, to perform a single Power Flow Solution, click the Single
Solution - Full Newton button in the Power Flow Tools ribbon group on the Tools ribbon tab.
Your case should look similar to the case shown below. If it does, congratulations! You have
completed building your first case.

Try clicking on the load circuit breaker to toggle the load’s status. A solid red circuit breaker indicates
that it is closed, a hollow green box indicates it is open. While the simulation is running, click on the
circuit breakers and note the nearly instantaneous change in system flows. If the Log window is
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visible, you will get a "backstage" view of what Simulator is doing. Feel free to close the log. To reopen the log, click the Log button in the Log ribbon group on the Tools ribbon tab.
With the load circuit breaker closed, open the circuit breaker between bus 3 and its connected
generator. Now open any of the transmission line or transformer circuit breakers.
Congratulations, you’ve just blacked-out your case!
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Tutorial: Adding a New Area Page 13 of 13
Next, we will create a second operating area for the case. Large interconnected systems usually have
a number of control areas, with each control area responsible for the operation of a particular part of
the system. Often, a single control area corresponds to a single owner (such as an investor-owned
utility), but it is not unusual for a single control area to have more than one owner. Control areas are
connected to neighboring areas through tie lines. A tie line is a transmission line that has one end in
one control area and the other end in another. The total amount of power flowing out of a control area
is the algebraic sum of the power flowing out on all the area’s tie lines. Each control area is
responsible for procuring enough power to meet its own load plus losses. The control area can get this
power either by generating it itself, or by buying it from another area. This ability to buy and sell
power (i.e., power transactions) is one of the principal advantages of interconnected operation.
To create another control area:




Change to Edit Mode. Right click on bus 3 and select Bus Information Dialog from the drop
down menu.
Entering a number for an area that does not already exist automatically creates a new area. Enter
‘2’ in the Area Number field. Enter ‘TWO’ in the Area Name field. Click OK.
To verify that the case now has two areas, select Case Summary from the Case Data ribbon
group on the Case Information ribbon tab. The Case Information Displays allow you to view the
entire case using non-graphical displays. The Case Summary dialog (shown below) shows the
number of buses, generators, lines/transformers, and control areas in the case. You cannot modify
any of these values.

Now we will make sure that both of the control areas are initially set as being on automatic generation
control (AGC). AGC insures that the generation in the area is equal to the load plus losses plus and
scheduled transactions.
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Select Case Information > Aggregation > Areas. The Area display (pictured below) provides
a convenient summary of all the control areas in the case. Similar displays exist for buses,
generators, lines/transformers, etc.



Right-click anywhere on the record for the first area and select the Show Dialog option. The Area
Display Dialog is shown (as below).
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Change the Area Name to ‘One’ and set the AGC Status under Area MW Control sOptions to
Economic Dispatch Control. Select SAVE to save this information.
Next click on the up arrow next to the right of the Area Number field. This displays the Area
Record dialog for the next area. Set the AGC Status to Economic Dispatch Control, and select
OK to save your changes and close the dialog.
Note the AGC Status field in the Area Records Display now shows ED in the AGC Status fields.
Close the Area Records display.
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Starting with an Existing Case Page 1 of 15
This procedure describes how to create a power system model from an existing power flow file using
PowerWorld Simulator. This tutorial assumes that you have at least some familiarity with PowerWorld
Simulator. If you need a more general introduction, please see Creating a New Case tutorial.
PowerWorld cases can be easily created from existing power flow cases stored in PTI RAW versions
23-30, GE PSLF text format (EPC version 11.X and later), and IEEE common format.
Simulator provides a static model of a power system. The power flow data is a subset of the system
model. For some studies this model is sufficient. For other studies the model needs to be augmented
by adjusting: generator cost information, the reactive capability curve, PowerWorld Simulator case
options, interface definitions, injection group definitions, contingency definitions, the time variation of
the load, etc….
To begin, double-click on the PowerWorld Simulator icon. This starts Simulator. In this example we will
be building a case from an existing power flow file.
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Tutorial: Loading an Existing Power Flow File Page 2 of 15
Once Simulator has been started, set Simulator to Edit Mode by clicking on the Edit Mode button.
Select Open Case from the Application Button. An Open dialog box will appear on the screen. To
select a power flow file, click on the Type of File field in the lower left hand corner of the dialog box.
A list of file formats will appear. Choose the appropriate format, and the available files of the type
selected will appear in the box above Type of File. Choose the desired file from the list of available
files and select OK. In this example, we will be building a oneline for the 3990 bus MAIN 1998 summer
case saved in PTI version 23 format as mdb98s.raw. When prompted to create a oneline, select ‘yes’.
Your display should immediately turn white. This shows the blank background upon which you will be
drawing the oneline diagram for your case. Onelines are used in power system analysis to represent
the actual three-phase power system using a single line to represent each three phase device. The
information from the power flow file is now accessible to Simulator.
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Tutorial: Case Information Displays Page 3 of 15
Simulator presents many different Case Information Displays to provide a text-based view of the case.
For example, to view or modify the description of the case, select Case Description from the Case
Data ribbon group on the Case Information ribbon tab. The Case Description Dialog should
appear, showing the text description of the power flow case. In PowerWorld, this text description may
be arbitrarily long.
You can also obtain a case summary by selecting Case Summary from the Case Data ribbon group
on the Case Information ribbon tab. The summary dialog will appear. It provides a summary of the
case and of the total case load and generation. None of the fields in this dialog can be changed, as
they are intended for informational purposes only.
The Area/Zone Filters information display is another important article. The Area/Zone/Owner Filters
feature restricts the contents of other case information displays to certain areas or zones. This is
particularly useful for large cases. Open the Area/Zone Filters display by selecting Area/Zone Filters
from the Case Information ribbon group on the Case Information ribbon tab. As with all Case
Information Displays, you can click on a column heading to sort the list on a particular field; click on
that same column heading again to reverse the sort order. To change a particular area’s area/zone
filter status, simply left-click on the area’s area/zone filter status field. To change the filter status for all
areas in the case, right-click on the display to bring up its local menu (all case information displays
have a local menu), and select either Toggle All Yes or Toggle All No.For our example, set all areas
to ‘no’ except WUMS.
Another important text-based display is the Power Flow List. The power flow list shows the complete
power flow information for all areas whose area/zone filter is set to ‘yes’. To display the power flow
list, select Power Flow List from the Case Data ribbon group on the Case Information ribbon tab.
The power flow list has other options that can be accessed by right-clicking anywhere on the list. If
you wish to view more details about a particular device, you can do so by holding down the Ctrl key
and left-clicking on the device. To move through the list of buses, you can use the arrow keys or the
scroll bar. If you are viewing a particular bus and you wish to view a bus connected to it, double-click
on the line connecting the two buses to view the flows at the other bus. Note that some of the
transmission lines have a circuit identifier of ‘99’. Whenever a ‘99’ is used for an identifier, it usually
means that the transmission line is an equivalent line.
A shorter version of the power flow list can often be more useful. Such a display is offered by the
Quick Power Flow List. The Quick Power Flow List is similar to the power flow list except that it shows
flows at individual buses or a set of buses, regardless of area/zone filter settings. You can view flows
at any bus in the case. To display the quick power flow list, select Quick Power Flow List from the
Case Data ribbon group on the Case Information ribbon tab. Identify the buses of interest In the Bus
Number field by entering the number of either a single bus, a set of buses separated by commas, or
a range of buses specified using a hyphen. Again you can double-click to move to a desired bus, or
choose Show Object Dialog from the display’s local menu to see the information dialog for any
object.
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Tutorial: Solving the Case Page 4 of 15
To solve the power flow case we have been using in this example, press the Single Solution - Full
Newton button in the Power Flow Tools ribbon group on the Tools ribbon tab, or press the Single
Solution icon on the Quick Access toolbar. You may wish to show the Message Log before you solve
the case so as to monitor the solution process. When you choose to perform a Single Solution, the
application automatically switches to Run Mode if it is not already there. The system has initial
mismatches because of voltage truncation in the power flow file. The case should converge quickly,
perhaps in 2 or 3 iterations. After the single solution has been performed, Simulator now has the
solved power flow in memory, and you are ready to build the oneline.
It is not necessary that the power flow case be solved before you create the oneline. However, we
recommend that you solve the existing case first to make sure that it is valid.
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Tutorial: Building Onelines Page 5 of 15
PowerWorld Simulator makes the power system case easier to analyze by presenting results visually
using a oneline diagram. You do not need to represent every bus in the power flow model on the
oneline; a oneline diagram need be created only for the desired portion of a system under study.
Simulator can automatically link the constructed oneline diagram to the existing power system model.
The following sections of this tutorial will discuss placing various visual components onto a oneline
diagram. In all of the following sections the actions described will relate to the aforementioned MAIN
example.
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Tutorial: Entering a Bus Page 6 of 15
The most important component of the power system model is the bus. Buses are used to represent
junction points in the power system where a number of devices connect together. To build a oneline
diagram, you draw the buses, attach devices such as generators and loads to the buses, and connect
the buses together with transmission lines and transformers.
To begin entering devices onto the blank oneline, you must first switch to Edit Mode. If you are not
already in Edit Mode, switch back to Edit Mode now. Show the Quick Power Flow List and move it
towards the bottom of the screen. Show bus 39820 by typing that number in the Bus Number field.
Select Network > Bus from the Individual Insert ribbon group on the Draw ribbon tab. Click on the
oneline towards the top center to define the point at which the new bus will be added. The Bus
Information Dialog will appear. In the Bus Number field enter 39820. Select Find by Number to
view the bus information. You should see the information appear in the Bus dialog fields that
corresponds with the MAIN power flow case. Select OK to place the bus. The bus should now appear
on your screen.
If it has not already been done for you automatically, add a bus field identifying the new bus’ number
immediately to the left of the new bus. To do this, click on or to the left of the display object that
represents bus 39820 and select Field > Bus Field from the Individual Insert ribbon group on the
Draw ribbon tab. The Bus Field Options Dialog will appear for you to fill out. Designate the type of field
as Bus Number and close the dialog. Simulator will add a text object showing the bus number at the
point where you had clicked.
Repeat this procedure to place buses 39881 and 39821 on the oneline, along with their bus numbers.
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Tutorial: Automatic Line Insertion Page 7 of 15
Transmission lines between buses can be inserted manually by choosing Network > Transmission
Line from the Individual Insert ribbon group on the Draw ribbon tab and clicking on the beginning
bus. Vertices may be defined along the way by clicking the mouse on the diagram where vertices
should appear. However when creating a case from an existing power flow file, you also have the
option to insert transmission line display objects automatically. To do this, select Auto Insert >
Lines from the Quick Insert ribbon group on the Draw ribbon tab. Accept the default options and click
OK. The lines joining the visible buses on the display are automatically added, along with circuit
breakers and pie charts, provided those options are set. Simulator will draw only transmission lines
that link buses that have already been drawn on the oneline diagram. If you add another bus to the
diagram, you can again auto-insert lines, and Simulator will only insert lines that are not already
present on the display.
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Panning and Zooming Page 8 of 15
Two features of Simulator are indispensable when you have a large, detailed oneline: panning and
zooming. To pan from side to side or up and down, either use the arrow keys or the scrollbars on the
sides of the oneline. To zoom in or out of the oneline, hold the Ctrl key down and press the up arrow
to zoom in and the down arrow to zoom out. For the example, pan up and insert buses 39819 and
39841, again with bus fields showing their numbers. Again use Auto Insert > Lines from the Quick
Insert ribbon group on the Draw ribbon tab to add the transmission lines.
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Tutorial: Adding Background Page 9 of 15
Sometimes you may wish to insert background elements on a oneline such as bodies of water or state
lines to convey geographic location. To show static background elements on the oneline, select
Background > Background Line from the Individual Insert ribbon group on the Draw ribbon tab.
Click on the diagram to start the background line, and click at other points on the diagram to add
segments. Double click to terminate the background line. If you wish to fill in the area inside the
background line or change the background line’s color, select the background line and choose
Line/Fill
from the Formatting ribbon group on the Draw ribbon tab and make the appropriate
choices in the resulting dialog. You may wish to experiment now with drawing background lines or
objects and with adding fill color. Additionally, some political and geographic borders can be inserted
by selecting Auto Insert > Borders from the Quick Insert ribbon group on the Draw ribbon tab.
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Tutorial: Simulating the Case Page 10 of 15
Once you have constructed a oneline diagram showing the area of interest, you can simulate the case.
Simulator does not only show the magnitude and direction of flows on transmission lines, but can also
animate them. To configure the animated flows, switch to Edit Mode and choose Oneline Display
Options from the Active ribbon group on the Onelines ribbon tab. This dialog box also allows you to
change the size, density, and fill color of the animated flows for easier visualization. At this point, just
click OK. Next, save your case by selecting Save Case from the Application Button or by pressing the
Save Case
button on the Quick Access Toolbar. If you have not already saved the case, a Save
As dialog will prompt you to select a name. Both the oneline diagram and the case will use this name.
To begin solving and animating the load flow solution, switch to Run Mode and then press the Play
button in the Power Flow Tools ribbon group on the Tools ribbon tab. You should now see Simulator
modeling the 3990-bus case.
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Tutorial: Run-time Object Dialogs Page 11 of 15
While the animation ensues, you might want to view or change some study parameters. To do this,
first pause the animation. (Note that you do not have to pause the animation to tweak parameters.
You can adjust anything in the case while the animation runs, too.) Then, right-click on any of the
objects on the display, and choose Show Dialog from the popup menu. This will bring up the run-time
dialog for the object. Many of the parameters on this dialog can be modified, and the new settings will
take effect when the animation is restarted.
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Oneline Local Menu Page 12 of 15
Several options are available at run time from the oneline diagram’s local menu. To call up the menu,
right-click on an empty portion of the oneline. The local menu will appear. Use it to print the oneline,
save it as a metafile, or copy it to the clipboard. You can also find a particular bus on the oneline,
access panning and zooming options, set oneline display options, view information about the power
system area in which you clicked, create a contour plot, and use the difference flows activity, all from
the oneline local menu.
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Tutorial: Area Page 13 of 15
Often, system data is most conveniently displayed by area. To view the Area Records Display, select
Aggregation > Areas from the Model Explorer. The resulting display summarizes information about
all the areas in the case. You can sort the entries by clicking on the column labels.
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Limit Violations Page 14 of 15
You can view a report of limit violations by selecting Limit Monitoring Settings from the Other
Tools ribbon group on the Tools ribbon tab. A display showing bus voltage violations, line/transformer
violations or interface violations will appear. To show only violations, select Violating Elements from
the Elements to Show options. If the Use Area / Zone Filters on List Displays is checked, then
the displayed violations will correspond only to areas whose Shown field is set to Yes on the
Area/Zone/Owner Filters display.
If you wish to see more information on a bus that appears in the violation list, right-click on the bus
number and select Quick Power Flow List from the resulting local menu. If the Case Information
Display is set to refresh automatically, the list of bus voltage violations will update as new violations
occur.
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Other Case Information Displays Page 15 of 15
In addition to the few displays discussed in this tutorial, Simulator offers many other Case Information
Displays. In most cases, you can view information about buses, generators, lines, transformers, loads,
and zones simply by right-clicking on the object in question and choosing the appropriate option from
the object’s local menu. The best way to become more familiar with the displays and the information
contained in them is simply to play with a Simulator case and oneline. Simulator’s interface has been
designed to be simple and intuitive. If you run into problems, consult the On-line Help for assistance.

1661
©2011 PowerWorld Corporation

Tutorial: Solving an OPF Page 1 of 6
Note: The OPF option in PowerWorld Simulator is only available if you have purchased the
OPF add-on to the base package. Please contact PowerWorld Corporation at
info@powerworld.com or visit the website at http://www.powerworld.com for details about ordering
the OPF version of Simulator.
The PowerWorld Simulator (Simulator) is an interactive power system simulation package designed to
simulate high voltage power system operation. In the standard mode, Simulator solves the power flow
equations using a Newton-Raphson power flow algorithm. With the optimal power flow (OPF)
enhancement, Simulator OPF can also solve many of the system control equations using an Optimal
Power Flow algorithm. Specifically, Simulator OPF uses a linear programming (LP) OPF
implementation.
The purpose of an OPF is to minimize an objective (or cost) function by changing different system
controls, taking into account both equality and inequality constraints. These constraints are used to
model the power balance constraints and various operating limits.
In Simulator OPF, the LP OPF determines the optimal solution by iterating between solving a standard
power and then solving a linear program to change the system controls to remove any limit violations.
See OPF Primal LP for more details.
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Tutorial: OPF Three Bus Example Page 2 of 6
For this tutorial, we will start with a provided three-bus case (B3LP) found in the
PowerWorld\Simulator\Sample Cases directory. Bus 1 is the system slack bus. All buses are connected
via 0.1 pu reactance lines, each with a 100 MVA limit. There is a single 180 MW load at bus 3. The
generator marginal costs are:




Bus 1: 10 $/MWhr; Range = 0 to 400 MW
Bus 2: 12 $/MWhr; Range = 0 to 400 MW
Bus 3: 20 $/MWhr; Range = 0 to 400 MW

To begin:







Load B3LP case.
Verify the above system specifications by right clicking on each line, bus, and generator and
selecting its respective Line/Bus/Generator Information Dialog from the drop down menu.
Select Run Mode.
To be included in the OPF, all required area AGC status fields must be selected to OPF. To set area
AGC to OPF: Select OPF Case Info > OPF Areas from the OPF ribbon group on the Add Ons
ribbon tab. The OPF Area Records display automatically opens. Verify the AGC Status field is set to
OPF. If it is not, double click on the field to change its value. Close the OPF Area Records display.
Select Add Ons > Primal LP from the OPF ribbon group on the Add Ons ribbon tab to solve the
case. Note: line limits are not initially enforced.

Your display should look similar to the following:

B3LP Solved Using Add Ons > Primal LP
Note the line from Bus 1 to Bus 3 is overloaded and that all buses have the same marginal cost.
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Tutorial: OPF Line Limit Enforcement Page 3 of 6



Select OPF Case Info > OPF Areas from the OPF ribbon group on the Add Ons ribbon tab.

The Branch MVA column specifies whether or not the MVA limits should be enforced for transmission
lines and transformers that have at least one terminal in this area. For a transmission line or
transformer to be included in the OPF constraints, Line/Transformer constraints must not be disabled
on the OPF Options and Results Dialog, and the individual line/transformer must be enabled for
enforcement on the OPF Line/Transformer MVA Constraints display.





Double click on the Branch MVA field to change the value to YES. Close the OPF Area display
Select OPF Options and Results from the OPF ribbon group on the Add Ons ribbon tab.
The LP OPF Dialog opens automatically. Select the Constraint Options tab then click Disable
Line/Transformer MVA Limit Enforcement to remove the checkmark.
Click Solve LP OPF then click OK.

B3LP Solved with Line Limit Enforcement Enabled
The LP OPF re-dispatches to remove the line limit violation. Bus marginal costs have changed from the
initial example. The new bus marginal cost at Bus 3 is 14 $/MWh. To verify this:



Increase the load at Bus 3 by 1 MW. Right click on the load, enter "181.0" in the Constant Power /
MW Value field in the Load Options dialog. Click OK.
Select Primal LP from the OPF ribbon group on the Add Ons ribbon tab.

The Total Cost increased to 1935 $/hr from the previous value of 1921 $/hr, a difference of 14 $/hr
when Bus 3 load was increased by 1 MW.
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Tutorial: OPF LMP Explanation Page 4 of 6
Explanation of Bus 3 LMP = 14 $/MWh (from previous page):

B3LP Solved with Line Limit Enforcement Enabled
All lines have equal impedance. Power flow in a simple network distributes inversely to impedance of
the path.




For Bus 1 to supply 1 MW to Bus 3, 2/3 MW will take the direct path from 1 to 3, while 1/3 MW
will take the path from 1 to 2 to 3.
Likewise, for bus 2 to supply 1 MW to Bus 3, 2/3 will go from 2 to 3, while 1/3 will go from 2 to 1
to 3.
To supply one additional MW to Bus 3, we need the change in power of generator 1 (Pg1) plus the
change in power of generator 2 to equal 1 MW.
Pg1 + Pg2 = 1 MW



With the line from 1 to 3 limited, no additional power flows are allowed on it.
(2/3)Pg1 + (1/3)Pg2 = 0



Solving the above system of equations results in:

Pg1 = -1 MW and Pg2 = 2 MW
cost = (Pg*LMP) = [(-1 MW)*(10.00 $/MWh) + (2 MW)*(12.00 $MW/h)] = 14.00 $/hr
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Tutorial: OPF Marginal Cost of Enforcing Constraints Page 5 of 6
Similar to the bus marginal cost, you can also calculate the marginal cost of enforcing a line constraint.
For a transmission line, this represents the amount of system savings that could be achieved if the
MVA rating was increased by 1.0 MVA.


Select OPF Case Info > OPF Lines and Transformers from the OPF ribbon group on the Add
Ons ribbon tab. The OPF Constraints Records dialog opens.

Note the column displaying MVA Marginal Cost displays 6.0 for the line from Bus 1 to Bus 3. This is
determined based on the following:


With no change in system load:
Pg1 + Pg2 = 0



If we allow one additional MVA to flow on the line from Bus 1 to Bus 3:
(2/3)Pg1 + (1/3)Pg2 = 1



Solving the above system of equations results in:

Pg1 = 3 MW and Pg2 = -3 MW
cost = (Pg*LMP) = [(3 MW)*(10.00 $/MWh) + (-3 MW)*(12.00 $MW/h)] = -6.00 $/hr, a net
savings of 6.00 $/hr.
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Tutorial: OPF Unenforceable Constraints Page 6 of 6
Next we will consider a case with unenforceable constraints. To begin, increase the load at Bus 3 to
250 MW then run the LP OPF again:



Right-click on the load at Bus 3. Enter 250 in the Constant Power / MW Value field.
Select Primal LP from the OPF ribbon group on the Add Ons ribbon tab.

B3LP with Bus 3 Generator Carrying Load
Note that the transmission lines connecting Bus 3 to the other buses are both at their respective MVA
limit and that the generator at Bus 3 is supplying the load in excess of the transmission line limits.
Next we will open the generator at Bus 3 thereby inserting an unenforceable constraint:



Left-click on the red breaker symbol connecting the generator to Bus 3 to open the breaker.
Select Primal LP LP from the OPF ribbon group on the Add Ons ribbon tab.
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B3LP Solved with Unenforceable Constraints
Both constraints cannot be enforced. If a constraint cannot be enforced due to insufficient controls,
the slack variable associated with enforcing that constraint can not be removed from the LP basis.
Note the new LMP value for bus 3 exceeds 1000 $/MWh. The marginal cost depends on the arbitrary
cost of the slack variable. This value is specified in the Marginal Violation Cost field of the Add Ons >
OPF Options and Results dialog. See OPF Options and Results dialog for more details.
Additional Example
To see another OPF example select PowerWorld Simulator Add-on Tools > Optimal Power
Flow (OPF) > Examples from the table of contents in the on-line help file.
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Tutorial: Contingency Analysis
This tutorial will walk you through the basic commands necessary to insert contingencies and have
Simulator automatically analyze the results. Please see Introduction to Contingency Analysis for the
necessary background information regarding the capabilities and uses of the Contingency Analysis
tool.
For this tutorial, we will use an existing 7-bus case.




Open case B7SCOPF from the Program Files/PowerWorld/Simulator/Sample Cases directory.
Ensure Simulator is in Run Mode.
Select Contingency Analysis from the Run Mode ribbon group on the Tools ribbon tab.
Simulator opens the Contingency Analysis Dialog.

The next section of the tutorial discusses Defining Contingencies and provides an example of
inserting a single element contingency.
1 2 3 4 5 6 7 8 9 10 11
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Functions and Operators, 162, 163, 164, 165

Filter, 33, 138, 142, 152, 153, 154, 155, 158,
160, 161, 176, 647, 945

G

Find, 134, 137, 172, 801

Gauges, 42

Find Branches that Create Islands, 934

gcd, 89

Find Dialog, 172

gcp, 88

Find Records, 134
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General, 489, 622, 654

310, 312, 393, 396, 400, 452, 453, 456, 457,
459, 462, 463, 466, 689, 713, 714, 785, 838,
924, 943, 963, 964, 1095, 1174

General Script Actions, 22, 489, 622
Generation Chart, 680

Generic Model Fields, 757

Generation Shift Factor, 996

Geographic Data View, 193

Generation Shift Factor Sensitivities, 996

Geographic Data View Styles, 200

Generator, 90, 233, 235, 236, 237, 239, 241,
297, 299, 301, 302, 305, 307, 308, 309, 310,
312, 393, 395, 398, 400, 401, 827, 943, 964,
1174

Geography/Coordinates, 857

Generator Capability Curves Format, 88

Get Column Metrics, 151

Generator Cost, 233, 237

Get Parameters, 1406, 1408, 1410, 1412,
1414, 1416, 1417, 1419, 1422, 1475

Fields and Attributes, 195
General Display Options, 199

Generator Cost Curve Data Options, 89
Generator Cost Data Format, 89

GetParametersMultipleElementFlatOutput
Function, 1421

Generator Costs, 241

Getting, 19

Generator Cubic Cost, 239

Started, 19

Generator Display Objects, 713

GIS, 854, 855, 856, 858, 865, 867, 868, 870

Generator Economic Curves, 235
Generator Field Information, 299

Great Circle Distance Calculation, 855

Generator Fields, 299, 714, 809

Map Projections, 850
GIS Shapefile Data, 859, 861, 862, 863

Generator Information, 301, 305, 308, 309,
393, 395, 398, 400, 401

Control, 859

Area, 308, 401

Format, 862

Costs, 305, 398

Identify, 860

Owner, 308, 401

Modify, 861

Zone, 308, 401

Shape List, 863

Generator MW Limits, 56

GIS Tools, 854, 855, 856, 865, 867, 868, 870

Enforce, 56

Closest Facilities to Point, 870

Generator MW Marginal Cost, 239

Delete All Measure Lines, 868

Generator Options, 297, 302, 307

Export Oneline as Shapefile, 865

Fault Parameters, 307

Great Circle Distance, 854

MW Control, 302

Insert Measure Line, 867

Generator Piecewise Linear, 241

Populate Lon,Lat with Display X,Y, 856

Generator Reactive Power Capability Curve,
312

Shape File Import, 858
Governor, 940, 941, 942, 1541

Generator Records, 233, 1174

Graph, 679, 680, 681, 682, 939

Generator Spinning Reserves, 215

Graphic Formats, 95

Generator VAR Limits, 56

Graphics, 96, 135

Check, 56

Great Circle Distance Calculation, 855

Display, 56

Great Circle Distance Dialog, 854

Generator/Load Cost Models, 236

Grid, 151, 188, 798

Generators, 214, 219, 230, 233, 235, 236, 237,
239, 241, 267, 269, 271, 282, 299, 301, 309,

Snap Objects, 798
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Grid Metrics, 188

Background, 42

Grid Metrics Dialog, 151

Directions, 981

Grid/Highlight Unlinked Objects, 798, 826

Display Objects, 42

Gridline Color, 798

Fields, 42

Gridlines, 798

Hyperlink, 42

GSF, 996

Injection Group, 42
Interface, 42
H

Link, 42
Memo, 42

Help, 15

Picture, 42

High Zoom Level, 812

Pie Charts, 42

Highlight Unlinked Objects, 798

Screen Layer, 811

Highlighting, 798

Text, 42

Unlinked Objects, 798

Zone, 42
Insert Palettes, 777

I

Install, 1385

Identify Cross Compound Units, 90

Installing, 1385

Images, 96, 135

InterArea, 738

Immobile, 40, 804, 814

Interchange, 220, 222

Impedance, 326, 368, 369, 414, 1177

Interchange MW, 220, 222

Impedance Correction Tables, 414

Interface Data Format, 92

Import, 276, 468

Interface Fields, 447, 737

Import PTI Subsystems Dialog, 461

Interface Information, 444, 446, 447, 448

Include, 1386

Interface Limiters, 1371

Include Suffix, 808
Increase/Decrease Decimals, 137

Interfaces, 92, 215, 264, 266, 420, 444, 446,
447, 448, 449, 450, 474, 583, 735, 736, 737,
739, 740, 788, 801, 828, 976, 1371

Indication, 42

Introduction, 3

inf, 92

Inverter Parameters, 354

Info/Interchange, 432

IOA, 239

Initialize, 104

Island Based AGC, 649

inj, 91

Island Slack Bus, 274

Injection Groups, 91, 215, 267, 269, 272, 452,
453, 456, 457, 459, 461, 462, 464, 466, 581,
827

Island-Based AGC, 639

Increase Decimals, 137

Islands, 215, 274, 649, 940, 942
Iterated Linear Step, 1341, 1372

Import PTI Subsystems Dialog, 461

Iterations, 23, 56, 640, 672

Injection Groups Format, 91

Control Loop, 56

Insert, 42, 449, 690, 736, 777, 782, 783, 785,
786, 787, 788, 789, 811

Maximum, 56
Maximum Number, 56

Area, 42
Area/Zone, 42
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J

Line Information, 343, 364
Line Loading Replicator, 1005

Jacobian, 97, 284

Line Outage Distribution Factors, 984
Line Per Unit Impedance Calculator Dialog, 326

K

Line Shunt Display, 259

Key Field, 664

Line Shunts, 325

Key Fields, 182

Line Shunts Information, 325

Keyboard Short Cut Actions Dialog, 880

Line Taps, 965, 966

Keyboard Shortcuts, 880

Line Thickness, 809
Line Voltage Profile, 249

L

Line/Fill, 40, 804, 806, 809

Labels, 420, 423, 474, 477

Line/Fill Properties, 809

Layer, 40, 795, 804, 806, 810, 811, 812

Line/Fill Tab, 40, 804, 806, 809

Screen Stack, 41, 805

Line/Transformer Information, 404

Stack, 40, 804

Linear ATC, 1342, 1372
Linear Calculation Method, 1342

Layers, 810, 812, 874

Linearized AC, 1342

choosing, 810

Lines/Transformers, 214, 1175

Level, 40, 795, 804, 809, 810, 812, 874

Links, 743, 745

Background, 41, 805

Other Onelines, 743

Base, 41, 805
Middle, 41, 805, 810

List of Devices, 1423, 1425, 1427, 1429

Top, 41, 805, 810

ListOfDevicesAsVariantStrings Function, 1431

Levels/Layers, 40, 804, 806, 810, 811, 812

ListOfDevicesFlatOutput Function, 1432

Levels/Layers Options, 810, 811

Load, 236, 243, 313, 317, 319, 402, 839,
1050, 1095, 1178

Levels/Layers Tab, 40, 804, 806, 810, 812

Load Benefit Models, 244

Format Multiple Objects dialog, 812

Load Characteristic, 1541

Limit, 1341

Load Chart, 680

Limit Groups, 915

Load Display Objects, 715

Limit Monitoring, 1045, 1046, 1054, 1055

Load Field Information, 317

Limit Monitoring Settings, 909, 910, 915, 1341,
1374

Load Fields, 317, 716, 809, 1050

Limit Monitoring Settings and Limit Violations
Dialog, 910

Load Flow, 24

Limiters, 1371

Load Information, 402

Line, 38, 39, 40, 246, 253, 283, 783, 793, 794,
795, 804, 806, 809, 817, 818, 827, 966, 1175

Load Modeling, 319

Load ID, 243

Load Multiplier, 220, 222

Line Color, 809

Load NERC Flowgates, 740

Line Field Options, 345

Load Options, 313, 315, 316

Line Fields, 718, 809

Load Information, 315

Line Flow Gauge Options Dialog, 722

OPF Load Dispatch, 316

Line Flow Gauges, 721
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Load Relay, 1541

Memo Display, 24

Load Schedules, 220, 222

Memo Text, 756

Load State, 1433, 1434

Menus, 70

Load Status, 243

Merging Buses, 960

Load Throw Over, 1050

Message Log, 23, 30, 57, 672

Load Variation, 220, 222

Print, 23

Loading NERC Flowgates, 740

Save, 23

Loads, 214, 219, 236, 243, 244, 267, 269, 271,
281, 313, 317, 402, 420, 452, 453, 456, 457,
459, 462, 463, 466, 474, 689, 715, 716, 786,
924, 963, 964, 1095, 1178

Show, 23
Using, 23
Metrics, 151, 188
Microsoft Excel, 140

Local Menu, 129, 824

Middle, 41, 805, 810

Local Menus, 209

Level, 810

LODF, 984, 986, 989, 1341

Minimal, 827

Log, 23, 30, 57

Minimal Show, 827

Windows, 23

Minimum Highlighted Object Pixel Size, 798

Long Line Voltage Profile, 249

Minimum Sensitivity, 640

Loss, 997

Mismatch, 229

Sensitivities, 997

Model Conditions, 589, 647

Loss Sensitivities, 997

Model Conditions Dialog, 175

Loss Sensitivity, 240

Model Conditions Display, 175

Losses, 653, 681

Model Criteria, 647

LTC, 56

Model Explorer, 111, 210

LTC Transformer, 340, 370, 408

Explore Pane, 111

LTC Transformers, 372, 410

Fields Pane, 112
Fields Pane, 114

M

Recent Tabs, 112

Machine Model, 1541

Model Expressions, 168, 179

Maintain Fixed Screen Location, 810

Model Fields, 757

Maintain Fixed Screen Size, 810

Model Filters, 176, 177, 592, 647

Make Default, 808
Make Default button, 808

Model Filters View Logical Graphical Display,
177

Make-Up Power Sources, 1095, 1096

Model Object, 821

Map Projections, 850
Matrix Grids, 1126

Modeling, 175, 176, 236, 237, 241, 244, 319,
940, 1045, 1064

Max Flow Min Cut, 938, 939

Models, 175, 237, 647

Maximum, 56

Moderate Show, 827
Modify, 19, 806, 809, 810, 811, 812, 814

Control Loop Iterations, 56

Orientation, 814

Iterations, 56

Size, 814

Memo, 24, 436

Mouse, 2, 17, 828
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Mouse Wheel Zooming, 828

Number, 56

Movie Maker, 849

Iterations, 56

Multiple Display Fields, 690
Multiple Scenario, 1371

O

Multiple Scenario Analysis, 1342, 1361

O&M, 239

Multiple Scenario ATC Analysis - Results Tab
Local Menu Options, 1369

Objects, 24, 38, 39, 42, 137, 793, 794, 795,
801, 803, 806, 808, 809, 810, 811, 812, 814,
817, 818, 821, 826, 827, 844, 963, 1464

Multiple Scenario ATC Dialog Results Tab,
1367

Area, 801

Multiple Scenario ATC Dialog Scenarios Tab,
1364

Area/Zone, 801
Background Objects, 746, 748, 749, 750,
754, 755, 757, 809

Multi-Section Lines, 219, 253, 343, 597, 725
Multi-Terminal, 261, 360, 361, 362, 364

Bus, 801

Mutual, 1176, 1177

Display, 38, 39, 793, 794, 817, 818

Mutual Impedance, 1176, 1177

Find, 801

MVA flow, 829

Zone, 801

Mvar, 372, 410, 827

Observing, 810

Mvar Control, 372, 410

oneline, 810

MVR flow, 829

Off-Nominal, 369

MW, 682, 827, 829, 982

Oneline, 38, 40, 42, 80, 86, 87, 95, 470, 473,
660, 688, 702, 703, 743, 793, 795, 798, 800,
801, 804, 808, 810, 811, 812, 814, 817, 820,
821, 826, 827, 836, 838, 840, 871, 872, 879,
882, 951

MW Control, 302
MW Distance, 982
MW Marginal Cost, 239
MW Transactions, 220, 222, 275, 682

Browsing Path, 662

MW/MVR, 827

Conditional Display, 872, 879
Coordinates, 660

N
NERC, 740, 741

Diagrams, 80, 688, 692, 702, 703, 705, 707,
708, 714, 716, 719, 720, 800, 820, 827, 882

Network, 42, 111

Display, 688, 798, 800, 826, 827, 838

Network Cut, 945, 946

Diagrams, 723

New, 83, 84

Display Options, 660

New Case, 19, 20, 83

Displays, 470, 473
Exporting, 95

Creating, 19
New Oneline, 20, 84

File, 658, 661

Newton, 64, 65, 669, 670

Font, 661

Newton-Raphson, 642, 672

Links, 743, 828

Nomogram Display, 266

Options, 660, 688, 800, 810, 812, 827, 838,
879

Nomogram Information, 450

Save, 660

Nomogram Interface Limiters, 1371

Screen Coordinates, 871

Nomograms, 266, 450

Size, 661
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Text Fields, 754

Constraints, 1249, 1250, 1251, 1253, 1254,
1261

Visualization, 660

Controls, 1248, 1259, 1263, 1275, 1292,
1293

Oneline Display Options, 826, 857
Geography/Coordinates, 857

Data, 1255, 1258, 1267

Open, 23, 79, 80, 82, 110, 795, 806, 810

Example, 1257, 1294, 1297, 1298, 1300

Project, 110

LP OPF, 1256, 1270, 1271, 1272

Screen Layers list, 810

Options, 1258, 1259, 1261, 1263, 1267,
1270, 1271, 1272, 1273, 1274, 1275, 1276,
1277

Open Case, 1435, 1436
Operators, 165
OPF, 266, 316, 400, 435, 677, 1008, 1247

Records, 1255, 1278, 1280, 1281, 1284,
1285, 1286, 1288, 1290

Constraints, 1249, 1250, 1251, 1253, 1254,
1261

Trace Solution, 1277

Controls, 1248, 1259, 1263, 1275, 1292,
1293
Data, 1255, 1258, 1267

Options, 23, 56, 137, 638, 639, 640, 649, 651,
654, 655, 658, 663, 673, 688, 691, 795, 798,
800, 801, 803, 806, 811, 812, 827, 983

Example, 1257, 1294, 1297, 1298, 1300

Options Toolbar, 56

Load Dispatch Options, 316

Options/Tools, 482, 679, 800, 803, 826, 840,
907, 922, 1000

LP OPF, 1256, 1270, 1271, 1272

Orientation, 806, 814

Options, 1258, 1259, 1261, 1263, 1267,
1270, 1271, 1272, 1273, 1274, 1275, 1276,
1277

Orientation Setting, 814
Oscillations, 56

Records, 1255, 1278, 1280, 1281, 1284,
1285, 1286, 1288, 1290

OTDF, 1356

Trace Solution, 1277

Other Display Object Properties, 814

Other Applications, 180

OPF Control, 677

Out of Service Elements, 660

OPF DC Lines Records, 1287

Outages, 219

OPF Options Advanced Options, 1266

Out-of-Service Elements, 828

OPF Options and Results, 1258

Visualizing, 828

OPF Reserves
Case Information Display, 1336

Overview, 103, 452, 462, 684, 776, 820, 935,
1180, 1247, 1302

Constraints, 1332

Owned, 281, 282, 283

Controls, 1330

Owned Bus Records, 280

Example, 1337

Owned Generator Records, 282

Objective Function, 1334

Owned Line Records, 283

Overview, 1328

Owned Load Records, 281

Reserve Requirement Curves, 1333
Reserves Bids, 1331

Owner, 153, 278, 279, 280, 281, 282, 283,
308, 401, 600

Results and Pricing, 1335

Owner Display Objects, 700

Topics, 1329

Owner Display Options Dialog, 701
Owner Fields on Onelines, 706

Optimal Power Flow, 266, 400, 435, 677, 1008,
1247

Owners, 153
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P

Pies, 42
Populate Lon,Lat with Display X,Y, 856

Palettes, 776, 777

Popup menu, 811

Pan, 2, 53, 801, 810, 872

Post Power Flow, 640, 647

Zoom, 872

Post-contingency, 1374

Pan/Zoom, 801, 873

Potential Misplacements Dialog, 964

New Location, 802

Power Control, 395

Pan/Zoom Control, 801, 873

Power Flow, 23, 56, 216, 218, 229, 639, 640,
653, 672, 940, 942, 974, 1050

Panning, 801
Participation Factor Control, 676

Submode, 523

Participation Factors, 234, 310, 676, 940, 942,
943

Visualize, 974
Power Flow List, 216, 218

Participation Points, 271, 462, 463, 466

Paste Buffer, 38, 39, 793, 794, 817, 818

Power Flow Solution, 2, 23, 56, 276, 468, 470,
473, 638, 639, 640, 647, 649, 651, 653, 654,
655, 658, 665, 672, 676, 679, 680, 681, 682,
683, 940, 942, 982, 983, 984, 1050

Paste Format Dialog, 807

Power Flow Solution Advanced Options, 643

Path, 291, 828, 929

Power Flow Solution Message Log, 656

Paste, 38, 39, 140, 141, 180, 793, 794, 817,
818

Browsing, 828

Power Flow Solution Actions, 640

Pathname, 215

Power System Model, 38, 39, 175, 176, 236,
237, 241, 244, 319, 420, 474, 793, 794, 817,
818, 821

Pause, 30, 57, 849
Per Unit, 326, 368

Power System Scaling, 924

Phase, 255, 369, 374, 412

Power Technologies, 1023

Phase Shift, 369, 374, 412

Power Technology, 1024

Phase Shifters, 56

Power Transfer Distribution Factors, 974, 975,
1341

Pie Chart / Gauge Dialogs, 764
Pie Chart / Gauge Example, 775

PowerFlow

Pie Chart / Gauge Style Dialog, 767

Submode, 523

Pie Chart / Gauge Style Dialog - Gauge
Parameters Tab, 773

PowerPoint, 841

Pie Chart / Gauge Style Dialog - Open
Parameters Tab, 771

PowerWorld Corporation, 15

PowerWorld, 15, 19, 1464

Pie Chart / Gauge Style Dialog - Pie Chart
Parameters Tab, 772

PowerWorld Project, 103, 104, 105, 107, 108,
110

Pie Chart / Gauge Style Dialog - Standard
Parameters Tab, 769

PowerWorld Simulator, 15, 19

Pie Chart Relative, 829

Present Case, 478, 479, 480, 482, 903, 904,
905, 907, 918, 919, 920, 922

Pie Chart Style, 829

Present Topological Differences, 482, 907, 922

Pie Charts, 448, 720, 739, 826, 829

Presentations, 841

Pie Charts/Gauges General Options, 763

Pre-Transfer Value Estimate, 1374

Pie Charts/Gauges Interfaces, 761

Prevent Controller Oscillations, 56, 642

Pie Charts/Gauges Lines, 759

Print, 882, 883, 885
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Print Message Log, 23

Rectangular Selector, 806

Print Options, 883

Rectifier Parameters, 353

Print Title Bar, 883

Reference State, 1013

Print Window, 883

Refresh, 67, 138, 816, 827, 876

Printer Setup, 885

Refresh Anchors, 816

Printing, 882, 883, 885

Refresh Display, 138

ProcessAuxFile, 1437, 1438

Regulation, 233

Project, 103, 104, 105, 107, 108, 110

Relationship Between Display Objects, 38, 39,
793, 794, 817, 818

Properties, 798, 808, 809, 814

Relinking, 798

Display Object, 814

Remote Regulation, 230, 233

PSS/E, 1023, 1024, 1026
PSS/E Load Throw Over Files, 1025

Remote Regulation Viability, 672

PTDF, 2, 452, 974, 975, 979, 980, 981, 982,
984, 990, 1341, 1356, 1374

Remotely Regulated, 230, 233
Renumber Areas/Zones/Substations Dialog,
973

Directions, 980
Publish, 96, 135

Renumbering, 969, 970, 972

PV, 1180, 1181, 1182, 1203, 1208, 1211,
1215, 1217, 1242, 1244

Report Violations, 1055
Report Writing, 1067, 1072

New Plots, 1218

RequestBuildDate Property, 1463

Options, 1184, 1185, 1190, 1198, 1200,
1206, 1237, 1245

Required Field, 138, 664

Submode, 534

Resize, 40, 804, 806, 810

Required Fields, 184
Resizing, 810

Q

Restore, 655

Quick Access Toolbar, 29

Restore Default Values, 802

Quick Filter, 152

Restore Last Solution, 655

Quick Power Flow List, 148, 178, 216, 218

Restore State, 655

QV, 1215, 1217, 1219, 1221, 1223, 1226,
1228, 1230, 1239, 1240, 1242, 1244

Ribbon, 26
Case Information, 33

Options, 1198, 1206, 1225, 1237, 1245

Draw, 37, 687

Submode, 536

Clipboard, 38, 793, 817
Formatting, 807
R

Individual Insert, 42

Range, 178

Quick Insert, 44, 780

Range of Numbers, 178

Select, 46, 797
Onelines

Reactive Power Capability, 312
Recently Opened Cases, 82

Active, 49

Records, 133, 134, 140, 821

Onelines, 47
Onelines

Sorting, 129, 133, 138

Zoom, 53

Rectangle Selector, 806

Options, 54
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Quick Access Toolbar, 29

Save Log, 23

Tools, 57

Save View, 53, 874

Tools

Save/Edit/Delete, 874

Edit Mode, 59

Saving NERC Flowgates, 741

Tools

Scaling, 178, 924

Other Tools, 61

Schedules, 220, 222

Tools

SCOPF, 266, 400, 435, 676, 1008, 1302, 1303,
1304, 1305, 1306, 1311, 1314, 1316, 1317,
1321

Run Mode, 63
Window, 67, 876

Constraints, 1307, 1308, 1309

Right-clicking, 811

Controls, 1311, 1322

oneline, 811

Example, 1323, 1326, 1327

Run, 21, 23

LP, 1316, 1319, 1320

Run Mode, 21, 22, 387, 391, 393, 402, 404,
415, 418, 515, 828, 974

LP OPF, 1256, 1270, 1271, 1272
OPF Constraints, 1249, 1250, 1251, 1253,
1254, 1261

Difference Flows, 479, 480, 482, 904, 905,
907, 919, 920, 922

OPF Controls, 1248, 1259, 1263, 1275, 1292,
1293

Fault Analysis, 1171, 1172, 1173, 1174,
1175, 1178, 1179
Governor Power Flow, 940, 941, 942

OPF Data, 1255, 1258, 1267

Introduction, 21

OPF Example, 1257, 1294, 1297, 1298, 1300

LODF, 984, 986

OPF Options, 1258, 1259, 1261, 1263, 1267,
1270, 1271, 1272, 1273, 1274, 1275, 1276

Options, 941

OPF Records, 1255, 1278, 1280, 1281, 1284,
1285, 1286, 1288, 1290

Script, 515
Sensitivities, 996, 997, 1000

Screen Coordinates, 871

Tools, 168, 235, 940, 950, 974, 984, 990,
996, 1008, 1095

Screen Layer Options, 812
Screen Layer Options dialog, 811

Tools & Options, 168, 235, 479, 480, 482,
849, 904, 905, 907, 919, 920, 922, 940, 942,
974, 975, 979, 980, 981, 984, 986, 989, 990,
991, 994, 996, 997, 1000, 1008, 1012, 1013,
1020, 1023, 1024, 1026, 1029, 1030, 1031,
1032, 1035, 1038, 1040, 1042, 1045, 1046,
1050, 1054,1055, 1065, 1066, 1067, 1070,
1072, 1074, 1075, 1077, 1080, 1095, 1096,
1171, 1172, 1173, 1174, 1175, 1176, 1177,
1178, 1179

Screen Layers, 811, 812
Screen Layers list, 810
open, 810
Screen Location, 801, 810
Screen Size, 810
Fixed, 810
Script Command Execution Window, 22
Script Commands, 22

RunScriptCommand, 1439, 1440

Script General Actions, 22, 489, 622
Script Mode, 22, 30, 57, 484, 486, 488, 507,
543, 547, 621

S
Save, 23, 53, 85, 86, 97, 181, 874, 1441, 1443
Save Case, 181, 1441

Actions, 489, 507, 509, 515, 523, 527, 531,
533, 534, 536, 538, 540, 622

Save Case Information Data, 181

Data, 554, 555

Save Hidden Layers, 875

Data, 543, 544, 547, 548, 549, 550, 551, 552
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Data, 556

Data, 615

Data, 557

Data, 616

Data, 558

Data, 617

Data, 559

Data, 618

Data, 560

Data, 619

Data, 567

Data for Display Auxiliary Files, 602, 620,
627, 628, 630, 631, 632, 633, 634, 635, 636,
637

Data, 568
Data, 569

Files, 484, 487, 488, 543, 621

Data, 570

Script, 486, 488, 489, 507, 509, 515, 523,
527, 531, 533, 534, 536, 538, 540, 621, 622

Data, 571
Data, 572

Script Mode Introduction, 22

Data, 574

Search, 112, 137, 174

Data, 576

Security Constrained OPF, 266, 400, 435, 676,
1008, 1302, 1303, 1304, 1305, 1306, 1311,
1314, 1316, 1317, 1321

Data, 577
Data, 579
Data, 580

Constraints, 1307, 1308, 1309

Data, 581

Controls, 1311, 1322

Data, 583

Example, 1323, 1326, 1327

Data, 585

LP, 1316, 1319, 1320

Data, 586

LP OPF, 1256, 1270, 1271, 1272

Data, 587

OPF Constraints, 1249, 1250, 1251, 1253,
1254, 1261

Data, 588

OPF Controls, 1248, 1259, 1263, 1275, 1292,
1293

Data, 589
Data, 590

OPF Data, 1255, 1258, 1267

Data, 592

OPF Example, 1257, 1294, 1297, 1298, 1300

Data, 593

OPF Options, 1258, 1259, 1261, 1263, 1267,
1270, 1271, 1272, 1273, 1274, 1275, 1276

Data, 597
Data, 598

OPF Records, 1255, 1278, 1280, 1281, 1284,
1285, 1286, 1288, 1290

Data, 599
Data, 600

Select, 39, 794, 795, 809, 810, 814, 818

Data, 603

Select By Criteria, 795, 806

Data, 604

Select OK, 809

Data, 605

Selected group, 796

Data, 606

Selected objects, 795, 945

Data, 607

Selecting Format, 809

Data, 608

Seller, 1342, 1356

Data, 610

Send, 41, 805, 810

Data, 611

Back, 41, 805, 810

Data, 612

Send All to Excel, 141

Data, 613

Send to Excel, 141
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Sensitivities, 986, 991, 996, 997, 1000, 1032

ListOfDevicesAsVariantStrings, 1431

Sensitivity Calculations, 1033

ListOfDevicesFlatOutput, 1432

Sequence Data Format, 93

Load State, 1433, 1434

Series Capacitor, 342, 347, 731

MATLAB, 1410, 1417, 1427

Fields, 347

Open Case, 1435, 1436

Series Capacitor Fields, 732

ProcessAuxFile, 1437, 1438

Set Custom Detail, 827

Properties, 1456, 1457, 1459, 1461

Set Generator Participation Factors, 310, 943

RunScriptCommand, 1439, 1440

Setting, 800

Sample Code, 1394, 1397, 1400, 1403, 1405,
1408, 1410, 1412, 1416, 1417, 1419, 1425,
1427, 1429, 1434, 1436, 1438, 1440, 1442,
1444, 1446, 1454, 1458, 1460, 1462

Background Color, 800
Setting Default Drawing Options, 691
Shape File Import, 858

VB, 1412, 1419, 1429

Shapefile, 859, 860, 861, 862, 863

Version 9.0, 1465, 1466, 1467, 1468, 1470,
1471, 1472, 1473, 1474, 1475, 1476, 1477,
1478, 1479, 1480, 1481, 1482, 1483, 1484

Database Record Dialog, 864
Export Oneline as Shapefile, 865
GIS Shapefile Data Control, 859

Simulation, 23, 79

GIS Shapefile Data Format, 862

Simulation Control, 30, 57, 64, 669

GIS Shapefile Data Identify, 860

Simulator Options, 638

GIS Shapefile Data Modify, 861

Single Linear Step, 1341

GIS Shapefile Data Shape List, 863

Single Solution, 64, 65, 640, 669, 670
Size, 137, 806, 808, 810, 814, 827

Shortcuts, 880

modify, 814

Shortest Path Between Elements, 291, 929
Show Animated Flows, 831

Size/color, 809

Show Fields Primary, 207

Slack, 215

Show Fields Secondary, 208

Slack Bus, 215, 287, 643

Show ThumbNail View, 834

Slide Presentations, 841

Shunts, 56, 262, 325, 380, 415, 689, 719, 733,
787, 924, 963, 964, 1179

Snap Objects, 798

SimAuto, 1384, 1385, 1386, 1387, 1389, 1390,
1391, 1393, 1396, 1397, 1399, 1400, 1431,
1432, 1456, 1464
ChangeParametersMultipleElement, 1396

Solution, 23, 56, 229, 276, 468, 472, 473, 638,
639, 640, 647, 649, 651, 653, 654, 655, 658,
665, 672, 677, 679, 680, 681, 682, 683, 982,
983, 1012

ChangeParametersMultipleElementFlatInput,
1399

Solution Options, 56, 638, 639, 640, 649, 651,
654, 655, 658, 663, 672, 940, 942, 983, 1012

ChangeParametersSingleElement, 1393

Solution Options Toolbar, 56

Delphi, 1408, 1416, 1425

Solving, 672

Functions, 1391, 1392, 1402, 1404, 1406,
1414, 1422, 1423, 1433, 1435, 1437, 1439,
1441, 1443, 1445, 1453

Sort, 133, 138

Get Parameters, 1406, 1408, 1410, 1412,
1414, 1416, 1417, 1419, 1422, 1475

Sorting Records, 133

Grid, 798

Sorting, 129, 133, 138
Records, 140
Special Data Sections, 632

List of Devices, 1423, 1425, 1427, 1429
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Spinning Reserves, 215

T

Splitting Buses, 961, 962

Tap, 255, 965

Stability, 1180

Tapping Transmission Lines, 965

Stabilizer, 1541

Taps, 966

Stack, 40, 804, 806, 810

Terms, 871

Stack Level, 40, 804, 806, 810

x-y, 871

Status Bar, 25

Text, 137, 174, 754, 755, 809, 810, 827

Storage, 639, 655

Text Fields, 754

Submenu, 825

Text/font, 806

Substation, 232, 295, 473, 712, 801, 826, 827,
838

Three Winding Transformers, 257, 378, 729
Throw Over, 1050

Field Options, 295

Thumbnail, 826, 834

Fields, 712

Background, 835

Object, 801

Size, 835

Substation Display, 473, 838

Thumbnail View, 826, 834

Substation Display Options, 838

Tie Lines, 434

Substation Field Options, 295

Tie Lines between Areas, 223

Substation Fields on Onelines, 712

Tie Lines between Zones Display, 225

Substation Information, 293, 391

Time Step Simulation, 1114, 1115, 1117, 1120,
1121, 1122, 1124, 1125, 1126, 1127, 1131,
1132, 1133, 1134, 1135, 1139, 1140, 1141,
1142, 1145, 1146, 1147, 1150, 1152, 1154,
1156, 1162, 1166, 1167, 1170

Substation Records, 232
Substation View, 148, 473
Substations, 293, 391, 473, 711, 789
Super Area, 226, 439, 442, 705

Binding Constraint Dialog, 1131

Super Area Display Objects, 698

Change Timepoint Time Dialog, 1141

Super Area Display Options Dialog, 699

Custom Results Selection Dialog, 1133

Super Area Information, 439, 442

Dialog, 1117

Supplemental Classification, 847

Input, 1125

Supplemental Data, 847

Insert/Scale Column Dialog, 1143

Creating Records, 847

Loading Hourly Input Data, 1145

Fields, 758

Matrix Grids, 1126

Linking Display Objects, 848

New Timepoint Dialog, 1140

Switched Shunt, 262, 380, 383, 415, 733, 839,
1179

Options, 1135

Switched Shunt Fields, 383, 734, 809

Pages, 1121

Switched Shunt Information, 380, 383, 415,
1179

Quick Start, 1115

Switched Shunts, 214, 219, 380, 383, 415,
420, 474, 734, 787, 963, 964, 1179

Results Grid Pages, 1134

Results, 1132
Results: Constraints, 1127

System Scaling, 924

Running a Timed Simulation, 1166
Running OPF and SCOPF, 1167
Schedule Dialog, 1147
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Schedule Subscription Dialog, 1152

689, 719, 726, 728, 729, 915, 963, 964, 1163,
1175

Schedule Subscriptions Page, 1154

Control, 337, 365

Schedules Page, 1150

Fields, 348, 376

Setting up Scheduled Input Data, 1146

Transient Stability, 540, 1518, 1519, 1523,
1526, 1527, 1528, 1530, 1532, 1534, 1535,
1538, 1544, 1545, 1547, 1550, 1552, 1555,
1556, 1557, 1562, 1564, 1565, 1567, 1571,
1573, 1577, 1582, 1584, 1586, 1588, 1590,
1592, 1593, 1595, 1597, 1598, 1601, 1603,
1605, 1606, 1608, 1611, 1613

Specifying and Maintaining a List of
Timepoints, 1139
Storing Input Data and Results, 1170
Summary, 1122, 1124
Toolbar, 1120
TSB Case Description Page, 1142

Block Diagrams, 1544

TLR, 990, 991, 994, 996

Data, 1534, 1535, 1544

TLR Multiple Device Type, 994

Distributed Computing, 1564

TLR sensitivities, 990, 991

General, 1556

TLR Sensitivities, 996

Generic Limit Monitors, 1562

Toggle Full Screen, 825

Options, 1555, 1556, 1557, 1559, 1562, 1564

Tools, 800, 803

Power System Model, 1557

Top, 41, 805, 810

Result Options, 1559

level, 810

Results, 1603, 1605

Topological Differences, 482, 907, 922

Results Storage, 1565, 1567, 1571

Topology Processing, 538, 1486, 1488, 1490,
1491, 1492, 1493, 1494, 1495, 1496, 1498,
1500, 1501, 1502, 1506, 1507, 1508, 1509,
1510, 1511, 1513, 1514

Single Machine Infinite Bus, 1611
SMIB, 1611
Transient Limit Monitors, 1597, 1598, 1601

Total Digits, 808

Transmission Line, 354, 355

Transactions, 220, 222, 275, 276, 468, 682

DC Actual Flow, 355

Transfer, 1361, 1371

DC Inverter Parameters, 354

Transfer Limit, 1371

Transmission Line Information, 1175

Transfer Limit For Scenario, 1361

Transmission Line Options, 320

Transfer Limiters, 1361, 1371

Transmission Line Parameter Calculator, 327

Transfer Limiters Display, 1371

Transmission Line Transformer Options
Display, 323

Transfer Result Reporting Options, 1348
Transformer AVR Dialog, 340, 370, 408

Transmission Line/Transformer Options, 324,
337, 342, 365

Transformer Control, 337, 365, 1163
Transformer Fields, 728, 809

Parameters/Display, 324

Transformer Impedance Correction, 369

Series Capacitor, 342

Transformer Impedance Correction Tables, 414

Transformer Control, 337, 365
Transmission Lines, 214, 246, 253, 260, 283,
320, 325, 345, 350, 351, 353, 357, 404, 717,
718, 724, 725, 726, 783, 915, 963, 964, 1175

Transformer Options, 320
Transformer Phase Shifting, 374, 412
Transformers, 214, 246, 253, 255, 257, 283,
320, 325, 337, 340, 348, 365, 368, 369, 370,
372, 374, 376, 378, 404, 408, 410, 412, 414,

DC, 350
DC Line Parameters, 351
DC Rectifier Parameters, 353
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Fields, 345

Use Area/Zone/Owner Filters, 33, 138, 142

Transmission Loading Relief, 990, 991, 994,
996

Use Background Fill, 809

Transmission Loading Relief Sensitivities, 990,
991, 996

User-Defined Case Information, 111, 118, 210

Use Conditional Display, 812
Using Difference Flows, 480, 905, 920

Turns Ratio, 369

Using the Oneline Alignment Grid, 799

Tutorial, 19, 1097, 1098, 1669
Contingency Analysis - Page 10, 1111

V

Contingency Analysis - Page 11, 1113
Contingency Analysis - Page 4, 1103

Validate, 23

Contingency Analysis - Page 5, 1105

Variable O&M, 239

Contingency Analysis - Page 6, 1106

View, 53, 470, 688, 743, 826, 834, 874

Contingency Analysis - Page 7, 1108

View Name, 874

Contingency Analysis - Page 8, 1109

Violations, 1055

Contingency Analysis - Page 9, 1110

Visualize, 974, 976

Tutorial Contingency Analysis, 1097, 1669

Power Flows, 974, 976

Tutorial Creating a New Case, 1618

PTDFs, 974
Visualizing, 660, 828

Tutorial Solving an OPF, 1662

Out-of-Service Elements, 828

Tutorial Starting with an Existing Case, 1647
Tutorial Contingency Analysis, 1098

Voltage Adequacy, 1180

Tutorials, 1097, 1618, 1619, 1621, 1623, 1624,
1627, 1629, 1631, 1633, 1636, 1638, 1642,
1644, 1647, 1648, 1649, 1650, 1651, 1652,
1653, 1654, 1655, 1656, 1657, 1658, 1659,
1660, 1661, 1662, 1663, 1664, 1665, 1666,
1667, 1669

Voltage Control, 395
Voltage Gauges, 709, 710
Voltage Sensitivities, 1000
Voltage Stability, 1180
W

U

Warning, 829

Uncheck, 814

Warning Color, 829

Anchored, 814

Warning Percent, 829

Undo, 819

Default values, 829

Unit Type, 240

Warning Size Scalar field, 829

Unlinked Display Objects, 844

Web, 15

Unlinked Objects, 798, 844

Web Publishing, 96, 135

Highlighting, 798

Weighted Transmission Loading Relief, 995

Unused Bus Numbers, 952

Why is this field or line disabled, 129

Use, 814

Wind Control Mode, 302

Display/Size Tab, 814

Window, 17, 23, 140

Use Absolute Values, 827

Windows Basics, 17

Mvar, 827

Word, 841

MW, 827

Word Processor, 841
1689

©2011 PowerWorld Corporation

X

Zone Display Options Dialog, 697
Zone Fields, 703

X Grid Spacing, 798

Zone Information, 385, 418

XF, 255

Zones, 153, 215, 264, 420, 474

x-y, 871, 874

Zoom, 40, 53, 795, 798, 801, 804, 810, 811,
812, 828, 829, 834, 872

Y

Area, 53

Y Grid Spacing, 798

In, 53

Ybus, 97, 285

Levels, 53, 795, 798, 810, 811, 812, 829,
834, 872, 874
Out, 53

Z

Pan, 872

Zero Sequence, 1176

Percentage, 829

Zone, 153, 308, 385, 401, 418, 703, 795, 801

Toolbar, 53

Object, 801

Zoom/Pan/Find, 801, 810, 872

Zone Display Objects, 696
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